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Preface 1
As part of an effort to improve its product lines, VMware periodically releases revisions of its software and
hardware. Therefore, some functions described in this document might not be supported by all versions of
the software or hardware currently in use. The product release notes provide the most up-to-date
information on product features.


Contact your VMware technical support professional if a product does not function properly or does not
function as described in this document.


Note   This document was accurate at publication time. Go to VMware Online Support docs.vmware.com
to ensure that you are using the latest version of this document.


This chapter includes the following topics:


n Purpose


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n VMware Smart Assurance Service Assurance Manager


n Related documentation


n Suggestions for searching PDF files


n Conventions used in this document


n Pathname conventions


n Graphical conventions


n Manager


n Where to get help


n Your comments


Purpose
This guide is intended for administrators who are responsible for deploying, installing, and configuring the
Adapter Platform. IT managers who seek to understand the role of the Adapter Platform and the
Global Manager in the context of an VMware Smart Assurance solution may also find this guide useful.
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In addition to the configuration guides for specific components, administrators should also read the
VMware Smart Assurance Service Assurance Manager Deployment Guide and the
VMware Smart Assurance System Administration Guide.


Audience
This document is intended for administrators who are responsible for deploying, installing, and configuring
the Adapter Platform.


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<productsuite>.


n For example, on UNIX operating systems, VMware Smart Assurance Service Assurance Manager is,
by default, installed to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than/opt/InCharge (on UNIX)
or but you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.


VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System


n Global Console


n Business Dashboard


n Companion UI (CUI)


n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)


n VMware Smart Assurance Adapter for UIM/O


n XML Adapter
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Related documentation
In addition to this document, VMware Corporation provides a help system for command line programs as
well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


n VMware Smart Assurance Common Information Model (ICIM) 1.11 Reference for Non-Service
Assurance Manager Products


n VMware Smart Assurance Common Information Model (ICIM) Reference for Service Assurance
Manager


n VMware Smart Assurance Foundation Documentation Portfolio


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ASL Reference Guide


n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide


Note   These documents are updated periodically. Electronic versions of the updated manuals are
available on the VMware Online Support website (registration required) at: docs.vmware.com.


VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes


n VMware Smart Assurance Open Source License and Copyright Information


n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


n VMware Smart Assurance Service Assurance Manager Deployment Guide


VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


VMware, Inc.  7



https://support.emc.com





n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide


n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide


n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance Companion UI Open Source License and Copyright Information for GPLv3
as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1 If the documentation is not accessible to all users of the VMware Smart Assurance product, copy the
contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a shared drive on
your LAN, so that operators and others can view the documentation.


2 To search throughout the documentation library, open the Acrobat Reader software:


3 Select Edit > Search, and type a word or phrase.


4 Select All PDF Documents in, in the Where would you like to search option, and type the
pathname of the location where the PDF documents reside.


If you have more than one VMware Smart Assurance product installed, you can set up cross-product
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each product into
this common documentation directory path.
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Conventions used in this document
VMware uses the following convention for special notices:


Note   NOTICE is used to address practices not related to personal injury.


Typographical conventions
VMware uses the following type style conventions in this document:


Normal Used in running (nonprocedural) text for:
n Names of resources, attributes, pools, Boolean expressions, buttons, DQL statements, keywords,


clauses, environment variables, functions, and utilities
n URLs, pathnames, filenames, directory names, computer names, links, groups, service keys, file


systems, and notifications


Bold Used in running (nonprocedural) text for names of commands, daemons, options, programs,
processes, services, applications, utilities, kernels, notifications, system calls, and man pages


Used in procedures for:
n What the user specifically selects, clicks, presses, or types


Italic Used in all text (including procedures) for:
n Full titles of publications referenced in text
n Emphasis, for example, a new term
n Variables


Courier
Used for:
n System output, such as an error message or script
n URLs, complete paths, filenames, prompts, and syntax when shown outside of running text


                
        Courier 
bold
                
     


Used for specific user input, such as commands


                
        Courier 
italic
                
     


Used in procedures for:
n Variables on the command line
n User input variables


< > Angle brackets enclose parameter or variable values supplied by the user


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example
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Pathname conventions
Directory pathnames are shown with forward slashes (/).


Graphical conventions
If there are figures illustrating consoles in this document, they represent the consoles as they appear.
Under UNIX, the consoles appear with slight differences. For example, in views that display items in a
tree hierarchy such as the Topology Browser, an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to VMware Smart Assurance programs
such as Domain Managers, Global Managers, and adapters.


Where to get help
VMware support, product, and licensing information can be obtained as follows:


Product information


For documentation, release notes, software updates, or information about VMware products, go to
VMware Online Support at:


docs.vmware.com


Technical support


Go to VMware Online Support. You will see several options for contacting VMware Technical Support.
Note that to open a service request, you must have a valid support agreement. Contact your VMware
sales representative for details about obtaining a valid support agreement or with questions about your
account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:


docs.vmware.com.
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Service Assurance
Adapter Platform 2
This chapter includes the following topics:


n Overview


n Service Assurance Adapter Platform architecture


n Overview of configuration for Adapter Platform


n Configuring Adapter Platform Server


n Starting and stopping the Adapter Platform Server


n The sm_edit utility


Overview
The VMware Smart Assurance Service Assurance Manager Adapter Platform (Adapter Platform) imports
and normalizes topology and event information from sources other than VMware Smart Assurance
products, such as SNMP traps, system log files, or events generated from the sm_ems command line
interface. After it normalizes to the ICIM data model, the information is transferred to the
VMware Smart Assurance Service Assurance Manager (Global Manager).


The Adapter Platform works with third-party applications in a variety of ways to import topology and event
information and prepare it for use by the Global Manager. The Adapter Platform allows for several
methods of receiving events, including:


n SNMP trap integration


n Log file integration


n Integration by using a custom adapter


n Command line interface


The Adapter Platform works with any combination of these methods.


Regardless of how the Adapter Platform receives the event information, it does the following:


n Provides uniform representation of event information regardless of the source of the event. This is
called event normalization.


n Consolidates recurring events, rather than considering each new event separately. This reduces the
number of events sent to the Global Manager. It is called deduplication.
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n Allows for an incoming message to clear a previous event.


n Provides a mechanism to set an event expiration. This mechanism automatically clears events that
have not changed for a period of time.


n Optionally associates events to a topology element, thus placing events in their topological context.


After the event information is processed, it is sent to the Global Manager.


Adapter Platform configuration files describes the configuration files that are relevant to the
Adapter Platform Server. The sm_edit utility ensures that modified files are saved to the appropriate
location in the BASEDIR/smarts/local directory.


Note   You should edit only local copies of the Adapter Platform configuration files, which are located
in BASEDIR/smarts/local/conf/icoi. If local copies of the configuration files already exist and you
attempt to edit non-local files, the sm_edit utility will locate and edit the local (not the non-local)
versions of files. The sm_edit utility provides information about the sm_edit utility.
VMware Smart Assurance System Administration Guide provides detailed instructions about how to
properly modify an VMware Smart Assurance file.


Table 2‑1.  Adapter Platform configuration files


Directory under
BASEDIR Filename


User
editable Description


smarts/conf/icoi bootstrap.conf No Contains vital information required to start the
Adapter Platform Server.


smarts/conf/icoi dxa-sysip.conf No Used by the Adapter Platform to import
information from cooperating
VMware Smart Assurance IP Availability
Managers.


smarts/conf/icoi icoi-config.dtd No Definition file for XML configuration.


smarts/conf/icoi icoi-default.xml Yes Contains the default notification lists, user
profiles, and users for the Service Assurance
Adapter Platform when the server is first started,
or started without an existing repository file.


smarts/conf/icoi icoi-config-sample.xml Yes Sample XML file of notification lists, user profiles,
and users. It can be used as a template for
creating XML files of these entities.


smarts/conf/icoi nlconfig-sample.xml Yes Sample XML file for notification list configuration.
It can be used as a template for creating
additional files.


smarts/conf/icoi profileconfig-sample.xml Yes Sample XML file for user profile configuration. It
can be used as a template for creating additional
files.


smarts/conf/icoi userconfig-sample.xml Yes Sample XML file for user configuration. It can be
used as a template for creating additional files.
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Service Assurance Adapter Platform architecture
The Adapter Platform consists of four basic components as shown in Service Assurance Adapter Platform
architecture:


n Service Assurance Adapter Platform Server


The Adapter Platform Server prepares event information for use by the Global Manager. It normalizes
the event information and places it in a context understood by the Global Manager.


n VMware Smart Assurance Syslog Adapter


The Syslog Adapter parses a system log file and generates notifications based on the contents of the
file. Either the complete contents of the file are read or the file can be tailed, which means that only
newly added information is read.


n VMware Smart Assurance SNMP Trap Adapter (Receiver)


The SNMP Trap Adapter parses SNMP traps received and generates notifications based on the
contents of the traps. The SNMP Trap Adapter can be configured to handle many different types of
traps.


If you plan to receive SNMPv3 traps, additional steps are required. Configuring the SNMP Trap
Adapter to receive SNMPv3 traps provides more information.


n Command line interface sm_ems)


The command line interface creates or modifies notifications that are sent to the Global Manager.
This interface may be used in conjunction with third-party applications to send events to the
Global Manager.


Note   The Syslog Adapter and the SNMP Trap Adapter configurations must be customized to specify
the relevant file contents or the SNMP traps to use and how the information maps to objects in the
Global Manager repository.


Topology Importer
In addition to the basic Adapter Platform components, you can enable an Adapter Platform feature, the
Topology Importer, which provides a consistent method of identifying the systems associated with
Adapter Platform events.


The Adapter Platform creates notifications from different sources and tries to associate these notifications
to the topology element where the notification occurred. Making this association can be difficult because
there are many different methods of identifying topology elements.


The Topology Importer collects IP addresses and hostnames from an
VMware Smart Assurance IP Availability Manager so the Adapter Platform can accurately place events in
their topological context.


The Adapter Platform updates this list as the information changes in the IP Availability Managers. Service
AssuranceAdapter Platform architecture shows the Service Assurance Adapter Platform architecture.
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Figure 2‑1.  Service Assurance Adapter Platform architecture


Overview of configuration for Adapter Platform
Configuring the Adapter Platform to import and normalize event and topology information requires that
you complete one or more of the following procedures. Not all of these configuration procedures are
relevant in all Adapter Platform deployments.


Depending on which components you are implementing, you can omit some of these steps:


n Configure the Adapter Platform Server


n Configure the SNMP Trap Adapter


n Configure the Syslog Adapter


n Configure the Adapter Platform Server and adapters to start and stop automatically.


The following configuration sections describe each of these procedures.


Configuring Adapter Platform Server
Configuring the Adapter Platform Server involves:


n Configuring notification lists


n Configuring user profiles


n Configuring users


n Configuring system defaults


n System defaults cannot be deleted. on page 32
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n Configuring domain types


Configuring notification lists
Topics in this section include:


n Creating a notification list


n Modifying a notification list


n Disabling a notification list


n Configuring custom notification lists


Creating a notification list
To create a notification list by using the Notification List Creation Wizard:


1 From the Global Manager Administration Console, select Edit > New Notification List.


The Notification List Creation Wizard appears.


2 Type a unique name for the Notification List.


3 Select to create a new notification list or copy an existing notification list:


n If a new notification list is being created, all of the filter properties are empty.


n If you copy a notification list, the notification list properties contain the same values as the
copied list.


4 Click Next.


5 Create an expression filter or type the name of an ASL Filter prefaced by the name of the
BASEDIR/smarts/local/rules directory in which it is located, and click Next.


6 Edit the column headings that are displayed in the notification log. The left column lists the attributes
included in a notification. The right column lists the column names as they are currently displayed.
You can edit the values in the right column by double-clicking a field.


7 Perform one of the following:


n Click Next to view the confirmation panel.


n Click Finish to create the notification list.


The new notification list is displayed in the Global Manager Administration Console.


Modifying a notification list
To edit the filters and the column headings for a notification list:


1 Select a notification list in the tree.


The Configure Notification List panel appears.
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2 Click Edit Filter to modify the filter.


The Edit Filter dialog box appears. The
VMware Smart Assurance Service Assurance Manager Configuration Guide provides additional
information.


3 Click OK when finished editing the filters.


4 Edit the display headings as needed. Double-click the display heading in the right column to edit the
text. The new display heading is visible when users reattach to the Global Manager.


5 Click Apply.


Note   To provide a value for a UserDefined attribute, you must configure a hook script to populate
the field. VMware Smart Assurance Service Assurance Manager Configuration Guide provides
information about hook scripts.


Disabling a notification list
You can disable a notification list if you do not want it active, but do not want to delete it. When a user
attaches to a Global Manager and their notification is disabled, their console will not receive any
notifications. The console will receive notifications when the notification list is enabled.


To disable a notification list:


1 Select the list from the tree in the Global Manager Administration Console.


2 Clear the Enabled checkbox.


3 Click Apply.


The name of the disabled notification list appears dimmed.


Configuring custom notification lists
You do not need to create a notification list in the Adapter Platform Server for the Global Manager to use.
By default, it connects to the Adapter Platform Server’s Default notification list. However, if you want to
use a custom notification list, you can create it through the Global Manager Administration Console, or
you can create it through the use of the nlconfig-sample.xml file and import it with the sm_config
command. This allows you to send a subset of notifications from the Adapter Platform Server to the
Global Manager. Then you need to modify the local copy of the dxa-oi.conf on the Global Manager and
change the following line:


sub    Default/n


to


sub     <notification_list>/n


Configuring user profiles
Topics in this section include:


n Creating a user profile
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n Deleting a user profile


n Modifying a user profile


Creating a user profile
When using the User Profile Creation Wizard, you are prompted to specify the users, notification list,
tools, saved consoles, and console operations associated with the user profile.


Note   You can create users and notification lists from within the User Profile Creation Wizard.


As you proceed through the wizard, you may notice that certain elements, such as users or tools, appear
dimmed. This indicates that these elements are not enabled. You can associate disabled elements with a
user profile. However, such elements are not available to the user profile. For example, if a tool is not
enabled, it will not be available to a user until it is enabled. You can enable or disable elements by
selecting them in the tree, and selecting or clearing the Enable box in the Configure User Profile panel.


In addition, you can click Finish at any point and the wizard will create the user profile. If you are creating
a new user profile, any options after the point where you selected Finish will be blank. If you copied an
existing user profile, the new profile will include the options of the copied profile.


Note   Users may have to detach and reattach for changes to their user profile to take effect.


To create a user profile:


1 From the Global Manager Administration Console, click the Launch User Profile Wizard toolbar
button.


The User Profile Creation Wizard appears.


2 Type the name of the user profile and select whether to create a new profile or to copy an existing
profile, and click Next. If you want to copy an existing profile, the remaining configuration options will
be identical to the user profile that was copied.


The name of a user profile cannot be the same as the name of a user. For example, you cannot
create a user profile Operator and a user Operator. A suggested naming convention is to name the
user profile with a –profile extension. For example, you could have a user profile called Operator–
profile.


3 Select a notification list from list box and click Next. Optionally, you can select New Notification List
from the menu to create a new notification list.


4 Select the user or users associated with this user profile. You can select multiple users by holding the
Ctrl key when selecting users. Click Add to associate the user or users with the user profile.


If the user does not exist, you can create a user by doing the following:


5 Type the username in the Create and add new user field.


6 Click Add.
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7 Click Next.


Note   A user can belong to only one user profile. If the user you select is already a member of
another user profile, the user is associated with the new user profile.


8 Select any appropriate server tools from the list of Available server tools and click Add to associate
them with the user profile. You can select multiple tools by holding the Ctrl key while selecting. When
finished, click Next.


Note   Click the Allow user to launch client or server tools only for a single selected object
option to allow users to only launch client or server tools for a single selected object.


9 Select one or more appropriate client tools from the list of Available client tools, and click Add to
associate them with the user profile. You can select multiple tools by holding the Ctrl key while
selecting. When finished, click Next.


Note   Click the Allow user to launch client or server tools only for a single selected object
option to allow users to only launch client or server tools for a single selected object.


10 Select the saved consoles that are opened when users attach to the Global Manager, and click Next.
If a saved console is not selected, the default NotificationLog console will appear when the user
attaches to the Global Manager.


If the appropriate console is not listed, type the name of the console in the Add new console field,
and click Add. You can specify the name of a saved console whether or not the saved console exists.


11 Select the console operations for users associated with this user profile. You can select Other for
specific console operations or select one of the default sets of console operations:


n Read Only


n Operator


n Administrator


The default sets of console operations cannot be modified.


You can assign a modified version of one of the default sets of console operations by first
selecting the set that provides most of the console operations to assign. Then, select Other.
When you click Next, the console operations that correspond to the set you chose are
selected but you can enable or disable individual console operations.


12 Click Next. The final screen of the User Profile Wizard shows all newly created elements, including
the new user profile. By default, the user profile is enabled. You can disable it by clearing the box next
to the profile name.


13 Click Finish to display a dialog box confirming that the user profile elements were created.
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Deleting a user profile
To delete a user profile:


1 Select the user profile.


2 Select Edit > Delete.


You can disable a user profile without removing it. Disabling a user profile describes how to disable a
user profile.


Note   You must not delete the default-profile user profile. When users attach to a Global Manager
and their username is not assigned to a user profile, the default-profile user profile is applied. If the
default-profile does not exist, an error message appears and the Global Console will not open.


Modifying a user profile
To modify a user profile:


1 Select the user profile.


2 Modify the properties of the user profile in the right panel:


3 Change the notification list.


4 Add or remove users.


5 Add or remove server tools.


6 Add or remove client tools.


7 Add or remove saved consoles.


8 Add or remove console operations.


9 Click Apply.


Changes to a user profile may not be available to console users until they restart the Global Console.


Disabling a user profile


You can disable a user profile without having to delete it. When users of a disabled profile attach to the
Global Manager, they are assigned the default-profile. If the default-profile is deleted, users associated
with a disabled user profile cannot attach to the Global Manager.


To disable a user profile:


1 Select the user profile.


2 Clear the Enabled checkbox.


3 Click Apply.


VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


VMware, Inc.  19







Changing the notification list for a user profile


A notification list determines what notifications a user sees in the Global Console. Changing the
notification list associated with a user profile affects all the users of this profile.


To change the notification list for a user profile, select a new notification list from the Notification List
menu.


Adding or removing a user


A user can be associated with only one user profile. If you add a user to a user profile, the user is
automatically removed from its previous user profile.


To add a user to a profile:


1 Select the user profile from the tree.


2 From the Configure User Profile panel, click Modify List in the Users section.


This displays the Modify Users dialog box.


3 Add or remove users from the user profile.


4 Click OK.


5 Click Apply. Creating a user profile describes how to create a user account.


To remove a user, select the user profile in the tree. From the Configure User Profile panel, select the
user from the Users list and click Remove Selected. Click Apply at the bottom of the Configure User
Profile panel.


When you remove a user from a user profile, the user is automatically associated with the default-
profile until you assign the user to a different user profile.


Adding or removing a tool


Client and server tools are configured separately, however the process for adding or removing a client or
server tool from a user profile is the same.


To add a tool to a user profile:


1 Select the user profile in the tree.


2 From the Configure User Profile panel, click Modify List in the Server Tools or Client Tools
section.


The Modify Server Tools or Modify Client Tools dialog box appears.


3 Add or remove tools from the user profile.


4 Click OK.


5 Click Apply.


To remove a tool:


6 Select the user profile in the tree.


7 From the Configure User Profile panel, select a tool and click Remove Selected.
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8 Click Apply at the bottom of the Configure User Profile panel.


Adding or removing a saved console


A saved console provides users with a preconfigured view of the network, helping users focus on aspects
of the managed system they are to monitor.


To add a saved console to a user profile:


1 Select the user profile in the tree.


2 From the Configure User Profile panel, click Modify List in the Saved Consoles section.


The Modify Saved Consoles dialog box appears.


3 Add or remove saved consoles from the user profile.


4 Click OK.


5 Click Apply.


To remove a saved console:


6 Select the user profile in the tree.


7 From the Configure User Profile panel, select a saved console and click Remove Selected.


8 Click Apply at the bottom of the Configure User Profile panel.


Adding or removing console operations


Console operations are the functions and commands a user can invoke through the Global Console. By
adding or removing console operations, an administrator can determine the level of access a user has to
console operations.


To add or remove console operations for a user profile:


1 Select the user profile in the tree.


2 From the Configure User Profile panel, click Modify List in the Console Operations section.


The Console Operations dialog box appears.


3 Select or clear console operations for the user profile.


Note   In addition, you can select one of the three default groups of console operations and apply it to
the user profile.


4 Click OK to close the dialog box.


5 Click Apply at the bottom of the Configure User Profile panel.


Configuring users
Topics in this section include:


n Creating a user account
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n Deleting a user account


Creating a user account
You can create new users in one of the following ways:


n Through the User Profile Wizard when you create a user profile as described in Creating a user
profile.


n Through the User Wizard as described below.


n Through the sm_config utility as described in The sm_edit utility.


To create a new user with the User Wizard:


a Select the Launch User Wizard toolbar button.


The User Creation Wizard appears.


b Type the name of the new user. The username must be unique. Click Next.


c Select a user profile for this user from the list box.


d Do one of the following:


n Click Next to display a confirmation screen.


n Click Finish to create the user.


e Add the username and password in the serverConnect.conf file used by the Global Manager.


Deleting a user account
To delete a user:


1 Select the user in the tree.


2 Select Edit > Delete.


Note   Do not disable or remove the Admin user account. If the Admin user account is removed or
disabled, but other users still have the same privileges, none of the applications can be shut down.


Configuring system defaults
To configure system defaults:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the Adapter Platform (INCHARGE-OI).


3 Expand ICS Configuration.


4 Click System Defaults.


The Configure System Defaults interface appears, as illustrated in Global Manager Administration
Console — Configure System Defaults.
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Figure 2‑2.  Global Manager Administration Console — Configure System Defaults


5 Type or select your system defaults configuration options.


6 Click Apply.


System default parameters describes the system default parameters.


Table 2‑2.  System default parameters


Parameter Description


Auto acknowledgement interval Defines interval, in seconds, after which an inactive and unowned notification is
acknowledged. Notifications that are acknowledged by the Global Manager are owned by the
user SYSTEM.


Default: 300 seconds


Inactive auto archive interval Defines interval, in seconds, after which an inactive and acknowledged notification is
archived. Default is 14400 seconds (4 hours). If this value is set to zero, archiving is disabled
and notifications will not be deleted, causing Global Manager to use more memory.


Audit trail size limit Defines the number of audit log entries for each notification that are saved and visible in the
Global Console before the log contents are archived. When this limit is reached, half of the
entries are written to the notification archive.


Default: 100 entries


Note   System defaults cannot be deleted.
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Configuring domains
Topics in this section include:


n Creating a domain


n Modifying domains


n Deleting domains


Creating a domain
To create a domain:


1 From the Global Manager Administration Console, select Edit > New Domain.


The Domain Creation Wizard appears.


2 Type the name of the domain server in the Domain Name field.


3 Type the description of the domain in the Domain Description field, and click Next.


Note   To create a domain by using the Copy Existing option, select an existing domain server from
the Copy Existing list, type a Domain Name, and click Finish.


4 Select the domain type. Available options include:


n Use Default Type


Note   This option is available only when copying an existing domain.


n Create New Type


If this option is selected, type the name of the domain type in the Type Name field.


To copy an existing domain type, select an existing domain type from the Copy Existing list.


n Select Existing Type


If this option is selected, select a domain type from the Select Type list.


5 Click Next.


6 Edit the domain settings, and click Next.


Domain settings defines the available domain settings.


Table 2‑3.  Domain settings


Option Definition


DXA file Defines the DXA configuration file.


Hook script: enable Enables the hook script.


Note   If the hook script is enabled, type the path for the hook script in the field.
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Table 2‑3.  Domain settings (Continued)


Option Definition


Minimum certainty Defines the minimum certainty. Default value: 0.01


Smoothing interval Defines the smoothing interval. Default value: 65


The instance that is created when the domain creation process is complete appears.


Note   By default, the domain is enabled. If the domain is part of a domain group, it is only enabled if the
domain group it belongs to is enabled. To disable the domain, clear its checkbox.


1 Click Finish.


Modifying domains
To modify a domain:


1 Open the Global Manager Administration Console.


2 From the ManagerList, select the Adapter Manager (INCHARGE-OI).


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domains.


6 Click the appropriate domain.


The Configure Domaininterface appears, as illustrated in
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Figure 2‑3.  Global Manager Administration Console — Configure Domain interface


7 Type the appropriate configurations.


Domain parametersdescribes the available domain parameters.


Global ManagerAdministration Console — Configure Domain interface.


Table 2‑4.  Domain parameters


Parameter Description


Enable Enables the domain.


Domain description Provides a description of the domain.


Domain type Defines the domain type.


Show type details Displays the domain type information.


1 Click Apply.


2 Click Reconfigure.


Note   Configuration changes are not applied until Reconfigureis clicked. Clicking Reconfigurestarts
the data synchronization process. Click Reconfigureonly after all updates to domains, domain tags,
domain groups, and domain types have been made.


Deleting domains
To delete domains:


1 Open the Global Manager Administration Console.
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2 From the Manager list, select the Adapter Platform (INCHARGE-OI).


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domain.


6 Click the appropriate domain.


7 Select Edit > Delete.


The selected domain is deleted.


Note   Domains that refer to other domains cannot be deleted.


Configuring domain types
Topics in this section include:


n Creating domain types


n Modifying domain types


n Deleting domain types


Creating domain types
To create a domain type by using the Domain Groups Creation Wizard:


1 From the Global Manager Administration Console, select Edit > New Domain Type.


The Domain Groups Creation Wizard appears.


2 Select a type to be copied from the Copy Existing list.


3 Type a name in the Type Name field.


4 Type a description in the Type Description field.


5 Click Next.


6 Edit the domain type settings, and click Next.


Domain type settings defines the available domain type settings.


Table 2‑5.  Domain type settings


Option Definition


DXA file Defines the DXA configuration file.


Hook script: enable Enables the hook script.


Note   If the hook script is enabled, type the path for the hook script in the field.
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Table 2‑5.  Domain type settings (Continued)


Option Definition


Minimum certainty Defines the minimum certainty. Default value: 0.01


Smoothing interval Defines the smoothing interval. Default value: 65


1 Select the servers from the Available Domains list.


2 Click Add to move the server to the Selected Domains list.


This defines the servers associated with the new domain type.


Note   Domains cannot be removed from a domain type — they can only be reassigned to another
domain type. By adding domains, you are only reassigning the domains to a different domain type.
Newly added domains appear in green text. You can only delete domains displayed in green text.
After clicking Apply, the domains cannot be deleted.


3 Click Next.


Objects that will be created after the domain type creation process is complete.


4 Click Finish. The configuration objects are created in the server.


Modifying domain types
To modify a domain type:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the Adapter Platform (INCHARGE-OI).


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domain Types.


6 Click the appropriate INCHARGE Domain Type.


The Configure Domain Type interface appears, as illustrated in Global Manager Administration
Console — Configure Domain Type interface.
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Figure 2‑4.  Global Manager Administration Console — Configure Domain Type interface


7 Type the appropriate configurations.


Domain type configuration parameters defines the available domain type configuration parameters.


Table 2‑6.  Domain type configuration parameters


Parameters Definition


Type description Defines the domain type.


DXA configuration file Defines the DXA configuration file.


Hook script: enable Enables the hook script.


Note   If the hook script is enabled, type the path for the hook script in the field.


Minimum certainty Defines the minimum certainty. Default value: 0.01


Smoothing interval Defines the smoothing interval. Default value: 65


Domains Defines the domains associated with the domain type.


Note   Click Modify List to add domains, select a domain from the list and click Remove
Selected to remove domains, and click Restore to restore previously configured domains.
Domains cannot be removed from a domain type, they can only be reassigned to another
domain type.


1 Click Apply.
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2 Click Reconfigure.


Note   Configuration changes are not applied until Reconfigure is clicked. Clicking Reconfigure
starts the data synchronization process. Click Reconfigure only after all updates to domains, domain
tags, domain groups, and domain types have been made.


Deleting domain types
To delete domain tags:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the Adapter Platform (INCHARGE-OI).


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domain Types.


6 Click the appropriate domain type.


7 Select Edit > Delete.


The selected domain type is deleted.


Note   Domain types that refer to other domains cannot be deleted.


Configuring security for the Adapter Platform
It is important to secure access to the Adapter PlatformServer. Service Assurancecomponents
authenticate users and determine their privileges through three files: serverConnect.conf,
clientConnect.conf, and brokerConnect.conf. These files ensure that only authorized users access
Service AssuranceServer applications. Use sm_editto modify these files, which are located in
BASEDIR/smarts/conf.


The Adapter Platformfunctions as a server application. The following are possible clients of the
Adapter PlatformServer:


n Broker


n Command line utilities (dmctl)


n Global Manager


n sm_ems


n SNMP Trap Adapter(Receiver)


n Syslog Adapter


VMware Smart Assurance System Administration Guideprovides a complete list of server and client
programs and a more detailed explanation of the Service Assurancesecurity mechanism.
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Security configuration of the Adapter Platformprovides an overview of the security files required in a
typical deployment of the Adapter Platform. A circle in the figure indicates that the component
represented by the adjacent box is a client application. An arrowhead indicates that the component
represented by the adjacent box is a server application. For example, the Adapter Platformis a client
of the broker and the Adapter Platformhas five clients”the broker, the Global Manager, the
SNMP Trap Adapter, the Syslog Adapter, and sm_ems. Although not depicted in the figure, the
SNMP Trap Adapter, the Syslog Adapter, and sm_ems are also clients of the Broker because
everything is a client of the Broker.


Note   In general, the Global Managerand the Adapter Platformare deployed on different hosts. If the
Adapter Platformresides on the same host as another Service Assuranceserver application, such as
the Adapter Platform, then they can share the same serverConnect.conf file. Likewise, if clients of the
Adapter Platformreside on the same host as other Service Assuranceclient applications, they too can
share the same clientConnect.conf file.


Figure 2‑5.  Security configuration of the Adapter Platform


The following sections provide examples of authentication records for the client programs,
SNMP Trap Adapter(Receiver), Syslog Adapter, and sm_emscommand line interface and
corresponding records for the server program, Adapter PlatformServer.


The VMware Smart Assurance System Administration Guideprovides examples of authentication
records for the broker and the Global Manager.


VMware Smart Assurance SNMP Trap Adapter security
The SNMP Trap Adapter is a client of the Adapter Platform Server. As such it will use information in the
clientConnect.conf file to provide authentication information to the Adapter Platform Server. The
Adapter Platform Server will compare this information to entries in the serverConnect.conf file to validate
the connection. Thus, both these files must be configured.
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The clientConnect.conf file must be configured on the host where the SNMP Trap Adapter runs. In the
clientConnect.conf file you should create an entry for the system user ID running the SNMP Trap Adapter
with a corresponding VMware Smart Assurance username and password. For example:


trap-uid1 : INCHARGE-OI : admin : changeme


where:


n trap-uid1 is the system user ID running the SNMP Trap Adapter


n INCHARGE-OI is the Adapter Platform Server name


n admin is the VMware Smart Assurance login username


n changeme is the VMware Smart Assurance login password


The serverConnect.conf must be configured on the same host as the Adapter Platform. In the
serverConnect.conf, an entry must exist that corresponds to the VMware Smart Assurance username
and password specified in the clientConnect.conf file for the system user ID running the
SNMP Trap Adapter. The VMware Smart Assurance user must be given All privileges. For example:


INCHARGE-OI : admin : changeme : ALL


where:


n INCHARGE-OI is the Adapter Platform Server name (you could use an * to indicate all
Service Assurance servers)


n admin is the VMware Smart Assurance login username


n changeme is the VMware Smart Assurance login password


n ALL is the privileges granted this user


The SNMP Trap Adapter does not have to run on the same host as the Adapter Platform.
VMware Smart Assurance System Administration Guide provides more information about security
configuration.


VMware Smart Assurance Syslog Adapter security
The Syslog Adapter is a client of the Adapter Platform Server. As such it will use information in the
clientConnect.conf file to provide authentication information to the Adapter Platform Server. The
Adapter Platform Server will compare this information to entries in the serverConnect.conf file to validate
the connection. Thus, both these files must be configured.


The clientConnect.conf file must be configured on the host where the Syslog Adapter runs. In the
clientConnect.conf file you should create an entry for the system user ID running the Syslog Adapter with
a corresponding VMware Smart Assurance username and password. For example:


syslog-uid1 : INCHARGE-OI : admin : changeme
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where:


n syslog-uid1 is the system user ID running the Syslog Adapter


n INCHARGE-OI is the Adapter Platform Server name


n admin is the VMware Smart Assurance login username


n changeme is the VMware Smart Assurance login password


Note   The system user ID that starts the Syslog Adapter will need administrative privileges.


The serverConnect.conf must be configured on the same host as the Adapter Platform. In the
serverConnect.conf, an entry must exist that corresponds to the VMware Smart Assurance username
and password specified in the clientConnect.conf file for the system user ID running the
Syslog Adapter.


The VMware Smart Assurance user must be given All privileges. For example:


INCHARGE-OI : admin : changeme : ALL


where:


n INCHARGE-OI is the Adapter Platform Server name (you could use an * to indicate all
Service Assurance servers)


n admin is the VMware Smart Assurance login username


n changeme is the VMware Smart Assurance login password


n ALL is the privileges granted this user


The Syslog Adapter runs on the same host as the Adapter Platform. The
VMware Smart Assurance System Administration Guide provides more information about security
configuration.


sm_ems command line interface security
The sm_ems command line interface may or may not run on a host different from the Adapter Platform
Server. The clientConnect.conf file must be configured on the host running the command line interface.
You should create a unique username and password that matches a user in serverConnect.conf and give
that user All privileges. Typically, when using the command line interface from a third-party application,
the username and password should not be prompted. However, if you want to run sm_ems manually,
then prompting could be used. The VMware Smart Assurance System Administration Guide provides
more information about security configuration.
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Starting and stopping the Adapter Platform Server
If you installed the Adapter Platform Server as a service, it automatically starts when the system starts up.
The following instructions describe how to use the sm_service utility to manually start and stop the
Adapter Platform Server.


Note   To use the sm_service utility to install a service or start a service, you must have administrative
privileges on the local host.


Issue one of the following from the command line:


         BASEDIR/smarts/bin/sm_service start ic-icoi-server


or


         BASEDIR/smarts/bin/sm_service stop ic-icoi-server


The VMware Smart Assurance System Administration Guide provides more information about the
sm_service utility or about how to modify sm_service options.


Default sm_service parameters for Adapter Platform Server
When the Adapter Platform Server is installed as a service during the installation process, the
Adapter Platform Server is set up with default parameters. The default parameters and their values are:


t /InCharge/SAM/smarts/bin/sm_service install


--startmode=runonce --name=ic-icoi-server


--description=”SMARTS SAM Adapter Platform Server”


/C:/InCharge/SAM/smarts/bin/sm_server


--name=INCHARGE-OI


--config=icoi


--port=0


--ignore-restore-errors


--output s 


The sm_edit utility
As part of the VMware Smart Assurance deployment and configuration process, you need to modify
certain files. User modifiable files include configuration files, rule set files, templates, and files (such as
seed files and security configuration files) that contain encrypted passwords. Original versions of these
files are installed into appropriate subdirectories under the BASEDIR/smarts/ directory. Examples follow:


Examples


n The original versions of the Global Manager configuration files on UNIX are installed
to /opt/InCharge/SAM/smarts/conf/ics
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n Original versions of files should not be altered. If a file requires modification, it must be stored as a
local copy of the file in BASEDIR/smarts/local or one of its subdirectories. For example:


Examples


n A modified dxa-sam.conf file on UNIX should be saved to /opt/InCharge/SAM/smarts/local/conf/ics


n VMware Smart Assurance software is designed to first search for user modifiable files in
BASEDIR/smarts/local or one of its subdirectories. If a modified version of a file is not found in the
local area, the software then searches appropriate nonlocal directories.


To facilitate proper file editing, VMware, Inc. provides the sm_edit utility with every product. When
used to modify an original version of a file, this utility automatically creates a local copy of the file and
places it in the appropriate location under BASEDIR/smarts/local. This ensures that the original
version of the file remains unchanged. You can invoke sm_edit from the command line.


To invoke the s m_edit utility from the command line, specify the path and the name of the file to edit
under BASEDIR/smarts. If multiple products are running on the same host, invoke sm_edit from the
bin directory of the product with the files to edit.


Example


To edit the configuration file for the Global Manager, invoke the sm_edit utility as follows:


# /opt/InCharge/SAM/smarts/bin>sm_edit conf/ics/dxa-sam.conf


In this example, the sm_edit utility automatically creates a local copy of the dxa-sam.conf file in
the /opt/InCharge/SAM/smarts/local/conf/ics directory and opens the file in a text editor. If a local
version of the file already exists, the sm_edit utility opens the local version in a text editor. In addition,
sm_edit creates any necessary subdirectories.


The VMware Smart Assurance System Administration Guide provides additional information about
the sm_edit utility.
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VMware Smart Assurance SNMP
Trap Adapter 3
This chapter includes the following topics:
n Overview


n Configuring the SNMP Trap Adapter to receive SNMPv3 traps


n Configuring trapd.conf (trap exploder and trap receiver)


n Configuring the SNMP Trap Adapter to forward notifications


n Starting and stopping the SNMP Trap Adapter


Overview
The Simple Network Management Protocol (SNMP) Trap Adapter (Receiver) collects and parses SNMP
traps and generates notifications to the Global Manager based on the contents of the traps. The Trap
Adapter can receive SNMP v1, v2c, or v3 traps. However, it forwards only v1 or v2c traps. If SNMPv3
traps are received, they are converted to one of the other formats before being sent to a Domain Manager
or to another trap receiver.


Two deployment scenarios are possible. The
VMware Smart Assurance Service Assurance Manager Deployment Guide provides more information.


Scenario 1: Single trap receiver associated with Adapter Platform
In Scenario 1, a single trap receiver listens for all traps from the network.


Note   Do not use this scenario in a production environment! This scenario may be employed for test or
debug purposes when forwarding small numbers of traps to the Adapter Platform and possibly one other
manager such as IP Availability Manager.


In this scenario, you must edit the following files:


n The InCharge/SAM/smarts/conf/icoi/trapd.conf file to indicate the port and hostnames to forward the
traps to. Configuring trapd.conf (trap exploder and trap receiver) provides more information.
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n If you plan to receive SNMPv3 traps from the network, you must edit a seed file as explained in 
Editing seed files load SNMPv3 agent credentials.


Note   This trap receiver (ic-trapd-receiver) is the one that starts automatically if you install the
SNMP Trap Adapter as a service. Default sm_service parameters for the SNMP Trap Adapter
provides more information.


n The InCharge/SAM/smarts/conf/icoi/trap-mgr.conf file to convert traps to notifications and send them
on to the Adapter Platform. Configuring the SNMP Trap Adapter to forward notifications provides
more information.


n The ics-default.xml file to allow communication (forwarding of notifications) between the
Adapter Platform and the Global Manager.


Scenario 2: Trap exploder forwards traps to a second trap receiver
In Scenario 2, there are two trap receivers. The first trap receiver, referred to as the trap exploder,
receives all traps from the network and selectively forwards only those traps that meet certain
configuration requirements. This scenario is the recommended deployment scenario. It may be employed
when a large volume of traps comes from the network and you need to send traps to multiple
Domain Managers as well as to a second trap receiver associated with Adapter Platform.


To set up the trap exploder, configure the following files:


n Edit BASEDIR/smarts/conf/trapd/trapd.conf and specify the port to forward traps to as well as the
hostname of the Domain Managers and Adapter Platform. (BASEDIR may be either InCharge/IP/ or
InCharge/SAM/. The same trapd.conf file is shipped with both products.) Configuring trapd.conf (trap
exploder and trap receiver) provides more information.


n If you plan to receive SNMPv3 traps from the network, you must edit a seed file as explained in 
Editing seed files in order to load SNMPv3 agent credentials.


n Copy this seed file to the BASEDIR/smarts/conf/trapd path in the product (IP or SAM) where the trap
exploder is running. For example, to start the trap exploder from the Service Assurance Manager:


tIncharge/SAM/smarts/bin>sm_trapd --port=162 --rules=default --name=TRAP_EXPLODER --seed=seedfiles


With SAM 9.2, the behaviour of sm_trapd option, --rules=default is changed so that it will no longer
log received traps by default.


To enable logging of received traps, follow the procedure:


a Goto BASEDIR/smarts/rules/trapd and type the following command to edit the trapParse.asl file:


./sm_edit <BASEDIR>/smarts/rules/trapd/trapParse.asl
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b Type the following command to change the setting of debug from FALSE to TRUE on line 25 in
the trapParse.asl file:


debug = TRUE; /* Set to TRUE to enable printing of trap data */


c Save the modified file and then restart sm_trapd.


To start the trap exploder as a service you must carry out a manual step in which you need to
ensure the name is unique.


For example:


Note   t s indicates the command must be typed as one line. Type the command from the
BASEDIR/smarts/bin directory for the Service Assurance Manager product.


t /InCharge/SAM/smarts/bin/sm_service install --force --unmanaged


--startmode=runonce 


--description="VMware Smart Assurace SNMP Trap Exploder Server"


--name=trap_exp


 /InCharge/SAM/smarts/bin/sm_trapd                                                 


    --name=TRAP_EXPLODER 


    --config=trapd 


    --port=162


    --sport=9180


    --seed=seedfile


    --rules=default 


    --output s


To configure the second trap receiver (associated with Adapter Platform), edit both files listed
below:


n InCharge/SAM/smarts/conf/icoi/trapd.conf, as described in Configuring trapd.conf (trap exploder and
trap receiver).


n InCharge/SAM/smarts/conf/icoi/trap-mgr.conf file, as described in Configuring the SNMP Trap
Adapter to forward notifications.


n Start the trap receiver associated with the Adapter Platform as a service (if not already installed as a
service). Default sm_service parameters for the SNMP Trap Adapter provides more information.


Configuring the SNMP Trap Adapter to receive SNMPv3
traps
You may want to receive SNMPv3 traps from some of your network devices. The SNMP Trap Adapter
supports the following SNMPv3 features:


n The ability to receive SNMPv3 traps, convert them to SNMPv2c, and forward them in SNMPv2c
format to other elements of the VMware Smart Assurance system such as IP Domain Managers or
Adapter Platform.
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n The use of the SNMPv3 User Security Model (USM) for authentication and privacy, as described in
RFC-3414.


n The ability to load USM user credentials by using text files (similar in format to existing IP domain
manager seed files).


n The use of authentication protocols MD5 and SHA-1 (RFC-3414).


n The use of privacy protocols DES (RFC-3414) and AES-128 (RFC 3826).


If the SNMPv3 network devices are configured to support authentication and encryption, you have to
load the agent credentials by using a seed file to enable the SNMP Trap Adapter to receive the
SNMPv3 traps.


Configuring the seed file to load SNMPv3 credentials
A seed file is used to load the SNMPv3 User Security Model (USM) data into the Local Credentials
Database (LCD). The SNMP Trap Adapter recognizes SNMPv3 device entries by the engineID/userName
pair for a given device listed in the seed file.


A sample seed file is shipped with the Service Assurance Manager software in the
InCharge/SAM/smarts/conf/icoi path. The format (syntax) of the seed file used for the
SNMP Trap Adapter is the same as it is for an IP domain manager; however, there may be slight
variations in field values when used for IP discovery. The
VMware Smart Assurance IP Manager User Guide provides specific seed file values required for the
discovery process.


Editing seed files provides more details about editing seed file entries for use by the SNMP Trap Adapter.


If you plan to use the seed file for both IP discovery and for the SNMP Trap Adapter Scenario 1 (single
trap receiver only), then ensure the seed file resides in two places:


n InCharge/IP/smarts/conf


n InCharge/SAM/smarts/conf/icoi


If you plan to use the seed file for the SNMP Trap Adapter Scenario 2 (trap exploder), then ensure the
seed file is in the following path (not in the InCharge/SAM/smarts/conf/icoi path mentioned above):


n BASEDIR/smarts/conf/trapd (where BASEDIR may be either InCharge/SAM/ or InCharge/IP/)


Be sure to use the sm_edit utility to edit the seed file so that passwords will be encrypted.


Verify that the secret phrase used to re-encrypt the seed file matches for all products receiving traps
from the SNMP Trap Adapter. The VMware Smart Assurance System Administration Guide provides
more information about configuring the secret phrase used to encrypt seed files.


Note   Although the SNMP Trap Adapter can parse plain text passwords from unencrypted seed files,
VMware strongly recommends that all seed files be encrypted by using the sm_edit utility. The
VMware Smart Assurance System Administration Guide provides more information.
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Editing seed files
The format of the seed file is identical to a standard IP Domain Manager seed file, but the semantics are
slightly different. In IP, the sections are keyed by the hostname or IP address (the first line in each block).
SNMPv3/USM uses the engineID of the SNMP agent in the network device to uniquely identify the agent
which sent the trap. The hostname (or IP address) is ignored completely. For each engineID, there will be
one or more users. The engineID/userName pair constitutes the unique key for the SNMP Trap Adapter
seed file.


Note   To receive SNMPv3 traps, you must uncomment and edit specific lines. For example, you must
type a valid hostname or IP address, set the SNMPVERSION field to V3, and edit the seed file fields
beginning with the comment: # The following are for SNMPv3 entries. Recommended practice is to place
each SNMPv3 field/value pair on its own line. Sample SNMPv3 seed file entries provides more
information.


The first line in the seed file must appear as follows if you intend to encrypt both the AUTHPROTOCOL
and PRIVPROTOCOL passwords:


#<encrypted seed>:1.0:AUTHPASS,PRIVPASS


When you edit the seed file by using the sm_edit utility, this line controls which field values in the seed
file should be encrypted (for example, the AUTHPASS and PRIVPASS password fields).


The sm_edit utility may be invoked in a non-interactive mode by using the noedit option, for example:


sm_edit --noedit conf/trapd/seedfile


This will cause sm_edit to read the seed file, encrypt the fields specified by the first line, and write them
back in an encrypted mode.


Note   While sm_trapd can parse plain text passwords from unencrypted seed files, VMware strongly
recommends that all seed files be encrypted by using the sm_edit utility. Failure to encrypt the seed files
(and destroy any plaintext intermediates) will expose plaintext passwords to anybody who can read the
file.


Sample SNMPv3 seed file entries


#<encrypted seed>:1.0:AUTHPASS,PRIVPASS


128.221.19.8 


SNMPVERSION=V3 


USER=shaAESUser 


AUTHPROTOCOL=SHA 


AUTHPASS=123ABC456#$%123abc456#$%


PRIVPROTOCOL=AES 


PRIVPASS=456123abc456#$%456123ABC456#$%


ENGINEID=0000000902000003E333C440


qa-gwipv6 


SNMPVERSION=V3 
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USER=MD5DesUser 


AUTHPROTOCOL=MD5 


AUTHPASS=789ABC456#$%789abc456#$%


PRIVPROTOCOL=DES


PRIVPASS=789123abc456#$%789123ABC456#$%


ENGINEID=000000090200000F134B93C


SNMPv3-related seed file field descriptions lists and describes seed file fields for SNMPv3.


Table 3‑1.  SNMPv3-related seed file field descriptions


Field Description


AUTHPROTO
COL


Specifies the authentication protocol in use by the network device sending the SNMPv3 traps. Valid entries
include MD5, NONE, or SHA. For the SNMP trap processor, if no value is specified, it defaults to NONE.


Note   The default value used in the discovery process by the IP Manager may differ. The
VMware Smart Assurance IP Manager Release Notes provide more information.


AUTHPASS Authentication password. This may be 64 characters long. VMware, Inc. recommends the use of complex
passwords (for example, a long string of uppercase or lowercase alpha characters, numbers, and special
characters)


ENGINEID An engineID is a unique string identifying an SNMP engine. It does not uniquely identify a DEVICE, because
technically, a device can host multiple SNMP agents. So, the engine ID is assigned to each agent, not device.


If you have VMware Smart Assurance IP Availability Manager running, you can use the sm_tpmgr -s <server
name> --dump-agents command to find the engineIDs for those agents generating SNMPv3 traps in your
network.


PRIVPASS Privacy (encryption) password. This may be 64 characters long. VMware, Inc. recommends the use of complex
passwords (for example, a long string of uppercase or lowercase alpha characters, numbers, and special
characters).


PRIVPROTOC
OL


Privacy (encryption) protocol in use by the router sending the SNMPv3 traps. Valid entries include DES, NONE,
or AES. If no entry, defaults to NONE.


To simplify debugging of your network device configurations, VMware, Inc. recommends that you first
establish that SNMPv3 traps sent from the network device in noAuthNoPriv mode are processed
correctly. When you are sure that it works, use authNoPriv and finally authPriv, after verifying correct
operation at each step.


Encryption (Privacy) options supported in SNMPv3 seed file
The following seed file options are used to encrypt SNMPv3 traps coming from the network to the SNMP
trap exploder (SNMP Trap Adapter):


n PRIVPASS


n PRIVPROTOCOL


The VMware Smart Assurance IP Manager User Guide and the
VMware Smart Assurance System Administration Guide provide additional information.
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To enable the SNMPV3 Privacy Protocol and Privacy Password fields located in the Add Agent dialog
box:


a From the Add Agent dialog box, click Advanced Options.


The Advanced Options pane appears.


b Select V3 from the SNMP Version field.


The SNMP V3 Specifications pane appears.


c Select a privacy protocol from the Privacy Protocol field.


d Type a password in the Privacy Password field.


e Click OK.


Load the seed file into the Local Credentials Database (LCD)
Provide agent credentials to the SNMP Trap Adapter by loading one or more seed files using the
importSeedFile.asl script. This script writes the content of the seed file to the LCD.


The sample startup script given above will cause the SNMP Trap Adapter to read in a pre-existing seed
file when the program begins execution. This is most useful in a test environment, or in a fairly small and
static installation. In a large network, it is expected that new devices will be added, and user credentials
changed, on a regular basis. To accommodate this, the SNMP Trap Adapter can read seed files while it is
running.


To read a new seed file, invoke the ASL script, importSeedFile.asl, and give a single command line option
specifying the name of the seed file:


1 Go to BASEDIR/smarts/bin for the Service Assurance Manager product.


2 Type the following command:


tsm_adapter -s TRAP-INCHARGE-OI -D seed=seedfile trapd/importSeedFile.asl s


The seed file will be parsed, and the new USM credential data will be merged into the existing LCD.


Managing seed file updates
The seed file entries used by the SNMP Trap Adapter are keyed by engineID and userName pair. Any
entry which has the same engineID and userName pair as existing data in the LCD will result in the new
data overwriting the old.


In some cases, it may be convenient to split the USM credential data into several seed files (for example,
one seed file corresponding to each of several IP domain managers). You may run importSeedFile.asl
after for each seed file; and they will be read in turn. All of the data from all of the seed files is merged into
a single LCD. If there are duplicate engineID and userName pairs between files, the last one read is the
one which will be kept.
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There is currently no way to delete a user from the LCD. In many instances, having obsolete user data in
the LCD will cause no operational harm, and old entries can simply be ignored. If you want, you may
import a seed file containing the obsolete engineID and userName pair with a non-matching password to
effectively disable that entry.


Configuring trapd.conf (trap exploder and trap receiver)
To configure the trap receiver to listen for traps, edit the trapd.conf file. There are multiple trapd.conf files
shipped with the VMware Smart Assurance product s. Configuring trapd.conf (trap exploder and trap
receiver) lists and describes the parameters in the trapd.conf file.


To determine which trapd.conf file to edit depends upon your deployment scenario:


n For Scenario 1 (single trap receiver), edit InCharge/SAM/smarts/conf/icoi/trapd.conf. For example, to
forward traps to the IP Availability Manager, remove the # to uncomment the FORWARD line:


# Traps required by InCharge IP Availability Manager (AM)


#


# Generic: coldStart, warmStart, LinkUp, LinkDown


# FORWARD: *.*.*.* .* <0-3> * host:port


For example:


FORWARD: *.*.*.* .* <0-3> * AM_HOST-NAME:AM-PORT


n For Scenario 2 (one trap exploder and one trap receiver), edit:


               BASEDIR/smarts/conf/trapd/trapd.conf 


FORWARD: *.*.*.* .* * * TRAP-ADAPTER_HOST-NAME:TRAP-ADAPTER-PORT


FORWARD: *.*.*.* .* <0-3> * AM_HOST-NAME:AM-PORT


Parameters in trapd.conf file
The trapd.conf file is located under:


n For Trap Adapter: <BASEDIR>/smarts/conf/trapd directory


n For Trap Exploder: <BASEDIR>/smarts/conf/icoi directory


You need to use sm_edit to edit the parameters in the trapd.conf file. Parameters in trapd.conf file
lists and describes the parameters in the trapd.conf file.
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Table 3‑2.  Parameters in trapd.conf file


Configuration file
parameter Description Valid values


Applicable for
Adapter or
Exploder


PORT The UDP port number the trap adapter listens to.


If NetView or OpenView is running on this system, during
installation, the value is set to 9000, otherwise it is set to 162


0-65535 Adapter


WINDOW This is the de-duplication window, in seconds. The maximum
amount of time between receiving similar traps, before the
second trap is considered unique.


To disable de-duplication feature make all traps unique. That is,
do not specify a value for this parameter or use zero. If a value
is not specified for this parameter, or it is set to zero, de-
duplication is disabled.


Non-negative
integer


Adapter


THREADS The number of trap processing threads to spawn. The
determines how many traps can be processed concurrently.
The maximum value is 25. If not set, the default value is 1.


0 - 25 Adapter and
Exploder


ASCII This controls the formatting of non-printable characters. If the
value for ASCII is set to FALSE or if “--ascii” is not specified on
the commandline for starting sm_trapd, sm_trapd converts the
entire value of that OID into a printable UTF-8 coding string,
such as a varbind. For example, .1.3.6.1.4.1.333.1 ->
"abcd012" is converted into .1.3.6.1.4.1.333.1 -> "61 62 63 64
C3 96 30 31 32".


If the value for this parameter is set to TRUE or if “--ascii” is
specified on the commandline for starting sm_trapd, sm_trapd
replaces all the non-printable characters with an “X” followed by
the HEX string of these characters using UTF coding. The
remaining printable characters of the original value (octet-
string) remain unchanged, such as the varbind. For example, .
1.3.6.1.4.1.333.1 -> "abcd012"


is then converted into .1.3.6.1.4.1.333.1 -> "abcdXC3X96012."


TRUE | FALSE Adapter and
Exploder


SOURCE This switch enables the trap processor to obtain the source
address of the IP packet, and makes it available to the
customer configurable .conf file and .asl scripts. If not set, value
is FALSE.


TRUE | FALSE Adapter and
Exploder


TAG Enables tagging of varbind values. When enabled, it streams
the value's type before each value. For example, INTEGER-32
3.


TRUE | FALSE Adapter and
Exploder
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Table 3‑2.  Parameters in trapd.conf file (Continued)


Configuration file
parameter Description Valid values


Applicable for
Adapter or
Exploder


QUEUE_LIMIT_MEGS This parameter helps limit the size of internal trap queue to the
stated size. The limit is not exact - the queue may grow slightly
larger than that. When the limit is reached, some traps will be
discarded. The default value is set to 200 MB. On reaching this
limit, the sm_trapd queue starts discarding traps.


When the queue starts discarding traps, a
trapdDiscardingTraps alert is generated, as defined in the
trap_mgr.conf file. If and when a device is identified as the
source of a trap storm, information about it is logged in the
sm_trapd log file. The alert is cleared once the incoming trap
rate to the sm_trapd reduces to a rate below which these traps
can be processed by the queue.


Non-negative
integer


Adapter and
Exploder


QUEUE_LIMIT_SECOND
S


Limit the time that a trap can remain in the internal trap queue.
This limit is even less exact than the size limit above. In
general, it is advisable to specify both. When traps start to
remain in the queue exceeding the time limit set, some traps
will be discarded. The default value is set to 480 seconds.


When the queue starts discarding traps, a
trapdDiscardingTraps alert is generated, as defined in the
trap_mgr.conf file. If and when a particular device is identified
as the source of a trap storm, information about it is logged in
the sm_trapd log file. The alert is cleared once the incoming
trap rate to the sm_trapd reduces to a rate below which these
traps can be processed by the queue.


Non-negative
integer


Adapter and
Exploder


ENABLE_FWD This parameter enables trap forwarding. Traps are only
forwarded if a forwarding criteria is specified. See the
FORWARD parameter for more information.


TRUE | FALSE Exploder


MATCH Determines whether traps are tested against all forwarding
criteria or up to the first criterion that matches. If forwarding
criteria is not specified, this parameter is ignored. Forwarding
criteria is specified in this file using the FORWARD parameter.
If not set, value is first.


all | first Exploder
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Table 3‑2.  Parameters in trapd.conf file (Continued)


Configuration file
parameter Description Valid values


Applicable for
Adapter or
Exploder


TIMESTAMP_RCV When receiving a trap, whether to forward the time from the
trap to ASL as the received time of the trap. The original
behavior of the trap processor received timestamps of this
format and this option allows that behavior. If set to FALSE this
defaults to sending the timestamp from the trap itself which is in
normal SNMP time format of hundredths of a second since
device boot.


TRUE | FALSE Adapter and
Exploder


FORWARD Specifies matching criteria for traps and the forwarding
destinations for matched traps. Valid syntax is as follows:


FORWARD<specific type> <<dest_opt> | 
<dest_entry>> \ [<<dest_opt> | <dest_entry>>...]


Where:


1 <dest_entry> is: <host>:<port> |
<host>:<port>:<community>


<host> is one of the following:


<host name>[:<ipVersion>]


<fully qualified domain name>[:<ipVersion>]


<IPv4 address>[:<ipVersion>]"["<IPv6 address>"]"


<ipVersion> is: v4 | v6 | v4v6 | v6v4 or similar values with
mixed case or uppercase letters.
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Table 3‑2.  Parameters in trapd.conf file (Continued)


Configuration file
parameter Description Valid values


Applicable for
Adapter or
Exploder


<port> is an integer


<community> is a community string


2 <dest_opt> is "-nosmtrapaddr" | "-usesmtrapaddr"


dest_opt -nosmtrapaddr disables the addition of MIB
variables representing the trap address type and trap
address. dest_opt -usesmtrapaddr enables the addition of
these MIBs. This is the default behavior. -nosmtrapaddr
and -usesmtrapaddr apply to destination entries that occur
after the option, until the end of the line or until a new
option overrides the active option.


Examples are provided below:


FORWARD: 192.168.250.<32-120> .* 6 * asterix:
5000 jupiter [3ffe:80c0:22c:
109:214:4fff:fe39:a73d]:2002


Here, all specific traps received from network devices in the
range from 192.168.230.32 to 192.168.230.120 will be sent to
asterix port 5000, jupiter port 162 and 3ffe:80c0:22c:
109:214:4fff:fe39:a73d port 2002.


FORWARD: * .* * * snake:9099:public1


All traps received from all network devices will be sent to host
snake port 9099.


Globbing can be used to specify values of the following fields: <address>, <OID>, <generic type>,
<specific type>. Field description lists and describes the fields:.
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Table 3‑3.  Field description


Field name Description


<address> Source IP address or host name of the SNMP agent sending the trap. Globbing can be used
to specify ranges of IP addresses.


Examples of valid values:


192.168.114.5


3ffe:80c0:22c:109:214:4fff:fe39:a73d


*.*.*.*


*:*:*


192.168.*.*


3ffe:80c0:22c:*


*.*.*.168


*:*:a73d


192.168.<120-123>.*


3ffe:80c0:22c:109:214:4fff:<0-ffff>:*


<OID> Enterprise OID of incoming trap. Globbing can be used to specify ranges of OIDs. Examples
of valid values:


.1.3.6.4.1.9


.1.3.*


.*


.1.3.6.4.1.<1-18>.*


<generic type> Generic type of incoming trap. Globbing can be used to specify ranges of trap numbers.
Examples of valid values: 0, 3, <0-5>


<specific type> Specific type of incoming trap, if valid. For standard (generic) traps this field is ignored.
Globbing can be used to specify ranges of trap numbers. Examples of valid values:


733, <130-156>, *


<host <[:port] |
[:port:community]>>


Destination to forward matched traps to. Multiple destinations can be specified. Host is
specified as an IP address or a host name. Port and Community are optional; IPv6
addresses need to be enclosed in square brackets [] if omitted, port 162 is used and the
community string of the incoming trap is preserved. Globbing cannot be used in this field.
Examples of valid values: cobra, snake.planet.net:6789, 192.76.70.21, [3ffe:80c0:22c:
109:214:4fff:fe39:a73d]:2002, 192.168.70.190:6789


Some more examples:


n All traps from all IPv4 addresses are forwarded to IPv6 host gifted.yahoo.com on port 2002:


 FORWARD: *.*.*.* .* * * gifted.yahoo.com:v6:2002


n All traps from all IPv6 addresses are forwarded to IPv6 host gifted.yahoo.com on port 2002:


 FORWARD: *:*:* .* * * gifted.yahoo.com:v6:2002


n All traps from all IPv6 addresses are forwarded to IPv6 host with address 3ffe:80c0:22c:
109:214:4fff:fe39:a73d on port 2002:


 FORWARD: *:*:* .* * * [3ffe:80c0:22c:109:214:4fff:fe39:a73d]:2002
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n All traps from all IPv4 addresses are forwarded to IPv6 host gifted.yahoo.com on port 2002, smarts
OIDs smTrapAddress and smTrapAddressType are not added when forwarding.


 FORWARD: *.*.*.* .* * * -nosmtrapaddr gifted.yahoo.com:v6:2002


n All traps from all IPv6 addresses are forwarded to IPv6 host gifted.yahoo.com on port 2002, smarts
OIDs smTrapAddress and smTrapAddressType are not added when forwarding.


 FORWARD: *:*:* .* * * -nosmtrapaddr gifted.yahoo.com:v6:2002


n All traps from all IPv6 addresses are forwarded to IPv6 host with address 3ffe:80c0:22c:
109:214:4fff:fe39:a73d on port 2002, smarts OIDs smTrapAddress and smTrapAddressType are not
added when forwarding.


 FORWARD: *:*:* .* * * -nosmtrapaddr [3ffe:80c0:22c:109:214:4fff:fe39:a73d]:2002


n All traps from all IPv4 addresses are forwarded to IPv4 host amtest.smarts.com (on the default SMTP
port) and IPv6 host gifted.yahoo.com (on port 2002). MIB variables smTrapAddress and
smTrapAddressType are added when forwarding to amtest.smarts.com (default behavior). The same
OIDs are not added when forwarding to gifted.yahoo.com, due to the -nosmtrapaddr option that
precedes this destination entry.


 FORWARD: *.*.*.* .* * * ipam.smarts.com:v4:2002 -nosmtrapaddr gifted.yahoo.com:v6:2002


Configuring the SNMP Trap Adapter to forward
notifications
SNMP Trap Adapter configuration and script files describes the files that you use to configure the
SNMP Trap Adapter to forward notifications on to the Global Manager.


Note   You can define up to 25 trap processing threads in your local trapd.conf file, which includes a
definition and default value for THREADS. Running a multi-threaded trap adapter may eliminate the need
to send these traps to a forwarder.


To configure the SNMP Trap Adapter, complete the following steps:


1 Define the traps that you want to forward to the Global Manager in your local copy of trap_mgr.conf
file.


2 Set up the proper security between the Adapter Platform and the SNMP Trap Adapter. VMware Smart
Assurance SNMP Trap Adapter security provides more information.


3 Verify the port setting for the SNMP Trap Adapter. Verifying the SNMP Trap Adapter port setting
provides more information.


4 Configure the SNMP Trap Adapter to start and stop automatically.
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5 Start the SNMP Trap Adapter. Starting and stopping the SNMP Trap Adapter provides more
information.


Table 3‑4.  SNMP Trap Adapter configuration and script files


Directory under BASEDIR/ Filename
User
editable Description


smarts/conf/icoi trap_mgr.conf Yes Used to map incoming SNMP traps to notifications,
and to configure notification batch parameters.


Overview of trap_mgr.conf
The trap receiver uses the trap_mgr.conf configuration file to translate incoming traps into notifications
that are sent to the Global Manager. You need to use sm_edit to edit trap_mgr.conf (found at
BASEDIR/smarts/conf/icoi) to define the traps that you want to send to the Global Manager. For situations
requiring more advanced trap processing, an ASL script can be called for specific traps.


The trap_mgr.conf file contains several sections:


n The beginning of the file includes comments regarding the syntax of the file.


n The first line of code sets the BATCH_NOTIFY_INTERVAL. SNMP trap batching provides more
information about this interval.


n A default section, which lists default values for the fields. If, for a given trap, no value is set for a field,
the value from the default section is used. This section begins with BEGIN_DEFAULTS and ends with
END_DEFAULTS.


n Trap definition sections, which define mappings of information for specific traps or groups of traps.
There can be one or more trap definition sections. Each section begins with BEGIN_TRAP and
specifies the trap mapping by OID, generic trap number, and specific trap number. Each trap
definition ends with END_TRAP.


Default trap parameter section on page 61 provides more information. Chapter 7 VMware Smart
Assurance MIB for SNMP Traps includes the VMware Smart Assurance MIB implemented by
VMware, Inc. for SNMP traps.


SNMP trap example
Translation of SNMP trap to standard notification shows an example of a simple trap and how values in
the trap might populate fields in a Service Assurance notification. In this example, the SNMP trap consists
of five values:


n Enterprise OID


n Generic Trap Number


n Specific Trap Number


n System Name


The system name sent by the trap translates into the instance name.
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n Varbind 1


Varbind 1 translates into a text message for the notification.


Other fields in the notification get populated from values placed in the configuration file. For example,
the ClassName is Host not because the information was sent with the trap, but because an
association was made in the configuration file.


.1.3.6.1.4.1.2.1


0


0


HostNYC8


Operator requested reboot


SNMP Trap (simplified)


.1.3.6.1.4.1.2.1


0


0


HostNYC8


Operator requested reboot


Enterprise OID


Generic Trap Number


Specific Trap Number


System Name


Varbind 1


Incoming SNMP Trap


Cold Start


HostNYC8


InstanceName


EventName


Host


ClassName


EventType


MOMENTARY


EventText


Agent HostNYC restarted, reason=Operator requested reboot
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Severity


5


Standard Notification Fields


For this example, no translation into any standard notification fields. These fields are used as keys to
the configuration file.


Figure 3‑1.  Translation of SNMP trap to standard notification


The following is an example of a portion of the configuration file used by the SNMP Trap Adapter.
This example corresponds to Translation of SNMP trap to standard notification. When the trap
matches a trap definition (Enterprise OID, generic trap number, and specific trap number), the
Adapter Platform populates attributes in a notification based on entries in the trap definition. In the
example, the standard notification attribute ClassName is populated with the value Host:


BEGIN_TRAP  .1.3.6.1.4.1.2.1  0  0


ClassName:   Host


InstanceName:   $SYS$


EventName:   Cold Start


Severity:   5


EventType:   MOMENTARY


EventText:   Agent $SYS$ restarted, reason=$V1$


END_TRAP


Default trap parameter section
The format of the default section is as follows:


BEGIN_DEFAULTS


 ClassName:   SNMPTrap


 InstanceName:   $SYS$


 EventName:   $E$ $N$ $S$


 Severity:   2


 EventText:   Varbinds: $V*$


 Expiration:   7200


 State:   NOTIFY


 InMaintenance:   FALSE


 ClearOnAcknowledge:   TRUE


 EventType:   MOMENTARY


 SysNameOrAddr:   $A$


 UnknownAgent:   IGNORE


 LogFile:   NONE


END_DEFAULTS


The default section demonstrates that you can use variables in descriptions. Of particular note is the use
of the varbind variable with an asterisk for the EventText parameter. In this case, EventText stores the
value of all of the varbinds associated with a trap. By defining LogFile, the SNMP Trap Adapter logs all of
the traps unless a trap’s LogFile is defined as NONE.
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Trap definition sections
The configuration file contains multiple trap definitions. Each definition specifies what set of traps are
processed by the trap definition and what notification values are set for those traps. Incoming SNMP traps
are matched against trap definitions in a configuration file.


The beginning of each trap definition starts with BEGIN_TRAP. Each incoming trap is identified by three
fields following BEGIN_TRAP. These fields are: Enterprise OID, generic trap number, and specific trap
number. The format of the first line is:


BEGIN_TRAP <enterprise> <generic_trap> <specific_trap>


Each of the fields need to be separated by either a space or a tab. The first field contains the Enterprise
OID. The first six numeric values in this field are expected to conform to either the standard Enterprise
(vendor) prefix of 1.3.6.1.4.1 or the standard MIB-II (generic) prefix of 1.3.6.1.2.1. However, the
SNMP Trap Adapter does not restrict you to these numeric values. The first field can be any valid OID
number or the string ’any’ (or *).


You can specify a range or use wildcards in the range. For example, you can specify a range as .
1.3.6.1.4.1.<4-10> where the last numeric value can be within the range of 4 through 10. In the example
1.3.6.1.4.1.*, the “*” character matches any number for the last OID numeric value.


Additionally, you can list multiple OIDs at the beginning of each trap definition. Specifying multiple OIDs
allows the same trap definition to be used for multiple traps. The following example demonstrates listing
multiple OIDS, specifying a numeric value range, and using a wildcard:


BEGIN_TRAP .1.3.6.1.4.1.1.2.<23-40> 6 1 .1.3.6.1.4.1.6.* 6 1 


Trap definitions are read from left to right. For example, suppose a configuration file includes multiple trap
definitions such as:


BEGIN TRAP .1.2.3.4.5.6.*   *  2


BEGIN TRAP .1.2.3.4.5.6.*   1  *


Your system receives a trap with the definition:


BEGIN TRAP .1.2.3.4.5.6.*   1  2


The trap matches both trap definitions included in the configuration file. However, because traps
definitions are read from left to right, the second trap definition is used for the trap.
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SNMP trap parameters
The trap definition follows the BEGIN_TRAP line. The trap definition is the set of values for specified
notification attributes that are placed in the Service Assurance notification. You can define these values in
any order. The syntax of a line from the trap definition is:


<notification_attribute>:  <value>


Trap definition parameters shows the complete list of parameters to use in a trap definition and in the
BEGIN_TRAP line. Each trap definition ends with END_TRAP.


Note   If no parameter values are set within a trap definition BEGIN_TRAP section, the values set in the
BEGIN_DEFAULT section are used.
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Table 3‑5.  Trap definition parameters


Configuration file
parameter


Corresponding standard notification attribute
or description Valid values


ASL For advanced SNMP trap integration, this defines
the ASL rule set file used to perform additional
processing, which may include additional variable
substitution. The ASL rule set must be located in
BASEDIR/smarts/local/rules/icoi_trapd. (A sample
rule set is available in my_trap-rules.asl.) The ASL
processing overwrites any values set in the trap
definition section.


Filename


Aggregate For advanced SNMP trap integration, this defines
the mapping of a trap definition to an aggregate
notification. One or more component notifications
comprise an aggregate notification.


Using the Trap Adapter Aggregate parameter
provides details and examples.


Note   The Aggregate field is not supported in the
Default Section of the file.


Special
n EventName:<string>


This is the name of the aggregate
notification and is required.


n ElementName:<object-handle>


An object-handle identifies the
InstanceName and the
CreationClassName of an element.


This is the name of the topology element
where the aggregate is defined. This field
is optional. If this field is not defined, the
ElementClassName and ElementName of
the trap definition are used, if available.
Otherwise, the ClassName and
InstanceName of the trap definition are
used.


If you define this field and specify an
object-handle that does not exist in the
topology, then the aggregate is not
created.


n EventText:<string>


This is the description of the aggregate
notification (event). This field is optional.


Category Category Any string


ClassName ClassName and DisplayClassName Any string


ClearOnAcknowledge ClearOnAcknowledge TRUE or FALSE


Discard Discard the event information captured by the
trap:
n YES discards event information.
n NO saves event information.
n IF_MANAGED allows a discard of the event


information if the device is managed by
another connected server, thus avoiding
possible duplicate event information from both
servers.


YES, NO, or IF_MANAGED


Note   IF_MANAGED requires that the ICOI
server subscribes to all underlying IP servers
for consideration to determine if the device that
originated the trap is managed.
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Table 3‑5.  Trap definition parameters (Continued)


Configuration file
parameter


Corresponding standard notification attribute
or description Valid values


ElementClassName ElementClassName Valid Class Name in VMware Smart Assurance
topology.


ElementName ElementName Valid Instance Name in
VMware Smart Assurance topology. If you set
the UnknownAgent to CREATE, then the
instance does not have to previously exist.


Note   If the UnknownAgent parameter is
configured to CREATE, the
ElementClassName and ElementName
parameters must be defined in the
trap_mgr.conf file.


EventName EventName (describing the notification) and the
EventDisplayName


Any string


EventText EventText Any string


EventType EventType:
n MOMENTARY sends notifications of events


with no duration, such as a coldStart trap.
Clears after the Expiration interval.


n DURABLE sends notifications of events with
an active and inactive state, such as linkDown
and linkUP traps.


MOMENTARY or DURABLE


Expiration Defines the expiration time in seconds for the
notification. Zero indicates that the notification will
not expire. 7200 is the default value.


If you use zero, you should use some method to
eventually clear the notification. For example, you
can configure the SNMP Trap Adapter to send
clear state notifications or set the
ClearOnAcknowlege parameter to TRUE.


Integer


ForceOccurredOn Overwrite the ElementClass or ElementName to
modify the OccurredOn object.


Note   If ElementClass and ElementName are
undefined, the trap defaults to the Agent name if it
is defined.


TRUE or FALSE


InMaintenance InMaintenance TRUE or FALSE


InstanceName InstanceName (of the object associated with the
notification) and InstanceDisplayName.


Any string
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Table 3‑5.  Trap definition parameters (Continued)


Configuration file
parameter


Corresponding standard notification attribute
or description Valid values


LogFile The name of the file used by the
SNMP Trap Adapter to log information for this
trap. If this parameter is NONE or undefined, no
information is logged. If this parameter is
undefined, the default value is used.


Note   Log files contain any error messages with
line numbers of the trap_mgr.conf to help you find
and correct the error.


Filename


Map Map is a special field that enables you to map
varbinds to one or more printable strings. Using
the Map parameter and Using the Map parameter
with tags provide more information and examples
of how to map varbind values.


Note   The Map field is not supported in the
Default Section of the file.


Special


Severity Severity Any integer from 1 to 5


State Describes the state of the notification. NOTIFY or CLEAR


SysNameOrAddr A valid value describes either the system name or
address of the entity that sent the trap. Values for
this parameter override values in
ElementClassName and ElementName.


Any string


TrapSource Define the name of your trap processor so that it
more closely identifies the function or form of your
traps. The default name isTrap Processor.


Any string


UnknownAgent Describes whether Adapter Platform should
ignore traps related to unknown topology
elements or create elements for the traps.


CREATE or IGNORE


Note   If the UnknownAgent parameter is
configured to CREATE, the
ElementClassName and ElementName
parameters must be defined in the
trap_mgr.conf file.


UpdateUD Update the user-defined trap and data with a
CLEAR.


TRUE or FALSE


UserDefined1-10 UserDefined1-10 Any string
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In SNMP trap parameters and the corresponding trap definition, certain values in the SNMP trap were
used as attribute values in the notification. This is accomplished through the use of variable substitution.
SNMP variable bindings (varbinds) are placeholders for information common to standard SNMP traps and
can be assigned to Service Assurance notification attributes within the trap definitions in the
trap_mgr.conf file. The following two lines are taken from the trap definition based on SNMP trap
parameters that use variable substitution:


InstanceName:$SYS$


EventText:Agent $SYS$ restarted, reason=$V1$


The attribute InstanceName is populated with the value of a variable $SYS$. The contents of this variable
come from the incoming trap. In this example, $SYS$ is the name of the system where the trap
originated, and $V1$ represents the value of the first varbind. SNMP Trap Adapter variables describes
the variables available for basic SNMP trap integration. When specifying a variable, it must be enclosed
within dollar signs ($).


Table 3‑6.  SNMP Trap Adapter variables


Variable Description


$A$ Address of the agent sending the trap.


$C$ Community string of the SNMP trap.


Note   To use this variable, you must start the trap adapter with the --community option.


$E$ Enterprise OID of the SNMP trap.


$N$ Generic trap number of the SNMP trap.


$S$ Specific trap number of the SNMP trap.


$SRC$ Source, or originator, of the IP address for the trap. A V1 trap may return the source IP address of the relay
agent for the trap.


Note   To use this variable, you must specify the --source parameter.


$SYS$ System where the SNMP trap originated.


$T$ Timestamp of the SNMP trap.


$V<n>[-<tag>]$


or


$OID<n>[-<tag>]$


or


$V<*>$


or


$OID<*>$


Value of the <n>th varbind. The varbind may contain one of the following data types: integer, bit-string,
octet-string, IP address, counter, gauge, unsigned integer, time ticks, counter 64, obj id, opaque, or null.


Optionally, you can use a text string to tag the value of the <n>th varbind for multiple mappings.


You can also use an asterisk <*> to specify all varbinds.
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Example of set and clear notification
The following example illustrates how to configure the notification and clear an event. One trap creates a
state of NOTIFY, while the other creates a state of CLEAR:


BEGIN_TRAP  .1.3.6.1.4.1.10.1.9.5.1  6  1


ClassName:   Port


InstanceName:   $SYS$ PORT $V1$


EventName:   lerAlarmOn


Severity:   3


EventText:   This is a longer text message


EventType:   DURABLE


Category:   Performance


State:   NOTIFY


END_TRAP


BEGIN_TRAP  .1.3.6.1.4.1.10.1.9.5.1  6  2


ClassName:   Port


InstanceName:   $SYS$ PORT $V1$


EventName:   lerAlarmOn


State:   CLEAR


END_TRAP


Notifications are uniquely identified by using the three attributes: ClassName, InstanceName, and
EventName. In the example, the second trap definition will clear an event created with the first trap
definition when the values of the three key fields are identical.


Using the Map parameter
The format of the Map parameter is:


 Map:  {


   V<n>


    <value_a>= <string>


    <value_b>= <string>


   }


   {


   V<n>


    <value_c>= <string>


    <value_d>= <string>


   }


The following example shows how the Map parameter could be used to substitute text for two different
varbind values:


BEGIN_TRAP .1.3.6.1.4.1.10 6 0


 ClassName:    Host


 InstanceName:    $SYS$


 EventName:    Coldstart


 Severity:    5


 EventText:    Reason - $V1$


 Expiration:    30


 State:    NOTIFY
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 UserDefined1:    Community String: $C$


 ClearOnAcknowledge:    TRUE


 Map:    {


     V1


      1= UP


      2= DOWN


     }


 EventType:    DURABLE


 UnknownAgent:    CREATE


 ElementClass:    Router


 ElementInstance:    $SYS$


 LogFile:    Coldstart.log


END_TRAP


In the example, the Map parameter describes how the enumeration values of the first varbind translate
into printable strings. These printable strings are substituted as values in EventText. If a SNMP trap had a
value of one for its first varbind, the phrase “Reason - UP” would be placed in EventText.


If a map is not defined for a specific varbind, the SNMP Trap Adapter uses the varbind’s integer value. In
the example, the integer “1” would be used instead of the text “UP,” so the phrase “Reason -1” would be
placed in EventText.


Note   For a trap to clear, the InstanceName and ElementInstance parameters must be set to the same
type.


Using the Map parameter with tags
Each incoming trap is identified by three fields: Enterprise OID, generic trap number, and specific trap
number. Some SNMP agents send traps with the same combination of OID, generic, and specific trap
numbers but for different reasons. When this occurs, the only way to differentiate the meaning of the trap
is to examine the varbinds. You can use the $V<n>-[<tag>]$ variable to map varbind values to different
text strings.


The format of the Map parameter when using tags is as follows:


 Map:  {


   V<n-tag1>


    <value_a>= <string1>


    <value_b>= <string2>


    default= <string3>


   }


   {


   V<n-tag2>


    <value_a>= <string4>


    <value_b>= <string5>


    default=


   }


   }
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   V<n-tag3>


    <value_a>= <string6>


    <value_b>= <string7>


    default=


The following example defines two $V<n>-[<tag>]$ variables, one for substitution of ClassName and
another for substitution of EventName:


BEGIN_TRAP .1.3.6.1.4.1.546.1.1 6 


 ClassName:    $V2-class$


 EventName:    $V2-event$


.


.


.


The mapping defines when to map the appropriate tags to the varbinds.


.


.


.


 Map:  {


   V2-class


   .1.3.6.1.4.1.546.1.1.7.9.30.0= Memory


   .1.3.6.1.4.1.546.1.1.7.9.2.0= Processor


   default=Host


   }


   {


   V2-event


   .1.3.6.1.4.1.546.1.1.7.9.30.0= NotEnoughMem


   .1.3.6.1.4.1.546.1.1.7.9.2.0= HighUtilization


   default= TrapReceived


   }


If the incoming trap has a Varbind 2 value of .1.3.6.1.4.1.546.1.1.7.9.30.0, then Memory is used for the
ClassName and NotEnoughMem is used for the EventName. If the incoming trap has a Varbind 2 value
of .1.3.6.1.4.1.546.1.1.7.9.2.0, then Processor is used for the ClassName and HighUtilization is used for
the EventName. The default, Host, is used for the ClassName and the default, TrapReceived, is used for
the EventName for incoming traps with any other Varbind 2 values. If a default is not specified, the
original value for the Varbind 2 is returned.


Using the Trap Adapter Aggregate parameter
An aggregate notification is a notification that is composed of one or more component events. When one
of the component events occurs, the aggregate notification is notified. Creating an aggregate notification
provides several benefits:


n Aggregation compresses multiple component events into a single aggregate notification.


n Aggregation helps you organize related traps into meaningful categories.
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n Aggregation provides a method by which the details of the component events can be displayed to an
operator. The component events of an aggregate notification are displayed in the Aggregate tab of
the Notification Properties window of the Global Console.


You use the aggregate in your trap definition to create an aggregate notification as well as the
aggregate’s component events. You are required to define an EventName for each aggregate or
component event. Because all notifications are uniquely identified by EventName and the
ClassName, and the InstanceName it OccurredOn, values must also be derived for the two latter
attributes. VMware, Inc. recommends that you explicitly define the ElementName:<object-handle>
within the Aggregate portion of the trap definition. If you do not explicitly define the ElementName
within the Aggregate portion, then the ElementClassName and ElementName of the trap definition
are used, if available. Alternatively, if ElementName and ElementClassName are not defined, then the
ClassName and InstanceName are used to define the aggregate.


The following example illustrates how to configure two different trap definitions to generate the same
aggregate notification. The first trap definition processes an incoming trap that indicates a system is
experiencing low memory. The second trap definition processes an incoming trap that indicates that a
system’s processor is experiencing high utilization. As both traps indicate system degradation, if
either trap is received, a notification is generated to indicate that the system is degraded:


BEGIN_TRAP .1.3.6.1.4.1.546.1.1 6 1


 ClassName:    Memory


 InstanceName:    MEM-$SYS$


 EventName:    Low


 Aggregate:    {


       EventName: Degraded


       ElementName:$SYS$


     }


 Severity:    1


 Expiratiton:    30


 State:    NOTIFY


 ClearOnAcknowledge:    TRUE


END_TRAP


BEGIN_TRAP .1.3.6.1.4.1.546.1.1 6 2  


 ClassName:    Processor


 InstanceName:    PRO-$SYS$


 EventName:    HighUtilization


 Aggregate:    {


       EventName: Degraded


       ElementName:$SYS$


     }


 Severity:    1


 Expiratiton:    30


 State:    NOTIFY


 ClearOnAcknowledge:    TRUE


END_TRAP
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Using the example, if a trap with OID .1.3.6.1.4.1.546.1.1 6 1 is received from Router::CoreRouter1,
the component event Memory::MEM-CoreRouter1 Low is generated. Similarly, if a trap with OID .
1.3.6.1.4.1.546.1.1 6 2 is also received from the same router, then the component event
Processor::PRO-CoreRouter1 HighUtilization is generated. Because the same aggregate is defined
for both of these traps, this will also generate the aggregate notification, Router::CoreRouter1
Degraded.


Although all events are propagated to the Service Assurance Global Manager, only the aggregate
notification (Router::CoreRouter1 Degraded) will appear in the Global Console. This is because the
default NotificationList used by the Global Manager is configured to filter out the component (raw trap)
events. If desired, the Global Console operator can display the component events from the
Notification Properties window by clicking the Aggregate tab.


Advanced SNMP trap integration
For more sophisticated SNMP trap processing, you can define an ASL script in a trap definition that is
invoked during the processing of the trap. To define an ASL script, you add the keyword ASL, followed by
the ASL script name, to the trap definition. For example:


BEGIN_TRAP  .1.3.6.1.4.1.9.10.1  0  0


 ClassName:   System


 ASL:         my-trap-rules.asl


 InstanceName:$SYS$


 EventName:   ColdStart


 Type:        MOMENTARY


END_TRAP


Notification attribute values are initially determined by the trap definitions. If an attribute value has not
been defined by a trap definition, then the value for the attribute will come from the default section. The
notification attribute values are exported from within the ASL script. The ASL script can override default
attribute values. After the ASL script completes, the notification is created with those sets of values.


The ASL script relies on two special types of variables: input/output and input-only. Input/output variables
correspond to attributes of the notification and the parameters in the configuration file. The input-only
variables correspond to the variables used in the configuration file (for example, $SYS$, $V4$, and $N$).


A DISCARD_TRAP variable is included with the input/output variables. The variable controls whether a
given trap message is discarded or processed. The default value for this variable is “NO,” which means
the trap must be processed. To override the default and discard the trap, create a rule in the functional
loop of the hook script in my_trap_rules.asl to process the trap, and within this rule set the
DISCARD_TRAP to “YES.”


To run the ASL script, you must place it in the BASEDIR/smarts/local/rules/icoi-trapd folder. Further,
ensure that you include the hook script in the trap definition in the trap_mgr.conf file for the hook script to
be invoked for a particular OID.
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Example of ASL script to set EventText
In the following example, ASL script extracts the substring “Agent Restarted for Reason:” from the
contents of a trap’s first varbind, and places the remaining string into the notification attribute EventText.
In the script, a list of all of the input and output variables as well as the input-only variables precedes the
start of the processing (START).


Only the variables used by the script need to be declared:


/*


 * The first variable binding is a string of the form:


 *  "Agent Restarted for Reason: <text to extract>"


 */


// Input/Output variables.


CLASSNAME = "";


INSTANCENAME = "";


EVENTNAME = "";


AGGREGATE = "";


SEVERITY = "";


EVENTTEXT = "";


CATEGORY = "";


COMMUNITY = "";


DISCARD = "";


FORCEOCCURREDON = "";


UPDATEUD = "";


EXPIRATION = "";


STATE = "";


INMAINTENANCE = "";


CLEARONACKNOWLEDGE = "";


TRAPSOURCE = "";


EVENTTYPE = "";


MAP = "";


ASL = "";


ELEMENTCLASSNAME ="";


ELEMENTNAME ="";


SYSNAMEORADDR ="";


UNKNOWNAGENT ="";


LOGFILE ="";


USERDEFINED1 = "";


USERDEFINED2 = "";


USERDEFINED3 = "";


USERDEFINED4 = "";


USERDEFINED5 = "";


USERDEFINED6 = "";


USERDEFINED7 = "";


USERDEFINED8 = "";


USERDEFINED9 = "";


USERDEFINED10 = "";


DISCARD_TRAP = "YES";


// Input Variables


TIMESTAMP = "0";


IPADDRESS = "";


ENTERPRISE = "";


VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


VMware, Inc.  64







GENERIC = "9999";


SPECIFIC = "9999";


V1 = "";


V2 = "";


V3 = "";


V4 = "";


V5 = "";


V6 = "";


V7 = "";


V8 = "";


V9 = "";


V10 = "";


V11 = "";


V12 = "";


V13 = "";


V14 = "";


V15 = "";


V16 = "";


V17 = "";


V18 = "";


V19 = "";


V20 = "";


START {


 PARSE_EVENT_TEXT


}


PARSE_EVENT_TEXT {


 input = V1;


 ..  "Reason:"  EVENTTEXT: rep(word)  eol


}


The processing of the trap’s first varbind occurs in the rule PARSE_EVENT_TEXT. The input to the rule is
the contents of the first varbind. The line after the input reads all text up to and including “Reason:”. The
rest of the string is assigned to the variable EVENTTEXT. Any change to the value of the input/output
variables automatically gets placed in the corresponding attribute in the translated Service Assurance
notification. VMware Smart Assurance ASL Reference Guide provides more information about ASL.


Verifying the SNMP Trap Adapter port setting
The default value for the SNMP Trap Adapter (trap receiver) port is 9000. The
VMware Smart Assurance System Administration Guide provides more information about how to change
this default value, and about how to modify runtime parameters for an application.


SNMP trap batching
By default, the SNMP Trap Adapter immediately converts traps it receives (that match a trap definition)
into new Service Assurance notifications or into updates to existing Service Assurance notifications and
forwards them on to the Global Manager. SNMP trap batching refers to a process where the
Adapter Platform Server waits for a specified period of time before forwarding re-notifications (updated
notifications) to the Global Manager.
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In case of high frequency of traps, you can use batching to improve performance of clients processing the
converted Service Assurance notifications. You configure batching by editing your local copy of
trap_mgr.conf file so that traps renotifying an event are held for a specified period of time. After that time
is exceeded, only the most recent trap of those bearing the same notification name is sent to the
Global Manager.


To set the batch parameter, use sm_edit to open BASEDIR/smarts/local/conf/icoi/trap_mgr.conf, and type
the period of time in seconds you want the trap receiver to wait before forwarding re-notifications to the
Global Manager. The following text shows the section where you set the batch parameter. By default, the
batch setting is 10 seconds. To disable batching, specify zero (0):


# This interval (in seconds) will be used to batch updates to # notifications. In case, where a high 


frequency of


# notifications occur, batching will improve performance.


# Setting this interval to 0 will disable batching.


 BATCH_NOTIFY_INTERVAL = 10


Using keywords in trap_mgr.conf
Keywords in trap_mgr.conf lists and describes keywords that you can set in your local trap_mgr.conf.


Table 3‑7.  Keywords in trap_mgr.conf


Keyword Description Option or format


BATCH_NOTIFY_INTERVAL Allows you to set an interval (in seconds) to batch
updates to notifications. In case, where a high
frequency of notifications occurs, batching
improves performance. To disable batching, set this
interval to 0.


For example:


BATCH_NOTIFY_INTERVAL = 10


Any integer


CACHE_HOSTS Note   Use this CACHE_HOSTS keyword only if
the “RESOLVE_IP” keyword is TRUE.


Allows you to determine whether the system hosts
will be cached and used to resolve IP addresses
instead of calling the system functions, which may
be slow in some cases.


Note   This is ONLY useful if DNS name resolution
is disabled in the VMware Smart Assurance
environment. This is sometimes done to improve
performance, but it requires an extensive hosts
table. By altering the “HOSTS_PATH” keyword, you
can use a special file to load the hosts cache
instead of using the same hosts file used by the
system that the trap processor is running on.


For example:


CACHE_HOSTS = FALSE


TRUE or FALSE
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Table 3‑7.  Keywords in trap_mgr.conf (Continued)


Keyword Description Option or format


DEBUG Allows you to generate status messages, which
you can use to debug the trap processor—without
updating the trap_mgr_parse.asl. When DEBUG is
set to TRUE in your local trap_mgr.conf, verbose
status messages are generated, and your trap
processor runs slower while the log grows faster.


For example:


DEBUG = FALSE


TRUE or FALSE


HOSTS_PATH Note   Use this HOSTS_PATH keyword only if
“CACHE_HOSTS” is TRUE.


Allows you to define the full path to the system
hosts file. (You can use a unique file for the cache
by specifying its path here.)


For example:


HOSTS_PATH = /etc/hosts


Path name


IMPORT Allows you to access external information or
processes for processing traps—without editing
ASL scripts. You can use the IMPORT keyword in
your local trap_mgr.conf to load tables, or any other
pre-processor driver scripts. To load import drivers
and lookup tables, you can replicate the IMPORT
keyword as many times as necessary.


For example:


IMPORT TRUE TRUE driver1 import_rules.asl
local/conf/someinput.txt |


The format is as follows:


IMPORT <wait> <auto-reload> <driver-
name> <rules-file> [<input-file>] ...
[<field-separator>]


where:
n <wait> is TRUE or FALSE. Set the


Trap Processor to wait for the driver
to exit.


n <auto-reload> is TRUE or FALSE.
Set the Trap Processor to start this
driver using a --reloadConfig call.


n <driver-name> is simple string used
to name the driver.


n <rules-file> is the name of the rules
file located in rules/icoi-rules.


n <input-file> is optional. Set the path
to an input file from $SM_SITEMOD.


n <field-separator> is optional. Set the
field separator character.


LOGGING Allows you to generate status messages, which
you can use to capture information about the trap
processor. When LOGGING is set to OFF, for
example, in your local trap_mgr.conf, error
messages are generated and sent to the log file.


For example:


LOGGING = OFF


ALL, DISCARD, STATUS, and OFF:
n ALL logs all messages about traps


received and discarded, as well as
server status.


n DISCARD logs messages about
discarded traps and server status.


n STATUS logs messages about
changes to the server status.


n OFF logs error messages.
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Table 3‑7.  Keywords in trap_mgr.conf (Continued)


Keyword Description Option or format


LOOKUP Allows you to substitute one value for another in
the trap processor—without editing ASL scripts.
You can use the LOOKUP keyword in your local
trap_mgr.conf to substitute values.


For example:


LOOKUP MyTable local/lookups/filename


In this example, filename contains:


abcd1234:Alexandria


stuvwxyz:Hopkinton


If the trap definition in your trap_mgr.conf includes:


UserDefined1: $MyTable($SYS$)$


Then, if SYS contains abcd1234, then
UserDefined1 returns the value Alexandria. If SYS
contains stuvwxyz, then UserDefined1 returns the
value Hopkinton.


Other examples include:


$TABLE1($V4$)$; $TABLE2($SYS$[4])$
$TABLE2(coldStart[1])$


Available formats include:
n <table>(<key>) accesses a lookup


table to return a single element if the
table has only one value, or a list if
the table has more than one value.


n <table>(<key>[<index>]) accesses a
lookup table to return an element
from the table.


where:
n <table> is the name of the table


defined in the IMPORT keyword.
n <key> is the key into this table,


which is any string or variable.
n <index> is an optional index value,


which starts from 1 if the table
contains more than one value.
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Table 3‑7.  Keywords in trap_mgr.conf (Continued)


Keyword Description Option or format


RESOLVE_IP Allows you to resolve IP addresses into their
names.


You can use this option to determine whether
unrecognized IP addresses will be resolved before
being assigned to the $SYS$ variable. For objects
already known to the system, this option has no
effect.


Note   Name resolution can be very slow. A system
receiving thousands of traps and calling a name
server for every request can seriously impact the
number of traps that can be processed. Threading
can help somewhat, but name resolution is not
recommended in large installations unless the
server is configured to use only host file resolution
and the “CACHE_HOSTS” keyword is defined.
Alternatively, a caching DNS server can be run on
the trap host to help somewhat, but performance
will still be impacted.


For example:


RESOLVE_IP = FALSE


TRUE or FALSE


USE_CURRENT_TIME Allows you to set the timestamp for notifications—
using either the time contained in the trap, or the
time the trap was received.


If this keyword is set to FALSE, then the timestamp
from the trap is used unless it is invalid. If this
option is set to TRUE, the timestamp from the trap
is discarded, and the current time is used when
creating notifications.


Note   When using threads, traps can appear to
come in out of order if this keyword is enabled.
CLEAR traps are reordered, but other traps appear
to occur at the time they were processed.


For example:


USE_CURRENT_TIME = FALSE


TRUE or FALSE


sm_trapd options
Options for sm_trapd lists and describes available options for sm_trapd.
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Table 3‑8.  Options for sm_trapd


Option Description


--ascii If “--ascii” is not specified on the commandline for starting sm_trapd, sm_trapd converts the entire value
of that OID into a printable UTF-8 coding string, such as a varbind. For example, .1.3.6.1.4.1.333.1 ->
"abcd012" is converted into .1.3.6.1.4.1.333.1 -> "61 62 63 64 C3 96 30 31 32".


If “--ascii” is specified on the commandline for starting sm_trapd, sm_trapd converts only the non-
printable characters into a HEX string using the UTF coding for these characters. The remaining
printable characters of the original value (octet-string) remain unchanged, such as the varbind. For
example, .1.3.6.1.4.1.333.1 -> "abcd012" is then converted into .1.3.6.1.4.1.333.1 -> "abcdXC3X96012."


--broker Alternate broker location as host:port. For example: --broker AM_HOST-NAME:AM-PORT. Also -b
<location>.


--community Stream the trap community string to the parser. Writes the community string to the sm_trapd.log file.


Note   This option is required in the sm_trapd command line when using a community string in a
hookscript or the $C$ variable.


--config=<cfg> Name of trap configuration directory where the trapd.conf is located. The trapd.conf file is loaded from
one of the following directories:
n BASEDIR/smarts/local/conf/<cfg> or
n BASEDIR/smarts/conf/<cfg>


The file in the local directory takes precedence if the configuration is present in both places.


Note   Default is --config=trapd.


--
limitQueueMegs=<nu
m>


Size limit of internal trap queue. When the limit is reached, discard incoming traps from the most active
sources.


--model=<model> Name of the model library that you want to load. For example: -model=sm_actions. Also -m <model>.


--name=<name> Registered server name you want to start. Also -name <name>.


--output Data transfer.


--port=<port> Alternate port number for receiving traps. Also -p <port>.


Note   Default value is --port=162.


--reloadConfig Reload, rather than restart, the trap configuration file for an already-running SNMP trap adapter.


For example: -s <adaptername> --reloadConfig.


--rules=<name> Name of the rules set for parsing traps. For example: --rules=icoi-trapd/trap_mgr_parse.asl.


--rules=default Name of the default rules set for parsing traps.


Note   Default is --rules=BASEDIR/smarts/rules/trapd/trapParse.asl.


--seed=<file> Get SNMPv3/USM credentials from the seed file.


For example: --seed=seedfile.


The seed file has a path that is relative to the conf directory.


--server=<name> Name of the server. For example: --server=INCHARGE-OI. Also -s <name>.


--source Forward the source address of the trap to the trap processor and make this address available to
configuration files and ASL scripts.


--sport=<port> Alternate registration port. Use with --name. For example: --sport=9180. Also -P <port>.


--tag Tag each varbind value with its type.
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Table 3‑8.  Options for sm_trapd (Continued)


Option Description


--window=<num> Window size for duplication. Also -w <num>.


Trace options


--traceSNMP Trace incoming SNMP messages.


--traceRules Trace rule compilation.


--traceServer Trace interactions with the back-end server.


--traceParse Trace rule matching.


Standard options


--accept=<host-list> Accept connections only from hosts on <host-list>, which is a comma-separated list of hostnames and IP
addresses. The any option for <host-list> allows any host to connect.


Note   Default is --accept=any.


--daemon Run process as a daemon.


--errlevel=<level> Minimum error printing level.


Note   Default is --errlevel=Warning.


--help Print help and exit.


--loglevel=<level> Minimum system logging level.


Note   Default is --loglevel=Error.


--logname=<name> Use <name> to identify sender in the system log.


Note   Default is the name of a program.


--output[=<file> Redirect server output (stdout and stderr). The filename is <file>, or the --logname value if <file> is
omitted. Log files are in $SM_LOGFILES or $SM_WRITEABLE/logs.


--tracelevel=<level> Minimum stack trace level. Options for <level> include: One of None, Emergency, Alert, Critical, Error,
Warning, Notice, Informational, or Debug. Fatal is a synonym for Critical. For example: --
tracelevel=Informational.


Note   Default is --tracelevel=Fatal.


--version Print program version and exit.


--useif=<ip-address> Use this IP address as the source or destination interface address.
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Table 3‑8.  Options for sm_trapd (Continued)


Option Description


-- Stop scanning for options.


--trailingNulls This option allows for printing trailing NULL bytes in an octet string of varbind value as 00 or \X00. By
default trailing null octets are ignored.


For example:


Device data: 41 00 00 00 00


sm_adapter data: 41


If sm_adapter is started with option --trailingNulls, then the adapter will print the octet string as it is, that
is, the way it is coming from the trap device, including the trailing null octets.


For example:


sm_adapter started with --trailingNulls option:


Device data: 41 00 00 00 00


sm_adapter data: 41 00 00 00 00


Starting and stopping the SNMP Trap Adapter
If you installed the SNMP Trap Adapter as a service, it automatically starts when the system starts up.
The following instructions describe how to use the sm_service utility to manually start and stop the
SNMP Trap Adapter.


Note   To use the sm_service utility to install a service or start a service, you must have administrative
privileges on the local host.


Issue one of the following from the command line:


         BASEDIR/smarts/bin/sm_service start ic-trapd-receiver


or


         BASEDIR/smarts/bin/sm_service stop ic-trapd-receiver


The VMware Smart Assurance System Administration Guide provides more information about the
sm_service utility and about how to modify sm_service options.


Default sm_service parameters for the SNMP Trap Adapter
When the SNMP Trap Adapter is installed as a service during the installation process, the
SNMP Trap Adapter is set up with default parameters. The default parameters and their values are:


t /InCharge/SAM/smarts/bin/sm_service install --force --unmanaged


--startmode=runonce 


--description="SMARTS SNMP Trap Adapter" ic-trapd-receiver


 /InCharge/SAM/smarts/bin/sm_trapd                                                 


    --name=TRAP-INCHARGE-OI                                                


    --server=INCHARGE-OI                                                   


    --config=icoi                                                          
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    --port=162 


    --model=sm_actions 


    --seed=seedfile


    --rules=icoi-trapd/trap_mgr_parse.asl 


    --output s 
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VMware Smart Assurance
Syslog Adapter 4
This chapter includes the following topics:
n Overview


n Configuring the Syslog Adapter


n Starting and stopping the Syslog Adapter


Overview
The Syslog Adapter tails and parses the contents of any system log file and generates notifications to the
Global Manager based on the file contents.


You start the adapter by invoking the sm_service command. For example:


InCharge/SAM/smarts/bin>sm_service start ic-syslog-adapter


First the syslog_mgr.asl file parses each syslog message and populates the input variables. Then the
my_hook_syslog.asl gets executed. This script first populates the notification attribute output variables by
using the default values. It then uses the MODIFY_ATTRIBUTES rule to set additional attributes defined
and potentially modify (overriding) any default attribute values. This is how the Service Assurance
notification gets created by the Syslog Adapter.


Before you configure the Syslog Adapter, identify the location of the SYSFILE you want the adapter to tail
and parse and ensure that sm_service install command line for the ic-syslog-adapter identifies this
location. You must also ensure that the file format of the Syslog exactly matches the format described in
the following sections.


Configuring the Syslog Adapter
Syslog Adapter configuration and script files describes the files that you need to use when configuring the
Syslog Adapter. If you edit any of these files, you must use the sm_edit utility. The utility will save the
local copies to the appropriate VMware Smart Assurance subdirectories under the BASEDIR/smarts/local
directory. The sm_edit utility provides more information.
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Table 4‑1.  Syslog Adapter configuration and script files


Directory under BASEDIR/ Filename
User
editable Description


smarts/rules/icoi-syslog/ my_hook_syslog.asl Yes Basic template for processing a syslog file.


smarts/rules/icoi-syslog/ syslog_mgr.asl Yes Rule set for parsing each syslog message.


The Syslog Adapter creates events by parsing the contents of syslog files. You can use it to parse the
contents of any text file with entries of the format:


month day time hostName applicationName [process_id]:text_message


If the format of your syslog file is different from the above format, you can edit my_hook_syslog.asl and
syslog_mgr.asl to parse the entries accordingly.


The Syslog Adapter can parse the contents of a file and it can tail a file. When the Syslog Adapter tails a
file, it skips the existing content and uses only content added to the file while the adapter is running.


Note   The process_id parameter is optional when parsing the contents of syslog files.


The Adapter Platform includes a basic template for processing a syslog file. This file is
BASEDIR/smarts/rules/icoi-syslog/my_hook_syslog.asl.


After ensuring that the Adapter Platform Server and the Global Manager are up and running, complete
the following procedures to configure the Syslog Adapter:


1 Check the location of the Syslog file to be sure it is appropriately placed for your operating system.


2 Change the parameters in the local copy of my_hook_syslog.asl to match your needs.


3 Start the Syslog Adapter.


Syslog file location
The sm_service install command line for the Syslog Adapter, ic-syslog-adapter, is stored in the
sm_service database. By default, the SYSFILE parameter in this script specifies the location
as /var/log/syslog. Edit the command line to change the location of the Syslog file if necessary.


Editing the my_hook_syslog.asl
You can use the Adapter Scripting Language (ASL) to modify the functionality of the local copy of
my_hook_syslog.asl or to create a new file. The basic components of a custom processing file for the
Syslog Adapter are explained below:


debug = FALSE;


ASLNAME = " ".getRuleFileName ().": ";


DISCARD = "TRUE";


CLEAR_SYSLOG = "FALSE";


BATCH_NOTIFY_INTERVAL = 10;


// Output variables : This section has all default settings.


CLASSNAME = "Syslog";
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INSTANCENAME = "";


EVENTNAME = "";


SEVERITY = "2";


EVENTTEXT = "";


CATEGORY = "";


EXPIRATION = "7200";


STATE = "";


INMAINTENANCE = "FALSE";


CLEARONACKNOWLEDGE = "TRUE";


EVENTTYPE = "";


USERDEFINED1 = "";


USERDEFINED2 = "";


USERDEFINED3 = "";


USERDEFINED4 = "";


USERDEFINED5 = "";


USERDEFINED6 = "";


USERDEFINED7 = "";


USERDEFINED8 = "";


USERDEFINED9 = "";


USERDEFINED10 = "";


ELEMENTCLASSNAME = "";


ELEMENTNAME = "";


SYSNAMEORADDR = "";


UNKNOWNAGENT = "IGNORE";


LOGFILE = "NONE"; 


// Aggregate Section : 


AGG_EVENTNAME = "";


AGG_ELEMENTNAME = "";


AGG_EVENTTEXT = "";


The values of the output variables populate the attributes of the standard notification created when the
syslog message is imported. The variable names correspond directly to the standard notification’s
attribute names.


The Syslog Adapter populates these variables when the syslog entry is parsed:


// Input Variables


SYSLOGTIME = "";


HOST = "";


APPLICATION_NAME = "";


PROCESS_ID = "";


MESSAGE = "";


The START rule takes the text parsed from the syslog entry as input, prints a message, calls three other
rules, prints another message, and exits after the processing is complete:


START {


  input=MESSAGE;


do {


if (debug) {print(time().ASLNAME."SYSLOGTIME =".SYSLOGTIME);}


if (debug) {print(time().ASLNAME."HOST =".HOST);}


if (debug) {print(time().ASLNAME."APPLICATION_NAME=".APPLICATION_NAME);}


if (debug) {print(time().ASLNAME."PROCESS_ID =".PROCESS_ID);}
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if (debug) {print(time().ASLNAME."MESSAGE =".MESSAGE);}


}


    PARSE_MESSAGE


    MODIFY_ATTRIBUTES


    CUSTOM_RULE?


} do {


    if (debug) { print(time().ASLNAME."Done with my_hook_syslog.asl ");}


    return;


}


The CUSTOM rule is an example of a rule which performs more customizations. In this case, it saves a
prefix and a message description:


CUSTOM_RULE {


    unusedPrefix:rep(notany(":")) ":" /* consume chars up to : */


    msgDescription:rep(word) eol


} do {


    if (debug) { print(time().ASLNAME."Executing CUSTOM_RULE");}


}


This PARSE_MESSAGE rule saves only the first 30 characters:


PARSE_MESSAGE {


} do {


    // Use a slice of 30 characters as part of EVENTNAME


    slice = substring(MESSAGE, 0, 30);


}


The MODIFY_ATTRIBUTES rule assigns values to the notification created from the syslog entry. The
value of InstanceName is composed of HOST, APPLICATION_NAME, and PROCESS_ID. These are
values parsed from the syslog entry:


/*


 * MODIFY_ATTRIBUTES Rule:


 * All your customizations are done here. You can use all


 * the Syslog input variables wherever you want them assigned


 * to ICS_Notification attributes.


 * ------------------------------------------------------------ */


MODIFY_ATTRIBUTES {


} do {


  DISCARD = "TRUE";


  CLEAR_SYSLOG = "FALSE";


  BATCH_NOTIFY_INTERVAL = 10;


  CLASSNAME = "Syslog" ? LOG;


  INSTANCENAME = HOST."_".APPLICATION_NAME."_".PROCESS_ID ? LOG;


  EVENTNAME = slice ? LOG;


   SEVERITY = "2" ? LOG;


   EVENTTEXT = MESSAGE ? LOG;


   CATEGORY = "" ? LOG;


   EXPIRATION = "7200" ? LOG;


   STATE = "NOTIFY" ? LOG;


   INMAINTENANCE = "FALSE" ? LOG;


   CLEARONACKNOWLEDGE = "TRUE" ? LOG;
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   EVENTTYPE = "DURABLE" ? LOG;


   USERDEFINED1 = "" ? LOG;


   USERDEFINED2 = "" ? LOG;


   USERDEFINED3 = "" ? LOG;


USERDEFINED4 = "" ? LOG;


USERDEFINED5 = "" ? LOG;


USERDEFINED6 = "" ? LOG;


USERDEFINED7 = "" ? LOG;


USERDEFINED8 = "" ? LOG;


USERDEFINED9 = "" ? LOG;


USERDEFINED10 = "" ? LOG;


ELEMENTCLASSNAME = "Host";


ELEMENTNAME = HOST;


SYSNAMEORADDR = HOST;


UNKNOWNAGENT = "CREATE";


LOGFILE = "NONE";


AGG_EVENTNAME = "AggEvent-".INSTANCENAME;


AGG_ELEMENTNAME = HOST;


AGG_EVENTTEXT = "This is an Aggregate Test"


}


You can optionally add logic that compares the input variables and sets the output variables based on
them.


Whenever you modify the hook script file, you must restart the adapter for the changes to take effect.


Syslog Adapter parameters
Syslog Adapter parameters shows the complete list of parameters that can be defined for a notification
forwarded to the Global Manager by the Syslog Adapter.


Note   If no parameter values are set within the MODIFY_ATTRIBUTES rule, then the values set in the
Output variables section are used.


Table 4‑2.  Syslog Adapter parameters


Parameter Corresponding standard notification attribute or description Valid values


AGG_EVENTNAME This is the event name of the aggregate notification and is required if
you are creating an aggregate.


<string>


AGG_ELEMENTNAME This is the name of the topology element where the aggregate event
occurs. This field is optional. If this field is not defined, the
ElementClassName and ElementName of the trap definition are
used, if available. Otherwise, the ClassName and InstanceName are
used.


If you define this field and specify an object-handle that does not
exist in the topology, then the aggregate is not created.


<object-handle>


AGG_EVENTTEXT This is the description of the aggregate notification (event). This field
is optional.


<string>


CATEGORY Category Any string


CLASSNAME ClassName and DisplayClassName Any string
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Table 4‑2.  Syslog Adapter parameters (Continued)


Parameter Corresponding standard notification attribute or description Valid values


CLEARONACKNOWLEDGE ClearOnAcknowledge TRUE or FALSE


CLEAR_SYSLOG Controls whether a given syslog message clears an already existing
notification or results in a notify.


The default is FALSE, all syslog messages result in notifications.


All syslog messages result in notifications unless the syslog
messages are processed by subsequent MODIFY_ATTRIBUTES
rules, which override the default.


TRUE or FALSE


DISCARD Controls whether a given syslog message is discarded or processed.


The default is TRUE, all syslog messages are discarded.


To override the default and process a syslog message, create a rule
to process this syslog message. Within this rule, DISCARD should
be set to FALSE.


TRUE or FALSE


ELEMENTCLASSNAME ElementClassName Valid Class Name in
VMware Smart
Assurance topology


ELEMENTINSTANCENAME ElementName Valid Instance Name
in
VMware Smart
Assurance topology


EVENTNAME EventName (describing the notification) and the EventDisplayName Any string


EVENTTEXT EventText Any string


EVENTTYPE EventType MOMENTARY or
DURABLE


EXPIRATION Defines the expiration time in seconds for the notification. Zero
indicates that the notification will not expire. 7200 is the default
value.


If you use zero, you should use some method to eventually clear the
notification. For example, you can configure the Syslog Adapter to
send clear state notifications or set the ClearOnAcknowlege
parameter to TRUE.


Integer


INMAINTENANCE InMaintenance TRUE or FALSE


INSTANCENAME InstanceName (of the object associated with the notification) and
InstanceDisplayName


Any string


LOGFILE The name of the file used by the SNMP Trap Receiver to log
information for this trap. If this parameter is ’NONE’ or not defined,
no information is logged.


Filename


SEVERITY Severity Any integer from 1 to
5


STATE Describes the state of the notification.


This option is deprecated; its function is replaced by
CLEAR_SYSLOG.


NOTIFY or CLEAR
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Table 4‑2.  Syslog Adapter parameters (Continued)


Parameter Corresponding standard notification attribute or description Valid values


SYSNAMEORADDR A valid value describes either the system name or address of the
entity that sent the trap. Values for this parameter override values in
ElementClass and ElementInstance.


Any string


UNKNOWNAGENT Describes whether Adapter Platform should ignore traps related to
unknown topology elements or create elements for the traps.


CREATE or IGNORE


USERDEFINED1-10 UserDefined1-10 Any string


Using the Syslog Aggregate parameters
You configure aggregates in the Aggregate Section of the local copy of my_hook_syslog.asl rule set,
located in BASEDIR/smarts/local/rules/icoi-syslog directory. Using the Trap Adapter Aggregate parameter
provides general information about Aggregates.


The following example illustrates how to use the aggregate parameter with the Syslog Adapter:


/*


 * my_hook_syslog.asl - Hook adapter for 


 * any syslog related customizations.


 *


 * Copyright (C) 1997, System Management ARTS (SMARTS)


 * All Rights Reserved


 */


debug = FALSE;


ASLNAME = " ".getRuleFileName().": ";


DISCARD = "TRUE";


CLEAR_SYSLOG = "FALSE";


/*


 * This interval (in seconds) will be used to batch updates to


 * notifications. In case, where a high frequency of


 * notifications occur, batching will improve performance. 


 * Setting this interval to 0, will disable batching.


 */


BATCH_NOTIFY_INTERVAL = 10;


CLASSNAME = "Syslog";


INSTANCENAME = "";


EVENTNAME = "";


SEVERITY = "2";


EVENTTEXT = "";


CATEGORY = "";


EXPIRATION = "300";


STATE = "";


INMAINTENANCE = "FALSE";


CLEARONACKNOWLEDGE = "TRUE";


EVENTTYPE = "";


USERDEFINED1 = "";


USERDEFINED2 = "";


USERDEFINED3 = "";


USERDEFINED4 = "";


USERDEFINED5 = "";


USERDEFINED6 = "";
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USERDEFINED7 = "";


USERDEFINED8 = "";


USERDEFINED9 = "";


USERDEFINED10 = "";


ELEMENTCLASSNAME = "";


ELEMENTNAME = "";


SYSNAMEORADDR = "";


UNKNOWNAGENT = "IGNORE";


LOGFILE = "NONE";


/* Need to Declare these, if you want Aggregates


 * --------------------------------------------- */


AGG_EVENTNAME = "";


AGG_ELEMENTNAME = ""; 


AGG_EVENTTEXT = ""; 


/*


 * Input Variables: Following are the variable declarations,


 * which hold the Syslog parsed values.


 * -------------------------------------------------------- */


SYSLOGTIME = "";


HOST = "";


APPLICATION_NAME = "";


PROCESS_ID = "";


MESSAGE = "";


if (debug) {  print(time().ASLNAME."Activated"); }


/*


 * Start Rule


 * ---------- */


START {


    input=MESSAGE;


    MODIFY_ATTRIBUTES


    CREATE_AGGREGATE


} do {


    if (debug) { print(time().ASLNAME."Done with my_hook_syslog.asl ");}


    return;


}


CREATE_AGGREGATE {


} do {


        // If you see strings "CPU" and "HighUtilization" in 


        // the syslog 


        // message, then generate and aggregate.


        // --------------------------------------------------


        if (glob("*CPU*",MESSAGE) &&


        glob("*HighUtilization*",MESSAGE)) {


                AGG_EVENTNAME = "Degraded";


                AGG_ELEMENTNAME = HOST;


                AGG_EVENTTEXT = "Host [".HOST."] is Degraded";


        }


}


MODIFY_ATTRIBUTES {


} do {


    CLASSNAME = "Processor" ? LOG;


    INSTANCENAME = "PRO-".HOST ? LOG;


    EVENTNAME = substring(MESSAGE, 0, 30) ? LOG;


    SEVERITY = "2" ? LOG;


    EVENTTEXT = MESSAGE ? LOG;
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    CATEGORY = "" ? LOG;


    EXPIRATION = "7200" ? LOG; //PR:6617


    STATE = "NOTIFY" ? LOG;


    INMAINTENANCE = "FALSE" ? LOG;


    CLEARONACKNOWLEDGE = "TRUE" ? LOG;


    EVENTTYPE = "DURABLE" ? LOG;


    ELEMENTCLASSNAME = "Processor";


    ELEMENTNAME = "PRO-".HOST ? LOG;


    UNKNOWNAGENT = "CREATE";


    LOGFILE = "Processor.log";


}


DEFAULT {


     msg:{.. eol}


} do {


    print(time().ASLNAME."Reached Default rule: ".msg);


    this->clearVariables();                


}


/*


 * These variables describe the formatting of this file.  If 


 * you don't like the template defaults, feel free to change    


 * them here (not in your .emacs file).


 *


 * Local Variables:


 * mode: C++


 * End:


 */


Syslog batching
By default, except if the DISCARD parameter is set to TRUE, the Syslog Adapter does the following:


n Converts the syslog messages it receives into new Service Assurance notifications or updates the
existing Service Assurance notifications.


n Forwards them on to the Global Manager.


Syslog batching refers to a process where the Adapter Platform Server waits for a specified period of
time before forwarding re-notifications (updated notifications) to the Global Manager.


In case of high frequency of syslog messages, you can use batching to improve performance of
clients processing the converted Service Assurance notifications. You configure batching by editing
the my_hook_syslog.asl file so that re-notification messages are held for a specified period of time.
Then, once that time is exceeded, only the most recent message of those bearing the same
notification name is sent to the Global Manager.
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To set the batch parameter, use sm_edit to open my_hook_syslog.asl, and type the period of time (in
seconds) you want the Syslog Adapter to wait before forwarding re-notifications to the
Global Manager. By default, the batch setting is 10 seconds. To disable batching, specify zero (0):


BATCH_NOTIFY_INTERVAL = 10


Using the Syslog Aggregate parameters provides an example of a script that contains the batch
parameter.


Starting and stopping the Syslog Adapter
If you installed the Syslog Adapter as a service, it automatically starts when the system starts up. The
following instructions describe how to use the sm_service utility to manually start and stop the
Syslog Adapter.


Note   To use the sm_service utility to install a service or start a service, you must have administrative
privileges on the local host.


Issue one of the following from the command line:


         BASEDIR/smarts/bin/sm_service start ic-syslog-adapter


or


         BASEDIR/smarts/bin/sm_service stop ic-syslog-adapter


The VMware Smart Assurance System Administration Guide provides more information about the
sm_service utility and about how to modify sm_service options.


Default sm_service parameters for the Syslog Adapter
When the Syslog Adapter is installed as a service during the installation process, the Syslog Adapter is
set up with default parameters.


The default parameters and their values are:


t /InCharge/SAM/smarts/bin/sm_service install 


--startmode=runonce 


--description="SMARTS Syslog Adapter" ic-syslog-adapter


 /InCharge/SAM/smarts/bin/sm_adapter                                                 


    --name=SYSLOG-INCHARGE-OI                                              


    --rserver=INCHARGE-OI                                                  


    --tail=/var/log/syslog                                                 


    --model=sm_system                                                      


    --model=sm_actions                                                     


    --output                                                               


    icoi-syslog/syslog_mgr.asl s                                                             
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Command Line Interface 5
The command line interface ( sm_ems) is useful for converting information from third-party applications
into events. This interface can create and clear events and create basic topology elements. The
command line interface also can update event attributes passed by the Adapter PlatformServer, and
associate events to topology elements. You can use the ASL scripting language in conjunction with the
command line interface for more advanced processing.


Using the command line interface
Configuration of the command line interface consists of two parts:


1 You need to set up the proper security between the Adapter Platform and the command line interface.
By default, the sm_ems command line interface does not prompt for authentication credentials.


If you are working in a secure environment, you need to create an entry in the clientConnect.conf file
(using the sm_edit utility) that provides the necessary username and password for the sm_ems
interface. The username in this entry must match a user in the corresponding serverConnect.conf file.
You must edit the clientConnect.conf file on the host where sm_ems is running.


2 You must modify your third-party application to call sm_ems.


Command line interface usage
The third-party application must be modified to call the sm_ems command. The documentation for third-
party applications provides more information about configuring the application to call the command line
interface.


The basic format to call the command line interface is:


sm_ems --server=<server_name> [options ...] <command>


Command line interface options describes the options.


Table 5‑1.  Command line interface options


Option Description


--server=<name> The name of the Adapter Platform Server. This parameter is required.


--broker=<location> The name of the broker, if you override the broker set by the SM_BROKER environment
variable.
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Table 5‑1.  Command line interface options (Continued)


Option Description


--system=<nameOrAddr> Specifies the name or IP address of the existing system (Unitary Computer System) you
want to associate with this event.


The event will automatically be associated with this system in the Adapter Platform
topology.


The system name is converted to its canonical name using hostname lookups. For
example, Host1 or 10.1.2.345 might be converted to Host1.example.com.


If the system does not exist in the topology, it may be created automatically if the --create-
system option is specified.


--create-system Determines that the unitary computer system should automatically be created if it does not
exist in the topology. The Class defaults to Node, however you can optionally use --
element-class to specify the class name. This option is deprecated, but retained for
backwards compatibility.


The --create-element option can be used instead of this option to create any infrastructure
element.


--element-class=<ClassName> Determines the ClassName of the entity being created in the VMware Smart Assurance
topology, if the element does not already exist.


Issue this option with --create-element and also --element-name.


--element-name=<InstanceName> Determines the InstanceName to be used with the --element-class option. Options
provided with --element-class and --element-name will be used to create the object.


Note   Do not use the --system option if you are also issuing the --element-class and --
element-name options.


--create-element Determines that the element-class and element-name you specify should automatically be
created if it does not exist in the VMware Smart Assurance topology.


Use this option to create any infrastructure element, including business elements,
application-related elements, and unitary computer systems.


--aggregate-element-
class=<ClassName>


Determines the ClassName for the Aggregate Notification, if one is being created.


--aggregate-element-
name=<InstanceName>


Determines the InstanceName for the Aggregate Notification, if an aggregate notification is
being created (using the --aggregate-event option). Also creates an OccurredOn
relationship between the Instance and the Aggregate Event.


--aggregate-
event=<AggregateEventName>


Determines the EventName of an Aggregate Notification. This is a required option if you
are creating an Aggregate.


--audit=<msg> Optional text to include in the description field of the audit log entry created for this action.


Note   This option is ignored for the add-audit-log command.


--traceServer Enables tracing of server communications.


Command line interface commands
There are 10 different commands to use with sm_ems. Along with the command, you need to pass
arguments. sm_ems commands describes these commands. Where possible in the table, the arguments
passed with the command are expressed as attributes from the standard notification. Notification
attributes are described in Chapter 6 Adapter Platformand Notifications.
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With the exception of summarize, all of the sm_ems commands use ClassName, InstanceName, and
EventName. These three fields are always required because they uniquely identify a standard notification.


Table 5‑2.  sm_ems commands


Command Description


acknowledge <ClassName>
<InstanceName> <EventName>


Changes the notification’s attribute, Acknowledged to TRUE. Attribute values
modified using this command argument do not get propagated to Global Manager
through the Adapter Platform.


add-audit-log <ClassName>
<InstanceName> <EventName>
<message>


Adds an entry to the Adapter Platform’s audit log. The entry contains information
about the notification as well as a text message (<message>).


assign <ClassName> <InstanceName>
<EventName> <Owner>


Changes the notification’s ownership. Attribute values modified using this command
argument do not get propagated to Global Manager through the Adapter Platform.


clear <ClassName> <InstanceName>
<EventName> <SourceDomainName>


Clears an occurrence of a notification. In order for this command to work,
SourceDomainName must match the notification’s attribute.


notify <ClassName> <InstanceName>
<EventName> <SourceDomainName>
<EventType> <Clear-Mode>
[<attribute>=<value> ...]


Creates a notification.


If you use the notify command to create a notification that already exists, the Count
attribute is increased by 1 and any attribute which is not explicitly assigned a new
value will retain its previous value.


You must use values for each argument through <Clear-Mode>. Clear-Mode
indicates how the notification gets cleared. Valid values for Clear-Mode are:
n source — The source sends a clear.
n <number> — The number of seconds before the event expires.
n none — The notification should not expire and the source will not send a clear.


At the end of this command, you have the option of defining other attributes for the
command. Optional attributes are: Category, Certainty, ClassDisplayName,
ClearOnAcknowledge, EventDisplayName, EventText, Impact, InMaintenance,
InstanceDisplayName, Severity, TroubleTicketID, and UserDefined1 through
UserDefined10.


In this case, the attribute name must match the standard notification attribute. If you
do not explicitly assign values for other attributes, the default attribute values are
used. Chapter 6 Adapter Platformand Notifications provides a list of default values.


print <ClassName> <InstanceName>
<EventName>


Prints all of the notification’s attributes to stdout.


release <ClassName> <InstanceName>
<EventName>


Clears the notification ownership. Attribute values modified using this command
argument do not get propagated to Global Manager through the Adapter Platform.


summarize [<Notification_List>] Prints a summary for a given notification list. If a notification list is not specified, the
notification list named Default is used.


unacknowledge <ClassName>
<InstanceName> <EventName>


Changes the notification’s attribute, Acknowledged to FALSE. Attribute values
modified using this command argument do not get propagated to Global Manager
through the Adapter Platform.


update <ClassName> <InstanceName>
<EventName> <attribute>=<value> ...


Modifies one or more of a notification’s attributes.
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An example of the sm_ems Notify command
The following sm_ems command creates a notification on the Adapter Platform Server ICOI:


tsm_ems --server=ICOI notify Router RouterNY25 Down 


 3rdParty DURABLE 3600 Category=3rdParty-Down Severity=2 s


The notification is for a Router named RouterNY25 and it is Down, which is in this case a durable event.
The notification expires in 3600 seconds. The Category attribute of the standard notification contains the
name of the event as seen in the third-party application.


An example of the sm_ems Create Element option with Notify
command
The following sm_ems command uses the --create-element option along with the notify command to:


n Create a Host, WebHost (Host::WebHost) if it does not exist in the VMware Smart Assurance
topology.


n Generate a notification, ApplicationService::WebServer Stopped. Specifies that the event was sent by
a third party, is a momentary type of event, will be cleared by its source, and has a severity level of 2.
Also, implies that the event OccurredOn Host::WebHost:


tsm_ems --server=ICOI --element-class=Host 


--element-name=WebHost --create-element notify ApplicationService WebServer Stopped 3rdParty 


momentary 


source severity=2 s


An example of the sm_ems Aggregate option with Notify
command
The following sm_ems command uses Aggregate option along with the notify command to generate two
notifications:


n Generate an Aggregate notification, CPU::WebHost-CPU High-Utilization. Specifies that the event
was sent by a third party, is a momentary type of event, and has a severity level of 1.


n Generate a component Notification, Host::WebHost Unresponsive, which is associated with the
previously generated Aggregate Notification:


tsm_ems --server=ICOI --aggregate-element-class=Host --aggregate-element-name=WebHost --aggregate-


event-name=unResponsive notify CPU WebHost-CPU High-Utilization 3rdParty momentary source 


severity=1 s
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Adapter Platform and
Notifications 6
The purpose of the Service Assurance Adapter Platformis to normalize events and place them into a
topological context so that they can be imported into a Global Manager. This means that the
Adapter PlatformServer takes incoming events from a variety of other sources and translates the
information into standard notifications. The standard notification is based on the ICIM_Notification class
and consists of many attributes. When the Adapter Platformis used as a platform for ASM Adapters, the
ASM Adapters set the properties of the notification attributes. Depending on the configuration of the
adapter, the attributes created for each notification may or may not be populated with data.


Also, when the Global Managercollects the notification information from the Adapter PlatformServer, not
all of the attributes of the notification get passed by default. Notification attributeslists the attributes of the
notifications for Service Assuranceand also identifies those that get passed to the Global Manager.


Note   For attributes that contain a time value, time is counted in seconds from Midnight, January 1st,
1970 GMT (the Epoch).


Table 6‑1.  Notification attributes


Notification attribute Type
Value range
(default value)


Passed
by default Description


Acknowledged Boolean TRUE or FALSE No TRUE if the notification has been
acknowledged, FALSE if not.


Active Boolean TRUE or FALSE


(Default: TRUE)


No TRUE if the notification is active, FALSE
if not.


AuditTrail Special No Audit trail for the notification. AuditTrail
is a table that includes:
n ActionType
n SerialNumber
n Text
n Timestamp
n User
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Table 6‑1.  Notification attributes (Continued)


Notification attribute Type
Value range
(default value)


Passed
by default Description


Category String Yes Type of notification. Possible values
include:
n Availability
n Discovery
n Error
n Operational
n Performance
n PowerSupply
n Resource
n Temperature
n IMPACT


These categories correspond to the
Exceptions of the same name described
in the
VMware Smart Assurance IP Manager
User Guideand the
VMware Smart Assurance Business
Impact Manager User Guide.


Certainty Float 0 to 100


(Default: 100)


Yes Confidence level that this notification is
the correct diagnosis.


ClassDisplayName String Yes Class name of the managed element
(where the event occurred) that is
displayed to the user.


ClassName String Yes Class name of the managed element
where the event occurred. This attribute
along with InstanceName and
EventName uniquely identifies this
notification. ClassName may differ from
the ElementClassName.


ClearOnAcknowledge Boolean TRUE or FALSE


(Default: FALSE)


Yes TRUE if the notification should be
cleared when it is acknowledged. Use
this in cases when notifications never
expire or that have sources that will not
generate a clear.


ElementClassName String Yes Class Name of the object that the event
occurred on.


ElementName String Yes Element Name of the object that the
event occurred on.


EventDisplayName String Yes Name of the notification that is displayed
to the user.


EventName String Yes Name of the event. This attribute along
with ClassName and InstanceName
uniquely identifies this notification.
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Table 6‑1.  Notification attributes (Continued)


Notification attribute Type
Value range
(default value)


Passed
by default Description


EventState String No Indicates the state of the notification.
Possible values include:
n ACTIVE
n SUSPENDED
n WAS_ACTIVE
n INACTIVE
n UNINITIALIZED


EventText String Yes A description of the notification.


EventType Special MOMENTARY or


DURABLE


(Default: DURABLE)


Yes Indicates the nature of the event. A
MOMENTARY event has no duration
(such as an authentication failure). A
DURABLE event has a period during
which the event is active and after which
the event is no longer active (such as a
link failure).


FirstNotifiedAt Integer (Default: 0) No First notification time. (This value is
reset after an event is archived.)


Events diagnosed by an underlying
domain include timestamps that
accurately reflect when the event
occurred. The Global Manageruses this
value from the event for the
FirstNotifiedAt/LastNotifiedAt times
when it creates the notification.


Impact Integer (Default: 0) No A number that quantifies the impact of
this notification on the infrastructure or
business processes. Larger numeric
values indicate a larger impact.


InMaintenance Boolean TRUE or FALSE


(Default: FALSE)


No TRUE indicates that the device
associated with the notification is in
maintenance mode, FALSE if not.


InstanceDisplayName String Yes Name of the instance that is displayed to
the user.


Note   If tagging is implemented in the
Global Manager, the
InstanceDisplayName may include a tag
suffix.


InstanceName String Yes Name of the instance where the event
occurred. This attribute along with
ClassName and EventName uniquely
identifies this notification.
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Table 6‑1.  Notification attributes (Continued)


Notification attribute Type
Value range
(default value)


Passed
by default Description


IsRoot Boolean TRUE or FALSE No TRUE if the notification is a root cause,
FALSE if not.


It is often useful to filter on IsRoot to find
those notifications which require
immediate attention.


IsProblem String Yes Yes indicates if (and only if) at least one
of the source event types is “PROBLEM”
and other source event types are either
“PROBLEM” or “UNKNOWN”.


No indicates that one or more of the
source event types is “EVENT” or
“AGGREGATE”.


Because filtering on IsRoot can result in
transient behavior when events are
received from multiple underlying
sources, it is recommended to filter on
IsProblem instead.


LastChangedAt Integer (Default: 0) No Time since the Epoch when the status of
the notification last changed. This is
calculated by the Global Manager.


LastClearedAt Integer (Default: 0) No Time since the Epoch when the
notification was last cleared. This is
calculated by the Global Manager.


LastNotifiedAt Integer (Default: 0) No Time since the Epoch when the
notification was last notified.


Name String No Internal identifier for the notification.


Occurrence Count Integer No Number of times the notification has
occurred.


Owner String No Name of the user responsible for
handling this notification.
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Table 6‑1.  Notification attributes (Continued)


Notification attribute Type
Value range
(default value)


Passed
by default Description


Severity Integer 1 to 5


(Default: 5)


Yes An enumerated value that describes the
severity of the notification from the
notifier's point of view. Valid values are
the integers 1 through 5:


1 Critical indicates action is needed
NOW and the scope is broad, for
example, an outage to a critical
resource.


2 Major indicates action is needed
NOW.


3 Minor indicates action is needed, but
the situation is not serious at this
time.


4 Unknown indicates that the element
is unreachable, disconnected, or in
an otherwise unknown state.


5 Normal is used when an event is
purely informational.


Note   Only the numbers, not the
text descriptions, are passed by the
Global Manager.


SourceDomainName String No The name of the domain that notified
current occurrences of this event. If
there is more than one domain, the
attribute lists each separated by a
comma.


An intermediary Managerthat relays an
event is not listed as a source. For
example, “Trap Processor” (SNMP Trap
Adapter) is listed as the source of a
notification and not the intermediary
SAM Adapter PlatformServer.


SourceEventType String UNKNOWN Yes Indicates the type of event from an
underlying source or sources. Value can
be: PROBLEM, EVENT, AGGREGATE,
or UNKNOWN. (Not to be confused with
Event Type.)


TroubleTicketID String No Trouble-ticket number associated with
this notification.


UserDefined1-10 String No User defined field 1-10.
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VMware Smart Assurance MIB
for SNMP Traps 7
The VMware Smart Assurance MIB implemented by VMware Corporation for SNMP Traps is as follows:


-- SMARTS-MIB.my: VMware Smart Assurance corporate MIB


--


-- Copyright 1999-2006 by VMware Corporation ("VMware").


-- All rights reserved.


--


-- UNPUBLISHED CONFIDENTIAL AND PROPRIETARY PROPERTY OF VMware.  The


-- copyright notice above does not evidence any actual or intended


-- publication of this software.  Disclosure and dissemination are


-- pursuant to separate agreements.  Unauthorized use, distribution


-- or dissemination are strictly prohibited.


--


-- RCS $Id: SMARTS-MIB.my,v 1.1.38.2 2006/02/06 23:41:15 eo1 Exp $


--


SMARTS-MIB DEFINITIONS ::= BEGIN


IMPORTS


        enterprises, Counter32, OBJECT-TYPE,


        MODULE-IDENTITY, OBJECT-IDENTITY, NOTIFICATION-TYPE


                FROM SNMPv2-SMI;


smartsMIB MODULE-IDENTITY


        LAST-UPDATED "200602070000Z"


        ORGANIZATION "VMware Corporation"


        CONTACT-INFO


                "       Support


                Postal: VMware Corporation


                        Corporate Headquarters


                        176 South Street


                        Hopkinton, MA 01748-9103


                        US


                Phone:


                  United States: (800) 782-4362 (SVC-4VMware)


                  Canada:        (800) 543-4782 (543-4SVC)


                  Worldwide:     (508) 497-7901


 Web: http://powerlink.VMware.com"


                DESCRIPTION


                        "The MIB module for VMware Smart Assurance entities defined by


                        VMware Corporation."


        ::= { enterprises 733 }


-- top level groups in the SMARTS-MIB


-- The smNotificationTrap Group.


smNotificationTrap OBJECT-IDENTITY
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        STATUS  current


        DESCRIPTION


         "This group is acutally the prefix one uses when creating


          enterprise-specific trap OID's for an SNMPv2 trap.  It is


          used in the SMARTS MIBS when defining traps."


        ::= { smartsMIB 0 }


-- The smNotificationData Group.


smNotificationData OBJECT-IDENTITY


        STATUS  current


        DESCRIPTION


         "The members of this group are the OIDs for VarBinds


          containing notification data."


        ::= { smartsMIB 2 }


-- Group for generic notification data.


smGenericNotify OBJECT-IDENTITY


        STATUS  current


        DESCRIPTION


         "The members of this group are the OIDs for VarBinds


          containing generic notification data."


        ::= { smNotificationData 1 }


smNotifTimestamp OBJECT-TYPE


        SYNTAX Counter32


        MAX-ACCESS accessible-for-notify


        STATUS  current


        DESCRIPTION


         "The timestamp of the notification."


        ::= { smGenericNotify 1 }


smNotifServer OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


         "The name of the server that is sending the notification."


        ::= { smGenericNotify 2 }


smNotifClass OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


         "The class of the object associated with the notification."


        ::= { smGenericNotify 3 }


smNotifInstance OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


        "The instance name of the object associated with the notification."


        ::= { smGenericNotify 4 }


smNotifEventName OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


        "The name of the event causing the notification."


        ::= { smGenericNotify 5 }
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smNotifInstanceID OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


         "The unique InCharge inventory identification 


          for the object associated with the notification."


        ::= { smGenericNotify 6 }


smNotifDescription OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


         "A complete description of the event."


        ::= { smGenericNotify 7 }


smNotifCertainty OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


         "The certainty of the event.  Floating-point number in the


          range 0-100, stored as a string."


        ::= { smGenericNotify 8 }


smNotifSeverity OBJECT-TYPE


        SYNTAX INTEGER {


                notApplicable (1),


                informational (2),


                warning (3),


                minor (4),


                major (5),


                severe (6)


        }


        MAX-ACCESS accessible-for-notify


        STATUS  current


        DESCRIPTION


         "The severity of the event.  Integer number in the range 1-6."


        ::= { smGenericNotify 9 }


-- The SMARTS enterprise Traps


--


-- These are the enterprise-specific trap codes currently in-use in


-- SMARTS software.  The final sub-OID of each object is the code sent


-- in the "specific-trap" field of an SNMPv1 Trap-PDU.


--


-- The definition of these objects mimics the SNMPv2 convention for


-- sending traps:  Take the enterprise OID, append 0, then append the


-- trap code.


-- TRAP NUMBER USE: Trap code 0 is reserved (by SNMP).


--                  Trap codes 1-3 are used by the SMARTS-OV-NV-MIB.


-- TRAPS 4-7: The "smTrap*" series of traps define "base" trap


--            numbers, ones with a generic purpose.  These traps are


--            also used by the generic Trap Adapter.


          smTrapNotification NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,
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                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


               }


            STATUS current


            DESCRIPTION


             "A trap describing an InCharge root cause notification.


              The text in smNotifDescription indicates the nature of


              the problem."


          ::= { smNotificationTrap 4 }


          smTrapCertaintyChange NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


                }


             STATUS current


             DESCRIPTION


              "A trap indicating a certainty change of an InCharge


               notification. The text in smNotifDescription indicates


               the nature of the problem."


           ::= { smNotificationTrap 5 }


           smTrapSeverityChange NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


                }


             STATUS current


             DESCRIPTION


              "A trap indicating a severity change of an InCharge


               notification. The text in smNotifDescription indicates


               the nature of the notification."


           ::= { smNotificationTrap 6 }


           smTrapNotificationClear NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,
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                        smNotifCertainty,


                        smNotifSeverity


                 }


              STATUS current


              DESCRIPTION


               "A trap indicating the clear of an InCharge notification."


           ::= { smNotificationTrap 7 }


           smTrapNotificationChange NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


                 }


              STATUS current


              DESCRIPTION


               "A trap indicating the change of an InCharge notification."


           ::= { smNotificationTrap 98 }


           smTrapNotificationDelete NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


                 }


              STATUS current


              DESCRIPTION


               "A trap indicating the delete of an InCharge notification."


           ::= { smNotificationTrap 99 }


-- TRAP NUMBER USE: Trap codes 8-99 are reserved for future "base trap number"


--                  use.


--


--                  Trap codes 100-133 are used by SMARTS-PERFORMANCE-MIB.


--                  Trap codes 134-199 are reserved for future use by


--                  SMARTS-PERFORMANCE-MIB. 


END
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Introduction 1
This chapter includes the following topics:


n Availability, features, and licensing


n Differences between MODEL and Dynamic Model


n Restrictions of dynamic modeling


n Developing dynamic models


n Location and loading of dynamic model files


Availability, features, and licensing
Dynamic Model is an extension of the Managed Object Definition Language (MODEL). MODEL is integral
to the VMware Smart Assurance SDK application development process. Its purpose is to render the
schema and semantics of the VMware Smart Assurance ICIM Reference specification. These libraries are
loaded by a Domain Manager and are operated on by SDK applications. Foran SDK application, all of the
classes, relationships, attributes, and events are defined at compile time.


Dynamic modeling enables you to add new classes, and refine classes that are already defined in the
data model libraries. These additions and refinements occur at runtime when the dynamic models are
loaded into a Domain Manager.


This section describes the different products that currently support Dynamic Model. It also gives an
overview of the features that are available.


Availability of dynamic modeling
Dynamic modeling is supported on all Domain Managers.


Features of dynamic modeling
The following features are provided by Dynamic Model:


n Classes may be made known to the system at runtime, when they are loaded into a Manager as a
dynamic model.


n A dynamic model compiler that produces a file with a .ldm extension that can be loaded by a
Manager.
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n You can load a dynamic model when the Domain Manager is started or after the Domain Manager is
running.


n When you load a dynamic model, the existing model class dependencies and the new dynamic model
class dependencies are resolved.


n A new class may be defined that derives from any existing ICIM class that is part of the
ICIM_ManagedElement and ICIM_MetaObject trees. The VMware Smart Assurance ICIM Reference 
provides information for determining which classes fall under the ICIM_ManagedElement and
ICIM_MetaObject trees.


n An existing ICIM class may be extended by defining new attributes, events, aggregates, relationships,
and operations for the class.


n An existing ICIM class may also be extended, by defining new problems and symptoms.


n You can refine relationships, events, aggregates, operations, and attributes in an existing ICIM class.


n You can refine problems and symptoms in an existing ICIM class.


Differences between MODEL and Dynamic Model
Although MODEL and Dynamic Model are used independently and involve different steps and tools, the
dynamic model is fully derived from MODEL so many of the concepts that apply to MODEL also apply to
the dynamic model. Familiarity with the VMware Smart Assurance MODEL Reference Guide is useful
when working with dynamic models.


Differences Between MODEL and Dynamic Model presents a summary of the differences between using
MODEL to create a custom solution and using Dynamic Model to enhance an existing solution.


Table 1‑1.  Differences Between MODEL and Dynamic Model


Feature MODEL Dynamic Model


Define new classes 3 3


Use “refine interface” to extend an existing ICIM class No 3


Use “refine interface” to extend a subclass of a new subclass No 3


Define new problems 3 3


Define new relationships 3 3


Refine existing relationships, events, aggregates, operations, and
attributes


3 3


Refine existing problems and symptoms 3 3


Define new symptoms 3 3


Define new events 3 3


Define new stored attributes 3 3


Define new propagated attributes 3 3


Define new instrumented attributes 3 3


Define new computed attributes 3 3


VMware Smart Assurance Dynamic Modeling Tutorial


VMware, Inc.  6







Table 1‑1.  Differences Between MODEL and Dynamic Model (Continued)


Feature MODEL Dynamic Model


Define new aggregates 3 3


Define new operations 3 3


Delete existing ICIM classes No No


The refine interface keyword
Dynamic model uses the refine interface keyword to indicate that any declarations that follow will modify
an existing ICIM class. In MODEL, you cannot refine an existing class.


The refine keyword
In both Dynamic Model and MODEL, the refine keyword is used to refine existing inherited properties of a
class, such as attributes, events, and so on. You can refine inherited class relationships, attributes and
events when you create a new subclass. These class properties may be inherited from the parent class or
any of the other classes up the inheritance tree to the base class.


Restrictions of dynamic modeling
This section describes the restrictions that you need to be aware of when using dynamic modeling.


Preprocessor macros
Preprocessor macros, including the preprocessor statement “#include”, may not be used in Dynamic
Model source code.


Pragmas
Only those pragmas listed in Pragmas, can be used with Dynamic Model. Pragmas that produce output in
C++ source files may not be used, since Dynamic Model does not generate C++ source files.


User-defined source code
User-defined source code that produces C++ stubs may not be included in Dynamic Model source files.


ICIM_ManagedDomain
ICIM_ManagedDomain and any of its subclasses cannot be subclassed or refined.


Single class refinement
All refinements to a class must be contained in a single


refine interface <classname> declaration. For example, you cannot have a
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refine interface Router declaration in the mymodel1.mdl file, and then another refine interface Router
in the mymodel2.mdl. Likewise, you cannot have more than one refine interface Router declaration in
the mymodel1.mdl file.


MODEL keywords and data types not available in the
Service Assurance Manager
There are several MODEL keywords and data types that can be used in the dynamic model files of the
IP Manager, but not in Service Assurance Manager.


n binary


n byte


n external


Avoid using the binary or byte data type, or the external keyword in any dynamic model files of the
IP Manager that you will be copying over to the Service Assurance Manager.


The binary data type
The binary data type represents binary data and can be used in IP Manager dynamic model files.
However, the binary data type is not available in the Service Assurance Manager dynamic model files.


After copying over dynamic model files from the IP Manager to the Service Assurance Manager, you must
remove any instances of the binary data type before compiling.


byte data type
The byte data type represents an unsigned 8-bit integer ranging from 0 - 255 in IP Manager dynamic
model files. However, the byte data type is not available in the Service Assurance Manager dynamic
model files.


After copying over dynamic model files from the IP Manager to the Service Assurance Manager, you must
replace any instances of the byte data type with the int data type before compiling.


external keyword
The external keyword can be used in IP Manager dynamic model files.The external keyword indicates
whether the literal text specified as the initial value of a string attribute will be externalized. The external
keyword implies both static and readonly. When including the external keyword in a declaration, do not
include the static and readonly keywords.


The external keyword is not available in Service Assurance Manager dynamic model files.


After copying over dynamic model files from the IP Manager to the Service Assurance Manager, you must
remove any instances of the external keyword before compiling.
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Developing dynamic models
This section describes the guidelines that should be used when using dynamic models. It also describes
the steps that are involved in the development cycle when extending a model of a Domain Manager.


Guidelines
Follow these guidelines when using dynamic models:


n Create and verify dynamic models on a test Manager prior to deploying them into any production
environment. The test Manager may be started and stopped several times during the process to
verify the results of each step.


n Create and edit the dynamic model files (those with extension .mdl) by using sm_edit.


Note   Only the .mdl files are created and edited by using sm_edit. The .ldm file generated by the
dynmodel compiler must not be edited.


n Classes that are related to each other should be contained in the same dynamic model file.


n Dynamic model files can be loaded when a Manager is started or after the Domain Manager is
already running. Location and loading of dynamic model files provides additional information.


n Perform a back up on the repository of the Manager before using dynamic modeling in a production
environment.


n Precede any new attributes, classes, aggregates or events that are defined with a unique tag, such
as “USR_”. You should not use "SM_" as this is already used by SDK.


n Avoid using the binary or byte data type, or the external keyword in any dynamic model files of the
IP Manager that you will be copying over to the Service Assurance Manager.


Note   Changes made by using dynamic modeling may impact the performance and load of the
Domain Manager.


Requirements
The following requirements must be followed when using dynamic model:


n Dynamic model filenames may contain ASCII letters (A..Z,a..z), ASCII numbers (0...9), and the
underscore character (_), but may contain no other characters. The first character must be a letter.


n The dynamic model filename must be unique within the first 23 characters.


n The dynamic model file that you edit must have a .mdl filename extension.


n Dynamic model files must follow the syntax rules described in Adding a class to the model and 
Updating an existing class in the model.


n All refinements to a class must be contained in a single


n refine interface <classname> declaration. For example, you cannot have a
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n refine interface Router declaration in the mymodel1.mdl file, and then another refine interface
Router in the mymodel2.mdl. Likewise, you cannot have more than one refine interface Router
declaration in the mymodel1.mdl file.


n Dynamic model files (those with extension .ldm) must be located in either
BASEDIR/smarts/modelorBASEDIR/smarts/model/<config>. The <config> refers to the configuration
directory that is specified on the command line when the Domain Manager is started. Loading
dynamic models during Manager startup provides further details.


Note   It is recommended to have both the .mdl and .ldm versions of a dynamic model file located
together in either the BASEDIR/smarts/model or BASEDIR/smarts/model/<config> directory.


n The dynamic model files (those with extension .ldm) must be loaded into each Manager that requires
knowledge of the new topology and events.


Development cycle
Several steps are involved in the development cycle of extending a model of a Domain Manager, by using
dynamic modeling. Steps involved in developing dynamic models illustrates the development cycle.
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Figure 1‑1.  Steps involved in developing dynamic models


The first five steps are common to all dynamic modeling development.


1 Add the new model elements to either a new dynamic model text file (.mdl) or an existing one. 
Chapter 5 Guidelines and Syntax for Dynamic Model Files contains additional information.


2 Compile the dynamic model text file into a file (those with extension .ldm) that can be loaded into a
Manager. The command used to compile the dynamic model file is described in Chapter 6 The
dynmodel Command Syntax and Options


3 If you require the string literals in the dynamic model text file to be of a language other than the
language in the dynamic model text file:


4 Copy the <modelname>_mm.txt file to <loc>.txt, and move it to the appropriate l10n subdirectory. The
<loc> refers to a locale such as, fr_FR for French as spoken in France.
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5 Edit <loc>.txt. Change the “root {“ to “<loc> {“ in the first line. Translate the string literals as required.
Return to step 2 on page 22 .


6 From the BASEDIR/smarts/model directory, copy the following files to the SM_SITEMOD/l10n
directory:


n Example1_mmbe.dat


n Example1_mmle.dat


7 Load the compiled dynamic model file into a Domain Manager. Verify that the new model elements
have been added to the list of classes or the list of properties by using the Global Console.


If you encounter errors, go back to step 1 on page 22 and make the appropriate modifications to
your .mdl file. Loading errors provides additional troubleshooting information.


8 If you have defined new classes, create or discover instances of those classes. Appendix C,
“Methods of Creating Classes and Populating Attributes,” provides additional information.


9 If you have defined new attributes, populate the values of those attributes, either manually or by using
the discovery mechanism. Appendix C, “Methods of Creating Classes and Populating Attributes,”
provides additional information.


10 If you want to view the new classes, attributes, problems, aggregates or events in the
Global Manager, then configure the appropriate DXA. Chapter 8 Updating the Global Manager
describes DXA configuration.


11 If you added new events, then add a subscription to the event in the appropriate bootstrap.conf files.


12 Verify the topology in the Global Console.


If you encounter errors, go back to step 1 on page 22 and make the appropriate modifications. 
Chapter 9 Troubleshooting provides additional information.


Model enhancement examples
This tutorial presents three different exercises:


n Chapter 2 Exercise 1 – Adding a New Printer Class, adds a new printer class to the model.


n Chapter 3 Exercise 2 - Adding an Attribute to the Router Class, adds a new attribute to an existing
ICIM class.


n Chapter 4 Exercise 3 - Polling for Values of Additional Attributes, adds an event whose state is
determined by a new attribute. The exercise also presents how to set up polling of the value for the
new attribute.


The source files for the exercises are located in the following directory:


               BASEDIR/smarts/examples/dynamic-model
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Location and loading of dynamic model files
Dynamic model files can be located in either the BASEDIR/smarts/local/model or
BASEDIR/smarts/local/model/<config> directories. The <config> refers to the configuration directory that
was specified on the command line when the Domain Manager was started.


Dynamic models can be loaded into a Manager during startup or while it is running.


The examples in this guide use the sm_server command to load the dynamic models into a Manager
during startup. If you use sm_service to start your Manager, edit the command string used by
sm_service to include the appropriate option to load your dynamic models. The
VMware Smart Assurance System Administration Guide provides additional information.


Loading dynamic models into a running Manager
The loadModel operation in the SM-System instance of the SM_System class is used to load a model into
a running Manager. All dynamic model files must be located in the BASEDIR/smarts/model directory. The
dmctl utility is used to invoke the loadModel operation. Using dmctl provides additional information. The
syntax for the command line is as follows:


t# 


        


         BASEDIR/smarts/bin/dmctl -s <domain_manager> [-b <broker>] invoke SM_System::SM-System 


loadModel <modelfilename> SM_DYNAMIC_LIBRARYs


where:


n <domain_manager> is the name of the Domain Manager.


n (Optional) <broker> is the name of the Broker to which the Domain Manager has been registered.
The default is localhost:426.


n <modelfilename> is the name of the model file without the extension.


For example, you would type the following to load the Example3.ldm dynamic model file into the
TESTDM Domain Manager attached to the broker on localhost:426.


t# 


        


               BASEDIR


               /smarts/bin/dmctl -s TESTDM -b localhost:426 invoke SM_System::SM-System loadModel 


Example3 SM_DYNAMIC_LIBRARYs


Verify that the model file was loaded. If you started your Domain Manager with the


-- output option, you can check the log file. Your output should be similar to the following:


[July 10, 2009 12:25:29 PM EDT +789ms] t@1120213312 LDM file processing #1


DYN-W-FILE_OPEN_OK- Reading


    '/opt/InCharge8/IP/smarts/local/model/Example3.ldm'


[July 10, 2009 12:25:44 PM EDT +141ms] t@1120213312 LDM file processing #1
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MRM-*-MRM_PROP_INIT-Property TS_OverrunThreshold initial value ='10'


[July 10, 2009 12:25:44 PM EDT +142ms] t@1120213312 LDM file processing #1


MRM-*-MRM_SET_PROP-Setting initial property of TS_OverrunThreshold to 10


[July 10, 2009 12:25:44 PM EDT +143ms] t@1120213312 LDM file processing #1


MRM-*-MRM_ACT_PROP-Actual initial value for TS_OverrunThreshold = 10


[July 10, 2009 12:25:44 PM EDT +144ms] t@1120213312 LDM file processing #1


DYN-W-CLASS_REFINE_CREATED- Interface NetworkAdapter_Performance_Setting


    refined from Example3.mdl:1


[July 10, 2009 12:25:44 PM EDT +145ms] t@1120213312 LDM file processing #1


MRM-*-MRM_PROP_INIT-Property TS_OverrunThreshold initial value ='10'


[July 10, 2009 12:25:44 PM EDT +146ms] t@1120213312 LDM file processing #1


MRM-*-MRM_SET_PROP-Setting initial property of TS_OverrunThreshold to 10


[July 10, 2009 12:25:44 PM EDT +146ms] t@1120213312 LDM file processing #1


MRM-*-MRM_ACT_PROP-Actual initial value for TS_OverrunThreshold = 10


[July 10, 2009 12:25:44 PM EDT +147ms] t@1120213312 LDM file processing #1


DYN-W-CLASS_REFINE_CREATED- Interface Interface_Performance_CiscoRouter


    refined from Example3.mdl:8


Loading dynamic models during Manager startup
A Manager can be started either without or with the --dynamic option. The use of the --dynamic option
determines which .ldm files are loaded into the Manager.


Starting a Manager without the --dynamic option
If you start a Manager without the --dynamicoption, the following .ldm files will be loaded:


n BASEDIR/smarts/model /<config>


The <config> refers to the configuration directory that is specified on the command line when the
Domain Manager is started.


In this example, a Global Manager is started without the --dynamic option. This example loads all of
the .ldm files in BASEDIR/smarts/model /ics since ics is the configuration directory specified in the
command line.


sm_server -n TEST-SA -c ics --output


Starting a Manager with the --dynamic option
Including the --dynamic option on the command line, when you start up a Manager, loads all of the .ldm
files in the following directories:


n BASEDIR/smarts/model


n BASEDIR/smarts/model / <config>


The <config> refers to the configuration directory that is specified on the command line when the
Domain Manager is started.
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In this example, all of the .ldm files in the BASEDIR/smarts/model and the
BASEDIR/smarts/model/icf-r directories are loaded into the TEST_NR server:


sm_server -n TEST_NR -c icf-r --output --dynamic
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Exercise 1 – Adding a New
Printer Class 2
This chapter includes the following topics:


n Objectives


n Exercise


Objectives
This exercise describes how to use Dynamic Model to add a new printer class without attributes or other
properties to the following:


n Network-Resource Manager


n IP-Perspective Manager


n IP-Analysis Manager


n Global Manager


This exercise also demonstrates how new instances can be classified in the new class, and then
discovered. Instances of the new class will be discovered automatically, based on the device’s MIB
object ID (OID) when the Network-Resource Manager is started.


Note   This exercise should be performed on test versions of a Broker, Network-Resource Manager,
IP-Perspective Manager, IP-Analysis Manager, and Global Manager. Before starting this exercise,
back up the repository on the test Managers.


This exercise includes the following tasks:


n Create and compile a dynamic model file.


n Add a new printer class to the models in a Network-Resource Manager, IP-Perspective Manager,
IP-Analysis Manager, and Global Manager.


n View the new printer class by using the Global Console.


n Set up the printer OID for discovery.


n Reload the dynamic model file into the Network-Resource Manager, IP-Perspective Manager, and
IP-Analysis Manager.


n Set up topology sources for the IP-Perspective Manager, and the IP-Analysis Manager.
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n Discover instances of the new class by using the Network-Resource Manager.


n Add the new printer class into the Global Manager model.


Exercise
After your network has been discovered, you may want to differentiate certain devices, such as personal
computers or printers, from hosts in your topology. This exercise extends the model by adding a class to
represent a printer. The printer class is declared without any additional properties, other than those
attributes, events, and relationships that are inherited from its parent class.


A new class is declared as a subclass of an existing ICIM class. The key is to determine which class
should be the parent class. This determination is based on several factors:


n How you want to search and report on the new class


n Functional similarities to existing elements in topology


n The events, attributes, and relationships the new class needs to inherit


A printer is a physical element, on the same level as a router or a host. In this exercise, its parent
class is the UnitaryComputerSystem, which is also the parent class of the router and host. A printer,
router, and host all inherit the same attributes, events, and relationships from the
UnitaryComputerSystem class.


The IP Manager counts the instances of the ICIM_UnitaryComputerSystem. When your dynamic
model classes inherit from ICIM_UnitaryComputerSystem, instances of that class will take advantage
and participate on the full predefined IP Management Suite root cause analysis model.


If the instances of your class do not need to participate on the full root cause analysis, you can inherit
from either ICIM_System or ICIM_ComputerSystem. In addition, if you inherit from either
ICIM_System or ICIM_ComputerSystem you will have to add your new class into the appropriate dxa
to transfer the topology to the Global Manager. Chapter 3 Exercise 2 - Adding an Attribute to the
Router Class provides information about adding a class and its associated attributes to dxa files.


In the following procedures, the syntax is the same as that used to declare any MODEL class. Adding
the new class provides more detail.


Note   Use a unique prefix with new class names and other properties. The name must differ from
existing ICIM classes and properties. “SM_” is used as a prefix in this exercise. Do not use "SM_" as
this is already used by SDK.


Unless otherwise noted, BASEDIR refers to the directory for the IP Manager.


Creating and compiling the dynamic model
In this exercise, you create and compile a new dynamic model.
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Creating the dynamic model
In this example, the same dynamic model is loaded into several Domain Managers, each starting with a
different --conf directory. Instead of copying the same compiled dynamic model file (the file with
extension .ldm) to each BASEDIR/smarts/local/model/<conf> directory, one single copy is created and
compiled in BASEDIR/smarts/local/model. Each of the Domain Managers is then started with the --
dynamic command line option to load the compiled dynamic model file from
BASEDIR/smarts/local/model.


To create the dynamic model:


1 Create and edit a new file in the BASEDIR/smarts/modeldirectory. Type the following at a command
prompt:


               


               BASEDIR


               /smarts/bin/sm_edit --create model/Example1.mdl


            


2 To declare the new printer class as a subclass of the UnitaryComputerSystem class, type the
following lines into the Example1.mdl file.


               interface SM_Printer:UnitaryComputerSystem


               "Create a printer class inheriting from UCS"


               {


               }


            


3 Save and close the Example1.mdl file.


The file is saved in the BASEDIR/smarts/local/modeldirectory.


Compiling the dynamic model
From theBASEDIR/smarts/local/model directory, run the command to compile the Example1.mdl model
file:


         # 


        


         cd


         BASEDIR


         /smarts/local/model


         # 


        


         BASEDIR


         /smarts/bin/dynmodel Example1.mdl
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If it is successful, the dynmodel command does not produce any output to the command-line console. In
addition, the following files are created in the BASEDIR/smarts/local/model directory:


n Example1.ldm


n Example1_mmbe.dat


n Example1_mmle.dat


n Example1_mm.txt


The following subdirectory is also created in the BASEDIR/smarts/model directory:


n Example1_mm


Compilation errors on page 111 provides additional information if you encounter errors.


Copying files for localization
From the BASEDIR/smarts/model directory, copy the following files to the SM_SITEMOD/l10n directory:


n Example1_mmbe.dat


n Example1_mmle.dat


Loading and viewing the new class in the Domain Manager s
Once the dynamic model has been compiled, you must load it into the appropriate Domain Managers.
The Printer class appears in the topology of the Network-Resource Manager, the
IP-Perspective Manager, and the IP-Analysis Manager. The dynamic model is loaded into all three of
these Domain Managers.


Loading the dynamic model into the Network-Resource Manager
In this procedure, TEST_SERVER_RM is the name of the test Network-Resource Manager. The
Network-Resource Manager is started with the --dynamic command line option to pull the compiled
dynamic model file from BASEDIR/smarts/local/model.


Note   If the test Network-Resource Manager is already running, stop it first.


To load the dynamic model:


Note   Two dash (--) characters precede the output and dynamic options of the sm_server command.


1 Load the compiled dynamic model file into the test Network-Resource Manager.


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER_RM -c icf-r 
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                --broker=localhost:426 --bootstrap=bootstrap.conf --output


               


                --dynamics


2 Open the log file.


If the new SM_Printer class has been processed successfully, the output from the sm_server
command appears similar to:


 [May, 27, 2009 12:23:33 PM EDT +999ms] t@4097444752 LDM file processing #1


 DYN-W-FILE_OPEN_OK- Reading


    'BASEDIR/smarts/local/model/Example1.ldm'


 [May, 27, 2009 12:23:47 PM EDT +200ms] t@4097444752 LDM file processing #1


 DYN-W-CLASS_DEFINITION_CREATED- Interface SM_Printer created from


    Example1.mdl:3


Verifying that the new class is present in the Network-Resource Manager
Before trying to discover instances of the new printer class, verify that the SM_Printer class has been
added to the data model of TEST_SERVER_RM.


To verify the presence of the new class:


1 Open a Global Console. For this example, attach to TEST_SERVER_RM.


2 Right-click within the Topology Browser Console topology tree and select Select .


3 Select Show classes with no instances in current domain, and click OK.


4 In the Topology Browser Console, verify that the SM_Printer class has been added as shown in 
SM_Printer class in topology of TEST_SERVER_RM.


Note   You can also use dmctlto verify whether the class is present in the topology. Command-line
modeprovides further details.


Figure 2‑1.  SM_Printer class in topology of TEST_SERVER_RM
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Loading the dynamic model into the IP-Perspective Manager
In this procedure, TEST_SERVER_P is the name of the test IP-Perspective Manager. The
IP-Perspective Manager is started with the --dynamic command line option to pull the compiled dynamic
model file from BASEDIR/smarts/local/model.


Note   If the test IP-Perspective Manager is already running, stop it first.


To load the dynamic models:


Note   Two dash (--) characters precede the output and dynamic options of the sm_server command.


1 Load the compiled dynamic model file into the test IP-Perspective Manager.


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER_P -c icf-p 


               


                --broker=localhost:426 --bootstrap=bootstrap.conf --output


               


                --dynamics


2 Open the log file. If the new SM_Printer class has been processed successfully, the output from the
sm_server command appears similar to:


 [May, 27, 2009 12:23:33 PM EDT +999ms] t@4097444752 LDM file processing


 #1


 DYN-W-FILE_OPEN_OK-Reading


    'BASEDIR/smarts/local/model/Example1.ldm'


 [May, 27, 2009 12:23:47 PM EDT +200ms] t@4097444752 LDM file processing


 #1


 DYN-W-CLASS_DEFINITION_CREATED- Interface SM_Printer


 created from


    Example1.mdl:3


Verifying that the new class is present in the IP-Perspective Manager
In the Topology Browser Console, attach to the TEST_SERVER_P Domain Manager. Verify that the
SM_Printer class has been added to the data model of TEST_SERVER_P.


To verify the presence of the new class:


1 In the Topology Browser Console menu bar, select Manager > Attach.


2 In the Attach Manager dialog box, select TEST_SERVER_P in the Manager drop-down list. Type
the appropriate username and password, and click OK.


3 In the Topology Browser Console, select TEST_SERVER_P from the Manager drop-down list.
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4 Right-click within the Topology Browser Console topology tree and click Select . Select Show
classes with no instances in current domain, and click OK.


5 In the Topology Browser Console, verify that the SM_Printer class has been added.


Note   You can also use dmctl to verify whether the class is present in the topology. Command-line
mode provides further details.


.


Loading the dynamic model into the IP-Analysis Manager
In this procedure, TEST_SERVER_A is the name of the test IP-Analysis Manager. The
IP-Analysis Manager is started with the --dynamic command line option to pull the compiled dynamic
model file from BASEDIR/smarts/local/model.


Note   If the test IP-Analysis Manager is already running, stop it first.


To load the dynamic model:


Note   Two dash (--) characters precede the output and dynamic options of sm_server.


1 Load the compiled dynamic model file into the test IP-Analysis Manager.


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER_A -c icf-a 


               


                --broker=localhost:426 --bootstrap=bootstrap.conf --output


               


                --dynamics


2 Open the log file. If the new SM_Printer class has been processed successfully, the output from the
sm_server command appears similar to:


 [May, 27, 2009 12:23:33 PM EDT +999ms] t@4097444752 LDM file processing


 #1


 DYN-W-FILE_OPEN_OK-Reading


    'BASEDIR/smarts/local/model/Example1.ldm'


 [May, 27, 2009 12:23:47 PM EDT +200ms] t@4097444752 LDM file processing


 #1


 DYN-W-CLASS_DEFINITION_CREATED- Interface SM_Printer


 created from


    Example1.mdl:3


Verifying that the new class is present in the IP-Analysis Manager
In the Topology Browser Console, attach to the TEST_SERVER_A Domain Manager. Verify that the
SM_Printer class has been added to the data model of TEST_SERVER_A.


VMware Smart Assurance Dynamic Modeling Tutorial


VMware, Inc.  22







To verify the presence of the new class:


1 In the Topology Browser Console menu bar, select Manager > Attach.


2 In the Attach Manager dialog box, select TEST_SERVER_A in the Manager drop-down list, and
type the password. Click OK.


3 In the Topology Browser Console, select TEST_SERVER_A from the Manager drop-down list.


4 Right-click within the Topology Browser Console topology tree and select Select . Select Show
classes with no instances in current domain, and click OK.


5 In the Topology Browser Console, verify that the SM_Printer class has been added.


Note   You can also use dmctl to verify whether the class is present in the topology. Command-line
mode provides further details.


Setting up the printer OID for discovery
Printers are network devices, but they are classified generically as a host by the SDK discovery process.
You can, however, add such devices to a field certification file so that SDK:


n Properly recognizes the devices


n Classifies the devices as instances of the new SM_Printer class


Determining if the printer is already defined
You need to determine if the printer is already defined generically (TYPE = Host), in one of the existing
SDK certification files. Certification files are named oid2type_*.conf and are found in the
BASEDIR/smarts/conf/discovery directory.


If the printer OID is already present in one of the existing certification files, use sm_edit to edit the
particular oid2type file to comment out the entry.


In this procedure, the printer OID, .1.3.6.1.4.1.253.8.62.1.19.3.1.3, is also defined in
BASEDIR/smarts/conf/discovery/oid2type_Misc.conf.


To remove the generic definition:


1 Edit the oid2type_Misc.conf file, by using sm_edit.


               # 


        


               BASEDIR


               /smarts/bin/sm_edit conf/discovery/oid2type_Misc.conf


            


2 Comment out the entry for the duplicate OID by preceding the lines with a pound sign (#):


               #.1.3.6.1.4.1.253.8.62.1.19.3.1.3 {


#  TYPE = Host


#  VENDOR = HP


#  CERTIFICATION = VALIDATED
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#


               #INSTRUMENTATION:


#  Interface-Fault   = MIB2


#  Interface-Performance  = MIB2


#}


3 Save and close the file.


The edited copy is saved in the BASEDIR/smarts/local/conf/discovery/ directory.


Adding the printer OID to the field certification file
To add the printer OID to the field certification file:


1 Open the oid2type_Field.conf file by using the sm_edit utility in the BASEDIR/smarts/bin directory.


               # 


        


               cd


               BASEDIR


               /smarts/bin


               # 


        


               sm_edit conf/discovery/oid2type_Field.conf


            


2 Type the following lines at the bottom of the oid2type_Field.conf file.


These lines create an instance of the SM_Printer class each time this model printer, designated by
the OID (.1.3.6.1.4.1.253.8.62.1.19.3.1.3), is discovered in the network. The TYPE attribute
designates this OID as a member of the SM_Printer class.


 .1.3.6.1.4.1.253.8.62.1.19.3.1.3 {


      TYPE = SM_Printer


       VENDOR = XEROX


       MODEL = Xerox Phaser 5500


       CERTIFICATION = TEMPLATE


  INSTRUMENTATION:


       Interface-Fault                   = MIB2


       Interface-Performance             = MIB2


  }


3 Save and close the oid2type_Field.conf file.


The modified version of the file is saved to the BASEDIR/smarts/local/conf/discovery directory.


Reloading the dynamic model
Because the oid2type_Field.conf file is processed when a Domain Manager is first started,
TEST_SERVER_RM, TEST_SERVER_P, and TEST_SERVER_A must be stopped and restarted for any
changes to take effect. The new class must be loaded into all three Domain Managers.
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The Domain Managers are started with the --dynamic command line option to pull the compiled dynamic
model file from BASEDIR/smarts/local/model.


To reload the dynamic model:


1 Stop TEST_SERVER_RM.


2 Reload the compiled dynamic model file into TEST_SERVER_RM.


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER_RM -c icf-r 


               


               --broker=localhost:426 --bootstrap=bootstrap.conf --output


               


               --dynamics


3 Stop TEST_SERVER_P.


4 Reload the compiled dynamic model file into the test Domain Manager.


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER_P -c icf-p 


               


               --broker=localhost:426 --bootstrap=bootstrap.conf --output


               


               --dynamics


5 Stop TEST_SERVER_A.


6 Reload the compiled dynamic model file into TEST_SERVER_A.


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER_A -c icf-a 


               


               --broker=localhost:426 --bootstrap=bootstrap.conf --output


               


               --dynamics


Setting up topology sources
The Network-Resource Manager is added as a source of topology to both the IP-Perspective Manager
and the IP-Analysis Manager. In addition, the IP-Perspective Manager is also added as a topology source
to the IP-Analysis Manager.
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Adding the Network-Resource Manager as a source to the
IP-Perspective Manager
To add the Network-Resource Manager as a source:


1 In the Topology Browser Console, select Configure> Domain Manager Administrative Console.


2 In the Domain Manager Administrative Console, select TEST_SERVER_P in the Manager drop-down
list.


3 In the Domain Manager Administrative Console, select Topology > Add Source.


4 In the Add Source dialog box, type TEST_SERVER_RM in the Element Name field. Keep
NETWORK-RESOURCE-TYPE as the Element Type. Click OK.


Adding the Network-Resource Manager as a source to the
IP-Analysis Manager
To add the Network-Resource Manager as a source:


1 In the Domain Manager Administrative Console, select TEST_SERVER_A in the Manager drop-
down list.


2 In the Domain Manager Administrative Console, select Topology > Add Source.


3 In the Add Source dialog box, type TEST_SERVER_RM in the Element Name field. Select
NETWORK-RESOURCE-TYPE as the Element Type. Click OK.


Adding the IP-Perspective Manager as a source to the IP-Analysis Manager
To add the IP-Perspective Manager as a source:


1 In the Domain Manager Administrative Console, select TEST_SERVER_A in the Manager drop-
down list.


2 In the Domain Manager Administrative Console, select Topology > Add Source.


3 In the Add Source dialog box, select IP-PERSPECTIVE-TYPE in the Element Type drop-down list.
Type TEST_SERVER_P in the Element Name field. Click OK.


Discovering an instance of the SM_Printer class
To discover a printer instance:


1 In the Domain Manager Administrative Console, select TEST_SERVER_RM in the Manager drop-
down list.


2 Initiate discovery. One method is to select Topology > Add Agent , and type either the name or IP
address of the printer.


The VMware Smart Assurance IP Management Suite Discovery Guide describes various methods of
discovery.
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3 Verify that the printer has been added to the topology as an instance of the new SM_Printer class as
shown in Printer discovered as an instance of SM_Printer.


Figure 2‑2.  Printer discovered as an instance of SM_Printer


4 Select TEST_SERVER_P in the Manager drop-down list and verify that the printer instance has been
added to the topology.


5 Select TEST_SERVER_A in the Manager drop-down list and verify that the printer instance has been
added to the topology.


Adding the new class to the Global Manager
The new SM_Printer class has only been loaded into the test Network-Resource Manager,
IP-Perspective Manager, and IP-Analysis Manager. The test Global Manager does not contain the new
class in its model. Therefore, the new class cannot be viewed in the Global Manager. This section
explains:


n Compiling and loading the dynamic model into the Global Manager.


n Transferring the topology information from the Network-Resource Manager, IP-Perspective Manager,
and IP-Analysis Manager to the Global Manager.


Note   In this section,BASEDIR is the directory for the Service Assurance Manager, unless otherwise
noted.


Compiling and loading the dynamic model into the Global Manager


Note   This exercise should be performed on a test version of a Global Manager. Before starting this
exercise, back up the repository on the test Global Manager.
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The dynamic model enhancements must be loaded into the Global Manager. Otherwise, the
Global Manager has no awareness of the new SM_Printer class.


To compile and load the dynamic model into the Global Manager:


1 Copy Example1.mdlfrom the IP Manager’s BASEDIR/smarts/local/modeldirectoryto the
Service Assurance Manager’s BASEDIR/smarts/local/modeldirectory.


2 From the Service Assurance Manager’s BASEDIR/smarts/local/model directory, run the command to
compile the Example1.mdl model file:


               # 


        


               cd


               BASEDIR


               /smarts/local/model


               # 


        


               BASEDIR


               /smarts/bin/dynmodel Example1.mdl


            


3 Load the compiled dynamic model file into the test Global Manager.


t# 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SA -c ics 


               


                --broker=localhost:426 --output --dynamics 


This example registers TEST_SA with the Broker that is running on the host named “localhost” and
port 426. Substitute the host and port of your Broker if they are different.


Adding the Network-Resource Manager as a source to the Global Manager
To add the Network-Resource Manager as a source:


1 In the Topology Browser Console menu bar, select Manager > Attach


2 In the Attach Manager dialog box, select TEST_SA in the Manager drop-down list. Type the
appropriate username and password, and click OK.


3 In the Topology Browser Console, select Configure> Global Manager Administrative Console.


4 In the Global Manager Administrative Console, select TEST_SA in the Manager drop-down list.


5 In the Global Manager Administrative Console, select Edit > New Domain.


6 In the Domain Creation Wizard dialog box, type TEST_SERVER_RM in the Domain Name field.
Select Network-Resource in the Copy Existing drop-down list. Click Finish.
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Adding the IP-Perspective Manager as a source to the Global Manager
To add the IP-Perspective Manager as a source:


1 In the Global Manager Administrative Console, select Edit > New Domain.


2 In the Domain Creation Wizard dialog box, type TEST_SERVER_P in the Domain Name field.
Select IP-Perspective in the Copy Existing drop-down list. Click Finish.


Adding the IP-Analysis Manager as a source to the Global Manager
To add a IP-Analysis Manager as a source:


1 In the Global Manager Administrative Console, select Edit > New Domain.


2 In the Domain Creation Wizard dialog box, type TEST_SERVER_A in the Domain Name field.
Select IP-Analysis in the Copy Existing drop-down list. Click Finish.


Reconfiguring the Global Manager
To reconfigure:


1 In the Global Manager Administrative Console, select Configure > Reconfigure Server.


2 Click Close at the prompt.


Verifying the presence of the SM_Printer class instance in the Global Manager
To verify the presence of the SM_Printer class:


1 In the Topology Browser Console, verify that the SM_Printer class has been added, as shown in 
SM_Printer class in the TEST_SA Global Manager.


Figure 2‑3.  SM_Printer class in the TEST_SA Global Manager
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2 Right-click the printerinstance (CAXTON in this procedure) and select Show Map. The printer
instance is displayed in a Map Console, as shown in Map view of the SM_Printer instance.


Figure 2‑4.  Map view of the SM_Printer instance


3 If you have a custom icon to represent a printer, you can modify the icon used to display an instance
of SM_Printer. The VMware Smart Assurance Service Assurance Manager Configuration Guide has
more information on custom icons for map nodes.
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Exercise 2 - Adding an Attribute
to the Router Class 3
This chapter includes the following topics:


n Objectives


n Exercise


Objectives
In this exercise, you add a new attribute to an existing ICIM class in the following:


n Network-Resource Manager


n IP-Perspective Manager


n IP-Analysis Manager


n Global Manager


This exercise also demonstrates how the value of the new attribute can be populated.


Note   This exercise should be performed on test versions of a Broker, Network-Resource Manager,
IP-Perspective Manager, IP-Analysis Manager, and Global Manager. Before starting this exercise,
back up the repository on the test Managers.


This exercise includes the following tasks:


n Create and compile a dynamic model file.


n Add an attribute to the existing Router class in the models of the Network-Resource Manager,
IP-Perspective Manager, and the IP-Analysis Manager.


n View the new attribute in the Router class by using the Global Console.


n Set up topology sources for the IP-Perspective Manager, and the IP-Analysis Manager.


n Discover an instance of the Router class.


n Populate the value of the new attribute in the Network-Resource Manager, IP-Perspective Manager,
and the IP-Analysis Manager.


n Compile and load the new Router attribute into the Global Manager model.


n Transfer the value of the new Router attribute to the Global Manager.
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Exercise
This exercise describes how to add an attribute for the serial number to the existing Router class in order
to extend the following models:


n Network-Resource Manager


n IP-Perspective Manager


n IP-Analysis Manager


n Global Manager


The syntax is the same as that used to declare any attribute in a MODEL class.


Note   Use a unique prefix with new class names and other properties. The name must differ from
existing ICIM classes and properties. “SM_” is used as a prefix in this exercise. Do not use "SM_" as
this is already used by SDK.


Unless otherwise noted, BASEDIR refers to the directory for the IP Manager.


Creating and compiling the dynamic model
In this exercise, you create and compile a new dynamic model.


Creating the dynamic model
In this example, the same dynamic model is loaded into several Domain Managers, each starting with a
different --conf directory. Instead of copying the same compiled dynamic model file (the file with
extension .ldm) to each BASEDIR/smarts/local/model/<conf> directory, one single copy is created and
compiled in BASEDIR/smarts/local/model. Each of the Domain Managers is then started with the --
dynamic command line option to load the compiled dynamic model file from
BASEDIR/smarts/local/model.


To create the dynamic model:


1 Create and edit a new file in the BASEDIR/smarts/local/modeldirectory. Type the following at a
command prompt:


               BASEDIR


               /smarts/bin/sm_edit --create model/Example2.mdl
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2 To add the serial number attribute to the Router class, type the following lines into the Example2.mdl
file.


 refine interface Router


 {


  stored attribute string SM_SerialNumber


  "Custom serial number" 


  = "NotAvailable";


 }


3 Save and close the Example2.mdl file.


The file is saved in the BASEDIR/smarts/local/modeldirectory.


Compiling the dynamic model
From theBASEDIR/smarts/local/model directory, run the command to compile the Example2.mdl model
file.


To compile:


         # 


        


         cd


         BASEDIR


         /smarts/local/model


         # 


        


         BASEDIR


         /smarts/bin/dynmodel Example2.mdl


      


If it is successful, the dynmodel command does not produce any output to the command-line console. In
addition, the following files and subdirectory are created in the BASEDIR/smarts/local/model directory:


n Example2.ldm


n Example2_mmbe.dat


n Example2_mmle.dat


n Example2_mm.txt


The following subdirectory is also created in the BASEDIR/smarts/local/model directory:


n Example2_mm


Compilation errors on page 111 provides additional information if you encounter errors.


Copying files for localization
From the BASEDIR/smarts/local/model directory, copy the following files to the SM_SITEMOD/l10n
directory:


n Example2_mmbe.dat
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n Example2_mmle.dat


Transferring the new attribute to the other Domain Manager s
Whether or not the new attribute is transferred from the Network-Resource Manager to the other
Domain Managers depends on the purpose of the attribute. Several scenarios for updating dxa files
between Domain Managers presents a few scenarios and describes which inter-Domain Manager dxa file
needs to be updated with the new attribute.


Table 3‑1.  Several scenarios for updating dxa files between Domain Manager s


Scenario Inter-Domain Manager dxa file that is modified


Variable is discovered in the
Network-Resource Manager and only needs to appear
in the Global Manager


None


Note   The attribute does need to be added to the
Network-Resource Manager to Global Manager dxa.


Variable is made available to satellite
Domain Managers through the IP-Analysis Manager


Network-Resource Manager to IP-Analysis Manager


Variable is to be used for postprocessing Network-Resource Manager to IP-Perspective Manager


However, so that you may see all of the files that are involved, this example shows the steps to transfer
the new attribute from the Network-Resource Manager to both the IP-Perspective Manager and the
IP-Analysis Manager.


Transferring the new attribute from the Network-Resource Manager to the
IP-Perspective Manager
The dxa-iptm-from-iprm.conf file provides a listing of the classes, and attributes of those classes, that will
be transferred from the Network-Resource Manager to the IP-Perspective Manager.


To add the Router attribute to the dxa-iptm-from-iprm.conf file:


1 Edit the dxa-iptm-from-iprm.conf file by using sm_edit:


               # 


        BASEDIR/smarts/bin/sm_edit conf/icf-p/dxa-iptm-from-iprm.conf


            


2 Type the following two lines for the Router class (shown in bold) before the entry for the
UnitaryComputerSystem as follows:


# DXA file for transferring topology from IP Resource Manager


# to IP Perspective (topology) manager.


#


prehook    icf-p/iptm-iprm-dxa-prehook.asl


class Router


               attr  SM_SerialNumber
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class UnitaryComputerSystem


attr  DisplayName


attr  IsManaged   IsManagedActive


attr  UseBridgingRelationship


3 Save and close the dxa-iptm-from-iprm.conf file.


The modified version of the file is saved to the BASEDIR/smarts/local/conf/icf-p directory.


Transferring the new attribute from the Network-Resource Manager to the
IP-Analysis Manager
The dxa-ipam-from-iprm.conf file provides a listing of what classes, and attributes of those classes, will be
transferred from the Network-Resource Manager to the IP-Analysis Manager.


To add the Router attribute to the dxa-ipam-from-iprm.conf file:


1 Edit the dxa-ipam-from-iprm.conf file by using sm_edit:


               # 


        BASEDIR/smarts/bin/sm_edit conf/icf-a/dxa-ipam-from-iprm.conf


            


2 Type the following two lines for the Router class (shown in bold) before the entry for the
UnitaryComputerSystem, as follows:


# DXA file for transferring topology from Network Resource Manager


# to IP Analysis Manager.


#


prehook    icf-a/ipam-iprm-dxa-prehook.asl


class Router


               attr  SM_SerialNumber


class UnitaryComputerSystem


peek  IsManaged   TRUE


attr  DisplayName


attr  IsManaged   IsManagedActive


attr  UseBridgingRelationship 


3 Save and close the dxa-ipam-from-iprm.conf file.


The modified version of the file is saved to the BASEDIR/smarts/local/conf/icf-a directory.


Loading and viewing the new attribute in the Domain Manager s
Once the dynamic model has been compiled, you must load it into the appropriate Domain Managers.
The Router class appears in the topology of the Network-Resource Manager, the
IP-Perspective Manager, and the IP-Analysis Manager. The dynamic model is loaded into all three of
these Domain Managers.
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Loading the dynamic model into the Network-Resource Manager
In this procedure, TEST_SERVER_RM is the name of the test Network-Resource Manager. The
Network-Resource Manager is started with the --dynamic command line option to pull the compiled
dynamic model file from BASEDIR/smarts/local/model.


Note   If the test Network-Resource Manager is already running, stop it first.


To load the dynamic model:


Note   Two dash (--) characters precede the output and dynamic options of the sm_server command.


1 Load the compiled dynamic model file into the test Network-Resource Manager.


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER_RM -c icf-r 


               


                --broker=localhost:426 --bootstrap=bootstrap.conf --output


               


                --dynamics


2 Open the log file. If the new SM_SerialNumber attribute has been processed successfully, the output
from the sm_server command appears similar to:


[September 11, 2009 4:27:08 PM EDT +263ms] t@1084463424 LDM file processing #1


DYN-W-FILE_OPEN_OK- Reading '/opt/InCharge8/IP/smarts/local/model/Example2.ldm'


[September 11, 2009 4:27:15 PM EDT +401ms] t@1084463424 LDM file processing #1


MRM-*-MRM_SET_PROP-Setting initial property of SM_SerialNumber to "NotAvailable"


[September 11, 2009 4:27:15 PM EDT +401ms] t@1084463424 LDM file processing #1


MRM-*-MRM_ACT_PROP-Actual initial value for SM_SerialNumber = "NotAvailable"


[September 11, 2009 4:27:15 PM EDT +405ms] t@1084463424 LDM file processing #1


DYN-W-CLASS_REFINE_CREATED- Interface Router refined from Example2.mdl:1


Verifying that the new attribute is present in the Network-Resource Manager
Before trying to populate the value of the new attribute, verify that the SM_SerialNumber attribute has
been added to the Router class in the data model of TEST_SERVER_RM.


To verify the presence of the new attribute:


1 Open a Global Console. For this example, attach to TEST_SERVER_RM.


2 Right-click within the Topology Browser Console topology tree and select Select .


3 Select Show classes with no instances in current domain, and click OK.


4 Select the Router class in the topology tree to display the attributes in the Attributes tab.


The SM_SerialNumber attribute appears, as shown in Serial number attribute added to the Router
class in TEST_SERVER_RM.
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Figure 3‑1.  Serial number attribute added to the Router class in TEST_SERVER_RM


Loading the dynamic model into the IP-Perspective Manager
In this procedure, TEST_SERVER_P is the name of the test IP-Perspective Manager. The
IP-Perspective Manager is started with the --dynamic command line option to pull the compiled dynamic
model file from BASEDIR/smarts/local/model.


Note   If the test IP-Perspective Manager is already running, stop it first.


To load the dynamic model:


Note   Two dash (--) characters precede the output and dynamic options of the sm_server command.


1 Load the compiled dynamic model file into the test IP-Perspective Manager.


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER_P -c icf-p 


               


                --broker=localhost:426 --bootstrap=bootstrap.conf --output


               


                --dynamics
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2 Open the log file. If the new SM_SerialNumber attribute has been processed successfully, the output
from the sm_server command appears similar to:


[September 11, 2009 4:27:08 PM EDT +263ms] t@1084463424 LDM file processing #1


DYN-W-FILE_OPEN_OK- Reading '/opt/InCharge8/IP/smarts/local/model/Example2.ldm'


[September 11, 2009 4:27:15 PM EDT +401ms] t@1084463424 LDM file processing #1


MRM-*-MRM_SET_PROP-Setting initial property of SM_SerialNumber to "NotAvailable"


[September 11, 2009 4:27:15 PM EDT +401ms] t@1084463424 LDM file processing #1


MRM-*-MRM_ACT_PROP-Actual initial value for SM_SerialNumber = "NotAvailable"


[September 11, 2009 4:27:15 PM EDT +405ms] t@1084463424 LDM file processing #1


DYN-W-CLASS_REFINE_CREATED- Interface Router refined from Example2.mdl:1


Verifying that the new attribute is present in the IP-Perspective Manager
In the Topology Browser Console, attach to the TEST_SERVER_P Domain Manager. Verify that the
SM_SerialNumber attribute has been added to the Router class in the data model of TEST_SERVER_P.


To verify the presence of the new attribute:


1 In the Topology Browser Console menu bar, select Manager > Attach.


2 In the Attach Manager dialog box, select TEST_SERVER_P in the Manager drop-down list. Type
the appropriate username and password, and click OK.


3 In the Topology Browser Console, select TEST_SERVER_P from the Manager drop-down list.


4 Right-click within the Topology Browser Console topology tree and select Select . Select Show
classes with no instances in current domain, and click OK.


5 In the Topology Browser Console, verify that the SM_SerialNumber attribute has been added to the
Router class.


.


Loading the dynamic model into the IP-Analysis Manager
In this procedure, TEST_SERVER_A is the name of the test IP-Analysis Manager. The
IP-Analysis Manager is started with the --dynamic command line option to pull the compiled dynamic
model file from BASEDIR/smarts/local/model.


Note   If the test IP-Analysis Manager is already running, stop it first.


To load the dynamic model:


Note   Two dash (--) characters precede the output and dynamic options of sm_server.


1 Load the compiled dynamic model file into the test IP-Analysis Manager.


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER_A -c icf-a 
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                --broker=localhost:426 --bootstrap=bootstrap.conf --output


               


                --dynamics


2 Open the log file. If the new SM_SerialNumber attribute has been processed successfully, the output
from the sm_server command appears similar to:


[September 11, 2009 4:27:08 PM EDT +263ms] t@1084463424 LDM file processing #1


DYN-W-FILE_OPEN_OK- Reading '/opt/InCharge8/IP/smarts/local/model/Example2.ldm'


[September 11, 2009 4:27:15 PM EDT +401ms] t@1084463424 LDM file processing #1


MRM-*-MRM_SET_PROP-Setting initial property of SM_SerialNumber to "NotAvailable"


[September 11, 2009 4:27:15 PM EDT +401ms] t@1084463424 LDM file processing #1


MRM-*-MRM_ACT_PROP-Actual initial value for SM_SerialNumber = "NotAvailable"


[September 11, 2009 4:27:15 PM EDT +405ms] t@1084463424 LDM file processing #1


DYN-W-CLASS_REFINE_CREATED- Interface Router refined from Example2.mdl:1


Verifying that the new attribute is present in the IP-Analysis Manager
In the Topology Browser Console, attach to the TEST_SERVER_A Domain Manager. Verify that the
SM_SerialNumber attribute has been added to the Router class in the data model of TEST_SERVER_A.


To verify the presence of the new attribute:


1 In the Topology Browser Console menu bar, select Manager > Attach.


2 In the Attach Manager dialog box, select TEST_SERVER_A in the Manager drop-down list. Type
the appropriate username and password. Click OK.


3 In the Topology Browser Console, select TEST_SERVER_A from the Manager drop-down list.


4 Right-click within the Topology Browser Console topology tree and select Select . Select Show
classes with no instances in current domain, and click OK.


5 In the Topology Browser Console, verify that the SM_SerialNumber attribute has been added to the
Router class.


Setting up topology sources
The Network-Resource Manager is added as a source of topology to both the IP-Perspective Manager
and the IP-Analysis Manager. In addition, the IP-Perspective Manager is also added as a topology source
to the IP-Analysis Manager.


Adding the Network-Resource Manager as a source to the
IP-Perspective Manager
To add the Network-Resource Manager as a source of topology:


1 In the Topology Browser Console, select Configure> Domain Manager Administrative Console.


2 In the Domain Manager Administrative Console, select TEST_SERVER_P in the Manager drop-down
list.
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3 In the Domain Manager Administrative Console, select Topology > Add Source.


4 In the Add Source dialog box, type TEST_SERVER_RM in the Element Name field. Keep
NETWORK-RESOURCE-TYPE as the Element Type. Click OK.


Adding the Network-Resource Manager as a source to the
IP-Analysis Manager
To add the Network-Resource Manager as a source of topology:


1 In the Domain Manager Administrative Console, select TEST_SERVER_A in the Manager drop-
down list.


2 In the Domain Manager Administrative Console, select Topology > Add Source.


3 In the Add Source dialog box, type TEST_SERVER_RM in the Element Name field. Select
NETWORK-RESOURCE-TYPE as the Element Type. Click OK.


Adding the IP-Perspective Manager as a source to the IP-Analysis Manager
To add the IP-Perspective Manager as a source of topology:


1 In the Domain Manager Administrative Console, select TEST_SERVER_A in the Manager drop-
down list.


2 In the Domain Manager Administrative Console, select Topology > Add Source.


3 In the Add Source dialog box, select IP-PERSPECTIVE-TYPE in the Element Type drop-down list.
Type TEST_SERVER_P in the Element Name field. Click OK.


Discovering an instance of the Router class
1 In the Domain Manager Administrative Console, select TEST_SERVER_RM in the Manager drop-


down list.


2 Initiate discovery.


3 Select Topology > Add Agent.


4 Type either the name or IP address of the router.


The VMware Smart Assurance IP Management Suite Discovery Guide describes various methods of
discovery.
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5 Verify that the router has been added to the topology as an instance of the Router class. The initial
value of the new SM_SerialNumber attribute will be “NotAvailable” as shown in Router discovered
with the SM_SerialNumber attribute in TEST_SERVER_RM.


Figure 3‑2.  Router discovered with the SM_SerialNumber attribute in TEST_SERVER_RM


6 Select TEST_SERVER_P in the Manager drop-down list and verify that the router has been added to
the topology.


7 Select TEST_SERVER_A in the Manager drop-down list and verify that the router has been added to
the topology.


Populating the value of SM_SerialNumber
To populate the values of the new Router attribute, use any of the methods described in Appendix C,
“Methods of Creating Classes and Populating Attributes.”


After populating the value, rediscover the Router instance. The rediscovery transfers the new value of the
SM_SerialNumber property from the Network-Resource Manager to the IP-Perspective Manager and
IP-Analysis Manager.


To rediscover the Router:


1 In the Domain Manager Administrative Console, select TEST_SERVER_RM in the Manager drop-
down list.


2 Right-click the Router instance, and then select Rediscover.


Forwarding the new attribute to the Global Manager


Note   In this section,BASEDIR refers to the base directory for the Service Assurance Manager.
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The BASEDIR/smarts/conf/ics/ics-default.xml file is the configuration file for the Global Manager. This file
designates which dxa files are used to transfer events and topology from the
Network-Resource Manager, IP-Perspective Manager, and IP-Analysis Manager into the Global Manager.
The ics-default.xml file will contain a separate section for each of the three Domain Managers. Each
section indicates the dxa file that is used for that particular Domain Manager.


In this example, the models of the Network-Resource Manager, IP-Perspective Manager, and
IP-Analysis Manager have all been enhanced with the new Router attribute. However, only one
Domain Manager should transfer that attribute to the Global Manager. In this example, only the
Network-Resource Manager will transfer the new attribute to the Global Manager.


Updating the Network-Resource Manager dxa file
The ics-default.xml defines which topology and events to transfer from a Domain Manager to the
Global Manager. In this example, the ics-default.xml file sets dxa-net-rm-conn-perf.conf as the dxa file
that defines which topology and events to transfer from a Network-Resource-Suite to the Global Manager.


TEST_SERVER_RM is of the type Network-Resource-Suite. The new Router class attribute must be
added to the dxa-net-rm-conn-perf.conf file.


<domaintype 


     name="Network-Resource-Suite" 


     dxaConfFile="dxa-net-rm-conn-perf.conf" 


     MinimumCertainty="0.01" 


     SmoothingInterval="65"> 


     <description>Type for Network Resource Connectivity and Performance Suite</description>


     <hook enable="False">ics/dxa-sample-hook.asl</hook>


     <domainname>Network-Resource</domainname>


 </domaintype>


To add the Router attribute to the dxa-net-rm-conn-perf.conf file:


1 Edit the dxa-net-rm-conn-perf.conf file by using sm_edit:


               # 


        


               BASEDIR


               /smarts/bin/sm_edit conf/ics/dxa-net-rm-conn-perf.conf


            


2 Type the following two lines for the Router class (shown in bold) before the entry for the
ICIM_UnitaryComputerSystem, as follows:


# Remote Name of Class/Property        Mapped Name of Class/Property


   class   Router


                  attr    SM_SerialNumber


   class   ICIM_UnitaryComputerSystem           Node


   attr    Certification


   attr    DisplayName


   attr    Description


   attr    Location
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   attr    Model


   attr    PrimaryOwnerContact


   attr    Type


   attr    Vendor


   rel     ConnectedVia


3 Save and close the dxa-net-rm-conn-perf.conf file.


The modified version of the file is saved to the BASEDIR/smarts/local/conf/ics directory.


Compiling and loading the dynamic model into the
Global Manager


Note   This exercise should be performed on a test version of a Global Manager. Before starting this
exercise, back up the repository on the test Global Manager.


The dynamic model enhancements must be loaded into the Global Manager. Otherwise, the
Global Manager has no awareness of the new SM_SerialNumber attribute of the Router class.


Typically, the model that is loaded into a Global Manager contains only those attributes that are needed to
identify the object in the topology. The values of these types of attributes, such as model number and
serial number, are not polled by the underlying Domain Manager.


In addition, the Global Manager model does not contain any events or problems. If your dynamic model
contains events or problems, remove the events after you copy the original .mdl file to the
Service Assurance Manager’s BASEDIR/smarts/local/modeldirectory. Then recompile the edited .mdl file
(by using dynmodel) to create the .ldm file.


In this example, only an attribute is added to the Router class. You do not have to remove the events or
problems before recompiling the file.


To compile and load the dynamic model into the Global Manager:


1 Copy Example2.mdlfrom the test IP Manager’s BASEDIR/smarts/local/modeldirectoryto the test
Service Assurance Manager’s BASEDIR/smarts/local/modeldirectory.


2 From the Service Assurance Manager’s BASEDIR/smarts/local/model directory, run the following
commands to compile the Example2.mdl model file:


               # 


        


               cd


               BASEDIR


               /smarts/local/model


               # 


        


               BASEDIR


               /smarts/bin/dynmodel Example2.mdl
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3 Load the compiled dynamic model file into the test Global Manager.


t# 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SA -c ics


               


               --broker=localhost:426 --output --dynamics


This example registers TEST_SA with the Broker that is running on the host named “localhost” and
port 426. Substitute the host and port of your Broker if they are different.


Transferring the value of the new attribute to the Global Manager
The new attribute for the Router class has been loaded into the model of the Global Manager. To transfer
the value of the new attribute, the Network-Resource Manager, IP-Perspective Manager, and the
IP-Analysis Manager must be added as sources to the Global Manager.


Adding the Network-Resource Manager as a source to the Global Manager
To add the Network-Resource manager as a source:


1 In the Topology Browser Console menu bar, select Manager > Attach


2 In the Attach Manager dialog box, select TEST_SA in the Manager drop-down list. Type the
appropriate username and password, and click OK.


3 In the Topology Browser Console, select Configure> Global Manager Administrative Console.


4 In the Global Manager Administrative Console, select TEST_SA in the Manager drop-down list.


5 In the Global Manager Administrative Console, select Edit > New Domain.


6 In the Domain Creation Wizard dialog box, type TEST_SERVER_RM in the Domain Name field.
Select Network-Resource in the Copy Existing drop-down list. Click Finish.


Adding the IP-Perspective Manager as a source to the Global Manager
To add the IP-Perspective manager as a source:


1 In the Global Manager Administrative Console, select Edit > New Domain.


2 In the Domain Creation Wizard dialog box, type TEST_SERVER_P in the Domain Name field.
Select IP-Perspective in the Copy Existing drop-down list. Click Finish.


Adding the IP-Analysis Manager as a source to the Global Manager
To add the IP-Analysis manager as a source:


1 In the Global Manager Administrative Console, select Edit > New Domain.


2 In the Domain Creation Wizard dialog box, type TEST_SERVER_A in the Domain Name field.
Select IP-Analysis in the Copy Existing drop-down list. Click Finish.
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Reconfiguring the Global Manager
To reconfigure the Global Manager:


1 In the Global Manager Administrative Console, select Configure > Reconfigure Server.


2 Click Yes to confirm the reconfiguration.


3 Click Close at the prompt.


Verifying the presence of SM_SerialNumber in the Global Manager
To verify the presence of SM_SerialNumber:


1 In the Global Console, attach to the TEST_SA Global Manager.


2 In the Topology Browser Console, verify that the SM_SerialNumber attribute has been added to the
Router class as shown in SM_SerialNumber in the TEST_SA Global Manager.


Note   If you did not populate the value of the attribute (refer to Populating the value of
SM_SerialNumber), then the value of SM_SerialNumber will still be “NotAvailable.”


Figure 3‑3.  SM_SerialNumber in the TEST_SA Global Manager
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Exercise 3 - Polling for Values of
Additional Attributes 4
This chapter includes the following topics:


n Objectives


n Exercise


Objectives
This exercise is a complex example of using Dynamic Model. This example enhances the following
Domain Managers:


n Network-Resource Manager


n IP-Perspective Manager


n IP-Analysis Manager


n Global Manager


The purpose of the exercise includes:


n Polling for a new attribute.


n Generating an event based on the value of the attribute.


n Forwarding the new event to a Global Manager so that it can be displayed as a notification.


Note   This exercise should be performed on test versions of a Broker, Network-Resource Manager,
IP-Perspective Manager, IP-Analysis Manager, and Global Manager. Before starting this exercise,
back up the repository on the test Managers.


This exercise includes the following tasks:


n Determine the instrumentation class that will be refined to poll for the new attribute.


n Create and compile a dynamic model file:


n Define an additional MIB variable that can be polled by the Network-Resource Manager.


n Define a setting class for the new attribute.


n Refine an instrumentation class that will define the MIB OID to poll.
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n Subscribe to the event in the Network-Resource Manager.


n Add a new threshold setting to adapter-setting.asl.


n Add the polled event to the Global Manager.


n Load the dynamic model into the Network-Resource Manager, IP-Perspective Manager, and the
IP-Analysis Manager.


n Set up topology sources.


n Discover an instance of the Router class.


n Verify variable in Polling and Threshold dialog box.


n Poll the values of the new attributes in real-time.


n Generate an event based on the values of this polled attribute.


n Have the Global Manager subscribe to and display notifications associated with the event based on
the value of this polled attribute.


Exercise
In this exercise, the Network-Resource Manager polls for a new attribute and generates an event. The
Global Manager subscribes to the event, and when the event is active the event notification is displayed
in the Notification Log Console.


The new TS_HighOverrunRate event is triggered if the rate of increase of the locIfInOverrun attribute of
the interface, expressed as a percentage of the inputPacketRate, is over a user defined threshold.


You do not need to copy and load the dynamic model enhancements (the file with extension .ldm) into the
Global Manager. This exercise polls for a value and creates an event based on the polled value.
However, the Global Manager model does not contain events. Instead, it contains only those attributes
that are required to identify the device in topology.


Note   Use a unique prefix with new class names and other properties. The name must differ from
existing ICIM classes and properties. The prefix “TS_” is used in this example. Do not use "SM_" as this
is already used by SDK.


Unless otherwise noted, BASEDIR refers to the base directory for the IP Manager.


Determining the instrumentation class
In this exercise, the Network-Resource Manager polls an additional attribute that measures the
performance of the Ethernet connection with a Router.


The Network-Resource Manager uses instances of designated instrumentation classes to hold the polled
attributes, in order to abstract the instrumentation details between device models. These instances are in
relationship with the object representing the device, which is where the event logic is defined. The event
logic may depend on comparison with thresholds, which are stored in setting objects.
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The instrumentation class that you need to refine can be determined from the oid2type_*.conf files. In this
example, the OID for a Router appears in the oid2type_Cisco.conf file.


The TS_locIfInOverrun variable is instrumenting the performance of an Ethernet connection. To determine
the instrumentation class, locate Interface-Ethernet-Performance under INSTRUMENTATION.


.1.3.6.1.4.1.9.1.469 {


    TYPE = Router


    VENDOR = Cisco


    MODEL = 2621XM


    CERTIFICATION = CERTIFIED


    CONT = Cisco-Router


    NEIGHBOR = Cisco-Cdp


    HEALTH = Cisco-Router


INSTRUMENTATION:


    Card-Fault                          = OldCiscoChassis


    Environment                         = CiscoEnvMon:DeviceID


    CPU/Memory                          = CiscoRouter:DeviceID


    Interface-Fault                     = MIB2


    Interface-Performance               = CiscoRouter


    Interface-Ethernet-Performance      = CiscoRouter_Ethernet 


}


The name of the instrumentation class to refine is obtained by concatenating “Interface_Performance_”
with the string associated with the Interface-Ethernet-Performance instrumentation type. The string
CiscoRouter_Ethernet is associated with the Interface-Ethernet-Performance instrumentation type.
Therefore, the name of the instrumentation class is Interface_Performance_CiscoRouter_Ethernet.


Creating and compiling the dynamic model
In this exercise, you create and compile a new dynamic model.


Creating the dynamic model
In this example, the same dynamic model is loaded into several Domain Managers, each starting with a
different --conf directory. Instead of copying the same compiled dynamic model file (.ldm) to each
BASEDIR/smarts/local/model/<conf> directory, one single copy is created and compiled in
BASEDIR/smarts/local/model. Each of the Domain Managers is then started with the --dynamic command
line option to pull the compiled dynamic model file from BASEDIR/smarts/local/model.


To create the dynamic model:


1 Create and edit a new file in the BASEDIR/smarts/local/model directory. Type the following at a
command prompt:


               # 


        


               BASEDIR


               /smarts/bin/sm_edit --create model/Example3.mdl


            


VMware Smart Assurance Dynamic Modeling Tutorial


VMware, Inc.  48







2 Refine the setting class that sets the default value for the alarm threshold. Type the following lines
into the Example3.mdl file:


               refine interface NetworkAdapter_Performance_Setting


               {


                       attribute float [0 .. 100] TS_OverrunThreshold


                       "Acceptable upper threshold for Overruned packets, "


                       "expressed as a percentage of the total number of input packets."


                       = 10;


               }


            


3 Refine the Interface_Performance_CiscoRouter_Ethernet instrumentation class that will be used to
poll for the attribute. Type the following lines into the Example3.mdl file:


               refine interface Interface_Performance_CiscoRouter_Ethernet


               {


               attribute float TS_OverrunThreshold


               "The upper threshold for Overrun packet errors expressed as a percentage"


               "of the total number of output packets."


               = 10;


               instrument SNMP {


               TS_locIfInOverrun = "1.3.6.1.4.1.9.2.2.1.1.14"


               };


               readonly instrumented attribute int TS_locIfInOverrun


               "The number of overrun errors.";


               readonly computed attribute float TS_locIfInOverrunRate


               = rate(TS_locIfInOverrun, PollingInterval);


               computed attribute float TS_OverrunErrorRate


               "The rate of ignored Overrun packets expressed in packets"


               "per second."


               = TS_locIfInOverrunRate;


               #pragma Uses Propagation


               readonly computed attribute float TS_OverrunErrorPct


               "The rate of Overruned input packets expressed as a percentage"


               "of total input packets."


               = (TS_OverrunErrorRate / (InputPacketRate + 0.001)) * 100;


               event TS_HighOverrunRate


               "Indicates that the percentage of packets with Overrun errors exceeds 


OverrunErrorThreshold"


               = if NetworkAdapterOperational && (TS_OverrunThreshold < 100) && (MaxSpeed > 0)


               check (TS_OverrunErrorPct > TS_OverrunThreshold);


               export TS_HighOverrunRate;


               }


TS_OverrunErrorPct > TS_OverrunThreshold


if NetworkAdapterOperational and (TS_OverrunThreshold < 100) and (MaxSpeed > 0)


4 Save the Example3.mdl file.


The file is saved in the BASEDIR/smarts/local/model directory.
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Compiling the dynamic model
To compile the Example3.mdl model file, type the following commands:


         # 


        


         cd


         BASEDIR


         /smarts/local/model


         # 


        


         BASEDIR


         /smarts/bin/dynmodel Example3.mdl


      


If it is successful, the dynmodel command does not produce any output to the command-line console.


In addition, the following files are created in the BASEDIR/smarts/local/model directory:


n Example3.ldm


n Example3_mmbe.dat


n Example3_mmle.dat


n Example3_mm.txt


The following directory is also created in the BASEDIR/smarts/local/model directory:


n Example3_mm


Compilation errors on page 111 provides additional information if you encounter errors.


Copying files for localization
From the BASEDIR/smarts/local/model directory, copy the following files to the SM_SITEMOD/l10n
directory:


n Example3_mmbe.dat


n Example3_mmle.dat
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Automatically subscribing to the event in a Domain Manager
One of the strengths of SDK technology is that expressions defined in an event are not evaluated and
polled unless there is a subscription to that event. In order for the Network-Resource Manager to
automatically begin polling and monitoring for the new event, add a subscription the
Network-Resource Manager bootstrap file.


1 Edit the bootstrap file by using sm_edit:


               # 


        


               BASEDIR


               /smarts/bin/sm_edit conf/icf-r/bootstrap.conf


            


2 Type the following line into the bootstrap file in the GA_SubscriberProfile::PROFILE-default
section:


               {"Interface_Performace_CiscoRouter_Ethernet",".*","TS_HighOverrunRate",77879 }


 { <class>, <instance>, <event>, <subscription-level> },


3 Save and close the bootstrap file.


The file will be saved in the BASEDIR/smarts/local/conf/icf-rdirectory.


Adding the new threshold setting to the adapter-setting.asl file
The new threshold setting attribute must be added to the BASEDIR/smarts/rules/health/adapter-
setting.asl file.


To add the threshold setting:


1 Edit the BASEDIR/smarts/rules/health/adapter-setting.asl file by using sm_edit:


               # 


        


               BASEDIR


               /smarts/bin/sm_edit rules/health/adapter-setting.asl


            


2 Look for the APPLY_SETTING() section in the adapter-setting.asl file. Type the following line, at the
following location, in the adapter-setting.asl file.


if (!setObj->isNull()) {


 REMOVE_PERF_INSTRUMENTATION(obj);


 continue;


}


threshold_map += TS_OverrunThreshold;


if (obj->CreationClassName == "Port") {


VMware Smart Assurance Dynamic Modeling Tutorial


VMware, Inc.  51







3 Save and close the adapter-setting.asl file.


The modified version of the file is saved to the BASEDIR/smarts/local/rules/health/ directory.


Adding the polled event to the Global Manager


Note   In this section,BASEDIR refers to the directory for the Service Assurance Manager .


The BASEDIR/smarts/conf/ics/ics-default.xml file is the configuration file for the Global Manager. This file
designates which dxa files are used to transfer events and topology into the Global Manager from the
Network-Resource Manager, IP-Perspective Manager, and IP-Analysis Manager. The ics-default.xml file
contains a separate section for each of the three Domain Managers. Each section indicates the dxa file
that is used for that particular Domain Manager.


In this example, the event is generated in the Network-Resource Manager. The event is not used in any
analysis in the IP-Analysis Manager. Therefore, the event subsciption needs to be added to only the dxa
file that defines which topology and events are transferred from the Network-Resource Manager to the
Global Manager.


The ics-default.xml file sets dxa-net-rm-conn-perf.conf as the dxa file that defines which topology and
events to transfer from a Network-Resource-Suite to the Global Manager. This is shown in the following
section of the ics-default.xml file.


<domaintype 


     name="Network-Resource-Suite" 


IP-Analysis Manager     dxaConfFile="dxa-net-rm-conn-perf.conf" 


     MinimumCertainty="0.01" 


     SmoothingInterval="65"> 


     <description>Type for Network Resource Connectivity and Performance Suite</description>


     <hook enable="False">ics/dxa-sample-hook.asl</hook>


     <domainname>Network-Resource</domainname>


 </domaintype>


TEST_SERVER_RM is of the type Network-Resource-Suite. Therefore, the subscription to the new event
must be added to the dxa-net-rm-conn-perf.conf file.


Event and notification subscriptions in the Global Manager are configured within dxa configuration files by
using the sub keyword. Patterns (regular expressions) separated by "::" match the class name, instance
name, and event name in the Domain Manager.


The syntax is as follows:


sub <classPattern>::<instancePattern>::<eventPattern>/<modifiers>


where:


n <classPattern> is the pattern to match for the class name.


n <instancePattern> is the pattern to match for the name of the instance.


n <eventPattern> is the pattern to match for the name of the problem or event.


VMware Smart Assurance Dynamic Modeling Tutorial


VMware, Inc.  52







n <modifiers> can have the following values:


n p = problem


n e = event


n a = aggregates


n n = notifications


To add the event:


1 Edit the dxa-net-rm-conn-perf.conf file by using sm_edit:


                           # 


        


                           BASEDIR


                           /smarts/bin/sm_edit conf/ics/dxa-net-rm-conn-perf.conf


                        


2 Type the following lines in the subscription section of the file.


                           # Added for Dynamic Model


                            sub  


Interface_Performance_CiscoRouter_Ethernet::.*::TS_HighOverrunRate/e


                        


3 (Optional) Set the severity and category of the notification that is created for this event. 
Setting the notification characteristics of the event provides more information.


4 Save and close the dxa-net-rm-conn-perf.conf file.


The modified version of the file is saved to the BASEDIR/smarts/local/conf/ics directory.


Loading the dynamic model into the Domain Manager s
Once the dynamic model has been compiled, you must load it into the Domain Managers.


Note   In this section,BASEDIR is the directory for the IP Manager, unless otherwise noted.


Loading the dynamic model into the Network-Resource Manager
In this procedure, TEST_SERVER_RM is the name of the test Network-Resource Manager. The
Network-Resource Manager is started with the --dynamic command line option to pull the compiled
dynamic model file from BASEDIR/smarts/local/model.


Note   Two dash (--) characters precede the dynamic option of the sm_server command.
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To load the dynamic model:


1 Type the following command:


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER_RM -c icf-r 


               


                --broker=localhost:426 --bootstrap=bootstrap.conf --output


               


                --dynamics


2 Open the log file. If the dynamic model has been processed successfully, the CREATED FILES
section of the output from the sm_server command appears similar to the following:


[July 10, 2009 12:25:29 PM EDT +789ms] t@1120213312 LDM file processing #1


DYN-W-FILE_OPEN_OK- Reading


    '/opt/InCharge8/IP/smarts/local/model/Example3.ldm'


[July 10, 2009 12:25:44 PM EDT +141ms] t@1120213312 LDM file processing #1


MRM-*-MRM_PROP_INIT-Property TS_OverrunThreshold initial value ='10'


[July 10, 2009 12:25:44 PM EDT +142ms] t@1120213312 LDM file processing #1


MRM-*-MRM_SET_PROP-Setting initial property of TS_OverrunThreshold to 10


[July 10, 2009 12:25:44 PM EDT +143ms] t@1120213312 LDM file processing #1


MRM-*-MRM_ACT_PROP-Actual initial value for TS_OverrunThreshold = 10


[July 10, 2009 12:25:44 PM EDT +144ms] t@1120213312 LDM file processing #1


DYN-W-CLASS_REFINE_CREATED- Interface NetworkAdapter_Performance_Setting


    refined from Example3.mdl:1


[July 10, 2009 12:25:44 PM EDT +145ms] t@1120213312 LDM file processing #1


MRM-*-MRM_PROP_INIT-Property TS_OverrunThreshold initial value ='10'


[July 10, 2009 12:25:44 PM EDT +146ms] t@1120213312 LDM file processing #1


MRM-*-MRM_SET_PROP-Setting initial property of TS_OverrunThreshold to 10


[July 10, 2009 12:25:44 PM EDT +146ms] t@1120213312 LDM file processing #1


MRM-*-MRM_ACT_PROP-Actual initial value for TS_OverrunThreshold = 10


[July 10, 2009 12:25:44 PM EDT +147ms] t@1120213312 LDM file processing #1


DYN-W-CLASS_REFINE_CREATED- Interface Interface_Performance_CiscoRouter


    refined from Example3.mdl:8


Loading the dynamic model into the IP-Perspective Manager
In this procedure, TEST_SERVER_P is the name of the test IP-Perspective Manager. The
IP-Perspective Manager is started with the --dynamic command line option to pull the compiled dynamic
model file from BASEDIR/smarts/local/model.


Note   Two dash (--) characters precede the dynamic option of the sm_server command.


To load the dynamic model, type the following command:


t # 


        


         BASEDIR


         /smarts/bin/sm_server -n TEST_SERVER_P -c icf-p 
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          --broker=localhost:426 --bootstrap=bootstrap.conf --output


         


          --dynamics


Loading the dynamic model into the IP-Analysis Manager
In this procedure, TEST_SERVER_A is the name of the test IP-Analysis Manager. The
IP-Analysis Managers is started with the --dynamic command line option to pull the compiled dynamic
model file from BASEDIR/smarts/local/model.


Note   Two dash (--) characters precede the dynamic option of the sm_server command.


To load the dynamic model, type the following command:


t # 


        


         BASEDIR


         /smarts/bin/sm_server -n TEST_SERVER_A -c icf-a 


         


          --broker=localhost:426 --bootstrap=bootstrap.conf --output


         


          --dynamics


Setting up topology sources
The Network-Resource Manager is added as a source of topology to both the IP-Perspective Manager
and the IP-Analysis Manager. In addition, the IP-Perspective Manager is also added as a topology source
to the IP-Analysis Manager.


Opening a Global Console and attaching to the Domain Manager s
To open a Global Console and attach to the Domain Managers:


1 Open a Global Console. For this example, attach to TEST_SERVER_RM.


2 In the Topology Browser Console menu bar, select Manager > Attach.


3 In the Attach Manager dialog box, select TEST_SERVER_P in the Manager drop-down list. Type
the appropriate username and password, and click OK.


4 In the Topology Browser Console menu bar, select Manager > Attach.


5 In the Attach Manager dialog box, select TEST_SERVER_A in the Manager drop-down list. Type
the appropriate username and password, and click OK.


Adding the Network-Resource Manager as a source to the
IP-Perspective Manager
To add the Network-Resource Manager as a source of topology:


1 In the Topology Browser Console, select Configure> Domain Manager Administrative Console.
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2 In the Domain Manager Administrative Console, select TEST_SERVER_P in the Manager drop-down
list.


3 In the Domain Manager Administrative Console, select Topology > Add Source.


4 In the Add Source dialog box, type TEST_SERVER_RM in the Element Name field. Keep
NETWORK-RESOURCE-TYPE as the Element Type. Click OK.


Adding the Network-Resource Manager as a source to the
IP-Analysis Manager
To add the Network-Resource Manager as a source of topology:


1 In the Domain Manager Administrative Console, select TEST_SERVER_A in the Manager drop-
down list.


2 In the Domain Manager Administrative Console, select Topology > Add Source.


3 In the Add Source dialog box, type TEST_SERVER_RM in the Element Name field. Select
NETWORK-RESOURCE-TYPE as the Element Type. Click OK.


Adding the IP-Perspective Manager as a source to the IP-Analysis Manager
To add the IP-Perspective Manager as a source of topology:


1 In the Domain Manager Administrative Console, select TEST_SERVER_A in the Manager drop-
down list.


2 In the Domain Manager Administrative Console, select Topology > Add Source.


3 In the Add Source dialog box, select IP-PERSPECTIVE-TYPE in the Element Type drop-down list.
Type TEST_SERVER_P in the Element Name field. Click OK.


Discovering an instance of the Router class
To discover an instance of the Router class:


1 Initiate discovery.


2 Select Topology > Add Agent.


3 Type either the name or IP address of the router.


The VMware Smart Assurance IP Management Suite Discovery Guide describes various methods of
discovery.


4 Verify that the router and interface have been added to the topology.


5 Click within the Topology Browser Console topology tree .


6 Type Ctrl-Alt-m.


7 Right-click within the Topology Browser Console topology tree and select Refresh tree .


8 Verify that the following attributes have been added to the
Interface_Performance_CiscoRouter_Ethernet instance:


VMware Smart Assurance Dynamic Modeling Tutorial


VMware, Inc.  56







9 TS_locIfInOverrun


10 TS_locIfInOverrunRate


11 TS_OverrunErrorRate


12 TS_OverrunErrorPct


Use the Attributes tab as shown in Attributes tab with the new attributes before polling.


Figure 4‑1.  Attributes tab with the new attributes before polling


Verifying the variable in the Polling and Settings Threshold dialog
box
In this example, the TS_OverrunThreshold attribute was added by


refining the NetworkAdapter_Performance_Setting class. The NetworkAdapter_Performance_Setting
class defines parameters that are used


for monitoring performance characteristics of a network adapter. These include basic parameters
common to all network adapters, such as utilization, errors, broadcast, and packet drops.


To verify the TS_OverrunThreshold attribute:


1 In the Domain Manager Administration Console, select Configure > Polling and Thresholds. The
Polling and Thresholds console opens.


2 In the left panel, select the Thresholds tab.


3 In the left panel, select Interface Groups.


4 Find the interface group to which your router interfaces are members.
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5 In the left panel, under the appropriate interface group, select Settings > Ethernet Interface/Port
Performance.


Note   If your router interfaces are members of Other Interfaces, then select Settings > Generic
Interface/Port Performance.


6 Verify that the value of the TS_OverrunThreshold attribute can be set as shown in 
TS_OverrunThreshold attribute in the Thresholds tab.


Figure 4‑2.  TS_OverrunThreshold attribute in the Thresholds tab
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7 In this example, subinterface performance analysis must be enabled. Scroll to the top of the
Parameters tab. Enable subinterface performance analysis if disabled as shown in Enabled
subinterface performance analysis.


Figure 4‑3.  Enabled subinterface performance analysis


Polling the new attributes
The expressions defined in an event are not evaluated and polled unless there is a subscription to that
event. The previous edit of the dxa-net-rm-conn-perf.conf file added a subscription to the
TS_HighOverrunRate event from the Global Manager. The Global Manager must be started for the
subscription to take effect and for polling of the new variables to commence.


Note   In this section, BASEDIR refers to the directory for the Service Assurance Manager.


To start polling the new attributes:


1 Type the following command to start the Global Manager:


t


                  # 


        


               


               BASEDIR


               /smarts/bin/sm_server -n TEST_SA -c ics --broker=localhost:426 --outputs


2 In the Global Console, attach to the TEST_SA Global Manager.


Once polling has started, the values of TS_locIfOverrun, TS_locIfInOverrunRate,
TS_OverrunErrorRate, and TS_OverrunErrorPct update and will appear similar to Attributes tab with
the new attributes after polling.
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Figure 4‑4.  Attributes tab with the new attributes after polling


TS_HighOverrunRate event in the Global Manager
When the TS_HighOverrunRate event is triggered by the TS_OverrunErrorPct value, the
TS_HighOverrunRate event is transferred to the Global Manager and displayed in the Global Console, as
shown in TS_HighOverrunRate event in the Global Manager.


Figure 4‑5.  TS_HighOverrunRate event in the Global Manager
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Guidelines and Syntax for
Dynamic Model Files 5
This chapter includes the following topics:


n Guidelines and requirements


n Adding a class to the model


n Updating an existing class in the model


Guidelines and requirements
A dynamic model file describes the model elements that extend the basic VMware Smart Assurance data
model. The following guidelines apply to dynamic model files:


n Typically, those classes that are related to each other are contained in the same dynamic model file.


n Dynamic model filenames may contain ASCII letters (A..Z,a..z), ASCII numbers (0...9), and the
underscore character (_), but may contain no other characters. The first character must be a letter.


n The dynamic model filename must be unique within the first 23 characters.


n The dynamic model file must have a .mdl filename extension.


n Create and edit the dynamic model files (those with extension .mdl) by using sm_edit.


n Dynamic model files must follow the syntax rules described in Adding a class to the model and 
Updating an existing class in the model.


n All refinements to a class must be contained in a single


n refine interface <classname> declaration. For example, you cannot have a


n refine interface Router declaration in the mymodel1.mdl file, and then another refine interface
Router in the mymodel2.mdl. Likewise, you cannot have more than one refine interface Router
declaration in the mymodel1.mdl file.


n Precede any new attributes, classes, aggregates or events that are defined with a unique tag, such
as “USR_”. You should not use "SM_" as this is already used by SDK.


n Avoid using the binary or byte data type, or the external keyword in any dynamic model files of the
IP Manager that you will be copying over to the Service Assurance Manager.
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n Dynamic model files must be located in either
BASEDIR/smarts/modelorBASEDIR/smarts/model/<config>. The <config> refers to the configuration
directory that is specified on the command line when the Domain Manager is started.


n The dynamic model files (those with extension .ldm) must be loaded into each Manager that requires
knowledge of the new topology and events. The loading of the dynamic model files incorporates them
into the runtime data model.


n When the option --dynamic is not added to the sm_server command, the Manager will load all
dynamic model files that can be loaded into a Manager (those with extension .ldm) located in:


BASEDIR/smarts/model/<config>


The <config> refers to the configuration directory that is specified on the sm_server command line
when the Domain Manager is started.


Chapter 6 The dynmodel Command Syntax and Options provides information on creating dynamic
model files that can be loaded into a Manager.


n When the --dynamic option is specified on the sm_server command line, the Manager will load all
dynamic model files that can be loaded into a Manager (those with extension .ldm) located in:


n BASEDIR/smarts/model


n BASEDIR/smarts/model/<config>.


The <config> refers to the configuration directory that is specified on the sm_server command
line when the Domain Manager is started.


Note   Two dash (--) characters precede the dynamic option of sm_server.


If a Manager is started by using sm_service, edit the sm_service command to include the --
dynamic option.


Adding a class to the model
First, the class to be added needs to be declared, as described in Adding the new class. Next, it is
compiled into a form that can be loaded into a Manager. Once the model that contains the new class is
loaded into the Manager, any operations and facilities available for common VMware Smart Assurance
classes in the Manager are now available for the new class. However, additional steps are needed to
actually discover and instantiate instances of the class.


Determining the parent of the new class
A new class is declared as a subclass of an existing ICIM class. The key is to determine which class
should be the parent class. This determination is based on several factors:


n How you want to search and report on the new class


n Functional similarities to existing elements in topology
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n The events, attributes, and relationships the new class needs to inherit


For example, suppose a class that represents a printer needs to be added to the model. A printer is a
physical element, similar to a router, switch, or host. Therefore, the printer class can be defined as a
subclass of UnitaryComputerSystem, which is the parent class of routers, switches, and hosts. The
printer class inherits all of the attributes, relationships, and events of the UnitaryComputerClass class.


Note   The IP Manager counts the instances of the ICIM_UnitaryComputerSystem. If this is a problem
for you, you can inherit from either ICIM_System or ICIM_ComputerSystem. However, if you inherit
from either ICIM_System or ICIM_ComputerSystem you will have to add your new class into the
appropriate dxa to transfer the topology to the Global Manager. Chapter 3 Exercise 2 - Adding an
Attribute to the Router Class provides information about adding a class and its associated attributes
to dxa files.


Adding the new class
To add a new class to a model, use the interface keyword. The interface keyword indicates that any
declarations that follow define a new class.


The syntax is as follows:


interface <class_name>:<parent_class>


{


<declarations>


}


In this example the printer class inherits from the UnitaryComputerSystem class, and is named
SM_Printer.


interface SM_Printer:UnitaryComputerSystem


"Create a printer class inheriting from UCS"


{


 stored attribute string SM_PrtrLocation


 "Location of Printer"="";


}


The new class may include a description.


The VMware Smart Assurance MODEL Reference Guide describes the <declarations> syntax. In
dynamic modeling, declarations include attributes, relationships, operations, problems, symptoms,
aggregates, and events.


Updating an existing class in the model
You may also make changes to the ICIM classes that already exist in the model installed on a
Domain Manager. An existing class can be extended by adding any of the following:


n Attribute
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n Relationship


n Event


n Aggregate


n Problem


n Symptom


n Operation


However, when a Manager, such as a Network-Resource Manager, is started, its model is loaded
from a library file. Dynamic modeling allows you to extend one of the classes in the library file by
adding new properties, such as attributes and events. However, you cannot delete any class
properties in the delivered library file.


In this example, several properties are declared in a class in the library file:


interface Host : ICIM_System


 "Host is a computer system that represents a workstation or server."


{


    export Down,


    Unresponsive;


    


    relationship SystemPackagedIn, Chassis, PackagesSystems


    problem Down =>


   Unresponsive, 


   Unresponsive explains;


    event Unresponsive = IsUnresponsive;


    stored attribute boolean IsUnresponsive = FALSE;


    stored attribute boolean IsAgentUnresponsive = FALSE;


}


Dynamic modeling allows a new property to be added or one of the existing properties to be modified.
However, the existing Unresponsive event, Down problem, SystemPackagedIn relationship, and the
IsUnresponsive and IsAgentUnresponsive attributes cannot be deleted.


refine interface keyword
To modify an existing class, use the refine interface keyword. The refine interface keyword indicates
that any declarations that follow will modify an existing ICIM class.


All refinements to a class must be contained in a single refine interface <classname> declaration. For
example, you cannot have a refine interface Router declaration in the mymodel1.mdl file, and then
another refine interface Router in the mymodel2.mdl. Likewise, you cannot have more than one refine
interface Router declaration in the mymodel1.mdl file.
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In this example, the stored attribute SM_RtrChassisType is added to the Chassis class. The Chassis
class is one of the ICIM classes.


refine interface Chassis


{


 stored attribute string SM_RtrChassisType;


}


Refining inherited class properties
You can refine inherited attributes, events, problems, symptoms, operations or relationships when you
create a new subclass. These class properties may be inherited from the parent class or any of the other
classes up the inheritance tree to the base class. The syntax for refining an inherited attribute, event,
problem, symptom, operation or relationship is:


interface <child_class> : <parent_class>


{


 refine <property declarations>


}


The refine syntax for each type of declaration such as an attribute, is the same as that described in the
VMware Smart Assurance MODEL Reference Guide.


Adding an attribute
The syntax for adding a new attribute to an existing ICIM class is:


refine interface <ICIM_class_name>


{


<attribute declarations>


}


The following example adds the stored attribute SM_SerialNumber to the existing Router class.


refine interface Router


{


 stored attribute string SM_SerialNumber


 “Custom serial number stored in the Cisco”


 “chassis-id MIB (.1.3.6.1.4.1.9.3.6.3)”


 = “NotAvailable”;


}


For more information about attribute declarations and valid data types, see the
VMware Smart Assurance MODEL Reference Guide.
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Adding a relationship
A new relationship (one-to-one or one-to-many) can be added to an existing ICIM class. The syntax for
adding a new relationship to an existing ICIM class is:


refine interface <ICIM_class_name>


{


<relationship declarations>


}


The following example adds a relationship, OSInstalled, to the existing ICIM class,
UnitaryComputerSystem.


refine interface UnitaryComputerSystem


{


 relationshipset OSInstalled, SM_OperatingSystem, OSRunningOn;


}


For more information about relationship declarations, see the
VMware Smart Assurance MODEL Reference Guide.


Adding an event
A new event can be added to an existing ICIM class. The syntax for adding a new event to an existing
ICIM class is:


refine interface <ICIM_class_name>


{


<event declarations>


}


The following example adds the IPForwardingOn event to the existing ICIM class, Host.


refine interface Host


 {


  propagate attribute int min SM_ipForwarding


  "Value of ipFrowarding from SM_ipForwardingInstrument"


  <=SM_ipForwardingInstrument, InstrumentedBy, SM_ipForwarding;


  event IPForwardingOn "A Host has IPForwarding turned 


   on" = SM_ipForwarding==1;


  export IPForwardingOn;


 }


For more information about event declarations, see the
VMware Smart Assurance MODEL Reference Guide.
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Adding an aggregate
A new aggregate can be added to an existing class. The syntax for adding a new aggregate to an existing
class is


refine interface <class_name>


{


<aggregate declarations>


}


The following example adds the DegradedWirelessConnectivity aggregate to the existing class,
SM_WirelessAccessPoint.


refine interface SM_WirelessAccessPoint


{


 stored attribute int MaxNumberIntended =20;


 propagate attribute int max SM_SignalDegradation


 <=SM_APInstrumentation, InstrumentedBy,


 SM_SignalDegradation;


 propagate attribute int max SM_NumberOfMACS


 <=SM_APInstrumentation, InstrumentedBy,


 SM_NumberofMACS;


 event PoorConnectivity “AP MIB returns loss in


 SignalPower (dB)” SM_SignalDegradation >10;


 event MaxUsersReached “Number of users on a signal


 AP device has been exceeded”


 SM_NumberOfMACS>MaxNumberIntended;


 aggregate DegradedWirelessConnectivity “Wireless


 connectivity for the AP is degraded” <= PoorConnectivity,


 MaxUsersReached;


 export DegradedWirelessConnectivity;


}


For more information about aggregate declarations, see the
VMware Smart Assurance MODEL Reference Guide.


Adding a problem
A new problem can be added to an existing ICIM class. The syntax for adding a new problem to an
existing ICIM class is:


refine interface <ICIM_class_name>


{


<problem declarations>


}
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The following example adds the IPForwarded problem to the existing ICIM class, Host.


refine interface Host


 {


  propagate attribute int min SM_ipForwarding


  "Value of ipFrowarding from SM_ipForwardingInstrument"


  <=SM_ipForwardingInstrument, InstrumentedBy, SM_ipForwarding;


  event IPForwardingOn "A Host has IPForwarding turned 


   on" = SM_ipForwarding==1;


  problem IPForwarded =>


   IPForwardingOn,


   IPForwardingOn explains;


  export IPForwardingOn;


  export IPForwarded;


 }


For more information about problem declarations, see the
VMware Smart Assurance MODEL Reference Guide.


Adding a symptom
A new symptom can be added to an existing ICIM class. The syntax for adding a new symptom to an
existing ICIM class is:


refine interface <ICIM_class_name>


{


<symptom declarations>


}


For more information about symptom declarations, see the
VMware Smart Assurance MODEL Reference Guide.


Adding an operation
A new operation can be added to an existing ICIM class. The syntax for adding a new operation to an
existing ICIM class is:


refine interface <ICIM_class_name>


{


<operation declaration>


}


For more information about operation declarations, see the
VMware Smart Assurance MODEL Reference Guide.
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The dynmodel Command
Syntax and Options 6
This chapter includes the following topics:


n Syntax and options


n Pragmas


Syntax and options
After you create dynamic model files, the class and property declarations must be compiled into a form
that can be loaded by a Manager. The dynamic model compiler, dynmodel, is used to compile the
modified model files.


The dynmodel compiler is located in the BASEDIR/smarts/bin/ directory.


The dynmodel command is used to invoke the dynamic model compiler on one or more files that contain
model class definitions. The compiler checks the MODEL syntax but does not verify compatibility with
other models, including name resolution. The dynamic model compiler generates a corresponding model
file, for each input file, that can be loaded into a Manager. The generated files can be loaded by a
Manager as part of the data model.


The syntax of the dynmodel command is:


dynmodel [<options>] <mdl-files>


where:


n <options> may be in any order, but must precede the .mdl files. Options are defined in Command line
options for the dynmodel command.


n <mdl-files> specify one or more files, separated by a space.


Table 6‑1.  Command line options for the dynmodel command


option Description


-w Suppress generation of warning messages produced by the compiler.


-Wb,ProblemMode Compile dynamic model files that have added or refined problems and symptoms.


--help Prints the compiler’s command line options and then exits.


--version Prints the compiler’s version information and then exits.
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Table 6‑1.  Command line options for the dynmodel command (Continued)


option Description


--l10nsrc The base directory that holds locale source files.The default is l10nsrc.


When dynmodel generates Resource Packages it incorporates files for each model based
on <dir>/<pkg_id>


where:


<pkg_id> is the model filename less its extension, plus "_mm", and then truncated at 23
characters.


This option must be used in conjuction with the --locales option.


Note   This option is not available in the Service Assurance Manager.


--locales A comma-delimited list of locales which correspond to localized text files to be
incorporated into the Resource Package for model files.


This option must be used in conjuction with the --locales option.


Note   This option is not available in the Service Assurance Manager.


In this example, the command line suppresses the generation of warning messages produced when
compiling the mymodel.mdl file.


dynmodel -w mymodel.mdl


The dynmodel command creates the following files in the BASEDIR/smarts/model directory, where
<modelname> is the name of a dynamic model. Files and directories generated by the dynmodel compiler
describes the set of files that is created for each of the dynamic model files included on the command
line.


Table 6‑2.  Files and directories generated by the dynmodel compiler


Generated file or directory Description


<modelname>.ldm The version of the dynamic model that is loaded into a Domain Manager.


<modelname>_mmbe.dat The Big Endian message file for the MODEL interface, attribute, and event
descriptions


<modelname>_mmle.dat The Little Endian message file for the MODEL interface, attribute, and event
descriptions


<modelname>_mm.txt The Resource Package source that contains MODEL text.


<modelname>_mm A directory created for holding temporary files needed during the dynamic model
compilation process.


Note   Do not remove this directory.


For example, the following commands compile the Asset.mdl and AssetUCS.mdl dynamic model files:


         # 


        


         cd 


         BASEDIR


         /smarts/local/model
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            # 


        


         


         BASEDIR


         /smarts/bin/dynmodel Asset.mdl AssetUCS.mdl


      


When the Asset.mdl and AssetUCS.mdl dynamic model files are compiled, the following set of files and
directories are produced:


n Asset.ldm


n Asset_mmbe.dat


n Asset_mmle.dat


n Asset_mm.txt


n Asset_mm


n AssetUCS.ldm


n AssetUCS_mmbe.dat


n AssetUCS_mmle.dat


n AssetUCS_mm.txt


n AssetUCS_mm


Asset.ldm is the version of the dynamic model file that can be loaded by a Manager. Likewise, 


AssetUCS.ldm is the version of the dynamic model file AssetUCS.mdlthat can be loaded by a Manager.


Using the --l10nsrc and --locales options
The --l10nsrc and --locales options cannot be used independently. You must either include both options
on the command line or exclude both options from the command line.


The two options are applied uniformly to all model files on the command line. If you want to compile two
(or more) models that have a different list of locales or with different l10nsrc base directories, then you
need to use two (or more) different dynmodel calls.


When dynmodel generates Resource Packages, it will incorporate files for each model based
on<dir>/<pkg_id> (where <pkgId> is the model file name less its extension, plus "_mm", then truncated at
23 characters.


In this example, dynmodel compiles two models, model1 and model2. The dynmodel compiler
incorporates ./mysource/model1_mm/ja.txt and ./mysource/model1_mm/de.txt into model1’s .dat file. The
dynmodel compiler also incorporates ./mysource/model2_mm/ja.txt and ./mysource/model2_mm/de.txt
into model2's .dat file.


dynmodel model1 model2 --l10nsrc=mysource --locales=ja,de
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If you do not include the --l10nsrc and --locales options then dynmodel will not look for any
localization .txt files, and the .dat file for the model will only support the native language of the .mdl file.


Pragmas
Pragmas can be used in dynamic model files to convey SNMP MIB qualities, and other directives, to the
dynamic model compiler. Pragmas used in dynamic modeling lists the available pragmas.


Table 6‑3.  Pragmas used in dynamic modeling


Pragma Description


#pragma DotNotation Specifies that an SNMP instrumented attribute is to be converted from dotted
notation when retrieved from an SNMP agent.


#pragma HexNotation Specifies that an SNMP instrumented attribute is to be converted from hex notation
when retrieved from an SNMP agent.


#pragma Local Operation Locks only the object on which the operation is invoked. Normally, the dynamic
model compiler generates code so that invoking an operation implicitly locks the
entire repository.


#pragma ObjectID Appears before an instrumented attribute declaration of type string whose value is
the OID of an SNMP device. This pragma tells the repository to convert the OID
type returned by the SNMP agent into a MODEL string.


#pragma Uses Propagation Must appear before the attribute declaration to which it applies. This pragma tells
the dynamic model compiler that access to this attribute may require access to
other repository instances. Use this pragma before any attribute that can be
refined as propagated or as computed with an expression that refers to other
propagated attributes. This pragma locks the entire repository, however, the lock
type (read/write) will be according to the type of operation called on the attribute.
For example, if you are setting the value of an attribute, it will be a write lock.


#pragma WrapCounter Specifies that an SNMP instrumented attribute is to be treated as a wrapping
counter, which affects comparisons of previous and current values.
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Methods of Creating Classes
and Populating Attributes 7
This chapter includes the following topics:
n Overview


n Using dmctl


n Populating attributes by using an SDK API


n Discovery customization


Overview
For new classes added by dynamic modeling, instances of the class must be discovered and added to
the repository. In addition, new attributes need to be populated with values.


There are several methods that may be used to create instances of new classes or to populate values of
new attributes:


n The dmctl command


n Text file accessed by one of the SDK APIs (PERL, C, Java)


n ASL scripts


n Working with scripts that are invoked as part of the postprocessing phase ofthe discovery mechanism


Using dmctl
The dmctl command is a command line tool for interacting with a Manager. It may be used to create
instances of new classes or manually populate attributes in a Manager. It can either execute commands
typed at the command line, execute commands read from a batch file, or interactively read commands
that the you type.


If the Global Manager is already running, and you use dmctl to modify class properties that it subscribes
to, you need to re-synchronize the topology. Synchronizing topology changes with the Global Manager
provides additional information.
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Command-line mode
To run dmctl in command-line mode, connect to the Manager and type the command by using the
following syntax:


         # 


        


         BASEDIR


         /smarts/bin/dmctl -s


         <manager_name> [--broker=


         <host>


         :


         <port>] <command_name>


         <command_params>


      


where:


n <manager_name> is the name of the Manager.


n <host> is the host on which the Broker resides.


n <port> is the port on the host from which the Broker can be accessed.


n <command_name> is the name of the command.


n <command_params> is the list of the parameters for the command.


Note   The --broker option is optional. The default value is localhost:426.


The following command, starts dmctl interacting with the TEST_SERVER Manager and creates an
instance of the SM_Printer class, named HP_Printer1:


               


                  # 


        


               


               BASEDIR


               /smarts/bin/dmctl -s TEST_SERVER create SM_Printer::HP_Printer1


            


You can also use dmctl to verify that a class has been added. For example:


# 


                  BASEDIR/smarts


               


               /bin/dmctl -n TEST_SERVER_RM getInstances <classname>


where:
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n <classname> is the name of the class you want to verify.


If the class is not loaded, dmctl will display output similar to:


MR-E-CLASS_NOT_FOUND_EX-Cannot find class '<classname>'


If the class has been added, dmctl will output a (possibly empty) list of instances.


Interactively
To run dmctl interactively, connect to the Manager as follows:


         # 


        


         BASEDIR


         /smarts/bin/dmctl -s


         <server_name> [--broker=


         <host>


         :


         <port>]


where:


n <server_name> is the name of the Manager.


n <host> is the host on which the Broker resides.


n <port> is the port on the host from which the Broker can be accessed.


Note   The --broker option is optional. The default value is localhost:426.


The following command, starts dmctl interacting with the TEST_SERVER Manager registered with
the broker running on the local host and port 426. At the prompts, type the username and password.


               # 


        


               BASEDIR


               /smarts/bin/dmctl -s TEST_SERVER --broker=localhost:426


            


The output appears similar to the following:


>dmctl -s TEST_SERVER --broker=localhost:426


Server TEST_SERVER User: admin


admin’s Password: XXXXXXX


Domain Manager Control Program (v9.0.0.1) -- Type ‘help’ for a


list of commands.


Attached to ‘TEST_SERVER’


dmctl>
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Once attached to the Manager, use the create command to create an instance of a class:


create <class_name>::<instance_name>


where:


n <class_name> is the name of the class.


n <instance_name> is the name of the instance of the class.


For example, type the following command to create an instance of the SM_Printer class, named
HP_Printer1:


dmctl>create SM_Printer::HP_Printer1


            


The getClasses command lists all of the classes in the repository.


You can also populate the value of an attribute by using the put command:


               put <class_name>::<instance_name>::<property_name> <value> 


where:


n <class_name> is the name of the class.


n <instance_name> is the name of the instance of the class.


n <property_name> is the name of the property in the class instance.


n <value> is the value of the property.


For example, type the following command to populate the value of the SM_SerialNumber attribute
associated with router-1.mynet.com (an instance of the Router class):


dmctl>put Router::router-1.mynet.com::SM_SerialNumber 123456abc


            


Batch mode
The dmctl command may also be run in batch mode by passing it a filename. The batch file is created by
using a text editor and consists of a series of dmctl commands, with one command per line.


The following batch file creates two instances of the Printer class, and sets the value of the
SM_SerialNumber attribute for an instance of the Router class:


create SM_Printer::HP_Printer1


create SM_Printer::HP_Printer2


put Router::lab-gw::SM_SerialNumber 123456abc
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Before running dmctl in batch mode, change the directory to the location of the batch file. The following
example runs dmctl in batch mode:


t# 


        


         BASEDIR


         /smarts/bin/dmctl --server=TEST_SERVER_RM


         


         --broker=localhost:426 --file=test_dmctl_batch.txts


Resulting topology from dmctl batch file “test_dmctl_batch.txt” shows the two new printers and the new
value of the Router serial number in topology.


1 New Instances of SM_Printer Class


New Value of SM_SerialNumber


Figure 7‑1.  Resulting topology from dmctl batch file “test_dmctl_batch.txt”


Synchronizing topology changes with the Global Manager
If the Global Manager is already running, and you modify class properties that it subscribes to, you need
to resynchronize the topology in order for Global Manager to reflect the changes. From the command line,
type the following:


t# 


        


         BASEDIR


         /smarts/bin/dmctl -s <GLOBAL_MANAGER> invoke GA_Driver::<


            Domain Manager


         >_Topo-Driver starts


where:


n <GLOBAL_MANAGER> is the name of the Global Manager.
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n <Domain Manager> is the name of the underlying Domain Manager that is being synchronized.


For example:


t# 


        


               BASEDIR


               /smarts/bin/dmctl -s TEST_SA invoke GA_Driver::TEST_SERVER_Topo-Driver starts


Populating attributes by using an SDK API
This section describes how to populate attributes with the SDK API.


PERL API
The following is an example of a PERL script that can be used to populate the value of the
SM_SerialNumber attribute in the Router class. The VMware Smart Assurance Perl Reference Guide
provides additional information.


use InCharge::session;


#Establish a connection to the VMware Smart Assurance Server


$session=InCharge::session->new( server=>"TEST_SERVER_EX2",


            broker =>"localhost:426",


            user=>"admin",


            password=>"ad1");


# Create a handle to the object router-1.mynet.com


$deviceHandle=$session->object("Router","router-1.mynet.com");


# Retrieve value of current Serial Number


$currentSerial=$deviceHandle->{SM_SerialNumber};


print "Current Serial Number: $currentSerial \n";


#Assign a value to the attribute SM_SerialNumber of device router-1.mynet.com


$deviceHandle->{SM_SerialNumber}="123456abc";


# Print the new value


print "New Serial is: $deviceHandle->{SM_SerialNumber}";


ASL
The following is an example of an ASL script that can be used to populate the value of the
SM_SerialNumber attribute in the Router class. The VMware Smart Assurance ASL Reference Guide
provides additional information.


START{


 ..eol


 }


 do


 {


  /* Retrieve existing value */


  objHandle=object("Router","router-1.mynet.com");


  print("Current serial: ".objHandle->SM_SerialNumber);
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  /* Assign a new value */


  objHandle->SM_SerialNumber="123456abc";


  print("New serial: ".objHandle->SM_SerialNumber);


  


  stop();


 }


Discovery customization
This example populates the value of SM_SerialNumber (an attribute in the Router class) by querying a
MIB. The postprocessing scripts can be used to query a MIB during discovery.


First, a driver is created that sets up the process of querying the MIB for the value of SM_SerialNumber. A
driver is an instance of the GA_Driver class, and in this example it is defined in an import file. The import
file is loaded into the test Network-Resource Manager when it is started with the sm_server command.


During a discovery, the custom-end-system.asl script is automatically run for each device after Phase III
(discovery probing). Additional rules are added to this file. Within these rules, if the object is a router, it
launches the driver that was created when the import file was read into memory. The driver executes and
retrieves the values in the appropriate OID. The results are then forwarded to an ASL script that parses
the input and populates the value of the SM_SerialNumber attribute.


This process is summarized in Figure 15 on page 98.


1 1


2 2


3 3


4 4


5 5


DISCOVERY_serialNumber.import


custom-end-system.asl


The import file is loaded into the Manager memory at runtime. An instance of GA_Driver is created
that defines the input source, how the input is parsed, and which repository the attribute value is
stored in.


This discovery postprocessing script is executed during the discovery process.


This discovery postprocessing script invokes the GA_Driver that was loaded into memory when the
Manager was started.


The GA_Driver performs an SNMPWalk to retrieve the value from the MIB


The input that is retrieved is parsed by this ASL script (defined by the GA_Driver) and assigned to the
appropriate instance and attribute.


dynmodel-sn.asl
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Figure 7‑2.  Using the discovery postprocessing mechanism


Creating the driver
First, you create a driver that sets up the process of querying the MIB for the value of SM_SerialNumber.


A driver is an instance of the GA_Driver class, and is composed of three parts:


n Front End — The source of the input (defined by the ReadsInputFrom attribute of the GA_Driver
class).


n Rule Set — The ASL script that parses through the input string to determine the values of the
attributes (defined by the ReadsRulesFrom attribute of the GA_Driver class).


n Back End — The repository where the attribute values that are parsed from the input string are
stored.


In this example, the back end is the Manager that is started with the sm_server command and loads
the import file. The value for the root OID in this example is for a Cisco router, Cisco chassis-id MIB
(3).


To create an import file:


a Start editing the import file.


t # 


        


                     BASEDIR


                     /smarts/bin/sm_edit --create


                     


                      conf/discovery/DISCOVERY_serialNumber.imports


b Type the following lines into the DISCOVERY_serialNumber.importfile:


                      GA_Driver::DynModel-SerialNumber-Driver {


                       ReadsInputFrom = SNMP_WalkFE::DynModel-SN-FrontEnd


                       {


                        retries =5


                        rootOIDs = {


                          { 10, ".1.3.6.1.4.1.9.3.6.3" }


                        }


                        trace=FALSE


                       }


                     


                       ReadsRulesFrom = GA_RuleSet::DynModel-SN-RuleSet


                       { fileName = "discovery/dynmodel-sn.asl" 


                        trace=FALSE}


                     


                     


                      waitForCompletion =TRUE


                     }
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c Save and close the DISCOVERY_serialNumber.import file.


The DISCOVERY_serialNumber.import file is saved into the
BASEDIR/smarts/local/conf/discovery directory.


In this import file, an instance of the GA_Driver class is created, named DynModel-SerialNumber-
Driver. Since an OID is queried for its value, a SNMP_WalkFE front end is used. The
SNMP_WalkFE instance, DynModel-SN-FrontEnd:


n Retrieves all of the MIB objects under a set of root OIDs.


n Converts the values to ASCII and markers.


n Passes them to the ASL file that is defined to parse the input..


In this import file, the ASL file is defined by the ReadRulesFrom attribute as discovery/dynmodel-
sn.asl.


Editing custom-end-system.asl
During a discovery, the custom-end-system.asl script is automatically run for each device after Phase III
(discovery probing). At the end of the custom-end-system.asl script is a section where you can add your
own processing for each device, as shown in Modifying custom-end-system.asl.


START {


/*


* Add Parsing rules here.


*/


.. eol


} do {


/*


* Add processing rules here.


*/


stop();


}


New processing rules are added here.


Figure 7‑3.  Modifying custom-end-system.asl


To add custom processing:


1 Start editing the custom-end-system.asl file, by using sm_edit:


               # 


        


               cd


               BASEDIR
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               /smarts/bin


               # 


        


               sm_edit rules/discovery/custom/custom-end-system.asl


            


2 Type the following lines after Add processing rules here in the START rule.


               /* Check first if the object is a router since you have only added


               * serial number of the router class */


               if (nodeObj->CreationClassName =="Router")


               {


                /* Setup a handle to the internal GA_Driver's


                GA_Parameters instance for custom-end-system.asl */


                  cesObj=this->findMyParameters();


               


                /* This statement creates the object handle to the


                * driver defined in our import file


                * DISCOVERY_serialNumber.import. */


                DynModelSerialNumberDriverObj = object("DynModel-SerialNumber-Driver");


                /* Now you kick off the GA _Driver that you have defined


                * in the import file whose purpose is to poll the device


                * for some MIB values and return it.   You start the driver


                * by calling the operation startWithParamters and pass as an


                * argument the parameters that are available through cesOBJ.


                  *


                  * Note, since the driver in the import file uses


                * SNMPWalkFE as the frontend, the results from this


                * front end are in the form of OID|Value


                * for example, a sample output is: 


                * .1.3.6.1.2.1.25.1.1.0|6297154|;  


                * therefore the ASL script dynmodel-sn.asl


                * defined by the driver in the import file has to


                * parse the output in this format.


                */


                print("Starting DynModel-SerialNumber-Driver...");


                DynModelSerialNumberDriverObj->startWithParameters(cesObj);


               }


            


3 Save and close the custom-end-system.asl file.


The custom-end-system.asl file is saved into the BASEDIR/smarts/local/rules/discovery/custom
directory.


Creating the script to parse the value of SM_SerialNumber
This script parses the results of the SNMPWalk to retrieve the value of SM_SerialNumber.
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To create the script:


1 Start editing the ASL file.


               # 


        


               cd


               BASEDIR


               /smarts/bin


               # 


        


               sm_edit --create rules/discovery/dynmodel-sn.asl


            


2 Type the following lines into the dynmodel-sn.asl file:


               /* Create a handle to the SNMP Agent object */


                agentObj=object(AgentName);


               


                /* Test that the results are not null */


                if (agentObj->isNull()  ) {


                 print("***********Error in dynmodelsn.asl********");


                 stop();


                 }


                /* DEBUG= TRUE; */


               


               


                /* Get a handle to the actual device by using the getSystem


               


                operation available through the agent object handle */


                nodeObj=agentObj->getSystem();


                print("NODE:".nodeObj->DisplayClassName);


                START{


                 SERIAL  


                }


                /* fs is need as field separators in this parsing.*/


                /* This OID matches what was defined in the import file */


                serialNumberOID {


                 ".1.3.6.1.4.1.9.3.6.3"


                }


                SERIAL{


                 oid:{ serialNumberOID.".".integer }  fs


                 serial:word fs


                 }


                 do{


                  /* As the snmpwalk returns a value without knowing the


               


                 type, you need to use hexToString to convert the


                   * result from hex to ASCII string */


                  serial=hexToString(serial);


               


                 /* Assign the results to the new SM_SerialNumber


               


                 attribute */
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                 nodeObj->SM_SerialNumber=serial;


               


                stop();


                }


            


3 Save and close the dynmodel-sn.asl file.


The dynmodel-sn.asl file is saved into the BASEDIR/smarts/local/rules/discovery directory.


Restarting the Network-Resource Manager
Once the driver has been created, and the custom-end-system.asl and dynmodel-sn.asl files have been
edited, the Network-Resource Manager needs to be restarted.


To restart the Network-Resource Manager:


1 Stop the test Network-Resource Manager.


2 Reload the compiled dynamic model file into the test Network-Resource Manager.


               # 


        


               cd


               BASEDIR


               /smarts/local/model


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER -c icf-r 


               


                --broker=localhost:426 --dynamics
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Updating the Global Manager 8
This chapter includes the following topics:


n Loading the dynamic model enhancements


n Transferring topology and events


Loading the dynamic model enhancements
If the new topology needs to be accessible by the Global Manager, then the dynamic model files must be
loaded into the Global Manager. In addition, the Global Manager configuration file must be modified to
subscribe to new events.


Note   BASEDIR is the directory for the Service Assurance Manager.


To load the dynamic model enhancements into the Global Manager:


1 Copy the appropriate dynamic model files (.mdl files) to the Service Assurance Manager’s
BASEDIR/smarts/local/modeldirectory.


All subsequent steps refer to the copies of the dynamic model files in the
Service Assurance Manager’s BASEDIR/smarts/local/modeldirectory.


2 Remove any instances of the binary data type from the dynamic model files.


3 Replace any instances of the byte data type with the int data type in the dynamic model files.


4 Remove any instances of the external keyword in the dynamic model files.


5 Remove any problems or events in the dynamic model files.


6 Compile the dynamic model files.


For example, to compile the Example2.mdl dynamic model file:


               # 


        


               cd


               BASEDIR


               /smarts/local/model


               # 
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               BASEDIR


               /smarts/bin/dynmodel Example2.mdl


            


7 Load the compiled dynamic model files into the Global Manager.


For example:


t# 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SA -c ics 


               


                --broker=localhost:426 --output --dynamics 


Transferring topology and events
The BASEDIR/smarts/conf/ics/ics-default.xml file is the configuration file for the Global Manager. This file
designates which dxa files are used to transfer events and topology from the
Network-Resource Manager, IP-Perspective Manager, and IP-Analysis Manager into the Global Manager.
The ics-default.xml file contains a separate section for each of the three Domain Managers. Each section
indicates the dxa file that is used for that particular Domain Manager.


In this example, the ics-default.xml file sets dxa-net-rm-conn-perf.conf as the dxa file that defines which
topology and events to transfer from a Network-Resource-Suite to the Global Manager.


<domaintype 


     name="Network-Resource-Suite" 


     dxaConfFile="dxa-net-rm-conn-perf.conf" 


     MinimumCertainty="0.01" 


     SmoothingInterval="65"> 


     <description>Type for Network Resource Connectivity and Performance Suite</description>


     <hook enable="False">ics/dxa-sample-hook.asl</hook>


     <domainname>Network-Resource</domainname>


 </domaintype>


Transferring topology
The first section of the dxa configurationfile provides a listing of what classes, and attributes of those
classes, will be transferred from the Manager to the Global Manager. If an attribute has been added to an
existing ICIM class, and you want that attribute to appear in the Global Manager, then the class and
attribute must be added to this listing.


Note   Use sm_edit to edit the dxa configuration file.
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For example, the attribute SM_SerialNumber is added to the Router class. To add the SM_SerialNumber
attribute in the Global Manager, the following lines would be typed (shown in bold) before the entry for
the ICIM_UnitaryComputerSystem, as illustrated:


# Remote Name of Class/Property        Mapped Name of Class/Property


server   Network-Resource


class   Router


         attr    SM_SerialNumber


class   ICIM_UnitaryComputerSystem           Node


attr    Certification


attr    DisplayName


attr    Description


attr    Location


attr    Model


attr    PrimaryOwnerContact


attr    Type


attr    Vendor


rel     ConnectedVia


The addition of these two lines configures the Global Manager to subscribe to topology changes for the
new SM_SerialNumber attribute of the Router class.


Transferring events
In order for the event that is generated by one of the IP Manager Domain Managers to appear in the
Global Manager, you need to edit the appropriate dxa configuration file to subscribe to the new event.


Events are based on expressions that are created based on attribute values. These attribute values are
not polled for unless there is a subscription to the event that utilizes this value.


Note   Use sm_edit to edit the dxa configuration file.


Subscribing to the event
Event and notification subscriptions in the Global Manager are configured within dxa configuration files by
using the sub keyword. Patterns (regular expressions) separated by "::" match the class name, instance
name, and event name in the Domain Manager.


The syntax is as follows:


sub <classPattern>::<instancePattern>::<eventPattern>/<modifiers>


where:


n <classPattern> is the pattern to match for the class name.


n <instancePattern> is the pattern to match for the name of the instance.


n <eventPattern> is the pattern to match for the name of the problem or event.


n <modifiers> can have the following values:


n p = problem
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n e = event


n a = aggregates


n n = notifications


For example:


# Subscriptions


.


.


sub     ICIM_UnitaryComputerSystem::.*::DiscoveryError/e


sub     ICIM_UnitaryComputerSystem::.*::Unresponsive/e


.


.


To subscribe to a new event, add a line to this Subscriptions section. For example, to subscribe to
a new IPForwardingOn event in the Host class, the following line is added:


sub  Host::.*::IPForwardingOn/e


Setting the notification characteristics of the event
The next section of the dxa file defines the category and severity associated with each of the subscribed
events.


#COMPUTER SYSTEMS


sev  ExternalPowerSupply  Down               Operational 1


sev  Host      Unresponsive       Operational 1


sev  Host       AgentUnresponsive  Operational 2


sev  Application       Unresponsive       Operational 2


The syntax is:


         sev


         <Class_Name>


         <Problem_Event_Name>


         <category>


         <severity_code>


      


where <severity_code> can have one of the following values:


n 1 = red, critical.


n 2 = orange, major.


n 3 - yellow, minor.


n 4 = cyan, unknown.
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n 5 = green, normal.


The
VMware Smart Assurance IP Performance Manager and Server Performance Manager User Guide
and VMware Smart Assurance IP Availability Manager User Guide provide additional information
concerning the valid values for <category>.


To set the category and severity of an event that you have created, add a new line to this section. For
example, to define the severity and category for the new IPForwardingOn event, add the following
line:


sev  Host    IPForwardingOn       Operational 3
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Troubleshooting 9
This chapter includes the following topics:


n Overview


n Loading errors


n Discovery errors


Overview
This appendix describes common problems and their resolutions. The problems are categorized as:


n Compilation — Errors that may occur while compiling dynamic models.


n Loading — Errors that may occur while loading dynamic models into a Manager.


n Discovery — Errors that may occur when discovering new classes and populating attributes.


Loading errors
This section explains some common errors that you may encounter while loading dynamic models into an
Manager.


Note   If you include the --output option with the sm_server command used to load dynamic models into
an Manager, these error messages appear in the log file. Otherwise, these error messages are displayed
on the command console.


Missing ICU files
The following error is encountered when the <modelname>_mmbe.dat and <modelname>_mmle.dat files
have not been copied over to the SM_SITEMOD/l10n directory, after the model files have been compiled
using dynmodel.


[September 28, 2009 3:30:19 PM EDT +834ms] t@1119086912 LDM file processing #1


DYN-W-CANT_LOAD_DAT-Can't load ICU dat file 'Example1_mm' version 4ac10ddd (pkgname 


'Example1_mm4ac10ddd')


 CI-REGISTER_PKG-Error occurred while registering package 'Example1_mm4ac10ddd'; in file 


"/work/blackcurrent/DMT-9.0.0.X/1189/smarts/clsapi/ci_i18n.c" at line 290


 I18N-EACCES_PKGFILE-Cannot access resource bundle file
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Solution
From the BASEDIR/smarts/model directory, copy the <modelname>_mmbe.dat and
<modelname>_mmle.dat files to the SM_SITEMOD/l10n directory.


For example, copy the following files to the SM_SITEMOD/l10n directory:


n Example1_mmbe.dat


n Example1_mmle.dat


Note   You must copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the
SM_SITEMOD/l10n directory every time you compile the <modelname>.mdl file using the dynmodel
compiler.


Duplicate OID entries
The following error is encountered when an OID is defined in more than one oid2type file. In this example,
the printer OID was added to BASEDIR/smarts/conf/discovery/oid2type_Field.conf so that this printer
would be added to topology as an instance of SM_Printer. However, this OID is also defined in another
oid2type file.


[November 3, 2009 12:35:08 PM EST +668ms] t@1150445888 InCharge Framework


ASL_MSG-*-ASLP-discovery/discovery-init.asl: 


DSCV-W-While loading oid2type files, the following entries are duplicate


[November 3, 2009 12:35:08 PM EST +668ms] t@1150445888 InCharge Framework


ASL_MSG-*-ASLP-discovery/discovery-init.asl: .1.3.6.1.4.1.11.2.3.9.1 in file: 


BASEDIR/smarts/local/conf/discovery/oid2type_Field.conf


Solution
Determine which oid2type_*.conf file contains the duplicate entry. Use sm_edit to edit the oid2type file
that contains the duplicate entry and comment out the entry.


For example, the printer OID in this error is also defined in
BASEDIR/smarts/conf/discovery/oid2type_Misc.conf.


1 Edit the file by using sm_edit.


               BASEDIR/smarts/bin/sm_edit conf/discovery/oid2type_Misc.conf


2 Comment out the entry for the duplicate OID, by preceding the lines with a pound sign (#):


 #.1.3.6.1.4.1.11.2.3.9.1 {


 #  TYPE = Host


 #  VENDOR = HP


 #  CERTIFICATION = VALIDATED


 #
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 #INSTRUMENTATION:


 #  Interface-Fault   = MIB2


 #  Interface-Performance  = MIB2


 #}


3 Save and close the file. The edited copy is saved in the BASEDIR/smarts/local/conf/discovery/
directory.


4 Restart the Manager with the --dynamic option.


Manager cannot restore topology
An error, similar to the following, is encountered when you try to start a Manager


[November 3, 2009 12:11:00 PM EST +288ms] t@1141098816 InCharge Framework


ICF-E-EINIT-While initializing the InCharge application


 ICF-ERESTOREREPOS-While attempting to restore topology from file 


BASEDIR/smarts/local/repos/icf/TEST_SERVER_RM.rps


 MR-CANTCREATE_INSTANCE-'SM_Printer::CAXTON' could not be created.  ; in file 


"/work/blackcurrent/DMT-9.0.0.X/1201/smarts/repos/mr/dyn_acc.c" at line 2829


 MR-CLASS_NOT_FOUND-Class of given name 'SM_Printer' not found; in file 


"/work/blackcurrent/DMT-9.0.0.X/1201/smarts/repos/mr/dyn_acc.c" at line 1709


[November 3, 2009 12:11:00 PM EST +430ms] t@1141098816 InCharge Framework


SVIF-N-SHUTDOWN-Shutting down...


This error is occurring because you have an instance of a class in the repository, but the class is not
defined in the data model of the Manager. Similar errors occur for attributes, events, operations,
problems, symptoms, or aggregates that are in the repository, but not defined in the data model of the
Manager.


For example, a dynamic model file was previously loaded into the Manager. The dynamic model file
added a new class called, SM_Printer. An instance of the SM_Printer class was discovered and added to
the repository of the Manager.


Now, when you invoke the sm_server command the appropriate dynamic model file must be in the
proper directory. The directory is determined by whether or not you are including the --dynamic option on
the sm_server command line. If you are not loading the dynamic model enhancements into the
Manager’s data model, then the SM_Printer class does not exist in the Manager’s data model. The
instance of SM_Printer still exists in the repository, and the system tries to restore the instance of
SM_Printer that was previously discovered. However, the class does not exist.


Solution
If you want the dynamic model enhancements and the previously discovered topology to be restored in
the Manager, then place your dynamic model in the appropriate directory. The directory is based on your
use of the --dynamic option when you invoke sm_server.


Including the --dynamic option on the command line when you start up a Manager, loads all of the .ldm
files in the following directories:


n BASEDIR/smarts/model
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n BASEDIR/smarts/model / <config>


The <config> refers to the configuration directory that is specified on the command line when the
Domain Manager is started.


If you start a Manager without the --dynamicoption, then only the following .ldm files will be loaded:


n BASEDIR/smarts/local/model /<config>


The <config> refers to the configuration directory that is specified on the command line when the
Domain Manager is started.


If you want to discard the dynamic model enhancements, including any topology changes that were
discovered for the dynamic model enhancements, then invoke the sm_server command with the --
ignore-restore-errors option.


t # 


        


               BASEDIR


               /smarts/bin/sm_server -n TEST_SERVER -c icf-r 


               


                --broker=localhost:426 --bootstrap=bootstrap-am.conf


               


                --ignore-restore-errorss


Unable to open <ldmfilename>
The .ldm file, <ldmfilename>, cannot be opened by the Manager. BASEDIR/smarts/model directory.


Solution
Verify that <ldmfilename> has the correct read permissions. This error should be pretty rare, since most
Managers are started by root. They have administrative privileges.


DYN-E-CLASS_NAME_ALREADY_EXIST
The name of a class declared in the .mdl source file, at the given line number, conflicts with an existing
class name in the configuration already loaded.


Solution
You must choose a different class name.


1 Edit the .mdl file.


2 Run dynmodel.


3 Copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the SM_SITEMOD/l10n
directory.


4 Restart the Manager with the --dynamic option.
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DYN-E-STRUCT_NAME_ALREADY_EXISTS
The name of a structure declared in the .mdl source file, at the given line number, conflicts with an
existing structure name in the configuration already loaded.


Solution
You must choose a different structure name.


1 Edit the .mdl file.


2 Run dynmodel.


3 Copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the SM_SITEMOD/l10n
directory.


4 Restart the Manager with the --dynamic option.


DYN-E-ENUMERATION_NAME_ALREADY_EXISTS
The name of an enumeration declared in the .mdl source file, at the given line number, conflicts with an
existing enumeration name in the configuration already loaded.


Solution
You must choose a different enumeration name.


1 Edit the .mdl file.


2 Run dynmodel.


3 Copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the SM_SITEMOD/l10n
directory.


4 Restart the Manager with the --dynamic option.


DYN-E-ATTRIBUTE_NAME_ALREADY_EXISTS
The name of an attribute declared in the .mdl source file, at the given line number, conflicts with an
existing attribute name in the configuration already loaded.


Solution
You must choose a different attribute name.


1 Edit the .mdl file.


2 Run dynmodel.


3 Copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the SM_SITEMOD/l10n
directory.


4 Restart the Manager with the --dynamic option.


VMware Smart Assurance Dynamic Modeling Tutorial


VMware, Inc.  94







DYN-E-EVENT_NAME_ALREADY_EXISTS
The name of an event declared in the .mdl source file, at the given line number, conflicts with an existing
name in the configuration already loaded.


Solution
You must choose a different event name.


1 Edit the .mdl file.


2 Run dynmodel.


3 Copy the <modelname>_mmbe.dat and <modelname>_mmle.dat files to the SM_SITEMOD/l10n
directory.


4 Restart the Manager with the --dynamic option.


DYN-E-NO_AGGREG_OP
A property that is propagated across a relationshipset needs an aggregation operator. The Dynamic
MODEL compiler cannot tell whether a name is a relation or a relationshipset until runtime, so it does not
require an aggregation operator. This message is followed by the class name, propagated property name,
and relationshipset name.


         <classname>:<property>:<relationshipset>


      


Solution
Find the .mdl source file which declares the propagated property and add the aggregation operator to the
propagated property declaration.


Discovery errors
This section explains some of the errors that you may encounter while discovering classes and populating
attributes.


Class property changes do not appear in Service Assurance
You modified class properties, such as attribute values, in the underlying Domain Manager, but you do
not see those changes reflected in the Global Manager. The problem is that the topology in the underlying
Domain Manager and the Global Manager are no longer synchronized.


Solution
You can synchronize the topology between an underlying Domain Manager and the Global Manager by:


n Initiating a discovery.
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n Using the dmctl command. Synchronizing topology changes with the Global Manager provides
additional information.


Running the ASL scripts


ASL-ERROR_PUT
The following error usually occurs when there is a misspelling or missing capital letters. For example, the
following error was generated because filename was used instead of fileName:


# ASL-ERROR_PUT-While attempting to set property 'filename' of object


#     'GA_RuleSet::DynModel-OS-RuleSet'


#CI-EGENERIC-filename


# MR-PROPERTY_NOT_FOUND-Specified property not found in class


ASL-ERROR_CREATE
The following error was generated due to a syntax error. For example, GA_RulesSet was used instead of
the correct GA_RulesSet


# ASL-ERROR_CREATE-While attempting to create the object


#    'GA_RulesSet::DynModel-OS-RuleSet'


# CI-EGENERIC-GA_RulesSet


# MR-CLASS_NOT_FOUND-Class of given name not found
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MODEL and Dynamic Models 10
This chapter includes the following topics:
n The ICIM Reference


n Representing systems with MODEL


n Differences between MODEL and Dynamic Model


The ICIM Reference
Managed Object Definition Language (MODEL) is integral to the SDK application development process.
Its purpose is to render the schema and semantics of the VMware Smart Assurance ICIM Reference
specification. MODEL is compiled, producing data model libraries that describe the model. These libraries
are loaded by a Domain Manager and are operated on by SDK applications. For an SDK application, all
of the classes, relationships, attributes, events, and so on are defined at compile time.


Dynamic Modeling is an extension of the existing MODEL language, building on the same core
implementation and principles. It enables you to add new classes, and refine classes that are already
defined in the data model libraries, at runtime when the Dynamic Models are loaded into an Manager.


The ICIM represents logical and physical components of managed systems across networked technology
domains. By using an object-oriented representation, it is a conceptual view of the problem domain that
provides Domain Managers with semantics that support root-cause analysis.


SDK models are object-oriented.


n The notion of class provides a mechanism for encapsulating a managed element’s state or
properties. Two semantic properties especially useful for root-cause analysis are relationship and
event. Relationship expresses the correlation dependencies between classes. Events are those
actions that cause transitions within the model.


n The object-oriented inheritance construct allows new classes to be derived from existing classes. This
is a mechanism for specialization within the model, while preserving model semantics for the new
class. New classes inherit not only the properties of the base class but its semantics, as well.
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n The object-oriented instance construct provides a mechanism for separating the model representation
of a managed element from its actual implementation. This supports desirable modeling goals, where
the model is conceptual and generalized, and independent of any particular implementation within the
problem domain. With respect to ICIM, this means that the correlation model, represented by classes,
is separated from the domain topology, represented by instances. So ICIM is a true model, in the
sense that it can accurately conceptualize, or model, particular implementations without prior
knowledge.


Representing systems with MODEL
An ICIM class is actually defined by describing it as an interface. This is consistent with the programming
practice of information hiding, where program elements are known and fully described by their interface
and not by their implementation. To accomplish this, a language is needed to establish syntactic rules for
the interface itself and for programs that use the interface. For SDK, the Managed Object Definition
Language (MODEL) was developed to describe ICIM classes.


The MODEL is a textual notation with a syntax that supports a common way of representing
heterogeneous elements. This also allows tools, such as compilers and analysis programs, to be applied
to the model. The MODEL also defines semantic constructs that support the correlation model.


The example shows a simple MODEL interface declaration.


interface MyExample : ICIM_ManagedSystemElement


“An interface to generate an event when value > threshold.”


{ 


 attribute int MyValue = 0; 


 attribute int MyThreshold = 50; 


 event MyValueOverThreshold = MyValue > MyThreshold; 


 export MyValueOverThreshold; 


}; 


The interface has a name identifier, MyExample, and inherits from a base class,
ICIM_ManagedSystemElement. The interface may also include a comment that describes the interface.


Constructs that support the correlation model include:


n Typed attributes


n The attribute int


n Events that are computed by and exported from the interface: event and export


The MODEL compiler generates the C++ source code needed to access an interface’s attributes and
to monitor the event conditions and generate an event notification. The generated source code is
linked as an executable model library, which is loaded by a Manager whose analysis programs
operate on the loaded model.
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Add your model source file to the makefile used to build the system. Executing the appropriate
makefileinvokes the model compiler for your model file, producing C++ source code and header files.
The C++ compiler is then called to produce an object file for linking. (The filename extension of the
executable model is specific to your operating system.) Your model object file is linked with
VMware Smart Assurance model libraries and produces an executable model of the domain, which
includes your application.


To execute your application, start a Manager by using sm_server. Specify the model executable to
load on the sm_server command line.


Differences between MODEL and Dynamic Model
ICIM models are bound to programs that operate on the models at compile time. This is a characteristic of
both the MODEL language and of the methodology for developing models.


This imposes a limitation on applications that are not aware of all of an interface’s properties at compile
time. This typically occurs because VMware Smart Assurance models tend to be general enough to
support a large customer base. A particular customer, for whom more interface properties would be
useful, must, however, limit the application programs to only what is made available by the ICIM model.


Dynamic modeling is a step toward solving this problem. It achieves this by allowing delays when binding
occurs between the model and the programs that operate on the model. Instead of binding at compile
time, as with the traditional MODEL, interfaces may now effectively be made known to the system at
runtime, when they are loaded into a Manager as a dynamic model.


Simplified MODEL and Dynamic Model methodology comparison shows the differences between using
MODEL and Dynamic Model. The obvious differences between the process of creating a traditional model
executable and creating a dynamic model executable is that intermediate C++ source code is not
generated and the dynamic model is not linked into the system during the build phase. Instead, the
dynamic model compiler is invoked to directly produce a file with a .ldm extension that can be loaded by a
Manager. When the Manager is started, and the dynamic model is loaded, the existing model class
dependencies and the new dynamic model class dependencies are resolved.
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Figure 10‑1.  Simplified MODEL and Dynamic Model methodology comparison


Note the following:
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There are other files that are produced by the MODEL compiler and by the Dynamic Model compiler. 
Simplified MODEL and Dynamic Model methodology comparison is a simplified view to highlight the
major differences. A more detailed explanation of the MODEL compiler is available in the
VMware Smart Assurance MODEL Reference Guide.


Dynamic model files can be loaded when a Manager is started or after the Manager is already running.


Although MODEL and Dynamic Model are used independently and involve different steps and tools, the
dynamic model is fully derived from MODEL. Therefore, many of the concepts that apply to MODEL also
apply to the dynamic model. Familiarity with the VMware Smart Assurance MODEL Reference Guide is
useful when working with Dynamic Model.
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Introduction 1
This chapter includes the following topics:
n Fundamental concepts


n Overview of a simple API Perl script


n Using primitives and object references


n Event subscription


Fundamental concepts
The VMware Smart Assurance Remote Application Programming Interface (API) for Perl allows
developers to create Perl scripts that connect to Domain Managers as clients to exchange information,
manipulate data, or drive Domain Manager actions. The API provides access to all Domain Manager
features, by using a syntax and logic that mirrors what is available through the Adapter Scripting
Language (ASL) and the dmctl utility in a way that is natural to Perl developers. The API runs on UNIX
platforms that support Perl 5.6.1 and Perl 5.8.x.


When using the provided Perl 5.8.8 version, the API uses a Flow module, which replaces IO::Socket and
enables encryption and “keep alive” functionality. If you use Perl 5.6.1 there is no encryption or keep alive
functionality.


The API also supports IPv4 and IPv6 environments.


In order to create scripts that interact with a Domain Manager, it is necessary to understand how the
manager is configured.


A script developed using the Perl API can crete, delete and interact with instances of interfaces in a
Domain Manager. The interfaces are defined using the MODEL language, compiled and loaded into a
Domain Manager. The MODEL language is an object-oriented language used to construct a data model
to describe a managed domain. The language is used to define a set of classes and the attributes,
relationships, operations, and events that are associated with the classes.
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Classes
Classes describe the objects that are modeled for use in a Domain Manager. For example, Router is the
name of a class, and all routers that are managed by a domain are represented as Router objects in the
domain. Every object in a class shares the same set of attributes, although the values of the attributes
differ. Hence, every router has an IP address, an attribute, but the actual addresses are different.
PowerSupply is also a class, but power supplies do not have IP addresses. However, the event, power
outage, is relevant to the PowerSupply class but not to routers. Therefore, a model class is a grouping of
all objects that are similar in nature but not in detail.


Every model class has a number of properties, events and operations defined for them. The API provides
functions for obtaining details of these definitions.


Instances
Object instances are specific occurrences of a class. For example, a class might describe a human, and
an instance of the class could be an object named Bill.


Properties - Attributes and relationships
Every instance in a VMware Smart Assurance domain has a set of properties associated with it. These
are values that describe the object. There are two distinct types of class properties supported by
VMware Smart Assurance software: attributes and relationships.


Attributes
Attributes describe a class and for an instance of the class include information about its present state.
Examples of attributes include an element’s name and a counter that counts the number of packets
traversing an interface. Attributes are simple strings, integers, booleans, or enumerations.


Relationships
Relationships define how instances are related to other instances. Relationships can be one-to-one, one-
to-many, many-to-one or many-to-many.


n When only a single instance can be related to another instance, or instances, it is known as a
relationship.


n When multiple instances can be related to another instance, or instances, it is known as a
relationshipset.


Operations
Operations are actions that are specific to a class of object. For example, you can get the associated
network adapter name for a MAC address but not for a router.


The API provides a mechanism for invoking these class-specific actions, by passing information to them
through arguments, and by obtaining the results of the action.
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Events
Events describe the failures that can occur for a class, the symptoms that these failures create, and the
effect of such failures. Symptoms can be local, observed in the instance of the class, or propagated,
observed in instances related to the failing instances.


Primitives - Basic Domain Manager interface
Primitives are Perl functions that provide the basic interface between a client application and the
Domain Manager.


A number of these are likely to be used directly by scripts and will be familiar to ASL developers. These
include getInstances(), getChildren(), getExplainedBy().


Others are normally hidden from view because higher level features can be used instead, which
ultimately call the primitives. For example, primitives that are not normally used directly are get() and
invoke(). These are the calls that allow an instance's properties to be queried and its operations to be
called. In both the API for Perl and ASL, these calls are normally invoked by using a classic object-
oriented syntax.


The VMware Smart Assurance ASL Reference Guide provides further information about the
VMware Smart Assurance data structures.


The Perl API is implemented as a set of Perl modules, which individual Perl scripts may access, by using
the familiar ”use” directive. InCharge::session and InCharge::object offer the principal interface, which
respectively provide connection sessions to Domain Managers and access to objects within those
managers. Simultaneous sessions to multiple Domain Managers may be established within a single Perl
script. Properties and methods of objects within those managers may be accessed as with C++, offering
somewhat broader functionality than that afforded by ASL.


Encryption
Messaging between the client and Domain Manager can be encrypted, by using the Perl API. Encryption
is dependent upon the values set for the environment variables SM_INCOMING_PROTOCOL and
SM_OUTGOING_PROTOCOL. If these values are not specified, encryption is automatically negotiated
between the client and Domain Manager. The VMware Smart Assurance System Administration Guide
provides further information about encryption.


“Keep Alive” messaging
The Perl API also supports “Keep Alive” messaging to maintain active connections between the client and
DM, as discussed in the VMware Smart Assurance System Administration Guide.
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Transcoding character data
You must transcode character data from your code page to UTF-8 before placing the character data into
the remote API buffer. Data will be returned to your Remote API client application bindings as UTF-8
strings.


Setting environment variables
You must define the following variables to run a Perl script within the VMware Smart Assurance
environment from the command line.:


n SM_HOME


n SM_WRITABLE


n SM_AUTHORITY


n SM_BROKER


n SM_BROKER_DEFAULT


n SM_SITEMOD


n SM_INCOMING_PROTOCOL


n SM_OUTGOING_PROTOCOL


You can find further information on these variables in the
VMware Smart Assurance System Administration Guide.


To set these variables, type the following command to start the bash environment:


               


                  BASEDIR/smarts


               /bin/runcmd bash 


bash$>


A Perl script to define the variables can now be run within this bash environment.


“Keep Alive” and encryption requirements
The Perl API now supports “Keep Alive” and encrypted communications when run with the version of Perl
supplied by VMware. You should use the sm_perl command that is shipped with the
VMware Smart Assurance software, in order to successfully run the Perl API.


You can use a pure Perl implementation without keepalive or encryption by setting the environment
variable SM_DISABLE_FLOW_WRAPPER.
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Overview of a simple API Perl script
The general approach to writing a script that uses the Remote Perl API is to follow these basic steps:


1 Open a session.


Initialize a session, and obtain a reference to it, by using either InCharge::session->init() or
InCharge::session->new(), as appropriate.


  use InCharge::session;


  $session = InCharge::session->init( );


2 Work with the domain.


Call the primitives required, by using the session reference obtained in step 1, and manipulate the
data. For example,


  foreach $class ( sort $session->getClasses() ) {


   foreach $inst (


    sort $session->getInstances($class))


   {


    print $class . "::" . $inst . "\n”;


   }


  }


3 Close the session.


Once the script has finished working with the domain, the session should be closed.


  $session->detach( );


Where access to the operations or properties of domain objects (such as routers and interfaces) is
required, you use the features of the InCharge::object module. The script obtains an InCharge::object
reference, and then uses it to access the required information. For example.


4 Establish a session.


  use InCharge::session;


  $session = InCharge::session->init();


5 Obtain an object reference.


Before an object in the domain can be accessed, the script needs to obtain an InCharge::object
reference to the object of interest, by using the object() method of the session handle.


  $obj = $session->object( "Router::gw1" );
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6 Manipulate the object.


The reference obtained in step 2 can now be used to access the properties and operations of the
object. Properties can be accessed, by using Perl's hashing syntax and operations can be invoked,
by using Perl's object-oriented syntax conventions.


  $type = $obj->{Type};


  $obj->{Vendor} = "Cisco";


  $fan1 = $obj->findFan( 1 );


7 Close the session.


As before, the session should be closed when no longer required.


  $session->detach( );


Using primitives and object references
The API provides function calls for accessing all the low-level facilities of Domain Managers. Each of
these primitives can be invoked with reference to the InCharge::session handle, described in step 1 on 
page 19, and takes arguments that exactly match the API syntax.


The API also provides an object-oriented abstraction layer that allows Perl code to access the
Domain Manager, by using a syntax that is very similar to ASL. For example, in ASL you can list the
vendors of all routers, by using this logic:


 routers = getInstances( "Router" );


 foreach router ( routers ) {


  obj = object( "Router", router );


  vendor = obj->Vendor;


  print( router . " - " . vendor );


 }


When using the Perl API to perform the same action, the code looks like this:


 @routers = $session->getInstances( "Router" );


 foreach $router ( @routers ) {


  $obj = $session->object( "Router", $router );


  $vendor = $obj->{Vendor};


  print $router . " - " . $vendor . "\n”;


 }


The two code fragments in the ASL and Perl API example are very similar. The first main difference is a
matter of syntax. Perl uses ``$'' and ``@'' to denote scalar and array variables, and {..} to denote object
properties, which are hash table lookups. The second difference is that the object( .. ) and
getInstances( .. ) functions are called with reference to a session handle in the Perl code.
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Event subscription
The Perl API provides mechanisms for subscribing to and acting upon events generated by
Domain Managers.


The VMware Smart Assurance programming model delivers two different modes of client/server
communication. The most direct is where a client makes a request of the Domain Manager which acts on
the request and responds. A simple example of this is an object query or update. For example, the action
of obtaining the vendor of a particular device is one such query. In Perl, this query would be encoded in a
manner similar to the following fragment.


 use InCharge::session; 


 use InCharge::object;


 $session = InCharge::session->init( );


 $device = "Router::gw1";


 $obj = $session->object( $device );


 $vendor = $obj->{Vendor};


 print $vendor . "\n”;


The second mechanism provides asynchronous notifications through subscriptions and is used when the
client program needs to listen for events generated by the Domain Manager in response to other external
events. One example would be a script that waits for the Vendor field of a particular router to change. In
Perl, this could be coded in the following way.


 use InCharge::session; 


 use InCharge::object;


 $session = InCharge::session->init( );


 $observer = $session->observer( );


 $device = "Router::gw1";


 $session->propertySubscribe($device, "Vendor", 30 );


 while ( 1 ) {


  @event = $observer->receiveEvent( );


  print "Vendor $event[2]::$event[3] is now \


       $event[5]\n”;


 }


The following sections provide an overview of mechanisms for creating and controlling a number of
different types of subscriptions.


Registering an observer
In order to allow a Domain Manager to send subscribed events to a client program, the client must first
register itself with the Domain Manager as an event observer.
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In Perl, this is done by using the observer() method of the InCharge::session module. Two steps are
required:


1 Connect to the Domain Manager and get a valid session object handle.


First, the client must connect to the Domain Manager which establishe s a new InCharge::session
connection. This is done by using either the InCharge::session->new() or InCharge::session->init()
methods.


Here are some example code fragments that achieve this goal:


  $session = InCharge::Session->init( )


  $session = InCharge::session->new(


   broker=>"192.168.0.3",


   domain=>"INCHARGE"


  );


2 Attach an observer to the Domain Manager session.


Once the script has obtained a handle that references the script/server connection ($session in step 1
on page 22), it can be used to obtain a second connection to the notification engine of the
Domain Manager. This is obtained by using the observer() method on the InCharge::session handle
just obtained. The following code performs this action.


  $observer = $session->observer();


  $observer->detach();


Subscribing to notifications
Once the client has registered itself as an observer, the next step is to inform the Domain Manager about
which events the observer wants to receive notifications. VMware Smart Assurance allows clients to
subscribe to a number of different types of events. These are listed in Subscription methods summary.


Table 1‑1.  Subscription methods summary


Method type Description Method API call


property Notifications about changes to specified object properties in the
ICIM database. For example, when the “Vendor” field of
Router::gw1 changes


propertySubscribe


propertyUnsubscribe


topology Notifications about changes to the topology, such as the creation
and deletion of objects. This does not refer to object property
changes.


topologySubscribe


topologyUnsubscribe


event Notifications about the posting and clearing of events and
changes to their state.


subscribe


unsubscribe


subscribeAll


unsubscribeAll


getSubscriptionState


IsSubscribed
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This table gives the names of the methods used to subscribe to and unsubscribe from different types of
notifications.


The following code segment is an example script that subscribes to changes of the Vendor field of every
device in the topology:


 $session = InCharge::session->init( );


 $obs = $session->observer();


 foreach $name ( $session->getClassInstances(


    "ICIM_UnitaryComputerSystem" ) ) {


  $session->propertySubscribe("::$name", "Vendor", 30);


 }


Receiving notifications
Once the script has registered as an observer, and subscribed to the notifications of interest, it then
proceeds to listen for events and process them as required. The event reception method call is
receiveEvent(). This returns an array of up to five values.


For the purposes of the descriptions that follow, assume that events are returned in the array @event, as
shown in the following script fragment:


 @event = $observer->receiveEvent( );


Should the script require the event to be a single string with a separator used to delimit the fields, in the
style of the ASL language, then the application can use the standard Perl join function:


 $fs = "|";


 $event = join( $fs, $observer->receiveEvent( ) );


The receiveEvent() method can take an optional parameter to specify a timeout in seconds, which may be
fractional. If no event arrives within the specified time, a pseudo-event of type TIMEOUT is returned. For
example,


 @event = $observer->receiveEvent( 0.25 );


If no timeout is specified, the call waits forever.


The first element of the @event array, accessed by using the Perl syntax: $event[0], contains the event's
timestamp measured by using normal UNIX time_t semantics (number of seconds since midnight January
1, 1970).


The second element of the @event array, $event[1], contains a text string that describes the type of event
received.


The array elements from $event[2] to $event[$#event] have meanings that depend on the semantics of
the event type given in $event[1].
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Event notification records
Event notifications are received from the Domain Manager when the status of an event changes. The
format of the notification record is shown in Notification record - NOTIFY.


Table 1‑2.  Notification record - NOTIFY


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “NOTIFY”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Event name (STRING)


$event[5] Event certainty (FLOAT)


Normally, the Domain Manager sends a single notification message when an event becomes active and a
single clear message when the event is no longer active. If an event corresponds to a root-cause
problem, it is possible that the certainty of the diagnosis will change over time. If the diagnosis certainty
changes, the Domain Manager generates another notification. Notifications of this type are streamed in a
slightly different manner. This difference in behavior is a feature of the front-end Perl API, not the
Domain Manager. The Domain Manager sends NOTIFY messages in both cases. The API keeps internal
notes about active events, and changes the event type accordingly, as shown in Notification record -
CERTAINTY_CHANGE.


Table 1‑3.  Notification record - CERTAINTY_CHANGE


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “CERTAINTY_CHANGE”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Event name (STRING)


$event[5] Event certainty (FLOAT)


Notification record - CLEAR describes the format of the record when an event is cleared by the
Domain Manager.


Table 1‑4.  Notification record - CLEAR


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “CLEAR”


$event[2] Object class name (STRING)
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Table 1‑4.  Notification record - CLEAR (Continued)


Event record entry Description


$event[3] Object instance name (STRING)


$event[4] Event name (STRING)


Object create/delete records
An object create message is sent by the Domain Manager when a new object is created in the manager’s
repository. Notification record - CREATE describes the format of an object create record.


Table 1‑5.  Notification record - CREATE


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “CREATE”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


An object delete message is sent by the Domain Manager when an object is deleted from the manager’s
repository. Notification record - DELETE describes the format of an object delete record.


Table 1‑6.  Notification record - DELETE


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “DELETE”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


Class load records
A class load message is sent by the Domain Manager when a new class is created in the manager’s
repository. Classes are created when new MODEL-generated libraries are loaded. Notification record -
CLASS_LOAD describes the format of a class load record.


Table 1‑7.  Notification record - CLASS_LOAD


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “CLASS_LOAD”


$event[2] Class name (STRING)


Relation/property change records
A relation change message is sent by the Domain Manager when a relationship between objects
changes. Notification record - RELATION_CHANGE shows the format of a relation change record.
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Table 1‑8.  Notification record - RELATION_CHANGE


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “RELATION_CHANGE”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Relation name (STRING)


A property change message is sent by the Domain Manager when an object’s property changes. The
format of a property change record is shown in Notification record - ATTR_CHANGE.


Table 1‑9.  Notification record - ATTR_CHANGE


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “ATTR_CHANGE”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Property name (STRING)


Domain Manager connect/disconnect records
A Domain Manager disconnect record is generated when the connection to the server is lost. This differs
somewhat from ASL operation. The observer describes the proper handling of DISCONNECT events if
the restartableServer operation is appropriate. These records are generated even if no subscriptions to
the Domain Manager are issued. The format of the Domain Manager disconnect message is shown in 
Notification record - DISCONNECT.


Table 1‑10.  Notification record - DISCONNECT


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “DISCONNECT”


$event[2] Domain name (STRING)


Note   There is no CONNECT record. In ASL, these are an artifact of the resartableServer front-end that
the Perl API does not provide. The restartableServer affords a means of invisibly attempting a
reconnection. The CONNECT message is an indication of success. The Perl API instead gives an
immediate error on failure of the InCharge::session-->init() method or similar. It remains for the developer
to provide retry logic to successfully connect.
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Subscription status records
When the Domain Manager receives a subscription request, it normally sends a notification back to the
client to indicate whether or not the request was accepted. In the event of an error, such as an invalid
event name being specified, the Domain Manager does not report an error by using normal Perl die
semantics. Instead, a notification is used to report that the subscription was rejected. The format of the
ACCEPT/REJECT message is shown in Notification record - ACCEPT, REJECT, (PROPERTY).


Table 1‑11.  Notification record - ACCEPT, REJECT, (PROPERTY)


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “ACCEPT” or “REJECT” or “PROPERTY_ACCEPT” or “PROPERTY_REJECT”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Event or property name (STRING)


Event suspension records
Under certain circumstances, the Domain Manager will elect to suspend events if they are temporarily
irrelevant. For example, when an aggregation contains no triggering events, a SUSPEND message is
sent to the subscribed client. The format of the SUSPEND message is shown in Notification record -
SUSPEND (PROPERTY).


Table 1‑12.  Notification record - SUSPEND (PROPERTY)


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “SUSPEND” or “PROPERTY_SUSPEND”


$event[2] Object class name (STRING)


$event[3] Object instance name (STRING)


$event[4] Event or property name (STRING)


$event[5] Descriptive message (STRING)


Timeout records
If no event arrives within the time specified as the optional argument to receiveEvent(), a TIMEOUT
record is returned, whose message format is shown in Notification record - TIMEOUT.


Table 1‑13.  Notification record - TIMEOUT


Event record entry Description


$event[0] Timestamp (INTEGER)


$event[1] “TIMEOUT”


$event[2] Domain name (STRING)
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InCharge::Object 2
This chapter includes the following topics:


n Functions and methods


n Overview


Functions and methods


object


$object = $session->object( $class, $instance );


The object() method creates a new object reference.


get
The get() method is used to retrieve the value of the specified properties of the object, such as the value
of an attribute. In addition, the call get_t also extends the functionality of the get() method by returning
additional information that identifies the data type (for example, STRING) of the property value.


Note   The get() and get_t() primitives throw an error when used to access a nonexistent property or one
that cannot be retrieved for any reason, whereas the psuedo-hash syntax simply returns an undef value.
This difference allows the Data::Dumper logic to display an entire object without an error even when some
properties cannot be retrieved.


Single property
You can access the content of a property whose name is held in a variable by using the Perl typical logic,
as shown:


$result = $obj->{$property_name};
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In this example, the value of the $propname variable is retrieved:


 $propname = "Vendor";


 $value = $obj->{$propname};


Multiple properties
You can also get multiple values in a single get() call by listing all the property names as arguments, by
using the following syntax:


$result = $obj->get( $property_name [, $property_name ...] )


The results are returned in an array. This is faster than using multiple single-property get() calls. In this
example, the value of the Vendor and Type attributes are retrieved:


 ( $vendor, $type ) = $obj->get( "Vendor", "Type" );


All properties and relationships
You can also call get() with no arguments, in which case, a hash is created that contains all the object
properties and relations, as shown:


%all_properties = $obj->get( )


There is no syntactical advantage, but there is a significant speed advantage.


Return value types
The type of return value depends on the calling syntax used, get() or hash(), and the Perl evaluation
context, scalar or array, as shown in Return type for call syntax and Perl evaluation context.


Table 2‑1.  Return type for call syntax and Perl evaluation context


Expression syntax Property type Return type in scalar context Return type in array context


$obj->{prop} scalar scalar scalar in [0]


$obj->{prop} array array ref array ref in [0]


$obj->get(“prop”) scalar scalar scalar in [0]


$obj->get(“prop”) array array ref array


For example, if the attribute MyValue is declared as an integer in the MODEL code, then the return type
for that property will be an integer. Multiple values are always returned in an array or array reference.
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get_t
The get_t() method is like the get() method, except that it returns the type of return value as well as the
value itself. The data types are encoded as integer numbers. If the return is an array, then $value will
receive a reference to the array. If the return is a scalar, then $value will hold it. The $session->TYPE()
method can be used to convert the $type integer value to a mnemonic string.


($type, $value) = $obj->get_t( $property_name );


There is a second syntax that gets the types and values for multiple properties. Each type/value pair is
held in a two-element subarray within the returned data.


@types_and_values =


  $obj->get_t( $prop1 [, $prop2 [, prop3 .. ] ] )


There is also a third syntax gets the types and values for all the properties and relations of the object and
stores them in a hash, indexed by the property names.


%all_property_types_and_values = $obj->get_t( );


Example:


 $obj = $session->object( "Router::gw1" );


 ( $type, $value ) = $obj->get_t( "Vendor" );


 print "Vendor value ='$value', \


   type = ".$session>TYPE($type)."\n”;


This example will print:


 Vendor value='CISCO', type = STRING


put


$object->put( $property_name, $value );


The put() method allows fields of the object to be modified in the Domain Manager repository.


This method is used in a number of ways. However, the use of the pseudo-hash syntax is the preferred
option for syntactic equivalence with the Domain Manager native ASL language, as shown:


 $obj->put( "Vendor", "Cisco" );


 $obj->{Vendor} = "Cisco";


 $obj->{ComposedOf} = [ ];
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To set more than one property in a single call, use multiple name:value pairs, such as:


 $obj->put(Vendor => "Cisco",


   PrimaryOwnerContact => "Joe Bloggs");


You can also set more than one property in a single call, by using the following syntax:


 %updates = ( Vendor => "Cisco",


   PrimaryOwnerContact => "Joe Bloggs");


 $obj->put( %updates );


When using either syntax to set a relationship or list property, use a reference to a Perl array, such as:


 $obj->{ComposedOf} = [ $a, $b, $c ];


 $obj->put( "ComposedOf", \@things );


Use insertElement() and removeElement() to add or remove elements from a list.


isNull


$boolean = $object->isNull();


The isNull() method tests to see whether the object is present in the repository.


TRUE means that the object is not present. FALSE means it is present.


invoke


reply = $object->invoke( $operation, ... arguments ... );


The invoke() method calls the named repository class operation on the object.


The arguments passed should be as expected by the operation. If the operation returns a scalar value,
the call should be called in a scalar context. If it returns an array, it should be invoked in an array context.


Note   The preferred way of achieving the same result is to use the operation name directly. Thus, the
following are equivalent but the latter is preferred.


 $obj->invoke( "makePort", "1.0", "First port", "Port" );


 $obj->makePort( "1.0", "First port", "Port" );


You can also use the invoke_t() method, described in invoke_t to return additional information.


invoke_t


         ( $type, $value ) =


         $object->invoke_t($operation, .. args .. )>
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Invokes the named class operation on the object in the same way as invoke(), but invoke_t() also returns
the type of data returned by the call.


The data types are encoded as integer numbers. If the return is an array, then the $value will receive a
reference to the array. If the return is a scalar, then $value will hold it.


insertElement


$obj->insertElement( $relation, @object[s] );


Inserts the specified objects into an object relationship.


One or more can be specified to be inserted.


 $obj->insertElement( "ComposedOf",


    "Interface::IF-ether1", 


    "Interface::Loopback/0");


 $obj->insertElement( "ComposedOf", @interfaces );


removeElement


$obj->removeElement( $relation, @item[s] );


Removes the specified items from an object relationship.


One or more items can be specified to be removed.


 $obj->removeElement( "ComposedOf",


    "Interface::IF-ether1", 


    "Interface::Loopback/0" );


 $obj->removeElement( "ComposedOf", @interfaces );


delete


$obj->delete( ) 


Deletes the specified item from the repository, and from any relationships it belongs to. The delete()
function does not remove any objects that had a “contains” type of relationship with the object being
deleted. For example, calling delete() on a Router instance would remove that instance from the
repository and remove that instance from any relationships that it was part of. However, the delete()
function would not remove the Card objects to which the Router instance shares a “ComposedOf”
relationship.


Consider using the remove() operation, if one exists, instead for a more complete action. For example,
calling remove() on a Router will cause the Card objects it is composed of to be removed (which in turn
could cause the Ports/Interfaces to be removed, and so on).
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notify


$obj->notify( $event_name );


Notifies the specified event for the object.


 $objref->notify( "Unresponsive" );


clear


$obj->clear( $event_name );


Clears the specified event for the object.


 $objref->clear( "Unresponsive" );


countElements


$count = $obj->countElements( $relation )


Counts the number of elements in the given relationship. The countElements method will throw an error if
$relation is not a relationship.


 $count = $obj->countElements( "ComposedOf" );


Overview
The InCharge::object module provides the interface to Domain Manager repository objects. With it you
can:


n Get or set an object’s attributes


n Invoke an object’s operations


Name
InCharge::object
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Synopsis


use InCharge::session;


$obj = $session->object( $class, $instance );


$value = $obj->get( "PropertyName" );


$value = $obj->{PropertyName};


$obj->put( "PropertyName", $value );


$obj->{PropertyName} = $value;


$rtn = $obj->invoke( "OperationName", .. arguments .. );


$rtn = $obj->OperationName( .. arguments .. );


The InCharge::object module allows objects in the Domain Manager repository to be manipulated in an
object-oriented style, similar to the ASL language.


Description
An InCharge::object reference is required to access the properties or methods of a Domain Manager
object. This reference is returned from the object() or create() methods of the InCharge::sessionmodule.
Both methods allow access to preexisting objects, but the create() method will also create the object if it
does not already exist. While create()always accesses the Domain Manager, object() may or may not
depending on the invocation technique.


 $obj = $session->object( "Router", "edgert1" );


 $obj = $session->object( "Router::edgert1" );


 $obj = $session->create( "Router", "newrouter" );


If you do not know the class to which an object belongs, you can either use a class argument of undef, or
a string with nothing before the double-colon (::). For example,


 $obj = $session->object( undef, "edgert1" );


 $obj = $session->object( "::edgert1" );


The option of omitting the class name does not work with the InCharge::session->create() method
because the Domain Manager cannot create an object without knowing which class to use. It does work
with InCharge::session->object() and related calls because the process of referring to an existing instance
can legitimately include a query to identify the object's class.


Note   If you choose not to provide the class name in these calls, the API does additional work to
determine the object's class, which imposes a slight performance penalty.
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Once an object reference has been created, it can be used to invoke the object's operations or access its
properties. Access to an object's attributes or properties can be obtained by using calls shown in the
following example.


 $vendor = $obj->get( "Vendor" );


 $vendor = $obj->{Vendor};


 ($vendor,$model) = $obj->get( "Vendor", "Model" );


 %properties = $obj->get( );


 $obj->put( "Vendor", "Cisco" );


 $obj->{Vendor} = "Cisco";


 $obj->put(Vendor => "Cisco", Model => "2010" );


These examples show that object properties can be accessed by using either the get() and put() methods
or the psuedo-hash syntax. The latter syntax is preferred because it is closer to the original built-in ASL
language logic.


Two special internal properties can be accessed by using the hash syntax only. These give the name of
the class and instance to which the object reference refers. Treat them as read-only fields.


 $obj->{_class}           BUT NOT: $obj->get("_class")


 $obj->{_instance}        BUT NOT: $obj->get("_instance")


Object operations can be invoked by using the invoke() method, or directly, as in the example:


 @ports = $obj->invoke( "findPorts" );


 @ports = $obj->findPorts();


 $port = $obj->


  invoke( "makePort", "1.0", "PORT-rt1/1.0", "Port" );


 $port = $obj->makePort( "1.0", "PORT-rt1/1.0", "Port" );


Again, the latter syntax, calling the operation directly, is preferred.


Use the invoke() method to access an object operation that duplicates the name of any of the built-in
methods of the InCharge::object class.


n The first of these calls the new()operation of the object in the repository.


n The second calls the built-in new() method of the InCharge::object class.


 $obj->invoke( "new", "qtable" );


 $obj->new( "qtable" );


Note that InCharge::object is used for accessing ICIM instance operations and properties only. If you
make other ICIM calls that refer to instances, such as subscribe(), use the features of
InCharge::session directly. The following line of code is invalid:


 $obj->propertySubscribe( "Vendor" );


Instead, use one of the following:
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n The first alternative:


 $session->propertySubscribe($class, $instance, "Vendor");


n The second alternative:


 $session->propertySubscribe( $obj, ``Vendor'' );


The reason you have to use one of these two alternative methods is because the propertySubscribe
is not a repository class operation, but rather it is a primitive.


 dmctl -s <domain> getOperations <classname> | more


Likewise, to determine what properties can be accessed by using the InCharge::object module use:


 dmctl -s <domain> getProperties <classname>
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InCharge::Session 3
This chapter includes the following topics:


n Overview


n Function groups


n Error handling


n Session management functions


n Utility functions


n Specifying the locale while connected


n Retrieving and setting log, error and trace levels at runtime


n Wrapper functions


Overview
The InCharge::session module provides the interface to Domain Managers. With it you can:


n Attach to a Domain Manager


n Create and destroy objects


n Invoke operations


n Subscribe to Domain Manager events


Name
InCharge::session


Synopsis


 use InCharge::session;
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There are three different syntaxes that you can can then choose from to connect to the Domain Manager:


n $session = InCharge::session->init( );


n $session = InCharge::session->new( "INCHARGE" );


n $session = InCharge::session->new(


broker=>"localhost:426",


domain=>"INCHARGE",


username=>"noddy",


password=>"bigears",


traceServer => 1


locale=>”en_US”


);


 $object = $session->object( "Host::toytown1" );


 $object = $session->create( "Router::crossroads" );


(... and continuing with the methods described in the following sections...)


Description
This module provides the mechanisms for accessing a Domain Manager in a manner that is similar to that
employed by the ASL language. It provides the main access point to domains, allowing scripts to
establish client/server connections and to obtain InCharge::object references that can be used to
manipulate the objects in the topology.


The locale argument to the InCharge::session module allows you to set the locale of the session (the
client locale).


Note   You can use the InCharge::session->setLocale() method to change the locale for the session,
while it is connected.


The default locale to set for a Perl client is determined by looking in the following places.


1 The value of the SM_LOCALE environment variable.


2 The default isen_US.


Chapter 1, Introduction, provides an overview of this and the other InCharge::* modules and a simple
tutorial description of how they are used.


Function groups
InCharge::session provides access to five kinds of functions: session management, Domain Manager
primitives, utility, wrapper, and locale specification.
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Session management functions
Functions in this group are the principle functions of the module. They are used for managing the Perl
client/Domain Manager connection. You can use these functions within a script to attach, detach, listen for
events, and create InCharge::object references.


Domain Manager primitive functions
The InCharge::session module permits access to the low-level primitive functions of the Domain Manager,
allowing actions such as getClasses() and getInstances() to be performed. These primitives do not all
exactly mirror the interface provided by dmctl or the native ASL language. For example, dmctl has a save
command that does not have an exact primitive equivalent, but there are two primitives that can be
invoked to give the same results. These are storeClassRepostity() and storeAllRepository(). Where
primitives exist that semantically match dmctl or ASL commands but differ in name, aliased names are
provided to give syntactic compatibility.


Utility functions
This group includes functions to provide additional logical assistance to writers of Perl scripts to be used
with the SDK software.


Wrapper functions
This group of functions provides wrappers around the primitives to provide an interface that is more
consistent with the SDK native ASL language and dmctl utility.


Wrapper functions of this type are provided only for functions where the syntax and semantics of the
primitive are not compatible with ASL or dmctl. The save example, described in Domain Manager
primitive functions, is one such function.


Specifying the client locale
The InCharge::session module provides a function that enables you to set the locale of the session (the
client locale).


Error handling
Errors are reported back to the invoking script by using Perl's die mechanism, and can be caught by using
Perl’s eval function. This is typical Perl coding practice and mimics the try-throw-catch logic of Java and C
++. Error handling provides further information.


Session management functions
The following session management functions are provided.
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new


$session = InCharge::session->new( .. options .. );


The new function first establishes a connection between the calling Perl script and a Domain Manager. It
then returns a tied reference that can be used thereafter to manipulate the domain and the entities
contained in its repository.


If the domain name is the sole option passed, it can be specified without the domain=> key.


The username and password options are required if connecting to a server with authentication features
enabled. If neither of these arguments is given, the clientConnect.conf file is used to determine the
username and password or the mechanism to obtain them.


Option to specify the Broker


broker => $host[:$port]


This option specifies the Broker from which the domain details are to be lifted. The string consists of a
hostname or IP address followed by an optional port number, delimited by a colon. The section 
Conventions for specifying IPv6 addresses describes how to specify an IPv6 address.


The default host is localhost, and the default port is 426.


Option to specify the domain
This option specifies the name of the domain to be used. If the host and port details are also given, then
the API does not refer to the broker to determine them. The default domain name is INCHARGE.


There are two different syntaxes that can be used to specify the domain:


n domain => [$host:$port/]$domain


n server => [$host:$port/]$domain


Note   The option name “server” can be used in place of “domain” and the two options have the same
meaning.


Option to specify the username
This option specifies the name of the user to be used in connecting to the domain. If user or username is
specified, then password must also be specified, as described in Option to specify the password. If the
username is not given, then the API refers to the clientConnect.conf file to determine the authentication
information to use when establishing the connection.


There is no default username.


There are two different syntaxes that can be used to specify the username:


n user => $user_name
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n username => $user_name


If no username is specified, the script inspects and interprets the SM_AUTHORITY environment
variable in the same way that the main SDK software does and may prompt the user for the
username and password by using the standard I/O device.


Option to specify the password
This option specifies the password for the user given with the username option.


password => $password


Option to specify a description of the script
This option describes the role of the script and is noted by the Domain Manager for use in debug and
other logging messages. Its contents are not significant, otherwise. The default is Perl-Client.


description => $description


Option for specifying server-level tracing
If this option is specified and given a true value, non-zero, then server-level tracing is turned on. This
causes the Domain Manager to log information about every primitive call invoked by the script.


Note   When server-level tracing is turned on, it results in a large amount of data written to the server's
log file.


It is recommended to use this sparingly since it also has a negative impact on the Domain Manager's
performance.


traceServer => 1


Option for specifying response timeout
This option specifies the timeout to be enforced while waiting for responses from the Domain Manager to
primitive requests. The default value is 120 seconds. You may increase the value, if necessary, but do not
set it to a value below 120 seconds. Otherwise, slow to-process requests will fail in a manner that looks
like a communication link failure between the script and the Domain Manager.


timeout => $timeout


Option for specifying the session locale
The locale option allows you to set the locale of the session (the client locale).


locale=>locale
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init


$session = InCharge::session->init( );


This funtion is the simplified version of InCharge::session->new(). It parses the script’s command line,
looking for options that specify the Broker, Domain Manager username, password, trace, timeout, and
locale options. Then it invokes the primitive InCharge::session->new() with those arguments and passes
back the result.


InCharge::session->init() looks for the following script command line arguments.


 --broker=<brokerIP[:bokerPort]>   (also: -b)


 --server=<domain-name>            (also: -s)


 --user=<username>                 (also: -u)


 --password=<password>             (also: -p)


 --traceServer


 --timeout


 --locale=<locale>


If neither the --user (or -u) and --password (or -p) are specified, the script makes use of the
SM_HOME/conf/clientConnect.conf file to determine the username and password to be employed.
Comments are included in the file for detailing this mechanism. This mechanism is turned on by
specifying the value <STD> for the SM_AUTHORITY environment variable.


If the InCharge::session->init() functions encounters a command line syntax error, it calls usageError, in
the main script, which the developer must provide. A single large text string that contains a description of
the standard options handled is passed as the argument to usageError, which enables the author to
include information about the standard options as well as any nonstandard ones provided. If the
usageError subroutine does not exist, a default error message is printed on STDERR.


Note that the init() function consumes (removes) the command line arguments it handles from @ARGV
as it processes them. Therefore you can access the @ARGV array after its execution to process
additional arguments without needing to skip the standard ones. However, you cannot use the init
command twice in the same script without first saving and restoring the contents @ARGV, as in the
example:


 @SAVE = @ARGV;


 $session1 = InCharge::session->init( );


 @ARGV = @SAVE;


 $session2 = InCharge::session->init( );


The locale argument to the InCharge::session init method allows you to set the locale of the session (the
client locale).


Note   You can use the InCharge::session->setLocale() method to change the locale for the session,
while it is connected.
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The default locale to set for a Perl client is determined as follows:


1 The value of the SM_LOCALE environment variable.


2 If the SM_LOCALE variable is not set, then the default isen_US.


broken


$flag = $session->broken( );


The broken() function returns non-zero (TRUE) if the session with the Domain Manager is broken in some
way.


A return value of non-zero indicates connection or protocol failures. To continue working with a broken
session, the script should call the reattach() function, and then reestablish the event subscription profiles
required.


reattach


$session->reattach( );


Reestablishes a connection that has been detached or broken.


The reattach() function can be called to reconnect to a server to which the connection has been lost.
Reestablishing the connection does not automatically reestablish observer sessions, subscriptions,
transactional or other session state information.


If the call is used to reattach a session that had an active observer, the observer connection is closed as
a side effect of the action and must be reopened separately.


This function should be called after a [13] I/O Error is thrown by any of the Domain Manager access calls
in order to shut down and reopen the socket, leaving the session in a working state. If this step is not
taken, there is a danger that residual packets on the connection would cause synchronization problems
between the client and Domain Manager. Error handling describes error prefixes, including the [13] prefix.


Note   The reattach() primitive does not return a new session identifier, but does refresh the referenced
one. This is not a dup() style of action.


detach


$session->detach( );


The detach() function enables you to detach from the domain referred to by $session.


This function can be used for either a session, created using InCharge::session->new(), or an observer
session, created using InCharge::session->observer().


If this is used to detach a session with an active observer, the observer is also closed.
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This call does not completely destroy the $session reference contents but retains enough information to
allow the session to be reestablished. Thus, it is possible to call $session->reattach() to reconnect to the
Domain Manager by using the same parameters as were used in the initial connection. However, the
event subscriptions need to be reestablished explicitly in this event.


observer


$observer_session = $session->observer( .. options .. );


The observer() function creates and returns a reference to a connection to a Domain Manager on which
subscribed events can be received.


This establishes a new socket between the client and Domain Manager. Once connected, events can be
subscribed to by using the various subscribe methods, and they can be received by using:


 @event_info = $observer_session->receiveEvent( );


Specifying the option connectEvents => 1 to the observer() function causes server disconnection to be
notified as a DISCONNECT event rather than an [13] I/O Error. However, unlike ASL, the reconnection is
not performed automatically. The script can use the $session->reattach() call to attempt an explicit
reconnection and must then reestablish any event subscriptions and other contexts.


Specifying the option ignoreOld => 1 causes events generated before the connection was established to
be discarded automatically. The use of this option is not generally recommended since the atomicity of
time measurement on UNIX makes its results somewhat unpredictable.


Repeated calls to the observer() method of a session return references to the same observer. It is not
possible to create multiple observers on the same session.


receiveEvent


@event = $observer_session->receiveEvent( [ $timeout ] );


Listen for subscribed events from the Domain Manager.


The received events are returned as an array or, in scalar context, a reference to an array containing
three or more elements. “Event subscription” on page 22 describes the different events to which you can
subscribe.


The first element of all events is the timestamp, on the Domain Manager's system clock, and not the
client's clock. The second element is a string defining the event type. The other elements are event-
specific.


The $timeout is optional, and specifies a timeout period, in seconds, that the script is prepared to wait for
an incoming event. If no event arrives in this time period, an event of type TIMEOUT is returned. The
$timeout can be specified in fractions of a second, or “float”; for example, 0.25 = a quarter second.


VMware Smart Assurance Perl Reference Guide


VMware, Inc.  33







object


$obj = $session->object( $objectname );


Creates a new InCharge::object reference that can be used to invoke methods of the InCharge::object
module.


As an example, to obtain the value of the Vendor field for a particular object, use:


 $obj = $session->object( "::gw1" );


 $vendor = $obj->{Vendor};


You can even combine these into a single line, such as:


 $vendor = $session->object( "::gw1" )->{Vendor};


The $objectname parameter can be specified in any of the styles shown in the following examples:


n object( 'Router::gw1' )


In this example, the $objectname parameter is a single string where both the class and instance
names are specified with double colons (::) delimiting them. If variables are to be used to specify the
relevant parts of the string, then it is important that at least the variable before double-colon (::) is
encased in braces because without them, Perl will give the (::) characters its own meaning.


n object( 'Router', 'gw1' )


In this example, the $objectname parameter is specified as two strings with one for the class and one
for the instance name.


n object( '::gw1' )


In this example, the $objectname parameter is specified as one string with the class name missing.
The API will make a query to the Domain Manager to discover the actual class for the object which
causes a minor performance penalty.


n object( undef, 'gw1' )


In this example, the $objectname parameter is specified as two parameters with the first one
undefined. This also results in the API performing a Domain Manager query.


n object( 'gw1' )


In this example, the $objectname parameter is specified as a single parameter that does not include
the double-colon (::) delimiter, which must contain just the instance name. A Domain Manager query
is performed to determine the relevant class name.
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An important difference between the API and the native ASL language is that if you create an object,
using object(), in native ASL without specifying the class name, the language assumes that the class
MR_Object can be applied. This restricts the level of property and operation access that can be used.
The API queries the repository to determine the actual class for the instance, giving complete access
to the resulting object's features.


create


$obj = $session->create( $objectname );


Similar to the object() call, described in object, the create() call creates an InCharge::object valid
reference through which a specified instance can be manipulated. However, unlike object(), the create()
method creates the object if it does not already exist.


Since it has the ability to create objects, it is important that the object name specified as an argument
includes both the instance name and the class name. You cannot use the ::instance or (undef, $instance)
syntaxes for specifying the object name. You can, however, use either the Class::Instance or ($class,
$instance) syntax described for the object() method.


Unlike the createInstance() primitive, it is not an error to call the create() method for an object instance
that already exists. In this case, the call is equivalent to the $session->object() call and it simply returns
the InCharge::object valid reference to the instance.


callPrimitive


RESULT = $session->callPrimitive($primitiveName, @arguments)


Calls the specified Domain Manager primitive, passing the primitive the arguments and returning its
result.


Note   For most primitives, this is a complex invocation sequence. However, it is only actually needed
when a primitive and a method of the InCharge::session module share the same name, and you wish to
use the primitive version.


The following are equivalent, although the first is preferred.


 @list = $session->getInstances( "Router" );


 @list = 


  $session->callPrimitive("getInstances", "Router");


The put() primitive is one of the few primitives where these two ways of calling it are not equivalent. This
is because the InCharge::session module exports its own variant of the method. If you must gain access
to the primitive version, you will need to use the callPrimitive() mechanism. However, this is not
recommended, since the syntax is complex. The put provides further details.
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The type of the RESULT in array or scalar context is dependant on the primitive that is being called. In
general:


n If the primitive returns a scalar you get a scalar or, in array context, a single element array.


n If the primitive returns an array you get an array, in array context, or array reference, in scalar context.


Utility functions
The following utility functions are provided.


TYPE


$number = $session->TYPE( $string );


$string = $session->TYPE( $number );


The TYPE() function converts a Domain Manager data type symbolic name to its internal numeric code,
or converts an internal numeric code to its symbolic name. So the following prints “13”:


 print $session->TYPE( "STRING" ) . "\n”;


The following code prints “STRING”:


 print $session->TYPE( 13 ) . "\n”;


getFileno


$fno = $session->getFileno( );


The getFileno( ) function returns a number that refers to the socket used for the script/server connection.


Note   Do not use this function with the Perl select statement to listen for events from multiple domains
by using multiple observer objects. Instead, use the new select function: InCharge::session::select.


getProtocolVersion


$ver = $session->getProtocolVersion( );


The getProtocolVersion( ) function returns the protocol version number supported by the
Domain Manager. This is a single integer number derived by the following calculation.


 ( major * 10000 ) + (minor * 100) + revision


Hence, version “V5.1” is represented by the number 50100, and version “V4.2.1” is represented by
40201.
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primitiveIsAvailable


$boolean = $session->primitiveIsAvailable( $primitive_name )


The primitiveIsAvailable() function checks whether the named primitive is available in the
Domain Manager.


A value of 1 means that it is available, and value of 0 means that it is not available, either because it is an
undefined primitive or it was introduced in a later version of the Domain Manager software.


 if ( $session->primtiveIsAvailable (


    "getMultipleProperties" ) {


  $vendor, $model ) = $session->getMultipleProperties (


     $obj, [ "Vendor", "Model" ] );


 } else {


  $vendor = $obj->{Vendor};


  $model = $obj->{Model};


 }


select
@ret = InCharge::session::select(\@observerList, $timeout);


The select() function checks if there are data to be read for each observer in @observerList.


@ret returns a list of handles in which the value:


n 1 represents that the observer has data to read


n 0 indicates that there are no data to be read.


The $timeout parameter indicates how many seconds the function select should wait before returning
the result. It can be called with an undef value for no wait time.


Example of usage:


@ret = InCharge::session::select(<ref_list>,<timeout>);


where:


n <ref_list> is a reference to the list of observers that will be checked.


n <timeout> is the number of seconds to wait before returning. For immediate return, use the argument
undef.


The following script returns an array with the result for each checked observer.


use InCharge::session;


use Data::Dumper;


my %common = ( user => "admin", password => "changeme");


$mask = "";


$i=0;


foreach $dom ( "INCHARGE-AM", "INCHARGE-SA" ) {
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 $sess{$dom} = InCharge::session->new( %common, domain => $dom );


 $obs{$dom} = $sess{$dom}->observer( );


 @obsList[$i]= $obs{$dom};


       $sess{$dom}->subscribe( ".*::.*::.*/pa" );


 #$fn{$dom} = $obs{$dom}->getFileno()."\n";


 #vec($mask, $fn{$dom}, 1) = 1;


 $i++;


}


$i=0;


for ( ; ; ) {


       $i=0;


 @obsRet = InCharge::session::select( \@obsList, undef);


 foreach $obsR ( @obsRet ) {


  #next unless (vec($rout, $fn{$dom}, 1));


  @event = $obsR->receiveEvent( );


  print "$obsR->{domain} - ".join( ", ", @event ). "\n";


  $i++;


 }


}


Specifying the locale while connected
The setLocale() method may be used to indicate the locale in which text will be returned to the client for
the session, while it is connected.


If the locale has not been set for the session while connecting or the setLocale() method has not been
called, then the session locale is determined as follows:


1. The value of the SM_LOCALE environment variable.


2. The default is en_US.


Retrieving and setting log, error and trace levels at
runtime
There are three computed attributes available to get and set the log, error, and trace levels of a
Domain Manager at runtime. These computed attributes, described in Computed attributes to retrieve and
set log, error, and trace levels at runtime, are available on the SM_System object.


Table 3‑1.  Computed attributes to retrieve and set log, error, and trace levels at runtime


Computed Attributes Description


logLevel The minimum exception level for sending messages to the system error logger.The logLevel
attributeis a string, and can be any one of the values set for the --loglevel command line option:


errLevel The minimum exception level for writing messages to the log files. The errLevel attributeis a string,
and can be any one of the values set for the --errlevel command line option.


traceLevel Used to print a stack trace to the SDK log file when an exception at this level or above occurs.
Exceptions below this level do not write a stack trace. The traceLevel attributeis a string, and can
be any one of the values set for the --tracelevel command line option.
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The values of these computed attributes can be retrieved and set, and valid values are:


n None


n Emergency


n Alert


n Critical


n Error


n Warning


n Notice


n Informational,


n Debug


Note   Fatal is a synonym for Critical.


Retrieving the current level
You can retrieve the current levels of SM_System::SM-System::logLevel, SM_System::SM-
System::errLevel, or SM_System::SM-System::traceLevel. A string is returned which represents the
current level, such as "Warning", "Error", or "Fatal". For example:


my $smsystem = $session->object("SM_System","SM-System");


my $curr_error_level = $sm_system->{errLevel};


Setting the level
To change the current levels, obtain a pointer to the object, and then set the value of SM_System::SM-
System::logLevel, SM_System::SM-System::errLevel, or SM_System::SM-System::traceLevel to the
appropriate level.


In this example, the trace level setting is changed to None.


my $smsystem = $session->object("SM_System","SM-System");


$sm_system->{traceLevel} = "None";


When you change the log, error or trace levels a message is printed in the log file. The log message will
appear similar to the following:


[April 8, 2009 5:03:41 PM EDT +122ms] t@1149000000 SM_ProtocolEngine-6


JM_MSG-*-JM_TRACE_LEVEL_CHANGED-User 'user1', using remote dmctl client (id 6), on host host1 with 


credentials tpadmin1 has changed the Trace level to None; in file 


"/mypath/repos/jiim/SM_JIIM_Support_Impl.c" at line 458
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Wrapper functions
The following functions add varying degrees of wrapper logic round the SDK primitives, to make them
more compatible with the native ASL language.


save


$session->save( $filename [, $class ] );


The save() function saves the repository in the specified file. If a class name is specified, then only the
instances of that class are saved.


put


$session->put( $object, $property, $value );


It is not recommended that the put() method be used extensively. Instead, use the features of
InCharge::object.


This method changes the value of an object property. This version differs from the put_P() primitive in that
the latter requires the value type to be specified explicitly, whereas this version determines and caches
the type. The following calls are, therefore, equivalent, although the first is preferred.


 $obj = $session->object( "Router::gw1" );


 $session->{Vendor} = "Cadbury";


 $obj->put( "Vendor", "Cadbury" );


 $obj->put( Vendor => "Cadbury" );


 $session->put( "Router::gw1", "Vendor", "Cadbury" );


 $session->object( "Router::gw1" )->{Vendor} = "Cadbury";


 $session->callPrimitive( "put_P", "Router", "gw1",


    "Vendor",[ "STRING", "Cadbury" ] );


When giving a value to an array property, such as the ComposedOf relationship, pass an array reference
as shown in the following example:


 $obj->{ComposedOf} = [


 "Interface::IF-if1",


 "Interface::IF-if2"


 ];
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Also, you can set more than one property in a single call. This can reduce complexity in the script layout
but has minimal performance advantage.


 $obj->put(


  Vendor   => "CISCO",


  Model    => "2500",


  Location => "Behind the coffee machine"


 );


invoke


RESULT = $session->invoke($object, $operation[, @arguments]);


It is not recommended that this method be used extensively. Instead, use the features of
InCharge::object.


This method invokes the specified object operation, passing it the listed arguments and returning the
RESULT.


The type of the RESULT depends on the usual Perl concept of array or scalar context, as well as the
definition of the operation being called. In general:


n If it returns a scalar you get a scalar or, in array context, a single element array.


n If it returns an array you get an array, in array context, or array reference, in scalar context.


Note   This method's semantics and syntax differ from the primitive method invokeOperation() in that
the latter needs to have the types of the arguments specified explicitly. Whereas for this method, the
InCharge::session module version discovers and caches the operation argument types and does not
require the arguments to be listed in arrays of array references.


Additional documentation about the operations that exist for a particular class can be obtained by
using the dmctl utility, as shown:


dmctl -s DOMAIN getOperations CLASSNAME


The following examples are equivalent; the first example is preferred.


n Example 1:


 $obj = $session->object( "Router::gw1" );


 $fan= $obj->findFan( 2 );


n Example 2:


 $fan = $session->invoke( "Router::gw1", "findFan", 2 );
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n Example 3:


 $fan = $session->callPrimitive( "invokeOperation","Router", "gw1", "findFan",[ [ "INT", 2 ] ]


 );


invoke_t


($type, $value) =


  $session->invoke_t( $object, $operation [, @arguments]


);


The invoke_t() function is identical to invoke() except that the return indicates both the type and the value
of the returned data.


The value is a Perl scalar, if the operation returns a scalar, or an array reference, if the operation returns
an array. The type will contain one of the Domain Manager internal type codes. For example, “13” is the
code for a string.


findInstances


@instances =


  $session->findInstances( $c_patn, $i_patn [, $flags] )


or


@instances =


  $session->findInstances( "${c_patn}::${i_patn}" [, $flags] )


Finds instances that match the class and instance patterns, according to rules specified in the flags.


The $flags is a set of characters that modifies the way the call works.


A flag of “n” means that subclasses are not recursed into. Therefore, instances in matching classes only
are returned. Without “n”, instances of matching classes and their subclasses are returned.


A flag of “r” means that UNIX-like RegEx matching is used during the search. If the “r” flag is not
specified, the search uses glob pattern matching.


Note   The RegEx version that is supported is the UTF-8 and Unicode regexp compliant engine (coming
from ICU).


The default is no flags, therefore, the search uses glob pattern matching and recursion.


Results are returned as a list of strings, each of which contains a class and instance name delimited with
double-colon (::).


Note   The search strings are anchored as if the “^” and “$” had been used in the UNIX-style pattern.
Therefore, “rr*” matches “rred” but not “herring”, whereas “`*rr*” matches both of them.
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Example:


 @found = $session->findInstances( "Router::gw*", "n" );


getCauses


@events =  $session->getCauses( $objectname, $event [, $oneHop] );


The getCauses() function returns a list of problems that cause an event.


The function arguments are class, instance (possibly combined into one, for example, SM_System::SM-
System), and event. The function returns the problems that cause the event based on the relationships
among instances defined in the Domain Manager.


The oneHop parameter is optional:


n If it is omitted or passed as FALSE, the full list of problems that explain eventname, whether directly
or indirectly, is returned.


n If it is passed as TRUE, only those problems that directly list eventname among the events they
explain are returned.


The function returns an array of array references with the format:


 [


  [ <classname::instancename>,<problemname> ],


  [ <classname::instancename>,<problemname> ],


  ...


 ]


Example:


 @causes =


  $session->getCauses( "Router::gw1",


    "MightBeUnavailable"


 );


getClosure


@events =   $session->getClosure($object, $eventname[, $oneHop]);


The getClosure() function returns a list of symptoms associated with the problem or aggregate based on
the relationships among instances defined in the Domain Manager.


The oneHop parameter is optional:


n If it is omitted or passed as FALSE, the full list of problems that explain eventname, whether directly
or indirectly, is returned.
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n If it is passed as TRUE, only those problems that directly list eventname among the events they
explain are returned.


The function returns an array of array references with the format:


 [


  [ <classname::instancename>,<problemname> ],


  [ <classname::instancename>,<problemname> ],


  ...


 ]


Example:


 @symptoms =


  $session->getClosure( "Router::gw1", "Down", 0 );


getExplains


@events =  $session->getExplains($object, $eventname[, $onehop ]);


MODEL developers can add information to a problem in order to emphasize events that occur because of
a problem. The getExplains() function returns a list of these events.


The $onehop parameter is optional:


n If it is omitted or passed as FALSE, the full list of problems that explain $eventname, whether directly
or indirectly, is returned.


n If it is passed as TRUE, only those problems that directly list eventname among the events they
explain are returned.


The function returns an array of array references with the format:


 [


  [ <classname::instancename>,<problemname> ],


  [ <classname::instancename>,<problemname> ],


  ...


 ]


getExplainedBy


@events =   $session->getExplainedBy($object, $event[, $onehop ]);


The getExplainedBy() function is the inverse of the getExplains() function.


It returns those problems (or events) which the MODEL developer has listed as explaining this event.


The $onehop parameter is optional:


n If it is omitted or passed as FALSE, the full list of problems that explain $event, whether directly or
indirectly, is returned.
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n If it is passed as TRUE, only those problems that directly list $event among the events they explain
are returned.


The function returns an array of array references with the format:


 [


  [ <classname::instancename>,<problemname> ],


  [ <classname::instancename>,<problemname> ],


  ...


 ]


subscribe and unsubscribe


$session->subscribe( $C, $I, $E [, $flags ] );


$session->subscribe( "$C::$I::$E[/$flags]" );


$session->unsubscribe( $C, $I, $E [, $flags ] );


$session->unsubscribe( "$C::$I::$E[/$flags]" );


These functions subscribe, or unsubscribe, to notifications of the specified events. “$C”, “$I”, “$E” must be
regexp patterns that represent the classes, instances, and events to which to subscribe.


The unsubscribe() function is the inverse of subscribe().


The $flags value is a bitwise combination of the values or a more mnemonic string as shown in 
Subscription flag parameter values


Table 3‑2.  Subscription flag parameter values


Flag bitfield value Description


0x000001 Simple event


0x000002 Simple aggregation


0x000010 Problem


0x000020 Imported event


0x000040 Propagated aggregation


0x0000ff All


0x001000 Expand subclasses


0x002000 Expand subclasses events


0x004000 Expand aggregations


0x008000 Expand closures


0x010000 Sticky


0x020000 Undo all


0x040000 Quiet accept


0x080000 Quiet suspend


0x100000 Glob
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As a compatibility aid, the $flag can also be specified as a string of letters. In this case, each of the letters
are subscription qualifiers:


n “p” means subscribe to problems


n “a” means subscribe to aggregates (impacts)


n “e” means subscribe to events.


Note   If “p”, “a” or “e” are not present, “p” is assumed.


n “v” means run in verbose mode, which turns on subscription control messages.


The action of these options is the same as that provided by the sm_adapter program’s --subscribe=
option.


Examples:


 $session->subscribe( "Router", ".*", ".*", "/pev" );


 $session->subscribe( "Router::.*::.*/peav" );


 $session->subscribe( $obj, ".*", 0x3 );


 $session->unsubscribe( $obj, ".*", 0x3 );


transaction, abortTxn and commitTxn


$session->transaction( [ $flag ] );


$session->abortTxn( );


$session->commitTxn( );


These functions start, commit, and abort transactions.


Using transactions, you can commit many changes to the objects in a Domain Manager as a single
atomic transaction, or choose to abort all of them. Use the following syntax to create a transaction:


 $session->transaction();


After initiating the transaction, every change made to an object does not affect the object until you commit
the transaction. If the transaction is aborted, any changes made will not affect the object. Use the
following syntax to either commit or abort a transaction.


 $session->commitTxn( );


or


 $session->abortTxn( );


The changes made with a transaction are not visible outside of the script until the changes are committed.
Within a transaction, the same script can see the proposed changes. Transactions also can control how
other applications see objects before changes are committed or aborted by adding a single keyword.
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The syntax of a transaction with a keyword is:


 $session->


  transaction(["WRITE_LOCK"|"READ_LOCK"|"NO_LOCK"]);


A keyword can be any one of those described in Transaction lock options.


Table 3‑3.  Transaction lock options


Keyword Description


WRITE_LOCK While the transaction is open, no other process can modify or access information in the repository.


READ_LOCK The behavior of READ_LOCK is the same as WRITE_LOCK.


NO_LOCK This is the default behavior. No locks exist until the script commits the transaction.


Transactions may be nested. When you nest a transaction, you must commit or abort the nested
transaction before you commit or abort the previous transaction.


The API aborts any open transactions when the script terminates.


Example:


 #! /usr/local/bin/Perl


 $session = InCharge::session->init( );


 $delthis = shift @ARGV;


 $delthisObj = $session->object($delthis);


 @relObj = @{ $delthisObj->{ComposedOf} };


 $session->transaction();


 $x = $delthisObj->delete();


 foreach $mem (@relObj) {


  $mem->delete();


 }


 $session->commitTxn();


 print("Deleted ".delthis." and related ports\n”);


In the example, the script deletes a card and its related ports. The script is invoked with an argument that
specifies the card to delete. Using the ComposedOf relationship, the script creates a list of port objects to
delete. The script deletes the card and its related ports at the same time through a transaction that
ensures that no other script can see the intermediate stage with an incompletely deleted suite of objects.


delete


$session->delete( $object );


The delete() function deletes the specified object instance from the repository.


Note   This does not clean up all the object interdependencies and links. For a cleaner object deletion,
use the remove() operation, if one exists, for the object class in question. The section invoke also
provides additional information to the related invoke() primitive.
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The delete() method can be called in one of two ways.


 $session->delete( $object );


or


 $object->delete();


getEventType


$type = $session->getEventType( $class, $event );


Given a class and event name, the getEventType() function returns a string that describes the type of the
event. The possible strings returned are described in Event types.


Table 3‑4.  Event types


Event type literal Description


EVENT Event


AGGREGATION Aggregation


SYMPTOM Symptom


PROBLEM Problem


UNKNOWN Error indication


Example:


 $type = $session->getEventType( "Router", "Down" );


To obtain the low-level numeric type codes, instead of descriptive strings, use the getEventType()
primitive, as shown.


$type = 


 $session->primitive( "getEventType", "Router", "Down" );


getServerName


$session->getServerName( );


The getServerName() function returns the name of the Domain Manager to which the session is
connected.


insertElement


$session->insertElement( $object, $relation, @item[s] );
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The insertElement() function inserts one or more elements into an object relationship.


It is suggested that the insertElement() feature of the InCharge::object module be used instead, as
shown.


 $obj->insertElement( $relation, @item[s] );


removeElement


$session-E>removeElement( $object, $relation, @item[s] );


The removeElement() function removes one or more elements from an object relationship, such as
ComposedOf.


It is recommended that the removeElement() feature of the InCharge::object module be used instead, as
shown.


 $obj->removeElement( $relation, @item[s] );
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Primitives 4
This chapter includes the following topics:
n Primitive naming conventions


n Primitive calling conventions


n Error handling


n Error codes


n Data types


n Primitives


Primitive naming conventions
The Domain Manager primitives are low-level remote calls that are supported by the API. These
primitives provide the standard protocol between client applications, such as dmctl, ASL adapters, API
scripts, and the Smarts Console, and the Domain Manager.


Name
InCharge::primitives


Conventions
The names given to the primitives follow a convention of using lowercase, except for the first letter of the
second and subsequent words of multiword names. For example, to get operation arguments, the name
of the primitive is getOperationArguments.


Where the resulting names are overly long, the API provides shorter aliases; getOperationArguments()
has the alias getOpArgs(). Typically, the word “Operation” is shortened to “Op”, and “Property” is
shortened to “Prop”, however, both the long and shortened name can be used. Both forms are described
in the following sections.


Since primitives are designed to be called by using the InCharge::session, where a primitive name
conflicts with a module function, the name of the primitive has the string “_P” concatenated onto it in order
to differentiate the two. Script authors are discouraged from using these “_P” versions since higher-level
versions are available through InCharge::session and, in some cases, InCharge::object that are easier to
use.
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Where a primitive returns a value that may be of any type, a second version of the call is provided that
returns both the numeric type code and the return value. The name of this extended version is the same
as the lesser original but with “_t” appended. You can also specify “_T” instead of “_t”, in which case when
the primitive returns an ANYVAL_ARRAY_SET (that is, a structure of structures), the fields of the
structures are also accompanied by their types. This is a reference to a two-element array containing type
and value for each structure field.


The primitive names are similar to those used in the C++ API. Where the names do not match those used
by ASL or dmctl, aliases are provided. For example, the ASL command getInstances() is called getLeaf
Instances() in the C++ API. Therefore, the API allows both names to be used. The C++ name is the name
used for the actual primitive and the ASL name is provided as an alias.


The C interface for VMware Smart Assurance software, on the other hand, uses function names that look
like sm_property_unsubscribe(). They start with “sm_” and use all lowercase words delimited by
underscores. This set of functions is less complete than the C++ equivalent interface and does not
provide a one-to-one match of all the Domain Manager primitives. The API for Perl does not provide a
match for the C interface function names.


Primitive calling conventions
All the functions described in this document must be invoked with reference to a valid object of the
InCharge::session module. These object references are created by using InCharge::session->object(),
InCharge::session->create(), or InCharge::session->getInstances().


The general approach used for calling primitives is as follows:


1 Initialize a session and obtain a reference to it.


  $session = InCharge::session->init( );


2 Call the primitives required, by using the session reference. For example:


  foreach $class ( sort $session->getClasses() ) {


   foreach $inst (


    sort $session->getInstances($class)) 


   {


    print $class . "::" . $inst . "\n”;


   }


  }


3 Close the session.


  $session->detach( );


Where access to operations or properties of Domain Manager repository objects is required you are
discouraged from using the get(), put() and invokeOperation() primitives, but encouraged to use the
features of the InCharge::object module instead. Using this approach, the script obtains an
InCharge::object reference, which is used to access the required information. For example,
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4 Establish a session.


  $session = InCharge::session->init();


5 Create an InCharge::object valid reference to the object of interest.


  $obj = $session->object( "Router::gw1" );


6 Manipulate the object by using the reference.


  $type = $obj->{Type};


  $obj->{Vendor} = "Cisco";


  $fan1 = $obj->findFan( 1 );


7 Close the session.


  $session->detach( );


Error handling
All the functions and methods of objects in the API modules throw errors by using the Perl die command.
In order to catch any errors that may occur, the eval() function can be used and the “$@” variable
inspected after the event. This is common Perl scripting practice. The error message is rendered in the
locale set by the client session.


The example shown in the following script will abort if the router “gw1” does not exist in the topology at
the line where the name of the vendor is queried, and the last line will not be executed.


 use InCharge::session;


 $session = InCharge::session->init();


 $vendor = $session 


   ->object( "Router::gw1" )


   ->get("Vendor”);


 print "Vendor is $vendor\n”;


To trap this possible error, the code can be modified as follows.


 use InCharge::session; 


 $session = InCharge::session->init();


 $vendor = eval{


    $session ->object( "Router::gw1" ) ->get(Vendor); 


 }; 


 if ( $@ ) { 


  print "Error obtaining the Vendor property\n”;


} else {


  print "Vendor is $vendor\n”;


 }
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For more details about using this mechanism, refer to the section on the eval and die functions in the Perl
function man pages.


All error messages thrown by the API start with a number in square brackets. This is the error code and
classifies the error as being one of those listed in Error handling. The remainder of the error text gives a
verbose description of the specific error that was thrown. Where additional numeric codes are relevant,
these are included in a second or subsequent set of square brackets.


The following example script attempts a connection with a Domain Manager and prompts for a username
and password if the connection fails due to an authentication error: code 4.


 my $domain = "SAM1";


 my $user = undef;


 my $passwd = undef;


 for ( ; ; ) {


  $session = eval{ InCharge::session->new(


    domain => $domain,


    username => $user,


    password => $passwd);


  }


  if ( $@ =~ m/^\[4\]/ ) {


   print "Login: ";    chomp $user   = <STDIN>;


   print "Password: "; chomp $passwd = <STDIN>;


  } elsif ( $@ ) {


   die $@; # Some other fault


  } else {


   last;   # Success !


  }


 }


Error codes
Error codes provides a description of the different error codes and their associated types.


Table 4‑1.  Error codes


Error code Error type Description


1 Syntax error Wrong number of arguments, missing argument, or too many arguments


2 System error System call error; e.g., socket creation failed


3 Connection error Socket connection error


4 Authentication error Authentication error


5 HTTP error Other session init failure (HTTP error in second number, such as “[5][301]”


6 Bad argument Argument content or type error, or invalid name, invalid option, or wrong type,
such as a scalar arguement being passed but a reference was required


7 Broker error Cannot attach to Broker


8 No domain Domain not registered with Broker


9 Protocol error Protocol error, data size error, or unsupported protocol format


10 Isolated Not attached
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Table 4‑1.  Error codes (Continued)


Error code Error type Description


11 Invalid operation Invalid or illegal operation


12 Bad function Bad function call or primitive name


13 IO error Socket IO error


14 Timeout Timer expired


15 DM error Error returned by Domain Manager


16 Not cached Reply missing from cache


17 Configuration error A required configuration element, such as an environment variable, is either
missing or contains invalid data


Data types
The names of the variables used in the primitive descriptions, in the following sections, to denote the
arguments and return values indicate the data type passed or expected. Although every effort has been
made to use self-descriptive argument names in this guide, some need further explanation.


$session
The $session data type is a reference to a valid InCharge::session object - created by using
InCharge::session->new() or InCharge::session->init(). All Domain Manager primitives should be called
with reference to an InCharge::session object, as shown:


 $session = InCharge::session->init();


 @list = $session->getClassInstances( "Router" );


$object
The $object data type is the specification of a repository object to be acted upon.


This can be given in one of the formats described in Formats to specify a repository object.


Table 4‑2.  Formats to specify a repository object


Format Description


'class::instance' This format uses a single string, containing both the class and instance name with two colons
between them.


$n =
 $session->countElements("Router::gw1",  "ComposedOf");


'::instance' This format uses two parameters, where the first contains the class and the second contains
the name of the instance.


$n = $session->countElements( "::gw1", "ComposedOf" );
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Table 4‑2.  Formats to specify a repository object (Continued)


Format Description


$class, $instance This format uses two parameters, where the first contains the class and the second contains
the name of the instance.


$n = 
 $session->countElements( "Router",
    "gw1", "ComposedOf" );


undef, $instance This format uses two parameters. The first parameter contains the Perl undef value, to
indicate that it is unknown. This causes the API to perform a query to determine that name of
the object's class. This syntax can only be used to refer to existing objects.


$n = $session->countElements(undef, "gw1", "ComposedOf");


InCharge::object reference This format is used whenever an object name is required. It is also possible to pass an
InCharge::object reference.


$obj = $session->object( "Router::gw1" );
$n = $session->countElements( $obj,  "ComposedOf" );


@objects
The @objects data type is a list of objects is to be returned, which is only used as a return type.


The return is an array of object name strings in the “ClassName::InstanceName” format.


$symptom, @symptoms
A number of calls return lists of symptoms. These are represented as an array of array references. Each
subarray consists of four elements, each of which has the following significance:


 $x[0] = type (INT)


 $x[1] = certainly (FLOAT)


 $x[2] = object (STRING - class::instance)


 $x[3] = event/symptom name (STRING


You can gain access to the elements by using one of the following syntaxes:


n $list[ $record_number ] -> [ $field_number ]


n $listref -> [ $record_number ] -> [ $field_number ]


The first syntax is used where the list is held in an array variable. The second syntax is used when
the list is held in an array pointed to by a reference.


$symptomData, @symptomData
Symptom data is returned as an array of nine values, as described in Symptom data codes. When a list of
symptoms is returned, it is formatted as an array of array references where each subarray contains the
nine fields for a single symptom.
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Table 4‑3.  Symptom data codes


Symptom data code Description and type


$x[0] state (INTEGER)


0 = active


1 = inactive


2 = suspended


3 = not monitored


$x[1] last occurrence (LONG INTEGER)


$x[2] instance display name (STRING)


$x[3] class display name (STRING)


$x[4] event type (INTEGER)


$x[5] event certainty level (FLOAT)


$x[6] event class (STRING)


$x[7] event instance (STRING)


$x[8] event name (STRING)


$type, @types
The Domain Manager protocol uses a range of integer values to identify the types of data being passed.
These are used when a primitive is permitted to handle more than one data type as an argument or return
value. For example, the invoke() primitive can take arguments of any type, such as integer, string, and
Boolean. When specifying a type as a primitive function argument you can either use the numeric value
or the mnemonic string, as shown in the following example. For a string, either use “13” or “STRING”.
When type codes are returned by primitives, they are always returned as the numeric code.


To convert from the numeric code to the mnemonic string and back, use one of the built-in TYPE methods
of the InCharge::session module, as shown:


n $mnemonic = $session->TYPE( $code )


n $code = $session->TYPE( $mnemonic )


Type codes describes the type code values that are used.


Table 4‑4.  Type codes


Constant Literal Description


0 VOID void (nothing)


1 ERR error condition


2 BOOLEAN boolean (1 = true, 0 = false)


3 INT signed integer


4 UNSIGNED unsigned integer


5 LONG signed long integer


6 UNSIGNEDLONG unsigned long integer


VMware Smart Assurance Perl Reference Guide


VMware, Inc.  56







Table 4‑4.  Type codes (Continued)


Constant Literal Description


7 SHORT signed short integer


8 UNSIGNEDSHORT unsigned short integer


9 FLOAT floating point


10 DOUBLE double length floating point


12 CHAR 1-byte character


13 STRING string


14 OBJREF object (class and instance)


15 OBJCONSTREF constant object reference


16 BOOLEAN_SET set of booleans


17 INT_SET set of signed integers


18 UNSIGNED_SET set of unsigned integers


19 LONG_SET set of signed long integers


20 UNSIGNEDLONG_SET set of unsigned long integers


21 SHORT_SET set of signed short integers


22 UNSIGNEDSHORT_SET set of unsigned short integers


23 FLOAT_SET set of floating point numbers


24 DOUBLE_SET set of double length floats


26 CHAR_SET set of 1-byte characters


27 STRING_SET set of strings


28 OBJREF_SET set of objects (class and instance)


29 OBJCONSTREF_SET set of constant object references


30 ANYVALARRAY set of values (types included)


31 ANYVALARRAY_SET two-dimensional array of values


$freshness
Where the function argument list takes a freshness parameter, this refers to how fresh the property being
accessed by the function should be. This applies to polled or derived properties that may need
recalculating or repolling if the property was last updated more than the specified $freshness seconds
ago.


Primitives
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classExists


$boolean = $session->classExists( $class )


The classExists function returns 1 if the specified class exists or 0 otherwise.


 if ( $session->classExists( "Router" ) ) {


  print "Router class exists\n”;


 }


consistencyUpdate


$session->consistencyUpdate( )


The consistencyUpdate() function causes the Domain Manager to recompute the correlation codebook.


correlate


$session->correlate( )


The correlate() function triggers the ``Code book'' correlation actions, where symptoms are analyzed and
correlated into problems.


countChildren


$count = $session->countChildren( $class )


The countChildren() function counts the child classes of the specified class.


 $class = "ICIM_UnitaryComputerSystem";


 $n = $session->countChildren($class);


countClassInstances


$count = $session->countClassInstances( $class )


The countClassInstances() function counts the number of objects that exist for a specified class, or those
that would be returned by a call to getClassInstances().


 $n = $session->countClassInstances( "Router" );
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countClasses


$count = $session->countClasses( )


The countClasses() function counts the number of classes present in the system.


 $n = $session->countClasses( );


countElements


$count = $session->countElements( $object, $relation )


The countElements() function counts the number of elements in the specified relationship.


 $n = $session->countElements("Router::gw1","ComposedOf");


countInstances


$count = $session->countInstances( )


The countInstances() function counts the total number of objects in the repository, of all classes.


 $n = $session->countInstances( );


countLeafInstances


$count = $session->countLeafInstances( $class )


The countLeafInstances() function counts the number of leaf objects that exist for a specified class, those
that would be returned by a call to getLeafInstances().


 $n = $session->countLeafInstances( "Router" );


countf


$count =


 $session->countf( $object, $relationship, $freshness )


The countf() function counts the number of elements in the specified relationship, such as
countElements(). The contents of the relationship will be refreshed if the values are older than $freshness
seconds. The section $freshness provides additional information.
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createInstance


$session->createInstance( $object )


The createInstance() function creates a new ICIM object instance. The object specification must include
both a class name and unique instance name.


 $session->createInstance( "Router::fred" );


deleteInstance


$session->deleteInstance( $object )


Deletes the specified object instance from the repository. Note that this does not clean up all the object
interdependencies and links. When the Domain Manager has a MODEL based on ICIM, for a cleaner
object deletion, you can use the remove() operation, if one exists for the object class in question. The
section invoke provides additional information.


 $session->deleteInstance( "ACT_File::myFile" );


deleteObserver


$session->deleteObserver( )


The deleteObserver() function is an alias for purgeObserver(). The section purgeObserver provides
additional information.


Note   Consider this an internal call. Use $session->detach() instead, as discussed in Chapter 3,
“InCharge::Session.”


The deleteObserver() function reverses the effect of getObserverId(), deregistering the script as an
observer.


 $session->deleteObserver();


eventIsExported
The eventIsExported() function is an alias for getEventExported(). The section getEventExported provides
additional information.


execute
The execute() function is an alias for executeProgram(). The section executeProgram provides additional
information.
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executeProgram


@thread = $session->executeProgram( $program, \@args )


The executeProgram() function is an alias for execute(). The section execute provides additional
information.


The executeProgram() function executes an VMware Smart Assurance program, passing arguments to it.


The following example runs the dmdebug plug-in, displaying statistics information on the stdout file of the
sm_server process.


 @thread = $session->executeProgram (


   "dmdebug", [ "dmdebug", "--stats" ] );


exists
The exists() function is an alias for instanceExists(). The section instanceExists provides additional
information.


findInstances_P


Note   Use the findInstances() function from the InCharge::session module instead.


  @objects = $session->findInstances_P(


   $class-pattern, $instance-pattern, $flag )


Finds instances that match the class and instance patterns, according to rules specified in the flags.


When used by the console GUI, the $flag value is 0x101000, which requests subclass expansion and
glob pattern matches. When used by dmctl, the value 0x001000 is used which requests RegEx pattern
matches and subclass expansion.


The value of $flag consists of the following values OR’d in any combination, according to the options
required.


0x001000 = Expand-subclasses. With this flag set, the contents of subclasses of those classes that
match are also returned.


0x100000 = Glob. This causes the match to be done by using ICIM glob() matches rather than UNIX
regex syntax, which is used otherwise.


 @list = $session->findInstances_P(


     "Router", "s*", 0x100000 );


 @list = $session->findInstances_P(


   "ICIM_UnitaryComputerSystem", ".*", 0x001000);
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forceNotify


forceNotify( $object, $event, $notified, $expires)


Notifies, or clears, the specified event.


The $notified and $expires parameters are both timers:


n If $notified is greater than or equal to $expires, then the event is cleared.


n If $notified is less-than $expires then the event is notified, or raised. The actual values of these
parameters are not significant.


  # to notify an event:


  $session->forceNotify("Router::gw1",


     "Unresponsive", 0, 1);


  # to clear an event:


  $session->forceNotify("Router::gw1",


     "Unresponsive", 0, 0);


get


RETURN = $session->get( $object, $property )


Gets the contents of the specified property of the object.


The return type is scalar, array, or array reference as appropriate.


 $vendor = $session->get( "Router::gw1", "Vendor" );


 @parts = $session->get( "Router::gw1", "ComposedOf" );


The preferred implementation is:


 $object = $session->object( "Router::gw1" );


 $vendor = $object->{Vendor};


 @parts = $object->{ComposedOf};


get_t and get_T


($type, $value) = $session->get_t( $object, $property )
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Like get(), this returns the contents of the specified property, however, get_t() also returns a code for the
type of the data. The returned value will be a scalar or array reference, as appropriate.


 ( $type, $value ) = $session->get_t(


     "Router::gw1", "Vendor" );


 ( $type, $value ) = $session->get_t(


     "Router::gw1", "ComposedOf" );


The get_t() variant of this call also returns the types of values contained in complex structures. Where
get_t() returns a value, get_T() returns a type code and value in a two-element array.


getAggregationEvents


@list = $session->getAggregationEvents( $object,


      $eventname, $flag)


The getAggregationEvents() function gets the names of the events that are aggregated to the specified
event, which must be an aggregation event type.


n If $flag is false, then the events directly aggregated are returned.


n If $flag is true, then the aggregation tree is walked, and the names of all nonaggregation events that
the specified event ultimately depends on are returned.


 @list = $session->getAggregationEvents(


   "Router::gw1", "PowerSupplyException", 1 );


getAllEventNames


@events = $session->getAllEventNames( $class )


The getAllEventNames() function is an alias for getEvents(). The section getEvents provides additional
information.


The getAllEventNames() function gets the list of all events of all types, including symptoms, problems,
aggregates, and events, in no particular order.


The getEventNames() call is similar but omits the problems from the list.


 @list = $session->getAllEventNames( "Router" );


getAllInstances


@instances = $session->getAllInstances( )


The getAllInstances() function gets the names of all instances present in the ICIM database.


Note   The getAllInstances() function can potentially return a very large array and should not be used.
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getAllProperties and getAllProperties_t


@properties = $session->getAllProperties( $object, $flag );


The getAllProperties() function returns the names and values of all the properties of the specified object:


n If $flag is 0, attributes only are returned.


n If $flag is 1, relations only are returned.


n If $flag is 2, both attributes and relations are returned.


The @properties array contains an even number of elements, where the odd-numbered ones are the
property names, and the even-numbered are the matching values. This convention means that you
can treat the result as a Perl hash, as shown in the following examples:


n The first example:


 %props = $s->getAllProperties( $obj, 2 );


 print "Object Name is $props{Name}\n”;


n The second example:


use Data::Dumper;


print Dumper( \%props );


The “_t” variation of the call returns data types as well as values.


Consider using the get() or get_t() functions of the InCharge::object module with no arguments
instead of this call, as shown in the following example:


 %props = $obj->get( );


 print Dumper( \%props );


getArgDirection


$direction = $session->getArgDirection( $class, $operation, $argname )


The getArgDirection() function gets a flag to indicate whether the specified operation argument is an IN or
OUT argument:


n IN arguments are denoted by the value 0 and refer to argument values passed from the script to the
Domain Manager.
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n OUT arguments are denoted by the value 1 and refer to variables into which the operation puts result
information.


Nearly all arguments to all operations of all classes are IN arguments.


Note   OUT arguments are not supported by the remote access protocol, which is beyond the scope
of the API, dmctl, and ASL.


$direction = $session->getArgDirection(


    "Router", "getFan", "identifier" );


getArgType


$type = $session->getArgType( $class, $operation, $argname )


The getArgType() function is an alias for getOpArgType() and getOperationArgumentType(). The sections 
getOpArgType and getOperationArgumentType provide additional information.


The getArgType() function gets the type of the specified argument for the specified class operation. The
section $type, @types describes the possible data types.


$type = $session->getArgType( "Router", "makeFan", "className" );


getAttributes
The getAttributes() function is an alias for getAttributeNames(). The section getAttributeNames provides
additional information.


getAttributeNames


@properties = $session->getAttributeNames( $class )


The getAttributeNames() function is an alias for getAttributes(). The section getAttributes provides
additional information.


The getAttributeNames() function gets the list of all attributes for the specified class.


Attributes are properties that are not relations. For class Router, Vendor is an attribute but ComposedOf is
not, however, both are properties. The getAttributeTypes() call returns the types of these attributes.


 @list = $session->getAttributeNames( "Router" );


getAttributeTypes


@types = $session->getAttributeTypes( $class )
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The getAttributeTypes() function gets the list of type codes associated with the attribute names returned
by getAttributeNames().


The types returned by this call and the names returned by getAttributeNames() are in the same order,
such that the type of $property[$n] is given in $type[$n]. The section $type, @types provides a description
of the possible values.


 @list = $session->getAttributeTypes( "Router" );


getByKey


RESULT = $session->getByKey( $object, $table,


     [ $keytype, $keyvalue ] )


The getByKey() function gets the entry in the named table from the object, indexed by its key.


Tables are properties that can contain arrays of values.


 @driver = $session->getByKey(


   "GA_CompoundDriver::Bridge-Generic-Driver",


   "drivers", [ "INT", 10 ] );


getByKey_t and getByKey_T


($type, $value) = $session->getByKey_t( $object, $table,


      [ $keytype, $keyvalue ] )


Identical to getByKey() but returns a code for the type of the result as well.


 ($type, $data) = $session->getByKey_t(


   "GA_CompoundDriver::Bridge-Generic-Driver",


   "drivers", [ "INT", 10 ] );


getByKeyf


RESULT = $session->getByKeyf( $object, $table,


     [ $keytype, $keyvalue ], $freshness )


Identical to getByKey() but takes the “freshness” of the entry into account. The section $freshness
provides additional information.


 @driver = $session->getByKeyf(


   "GA_CompoundDriver::Bridge-Generic-Driver",


   "drivers", [ "INT", 10 ], 120 );


VMware Smart Assurance Perl Reference Guide


VMware, Inc.  66







getByKeyf_t and getByKeyf_T


($type, $value) = $session->getByKeyf_t( $object, $table,


     [ $keytype, $keyvalue ], $freshness )


Identical to getByKey_t() but takes the “freshness” of the entry into account. The section $freshness
provides additional information.


 ($type, $data) = $session->getByKeyf_t(


   "GA_CompoundDriver::Bridge-Generic-Driver",


   "drivers", [ "INT", 10 ], 120 );


getChildren


@classes = $session->getChildren( $class )


The getChildren() function gets the list of classes that are child classes of a specified one, that is, classes
derived from the base class.


 $class = "ICIM_UnitaryComputerSystem";


 @list = $session->getChildren($class);


getClassDescription


$text = $session->getClassDescription( $class )


The getClassDescription() function gets a textual description of the class.


The fixed string “no description available” is returned if the class programmer has not provided a
description message for the class.


 $description = $session->getClassDescription( "Router" );


getClassHierarchy


@hierarchy = $session->getClassHierarchy( );


The getClassHierarchy() function returns an array of information that provides a complete description of
the hierarchy of domain model classes.


Each element of the array is a reference to a three-element subarray, as described in Class hierarchy
descriptor.
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Table 4‑5.  Class hierarchy descriptor


Array element Description


$x[0] name of ICIM class


$x[1] name of the class’s parent class


$x[2] class is abstract flag: 1 = yes, 0 = no


getClassInstances


@instances = $session->getClassInstances( $class )


The getClassInstances() function gets the list of instances of a specified class.


The return is a list of strings that contain the instance names without the class name. For example, “fred”
is returned rather than “Router::fred”. This differs from getLeafInstances() in that this call returns the
members of the class and any derived classes, whereas getLeafInstances() returns only the members of
the specified class.


 @names = $session->getClassInstances( "Router" );


getClasses


@classes = $session->getClasses( )


The getClasses() function gets the list of classes present in the system.


The following code fragment displays the list of all instances of all classes in the database.


 foreach $class ($session->getClasses()) {


  foreach ($session->getClassInstances($class)) {


   print "${class}::$_\n”;


  }


 }


getCorrelationParameters


@info = $session->getCorrelationParameters( )


The getCorrelationParameters() function returns a nine-element array, each element of which contains a
parameter relating to the Domain Manager correlation mechanism.


The array elements are described in getCorrelationParameters return values:
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Table 4‑6.  getCorrelationParameters return values


Element Description


info[0] max problems (INT)


info[1] correlation interval (INT)


info[2] codebook radius (FLOAT)


info[3] correlation radius (FLOAT)


info[4] lost symptom probability (FLOAT)


info[5] spurious symptom probability (FLOAT)


info[6] time limit (INT)


info[7] suspend correlation (BOOLEAN)


info[8] provide explanation (BOOLEAN)


getEnumVals


@strings = $session->getEnumVals( $class, $property )


The getEnumVals() function returns the list of strings that represent the possible values for an
enumerated property.


The returned list of strings can be used to present a list of valid values to the user in the form of a
selection menu. If this primitive is used to refer to a property that is not an enumerated one, an error is
thrown.


 @values = $session->getEnumVals( "Router", "Type" );


getEvents
The getEvents() function is an alias for getAllEventNames(). The section getAllEventNames provides
additional information.


getEventCauses


@symptoms =   $session->getEventCauses( $object, $eventname, $flag )


The getEventCauses() function gets a list of the Root causes, or problems, that the specified event can
be considered to be a symptom of.


The getProblemClosure() primitive provides the reverse mapping. This is the mechanism used to
populate the codebook tab for an event property sheet in the administrative console.


The $flag parameter is optional:


n If it is passed as TRUE, the full list of problems explaining eventname, whether directly or indirectly, is
returned.
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n If it is passed as FALSE, only those problems that directly list eventname among the events they
explain are returned.


 @causes = $session->getEventCauses(


   "Router::gw1", "MightBeUnavailable", 1 );


getEventClassName


$class = $session->getEventClassName( $class, $event )


The getEventClassName() function returns a string with the name of the ancestor class associated with a
class and an event. The ancestor class is where the event was originally defined, that is, the class in
which the event definition statement, not any refinement, appeared.


 $class = $session->getEventClassname( "Router", "Down" );


getEventDescription


$text = $session->getEventDescription( $class, $event )


The getEventDescription() function returns a string, defined in MODEL, that describes an event.


 $descr = $session->getEventDescription("Router", "Down");


getEventExplainedBy


@symptoms = $session->getEventExplainedBy( $object, $event, $flag )


The getEventExplainedBy() function returns the list of symptoms that are explained by the specified
impact event.


The $flag is a boolean that indicates whether the event impact tree is to be walked during the processing
of the request.


 @list = $session->getEventExplainedBy(


    "Router::gw1", "DownImpact", 1);


getEventExported


$boolean = $session->getEventExported( $class, $event )


The getEventExported() function is an alias for eventIsExported(). The section eventIsExported provides
additional information.
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Returns one of the following:


n 1 if the specified event is exported by the class


n 0 if it is not exported.


Events that are not exported are hidden from view in the GUI.


 if ( $session->getEventExported( "Router", "Down" ) ) {


  print "Event is exported\n”;


 }


getEventNames


@events = $session->getEventNames( $class )


The getEventNames() function gets the list of events handled by the specified class.


Some of the returned events are exported while others are not, as described in getEventExported. Unlike
getAllEventNames(), this call does not return problems names.


@list = $session->getEventNames( $class );


getEventSymptoms


@events = $session->getEventSymptoms( $class, $event )


The getEventSymptoms() function returns the list of events that are symptoms of the specified one.


 @symptoms =


   $session->getEventSymptoms( "Router", "Down" );


getEventType_P


$eventtype = $session->getEventType_P( $class, $event )


This primitive returns a numeric code that indicates the type of the specified event. Possible values are
shown in getEventType return codes.


Table 4‑7.  getEventType return codes


Return code Event type


0 Event


1 Aggregation


2 Symptom


3 Causality


4 Problem


VMware Smart Assurance Perl Reference Guide


VMware, Inc.  71







Table 4‑7.  getEventType return codes (Continued)


Return code Event type


5 Imported event


6 Propagated Aggregation


7 Propagated Symptom


8 Same type


 $eventtype = $session->getEventType_P( "Router", "Down");


getInstances
The getInstances() function is an alias for getClassInstances(). The section getClassInstances provides
additional information.


getInstrumentationType


$type = $session->getInstrumentationType( $object )


The getInstrumentationType() function returns the instrumentation type for a specified object.


 $type =


  $session->getInstrumentationType("Router::gw1");


getLeafInstances


@instances = $session->getLeafInstances( $class )


The getLeafInstances() function is an alias for getInstances(). The section getInstances provides
additional information.


The getLeafInstances() function gets the list of instances of a specified class.


The return is a list of strings that contain the instance names without the class name. For example, “fred”
is returned rather than “Router::fred”. This differs from getClassInstances() in that this call returns only the
members of the specified class, whereas the getClassInstances() call returns the members of the class
and its derived classes.


 @names = $session->getLeafInstances( "Router" );


getLibraries


@libs = $session->getLibraries( )
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The getLibraries() function is an alias for getModels(). The section getModels provides additional
information.


The getLibraries() function gets the list of libraries loaded into the system.


getModels
The getModels() function is an alias for getLibraries(). The section getLibraries provides additional
information.


getMultipleProperties and getMultipleProperties_t


Note   Use the get() and get_t() functions of the InCharge::object module with multiple arguments instead
of this call, as shown in the example.


 ( $vendor, $model ) = $obj->get( "Vendor", "Model" );


The syntax of the primitive itself is:


n @values = $session->getMultipleProperties( $object, \@propnames);


n @values = $session->getMultipleProperties_t($object, \@propnames);


For example:


 ($vendor,$model) =


  $session->getMultipleProperties( $obj,


      [ "Vendor", "Model" ] );


The argument is a reference to an array that contains the names of the properties to be returned.


getObserverId


$id = $session->getObserverId()


The getObserverId() function creates and returns a new observer ID.


The deleteObserver() primitive reverses this action. The section deleteObserver provides additional
information.


getOpArgType
The getOpArgType() function is an alias for getArgType(). The section getArgType provides additional
information.


getOpArgs


@argnames = $session->getOpArgs( $class, $operation )
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The getOpArgs() function is an alias for getOperationArguments(). The section getOperationArguments
provides additional information.


The getOpArgs() function gets the names of the arguments for a specified class operation.


The argument names are returned in the order in which they should appear in the argument list when
invoking the operation.


 @list = $session->getOpArgs( "Router", "makeIP" );


getOpDescription


$text = $session->getOpDescription( $class, $operation )


The getOpDescription() function is an alias for getOperationDescription(). The section 
getOperationDescription provides additional information.


The getOpDescription() function returns a textual description of the specified class operation.


 $description = $session->getOpDescription(


     "Router", "makeIP");


getOperationArguments
The getOperationArguments() function is an alias for getOpArgs(). The section getOpArgs provides
additional information.


getOperationArgumentType
The getOperationArgumentType() function is an alias for getArgType(). The section getArgType provides
additional information.


getOperationDescription
The getOperationDescription() function is an alias for getOpDescription(). The section getOpDescription
provides additional information.


getOperationFlag
The getOperationFlag() function is an alias for getOpFlag(). The section getOpFlag provides additional
information.


getOperationReturnType
The getOperationReturnType() function is an alias for getOpReturnType(). The section getOpReturnType
provides additional information.
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getOperations
The getOperations() function is an alias for getOpNames(). The section getOpNames provides additional
information.


getOpFlag


$flag = $session->getOpFlag( $class, $operation )


The getOpFlag() function is an alias for getOperationFlag(). The section getOperationFlag provides
additional information.


The getOpFlag() function gets the flag associated with the specified class operation.


The value returned is between 0 and 3, as defined getOpFlag return codes.


Table 4‑8.  getOpFlag return codes


Return code Operation


0 No flag


1 Idempotent


2 Constant


3 Read only


 $flag = $session->getOpFlag( "Router", "makeIP" );


getOpNames


@operations = $session->getOpNames( $class )


The getOpNames() function is an alias for getOperations(). The section getOperations provides additional
information.


The getOpNames() function gets the list of operations for the specified class.


The operations are returned as an array of strings that contain their names.


 @list = $session->getOpNames( "Router" );


getOpReturnType


$type = $session->getOpReturnType( $class, $operation )


The getOpReturnType() function is an alias for getOperationReturnType(). The section 
getOperationReturnType provides additional information.
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The getOpReturnType() function returns the return type code for the specified class operation.


By using this function, you can determine whether the operation returns an integer, a string, an object, or
a list. The type codes returned are integer numbers, as described in getOpReturnType.


 $type_code = $session->getOpReturnType(


      "Router", "makeIP" );


getParentClass


$class = $session->getParentClass( $class )


The getParentClass() function returns the name of the class from which the specified class is derived.


This is the logical inverse of getChildren().


 $parent = $session->getParentClass( "Router" );


getProblemClosure


@symptoms =  $session->getProblemClosure( $object, $eventname, $flag )


Lists the events, or symptoms, that contribute to a specified problem. The getEventCauses() primitive is
the inverse of this one. The section getEventCauses provides additional information.


 @list = $session->getProblemClosure(


     "Router::gw1", "Down", 1 );


getProblemExplanation


         @list = $session->getProblemExplanation( $object, $eventname, $flag )


MODEL developers can add information to a problem in order to emphasize events that occur because of
a problem. This function returns a list of these events.


 @list = $session->getProblemExplanation( "Router::gw1", 


       "Down", 1 );


getProblemNames


@list = $session->getProblemNames( $class )


The getProblemNames() function gets the event names of problems associated with the specified class.


 @problems = $session->getProblemNames( "Router" );
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getProblemSymptomState


@symptomData = $session->getProblemSymptonState( $object, $eventname )


The getProblemSymptomState() function returns data about all the symptoms that indicate the specified
problem, including significant state information.


@list = $session->getProblemSymptonState( "Router::gw1", "Down");


getPrograms


@list = $session->getPrograms( )


The getPrograms() function gets the list of ``programs'' that are running in the Domain Manager.


Typically the reply list includes “dmboot” and “icf.”


 @progs = $session->getPrograms( );


getPropAccess


$access = $session->getPropAccess( $class, $property )


The getPropAccess() function returns a number that indicates the level of access to the specified
property.


 $access = $session->getPropAccess( "Router", "Vendor" );


The return value effectively identifies the method by which the property value is obtained internally.
Possible values and their meanings are listed in getPropAccess return codes .


Table 4‑9.  getPropAccess return codes


Return code Property access level


0 No access


1 Stored


2 Computed


3 Instrumented


4 Propagated


5 Uncomputable


6 Computed with expression


VMware Smart Assurance Perl Reference Guide


VMware, Inc.  77







getPropDescription


$text = $session->getPropDescription( $class, $property )


The getPropDescription() function is an alias for getPropertyDescription(). The section 
getPropertyDescription provides additional information.


The getPropDescription() function returns a textual description of the named class property.


 $descr =


  $session->getPropDescription( "Router", "Vendor" );


getProperties
The getProperties() function is an alias for getPropNames(). The section getPropNames provides
additional information.


Note   The functionality of the C++ function getProperties() is available through the
getMultipleProperties() primitive, and more easily through the get() method of the InCharge::object
module.


Primitive getProperties() is aliased to getPropNames() in order to provide dmctl syntax compatibility.


getPropertyDescription
The getPropertyDescription() function is an alias for getPropDescription(). The section getPropDescription
provides additional information.


getProperties
The getProperties() function is an alias for getPropNames(). The section getPropNames provides
additional information.


Note   For C++ developers, the C++ API call getProperties() is referred to as getMultipleProperties().
However, the InCharge::object->get() is an easier way to use this functionality.


getPropertyType
The getPropertyType() function is an alias for getPropType(). The section getPropType provides
additional information.


getPropIsReadonly


$boolean = $session->getPropIsReadonly( $class, $property )
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The getPropIsReadonly() function indicates whether the specified class property is read-only.


 if ( $session->getPropIsReadonly( "Router", "Vendor" ) ) {


  print "Vendor is readonly\n”;


 } else {


  print "Vendor can be changed\n”;


 }


getPropIsRelationship


$boolean =   $session->getPropIsRelationship( $class, $property )


The getPropIsRelationship() function indicates whether the specified class property is a relationship.


 if ( $session->getPropIsRelationship( "Router",


       "ComposedOf" ))


 {


  print "ComposedOf is a relationship\n”;


 }


getPropIsRequired


$boolean = $session->getPropIsRequired( $class, $property )


The getPropIsRequired() function indicates whether the specified class property is required to have a
value.


 $needed =


  $session->getPropIsRequired( "Router", "Vendor" );


getPropNames


@list = $session->getPropNames( $class )


The getPropNames() function retrieves the names of all the properties of a given class.


getPropRange


@range = $session->getPropRange( $class, $property )


The getPropRange() function returns the range of valid values for the class property, provided the
property has been defined.
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This applies to a very limited number of properties of integer type, typically in polling configuration
classes.


 ( $min, $max ) = $session->getPropRange(


    "DialOnDemand_Interface_Setting",


    "MaximumUptime" );


getPropType


$type = $seesion->getPropType( $class, $property )


The getPropType() function is an alias for getPropertyType(). The section getPropertyType


Returns the data type for a specified class property.


The section $type, @types describes the possible data types. This call always returns the integer number
representation of the type.


 $type = $session->getPropType( "Router", "Vendor" );


getPropertySubscriptionState


$state = $session->getPropertySubscriptionState(


      $object, $property )


The getPropertySubscriptionState() function gets the current state of subscription to the specified event.


The possible reply values are listed in getPropertySubscriptionState return codes.


Table 4‑10.  getPropertySubscriptionState return codes


Return code Subscription state


0 Unsubscribed


1 Pending


2 Subscribed


3 Suspended


getRelatedClass


$class = $session->getRelatedClass( $class, $property )


The getRelatedClass() function returns the name of the class of object that can be related to the specified
class through the property, which must be a relationship.


$class =


  $session->getRelatedClass( "Router", "ComposedOf" );
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getRelationNames


@properties = $session->getRelationNames( $class )


The getRelationNames() function is an alias for getRelations(). The section getRelations provides
additional information.


The getRelationNames() function gets the names of all the relationship properties for the specified class.


 @relationships = $session->getRelationNames( "Router" );


getRelations
The getRelations() function is an alias for getRelationNames(). The section getRelationNames provides
additional information.


getRelationTypes


@types = $session->getRelationTypes( $class )


The getRelationTypes() function returns a list of type numbers for the relationships which are returned by
the getRelationNames() call.


 @types = $session->getRelationTypes( "Router" );


The section $type, @types describes the possible data types.


getReverseRelation


$property = $session->getReverseRelation( $class, $property )


The getReverseRelation() function returns the name of the other end of a relationship pair denoted by the
specified property name.


The inverse of ComposedOf is PartOf.


$relationship = $session->getReverseRelation(


      "Router", "ComposedOf");


getSubscriptionState


$state = $session->getSubscriptionState( $object, $event )


The getSubscriptionState() function gets the current state of subscription to the specified event.


The possible values are listed in getSubscriptionState return codes .
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Table 4‑11.  getSubscriptionState return codes


Return code Subscription state


0 Unsubscribed


1 Pending


2 Subscribed


3 Suspended


getThreads


@list = $session->getThreads( )


The getThreads() function returns a list of threads that run in the current Domain Manager system.


Each element of the returned array is a reference to a four-element array. The four values that describe
each thread are as they are described in getThreads return codes:.


Table 4‑12.  getThreads return codes


Return array element Thread information


$t[0] Process ID


$t[1] name


$t[2] State


$t[3] Status


This example prints the thread IDs and names of all threads in thread ID order.


 foreach $t ( sort { $a->[0] <=> $b->[0] }


     $session->getThreads( ) ) {


  print $t->[0] . " - " . $t->[1] . "\n”;


 }


getf


RETURN = $session->getf( $object, $property, $freshness )


The getf() function gets the contents of the specified property of the object with reference to its freshness.
The section $freshness provides additional information.


The return type is scalar, array, or array reference, as appropriate, as described in “Data types” on
page 70.


 $vendor = $session->getf( "Router::gw1", "Vendor", 240 );


 @parts =


  $session->getf( "Router::gw1", "ComposedOf", 360 );
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getf_t and getf_T


($type, $value) = $session->getf_t( $object, $property, $freshness )


Like getf(), the getf_t() function returns the contents of the specified property but getf_t() also returns a
code for the type of the data. The section $freshness provides additional information.


The returned value will be a scalar or array reference, as appropriate.


( $type, $value ) =


  $session->getf_t( "Router::gw1", "Vendor", 240 );


( $type, $value ) =


  $session->getf_t("Router::gw1", "ComposedOf", 360);


getfAllProperties and getfAllProperties_t


%properties = $session->getfAllProperties($object, $flag, $freshness);


The getfAllProperties() function is the same as getAllProperties(), but takes the freshness of the values
into account, and refreshes any stale properties before returning the results, that is, those that are older
than $freshness seconds. The section $freshness provides additional information.


The sectiongetAllProperties and getAllProperties_t provides a description of the $flag.


getfMultipleProperties and getfMultipleProperties_t


@values = $session->getfMultipleProperties( $object, 


       \@propNames,


       $freshness );


The getfMultipleProperties() function is like getMultipleProperties(), but refreshes values that are staler
than $freshness seconds and need re-polling. The section $freshness provides additional information.


The propNames argument must be a reference to an array of property names. For example,


 @props = qw(Vendor Model Type);


 ($v,$m,$t) =


  $session->getfMultipleProperties($obj, \@props, 30);


hasRequiredProps


$boolean = $session->hasRequiredProps( $class )


Indicates whether or not the specified class has any properties that are flagged as required.


 $reqd = $session->hasRequiredProps( "Router" );
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insertElement_P


$session->insertElement_P($object,


    $relation,


    [ $type, $value ])


The InsertElement_P() function inserts something into a relationshipset.


In order to access the low-level primitive version of this call, you must invoke it by using the primitive
method because the InCharge::session module also has its own variant.


 $session->insertElement_P(,"Router", "ComposedOf",


     [ "OBJREF", "Fan::fan1" ]);


instanceExists


$boolean = $session->instanceExists( $object )


The InstanceExists() function is an alias for exists(). The section exists provides additional information.


Note   Use the ASL-like function InCharge::object::isNull() instead of this primitive. Note that the sense of
the return value is reversed.


Indicates whether or not the named object is present in the repository.


However, the class name and instance name should be specified in the $object parameter.


 $exists = $session->instanceExists( "Router::gw1" );


invoke
The invoke() function is an alias for invokeOperation(). The section invokeOperation provides additional
information.


invoke_t and invoke_T
The invoke_t() and invoke_T() functions are an alias for invokeOperation_t(). The section 
invokeOperation_t and invokeOperation_T.


invokeOperation


RESULT = $session->invokeOperation($object, $operation, \@args)
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The invokeOperation() function is an alias for invoke(). The section invoke provides additional information.


Note   Use the features of the InCharge::object module instead, as described in Chapter 2,
“InCharge::Object.”


The invokeOperation() function invokes a class operation on a specified object, passing the parameters to
the operation.


The syntax of the arguments list requires it to be a reference to an array, each element of which is a
reference to a two-element array containing the data type and value. Because of the awkward syntax,
using the InCharge::object module provides a more natural style of interface. For example:


 $result = $session->invokeOperation(


    "Router::gw1", "makeInterface",


    [


    [ "INT", 1 ],


    [ "STRING", "interface-1" ],


    [ "STRING", "Interface" ]


    ] );


invokeOperation_t and invokeOperation_T


( $type, $value ) =


 $session->invokeOperation_t($object, $operation, \@args)


The invokeOperation_t() function is an alias for invoke_t(). The section invoke_t and invoke_T provide
additional information.


The invokeOperation_t() function is identical to invokeOperation(), except that the return indicates the
type of the returned data as well.


 ( $type, $value ) = $session->invokeOperation_t(


    "Router::gw1", "makeInterface",


    [


    [ "INT", 1 ],


    [ "STRING", "interface-1" ],


    [ "STRING", "Interface" ]


    ] );


The “_T” variation also embeds type codes into the fields of returned complex structures.


isAbstract


$boolean = $session->isAbstract( $class )


The isAbstract() function indicates whether the specified class is abstract.
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An abstract class is one from which other classes are derived but which cannot have any objects.


 $class = "ICIM_UnitaryComputerSystem";


 $flag = $session->isAbstract( $class );


isBaseOf


$boolean = $session->isBaseOf( $class1, $class2 )


The isBaseOf() function returns TRUE if $class2 is a base class of $class1, that is, $class1 is derived
from $class2.


Note   For the purposes of this query, all classes are taken to be derived from themselves.


 $class1 = "Router";


 $class2 = "ICIM_UnitaryComputerSystem";


 $is_it = $session->isBaseOf( $class1, $class2 );


isBaseOfOrProxy


$boolean = $session->isBaseOfOrProxy( $class1, $class2 )


The isBaseOfOrProxy() function returns TRUE (1) if $class2 is a base class or proxy class of $class1.


 $class1 = "Router";


 $class2 = "ICIM_UnitaryComputerSystem";


 $is_it = $session->isBaseOfOrProxy( $class1, $class2 );


isInstrumented


$boolean = $session->isInstrumented( $class )


The isInstrumented() function indicates whether the specified class has associated instrumentation.


 $flag = $session->isInstrumented( "TCPConnect" );


isMember


$boolean = $session->isMember( $object1, $relation, $object2)
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The isMember() function returns TRUE if $object2 is a member of the specified $object1 relationship.


 $flag = $session->isMember( "Router::strrtbos",


     "ComposedOf",


     "Interface::IF-strrtbos/1" );


isMemberByKey


$boolean = $session->isMemberByKey( $object, $table,


      $keytype, $keyvalue] )


The isMemberByKey() function indicates whether an entry in the named object table exists.


 $exists = $session->isMemeberByKey(


   "GA_CompoundDriver::Bridge-Generic-Driver",


   "drivers", [ "INT", 10 ] )


isMemberByKeyf


$boolean = $session->isMemberByKeyf( $object, $table,


    [$keytype, $keyvalue], $freshness)


The isMemberByKeyf() function is similar to isMemberByKey(), but with reference to the freshness of the
value. The section $freshness provides additional information.


 $exists = $session->isMemeberByKeyf(


   "GA_CompoundDriver::Bridge-Generic-Driver",


   "drivers", [ "INT", 10 ], 120 )


isMemberf


$boolean = $session->isMemberf( $object1, $relation,


     $object2, $freshness )


The isMemberf() function returns TRUE if $object2 is a member of the specified $object1 relationship. If
the $relation is a computed or polled value and is more than $freshness seconds old, it is refreshed first.
The section $freshness provides additional information.


 $flag = $session->isMemberf( "Router::strrtbos",


     "ComposedOf",


     "Interface::IF-strrtbos/1",


     240 );
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isSubscribed


$boolean = $session->isSubscribed( $object, $event )


The isSubscribed() function returns TRUE if the specified event has been subscribed to by the calling
process.


$subscribed = $session->isSubscribed( "Router::gw1", "Down");


loadLibrary


$session->loadLibrary( $library )


The loadLibrary() function is an alias for loadModel(). The section loadModel provides additional
information.


The loadLibrary() function loads a library, model, into sm_server memory.


 $session->loadLibrary( $libname );


loadModel
The loadModel() function is an alias for loadLibrary(). The section loadLibrary provides additional
information.


loadProgram


$session->loadProgram( $program )


The loadProgram() function loads the named program into sm_server memory.


 $session->loadProgram( "dmdebug" );


noop


$session->noop()


The noop() function is an alias for ping(). The section ping provides additional information.


This is a type of ping. It sends a null command string to the Domain Manager, and thus determines
whether the client/server link is active.


notify
The section notify provides a description of notify().
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ping
The ping() function is an alias for noop(). The section noop provides additional information.


propertySubscribe


$session->propertySubscribe( $object, $property, $interval )


The propertySubscribe() function subscribes to notifications of changes to the specified object property.
“Event subscription” on page 22 provide an overview of subscribing to events in a Domain Manager.


The actions of this call are reversed by propertyUnsubscribe().


 $session->propertySubscribe( "Router::gw1",


     "Vendor", 30 );


propertySubscribeAll


$session->propertySubscribeAll( $flags,$class_pattern,


     $instance_pattern,


     $property_pattern, $interval);


The propertySubscribeAll() function subscribes to changes in all the matching properties in the matching
objects.


The meaning of the $flags is described for the subscribe() session function.


The actions of this call are reversed by propertyUnsubscribeAll(). The section propertyUnsubscribeAll
provides additional information.


 $session->propertySubscribeAll( 0, "Router", "gw1",


      ".*", 30 );


propertyUnsubscribe


$session->propertyUnsubscribe( $object, $property )


The propertyUnsubscribe() function reverses the effect of the propertySubscribe() call. The section 
propertySubscribe provides additional information.


 $session->propertyUnsubscribe( "Router::gw1", "Vendor" );
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propertyUnsubscribeAll


$session->propertyUnsubscribeAll( $flags, $class_pattern,


      $instance_pattern,


      $property_pattern );


The propertyUnsubscribeAll() function unsubscribes from changes in all the matching properties in the
matching objects.


The meaning of the $flags is described for the subscribe() session function.


purgeObserver
The purgeObserver() function is an alias for deleteObserver(). The section deleteObserver provides
additional information.


put_P


$session->put_P( $object, $property, [ $type, $value ] )


The put_P() function writes the specified value to the specified object property.


The put_P() function is the low-level primitive that the put() function of InCharge::session uses, and is
called when using the hash dereferencing syntax of InCharge::object.


The reader is encouraged to use the InCharge::object logic.


The following examples are essentially equivalent:


n The first example


 $obj = $session->object( "Router::gw2" );


 $obj->{Vendor} = "Cisco";


n The second example


 $obj->put( "Vendor", "Cisco" );


n The third example


 $ojb->put( Vendor => "Cisco", PrimaryOwnerContact => "Joe Blog" );


n The fourth example


 $session->put( "Router::gw", "Vendor", "Cisco" );
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n The fifth example


 $session->put_P( "Router::gw", "Vendor", [ "STRING", "Cisco" ] );


quit


$session->quit( )


The quit() function is an alias for shutdown(). The section shutdown provides additional information.


The quit() function closes down the Domain Manager cleanly, saving the configured parts of the repository
to disk.


removeElement_P


$session->removeElement_P( $object, $relation, [ $type, $value ] )


The removeElement_P() function removes an element from an object relationship, such as ComposedOf.


In order to access the low-level primitive version of this call, invoke it by using the primitive method
because the InCharge::session module has a method of the same name that provides an enhanced
interface.


 $session->removeElement_P("Router::gw", "ComposedOf",


     [ "OBJREG", "Host::pingu6" ] );


removeElementByKey


$session->removeElementByKey($object, $table, [$keytype, $keyvalue])


The removeElementByKey() function removes a set-valued property by key.


restoreRepository


$session->restoreRepository( $filename, $purgeflag )


The restoreRepository() function restores the repository from file, optionally purging existing repository
contents in the process.


 $session->restoreRepository( "save.rps", 0 );


setCorrelationParameters


$session->setCorrelationParameters( @info )


The setCorrelationParameters() function sets the Domain Manager correlation parameters.
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The section getCorrelationParameters describes the fields of the @info array. The following example sets
the correlation interval to 20 seconds.


 @info = $session->getCorrelationParameters( );


 $info[1] = 20;


 $session->setCorrelationParameters( @info );


shutdown
The shutdown() function is an alias for quit(). The section quit provides additional information.


storeAllRepository


$session->storeAllRepository( $filename )


The storeAllRepository() function saves the repository in the named file, which is located in the directory
$SM_HOME/repos. The directory name must not contain any path separator characters.


 $session->saveAllRepository( "save.rps" );


storeClassRepository


$session->storeClassRepository( $filename, $class )


The storeClassRepository() function saves the repository for the named class in the specified file.


 $session->saveClassRepository( "save.rps", "Host" );


subscribeEvent


$session->subscribeEvent( $object, $event )


The subscribeEvent() function subscribes to a specific event without using wildcard pattern matching,
unlike subscribeAll().


The function unsubscribeEvent() cancels subscriptions that were established by using subscribeEvent().
The section unsubscribeEvent provides additional information.


 $session->subscribeEvent( "Router::gateway39", "Down" );


subscribeAll


Note   Use InCharge::session->subscribe() instead.


VMware Smart Assurance Perl Reference Guide


VMware, Inc.  92







topologySubscribe


$session->topologySubscribe( )


The topologySubscribe() function subscribes to notifications of topology updates.


The subscription/observer mechanism is described in detail in “Event subscription” on page 22. API
subscriptions topology subscriptions may be reversed by using topologyUnsubscribe().


topologyUnsubscribe


$session->topologyUnsubscribe( )


The topologyUnsubscribe() function cancels topology subscriptions previously requested with the
topologySubscribe() function. The section topologySubscribe provides additional information.


 $session->topologyUnsubscribe( );


transactionAbort


$session->transactionAbort( )


Use InCharge::session>abortTxn instead.


The transactionAbort() function aborts a transactional block previously started by using transactionStart().
The section transactionStart provides additional information.


transactionCommit


$session->transactionCommit( )


The transactionCommit() function commits a transactional block previously started using
transactionStart(). The section transactionStart provides additional information


transactionStart


$session->transactionStart( $lock_code )


The transactionStart() function starts a transaction block, which may subsequently be aborted or
committed by using transactionAbort()/transactionCommit().


 sub SM_READ_LOCK { 1 };


$session->transactionStart( SM_READ_LOCK );


The $lock_code values have the possible values shown in Lock code literals.
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Table 4‑13.  Lock code literals


Lock code Literal


0 SM_NO_LOCK


1 SM_READ_LOCK_ONLY


2 SM_READ_LOCK


3 SM_WRITE_LOCK


unsubscribeAll


Note   Use InCharge::session->unsubscribe() instead.


unsubscribeEvent


$session->unsubscribeEvent( $object, $event )


The unsubscribeEvent() function unsubscribes from the event previously subscribed by using
subscribeEvent(). The section subscribeEvent provides additional information.
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IPv6 Considerations 5
This chapter includes the following topics:


n Conventions for specifying IPv6 addresses


n Controlling name resolution


Conventions for specifying IPv6 addresses
Internet Protocol version 6 (IPv6) uses colons (:) in its addresses instead of periods (.), which are used in
Internet Protocol version 4 (IPv4) .


Sometimes when you use VMware Smart Assurance APIs or command-line utilities, you need to specify
an IP address with a port number. The port number is delimited by a colon (:). (The combination of an IP
address and port number is also called a socket.)


For the IPv6 address and port number to be interpreted correctly, specify the IPv6 address by using one
of the following conventions:


n Enclose the IPv6 address within a pair of double quotation marks and square brackets. The syntax is:


"[ipv6_address]:port"


"[2001:0db8::0010]:65000"


n Enclose the IPv6 address with a pair of back slashes and square brackets. The syntax is:


\[ipv6_address\]:port


\[2001:0db8::0010\]:65000


n If the port is a default port, omit the port number and specify only the IPv6 address. No additional
convention notations are needed.


For example, for an IPv6 address and the default port of 162, specify:


2001:0db8::0010


Controlling name resolution
The order in which name resolution is performed depends on how you specify a hostname and whether
the SM_IP_VERSIONS environment variable is set.
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When a user specifies a hostname for an VMware Smart Assurance utility or the Perl API, the behavior
occurs in the following order:


1 If the hostname includes an explicit Internet Protocol (IP) protocol (the suffix to the right of the colon),
the hostname is resolved to an address of that protocol. For example:


n frame.someDomain.vmware.com:v4 —Resolves to an IPv4 address.


n frame:v6 —Resolves to an IPv6 address.


n frame:v4v6 —Resolves to an IPv4 address, or, if that fails, to an IPv6 address.


n frame:v6v4 —Resolves to an IPv6 address, or, if that fails, to an IPv4 address.


2 If the hostname does not include an explicit IP protocol, the utility searches for the
SM_IP_VERSIONS environment variable and uses the setting specified for variable. The
SM_IP_VERSIONS environment variable is described in The SM_IP_VERSIONS environment
variable.


3 If the environment variable is not set and the IP protocol is not explicitly provided, the default behavior
is to resolve the hostname as an IPv6 address, or, if that fails, to an IPv4 address (the behavior for
the v6v4 suffix).


Additional information about discovery and name resolution is provided in the
VMware Smart Assurance IP Management Suite Discovery Guide and the
VMware Smart Assurance IP Manager Deployment Guide.


The SM_IP_VERSIONS environment variable
The SM_IP_VERSIONS environment variable enables you to control the Internet Protocol (IP) version
used for name resolution.


This affects VMware Smart Assurance utilities that use a command line (for example, dmctl), some ASL
scripts, the Perl API, and DNS lookup of undiscovered hostnames.


The variable can be set depending on the order in which you want to do name resolution. If the variable is
not set, and the IP protocol is not explicitly provided (for example, frame.someDomain.vmware.com:v4),
the default behavior is to resolve the hostname as an IPv6 address, or, if that fails, to an IPv4 address.
The variable should be set to the Internet Protocol version that is predominate for the network.


To set this variable, add it to the runcmd_env.sh file, which is located in the BASEDIR/smarts/local/conf
directory of the product suite.


The syntax of the environment variable is:


SM_IP_VERSIONS="ip_value"


Acceptable values for the SM_IP_VERSIONS environment variable lists acceptable values for the
SM_IP_VERSIONS environment variable.
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Table 5‑1.  Acceptable values for the SM_IP_VERSIONS environment variable


ip_value Description


"V4" Hostname is resolved to an IPv4 address.


"V6" Hostname is resolved to an IPv6 address.


"V4V6" Hostname is resolved to an IPv4 address. If that fails, the Domain Name System server tries to
resolve the hostname to an IPv6 address.


"V6V4" Hostname is resolved to an IPv6 address. If that fails, the Domain Name System server tries to
resolve the hostname to an IPv4 address (default).


Note: The acceptable value can also be lowercase ("v4", "v6", "v4v6" or "v6v4").


Detailed instructions about setting environment variables and information about the runcmd_env.sh file is
provided in the VMware Smart Assurance System Administration Guide.
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Preface 1
As part of an effort to improve its product lines, VMware periodically releases revisions of its software and
hardware. Therefore, some functions described in this document might not be supported by all versions of
the software or hardware currently in use. The product release notes provide the most up-to-date
information on product features.


Contact your VMware representative if a product does not function properly or does not function as
described in this document.


Note   This document was accurate at publication time. New versions of this document might be released
on the VMware online support website. Check the VMware online support website to ensure that you are
using the latest version of this document.


This chapter includes the following topics:


n Purpose


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n VMware Smart Assurance Service Assurance Manager


n Related documentation


n VMware Smart Assurance Service Assurance Manager documentation


n Conventions used in this document


n Where to get help


n Your comments


Purpose
The VMware Smart Assurance Business Dashboard is a web-based interface that enables customers,
operators, and administrators to access information about the status of their managed infrastructure from
any standard browser, from any location. This document describes how to configure the
VMware Smart Assurance Business Dashboard. Configuration tasks include configuring Tomcat Servlet
Engine, saving views in the Global Console as viewlets, writing HTML, and configuring the interaction and
operation of dashboard viewlets.
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Audience
This document is intended for system or network administrators and IT managers responsible for the
configuration and management of the VMware Smart Assurance Business Dashboard. Administrators
responsible for deploying web portals that incorporate dashboard viewlets or the web console will also
find this document useful.


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<productsuite>.


n For example, on UNIX operating systems, VMware Smart Assurance Service Assurance Manager is,
by default, installed to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than/opt/InCharge (on UNIX)
but you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.


VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System


n Global Console


n Business Dashboard


n Companion User Interface (CUI)


n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)


n XML Adapter


n VMware Smart Assurance Adapter for UIM/O
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Related documentation
In addition to this document, VMware Corporation provides a help system for command line programs as
well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


n VMware Smart Assurance Common Information Model (ICIM) 1.11 Reference for Non-Service
Assurance Manager Products


n VMware Smart Assurance Common Information Model (ICIM) Reference for Service Assurance
Manager


n VMware Smart Assurance Foundation Documentation Portfolio


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ASL Reference Guide


n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide


Note   These documents are updated periodically. Electronic versions of the updated manuals are
available on the VMware online support website:


docs.vmware.com


VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes


n VMware Smart Assurance Open Source License and Copyright Information


n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers
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n VMware Smart Assurance Service Assurance Manager Deployment Guide


n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide


n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide


n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance Companion UI Open Source License and Copyright Information for GPLv3
as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance products.


Conventions used in this document
VMware uses the following conventions for special notices:


Note   NOTICE is used to address practices not related to personal injury.


Typographical conventions
VMware uses the following type style conventions in this document:


Normal Used in running (nonprocedural) text for:
n Names of interface elements
n Names of resources, attributes, pools, Boolean expressions, buttons, DQL statements,


keywords, clauses, environment variables, functions, and utilities
n URLs, pathnames, filenames, directory names, computer names, links, groups, service


keys, file systems, and notifications


Bold Used in running (nonprocedural) text for names of commands, daemons, options, programs,
processes, services, applications, utilities, kernels, notifications, system calls, and man pages
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Used in procedures for:
n Names of interface elements
n What the user specifically selects, clicks, presses, or types


Italic Used in all text (including procedures) for:
n Full titles of publications referenced in text
n Emphasis, for example, a new term
n Variables


Courier
Used for:
n System output, such as an error message or script
n URLs, complete paths, filenames, prompts, and syntax when shown outside of running text


                      
  Courier bold
                     


Used for specific user input, such as commands


                      
  Courier italic
                     


Used in procedures for:
n Variables on the command line
n User input variables


< > Angle brackets enclose parameter or variable values supplied by the user


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example


Pathname conventions
Directory pathnames are shown with forward slashes (/).


Graphical conventions
Under UNIX, the consoles appear with slight differences. For example, in views that display items in a
tree hierarchy such as the Topology Browser, an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to VMware Smart Assurance programs
such as Domain Managers, Global Managers, and adapters.


Where to get help
VMware support, product, and licensing information can be obtained as follows:


Product information
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For documentation, release notes, software updates, or information about VMware products, licensing,
and service, go to the VMware online support website (registration required) at:


         


         docs.vmware.com
      


For technical support, click Get Support or Contact Customer Service on VMware Online Support at 
support.vmware.com. To open a service request through VMware Online Support, you must have a valid
support agreement. Contact your VMware Sales Representative for details about obtaining a valid
support agreement or to answer any questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:


docs.vmware.com.
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Overview 2
The VMware Smart Assurance Business Dashboard displays the results of VMware Smart Assurance
analysis in a flexible, web-based user interface. The VMware Smart Assurance Business Dashboard
provides the views from the Global Console as individual components called dashboard viewlets. A
dashboard viewlet is implemented as a Java applet.


You can configure the display and contents of dashboard viewlets to customize the presentation of
VMware Smart Assurance analysis, enabling you to deliver role-based views of the managed topology
across all layers of your IT environment, including:


n Business managers can view status summaries for systems and business processes


n Operations staff can view real-time operational status of monitored elements and services


n Users can drill down to see the health and status of related infrastructure, applications, and business
services


Installing the VMware Smart Assurance Business Dashboard provides all of the components
necessary to create, configure, and display dashboard viewlets. Chapter 6 Examples of Dashboard
viewlets includes a set of ready-to-use viewlets.


In addition, an installation of the VMware Smart Assurance Business Dashboard includes the web
console, which displays the Global Console within a web browser. The web console provides the
same functions and features as the Global Console.
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Architecture of Service
Assurance Manager with the
dashboard 3
While the Global Console is the primary user interface for VMware Smart Assurance software, the
VMware Smart Assurance Business Dashboard provides another means of viewing and responding to
the analysis provided by VMware Smart Assurance Service Assurance Manager. The
VMware Smart Assurance Business Dashboard provides additional features:


n Dashboard viewlets can be displayed in any supported web browser from any location. The web
clients do not require an installation of VMware Smart Assurance software.


n Dashboard viewlets can be embedded into a web Portal, combining VMware Smart Assurance’
analysis with information from other sources.


Architecture of Service Assurance with Business Dashboard illustrates how the
VMware Smart Assurance Business Dashboard integrates with VMware Smart Assurance Service
Assurance Manager.
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Figure 3‑1.  Architecture of Service Assurance with Business Dashboard


n The following components, illustrated in Architecture of Service Assurance with Business Dashboard,
are related to the VMware Smart Assurance Business Dashboard:


n Global Manager consolidates topology and event information it receives from data sources such as
VMware Smart Assurance Managers. The Global Manager provides this data to clients such as the
Global Console or dashboard viewlets.


n VMware Smart Assurance Business Dashboard is a collection of dashboard viewlets that are
displayed in a web page. A viewlet can also be embedded within a web portal page or loaded from a
dynamically generated URL.


n Tomcat Servlet Engine serves the JAR files that compose dashboard viewlets and the map layout
servlet. The servlet engine is installed as a service with the
VMware Smart Assurance Business Dashboard. If you are already running a web server, you can use
it to serve the necessary files to display dashboard viewlets.
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Software requirements 4
VMware Smart Assurance Business Dashboard includes the necessary files and software for serving the
files to display dashboard viewlets and the web console.


This chapter includes the following topics:
n Client requirements


n Server requirements


Client requirements
Users who display dashboard viewlets in a web browser, or want to use the web console, require the
following software:


n One of the following web browsers:


n Internet Explorer 7.0 and 6.0 with Service Pack 1


n Firefox 1.5.x


n Browser that supports Java JRE 1.6.15 or later


Note   Only browsers running on HP-UX,Linux and Solaris operating systems are supported.


Use Firefox instead of Microsoft IE if you need to use an IPv6 literal address to access the Web
Console or Business Dashboard.


n Java 2 Platform Standard Edition 5.0 which includes the 1.6.x web browser Plug-in


When using Internet explorer with JRE 1.6, exiting the Web Console or Business Dashboard by
choosing File > Exit does not clear the display on the browser window. The browser window displays
whatever was displayed in the window at the time you exited the application. This does not impact the
functionality. Instead of exiting the browser, you can either:


n Close the Web browser


n Type a new URL in the Web browser
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Server requirements
An installation of the VMware Smart Assurance Business Dashboard includes the Tomcat Servlet Engine,
which is necessary to serve the JAR files and map layout servlet. The servlet engine is installed as the
VMware Smart Assurance Servlet Engine service on the system where you install the
VMware Smart Assurance Business Dashboard.


If you wish to serve dashboard viewlets from a different web server, you must install the
VMware Smart Assurance Business Dashboard to obtain the necessary files. Deploying viewlets provides
a description of these files.
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Configuring the
VMware Smart Assurance
Business Dashboard 5
This chapter includes the following topics:
n Overview


n Serving Dashboard viewlets


n About user profiles and user accounts


n About Dashboard viewlets


n HTML syntax for viewlets


n URL-addressable viewlets


n About the web console


Overview
The configuration tasks for VMware Smart Assurance Business Dashboard depend on how you intend to
deploy it. A simple deployment could use the sample viewlets as an
VMware Smart Assurance Business Dashboard to display information from a Global Manager. A more
complicated deployment could involve creating new HTML pages to display Dashboard viewlets,
configuring the display of viewlets, creating an on-demand URL addressable viewlet, or integrating a
viewlet with a portal.


The configuration steps necessary to provide these deployments are described in this chapter and involve
one or more of the following tasks:


n Configuring the Tomcat Servlet Engine or an alternative web server


n Configuring user accounts on the Global Manager


n Creating saved viewlets with the Global Console


n Writing HTML to display viewlets


n Creating a URL-addressable viewlet
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Serving Dashboard viewlets
The Servlet Tomcat Engine is installed into the BASEDIR/smarts/tomcat directory on the host where the
VMware Smart Assurance Business Dashboard is installed. If you intend to use Tomcat to serve
Dashboard viewlets, you should install the VMware Smart Assurance Business Dashboard onto the
system from which you want to serve the relevant files. This can be a different host from where the
Global Manager, or any other Service Assurance component is installed.


The Servlet Tomcat Engine, its directory structure, and the Tomcat configuration files are not developed
by VMware Smart Assurance. As such, the files under this directory, including the files related to the
VMware Smart Assurance Business Dashboard, are not intended to be edited using the sm_edit utility.
Instead, open and edit any files under the BASEDIR/smarts/tomcat directory with a text editor.


Tomcat Servlet Engine directories lists relevant subdirectories under BASEDIR/smarts/tomcat related to
the configuration and running of VMware Smart Assurance Business Dashboard.


Table 5‑1.  Tomcat Servlet Engine directories


Directory Description


/conf Contains Tomcat configuration files, including server.xml


/webapps Contains directories and files served by Tomcat:
n /templates includes JAR files, viewlets, configuration files, and HTML files


related to the samples described in Chapter 6 Examples of Dashboard
viewlets


n /webconsole includes the files for the web console.


About the VMware Smart Assurance Servlet Engine service
The Servlet Tomcat Engine is installed as a service named the VMware Smart Assurance Servlet Engine.
As a service, it starts automatically with the system and runs continuously until it is manually stopped. The
VMware Smart Assurance Servlet Engine serves the HTML, JAR, and map layout servlet for both
Dashboard viewlets and the web console.


Default service parameters
The VMware Smart Assurance Servlet Engine service is installed with the following options:


tC:/InCharge/SAM/smarts/bin/sm_service install --force 


--startmode=runonce --description=”VMware Smart Assurance Servlet Engine” 


--name=”ic-business-dashboard” /C:/InCharge/SAM/smarts/bin/sm_tomcat --output start s


Starting and stopping the VMware Smart Assurance Servlet Engine
The sm_service utility is used to start and stop services. Invoke the following commands from the
BASEDIR/smarts/bin directory on the host where the service is running:


VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


VMware, Inc.  16







To stop the VMware Smart Assurance Servlet Engine service:


./sm_service stop ic-business-dashboard


To start the VMware Smart Assurance Servlet Engine service:


./sm_service start ic-business-dashboard


The VMware Smart Assurance System Administration Guide provides additional information about
services.


Verify that Tomcat is running
After the VMware Smart Assurance Servlet Engine service is installed and started, you can verify whether
Tomcat is running by opening the following URL in a web browser: http://<tomcat_host>:<port>, where
<tomcat_host> is the system where the VMware Smart Assurance Business Dashboard is installed and
<port> is the TCP port the Tomcat Servlet Engine is listening on.


You can also access the Tomcat Servlet Engine documentation from the following URL:
http://<tomcat_host>:<port>/tomcat-docs.


Changing the port number of Tomcat
For most installations, Tomcat should not require any additional configuration. In some cases, however, it
may be necessary to change the port number on which the Tomcat Servlet Engine is running.


The configuration of Tomcat is determined by the server.xml file located in the
BASEDIR/smarts/tomcat/conf directory. By default, Tomcat is configured to use TCP port 8080. If this port
is already in use on the system where the VMware Smart Assurance Business Dashboard is installed,
you can configure Tomcat to use another port.


To change the port number, find the following lines in server.xml:


<Connector port="8080" maxHttpHeaderSize="8192"


   maxThreads="150" minSpareThreads="25" maxSpareThreads="75"


   enableLookups="false" redirectPort="8443" acceptCount="100"


   connectionTimeout="20000" disableUploadTimeout="true" />


Change the port number to a suitable number. If Tomcat is currently running, you will need to restart it.


You may also need to change the shutdown server port number. Port number 8005 is the default port for
the shutdown server. To change the shutdown server port number, find the following line in the server.xml:


<Server port="8005" shutdown="SHUTDOWN">


Change the port number to a suitable number.


For more information regarding Tomcat Servlet Engine, see http://tomcat.apache.org
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Increasing the heap space
You can increase the heap space for the Java Plug-in and for Java Web Start.


Increasing the Java Plug-in heap space


If the web console or viewlets run out of memory, adjust the maximum amount of heap space that the
Java Plug-in uses for dynamic memory allocation. By specifying -Xmx256m as a runtime parameter, for
example, you can increase the heap space allocation to 256 MB. The number can be set larger or smaller
than 256 MB, depending on the resources available on the client machine running the web browser.


To increase the heap space for the Java Plug-in:


1 Launch the Java Control Panel. The Sun website provides instructions (http://java.sun.com).


2 In the Java Control Panel, click the Java tab.


3 In the Java Runtime Environment Settings section, click the View button.


The Java Runtime Environment Settings dialog box appears.


4 In the Runtime Parameters field, type the maximum heap-space runtime parameter (-Xmx) and a
value for the parameter.


For example: -Xmx330m. Java Runtime Environment Settings illustrates the Java Runtime
Environment Settings dialog box.


Figure 5‑1.  Java Runtime Environment Settings


The heap-space runtime parameter specifies heap size in megabytes, for example, -Xmx330m
increases the heap space to 330 megabytes.


5 Click OK.


6 Click the Java Control Panel Apply button.
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7 Terminate and restart any web browser running on the host machine.


For the Java Web Start, the heap space defaults to 350 megabytes.


Increasing Java Web Start heap space


To increase the heap space for the Java Web Start:


1 Using a text editor, open the BASEDIR/smarts/tomcat/webapps/webconsole/globalConsoleApp.jnlp
file.


2 Locate the following line:


<j2se version="1.6.0+" max-heap-size="350M"/>


3 Change the max-heap-size variable value.


4 Save and close the file.


Deploying viewlets
Directories under BASEDIR/smarts/tomcat/webapps contain the web applications served by the Tomcat
Servlet Engine. For example, the sample Dashboard viewlets included with
VMware Smart Assurance Business Dashboard are installed to the
BASEDIR/smarts/tomcat/webapps/templates directory. Each directory under /webapps must contain the
JAR, HTML, and configuration files necessary for the web application to run.


You can choose one of the following methods to deploy Dashboard viewlets:


n Modify the template files under BASEDIR/smarts/tomcat/webapps/templates. You can also add your
own new viewlet files to this directory.


n Create your own viewlets directory under /webapps. You must ensure that the new directory contains
the files and directories listed in Files used for viewlets, which can be copied from the templates
directory. After you create the new directory and add the necessary files, you need to restart the
VMware Smart Assurance Servlet Engine service.


Table 5‑2.  Files used for viewlets


File or directory Description


HTML files HTML files that specify the layout of viewlets, including the JAR files and configuration
parameters.


jcommon-0.7.0.jar


jfreechart-0.9.3.jar


masterpiece.jar


tsgdtj50.jar


tsgetj50.jar


tsglt50.jar


tsgltc50.jar


tsgmtj50.jar


JAR files necessary for displaying VMware Smart Assurance Business Dashboard
viewlets. All JAR files are required.
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Table 5‑2.  Files used for viewlets (Continued)


File or directory Description


dashboard.properties [Optional] Properties file to specify parameters that apply to all viewlets. This file must
be specified in the HTML using the com.smarts.propertiesFile parameter. Specifying
additional viewlet properties provides additional information about HTML parameters.


viewlet.properties [Optional] Property file to specify parameters for a specific viewlet. This file must be
specified in the HTML using the com.smarts.viewletProperties parameter. Specifying
additional viewlet properties provides additional information about HTML parameters.


WEB-INF Directory indicates that Tomcat should serve the files contained in this directory upon
request. This directory is required by Tomcat.


Deploying viewlets with a third-party web server
If you deploy viewlets using a different web server, the JAR files listed in Deploying viewlets with a third-
party web server are required. The properties files are optional, but recommended as they simplify
configuration of viewlets. Copy the necessary files listed in Deploying viewlets with a third-party web
server to the host where the web server is running.


Note   If you intend to display Map viewlets, the web server must be capable of executing servlets.


In addition, the files in Additional files needed for third-party web server must be installed on the server.


Table 5‑3.  Additional files needed for third-party web server


Operating system Files needed


Solaris/Linux libagraphj.so


libblayj.so


libclayj.so


libclidemoj.so


libdgraphj.so


libhlayj.so


libjagraphj.so


libjclayj.so


libjdgraphj.so


libjhlayj.so


libjmgraphj.so


libjolayj.so


libjslayj.so


libjtlayj.so


libjutilsj.so


libmgraphj.so


libnlayj.so


libolayj.so


libslayj.so


libtlayj.so


libtsgltextj.so


libtsgltj.so


libutilsj.so


HP-UX libagraphj.sl


libblayj.sl


libclayj.sl


libclidemoj.sl


libdgraphj.sl


libhlayj.sl


libjagraphj.sl


libjclayj.sl


libjdgraphj.sl


libjhlayj.sl


libjmgraphj.sl


libjolayj.sl


libjslayj.sl


libjtlayj.sl


libjutilsj.sl


libmgraphj.sl


libnlayj.sl


libolayj.sl


libslayj.sl


libtlayj.sl


libtsgltextj.sl


libtsgltj.sl


libutilsj.sl


Architecture when using a third-party web server illustrates the flow of information when using a web
server other than the VMware Smart Assurance Servlet Engine to serve viewlets.
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Figure 5‑2.  Architecture when using a third-party web server


To deploy the Dashboard viewlets with another web server (for example, a future version of Tomcat 6.x or
7.x), perform the following steps:


Note   Version numbers and directory paths in these steps are for example only.


1 Install Tomcat 6.x or 7.x.


2 Set JAVA_HOME. For example, JAVA_HOME=C:\Program Files\JAVA\jdk1.6.0_15. Add the line to
the catalina.bat file in the following location:


n C:\tomcat-6.x\bin for Tomcat 6.x.


n C:\tomcat-7.x\bin for Tomcat 7.x.


3 Copy BASEDIR\smarts\tomcat\webapps\tss, \webapps\webconsole, and \webapps\templates to the
new directory. For example, to the following location:


n C:\tomcat-6.x\webapps for Tomcat 6.x.


n C:\tomcat-7.x\webapps for Tomcat 7.x.


4 Create a "lib" folder under the following location:


n C:\tomcat-6.x\webapps\tss\WEB-INF for Tomcat 6.x.


n C:\tomcat-7.x\webapps\tss\WEB-INF for Tomcat 7.x.


and copy the JAR files from BASEDIR\smarts\tomcat\webapps\webconsole to this new folder.
You need only copy the JAR files that begins with “tsg.”
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5 Ensure that BASEDIR\smarts\lib is in the system path (used in the library path for UNIX installs) when
Tomcat is started. This directory includes libraries that the servlet needs.


Note   This only works if the web server is on the same host as the Dashboard or Global Console. If
they are not, you must copy libraries from the BASEDIR\smarts\lib of the Dashboard or Global
Console to the machine where the server is installed. Additional files needed for third-party web
server lists these files.


6 Start the Tomcat engine using your standard web server startup command:


..\tomcat-6.x\bin\startup.bat


..\tomcat-7.x\bin\startup.bat


Configuring the web console, Business Dashboard, Dashboard viewlets, and
Global Console to use a proxy server
You can configure the Business Dashboard and Dashboard viewlets to use a proxy server to
communicate with VMware Smart Assurance applications (for example, IP Availability Manager and
Global Manager) that reside behind a firewall. Using a proxy server, the number of firewall ports that need
to be opened is reduced to one.


Before you configure these VMware Smart Assurance Java clients, ensure that the web server that will
act as the proxy satisfies the requirement. Requirement for the proxy server describes these
requirements.


To configure the VMware Smart Assurance Java clients to use a proxy server, perform the following
steps:


1 Your firewall administrator needs to open Port 80 on the firewall to enable communications between
the client and a web server.


Through a series of requests, the client communicates with a web server and that web server acts as
the proxy to the VMware Smart Assurance applications.


2 Use a text editor (not sm_edit) to edit the Proxy properties described in Parameters for properties file
in the appropriate properties file (where BASEDIR is/opt/InCharge/SAM/smarts or
C:\InCharge\SAM\smarts\):


n If you are using the web console (or Java Web Start), modify the webconsole.properties file in the


n BASEDIR/smarts/tomcat/webapps/webconsole directory.


n If you are using the Business Dashboard and viewlets, modify the dashboard.properties file in
the


n BASEDIR/smarts/tomcat/webapps/templates directory.


3 Use the sm_edit utility to modify the properties.conf file.


n If you are using the Global Console, modify the BASEDIR/smarts/conf/console/properties.conf file
on the machine where the Global Console is running.
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Table 5‑4.  Parameters for properties file


Parameter Value


com.smarts.proxyHost "<Host name where the web server is running>"


com.smarts.proxyPort <Port number of the web server>


com.smarts.proxyAuthString "<Authentication string if authentication is required>"


com.smarts.proxyAdditionalHeaders "<Additional HTTP Requests if any >"


The parameters com.smarts.proxyAuthString and com.smarts.proxyAdditionalHeaders are optional.


For com.smarts.proxyAuthString, the value depends upon the type of authentication scheme the web-
server supports. For example, if it supports Basic Access Authentication Scheme, and if the Username is
“User” and Password is “Password,” the value would be:


"Proxy-Authorization: basic VXNlcjpQYXNzd29yZAo=\r\n"


Then string “VXNlcjpQYXNzd29yZAo=” would be the base64 encoding of, “User:Password”.


For com.smarts.proxyAdditionalHeaders, the value could be any valid HTTP request like this, for
example:


         "GET http://www.example.com HTTP/1.1 \r\nHost: example.domain.com \r\n" 


      


Requirement for the proxy server
The connection time-out mechanism implemented in
VMware Smart Assurance Service Assurance Manager makes use of a standard TCP feature known as
“urgent data” or “out of band data.”


The HTTP proxy used with this code must pass the “out of band data” as is.


The RFCs that define the correct operation of HTTP proxies require that the proxies provide a transparent
network connection. However, they do not explicitly mention support of out of band data.


Because of the large number of HTTP proxy implementations in use, VMware, Inc. is not in a position to
indicate which, if any, fail to correctly pass out of band data.


Please check if the proxy server you are considering passes out of band data. Contact
VMware Smart Assurance Global Services if the proxy server does not pass TCP urgent data.


Encrypted connections
Encrypted connections between Dashboard viewlets and the Global Manager are configured using two
environment variables:


n SM_OUTGOING_PROTOCOL — Controls the connections that an VMware Smart Assurance
program acting as a client is allowed to initiate.
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n SM_INCOMING_PROTOCOL — Controls the connections that an VMware Smart Assurance
program acting as a server is allowed to accept.


The variables are set in the runcmd_env.sh file, which is located in the BASEDIR/smarts/local/conf
directory. The variables may be set to “0” (unencrypted connection), “1” (encrypted connection), or
“1,0” (both encrypted and unencrypted connections).


The default setting is to use both encrypted and unencrypted connections which means that the
Dashboard viewlets and the Global Manager automatically negotiate the connection to the highest
level of encryption possible.


Encryption can be controlled by setting similar variables in the HTML code that displays the
Dashboard viewlet. Specifying viewlet parameters in HTML and Using a properties file to specify
viewlet parameters provide additional information.


For these two methods, the following variables are used:


n com.smarts.incoming_protocol — Controls the connections that an VMware Smart Assurance
program acting as a server is allowed to accept.


n com.smarts.outgoing_protocol — Controls the connections that an VMware Smart Assurance
program acting as a client is allowed to initiate.


The VMware Smart Assurance System Administration Guide provides detailed information about
encrypted connections.


Using SSL (https://)
If your deployment requires the use of Secure Socket Layer (SSL), you need to perform the following
steps before you launch the Dashboard with the https protocol:


Note   The ssl-howto.html document in the BASEDIR/smarts/tomcat/webapps directory on your system
provides detailed information. Or, access the document from the website:
http://tomcat.apache.org/tomcat-5.5-doc/ssl-howto.html.


1 Prepare a "self-signed" certificate.


If you do not purchase a Certificate from a Certificate Authority, you can generate a Certificate.


For example:


java1.5_HOME> /bin/keytool.exe -genkey -alias tomcat -keyalg  RSA - keystore testKeystore


Enter keystore password:  changeit


What is your first and last name?


  [Unknown]: User Name


What is the name of your organizational unit?


  [Unknown]: Engineering


What is the name of your organization?


  [Unknown]: VMware Smart Assurance


What is the name of your City or Locality?


  [Unknown]:  White Plains


What is the name of your State or Province?


  [Unknown]: NY
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What is the two-letter country code for this unit?


  [Unknown]: US


Is CN=User Name, OU=Engineering, O=VMware Smart Assurance, L=White Plains, ST=NY, C=US correct?


  [no]:  yes


Enter key password for <tomcat>


        (RETURN if same as keystore password):<Return>


2 Configure Tomcat:


3 In the Tomcat home directory, back up the conf/server.xml file. Then, edit the file.


4 Find the SSL connector element which is commented out (<!-- commented out text -->):


<-- Define an SSL HTTP/1.1 Connector on port 8443 


-->


<!--


<Connector port="8443" 


maxThreads="150" minSpareThreads="25" maxSpareThreads="75"


enableLookups="false" disableUploadTimeout="true"


acceptCount="100" debug="0" scheme="https" secure="true"


clientAuth="false" sslProtocol="TLS" />


-->


5 Uncomment the lines and edit them to include the keystore file that you created. The preceding will
look like this:


<!-- Define an SSL HTTP/1.1 Connector on port 8443 


-->


    


<Connector port="8443" 


maxThreads="150" minSpareThreads="25" maxSpareThreads="75"


enableLookups="false" disableUploadTimeout="true"


keystoreFile="C:\InCharge\SAM\smarts\tomcat\testKeystore" keystorePass="changeit"


acceptCount="100" debug="0" scheme="https" secure="true"


clientAuth="false" sslProtocol="TLS" />


6 Then comment out the non-SSL connector used for http, to look like this:


<!-- Define a non-SSL HTTP/1.1 Connector on the


port specified during installation  -->


<!--


<Connector port="8080" 


maxThreads="150" minSpareThreads="25" maxSpareThreads="75"


enableLookups="false" redirectPort="8443"


acceptCount="100"


debug="0" connectionTimeout="20000" 


disableUploadTimeout="true" />


--> 


VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


VMware, Inc.  25







7 If the com.smarts.layoutServlet property is defined, ensure that the dashboard.properties and
webconsole.properties point to the correct URL so that the maps lay out properly:


com.smarts.layoutServlet="https://localhost:8443/tss/


LayoutServer"


8 Start the Tomcat engine using the following command:


 ./sm_service start ic-business-dashboard


9 In the URL that will launch the web application, replace:


http://localhost:8080/ 


https://localhost:8443/ 


10 Launch the Dashboard by typing the following URL in the browser's Address field:


 https://localhost:8443/templates


The system displays a Security Alert window that provides information about the Certificate being
used. On accepting it, a Directory Listing for templates is displayed, as in the case of the non-SSL
Dashboard.


About user profiles and user accounts
Users who attach to a Global Manager, whether through the Global Console, the web console, or a web
browser, must have a user account. Each user account, in turn, is associated with a user profile. A user
profile defines the console operations a user can perform, the tools the user can invoke, and the
notifications displayed to the user. The
VMware Smart Assurance Service Assurance Manager Configuration Guide provides detailed information
about user profiles.


If a user attaches to a Global Manager using both the Global Console and a web browser, the same user
profile can apply for both connections.


When you save a viewlet, you can save it to a user’s directory or a user profile directory. In both cases,
the directory is located in the BASEDIR/smarts/local/consoles directory on the host where the
Global Manager is running. Dashboard viewlets saved to a user’s directory are only accessible to that
user. The name of a user’s directory is the same as the username. Dashboard viewlets saved to a user
profile directory are accessible by any user associated with that user profile. The name of the user profile
directory is the same as the user profile name.


You must create the user profiles and user accounts before you can save a viewlet to a user’s directory or
a user profile.
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About Dashboard viewlets
A Dashboard viewlet is a view from the Global Console that you can use as an applet. As such, you can
use viewlets in the following ways:


n Create an HTML page that includes one or more viewlets to provide a customized display of
VMware Smart Assurance analysis. Because this view is displayed in a web browser, it is accessible
from any host with a web browser.


n Provide an application that dynamically generates a URL in response to a notification that displays
one or more viewlets in a web browser.


n Embed a viewlet within a web portal application to combine the information from the Global Manager
within an existing information view.


The configuration tasks that must be completed to provide any of the above Dashboard viewlets are
similar. After you create a viewlet for a web page, for example, you could also embed that same
viewlet within a portal. This enables you to re-use viewlets, assigning them as necessary according
the user’s role or informational requirements.


You can also use the Dashboard viewlets located in the BASEDIR/smarts/tomcat/webapps/templates
directory. The HTML code for each viewlet has been converted to HTML that displays properly in both
Netscape and Internet Explorer. Chapter 6 Examples of Dashboard viewlets provides additional
information about the sample viewlets. The HTML converter used to create browser-specific HTML is
installed as part of Java 2 Platform Standard Edition 6.0.


Global Console views that function as viewlets
The following views from the Global Console can also be displayed as viewlets:


n Notification Log


n Status Table


n Summary View


n Containment


n Notification Properties


You can display these console elements as viewlets by specifying their parameter name and any
configuration parameters in the HTML code. “HTML syntax for viewlets” on page 35 provides
additional information regarding the HTML syntax for viewlets.


Saving views as viewlets
You can configure the views listed below using the Global Console and save them as viewlets:


n Notification Log


n Status Tables
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n Summary Views


Unless noted otherwise, the configuration options provided through the Global Console are retained
in the viewlet file.


To save a view as a viewlet:


a Configure the view using the Global Console.


The VMware Smart Assurance Service Assurance Manager Operator Guide provides additional
information.


b Select View > Save View As Viewlet to open the Save View As Viewlet dialog box. You need to
provide the following information to save the viewlet:


n Global Manager where the Dashboard viewlet is to be saved


n Location where the Dashboard viewlet is to be saved


n Dashboard viewlet name


c Select the Global Manager where the viewlet is to be saved. You can save the viewlet to any
attached Global Manager.


d Select the location on the Global Manager where the viewlet is to be saved:


n Save for User saves the viewlet into a user’s directory on the selected Global Manager
under BASEDIR/smarts/local/consoles. The list box lists users for the selected
Global Manager. If the user directory under BASEDIR/smarts/local/consoles does not exist, it
is created. A viewlet saved to a user’s directory is only accessible to that user.


n Save for User Profile saves the viewlet into a user profile directory on the selected
Global Manager under BASEDIR/smarts/local/consoles. The list box lists available user
profiles. If the user profile directory does not exist, it is created.


Any user associated with this user profile can load the viewlet, provided the viewlet is
specified by name in the web page loaded by the user.


Note   If a viewlet in the user’s directory has the same name as a viewlet in the user profile
directory, the viewlet in the user’s directory takes precedence.


e Specify a name for the viewlet. The file naming convention for saved viewlets is as follows:


  <user_specifed_name><viewlet_type>.icsvm


f Click OK.


Displaying maps
Map viewlets are not the same as the maps displayed in a Global Console. Map viewlets do not display a
topology tree from which an element can be selected. Use one of the following methods to display
elements in a Map viewlet:


n Select Show Map from a menu in another viewlet
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n Enable context sharing for the Map viewlet. Context sharing for viewlets provides additional
information.


n Save a map, as described below, and display the map by specifying its focus.


Saving maps
The purpose of saving a map is to customize the default map that is displayed for a specific element. A
saved map is associated with the element that is the focus of the map. When the focus element is
selected to display in a map, the saved map is displayed for users with access to the saved map.


A saved map can include the following information:


n Adjusted scope (for example, expanded nodes)


n Node positions


n Layout type (circular, hierarchical, or manual)


n Filtered classes


n User-defined backgrounds


To save a map, in the Map Console, select Map > Save Map. Click OK to acknowledge the pop-up
message which displays the location of the saved map. The map is saved to the user’s directory
under BASEDIR/smarts/local/consoles/ on the host where the Global Manager is running. The file
extension for a saved map is “.icsvm”.


To make a saved map available to other users, you must copy the map file to the shared location
BASEDIR/smarts/local/consoles.


The VMware Smart Assurance Service Assurance Manager Operator Guide provides additional
information about saved maps.


Displaying a saved map
To display a saved map, you must specify the topological instance that was the focus when the map was
saved. Unlike a saved viewlet, it is not necessary to specify the name of the saved map. Properties for
map viewlets describes Map viewlets.


HTML syntax for viewlets
This section describes the HTML parameters for loading and configuring Dashboard viewlets. Because
the viewlets are Java applets, you must use the HTML tags for displaying applets. The tags vary with the
version of HTML.


When you create an HTML page that displays several viewlets, using HTML frames provides control over
the layout of the viewlets. In addition, if you want to load two viewlets of the same type, two Notification
Logs for example, each viewlet must be specified in a separate HTML page. Then apply Frame tags to
display both Notification Log viewlets on the same page.
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You can examine and copy the HTML of the samples in the BASEDIR/smarts/tomcat/webapps/templates
directory. Chapter 6 Examples of Dashboard viewlets describes the viewlets and their associated HTML
files.


The HTML code in this section uses elements from the HTML 4.0 Specification.


HTML to display viewlets
Table 5 on page 36 lists the HTML tags and attributes necessary to display a Dashboard viewlet in a web
page. Subsequent sections describe attributes that enable you to further configure the viewlet.


An attribute’s name and its value must be enclosed by double quotes. When an attribute includes a set of
values, the set of values is enclosed by double quotes, as shown in the following example:


<APPLET TYPE="applet"


 CODE="com.smarts.webapps.SmWebNotificationsApp.class"


 WIDTH=”100%” HEIGHT=”100%”


 ARCHIVE="masterpiece.jar,jcommon-0.7.0.jar,\


 jfreechart-0.9.3.jar,tsgdtj50.jar,tsgetj50.jar,\


 tsglt50.jar,tsgltc50.jar,tsgmtj50.jar">


</APPLET>


Specifying additional viewlet properties
You can specify additional properties in the HTML code that displays a viewlet, or in a properties file.
These properties include parameters for the following features:


n Opening a saved view


n Enabling context sharing


n Setting the focus of a view


n Specifying connection properties


Additional viewlet properties describes each of these properties.


Specifying viewlet parameters in HTML
Parameters included in the HTML code that displays a viewlet are nested inside the <APPLET> tags and
have the following syntax:


<param name=”name” value=”value”>


In the following example, the com.smarts.context.collectionEntity parameter is set to true to enable
context listening for a Notification Log viewlet.


<APPLET TYPE="applet"


 CODE="com.smarts.webapps.SmWebNotificationsApp.class"


 WIDTH=”100%” HEIGHT=”100%”


 ARCHIVE="masterpiece.jar,jcommon-0.7.0.jar,\


 jfreechart-0.9.3.jar,tsgdtj50.jar,tsgetj50.jar,\
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 tsglt50.jar,tsgltc50.jar,tsgmtj50.jar">


 <PARAM NAME="com.smarts.context.collectionEntity"\


VALUE="true">


</APPLET>


Using a properties file to specify viewlet parameters
You can use a properties file to specify parameters for a Dashboard viewlet. One or more viewlets can
reference the properties file. This simplifies configuration because you can change the parameters within
the properties file instead of editing each HTML file.


Two parameters may be used to specify a properties file:


n com.smarts.propertiesFile specifies properties common to all viewlets. Such properties might include
the location of the VMware Smart Assurance Broker and the name of the Global Manager.


n com.smarts.viewletProperties specifies properties for a single viewlet. Such properties might enable
context sharing or set the focus of a map viewlet.


The parameters to specify a properties file for the viewlet are nested inside the <APPLET> tags and
have the following syntax:


<param name=”name” value=”value”>


"value" indicates the name of the file containing the properties. You can use any name for a
properties file.


In the following example, the HTML for a Notification Log viewlet references a properties file named
dashboard.properties:


<APPLET TYPE="applet"


 CODE="com.smarts.webapps.SmWebNotificationsApp.class"


 WIDTH=”100%” HEIGHT=”100%”


 ARCHIVE="masterpiece.jar,jcommon-0.7.0.jar,\


 jfreechart-0.9.3.jar,tsgdtj50.jar,tsgetj50.jar,\


 tsglt50.jar,tsgltc50.jar,tsgmtj50.jar">


 <PARAM NAME="com.smarts.propertiesFile" \


VALUE ="dashboard.properties">


</APPLET>


Additional viewlet properties and Encrypted connections describes the dashboard properties file. The
properties are assigned using the following syntax:


parameter_name=”value”


Quotes around the value are optional unless you need to have leading or trailing spaces as part of
the value.


VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


VMware, Inc.  31







The following properties file example sets the location of the VMware Smart Assurance Broker and
the name of the Global Manager:


smarts.remote.broker=host1.smarts.com:426


com.smarts.autoAttachDM=INCHARGE-SA


As a result, when a user opens the web page that displays the viewlet, the Attach dialog box includes
the information about the Broker and Global Manager. The user simply provides a username and
password to connect.


Additional viewlet properties
The following sections describe Dashboard viewlet properties that can be specified either in the HTML
displaying the viewlet or in a properties file. Similar properties are grouped together.


Displaying analysis servers and monitoring servers
Parameter for displaying analysis and monitoring servers describes the parameter used to display both
analysis servers and monitoring servers in the Broker dialog box.


Table 5‑5.  Parameter for displaying analysis and monitoring servers


Parameter Description


com.smarts.attachComponentServers When set to true, both analysis servers and monitoring servers are
displayed in the Broker dialog box.


Also, when this parameter is set to true, the functionality that checks for
case-insensitive strings of text in domain names is deactivated.


Note   This parameter can also be entered when using the sm_gui utility.
For example, from <BASEDIR> enter: ./sm_gui -
Dcom.smarts.attachComponentServers=true


Displaying a saved viewlet
Parameter for displaying a saved viewlet describes the parameter used to specify the name of a saved
viewlet.


Table 5‑6.  Parameter for displaying a saved viewlet


Parameter Description


com.smarts.savedView Name of the saved view that is displayed as a viewlet. Note that it is not necessary to
include the file extension, “.icsvm”, of the viewlet file.


Saving views as viewlets provides additional information about saving a viewlet.


Note   Tooltips are displayed only for Business Dashboard viewlets that are currently in focus. If you
position the cursor over an item in a viewlet that is not in focus, no tooltip appears. To display tooltips in a
viewlet other than the focused viewlet, click the second viewlet to cause it to gain focus.
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Context sharing for viewlets
Context sharing is when the focus of one viewlet determines the content that is displayed in one or more
viewlets on the same HTML page. A simple example illustrates how this might work. When instance
context sharing is enabled for a Notification Log viewlet, a user can select a failed node in a Map viewlet
and the Notification Log displays the notifications related to the selected map node. The
VMware Smart Assurance Service Assurance Manager Operator Guide provides additional information
about context sharing.


Parameters for context sharing with viewlets lists the parameters related to context sharing for viewlets
and indicates which viewlets the parameters apply to. Setting the value to true enables context sharing.


Table 5‑7.  Parameters for context sharing with viewlets


Parameter Description


com.smarts.context.notification When true, causes the viewlet to listen for notification context
changes. You can set this parameter for the following viewlets:
n Map


com.smarts.context.instance When true, causes the viewlet to listen for instance context
changes. You can set this parameter for the following viewlets:
n Map
n Notification Log


com.smarts.context.summary When true, causes a Notification Log viewlet to display the
notifications graphed in the Summary viewlet.
n Notification Log


com.smarts.context.collectionEntity When true, causes the viewlet to display information related to the
collection entity class. Collection entity classes include the following
classes and their subclasses:
n ServiceOffering
n ServiceSubscriber
n HierarchicalGroup
n SelectiveGroup
n ApplicationGroup


You can set this parameter for the following viewlets:
n Notification Log
n Map
n Summary


com.smarts.launch.globalMg Name of the Global Manager for context when the viewlet is
attached to more than one Global Manager.


Note   Notification Properties viewlets always listen for notification context and Containment viewlets
always listen for notification and instance context.


Automatic attach for viewlets
Automatic attach (autoAttach) enables you to configure a viewlet so that a user does not need to provide
a username or password to view information provided by the Global Manager.
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To make the connection to a Global Manager transparent, you must do the following:


n Edit two parameters in the dashboard.properties file (or in the viewlet HTML files).


n Configure the Dashboard credentials identifier (ID). This ID specifies the location of the
VMware Smart Assurance Broker, the name of the Global Manager, a username, and a password.


Note   The VMware Office of Product Security deems the use of this feature (Automatic attach by
storing credentials on disk) as an unsecure mode of operation. Storing credentials on disk amounts to
no user authentication. As such, VMware Corporation discourages the use of this feature.


Configure Dashboard viewlets to automatically attach to the Global Manager


The configuration of a Dashboard viewlet to automatically attach to a server involves defining two
properties in the dashboard.properties file. Alternatively, the parameters can be defined in the HTML files
used to launch the viewlets. If the properties are defined in the HTML files, they must be defined
identically in all the viewlet HTML files.


Parameters for automatic attach with viewlets describes the parameters used to configure Dashboard
viewlets to automatically attach to the Global Manager.


Table 5‑8.  Parameters for automatic attach with viewlets


Parameter Description


com.smarts.viewlet.authhttp The value of com.smarts.viewlet.authhttp specifies the URL of the servlet that will
perform the lookup and retrieval of the stored userid and password credentials.


The syntax of this parameter is http://<tomcat_host>:
8080/SMViewletAuth/ViewletAuth.do?MASK=0


If web server is configured to run over https, then the syntax to be used is:
https://<tomcat_host>:8443/SMViewletAuth/ViewletAuth.do?MASK=0, where port 8443
is the secure port (the port may differ depending on how the web server is configured). 
Using SSL (https://) provides additional information.


com.smarts.attach.alias The value of com.smarts.attach.alias is a unique identifier that labels the credentials to
be used by the auto attach mechanism. This unique identifier will have to be defined in
a small server database using the administrator Dashboard credentials tool provided in
the distribution.


Example of modified dashboard.properties file


An example of a modified dashboard.properties file that uses the parameters described in Example of
modified dashboard.properties file is:


# This is a Java Properties file, for the GUI running as an Applet.


# Leading and trailing blanks are stripped from parameter values.


# If you have a property which you want to have leading or trailing blanks, enclose that parameter in 


double quotes, 


# e.g.: some.parameter="  I am a value with leading and trailing blanks  "


com.smarts.viewer.hideToolbarText=true


com.smarts.OemCustomization=NONE


com.smarts.securityEnabled=true


com.smarts.viewlet.authhttp=http://<tomcat_host>:8080/SMViewletAuth/ViewletAuth.do?MASK=0


com.smarts.attach.alias=GUI_ID
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In this example, the parameter, com.smarts.viewlet.authhttp, refers to the URL of the servlet that will
retrieve the credentials (username, password, broker, and Global Manager) from Tomcat.


The parameter, com.smarts.attach.alias, is set to the Dashboard credentials identifier named, GUI_ID. To
configure GUI_ID, use the Dashboard credentials administrator’s tool.


Configuring the Dashboard credentials identifier


The administrator must define the credentials ID using the Dashboard credentials tool. To configure the
Dashboard credentials identifier:


1 Start a web browser specifying the following URL:


http://<tomcat_host>:8080/SMViewletAuth


2 Type a username and password that will be used in the future to access the Dashboard credential
tool (for example, admin, 12345).


3 Click Submit.


A message indicating a successful login appears.


Note   This step assigns values to two parameters that control access to the tool:
configuration.admin.user and configuration.admin.password. Use this username and password
whenever you need to access this tool to edit Dashboard credential IDs.


4 Select Edit Configuration. The following text appears:


# Automatically generated configuration file


# admin credential: DO NOT EDIT 2 fields below


configuration.admin.user=admin


configuration.admin.password=12345


#[connection_alias1]


#    com.smarts.userid=admin


#    com.smarts.password=changeit


#    smarts.remote.broker=10.239.3.92:426


#    com.smarts.autoAttachDM=INCHARGE-SAM


#    com.smarts.clientips=10.239.*;10.7.2.[1-9];10.7.2.11


## end of entry connection_alias1


Parameters for automatic attach with viewlets explains the parameters used in this screen.


Table 5‑9.  Parameters for automatic attach with viewlets


Parameter Description


connection_alias1 Replace this string of text with the credentials ID (for example, GUI_ID). You
must replace this at both the beginning and end of the list.


com.smarts.userid Username. This name must match a record in the serverConnect.conf file
used by the Global Manager. In addition, this user must have an account with
the Global Manager.


com.smarts.password Password.
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Table 5‑9.  Parameters for automatic attach with viewlets (Continued)


Parameter Description


smarts.remote.broker Location of the Broker in <host>:<port> format. For example, smarts-broker:
426.


com.smarts.autoAttachDM Name of the Global Manager, for example INCHARGE-SA.


com.smarts.clientips Your IP for running the Dashboard applet should be inserted to the
"com.smarts.clientips" list of the alias you are using for the Dashboard. For
localhost, it might be 127.0.0.1. "com.smarts.clientips" controls which host
can run the Dashboard without the need of knowing the connection
credentials.


1 Copy the text beginning with the line, #[connection_alias1], and paste it at the end of the file.
Uncomment and edit the parameters in these lines in order to create the credentials ID for the
autoAttach feature. For example:


[GUI_ID]


    com.smarts.userid=oper


    com.smarts.password=oper


    smarts.remote.broker=qa-fancy:426


    com.smarts.autoAttachDM=INCHARGE-SA


    com.smarts.clientips=10.239.*;10.7.2.[1-9];10.7.2.11;127.0.0.1


# end of entry GUI_ID


2 Click Save.


The Show Configuration screen appears and the username and password are scrambled, for
example:


# start of entry GUI_ID 


[GUI_ID]


# The following fields CAN NOT be modified manually


    com.smarts.userid=5f2c442449242f41


    com.smarts.password=5f2c642e4d392041


# end of fields CAN NOT be modified manually


    smarts.remote.broker=qa-fancy:426


    com.smarts.autoAttachDM=INCHARGE-SA


    com.smarts.clientips=10.239.*;10.7.2.[1-9];10.7.2.11;127.0.0.1


# end of entry GUI_ID 


3 Click Edit to return to the Edit Configuration screen.
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4 Click Logout to exit.


By default, the configuration file with all the obfuscated credentials is stored in the directory where
tomcat was started. The default filename is viewletauth.conf. The administrator can change this
behavior and specify a different location. This can be done by specifying the following property:


<init-param>


        <param-name>com.smarts.viewletauth.conf</param-name>


  <param-value>file_path</param-value>


      </init-param>


5 Start the viewlet. If properly configured, the viewlet should bypass the login dialog box and attach
directly to the Global Manager (INCHARGE-SA). (Note, this assumes that the Global Manager is
already running.) When values for one or more of the parameters in Parameters for automatic attach
with viewlets are not provided, the viewlet displays the login dialog box requesting credentials.


Recovering an administration account user ID and password


To recover an administration account user ID and password:


1 Using a text editor, open the viewletauth.conf file.


Note   Theviewletauth.conf file is located in your Service Assurance Manager installation where
tomcat is running.


Once the viewletauth.conf file is opened, locate the following lines located near the beginning of the
file:


# Automatically generated configuration file


# admin credential: DO NOT EDIT 2 fields below


configuration.admin.user=5f24442449242f292d5e572150283341


configuration.admin.password=5f2041214a2a2432315f5641264e4545


2 Execute the following command replacing the encoded string value with the encrypted (encoded)
configuration.admin.user text string value:


java -cp TOMCAT_INSTALL/webapps/SMViewletAuth/WEB-INF/classes 


com.smarts.viewletauth.util.SMObfuscatorFactory -s encoded_string


3 Execute the following command replacing the encoded string value with the encrypted (encoded)
configuration.admin.password text string value:


java -cp TOMCAT_INSTALL/webapps/SMViewletAuth/WEB-INF/classes 


com.smarts.viewletauth.util.SMObfuscatorFactory -s encoded_string
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Properties for map viewlets
Parameters for map viewlets describes the parameters which enable you to specify an element as the
focus of a map viewlet and to determine what type of map is displayed. The map type must be relevant to
the specified element.


Note   When launching a map viewlet, you must specify the class of the element and instance name of
the element for the map, otherwise the map will be empty. (The map viewlet does not include the topology
browser so you cannot select an instance.) However, when the map is used in conjunction with other
viewlets, such as the Notification Log viewlet, you can context share to display elements in the map.
When you specify the instance in the URL without a map type, the console chooses a default map type
for that instance.


Table 5‑10.  Parameters for map viewlets


Parameter Description


com.smarts.launch.class Name of the ICIM class of which the element is an instance.


com.smarts.launch.instance Display name of the elements.


com.smarts.launch.mapType Type of map that is displayed. Can include:
n Physical for Physical Connectivity
n IP for IP Connectivity
n VLAN for VLAN Connectivity
n Membership for Membership
n Business for Business Services Maps
n Application for Applications Maps


com.smarts.map.passive When true, prevents console operations such as Show Map from
displaying in the Map viewlet. Instead, actions such as Show Map
display in a new Map viewlet.


com.smarts.launch.mapHops Optional parameter that specifies how many hops the map should
display. If a value is not specified, one hop is displayed. (Part of
Launching in Context.)


com.smarts.fitInWindow Value is boolean. When true, this optional parameter forces the Map
to fit inside the window no matter how large the map.


com.smarts.map.showAllBusiness Value is boolean. When true, this optional parameter allows all
business topology to be seen in the map and not just the topology
that has a direct path to the central map node.


Note   You can also use the com.smarts.launch.class and com.smarts.launch.instance parameters for
Notification Properties and Containment viewlets.


Configuring map viewlet for dashboard


To configure map viewlets for the dashboard:


1 Open the viewlet.properties.file(com.smarts.ViewletProperties) file located under the
<BASEDIR>/smarts/tomcat/webapps/templates.
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2 Add the following lines:


com.smarts.launch.class=<class name>


com.smarts.launch.instance=<instance name>


com.smarts.launch.globalMgr=<SAM Server>


com.smarts.launch.mapType=<Type>


3 Save the file.


Enabling client tools
Client tools are programs that can be invoked by an operator using the Global Console, web console, or
Business Dashboard. Access to client tools can be controlled by associating or not associating tools to
user profiles. Available client tools are displayed in a pop-up menu when an operator right-clicks on a
notification or a device. The VMware Smart Assurance Service Assurance Manager Configuration Guide
provides additional information about creating client tools.


Note   Client tools that require the user to input values are not supported in either the web console or
Business Dashboard.


In order for client tools to be invoked, the tool scripts must be placed in a directory accessible from the
client machine (where the web browser is running). In an environment where Dashboard users share a
network drive, the client tools can be placed in a directory on the network drive, thus avoiding the need to
copy the tools onto each client machine.


To enable access to the client tools from the Business Dashboard, add the parameters described in 
Parameter to enable client tools to the appropriate properties file, for example, dashboard.properties.


Table 5‑11.  Parameter to enable client tools


Parameter Description


com.smarts.clientToolsInApplet=true When set to true, client tools are enabled in the web console or Business
Dashboard.


If this parameter is specified, and the com.smarts.webconsole.sitemod
parameter (see below) is not specified, the Dashboard client tool function gets
the client tools from the /actions/client directory in the web browser’s default
directory. (For IE, this may be Documents and Settings\Desktop. For Firefox, the
Firefox installation base directory.) You must put a copy of the tool in
this /actions/client path.


com.smarts.webconsole.sitemod When this parameter is configured in the dashboard.properties file, the Business
Dashboard searches for client tools in the directory path(s) specified. For
example,
com.smarts.webconsole.sitemod=F:/webconsoleSitemod;C:webconsoleSitemo
d/locl.


If this parameter is specified, then com.smarts.clientToolsInApplet=true must
also be specified to enable client tools in the web console or Business
Dashboard.


If this parameter is not specified, but com.smarts.clientToolsInApplet=true is
specified, then client tools will be accessed from a default directory (see above).
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Example


This example illustrates how to configure a tool named myClientTool.cmd where
com.smarts.webconsole.sitemod=Z:/toolsdir. The two parameters would be set as follows:


com.smarts.clientToolsInApplet=true


com.smarts.webconsole.sitemod=Z:/toolsdir


The client tool must be placed in the /actions/client folder under Z:/toolsdir, for example:


Z:/toolsdir/actions/client/myClientTool.cmd


The parameter, com.smarts.webconsole.sitemod does not directly specify where the tool file is stored.
Instead, it specifies where the /actions/client directory containing the tool file is stored.


If com.smarts.webconsole.sitemod is not specified, the /client/actions folder with the tool must be placed
under the web browser’s default directory. (For Internet Explorer, this may be Documents and
Settings\Desktop. For Firefox, it is the Firefox installation base directory.)


Enabling the com.smarts.user.display property to pass client IP
addresses to server scripts
To pass the client IP address instead of hostname to server scripts:


1 For web console, Java Web Start or dashboard, add the following line to the webconsole or
dashboard properties file:


com.smarts.user.display={IP}:0.0


2 To apply this option only to the Java Web Start, add the following property to the
globalConsoleApp.jnlp file:


3 <property name="com.smarts.user.display" value="{IP}:0.0"/>.


4 For the command line console (sm_gui), add the following command line option:


               -D com.smarts.user.display={IP}:0.0


            


Verifying the configuration
If the correct masterpiece file was used and the com.smarts.user.display property was configured
correctly, an entry similar to the following appears in the Java Console or the VMware Smart Assurance
console’s Java Message log:


Property com.smarts.user.display set to: 128.222.218.149:0.0 (was: {IP}:0.0)


Note   The IP address varies depending upon your specific environment.


If the entry is not added to the logs, the configuration is not accurate.
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URL-addressable viewlets
A URL-addressable viewlet is a viewlet that is displayed when a web client loads a particular URL. This
enables you to dynamically generate a URL to display Map, Notification Properties, and Containment
viewlets from within the context of another application. Additional viewlet properties describes the viewlet
parameters to configure a URL-addressable viewlet.


To specify viewlet parameters directly in a URL, use the following syntax:


http://URL?class=viewlet&parameter_name=value[&...]


Class parameter values for URL-addressable viewlets lists values used with the class parameter typically
used with URL-addressable viewlets and Separators used in URL-addressable viewlets describes the
separators used.


Table 5‑12.  Class parameter values for URL-addressable viewlets


Parameter Dashboard viewlets


class Determines the Dashboard viewlet that is displayed:
n com.smarts.webapps.SmWebMapApp(Maps)
n com.smarts.webapps.SmWebNotificationPropertiesApp(Notification Properties)
n com.smarts.webapps.SmWebContainmentApp(Containment)


Table 5‑13.  Separators used in URL-addressable viewlets


Separator Description


? Separates the filename of the HTML page specifying the JAR files from the parameter/value
pairs.


& Separates parameter/value pairs in the URL.


The following URL is an example of a URL-addressable viewlet that loads a Map viewlet with a specific
element class and instance as the focus. It does not specify a map type. The example uses an HTML
page included with the viewlet samples. Example of URL-addressable viewlet provides additional
information.


         t


         http://<tomcat_host>:8080/templates/context.html? 


class=com.smarts.webapps.SmWebMapApp& 


com.smarts.propertiesFile=dashboard.properties& 


com.smarts.launch.class=Router& 


com.smarts.launch.instance=lab-gw.example.com s
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The following URL, which is similar to the preceding, is an example of a URL-addressable viewlet that
loads a Map viewlet with a specific element class and instance as the focus, and specifies a map type:


         t


          http://<tomcat host>:8080/templates/context.html? 


class=com.smarts.webapps.SmWebMapApp& 


com.smarts.launch.mapType=IP& 


com.smarts.launch.class=Host& 


com.smarts.launch.instance=qa-fancy s


      


When necessary, use the dmctl utility to list the notifications in the Global Manager and select the one
that you want to use for the viewlet:


./dmctl -s INCHARGE-SA getInstances ICS_Notification


About the web console
The web console provides the same functionality as the Global Console, including the Topology Browser
view that is not available as a viewlet. Client requirements defines the client systems requirements.


Users can open the VMware Smart Assurance web console after you complete the following tasks:


n Start the VMware Smart Assurance Business Dashboard service


n Create user profiles and user accounts


The web console is installed to the BASEDIR/smarts/tomcat/webapps/webconsole directory.


Attaching with the web console
Two versions of the web console are available. With both versions, the JAR files are loaded over the
network during the initial connection but then saved to the user’s local system. Subsequent connections
use the cached files to optimize the use of network resources.


The first version functions as a typical Java applet. The HTML and JAR files are located on the host
where the VMware Smart Assurance Business Dashboard is installed. When a user opens the web
console, the JAR files are loaded over the network to the user’s web browser.


A second version of the web console uses Java Web Start. Java Web Start integrates the web console
with the user’s desktop. This enables users to start the web console directly from their desktop without
using a web browser.


Note   When opening the web console or a Dashboard viewlet, the JRE on the user’s system displays a
security warning. Users must select Yes or Always to allow the applet to run.
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Using the web console
To display the web console, open the following URL:


http://<tomcat_host>:8080/webconsole/InChargeApplet.html


When attached, the web console displays inside the web browser window. If the user opens additional
consoles using the File > Open menu options, each new console is displayed in its own window. When
the user exits the web browser, all web console are closed, as is the connection to the Global Manager.


Using Java Web Start
You can also use Java Web Start for caching the applet locally for improved performance; the necessary
applet files are not reloaded each time the applet is launched. To do so, point your browser at the
following URL:


http://<tomcat_host>:8080/webconsole/globalConsoleCached.html


When you launch the cached applet, you are prompted to optionally add a Java Web Start icon on your
desktop and a link in your Start menu.


If Java Web Start is not installed, you are prompted to use an automatic installer or directed to a Sun
Microsystems web page, depending upon your operating system or browser.
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Examples of Dashboard viewlets 6
About the sample viewlets
Each viewlet type is specified in an HTML page, with slight variations specified in separate HTML pages.
Each sample combines several viewlets, which are displayed in a single HTML page through the use of
HTML frames.


To ensure that the HTML pages that specify a viewlet display properly on all supported platforms and web
browsers, VMware, Inc. has processed the HTML pages using Java Plug-in HTML Converter. The Java
Plug-in Converter converts an HTML page that specifies Java applet to a form that can be processed by a
web browser using the Java Plug-in.


Because the converted HTML files are not easily read, both the original HTML file and the converted files
are included. For example, the original file for the Notification Log viewlets is named
NotificationsAppOrig.html. The converted files, which are used to display the viewlet, have names such
as NotificationsApp1.html.


To view the samples in a web browser, the VMware Smart Assurance Servlet Engine must be installed
and running. You can open the following URL in your web browser, appending the filename specified for
each sample. For example, if the VMware Smart Assurance Servlet Engine is running on host1, you can
view sample 1, by opening the following URL:


http://<tomcat_host>:<port>/templates/sample1.html


In addition, you also can find all the sample viewlets in BASEDIR\smarts\tomcat\webapps\templates\


Index to the sample Dashboard viewlets
The best way to view the samples is to open the following HTML page in your web browser:


         BASEDIR\smarts\tomcat\webapps\templates\DashboardIndex.html 


This page provides an index listing of all the sample viewlets and a ReadMe.html with hyperlinks to each.
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Sample 1
You can view the first sample by opening sample1.html in your web browser. This sample includes the
viewlets described in Viewlets of Sample1.html. The layout of this sample includes a Notification Log in
the top frame row and a Summary and Status Table in the bottom frame row.


Table 6‑1.  Viewlets of Sample1.html


Frame page Viewlet pages Viewlet Additional parameters


sample1.html NotificationsApp1.html Notification Log n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


n com.smarts.context.collectionEntity has a a value
of true. This indicates that the Notification Log
viewlet will display notifications related to
elements selected in the Status Table. Context
sharing for viewlets provides additional
information about context sharing.


SummaryApp1.html Summary View n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information about
properties files.


StatusTableAppAll.html Status Table n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information on
properties files.


Sample 2
You can view the second sample by opening sample2.html in your web browser. This sample includes the
viewlets described in Viewlets of Sample2.html. The layout of this sample includes a Status Table and
Map in the top frame row and a Notification Log in the bottom frame row.
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Table 6‑2.  Viewlets of Sample2.html


Frame page Viewlet pages Viewlet Additional parameters


sample2.html StatusTableAppAll.html Status Table n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


MapApp2a.html Map n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


n com.smarts.context.collectionEntity has a a value
of true. This indicates that the Map viewlet will
display the elements selected in the Status
Table. Context sharing for viewlets provides
additional information.


NotificationsApp2a.html Notification Log n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


n com.smarts.context.collectionEntity has a a value
of true. This indicates that the Notification Log
viewlet will display notifications for elements
selected in the Status Table. Context sharing for
viewlets provides additional information.


n com.smarts.context.instance has a a value of
true. This indicates that the Notification Log
viewlet will display notifications for elements
selected from the Map. Context sharing for
viewlets provides additional information.


Sample 3
You can view the third sample by opening sample3.html in your web browser. This sample includes the
viewlets described in Viewlets of Sample3.html. The layout of this sample includes a Map in the top frame
row and a Notifications Log and Containment viewlet in the bottom frame row.
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Table 6‑3.  Viewlets of Sample3.html


Frame page Viewlet pages Viewlet Additional parameters


sample3.html MapApp3a.html Map n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


n com.smarts.context.notification has a a value of
true. This indicates that the Map viewlet will
display the elements related to notifications
selected in the Notification Log. Context sharing
for viewlets provides additional information.


NotificationsAppAll.html Notification Log n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


ContainmentAppAll.html Containment n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


Sample 4
You can view the fourth sample by opening sample4.html in your web browser. This sample includes the
viewlets described in Viewlets in sample4.html. The layout of this sample includes a Notifications Log in
the top frame row, a Summary and Notification Properties viewlets in the middle frame row, and a map in
the bottom frame row.


Table 6‑4.  Viewlets in sample4.html


Frame page Viewlet pages Viewlet Additional parameters


sample4.html NotifcationsApp4.html Notification Log n com.smarts.propertiesFile includes the
parameters specified in the
dashboard.properties file.Using a properties file
to specify viewlet parameters provides
additional information.


n com.smarts.context.summary has a a value of
true. This indicates that the Notification Log
viewlet will display the notifications graphed by
the selected Summary. Context sharing for
viewlets provides additional information.


SummaryAppAll.html Summary n com.smarts.propertiesFile includes the
parameters specified in the
dashboard.properties file. Using a properties
file to specify viewlet parameters provides
additional information.
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Table 6‑4.  Viewlets in sample4.html (Continued)


Frame page Viewlet pages Viewlet Additional parameters


NotificationPropertiesAppAll.htm
l


Notification
Properties


n com.smarts.propertiesFile includes the
parameters specified in the
dashboard.properties file. Using a properties
file to specify viewlet parameters provides
additional information.


MapApp4a.html Map n com.smarts.propertiesFile includes the
parameters specified in the
dashboard.properties file. Using a properties
file to specify viewlet parameters provides
additional information.


n com.smarts.context.notification has a a value
of true. This indicates that the Map viewlet will
display the elements related to notifications
selected in the Notification Log. Context
sharing for viewlets provides additional
information.


Sample 5
You can view the fifth sample by opening sample5.html in your web browser. This sample includes the
viewlets described in Viewlets in Sample5.html. The layout of this sample includes a Notification Log in
the top frame row, a Summary and a map in the middle frame row, and a second Notification Log in the
bottom frame row.


Table 6‑5.  Viewlets in Sample5.html


Frame page Viewlet pages Viewlet Additional parameters


sample5.html NotificationsAppAll.html Notification Log n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


SummaryAppAll.html Summary n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.
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Table 6‑5.  Viewlets in Sample5.html (Continued)


Frame page Viewlet pages Viewlet Additional parameters


MapApp5a.html Map n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


n com.smarts.context.notification has a a value of
true. This indicates that the Map viewlet will
display the elements related to notifications
selected in the Notification Log. Context sharing
for viewlets provides additional information.


NotificationsApp5.html Notification Log n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


n com.smarts.context.summary has a a value of
true. This indicates that the Notification Log
viewlet will display the notifications graphed by
the selected Summary. Context sharing for
viewlets provides additional information.


Sample 6
You can view the sixth sample by opening sample6.html in your web browser. This sample includes the
viewlets described in Viewlets of Sample6.html. The layout of this sample includes a Status Table and
Summary in the first row, a Notification Log in the second row, and a second Summary in the bottom row.


One notable difference between this sample and the previous samples is that sample6.html uses HTML
TABLE tags in conjunction with IFRAME tags to position viewlets. An advantage of IFRAME tags is that
the viewlets within the tags remain at their specified size. As the web browser window is resized, the
viewlets within the table do not resize. When the browser window is made smaller than the specified size
of a viewlet, scroll bars are displayed within the IFRAME.


Table 6‑6.  Viewlets of Sample6.html


IFrame page Viewlet pages Viewlet Additional parameters


sample6.html StatusTableAppAll.html Status Table n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


SummaryApp6.html Summary n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


n com.smarts.context.collectionEntity has a a value
of true. This indicates that the Summary viewlet
will display a summary based on selections in the
Status Table. Context sharing for viewlets
provides additional information.
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Table 6‑6.  Viewlets of Sample6.html (Continued)


IFrame page Viewlet pages Viewlet Additional parameters


NotificationsApp6.html Notification Log n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


n com.smarts.context.collectionEntity has a a value
of true. This indicates that the Notification Log
viewlet will display notifications for elements
selected in the Status Table. Context sharing for
viewlets provides additional information.


SummaryAppAll.html Summary Log n com.smarts.propertiesFile includes the
parameters specified in the dashboard.properties
file. Using a properties file to specify viewlet
parameters provides additional information.


Example of URL-addressable viewlet
A URL-addressable viewlet is a viewlet that is displayed when a web client loads a particular URL. This
enables you to dynamically generate a URL that displays the Map, Notification Properties, or
Containment viewlets.


The base URL for displaying a viewlet is: http://<tomcat_host>:<port>/templates/context.html


This sample uses context.html as the base URL to load the JAR files necessary to display one of these
three viewlets. At a minimum you must specify the type of viewlet to display.


Note   Opening this page without specifying a viewlet displays a blank page.


Additional viewlet properties describes parameters and separators you can add to the base URL. URL-
addressable viewlets on page 48 provides additional information on the syntax of URL-addressable
viewlets.


The following URL is an example of a URL-addressable viewlet that loads a map viewlet with a specific
element class and instance as the focus. It does not specify a map type:


thttp://<tomcat_host>:8080/templates/context.html? 


class=com.smarts.webapps.SmWebMapApp& 


com.smarts.propertiesFile=dashboard.properties& 


com.smarts.launch.class=Router& 


com.smarts.launch.instance=lab-gw.example.com s
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The following URL, which is similar to the preceding, provides an example of a URL-addressable viewlet
that loads a Map viewlet with a specific element class and instance as the focus, and specifies a map
type:


thttp://<tomcat


         host>:8080/templates/context.html? 


class=com.smarts.webapps.SmWebMapApp& 


com.smarts.launch.mapType=IP& 


com.smarts.launch.class=Host& 


com.smarts.launch.instance=qa-fancy s 


The following URL provides an example of a URL-addressable viewlet that loads a Notification Properties
viewlet. In the example, the class (optional) is ICS_Notification, and the instance is the name of the
notification.


thttp://<tomcat


         host>:8080/templates/context.html? 


class=com.smarts.webapps.SmWebNotificationPropertiesApp& 


com.smarts.launch.class=ICS_Notification& 


com.smarts.launch.instance=NOTIFICATION-Router_qa-mplspe4.example.com_Unresponsive s


The following URL provides an example of a URL-addressable viewlet that loads a Containment viewlet.
The parameters for the Containment viewlet are the same as for a map: the class of the element and the
instance name of the element.


thttp://<tomcat


         host>:8080/templates/context.html? 


class=com.smarts.webapps.SmWebContainmentApp& 


com.smarts.launch.class=Router& 


com.smarts.launch.instance=qa-mplspe4.example.com s
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Troubleshooting 7
This chapter includes the following topics:
n Troubleshooting overview


n Debugging the web console


n Sun Java Console (Plug-in message log)


n Log file location


Troubleshooting overview
Note   The information contained in this chapter should be checked against your installation before
problems arise. Contact VMware Smart Assurance support if it becomes necessary to clarify or resolve
any questions or issues.


When troubleshooting reasons why the web console stops responding, the following files and parameters
are reviewed:


n Required files


When troubleshooting issues, VMware always asks for the following files:


n rps files


n Service Assurance Manager server log files


n tomcat log files


n sm_monitor log files


n Console log files
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n ics.conf files


The console log files include the VMware Smart Assurance Java Message log file, the Sun Java
Plug-in Console log file, and the VMware Smart Assurance server messages received log file. By
reviewing the console log files, VMware can clearly determine if the console stopped responding
because the system ran out of memory, or if the issue was the result of some other error. Using
the server log file, VMware can review what occurred at the time the console stopped responding;
for example, was the server busy or was there some other exception.


From prior experience, a web console or global console stops responding as a result of the
machine running out of memory.


n Debugging parameters.


To have debugging information entered in the log files, you must have the console debugging
parameters set by default, before you use the console and the console stops responding. You need to
verify that the debugging information is being entered into the log files before there is a problem.
Having the debugging parameters set ensures that no critical information is lost.


n Primary Java log file.


The primary Java log file is the key tool used in diagnosing issues. This file gets overwritten at each
startup time and is the file that saves the contents of the Console Java Log. Enable this file by typing
the following command:


               -Dcom.smarts.java.log=<


               filename


               >


            


n Asynchronous message log file.


This log file is controlled by versioning. This file can get very large if the server is processing
numerous notifications. Enable the asynchronous message log file by typing the following command:


               Dcom.smarts.server.logMessages=true


            


Debugging the web console
Web console debugging parameters defines the parameters used to capture information when a web
console stops responding.


Table 7‑1.  Web console debugging parameters


Parameter Description


-Xmx350m -Dsun.net.inetaddr.ttl=0 This parameter gets around the broker failover cache problem.


-Dcom.smarts.server.logMessages=true This parameter logs all the asynchronous messages that the
server sends to the console, primarily, notification
adds/changes/deletes.
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Table 7‑1.  Web console debugging parameters (Continued)


Parameter Description


-Dcom.smarts.java.log=<name>-webconsole.log This parameter saves the VMware Smart Assurance Java
Message Log content. This content is lost when the console
stops responding. This log file must be copied and saved
before restarting the web console. Content included in this log
file could provide information on why the console stopped
responding.


Note   Restarting the web console overwrites this file.


-Dcom.smarts.log.level=TRACE This parameter results in maximum information being entered
in the Java Message Log.


Heap size VMware has tested a heap size of 350 M


Note   The parameters are configured in the Java Plug-in Control Panel.


Configuring the log file directories
You can set up the log file directories for the com.smarts.server.logMessages and com.smarts.java.log
files when the VMware Smart Assurance graphical user interface (GUI) is running as a web console in
Internet Explorer.


The parameters can be enabled if they are set in the Java Control Panel in the workstations. To display
the Java Control Panel, click Settings > Control Panel > Java.


The Java Control Panel appears as illustrated in Java Control Panel.


Figure 7‑1.  Java Control Panel
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Internet Explorer defaults the console’s com.smarts.writeable parameter to the desktop location where log
files are written. You can verify this in the Sun Java Console window (not the VMware Smart Assurance
Java Log file).


To verify that the com.smarts.writeable parameter is configured correctly:


From Internet Explorer, click Tools > Sun Java Console.


The Java Console appears. An example of the type of information available from the Sun Java Console
is:


Java Plug-in 1.6.0_15


Using JRE version 1.6.0_15 Java HotSpot(TM) Client VM


User home directory = C:\Documents and Settings\bm1.SMARTS 


----------------------------------------------------


c: clear console window


f: finalize objects on finalization queue


g: garbage collect


h: display this help message


l: dump classloader list


m: print memory usage


o: trigger logging


p: reload proxy configuration


q: hide console


r: reload policy configuration


s: dump system and deployment properties


t: dump thread list


v: dump thread stack


x: clear classloader cache


0-5: set trace level to <n>


---------------------------------------------------- 


Properties: com.smarts.fixed, com.smarts.sitemod, com.smarts.writeable not found.


Defaulting com.smarts.fixed, com.smarts.sitemod, com.smarts.writeable paths to: C:\Documents and 


Settings\bm1.SMARTS\Desktop 


The Properties line defines the location of the com.smarts.writable path. In this example, the path has
been defaulted to the desktop and the user ID has been defined by default as the user ID for the specific
workstation (in the example, the user ID is: bm1.SMARTS).


Configuring the log files
To retrieve the log files when running the web console:


1 Verify that the log files have been configured.


Note   Configuring the log file directories provides additional information.


2 Create a new folder labeled “logs” on the workstation's desktop.


Use a command prompt to go to the directory specified in the Java Console message and create the
new folder. For example, the path for the folder could be C:\Documents and
Settings\bm1.SMARTS\Desktop\logs.
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3 Click Settings > Control Panel > Java.


The Java Control Panel appears.


4 Click Advanced and add a new Java Runtime Parameter. (For Java 1.5 or later, click the Java tab
and then click the View button to display the Java Runtime Settings window.) An example of the
settings is:


-Dcom.smarts.server.logMessages=true


-Dcom.smarts.java.log=ZZZZ


-Dcom.smarts.log.level=TRACE


5 Edit the -Dcom.smarts.java.log=ZZZZ to the name of your java log file.


Note   This log file does not get appended with versions. It needs to be saved before restarting the
console. If the file is not saved before starting the console, the contents of the file are overwritten.


After configuring the java log file location, when you run Internet Explorer, the log of server message
log file and the java log file are written into the desktop's logs directory. The java log file lists trace
level messages.


Because the parameter was updated in the client’s Java Plug-in, you do not need to restart the
tomcat application.


You need to configure the log files location before a console stops responding so that information
about the console not responding can be retrieved. VMware suggests verifying that the two
debugging files (webconsole.log and server_Mesg_<userid>.log) get written to the logs directory.


Sun Java Console (Plug-in message log)
When the VMware Smart Assurance GUI is run as a web console, important debugging information is
written to the Sun Java Plug-in Console. When the VMware Smart Assurance GUI stops responding but
Internet Explorer continues to run (for example, if the web browser window goes blank), it is helpful to
capture the contents of the Sun Java Plug-in console.


To enable the Sun Java Plug-in Console
To enable the Sun Java Plug-in Console:


1 From Settings, click Control Panel.


The Control Panel appears.


2 Double-click Java.


The Java Control Panel appears.


3 Click Advanced.


4 Expand the Java console option.
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5 Click the Show Console option.


By default, the Sun Java Plug-in Console displays as a window (typically in the upper-left corner of
the screen) in Internet Explorer. You can also display the Sun Java Console by clicking the Internet
Explorer’s Tools menu and selecting the Sun Java Console.


Capturing the Sun Java Plug-in Console content
To capture the Sun Java Plug-in Console content:


1 From the Java Console, click Copy.


The content displayed in the Sun Java Console is copied to the clipboard.


2 Open a new file in a text editor and paste the clipboard contents into the new file.


3 Save the file and send the file to VMware along with other debugging information.


Note   If you are reporting web console problems that did not cause the web console to stop
responding, you should also copy, save, and send this log file.


Log file location
Log file location defines the log file locations.


Table 7‑2.  Log file location


The Is located in the


rps file <BASEDIR>/smarts/local/repos/icf directory.


Note   Run dmctl -s NA-SAM-PRES and invoke the ICF_PersistenceManager::ICF-
PersistenceManager. Save this information before sending the rps file to ensure all notifications are
saved to the rps.


SAM server log <BASEDIR>/smarts/local/logs directory.


sm_monitor logs <BASEDIR>/smarts/local/logs/SM_Monitor directory.


Tomcat logs <BASEDIR>/smarts/jakarta-tomcat-5.0.16/logs directory from where tomcat started.


ics.conf file <BASEDIR>/smarts/local/conf/ics directory.


Console logs C:\Documents and Settings\<username>.SMARTS\Desktop\logs directory.
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Preface 1
As part of an effort to improve its product lines, VMware periodically releases revisions of its software and
hardware. Therefore, some functions described in this document might not be supported by all versions of
the software or hardware currently in use. The product release notes provide the most up-to-date
information on product features.


Contact your VMware representative if a product does not function properly or does not function as
described in this document.


Note   This document was accurate at publication time. New versions of this document might be released
on the VMware online support website. Check the VMware online support website to ensure that you are
using the latest version of this document.


This chapter includes the following topics:


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n Related documentation


n VMware Smart Assurance Service Assurance Manager


n Suggestions for searching PDF files


n Conventions used in this document


n Pathname conventions


n Graphical conventions


n Manager


n Where to get help


n Your comments


Audience
This guide is intended for administrators who are responsible for deploying, installing, and configuring the
Business Impact Manager. IT managers who seek to understand the role of the Business Impact
Manager and Global Manager in the context of an VMware Smart Assurance solution may also find this
guide useful.
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In addition to the configuration guides for specific components, administrators should also read the
VMware Smart Assurance Service Assurance Manager Deployment Guide and the
VMware Smart Assurance System Administration Guide.


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<productsuite>.


The <productsuite> represents the VMware Smart Assurance product suite to which the product
belongs. For example, on UNIX operating systems,
VMware Smart Assurance Service Assurance Manager is, by default, installed
to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than /opt/InCharge (on UNIX)
but you cannot change the <productsuite> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.


Related documentation
In addition to this document, VMware Corporation provides a help system for command line programs as
well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n VMware Smart Assurance Documentation Catalog


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ICIM Reference


n VMware Smart Assurance ASL Reference Guide


n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide
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VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes


n VMware Smart Assurance Open Source License and Copyright Information


n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


n VMware Smart Assurance Service Assurance Manager Deployment Guide


n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide


n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide


n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Installation and Configuration Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance DataBridge for SAM Open Source License and Copyright Information for
GPLv3 as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance product suites.


VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System
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n Global Console


n Business Dashboard


n Companion User Interface (CUI)


n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)


n VMware Smart Assurance Adapter for UIM/O


n XML Adapter


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1 If the documentation is not accessible to all users of the VMware Smart Assurance product suite,
copy the contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a shared
drive on your LAN, so that operators and others can view the documentation.


2 To search throughout the documentation library, open the Acrobat Reader software:


3 Select Edit > Search, and type a word or phrase.


4 Select All PDF Documents in, in the Where would you like to search option, and type the
pathname of the location where the PDF documents reside.


If you have more than one VMware Smart Assurance product suite installed, you can set up cross-
product document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each
product suite into this common documentation directory path.


Conventions used in this document
VMware uses the following conventions for special notices:


Danger   DANGER indicates a hazardous situation which, if not avoided, will result in death or serious
injury.


WARNING indicates a hazardous situation which, if not avoided, could result in death or serious injury.


CAUTION, used with the safety alert symbol, indicates a hazardous situation which, if not avoided, could
result in minor or moderate injury.


NOTICE is used to address practices not related to personal injury.


A note presents information that is important, but not hazard-related.


An important notice contains information essential to software or hardware operation.
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Typographical conventions
VMware uses the following type style conventions in this document:


Normal Used in running (nonprocedural) text for:
n Names of interface elements
n Names of resources, attributes, pools, Boolean expressions, buttons, DQL statements, keywords,


clauses, environment variables, functions, and utilities
n URLs, pathnames, filenames, directory names, computer names, links, groups, service keys, file


systems, and notifications


Bold Used in running (nonprocedural) text for names of commands, daemons, options, programs,
processes, services, applications, utilities, kernels, notifications, system calls, and man pages


Used in procedures for:
n Names of interface elements
n What the user specifically selects, clicks, presses, or types


Italic Used in all text (including procedures) for:
n Full titles of publications referenced in text
n Emphasis, for example, a new term
n Variables


Courier
Used for:
n System output, such as an error message or script
n URLs, complete paths, filenames, prompts, and syntax when shown outside of running text


                
        Courier 
bold
                
     


Used for specific user input, such as commands


                
        Courier 
italic
                
     


Used in procedures for:
n Variables on the command line
n User input variables


< > Angle brackets enclose parameter or variable values supplied by the user


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example


Pathname conventions
Directory pathnames are shown with forward slashes (/).
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Graphical conventions
Under UNIX, the consoles appear with slight differences. For example, in views that display items in a
tree hierarchy such as the Topology Browser, an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to VMware Smart Assurance programs
such as Domain Managers, Global Managers, and adapters.


Where to get help
VMware support, product, and licensing information can be obtained as follows:


Product information


For documentation, release notes, software updates, or information about VMware products, licensing,
and service, go to the VMware online support website (registration required) at:


support.vmware.com
         


For technical support, go to VMware online support and select Support. On the Support page, you will
see several options, including one to create a service request. Note that to open a service request, you
must have a valid support agreement. Contact your VMware sales representative for details about
obtaining a valid support agreement or with questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:


docs.vmware.com
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Introduction 2
This chapter includes the following topics:
n About Business Impact Manager


n Architectural and functional overview


n Business Impact Manager features


About Business Impact Manager
Business enterprises, such as those operated by financial institutions, manufacturers, retailers, and
network service providers, consist of the following broad categories of elements as shown in Business
enterprise hierarchy of elements:


n Network infrastructure elements


Devices (such as hosts, routers, and switches) and connections that make up a network.


n Application elements


Software programs (such as accounting packages, order management programs, and inventory
control packages) that are layered over and hosted by the network infrastructure elements.


n Business elements


Business service offerings and business processes and the subscribers (such as service subscribers,
customers, organizations, business units, lines of business, and departments) who use those service
offerings and processes.
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Figure 2‑1.  Business enterprise hierarchy of elements


The degradation or failure of important network infrastructure elements can slow or stop vital
applications and services, and dramatically reduce user productivity in needed business areas. For
example, a host (an infrastructure element) that exhibits degraded performance will slow one or more
applications that are running on it. The slow applications will, in turn, disrupt business services and
processes on which subscribers depend.


VMware Smart Assurance Business Impact Manager (Business Impact Manager) calculates the
impact of network infrastructure and application root-cause problem events on business elements,
and creates business impact notifications. The business impact notifications enable business
enterprises to immediately identify disruptions and failures, and to prioritize the resolution of the
infrastructure and application problems in accordance with their business impact.


Architectural and functional overview
Business Impact Manager operates in conjunction with, and extends the capabilities of,
VMware Smart Assurance Service Assurance Manager (Global Manager) to calculate the impact of
infrastructure and application problems on business elements.
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Figure 2‑2.  Business Impact Manager 9.1 architecture


To improve Global Manager performance, Business Impact Manager in release 9.1 runs as its own server
process instead of running as part of the Global Manager server process. Business Impact Manager 9.1
and Global Manager 9.1 may run on the same host machine or on different host machines.


Business Impact Manager 9.1 still imports its business service topology, hierarchical group topology, and
weights from user-configured datafiles loaded into the Global Manager. It may also import business
service topology and hierarchical group topology created using the Topology Builder and the Group
Builder and event filters from a user-configured event filter datafile.


Note   Business service topology includes business service offering elements, business process
elements, and business subscriber elements—subscribers who use the business service offerings and
processes.
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Business Impact Manager subscribes to all infrastructure and application notifications from the
Global Manager, calculates the impact of the infrastructure and application root-cause problem
notifications on the business elements, and propagates the impacts to the affected business elements.
The propagated impacts are discrete notifications that are connected through a causal event chain to the
root-cause problems in the network infrastructure layer or the application layer of the business enterprise.


Each infrastructure root-cause problem notification, each application root-cause problem notification, and
each business impact notification includes a business impact value, which is specified in the user-
configured weight datafile. The business impact value for a notification is displayed in the Notification Log
Console of the Global Manager. Concurrently, the propagated impact notification (Impacted) generated
for a business element is displayed in Business Services maps in the Map Console of the
Global Manager. The Impacted business element shows a Severity icon that is colored according to the
severity level of the notification. Double-clicking the element in the Business Services map shows the
details of the notification.


Business Impact Manager features
Business Impact Manager provides:


n Business Services maps through which users view impacted business elements.


Chapter 4 Viewing Business Analysis Results and Topology describes this feature.


n Text import datafiles in which users define business elements in text format, define hierarchical group
elements in text format, and define weight elements in text format.


Chapter 5 Setting Up and Using Business Impact Manager describes this feature.


n A Group Builder, also known as a Group Definitions window, through which users can create and
modify hierarchical group elements.


The VMware Smart Assurance Service Assurance Manager Configuration Guide describes this
feature.


n XML import datafiles in which users define the following elements in XML format:


n Business elements


n Hierarchical group elements


n Weight elements


n Event filter elements


Event filter elements represent events for which Business Impact Manager does not generate
business impact notifications.


Chapter 5 Setting Up and Using Business Impact Manager describes this feature.


n InMaintenance attribute processing, in which Business Impact Manager sets the InMaintenance
attribute to TRUE for any business impact notification created solely from causal infrastructure or
application notifications associated with devices in maintenance mode.


Chapter 5 Setting Up and Using Business Impact Manager describes this feature.
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Business Elements and
Notifications 3
This chapter includes the following topics:


n Business Impact Manager elements


n Business Impact Manager notifications


Business Impact Manager elements
Business Impact Manager uses instances of certain VMware Smart Assurance ICIM classes to create a
data model representation of the managed business topology within its repository. ICIM is based on the
Common Information Model developed by the Distributed Management Task Force. The data model,
shown in Business data model, represents the managed business elements and the relationships
between them.


Figure 3‑1.  Business data model


As shown in the figure, BusinessProcess is a subclass of ServiceOffering, and Customer, Organization,
BusinessUnit, LOB, and Department are subclasses of ServiceSubscriber.


ServiceOffering
A ServiceOffering represents a business service delivered to a set of subscribers (consumers). The
ServiceOffering is related to its subscribers through the Subscribers/Subscriptions relationship set. A
ServiceOffering is also related to the infrastructure and application elements that implement the offering
through the ConsistsOf/MemberOf relationship set.


Note   ServiceOfferings are usually web hosting or device name services.
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BusinessProcess
A BusinessProcess represents functions and operations that support the internal business activities or
other processes of a business enterprise or both. In the manufacturing sector, BusinessProcess elements
can include, for example, Order Processing, Production Planning, Purchasing and Receiving, Inventory
Management, Production Control, and Accounts Payable and Receivable.


In addition to the relationship sets (Subscribers/Subscriptions and ConsistsOf/MemberOf) inherited from
ServiceOffering, a BusinessProcess can also participate in the Serves/ServedBy relationship set with
other BusinessProcess elements. Serves/ServedBy models the dependencies between business
processes.


ServiceSubscriber
A ServiceSubscriber represents a subscriber (consumer) of one or more ServiceOfferings. The
ServiceSubscriber relationship to a ServiceOffering is Subscriptions.


Through class inheritance, Customer, Organization, BusinessUnit, LOB, and Department elements also
have a Subscriptions relationship to a ServiceOffering. Like ServiceSubscriber, all of these classes
consume business services provided by one or more ServiceOfferings.


Customer
A Customer represents one or more business enterprises or individuals that maintain a business
relationship with an Organization or one of its BusinessUnit elements.


Organization
An Organization represents a hierarchically structured business enterprise consisting of one or more
business units that engage in one or more lines of business. Its primary function is to manage the
performance of its composite business units. Organization elements can include, for example,
manufacturers, retailers, financial institutions, and service providers.


BusinessUnit
Within an Organization, a BusinessUnit represents a semi-autonomous division that engages in one or
more lines of business. Typically, BusinessUnit elements focus on specific product markets (in the
computer industry, for example, hardware or software products) or geographical areas (for example, the
Eastern United States, Europe, or Asia).


LOB
Within a BusinessUnit, a line of business (LOB) represents a division that focuses on specific product
markets. In the insurance industry, LOB elements include, for example, general homeowner policies, fire
coverage, and flood insurance. LOB elements can be further categorized as commercial lines (for
businesses) and personal lines (for individuals).


VMware Smart Assurance Service Assurance Manager Business Impact Manager User Guide


VMware, Inc.  16







Department
Within a BusinessUnit or LOB, a Department represents a group that engages in business functions that
support the BusinessUnit or LOB. Two very common, yet vital Department elements can include, for
example, Human Resources and Accounting.


Business Impact Manager notifications
Business Impact Manager evaluates events that affect business elements by:


n Calculating business impact values and generating business impact notifications.


n Automatically propagating business impact notifications.


Calculated business impact values
An administrator uses the weights.conf or weights-conf.xml import datafile to assign weights to business
elements and to the infrastructure and application elements that support the business elements.
Business Impact Manager uses the assigned weights to calculate a numeric impact value for each root-
cause problem notification received by the Global Manager from an underlying Domain Manager.
Business Impact Manager calculates the impact value for a problem notification as soon as
Business Impact Manager imports the notification from the Global Manager.


To calculate a numeric impact value for a root-cause problem notification, Business Impact Manager
performs the following operations:


n Determines the infrastructure or application element denoted in the problem notification.


n Determines the infrastructure or application element denoted in each impact notification associated
with the problem notification by tracing the Causes relationship from the problem notification to each
of its impact notifications:


problem notification -> Causes -> impact notification


impact notification -> CausedBy -> problem notification


The underlying Domain Manager that diagnoses the problem and its impacts creates the
Causes/CausedBy relationships between the problem notification and its impact notifications.


n Determines the business elements associated with the infrastructure or application element denoted
in the problem notification.


n Determines the business elements associated with each infrastructure or application element denoted
in the impact notifications associated with the problem notification.
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n Reads the weights assigned to the impacted business, infrastructure, and application elements and
adds the weights together to calculate the impact value for the problem notification.


After calculating the business impact value of a root-cause problem notification,
Business Impact Manager assigns that value to the Impact attribute of the notification. When viewing
the problem notification in the Notification Log Console of the Global Manager, the business impact
value appears in the Impact column.


Business impact values quantify the business impact of the root-cause problems; the larger the
impact value, the larger the business impact (degree of impairment). Administrators can use business
impact values to sort problem notifications by the impact that they have on service delivery.


Automatically propagated business impact notifications
Concurrently with calculating a business impact value for a problem notification,
Business Impact Manager uses a built-in, automated mechanism to automatically propagate the impact
as discrete notifications from the problem element through an event causality chain to the affected
business elements. When viewing a business impact notification in the Notification Log Console of the
Global Manager, the “Impacted” event name appears in the Event column.


Impacts are propagated as follows:


n To a service offering whenever an event occurs on a member of the service offering.


n To the business process that is served by an impacted business process.


n To one service subscriber from another whenever an event occurs on a service offering or business
process associated with the service subscriber. In addition, impacts are propagated to service
subscribers from the other service subscribers that are part of it. For example, impacts are
propagated to an Organization from an impacted Department that is part of the Organization.


When viewing an impacted business element in a Business Services map in the Map Console, the
color of the severity bar associated with the element corresponds to the severity level of the
notification. Double-clicking the element displays the details of the notification.


Automatically propagated impact notification scenario
An example of the automatic propagation of impact notifications is shown in Automatically propagated
impact notification scenario. In this example, the Trade Settlement BusinessProcess depends on a Trade
Settlement Application.
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Figure 3‑2.  Automatically propagated impact notification scenario


When viewing the Business Services map, remember that it shows dependent relationships through
arrowed lines: The arrowed lines point from a business element to the element that the business element
depends on. Impact notifications propagate in the direction opposite to that of the arrowed lines: The
impact notifications propagate toa business element from the element that the business element depends
on.


To aid in understanding, read the relationships in Automatically propagated impact notification scenario
from top to bottom and left to right. For example, TradeAccntgFinCntr (Trade Accounting Financial
Center) is served by Trade Netting, and Trade Netting is served by Trade Settlement.


When the Trade Settlement Application is Degraded (severity level 2, Major notification), the degradation
causes Business Impact Manager to generate an impact notification for the Trade Settlement
BusinessProcess.


Thus, Trade Settlement Application Degraded causes Trade Settlement Impacted. From Trade
Settlement BusinessProcess, the impact notification propagates to any dependant business processes—
that is, any business processes that Trade Settlement serves. These are the Trade Reconciliation and
TradeAccntgFinCntr BusinessProcesses.
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The Trade Reconciliation Impacted and TradeAccntgFinCntr Impacted notifications then propagate further
to any business processes served by these processes: to the Trade Netting BusinessProcess from
TradeAccntgFinCntr Impacted and, once again, to TradeAccntgFinCntr from Trade Reconciliation
Impacted.


As a result, Business Impact Manager generates an impact notification for Trade Settlement, Trade
Reconciliation, TradeAccntgFinCntr, and Trade Netting.
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Viewing Business Analysis
Results and Topology 4
This chapter includes the following topics:
n Before you start


n Attaching the Global Console to the Global Manager


n Business impact notifications


n Business topology


n Business Services maps


n Business Process tools


Before you start
The console operations described in this chapter are controlled by certain console operation options such
as Notification Properties and Expand Map Node. The
VMware Smart Assurance Service Assurance Manager Configuration Guide provides instructions on
changing the console operations.


Also, accessing the consoles described in this chapter requires attaching the Global Console to the
Global Manager (for example, INCHARGE-SA) in your deployment. The
VMware Smart Assurance Service Assurance Manager Operator Guide provides information about
starting the Global Console, logging in, and attaching to a Manager.


Console access is controlled by the user profile associated with your VMware Smart Assurance user
account. You do not need a user account with administrative privileges to access the consoles described
in this chapter.
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Attaching the Global Console to the Global Manager
To attach the Global Console to the Global Manager in your deployment:


1 Start the Global Console.


n The Attach Manager dialog box opens as shown in Attach Manager dialog box.


Figure 4‑1.  Attach Manager dialog box


2 localhost:426


3 In the dialog box:


4 Ensure that the VMware Smart Assurance Broker for your deployment appears in the Broker text
box.


5 Click the Manager list box or the Browse button to display a list of active (running) Domain Manager,
and from that list select the Global Manager application (for example, INCHARGE-SA) in your
deployment as the Domain Manager to which you want to connect.


6 Type your login username and password. (The default administration login is username admin and
password changeme.)


7 Click OK.


The Notification Log Console view of the Global Console opens as shown in Figure 6 on page 37.


In the figure, the Notification Log Console is attached to a Global Manager application named
INCHARGE-SA.
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Figure 4‑2.  Notification Log Console—example


The Notification Log Console is one of many console views composing the Global Console. One
other console view of particular interest to the discussions that follow is the Map Console, which
graphically represents topology in a map format.


The VMware Smart Assurance Service Assurance Manager Operator Guide provides detailed
information on using the Global Console.


Business impact notifications
Business Impact Manager passes the results of its impact analysis in the form of notifications to the
Global Manager. The Global Manager, in turn, combines these notifications with the notifications received
from underlying Domain Managers such as IP Availability Manager and then passes the notifications to
the Global Console, where they are presented in a tabular form in the Notification Log Console.


Each notification consists of a set of attributes that describe properties of the notification, such as Class,
Name, Event, Source, and Impact. The value in the Name attribute is the display name of the notification; 
Understanding names and display names describes the naming formats used to create business element
names. For a root-cause problem notification impacting (affecting) business elements or the infrastructure
or application elements that support those business elements, Business Impact Manager sets the
notification’s Impact attribute to the sum of the weights of the impacted elements; the larger the numeric
value, the larger the impact.


The severity of a notification is reflected by its color, where red indicates the highest severity level.


Viewing business impact notifications
You can view the notifications through the Global Console in two basic ways:


n As tabular entries in a Notification Log Console view


Included with the Notification Log Console view (or any other view where you can see notifications) is
a Notification Properties dialog box for viewing detailed information about an individual notification.
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n As color-coded severity bar icons in a Map Console view


In a map, a color-coded severity bar icon appears underneath nodes (graphical representations of
topology elements) that are affected by abnormal conditions denoted in notifications.


Opening a business Notification Properties dialog box
To obtain detailed information about an individual business impact notification, you can use any of the
following common methods to open the Notification Properties dialog box:


n Double-click a business impact notification in the Notification Log Console.


n Select a business impact notification in the Notification Log Console and then click Show
Notification Properties.


n Right-click a selected business impact notification and then select Properties in the pop-up menu.


n Double-click a business map icon (in the Map Console) affected by active events.


Notification Properties dialog box showing a ServiceOffering Impacted notification is an example of a
Notification Properties dialog box showing detailed information for a ServiceOffering Impacted
notification diagnosed by Business Impact Manager.


Figure 4‑3.  Notification Properties dialog box showing a ServiceOffering Impacted
notification
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In Notification Properties dialog box showing a ServiceOffering Impacted notification, the setting No
for attributes IsProblem and IsRoot indicates that the ServiceOffering Impacted notification is not a
root cause.


Possible value combinations for IsProblem and IsRoot attributes shows the three possible value
combinations for these two attributes and what the combinations mean.


Table 4‑1.  Possible value combinations for IsProblem and IsRoot attributes


IsProblem value IsRoot value Meaning


Yes Yes Indicates that this notification is a root-cause problem diagnosed by
an underlying Domain Manager using event-correlation analysis.


No Yes Indicates that this notification is an event computed by an underlying
Domain Manager when a certain polled metric equals or exceeds a
threshold. The event is a root cause unto itself.


No No Indicates that this notification is an impact event generated by a
listening Business Impact Manager or by an underlying
Domain Manager, or is an informational event originating from the
managed network and forwarded by the underlying
Domain Manager to the Global Manager.


Note   Except for notifications created for BusinessProcess elements using the tools described in 
Business Process tools, no root-cause problems are defined for business elements.


By default, the IsProblem and IsRoot attributes columns do not appear in the Notification Log Console. To
add the IsProblem attribute column:


1 Right-click an attribute in column heading (for example, Class) in the Notification Log Console.


2 Select Insert Column in the pop-up menu.


3 Then select IsProblem in the submenu. The IsProblem column is inserted to the left of the selected
column.


4 Repeat this procedure to add the IsRoot attribute column.


Viewing the cause of a business impact notification
You view the cause of a business impact notification by clicking the Caused By tab in the Notification
Properties dialog box. The Caused By tab lists the problem that caused the notification.


For example, Caused By tab showing the problem that caused the ServiceOffering Impacted notification
identifies the problem that caused the ServiceOffering Impacted notification shown in Viewing the cause
of a business impact notification.
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Figure 4‑4.  Caused By tab showing the problem that caused the ServiceOffering Impacted
notification


When the problem causing a business impact notification is cleared, the business impact notification is
also cleared. A cleared business impact notification has its Active attribute set to No and its IsRoot
attribute set to Yes. The Caused By tab does not appear in the Notification Properties dialog box in case
of a cleared business impact notification.


Business topology
The Global Manager loads instances of the following topology element types from the import datafiles of
the Business Impact Manager. The topology includes offering types, subscriber types, and hierarchical
groups:


n Offering types:


n ServiceOffering


n BusinessProcess


n Subscriber types:


n ServiceSubscriber


n Customer


n Organization


n BusinessUnit


n LOB
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n Department


n Hierarchical groups:


n HierarchicalGroup


Business Impact Manager elements and Text import datafile service.data.template describe the
offering type and subscriber type topology elements. Text import datafile topology-
group.data.template and the
VMware Smart Assurance Service Assurance Manager Configuration Guide describe the
hierarchical group topology elements.


Business Services maps
The Global Console presents the business topology information in a variety of dynamically updated
formats that show the status of the business and group elements and their relationships. One of those
formats is the Business Services map, which is a graphical representation of the business topology.


Viewing Business Services maps is an easy and quick way to learn more about the source and cause of
business impact notifications. You can view Business Services maps using the Map Console view.


The Business Services map shows business, group, infrastructure, and application elements. The
infrastructure and application elements support the ServiceOffering and BusinessProcess business
elements and include devices, software services, and groups of devices or software services
(HierarchicalGroups).


The relationships between the business, group, infrastructure, and application elements are defined in the
Business Impact Manager import datafiles. The infrastructure and application elements are discovered by
the underlying Domain Managers.


Opening a Business Services map
You can use any of the following common methods to open a Business Services map:


n Open the Map Console by selecting the Show Map menu option from any opened console attached
to the Global Manager. For example, in the Notification Log Console, click a business impact
notification and then select Event > Show Map, or right-click the notification and then select Show
Map in the pop-up menu. In the Topology Browser Console, right-click a business element and then
select Show Map in the pop-up menu.


n Open the Map Console from the Global Console by selecting File > New > Map Console. In the
topology tree of the Map Console, click an element to display a map for the element, or right-click an
element and then select Business Services from the pop-up menu. If the Business Services option
is not available (dimmed) in the pop-up menu, a Business Services map is not available for the
element.
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n In an opened topology map, right-click a map icon and then select Business Services from the pop-
up menu.


If an infrastructure or application element has a relationship to ServiceOffering or BusinessProcess
elements, the Business Services map is available for that infrastructure or application element in the
Topology tab of the Map Console. Likewise, for groups with relationships to ServiceOffering or
BusinessProcess elements, the Business Services map is available for the group in the Groups tab of
the Map Console.


Business Services map pop-up menus
Two types of pop-up menus are available in a Business Services map:


n Right-click a selected node in the map


Opens a pop-up menu that enables you to select any of the map types available to the selected node
(for example, Business Services, Physical Connectivity), to display notification properties (if any) for
the selected node, and so on. For a node marked with a plus sign (+), the Expand Node menu option
allows you to expand the node to see all nodes that are physically or logically connected to the node.


n Right-click an open space in the map


Opens a pop-up menu that enables you to display a circular layout of the map, to manually position
nodes in the map, and so on. The Reset map menu option enables you to reset changes made to the
map or to return to the saved map display.


In the topology tree of a Map Console, a pop-up menu is also available when you right-click an object.
This menu enables you to select any of the map types available to the selected object, to display
notification properties (if any) for the selected object, and so on.


The VMware Smart Assurance Service Assurance Manager Operator Guide provides detailed
descriptions of map menus and pop-up menus available for the Map Console.


Business Services map graphical representations
In a map display, a node is a graphical representation of a topology element, and an edge is a graphical
representation of a relationship or connection between elements.


Default icons and edges for the Business Services map identifies and describes the default nodes and
edges that may appear in a Business Services map. In the Map Console, you can also select Map > Map
Legend to see a similar list.
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Table 4‑2.  Default icons and edges for the Business Services map


Icon / visual indicator Description


Icon represents a ServiceOffering (business element).


Icon represents a BusinessProcess (business element).


Icon represents a ServiceSubscriber (business element).


Icon represents a Customer (business element).


Icon represents an Organization (business element).


Icon represents a BusinessUnit (business element).


Icon represents a line of business (LOB) (business element).


Icon represents a Department (business element).


Icon represents a HierarchicalGroup.


Icon represents a DatabaseServer.


Icon represents a SoftwareService.
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Table 4‑2.  Default icons and edges for the Business Services map (Continued)


Icon / visual indicator Description


Solid line with arrow represents dependency.


Dotted line with arrow represents dependency, composition, and membership.


Note   Your system administrator may replace the default map nodes with other map nodes that are
preferred by your organization. In that case, use Map > Map Legend to see the definitions of your map
nodes.


You can customize the font and point size of the map icon text. The default map icon font is Helvetica.
The default map icon font size is 12 point. The font and font size properties are modified in the
webconsole.properties and dashboard.properties files. “Adjusting Java properties” in the
VMware Smart Assurance Service Assurance Manager Operator Guide provides detailed information.


Business Services map example
In the Business Services map examples presented in this section, an Organization named Acme uses an
order management process flow. The flow includes five distinct business processes:


n Demand Planning develops product and market forecasts to ensure that Acme can meet customer
demands. This process does not rely on a specialized application.


n Order Management uses an SAP application suite to support all order management functions,
including scheduling and generating parts lists.


n Fulfillment relies on FedEx fulfillment services to deliver orders to customers.


n Accounting provides customer billing, accounts receivable, and accounts payable functions for Acme.
These functions are supported by (1) an SQL database that stores financial data and (2) the Oracle
Financials application for bookkeeping.


n Customer Relationship Management (CRM) attempts to ensure customer satisfaction after order
delivery by providing product support, refund processing, and warranties. CRM uses the Siebel
applications for this purpose.


The Business Services map, shown in A fully expanded Business Services map shows how the order
management process flow is mapped in Business Impact Manager. Acme appears in the topology
tree under Organization. When Acme is selected in the topology tree, the Business Services map
appears. In the figure, the Business Services map was expanded to show all elements.
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Figure 4‑5.  A fully expanded Business Services map


The Business Services map shows that the Organization named Acme relies on five
BusinessProcesses through the dependencies. Four of the BusinessProcesses consist of at least one
SoftwareService; two BusinessProcesses also consist of a DatabaseServer.


When viewing a Business Services map, you might find it useful to manually rearrange the icons so
that the logic of the Organization’s business processes is more evident. For example, after manually
rearranging the icons, the linear relationship of the BusinessProcesses is obvious in A manually
arranged Business Services map showing an organization’s business processes:


n The BusinessProcesses include DemandPlanning, OrderManagement, Fulfillment, Accounting, and
CRM. Remember that the arrowed lines indicate dependencies—not data flow. Therefore,
OrderManagement depends on, or is served by, DemandPlanning. Fulfillment is served by
OrderManagement, and so on.


n SoftwareServices include SAP, FedExFulfillment, OracleFinancials, and Siebel. Dashed arrowed lines
indicate dependency and composition: for example, the OrderManagement BusinessProcess consists
of the SAP application, and the Fulfillment BusinessProcess consists of the FedExFulfillment
application.


n The DatabaseServers are SQLFinancialRepository and SQLServerRepository. Once again, dashed
arrowed lines indicate dependency and composition, so the Accounting BusinessProcess consists of
the SQLFinancialRepository data server, and the CRM BusinessProcess consists of the
SQLServerRepository data server.
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Figure 4‑6.  A manually arranged Business Services map showing an organization’s
business processes


When an event occurs, Business Impact Manager calculates the business impact of the event and
propagates impact notifications to the affected business elements. Notification propagation in a
Business Services map for an organization shows how impacts are automatically propagated in the
example. A Degraded event occurs at the Siebel SoftwareService, which indicates Major status
(severity 2). An impact notification results at the CRM BusinessProcess, which also indicates Major
status (severity 2). No other BusinessProcesses are served by CRM, so there is no further
propagation of the impact.


Figure 4‑7.  Notification propagation in a Business Services map for an organization
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Business Process tools
Through the Global Console, you can access a set of server tools to create, modify, or clear
BusinessProcess notifications. The tools are called Business Process tools.


VMware Smart Assurance Service Assurance Manager Configuration Guide provides details on the
server tools .


BusinessProcess elements are typically affected by performance degradation or failures in infrastructure
or application elements, and are displayed as impact notifications. However, business leaders, for
example, directors and managers, as well as other authorized personnel, can use the Business Process
tools to create root-cause problem notifications for BusinessProcess elements when they notice
disruptions in processes.


For example, a financial officer of a business unit can create a root-cause notification if the officer sees
that the Accounts Receivable process is impacted by external activities such as construction in the
building that prevents access to the Accounts Receivable office. The problem with the process can then
be resolved in a timely manner.


Notify Business Process Event tool
This tool enables you to create a notification on a BusinessProcess element. In the dialog box, shown in 
Notify Business Process Event dialog box, you must provide an event name (other than “Impacted”) for
Event Name and a severity level (1, 2, 3, 4, or 5) for Severity. Event Text is optional.


Figure 4‑8.  Notify Business Process Event dialog box


The Notify Business Process Event tool is accessed from the Topology Browser Console or from a
Business Services map in a Map Console by right-clicking an instance of a BusinessProcess element and
selecting Notify Business Process Event from the Server Tools menu.


The attribute values automatically assigned to a manually created BusinessProcess notification are listed
in Attribute values for manually created business process notifications.


Table 4‑3.  Attribute values for manually created business process notifications


Attribute Value


Category BusinessNotification


Certainty 100


ClearOnAcknowledge FALSE


EventType DURABLE


Expiration 0
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Table 4‑3.  Attribute values for manually created business process notifications (Continued)


Attribute Value


InMaintenance FALSE


SourceDomainName INCHARGE-SA (Global Manager name)


Update Business Process Event tool
This tool enables you to change the Event Text and Severity values of a BusinessProcess notification
created using the Notify Business Process Event tool. In the dialog box, shown in Update Business
Process Event dialog box, you have the option to update the values for Event Text and Severity. If the
values are not updated, the current values remain.


Figure 4‑9.  Update Business Process Event dialog box


The Update Business Process Event tool is accessed from the Notification Log Console by right-clicking a
Business Process notification and selecting Update Business Process Event from the Server Tools menu.


Clear Business Process Event tool
This tool enables you to clear a BusinessProcess notification created using the Notify Business Process
Event tool. In the dialog box, shown in Clear Business Process Event dialog box, you can update the
Event Text.


Figure 4‑10.  Clear Business Process Event dialog box


The Clear Business Process Event tool is accessed from the Notification Log Console by right-clicking an
active BusinessProcess notification and selecting Clear Business Process Event from the Server Tools
menu.


Business Process tools notification scenario
Business Process tools notification scenario illustrates an impact notification created with the Business
Process tools. In the figure, the BusinessProcess Customer Relationship Management (CRM) depends
on an application, Customer Service, for its operations. When Customer Service is degraded or down,
CRM is degraded or down.


VMware Smart Assurance Service Assurance Manager Business Impact Manager User Guide


VMware, Inc.  34







Figure 4‑11.  Business Process tools notification scenario


When viewing the Business Services map, remember that it shows dependent relationships through
arrowed lines: The arrowed lines point from a business element to the element that the business element
depends on. Impact notifications propagate in the direction opposite to that of the arrowed lines: The
impact notifications propagate to a business element from the element that the business element
depends on.


To aid in understanding, read the relationships in Business Process tools notification scenario from top to
bottom and left to right. For example, CRM consists of Customer Service, and Accounting is served by
CRM.


For example, if the customer service representatives decide to go on strike at Ace Industries, their
manager can use the Business Process tools to create an UnusualSituation root event on CRM with a
severity level 1, critical. Business Impact Manager will also create an impact notification on the affected
BusinessProcess CRM, also with severity level 1, critical.


In addition, the CRM notification propagates through the ServedBy relationship to the business process of
Accounting. As a result, Business Impact Manager generates an impact notification for Accounting.


Thus, the CRM UnusualSituation notification causes CRM and Accounting Impacted notifications.
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Setting Up and Using
Business Impact Manager 5
This chapter includes the following topics:
n Configuration overview


n Understanding names and display names


n Defining business service and hierarchical group topology


n Defining business weights


n Defining business event filters


n Specifying text or XML datafiles


n Reloading service and group elements


n Reloading weight and event filter elements


n Using a utility to convert text service and group definitions to XML


n Merging pre-9.1 business-related rules files with 9.1 rules files


n Adding the Global Manager as a topology source


n Specifying a different Global Manager source


n Enabling maintenance tracking


Configuration overview
The Maintenance and Business Impact Manager (MBIM) is a separate service and server, and must be
started so that the Business Impact Manager works correctly.
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Figure 5‑1.  Data imported when the Global Manager is added as a topology source


As part of the MBIM configuration, the Service Assurance Manager server must be added as the topology
source for the MBIM server. Data imported when the Global Manager is added as a topology source
identifies the data imported by the Maintenance and Business Impact Manager server when the
Global Manager is added as a topology source to the Maintenance and Business Impact Manager server.


Adding BIM Domain as INCHARGE-SAM-MBIM-SUITE Domain
Type
To add the BIM Domain in the avaialable Domains:


1 In VMware Smart Assurance Global Console , select Configure > Global Manager
Administration Console.


2 In the Global Manager Administration Console, expand INCHARGE-SA (SAM Server)> ICS
Configuration > IC Domain Configuration > Domains.


3 Right-click Domains > New Domain. The Domain Creation Wizard appears.


VMware Smart Assurance Service Assurance Manager Business Impact Manager User Guide


VMware, Inc.  37







Figure 5‑2.  Global Administartion Console for creating a new domain


4 In the Domain Creation Wizard, type INCHARGE-MBIM as Domain Name.


5 Click Next.


6 Select Select Existing Type.


VMware Smart Assurance Service Assurance Manager Business Impact Manager User Guide


VMware, Inc.  38







7 Select INCHARGE-SAM-MBIM-SUITE from the Select Type list box.


Figure 5‑3.  Domain Creation Wizard for Select Existing Type


8 Click Launch Server Reconfiguration to reconfigure SAM.


Adding Service Assurance Manager as topology source to MBIM
server
To add the Service Assurance Manager as a topology source to MBIM:


1 In the Domain Manager Administration Console, select INCHARGE-MBIM from the Manager list
box, and select Topology > Add Source to launch the Add Source dialog box.


2 In the dialog box, as shown in Add Source dialog box for the Service Assurance Manager server,
select SA from the Element Type list box, type the name of the Service Assurance Manager server
(for example, INCHARGE-SA) in the Element Name field, and then click OK to add the Service
Assurance Manager server as a topology source.


Figure 5‑4.  Add Source dialog box for the Service Assurance Manager server


The Service Assurance Manager server contains the complete set of Business Impact Manager
topology object data and contains Business Impact Manager maps, too. The MBIM server only
imports the minimum required Business Impact Manager data to perform business impact analysis.
The MBIM server does not contain a complete set of Business Impact Manager object data.


3 INCHARGE-SA


4 SA
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Import datafiles
Two sets of user-configurable import datafiles, identified in Text import datafiles for Business Impact
Manager and XML import datafiles for Business Impact Manager, are available with the Global Manager. 
Defining business service and hierarchical group topology, Defining business weights, and Defining
business event filters describe how to define entries in the import datafiles.


Specifying text or XML datafiles describes how to specify which text-format or XML-format import datafiles
are loaded by the Global Manager, for subsequent import by Business Impact Manager.


Regardless of the selection (TEXT or XML), the Global Manager will load and the
Business Impact Manager will import the event filter import datafile.


VMware Smart Assurance Service Assurance Manager Business Impact Manager User Guide


VMware, Inc.  40







Figure 5‑5.  Text import datafiles for Business Impact Manager
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Figure 5‑6.  XML import datafiles for Business Impact Manager


Topology Builder
In addition to defining business service topology in text or XML import datafiles, users can also use the
Topology Builder to create or modify business service topology. The Topology Builder is described in 
Chapter 6 Creating Business Elements with the Topology Builder
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Note that elements or relationships created by the Topology Builder can be removed only by the Topology
Builder. Similarly, the Topology Builder Console cannot remove any elements or relationships created or
established using the import datafiles.


The Topology Builder can also delete service information created using other means, such as an ASL
script or using the create operation with the dmctl utility.


Group Builder
In addition to defining hierarchical group topology in text or XML import datafiles, users can also use the
Group Builder (also known as a Group Definitions window) to create or modify hierarchical group
topology. The VMware Smart Assurance Service Assurance Manager Configuration Guide describes the
Group Builder.


Automatic conversion of text service and group definitions to XML
Users can use a Service Assurance topology export utility to convert text-format service and group
definitions to XML-format definitions and write the definitions to an XML service-group import datafile. 
Using a utility to convert text service and group definitions to XML provides the procedure for performing
the conversion.


File migration from an old installation to a new installation
When migrating from an old Service Assurance Manager installation to a new
Service Assurance Manager installation, users must manually merge any modified business-related rules
files with the same files in the new installation. Merging pre-9.1 business-related rules files with 9.1 rules
files identifies the files to be merged and provides the procedure for merging the files.


InMaintenance attribute processing
For a business impact notification created solely from causal infrastructure or application notifications
associated with devices in maintenance mode, Business Impact Manager will set the InMaintenance
attribute of the business impact notification to TRUE.


Put another way, Business Impact Manager will set the InMaintenance attribute of a business impact
notification to TRUE when the InMaintenance attribute of each of the underlying causal infrastructure or
application notifications is set to TRUE. If the InMaintenance attribute of at least one underlying causal
notification is FALSE, Business Impact Manager will set the InMaintenance attribute of the business
impact notification to FALSE.


An administrator can configure a notification list and associate it with a user profile to determine whether
users of the user profile will see, in their Notification Log Console, those business impact notifications
having InMaintenance=TRUE. The
VMware Smart Assurance Service Assurance Manager Configuration Guide provides instructions for
creating and modifying notification lists.
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Global Manager sourcing
Adding the Global Manager as a topology source to Business Impact Manager enables
Business Impact Manager to import business service and hierarchical group topology, weights, and event
filters from the Global Manager. Adding the Global Manager as a topology source provides instructions
for completing this task.


Understanding names and display names
Each element in the Global Manager’s repository must have a unique name. When you create a topology
element, the Global Manager assigns a predetermined prefix to each element’s name to prevent naming
conflicts with other topology elements. Prefixes for business element names lists the prefixes for the
business elements managed by Business Impact Manager.


Table 5‑1.  Prefixes for business element names


Prefix Business element


SRVO- ServiceOffering


BP- BusinessProcess


SRVS- ServiceSubscriber


ORG- Organization


BU- BusinessUnit


LOB- Line of business (LOB)


DEP- Department


CUS- Customer


HGRP HierarchicalGroup


In addition to a Name, each element is also given a DisplayName, which is easier to read and
understand. The DisplayName does not include the element prefix.


When you create topology elements using topology import datafiles or the Topology Builder, specify the
DisplayName. The Global Manager automatically creates the Name by adding the prefix to the
DisplayName.


When topology elements are created by other means, for example, through a custom adapter, the Name
of the element must include the prefix while the DisplayName should not. Elements created using these
methods must observe the naming conventions used by VMware Smart Assurance software.


Defining business service and hierarchical group topology
For Business Impact Manager to import business service and hierarchical group topology from its source
Global Manager, you define business service and hierarchal group topology in the two text import
datafiles or the single XML import datafile identified in Business service and hierarchal group import
datafiles for Business Impact Manager. The datafiles are located in the Service Assurance installation
area from which the source Global Manager is invoked.
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Figure 5‑7.  Business service and hierarchal group import datafiles for Business Impact
Manager


Whether you choose to use the two text import datafiles or the single XML import datafile to define
service and group elements, the Global Manager will load the elements in the same way: At startup, the
Global Manager loads the service and group elements and store them in its repository. Specifying text or
XML datafiles describes how to specify the import of text-format or XML-format import datafiles.


This section focuses on defining service and group elements in the service.data.template and topology-
group.data.template files, respectively. Defining service and group elements in the service-group-data.xml
file is identical to defining service and group elements in the two text files except that the definitions are in
XML format. The format of the service-group-data.xml file (and the service-group-data-sample.xml file) is
defined in the BASEDIR/smarts/conf/ics/bim-config.dtd file.


Text import datafile service.data.template
All lines in the original service.data.template file are commented-out (preceded with a pound sign),
meaning that by default the Global Manager does not load any business service definitions from the
service.data.template file.


The discussions that follow assume that the name of the service import datafile is service.data.template.
Of course, when editing the service.data.template file to create a service import datafile, as explained in 
Procedure for creating a service import datafile, you can save the file as a new name.
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Input format
The input format of the service.data.template file is based on Offering Types and Subscriber Types,
where:


n Offering Types represent any of the following ICIM classes:


n ServiceOffering


n BusinessProcess


n Subscriber Types represent any of the following ICIM classes:


n ServiceSubscriber


n Customer


n Organization


n BusinessUnit


n LOB


n Department


These ICIM classes compose the business data model, which is described in Business Impact
Manager elements.


Relationship keywords
The following portion of the service.data.template file shows the relationship keywords (in bold) that can
be stated between Offering Types and Subscriber Types, between Subscriber Types and Subscriber
Types, and between Offering Types and underlying infrastructure elements and applications. The serves
and servedby relationships are valid for the BusinessProcess Offering Type but not for the
ServiceOffering Offering Type:


# <Offering Type> <service> subscribers <Subscriber Type>::<subscriber1> ...


# <Offering Type> <service> subscribers file:<//foo/bar/service.subscribers>


# <Offering Type> <service> members <class1>::<instance1> ...


# <Offering Type> <service> members file:<//foo/bar/service.members>


#


# <Subscriber Type> <subscriber> subscriptions <Offering Type>::<service1> ...


# <Subscriber Type> <subscriber> composedof <Subscriber Type>::<subscriber1> ...


# <Subscriber Type> <subscriber> partof <Subscriber Type>::<subscriber1> ...


#


# BusinessProcess <bProcess> serves <bProcess1> ...


# BusinessProcess <bProcess> servedby <bProcess1> ...


Relationships enable Business Impact Manager to associate business elements with each other, and with
underlying infrastructure elements and applications. Relationships also identify dependencies of elements
on other elements, and identify groupings. Examples:


n subscriptions
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n (corresponds to the ICIM-defined relationship named Subscriptions):


Associates a Subscriber Type to one or more Offering Types that are being provided to the
Subscriber Type.


n subscribers


n (corresponds to the ICIM-defined relationship named Subscribers):


Associates an Offering Type to one or more Subscriber Types who subscribe to the Offering Type.


n members


n (corresponds to the ICIM-defined relationship named ConsistsOf):


Associates an Offering Type to one or more underlying infrastructure, application, or hierarchical
group elements that are directly relied upon by the Offering Type. The list of underlying elements
might be a list of network elements (hosts, routers, and so on), a list of applications, or a
HierarchicalGroup.


n servedby


n (corresponds to the ICIM-defined relationship named ServedBy):


Associates a BusinessProcess to one or more other BusinessProcesses that serve the
BusinessProcess.


Syntax
The syntax for defining business services in the service.data.template file is as follows:


<class> <instance> <relationship keyword> <related_instance>


Business service definition examples
In the following examples, relationship keywords are indicated in bold type.


Here is a ServiceSubscriber example:


ServiceSubscriber subscriber1 subscriptions service1 service2 


   BusinessProcess::bProcess1


This business service definition results in the creation of the ServiceSubscriber element subscriber1 and
the ServiceOffering elements service1 and service2. The bProcess1 element will also be created as an
instance of the class, BusinessProcess. The ServiceOffering class is not specified because the
subscriptions keyword implies that these elements are instantiated from the ServiceOffering class.


The ServiceOffering example that follows uses similar logic:


ServiceOffering service1 subscribers subscriber1 subscriber2 Customer::customer1
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This business service definition results in the creation of the ServiceOffering element service1 and the
ServiceSubscriber elements subscriber1 and subscriber2. The customer1 element will also be created as
an instance of the class, Customer. The ServiceSubscriber class is not specified because the subscribers
keyword implies that these elements are instantiated from the ServiceSubscriber class.


When the relationship keyword is serves or servedby, the value of <class> is BusinessProcess, and the
implied class for <related_instance> is also BusinessProcess:


BusinessProcess bProcess1 serves bProcess2 BusinessProcess::bProcess3


BusinessProcess bProcess1 servedby bProcess4


Here are some more Subscriber Type examples:


Organization organization1 subscriptions service1 BusinessProcess::bProcess1


BusinessUnit business_unit1 subscriptions service1 BusinessProcess::bProcess1


LOB lob subscriptions ServiceOffering::service1 BusinessProcess::bProcess1


Department department subscriptions service1 BusinessProcess::bProcess1


Customer customer subscriptions service1 service2 BusinessProcess::bProcess1


Additionally, Subscriber Type elements can be a part of or composed of other Subscriber Type elements.
The syntax is:


Organization organization1 composedof BusinessUnit::business_unit1 


   Department::department1


LOB lob1 partof business_unit1 BusinessUnit::business_unit2


After a BusinessProcess instance is specified in the service.data.template file, it can be specified as a
member of a ServiceOffering or HierarchicalGroup that is also defined in the service.data.template file:


ServiceOffering service1 members BusinessProcess::bProcess1 Host::H1


HierarchicalGroup group1 members BusinessProcess::bProcess1 Router::R1


A BusinessProcess may consist of SoftwareService elements or other logical elements that already exist
in the topology:


BusinessProcess bProcess1 members SoftwareService::A1 SoftwareService::A2


For a complete example, the Organization, BusinessProcess, DatabaseServer, and SoftwareService
elements and their relationships shown in the Business Services map in Business service definition
examples through Business service definition examples are defined as follows:


BusinessProcess CRM servedby BusinessProcess::Accounting


BusinessProcess Accounting servedby BusinessProcess::Fulfillment


BusinessProcess Fulfillment servedby BusinessProcess::OrderManagement


BusinessProcess OrderManagement servedby BusinessProcess::DemandPlanning


Organization Acme subscriptions BusinessProcess::OrderManagement


BusinessProcess OrderManagement members SoftwareService::SAP


BusinessProcess Fulfillment members SoftwareService::FedExFulfillment
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BusinessProcess Accounting members SoftwareService::OracleFinancials 


   DatabaseServer::SQLFinancialRepository


BusinessProcess CRM members SoftwareService::Siebel 


   DatabaseServer::SQLServerRepository


When dealing with large numbers of members in a ServiceOffering, it may become more practical to use
HierarchicalGroups to represent a group of network elements. Groups may be defined in the
service.data.template file along with the ServiceOfferings. The
VMware Smart Assurance Service Assurance Manager Configuration Guide contains additional
information on defining and importing HierarchicalGroups.


Optional input files
Listing related (<related_instance>) subscribers, members, or applications is not practical because there
are too many of them, elements can be listed in separate input files that are referenced in the
service.data.template file. For example:


BusinessProcess bProcess1 serves bProcess2 bProcess3 bProcess4


is the same as:


BusinessProcess bProcess1 serves file://C:/mydir/myfile


where C:/mydir/myfile consists of three lines:


bProcess2


bProcess3


bProcess4


Input files must be specified in the service.data.template file.


Each element in an input file must use the <class_name>::<instance> syntax with one entry per line.
Similar to the service.data.template file, Business Impact Manager assumes that elements in the input file
for an Offering Type having a subscribers relationship keyword are ServiceSubscriber elements.


When members are specified, the elements must already exist in the topology so that the relevant
relationship keyword can be established with the requested element. Otherwise, such items will be
ignored.


Rules and considerations for creating business service definitions
When defining business service definitions in the service.data.template file, keep the following rules and
considerations in mind:


n Each business element to be included must start with the class name (for example, ServiceOffering,
ServiceSubscriber).


n You can combine ServiceOffering data with group data (HierarchicalGroups) in the
service.data.template file.
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n When defining members or subscribers in a separate input file, <file_name> is a file that will contain
one member or subscriber name per line, as an alternative to listing members in the
service.data.template file. For members, the <class_name>::<instance> syntax is required.


n Each relationship must be defined on a separate line.


n The same business element can appear in multiple lines (so you do not have to list all of the related
elements on a single line).


n Because a service is created as a ServiceOffering of a subscriber, it does not need to be defined
separately if it does not have any other subscribers or any members of its own. Similarly, when a
subscriber appears in a line where an offering is listed, it is automatically created. You do not have to
define it individually.


n The system name of an element does not need to be a fully qualified domain name. The truncated
system name will be searched for and matched.


Procedure for creating a service import datafile
You use the service.data.template file as the basis for creating a service import datafile.


To create a service import datafile:


1 In the installation area from which the source Global Manager is invoked, go to the
BASEDIR/smarts/bin directory and type the following command to open the service.data.template file:


               sm_edit conf/ics/service.data.template


            


2 Add your business service definitions to the file.


3 Save and close the file. The modified version of the service.data.template file is saved to the
BASEDIR/smarts/local/conf/ics directory in the installation area.


If you saved the service import datafile as a new name, the file is saved as the new name in the
BASEDIR/smarts/local/conf/ics directory. Perform the procedure in Specifying text or XML datafiles to
make the Global Manager aware of the new service import datafile. Then, perform the procedure in 
Reloading service and group elements to force the Global Manager to load the elements defined in
the new service import datafile.


If you saved the service import datafile as is, the file is saved as service.data.template in the
BASEDIR/smarts/local/conf/ics directory. If the Global Manager was running before you created the
file, perform the procedure in Reloading service and group elements to force the Global Manager to
load the elements defined in the service import datafile.


Thereafter, every time that you modify the service import datafile, perform the procedure in Reloading
service and group elements to force the Global Manager to reload the elements defined in the service
import datafile.
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Text import datafile topology-group.data.template
All lines in the original topology-group.data.template file are commented-out (preceded with a pound
sign), meaning that by default the Global Manager does not load any hierarchical group definitions from
the topology-group.data.template file.


The discussions that follow assume that the name of the group import datafile is topology-
group.data.template. Of course, when editing the topology-group.data.template file to create a group
import datafile, as explained in Procedure for creating a group import datafile, you can save the file as a
new name.


Input format and relationship keywords
The following portion of the topology-group.data.template file shows the input format of the topology-
group.data.template file and the relationship keywords (in bold) that can be stated between
HierarchicalGroups and children or member groups:


# HierarchicalGroup <group> children <group1> <group2> ...


# HierarchicalGroup <group> members  <class1::instance1> <class2::instance2> ...


# HierarchicalGroup <group> members  file:<//foo/bar/group.members>


The members relationship keyword corresponds to ConsistsOf in the ConsistsOf/MemberOf ICIM-defined
relationship set, and the children relationship keyword corresponds to ChildGroups in the
ChildGroups/ParentGroup ICIM-defined relationship set.


The VMware Smart Assurance Service Assurance Manager Configuration Guide provides information
about defining and importing HierarchicalGroups.


Hierarchical group definition examples
In the following examples, relationship keywords are indicated in bold type:


HierarchicalGroup "Groups of SO1" children "Group1 of SO1" "Group2 of SO1"


HierarchicalGroup "Groups of SO1" members file:/foo/bar/g1_so1.members


HierarchicalGroup "Routers of SO1" children Critical


HierarchicalGroup "Routers of SO1" members Router::lab-gw.smarts.com 


   Router::ny-sma-1


HierarchicalGroup "Routers of SO1" members file:/foo/bar/routers_so2.members


HierarchicalGroup Critical members Router::moto-gw


HierarchicalGroup G1 children G2


HierarchicalGroup G1 members VLAN::VLAN-1 Cable::IF-172.16.0.0 


   IPNetwork::LINK-IF-172.16.0.0


Procedure for creating a group import datafile
You use the topology-group.data.template file as the basis for creating a group import datafile.


To create a group import datafile, follow the instructions in Procedure for creating a service import
datafile; substitute service.data.template with topology-group.data.template in the procedure and add
your hierarchical group definitions to the group import datafile.
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Defining business weights
For Business Impact Manager to import weights from its source Global Manager, you define weight
elements in the text or XML import datafile identified in Weights import datafiles for Business Impact
Manager. The datafiles are located in the Service Assurance installation area from which the source
Global Manager is invoked.


Figure 5‑8.  Weights import datafiles for Business Impact Manager


Whether you choose to use the text or the XML import datafile to define weight elements, the
Global Manager will load the elements in the same way: At startup, the Global Manager loads the weight
elements but does not store them in its repository. Specifying text or XML datafiles describes how to
specify the import of text-format or XML-format import datafiles.


This section focuses on defining weight elements in the weights.conf file. Defining weight elements in the
weights-conf.xml file is identical to defining weight elements in the text file except that the definitions are
in XML format. The format of the weights-conf.xml file is defined in the BASEDIR/smarts/conf/ics/bim-
config.dtd file.


Text import datafile weights.conf
All but the following lines in the original weights.conf file are commented-out (preceded with a pound
sign), meaning that by default the Global Manager loads the following weight definitions from the
weights.conf file:


n ClassWeight ICIM_ManagedElement      1


n ClassWeight UnitaryComputerSystem      1
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n ClassWeight ICIM_Service      1


n ClassWeight ServiceOffering      1


n ClassWeight ServiceSubscriber      1


Impact value calculations
Business Impact Manager calculates a numeric impact value for a root-cause problem notification by
summing the weights of all of the elements affected by the problem. The numeric impact value appears in
the Impact column for the problem notification in the Notification Log Console.


A weight is a numeric value that you assign to an element (for example, a ServiceOffering, a
BusinessProcess, or an infrastructure or application element supporting a ServiceOffering or
BusinessProcess) based on its importance to your business. By summing all of the assigned values,
Business Impact Manager determines which problem notifications have a greater business impact than
other problem notifications. Assigning weights allows you to apply your own criteria to “weigh” problems
based on information that is most important to you at any given time; it enables you to prioritize support
efforts based on business impacts.


Only root-cause problem notifications can have a non-zero Impact value. A notification can both cause
and be caused by other notifications, as shown in Impact value calculation and impact propagation.


Figure 5‑9.  Impact value calculation and impact propagation


Notification N2 is caused by N1, and causes notification N3. However, even if a notification causes other
notifications, if it is not the root-cause problem notification, its Impact value is zero. Only notification N1
has an Impact value greater than zero.


In the figure, note that even if the element denoted in notification N1 has a weight assigned to it,
Business Impact Manager does not include that weight in the calculated impact value for N1.
Business Impact Manager includes in its calculation only the weights of the elements affected by the
problem element.
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Mechanisms for assigning weights
Business Impact Manager uses the weights.conf file to assign weights to ICIM classes and instances
(elements, objects). By default, Business Impact Manager assigns a weight of “1” for each managed
infrastructure or business element in the ICIM_ManagedElement class. Therefore, if left at this default
level, all impacted infrastructure, ServiceOffering, BusinessProcess, and ServiceSubscriber elements
carry equal “weight” when determining an event’s impact.


Strategies for assigning weights
Weight values are assigned to ICIM classes and instances in the weights.conf file.


Weights can be assigned to any class or instance by specifying one of the following keywords:


n ClassWeight


n InstanceNameWeight


n InstanceWeight


The syntax in the file is as follows:


ClassWeight <class_name> <value>


InstanceNameWeight <class_name> <DisplayName> <value>


InstanceNameWeight <class_name> <full_instance_name> <value>


InstanceWeight <class_name> <instance_name> <value>


For the keyword InstanceNameWeight, business classes are specified by their DisplayName, without
a prefix. For all other classes, you must specify the <full_instance_name>, or the complete name of
the element, including the prefix of the element. For <instance_name>, you can specify the
DisplayName or you can specify a wildcard pattern. The symbols for wildcards are listed and
described in the weights.conf file.


When you assign weight values to elements, categorize the elements according to their importance
within your environment. Then, assign greater values to the elements that are more important to your
business.


For example:


ClassWeight     ICIM_ManagedElement 1


InstanceNameWeight  BusinessProcess Inventory 4000


InstanceNameWeight  Application APP-Inventory Service 4000


InstanceWeight      Router *[Gg][Ww]* 1000
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Similarly, you can assign varying weights to service subscribers:


ClassWeight   Organization    1000


ClassWeight   BusinessUnit    1200


ClassWeight   LOB             1400


ClassWeight   Department      1600


ClassWeight   Customer        1800


In Business Impact Manager’s calculations, the weight assigned to an instance takes precedence
over the weight assigned to a class, and the weight assigned to a subclass takes precedence over
the weight assigned to the parent class.


Procedure for creating a weights import datafile
You use the weights.conf file as the basis for creating a weights import datafile.


To create a weights import datafile:


1 In the installation area from which the source Global Manager is invoked, go to the
BASEDIR/smarts/bin directory and type the following command to open the weights.conf file:


               sm_edit conf/ics/weights.conf


            


2 Add your weight definitions to the file.


3 Save and close the file. The modified version of the weights.conf file is saved to the
BASEDIR/smarts/local/conf/ics directory in the installation area.


If the Global Manager was running before you created your weights import datafile, perform the
procedure in Reloading weight and event filter elements to force the Global Manager to load the
weight elements defined in the BASEDIR/smarts/local/conf/ics/weights.conf file.


Thereafter, every time that you modify the weights import datafile, perform the procedure in Reloading
weight and event filter elements to force the Global Manager to reload the weight elements defined in
the BASEDIR/smarts/local/conf/ics/weights.conf file.


Defining business event filters
For Business Impact Manager to import event filters from its source Global Manager, you define event
filter elements in the XML import datafile identified in Event filter import datafile for Business Impact
Manager. The datafile is located in the Service Assurance installation area from which the source
Global Manager is invoked.


VMware Smart Assurance Service Assurance Manager Business Impact Manager User Guide


VMware, Inc.  55







Figure 5‑10.  Event filter import datafile for Business Impact Manager


At startup, the Global Manager loads the event filter elements but does not store them in its repository.


XML import datafile event-filter-conf.xml
All lines in the original event-filter-conf.xml file are commented-out, meaning that by default the
Global Manager does not load any event filter definitions from the event-filter-conf.xml file.


You use the event-filter-conf.xml file to create a table of events for which Business Impact Manager will
not generate business impact notifications. An event filter definition is designated as a
ClassName::EventName pair.


The format of the event-filter-conf.xml file is defined in the BASEDIR/smarts/conf/ics/bim-config.dtd file.


Procedure for creating an event filter import datafile
You use the event-filter-conf.xml file as the basis for creating an event filter import datafile.


To create an event filter import datafile:


1 In the installation area from which the source Global Manager is invoked, go to the
BASEDIR/smarts/bin directory and type the following command to open the event-filter-conf.xml file:


               sm_edit conf/ics/event-filter-conf.xml


            


2 Add your event filter definitions to the file.
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3 Save and close the file. The modified version of the event-filter-conf.xml file is saved to the
BASEDIR/smarts/local/conf/ics directory in the installation area.


If the Global Manager was running before you created your event filter import datafile, perform the
procedure in Reloading weight and event filter elements to force the Global Manager to load the
event filter elements defined in the BASEDIR/smarts/local/conf/ics/event-filter-conf.xml file.


Thereafter, every time that you modify the event filter import datafile, perform the procedure in 
Reloading weight and event filter elements to force the Global Manager to reload the event filter
elements defined in the BASEDIR/smarts/local/conf/ics/event-filter-conf.xml file.


Specifying text or XML datafiles
You use the Business Templates configuration window of the Global Manager Administration Console
attached to the source Global Manager to specify whether the source Global Manager loads, and the
Business Impact Manager imports:


n The text-format service and group import datafiles (service.data.template and topology-
group.data.template by default) or the XML-format service-group import datafile (service-group-
data.xml for example).


n The text-format weights import datafile (weights.conf by default) or the XML-format weights import
datafile (weights-conf.xml).


Open the Global Manager Administration Console
The VMware Smart Assurance Service Assurance Manager Operator Guide provides information about
starting the Global Console, logging in, and attaching to a Manager. You need a user account with
administrative privileges to access the Global Manager Administration Console. The default
administrative account is username admin and password changeme.


Attaching the Global Console to the Global Manager provides additional information.


The VMware Smart Assurance System Administration Guide provides information about changing the
password for the default administrative account (recommended) and configuring access privileges. The
VMware Smart Assurance Service Assurance Manager Configuration Guide provides information on
configuring permissions to perform specific console operations.


To open the Global Manager Administration Console:


1 Attach the Global Console to the Global Manager in your deployment.


A Notification Log Console opens.


2 In the console, select Configure > Global Manager Administration Console to open the G lobal
Manager Administration Console.


VMware Smart Assurance Service Assurance Manager Business Impact Manager User Guide


VMware, Inc.  57







Open the Business Templates configuration window
To open the Business Templates configuration window:


1 In the left panel of the Global Manager Administration Console, expand the configuration tree to
display Business Templates.


2 Click Business Templates to display its configuration window as shown in Business Templates
configuration window—example.


Figure 5‑11.  Business Templates configuration window—example


In the Business Templates configuration window, the upper list box determines the topology format
(TEXT|XML) of the service/group import datafiles, and the lower list box determines the format
(TEXT|XML) of the weights import datafile, that is, determines whether the weights.conf file or the
weights-conf.xml file is to be loaded by the Global Manager. The text box identifies which
service/group import datafiles are currently selected for loading by the Global Manager.


With the exception of using the lower list box to determine the weights import datafile, all functions
available through the Business Templates configuration window pertain to selecting which
service/group import datafiles are to be loaded by the Global Manager.


Configure a service/group import datafile list
To configure a service/group import datafile list:


1 In the Business Templates configuration window, select TEXT in the upper list box if you want to
configure a text service/group import datafile list, or select XML if you want to configure an XML
service/group datafile list.
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2 In the Business Templates configuration window, click Modify List to launch the Edit Business
Template Files dialog box as shown in Edit Business Template Files dialog box—example.


Figure 5‑12.  Edit Business Template Files dialog box—example


If TEXT is selected in the upper list box of the Business Templates configuration window, all files with
names matching *.template in the BASEDIR/smarts/local/conf/ics or BASEDIR/smarts/conf/ics
directory will appear in the Available Template Files list of the dialog box, except for any already
selected matching text files, which will appear in the Selected Template Files list. You can select one
or more text service/group import datafiles for loading by the Global Manager.


Note   The asterisk (*) is a wildcard character that matches an arbitrary string of characters, including
an empty string.


If XML is selected in the upper list box of the Business Templates configuration window, all files with
names matching *service-group-data*.xml in the BASEDIR/smarts/local/conf/ics or
BASEDIR/smarts/conf/ics directory will appear in the Available Template Files list of the dialog box,
except for any already selected matching XML file, which will appear in the Selected Template Files
list. You can select only one XML service-group import datafile for loading by the Global Manager.


Be aware that even after the format in the Business Templates configuration window is changed to
the opposite value, whatever service/group import datafiles are currently selected for loading will
appear in the Selected Template Files list. For example, if you set the upper list box in Configure a
service/group import datafile list to XML and click Modify List, the service.data.template and topology-
group.data.template files will still appear in the Selected Template Files list as shown in Edit Business
Template Files dialog box—example 2.
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Figure 5‑13.  Edit Business Template Files dialog box—example 2


Of course, all files with names matching *service-group-data*.xml in the
BASEDIR/smarts/local/conf/ics or BASEDIR/smarts/conf/ics directory will appear in the Available
Template Files list.


You remove an unwanted, currently selected file from the Business Templates configuration by
selecting it in the Selected Template Files list and clicking Remove. Or, as an alternative, you can
remove the file by selecting it in the Business Templates configuration window, Configure a
service/group import datafile list, and clicking Remove Selected.


Note   At anytime, you can click Refresh in the Business Templates configuration window to populate
the window with its original settings.


To modify the list of selected service/group import datafiles:


3 In the Edit Business Template Files dialog box, select a file in the Available Template Files list box
or in the Selected Template Files list box.


4 Click Add to move an available file to the Selected Template Files list, or click Remove to move a
selected file to the Available Template Files list.


5 In the Edit Business Template Files dialog box, type the name of a service/group import datafile in
the New Template File text box.


For TEXT format, you can type the name of any text service/group import datafile except a name
matching *.xml. For XML format, you can type the name of any XML service-group import datafile
matching *.xml. The datafile must reside in the BASEDIR/smarts/local/conf/ics directory.


6 Click Add to move the new file to the Selected Template Files list.


7 Click OK to close the dialog box.
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8 In the Business Templates configuration window, click Apply to save your changes.


Upon clicking Apply, the underlying software loads a single configuration object named
ICS_BusinessTemplatesConfiguration::ICS-Business Templates and stores it in the Global Manager's
repository. The attributes of this object hold most of the settings of the Business Templates
configuration, including the names of the selected service/group import datafiles and the format
(TEXT|XML) of the datafiles. An attribute of the BIM_Manager::BIM-Manager object holds the format
(TEXT|XML) of the selected weights import datafile.


To load the topology elements defined in the service/group import datafiles, perform the procedure
given in Reloading service and group elements. To load the weight elements defined in the weights
import datafile, perform the procedure given in Reloading weight and event filter elements.


Each time an import datafile is reloaded, the new definition set replaces the current one. Any
eliminated definition from an import datafile will remove that definition from the Global Manager’s
memory.


Note   The Global Manager automatically loads the topology elements defined in the service/group
datafiles whenever it performs a topology synchronization with an underlying Domain Manager.


Reloading service and group elements
When you modify the content of a text service import datafile, a text group import datafile, or an XML
service-group import datafile that has already been loaded by the source Global Manager, you must issue
a dmctl command to force the Global Manager to reload the elements defined in the service and group
import datafiles. The dmctl command invokes a driver that loads the elements defined in these datafiles.


To reload business service and hierarchical group elements:


1 In the installation area from which the source Global Manager is invoked, go to the
BASEDIR/smarts/bin directory and type the following command on one line:


               dmc


               


               tl -s <


               Global Manager name


               > 


               


                  invoke GA_DaemonDriver::ICS-Group-Driver start


               dmctl -s INCHARGE-SA invoke 


               


                  GA_DaemonDriver::ICS-Group-Driver start
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2 If prompted for a username and password, specify your user account; for example, to specify the
default administrative account, enter username admin and password changeme.


Each time a service/group import datafile is reloaded, the new definition set replaces the current one.
Any eliminated definition from a service/group import datafile will remove that definition from the
Global Manager’s repository.


Reimporting affects the elements or relationships previously created by a service/group data import; it
does not affect the elements or relationships created using the Topology Builder Console.


Reloading weight and event filter elements
When you modify the content of a weights or event filter import datafile that has already been loaded by
the source Global Manager, you must issue an sm_adapter command to force the Global Manager to
reload the elements defined in the weights and event filter import datafiles. The sm_adapter command
invokes the drivers that load the elements defined in these datafiles.


To reload business weight and event filter elements:


1 In the installation area from which the source Global Manager is invoked, go to the
BASEDIR/smarts/bin directory and type the following command:


               s


               


               m_adapter -s <


               Global Manager name


               > ics/ICS_RemoteConfig.as


               l


               sm_adapter -s INCHARGE-SA ics/ICS_RemoteConfig.asl


            


2 If prompted for a username and password, specify your user account; for example, to specify the
default administrative account, type username admin and password changeme.


Each time a weights or event filter import datafile is reloaded, the new definition set replaces the
current one. Any eliminated definition from a weights or event filter import datafile will remove that
definition from the Global Manager’s memory.


Using a utility to convert text service and group
definitions to XML
You can use a Service Assurance topology export utility to convert text-format service and group
definitions to XML-format definitions and write the definitions to an XML service-group import datafile. The
final location of this XML service-group import datafile must be the BASEDIR/smarts/local/conf/ics
directory in the installation area.


To automatically convert text service and group definitions to XML:


1 Consult Specifying text or XML datafiles and select the text service and group import datafiles that
you want to convert to XML.
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2 Consult Reloading service and group elements and load the topology elements defined in the import
datafiles selected in step 1 .


3 In the installation area from which the source Global Manager is invoked, go to the
BASEDIR/smarts/bin directory and type the following command on one line:


               dmctl -s 


               <Global Manager name>


                invoke 


               


                  ICS_ConfigurationManager::ICS-ConfigurationManager 


               


                  exportConfigFor BIM_Topology >


               


                  <BASEDIR/smarts/local/conf/ics/name of XML datafile into which 


               


                  to write the service-group definitions>


               dmctl -s <


               INCHARGE-SA


               > invoke 


               


                  ICS_ConfigurationManager::ICS-ConfigurationManager 


               


                  exportConfigFor BIM_Topology >


               


                  


               /opt/InCharge/SAM/smarts/local/conf/ics/service-group-data.xml


            


4 If prompted for a username and password, specify your user account; for example, to specify the
default administrative account, type username admin and password changeme.


If you want to convert text-format weight definitions to XML-format definitions and save the definitions
to the BASEDIR/smarts/local/conf/ics/weights-conf.xml import datafile, you can do so manually by
following the classweightconfig format defined in the bim-config.dtd.


Merging pre-9.1 business-related rules files with 9.1 rules
files
When migrating from a Service Assurance Manager pre-9.1 installation to a Service Assurance Manager
9.1 installation, you must manually merge any modified business-related rules files with the same files in
the 9.1 installation. File merging when migrating from a pre-9.1 installation to an 9.1 installation identifies
the files to be merged.
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Figure 5‑14.  File merging when migrating from a pre-9.1 installation to an 9.1 installation


In the figure, the top two files are relevant to Business Impact Manager operation, and the bottom three
files are relevant to Global Manager operation.


If you have not modified any of these files in the pre-9.1 installation from which you are migrating, you do
not need to merge the older versions of the files in the pre-9.1 installation with the newer versions of the
files in the 9.1 installation.


To merge a pre-9.1 business-related rules file with the 9.1 rules file:


1 Use an editor application with a file-comparison capability to open both the pre-9.1 file and the 9.1
file.


2 Perform a comparison of the pre-9.1 file with the 9.1 file to identify your modifications.


3 Add your modifications to the 9.1 file. You can copy text from the pre-9.1 file and copy it into the 9.1
file.


4 Close the pre-9.1 file without saving the file.


5 Save and close the 9.1 (and modified) file to the /local subdirectory identified in File merging when
migrating from a pre-9.1 installation to an 9.1 installation.
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Adding the Global Manager as a topology source
You use the Domain Manager Administration Console attached to Business Impact Manager to add the
Global Manager as a topology source to Business Impact Manager.


When you add the Global Manager as a topology source, Business Impact Manager imports business
service topology, hierarchical group topology, weights, and event filters from the Global Manager.


Open the Domain Manager Administration Console
The VMware Smart Assurance Service Assurance Manager Operator Guide provides information about
starting the Global Console, logging in, and attaching to a Manager. You need a user account with
administrative privileges to access the Domain Manager Administration Console. The default
administrative account is username admin and password changeme.


Attaching the Global Console to the Global Manager provides additional information.


The VMware Smart Assurance System Administration Guide provides information about changing the
password for the default administrative account (recommended) and configuring access privileges. The
VMware Smart Assurance Service Assurance Manager Configuration Guide provides information on
configuring permissions to perform specific console operations.


To open the Domain Manager Administration Console:


1 Attach the Global Console to the Business Impact Manager in your deployment.


A Topology Browser Console opens.


2 In the console, select Configure > Domain Manager Administration Console to open the Domain
Manager Administration Console.


Add the Global Manager as a topology source
To add the Global Manager as a topology source to Business Impact Manager:


1 In the Domain Manager Administration Console, select Business Impact Manager (BIM) from the
Manager list box, and select Topology > Add Source to launch the Add Source dialog box.


2 In the dialog box, as shown in Add Source dialog box for the Global Manager—example, select SA
from the Element Type list box, type the name of the Global Manager application (for example,
INCHARGE-SA) in the Element Name field, and then click OK to add the Global Manager as a
topology source.


Figure 5‑15.  Add Source dialog box for the Global Manager—example


In response, Business Impact Manager:


n Adds the specified Global Manager as a topology source.


n Creates in its repository an InChargeDomain object (for example, INCHARGE-SA) for the
Global Manager instance added as a topology source.
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n Establishes a connection to the Global Manager source.


A Discovery Progress window opens, displays progress messages. When you see "Last
discovery completed" near the end of the progress report in the Discovery Status section, the
setup of the Global Manager as a source to Business Impact Manager is complete.


At that point, Business Impact Manager:


n Probes the Global Manager source for business service topology, group topology, weights,
and event filters.


n Imports and loads this data to its repository.


n Subscribes to infrastructure and application notifications from the Global Manager.


3 INCHARGE-SA


4 SA


5 Click Close to close the Discovery Progress window.


After completing its initial import from the Global Manager, Business Impact Manager will import
business service topology, group topology, weights, and event filters from the Global Manager
whenever any of this data changes in the Global Manager.


Note   Upon adding a Global Manager source, the Topology > Add Source menu option on the
Domain Manager Administration Console is unavailable (dimmed) to prevent users from adding more
than one Global Manager source to Business Impact Manager.


Specifying a different Global Manager source
You can specify a different Global Manager source for Business Impact Manager by performing the
following two steps:


1 Remove the current Global Manager source by stopping the Business Impact Manager and then
restarting it with a startup command line that contains the --norestore option.
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2 Add a new Global Manager source by completing the procedure in Adding the Global Manager as a
topology source.


Including the --norestore option in the startup command line will start Business Impact Manager
without restoring any saved objects from its repository file. (Business Impact Manager repository files
are located in the BASEDIR/smarts/local/repos/icf directory.) This mode of startup is necessary to
delete from the repository the topology elements associated with the Global Manager source that is
targeted for source removal.


Because the Business Impact Manager startup command created during the
Service Assurance Manager installation does not contain the --norestore option, you will need to
either temporarily modify the Business Impact Manager startup command (substitute --ignore-
restore-errors with --norestore) or create a new service startup command or a new native startup
command that contains the --norestore option.


Example procedure for specifying a different Global Manager
source
What follows is an example procedure of specifying a different Global Manager source; that is, an
example procedure for removing the current Global Manager source and adding a new Global Manager
source. A native startup command containing the --norestore option is included in the procedure.


To specify a different Global Manager source:


1 In the installation area from which Business Impact Manager is invoked, go to the
BASEDIR/smarts/bin directory and type the following command to stop Business Impact Manager:


               sm_service stop --force ic-mbim-server


            


Press Enter.


2 On a UNIX system:


sm_server --name=INCHARGE-MBIM --config=bim --subscribe=default


--norestore --output --daemon


Note   On a UNIX system, including the --daemon option in the command line starts the VMware
Smart Assurance process running in the background, leaving the original UNIX shell free to receive
more commands.


3 Consult Adding the Global Manager as a topology source and add the new Global Manager source.


Enabling maintenance tracking
You can track the maintenance of specific managed elements by enabling the maintenance tracking
option. To enable maintenance tracking:


1 Log in to the console.
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2 In the Topology Browser Console, select Service Assurance Manager (SAM) from the Manager list
box.


3 Right-click the SAM manager.


A submenu appears.


4 Select Enable Maintenance.


Disabling maintenance tracking
To disable maintenance tracking:


1 Log in to the console.


2 In the Topology Browser Console, select Service Assurance Manager (SAM) from the Manager list
box.


3 Right-click the SAM manager.


A submenu appears.


4 Click Disable Maintenance.
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Creating Business Elements
with the Topology Builder 6
This chapter includes the following topics:


n Topology Builder overview


n Business elements


n Relationships


n Accessing the Topology Builder Console


n Opening the Topology Builder Console


n Understanding the layout of the Topology Builder Console


n Modifying topology


n Adding business elements to your topology


n Adding relationships to your topology


n Deleting business elements and relationships


n Synchronizing topology


Topology Builder overview
The Topology Builder is a tool used to create and add business elements to the business-related topology
loaded into the Global Manager’s repository from the Business Impact Manager’s import datafiles.
Typically, you use the import datafiles to create most of the business elements, and use the Topology
Builder to create smaller collections of business elements.


You use the Topology Builder to create business elements, to create relationships (links) between
business elements, and to create relationships between business elements and infrastructure,
application, or hierarchical group elements. The analysis performed by a Manager such as
Business Impact Manager depends on the relationships between topology elements.


Business elements
You use the Topology Builder to create and add instances of the ICIM business classes and their
subclasses identified in Business classes added to the Global Manager topology using the Topology
Builder to the Global Manager’s topology. These classes and subclasses compose the business data
model shown in Business elements.
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Table 6‑1.  Business classes added to the Global Manager topology using the Topology
Builder


Business class Subclasses Description


ServiceOffering Represents a business service delivered to a set of subscribers
(consumers).


BusinessProcess Represents the functions and operations that support the internal
business activities or other processes of a business enterprise.


ServiceSubscriber Represents a subscriber (consumer) of one or more
ServiceOfferings.


Customer Represents one or more business enterprises or individuals that
maintain a business relationship with an Organization or one of its
BusinessUnit elements.


Organization Represents a hierarchically structured business enterprise
consisting of one or more business units that engage in one or more
lines of business (LOBs).


BusinessUnit Within an Organization, represents a semi-autonomous division that
engages in one or more LOBs.


LOB Within a BusinessUnit, represents a division that focuses on specific
product markets.


Department Within a BusinessUnit or LOB, represents a group that engages in
business functions that support the BusinessUnit or LOB.


Relationships
ICIM-defined relationships enable Business Impact Manager to associate business elements with each
other, and with underlying infrastructure, application, or hierarchical group elements. The relationships
also identify the dependencies of elements on other elements, and identify groupings.


In most cases, a relationship has an inverse relationship. For example, the relationship PartOf is the
inverse relationship of ComposedOf. A relationship pair, such as ComposedOf/PartOf, is referred to as a
relationship set.


You use the Topology Builder to create the following relationships between elements (nodes) in Business
Services map displays:


n Subscriptions/Subscribers relationship set


n (corresponds to subscriptions/subscribers relationship keywords in import datafiles):


The Subscriptions relationship associates a ServiceSubscriber or ServiceSubscriber subclass to one
or more ServiceOfferings or BusinessProcesses that are being provided to the ServiceSubscriber or
ServiceSubscriber subclass.


The Subscribers relationship associates a ServiceOffering or BusinessProcess to one or more
ServiceSubscribers or ServiceSubscriber subclasses who subscribe to the ServiceOffering or
BusinessProcess.


n ConsistsOf/MemberOf relationship set
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n (corresponds to members relationship keyword in import datafiles):


The ConsistsOf relationship associates a ServiceOffering or BusinessProcess to one or more
underlying infrastructure, application, or hierarchical group elements that are directly relied upon by
the ServiceOffering or BusinessProcess. The list of underlying elements might be a list of network
elements (hosts, routers, and so on), a list of applications, or a HierarchicalGroup.


The MemberOf relationship associates an underlying infrastructure, application, or hierarchical group
element to one or more ServiceOfferings or BusinessProcesses that directly rely upon the
infrastructure, application, or hierarchical group element.


The ConsistsOf/MemberOf relationship set can also associate a ServiceOffering to another
ServiceOffering, or to a BusinessProcess, and can associate a BusinessProcess to another
BusinessProcess, or to a ServiceOffering.


n ServedBy/Serves relationship set


n (corresponds to servedby/serves relationship keywords in import datafiles):


The ServedBy relationship set associates a BusinessProcess to one or more other
BusinessProcesses that serve the BusinessProcess.


The Serves relationship associates a BusinessProcess to one or more other BusinessProcesses that
are served by the BusinessProcess.


n ComposedOf/PartOf relationship set


n (corresponds to composedof/partof relationship keywords in import datafiles):


The ComposedOf relationship associates a ServiceSubscriber or ServiceSubscriber subclass to one
or more other ServiceSubscribers or ServiceSubscriber subclasses that it contains.


The PartOf relationship associates a ServiceSubscriber or ServiceSubscriber subclass to one or
more other ServiceSubscribers or ServiceSubscriber subclasses in which it is contained.


Because the arrowed lines in a Business Services map point from a business element to the element
that it depends on, only the Subscriptions, ConsistsOf, ServedBy, and ComposedOf relationships
appear in a Business Services map. Their inverse relationships are implied but not shown.


Accessing the Topology Builder Console
Accessing the Topology Builder Console and the Business Services map requires attaching the
Global Console to the Global Manager (for example, INCHARGE-SA) in your deployment. The
VMware Smart Assurance Service Assurance Manager Operator Guide provides information about
starting the Global Console, logging in, and attaching to a Manager.


Attaching the Global Console to the Global Manager provides additional information.


You need a user account with administrative privileges to access the Domain Manager Administration
Console. The default administrative account is username admin and password changeme.
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The VMware Smart Assurance System Administration Guide provides information about changing the
password for the default administrative account (recommended) and configuring access privileges. The
VMware Smart Assurance Service Assurance Manager Configuration Guide provides information on
configuring permissions to perform specific console operations.


Opening the Topology Builder Console
To open the Topology Builder Console:


1 Attach the Global Console to the Global Manager in your deployment.


A Notification Log Console opens.


2 In the console, select Configure > Topology Builder to open the T opology Builder Console.


Understanding the layout of the Topology Builder
Console
Figure 31 on page 108 shows an example Topology Builder Console display. In the display, the Topology
Builder Console is attached to a named INCHARGE-SA.


Figure 6‑1.  Topology Builder Console—example


Topology tree and topology graphical display
The Topology Builder Console is divided into two panels: a topology tree panel (left panel) and a topology
graphical display panel (right panel). The topology tree panel contains a Topology tab and a Groups tab.
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The topology tree of the Topology tab shows the business-related topology of the attached
Global Manager. The topology tree of the Groups tab shows the hierarchical group business-related
topology of the attached Global Manager. Clicking the plus sign next to a topology element class shows
the topology elements associated with the class. Clicking a topology element launches a graphical
topology representation—a Business Services map—in the right panel of the console.


To display a list of nodes (graphical representations of elements) and edges (graphical representations of
relationships and connections) that may appear in a graphical topology representation, select
Map > Map Legend in the Topology Builder Console.


Toolbar buttons
Toolbar buttons for editing business-related topology describes the toolbar buttons used to create
business elements and relationships.


Table 6‑2.  Toolbar buttons for editing business-related topology


Button Description


Create Node creates a new business element in a Business Services map and adds the element to
the existing topology.


Remove deletes the selected business element or relationship from a Business Services map. You
can only remove elements and relationships that were created with the Topology Builder Console.


Link Node creates a relationship between two selected elements in a Business Services map.


Synchronize Topology forces the attached Global Manager to export topology updates to all listening
Managers, including Business Impact Manager.


An unavailable (dimmed) toolbar button indicates that the associated function is not available, or that you
do not have sufficient permission to perform the action.


Modifying topology
You use the Topology Builder to add new business elements and relationships to your topology and to
delete business elements and relationships created with the Topology Builder. Your topology
modifications are automatically saved as you make them, and are stored in the Global Manager’s
repository.
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You cannot use Topology Builder to add or modify elements and relationships that are discovered by the
underlying Domain Manager topology sources or defined in the Business Impact Manager import
datafiles. For example, you cannot create a new element for the Host class.


Clicking the Synchronize Topology toolbar button exports your topology changes to the listening
Business Impact Manager. Invoke Synchronize Topology after you have completed your changes.


Adding business elements to your topology
You can create and add business elements to your topology using one of several methods:


n Add elements using the “Create Node” toolbar button


n Add elements using the Create Instance menu option


n Add elements using the “Create Instance” pop-up menu option


n Add elements using the “Create” pop-up menu


n Add elements using the “Add to map” pop-up menu


The new elements will be visible as element names in the topology tree and as nodes in a graphical
topology representation—a Business Services map. If the ICIM class of a new element is not already
listed in the topology tree, the class will automatically be added to the topology tree.


When creating new elements, follow the naming conventions in Understanding names and display
names to name them. You use the DisplayName format when naming a new element.


After creating and adding the new elements to your topology, follow the procedure in Adding
relationships to your topology to create relationships for them.


Add elements using the “Create Node” toolbar button
This method is available only when a Business Services map is displayed in the Topology Browser
Console. This method adds a new business element to both the Business Services map and the topology
tree.


To add a business element using the Create Node toolbar button:


1 Click an element in the topology tree to open a Business Services map in which you want to add the
new element. The clicked element becomes the focal element (object) of the map display and is
surrounded by a box.


2 Click the Create Node toolbar button to display the Create Map Node dialog box.


3 In the dialog box, select an element class (BusinessProcess, BusinessUnit, Customer, Department,
LOB, Organization, ServiceOffering, or ServiceSubscriber) from the Select class list box.


4 Type the name of the new element.


5 Click Apply to add the new element to the topology, and continue to create additional elements. Or,
click OK to add the new element and close the Create Map Node dialog box.
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Add elements using the Create Instance menu option
This method is available whether or not a Business Services map is displayed in the Topology Browser
Console. This method adds a new business element to the topology tree.


To add a business element using the Create Instance menu option:


1 In the menu bar, select Edit > C reate Instance to launch the Create instance in domain dialog box.


2 In the dialog box, select an element class (BusinessProcess, BusinessUnit, Customer, Department,
LOB, Organization, ServiceOffering, or ServiceSubscriber) from the Select class list box.


3 Type the name of the new element.


4 Click Apply to add the new element to the topology, and continue to create additional elements. Or,
click OK to add the new element and close the Create instance in domain dialog box.


Add elements using the “Create Instance” pop-up menu option
This method is identical to the method described in the previous section, Add elements using the Create
Instance menu option.


To initiate this method:


In the topology tree, right-click the name of the Global Manager (for example, INCHARGE-SA) and select
Create Instance from the pop-up menu. The Create instance in domain dialog box appears.


Add elements using the “Create” pop-up menu
This method is available whether or not a Business Services map is displayed in the Topology Browser
Console. This method adds a new business element to the topology tree.
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To add a business element using the Create pop-up menu option:


1 In the topology tree, right-click the element class (BusinessProcess, BusinessUnit, Customer,
Department, LOB, Organization, ServiceOffering, or ServiceSubscriber) for which you want to add an
element and select Create from the pop-up menu. The Create Instance dialog box appears.


2 In the dialog box, type the name of the new element.


3 Click Apply to add the new element to the topology, and continue to create additional elements. Or,
click OK to add the new element and close the Create Instance dialog box.


Add elements using the “Add to map” pop-up menu
This method is available only when a Business Services map is displayed in the Topology Browser
Console. This method adds any element in the topology tree—including a non-business element—to the
currently displayed Business Services map.


To add any element in the topology tree to the currently displayed Business Services map:


1 Click an element in the topology tree to open a Business Services map in which you want to add an
instance of an existing element.


2 In the topology tree, right-click the element (any business or non-business element) that you want to
add and select Add to map from the pop-up menu. The element appears as a node in the Business
Services map.


Adding relationships to your topology
After you add new business elements to your topology, you need to add ICIM-defined relationships to link
them to related topology elements. You add relationships between the new business elements, and
between the new business elements and existing business, infrastructure, application, or hierarchical
group elements. The analysis performed by a Manager such as Business Impact Manager depends on
the relationships between topology elements.


When an underlying infrastructure or application element has a problem, the problem may propagate to a
manually added business element through a manually added relationship, or may propagate to an
existing business element through a manually added relationship. The additional symptoms resulting from
these propagations help Business Impact Manager better calculate the impact of underlying problems on
business elements.
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To establish a relationship between two elements:


1 Click an element in the topology tree to open a Business Services map in which you want to add the
relationship.


2 Press Ctrl and select the source element and then the related element between which you want to
create the relationship. The source element refers to the first element selected, and the related
element refers to the second element selected.


3 Click the Link Node toolbar button. What happens at this point depends on the source element and
the related element:


n For a source ServiceSubscriber or ServiceSubscriber subclass element and a related
ServiceOffering or BusinessProcess element, the Topology Browser automatically adds a
Subscriptions relationship from the source element to the related element. For example:


n (Inverse of previous bulleted item) For a source ServiceOffering or BusinessProcess subclass
element and a related ServiceSubscriber or ServiceSubscriber subclass element, the
Topology Browser automatically adds a Subscriptions relationship from the related element to
the source element. For example:


n For a source ServiceOffering or BusinessProcess element and a related infrastructure,
application, or hierarchical group element, the Topology Browser automatically adds a
ConsistsOf relationship from the source element to the related element. For example:


n (Inverse of previous bulleted item) For a source infrastructure, application, or hierarchical
group element and a related ServiceOffering or BusinessProcess element, the Topology
Browser automatically adds a ConsistsOf relationship from the related element to the source
element. For example:


n For a source (“From”) ServiceOffering element and a related (“To”) BusinessProcess element,
a Link Selected Map Nodes dialog box similar to this one appears:


n (Inverse of previous bulleted item) For a source (“From”) BusinessProcess element and a
related (“To”) ServiceOffering element, a Link Selected Map Nodes dialog box similar to this
one appears:


n For a source (“From”) BusinessProcess element and a related (“To”) BusinessProcess
element, a Link Selected Map Nodes dialog box similar to this one appears:


n For a source (“From”) ServiceSubscriber or ServiceSubscriber subclass element and a
related (“To”) ServiceSubscriber or ServiceSubscriber subclass element, a Link Selected
Map Nodes dialog box similar to this one appears:


4 If a Link Selected Map Nodes dialog box appears, select a relationship from the list. (Typically, you
create only one relationship—or more precisely, only one relationship set—between a source element
and a related element.) Click OK to add the relationship and to close the Link Selected Map Nodes
dialog box.


Because the arrowed lines in a Business Services map point from a business element to the element
that it depends on, the Topology Browser creates only Subscriptions, ConsistsOf, ServedBy, or
ComposedOf relationships.
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If you select Subscribers, MemberOf, Serves, or PartOf in a Link Selected Map Nodes dialog box,
the Topology Browser will create a Subscriptions, ConsistsOf, ServedBy, or ComposedOf relationship
from the related (“To”) element to the source (“From”) element.
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Deleting business elements and relationships
You use the Remove toolbar button to delete one or more selected business elements or relationships
from the Global Manager’s topology. You can delete elements and relationships created with the Topology
Builder, but you cannot delete elements and relationships that are discovered by the underlying
Domain Manager topology sources or defined in the Business Impact Manager import datafiles.


To remove a new business element or relationship:


1 Click an element in the topology tree to open a Business Services map in which you want to delete
the new element or relationship.


2 In the map, select the element or relationship that you want to remove. (To select multiple elements or
relationships, press Ctrl while making your selections.)


3 Click the Remove toolbar button to remove the element or relationship from the topology.


Synchronizing topology
After you have completed your changes, click the Synchronize Topology toolbar button to export your
topology changes to the listening Business Impact Manager, at which time the updates become available
to Business Impact Manager for analysis. The updates do not affect analysis locally (at the attached
Global Manager, itself) or remotely (at the listening Business Impact Manager) until the topology is
synchronized.


If you do not invoke Synchronize Topology and you exit the Topology Builder, the attached
Global Manager does not export the updates to Business Impact Manager.
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Root Cause and Impact Analysis
of Metro Ethernet Failures on
CE-VLANs 7
This section describes how the IP Manager, MPLS Manager, Global Manager, and
Business Impact Managerwork together to determine how Metro Ethernet failures impact customer
VLANs (CE-VLANs). Flow of information to determine how Metro Ethernet failures Impact CE-
VLANsshows the flow of information between the Managers to accomplish this end.


n Figure 7‑1.  Flow of information to determine how Metro Ethernet failures Impact CE-
VLANs
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As implied in the figure, Business Impact Managercalculates the impact of EVC events on CE-VLAN
ServiceOffering objects, and creates CE-VLAN impact notifications. The CE-VLAN impact
notifications enable users to immediately identify disruptions and failures to CE-VLANs due to EVC
events, and to prioritize the resolution of the network and MPLS problems in accordance with their
business impact.


This chapter includes the following topics:


n CE-VLAN ServiceOffering object creation


n CE-VLAN impact notifications


n EVC topology maps


n Disabling CE-VLAN impact analysis


CE-VLAN ServiceOffering object creation
When the Global Manager imports topology from the MPLS Topology Server, and that topology contains
EVCs, the Global Manager runs a script that reads the EVC IDs of the EVCs. The script then proceeds as
follows:


n Contacts the underlying IP Availability Manager and retrieves the CE-VLAN IDs from the
EVCEndPoints that match the EVC IDs.


n Creates a CE-VLAN ServiceOffering object for each retrieved CE-VLAN ID and assigns a name to
the ServiceOffering object (SO-CEVLAN<CE-VLAN ID>).


n For each CE-VLAN ServiceOffering object, creates a LayeredOver relationship from the
ServiceOffering object to the associated EVC object.


Business Impact Manager imports the CE-VLAN ServiceOffering objects from the Global Manager
and subscribes to EVCEndPoint Down and EVC Impacted notifications.


CE-VLAN impact notifications
Through a Global Console attached to the Global Manager, a user can view the CE-VLAN impact
notifications that are created by Business Impact Manager as tabular entries in a Notification Log Console
view. In addition, a user can view the CE-VLAN impact notifications as blue severity bar icons underneath
CE-VLAN ServiceOffering nodes in a Map Console view: A blue severity bar icon will appear underneath
any CE-VLAN ServiceOffering node that has an active EVC::Impacted notification.


EVC topology maps
The Global Manager supports Business Services topology maps. And like most types of topology maps,
the display of Business Services maps is disabled by default.
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Enabling display of Business Services maps
To enable the display of Business Services maps and to associate this functionality to user profiles:


1 Attach the Global Console to the Global Manager (for example, INCHARGE-SA) in your deployment.


By default, a Notification Log Console opens.


2 In the Notification Log Console, select Configure > Global Manager Administration Console to
open the Global Manager Administration Console.


3 In the left panel of the Global Manager Administration Console, expand the configuration tree to
display the User Profiles.


4 Select a user profile (for example, admin-profile) to display its configuration window.


5 In the configuration window, locate Console Operations and click its Modify List button to launch
the Console Operations dialog box.


6 In the Console Operations dialog box, expand the Map option and click the Business Service
checkbox.


7 Click OK to close the Console Operations dialog box.


8 In the configuration window, click Apply to save your configuration changes.


9 Repeat Steps 4 through 8 to enable the display of Business Services maps for any other user profiles
that need to see these maps.


10 Detach and reattach the Global Console to the Global Manager in order to view the Business
Services maps. Start by selecting Manager > Detach.


Launching Business Services maps
Business Services maps can be launched for CE-VLAN notifications or objects. A user can launch a
Business Services map for a CE-VLAN by using any of the following methods:


n In a Notification Log Console, click a CE-VLAN notification and select Event > Show Map, or right-
click the notification and select Show Map in the pop-up menu.


n In a Topology Browser Console, right-click a CE-VLAN object and select Show Map in the pop-up
menu.


n In the topology tree of the Map Console, click a CE-VLAN object to display a Business Services map
for the object, or right-click a CE-VLAN object and select Business Services in the pop-up menu.


n In an opened topology map, right-click a CE-VLAN node and select Business Services in the pop-up
menu.


Business Services map launched for a CE-VLAN ServiceOffering object is an example of a Business
Services map that is launched for a CE-VLAN object.


a
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Figure 7‑2.  Business Services map launched for a CE-VLAN ServiceOffering object


A Business Services map shows dependent relationships through arrowed lines: The arrowed lines
point from a business object to the object that the business object depends on. Impact notifications
propagate in the direction opposite to the arrowed lines: The impact notifications propagate to a
business object from the object that the business object depends on.


In Figure 33, when EVC object EVC-EVPL_EVC_1 is impacted, the degradation causes
Business Impact Manager to generate an impact notification for CE-VLAN service objects SO-
CEVLAN100 and SO-CEVLAN1-4094.


Disabling CE-VLAN impact analysis
By default, CE-VLAN impact analysis is enabled. You can edit the bim.conf file and disable the analysis.
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To disable CE-VLAN impact analysis:


1 Go to the BASEDIR/smarts/bin directory in the Business Impact Manager installation area and type
the following command to open the bim.conf file:


               sm_edit conf/bim/bim.conf


            


2 Find the following line:


CEVLANImpactEventEnable = TRUE


3 Change TRUE to FALSE.


4 Save and close the file.


The modified version of the bim.conf file is saved to the BASEDIR/smarts/local/conf/bim directory.


5 If Business Impact Manager was running before you edited the bim.conf file, restart
Business Impact Manager.
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Operating system requirements 2
Service Assurance Manager, IP Manager, MPLS Manager, Server Manager, and Network Protocol
Manager are supported on operating systems:


Operating system Supported version Notes


Red Hat Enterprise Linux


(Native/Virtual*)


n Red Hat Enterprise Linux 6.8, 6.9 and 6.10–
64 bit


n Red Hat Enterprise Linux 7.4, 7.5 and 7.6– 64
bit


Veritas cluster is not supported on Linux
platforms.


CentOS Linux


(Native/Virtual*)


n CentOS 6.8, 6.9 and 6.10– 64 bit
n CentOS 7.4, 7.5 and 7.6– 64 bit


Veritas cluster is not supported on Linux
platforms.
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Oracle Linux


(Native/Virtual*)


n Oracle Linux 7.4, 7.5, and 7.6– 64 bit


Docker n 17.05.0 - CE Supported OS version for Docker:
n Red Hat Enterprise Linux 7.4, 7.5, and 7.6–


64 bit or higher
n CentOS 7.4, 7.5, and 7.6– 64 bit or higher


Note   
n VMware Smart Assurance (VSA) 10.0 is supported on RHEL 6 and RHEL 7. VMware has tested and


validated VSA 10.0 with RHEL version 6.8, 6.9 and 6.10 as well as with RHEL version 7.4, 7.5 and
7.6. Hence, VMware recommends the customer to use VSA 10.0 with the validated versions of RHEL
6 or RHEL 7. However, if the customer chooses to use a later minor version of RHEL 6/7 than version
6.9/7.4 and in the event of an unexpected defect or deprecated feature introduced in that later release
of the RHEL 6/7 operating system, VMware will do its best to either provide a patch on VSA 10.0 or
recommend customer to upgrade to a future release of VMware Smart Assurance as deemed
necessary.


n * = Support for virtualized deployments may vary per hypervisor due to the nature of integration
between OS and hypervisor.


n VMWare: best practices are offered on VMWare hypervisors for the above operating systems


n All other hypervisors:  Smart Assurance may be deployed on other hypervisors but VMware does
not support performance and interoperability issues between the OS layer and hypervisor.  We do not
have best practices for deploying on non-VMware hypervisors. Check with hypervisor vendor to
address issues not reproducible on physical or VMWare deployed environments.


n Java SE runtime environment (JRE) 1.8 update 181 is used for 10.0 products on all supported
platforms.


SAM, IP, ESM, MPLS, and NPM Managers Support Matrix
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Operating system minimum
required patches 3
Operating system minimum patch versions that are required for the IP Manager, Service Assurance
Manager, MPLS Manager, Server Manager, and Network Protocol Manager. If the installation program
does not detect the minimum required patch versions, it will not proceed with the installation.
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Operating system Minimum required patch versions


Red Hat Enterprise Linux 6.8,
6.9, and 6.10


CentOS 6.8, 6.9, and 6.10


n glibc-2.2.4-32.i686
n glibc-2.2.4-32.x86_64
n glibc-common-2.2.4-32
n compat-libstdc++-33-3.2.3-47.x86_64
n compat-libstdc++-33-3.2.3-47.3.i686
n redhat-lsb library


Additionally, for Service Assurance Manager Console,


On Red Hat Enterprise Linux 6.x / CentOS 6.x:
n libstdc++-4.4.6-3.e16.i686
n libXi-1.3-3.e16.i686
n libXext-1.1-3.e16.i686
n libXtst-1.0.99.2-3.e16.i686
n libXrender-0.9.5-1.e16.i686
n compat-libstdc++-296-2.96-144.e16.i686


Note   When installing on a 64-bit Linux platform, both 64-bit and 32-bit libraries are required.


Red Hat Enterprise Linux 6.8,
6.9, and 6.10


CentOS 7.4, 7.5, and 7.6


n glibc-2.2.4-32.i686
n glibc-2.2.4-32.x86_64
n glibc-common-2.2.4-32
n compat-libstdc++-33-3.2.3-47.x86_64
n compat-libstdc++-33-3.2.3-47.3.i686
n redhat-lsb-4.1-24.e17.x86_64


Additionally, for Service Assurance Manager Console,


On Red Hat Enterprise Linux 7 / CentOS 7:
n libstdc++-4.4.6-3.e16.i686
n libXi-1.3-3.e16.i686
n libXext-1.1-3.e16.i686
n libXtst-1.0.99.2-3.e16.i686
n libXrender-0.9.5-1.e16.i686


Note   When installing on a 64-bit Linux platform, both 64-bit and 32-bit libraries are required.


SAM, IP, ESM, MPLS, and NPM Managers Support Matrix
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Browser requirements for Web
Console and Business
Dashboard 4
The Smarts Global Console can also be deployed as either:


n Smarts Web Console


Or


n Smarts Business Dashboard


Note   Tomcat Servlet Engine version 8.5.27 is installed as part of the Web Console/ Business
Dashboard. The Tomcat Servlet Engine serves the files used by the web applications.


Users who display Business Dashboard viewlets in a web browser, or want to use the Web Console,
require the following software:


Browser Version Notes


Google Chrome 68 or later Refer to the release notes for the steps/workaround provided for launching in Google Chrome
version till 44 and 45 or later


Internet Explorer 10.0 and 11.0 The browser must have JavaScript enabled.


Mozilla Firefox 48 or later


Safari 12 or later


JRE 1.8 update 181 web browser plug-in must be installed on the client workstation. If the JRE is not
installed on the client workstation, then you will be prompted to install it when you launch the Web
Console or Business Dashboard.


Note   In SAM 10.0, Red Hat Enterprise Linux 6 and 7, CentOS 6, and 7 uses JRE 1.8 update 181.


Java Web Start requirements for Web Console
Java Web Start is optional and can be invoked when the Web Console is run.


Java Web Start must be installed and configured on the client machine:


n For Linux, contact your system administrator to install and configure Java Web Start


The VMware Smart Service Assurance Manager Dashboard Configuration Guide provides information
about using the Web Console.
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Interoperability 5
VMware Smart Assurance Suite 10.0 products interoperate with the following products as mentioned in
the below table:


Upgrade


n In place upgrades from 9.4.x, 9.5.x, and 9.6 to 10.0 is supported for Smarts.


n Migration from 9.4.x, 9.5.x and 9.6 to 10.0 is supported for Smarts.
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Hardware requirements 6
Minimum hardware requirements for CPUs, memory, and data disk space for the products. If you install
more than one product on a system, the system must meet the total memory and disk space
requirements for those products. CPU refers to the number of physical CPU cores and not the number of
CPUs that are displayed when hyperthreading is activated.


Note   When VMware Smart Assurance 10.0 is deployed in a bare metal (non-VMware) environment, do
not use hyperthreading. When hyperthreading is enabled, the Smart Assurance software runs more
slowly and performance is adversely affected.


This chapter includes the following topics:
n Smart Assurance Manager requirements


n IP Manager requirements


n VMware Smart Assurance Server Manager requirements


n MPLS/NPM Manager requirements


n DCF requirements


n K4M requirements


n Smart Assurance UI requirements


n Kafka requirements


Smart Assurance Manager requirements
System requirements for Smart Assurance Manager.


VMware, Inc.  11







Hardware for several platform equipment tiers
Operating system CPUs Memory (RAM) Disk space


Red Hat Enterprise
Linux


4 8 GB


Note   The memory and CPU requirements will change based on the size of the
topology.


40 GB


CentOS 40 GB


Note   Refer to VMware Smart Assurance SAM Version 10.0 Performance Benchmarking and Sizing
Guidelines document for planning SAM deployment.


Disk space requirements for Service Assurance Manager Console
Operating system CPUs Memory (RAM) Disk space


Red Hat Enterprise Linux 1 2 GB 8 GB


CentOS 8 GB


CPU, memory, data disk space requirements
Minimum requirements for CPUs, memory, and data disk space that is used by the software for writable
files such as logs, repository files, and output files.


Smarts product CPUs Memory (RAM) Disk space


Service Assurance Manager
Adapter Platform


1 512 MB 2 GB each


Syslog Adapter 1 512 MB 2 GB each


SNMP Trap Adapter 1 512 MB 2 GB each


XML Adapter 1 512 MB Depends on the size of the output file being exported; upto 200 MB.


For example, the XML Adapter communicates with 5 Service
Assurance Global Managers and each output file is 200 MB, then 1
gigabyte (GB) is required.


IP Manager requirements
Operating system CPUs Memory (RAM) Disk space


Red Hat Enterprise
Linux


4 8 GB


Note   The memory and CPU requirements will change based on the size of the
topology.


40 GB


CentOS 40 GB


Note   Refer to VMware Smart Assurance IP Version 10.0 Performance Benchmarking and Sizing
Guidelines document for planning IP deployment.


SAM, IP, ESM, MPLS, and NPM Managers Support Matrix
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VMware Smart Assurance Server Manager requirements
Operating system CPUs Memory (RAM) Disk space


Red Hat Enterprise
Linux


4 8 GB


Note   The memory and CPU requirements will change based on the size of the
topology.


40 GB


CentOS 40 GB


Note   Refer to VMware Smart Assurance Server Manager Version 10.0 Performance Benchmarking and
Sizing Guidelines document for planning Server Manager deployment.


Server Manager supported managed devices and software
Feature Devices and Software


VMware management n VMware vSphere 4.x
n VMware vSphere 5
n VMware vSphere 5.5
n VMware vSphere 6.0
n VMware vSphere 6.5
n VMware ESX Cluster


Note   Ensure that the VM tools are installed on each managed VMware virtual machine, as
described in VMware documentation.


Microsoft cluster management n Windows Server 2016
n Xeon (Microsoft cluster feature only)


Process monitoring Any machine that is running an SNMP agent (native or otherwise) that supports HOST-
RESOURCE-MIB.


Hardware and operating
system monitoring


Devices that support the following systems on Windows 2008 and Linux:
n Dell OpenManager
n IBM Director
n HP Systems Insight Manager


Devices that support the following system on Windows:
n WMI


Devices that support the following system on Linux:
n Sun Management Center


Load balancer F5 BIG-IP F5 BIG-IP load balancer devices and software:
n 6400
n 6800
n 8800
n 9.1.2
n 9.4.x
n 10.x
n 11.x
n 12.x


SAM, IP, ESM, MPLS, and NPM Managers Support Matrix
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Hyper V n As a child partition of Hyper-V in Windows 2008
n As a child partition of Hyper-V in RHEL AS 5


Citrix Xen Server n Citrix Xen Server 6.2


VMware NSX for vSphere n NSX 5.x
n NSX 6.0
n NSX 6.4.4


VMware NSX-T for vSphere NSX-T 2.3


VMware-OpenStack OpenStack-5.1.0.0


VeloCloud VeloCloud Orchestrator 3.1.0


OpenStack KVM n Kilo
n Liberty
n Mitaka
n Newton
n Note: Keystone versions v2 and v3 are supported.


ScaleIO n ScaleIO Version : 1.32, 2.0.0, 2.0.1
n ScaleIO Platfrom Version:
n Linux ( RHEL6/7, CentOS6/7, SUSE 12, Ubuntu14.04/16.04)
n vSphere 5.5 and 6.0 version
n PCS 1.0 version with ESX 6.0 version deployed. Brocade VDX Switch BR-VDX6740 used


part of deployment of PCS.


MPLS/NPM Manager requirements
Operating system CPUs Memory (RAM) Disk space


Red Hat Enterprise
Linux


2 4 GB


Note   The memory and CPU requirements will change based on the size of the
topology.


40 GB


CentOS 40 GB


DCF requirements
System requirements for Data Collector Framework.


Operating system CPUs Memory (RAM) Disk space


Red Hat Enterprise
Linux


4 8GB


Note   The memory and CPU requirements will change based on the size of
the topology.


40 GB


CentOS 40 GB


Note   Refer VMware Smart Assurance Server Manager Version 10.0 Performance Benchmarking and
Sizing Guidelines document for planning DCF deployment.


SAM, IP, ESM, MPLS, and NPM Managers Support Matrix
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K4M requirements
System requirements for K4M.


Operating system CPUs Memory (RAM) Disk space


Red Hat Enterprise
Linux


4 16 GB


Note   The memory and CPU requirements will change based on the size of the
topology.


600 GB


CentOS 600 GB


Note   Refer VMware Smart Assurance Server Manager Version 10.0 Performance Benchmarking and
Sizing Guidelines document for planning K4M deployment.


Smart Assurance UI requirements
System requirements for Smart Assurance UI.


Operating system CPUs Memory (RAM) Disk space


Red Hat Enterprise
Linux


4 16 GB


Note   The memory and CPU requirements will change based on the size of the
topology.


80 GB


CentOS 80 GB


Note   Refer VMware Smart Assurance Server Manager Version 10.0 Performance Benchmarking and
Sizing Guidelines document for planning Smart Assurance UI deployment.


Kafka requirements
System requirements for Kafka.


Operating system CPUs Memory (RAM) Disk space


Red Hat Enterprise
Linux


4 16 GB


Note   The memory and CPU requirements will change based on the size of the
topology.


120 GB


CentOS 120 GB


Note   Refer VMware Smart Assurance Server Manager Version 10.0 Performance Benchmarking and
Sizing Guidelines document for planning Kafka deployment.


SAM, IP, ESM, MPLS, and NPM Managers Support Matrix
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Overview 1
This chapter includes the following topics:
n Adapters and ASL


n Setting the locale


n Setting the locale


n String support


n Printing and logging


Adapters and ASL
Adapters facilitate the communication of information between devices or applications and a
Domain Manager. Adapters exist as either inflow adapters or outflow adapters.


n Inflow adapters collect information and send it to a Domain Manager. These adapters can be used to
initialize a Domain Manager with data such as topology information. They also can send, as they
occur, event information and topology changes to a Domain Manager.


n Outflow adapters subscribe to a Domain Manager for a set of notifications. These adapters then pass
the information to devices or other applications.


Adapter overview shows the flow of information through an inflow adapter, a Domain Manager, and
an outflow adapter.


a The inflow adapter collects information and passes it to the Domain Manager.


b The Domain Manager generates notifications.


c The outflow adapter subscribes to a set of notifications.


d The Domain Manager passes those notifications to the adapter.
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e The outflow adapter passes the information to another entity.


Figure 1‑1.  Adapter overview


Smart Assurance installation directory
In this document, the term BASEDIR represents the location where Smart Assurance software is
installed.


n For UNIX, this location is /opt/InCharge/<product>.


Optionally, you can specify the root of BASEDIR to be something other than:


n UNIX: /opt/InCharge


However, you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure.


Adapter components
All adapters, regardless of type, consist of three basic components: front end, rule set and back end.
These three components must be included as part of any adapter.


Front end
The front end collects information for processing in the rule set of the adapter.


n The front end of an inflow adapter collects information an external entity.


n The front end of an outflow adapter collects information from Domain Manager notifications.


Rule set
Rule sets match, filter, and process information received from the front end. The processed information is
handled by the back end.
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Back end
The back end passes information processed by the rule set to other programs or devices.


n The back end of an inflow adapter passes information to a Domain Manager.


n The back end of an outflow adapter passes information from a Domain Manager to another device or
location.


For example, in Adapter components, if an adapter is designed to move SNMP data to a
Domain Manager, its front end communicates with an SNMP device and its back end passes data to
a Domain Manager.


Figure 1‑2.  Adapter components


Adapter Scripting Language
The VMware Smart Assurance Adapter Scripting Language (ASL) is used to construct the rule sets of
adapters. These rule sets are responsible for matching incoming data with patterns and processing the
matched data. ASL provides an easy-to-use method of moving data into or out of a Domain Manager.


Introduction to running adapters
The sm_adapter command starts ASL scripts. The file sm_adapter is found in BASEDIR/smarts/bin.
Adapters can receive information from files and send output to a file or to the screen. To run most of the
sample scripts found in this guide, use this syntax:


sm_adapter --file=<input_file>


         <ASL_script_file>


      


The command starts an adapter that runs a user-supplied script <ASL_script_file>, reading data from the
file, <input_file>.


Chapter 7 Running Adapters provides additional information about the sm_adapter command.
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Setting the locale
A locale is the RFC-1766/3066 compliant specification for language and country.


The scope of execution of an ASL script is within the context of a Domain Manager. Once connected, the
locale can be changed by using the setLocale()function. The syntax is:


         <var> = setLocale(<locale>)


The return value is a string representation of the previous setting of the locale, or a default value if
setLocale() has not yet been called.


The following example sets the locale to French as spoken in France.


old_locale = setLocale(”fr_FR”);


print(“The old locale was “.old_locale);


When setLocale() is called in ASL, the value of the locale is saved in thread-local storage. When an ASL
script connects to a Domain Manager, the same thread is used for the lifetime of the connection session.
Therefore, if you call setLocale(“fr_FR”) from an ASL script, then the locale is fr_FR for the duration of the
ASL script. When the script ends, the Domain Manager thread goes away. Other ASL scripts, and other
clients each have their own connection/session in their own thread, so each thread is independent of the
others.


Locale effects on message rendering
Currently, the scope of the setLocale() operation influences text sent from the Domain Manager to the
ASL script. Specifically, setLocale() affects textual data of these types:


n MODEL descriptions obtained from the following operations on SM_System:


n getOpDescription


n getEventDescription


n getPropDescription


n getClassDescription


n Error text obtained from the following operations on SM_API_Support:


n getErrorText


The scope of the setLocale() operation has no influence on any other textual data communicated
between the ASL script and the Domain Manager. Textual elements defined as part of modeled
applications (aside from entity description data) are not affected by this operation.


Default locale when setLocale() is not called
The default locale to set for an ASL script is determined as follows:


1 The value of the SM_LOCALE environment variable.
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2 If SM_LOCALE is not set equal to a value, then the default locale is set equal to en_US.


Setting the locale
A locale is the RFC-1766/3066 compliant specification for language and country.


The scope of execution of an ASL script is within the context of a Domain Manager. Once connected, the
locale can be changed by using the setLocale()function. The syntax is:


         <var> = setLocale(<locale>)


The return value is a string representation of the previous setting of the locale, or a default value if
setLocale() has not yet been called.


The following example sets the locale to French as spoken in France.


old_locale = setLocale(”fr_FR”);


print(“The old locale was “.old_locale);


When setLocale() is called in ASL, the value of the locale is saved in thread-local storage. When an ASL
script connects to a Domain Manager, the same thread is used for the lifetime of the connection session.
Therefore, if you call setLocale(“fr_FR”) from an ASL script, then the locale is fr_FR for the duration of the
ASL script. When the script ends, the Domain Manager thread goes away. Other ASL scripts, and other
clients each have their own connection/session in their own thread, so each thread is independent of the
others.


Locale effects on message rendering
Currently, the scope of the setLocale() operation influences text sent from the Domain Manager to the
ASL script. Specifically, setLocale() affects textual data of these types:


n MODEL descriptions obtained from the following operations on SM_System:


n getOpDescription


n getEventDescription


n getPropDescription


n getClassDescription


n Error text obtained from the following operations on SM_API_Support:


n getErrorText


The scope of the setLocale() operation has no influence on any other textual data communicated
between the ASL script and the Domain Manager. Textual elements defined as part of modeled
applications (aside from entity description data) are not affected by this operation.
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Default locale when setLocale() is not called
The default locale to set for an ASL script is determined as follows:


1 The value of the SM_LOCALE environment variable.


2 If SM_LOCALE is not set equal to a value, then the default locale is set equal to en_US.


String support
The ASL interpreter assumes that ASL Script files are UTF-8 encoded. The interpreter will recognize a
valid UTF-8 BOM if it is present. The file may contain a valid UTF-8 BOM, but it is not required.


ASL is assumed to be working with UTF-8 strings all the time. The string type in ASL is assumed to be a
UTF-8 string.


You can print a string by performing the following:


n Extract the localized string.


n Apply substitutions to the string.


n Print the final rendered string.


Obtaining externalized strings
A built-in function for use by internal applications only (SDK and other VMware adopting applications)
may be used to retrieve an externalized string. The getExternalString() function extracts a string, based
on the table name, key, and locale that is passed to the function. The getExternalString() function then
renders the extracted string given a list of substitutions (up to six).


         <var> = getExternalString(<table>, <key>, <locale>)


The <table> and <key> arguments are required. The <locale> argument is optional. The default value is
the value of the SM_LOCALE environment variable. The return value is the UTF-8 encoded string that
contains the text of the message defined in the table.


The ASL script may then use the returned string as an argument in the print() built-in function, as shown
in the following example:


msg = getExternalString("SMS_MSG","SUCCESS","fr_FR");


print(msg);


Applying substitutions
Applying substitutions may be accomplished by using the formatString() built-in function. The
formatString() function takes up to seven arguments:


         <var> = formatString(<msg>[,<sub_1>][,<sub_2>][,<sub_3>][,<sub_4>][,<sub_5>][,<sub_6>])
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The <msg> argument is the string variable which was extracted from a message table. Up to six
substitution arguments may be specified.


The example below shows the use of the getExternalString() and formatString() built-in functions.


# message table entry:


#


message_table MY_TABLE


message_code  OPER_FAIL_MSG, 


              "Operation &1 failed.  Reason: &2"


---------------------------------------


// ASL fragment.   An attempt to perform some operation failed. 


// the variable 'operation' holds the name of the operation that


// failed, the variable 'reason' indicates the reason for the failure. 


// 


// extract the string using the default locale (SM_LOCALE)


//


 format = getExternalString("MY_TABLE","OPER_FAIL_MSG");


// 


// format the substitutions


// 


 output = formatString(format,operation,reason)


// 


// print the resulting string


// 


 print(output);


Printing and logging
Messages that are printed by using the ASL print() built-in function are printed to each of the active logs in
the Domain Manager process. There is no automatic translation of the message text. For example, if the
message was obtained by calling getExternalString() by using a French locale, the message will appear
both in the English log and the French log in French. The section print() function provides additional
information.


Retrieving and setting log, error and trace levels at runtime
There are three computed attributes available to get and set the log, error, and trace levels of a
Domain Manager at runtime. These computed attributes, described in Computed attributes to retrieve and
set log, error, and trace levels at runtime, are available on the SM_JIIM_Support object. The SM_System
object is a subclass of SM_JIIM_Support and also inherits these computed attributes.
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Table 1‑1.  Computed attributes to retrieve and set log, error, and trace levels at runtime


Computed Attributes Description


logLevel The minimum exception level for sending messages to the system error logger.The logLevel
attributeis a string, and can be any one of the values set for the --loglevel command line option:


errLevel The minimum exception level for writing messages to the log files. The errLevel attributeis a string,
and can be any one of the values set for the --errlevel command line option.


traceLevel Used to print a stack trace to the SDK log file when an exception at this level or above occurs.
Exceptions below this level do not write a stack trace. The traceLevel attributeis a string, and can
be any one of the values set for the --tracelevel command line option.


The values of these computed attributes can be retrieved and set, and valid values are:


n None


n Emergency


n Alert


n Critical


n Error


n Warning


n Notice


n Informational,


n Debug


Note   Fatal is a synonym for Critical.


Retrieving the current level
You can retrieve the current levels of SM_System::SM-System::logLevel, SM_System::SM-
System::errLevel, or SM_System::SM-System::traceLevel. A string is returned which represents the
current level, such as "Warning", "Error", or "Fatal". For example:


sm_system = object("SM_System", "SM-System");


curr_error_level = sm_system->errLevel;


Setting the level
To change the current levels, obtain a pointer to the object, and then set the value of SM_System::SM-
System::logLevel, SM_System::SM-System::errLevel, or SM_System::SM-System::traceLevel to the
appropriate level.


In this example, the trace level setting is changed to None.


sm_system = object("SM_System", "SM-System");


sm_system->traceLevel = "None";
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When you change the log, error or trace levels a message is printed in the log file. The log message will
appear similar to the following:


[April 8, 2009 5:03:41 PM EDT +122ms] t@1149000000 SM_ProtocolEngine-6


JM_MSG-*-JM_TRACE_LEVEL_CHANGED-User 'user1', using remote dmctl client (id 6), on host host1 with 


credentials tpadmin1 has changed the Trace level to None; in file 


"/mypath/repos/jiim/SM_JIIM_Support_Impl.c" at line 458
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Rule Sets 2
This chapter includes the following topics:


n Rule set construction


n Rule execution


Rule set construction
A rule set is a group of rules that may match, filter, and execute actions to process data received from an
adapter’s front end.


An ASL rule consists of blocks of patterns, filters, and actions. Patterns select the data to process by
applying a pattern matching to the incoming datastream. Filters control whether actions are performed on
matched data. Actions process the data.


An ASL rule has the basic form:


         <RULE-NAME> {


<pattern-list>


}


filter {


<filter-list>


}


do {


<action-list>


}


Rules begin with a rule name. A rule name must consist of alphanumeric characters and/or an
underscore (_). The first character of a rule cannot be a number.


Note   In this guide, by convention, no rule names contain lowercase letters.


Pattern, filter, and action blocks comprise the contents of a rule. None of the blocks are required.


Note   Certain ASL words are reserved and should not be used, as described in “Reserved words” on
page 149.
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Braces surround the pattern list and demarcate the pattern block. A pattern block can contain one or
more action blocks, but cannot contain any filter blocks. For actions performed before any pattern
matching, an action block can be included inside of the pattern block before any pattern matching
statements.


The word “filter” followed by a brace ( { ) marks the beginning of a filter block. Another brace ( } ) marks
the end. A rule can contain no more than one filter block, and that block must appear after the pattern
block.


The word “do” followed by a brace ( { ) marks the beginning of an action block. Another brace ( } ) marks
the end. A rule can contain multiple action blocks placed inside a pattern block or outside of a pattern
block. However, only one action block can appear outside of a pattern block.


In this example, the following rule associates a specific pattern with a specific action:


         <RULE-NAME> {


<pattern-list> do {<action-list>}


<pattern-list> do {<action-list>}


<pattern-list> do {<action-list>}


}


The pattern block shown in the example encompasses all of the patterns and all of the action blocks. In
order to add a filter block, the brace marking the end of the pattern block has to follow the last pattern list.
Filter information can be added before the last action block.


         <RULE-NAME> {


<pattern-list> do {<action-list>}


<pattern-list> do {<action-list>}


<pattern-list> 


}


filter {<filter-list>}


do {<action-list>}


Rules can be called from other rules or in an action block. Rules cannot be called from a filter.


         <RULE-NAME> {


<OTHER-RULE>


}


filter {


<filter-list>


}


do {


<action-list>


}
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Patterns and called rules can be interspersed with action blocks.


         <RULE-NAME> {


<pattern-list> 


do {<action-list>}


<OTHER-RULE>


}


Rules referenced by other rules are considered subordinate to the rule that references them. The rule that
references a subordinate rule is referred to as superior. The flow of control of ASL processing passes
from superior rules to subordinate rules and back.


Special rules
Three special rules exist: START, DEFAULT and EOF. Each of these rules must be in uppercase letters.


START rule
All rule sets must include a rule named START. The START rule marks the starting point of the ASL script
when the adapter receives input. However, the START rule does not have to be the first rule listed in the
script.


START {


<pattern-list>


}


filter {


<filter-list>


}


do {


<action-list>


}


DEFAULT rule
If the input fails to match any patterns specified by the START rule and the rules called by the START
rule, a rule named DEFAULT runs automatically. The purpose of the DEFAULT rule is to resynchronize
the input stream. The DEFAULT rule has the same structure as any other rule. However, if the pattern
matching of the DEFAULT rule fails, the ASL script aborts.


If the DEFAULT rule is not explicitly defined and the START rule fails, there is an implicit DEFAULT rule
that is executed. This implicit DEFAULT rule matches the current line of input.


If the implicit DEFAULT rule was added to an ASL script, it would look like this:


DEFAULT {


..eol


}


The string "..eol" is an ASL pattern that, from a starting point, matches all characters up to and including
an end-of-line. Chapter 4 Pattern Matching and Filters provides additional information about patterns.
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EOF rule
A rule named EOF runs at the end of an input file. The EOF rule can but should not include a pattern
matching block. At the end of a file, there is no data for a pattern to match. The EOF rule is not required in
an ASL script.


EOF 


do {


<action-list>


}


Rule execution
The first rule executed in an ASL script is the START rule. The START rule runs repeatedly until all of the
data input is processed. Data input is processed as it is matched with all of the patterns of a rule.


Patterns are components either of the START rule or of other rules called from the START rule. As data
matches patterns, the starting position for the next pattern match moves to the end of the matched data.
The next match is tested from this new position and so forth.


The new starting position for pattern matches is permanent when all of the patterns associated with the
START rule match. Patterns associated with the START rule include patterns from all of the rules
subordinate to START. If the START rule and all of its subordinate rules have executed, the START rule
executes again at the new starting position.


If patterns in subordinate rules fail to match, control passes to the immediately superior rule where an
alternate, if it exists, is tried. If an alternate does not exist, the starting point for the match is reset to the
point when the superior rule executed. Control is passed to the next superior rule and the next alternate is
tested. This continues until a match is made or until the START rule does not match.


The DEFAULT rule runs when the START rule fails. The DEFAULT rule contains its own pattern matching.
When the DEFAULT rule matches, the starting point is permanently advanced and the START rule is
executed. If the DEFAULT rule pattern match fails, the ASL script aborts.


The EOF rule runs when the data input is exhausted. It is not necessarily the last rule to execute because
other rules might be subordinate.
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Operators, and Expressions 3
This chapter includes the following topics:


n Data and comments


n Variables and their values


n Operators


Data and comments
This section describes the input datastream and the format of comments.


Data
The ASL input datastream consists of characters and markers. Characters include any character in the
extended ASCII character set. Markers demarcate the boundaries of fields and records.


Comments
There are two different formats for comments. A comment is text that begins with two slashes (//) and all
information to the right of the slashes is ignored.


// ASL Script to read card information


A comment can also be marked as a block by using a slash followed by an asterisk at the beginning (/*)
and an asterisk followed by a slash at the end (*/) of the comment block.


/* ASL Script to read card information


   created 1/30/2009 by FTW */


Variables and their values
Variables are assigned values in an ASL script or at adapter startup. Variable assignment at startup
describes how to specify variable values at startup.
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ASL variables do not have a declared type, the values assigned to them are typed. Variable values can
have the following types:


n numeric


ASL stores all numbers as double-floating point.


n string


n binary


n Boolean


n list


n table


n object handle


The section Chapter 6 Interfacing with a Domain Manager provides additional information.


n datetime


The section time() function provides additional information.


A variable name can consist of a letter or an underscore, followed by any number of letters,
underscores, and digits. A variable name is case-sensitive. Uppercase and lowercase letters are
distinct.


Note   Certain ASL words are reserved and should not be used as identifiers or variables, as
described in “Reserved words” on page 149.


Any variable can be assigned different types of values. For example, starting with a basic ASL
statement:


x = ”string”;


The variable x can then be used to store a value:


x = 5.62;


It can also store a Boolean value:


x = TRUE;


For most values, ASL converts one type of value to the appropriate data type for use in a function or
expression. In this example, the var_w variable is assigned a string of numeric characters.


var_w = ”3498”;


The variable, var_w, can be added to a number.


var_y = var_w+100;
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This statement is valid. The number 100 is added to the numeric equivalent of the value stored in
var_w. There is no intermediate step.


Note   The semicolon terminates the end of these assignment actions in ASL.


Type conversions
In some instances, automatic type conversion does not occur. Some functions return values of different
types depending on the type of the value passed. For these cases, there are variable type conversion
functions. Type conversion functions shows the type of conversion functions:


Table 3‑1.  Type conversion functions


Syntax Description


string(value) Converts the values as a string type.


boolean(value) Converts the values as a Boolean type. Any nonzero number is converted to TRUE.
The only strings that convert are “true” and “false” including all capitalization
variations.


numeric(value) Converts the values as a numeric type. All numeric values are stored as double-
floating point.


Lists and tables
Lists and tables are special types of values that can store sets of values. Any variable can store lists and
tables. A value of any type can be assigned to a list or table.


List values
A list is an ordered set of values that are indexed numerically, starting with zero (0). The value assigned
to a member of a list can be any value regardless of whether it is variable, constant value, a table, a list,
or other value type. The list() function initializes the variable type to be of type list. An example is:


x = list();


Using this syntax, the list is empty.


There are three methods to add members to a list.


n The first method is:


x = list(<value_1>,<value_2>,<value_3>,...,<value_n>);


n The second method specifies an index and assigns a value. This method can also be used to change
the existing value of a member in a list.


x[100] = value_1;


x[57] = value_2;
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n The third method appends the value to the list. Using this method, ASL keeps track of the index
value.


x += value_1;


Table values
Tables are associative lists. They exist as hashed arrays with a key and value pair (<key>,<value>) for
each member. The keys for a table must be unique.


A variable may be initialized to be of type table. An example is:


y = table();


To add a value to a table, use the following syntax:


         <table_name>[<key>] = <value>;


The value specified for the <key> or for the <value> can be of any value type.


Multicolumn tables can be implemented in two ways.


The first method implements the multicolumn table as a table of tables:


START {


        .. eol


} do {


        x = table();


        x["a"] = table();


        x["a"]["b"] = 1;


        x["a"]["c"] = 2;


        print(x["a"]["b"]);


        print(x["a"]["c"]);


}


The second method implements the multicolumn table as a single table with joined key:


START {


        .. eol


} do {


        x = table();


        x["a|b"] = 1;


        x["a|c"] = 2;


        print(x["a|b"]);


        print(x["a|c"]);


}
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Scope of variables
The scope of variables determines where the value associated with the variable can be accessed. In
ASL, there are three scope levels:


n Local-scoped variables are accessible only from the rule where the variable is assigned a value and
can be referenced in subordinate rules.


n Driver-scoped variables are accessible from any rule in an ASL script.


n Global-scoped variables are accessible from any adapter that runs on the same process where the
variable is assigned a value.


Note   A local-scope variable cannot have the same name as a global-scoped variable.


Driver-scope
Driver-scoped variables are accessible from any rule in an ASL script. There are two lifetimes for driver-
scoped variables:


n Static


n Record


The difference between the two lifetimes depends on where the variable is assigned a value.


The longer lifetime for a driver-scoped variable is static. When a variable is assigned a value at the
beginning of an ASL script, before the START rule is executed, it is static. Static variables maintain
their value across uses of the START rule or until a new value is assigned. In Example of a variable
with a static lifetime, each time the START rule is invoked, the variable retains its value.
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Figure 3‑1.  Example of a variable with a static lifetime


In the following example, the script counts the number of lines of data in a file. A variable is assigned
to zero at the beginning of the script. The variable’s value is incremented for each line of input. At the
end of the script, the value of the variable is printed. In this script, the START rule is invoked five
times and the variable is not reset.


ASL Script (static_var.asl):


lines=0;


START {


 .. eol


}


do {


 lines = lines+1;


}


EOF do{


 print("Number of lines ".lines);


}


Input: (static_var.txt):


line 1


line 2


line 3


line 4


line 5


Output:


$ sm_adapter --file=static_var.txt static_var.asl


Number of lines 5


$ 


The shorter lifetime for a driver-scoped variable is record. A driver-scoped variable has a record
lifetime when it is assigned a value in a rule. The value of this variable does not change until it is
reassigned a value or when the START rule exits. A driver-scoped variable with a record lifetime is
undefined each time the START rule exits. In Example of a variable with a record lifetime , each time
the START rule is invoked, the variable is undefined.
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Figure 3‑2.  Example of a variable with a record lifetime


In the next example, the script demonstrates that driver-scoped variables keep their value until the
START rule is invoked. In the script, a variable is assigned when the HI rule runs (x=TRUE). This
variable holds its value when the action block of the program is invoked after the HI rule. When the
START rule is invoked again, the input fails to match the pattern specified by the HI rule so the
alternate rule to HI, the THERE rule, is invoked and the variable is not assigned a value in this rule.
When the execution of the script reaches the action block, no variable exists.


ASL Script (record_var.asl):


START {


 print("Starting again") 


 /* print returns TRUE so can be


  * used outside of a do*/


 HI|THERE


}


do {


 if (defined(x))


  //Tests whether variable exists


  {print("x is defined");}


 else {print("x is not defined");}


}


HI {


 "hi" eol


}


do { x=TRUE;}


THERE {


 "there" eol


}


Input (record_var.txt):


hi


there


Output:


$ sm_adapter --file=record_var.txt record_var.asl


Starting again
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x is defined


Starting again


x is not defined


$ 


Local-scope
Driver-scoped variables have some limitations. For instance, they are not suitable for recursion, but local-
scoped variables are suitable.


The following example shows a script that uses recursion and a driver-scoped variable. At first glance, the
script looks like it reverses the order of words that are passed to it. A driver-scoped variable x with a
record lifetime is used to store a value each time a rule is executed. Unfortunately, each time the
recursion executes, the word assigned to the variable overwrites the existing value. The last value
assigned to x is the value that is used for all of the recursions. Only the last word appears as output.


ASL Script (2ndrule_var.asl):


START {


 READANDPRINT


}


READANDPRINT {


 x:word READANDPRINT|eol


}


do {


 print(x);


}


Input (2ndrule_var.txt):


The dog ran.


Output:


$ sm_adapter --file=2ndrule_var.txt 2ndrule_var.asl


ran.


ran.


ran.


ran.


$ 


Local variables are defined in a rule and have a separate value each time the rule runs. Local variables
can be referenced in any subordinate rules. They cannot be accessed in any other rule. A local variable
cannot have the same name as a global variable.


If a local variable is used in a recursive rule, each recursion contains an exclusive value for the variable,
as shown in Figure 5 on page 37.


Local variables are declared in the pattern block of a rule. These declarations must occur before any
pattern matching statements. Local variables override variables with the same name. Use this syntax to
declare a local variable:


local <variable_name>;


The following example demonstrates how use of a local variable instead of a driver-scoped variable
changes the output of the script.
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The script reverses the order of words. The rule READANDPRINT iterates until it does not match. For
each iteration, the value of the word scanned is stored in a local variable. When the end-of-line (eol)
marker is reached, the READANDPRINT rule no longer matches and the recursive rules are completed
with the action block. Each value of x is printed, which has the effect of reversing the order of the input.
The section End-of-line matches provides additional more information about eol markers.


ASL Script (local_var.asl):


START {


 READANDPRINT


}


READANDPRINT {


 local x = “end”;


 x:word 


 READANDPRINT|eol


}


do {


 print(x);


}


Input: (local_var.txt):


The dog ran.


Output:


$ sm_adapter --file=local_var.txt local_var.asl


end


ran.


dog


The


$ 


Global-scope
Adapters in the same server or threads in a single process can share global variables. Global variables
can be of type numeric, string or boolean.


Lists and tables can also be used as global variables but it is not recommended. The ASL programmer
must exercise caution when using global lists or tables to ensure that a single thread or adapter is the
"writer" of the list or table. If more than one thread or adapter attempts to assign values to a list or table,
the likely result will be data loss due to rewriting the variables’ values. There is no inherent mutex or lock
arrangement in ASL to prevent this and it is up to the programmer to ensure against this.


Global variable declarations must be made in the static section of the script file, before any rules are
declared.


Note   A local variable cannot have the same name as a global variable.


Adapters in the same server or threads in a single process can share global variables. Global variables
can be of type numeric, string or boolean.


Use this syntax to declare a global variable:


global <variable_name>;
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Default variable values
A default assignment assigns a value only if the variable is undefined.


default <variable_name>=<value_or_expression>;


The scope of a default variable is restricted to driver-scoped with a static lifetime. A value must be
assigned to a variable declared as default. The value cannot be blank. An example of declaring a default
variable is:


default x = 5;


Default variables assigned in an ASL script can be overridden by the value of the variables specified
during the startup of an adapter with the -D option.


Any variable assignment not defined as default can override the default value and, if one exists, the value
that was assigned by using the -d option.


The following code fragment prints the number 1 if there is no integer value to assign to y.


x = 1;


default y = 1;


START


do


{       print("x=".x);


        print("y=".y);


        stop();


}


Output with the -D option:


$ sm_adapter -Dx=2 -Dy=2 default.asl


x=1


y=2


Output without the -D option:


$ sm_adapter default.asl


x=1


y=1


Variable assignment at startup
Variable values can be assigned when the adapter is started by using the -D option. Variables assigned
by using this method have a static lifetime. Default variables that are locally scoped cannot be assigned a
value by using this method.


sm_adapter -D<variable_name>=<value>


      


The value that is assigned by the switch can be overridden by a standard variable assignment through
either pattern matching or by a variable assignment statement. To define a variable so that the -D option
overrides the value set in the ASL script, define the variable as a default variable in the ASL script.
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Operators
This section describes operators and their order of evaluation.


Arithmetic operators
The addition, subtraction, multiplication, division, and modulus operators can only be used with numeric
values. The arithmetic operators are described in Arithmetic operators.


Table 3‑2.  Arithmetic operators


Operator Description


+ Addition


- Subtraction


* Multiplication


/ Division


% Modulus


Note   You can isolate the decimal portion of a number with the modulus operator by using the syntax:
number%1.


For example, this script assigns numeric values to two variables. These numbers are used in addition,
subtraction, multiplication, division, and modulus operations.


ASL Script (mathematic_do.asl):


START 


do {


 a = 36;


 b = 4;


 print(“Addition “.a+b);


 c = a-b;


 print(“Subtraction “.c);


 d = a*b;


 print(“Multiplication “.d);


 print(“Division “.b/a);


 e = 10%b;


 print("Modulus ".e);


 stop();


}


Output:


$ sm_adapter mathematic_do.asl


Addition 40


Subtraction 32


Multiplication 144


Division 0.111111111111111


Modulus 2


$ 
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String operators
The concatenation operator is the period (.). The concatenation operator forms a new string composed of
two values. Variable conversion is handled automatically.


Note   In the pattern block of a rule, a period is not an operator that concatenates two strings. It forces
two patterns to match together, as described in Chapter 4 Pattern Matching and Filters.


For example, in this script, four variables are assigned values. The first concatenation occurs within the
first print statement. The second concatenation is a combination of two numbers and is assigned to the
variable c. The new string represents a number and can be used in calculations.


ASL Script (concat_do.asl):


START 


do {


 a = 657;


 b = 9283;


 x = “cat”;


 y = ”dog”;


 print(x.y);


 c = a.b;


 print(c);


 stop();


}


Output:


$ sm_adapter concat_do.asl


catdog


6579283


$ 


Relational and logical operators
The relational and logical operators are described in Relational and logical operators.


Table 3‑3.  Relational and logical operators


Operator Description


== Equal to


!= Not equal to


> Greater than


< Less than


>= Greater than or equal to


<= Less than or equal to


&& Logical AND


|| Logical OR
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Precedence and order of evaluation
ASL evaluates operators in the following order:


1 ( )


2 * /


3 %


4 + -


5 == != < > <= >=


6 && || .


Parentheses are evaluated first. The logical AND, logical OR, and the concatenation operator are
evaluated last. ASL evaluates operators with the same level of precedence from left to right.
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Pattern Matching and Filters 4
This chapter includes the following topics:


n Patterns


n Pattern operators


n Pattern elements


n Special variables


n Filters


Patterns
A pattern is a mechanism for matching input. A combination of markers, operators, and characters
describes a pattern. This combination includes the data to match and the operators that control how and
when the data matches. More complicated patterns are made from simpler patterns.


ASL compares patterns to an input of markers and characters. As each component of a pattern matches
with data, the next pattern component is compared with the next segment of input. If all of the
components of a pattern match, the pattern is considered a match. If any component of a pattern fails to
match its corresponding data component, the pattern is not considered a match.


A pattern that does not match fails. In most cases, when a pattern fails, the rest of the rule following that
pattern does not execute.


As ASL matches patterns with data, the starting point for the next match moves to the position after the
data that was matched. When a pattern fails, the starting position does not advance and may or may not
go back to its original position, depending on how the rule containing the pattern is defined.


Progression of a pattern being compared to data shows that for the first match, the pattern is compared,
starting with the left-most position in the data. The pattern matches.


As the result of the successful match, the starting point for the next comparison, the second match, is
immediately after the last successful data match. The pattern matches.


For the third match, the starting position is in a different location again because of the previous successful
match. This comparison fails and the start position resets. Depending on the pattern, the start position
resets to either the starting point for this comparison or to the beginning of the data.
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Figure 4‑1.  Progression of a pattern being compared to data


Using a function in a pattern
Most ASL functions used in the action block of a script can be included in an ASL pattern match. The
syntax of these functions, when used in a pattern block, is slightly different than when used in an action
block. To use a function in a pattern block, use the following syntax:


function([<value>])


In a pattern block, do not use a semicolon with functions.


Pattern operators
This section describes pattern operators and their order of their order of precedence.


White space handling
White space is defined as one or more of any of the characters assigned to the delimiter variable, as
described in Customizing the delimiter. By default, the space and tab characters are assigned to the
delimiter variable. That means any number of contiguous space or tab characters constitute white space
in the data.
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A pattern is made up of one or more pattern elements. There are many types of pattern elements. For
example, keywords such as “word”, and “integer” are elements. An element can be a literal string (text
surrounded by quotes). By default, ASL will ignore any white space in the data as it tries to match pattern
elements. You can use the dot operator to keep ASL from ignoring white space in a pattern match, as
described in Dot operator.


Note   When a literal pattern element contains whitespace, ASL does not ignore it.


For example, if the pattern to match is:


"John" "Doe" integer “st” “Street”


Then ASL will match the following data equally.


John Doe 121st street


JohnDoe121stStreet


John    Doe  121  st   Street


The following script matches a word followed by an integer and another word. The dot operator is not
used, so the delimiters between the words in the data are automatically skipped (if they exist). The end-
of-line (eol) for each line of data is not matched, which causes the START rule to fail. Notice that the
second line of input matches even though there is no delimiter between the number, 42343, and the title,
Manager.


ASL Script (wspace_match.asl):


START {


 a:{word integer word}


}


do {


 print("Matched with ".a");


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (wspace_match.txt):


Tony 25234 Employee


John 42343Manager


Output:


$ sm_adapter --file=wspace_match.txt wspace_match.asl


Matched with Tony 25234 Employee


Failed match


Matched with John 42343Manager


Failed match
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Assignment operator
The characters matched to a pattern can be placed into a variable by using a colon (:) as an operator.
The syntax of a variable assignment is:


         <variablename>:<pattern>


      


ASL assigns all of the characters that match the pattern to the variable. If the pattern does not match, the
variable is not assigned a value.


To assign patterns that have more than one element, use braces to group the elements. All the
components within the braces must successfully match before the variable is assigned a value. The
syntax is:


         <variablename>:{<pattern_1>


         <pattern_2>


         <pattern_3>


         <pattern_4>}


The following script contains three variable assignments. The first and second variables are assigned the
first and second word, respectively, in the datafile. The last variable is assigned an integer followed by two
words.


This last variable demonstrates how patterns can be grouped by using braces. Without the braces, the
variable is assigned only the integer.


The last name in the input file causes the pattern to fail because there is no address information.


ASL Script (assign_match.asl):


START {


 f_name:word l_name:word


 address:{integer word word}


 eol


}


do {


 print(f_name);


 print(l_name);


 print(address);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (assign_match.txt):


John Doe 11 Main St.


Jane Doe 35 Oak Dr.


Bill Jones


Output:
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$ sm_adapter --file=assign_match.txt assign_match.asl


John


Doe


11 Main St.


Jane


Doe


35 Oak Dr.


Failed Match


$ 


Dot operator
A single dot (.) between two elements of a pattern indicates that the second element must be matched
immediately after the first. The dot can be separated from the two elements with white space. However, in
this case, the white space does not indicate an optional delimiter. If a delimiter exists in the input data,
this delimiter must be included as part of either the first or second element when using the dot operator.


The following script matches an integer followed by a word. Only the integer is assigned to a variable and
printed. In this example, the first two lines of data match this pattern. When a space is added between the
integer and the word, as in line 3 of the data, the pattern fails.


ASL Script (sngldot_match.asl):


START {


 a:integer.word


 eol


}


do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (sngldot_match.txt):


95627XFR


34036TFR


11536 GBH


Output:


$ sm_adapter --file=sngldot_match.txt sngldot_match.asl


Matched with 95627


Matched with 34036


Failed match


$ 


Double-dot operator
The double-dot operator (..) matches all characters except for an end-of-line (eol). White space can
surround the double-dot, but the dots must be together. This operator cannot stand alone. Another pattern
must follow. The parser matches as few characters as possible before matching the pattern that follows.
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The following script matches any string of characters up to and including the word, Smith. The pattern
fails on the second line of data because there is no Smith before the end-of-line (eol) is reached. In the
DEFAULT rule, the double-dot operator matches everything until the end of the line.


ASL Script (dbldot_match.asl):


START {


 a:{


 .."Smith"} eol


}


do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (dbldot_match.txt):


3400 John V. Smith


3502 Kathy McCue


1401 Bruce Smith


Output:


$ sm_adapter --file=dbldot_match.txt dbldot_match.asl


Matched with 3400 John V. Smith


Failed match


Matched with 1401 Bruce Smith


$ 


Alternative operator
The alternative operator (|) is used to specify an alternate pattern to match if the first pattern fails. This
operator can be used in a series to create a list of alternatives. When a pattern in a list of alternatives
matches, the remaining alternatives are not tested.


The alternative operator has the lowest level of precedence of all the pattern matching operators. Even
the white space operator has a higher level of precedence.


Once an alternate matches, ASL does not back up to test other combinations. For example, if the input to
an ASL script is:


abc


and the pattern matching is:


{"a"|"ab"} "c"
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No match occurs because once “a” matches, “ab” is not tested. ASL compares the pattern “c” with the
input character “b” and the pattern fails. In general, when constructing a series of alternates, it is better to
place the more complex (or longer) patterns ahead of other patterns.


Note   In the example, braces are used around the alternate expression to control how the pattern is
evaluated because the alternate operator has the lowest level of precedence. Without the braces, the
alternate to the pattern "a" is the pattern "ab" "c". Grouping patterns provides additional information on
controlling pattern evaluation.


The following script matches one of three numbers followed by an end-of-line. For the first number of the
input file, the data matches the first alternative so nothing else is checked. The second number of the
input file does not match any of the alternatives so the pattern fails. The third number does not match
either the first or second alternative, but it does match the third.


ASL Script (alt_match.asl):


START {


 a:{


 "3400"|"4500"|"4127"} eol


}


do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (alt_match.txt):


3400


3908


4127


Output:


$ sm_adapter --file=alt_match.txt alt_match.asl


Matched with 3400


Failed match


Matched with 4127


$ 


Maybe operator
In cases where data to be matched might or might not exist in the input, use the maybe operator, which is
a question mark (?). The maybe operator indicates that a pattern matches regardless of whether the
matching data exists. ASL assigns a NULL string to a variable if a pattern with a maybe operator has no
match.
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The following script matches an employee number (an integer) and a name (of multiple words). The first
and third lines of input match. An employee ID and a name exists. Even though there is no employee ID
number, the second input line matches because ASL assigns the variable a NULL string.


ASL Script (0to1_match.asl):


START {


/* (The rep keyword indicates Repeated Pattern Matches) */


 a:integer? b:rep(word) eol


}


do {


 print("Employee ".b);


 print("Employee ID ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (0to1_match.txt):


4120 Kathy Jones


John L. Doe


3901 David Smith


Output:


$ sm_adapter --file=0to1_match.txt 0to1_match.asl


Employee Kathy Jones


Employee ID 4120


Employee John L. Doe


Employee ID 


Employee David Smith


Employee ID 3901


$ 


Grouping patterns
Patterns can be grouped by using braces {}.


Grouping patterns together can extend the information assigned to a variable. For example,


x:{word word word}


The variable is assigned if the input consists of three strings. Without the braces, x is bound only to the
value of the first word match.


Braces also can control how patterns are evaluated. The use of braces can be combined with operators:


{word integer}


The braces used in this example force the pattern to match a word followed by an integer or nothing at all.
A single word or a single integer will not match this pattern.


VMware Smart Assurance ASL Reference Guide


VMware, Inc.  38







Precedence of pattern operators
The order of precedence for pattern matching is as follows:


1 {}


2 :


3 whitespace . ..


4 ?


5 |


The alternative operator has the lowest precedence. For example, suppose there are four patterns: A,
B, C, and D.


A B|C D


is equivalent to


{A B}|{C D}


The example matches an input of A followed by B, or it matches an input of C followed by D.


Grouping patterns by using the braces has the highest level of precedence. For the patterns A, B, C,
and D:


{A|B} C D


is not equivalent to


A|B C D


Pattern elements
Pattern elements are the building blocks for more complex patterns.


String matches
A string match is a match to one or more characters. An example of a string match is:


RULE {


 “def”


}


If the “def” pattern is compared with an input string of “defdefeedef,” the rule matches twice and fails
when it reaches the “eedef.”
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In the following script, the pattern used for matching is def. The pattern matches def twice and fails with
the input of eed. When the pattern fails in this script, the DEFAULT rule runs, which matches the entire
line.


In most of the examples in this chapter, the pattern to match is surrounded by the following, which
assigns the matched data to the variable a:


a:{


}


The section Assignment operator provides additional information.


It is not necessary to include a variable assignment as part of pattern matching. The matched data is
printed by printing the contents of the variable a.


ASL Script (str_match.asl):


START {


 a:{


 "def"}


}


do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (str_match.txt):


defdefead


Output:


$ sm_adapter --file=str_match.txt str_match.asl


Matched with def


Matched with def


Failed match


$ 


The match for some characters requires a special syntax. Match syntax for special characters contains
the special characters:


Table 4‑1.  Match syntax for special characters


Character Syntax Notes


tab \t


single quotation mark (') \' The quotation marks surrounding the string that contains this
code must be double quotes.


double quotation mark (") \" The quotation marks surrounding the string that contains this
code must be single quotes.


backward slash (\) \\


VMware Smart Assurance ASL Reference Guide


VMware, Inc.  40







Table 4‑1.  Match syntax for special characters (Continued)


Character Syntax Notes


carriage return \r In most cases, use the eol pattern match instead of carriage
return. End-of-line matches provides additional information.


line feed \n In most cases, use the eol pattern match instead of line feed. 
End-of-line matches provides additional information.


Note   Pattern matches are by default case-sensitive. Making patterns case-sensitive or case-insensitive
discusses how to override the default.


Any character matches
The any() function returns a match if the character that is being evaluated matches any character in
<character_string>.


any(<character_string>)


In the following script, the any() function matches with the first four characters of the input file. The next
character causes the pattern to fail and the DEFAULT rule runs.


ASL Script (any_match.asl):


START {


 a:any("abc")


}


do {  print("Matched with ".a);


}


DEFAULT {  ..eol


}


do {


 print("Failed match");


}


Input (any_match.txt):


bbacxy


Output:


$ sm_adapter --file=any_match.txt any_match.asl


Matched with b


Matched with b


Matched with a


Matched with c


Failed match


$ 


Notany character matches
The notany() function returns a match if the character that is being evaluated does not match any
character in the <character_string>.


notany(<character_string>)
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In the following script, the notany() function matches the first three characters of the input file. The next
character causes the pattern to fail and the DEFAULT rule runs.


ASL Script (notany_match.asl):


START {


 a:notany("cx")


}


do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (notany_match.txt):


bbacbxy


Ouput:


$ sm_adapter --file=notany_match.txt notany_match.asl


Matched with b


Matched with b


Matched with a


Failed match


$ 


Char matches
A char match is a match to any character except for a field-separator or an end-of-line. To replace the
char() function, the any() function has to have a character string that is 256 characters long. In the
following script, the character pattern matches with the letter a, the tab, the letter b, the space and finally
the letter c before failing when it tries to match the eol.


ASL Script (char_match.asl):


START {


 a:char


}


do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (char_match.txt):


a <tab> b c


Output:


$ sm_adapter --file=char_match.txt char_match.asl


Matched with a


Matched with 
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Matched with b


Matched with 


Matched with c


Failed match


Word matches
A word match is a match to a sequence of characters that ends with, but does not include, a delimiting
character. Spaces, tabs, field-separators, and ends of line are the default delimiting characters. The
delimiting characters can be redefined, as described in Customizing the delimiter.


The following script is an example of a word pattern that is a match of all characters up to, but not
including the delimiter. The second time the rule is evaluated, the pattern matching starts with the
delimiter. The second word match fails because there are no characters found before the delimiter is
found.


ASL Script (word_match.asl):


START {


 a:word


}


do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (word_match.txt):


city state country


Output:


$ sm_adapter --file=word_match.txt word_match.asl


Matched with city


Failed match


$
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Integer matches
The integer pattern matches a string of numeric characters that may or may not be preceded by a minus
sign. Any non-numeric character except for a dash (minus sign) is not valid for integer matches. The
integer pattern matches the first part of the string:


83294IVBXR  


For example, the following script matches each integer and the end-of-line. The match fails on the third
line of data because there is a decimal point. At that point, the integer is matched with 214 and the
pattern fails because eol is not a match for .56.


ASL Script (int_match.asl):


START {


 a:integer eol


}


do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (int_match.txt):


12300


-375


214.56


Output:


$ sm_adapter --file=int_match.txt int_match.asl


Matched with 12300


Matched with -375


Failed match


$ 


Floating-point number matches
The floating-point number pattern matches a string of numeric characters that may or may not be
preceded by a minus sign, and that may or may not include a decimal point followed by other numbers.
Any non-numeric character except for a period or a dash (minus sign) is not valid for floating-point
matches.


For example, this script matches each number and the corresponding end-of-line. Only the value of float
is assigned to the variable so there are no extra lines between the lines of output.


ASL Script (float_matches.asl):


START {


 a:float eol


}
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do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (float_match.txt):


173


-3.95


3453.45


Output:


$ sm_adapter --file=float_match.txt float_match.asl


Matched with 173


Matched with -3.95


Matched with 3453.45


$ 


Hexadecimal matches
The hexadecimal pattern matches a string of hexadecimal characters. These characters cannot be
preceded by a minus sign. The hexadecimal pattern matches any numeric character and the letters a
through f. The pattern does not match anything else. When ASL assigns a hexadecimal pattern to a
variable, the numeric value is kept but not the hexadecimal value.


The following script matches each hexadecimal number and the corresponding end-of-line.


ASL Script (hex_match.asl):


START {


 a:hex eol


}


do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (hex_match.txt):


ff2234


FF


23


Output:


$ sm_adapter --file=hex_match.txt hex_match.asl


Matched with 16720436


Matched with 255


Matched with 35


$ 
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Field-separator matches
A field-separator is inserted into input data by an adapter’s front end. When using input files, a field-
separator is defined to replace a character of input such as a comma, colon, or a vertical bar (|). A field-
separator represents a division of data that can include multiple words, integers, strings, and even end-of-
line (eol). You can use fs to pattern match a field-separator, as described in Field-separator translation.


Note   Do not confuse a field-separator with a delimiter. Even though a delimiter can be used to separate
multiple words, it is best used as a word separator. A field-separator separates fields that can contain one
or more words. Regardless of the value of the delimiting characters, a field-separator is implicitly defined
as a delimiter.


For example, the following script matches a name and an address, which are separated by a field-
separator. In the input, the field-separator is a colon (:). The name is assigned from one or more repeated
words that come before the field-separator. The address is assigned from the repeated words that follow
the field-separator.


The field-separator is defined when the adapter is run with the following option:


--field-separator 


The input is parsed by the front end and the field-separator is placed into the data.


ASL Script (fs_match.asl):


START {


 a:rep(word) fs


 b:rep(word) eol


}


do {


 print("Name ".a);


 print("Address ".b);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (fs_match.txt):


Jay Ray:11 Main St


Jane Doe:34 Oak Dr


Output:


$ sm_adapter --field-separator=: --file=fs_match.txt fs_match.asl


Name Jay Ray


Address 11 Main St


Name Jane Doe


Address 34 Oak Dr


$ 
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End-of-line matches
One of the markers included in the input is the end-of-line (eol). The eol is added to the input data by the
front end of the adapter. To match an end-of-line, use eol.


The following script matches a word and an end-of-line. Notice that the output is different from many of
the previous examples.


n The first difference is that there were no messages for Failed match. All of the data matched.


n The second difference is that there is a space between successive lines of output. This is because
the eol match is included as part of the output.


ASL Script (eol_match.asl):


START {


 a:{word eol}


}


do {


 print("Matched with ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (eol_match.txt):


switch


router


card


Output:


$ sm_adapter --file=eol_match.txt eol_match.asl


Matched with switch


Matched with router


Matched with card


$ 


Repeated pattern matches
The rep() function repeats pattern matches or a rule for a specific number or for one or more matches.
The syntax is:


rep(<ruleorpattern>[,<number>])


The rule or pattern to repeat is specified by using <ruleorpattern>. The <number> is optional and
indicates the number of times to match the pattern. If the <number> is not included, the pattern is
matched one or more times until it fails or until the pattern following it is matched. The pattern must match
at least once.


Samples of the rep() function shows some sample uses of the rep() function. Each sample uses the letter
P to denote a pattern.
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Table 4‑2.  Samples of the rep() function


Example Behavior Note


rep(P) P P P P P P ... Behaves as if a white space operator appears between each occurrence of P.


rep(.P) P.P.P.P.P.P.P. ... Behaves as if a dot operator appears between each occurrence of P.


rep(..P) ..P..P..P..P..P..P ... The double-dot operator ignores all patterns except for P.


The following ASL script matches two numbers, one or more words, and then an end-of-line.


n The first line of input is matched. There are two numbers followed by two words.


n The second line of input is matched. There are two numbers and three words. The second rep()
function is repeated until the end-of-line is reached.


n The third line of input fails. The line does not contain two numbers at the front of the line.


ASL Script (repeat_match.asl):


START {


 a:rep(integer,2)


 b:rep(word) eol


}


do {


 print("Matched numbers ".a);


 print("Matched with ".b);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (repeat_match.txt):


3400 4127 cat dog


4 5 goat lamb cow


1 chicken horse


Output:


$ sm_adapter --file=repeat_match.txt repeat_match.asl


Matched numbers 3400 4127


Matched with cat dog


Matched numbers 4 5


Matched with goat lamb cow


Failed match


$ 
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Boolean expressions
Boolean expressions can be added to a pattern list. If a Boolean expression fails, the pattern match also
fails.


Note   Boolean expressions are more commonly used in the filter section of a rule than in the pattern
matching block. Unlike Boolean expressions in a pattern, a failing Boolean expression in a filter does not
cause the rule to fail.


The following script matches a name and an integer. The Boolean expression is:


number>2


If the integer is greater than two, the match succeeds.


For every line in the input, the word, the integer and the eol are successfully matched. When the Boolean
expression causes the pattern to fail, the DEFAULT rule is executed and Failed Match is printed.


ASL Script (bool_match.asl):


START {


 animal:word 


 number:integer


 eol


 number>2


}


do {


 print("Animal ".animal);


 print("Number ".number);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (bool_match.txt):


elephants 4


moose 1


tigers 2


giraffes 3


Output:


$ sm_adapter --file=bool_match.txt bool_match.asl


Animal elephants


Number 4


Failed match


Failed match


Animal giraffes


Number 3


$ 
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Positional matching
As ASL matches input data, each character is evaluated until a pattern matches or fails. You can use two
positional matching functions to specify the position where the parser starts to test a pattern.


n The tab() function


n The len() function


tab() function
With the tab() function, you can skip characters of input data by using the following syntax:


tab(<char_num>)


The value of <char_num> is the number of characters to skip from the starting position when the START
rule is invoked. If <char_num> is not specified, the function returns the value of the position where the
parser starts to test a pattern.


It is not possible to use the tab() function to move backward (right to left) in the datastream. For example,
from the first position of a string, you use the tab() function to go to position 20, but, you then cannot go
back to position 15. You cannot use the tab() function to return to data already parsed. Also, the tab()
function does not skip over markers.


With the assignment operator (:), you can assign all of the characters skipped to the variable or the
current position if no characters are specified by using the following syntax:


         <variable>:tab(<char_num>)


In the following script, the tab() function in this pattern is used to skip the first and middle names. The
parser goes directly to the last name of each person in the list. In the input datafile, each field has a fixed
length. The last name field starts at position 16.


At position 16, a single word is matched and assigned to a variable. Then, the current starting position of
the next pattern is returned. This position varies because the word lengths are not equal.


ASL Script (tab_match.asl):


START {


 tab(16) lname:word 


 locate:tab() eol


}


do {


 print("Last Name ".lname);


 print("Tab ".locate);}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (tab_match.txt):
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John            Doe


Jane    Deborah Smith


Output:


$ sm_adapter --file=tab_match.txt tab_match.asl


Last Name Doe


Tab 19


Name Smith


Tab 21


$ 


len() function
Another positional matching function is len(). The len() function advances the starting position from its
current position, unlike the tab() function that works from the original starting position when the START
rule is invoked. The syntax is as follows:


len(<char_num>)


The value of <char_num> is the number of characters to advance from its current position. If <char_num>
is not specified, the function returns the value of the position where the parser would start to test a
pattern.


Like the tab() function, use of the assignment operator assigns all characters skipped to the variable. The
len() function does not skip over markers.


In Example of positional matching, because of the white space operator between each variable
assignment, the space between fox and jumps is skipped. The len() function starts with the letter j. It ends
at position 14, forcing tab (14) to return an empty string. This problem could be avoided by eliminating the
delimiters, as described in Customizing the delimiter.
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Figure 4‑2.  Example of positional matching


Peek() function
The peek() function returns a value of TRUE or FALSE depending on whether the pattern passed to it
matches the current input string. Use of the peek() function does not advance the starting position, so
input can be scanned before other pattern matching. The peek() function stops scanning for a pattern
when it reaches a marker.


peek(<pattern>)


The following script looks for the word horse in each input string. The double-dot operator is necessary in
the pattern so that the peek() function will match any occurrence of the word horse in a pattern and not
just when it appears first.


If the word horse is found in the input string, the peek() function is TRUE and the rule GETLINE executes.
GETLINE assigns every word in the string to the variable a. The value of a is printed and the peek()
function starts with the next input string. If the peek() function is FALSE, the rule GETLINE does not
execute, but the DEFAULT rule does execute.


ASL Script (peek_match.asl):


START {


 peek(..'horse') GETLINE


}


GETLINE{


 a:rep(word) eol
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}


do {


 print("Horse found: ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (peek_match.txt):


moose horse camel


elephant mule camel


goat llama horse


horse goat llama


Output:


$ sm_adapter --file=peek_match.txt peek_match.asl


Horse found: moose horse camel


Failed match


Horse found: goat llama horse


Horse found: horse goat llama


$ 


Not() function
The not() function acts as a logical NOT. If the pattern argument of the function matches, the not()
function returns failure to the match. When the argument does not match, the not() function returns a
successful match. The starting point does not advance when the not() function is used.


For example, the following script looks for input strings that do not contain the word horse.


n If the word horse is found in the input string, the peek() function matches but the not() function returns
a failed match. In this case, the rule GETLINE does not execute.


n If the peek() function does not match, the not() function returns a successful match so the rule
GETLINE executes.


ASL Script (not_match.asl):


START {


 not(peek(..'horse'))


 GETLINE


}


GETLINE{


 a:rep(word) eol


}


do {


 print("No horse: ".a);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}
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Input (not_match.txt):


moose horse camel


elephant mule camel


goat llama horse


horse goat llama


Output:


$ sm_adapter --file=not_match.txt not_match.asl


Failed match


No horse: elephant mule camel


Failed match


Failed match


$ 


Matching through other rules
Pattern matching can be divided among various rules. From the START rule, other rules can be called.
Rules that are called can have any or all of these sections: patterns, filters, or actions.


Operators or functions that work with patterns also work with rules. For example, the rep function can
repeat a rule:


START {


rep(<RULE1>) <RULE2>


}


In the following script, two rules are called from the START rule, PERSON and LOCATION. Each rule
uses the same pattern to find words until an end-of-line, but assigns values to different variables. The
values of the variables are printed from an action block under START.


ASL Script (other_rules.asl):


START {


 PERSON LOCATION


}


do {


 print("Name: ".name);


 print("Address: ".address);


}


PERSON {


 name:rep(word) eol


}


LOCATION {


 address:rep(word) eol


}


Input (other_rules.txt):


Jay Ray


11 Main St


Jane Doe


34 Oak Dr


Output:


$ sm_adapter --file=other_rules.txt other_rules.asl


Name: Jay Ray
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Address: 11 Main St


Name: Jane Doe


Address: 34 Oak Dr


$ 


In the next example, the DATE and PLACE rules are called from START. The DATE and PLACE rules are
separated by an alternative operator. For each line of text where DATE matches, PLACE is not tested. If
DATE does not match, PLACE is tested.


Notice how the variable assignment works in this example. When either DATE or PLACE matches, the
entire matched string is returned and assigned to x. The end-of-line is added to the string, which affects
the output.


ASL Script (operators_rules.asl):


START {


 x:{DATE|PLACE}


}


do {


 print("Day or place ".x);


}


DATE {


 integer.rep("/".integer,2)


 eol


}


PLACE {


 integer word word eol


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (operators_rules.txt):


01/05/99


11 Main St


camel horse mule


10/31/01


34 Oak Dr


Output:


$ sm_adapter --file=operators_rules.txt operators_rules.asl


Day or place 01/05/99


Day or place 11 Main St


Failed match


Day or place 10/31/01


Day or place 34 Oak Dr


$ 


End-of-file matches
The end of a file cannot be matched through pattern matching. However, there is a special rule, EOF, that
runs when the end of a file is reached. Special rules provides additional information about the EOF rule.
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Special variables
Special variables control how ASL evaluates patterns. These variables define the delimiters between
words, case-sensitivity, and even the data input.


Customizing the delimiter
You can redefine the delimiters by assigning a string to the built-in variable delim. Use the following
syntax to define new delimiters:


delim=<string>;


The <string> defines the set of characters to use as delimiters.


The delimiter is specified at the beginning of a script or at the beginning of a rule, before any pattern
matching.


n If a delimiter statement is placed before all of the rules, the delimiters apply to all rules.


n If a delimiter statement is placed in a rule, ASL overrides any previous delimiter definitions.


In this example, the delimiter is ":?" for RULE2, but "|" for RULE1 and RULE3.


delim=":?";


START {


    RULE1 RULE2


}


RULE1 {


   delim="|";


 RULE3


}


The new delimiters override all of the default delimiters except for eol and fs. Each character included
in the <string> is a separate delimiter.


delim = ":?";


When the string :? is assigned to delim, it defines two delimiters: a colon and a question mark. If input
data contained the combination (“:?”), ASL interprets the data as two delimiters in series.


The match for some characters requires a special syntax. To use tabs and returns as delimiters, use
the special syntax within the quotation marks, as described in Customizing the delimiter.


Note   For most cases, use the eol pattern match instead of line feed or carriage return. The eol
character is a delimiter by default and cannot be overridden.
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An alternative to using the delim variable is to use a combination of the rep() function and the
notany() function. For example:


x:rep(notany(":?"))


In the example, ASL assigns to the variable x everything that appears up to a question mark or a
colon.


Making patterns case-sensitive or case-insensitive
By default, pattern matching is case-sensitive. To override the default case-sensitivity, use the case
variable. This variable can be used at the beginning of a script or at the beginning of a rule, before any
pattern matching. The syntax of the case variable is:


case=[exact]|[ignore];


To match case-sensitive patterns, set case equal to exact. For patterns where case does not matter, set
case equal to ignore.


If a case variable is placed before all of the rules, the case setting applies to all rules. This can be
overridden in a rule by using another case variable.


Switching the input of a pattern
For complicated inputs, the pattern matching can be divided among different rules by using the input
variable. The input variable is assigned to a value which ASL uses for the pattern matching that follows
the input. The input variable must come at the beginning of a rule, before any pattern matching but not at
the beginning of a script. If the value assigned to the input variable does not end with an eol, an eol is
appended to the value. The syntax is as follows:


input=<value>;


For example, the following script looks for lines of input that start with the string “Error:”. When it finds
those strings, the rest of the words are assigned to the variable desc and the rule PROCESSDESC is
called.


PROCESSDESC takes the variable desc as its input and performs pattern matching based on the input.
The error level and error message are printed.


The START rule processes the next line data and, if it is an error, PROCESSDESC runs again. At the end
of the input file, the rule EOF runs. This rule prints a statement that the errors are processed.


ASL Script (input_ex.asl):


START {


 "Error:" desc:rep(word) eol


 PROCESSDESC


}


PROCESSDESC {


 input=desc;
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 errornumber:integer


 errorlevel:word


 errormsg:rep(word)


 eol


}


do {


 print(errorlevel." ".errormsg);


}


DEFAULT {


 ..eol


}


do {


 print("No Error");


}


EOF


do {


 print();


 print("Errors Processed");


}


Input (input_ex.txt):


Error: 2568 Severe Can't process


Status: 2358 Starting backup


Error: 1202 Warning Bad data


Error: 923 Critical Wrong Number


Output:


$ sm_adapter --file=input_ex.txt input_ex.asl


Severe Can't process


No Error


Warning Bad data


Critical Wrong Number


Errors Processed


$ 


Filters
A filter determines whether the action block of a rule executes. When a filter fails, the subsequent action
block does not execute. Unlike a pattern, if a filter fails, the rule it is called from does not fail.


A filter has the form:


filter {


{<filter-list>}


}


The <filter-list> must be a single Boolean expression. ASL evaluates this expression from left to right. If it
is TRUE, ASL executes the actions in the do block. If it is FALSE, ASL does not execute the actions in the
do block.


Filter operators are listed in Filter operators.


n Parentheses have the highest level of precedence.
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n The logical operators && and || have the lowest level of precedence.


Although the filter-list must be a single Boolean expression, you can use the logical AND and logical
OR to test for more than one condition.


Table 4‑3.  Filter operators


Operator Definition


() Grouping operators


+ - * / % Arithmetic operators


== Equal to


!= Not equal to


> Greater than


< Less than


>= Greater than or equal to


<= Less than or equal to


&& Logical AND


|| Logical OR


In the following script example, the filter controls whether an action is performed. The script matches a
word and an eol. The value of the word is assigned to x.


The filter is true when x has the value “switch”. For the input file, this occurs in the first line and the fourth
line. The action block is executed twice. The DEFAULT rule is never executed because the pattern always
matches.


ASL Script (simple_filter.asl):


START {


 x:word eol


}


filter {


 x=="switch"


}


do {


 print("Filter match: ".x);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (simple_filter.txt):


switch


router


card


switch


Output:
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$ sm_adapter --file=simple_filter.txt simple_filter.asl


Filter match: switch


Filter match: switch


$


In the next example, the script matches a word and an eol. The value of the word is assigned to x. The
filter is true when x has the value “switch,” or when it has the value “router.”


ASL Script (other_filter.asl):


START {


 x:word eol


}


filter {


 x=="switch" || x=="router"


}


do {


 print("Filter match: ".x);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (other_filter.txt):


switch


router


card


switch


Output:


$ sm_adapter --file=simple_filter.txt simple_filter.asl


Filter match: switch


Filter match: router


Filter match: switch


$ 


Filters can be useful for debugging. Setting a single variable at the beginning of a script can affect the
actions that a script performs.


debug = TRUE;


START {


x:word eol


}


filter {


debug==TRUE


}
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Actions 5
This chapter includes the following topics:
n Action block


n Iteration and control statements


n Function reference


n Returning values


n Passing arguments to functions


n Calling rules as functions from do blocks


n Exception handling


Action block
The action block is executed for a rule when pattern matching succeeds (or does not exist) and the filter
is TRUE (or does not exist). An action block uses the following form:


do {


<action-list>


}


Action lists can occur only within a do block. An action list is composed of statements. Statements include
variable assignments, conditional actions, and rules. Each statement must end with a semicolon. An
example of an action block is as follows:


do {


statement_1;


statement_2;


statement_3;


}


Operators
In the action block, statements are terminated with a semicolon (;). Although a semicolon is not required
to immediately follow the statement, it must occur before the next statement.


All other operators used in the action block are described in “Operators” on page 39.
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Iteration and control statements
Iteration and control statements are not followed by a semicolon. They may control other statements that
require the use of semicolons.


foreach statement
The foreach statement iterates through all of the members of a list or a table. The syntax is:


foreach <variable> (<list_or_table_name>) {statements}


When the foreach statement is used with a list, the variable stores the value of each member of the list
every time the foreach statement loops. The members returned are in numerical order by their list indices.


The following script matches numbers from an input file and stores the values in a list. The foreach
statement cycles through every value stored in the list. Each value is printed and added to a subtotal,
which is also printed.


ASL Script (foreachlist_do.asl):


data = list();


total = 0;


START {


 rep(NUMBERS)|eol


}


NUMBERS {


 x:integer


}


do {


 data += x;


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


EOF 


do {


 foreach i (data) {


  total = total + i;


  print("Number: ".i);


  print("Subtotal ".total);


 }


}


Input (foreachlist_do.txt):


2 4 8


Output:


$ sm_adapter --file=foreachlist_do.txt foreachlist_do.asl


Number: 2


Subtotal: 2


Number: 4


VMware Smart Assurance ASL Reference Guide


VMware, Inc.  62







Subtotal: 6


Number: 8


Subtotal: 14


$ 


When the foreach statement is used with a table, the variable receives the keys to the members of the
table. Tables have no inherent order.


The next script matches numbers and words from an input file and stores the values in a table. The
foreach statement cycles through every key stored in the table. Each key is printed as well as the
associated value. The order in which the members of the table are printed is not necessarily the order in
which the members were added to the table.


ASL Script (foreachtable_do.asl):


pop = table();


total = 0;


START {


 rep(NUMBERS)


}


NUMBERS {


 count:integer animal:word 


 eol


}


do {


 pop[animal] = count;


}


DEFAULT {..eol}


do {print("Failed match");}


EOF 


do {


 foreach w (pop)


 {


  print("Animal ".w);


  print("Number ".pop[w]);


 }


}


Input (foreachtable_do.txt):


2 cows


4 cats


6 dogs


8 chickens


Output:


$ sm_adapter --file=foreachtable_do.txt foreachtable_do.asl


Animal chickens


Number 8


Animal cows


Number 2


Animal cats


Number 4


Animal dogs


Number 6


$ 
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while statement
The while statement repeats a block of statements while a condition is true. The syntax is as follows:


while <condition> {<statements>}


The following script has no pattern matching. The variable x is printed and incremented by one until it is
no longer less than five.


ASL Script (while_do.asl):


x=0;


START


do {


 while x < 5


 {


  print(x);


  x=x+1;


 }


 stop();


}


Input:


none


Output:


$ sm_adapter while_do.asl


0


1


2


3


4


$ 


if else statement
The if else statements control what actions are performed based on the results of a conditional test. The
syntax is as follows:


if (<conditional_test>) {<statements>} [else {<statements>}]


The else portion of the statement is optional.


Note   The braces around the statements are required, even if there is only one statement.


In the following example, the if statements check whether a value to use in a table exists as a key or not.
Each key in a table must be unique. In the script, if a key exists, the value associated with the key is
added to the new value.


This script uses two if statements.


n The first if statement tests whether any of the existing keys match the name of the animal ready to be
loaded into the table. If the animal name matches any of the existing keys, a flag is set to TRUE.
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n The second if statement tests whether the flag is FALSE. If the flag is FALSE, the animal name and
number are added to the table. If the flag is TRUE, the number of animals are added to the animal
count already stored in the table.


ASL Script (if_do.asl):


z = table();


START {


 rep(IMPORT)


}


IMPORT {


 animal:word 


 count:integer 


 eol


}


do {


 test="FALSE";


 foreach i (z)


 {


  if (i == animal)


  {


   test="TRUE";


  }


 }


 if (test=="FALSE")


 {


  z[animal]=count;


 }


 else


 {


  z[animal]=z[animal]+count;


 }


}


EOF


do {


 foreach i (z)


 {


  print(i." count ".z[i]);


 }


}


Input (if_do.txt):


dog 3


cat 4


canary 3


cat 2


dog 5


dog 1


cat 1


Output:


$ sm_adapter --file=if_do.txt if_do.asl


dog count 9


cat count 7


canary count 3


$ 
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break statement
The break statement stops processing statements inside of a loop and exits the loop. The break
statement is valid only inside of foreach or while loops.


This example is similar to the if statement example except that a break statement has been added. if else
statement provides additional information about the if statement.


The break statement causes the test in the foreach statement to stop once the condition is TRUE rather
than continuing to test.


ASL Script (break_do.asl):


z = table();


START {


 rep(IMPORT)


}


IMPORT {


 animal:word 


 count:integer 


 eol


}


do {


 test="FALSE";


 foreach i (z)


 {


  if (i == animal)


  {


   test="TRUE";


   break;


  }


 }


 if (test=="FALSE")


 {


  z[animal]=count;


 }


 else


 {


  z[animal]=z[animal]+count;


 }


}


EOF


do {


 foreach i (z)


 {


  print(i." count ".z[i]);


 }


}


break_do.txt (Input):


dog 3


cat 4


canary 3


cat 2


dog 5
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dog 1


cat 1


Output:


$ sm_adapter --file=break_do.txt break_do.asl


dog count 9


cat count 7


canary count 3


$ 


continue statement
The continue statement starts the next iteration of a foreach statement or while statement. When ASL
invokes the continue statement, the remaining statements in the foreach or while loop are skipped. The
continue statement is not valid outside of a loop.


In the following example, an if statement checks whether values in a table are positive. For any number
less than or equal to 0, the continue statement advances the foreach loop.


ASL Script (continue_do.asl):


x = table();


START {


 LOAD


}


LOAD {


 y:word z:integer eol


}


do {


 x[y] = z;


}


EOF 


do {


 foreach w (x)


  //skip if not positive


  {if (x[w]<=0)


   {continue;


   }


  print(w." ".x[w]);


  }


}


Input (continue_do.txt):


elephant 0


goat -1


worm 100


chicken 7


dog 2


cat 0


moose 9


Output:


$ sm_adapter --file=continue_do.txt continue_do.asl


dog 2
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moose 9


chicken 7


worm 100


$ 


Function reference
This section discusses the different types of functions that are available.


glob() function
The glob() function returns a TRUE or FALSE based on whether a pattern matches a string. The glob()
function can be used as a conditional test for an if or while statement. The syntax is as follows:


glob(<pattern>, <string>)


The expression for a glob() function is a series of characters (or patterns) that are matched against
incoming character strings. You use these expressions when you define matching criteria.


Matching is done strictly from left to right, one character or basic glob expression at a time. Characters
that are not part of match constructs will match themselves. The pattern and the incoming string must
match completely. For example, the pattern abcd does not match the input “abcde” or” abc”.


A compound glob pattern consists of one or more basic wildcard patterns separated by ampersand (&) or
tilde (~) characters. A compound wildcard pattern is matched by attempting to match each of its
component basic wildcard patterns against the entire input string.


The pattern used in the glob() function is not the same pattern used in the pattern block of an ASL script.
The symbols that describe the pattern are described in Symbols for a glob pattern .


Table 5‑1.  Symbols for a glob pattern


Symbol Description


* Matches an arbitrary string of characters. The string can be empty.


? Matches any single character.


^ Acts as a NOT. Use this in conjunction with other symbols or characters.


[set] Matches:
n Any single character that appears within [set], or
n Any single character that is not in the set if the first character of [set] is (^).


A hyphen (-) within [set] indicates a range, so that [a-d] is equivalent to [abcd]. The character before the
hyphen (-) must precede the character after it or the range will be empty.


The character (^) in any position except the first, or a hyphen (-) at the first or last position, has no special
meaning.


<n1-n2> Matches numbers in a given range. Both n1 and n2 must be strings of digits, which represent non-negative
integer values. The matching characters are a non-empty string of digits whose value, as a non-negative
integer, is greater than or equal to n1 and less than or equal to n2. If either end of the range is omitted, no
limitation is placed on the accepted number.
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Table 5‑1.  Symbols for a glob pattern (Continued)


Symbol Description


| Matches alternatives. For example, ”ab|bc|cd” without spaces matches exactly the three following strings:
“ab”, “bc”, and “cd”. A vertical bar (|) as the first or last character of a pattern accepts an empty string as a
match.


\ Removes the special status, if any, of the following character. Backslash (\) has no special meaning within a
set ([set]) or range (<n1-n2>) construct.


& “And Also” for a compound wildcard pattern. If a component basic wildcard pattern is preceded by & (or is
the first basic wildcard pattern in the compound wildcard pattern), it must successfully match.


~ “Except” for a compound wildcard pattern (opposite function of &). If a component basic wildcard pattern is
preceded by ~, it must not match.


Note   Spaces are interpreted as characters and are subject to matching even if they are adjacent to
operators like “&.”


If the first character of a compound wildcard expression is an ampersand (&) or tilde (~) character, the
compound is interpreted as if an asterisk (*) appeared at the beginning of the pattern. For example, the
following two expressions are equivalent to each other:


~*[0-9]*


*~*[0-9]*


Both of these expressions match any string that does not contain any digits.


A trailing instance of an ampersand character (&) can match only the empty string. A trailing instance of a
tilde character (~) can be read as “except for the empty string.”


The following script prints sentences that contain the characters “Ship” or “ship.”


ASL Script (glob_do.asl):


START {


 sentence:rep(word) eol


}


do {


 if (glob("*[Ss]hip*",sentence))


  {print(sentence);}


}


Input (glob_do.txt):


I have a ship that floats.


Shipping is a big industry in Hong Kong.


The dog ate my homework.


I fell down and hurt my hip.


A boat is much smaller than a ship.


Output:


$ sm_adapter --file=glob_do.txt glob_do.asl
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I have a ship that floats.


Shipping is a big industry in Hong Kong.


A boat is much smaller than a ship.


$ 


stop() function
The stop() function stops the current thread. No arguments are passed to the function. A call to the stop()
function does not return.


If you call stop() in an ASL thread, and that thread is in a process that has other threads, the effect is to
simply stop that thread. However, when the thread that is being stopped is the only thread that is running,
then stopping that thread effectively shuts down the adapter (because the adapter shuts down when there
are no more active threads).


The syntax is as follows:


stop()


quit() function
The quit() function stops the back end, or the Domain Manager in the case of inflow adapters. No
arguments are passed to the function. When the quit() function is encountered, the ASL script
immediately ceases execution.


A call to the quit() function does not return, except when you run sm_adapter with the -s option to connect
the adapter to a remote Domain Manager, and then you call quit(). In this case, the remote
Domain Manager initiates its shutdown procedure and the function does return. The calling script
continues running while the remote Domain Manager shuts down (which may take more than a few
seconds). The script may even interact with the back-end Domain Manager during the interval between
calling quit() and the Domain Manager actually shutting down. And so long as the script never tries to
interact with the back-end Domain Manager once it has shut down, the script can continue running
indefinitely.


The syntax to stop a remote adapter is as follows:


quit();


The syntax to stop the current adapter is as follows:


self->quit();


If you launch sm_adapter and do not specify a back end, the adapter becomes its own back end.  In such 


cases, quit() does the same thing as self->quit().


defined() function
The defined() function returns TRUE if a variable has a value.
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This example is a refinement of the if example. The section if else statement provides additional
information.


By using the defined() function, several lines of the script are removed, including a foreach statement and
an if statement.


The single if statement verifies whether a table key entry exists in the table. If the name exists, the
number of animals is added to the animal count already stored in the table. If the name does not exist, the
animal name and number are added to the table.


ASL Script (defined_do.asl):


z = table();


START {


 rep(IMPORT)


}


IMPORT {


 animal:word 


 count:integer 


 eol


}


do {


 if (defined(z[animal]))


 {


  z[animal]=z[animal]+count;


 }


 else


 {


  z[animal]=count;


 }


}


EOF


do {


 foreach i (z)


 {


  print(i." count ".z[i]);


 }


}


Input (defined_do.txt):


dog 3


cat 4


canary 3


cat 2


dog 5


dog 1


cat 1


Output:


$ sm_adapter --file=defined_do.txt defined_do.asl


dog count 9


cat count 7


canary count 3


$ 
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undef() function
The undef() function clears a variable, including lists and tables, or a table member. A list entry cannot be
undefined. An undefined variable has no value. Other statements and functions cannot use it until it is
reassigned a value.


Note   The undef() function cannot be used to undefine a global or static variable.


sizeof() function
The sizeof() function returns a number depending on the value passed to the function. The sizeof()
function converts any values (except for a list or a table) to a string, and returns the number of characters
in the string. For lists and tables, the sizeof() function returns the number of defined members.


The syntax is one of the following:


n sizeof(<value>)


n sizeOf(<value>)


The following script matches a line of text in a file. The length of each line is measured and printed.


ASL Script (sizeOf_do.asl):


START {


 x:rep(word) eol


}


do {


 y = sizeof(x);


 print("Length ".y);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (sizeOf_do.txt):


This has a size of 21


size of 9


Output:


$ sm_adapter --file=sizeof_do.txt sizeof_do.asl


Length 21


Length 9


$ 
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substring() function
The substring() function returns a string. The returned string is a piece of the string passed to the
function. The syntax is as follows:


substring(<string>, <starting_position>, <characters_to_return>)


The <starting_position> value indicates the beginning of the new substring taken from the <string>. The
first position of a string is position 0. The <characters_to_return> value indicates the number of
characters to return starting with starting_position.


For the following script, the input is a 12-line text file. Each line has 10 characters.


For the first line of input, the substring() function returns the entire string. For subsequent lines of input, a
character is removed from the beginning of the string.


When the starting position is greater than the number of characters in the original string, no characters
are returned.


ASL Script (substring_do.asl):


y=0;


START {


 x:word eol


}


do {


 newstring=substring(x,y,10);


 print("New string ".newstring);


 y = y+1;


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (substring_do.txt):


0123456789


0123456789


0123456789


0123456789


0123456789


0123456789


0123456789


0123456789


0123456789


0123456789


0123456789


0123456789


Output:


$ sm_adapter --file=substring_do.txt substring_do.asl


New string 0123456789


New string 123456789
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New string 23456789


New string 3456789


New string 456789


New string 56789


New string 6789


New string 789


New string 89


New string 9


New string 


New string 


$ 


toLower() function
The toLower() function returns a string, converting any uppercase letters in the original string to
lowercase. The syntax is as follows:


toLower(<string>);


For example, this script converts strings so that all of the letters following the first character in each word
are lowercase.


For each word in a person’s name, the initial character is assigned to the initial variable and the remaining
characters (if there are any) are assigned to the rest variable. The toLower() function converts the string
stored in the rest variable to lowercase letters. Then, the characters stored in the initial and the rest
variables are assigned to the fullname variable.


Once each name has been read and converted, ASL prints it before the next name is read and converted.


ASL Script (toLower_do.asl):


START {


do {fullname="";}


 rep(READNAME) eol


}


do {


 print(fullname);


}


READNAME {


 initial:char.rest:word?


}


do {


 rest = toLower(rest);


 name=initial.rest;


 fullname = fullname.name." ";


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (toLower_do.txt):
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JOHN DOE


JANE Q PUBLIC


Output:


$ sm_adapter --file=toLower_do.txt toLower_do.asl


John Doe


Jane Q Public


$ 


toUpper() function
The toUpper() function returns a string, converting any lowercase letters in the original string to
uppercase. The syntax is as follows:


toUpper(<string>);


The following script assigns the first letter of each word to the variable a. The a variable is concatenated
with another variable, name, to form an acronym. The toUpper() function capitalizes the entire acronym
before it is printed.


ASL Script (toUpper_do.asl):


name="";


START {


 rep(FIRSTLETTER) eol


}


do {


 print(toUpper(name));


}


FIRSTLETTER {


 a:char.word?


}


do {


 name=name.a;


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (to Upper_do.txt):


I see several tall buildings


New York City


Output:


$ sm_adapter --file=toUpper_do.txt toUpper_do.asl


ISSTB


NYC


$ 
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print() function
The print() function sends strings it receives to each of the active logs in the Domain Manager process.
There is no automatic translation of the message text. The syntax is as follows:


print(<argument>);


The value of the argument passed to the print() function can be any data type. The argument passed to a
print() function is converted to a string before it is printed.


To print special characters, use the syntax listed in Print function special characters.


Table 5‑2.  Print function special characters


Character Syntax Notes


tab \t


single quote (') \' The quotation marks surrounding the string containing this code
must be double quotes.


double quote (") \" The quotation marks surrounding the string containing this code
must be single quotes.


backward slash (\) \\


carriage return \r


line feed \n


The output of the print() function is dependent on the value of the computed attribute, enableLegacyPrint,
in GA_Driver. When ASL scripts are run by using sm_adapter, the enableLegacyPrint attribute is set to
TRUE. In all other cases it is set to FALSE. The default value of the enableLegacyPrint attribute is
FALSE.


When the enableLegacyPrint is set to FALSE, the print output includes the time, date, thread id, and ASL
script. When enableLegacyPrint is set to TRUE, only the string that is sent to the print() function is printed.


You need an object handle to a GA_Driver object to set the enableLegacyPrint attribute. You can use
"Null GA_Driver" which always exists.


In this example, the value of the enableLegacyPrint attribute is changed. The output of the print() function
is also included.


START { } do {


 print("default");


 drv = object("GA_Driver", "Null GA_Driver");


 drv->enableLegacyPrint = FALSE ? LOG,STOP;


 print("new style");


 drv->enableLegacyPrint = TRUE ? LOG,STOP;


 print("legacy");


 stop();


}
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Output for "sm_adapter --output /tmp/foo.asl" :


default


[February 6, 2009 12:19:03 AM EST +527ms] t@1088432480 main


ASL_MSG-*-ASLP-/tmp/foo.asl: new style


legacy


sleep() function
The sleep() function temporarily stops the adapter. The syntax is:


sleep(<time_in_seconds>);


The sleep() function is passed a number, which represents the amount of seconds to sleep. The sleep()
function returns TRUE.


time() function
The time() function works with and without an argument. Without an argument, this function returns the
current system time. With a numeric argument, the time() function adds the argument (as seconds) to the
date and time January 1, 1970 00:00:00 GMT and returns the new time and date based on the current
time zone information.


The output type of the time() function can be controlled through type casting. By default, the function
returns a string. If the function is converted to a numeric, the output is converted into an integer that
represents the number of seconds since January 1, 1970 00:00:00 GMT.


For example:


x = string(time());


print(x);


The string() function returns the time in the following format:


DD-MONTH-YYYY HH:MM:SS


However, the following numeric function returns a number similar to 958159632.


x = numeric(time());


print(x);


Type conversions also work when a value is passed as an argument to the function.


The following script prints the date and time, waits five seconds, and prints the date and time again. It
also converts a number read from the input file into a date and time.


ASL Script (time_do.asl):


START {


 y:integer eol


}
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do {


 print(time());


 sleep(5);


 print(time());


 x = time(y);


 print(x);


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


Input (time_do.txt):


987517893


Output:


$ sm_adapter --file=time_do.txt time_do.asl


12-May-2000 03:28:47


12-May-2000 03:28:52


17-Apr-2001 10:31:33


$ 


trace() function
The trace() function turns on or off an internal trace() function that traces how the code is parsing the
passed parameters. You can turn on the function at a specific point in the code to validate that line. This
function is useful when creating a rule and validating what is being matched.


The trace() function gives you access, from within ASL, to command line options available with the
sm_adapter command with the following exceptions:


n There is no analog of sm_adapter - -traceRules because all rules have already been compiled by the
time you could turn on tracing of rule compilation.


n Calling the trace() function as trace(“input”,TRUE), turns on tracing at the front end, and has no
command line equivalent under sm_adapter.


The syntax is as follows:


trace(<string>, <BOOLEAN>)


The <BOOLEAN> argument determines whether tracing is turned on or off.


Valid values for string lists valid values for <string>.


Table 5‑3.  Valid values for string


Value Description


parser Matches the input stream against the rule.


input Traces input from the front end.


server Traces the interaction of the remote wire protocol with the server.
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For example:


START {


 x:rep(word) eol


 }


 do {


 trace ("parser", TRUE);


 trace ("input", TRUE);


 trace ("server", TRUE);


 }


hexToString() function
The hexToString() function converts values with a hexadecimal format into their equivalent ASCII
characters. The function pairs the hexadecimal values and converts each pair. The syntax is as follows:


hexToString(<value>)


getRuleFileName() function
The getRuleFileName() function returns the filename of the currently executing rule file. The syntax is as
follows:


getRuleFileName([<fullname>])


The <fullname> argument is optional. If it is omitted or passed as FALSE, only the base name of the rule
filename is returned. Otherwise, the full name, including the path, is returned.


Returning values
By default, a rule returns the characters it matches. A patternless rule returns an empty string. Like other
patterns, the returned value from a rule can be assigned to a variable.


a:RULE_A


The return statement overrides values returned by a rule. The syntax is:


return <value>;


ASL exits a rule immediately after a return statement. It does not execute any statements that follow a
return statement.


The next script reads input that consists of a person’s name followed by a field-separator and an address.
Both the name and address are corrected for capitalization: an uppercase letter at the beginning of a
word, followed with lowercase letters for the rest of the word.


In the START rule, two variables are assigned values returned from the READWORDS rule. Every time
the pattern in the START rule matches, the two variables are printed.
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The READWORDS rule is a repetition of pattern matching followed by an action block. The action block
converts the data so that the first letter of a word is capitalized and the rest of the letters are lowercase.
The word is added to a string called tempstr.


At the end of the READWORDS rule, the return statement returns the correctly capitalized string. If there
was no return statement, the READWORDS rule would return the string as it was read during the pattern
matching.


ASL Script (return_do.asl):


START {


 fullname:READWORDS fs


 address:READWORDS eol


}


do {


 print(fullname.address);


}


READWORDS {


 do {tempstr = "";}


 rep(READ_FIX)


do {return tempstr;


 }


}


READ_FIX {


 initial:char.rest:word?


}


do {


 initial = toUpper(initial);


 rest = toLower(rest);


 fixed=initial.rest;


 tempstr = tempstr.fixed." ";


}


DEFAULT {


 ..eol


}


do {


 print("Failed match");


}


Input (return_do.txt):


John Q Doe:11 MAin St.


JANE PUblic:387 OAK DR.


HENry HUDSON:9 ELM rd. 


Output:


$ sm_adapter --field-separator=: --file=return_do.txt return_do.asl


John Q Doe 11 Main St. 


Jane Public 387 Oak Dr. 


Henry Hudson 92 Elm Rd. 


$ 
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Passing arguments to functions
Rules can act as functions, which can be called from both a pattern block and an action block. You can
pass values to rules in ASL and receive values back by using the return statement, as described in
“Returning values” on page 92. The syntax is as follows:


RULE(<variablename>)


The argument of a rule is a local variable.


The following script reads and counts the words in a file. The READWORD rule is passed an argument
that is used as a counter. The count variable behaves as a local variable.


ASL Script (rule_arg.asl):


START {


 READWORD(1)


}


READWORD(count) {


 local y = "end";


 y:word


 READWORD(count+1)|eol


}


do {


 print(y." ".count);


}


Input (rule_arg.txt)


dog cat goat


Output:


$ sm_adapter --file=rule_arg.txt rule_arg.asl


end 4


goat 3


cat 2


dog 1


$ 


Calling rules as functions from do blocks
Another rule may be called within any do block. Functions have the following generalized syntax.


FunctionName (arguments)


do


{


 ... ASL statement(s) ...


}


Any valid ASL expression may be used in the body of a function. This includes calls to other functions
and recursive function calls.


Function may have any number of arguments, including no arguments, which are any data type that is
supported by ASL.
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Functions optionally return a value, which are also of any ASL data type. The return value may be a
constant, or a variable declared within the scope of the function do block, as described in Returning
values.


A function must be defined in the same ASL script where it is called, and may be defined before or after
the location where it is referenced. The general syntax used to invoke a function references the function
by name, passes the number and type of arguments expected by the function, and handles the return
value, as shown.


Note   Not all functions are required to return a value as shown in the example.


do {


  ... ASL statement(s) ...


  arg1 = x;


  arg2 = y;


  ReturnValue = FunctionName (arg1, arg2);


  ... handle ReturnValue ...


}


A function may be defined only outside of a do block. That is, a function may not be defined within
another function with the intent of referencing the inner function from another do block.


The following is an example of a recursive function definition and call.


START


{  .. eol  }


do {


  foreach i (list(0,1,2,3,4,5)) {


   print (i.”! = “.factorial(i));


  }


}


factorial(x)


do {


  if (x > 1)


   return (x * factorial(x-1));


  else


   return (x);


}


This example produces the following results.


0! = 0


1! = 1


2! = 2


3! = 6


4! = 24


5! = 120
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Exception handling
Exception handling can be added to any action components. Exception handling determines how errors
from statements or functions are treated. The syntax is as follows:


         <action> ? [LOG][,][FAIL|STOP|NEXT|IGNORE]


The question mark handles errors generated by the function. The keywords, that control how an
exception is handled are described in Exception handling keywords.


Table 5‑4.  Exception handling keywords


Keyword Description


LOG The exception is reported to the English log file and the non-English log file, if specified. When a remote
exception chain is logged by ASL, the locale defined in the SM_LOCALE environment variable will be
used. The VMware Smart Assurance System Administration Guide provides further information
concerning the log files.


FAIL The current rule exits with a failure status. If the failed expression is associated with the START rule, the
DEFAULT rule is executed.


STOP This is equivalent to calling the stop() function.


NEXT The processing of actions in the current expression block stops. The rule, however, is not treated as
failed rule.


IGNORE The current action is ignored and processing continues as if nothing happened.


You can specify the LOG keyword with any of the other keywords.


To define the severity of the exception, arguments can be passed to LOG. Logging levels are set by using
the syntax:


LOG("<logging_level>")


Valid logging keywords are (in increasing level of severity):


n Debug


n Notice or Informational


n Warning (Default log value)


n Error


n Fatal or Critical


When the exception is not specified, the default behavior for exceptions is LOG, NEXT. In other
words, when an exception occurs, the error is logged and no other actions are performed in the
current action block.


Note   Do not confuse the question mark (?) used for exception handling with the question mark (?)
used with patterns. Maybe operator provides additional information.
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The following script demonstrates two different keywords to use for exception handling. The first
exception occurs for:


print(x) ? IGNORE;


There is no value assigned to the variable x, so the function causes an exception. Since the keyword
is IGNORE, the current line is skipped and the next line is executed.


The second exception occurs for:


print(y) ? FAIL;


There is no value assigned to the variable y, so the function causes an exception. Since the keyword
is FAIL, the current action block is not completed (and the following print statement is not executed)
and the START rule fails. Whenever the START rule fails, the DEFAULT rule is executed.


ASL Script (exception_do.asl)


START


do {


 print("Hello");


 print(x) ? IGNORE;


 print("OK");


 print(y) ? FAIL;


 print(“Here I am”);


}


DEFAULT 


do {


 print("Default rule");


 stop();


}


Input:


none


Output:


$ sm_adapter exception_do.asl


Hello


OK


Default rule


$ 
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Interfacing with a
Domain Manager 6
This chapter includes the following topics:


n ASL and the MODEL language


n Objects and instances


n Tables, structures and enumerations


n Type conversions between ASL and MODEL


n Domain Manager control


n Events


n Transactions, commit, and abort


n Error handling


n Repositories


n Naming and identity


n Tracing ASL scripts


ASL and the MODEL language
In order to create adapters that interact with a Domain Manager, it is necessary to understand how the
Domain Manager is configured. The adapter creates, deletes, and interacts with instances of objects that
are defined by using the MODEL language.


The MODEL language is an object-oriented language used to construct a correlation model to describe a
managed domain. The language is used to define a set of classes and the attributes, relationships, and
events that are associated with the classes.


Classes describe the objects that are modeled for use in a Domain Manager. Instances are specific
occurrences of a class. For example, a class might describe a human and an instance of the class is
someone named Bill.


Attributes describe a class and, for an instance of the class, include information about its present state.
Examples of attributes include an element’s name and a counter that counts the number of packets
traversing an interface.
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Relationships define how instances are related to other instances. Relationships can be one-to-one, one-
to-many, many-to-one, or many-to-many. When only a single instance can be related to another instance
(or instances), it is a relationship. When multiple instances can be related to another instance (or
instances), it is a relationshipset.


Events describe the failures that can occur for a class, the symptoms that these failures can cause, and
the effect of failures.


Symptoms can be described a follows:


n Local, meaning they are observed in the instance of the class.


n Propagated, meaning they are observed in instances related to the failing instances.


Once classes are specified, the model is loaded and run on a Domain Manager. Instances are
created for each entity that is modeled. Each instance is associated with a class and has values for
its attributes, relationships, and events.


The models stored in a Domain Manager are static. Instances are dynamic and are stored in the
repository, as shown in Domain Manager with a model and repository.


Instances in a Domain Manager consist of a table entry and data. The table entry includes the name
of each instance and its class. Each instance name must be unique. The table of names always
contains an entry for the NULL object.


The data associated with each instance includes properties such as attributes, operations, and the
relationships between instances. The data also includes event information such as problems,
symptoms, and events.


VMware Smart Assurance MODEL Reference Guide provides additional information about MODEL.
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Figure 6‑1.  Domain Manager with a model and repository


Correlation model used for example scripts
All of the ASL script examples used in this chapter interact with a small correlation model. The model
defines two types of objects: cards and ports, as shown in Relationship between cards and ports.


Figure 6‑2.  Relationship between cards and ports


Cards and ports are separate classes. Each class has its own set of attributes and events. An instance of
one class can be related to an instance of another class.


Cards have the following:


n A single attribute, CardDesc. This attribute is a string and has no default value.
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n Two types of events.


n The first type is a problem called Down. When all of a card’s ports are OperationallyDown, the
card is Down.


n The second type is an aggregate called Impaired. If any of the ports associated with a card is
Down or if the card is Down, the card is Impaired.


Ports have the following:


n A single attribute, OperStatus. This attribute has a special data type that limits the values of the
attribute to TESTING, UP, and DOWN. DOWN is the default value.


n Two types of events.


n The first type is a problem called Down. A port is Down when it is OperationallyDown.


n A second type is a symptomatic event called OperationallyDown. When the port’s OperStatus
attribute is set to DOWN, it causes the OperationallyDown event.


In Events that affect ports and their related card, the port’s attribute OperStatus is equal to
DOWN. The attribute’s value causes the event OperationallyDown, which, in turn, causes the
problem Down. Since the port participates in a PartOf relationship with the card, the card is also
affected. The port has the problem Down and, as a result, the card has the compound event
(aggregate), Impaired. The card is probably not down, because only one port (not all ports) is
experiencing a problem.


Figure 6‑3.  Events that affect ports and their related card


The section Appendix C, “Card-Port MODEL Code,” describes the MODEL language code for this
example. Diagram of the card and port model is a diagram of this card and port model.


VMware Smart Assurance ASL Reference Guide


VMware, Inc.  88







Figure 6‑4.  Diagram of the card and port model


Objects and instances
This section discusses how to create, delete and manipulate objects and instances.
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Creating objects
The create() function creates an instance of a class or an instance with an object handle. The syntax is
one of the following:


n create(<classname>, <objectname>);


n create(<objhandle>);


If the object being created already exists, the create() function returns a reference to that object or an
error if the object exists and belongs to different class.


If you specify an object handle (objhandle) and the object does not exist, the create() function creates
the object and the object handle.


You can assign the result of the function to a variable (for example, objRef). This defines an object
handle for the object.


objRef = create(<classname>, <objectname>);


The following script example loads instances of ports and cards. The name of the Domain Manager
that contains the model is JS1.


ASL Script (create_obj.asl):


START {


 CARD rep(PORT)


}


CARD {


 "CARD:" cardname:word eol


}


do {


 create("Card",cardname);


}


PORT {


 portname:word eol


}


do {


 create("Port",portname);


}


DEFAULT {


 err:{..eol}


}


do {


 print(err." Failed");


}


EOF


do {print("Complete");


}


Input (create_obj.txt):


CARD: CARD0


 PORT00


 PORT01


 PORT02
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 PORT03


CARD: CARD1


 PORT10


 PORT11


 PORT12


CARD: CARD2


 PORT20


 PORT21


 PORT22


 PORT23


 PORT24


 PORT25


Output:


$ sm_adapter --server=JS1 --file=create_obj.txt create_obj.asl


Complete


$ 


Listing instances
The getInstances() function returns a list of object names for the given class, but does not return object
handles. The syntax is as follows:


         <listname> = getInstances(<classname>);


The following script example retrieves the names of all instances of the class “Card” and stores them in a
list. The names stored in the list cannot be used by ASL to reference objects.


ASL Script (get_obj.asl):


START {


 ..eol


}


do {


 x = getInstances("Card");


 print(x);


}


Input:


none


Output:


$ sm_adapter --server=JS1 get_obj.asl


{ CARD0, CARD1, CARD2 }


$


Creating handles for existing objects
The object() function returns an object handle for existing objects. An object handle is a distinguished
data type in ASL that represents a model class name and an object name. The syntax is one of the
following:


n <objectRef> = object([<classname>,] <objectname>);


The name of the instance must be unique, therefore, the class name is optional.
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n <objectRef> = object(<objhandle>);


There are three ways to obtain a handle for an existing object:


n If you specify a class name and an object name, then the object() function returns the object handle
for the specified object. ASL stores that information as <class>::<name>.


n If you specify an object handle (objhandle), then the object() function returns the object handle
unchanged.


n If you specify an object name only, then the object() function returns the handle object and assumes
the object name and the class name, MR_Object.


You can also create an object handle for future use for an object that does not exist.


For example:


objref = object();


The following script retrieves the names of all instances of the class “Card” and stores them in a list.
A foreach loop cycles through the list and adds each object, including its class, to a different list. The
script prints both lists.


The lists demonstrate the difference between the getInstances() function and the object() function.
The getInstances() function returns only the name of the object. The object() function returns the
object handle for the object and ASL stores that information as <class>::<name>. The section Listing
instances describes the getInstances() function.


ASL Script (handle_obj.asl):


y = list();


START {


 ..eol


}


do {


 x = getInstances("Card");


 print(x);


 foreach mem (x)


  {y += object("Card",mem);


  }


 print(y);


}


Input:


none


Output:


$ sm_adapter --server=JS1 handle_obj.asl


{ CARD0, CARD1, CARD2 }


{ Card::CARD0, Card::CARD1, Card::CARD2 }
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Attributes, relationships, and operations of objects
The attributes, relationships, and operations of an object are its properties. ASL assigns values to
properties by using the following syntax:


         <objectRef>-><property> = <value>;


The <objectRef> is the object handle for the object. You assign the object handle by using the create() or
object() functions or through a relationship.


The following script loads the names of all instances of the classes “Card” and “Port” into a
Domain Manager. The datafile contains a card name followed by the ports associated with the card. As
this script loads cards and ports, it creates a relationship between a card and its ports.


Relationships between objects in MODEL are paired. It is not necessary to define both relationships.
Define one relationship. Its converse is defined by default.


ASL Script (properties_obj.asl):


START {


 CARD rep(PORT)


}


CARD {


 "CARD:" cardname:word eol


}


do {


 cardObj = create("Card",cardname);


}


PORT {


 portname:word eol


 }


do {


 portObj = create("Port",portname);


 cardObj->ComposedOf += portObj;


 print(portObj." ".cardObj);


}


Input (create_obj.asl):


CARD: CARD0


 PORT00


 PORT01


 PORT02


 PORT03


CARD: CARD1


 PORT10


 PORT11


 PORT12


CARD: CARD2


 PORT20


 PORT21


 PORT22


 PORT23


 PORT24


 PORT25
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Output:


$ sm_adapter --server=JS1 --file=create_obj.txt properties_obj.asl


Port::PORT00 Card::CARD0


Port::PORT01 Card::CARD0


Port::PORT02 Card::CARD0


Port::PORT03 Card::CARD0


Port::PORT10 Card::CARD1


Port::PORT11 Card::CARD1


Port::PORT12 Card::CARD1


Port::PORT20 Card::CARD2


Port::PORT21 Card::CARD2


Port::PORT22 Card::CARD2


Port::PORT23 Card::CARD2


Port::PORT24 Card::CARD2


Port::PORT25 Card::CARD2


$ 


The value stored in <objectRef>-><property >can also be assigned to an ASL variable.


         <variable> = <objectRef>-><property>;


You can refer to properties indirectly. This is a two-step process. First, assign the property to a variable.
Second, the variable can be used in place of the property in conjunction with an indirection operator (->*).


propertyname = “property”;


objRef->*propertyname = "UP";


The syntax objRef->*variable allows you to access an attribute by variable. The following code sample
assigns the attribute name to a variable, then makes a reference to that attribute through the indirection
operator. The output is the creation class name of the given object.


 variable = “CreationClassName”;


 c = objRef->*variable;


 print(c);


When you run this ASL script on a router object, the output is “Router”.


Deleting objects
The delete() method deletes an instance of a class. This function does not delete objects that are related
to the deleted object. ASL creates an error if the object handle used with the delete() method points to an
object that does not exist. The syntax of the delete() method is:


         <objectRef>->delete();


You can use += or -= operators to add or delete an object from a list of object handles in ASL or from a
relationshipset in MODEL. Modifying relationshipsets provides additional information.
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The following script deletes a card and its related ports. The script contains a default variable that
specifies the card to delete. When the ComposedOf relationship is used, the ASL script creates a list of
port objects to delete. The card is deleted first, followed by its ports. Exception handling causes the script
to stop if the card object does not exist.


ASL Script (delete_obj.asl):


default delthis = "CARDX";


START {


 ..eol


}


do {


 delthisObj = object(delthis);


 relObj = delthisObj->ComposedOf?LOG,STOP;


 x = delthisObj->delete();


 foreach mem (relObj)


  {


  mem->delete();


  }


 print("Deleted ".delthis." and related ports");


}


Input:


none


Output:


$ sm_adapter --server=JS1 -Ddelthis="CARD2" delete_obj.asl


Deleted CARD2 and related ports


$ 


Testing for null objects
The isNull() method tests whether an object handle points to a valid object. If this function returns TRUE,
the object does not exist. The syntax is as follows:


         <objectRef>->isNull();


For example, this script deletes the object PORT25 from the Domain Manager if it exists. The if statement
uses the isNull() function to test if the object exists. An exclamation point is a logical NOT, so that if the
object does exist, the condition is true for the if statement. The output demonstrates the case where the
object exists and is deleted.


ASL Script (isnull_obj.asl):


START {


 ..eol


}


do {


 delthisObj = object("Port","PORT25");


 if (!delthisObj->isNull())


  {


   delthisObj->delete();


     print("Deleted   ".delthisObj);


  }


 else { print(delthisObj." does not exist");}
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}


Input:


none


Output:


$ sm_adapter --server=JS1 isnull_obj.asl


Deleted   Port::PORT25


$ 


Testing relationships
The is() function tests whether an object is a member of a relationship. The syntax is as follows:


is(<objectRef>-><Relationship>,<objectRef2>)


The <relationship> used in the is() function must be a valid relationship for the object or an error occurs. If
<objectRef2> is related to <objectRef> by <Relationship>, the function returns TRUE. Otherwise, the
function returns FALSE.


This script tests objects of the class Port to see if they are related to CARD2. The script gets the list of
ports by using the class Port. When the ports are printed, the class that is printed is MR_Object, which is
the parent class of the Port and Card classes. The MR_Object class appears because a class is not
specified for the object() function.


ASL Script (relation_obj.asl):


START {


 ..eol


}


do {


 cardObj = object("CARD2");


 x = getInstances("Port");


 foreach mem (x)


  {


  portObj = object(mem);


  if (is(cardObj->ComposedOf,portObj))


   {print(portObj." is related to ".cardObj);


   }


  }


}


Input:


none


Output:


$ sm_adapter --server=JS1 relation_obj.asl


MR_Object::PORT20 is related to MR_Object::CARD2


MR_Object::PORT21 is related to MR_Object::CARD2


MR_Object::PORT22 is related to MR_Object::CARD2


MR_Object::PORT23 is related to MR_Object::CARD2


MR_Object::PORT24 is related to MR_Object::CARD2


MR_Object::PORT25 is related to MR_Object::CARD2


$ 
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Modifying relationshipsets
When a model relates many objects to one or more objects, it is a relationshipset. A relationshipset in
MODEL is a list of object handles in ASL. You can manipulate this list by using the list operators
described in List operators


Table 6‑1.  List operators


Syntax Description


objRef->rela_prop += value; Adds a value to a relationshipset.


objRef->rela_prop -= value; Removes a value from a relationshipset.


x->rela_prop = object(""); Clears a single relationship.


x->rela_prop = list(y,z); Adds a list of object handles to a relationshipset.


x->rela_prop=list(); Clears a relationshipset.


Accessing a particular relationship in a relationshipset is a two-step process. First, load relationshipset
into a list in ASL. Then, access a specific element in the list. For example:


x = objRef->rela_prop;


print(x[0]);


Retrieving description texts
There are severaloperations of the class SM_System that can be used to retrieve description texts or
objects. The texts that are retrieved will be in the locale that was set either by the initial connection, or by
the locale set by the most recent call to the setLocale().


If these operations are run outside of the context of a remote session, then the effective locale is
CI_Locale::DEFAULT.


The getClassDescription() operation retrieves the descriptive text associated with the MODEL class
name.


/// get model class description


string getClassDescription(in string className);


The getOpDescription() operation retrieves the descriptive text associated with a MODEL operation.


/// get model operation description


string getOpDescription(in string className, in string opName);
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The getPropDescription() operation retrieves the descriptive text associated with a class property, such as
an attribute.


/// get model property description


string getPropDescription(in string className, in string propName);


The getEventDescription operation retrieves the descriptive text associated with a MODEL event.


/// get model event description


string getEventDescription(in string className, in string eventName);


In this example, the description of the Attr1 attribute in the MyClass class is printed, in Japanese.


sysObj = object("SM_System","SM-System");


setLocale("ja_JP");


foo = sysObj->getPropDescription("MyClass","Attr1");


print(foo);


Tables, structures and enumerations
This section describes how to access, and how to clear the members of a MODEL table. It also describes
how to access and update structures and enumerations.


Accessing tables in MODEL from ASL
Tables in MODEL are represented as lists in ASL. In MODEL, a table of structures is a list of lists in ASL.


To return the structure in the MODEL table given the key (“F”), use the following syntax:


print(x->f[“F”]);


Clearing the members of a table
To clear the members of a MODEL table, use the following syntax:


x->rela_prop=list();


Updating and accessing structure attributes in MODEL
Structures in MODEL are represented as lists in ASL. The number of items in the list in the ASL is equal
to the number of fields in the corresponding structure of the MODEL. The first item in the list will
correspond to the first field defined within the structure, and so on for each subsequent item.
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For example, if the following structure is defined in Example.mdl, the following ASL code, Example.asl,
shows how to reference the structure.


Example.mdl


interface Example_Struct:MR_ManagedObject


{


 struct model_struct


 {


  int  valueType;


  string  Value;


 };


 attribute model_struct asl_list;


};


Example.asl


START


{


 do


 {


  // create an instance, ‘example’, of Example_struct


  example = create (“Example_Struct”, “Example-Struct”);


  // put values into a ‘model_struct’ structure:


  // structure element ‘valueType’ is list element [0]


  // structure element ‘value’ is list element [1]


  struct_value = list();


  struct_value[0] = 1;


  struct_value[1] = “Structure Example”;


  // set the value in the Example_struct instance


  example->asl_list = struct_value;


  // get values from a ‘model_struct’ structure


  accessed_struct = list();


  accessed_struct = example->asl_list;


  // display the retrieved structure elements


  print (accessed_struct);


  stop();


 }


}


The output of the example is the following:


$sm_adapter -M Example Example.asl


{1, Structure Example }


Accessing enumerated data types in MODEL
Enumerated data types are represented as strings in ASL.


The following example shows the syntax to update an enumerated attribute with an enum value of
TESTING:


x->enum_variable = “TESTING”;
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Type conversions between ASL and MODEL
MODEL cannot convert data from one type to another. The types of data available in MODEL are not the
same as the types of data available in ASL. Correspondence between types of data in MODEL and ASL
shows how types of data in MODEL and ASL correspond.


Table 6‑2.  Correspondence between types of data in MODEL and ASL


MODEL ASL


Numeric (any type) Numeric (double)


binary binary


Table List


Relationship Object handle


Relationshipset List of object handles


boolean boolean


string string


External (User-defined) Type string


struct (a structure) List


enum string


Note   There is no MODEL type that corresponds to an ASL table.


Domain Manager control
The following functions allow you to trigger Domain Manager actions from ASL. These actions either
rebuild the correlation model or cause the Domain Manager to correlate events.


consistencyUpdate() function
The consistencyUpdate() function causes the Domain Manager to recompute the correlation rules. This
function always returns, as soon as the request has been registered, with a TRUE value. The actual
recomputation can take some time, and continues on the Domain Manager independently of the adapter.
The syntax is:


consistencyUpdate()


correlate() function
The correlate() function causes the Domain Manager to correlate events. This function always returns, as
soon as the request has been registered, with a TRUE value. The actual correlation computation
continues on the Domain Manager independently of the adapter. The syntax is:


correlate()
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Events
This section describes how to retrieve event information.


getCauses() function
The getCauses() function returns a list of problems that cause an event. The function receives three
arguments: class, instance, and event. The function returns the problems that cause the event based on
the relationships among instances defined in the Domain Manager. The syntax is as follows:


getCauses(<classname>,<instancename>,<eventname>,[<oneHop>])


The <oneHop> parameter is optional. If it is omitted or passed as FALSE, the full list of problems that
explain <eventname>, whether directly or indirectly, is returned. If it is passed as TRUE, only those
problems that directly list <eventname> among the events they explain are returned.


The function returns a list of lists with the format:


{ <classname>,<instancename>,<problemname> },


{ <classname>,<instancename>,<problemname> },


...


getClosure() function
The getClosure() function returns a list of symptoms associated with a problem or aggregation. The
function receives three arguments: class, instance, and event. The function returns the symptoms
associated with the problem or aggregate based on the relationships among instances defined in the
Domain Manager. The syntax is as follows:


getClosure(<classname>,<instancename>,<eventname>,[<oneHop>])


The <oneHop> parameter is optional. If it is omitted or passed as FALSE, the full list of problems that
explain <eventname>, whether directly or indirectly, is returned. If it is passed as TRUE, only those
problems that directly list <eventname> among the events they explain are returned.


The function returns a list of lists with the format:


{ <classname>,<instancename>,<symptomname> },


{ <classname>,<instancename>,<symptomname> }
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getEventClassName() function
The getEventClassName() function returns a string with the name of the ancestor class associated with a
class and an event. The ancestor class is where the event was originally defined. That is, the class in
which the event definition statement, not any refinement, appeared. The syntax is as follows:


getEventClassName(<classname>,<eventname>)


getEventDescription() function
The getEventDescription() function returns a string, defined in MODEL, that describes an event. The
syntax is as follows:


getEventDescription(<classname>,<eventname>);


getEventType() function
The getEventType() function returns a string that classifies an event as a PROBLEM, EVENT,
AGGREGATION, or SYMPTOM. The syntax is as follows:


getEventType(<classname>,<eventname>);


getExplainedBy() function
The getExplainedBy() function is the inverse of the getExplains() function. It returns those problems that
the MODEL developer has listed as explaining this problem. The syntax is as follows:


getExplainedBy(<classname>,<instancename>,<eventname>[,<oneHop>])


The <oneHop> parameter is optional. If it is omitted or passed as FALSE, the full list of problems that
explains <eventname>, whether directly or indirectly, is returned. If it is passed as TRUE, only those
problems that directly list <eventname> among the events that they explain are returned.


The function returns a list of lists with the format:


{ <classname>,<instancename>,<symptomname> },


{ <classname>,<instancename>,<symptomname> }


getExplains() function
MODEL developers can add information to a problem in order to emphasize events that occur because of
a problem. The getExplains() function returns a list of these events. The syntax is as follows:


getExplains(<classname>,<instancename>,<eventname>,[<oneHop>])
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The <oneHop> parameter is optional. If it is omitted or passed as FALSE, the full list of problems that
explains <eventname>, whether directly or indirectly, is returned. If it is passed as TRUE, only those
problems that directly list <eventname> among the events that they explain are returned.


getChildren() function
The getChildren() function provides the list of classes derived from a particular class.


getChildren(<classname>[,recursive])


The recursive parameter is optional. If omitted or false, only the immediate child classes are retrieved. If
true, all children, including those of derived classes are retrieved.


Transactions, commit, and abort
When you modify objects in ASL scripts, the objects change as each modification occurs. Using
transactions, you can commit many changes to the objects in a Domain Manager as a single change or
choose to abort all of them. Use the following syntax to create a transaction:


         <variable> = transaction();


You cannot assign a transaction to a global variable or to a statically scoped variable. After you assign the
transaction to a variable, every change made to an object does not affect the object until you commit the
transaction. If the you abort the transaction, any changes made will not affect the object. Use the following
syntax to commit a transaction:


         <variable>->commit()


Use the following syntax to abort a transaction:


         <variable>->abort()


The changes made with a transaction are not visible outside of the ASL script until you commit the
changes. Within a transaction, the same ASL script can see the proposed changes. Transactions also
can control how other applications see objects before changes are committed or aborted by adding a
single keyword. The syntax of a transaction with a keyword is:


         <variable> = transaction([WRITE_LOCK|READ_LOCK|NO_LOCK]);


A keyword can be any one of those listed in Transaction keywords.
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Table 6‑3.  Transaction keywords


Keyword Description


WRITE_LOCK While the transaction is open, no other process can modify or access information in the
repository.


READ_LOCK Currently behaves as WRITE_LOCK.


NO_LOCK This is the default behavior. No locks exist until the ASL commits the transaction.


You can nest transactions. When you nest a transaction, you must commit or abort the nested transaction
before you commit or abort the previous transaction.


ASL aborts any open transactions when the START rule completes.


Note   A maximum of 16 transactions may be open concurrently.


The following script deletes a card and its related ports. The script contains a default variable that
specifies the card to delete. Using the ComposedOf relationship, the ASL script creates a list of port
objects to delete. The script deletes the card and its related ports at the same time through a transaction.


ASL Script (deltrans_obj.asl):


default delthis = "CARDX";


START


do {


 delthisObj = object(delthis);


 relObj = delthisObj->ComposedOf?LOG,STOP;


 deltrans=transaction();


  x = delthisObj->delete();


  foreach mem (relObj)


   {


   mem->delete();


   }


 deltrans->commit();


 print("Deleted ".delthis." and related ports");


 stop();


}


Input:


none


Output:


$ sm_adapter --server=JS1 -Ddelthis="CARD2" deltrans_obj.asl


Deleted CARD2 and related ports


$ 


Error handling
This section describes functions that allow you to determine whether an error occurred, to get a
description of the error and to reset the error state.
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feError() function
Invoke the feError() function to determine if the front end has reported a failure to read data.


The function returns a Boolean value, where TRUE indicates an error occurred and FALSE indicates no
error occurred. If an error occurred, invoke feErrorMsg() for a description of the error.


feErrorMsg() function
Invoke the feErrorMsg() function to get a description of the error indicated by the feError() function.
feError() returns TRUE.


This function returns a string that describes the error. If no error condition exists, an empty string is
returned.


feErrorReset() function
The feErrorReset() function is used with the feError() and feErrorMsg() functions to reset the error state.
There is no return value for this function.


Repositories


self->
Directs functions that interact with the repository to use the adapter’s repository and not the
Domain Manager’s. Used in conjunction with adding objects to the adapter’s repository.


Naming and identity
This section describes functions used to retrieve names and identity of the rule which is running, what
Domain Manager the script is running o,n and the thread ID of the adapter.


getRuleFileName() function
The getRuleFileName() function returns the filename of the currently executing rule file as an argument.


Usage:


getRuleFileName ([<fullname>]);


where <fullname> is a string containing the complete path-qualified filename.


getServerName() function
The getServerName() function returns a string, which is the name of the Domain Manager associated with
adapter that is invoking the ASL script.
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thread() function
The thread() function returns the operating system thread ID that is associated with the adapter that is
invoking the ASL script.


Tracing ASL scripts
The ASL_Trace Model object is used to start and stop a trace from dmctl, the Java API, bootstrap.conf,
and ASL. The ASL_Trace model object contains three methods.


n start() method starts the tracing


n stop() method stops the tracing


n isActive() method checks to see if a trace is in progress


interface ASL_Trace


start()


stop()


isActive() 


The trace contains timestamps for:


n Entry into ASL scripts


n Exit to ASL scripts


n Exit from ASL scripts


For example, to use the tracing capability from dmctl:


a Create an instance of the Model object. An instance named ASL-Trace is customary.


dmctl –s serverName create ASL_Trace::ASL-Trace


b Invoke start/stop/isActive as needed.


dmctl –s serverName invoke ASL_Trace::ASL-Trace start


dmctl –s serverName invoke ASL_Trace::ASL-Trace stop


The output will appear similar to the following:


1 2009/02/26 13:26:15.175714600 1 000:00:00.000000000 NoteASLThread ThreadName=adapter 


1 2009/02/26 13:26:15.175714600 2 000:00:00.000000000 NoteLayout Record prefix fields: 


1 2009/02/26 13:26:15.175714600 3 000:00:00.000000000 NoteLayout Thread id, Date, Time, Seq, 


1 2009/02/26 13:26:15.175714600 4 000:00:00.000000000 NoteLayout Delta since prior record in 


thread, 


1 2009/02/26 13:26:15.175714600 5 000:00:00.000000000 NoteLayout RecordType. 


1 2009/02/26 13:26:15.175714600 6 000:00:00.000000000 NoteLayout Trace records continue with: 


1 2009/02/26 13:26:15.175714600 7 000:00:00.000000000 NoteLayout Entry|Exit|StopExit|ThrowExit|


ThrowExit1|ThrowExit2, 


1 2009/02/26 13:26:15.175714600 8 000:00:00.000000000 NoteLayout Constructor|Destructor|
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Initialize|Multiplex, 


1 2009/02/26 13:26:15.175714600 9 000:00:00.000000000 NoteLayout this for ASL_Parser, Nest 


depth, Rule file name. 


1 2009/02/26 13:26:15.175714600 10 000:00:00.000000000 StartTrace 


1 2009/02/26 13:26:15.186840900 11 000:00:00.011126300 NoteDriver CreationClassName=GA_Driver 


Name=ASL-Trace1-Driver 


1 2009/02/26 13:26:15.187012400 12 000:00:00.000171500 Trace Entry Constructor 


00000001002CA120 0 tasl_trace1.asl 


1 2009/02/26 13:26:15.187184600 13 000:00:00.000172200 Trace Exit Constructor 00000001002CA120 


0 tasl_trace1.asl 


1 2009/02/26 13:26:15.187535500 14 000:00:00.000350900 Trace Entry Initialize 00000001002CA120 


0 tasl_trace1.asl 


1 2009/02/26 13:26:15.187703000 15 000:00:00.000167500 Trace Exit Initialize 00000001002CA120 


0 tasl_trace1.asl 


1 2009/02/26 13:26:15.188291200 16 000:00:00.000588200 Trace Entry Destructor 00000001002CA120 


0 tasl_trace1.asl 


1 2009/02/26 13:26:15.188457500 17 000:00:00.000166300 Trace Exit Destructor 00000001002CA120 


0 tasl_trace1.asl 


1 2009/02/26 13:26:45.193438300 18 000:00:30.004980800 StopTrace 


The log file is written to BASEDIR/smarts/local/logs as <serverName>.ASL_Trace.log.


n If the BASEDIR/smarts/local/logs directory cannot be found, the log is written to the current working
directory.


n If the <serverName> is not available, the file name becomes ASL_Trace.log_<pid>.


The trace is written chronologically. Thus, traffic for several threads may be intermingled. A sort of the
first 4 fields will produce traces for individual threads.


The record layout is noted when the trace is started. The prolog of each record is fixed. After that,
each record contains a record type to provide summary program processing.


The ‘this’ pointer is logged, and can be used when tying the ASL trace to pstack samples.


Startup is automatic if the SM_ASL_TRACE environment variable is set to anything that does not
lower case to 0, false, no, or off.
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Running Adapters 7
This chapter includes the following topics:


n The sm_adapter command


n Front end


n Rule set


n Back end


n Tracing operations


n Stopping adapters


The sm_adapter command
The sm_adapter command starts ASL scripts. To run the command, you must specify the ASL rules file to
run as well as choosing how the front end and back end of the adapter operate. The command syntax is:


sm_adapter [options...] [<rule set>]


The <rule set> is the ASL script that the adapter follows when it receives information.


The options control which Domain Manager and Broker the adapter connects to, and it also configures
how the adapter runs. An adapter can run by using a variety of front end and back end components. The
options are described in The sm_adapter command.


The file, sm_adapter is found in BASEDIR/smarts/bin.


Basic options
sm_adapter basic options shows the options which enable you to name the adapter and control which
Broker, MODEL library, and port the adapter uses.


Table 7‑1.  sm_adapter basic options


Option Description


--broker=<location> Alternate Broker location as host:port. Also -b <location>.


--model=<model> Name of MODEL library to load. Also -M <model>.
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Table 7‑1.  sm_adapter basic options (Continued)


Option Description


--name=<name> Start a server registered under <name>. Also -n <name>.


--port=<xxxx> Alternate registration port. Use with --name.


--timeout=<secs> Set the timeout for server interaction. The timeout applies to the back end connection
except when using the subscriber front end, in which case it applies to the front end. The
argument is in seconds, and can be a decimal value. If the --timeout option appears with
no value, 600 seconds is used. By default, there is no timeout.


--wait Wait for initial driver to complete.


Other sm_adapter options describes additional sm_adapter options.


Table 7‑2.  Other sm_adapter options


Option Description


--accept=<host-list> Accept connections only from hosts on host-list, a comma-separated list of hostnames and IP
addresses. You can also specify any instead of host-list to allow any host to connect. Default:
--accept=any.


--daemon Run process as a daemon.


--errlevel=<level> Specify the minimum level at which error events are written to the standard error output.
Possible values include: none, emergency, alert, fatal, critical, error, warning, notice,
informational, debug. The default is warning. (Note that fatal is equivalent to emergency,
alert, or critical.)


--help Print help and exit.


--loglevel=<level> Specify the minimum level at which event messages are written to the system logging facility.
Possible values include: none, emergency, alert, fatal, critical, error, warning, notice,
informational, debug. The default is error. (Note that fatal is equivalent to emergency, alert, or
critical.)


--logname=<name> Specify the name used to identify the SDK program in the system log. On UNIX systems, the
default is the program name.


--output[=<file>] Messages generated from internal logging calls are directed to a log file. Log files are written
to the BASEDIR/smarts/logs directory. If <file> is not specified, the value of --logname is
used.


If a log file with specified name already exists, it is moved to a backup file,
BASEDIR/smarts/local/logs/<file>.bak. If the backup file already exists, it is deleted.


--tracelevel=<level> Specify the minimum level at which a process stack trace is written to the standard error
output. Possible values include: none, emergency, alert, fatal, critical, error, warning, notice,
informational, debug. The default is fatal. (Note that fatal is equivalent to emergency, alert, or
critical.)


--version Print program version and exit.
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Front end
The front end of the adapter is responsible for reading data from an input source and formatting it for
processing by an ASL rule set. The adapter can run with one of the following front ends:


n File—Reads data from an ASCII file.


n File tail—Is designed to read the log files of long-running Domain Managers.Like the file front end, the
file tail front end reads data from an ASCII file. But instead of opening the file, reading the contents
and closing the file, this front end opens the file, skips to its end and waits for additional lines to be
written to the file.


n Program—Reads data from the output of a command pipeline.


n Subscribe—Is used in outflow adapters. This front end connects to a Domain Manager and issues a
set of subscription requests. Subsequent notifications received from the Domain Manager are
formatted and delivered to the ASL rule set. There are many configuration options available with this
front end. The options include selecting the subscription set to performing sophisticated smoothing
and filtering of events.


Each front end is described in a subsequent subsection. A list of options is provided in sm_adapter
front end options. Examples of the sm_adapter command with front ends are provided in Sample
front end invocations.


File front end
The file front end reads data from an ASCII file. The front end opens and reads the file, feeds its contents
to the rule set, then closes the file and terminates. This front end performs two special formatting
translations:


n End-of-line translation


n Field-separator translation


The --file option of the sm_adapter command invokes this front end.


End-of-line translation
One of the more troublesome aspects of using a cross-platform file adapter is dealing with the end-of-line
problem. On UNIX, a single \n represents an end-of-line. The file front end translates either a single \n or
the \r\n sequence to an ASL end-of-line marker (eol), which eliminates this problem.


Consider a file with one line, “hello world":


h  e  l  l  o    w  o  r  l  d  \r  \n


Whereas, on a UNIX system, this file contains the characters:


h  e  l  l  o    w  o  r  l  d  \n
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Using the file front end on either system feeds the following input stream into the rule set:


h  e  l  l  o   w  o  r  l  d  eol


Field-separator translation
Many input files are structured as a series of records, where each record is represented as one line in the
file. Each record (line) may be further separated into fields. The fields are normally delimited by a special
character, such as the TAB character or perhaps the colon (:) character.


To simplify the parsing of such files, you can specify a field-separator character with the --field-separator
option of the sm_adapter command. Each occurrence of this character in the input file is replaced with an
ASL field-separator marker (fs). By default, ASL does not translate characters to field-separator markers.


Consider the following line taken from the UNIX /etc/passwd file:


root:*:0:0:Admin:/:/bin/sh


Reading this line and using the file front end with the field-separator character set to the colon (:), feeds
the following input stream into the rule set:


r o o t fs * fs 0 fs 0 fs A d m i n fs/fs / b i n / s h eol


This line can then be parsed with an ASL pattern:


word fs word fs integer fs integer fs word fs word fs word eol


The character replaced with an fs can never be seen by the rule set of the ASL script. The following
pattern does not match the input stream:


word “:” word “:” integer fs integer fs word fs word fs word eol


File tail front end
The file tail front endis designed to read the log files of long-running Domain Managers. All of the
characteristics of the file front end are present in the file tail front end. Unlike the file front end, however,
the file tail front end does not simply open the file, read its contents, and then terminate. Rather it opens
the file, seeks to the end of the file, and waits for additional lines to be written to the end of the file. As
new lines appear, the front end feeds them to the rule set. The --tail option of the sm_adapter command
invokes this front end.


Rotating Domain Manager log files
One of the difficulties in parsing Domain Manager log files is dealing with log file rotation. By their nature,
Domain Manager log files grow over time. Most system administrators set up periodic jobs to remove or
rename the log files to avoid consuming too much disk space. The file tail front end periodically checks if
the file has been rotated. If so, the file is closed and reopened. The file is then read from the beginning.
All entries in the newly opened file are fed into the rule set.
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Program front end
The program front end reads data from the output of a command pipeline. Like the file front end, the
program front end performs end-of-line and field-separator translations. This front end, for example, can
parse the results of a SQL query issued by using a command-line SQL program.


The --program option of the sm_adapter command invokes the program front end. This command string is
executed by using the native command interpreter for the system. On UNIX, this is normally /bin/sh.
When the front end object is created, the command is executed and a pipeline is created between the
command and the front end. This pipeline combines both the stdout and stderr streams from the
command into a single stream.


Once the command exits (or once it closes stderr and stdout) the front end terminates.


Subscriber front end
The subscriber front end subscribes to a Domain Manager and feeds the subsequent notifications from
the Domain Manager to the rule set. Subscriptions can be used for events, topology changes, and
attribute changes.


Notification formatting
The Domain Manager generates a number of different kinds of notifications. Each notification received
from the Domain Manager is streamed as a single record with an eol marker that identifies the end of the
notification. Individual fields within each notification, for example the class name or instance name in an
event notification, are separated by fsmarkers. The first field of all notifications is an integer timestamp in
the standard UNIX format which indicates when the Domain Manager originally created the notification.
The remaining fields of the notification record differ depending on the type of record.


Event notification records
Event notifications are received from the Domain Manager when the status of an event changes. In order
to receive these notifications, you must subscribe to events in the Domain Manager.


The ASL format of the notification record is:


 timestamp:    integer      fs


               “NOTIFY”     fs


 class:        word         fs


 instance:     word         fs


 event:        word         fs


 certainty:    float        fs


                            eol


Normally, the Domain Manager sends the following:


n Single notification message when an event becomes active
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n Single clear message when the event is no longer active.


If an event corresponds to a root-cause problem, it is possible that the certainty of the diagnosis will
change over time. If the diagnosis certainty changes, the Domain Manager generates another
notification. Notifications of this type are streamed in a slightly different manner:


timestamp:    integer            fs


              “CERTAINTY_CHANGE” fs


class:        word               fs


instance:     word               fs


event:        word               fs


certainty:    float              fs


                                 eol


The subscriber front end normally discards certainty changes that are less than 1% (0.01). This
behavior can be disabled.


When the Domain Manager clears an event, the ASL format of the notification record is:


timestamp:    integer      fs


              “CLEAR”      fs


class:        word         fs


instance:     word         fs


event:        word         fs


                           eol


Object create record
When a new object is created in the Domain Manager’s repository, the Domain Manager sends an object
create message. The ASL format of an object create record is:


timestamp:    integer       fs


              “CREATE”      fs


class:        word          fs


instance:     word          fs


                            eol


Object delete record
When an object is deleted from the Domain Manager’s repository, the Domain Manager sends an object
delete message. The ASL format of an object delete record is:


timestamp:    integer       fs


              “DELETE”      fs


class:        word          fs


instance:     word          fs


                            eol
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Class load record
When a new class is created in the Domain Manager’s repository, the Domain Manager sends a class
load message. Classes are created when new MODEL-generated libraries are loaded. The ASL format of
a class load record is:


timestamp:    integer           fs


              “CLASS_LOAD”      fs


class:        word              fs


                                eol


Class unload record
When a class is deleted from the Domain Manager’s repository, the Domain Manager sends a class
unload message. Deleting of classes is not currently supported in the Domain Manager so this message
is not used.


timestamp:    integer           fs


              “CLASS_UNLOAD”    fs


class:        word              fs


                                eol


Relation change record
When a relationship changes between objects, the Domain Manager sends a relation change message.
The ASL format of a relation change record is:


timestamp:    integer           fs


              “RELATION_CHANGE” fs


class:        word              fs


instance:     word              fs


relation:     word              fs


                                eol


Property change record
When an object’s property changes, the Domain Manager sends a property change message. The ASL
format of a property change record is:


              “ATTR_CHANGE”     fs


class:        word              fs


instance:     word              fs


attribute:    word              fs


value:        word              fs


                                eol
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Subscriber front end with a restartable Domain Manager
If the Domain Manager that is being sent subscriptions by the subscriber front end is a restartable
Domain Manager, two additional messages are sent to the rule set:


n One when a connection is made to the Domain Manager.


n The other when the connection to the Domain Manager is lost.


Domain Manager connect record
When the connection to the Domain Manager is established, the Domain Manager sends a
Domain Manager connect record. These records are sent to the rule set even if the front end issues no
subscriptions. In fact, it is sometimes useful to use a subscriber front end with no subscriptions just for the
purpose of being notified when the Domain Manager terminates and restarts. The ASL format of the
Domain Manager connect record is:


timestamp:    integer           fs


              “CONNECT”         fs


server:       word              fs


                                eol


Domain Manager disconnect record
When the connection to the Domain Manager is lost, the Domain Manager sends a Domain Manager
disconnect record. Like the Domain Manager connect record, these records are generated even if no
subscriptions to the Domain Manager are issued. The ASL format of the Domain Manager disconnect
message is:


timestamp:    integer           fs


              “DISCONNECT”      fs


server:       word              fs


                                eol


Sample front end invocations
This section provides sample front end invocations, as described in Sample front end invocations.


Table 7‑3.  Sample front end invocations


Type of front end Invocation


File front end $ sm_adapter --file=/etc/passwd --field-separator=: passwd.asl


File tail front end $ sm_adapter --tail=/var/adm/messages syslog.asl
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Table 7‑3.  Sample front end invocations (Continued)


Type of front end Invocation


Program front end $ sm_adapter --program=”/bin/ps -ef” ps.asl


Subscriber front end $ sm_adapter --subscribe=”.*::.*::.*” --server=myDomainManager notify.asl


The value of the subscribe parameter is parsed into class, instance, and event expressions. The “::”
string separates the individual patterns. Subscriptions are sent to the Domain Manager specified
with the --server option. In addition to the event patterns, the subscribe option also allows you to
qualify the types of events included in the subscription set. A qualification has the form:


--subscribe=”.*::.*::.*/paev”


The trailing /paev qualifies the subscription to include problems (p), aggregates (a), symptoms (e) in
the subscription set, and verbose mode (v) which turns on subscription control messages. You can
specify any combination of the letters p, a, e, and v. If no qualifier is specified, the default is
problems only (/p).


To use the subscription front end in conjunction with a restartable Domain Manager, use the --
rserver option in place of the --server option.


sm_adapter front end options
sm_adapter front end options describes the available sm_adapter front end options.


Table 7‑4.  sm_adapter front end options


Option Description


--file=<path> Read input from a file. Also -f <path>.


--tail=<path> Read input by tailing a file. Also -t <path>.


--program=<cmd> Read input from a command pipeline. Also -p <cmd>.


--field-separator=C Translate 'C' to the field-separator (FS) marker. Valid only in conjunction with --file, --tail or --
program. Also -F <C>.


--subscribe=<sub> Use the subscriber front end. Subscriptions are sent to the server specified with the --server
option. The <sub> parameter is the subscription request.
n If <sub> is 'topology', then a subscription for topology changes is requested.
n If <sub> is of the form '<name>/n', then a subscription to NL <name> is requested.


Note   Only one NL subscription may be specified.


n If <sub> is of the form C::I::E[/paev], 'C', 'I', 'E' are regexp patterns representing the classes,
instances, and events to which to subscribe. The letters following a slash (/) are subscription
qualifiers: 'p' means subscribe to problems; 'a' means subscribe to aggregates (impacts); and
'e' means subscribe to events. If none of these are present, 'p' is assumed. 'v' means run in
verbose mode, which turns on subscription control messages.


Otherwise, <sub> is a profile name in which the profile specifies what subscriptions are to be
requested. A profile name may be optionally followed by the /v qualifier.


Multiple --subscribe options can be specified.
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Table 7‑4.  sm_adapter front end options (Continued)


Option Description


--smoothing=<num> Event smoothing interval. This parameter is used by the subscriber front end to smooth event
notifications (and clears) received from the server. Only events (or clears) that stay active (or
cleared) for <num> seconds are fed into the input stream. The <num> must be a non-negative
integer. The default value is 0 which disables smoothing.


--ignoreOld Ignore old notifications. This parameter is used by the subscriber front end. Notifications for
events that were active before this adapter connected are not fed to the input stream.


Rule set
The rule set parameter is used to specify the ASL parse rules that are applied to the input data. The
name of the file that contains the ASL parse rules is added at the end of the sm_adapter command. For
example:


sm_adapter [<options>] myRules.asl


sm_adapter rule set options
The sm_adapter rule set options are listed in sm_adapter rule set options.


Table 7‑5.  sm_adapter rule set options


Option Description


--D<var>=<value> Override the default value for a rule set variable.


--verify Validate rules only.


Back end
The back end of an adapter represents a Domain Manager. Object manipulations (for example, setting an
attribute) within an ASL rule set are translated into VMware Smart Assurance Remote API requests. The
Domain Manager to which the API transmits the request is determined by the back end. Two back ends
are available:


n Remote Domain Manager —Specifies a remote Domain Manager.


n Restart-enabled Domain Manager — Specifies a remote Domain Manager, but the adapter handles
automatic reconnects if the connection to the Domain Manager is broken.


The --server option to the sm_adapter command creates a remote Domain Manager back end.


% sm_adapter --server=myServer rules.asl


The restart-enabled Domain Manager back end is a specialization of the remote Domain Manager
that adds automatic reconnect capabilities. When using a normal remote Domain Manager back end,
the adapter terminates if one of the following occurs:


n Domain Manager is unavailable when the adapter starts.
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n Domain Manager disconnects while the adapater is running.


The restart-enabled Domain Manager should be used in cases where you want the adapter to remain
active when the Domain Manager is unavailable. The back end of a restart-enabled Domain Manager
periodically attempts to reconnect to the Domain Manager. Once it succeeds, the connection is
restored and the adapter continues to function.


The restart-enabled back end is most useful in conjunction with the subscriber front end. The section 
Subscriber front end with a restartable Domain Manager provides additional information about using
the restart-enabled Domain Manager with the subscriber front end.


Behavior of the restart-enabled Domain Manager
The restart-enabled Domain Manager provides a way to create an adapter that is robust in the face of
communication problems with the Domain Manager.


Normally, errors encountered during the transmission of an operation to the Domain Manager result in an
exception to the rule set. This exception normally terminates the adapter. With a restart-enabled
Domain Manager, however, the exception is treated as a non-fatal error and it does not automatically
terminate the parser. Once the Domain Manager connection is re-established, operations no longer result
in exceptions but begin working properly again.


Using the restart-enabled Domain Manager from the command line
You can use the --rserver option of the sm_adapter command to create a restart-enabled
Domain Manager back end.


$ sm_adapter --rserver=<Domain Manager_name> rules.asl


Back end options
sm_adapter back end options describes the available back end options.


Table 7‑6.  sm_adapter back end options


Option Description


--server=self Connect driver to local repository, the default.


--server=null Do not connect to any server. Useful for debugging offline in combination with --
traceServer.


--server=<name> Connect driver to remote server. Also -s <name>.


--rserver=<name> Auto-reconnect driver to remote server. Also -S <name>.


--description=<desc> Description of this adapter, sent to remote server.


--mcast=<name> Connect driver to a local subscription server.


Tracing operations


VMware Smart Assurance ASL Reference Guide


VMware, Inc.  118







Rule set
When the adapter starts, rules contained in the rule set file are read in and compiled into an internal form.
The compilation enables the adapter to parse the input data efficiently. If the trace attribute of the rule set
object is set to TRUE, the adapter dumps a trace of the compiled rules after it has converted them to the
internal form. This option is used for debugging purposes only.


Specify the --traceRules option with the sm_adapter command to set the trace attribute of the rule set
object to TRUE.


Back end
All back ends of an adapter can trace all API operations transmitted to the Domain Manager. This is a
very useful option for debugging a rule set. If you are using the sm_adapter command, specify the --
traceServer option to enable back end tracing. The trace output includes the following:


n Timestamp


n Name of the Domain Manager


n Description of the operation sent to the Domain Manager


If the operation returns a value (for instance, if you are retrieving an object property), the retrieved
value is also printed.


For example, when the following ASL commands,


obj = object(“MyClass”,“MyObject”);


obj->attr = TRUE;


are executed in a rule set that is connected to a Domain Manager with the name, ServerName, the
commands result in the following trace output:


2-Feb-2009 14:26:11 ServerName: put(MyClass,MyObject,attr,TRUE)


Trace options
Trace options describes the available trace options.


Table 7‑7.  Trace options


Option Description


--traceRules Trace rule compilation.


--traceServer Trace interactions with the back end server.


--traceParse Trace rule matching.


--trace Enable all tracing. Also -d.
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Stopping adapters
Adapters that do not stop on their own can be stopped by using SIGTERM for UNIX systems.


You can create ASL scripts that include a stop() or quit() function. stop() function and quit() function
provide additional information for the stop() and quit() functions, respectively.
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ASL Reference 8
This chapter includes the following topics:


n Syntax


n Reserved words


Syntax
ASL syntax lists available ASL syntax.


Table 8‑1.  ASL syntax


Syntax Description


!= Indicates not equal to.


+ Indicates an addition operator.


- Indicates a subtraction operator.


* Indicates a multiplication operator.


/ Indicates a division operator.


% Indicates a modulus operator. Calculates by using integer
or floating-point numbers.


&& Indicates a logical AND.


. (Period) pattern matching. Indicates that the next pattern
must be matched immediately.


. (Period)action block. Concatenates two strings.


.. (Double period) Used to indicate an undefined string of
characters up to the next pattern match.


|| Indicates a logical OR.


+= Adds an object to a relationship.


? Pattern matching. Matches one or zero times.


? Action block. Exception handling operator.


< Indicates less than.


<= Indicates less than or equal to.


-= Removes an object from relationship.
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Table 8‑1.  ASL syntax (Continued)


Syntax Description


== Indicates equal to.


> Indicates greater than.


-> Used to reference properties of an object.


->* Used to reference properties of an object by using a
variable for the property name.


>= Indicates greater than or equal to.


any(<string>) Represents any character in its argument string.


boolean(<value>) Converts the argument to a TRUE or FALSE. All nonzero
numbers are TRUE. Any other type is converted to an
uppercase string and compared to TRUE or FALSE. If it
does not match either, it returns an error.


break Used to break out of a loop.


case = [exact]|[ignore] A variable that determines whether string matches are
case-sensitive (default is exact) or not.


char Represents a character, not an eol or fs.


consistencyUpdate() Causes the Domain Manager to recompute the correlation
rules.


continue Used to move to start of loop and start with the next
element.


correlate() Causes the Domain Manager to correlate events.


create(<classname>,<objectname>) Creates an object.


create(<objhandle>) Creates an object handle which represents an instance.


default Defines the value to use for a variable if the variable is not
assigned a value.


defined(<variable>) Determines whether a variable is defined.


delete() Deletes an object on the Domain Manager.


delim Defines delimiters.


do Marks the beginning of an action block.


else {<statements>} Alternative actions when an if statement fails.


eol Represents the end of a line of data.


exact Used in conjunction with “case” to make all string matches
case-sensitive.


FAIL Keyword for exception handling. Causes a rule to fail when
an exception occurs.


FALSE A Boolean false.


feError() Returns a Boolean value. TRUE if the front end has
reported a failure to read data.
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Table 8‑1.  ASL syntax (Continued)


Syntax Description


feErrorMsg() If the feError() function is true, the feErrorMsg() function
returns a string that describes the error.


feErrorReset() Resets the error state so that there is no error.


filter Marks the beginning of a filter block.


float Represents a floating number, including an optional minus
sign.


foreach <variable> (<list_or_table>) {<statements>} Iterates over the values of a list or the index of a table.
Variable is assigned successive values of the list of table.


fs Represents a field-separator.


getCauses(<classname>,<objectname>,
<eventname>[,<oneHop>])


Returns a list of problems that can cause that event. Each
element of the list is a list that contains classname,
objectname, and eventname of the root cause that causes
that event.


getChildren(<classname>[,recursive]) Retrieves the list of classes derived from the specified
class.


The recursive parameter is optional.
n If omitted or false, only the immediate child classes are


retrieved.
n If true, all children, including those of derived classes


are retrieved.


getClosure(<classname>,<objectname>,<eventname>[,<oneHop>
])


Given a root cause or aggregation (compound), returns a
list of symptoms for that root cause. Returned list is similar
to the getCauses() function.


getEventClassName(<classname>, <eventname>) Returns a string with the name of the ancestor class
associated with a class and an event.


getEventDescription(<classname>, <eventname> ) Returns a description for an event. The description string is
defined in MODEL.


getEventType(<classname>, <eventname>) Returns a string that indicates the type of the event
(PROBLEM, EVENT, AGGREGATE).


getExplainedBy(<classname>,
<instancename>,<eventname>[,<oneHop>])


Returns those problems which the MODEL developer has
listed as explaining this problem.


getExplains(<classname>,
<objectname>,<eventname>[,<oneHop>])


Given a root cause, returns the alternate closure as defined
in MODEL.


getInstances(<classname>) Returns a list of strings (not object handles) that are the
names of the instances of that class.


getRuleFileName([<fullname>]) Returns the filename of the currently executing rule file.


getServerName() Returns the name of the Domain Manager.


getExternalString(<table>, <key>, <locale>) Extracts a string given a table name, key, and locale, and
renders the string given a list of substitutions (up to six).


glob(<pattern>,<string>) Enables glob style pattern matching. Standard glob syntax.
Returns a Boolean.


VMware Smart Assurance ASL Reference Guide


VMware, Inc.  123







Table 8‑1.  ASL syntax (Continued)


Syntax Description


global Defines the scope of a variable as global. If more than one
adapter for a repository, global values can be shared.


hex Represents a hexidecimal number. There is no minus sign.


hexToString(<hexadecimal>) Converts a hexidecimal number (the argument) to a string.


if (<conditional expression>) {<statements>} Represents a conditional statement.


ignore Used in conjunction with “case” to make all string matches
NOT case-sensitive.


IGNORE Exception handling, ignores exception and continue.


input=string Defines the input for parsing.


integer Represents an integer, including an optional minus sign.


is(<objecthandle>-><Relate>,<object2handle>) Tests whether an object is a member of a relationship.


isNull() Tests whether an object handle points a valid object. If
TRUE, object does not exist.


len(<number>) Moves the current starting position of an input string a
number of characters.


list(<listitem1>,<listitem2>,<listitem3>, etc.) Creates a list variable. Can either be used with arguments
or without.


local Variable scoping keyword.


LOG Keyword for exception handling. Writes to the system log
when an exception occurs.


LOG(<loglevel>) Keyword for exception handling. Writes to the system log
when an exception occurs and allows the classification of
the exception’s severity.


NEXT Keyword for exception handling. Skips remaining actions in
do block and goes to next rule.


NO_LOCK Argument passed to the transaction() function.


not(<pattern>) Does not match if pattern matches. Matches if the pattern
does not.


notany(<string>) Matches any character not included its argument <string>.


numeric() Attempts to convert the argument to a number. If it is a
Boolean, it returns 1 if TRUE and 0 is FALSE. If it is a
string, it tries to interpret it as a number. If it cannot, an error
occurs.


object([<classname>,]<objectname>) Converts a name to an object handle.


object(<objhandle>) Returns an object handle.


peek(<pattern>) Prescan input for a pattern and match or fail it. The search
position does not change by using peek.


print(<string>) Prints the argument string to the screen.
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Table 8‑1.  ASL syntax (Continued)


Syntax Description


quit() Shuts down the VMware Smart Assurance process the
adapter is talking to. This can be the adapter or a
Domain Manager.


Tells the back end to shut down.If you launch sm_adapter
and do not specify a back end, the adapter becomes its
own back end. In such cases, quit() does the same thing as
self->quit().


READ_LOCK Argument passed to the transaction() function.


rep(<pattern>[,<Number>]) Repeat pattern or rule a defined number of times or until it
fails.


return <string> Returns a value from a do block.


self Same as self->


self-> Directs functions that interact with the repository to use the
adapters repository and not the Domain Manager's. Used in
conjunction with adding objects to the adapter's repository.


setLocale(<locale>) The <locale> is the RFC-1766/3066 compliant specification
for language and country. The return value is a string
representation of the previous setting of the locale, or a
default value if setLocale() has not yet been called.


sizeOf(<string>) Counts the number of characters in a string.


sizeof(<string>) Counts the number of characters in a string.


sleep(<number>) Causes the adapter to sleep for a certain number of
seconds.


STOP Exception handling. Stops the ASL script.


stop() Stops the current thread. If you call stop() in an ASL thread,
and that thread is in a process that has other threads, the
effect is to simply kill that thread. But if that thread is the
only thread, which is the typical case when using
sm_adapter, stopping that thread effectively kills the
adapter (because the adapter shuts down when there are
no more active threads).


string(<value>) Converts the argument to a string.


substring(<string>,<start_pos>,<num_chars_to_remove>) Returns a new string that is a piece of the string passed to
it.


tab(<integer>) Moves the starting position in an input string to the position
passed to the function. This cannot be used to go
backwards. If no argument is specified, this function returns
the starting position for pattern matching in an input string.


table() Creates a table variable.


thread() Returns the thread ID of the thread that is running the
adapter.


time() Returns the system time.
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Table 8‑1.  ASL syntax (Continued)


Syntax Description


toLower(<string>) Converts string to lowercase letters.


toUpper(<string>) Converts string to uppercase letters.


trace(<string>,BOOLEAN) Makes tracing available from with ASL


transaction([<WRITE_LOCK|READ_LOCK|NO_LOCK>] ) Starts a repository transaction. Allows updates to a
Domain Manager to be entered and then committed all at
once. Needs to be committed before changes in the
Domain Manager are accepted. Use the abort() function
instead of the commit() function to remove changes. If a
START rule begins before things are committed, they are
automatically aborted. NO_LOCK is the default.


TRUE Boolean true.


undef() Undefines a variable. Appears as if the variable was never
assigned.


while Conditional statement causes loop while condition is true.


word Represents a series of characters ending with, but not
including, a delimiter.


WRITE_LOCK Argument passed to the transaction() function.


Reserved words
ASL reserved words lists the ASL words that are reserved and should not be used as identifiers or
variables. The reserved words are case-sensitive. Parentheses () indicate functions. Not all of the
reserved words are currently used.


any() float ignore sizeOf()


boolean() foreach IGNORE sizeof()


break formatString() input rep()


case fs integer repository


char getCauses() is() sleep()


clear() getChildren() isNull() STOP


consistencyUpdate() getClassDescription() len() stop()


continue getClosure() list() string()


correlate() getEventClassName() local substring()


create() getEventDescription() LOG tab()


default getEventType() NEXT table()


defined() getExplainedBy() NO_LOCK thread()


delete() getExplains() not() time()


delim getExternalString() notany() toLower()
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do getInstances() notify() toUpper()


else getOpDescription() numeric() trace()


eol getPropDescription() object() transaction()


exact getRuleFileName() peek()


FAIL getServerName() print() TRUE


FALSE glob() quit() undef()


feError() global READ_LOCK while


feErrorMsg() hex return() word


feErrorReset() hexToString() self WRITE_LOCK


filter if setLocale()
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dmctl Reference 9
This chapter includes the following topics:


n Description


n dmctl syntax


Description
The Domain Manager Control Program or dmctl is a command line tool for interacting with a
Domain Manager. “dmctl syntax” on page 153 provides additional information. The dmctl can be used to
query, modify, or receive notifications from a Domain Manager.


The tool can do any of the following:


n Execute commands typed at the command line


n Execute commands read from a batch file


n Interactively read commands typed in


If no batch file or command is specified, dmctl enters an interactive mode in which it prints a prompt
and accepts typed user commands. If a batch file is specified, dmctl executes the commands in the
batch file. Single commands can also be specified.


Command names can be abbreviated, usually to the shortest unique prefix. There are exceptions to
allow a common command to be typed easily when an uncommon one conflicts with it, and
conversely, to prevent the accidental typing of some commands. For example, getE is getEvents. The
minimum abbreviation for getEventDescription is getEventD. The quit and exit commands cannot be
abbreviated, and shutdown must appear as at least shut. Uppercase letters in command names are
shown for clarity only. They can be typed in lowercase, with the same meaning.


In non-interactive mode, dmctl also accepts commands that subscribe to notifications from the
Domain Manager. In that case, dmctl does not return, but continuously waits for notifications and
prints them to standard out (stdout).


n In a command-line mode, the Domain Manager to interact with must be specified with the --
server=<name> or -s <name> option.


n In batch or interactive mode, the Domain Manager to interact with can be specified later with the
attach command.
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ASL and dmctl
Issuing dmctl instructions is a good method to use to find out about the classes, attributes, events,
relationships, and methods available in a Domain Manager. When you debug ASL scripts, dmctl is an
effective tool to monitor the state of a Domain Manager.


Setting the locale
Locale is the RFC-1766/3066 compliant specification for language and country. For example, “fr_FR”
refers to French as spoken in France.


The setLocale command can be used in dmctl to set the locale of a session, as described in Setting the
locale. The types of text that the locale affects is the same as those described for an ASL script. The
section Locale effects on message rendering provides additional information.


dmctl syntax
The basic syntax is:


dmctl [options...] [<command>]


When given a command or batch file to run, dmctl executes the commands and exits.


The options include those listed in dmctl options:


Table 9‑1.  dmctl options


Option Description


--server=<name> Name of Domain Manager. This argument is used to identify the Domain Manager
to connect to. If it is not specified, it can be set later, in interactive mode, by using
the attach command. If it is in a host:port/name format, the specified host:port is
used to locate Domain Manager name. Otherwise, if it is in a simple name format,
name is located by the Broker.


Also -s <name>.


--broker=<location> Alternate Broker <host>:<port> location. If it is not specified, the Broker is located
by the standard search order, as follows:


If the SM_BROKER environment variable is defined, use its value. Otherwise, use
the default smarts-broker:426 location.


Either <host> or :<port> portions may be omitted, in which case the defaults
smarts-broker and :426 are used, respectively.


Also -b <location>.


--file=<file> Input batch file. Given this option, dmctl executes the commands in the file and
exits.


Also -f <file>.
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Table 9‑1.  dmctl options (Continued)


Option Description


--timeout[=<seconds>] Set a timeout on the remote execution of each command. A value of 0 specifies no
limit. The default is 0 (no limit) in interactive mode, 60 (1 minute) in non-interactive
mode. If --timeout is specified without an argument, a value of 60 seconds is used.
If a remote command takes too long, an error message is printed and dmctl
immediately exits with the status ETIME.


--traceServer Trace actions performed in the Domain Manager.


--commands List dmctl commands and exit.


Also -c.


--help Print help and exit.


--version Print program version and exit.


At any given time, dmctl can be attached to (at most) one Domain Manager. The dmctl forwards all
accepted commands to the attached Domain Manager, receives a response, and prints it to stdout. It is
important to remember that the commands are invoked in the server process. The commands include
those in dmctl commands :


Table 9‑2.  dmctl commands


Command Description


attach domain Attaches to the specified
Domain Manager. Once a
Domain Manager is attached, other
commands can be invoked.


clear <class> :: <instance> :: <event> Forces a clear of the specified event.


create <class>::<instance> Creates a new instance in the
repository.


consistencyUpdate Recomputes the codebook.


correlate Correlates now.


delete <class>::<instance> Deletes an instance from the
repository.


detach Detaches from the Domain Manager.
Another Domain Manager can now be
attached with the attach command.


execute <program> [<arg1> ...] Executes a program. Program should
be the base name of the program file,
without the suffix or directory. For
example, use “name” to load the
program name.po.


exit Exits dmctl.


findInstances <class-pattern>::<instance-pattern> Lists instances that match given class
and instance patterns.
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Table 9‑2.  dmctl commands (Continued)


Command Description


get <class>::<instance>[::<property>] Lists all properties values or a given
property value for a particular class
instance.


getClasses Lists all classes in the repository.


getEvents <class> Lists all exported events defined in
given class.


getEventDescription <class>::<event> Prints description of given event.


getInstances [<class>] Lists all instances in the repository, or
all instances of the given class.


getModels Lists all models loaded to the
Domain Manager.


getOperations <class> Lists all operations defined in given
class.


getPrograms Lists all programs loaded to the
Domain Manager.


getProperties <class> Lists all properties defined in given
class.


getThreads Lists all threads that are running in the
Domain Manager.


insert <class>::<instance>::<property> <value> Inserts a value into a table or
relationship.


invoke <class>::<instance> <op> [<arg1> ...] Invokes an operation of given instance.


loadModel <model> Loads a new MODEL library. The
<model> should be the base name of
the library. Do not specify a prefix or
suffix with the name.


Once a MODEL library is loaded, a
prefix or suffix is added to the name.
For example, libname.so (Solaris),
libname.sl (HP-UX), or name.dll.


After a MODEL library is loaded, the
repository can be populated with
instances of classes defined in that
library.


loadProgram <program> Loads a new program.The <program>
should be the base name of the
program file. Do not specify a prefix or
suffix with the name.


Once a program is loaded, a prefix or
suffix is added to the name. For
example, name.po.


After a program is loaded, it can be
executed with the execute command.


notify <class> :: <instance> :: <event> Forces notification of a given event.
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Table 9‑2.  dmctl commands (Continued)


Command Description


ping Verifies that the Domain Manager is
still alive.


put <class>::<instance>::<property> <value1> [<value2> ...] Sets value of given property.


quit Quits dmctl.


remove <class>::<instance>::<property> <value> Removes a value from a table or
relationship.


restore <file> Restores the repository from a file. The
<file> should not contain a directory
portion; it is read from
BASEDIR/smarts/repos/.


shutdown Shuts down the Domain Manager.


save <file> [<class>] Saves the repository to a file. The
<file> should not contain a directory
portion. It is saved to
BASEDIR/smarts/repos/. If <class> is
specified, then save only the sub-tree
rooted at class.


setLocale <locale> Allows you to set the locale before a
Domain Manager attach operation, and
to change the locale while the session
is open. The setLocale command will
print the value of the previous setting
on completion of the API call.


The default locale is set for a dmctl
session as follows:


1 The value of the SM_LOCALE
environment variable.


2 If SM_LOCALE is not set equal to
a value, then the default locale is
set equal to en_US.


status Displays the connection status.


subscribe <class-regexp>::<instance-regexp>::<event-regexp> ... Subscribes to problems and events
that match the given patterns. The
dmctl sends the subscription requests,
and then loops indefinitely, printing the
received notifications. The program
exits only when the Domain Manager
is shut down, or when interrupted.
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Table 9‑2.  dmctl commands (Continued)


Command Description


subscribeEvents <class-regexp>::<instance-regexp>::<event-regexp> ... Subscribes to events that match the
given patterns. The dmctl sends the
subscription requests, and then loops
indefinitely, printing the received
notifications. The program exits only
when the Domain Manager is shut
down, or when interrupted.


subscribeProblems < class-regexp>::<instance-regexp>::<event-regexp> ... Subscribes to problems that match the
given patterns. The dmctl sends the
subscription requests, and then loops
indefinitely, printing the received
notifications. The program exits only
when the Domain Manager is shut
down, or when interrupted.
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Card-Port MODEL Code 10
Card-Port MODEL example


The following example provides the Card-Port MODEL as described in Correlation model used for
example scripts.


/* card.mdl -


*


* Copyright (c) 2019, VMware Inc.


* All Rights Reserved


*


* A simple model file for use as an example of writing and


* building a small model.


*


*/


// Include the "resource" class from the netmate heirarchy.


#include "nm/nm.mdl"


// Since we include nm.mdl for purposes of derivation, we must


// have the generated .h file include nm.h


#pragma include_h "nm/nm.h"


///////////////////////////////////////////////////////////////


//


// This is a very simple card.


//


///////////////////////////////////////////////////////////////


// The class Card
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interface Card : MR_ManagedObject {


// Attributes maintained for the class Card


attribute string CardDesc


"A brief description of the card";


// Relationship between the class Card and


// the class Port


relationshipset ComposedOf, Port, PartOf


"The ports in this card";


// The notifications for the class Card


export


Down, // Problems


Impaired; // Compound Notification


problem Down


"The card is down, causing all its ports to be "


"operationally down"


= OperationallyDown;


propagate symptom OperationallyDown


"Symptom observed on the ports in this card"


= Port, ComposedOf, OperationallyDown;


// Compound notification


aggregate Impaired


"The card or a port on this card is Down"


= Down,


PortDown;
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propagate aggregate PortDown


"The Down problem on ports in this card"


= Port, ComposedOf, Down;


}


// The class Port


interface Port : MR_ManagedObject {
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// Attributes maintained for the class Port


enum operStatus_e {


TESTING = 0,


UP = 1,


DOWN = 2


};


attribute operStatus_e operStatus


"The operational status of the port"


= TESTING;


// relationship between the class Port and


// the class Card


relationship PartOf, Card, ComposedOf


"The card this port is part of";


// The notifications for the class Port


export


OperationallyDown, // Symptom


Down; // Problem


event OperationallyDown


"This port is not operational"


= operStatus == DOWN;


// Problem


problem Down


"The port is down"


= OperationallyDown;


}
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Preface 1
As part of an effort to improve its product lines, VMware Smart Assurance periodically releases revisions
of its software and hardware. Therefore, some functions described in this document might not be
supported by all versions of the software or hardware currently in use. The product release notes provide
the most up-to-date information on product features.


Contact your VMware Smart Assurance technical support professional if a product does not function
properly or does not function as described in this document.


Note   This document was accurate at publication time. Go to VMware Smart Assurance Online Support 
docs.vmware.com to ensure that you are using the latest version of this document.


This chapter includes the following topics:
n Purpose


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n VMware Smart Assurance Service Assurance Manager


n Related documentation


n Suggestions for searching PDF files


n Conventions used in this document


n Pathname conventions


n Graphical conventions


n Manager


n Where to get help


n Your comments
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Purpose
This document provides instructions for the configuration of
VMware Smart Assurance Service Assurance Manager, specifically the Global Manager. Topics include
creating user profiles, specifying sources of topology and events, and managing topology and
notifications.


Audience
This guide is intended for administrators who are responsible for deploying, installing, and configuring the
Global Manager. IT managers who seek to understand the role of the Global Manager in the context of an
VMware Smart Assurance solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should also read the
VMware Smart Assurance Service Assurance Manager Deployment Guide and the
VMware Smart Assurance System Administration Guide Guide.


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<productsuite>.


n For example, on UNIX operating systems, VMware Smart Assurance Service Assurance Manager is,
by default, installed to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than/opt/InCharge (on UNIX)
but you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.


VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System


n Global Console


n Business Dashboard


n Companion UI
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n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)


n VMware Smart Assurance Adapter for UIM/O


n XML Adapter


Related documentation
In addition to this document, VMware Corporation provides a help system for command line programs as
well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


n VMware Smart Assurance Common Information Model (ICIM) 1.11 Reference for Non-Service
Assurance Manager Products


n VMware Smart Assurance Common Information Model (ICIM) Reference for Service Assurance
Manager


n VMware Smart Assurance Foundation Documentation Portfolio


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ASL Reference Guide


n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide


VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes
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n VMware Smart Assurance Open Source License and Copyright Information


n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


n VMware Smart Assurance Service Assurance Manager Deployment Guide


n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide


n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide


n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance Companion UI Open Source License and Copyright Information for GPLv3
as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1 If the documentation is not accessible to all users of the VMware Smart Assurance product, copy the
contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a shared drive on
your LAN, so that operators and others can view the documentation.


2 To search throughout the documentation library, open the Acrobat Reader software:


3 Select Edit > Search, and type a word or phrase.


4 Select All PDF Documents in, in the Where would you like to search option, and type the
pathname of the location where the PDF documents reside.


If you have more than one VMware Smart Assurance product installed, you can set up cross-product
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each product into
this common documentation directory path.
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Conventions used in this document
VMware uses the following convention for special notices:


Note   NOTICE is used to address practices not related to personal injury.


Typographical conventions
VMware uses the following type style conventions in this document:


Bold Use for names of interface elements.


Italic Use for full titles of publications referenced in text


Monospace
Use for:
n System output, such as an error message or script
n System code
n Pathnames, filenames, prompts, and syntax
n Commands and options


                      
  Monospace italic
                     


Use for variables.


                      
  Monospace bold
                     


Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example


Pathname conventions
Directory pathnames are shown with forward slashes (/).


Graphical conventions
Under UNIX, the consoles appear with slight differences. For example, in views that display items in a
tree hierarchy such as the Topology Browser, an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to VMware Smart Assurance programs
such as Domain Managers, Global Managers, and adapters.
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Where to get help
VMware support, product, and licensing information can be obtained as follows:


Product information


For documentation, release notes, software updates, or information about VMware products, go to
VMware Online Support at:


docs.vmware.com


Technical support


Go to VMware Online Support. You will see several options for contacting VMware Technical Support.
Note that to open a service request, you must have a valid support agreement. Contact your VMware
sales representative for details about obtaining a valid support agreement or with questions about your
account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:


docs.vmware.com
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Overview 2
This chapter provides a brief overview of VMware Smart Assurance Service Assurance Managerand
illustrates its architecture.


The successful deployment of the Service Assurance Managerrequires knowledge of your operations
environment and the management tools already in place. You can integrate Service Assurancewith third-
party tools and existing installations of VMware Smart Assuranceapplications.


The VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managersprovides
the hardware and software requirements, as well as the procedures for installing the
Service Assurance Manager.


This chapter includes the following topics:


n Service Assurance Manager components


n Information flow between components


Service Assurance Manager components
VMware Smart Assurance Service Assurance Manager includes the following components.


Global Manager
Global Manager (Service Assurance Manager) is the software component at the heart of Service
Assurance. The Global Manager consolidates topology and event information from multiple underlying
domains and provides a central point for monitoring and managing distributed analysis domains.


Global Console
The Global Console is the primary tool for operators and administrators. The console enables operators
to monitor the state of the managed environment and quickly respond to notifications. The
Global Console also allows users to launch map and topology views. As the primary tool for users, the
Global Console is typically installed on many hosts. The Global Manager Administration Console enables
administrators to create and manage:


n User profiles


n Notification lists


n Tools


VMware, Inc.  12







n Escalation policies


Business Dashboard
Business Dashboard displays views normally available from the Global Console as viewlets within your
organization’s web page or a third-party web portal. Viewlets™ can display a variety of information
including:


n Notification log


n Status table


n Maps


n Summary


n Notification properties


n Containment


Adapter Platform
Adapter Platform is a software component that:


n Imports SNMP traps, topology, and even information from third-party applications or products


n Normalizes the imported data to the ICIM Common Information Model (ICIM)


n Provides this data to the Global Manager


VMware Smart Assurance Adapter for UIM/O
The VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations (referred to as the
VMware Smart Assurance Adapter for UIM/O) provides integration between the
VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations (herein referred to as
UIM/O) and the Service Assurance Manager. The adapter retrieves alerts from UIM/O, creates
notifications from the alerts, and sends the notifications to the Global Manager.


The
VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide
provides deployment information, configuration instructions, and client tool examples.


Business Impact Manager
Business Impact Manager extends the capabilities of the Global Manager to:


n Calculate the business impact of events


n Propagate the impacts to affected business elements (ServiceOfferings, BusinessProcesses, and
ServiceSubscribers)


The propagated impacts are discrete notifications that are connected through an event causality
chain to the root-cause problems.
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VMware Smart Assurance Notification Module
The VMware Smart Assurance Notification Module (NOTIF) augments VMware Smart Assurance
solutions with event management features that are configured through a graphical user interface (the
NOTIF Editor). NOTIF enables the user to easily optimize the flow of events and notifications sent through
any VMware Smart Assurance system. NOTIF can be installed on a SAM server and/or an Adapter
Platform server. The internal event and notification processing features of the standard SAM Adapter
Platform are replaced by NOTIF.


The VMware Smart Assurance Notification Module User Guide includes information on NOTIF
functionality and architecture.


Companion UI
VMware Smart Assurance Companion UI supplements existing functionality in SAM, and
VMware Smart Assurance Network Configuration Manager (NCM).


The Companion UI is a VMwareÂ®-based appliance, that is, a virtual machine. The
VMware Smart Assurance SolutionPack Installation and Configuration Guide provides detailed
information about installing and configuring the Companion UI.


Watch4net
Watch4net provides cross-domain performance monitoring of infrastructure and data center components,
in real-time, from a single customizable Watch4net dashboard. The
VMware Smart Assurance Console SolutionPack provides consolidated access to various console
components of SAM and CUI from Watch4net.


If you are deploying SAM, Watch4net, and Companion UI and you want single sign-on capability, consult
the VMware Smart Assurance SolutionPack Installation and Configuration Guide for instructions.


VMware Smart Assurance Notification Module Cisco Syslog
Processing Adapter
The VMware Smart Assurance Notification Module Cisco Syslog Processing Adapter (referred to as the
NOTIF Cisco Syslog Adapter) replaces the log file processing features of the standard Syslog Adapter.
The NOTIF Cisco Syslog Adapter processes log file information into useful notifications, with or without
the use of ASL scripts.


The VMware Smart Assurance Notification Module Cisco Syslog Processing Adapter Installation and
User Guide provides additional information on this adapter.


Information flow between components
The following scenarios describe the architectural flow of topology and notifications between the different
Service Assurance Manager components.
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Scenario 1
The components described in Information flow between Global Manager, Managers, adapters, and
include:


n Service Assurance Manager:


n Broker


n Global Manager


n Global Console


n Report Manager


n Underlying Domains:


n SAM Adapters


n VMware Smart Assurance IP Availability Manager
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n VMware Smart Assurance IP Performance Manager


Figure 2‑1.  Information flow between Global Manager , Manager s, adapters, and


Figure 2‑2.  Global Console


Scenario 2
The second scenario, shown in Information flow between Global Manager, Adapter Platform, and
Business Dashboard, adds Adapter Platform and the Business Dashboard:


n Adapter Platform functions as an underlying domain by processing events and topology from
disparate sources and sending this information to the Global Manager.
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n Business Dashboard provides access to the Global Console by using standard web technologies
such as HTML and Java.


Figure 2‑3.  Information flow between Global Manager , Adapter Platform , and
Business Dashboard


The Adapter Platform processes events and topology from third-party sources and provides this
information to the Global Manager. Adapter Platform can receive events and topology from the
following sources:


n SNMP traps — To process SNMP traps, you must configure the VMware Smart Assurance SNMP
Trap Adapter. The SNMP Trap Adapter can operate as a trap exploder, forwarding traps to multiple
locations, or it can convert traps to notifications and forward the notifications to Adapter Platform. The
NOTIF Editor may be used to graphically configure trap to notification management.


n System log files — To produce notifications from a system log file, you must configure the
VMware Smart Assurance Syslog Adapter. You must specify the appropriate system log file to
process and make sure that the format of the log file matches the format described in the Syslog
Adapter’s ASL rule set. The Notification Module Cisco Syslog Processing Adapter may be used to
manage Cisco type log messages into notifications.
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n Third-party sources with sm_ems — To process events from a third-party source, you must configure
the event source to invoke the sm_ems utility. You must invoke sm_ems so that it can notify or clear
events, update the values of attributes, or create topology elements.


The VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide describes
how to configure Adapter Platform, the SNMP Trap Adapter, the Syslog Adapter, and the sm_ems
utility.


Business Dashboard
The Business Dashboard displays information about the managed environment through a web browser.
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Configuration Overview 3
After you install the Global Manager, one of the first configuration tasks is to specify the sources of
topology and events and enable the Global Managerto begin working.


While there is much you can do to tailor Global Managerto your particular environment, the set of default
configuration parameters provides a base from which to start. You can continue to configure the
Global Managerwhile it is running.


This chapter includes the following topics:
n Types of configuration tasks


n How to configure the Global Manager


n Starting and Configuring VMware Smart Assurance NOTIF


n Starting services


Types of configuration tasks
This section organizes configuration options into groups of related tasks:


n Creating user profiles


n Specifying underlying domains and system-wide parameters


n Managing notifications and topologies


n Automating responses to notifications


Each of these groups includes several options:


n Creating user profiles


n Configuring system parameters


n Managing topology and notifications


n Automating responses to notifications
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Creating user profiles
A user profile defines the environment for one or more users, that is, anyone who requires access to the
Global Manager through the Global Console. You can create user profiles based on role
(administrator/operator), job function (network management/helpdesk), or a combination of these. With a
user profile, you specify the following:


n Notification lists determine which notifications the Global Manager shows to a particular user. You
define one or more filters in a notification list to determine which notifications are available through
that notification list. Chapter 7 Managing Notifications with the Global Manager provides additional
information about notifications.


n Console operations determine a user’s access privileges to various functions and commands
provided by the Global Console. Such functions range from adding a view, to acknowledging a
notification, and saving a console. You can select the console operations associated with each user
profile. “Console operations” on page 59 lists the console operations and describes how to add or
remove operations to a user profile.


n Tools provide a means by which users can respond to a notification. Such a response might include
pinging a device to see if it is reachable or opening a trouble ticket. By defining the tools associated
with a user profile, you determine what actions a user can invoke in response to a notification. 
Chapter 9 Tool Configuration for the Global Manager describes how to create and configure tools.


n Saved consoles provide users with a defined view of the network. This defined view can equal
multiple displays of information. “Creating a saved console” on page 50 describes how to create a
saved console and make it available to users over the network.


Configuring system parameters
System configuration tasks define the operation of the Global Manager:


n Specifying sources of topology and events and defining a smoothing interval and a minimum certainty
for notifications received from each underlying domain.


n Setting parameters related to the archival of notifications.


n Defining the interaction between the Global Manager and Global Consoles.


n Defining the interaction between the Global Manager and underlying domains.


â€œDefining system defaultsâ€� on page 69 describes the system parameters.


Managing topology and notifications
Managing the topology and notifications maintained by the Global Manager requires an understanding of
how the Global Manager synchronizes topology information and processes notifications.


You may need to perform one or more of the following tasks:


n Uniquely identify elements managed by two or more underlying domains (tagging). How the Global
Manager applies tags describes how to configure overlapping elements.
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n Organize managed elements into groups. Chapter 8 Managing Topology with the Global Manager
describes how to group topology elements.


n Customize the display of maps with new icons or map backgrounds. “Custom icons for map nodes”
on page 136 describes how to add new icons or load map backgrounds.


The VMware Smart Assurance Notification Module User Guide provides detailed information on how
to manage notifications through the use of the NOTIF Editor.


Automating responses to notifications
Escalation policies provide a way to automatically respond to notifications. Chapter 10 Escalation
Configuration for the Global Manager describes how to create escalation policies using the Global
Manager Administration Console.


How to configure the Global Manager
You configure the Global Manager using the following methods:


n Global Manager Administration Console


n sm_config utility


Privilege requirements
To access the Global Manager Administration Console, you must have the following privileges:


n You must have All privileges, as determined by the serverConnect.conf file used by the
Global Manager.


n You must have access to the Configure Global Manager Administration Console console operation.


To invoke the sm_config utility requires All privileges in the Global Manager’s serverConnect.conf file
as well as the necessary system privileges to edit installed files. Typically, administrator privileges are
required to edit configuration files.


Global Manager Administration Console
The Global Manager Administration Console is a graphical interface for performing configuration tasks
related to user profiles, escalation policies and custom map icons. The following wizards are provided to
simplify configuration tasks:


n Notification List Wizard


n Automatic Tool Wizard


n Client Tool Wizard


n Server Tool Wizard


n User Profile Wizard


n User Wizard
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n New Domain Wizard


n New Domain Group Wizard


n New Domain Type Wizard


n New Domain Tag Wizard


You can also create new users and notification lists through the User Profile Wizard.


Launching the Global Manager Administration Console
To open the Global Manager Administration Console:


From the Global Console, select Configure > Global Manager Administration Console.


The Global Administration Console is divided into two panes with a navigation tree in the left panel and a
configuration panel in the right panel. Selecting an element in the tree displays content in the
configuration panel. At the top level of the tree is the Global Manager you are configuring. Listed under
the Global Manager are five elements configured through the console; Escalation Policies, Notification
Lists, Tools, User profiles, and Users. Listed under each element are any instances of these elements.
For example, the users default and maint are listed under the Users element.


To modify the icons displayed in the map consoles, from the Global Manager Administration Console,
select Configure > Edit Map Icons.


The configuration of the Global Manager is stored in its repository file. Chapter 12 Importing and
Exporting Configurations describes how to configure a Global Manager using the sm_config utility.


Modifying configuration files
As part of the VMware Smart Assurance deployment and configuration process, you need to modify
certain files. User-modifiable files include configuration files, rule set files, templates, and files (such as
seed files and security configuration files) that contain encrypted passwords. Original versions of these
files are installed into appropriate subdirectories under the BASEDIR/smarts/ directory.


Examples:


n The original versions of the Global Manager configuration files on UNIX are installed
to /opt/InCharge/SAM/smarts/conf/ics


n Original versions of files should not be altered. If a file requires modification, it must be stored as a
local copy of the file in BASEDIR/smarts/local or one of its subdirectories.


Examples:


n A modified dxa-sam.conf file on UNIX should be saved to /opt/InCharge/SAM/smarts/local/conf/ics


n VMware Smart Assurance software is designed to first search for user-modifiable files in
BASEDIR/smarts/local or one of its subdirectories. If a modified version of a file is not found in the
local area, VMware Smart Assurance software then searches appropriate nonlocal directories.
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To facilitate proper file editing, VMware, Inc. provides the sm_edit utility with every
VMware Smart Assurance product. When used to modify an original version of a file, this utility
automatically creates a local copy of the file and places it in the appropriate location under
BASEDIR/smarts/local. This ensures that the original version of the file remains unchanged. You can
invoke sm_edit from the command line.


To invoke the s m_edit utility from the command line, specify the path and the name of the file to edit
under BASEDIR/smarts. If multiple VMware Smart Assurance products are running on the same host,
invoke sm_edit from the bin directory of the product with the files to edit.


Example:


To edit the configuration file for the Global Manager, invoke the sm_edit utility as follows:


# /opt/InCharge/SAM/smarts/bin>sm_edit conf/ics/dxa-sam.conf


            


In this example, the sm_edit utility automatically creates a local copy of the dxa-sam.conf file in
the /opt/InCharge/SAM/smarts/local/conf/ics directory and opens the file in a text editor. If a local
version of the file already exists, the sm_edit utility opens the local version in a text editor. In addition,
sm_edit creates any necessary subdirectories.


The VMware Smart Assurance System Administration Guide provides additional information about
the sm_edit utility.


A number of configuration files exist for the Global Manager. The BASEDIR/smarts/local/conf/ics
directory contains configuration files related to the Global Manager.


Global Manager configuration files lists the configuration files for the Global Manager.


Table 3‑1.  Global Manager configuration files


Directory Files Description


conf serverConnect.confclientConnect.confbroke
rConnect.confsm_cloneDir.conf


Security files for configuring access to
Service Assurance Manager. The
VMware Smart Assurance System Administration Guide
describes the syntax and configuration of these files.


conf/ics service.data.template


topology-group.data.template


Sample datafiles for importing services and groups into the
Global Manager.


actionconfig-sample.xml


ics-config-sample.xml


nlconfig-sample.xml


policyconfig-sample.xml


profileconfig-sample.xml


userconfig-sample.xml


mapgif-sample.xml


The XML files that define sample configurations for
notification lists, user profiles, users, and custom map icons
for the Global Manager.
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Table 3‑1.  Global Manager configuration files (Continued)


Directory Files Description


weights.conf The configuration file for
VMware Smart Assurance Business Impact Manager. The
VMware Smart Assurance Business Impact Manager User
Guide describes how to configure this file.


local/conf runcmd_env.sh Used to set environment variables for
VMware Smart Assurance software.


Configure Secure Broker
To configure Secure Broker, edit serverConnect.conf and clientConnect.conf files in the
BASEDIR/smarts/local/conf/ics directory.


n Edit the serverConnect.conf file as follows:


a In the serverConnect.conf file, comment out the following line:


<BROKER>:<DEFAULT>:<DEFAULT>:All


b Modify the BrokerNonsecure setting as follows:


<BROKER>:BrokerNonsecure:Nonsecure:Ping


c Add the following line after the BrokerNonsecure line


<BROKER>:SecureBroker:Secure:All


n Edit the clientConnect.conf file as follows:


a In the clientConnect.conf file, comment out the following line:


*:<BROKER>:BrokerNonsecure:NonSecure


b Add a secure value as follows:


c *:<BROKER>:<PROMPT>:<PROMPT>


d where Secure value can be encrypted.


Nonmodifiable Service Assurance configuration files lists additional files used by the
Global Manager. The files listed in Nonmodifiable Service Assurance configuration files should
not be modified by the user.
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Table 3‑2.  Nonmodifiable Service Assurance configuration files


Directory Files Description


conf/ics ics-config.dtd


ics-default.xml


console_operations.xml


consoleoper-ext.xml


consoleoper_config.dtd


The XML and data type definition (DTD) files that define default
notification lists, user profiles, users, and console operations for the
Global Manager. These XML files provide the default configuration
for the Global Manager.


conf/maps instance_maptype-sample.xml


map-config.dtd


map_gif.xml


The XML and DTD files that define custom map icons.


conf/xml-if icim_xml.dtd


sample.xml


A sample XML file and the DTD file to define the XML standard used
to import ICIM objects into VMware Smart Assurance software. The
VMware Smart Assurance XML Adapter User Guide describes how
to import topology using XML.


If your deployment involves adapters that integrate with any third-party products, there might be additional
configuration and XML definition files. For more information regarding adapter configurations, refer to the
guide for that adapter.


Starting and Configuring VMware Smart Assurance NOTIF
After you install and configure the Global Manager, you must also configure NOTIF if you want to optimize
the flow of events and notifications sent through your VMware Smart Assurance system. To start and
configure NOTIF:


1 Set an environment variable in the BASEDIR directory path to ensure that Java can be successfully
started for NOTIF. In BASEDIR/smarts/local/conf/runenv_cmd.sh, add the following line:


export SM_JAVA_ENABLED=YES


2 Configure the SNMP Trap Adapter to use the Notif-trap_mgr_parse.asl script instead of the default
trap_mgr_parse.asl script in order for NOTIF to process SNMP traps.


For example:


./sm_trapd --name=TRAP-OI --server=INCHARGE-OI --config=icoi


--port=9013 --model=sm_actions --output


--rules=icoi-trapd/Notif-trap_mgr_parse.asl --daemon


3 Configure the Syslog Adapter to use the Notif-SysLog_mgr.asl script instead of the default
SysLog_mgr.asl script in order for NOTIF to process Cisco system log files.


For example:


sm_adapter.exe --name=SYSLOG-OI --server=INCHARGE-OI --tail=/var/log/syslog --model=sm_system --


model=sm_actions --output icoi-syslog/Notif-SysLog_mgr.asl
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4 Start the NOTIF Editor by selecting Start > Programs > InCharge > Smarts NOTIF Editor.


Note   You can also start the editor by double-clicking the NotifGui.sh file (for UNIX systems) in the
BASEDIR/smarts/notif/editor directory.


5 Use the NOTIF Editor to connect to the running SAM or Adapter Platform server. Select Remote >
Edit a server's settings in the NOTIF Editor.


6 The Connect to a Server dialog box displays the list of available Adapter Platform and SAM server
connections. Choose a server from the list of available server connections in the Connect to a
Server dialog box and click OK.


If no available server connections are displayed, do the following to populate the list of server
connections:


7 Click the More button in the Connect to a Server dialog box. This launches the Manage
Connections dialog box where you can add server connections.


8 Click the Add button in the Manage Connections dialog box.


The Input dialog box displays.


9 Enter a connection reference name (for example, “Remote VMware NOTIF OI server”) in the Input
dialog box and click OK.


10 Fill in the new connection record in the right pane of the Manage Connections dialog box.


11 Click OK to save the connection setup.


The Remote Server Settings dialog box displays, showing the server's current settings.


12 Select the Activate Smarts NOTIF checkbox, and then click OK.


Note   You can also change other server settings in the Remote Server Settings dialog box if
necessary.


13 Restart your SAM/Adapter Platform server.


Note   Server setting changes made in the VMware NOTIF Editor Remote Server Settings dialog
box are persistent. When you change server settings in the Remote Server Settings dialog box and
click OK, the changes are saved to the Notif_Settings.import file that is generated and saved to the
BASEDIR/smarts/local/conf/<icoi or ics> directory in the Adapter Platform or SAM server where
VMware NOTIF is running.


Server setting changes made in the VMware NOTIF Editor are preserved even if the repository is
deleted. For example, if the repository is erased because you used the --norestore option for server
startup, the server uses the last saved settings from the VMware NOTIF Editor saved in
BASEDIR/smarts/local/conf/<icoi or ics>/Notif_Settings.import. The
VMware Smart Assurance Notification Module User Guide includes information on how to use the
VMware NOTIF Editor.
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Starting services
During installation, VMware products may be installed as services. When installed as services, default
values are specified for the parameters that are associated with the services.


The parameters for the Global Manager service:


sm_service install --force  --unmanaged  --startmode=runonce \


 '--name=ic-sam-server' \


 '--description=VMware Smart Assurance Service Assurance Manager Server' \


 '/data/username/SAM_811_clean/SAM/smarts/bin/sm_server' \


 '-n' \


 'INCHARGE-SA' \


 '--config=ics' \


 '--port=0' \


 '--ignore-restore-errors' \


 '--output'


The parameters for the Adapter Platform service:


sm_service install --force 


 --name=ic-sam-server 


 "--description=VMware Smart Assurance Service Assurance Manager Server"


 --startmode=runonce


 E:\data\SAM\9.2\SAM\smarts\bin\sm_server.exe  "-n"


  "INCHARGE-SA" 


  "--config=ics" 


  "--port=0" 


  "--ignore-restore-errors" 


  "--output"


The parameters for the SNMP Trap adapter service:


/opt/InCharge/SAM/smarts/bin/sm_service 


 install --force --unmanaged --startmode=runonce


 --name=ic-trapd-receiver


 --description="VMware Smart Assurance SNMP Trap Adapter"


 /opt/InCharge/SAM/smarts/bin/sm_trapd 


  --name=TRAP-INCHARGE-OI


  --server=INCHARGE-OI


  --config=icoi


  --port=162


  --model=sm_actions


  --rules=icoi-trapd/Notif-trap_mgr_parse.asl


  --seed=seedfile


  --output


C:\InCharge\SAM\smarts\bin>sm_service


 install --force --name=ic-trapd-receiver


 --description="VMware Smart Assurance SNMP Trap Adapter"


 C:\InCharge\SAM\smarts\bin\sm_trapd.exe 


  --name=TRAP-INCHARGE-OI


  --server=INCHARGE-OI
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  --config=icoi


  --port=162


  --model=sm_actions


  --rules=icoi-trapd/Notif-trap_mgr_parse.asl


  --seed=seedfile


  --output


The parameter for the Syslog adapter service:


/opt/InCharge/SAM/smarts/bin/sm_service


 install --force  --unmanaged  --startmode=runonce


 --name=ic-syslog-adapter


 --description="VMware Smart Assurance Syslog Adapter"


 /opt/InCharge/SAM/smarts/bin/sm_adapter


  --name=SYSLOG-INCHARGE-OI


  --rserver=INCHARGE-OI


  --tail=/var/log/syslog


  --model=sm_system


  --model=sm_actions


  --output


  icoi-syslog/Notif-SysLog_mgr.asl


C:\InCharge\SAM\smarts\bin>sm_service


 install --force --name=ic-syslog-adapter


 --description="VMware Smart Assurance Syslog Adapter"


 C:\InCharge\SAM\smarts\bin\sm_adapter.exe


  --name=SYSLOG-INCHARGE-OI


  --rserver=INCHARGE-OI


  --tail=/var/log/syslog


  --model=sm_system


  --model=sm_actions


  --output


  icoi-syslog/Notif-SysLog_mgr.asl


When VMware products are installed as services, they start automatically upon system restart. The
following sections describe additional methods to start VMware services.
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User Configuration for the
Global Manager 4
This chapter includes the following topics:


n Configuring a security message


n User profiles


n User accounts


n Creating a saved console


n Notification lists


n Console operations


Configuring a security message
A security disclaimer message can be configured to display when users attempt to start the Global
Console, Business Dashboard console, or the Web Console.


Note   By default, the disclaimer dialog box is not enabled.


Configuring the security message for the Global Console
The file, security.warning, used to configure the disclaimer message is located in the
<BASEDIR>\smarts\local\conf directory. The file, security.warning, is a simple ascii text file containing the
security warning message text. This text appears in the security warning dialog box.


Note   The file used to configure the disclaimer message must be labeled security.warning. If the file does
not exist or is labeled a different name, the security warning message will not appear when the console
starts.


To configure the disclaimer message for the Global Console:


1 Verify that the security.warning file is located in the <BASEDIR>\smarts\local\conf directory.


Note   The security.warning file must be manually created if it already does not exist in the
<BASEDIR>\smarts\local\conf directory.


2 Modify the text in the security.warning file, if necessary.
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Configuring security message for Business Dashboard viewlet and
Web Console
For the security message to appear on either the Business Dashboard viewlet or the Web Console, the
com.smarts.securityMessage parameter must be configured.


The value of the com.smarts.securityMessage parameter is the filename of the ascii file containing the
security message. For example, if the security message file was created and saved as trespass.notice,
the property would be specified as:


com.smarts.securityMessage=trespass.notice


The Adjusting Java Properties section of the
VMware Smart Assurance Service Assurance Manager Operator Guide provides additional information.


User profiles
User profiles provide a means by which an administrator can create and control the access and display of
users who attach to the Global Manager through the Global Console, including the
VMware Smart Assurance web console and the Business Dashboard. For example, an administrator can
create one user profile for operators who monitor the network infrastructure and a second user profile for
operators who monitor application performance. All user accounts for a Global Manager are associated
with a user profile.


A user profile includes the following properties:


n A notification list determines what notifications the Global Manager sends to the users.


n One or more users defined for the Global Manager. You must also ensure that these users have
access to the Global Manager through the serverConnect.conf security file. The
VMware Smart Assurance System Administration Guide describes the configuration of security files.


n Server or client tools that enable users to invoke programs in response to notifications. Server and
client tools, which are optional, are separately assigned to user profiles.


n One or more saved consoles that open when the user attaches to the Global Manager.


n Console operations, which are user actions on the console and determine a user’s access privileges
to various functions and commands provided by the Global Console.


You can create user profiles with the Global Manager Administration Console or by using the
sm_config utility. Chapter 12 Importing and Exporting Configurations describes the sm_config utility.


Creating a user profile
When using the User Profile Wizard, you are prompted to specify the users, notification list, tools, saved
consoles, and console operations associated with the user profile.


Note   You can create users and notification lists from within the User Profile Wizard.
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As you proceed through the wizard, you may notice that certain elements, such as users or tools appear
grayed out. This indicates that these elements are not enabled. You can associate disabled elements with
a user profile, however such elements are not available to the user profile. For example, if a tool is not
enabled, it will not be available to a user until it is enabled. You can enable or disable elements by
selecting them in the tree and selecting or clearing the Enable box in the Configure User Profile panel.


In addition, you can click Finish at any point and the wizard will create the user profile. If you are creating
a new user profile, any options set after the point where you selected Finish will be blank. If you copied an
existing user profile, the new profile will include the options of the copied profile.


Note   Users may have to detach and reattach for changes to their user profile to take effect.


To create a user profile using the User Profile Wizard:


1 From the Global Manager Administration Console, click the Launch User Profile Wizard toolbar
button.


The User Profile Creation Wizard appears.


2 Type the name of the user profile and choose whether to create a new profile or to copy an existing
profile, and click Next. If you choose to copy an existing profile, the remaining configuration options
will be identical to the user profile that was copied.


The name of a user profile cannot be the same as the name of a user. For example, you cannot
create a user profile Operator and a user Operator. A suggested naming convention is to name the
user profile with a –profile extension. For example, you could have a user profile called Operator–
profile.


3 Select a notification list from the list box and click Next. Optionally, you could choose New
Notification List from the menu to create a new notification list. Notification list parameters describes
how to create notification lists.


4 Assign users to this user profile. You can select multiple users by holding the Ctrl key when selecting
users. Click the Add button to associate the user or users with the user profile.


If the user does not exist, you can create a user by doing the following:


5 Type the username in the Create and add new user field.


6 Click Add.


7 Click Next.


Note   A user can belong to only one user profile. If the user you select is already a member of
another user profile, the user is associated with the new user profile.
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8 Select the appropriate server tools from the list of Available server tools and click the Add button to
associate them with the user profile. You can select multiple tools by holding the Ctrl key while
selecting. When finished, click Next.


Note   Click the Allow user to launch client or server tools only for a single selected object
option to allow users to only launch client or server tools for a single selected object.


9 Select the appropriate client tools from the list of Available client tools and click the Add button to
associate them with the user profile. You can select multiple tools by holding the Ctrl key while
selecting. When finished, click Next.


Note   Click the Allow user to launch client or server tools only for a single selected object
option to allow users to only launch client or server tools for a single selected object.


10 Select the saved consoles that are opened when users attach to the Global Manager, and click Next.
If a saved console is not selected, the default NotificationLog console will appear when the user
attaches to the Global Manager.


If the appropriate console is not listed, type the name of the console in the Add new console field
and click the Add button. You can specify the name of a saved console whether or not the saved
console exists.


11 Select the console operations for users associated with this user profile. You can select Other to
choose specific console operations or choose one of the default sets of console operations:


n Read Only


n Operator


n Administrator


The default sets of console operations cannot be modified.


You can assign a modified version of one of the default sets of console operations by first
selecting the set that provides most of the console operations to assign. Then, select Other.
When you click Next, the console operations that correspond to the set you chose are
selected but you can enable or disable individual console operations.


12 Click Next.


The final screen of the User Profile Wizard shows all newly created elements, including the new user
profile. By default, the user profile is enabled. You can disable it by clearing the box next to the profile
name.


Note   If you chose to copy an existing profile in step 2, and if the existing profile is disabled, then the
user profile is disabled by default.


13 Click Finish to display a dialog box confirming that the user profile elements were created.
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Deleting a user profile
To delete a user profile:


1 Select the user profile.


2 Select Edit > Delete.


You can disable a user profile without removing it. Disabling a user profile describes how to disable a
user profile.


Note   You must not delete the default-profile user profile. When users attach to a Global Manager
and their username is not assigned to a user profile, the default-profile user profile is applied. If the
default-profile does not exist, an error message appears and the Global Console will not open.


Modifying a user profile
To modify a user profile:


1 Select the user profile.


2 Modify the properties of the user profile in the right panel:


3 Change the notification list.


4 Add or remove users.


5 Add or remove server tools.


6 Add or remove client tools.


7 Add or remove saved consoles.


8 Add or remove console operations.


9 Click Apply.


Changes to a user profile may not be available to console users until they restart the Global Console.


Disabling a user profile
You can disable a user profile without having to delete it. When users of a disabled profile attach to the
Global Manager, they are assigned the default-profile. If the default-profile is deleted, users associated
with a disabled user profile cannot attach to the Global Manager.


To disable a user profile:


1 Select the user profile.


2 Clear the Enabled checkbox.


3 Click Apply.
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Changing the notification list for a user profile
A notification list determines what notifications a user sees in the Global Console. Changing the
notification list associated with a user profile affects all the users of this profile.


The Default notification list filters out notifications where the value of the Owner attribute is maint. When
the user maint takes ownership of a notification, that notification is removed from the display of users
assigned the Default notification list.


There is a difference between taking ownership of a notification and acknowledging a notification. If a
notification is:


n Owned and acknowledged and then recurs, the ownership and acknowledgement values are cleared
in the new notification.


n Owned but not acknowledged and the notification recurs, the ownership is maintained and the
recurring notification is also filtered from the operator’s display.


â€œNotification listsâ€� on page 52 describes the properties of the default notification lists.


To change the notification list for a user profile, select a new notification list from the Notification List
menu. Notification list parameters describes how to use the Notification List Wizard to create a
notification list.


Adding or removing a user
A user can be associated with only one user profile. If you add a user to a user profile, the user is
automatically removed from its previous user profile.


To add a user to a profile:


1 Select the user profile from the tree.


2 From the Configure User Profile panel, click Modify List in the Users section.


The Modify Users dialog box appears.


3 Add or remove users from the user profile.


4 Click OK.


5 Click Apply at the bottom of the Configure User Profile panel. “User accounts” on page 48
describes how to create a user account.


To remove a user, select the user profile in the tree. From the Configure User Profile panel, select
the user from the Users list and click Remove Selected. Click Apply at the bottom of the Configure
User Profile panel.


When you remove a user from a user profile, the user is automatically associated with the default-
profile until you assign the user to a different user profile. “Creating a saved console” on page 50
describes the default user profiles.
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Adding or removing a tool
Client and server tools are configured separately, however the process for adding or removing a client or
server tool from a user profile is the same.


To add a tool to a user profile:


1 Select the user profile in the tree.


2 From the Configure User Profile panel, click Modify List in the Server Tools or Client Tools
section.


The Modify Server Tools or Modify Client Tools dialog box appears.


3 Add or remove tools from the user profile.


4 Click OK.


5 Click Apply at the bottom of the Configure User Profile panel.


To remove a tool:


6 Select the user profile in the tree.


7 From the Configure User Profile panel, select a tool and click Remove Selected.


8 Click Apply at the bottom of the Configure User Profile panel.


Chapter 9 Tool Configuration for the Global Manager describes how to configure tools.


Adding or removing a saved console
A saved console provides users with a preconfigured view of the network, helping users focus on aspects
of the managed system they are to monitor.


To add a saved console to a user profile:


1 Select the user profile in the tree.


2 From the Configure User Profile panel, click Modify List in the Saved Consoles section.


The Modify Saved Consoles dialog box appears.


3 Add or remove saved consoles from the user profile.


4 Click OK.


5 Click Apply.


To remove a saved console:


6 Select the user profile in the tree.


7 From the Configure User Profile panel, select a saved console and click Remove Selected.


8 Click Apply at the bottom of the Configure User Profile panel.


â€œCreating a saved consoleâ€� on page 50 describes how to create a saved console.
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Adding or removing console operations
Console operations are the functions and commands a user can invoke through the Global Console. By
adding or removing console operations, an administrator can determine the level of access a user has to
console operations.“Console operations” on page 59 lists the various console operations.


To add or remove console operations for a user profile:


1 Select the user profile in the tree.


2 From the Configure User Profile panel, click Modify List in the Console Operations section.


The Console Operations dialog box appears.


3 Select or clear console operations for the user profile.


Note   In addition, you can select one of the three default groups of console operations and apply it to
the user profile.


4 Click OK to close the dialog box.


5 Click Apply at the bottom of the Configure User Profile panel.


About the predefined user profiles
Service Assurance includes four editable user profiles: admin-profile, oper-profile, default-profile, and
maint-profile. The default-profile, admin-profile, and oper-profile user profiles include the default
notification list and the Notification Log console.


default-profile
The default-profile user profile provides read-only operations and no tools. This profile ensures that any
user that is not associated with a user profile or whose user profile is disabled, can attach to the
Global Manager. The user must still authenticate with the Global Manager.


maint-profile
The maint-profile also serves a special purpose, which is to take ownership of notifications that are not
relevant to operators. For example, if notifications are generated for interfaces that should not be
managed, or for components that are known to be faulty but are not scheduled to be fixed, an
administrator can log in as the user maint and take ownership of these notifications.


admin-profile
The admin-profile includes all console operations access groups, server tools, and client tools, assuming
the user has been given “All” privileges on the server side using the serverConnect.conf configuration file.


oper-profile
The oper-profile includes:


n All client and server tools
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n Details about notifications


n Maps


n Notification management, such as acknowledge


n Taking ownership of a notification


n Groups configurations


n Restricted access to configuration and management of user console and views


User accounts
A user account provides a unique identifier for each person who attaches to the Global Manager with the
Global Console. The username provides a method for tracking who performs the following operations on
notifications:


n When users acknowledge or unacknowledge a notification, their username is added to the
notification’s Owner attribute and recorded in the notification’s audit trail.


n When users take ownership, their username is added to the notification’s Owner attribute and this
information is recorded in the notification’s audit trail.


n When users invoke a tool on a notification, the user’s name is recorded to the notification’s audit trail.


When a user attaches to a Global Manager, the console automatically tries to associate the user with
a user profile. If the user is not assigned to a profile, the default-profile is used.


Note   Users must authenticate with a matching username and password in the serverConnect.conf
file used by the Global Manager. The VMware Smart Assurance System Administration Guide
describes the syntax and configuration of the security files.


Creating a user account
You can create new users in one of the following ways:


n Through the User Profile Wizard when you create a user profile as described in “User profiles” on
page 41.


n Through the User Wizard as described below.


n Through the sm_config utility as described in Chapter 12 Importing and Exporting Configurations.


To create a new user with the User Wizard:


a Select the Launch User Wizard toolbar button.


The User Creation Wizard appears.


b Type the name of the new user.


The username must be unique.


c Click Next.
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d Select a user profile for this user from the list box.


e Do one of the following:


n Click Next to display a confirmation screen.


n Click Finish to create the user.


f Add the username and password in the serverConnect.conf file used by the Global Manager.


Deleting a user account
To delete a user:


1 Select the user in the tree.


2 Select Edit > Delete.


Note   Do not disable or remove the Admin user account. If the Admin user account is removed or
disabled, but other users still have the same privileges, none of the applications can be shut down.


Creating a saved console
You can create a console layout for the Global Console, save it to the Global Manager, and associate it
with a user profile so that it automatically opens for users associated with that profile. In addition, you can
save the console to the Global Manager so that users can open it from the Global Console by selecting
File > Open Remote.


There are two methods to set up access to a saved console:


n Specify the console name when you set up a new user profile, the saved console opens automatically
when the user attaches to the Global Console.


n Save a console to a directory that users can access. Console users can use the Open Remote As
command to open consoles in this directory.


The VMware Smart Assurance Service Assurance Manager Operator Guide describes how to set up
and save a console.


Saving a remote console for user access
You can save a console to one of the following locations on the host where the Global Manager is
running:


n Use BASEDIR/smarts/local/consoles for all users.


n Use BASEDIR/smarts/local/consoles/<user> for a specific user.


n Use BASEDIR/smarts/local/consoles/<user_profile> for all users assigned a specific user profile.


Note   The BASEDIR/smarts/local/consoles/<user_profile> directory must be manually created by the
administrator.
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When a console is saved by selecting File > Save As > Save Remote As, the console is saved to the
BASEDIR/smarts/local/consoles/<USER> directory, where <USER> is the VMware Smart Assurance
username. Users cannot see or open the consoles saved in another user’s directory unless it is
manually copied into:


n Their own console directory.


n The BASEDIR/smarts/local/consoles directory.


n The BASEDIR/smarts/local/consoles/<user_profile> directory that corresponds to the user profile
associated with their username.


Providing a saved console in a user profile
To provide a saved console in a user profile:


1 Configure the console layout and select File > Save As > Save Remote As.


The console is saved to a directory that corresponds to your username under
BASEDIR/smarts/local/consoles. For example, if you are logged in as the user “admin”, the console is
saved to the BASEDIR/smarts/local/consoles/admin directory.


When you select Save Remote As, you are prompted to select the Domain Managers to which the
saved console should automatically reattach in the event of a disconnect. The list includes those
Domain Managers to which you are currently attached. By choosing to automatically reattach to a
Domain Manager, you can omit the attach and detach console operations from the user profile.


2 To make the console available to all Global Console users, move the saved console from its current
directory to the BASEDIR/smarts/local/consoles directory.


When a saved console is located in this directory, a user can also open the console using File >
Open Remote.


3 Add the console to the user profiles as described in Adding or removing a saved console.


4 To make the console available to users of a particular user profile, move the saved console from its
current directory to the BASEDIR/smarts/local/consoles/<user_profile> directory.


Note   The BASEDIR/smarts/local/consoles/<user_profile> directorymust be manually created by the
administrator.


Notification lists
A notification list determines what notifications a client of the Global Manager receives. A notification list
includes a filter that the Global Manager uses to process notifications before sending the notifications to
the client. In addition to a filter, you can also use a notification list to change the name of column headings
in the Notification Log of the Global Console.


Note   Changes to a notification list are not available to console users until they reattach to the
Global Manager. 
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Clients that use notification lists include:


n Global Consoles — The notification list is a property of the user profile. Creating a user profile
describes how to create user profiles.


n Notification adapters — The notification list used by a notification adapter is specified in the
NLSubscription section of the adapter’s configuration file. The
VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide provides
additional details on notification adapters.


n Adapter Platform — A Global Manager uses a notification list to receive notifications from the Adapter
Platform. The notification list used by Global Manager is specified in the dxa-oi.conf file.


Note   Changes to the notification list are made using the Global Console and not by directly editing
the dxa-oi.conf file.


Because a notification list controls what notifications a client receives, it affects more than the display
of notifications in a Notification Log. A notification list also affects the display of maps in the Global
Console. For example, if a notification list filters out all notifications for a router, the status of that
router will appear normal, regardless of its actual condition.


The filters specified as part of a notification list should not be confused with the filtering capabilities of
the Global Console. The Global Manager performs the filtering defined in a notification list. The
notifications that are filtered out by a notification list are not sent to a client. Filters in the Global
Console can be used to further refine the filter of a notification list. The
VMware Smart Assurance Service Assurance Manager Operator Guide describes filtering performed
by the Global Console.


You can create or modify a notification list using the Global Manager Administration Console or the
sm_config utility. This section describes using the Global Manager Administration Console. 
Chapter 12 Importing and Exporting Configurations describes how to use the sm_config utility.


Notification list parameters
A notification list includes the properties described in Notification list parameters.
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Table 4‑1.  Notification list parameters


Field Description


Name Name of the notification list, must be unique among notification lists.


Filter


and


ASL Filter


Type of filter used to filter notifications. You can specify two types of filters: an expression filter
or an ASL filter:
n An expression filter matches a wildcard expression against the value of a notification


attribute. You create an expression filter using the filter builder. Building expression filters
describes expression filters.


n An ASL filter is specified by checking the ASL Filter checkbox and typing the name of the
ASL file. The ASL filter file must be located in the BASEDIR/smarts/local/rules/ics directory.
You must also specify the ics directory with the name of the filter, for example,
ics/myASLfilter.asl.


If no filter is specified, the notification list matches all notifications.


Column Heading Used to modify the column headings that are displayed in the Notification Log. “Attributes for
matching notification properties” on page 215 lists notification attributes.


You can use expression filters and ASL filters in combination, as well as specify multiple expressions in
an expression filter. However, each filter definition sheets can contain only expression filters or an ASL
filter.


You cannot have expression filters and ASL filters on the same sheet:


n When an expression filter and an ASL filter are used in combination (they are on two separate
sheets), a notification must match either the expression filter or the ASL filter to be sent to the client.


n When multiple expression filters are specified on the same sheet, the notification must match each
expression filter to be sent to the client.


n When multiple expression filters are specified on multiple sheets, the notification must match each
expression filter on sheet 1 or each expression filter on sheet 2, and so on.


By default, there are two notification lists:


n Default — Specifies an expression filter.


n Maintenance — Does not specify a filter, it matches all notifications.


About Default notification lists describes the default notification lists.


Creating a notification list
To create a notification list using the Global Manager Administration Console:


1 Select the Launch Notification List Wizard toolbar button.


The Notification List Creation Wizard appears.


2 Type a unique name for the Notification List.
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3 Choose to create a new notification list or copy an existing notification list:


n If a new notification list is being created, all of the filter properties are empty.


n If you copy a notification list, the notification list properties contain the same values as the
copied list.


4 Click Next.


5 Create an expression filter or type the name of an ASL Filter prefaced by the name of the
BASEDIR/smarts/local/rules directory in which it is located, and click Next.


Note   The ASL filter must exist in the specified location, as the Global Manager loads the filter when
you exit the wizard. The filter builder, used to create expression filters, is also used to configure tool
and escalation policies. Chapter 11 Working with Filters provides additional information.


6 Edit the column headings that are displayed in the notification log. The left column lists the attributes
included in a notification. The right column lists the columns names as they are currently displayed.
You can edit the values in the right column by double-clicking a field.


7 Do one of the following:


n Click Next to view the confirmation panel.


n Click Finish to create the notification list.


The new notification list is displayed in the Global Manager Administration Console.


Modifying a notification list
To edit the filters and the column headings for a notification list:


1 Select a notification list in the tree.


The Configure Notification List panel appears.


2 Click Edit Filter to modify the filter.


The Edit Filter dialog box appears. Chapter 11 Working with Filters provides additional information.


3 Click OK when you have finished editing the filters.


4 Edit the display headings as needed. Double-click the display heading in the right column to edit the
text. The new display heading is visible when users reattach to the Global Manager.


5 Click Apply.


Note   To provide a value for a UserDefined attribute, you must configure a hook script to populate
the field. “User-defined notification attributes” on page 115 provides information about hook scripts.
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Disabling a notification list
You can disable a notification list if you do not want it active but do not want to delete it. When users
attach to a Global Manager and their notification is disabled, their console will not receive any
notifications. The console will receive notifications when the notification list is enabled.


To disable a notification list:


1 Select the list from the tree in the Global Manager Administration Console.


2 Clear the Enabled checkbox.


3 Click Apply.


The name of the disabled notification list appears dimmed.


Note   The Default notification list is used by the default-profile, admin-profile, and oper-profile user
profiles and if this default notification list is disabled then user attached to this profile will not be able
to receive any notification. Whenever changes are made to enable or disable of notification list
through an admin profile, SAM server re-initializes all notifications to console. The resent notifications
are based on changes made by the admin. So if the admin disables Default Notification List, when
server re-initializes the connection, it will not find the default notification list or any other notification
list attached to admin-profile. This will cause the console to not receive any notifications.


About Default notification lists
Two notification lists, Default and Maintenance, are included with the Global Manager and defined in the
ics-default.xml file. The Default notification list is used by the default-profile, admin-profile, and oper-
profile user profiles. If a user profile is disabled, users of that profile are assigned the Default user profile,
which includes the notification list.


The Default notification list uses an expression filter that specifies the following conditions:


n Matches any notification in which the value of the Owner attribute is not maint.


n Matches any notification in which the value of Owner attribute is not SYSTEM.


A notification must match both conditions before it is sent to a client. The Maintenance notification list
does not specify a filter. Because of this, it matches all notifications.


About the predefined user profiles describes the purpose of the default notification lists and how they
are incorporated into the default user profiles.


Processing notifications
The Service Assurance Manager processes notifications sent from:


n The Adapter Platform Manager (OI) to the INCHARGE-SA (SAM) server
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n An Aggregate SAM server to a Presentation SAM server


If your SAM Server is communicating with an older version SAM, or OI, you must configure the
usePre8.0 parameter included in the dxa-oi.conf file to true. Configuring the usePre8.0 parameter to
true, instructs the SAM server to communicate with pre 8.0 SAM Servers and OIs.


To configure the SAM Server to communicate with older versions of SAM and OI:


a Using a text editor, open the dxa-oi.conf file.


b Locate the following lines of text:


# Underlying OI is pre8.0, so we must use a different transport....


usePre8.0 TRUE


c Uncomment (delete the pound sign) the line, for example:


Underlying OI is pre8.0, so we must use a different transport....


usePre8.0 TRUE


d Save and close the file.


If your Service Assurance Manager environment requires even faster notification processing, you
can configure your Service Assurance Manager to provide multiple threads to process the
notifications. Processing notifications using multiple threads adds an additional layer of
complexity to your configuration, could possibly use additional system resources, and is only
recommended for specific use if your system is failing to keep up with the notifications.


To configure your Service Assurance Manager to process notifications using multiple threads:


e Using a text editor, open the dxa-oi.conf file.


f Locate the following lines of text:


# Subscribe to a Notification List


# NLName/n


sub     Default/n


g Uncomment (delete the pound sign) the line.


h Add the number of threads, for example:


Subscribe to a Notification List


NLName/n


sub     Default/n4


i Save and close the file.
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Notification polling and Property Change
The SAM Console polls the SAM server to request batched notification updates at a default polling
interval of 10 seconds. Therefore, operations that update notifications are shown with an average delay of
a few seconds.


In SAM 8.0 and above, an option has been added to the SAM Console to choose between Notification
polling (HyperNotification) and PropertyChange (subscription based notification updates from server)
notification updates.


Notification Polling
Notification polling provides better performance over a simple Notification transfer. T o enable 
Notification polling, set the new Console property com.smarts.disableHyperNotification to FALSE by
typing the following in the command line prompt:


sm_gui -Dcom.smarts.disableHyperNotification=False


By default, this property is set to FALSE making Notification polling the default form of receiving
notification updates.


Notifications are fetched in bulk at regular intervals. This interval can be changed by setting the
environment variable, SM_SAM_TO_SAM_HYPER_NOTIF_SLEEP in the runcmd_env.sh file. The
default value for SM_SAM_TO_SAM_HYPER_NOTIF_SLEEP parameter is 10. Setting the value to 5 will
reduce the interval for fetching notifications and any mismatch in notification timestamp in a hierarchical
environment.


For example, to set an interval of 5 seconds, add the following line in the runcmd_env.sh file:


SM_SAM_TO_SAM_HYPER_NOTIF_SLEEP=5


Polling Change
To enable PropertyChange notification updates, set the Console property
com.smarts.disableHyperNotification to TRUE by typing the following in the command line prompt:


sm_gui -Dcom.smarts.disableHyperNotification=True


Setting this parameter to True, also helps avoid creation of multiple entries for a single session connected
using dmctl.


The -Dcom.smarts.disableHyperNotification parameter was introduced in the SAM 8.1 HF 3 release. The
hyper notification feature allows the console to poll the SAM server to request batches of notification
updates. The feature requires dedicated separate connections between the server and console. While
hyper notification increases the number of connections between the server and console for SAM 8.x
versus SAM 7.x, it at the same time improves the console performance and notification processing.


It is recommended that hyper notification is not disabled as it would put additional load on the server and
console, resulting in degradation of SAM performance. Exercise caution while using the -
Dcom.smarts.disableHyperNotification parameter.
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Configuring the Maintenance and Business Impact Manager
To configure the MBIM- Maintenance and Business Impact Manager:


1 Start the MBIM domain manager server.


2 Configure an MBIM domain.


â€œConfiguring domainsâ€� on page 88 provides detailed information for configuring domains and
reconfiguring SAM.


Connecting SAM to the MBIM domain provides automatic MBIM notifications. When MBIM is
disconnected, a notification appears in the console and the maintenance adapter is automatically
disabled.


3 From the Domain Manager Administration Console, attach to the MBIM domain.


4 Select the MBIM object (the root of the display).


5 Click Topology > Add Source.


6 Type the instance of SAM to use as a source of topology for the MBIM domain.


Schedule Maintenance option
To inform fellow operators that a specific managed element is entering its scheduled maintenance period,
the In Maintenance option for a specific notification is used.


Enabling maintenance tracking
To enable maintenance tracking:


1 Log in to the console.


2 In the Topology Browser Console, right-click on the name of the Service Assurance Manager server
at the top of the topology tree which is the topology source for MBIM.


3 Click Enable Maintenance.


Disabling maintenance tracking
To disable maintenance tracking:


1 Log in to the console.


2 In the Topology Browser Console, right-click on the name of the Service Assurance Manager server
at the top of the topology tree which is the topology source for MBIM.


3 Click Disable Maintenance.
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Console operations
Console operations are user actions on the console and determine a user’s access privileges to various
functions and commands provided by the Global Console. Examples of console operations include taking
ownership or acknowledging a notification, adding a view to the console, or viewing the details of a
notification. An administrator can assign one or more of these tasks to a user profile.


Interaction with VMware Smart Assurance username/password
privileges
An administrator needs All privileges, conferred by the Global Manager’s serverConnect.conf file and
console operations access privileges to perform the following administrative tasks:


n Display the Configure menu in the Global Console


n Open the Global Manager Administration Console


n Open the Domain Manager Administration Console


n Open the Group Definition Console


n Open the Topology Builder Console


n Edit Map Icons


n Save View as Dashboard viewlet


n Edit attributes in underlying domains


n Select Correlate Now or Recompute Codebook in underlying domains


n Manage or unmanage elements in underlying domains


With console operations, an administrator can assign one or more of these tasks to a user profile.


Note   Some features require a separate license, such as Business Services Maps. An administrator
can assign any feature to a user, but the feature may not be enabled.


Default user profiles
The user profiles included with Service Assurance support the following console operations:


n The admin-profile includes all console operations groups, giving users assigned to this profile
administrative access.


n The maint-profile includes the Detail Information, Map, Views, and Event Management console
operations groups, giving users operator access.


n The default-profile includes the Detail Information, Map, and Views console operations groups, giving
users read-only access.


n The oper-profile includes the Detail Information, Map, Views, and Event Management console
operations groups, giving users operator access.
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Console operations and groups
Console operations and groups lists the console operations and their assigned group. To facilitate the
configuration of user profiles, the following sets of groups are provided:


n Read Only includes the Detail Information, Map, and Views groups


n Operator includes the groups in Read Only and Event Management


n Administrator includes all groups


When one of these sets is selected, the associated groups and operations are automatically selected.


The administrator can then customize the selected groups or operations as described in Creating a
user profile.


Table 4‑2.  Console operations and groups


Group/Console operation Description


Detail Information


Browse Opens a Topology Browser view from the Global Manager and
displays the element as the root.


Browse Detail Opens a Topology Browser view from the underlying
Domain Manager and displays the element as the root.


Expand Map Node Expands a map node to display connected nodes.


Show Containment Displays an element’s components.


Map


Physical Connectivity Opens a map displaying physical connectivity.


IP Connectivity Opens a map displaying IP connectivity.


VLAN Connectivity Opens a map displaying VLAN connectivity.


Membership Opens a map showing group elements (IP or VLAN).


Business Services Opens a map displaying business elements.


Application Opens a map displaying application elements.


Network Protocol Manager Connectivity Opens a map that depicts topology and connectivity for:
n BGP Connectivity
n OSPF Connectivity
n OSPF Network Connectivity
n EIGRP Connectivity
n EIGRP Network Connectivity
n ISIS Connectivity
n ISIS Network Connectivity


MPLS Connectivity Opens a map that depicts MPLS topology.


Multicast Connectivity Opens a map that depicts Multicast topology.


Multicast A Multicast map depicts multicast topology.


Storage Network Connectivity Opens a map that depicts storage network topology.
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Table 4‑2.  Console operations and groups (Continued)


Group/Console operation Description


Views


Notification Log Provides the ability to access a Notification Log view.


Topology Browser Provides the ability to access a Topology Browser view.


Summary Provides the ability to access a Summary view.


Status Table Provides the ability to access a Status Table view.


Map Open a Map Console.


View Configuration


Notification View Filter Create a filter for a Notification Log.


Summary Filter Create a filter for Summary Views.


Edit Summary Parameters Edit a Summary View configuration.


Add Summary Add a Summary to a Summary View.


Delete Summary Remove a Summary from a Summary View.


Status Table Configuration Edit Status Table configuration.


Console


Save Save the console to wherever it was originally loaded from, local or
remote.


If a console has not been previously saved, the system will prompt
the user for information on where to save the console.


Save Remote As Save a console to the Global Manager.


Open Local Open a console from the local system.


Open Remote Open a Console from the Global Manager.


InCharge Manager Attach Attach to a Domain Manager.


InCharge Manager Detach Detach from a Domain Manager.


Views Management


Add View Provides the ability to add a view to a console, and also open a new
console (for example, Notification Log Console).


Note   You can only add views or open a console for views for which
you have permission to access.


Delete View Remove a view from the console.


Copy View Copy a view in the console.


Copy View as New Console Copy a view in the console and open as a new console.


Set View Context Listening Set listening context for active view.


Event Management


Take Ownership Take ownership of a notification.


Release Ownership Release ownership of a notification.


Schedule Maintenance Schedule maintenance on a managed element.
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Table 4‑2.  Console operations and groups (Continued)


Group/Console operation Description


Acknowledge Acknowledge a notification.


Unacknowledge Unacknowledge a notification.


Notification Properties Open a notification properties dialog or add notification properties
view to console.


Administration


Configure Group Open a Groups Definition Console.


Configure Global Manager Administration Console Open a Global Manager Administration Console.


Configure Domain Manager Administration Console Open a Domain Manager Administration Console.


Configure Map Icons Specify custom icons for map nodes using the Global Manager
Administration Console.


Launch Topology Builder Open the Topology Builder Console.


Save View as Viewlet Save a view as a viewlet for the InCharge Business Dashboard.


Console operations allowed for all users
There are additional console operations that are always available and cannot be removed from the
console. Console operations allowed for all users lists of the more useful of these console operations.


Note   There are other operations that cannot be removed from the console that are not included in this
table.


Table 4‑3.  Console operations allowed for all users


Console view/console operation Description


Notification Log View/Console


Sort Columns Sort notifications by selected column.


Select Columns Select columns to display in the log.


Save log contents to file Save the log to a file on the local system.


Freeze Display Freeze the log to prevent display of new notifications.


Summary View/Console


Layout Set the number of summaries per row.


Move Summary Left Move a summary one summary to the left.


Move Summary Right Move a summary one summary to the right.


Topology Browser View/Console


Select Control the set of classes or instances displayed in the tree.


Refresh tree Refresh the tree view.


Make Root Make the selected instance the root of the tree.


Map View/Console
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Table 4‑3.  Console operations allowed for all users (Continued)


Console view/console operation Description


Save map Save a map to the Global Manager.


Edit map filter Edit classes displayed in a map.


Set background Load a background image for a map.
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System Configuration for the
Global Manager 5
This chapter includes the following topics:


n Defining Domain Manager parameters


n Defining system defaults


n Configuring business templates


n Configuring Global Manager Administration Console preferences


n Configuring IPv6 Availability Manager connections


n Audit logging


n SAM performance throughput report


n Notification lifecycle auditing


n Configuring weights.conf for OTM


n Hierarchical SAM configuration


Defining Domain Manager parameters
A Domain Manager refers to an underlying analysis application, such as IP Availability Manager,
Storage Insight for Availability, Adapter Platform, or other Global Manager that serves as a source of
event and topology data. You specify these domains and the parameters that control the import of event
and topology data in the domainconfig section of the ics-default.xml file.


The domainconfig section is divided into one or more domaintype subsections, each of which defines the
configuration for one or more underlying domains. The following example shows the syntax of a
domainconfig section when the underlying domain is IP Availability Manager:


<domainconfig>


        <domaintype


            name="AM-Suite"


            description="Type for AM-Suite"


            dxaConfFile="dxa-conn.conf"


            MinimumCertainty="0.01"


            SmoothingInterval="65">
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            <hook enable="False">ics/dxa-sample-hook.asl</hook>


            <domainname>INCHARGE-AM-1</domainname>


            <domainname>INCHARGE-AM-2</domainname>


        </domaintype>


Parameters defining the domainconfig section describes the domainconfig parameters.


Table 5‑1.  Parameters defining the domainconfig section


Parameter Description


name Defines the domain name.


description Defines the description of the domaintype.


dxaConfFile Defines the data exchange file that corresponds to the underlying domain. A data
exchange file ensures that Global Manager receives the correct event and topology data. 
Defining Domain Manager parameters specifies the correct data exchange file for each
product.


MinimumCertainty Defines the minimum value that the Certainty attribute must have before an event is sent
to the Global Manager from the underlying domain. Events with a Certainty value below
the threshold are discarded. This value must be a number between 0.0 and 0.99.


The default value is 0.01 for IP Availability Manager and IP Performance Manager.
Otherwise the default is 0.24.


Note   The MinimumCertainity parameter does not apply to underlying Adapter Platform
servers or other Global Managers.


SmoothingInterval Defines the time, in seconds, an event must be active before it is sent to the
Global Manager.


The default value is 65 seconds.


Note   The SmoothingInterval parameter does not apply to underlying Adapter Platform
servers or other Global Managers.


hook [Optional] Defines the name of an ASL script that modifies a notification. Typically, this is
used to add information to one of the user-defined fields of a notification. Hook scripts
must be located in the BASEDIR/smarts/local/rules directory. You must prefix the name
of the script with the directory in which it is located, typically this is the ics directory.


For example, the ics/dxa-sample-hook.asl hook script is located in the
BASEDIR/smarts/local/rules/ics directory.


Note   The default ASL hook scripts are placeholders for a script you must provide. A
hook script is not required unless you need to perform additional processing on the
notifications coming from the underlying domain. “User-defined notification attributes” on
page 115 describes possible uses for hook scripts.


domainname Defines the name of the underlying domain. You can specify multiple domains with the
same configuration by adding name parameters to the domaintype section. However, the
value of each name parameter within a domaintype section must be unique.


Data exchange files or underlying domains
Data exchange file for each product lists the data exchange files that should be used for each product.
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Table 5‑2.  Data exchange file for each product


Product Component Data exchange file


Service Assurance Manager Global Manager dxa-sam.conf


Adapter Platform dxa-oi.conf


Adapter for BMC Patrol dxa-bmc.conf


SDI Adapter dxa-sdi.conf


MBIM server dxa-sam-from-mbim.conf


IP Manager 7.0 IP Availability Manager dxa-conn.conf


IP Performance Manager and
IP Server Performance Manager


dxa-perf.con


IP Availability Manager and
IP Performance Manager


dxa-conn-perf.conf


IP Discovery Manager dxa-dm.conf


IP Manager 6.x IP Availability Manager dxa6X-conn.conf


IP Performance Manager and
IP Server Performance Manager


dxa6X-perf.conf


IP Availability Manager and
IP Performance Manager


dxa6X-conn-perf.conf


IP Discovery Manager dxa6X-dm.conf


IP Manager 4.x IP Availability Manager dxa4X-conn.conf


IP Performance Manager dxa4X-perf.conf


IP Availability Manager and
IP Performance Manager


dxa4X-conn-perf.conf


Network Protocol Management Suite Network Protocol Manager for BGP dxa-bgp.conf


Network Protocol Manager for OSPF dxa-ospf.conf


Network Protocol Manager for EIGRP dxa-eigrp.conf


Network Protocol Manager for IS-IS dxa-isis.conf


Storage Insight Manager Storage Insight for Availability dxa-storage-analysis.conf


dxa-storage-topology.conf


VoIP Management Suite VoIP Availability Manager dxa-sam-from-voip.conf


Application Insight Application Connectivity Monitor dxa-sam-from-acm.conf


Application Insight dxa-sam-from-ai.conf


MPLS Manager MPLS Manager dxa-mpls-vpn-ics-analysis.conf


dxa-mpls-vpn-ics-monitoring.conf


dxa-mpls-vpn-ics-topology.conf


dxa-mpls-vpn-ics.conf


ATM/Frame Relay Availability Manager ATM/Frame Relay Availability Manager dxa-sam-from-atmfr.conf


XD Manager for ATM/FR-to-IP AM dxa-sam-from-xdatmfrip.conf
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Table 5‑2.  Data exchange file for each product (Continued)


Product Component Data exchange file


Multicast Manager Multicast Manager dxa-mcast.conf


Optical Transport Manager Optical Transport Manager for SONET dxa-sam-from-sonet.conf


Optical Transport Manager for WDM dxa-sam-from-wdm.conf


XD Manager OTM to IP dxa-xd-otm-ip.conf


Application Connectivity Monitor 1.0 Application Connectivity Monitor dxa-app-poller.conf


Application Services Manager 1.0 Application Services Manager dxa-asm10.conf


Application Services Manager 1.1 Application Services Manager dxa-asm.conf


CiscoWorks Device Fault Manager CiscoWorks Device Fault Manager dxa-dfm.conf


CiscoWorks Voice Health Monitor CiscoWorks Voice Health Monitor dxa-vhm.conf


Security Infrastructure Manager Security Infrastructure Manager dxa-sim.conf


Defining system defaults
System defaults are system-wide settings that affect the Global Manager and its clients.


To configure system defaults:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the SAM Manager.


3 Expand ICS Configuration.


4 Click System Defaults.


The Configure System Defaults interface appears, as illustrated in Global Manager Administration
Console—Configure System Defaults.
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Figure 5‑1.  Global Manager Administration Console—Configure System Defaults


System Defaults parameters describes the System Defaults parameters.


Table 5‑3.  System Defaults parameters


Parameter Description


Auto Acknowledgement Interval Defines interval, in seconds, after which an inactive and unowned notification is
acknowledged. Notifications that are acknowledged by the Global Manager are
owned by the user SYSTEM.


Default: 300 seconds


Inactive Auto Archive Interval Defines interval, in seconds, after which an inactive and acknowledged
notification is archived. If this value is set to zero, archiving is disabled and
notifications will not be deleted, causing Global Manager to use more memory.


Default: 14400 seconds (4 hours)


Audit Trail Size Limit Defines the number of audit log entries for each notification that are saved and
visible in the Global Console before the log contents are archived. When this
limit is reached, half of the entries are written to the notification archive.


Default: 100 entries


SMTP Server Defines the name of the SMTP mail server through which mail messages sent
by the Global Console’s Mail tool are sent. This mail server must be reachable
from the host where the Global Manager is running. This value can be
overridden in the Global Console.


Default: “localhost”
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Table 5‑3.  System Defaults parameters (Continued)


Parameter Description


Fetch Local Notification Properties Defines how the properties of a particular notification are retrieved when
requested by a client application. If set to “true”, properties are retrieved from
the Global Manager. If set to “false”, properties are retrieved from the Global
Manager and from the underlying domain.


Note   The values configured for this parameter affect the performance of the
Service Assurance Manager.


Client applications include the Global Console, the dmctl utility, and adapters.


Default: False


RMI Time Out Defines the maximum amount of time, in seconds, the Global Manager is
allotted to retrieve Notification Properties, Find System, or get System
Containment information from an underlying domain. If a negative value is
specified, no time-out value is set.


Default: 60 seconds


Number Of Worker Threads Defines the number of worker threads used by the escalation mechanism in
executing tools associated with escalation levels in escalation paths. Increase
the number of threads if the escalation mechanism falls behind in executing
tools for escalation levels. Valid values are 1 - 10.


Default: 2


Broadcast Event State on Restart Defines whether notifications that result from internal Global Manager events
are propagated to clients that subscribe to them. Internal Global Manager
events include system disconnects and system reconfigurations. If set to True,
notifications resulting from internal Global Manager events are propagated. If
set to False, the events are not propagated.


When configuring this parameter, the value must be identical for all Service
Assurance Manager servers within your Service Assurance Manager
deployment. For changes to this parameter configuration to take effect, the
Service Assurance Manager servers must be restarted.


Note   For optimum benefit, configure this parameter as early in your
Service Assurance Manager deployment as possible, before all source
domains are added to the Service Assurance Manager server. The quickest
way to apply this parameter configuration is to restart the
Service Assurance Manager server. However, if you are configuring this
parameter in a production environment, apply the parameter configuration to
the Service Assurance Manager server by making a minimal change to the
configuration of each of the underlying source domain types, and clicking the
Reconfigure button. One example of a minimal configuration change is to
modify the value for the Smoothing Interval parameter. A minimal configuration
change is required for each domain type. This results in the
Service Assurance Manager server disconnecting from each underlying
domain, rereading all the settings including the new modification, and then
reconnecting to the underlying domains.


Default: True
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Table 5‑3.  System Defaults parameters (Continued)


Parameter Description


Hierarchical Acknowledge Defines whether acknowledging or unacknowledging a notification in the server
sends the acknowledge (or unacknowledged) information to the underlying
servers. If set to True, the notification in the underlying servers are also
acknowledged or unacknowledged. If set to False, the notification in the
underlying servers are not changed.


Default: True


Companion UI Hostname Defines the location of the related Companion UI vApp. The accepted values
are the Domain Name System (DNS) host or the IP address of the vApp (for
example, companionUI or companionUI.mycompany.com).


Use DNS Lookup in This Domain Defines whether the system performs Domain Name System (DNS) searches
when searching for computer systems. If set to True, the system queries the
DNS in this domain.


Note   When performing a DNS search, perform the search from the Adapter
Platform (OI).


Default: True


Use DNS Lookup in Underlying Domains Defines whether the system uses Domain Name when searching for computer
systems. If set to True, the system queries the DNS in underlying domains.


Default: True


Use DNS Domains in DNS Lookup Defines whether DNS domains are used when the system performs a DNS
search. If set to false, only original domain names are used during the DNS
search.


Default: False


DNS Domain Names Defines the list of domain names the system uses when performing a DNS
search.


Note   When entering multiple domain names, separate each domain name
with a comma.


Underlying Domains Order Defines the order in which the underlying domains are searched.


Note   When entering multiple domain names, separate each domain name
with a comma.


Fully Qualified Domain Name Suffixes Defines which domain names returned as a result of performing a DNS search
are considered to be fully qualified. Domain names matching suffixes entered in
this parameter are considered fully qualified.


1 Type or select your system defaults configuration options.


2 Click Apply.


Note   System defaults cannot be deleted.
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About acknowledging notifications
When a notification is acknowledged, an entry is appended to the notification’s Audit Log. In addition, the
values of two notification attributes are set: Owner and Acknowledged. The value of the Owner attribute is
set to the username of whomever acknowledged the event. The value of the Acknowledged attribute is
set to TRUE.


If a notification is unacknowledged, another entry is appended to the notification’s audit log. The value of
the Owner attribute is set to the VMware Smart Assurance username of whomever unacknowledged the
notification and the value of the Acknowledged attribute is set to FALSE.


Auto acknowledgement is a facility designed for notifications that clear before an operator is able to
acknowledge them. Usually a notification will clear shortly after it appears. Instead of requiring operators
to manually acknowledge such notifications, the Global Manager automatically acknowledges unowned
notifications after they remain inactive (clear) for the time specified by the AutoAcknowledgementInterval.
Notifications acknowledged by the Global Manager have their Owner attribute set to SYSTEM.


After a notification is acknowledged, it is eligible for archiving. The Global Manager will not archive an
active or unacknowledged notification.


Archiving notifications
Old notifications are periodically removed from the Global Manager’s repository and archived to a file. The
notification archive includes the values of the notification’s attributes at the time it is archived, including
the contents of the audit log. This archive is intended to provide a record of information before it is
deleted.


The VMware Smart Assurance Report Manager User Guide describes how to generate historical reports
based on notification data. Report Manager does not use the notification archive for reporting, but
maintains the notification information in a relational database.


Archived notifications are written to the file <global_manager>.archive, where <global_manager> is the
name of the Global Manager. By default, this is INCHARGE-SA so the resulting notification archive is
named INCHARGE-SA.archive. This file is written to the BASEDIR/smarts/local/logs directory.


Note   Over a period of time, a busy Global Manager can generate a sizeable archive file. It may be
necessary to periodically rotate the notification archive file.


Configuring business templates
Business templates are used to load business entities. Two types of business entities are topology-
group/service data files and Business Impact Manager weights files.


Both topology-group/service data files and Business Impact Manager weights data can be loaded using
text or XML files.


To configure business templates:


1 Open the Global Manager Administration Console.
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2 From the Manager list, select the SAM Manager.


3 Expand ICS Configuration.


4 Click Business Templates.


The Configure Business Templates interface appears, as illustrated in Global Manager
Administration Console—Configure Business Templates.


Figure 5‑2.  Global Manager Administration Console—Configure Business Templates


5 Select the format for the type of data file being configured.


Note   TEXT is the default format file type for both topology-group/service data files and the Business
Impact Manager weights files.


6 Click Modify List to add business template files.


Note   Click Remove Selected to delete a selected business template file from the list.


7 Click Apply.


Note   Business templates cannot be deleted.


Configuring Global Manager Administration Console
preferences
The following preferences are configured using the Global Manager Administration Console Preferences
dialog box:


n DXA configuration file cannot be found at the server location


n Hook script cannot be found at the server location
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n Business template file cannot be found at the server location


n Prompt for confirmation when closing the console with a server which requires reconfiguration


n Prompt for confirmation when exiting the application with a server which requires reconfiguration


n Remind to reconfigure after changing Domain configuration


n Remind to reconfigure after changing Domain Group configuration


n Remind to reconfigure after changing Domain Type configuration


n Remind to reconfigure after changing Domain Tag configuration


To configure Global Manager Administration Console Preferences:


a From the Global Manager Administration Console, select View > Global Administration
Console Preferences.


The Global Administration Console Preferences dialog box appears, as illustrated in Global
Administration Console Preferences dialog box.


Figure 5‑3.  Global Administration Console Preferences dialog box


b Select or click your desired configuration options.


c Click Apply.


Note   Click Restore Defaults to restore the default configuration settings.
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Configuring IPv6 Availability Manager connections
The SM_IP_VERSIONS environment variable allows you to define the Internet Protocol (IP) version used
when SAM is running in an IPv6 network.


To configure this variable:


1 Using a text editor, edit the runcmd_env.sh file. The runcmd_env.sh file is located in the
BASEDIR/smarts/local/conf/ directory.


2 Add the following line:


               SM_IP_VERSIONS=<


               value


               >


            


3 Save and close the file.


4 Edit the com.smarts.ip_versions Java property. The value for this property must match the value
entered for the SM_IP_VERSIONS environment variable.


The VMware Smart Assurance System Administration Guide provides detailed environment variable
information.


Examples of specifying the IP version
Code examples that specify the IP version when connection, include:


frame:v4


frame:v6


frame:v4v6


frame:v6v4


frame:v6:3026    ## 3026 is the port


[1:1::1111]:3026 ## 3026 is the port


The IP version in the following example is redundant but allowed:


[1:1::1111]:v6:3026 ## 3026 is the port


[1:1::1111]:v4v6:3026 ## 3026 is the port


Audit logging
Entries written to the audit log include specific user interactions with VMware Smart Assurance analysis
servers.


Audit logging is enabled on the Service Assurance Manager and analysis servers when a modification is
made to the servers from the Global Console.
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Actions that a user may perform in the Global Manager Administration Console that are captured in the
audit logs include:


n Escalation Policies


n Add an escalation policy


n Delete an escalation policy


n Modify an escalation policy


n Disable an escalation policy


n Enable an escalation policy


n Notification Lists


n Add a new notification list


n Delete a notification list


n Modify a notification list


n Modify filters


n Modify display headings


n Disable a notification list


n Enable a notification list


n Tools


n Add a new tool


n Delete a tool


n Modify a tool


n Allow different user profiles access to the tool


n Disable a tool


n Enable a tool


n User Profiles


n Add a user profile


n Delete a user profile


n Modify a user profile


n Modify notification list


n Modify users associated with profile


n Modify tools the user profile can access


n Modify default console


n Modify console operations the user profile can access
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n Disable a user profile


n Enable a user profile


This section includes the following topics:


n Configuring the Audit Log Adapter


n Starting the Audit Log Adapter


n Starting a new log file


n Filtering the Audit Log


Configuring the Audit Log Adapter
To generate audit log output on a server you must add the SM_AUDIT_CLIENT_ACTIONS environment
variable to the runcmd_env.sh file. The runcmd_env.sh file is located in the BASEDIR/smarts/local/conf
directory.


To add the SM_AUDIT_CLIENT_ACTIONS environment variable to the runcmd_env.sh file:


1 Invoke the sm_edit utility from the BASEDIR/smarts/bin directory:


               sm_edit conf/runcmd_env.sh


            


2 Add the following environment variables and corresponding values using the following syntax:


SM_AUDIT_CLIENT_ACTIONS=TRUE


SM_AUDIT_ALL_CONNECTIONS=1


3 Save and close the runcmd_env.sh file.


4 Restart any VMware Smart Assurance program currently running for the new environment variables
to take effect.


Starting the Audit Log Adapter
To start the Audit Log Adapter, type the following command:


tBASEDIR/smarts/bin/sm_server -n <adapter_name>


--config=audit-parse --outputs


Where:


n <adapter_name> is the name of the Audit Log Adapter. It is recommended that you name the Audit
log Adapter relative to the server for which it is performing audit parsing, for example, INCHARGE-
SAM-AUDIT.


Note   t s Indicates that this command must be typed as one line. Separate each option with a space
when typing the command.
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To name the Audit Log Adapter a name other than <adapter_name>:


a Copy the Sam/Smarts/conf/audit-parse/adapter-name.conf file to the sam/smarts/local/conf/audit-
parse directory.


b Rename the adapter-name.conf file with the same name as the Audit Log Adapter.


For example, if the Audit Log Adapter name is Audit-log, the adapter-name.conf file should be
renamed Audit-log.conf.


Starting a new log file
The roll_sam_auditlog command is invoked through the dmctl utility, which requires that you attach to a
Domain Manager or adapter with administrative privileges. The syntax of the command is:


serverName exec roll_sam_auditlog


On UNIX systems, the equivalent command is:


opt/InCharge/SAM/smarts/bin/dmctl -s InCharge exec roll_sam_auditlog


When roll_sam_auditlog is invoked, the Domain Manager or adapter writes an informational message to
the end of the current log file, repeats the steps it executed at startup, and creates a new log file and a
backup log file. All subsequent logging information is recorded to the new file.


Filtering the Audit Log
By default, the SAM audit log performs an audit and logs SAM functions in the .audit file without filtering.
When logging of client actions is enabled, the audit log provides information about client actions that
changed the state of the server, such as put, insert, remove or delete requests. The audit ignores
requests for information that do not change the state of the server, for example, get requests.


Many operations do not change the state of a server, and hence do not need to be logged or audited. The
conf/ics/sam-audit-filter.import file contains a list of operations that are known to not change the state of
the server. If a new operation is added that does not change the state of the server or if you do not want a
particular operation logged, then the operation may be added to the file to suppress logging that operation
when it is invoked. Each operation to be suppressed is listed on a separate line as a string containing the
class name, two colons, and the operation name.


In order to exclude redundant functions from the .audit file, a filtering criteria is available. To exclude
functions from the audit log, add them to the conf/ics/sam-audit-filter.import file. After the file is updated,
restart SAM.
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SAM performance throughput report
SAM performance throughput report provides users with information on notifications processed, notified,
cleared and changed within a specified time interval. The report explains the possible slowdown in SAM
performance and provides a better view into the health of SAM. The report, referred to as the <SAM-
SERVER-NAME>.perf file, is available under the <BASEDIR>/smarts/local/logs directory.


This report provides information on notification processing attributes such as:


n Average notification processing time


n Average impact refresh calculation time


n Number of topology synchronizations that have occurred during the default monitoring duration


n Average time for processing hook files


n Number of connected events


n Number of disconnect events


n Number of suspended events


n Number of cleared events


n Number of timer alarms


n Number of events with heart beats


n Number of rejected events


n Number of accepted events


n Number of notified events


n Average time taken to push an event to the NOTIF processing queue


The monitoring period for the report is controlled by the PERF_ARCHIVE_INTERVAL environment
variable. The default time interval for this variable is set to 3600 seconds (that is, one hour). At an
interval of every one hour, the above mentioned performance statistics are written to the <SAM-
SERVER-NAME>.perf file.


Each record in the file is in the following format:


<DATA-TIME> - <DOMAIN-MANAGER-NAME> : Performance metrics


Provided below is an example of the SAM performance throughput report:


 December 19, 2011 4:23:19 PM GMT+05:30 - VMware Smart-IT : Avg_NotificationProcess_Time = 0      


Avg_ImpactRefresh_Time = 0      No_Toposync = 0 Property_Control = 0Attrib_Change = 0        


Connect = 0     Suspend = 0     Clear = 0       Avg_HookFileProcess_Time = 0    


Avg_NotifProcess_Time = 0       Timer_Alarm = 60    Disconnect = 0   Heart_Beat = 0  Reject = 


0      Accept = 0      Notify = 0      Total_Count = 60
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You can modify the default time interval set for the PERF_ARCHIVE_INTERVAL environment
variable in the ics-event-processing.asl and the ics-nl-processing.asl files. These files are located
under the <BASEDIR>/local/rules/ics folder or the <BASEDIR>/rules/ics folder. The modification must
be carried out in both the ics-event-processing.asl and the ics-nl-processing.asl files. Use the
sm_edit utility to modify the values to these files. For example:


               BASEDIR/smarts/bin>sm_edit ../rules/ics/ics-event-processing.asl


            


You must reconfigure the domain for the changes to take effect.


Performance threshold event in SAM
As part of performance monitoring, few threshold values have been defined in the
DEFINE_PERF_THRESHOLD_VALUES rule, available in the ics-event-processing.asl and ics-nl-
processing.asl files. You can find these ASL files in the <BASEDIR>/local/rules/ics folder or the
<BASEDIR>/rules/ics folder. For example, the default number of threads for disconnected events in an
hour is one. If case more than one disconnected event is found, SAM generates a performance
monitoring severity 2 notification in SAM with relevant details. This notification will get auto-cleared after
an hour as defined in the PERF_ARCHIVE_INTERVAL environment variable.


SAM performance monitoring threshold setting parameters lists the SAM performance monitoring
threshold setting parameters. This feature is not enabled by default. You can enable this feature by
setting the value for the PERF_THRESHOLD_EVENT flag to TRUE in both the ics-event-processing.asl
and ics-nl-processing.asl files.


Table 5‑4.  SAM performance monitoring threshold setting parameters


Parameter Default Values


Number of Topology Synchronization The maximum is one topology synchronization operation every 10 minutes for a
given domain manager.


Number of disconnect Events The maximum is one disconnected event in an hour for a given domain manager.


Average Impact Refresh Calculation Time The average time taken must not be more than 5 seconds.


Average Notification Processing Time The average time taken must not be more than one second.


Average Hook file processing Time The average time taken must not be more than two seconds.


Average Time taken to push an Event to
NOTIF processing queue


The average time taken must not be more than two seconds.


You can modify the default values for the performance monitoring threshold parameters by modifying the
values for the parameters both in the ics-event-processing.asl and the ics-nl-processing.asl files. Use a
text editor or the sm_edit utility to modify the values. For example:


         BASEDIR/smarts/bin>sm_edit ../rules/ics/ics-event-processing.asl


      


You must reconfigure the domain for the changes to take effect.
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Notification lifecycle auditing
Notification lifecycle auditing feature helps you identify any kind of delay in the event or notification
processing lifecycle. If this feature is enabled the audit log includes additional information such as the
time spent by a notification in a hook script, in addition to notify, refresh impact, NOTIF processing,
change and clear events.


Auditing entries are displayed for the following stages of event or notification processing:


n Notification creation and updating of notification attributes


n Topology element linking


n Hook script invocation


n Impact and CausedBy relationship update


n NOTIF processing


The feature is disabled by default and can be manually enabled when required for that specific
domain by setting the variable detailedEventAudit to TRUE.


To enable notification lifecycle auditing, type the following command:


#dmctl -s <SAM-Server> put InChargeDomain::InChargeDomain_<omain Name>::detailedEventAudit
TRUE


For example,


#dmctl -s <SAM-Server> put InChargeDomain::InChargeDomain_INCHARGE-AM::detailedEventAudit TRUE


The feature can be disabled for each domain by setting the parameter detailedEventAudit to FALSE
using the same command:


#dmctl -s <SAM-Server> put InChargeDomain::InChargeDomain_INCHARGE-AM::detailedEventAudit FALSE


The values of the EventAudit and NotificationAudit flags in the DXA configuration files associated with
the underlying domain are internally changed based on the value set for detailedEventAudit.


Note   VMware recommends that you use the variable detailedEventAudit to enable or disable
notification lifecycle auditing. Modifying values in the DXA configuration files can cause a conflict and
there is a chance that the value of detailedEventAudit will get overwritten when the event driver
restarts.


The audit trail has a size limit and is by default set to 100 entries. Defining system defaults section in
the VMware Smart Assurance Service Assurance Manager Configuration Guide describes the
procedure to modify the default audit trial size limit.
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Configuring weights.conf for OTM
Note   This is an Optical Transport Manager (OTM) product-specific configuration in SAM, and hence not
required to be carried out by other product users.


The SAM weights.conf file must be configured in the SAM installation area. After you install SAM, the
following new, weights files are installed in SAM installation area:


n <BASEDIR>smarts/conf/ics/weights.conf


n <BASEDIR>smarts/conf/ics/weights-otm.conf


Note   The weights-otm.conf contains the names of the classes which need to be appended to
weights.conf for Impact count calculation.


a Use sm_edit to open the <BASEDIR>smarts/conf/ics/weights.conf and the
<BASEDIR>smarts/conf/ics/weights-otm.conf.


b Copy the following configuration items from <BASEDIR>/smarts/conf/ics/weights-otm.conf:


n ClassWeight OpticalNetworkElement 0


n NotificationClassWeight HighOrder_Circuit 1


n NotificationClassWeight LowOrder_Circuit 1


n NotificationClassWeight ClientCircuit 1


n NotificationClassCheck TopologicalLink


n NotificationClassCheck DropSideTopologicalLink


n NotificationClassCheck BBFiberLink


n NotificationClassCheck BBTopologicalLink


n NotificationClassCheck BBDropSideTopologicalLink


n NotificationClassCheck Equipment


n NotificationClassCheck Card


n NotificationClassCheck EquipmentProtectionGroup


n NotificationClassCheck FiberLink


n NotificationClassCheck FiberBundle


n NotificationClassCheck OpticalNetworkElement


n NotificationClassCheck HighOrder_Trail


n NotificationClassCheck LowOrder_Trail


n NotificationClassCheck Transponder


n NotificationClassCheck Amplifier
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n NotificationClassCheck PTP


n NotificationClassCheck Conduit


c Paste the configuration items to <BASEDIR>/conf/ics/weights.conf.


d Save and close conf/ics/weights.conf.


e Close conf/ics/weights-otm.conf without saving.


VMware Smart Assurance Optical Transport Management Installation Guide provides detailed
instructions on installing OTM.


Hierarchical SAM configuration
In a typical SAM configuration, when the server is started it does not contain the dynamic library to load
all custom classes, for example, UIM_O_AdapterManager. In a custom hierarchical SAM configuration,
this could result in generating ASL errors.


The following configuration must be made in the hierarchical SAM area to avoid the generation of ASL
errors:


1 Copy dyn_uii.ldm and dyn_uii.mdl files from the Service Assurance Manager
BASEDIR/smarts/model/ics files to the BASEDIR/smarts/local/model/top-sam folder. Here, top-sam is
the custom created folder for the top-level SAM.


2 Restart the server.


VMware Smart Assurance Service Assurance Manager Configuration Guide


VMware, Inc.  70







Configuring Domains 6
This chapter includes the following topics:


n Configuring domains


n Configuring domain groups


n Configuring domain types


n Managing overlapping elements from separate underlying domains


n Configuring domain tagging


n Reconfiguring the server


Configuring domains
This section provides detailed information on configuring domains and includes the following topics:


n Creating a domain


n Modifying domains


n Deleting domains


Available domains defines the domains available.


Note   The domains will be available in the Console only if SAM is started without an RPS file. For
domains with existing RPS files, the domains will not be available. The INCHARGE-AM domain is
enabled by default. All other domains are disabled.


Table 6‑1.  Available domains


Domain Description


INCHARGE-AM-PM Availability and Performance Manager


INCHARGE-AM Availability Manager


INCHARGE-DISCMGR Discovery Manager


INCHARGE-MPLS-ANALYSIS Analysis Server for MPLS 2.0


INCHARGE-MPLS-MONITORING Monitoring Server for MPLS 2.0


INCHARGE-MPLS-TOPOLOGY Topology Server for MPLS 2.0
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Table 6‑1.  Available domains (Continued)


Domain Description


INCHARGE-OI Adapter Platform


INCHARGE-PM Performance Manager


INCHARGE-MBIM MBIM Manager


NCM Network Connectivity Monitor


Note   You can use sm_config utility to import domain configurations. However, VMware Corporation
recommends that you create and modify domains using the Domain Creation Wizard and the Global
Manager Administration Console. Creating a domain and Modifying domains provide detailed information.


Creating a domain
To create a domain:


1 From the Global Manager Administration Console, click Edit > New Domain.


The Domain Creation Wizard appears.


2 Type the name of the domain server in the Domain Name field.


3 Type the description of the domain in the Domain Description field, and click Next.


Note   To create a domain using the Copy Existing option, select an existing domain server from the
Copy Existing list, type a Domain Name, and click Finish.


4 Click the domain type. Available options include:


n Use Default Type


Note   This option is available only when copying an existing domain.


n Create New Type


If this option is selected, type the name of the domain type in the Type Name field.


To copy an existing domain type, select an existing domain type from the Copy Existing list.


n Select Existing Type


If this option is selected, select a domain type from the Select Type list.


5 Click Next.


6 Type the tag string in the Tag String field.


Note   If a tag string is not specified, go to step 12.


7 Click Next.
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8 Click the appropriate option. Available options include:


n Use Default Tag


Note   This option only appears when a copied domain is selected or when the selected domain
has an assigned tag.


n Create New Tag


Type a name in the Tag Type Name field. To copy an existing tag, select a tag from the Copy
Existing list.


n Select Existing Tag


Select a tag from the Select Tag list.


9 Click Next.


10 Type description in the Tag Description field.


11 Type a matching tag pattern in the Matching Pattern field.


12 Click Next.


13 Select the groups this domain belongs to from the Available Groups list.


14 Click the group’s role. Available options include:


n Topology Server


n Monitoring Server


n Analysis Server


Note   This step is only required if configured groups exist.


15 Click Add to move the group to the Selected Groups list.


16 Click Next.


The instance that will be created when the domain creation process is complete is displayed.


Note   By default, the domain is enabled. If the domain is part of a domain group, it is only enabled if
the domain group it belongs to is enabled. To disable the domain, clear its checkbox.


17 Click Finish.


Domain naming conventions
To allow the console to easily suppress names of component domain servers, domain names must
comply with the following naming convention:


Group Name-Role[-Sub-Role]
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Where:


n Group Name — Identifies the function of the group (for example, MPLS) as well as the region or other
further designation if multiple groups with the same function are being deployed. For example, MPLS-
NA might designate the MPLS server group monitoring North America.


n Role — Must be one of MONITORING, TOPOLOGY, or ANALYSIS. This is the key field the graphical
user interface uses to identify component servers.


n Sub-Role — Distinguishes multiple servers within the same role. For example, MPLS-Monitoring-
Snmp and MPLS-Monitoring-Ping.


Modifying domains
To modify a domain:


1 Open the Global Manager Administration Console.


2 From the Manager List, select the SAM Manager.


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domains.


6 Click the appropriate domain.


The Configure Domain interface appears, as illustrated in Global Manager Administration Console—
Configure Domain interface.
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Figure 6‑1.  Global Manager Administration Console—Configure Domain interface


7 Type the appropriate configurations.


Domain parameters describes the available Domain parameters.


Table 6‑2.  Domain parameters


Parameter Description


Enable Enables the domain.


Domain Description Provides a description of the domain.


Domain Type Defines the domain type.


Show Type Details Displays the domain type information.


Tag Type Defines the tag type.
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Table 6‑2.  Domain parameters (Continued)


Parameter Description


Tag String Defines the tag string.


Domain Groups Defines the domain groups in which the domain is included.


The table includes the following columns:
n T — Topology
n M — Monitoring
n A — Analysis


Note   Click Add New to display the Add Domain Group dialog box.
Select a Domain Group and click Delete Selected to remove a domain
group.


1 Click the Apply.


2 Click Reconfigure.


Note   Configuration changes are not applied until the Reconfigure button has been clicked. Clicking
the Reconfigure button starts the data synchronization process. Click the Reconfigure button only
after all updates to domains, domain tags, domain groups, and domain types have been made.


Deleting domains
To delete domains:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the SAM Manager.


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domain.


6 Click the appropriate domain.


7 Select Edit > Delete.


The selected domain is deleted.


Note   Domains that refer to other domains cannot be deleted.


Configuring domain groups
A typical domain group comprises three servers—a topology server, an analysis server, and a monitoring
server.


Note   For more complex deployments, contact Custom Engineering.
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The Configure Domain Group interface consists of a description of the domain group and three sections
listing the topology servers, monitoring servers, and analysis servers. A typical MPLS deployment
includes one of each type of server. The pane included on the left of the interface displays the default
configuration of the Service Assurance Manager (SAM) server.


Note   Most domain objects included in the default configuration are disabled (except INCHARGE-AM).
The MPLS Group is disabled by default.


This section includes the following topics:


n Creating domain groups


n Modifying domain groups


n Deleting domain groups


Creating domain groups
Use the Domain Groups Creation Wizard to create a new domain group. Using the wizard, you can:


n Copy an existing domain group and type a name for the new group. The wizard automatically creates
the domains in the group.


n Manually create the component domains from within the wizard.


Creating a domain group using the Copy Existing option
To create a domain group using the Copy Existing option:


1 From the Global Manager Administration Console,click Edit > New Domain Group.


The Domain Group Creation Wizard appears.


2 Select a group to be copied from the Copy Existing list.


3 Type a name in the Group Name field.


4 Type a description in the Group Description field.


5 Click Next.


6 Click Default Configuration.


Note   To customize the configuration, click Customized Configuration. This option is for advanced
users only.


7 Click Finish.


The configuration objects are created in the server.
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Manually creating a domain group
To manually create a domain group:


1 From the Global Manager Administration Console, click Edit > New Domain Group.


The Domain Groups Creation Wizard appears.


2 Type a name in the Group Name field.


3 Type a description in the Group Description field.


4 Click Next.


5 Click Default Configuration.


Note   To customize the configuration, click Customized Configuration and complete the Select
Topology Server options. If the Default Server option is selected, the wizard creates a default server
for this group. The default server does not include any domain tagging information. The default
server’s domain type is copied from the corresponding domains of the copied domain group.


6 Click Next.


The instance that will be created once the domain group creation process is complete appears in the
wizard.


Note   By default, the domain group is enabled. If a domain is part of the domain group, it is also
enabled. To disable the domain group, clear its checkbox.


7 Click Finish.


Modifying domain groups
To modify a domain group:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the SAM Manager.


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domain Groups.
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6 Click INCHARGE-MPS. The Configure Domain Group interface appears, as illustrated in Global
Manager Administration Console—Configure Domain Group interface.


Figure 6‑2.  Global Manager Administration Console—Configure Domain Group interface


7 Type the appropriate configurations.


Domain Group parameters describes the available Domain Group parameters.


Table 6‑3.  Domain Group parameters


Parameter Description


Enable Enables the domain group.


Enabling a domain group enables all the domains within it. Disabling the group
disables domains included in the group as long as the domains are not members
of any other enabled group. Disabling or enabling a domain, however, has no
effect on groups of which that domain is a member.


Group Description Provides a description of the domain group.


Topology Servers Defines the topology servers.
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Table 6‑3.  Domain Group parameters (Continued)


Parameter Description


Monitoring Servers Defines the monitoring servers.


Analysis Servers Defines the analysis servers.


Note   Click the Modify List button to display the Modify List of Topology Services dialog box. To
remove a server from a list, select the server in the list and click the Removed Selected button.


1 Click the Apply.


2 Click Reconfigure.


Note   Configuration changes are not applied until the Reconfigure button has been clicked. Clicking
the Reconfigure button starts the data synchronization process. Click the Reconfigure button only
after all updates to domains, domain tags, domain groups, and domain types have been made.


Deleting domain groups
To delete domain groups:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the SAM Manager.


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domain Groups.


6 Click the appropriate domain group.


7 Select Edit > Delete.


The selected domain group is deleted.


Note   Domain groups that refer to other domains cannot be deleted.


Configuring domain types
A domain type is a configuration object that captures all the settings relevant to a particular type of
domain with which the Service Assurance Manager server connects. One domain type exists for each
class of server communicating with the Service Assurance Manager; for example, AM, NPM, MPLS, and
SIA.


Properties of a domain type include:


n DXA file


n Hook scripts
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n Minimum certainty


n Smoothing intervals


Note   The domain type does not instantiate a domain object.


Default domain types defines the default domain types.


Table 6‑4.  Default domain types


Domain type Description


INCHARGE-AM-PM-SUITE Availability and Performance Manager


INCHARGE-AM-SUITE Availability Manager


INCHARGE-DISCMGR-SUITE Discovery Manager


INCHARGE-MPLS-ANALYSIS-SUITE Analysis Server for MPLS 2.0


INCHARGE-MPLS-MONITORING-SUITE Monitoring Server for MPLS 2.0


INCHARGE-MPLS-TOPOLOGY-SUITE Topology Server for MPLS 2.0


INCHARGE-OI-SUITE Open Integration Server


INCHARGE-PM-SUITE Performance Manager


INCHARGE-SAM-MBIM-SUITE Maintenance and Business Impact Manager


NCM-SUITE NCM OEM


Note   Additional domain types previously configured in the ics.conf file are available as separately
loadable XML files located in the conf/ics directory.


The following topics are included in this section:


n Creating domain types


n Modifying domain types


n Deleting domain types


Creating domain types
To create a domain type using the Domain Groups Creation Wizard:


1 From the Global Manager Administration Console, click Edit > New Domain Type.


The Domain Groups Creation Wizard appears.


2 Select a type to be copied from the Copy Existing list.


3 Type a name in the Type Name field.


4 Type a description in the Type Description field.


5 Click Next.
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6 Edit the domain type settings, and click Next.


Domain type settings defines the available domain type settings.


Table 6‑5.  Domain type settings


Option Definition


DXA File Defines the DXA configuration file.


Hook Script: Enable Enables the hook script.


Note   If the hook script is enabled, type the path for the hook script in the field.


Minimum Certainty Defines the minimum certainty.


Default value: 0.01


Smoothing Interval Defines the smoothing interval.


Default value: 65


1 Select the servers from the Available Domains list.


2 Click Add to move the server to the Selected Domains list.


This defines the servers associated with the new domain type.


Note   Domains cannot be removed from a domain type—they can only be reassigned to another
domain type. By adding domains, you are only reassigning the domains to a different domain type.
Newly added domains display in green text. You can only delete domains displayed in green text.
After clicking Apply, the domains cannot be deleted.


3 Click Next.


4 Click Finish. The configuration objects are created in the server.


Modifying domain types
To modify a domain type:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the SAM Manager.


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domain Types.
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6 Click the appropriate INCHARGE Domain Type. The Configure Domain Type interface appears, as
illustrated in Global Manager Administration Console—Configure Domain Type interface.


Figure 6‑3.  Global Manager Administration Console—Configure Domain Type interface


7 Type the appropriate configurations.


Domain type configuration parameters defines the available domain type configuration parameters.


Table 6‑6.  Domain type configuration parameters


Parameters Definition


Type Description Defines the domain type.


DXA Configuration File Defines the DXA configuration file.


Hook Script: Enable Enables the hook script.


Note   If the hook script is enabled, type the path for the hook script in the field.


Minimum Certainty Defines the minimum certainty.


Default value: 0.01
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Table 6‑6.  Domain type configuration parameters (Continued)


Parameters Definition


Smoothing Interval Defines the smoothing interval.


Default value: 65


Domains Defines the domains associated with the domain type.


Note   Click Modify List to add domains, select a domain from the list and click Remove
Selected to remove domains, and click Restore to restore previously configured domains.
Domains cannot be removed from a domain type, they can only be reassigned to another
domain type.


1 Click Apply.


2 Click Reconfigure.


Note   Configuration changes are not applied until the Reconfigure button has been clicked. Clicking
the Reconfigure button starts the data synchronization process. Click the Reconfigure button only
after all updates to domains, domain tags, domain groups, and domain types have been made.


Deleting domain types
To delete domain tags:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the SAM Manager.


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domain Types.


6 Click the appropriate domain type.


7 Select Edit > Delete.


The selected domain type is deleted.


Note   Domain types that refer to other domains cannot be deleted.


Managing overlapping elements from separate underlying
domains
A Global Manager collects topology information from multiple underlying domains. In some cases, two or
more of these domains can manage elements with the same name. Two such examples are IP networks,
which are named using the network address, and partitions which are assigned names by the underlying
domain.
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For example, a service provider might use a private IP network address, such as 10.0.0.0, to provide IP
addresses to different customers. When the same range of IP addresses are assigned to multiple
customers, different topology elements may have the same IP address, and thus the same name.


Partitions are created and named by IP Availability Manager. All IP Availability Managers use the same
convention to name partitions. If the topologies of two domain managers each include partitions, it is
possible that one or more of the partitions have the same name, as defined by the Name attribute. The
VMware Smart Assurance IP Manager User Guide provides more information about partitions.


By default, the Global Manager treats elements with the same name from different underlying domains as
a single instance, consolidating the relationships and attributes of the two elements to a single topological
instance. The values for the attributes are taken from the underlying domain that performs the most
recent topology synchronization.


You can, however, configure the Global Manager to manage elements of the same name from different
domains as distinct elements. By specifying a tag for one or both of the underlying domains, the
Global Manager will create two separate topology elements, each containing the attributes and
relationships of the respective objects in the underlying domains. The tag that you specify is appended to
the name of the objects in the tagged domain and displayed in the Global Console.


To tag managed elements, you need to complete two tasks:


n Specify a tag.


n Specify a matching pattern that will match the IP addresses and partitions to be tagged.


How the Global Manager applies tags
The Global Manager can apply tags to both topology elements and notifications. The Global Manager
finds matching elements by comparing the matching pattern against the Name and DisplayName
attributes of both topology elements and notifications from the relevant underlying domain. If they match
the filter, both are applied to the tag. Additionally, a notification on a matching instance will cause the
Name, DisplayName, InstanceDisplayName, and InstanceName of the notification to be tagged.


As a result, you should construct a matching pattern to match the values of attributes you want tagged.
For topology elements, this can include the Name and DisplayName attributes. For notifications, this can
include the DisplayName, InstanceDisplayName, and InstanceName attributes.


For example, the pattern IP*-172.16.*|172.16.* could match the following:


n Elements of the IPNetwork class, which are prefixed with “IPNET-”. For IPNET-172.16.0.0, the
following would result:


n DisplayName of 172.16.0.0 [tag-3]


n Name of IPNET-172.16.0.0_tag-3.


n Elements of the system classes, such as Host, that are named using the system’s IP address. For
host 172.16.1.107, the following would result:


n DisplayName of 172.16.1.107 [tag-3]


n Name of 172.16.1.107_tag-3.
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n Notifications generated for these elements would also be tagged. For a Host Down notification, the
following would result:


n DisplayName of Host Down 100%: 172.16.1.107 [tag-3]


n InstanceDisplayName of 172.16.1.107 [tag-3]


n InstanceName of 172.16.1.107_tag-3.


Note   If the system is named by its hostname, this matching pattern would not apply.


Configuring domain tagging
Domain tags allow the Service Assurance Manager to tag a subset of the topology of a given domain.
Domain tags distinguish a topology subset from topology from an underlying domain which may have
instance names that overlap but represent unique instances in the network topology.


A domain tag consists of a unique identifier and a wildcard expression that identifies matching instances.


The following topics are included in this section:


n Creating domain tags


n Modifying domain tags


n Deleting domain tags


Creating domain tags
To create a domain tag:


1 From the Global Manager Administration Console, click Edit > New Domain Tag.


The Domain Tag Creation Wizard appears.


2 Type a name in the Tag Type Name field.


3 Type a description in the Tag Description field.


Note   To copy an existing tag, select a tag from the Copy Existing list.


4 Click Next.


5 Type a matching pattern for the domain tag in the Matching Pattern text box.


6 Click Next.


7 From the Available Domains list, select domains for which the domain tag applies.


Note   For each domain selected, type a tag string in the Tag String field. If a domain has a tag string
already associated with it, you can replace the domain tag associated with the tag string with this new
one.


8 Click the Add button to move the selected domains to the Selected Domains list.
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9 Click Next.


Instances that will be created when the create domain tag process is completed appear in this
screen.


10 Click Finish.


Modifying domain tags
To modify domain tags:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the SAM Manager.


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domain Tags.


6 Click the appropriate domain tag.


The Configure Domain Tag interface appears, as illustrated by Global Manager Administration
Console—Configure Domain Tag interface.


Figure 6‑4.  Global Manager Administration Console—Configure Domain Tag interface
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7 Type the appropriate configurations.


Domain Tag parameters describes the available Domain Tag parameters.


Table 6‑7.  Domain Tag parameters


Parameter Description


Tag Description Provides a description of the domain tag.


Matching Pattern Defines the domain tag matching pattern.


Note   Wildcard expressions are valid.


Domains Defines the domains with which the domain tag is associated.


Note   Click Add New to display the Add New Domain dialog box. Select a
domain and click Edit Selected to display the Edit Domain dialog box. Select a
domain and click Delete Selected to delete the selected domain.


1 Click Apply.


2 Click Reconfigure.


Note   Configuration changes are not applied until the Reconfigure button has been clicked. Clicking
the Reconfigure button starts the data synchronization process. Click the Reconfigure button only
after all updates to domains, domain tags, domain groups, and domain types have been made.


Deleting domain tags
To delete domain tags:


1 Open the Global Manager Administration Console.


2 From the Manager list, select the SAM Manager.


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domain Tags.


6 Click the appropriate domain tag.


7 Select Edit > Delete.


The selected domain tag is deleted.


Note   Domain tags that refer to other domains cannot be deleted.


Reconfiguring the server
Any modifications to domains, domain groups, domain tags, and domain types are not implemented until
the server has been reconfigured. You should reconfigure the server only after all modifications have
been applied—not after each individual modification. When you click the Launch Server Reconfiguration
toolbar button, the reconfigure process begins.
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Click View > Message Log to display the Manager Message Log window. Configuration errors are
displayed in this window.


Note   The Service Assurance Manager server applies all reconfigurations during the restart process.


To reconfigure the server:


From the Global Manager Administration Console, click the Launch Server Reconfiguration toolbar
button.


Note   Click the Launch Server Reconfiguration toolbar button only after all modifications have been
applied.
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Managing Notifications with the
Global Manager 7
This chapter includes the following topics:
n Overview of notifications


n Understanding and managing notifications


n Acknowledging and archiving notifications


n Notification types and incrementing OccurrenceCount


n User-defined notification attributes


Overview of notifications
The Global Manager stores the topology and event information that it receives from the underlying
domains in its repository. The topology and event information are stored as objects, that is as instances of
the classes defined in the ICIM model. The notifications that Global Manager sends to clients are
themselves objects in the Global Manager’s repository.


Notification objects, similar to other objects in the Global Manager’s repository, have attributes that
describe their properties. For notifications, these attributes include the time the event occurred, the type
of event, the name of the object where the event occurred, and much more information. “Attributes for
matching notification properties” on page 215 provides a complete list of notification attributes.


Notification attributes are used throughout Service Assurance for a variety of purposes:


n Notification attributes correspond to the columns in the Notification Log of the Global Console.


Note   Attribute names are not exactly the same as the column headings of the Notification Log.


n You can specify a matching pattern against the values of notification attributes for filtering a
notification list.
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n Twenty notification attributes are user-defined. You can write an ASL script that populates these
attributes with additional information.


Note   This chapter discusses how you can manage notifications using the Global Manager. In
addition to the standard notification processing provided by the Global Console, you can also manage
notifications creation in a more extensive manner from any event source using the NOTIF Editor. This
editor allows for real-time reconfiguration of event and notification processing without server restarts.
The VMware Smart Assurance Notification Module User Guide provides detailed information on
configuring events and notifications using the NOTIF Editor.


Understanding and managing notifications
This section describes the states of a notification. It also describes the attributes of a notification and how
a change in the notification’s state affects the values of these attributes. Finally, this section describes the
acknowledgement and archiving of notifications.


The following notification attributes are related to a notification’s state:


n Event State


n First Notify Time


n Last Notify Time


n Last Change Time


n Last Clear Time


n Count


Note   The connotation for the Last Notify Time attribute differs between the one displayed in the
SAM notification console and the IP event console. In the IP event console, Last Notify Time indicates
the current timestamp of the console, compared to the actual notification time displayed in SAM.
Hence, the Last Notify Time from the IP event console must not be used for correlation of the Last
Notify Time between SAM and IP.


States of a notification
A notification’s state is defined by the Event State attribute, which has five possible values. Description of
Event State notification attribute describes each possible value of the Event State attribute and shows its
relationship to the Active notification attribute.
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Table 7‑1.  Description of Event State notification attribute


Event State value Description Active value


ACTIVE Event that caused the notification is occurring. The notification is in the
“notify” state.


TRUE


WAS_ACTIVE Global Manager is disconnected from the underlying domain that was the
source for the notification.


Note   The WAS_ACTIVE attribute is not applicable when the Broadcast
Event State on Restart Flag is configured to FALSE.


The WAS_ACTIVE and SUSPENDED event states describes the
suspended state. “Defining system defaults” on page 69 provides detailed
information on the Broadcast Event State on Restart Flag system default.


TRUE


SUSPENDED Global Manager is no longer receiving information about an active
notification.


Note   The SUSPENDED attribute is not applicable when the Broadcast
Event State on Restart Flag system default is configured to FALSE.


The WAS_ACTIVE and SUSPENDED event states describes the
suspended state. “Defining system defaults” on page 69 provides detailed
information on the Broadcast Event State on Restart Flag system default.


TRUE


INACTIVE Event that causes the notification is no longer occurring. The notification is
in the clear state.


FALSE


UNINITIALIZED State of the notification object when it is first created and before any state
is assigned to it.


FALSE


The WAS_ACTIVE and SUSPENDED event states
The WAS_ACTIVE event state is used to identify those notifications that are active under two conditions:


n A Global Manager disconnects from the underlying domain that is the event source. In this case, all
active notifications from the disconnected domain are marked WAS_ACTIVE.


n A Global Manager is started from a saved repository file. In this case, all active notifications are
marked WAS_ACTIVE.


Notifications marked as WAS_ACTIVE remain in the WAS_ACTIVE state until the Global Manager
can verify their status.


If the Global Manager is not able to reconnect to the underlying domains that generated these
notifications in 1800 seconds (30 minutes), the value of the Severity attribute is set to 4 (“Severity” on
page 217 provides additional information), changing the color of the notification in a Notification Log
to blue. The value of 1800 seconds is referred to as the detachTime.


When the connection between the Global Manager and the underlying domains is reestablished, the
Global Manager does the following:


n Notifications that are still active in the underlying domain have their Event State changed to ACTIVE
and their Severity value updated accordingly. The Last Change attribute is assigned the current time
and the Last Notify attribute value remains unchanged.


VMware Smart Assurance Service Assurance Manager Configuration Guide


VMware, Inc.  92







n Notifications that have cleared in the underlying domain remain in the WAS_ACTIVE state until the
attachTime has elapsed. The default value of attachTime is 6000 seconds (100 minutes). However,
the actual value that is used to calculate when to clear the notifications is determined as follows:


n When the uptime for the underlying domain is greater than the attachTime, then the value is 240
seconds plus the smoothing interval. The smoothing interval is specified in the corresponding
Domain Type. This typically occurs when the server was restarted.


n When the uptime for the underlying servers is less than the attachTime, the value is attachTime
minus uptime plus the smoothing interval plus 20 minutes. For temporary disconnects, this value
is typically used to determine the state of WAS_ACTIVE notifications. This typically occurs when
the server was restarted and there was a disconnect.


The SUSPENDED state indicates that the Global Manager is no longer able to retrieve
information about an active notification. When an underlying Domain Manager is not able to get to
the source of a notification, it suspends the notification. The Domain Manager sends this
message to the Global Manager, which in turn suspends the notification. A Domain Manager may
not be able to get to the source of a notification because an SNMP agent is not responding or
because it received unexpected error values in an SNMP request.


Notifications suspended by the Global Manager have the value of the Severity attribute set to 4,
changing the color of the notification in a Notification Log to blue.


A notification’s life cycle
Each notification has a unique name. A notification’s name consists of the class name and instance name
where the event occurred, and the event name. The notification naming convention is:


NOTIFICATION-ClassName_InstanceName_EventName


For example, the notification NOTIFICATION-Router_R1_Down identifies the event Down, which
occurred in instance R1 of the Router class.


The Notification Log Console will not list more than one notification with this name. If the event clears and
occurs again before it is archived, the Count field is increased accordingly.


The following notification attributes are related to a notification’s state:


n First Notify — Is the first time a notification occurs.


n Last Notify — Is the last time a notification occurs.


n Last Clear — Is the last time a notification cleared.


n Last Change — Is the last time a notification changed.


n Count — Is the number of occurrences of an event starting from First Notify until Last Notify.


States of NOTIFICATION-Router_R1_Down illustrates the states of the notification NOTIFICATION-
Router_R1_Down. For the First Notify and Last Notify attributes, the timestamp value is provided by
the underlying domain that diagnosed the event. Values for Last Change, Count, and Last Clear (not
shown) are provided by the Global Manager.
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Table 7‑2.  States of NOTIFICATION-Router_R1_Down


Time
User/system
actions Notification state


Time of first
notify


Time of last
notify


Time of last
change Count


2:00 Notify 1:00 1:00 2:00 1


2:15 Clear 1:00 1:00 2:15 1


2:25 Notify 1:00 2:25 2:25 2


2:35 Clear 1:00 2:25 2:35 2


3:00 Acknowledge 1:00 2:25 3:00 2


3:05 Archived 1:00 2:25 3:00 2


3:55 Notify 3:55 3:55 3:55 1


In this example:


At 1:00, an Availability Manager generated a Down event.


At 2:00, the Global Manager connected to the Availability Manager and the Global Manager created the
notification NOTIFICATION-Router_R1_Down for the Down event. The Global Manager retains the
original timestamp of the event and stores it in the notification—First Notify and Last Notify are assigned
the values of 1:00.


At 2:15, the notification is cleared.


At 2:25, the Availability Manager generated the same Down event again, the Availability Manager was
already connected to the Global Manager, and the Global Manager reactivates the notification. The First
Notify remains 1:00 and the Last Notify reads 2:25.


At 2:35, the notification is cleared.


At 3:00, the operator acknowledged the notification.


Notice at 3:05, the notification is archived and the archive action records the most recent values for First
Notify, Last Notify, and Last Change. A notification cannot be archived until it has been acknowledged.
Acknowledgement does not change a notification’s state unless the notification attribute
ClearOnAcknowledge is set to True for a specific notification.


At 3:55, the Availability Manager generated a Down event again and the Global Manager created the
notification again. After a notification is archived, the Global Manager treats a recurrence of that
notification as though it were a first occurrence. The value of notification attributes start all over again:
new First Notify time, Count starts at 1, and so on.


Acknowledging and archiving notifications
Regardless of its state, a notification can be marked as Acknowledged. An operator can acknowledge a
notification through the Global Console. When an operator acknowledges a notification, the operator
becomes the owner of the notification. Acknowledging a notification does not change its state. If an
inactive acknowledged notification is re-notified, the value of the Acknowledged attribute is set to FALSE
and the value of the Owner attribute is cleared.
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By default, the Global Manager automatically acknowledges cleared (inactive) and unowned notifications
after 5 minutes. When Global Manager acknowledges a cleared notification, the owner is set to SYSTEM.
You can configure this interval through the AutoAcknowledgementInterval.


Using a notification list, you can filter acknowledged notifications so that they do not appear in an
operator’s display.


After a notification has been acknowledged and is cleared (inactive), it is eligible to be archived. An
archived notification is removed from the Global Manager’s repository and written to an archive file. The
notification archive file is named <global_manager>.archive and located in the
BASEDIR/smarts/local/logs directory.


When a notification is archived, the Global Manager treats a recurrence of that notification as though it
were the first occurrence. The value of notification attributes start over again: new First Notify time, Count
starts at 1, and so on.


The Global Manager archives only notifications that are both inactive and acknowledged. You can
configure the acknowledgement and archival of notifications through the AutoAcknowledgementInterval
and InactiveAutoArchiveInterval settings.


Configuration of acknowledgment and archiving of notifications
The following parameters, defined using the Global Administration Console, control how and when the
Global Manager acknowledges or archives notifications. “Defining Domain Manager parameters” on
page 66 describes these parameters.


Note   Any changes made to the parameters of the ics-default.xml file require that you click the
Reconfigure button to make those changes take effect. “Reconfiguring the server” on page 106 provides
detailed information.


AutoAcknowledgementInterval
AutoAcknowledgementInterval controls when a cleared (inactive) notification is automatically marked as
acknowledged by the Global Manager. The interval is calculated from the time when a notification clears.
If a notification recurs, or is unacknowledged, the notification is rescheduled for automatic
acknowledgement. The default value is 300 seconds (5 minutes). When this interval is set to 0, the
Global Manager will not automatically acknowledge cleared notifications.


InactiveAutoArchiveInterval
InactiveAutoArchiveInterval controls when a cleared (inactive) and acknowledged notification is archived
by the Global Manager. The interval is calculated from either the time the notification is cleared or the
time a notification is acknowledged (whichever is later). If a notification recurs, or is unacknowledged, the
notification is rescheduled for archival. The default value is 14400 seconds (4 hours). When this interval is
set to 0, the Global Manager will not automatically archive cleared and acknowledged notifications.
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Retain local objects with an associated notification instance
If attributes such as, elementname and elementclassname are found empty for notifications in the
Notification Log Console, it is likely that corresponding local objects were deleted during topology
synchronization with underlying domain managers but notifications were not cleared.


To avoid local objects that have an associated notification instance from being deleted, set the following
property in the local/conf/runcmd_env.sh file:


SM_KEEP_LOCAL_OBJECTS=true


By default, it is set to FALSE.


Notification types and incrementing OccurrenceCount
The ICIM defines two types of notifications: momentary and durable. A momentary notification has no
duration, it describes an event that happened at a specific time. An authentication failure is an example of
a momentary event. A durable notification describes an event that is active over a period of time. While
the event is active, the problem it causes is still in effect. An example of a durable event is a link failure.
You can determine a notification’s type by checking the value of the EventType notification attribute.


A notification’s type determines how the value of the OccurrenceCount attribute is increased by a
Global Manager. In addition, the source of the notification and the conditions under which a notification is
sent, also determine how a notification’s count is increased.


For example, consider the scenario where notification N_1 is active in a Global Manager and there are
two different sources (S1 and S2) for the notification:


n For durable notifications, the OccurrenceCount represents how many times the notification has
become active (notified) during the notification’s life cycle. The count is incremented when the
notification reoccurs after it was cleared and renotified.


Using the example above, when S1 notifies, the Global Manager increments the OccurrenceCount to
1. If S2 then notifies, the OccurrenceCount remains 1.


n For momentary notifications, the OccurrenceCount represents how many times the Global Manager
has received a notify message regarding the notification. The current state of the notification has no
effect.


Using the example above, when S1 notifies, the Global Manager increments the OccurrenceCount to
1. If S2 then notifies, the OccurrenceCount increments to 2.


The Global Manager would increment the OccurrenceCount on a re-notify by 1, regardless of whether
the notification was active. In fact, if notification N_1 occurred 50 times in the underlying domain, the
Global Manager would increase the value of the OccurrenceCount by 50.
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If the Event Type is durable or the value for the SM_OCCURANCECOUNT flag is set to FALSE in the
runcmd_env.sh file while the event type is momentary, the server always ignores any re-occurrences
of an active notification that has occurred during the disconnected period. If the Event Type is
momentary and the value for the SM_OCCURANCECOUNT flag is set to TRUE in the
runcmd_env.sh file, the server will update the re-occurrences of an active notification that has
occurred during the disconnected period.


User-defined notification attributes
Notification objects created by the Global Manager include twenty user-definable attributes. By default,
these attributes have no value.


To populate the attributes with values, you may create an ASL program and specify it in the HookScript
field of a DomainType subsection. “Defining Domain Manager parameters” on page 66 describes the
HookScript field.


A sample ASL program, dxa-sample-hook.asl, is included in the BASEDIR/smarts/rules/ics directory. This
ASL program receives a handle to the notification object. You need to provide any additional functionality.
Your ASL script should query the Global Manager, Adapter Platform, or underlying domain for additional
information.


For example, you can populate one of the columns with the number of affected customers (instances of
the ServiceSubscriber class) by counting the number of impacted subscribers.


Notification list parameters describes the method to give the column names in the Global Console more
meaningful names.


User-defined notification attributes from Adapter Platform or
Global Manager
When a Global Manager receives notifications from Adapter Platform or another Global Manager, these
notifications include 20 user-definable notification attributes. The values for these user-defined notification
attributes should be populated in the underlying Adapter Platform or Global Manager.


The user-defined attributes, and their values, are automatically passed to a Global Manager when the
default data exchange file is specified in the corresponding Domain Type, for example:


n dxa-oi.conf for notifications received from Adapter Platform


n dxa-sam.conf for notifications received from Global Manager


â€œDefining Domain Manager parametersâ€� on page 66 describes how to configure a Global
Manager to receive events and topology from underlying domains.
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Managing Topology with the
Global Manager 8
This chapter includes the following topics:


n Topology synchronization


n Topology Timeout


n Ensuring a consistent representation of topology


n Organizing topology with groups


n Purging of HierarchicalGroupManager instance


n Custom icons for map nodes


Topology synchronization
A Global Manager imports topology information from the underlying domains specified for all enabled
domains. To maintain an up-to-date representation topology, the Global Manager synchronizes its
topology with an underlying domain when any one of the following occurs:


n The underlying domain is reconnected after a connection loss or a restart.


n The Global Manager is started.


n The underlying domain performs a full or incremental discovery, rediscovers an object, or a manual
discovery is initiated.


n A change is made to the configuration of the underlying domains. When the Global Manager is
reconfigured, it automatically synchronizes its topology with the updated underlying domains.


Topology synchronization consists of the following two parts:


n Import of raw topology data from remote domains – This involves retrieving of raw data from the
domain and creating topology elements and relationships. If topology and relationships already exist,
no action is taken.


n Post processing – This involves reconciliation of the SAM topology. SAM maintains an internal data
structure to keep track of topology elements imported from underlying domains which allows SAM to
identify and purge topology objects and relationships which no longer exists in the underlying
domains.
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Starting topology synchronization
To manually start topology synchronization, invoke the following dmctl command from the
BASEDIR/smarts/bin directory:


tdmctl -s SAMServername invoke GA_Driver::<domain-name>_Topo-Driver starts


Limitation of topology synchronization
The following are the limitations of SAM topology synchronization:


n Redundant syncs


n Costly operation


Redundant syncs


Topology synchronization is triggered whenever there is a change in topology of an underlying domain.
But SAM may import only a subset of the topology from the underlying domain based on dxa
configuration. As a result, topology synchronization may be triggered even though the imported topology
has not changed in the underlying domain. Such topology synchronizations are not useful as no change
is propagated to SAM and can be avoided by disabling autosync mode. Instead topology
synchronizations can be triggered manually at regular intervals. One of the easiest ways to identify
redundant syncs is to find out number of instances added or deleted during topology synchronizations. If
it is zero, then it is likely that redundant syncs are triggered between SAM and underlying domain.


Costly Operation


Topology synchronization is a costly operation on SAM server and it is recommended to configure
topology synchronization judiciously. Performance of SAM topology synchronization is dependent on the
factors mentioned in Performance factors of SAM topology synchronization.


Table 8‑1.  Performance factors of SAM topology synchronization


Performance factor Dependency of SAM topology synchronization


Size of topology Time taken to import topology is directly proportional to size of topology.


Frequency of sync More frequent syncs increase load on SAM server.


Resources(CPU/memory) Concurrent topology synchronization works better on a multi core machine.


Network latency Topology import slows down due to network latency.


Memory growth due to Topology Synchronization


When reconciliation of SAM topology and import of topology from other underlying domains are in
progress at the same time, a growth in memory is observed.
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During topology synchronisation in SAM, a separate thread is created for synchronization of each
domain. Whenever topology changes in the underlying domains, topology synchronization is triggered by
SAM to keep local SAM topology in synchronization with the topology in the underlying domains. The
underlying domain updates the lastProbeFinishedAt attribute of ICF_TopologyManager whenever there is
a change in topology. SAM subscribes to the attribute and when the attribute is updated after a topology
change (like discovery in AM), SAM triggers topology synchronization with underlying domain. Each time
topology synchronization is triggered, classes mentioned in dxa configuration are imported from
underlying domains and SAM topology is reconciled. In other words, topology synchronization is always
full and not incremental in nature.


Topology Synchronization can be run in the following three modes:


n Concurrent Synchronization – This is the default mode.


n Serial Synchronization – This can be enabled by setting SM_ENABLE_SERIAL_SYNCS=TRUE in
runcmd_env.sh


n Fixed Interval – This disables topology synchronization and invokes drivers at regular interval.


Enable or disable topology autosync
There are two methods by which you can disable auto synching of the topology:


n Enable or disable topology autosync using the Console


n Enable or disable topology autosync using the configuration file


Enable or disable topology autosync using the Console
To enable or disable topology autosync using the Global Manager Administration Console:


1 Open the Global Manager Administration Console.


2 From the Manager List, select the SAM Manager.


3 Expand ICS Configuration.


4 Expand IC Domain Configuration.


5 Expand Domains.


6 Click the appropriate domain.
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7 The Configure Domain interface appears, as illustrated in Global Manager Administration Console -
Disable autosync.


Figure 8‑1.  Global Manager Administration Console - Disable autosync


8 Select or clear the Automatic Topo-Sync Enabled check box based on whether you want to enable
or disable autosync of the topology.


Note   Automatic synchronization of topology is enabled by default.


9 Click Apply > Reconfigure.


Enable or disable topology autosync using the configuration file


Note   Autosync of topology is enabled by default.


To disable topology autosync using the configuration file:


Add the following command at the end of the dxa file used for the domain:


topoUpdate ICF_TopologyManager::ICF-TopologyManager::fakeAttr


Enable topology synchronizations at regular intervals
To enable topology synchronizations at regular intervals add the following command to a cron script:


         dmctl -b <broker-name> -s <server-name> invoke GA_DaemonDriver::<Underlying-Domain-Name>_Topo-


Driver start
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Get a list of topology drivers


To get a list of topology drivers, execute the following command:dmctl -b <broker-name> -s <server-


name> getInstances GA_DaemonDriver


      


The advantages and disadvantages of running topology synchronization in each mode


Table 8‑2.  Advantages and disadvantages of each mode


Mode Advantages Disadvantages


Concurrent Synchronization n Topology is updated with little or no
delay.


n Post processing is refined which
improves the performance of server.


n Heavy load on server as topology
synchronizations are triggered at higher
frequency.


n Memory growth might happen if overlapping
topologies are synchronized at the same
time.


Serial Synchronization n Server Load is less on server as only
one sync will be active at any point.


n No issues related to memory growth.


n Topology may get updated with delay. Time
delay is unpredictable as depends on how
many domains are synchronizing at the
same time.


n Post processing gets invoked at the end of
topology synchronization which might
degrade the performance in large topology.


Fixed Interval n Topology synchronization can be
scheduled based on server load
pattern.


n Time delay in topology update is
predictable.


n Topology is updated with delay.


mentioned in Advantages and disadvantages of each mode.


If there are overlapping topologies between two or more underlying domains and top level SAM is
configured such that it is synchronizing with underlying domains concurrently, then it is recommended to
either run the server in serial mode or start topology drivers at regular intervals. The rule of thumb is to
use the serial mode if there is more than 50% overlapping topology when synchronizations are triggered
concurrently. When topology synchronization is set to operate in serial mode(non-default option), both
import and post processing operations are considered as one atomic operation, and multiple topology
synchronizations with underlying domains are executed serially.


Only one topology synchronization thread is executed at any point. This reduces the load on the server.
The downside is a delay in completion of topology synchronization operation if multiple synchronizations
are triggered at the same time.
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Topology Timeout
The timeout (default timeoutTopoValue) parameterdefines the default timeout to be applied to the front
end and back end to which this driver is connected. If multiple drivers are connected, the maximum value
across all of them defines the default. The timeout is always in seconds. A value of 0, requests no
timeout. The value cannot be negative. If multiple drivers connect to the same front end or back end, a
value of 0 requesting no timeout can be replaced by a non-zero value. If you want to force there to be no
timeout, set the timeout to some very large value. For instance, you may leave the timeout value at the
default value of 600 seconds. When the topodriver calls the remote server, it waits for 600 seconds to
receive a response from the server. During topology synchronization if for some reason the underlying
source domain stops responding to SAM, after a wait of 600 seconds, SAM will time-out and resume
topology synchronization after the next topology discovery cycle.


The TimeOutTopo <n> parameter is present in the dxa configuration file of the corresponding domain (for
example, dxa-sam.conf for SAM domains). The timeout value can be modified in the corresponding
underlying domain dxa configuration file.


Ensuring a consistent representation of topology
A Global Manager imports topology information. Because the topology information comes from disparate
sources, it is important that the Global Manager present a correct and consistent representation of the
topology. This is especially true when two or more domains manage the same devices.


Newer versions of VMware Smart Assurance applications include an expanded and updated list of
certified devices. This may mean that a device classified as Uncertified or Node by an older version of the
VMware Smart Assurance software is classified as a Router or Switch by a newer version of the software.
For best results, upgrade existing VMware Smart Assurance applications to the most recent version. If
that is not possible, use the same version of the software for all the underlying applications.


Two issues can arise when the Global Manager receives inconsistent topology information:


n The Global Manager imports information about two or more devices with the same name but the
devices are classified differently in their respective underlying domains.


n The Global Manager imports the same device from two or more underlying domains but the device is
named differently in each underlying domain.


Note   The Global Manager does not import instances of the Unsupported and Undiscovered classes.
However, the topology of a Global Manager may include instances, such as Hosts, with a value of
Undiscovered for their Certification attribute.
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Same device classified differently in separate underlying domains
The Global Manager can receive conflicting topology information when two underlying domains discover
the same device but classify it differently. The scenarios where this may occur are as follows:


n A device has the same name, but is an instance of different classes in two or more underlying
domains. In addition, the device is classified as Host, Uncertified, or Node in one or more of the
underlying domains. When this occurs, the Global Manager replaces an instance of a less specific
class, Host, Uncertified or Node, with an instance of a more specific class. Incoming event
information for the device is consolidated to the instance in the Global Manager’s topology.


For example, device1.mydomain.com is classified as Uncertified in one underlying domain and
classified as a Router in a second underlying domain. The Global Manager classifies the device as a
Router in its topology. All incoming notifications related to device1.mydomain.com are associated with
the Router instance in the Global Manager’s topology.


n A device has the same name, but is an instance of different classes in two or more underlying
domains. In this case, the device is not classified as Host, Uncertified, or Node in any underlying
domain. The Global Manager classifies the device according to the first topology information it
receives from an underlying domain. Relationship information for the device is updated during
consecutive topology synchronizations. Incoming event information for the device is consolidated to
the instance in the Global Manager’s topology.


For example, device2.mydomain.com is classified as a Probe in one underlying domain and a Router
in a second underlying domain. If the first underlying domain synchronizes first with the
Global Manager, the Global Manager classifies the device as a Probe in its topology. However, any
relationship information for the router from the second underlying domain is preserved by the
Global Manager and added to the Probe instance. All incoming notifications related to
device2.mydomain.com are associated with the Probe instance in the Global Manager’s topology.


Note   If there is only one domain, the Global Manager will change the classification of an object
when the domain changes it. For example, if IP Availability Manager discovers a device as a Probe,
the Global Manager will create a Probe. If IP Availability Manager rediscovers the same device as a
Switch, then Global Manager will delete the Probe and re-create the instance as a Switch.


Same device named differently in separate underlying domains
The Global Manager creates its topology based on the names of the devices it imports from the
underlying domains. When the Global Manager imports the same device from two or more underlying
domains with the same name, it creates a single corresponding device in its own topology. The
Global Manager associates any incoming events from the underlying domains that are related to this
device with the single device in its own topology.


When the Global Manager imports the same device from two or more underlying domains and each
domain gives the device a different name, the Global Manager creates unique elements in its topology for
each device.
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For example:


n One underlying domain discovers a device and gives it the name device3.


n Another underlying domain discovers the same device but gives it the name device3.mydomain.com.


When the Global Manager receives topology information from these underlying domains, it creates
two instances in its topology — one named device3 and one named device3.smarts.com.


Same device with different DisplayName
When two or more underlying domains manage the same instance and the value of DisplayName is
different in each underlying domain, the value of DisplayName in the Global Manager changes each time
it synchronizes with the other underlying domain. The same issue applies to notification display names
when an alarm is generated on the instance by one of the underlying domains.


To fix the display name to a single value, specify the keyword update in the underlying domains from
which the value of DisplayName should be taken in the smarts/conf/ics/ics-default.xml file, as shown in
the following example:


<domainconfig>


        <domaintype


            name="MPLS"


            description="Type for MPLS"


            dxaConfFile="dxa-mpls-vpn-conn.conf"


            MinimumCertainty="0.24"


    update=”True”


            SmoothingInterval="65">


            <hook enable="False">ics/dxa-sample-hook.asl</hook>


            <domainname>INCHARGE-MPLS</domainname>


</domaintype>


Organizing topology with groups
Grouping provides a method by which you can organize topology elements. With
Service Assurance Manager, you can create groups and organize topology elements to more efficiently
manage large numbers of elements.


Before you start, it might be useful to devise a strategy to organize topology elements into groups.
Common strategies include organizing by the following:


n Business units


n Geographical regions


n Resources
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General properties of groups
A group is a user-defined collection of instances from the Global Manager’s topology. A group consists of
members or child groups. A member is a topological element such as a switch. A child group (or
subgroup) is another group, which may be a collection of members or additional subgroups. A group that
contains child groups is referred to as the parent group.


Parent and child groups are organized into a tree structure. At the root of each tree is a top-level group.
Each top-level group is a distinct organization of groups and members—its configuration or removal does
not effect other top-level groups.


In the Map Console, top-level groups are displayed directly beneath the icon for the Global Manager:


n A member is also a member of the groups above it within the same group hierarchy.


n Within a single group hierarchy, an element cannot be a member of more than one group. An element
can belong to two or more groups that descend from different top-level groups.


n You cannot create a circular group where a group is specified as a subgroup of itself or one of its
subgroups.


Before we explain how to create groups, you may find it helpful to understand how groups are
displayed in the Map Console.


How groups are displayed in the Map Console
The Map Console only displays the members of a group when that group does not contain any child
groups. If a group contains one or more child groups as well as members, only the child groups are
displayed.


When you create groups to display them in the console maps, create a catch-all group within a parent
group. The catch-all group should contain all the members that do not belong to any of the other
subgroups. This technique prevents a parent group from containing both members and child groups.


Types of groups
The Global Manager supports two types of groups: selective groups and hierarchical groups:


n A selective group is a group whose members are determined by a matching pattern that you specify
through the Global Console.


n A hierarchical group is specified in a data file which is then imported by the Global Manager.


In addition to the methods by which they are created, there exist several other differences between
selective and hierarchical groups.


Properties of selective groups
Selective groups contain three properties that distinguish them from hierarchical groups: matching
criteria, priority, and target classes. These properties help to determine what elements become members
of a selective group.
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Matching criteria
Matching criteria are attributes defined in the ICIM model that you use to determine what elements are
eligible to become a member of a group. When you create a selective group, you specify a matching
pattern that is compared against the attributes of the element. If the pattern matches the value of the
specified attribute, the element becomes a member of the group. A matching pattern comprises one or
more characters and wildcards. If you do not specify a matching pattern, all managed elements that pass
the target class filter match the group. Priority will determine if any elements become members.


Attributes for matching criteria lists attributes against which you can apply a matching pattern. The groupâ
€™s target class determines which attributes are available to match against. For example, if the target
class is IPNetwork, attributes that describe a managed system, such as Certification, are not listed.


Table 8‑3.  Attributes for matching criteria


Attribute Description


Certification Level of certification assigned to this device during discovery. Values include:
UNCERTIFIED, GENERIC, TEMPLATE, CERTIFIED, or VALIDATED.


CreationClassName Name of the class of which the managed element is an instance. This is used as the
ClassDisplayName attribute in notifications affecting this element.


Description A brief description of the element.


DisplayClassName Same as creation class name.


DisplayName Name of the managed element. For systems, DisplayName and Name are usually the
same.


IsManaged Determines if the system is managed by the underlying domain.


Value is TRUE or FALSE.


Note   Unmanaged elements do not appear in the Global Manager topology.


Location A brief textual description of the system’s physical location.


Model Vendor’s name for the system.


Name Name of the managed element. For systems, Name and DisplayName are usually the
same.


PrimaryOwnerContact Information on how to contact the system’s owner.


PrimaryOwnerName Name of the system’s owner.


ServiceName Name of external system used to import attributes and events.


SystemName Name of the system that contains this managed element.


Type Classifies the type of system. Possible values include: Bridge, Host, Hub, Node, Other,
Probe, Router, RSFC, RSM, Switch, and TerminalServer.


Vendor Name of the system’s manufacturer.


Chapter 15 Wildcard Patterns describes wildcards for matching patterns.
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Priority
Priority distinguishes between groups at the same level of the hierarchy with the same parent. Each such
group is automatically assigned a different priority. When a topology element matches the pattern of two
different groups, it becomes a member of the group with the higher priority. Because of this, you should
assign a higher priority to a group with a stricter matching pattern. If a group has a high priority and it
matches all the topology elements, it will contain all the available members.


Target classes
A target class acts like a filter, allowing only those elements that are instances of the target class, or one
of its subclasses, to become members of the group. Managed elements must pass the target class filter
before they are compared against the matching criteria.


When you create a child group, the child group should have the same target class as its parent. The
exception to this rule is when the new target class is a subclass of the parent group’s target class. For
example, the ICIM_ManagedSystemElement class is near the top of the ICIM hierarchy. All of the other
target classes are a subclass of ICIM_ManagedSystemElement. If ICIM_ManagedSystemElement is the
target class of a parent group, you can select a different target class for a child group.


Similarly, VLAN, NetworkConnection, and IPNetwork are subclasses of ICIM_LogicalLink. If
ICIM_LogicalLink is the target class of the parent, you can choose one of these three classes as the
target class for a child group.


Target classes for selective groups lists the target classes you can assign to a selective group when you
create it. Classes are listed in the order that they appear in the ICIM class hierarchy. The description
indicates when a class is a subclass of another target class.


Table 8‑4.  Target classes for selective groups


Target class Description


ICIM_ManagedElement Base class for the ICIM system element hierarchy. This is the broadest target
class.


UnitaryComputerSystem Represents a single computer system. This is the superclass for the Bridge, Host,
Hub, Probe, MSFC, Router, RSFC, RSM, Switch, TerminalServer, and Node
classes.


ApplicationService Represents service provided by software. Examples include email, web server, and
database applications.


LogicalLink Represents a link between two endpoints. Examples include database
transactions, IP networks, and cables.


VLAN Virtual LAN typical in switched networks. VLAN is a subclass of LogicalLink.


NetworkConnection A connection between two routers, typically a virtual circuit. NetworkConnection is
a subclass of LogicalLink.


IPNetwork Subnet of an IP network. IPNetwork is a subclass of LogicalLink.


ServiceSubscriber Customer who receives services provided through a service offering.


ServiceOffering A service provided to customers.
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Creating selective groups
You create and edit selective groups by using the Global Console. Creating or editing groups through the
console requires administrator privileges from the Global Manager. Operators with monitoring privileges
can view groups in the Topology Browser and Map Console, but are not able to create or edit groups.


You should be aware of the following points when creating selective groups:


n Top-level selective groups cannot contain members, only child groups. As such, you need to create
both a top-level group and one or more child groups to assign topology elements to a group.


n By default, each top-level group contains all the topology elements that match its target class and
matching criteria.


n Each group is identified by a unique name. The name is displayed in group maps and in the Topology
Browser. It is the value of the DisplayName attribute for the group instance.


n Hierarchical groups are visible in the Group Definition window, but they cannot be edited.


Layout of the Group Definition window
You create and edit groups through the Group Definition window. You open this window by selecting
Groups from the Configure menu of the Global Console.


The Group Definition window is divided into two panels. The left panel displays the Global Manager,
groups, and the group members. When you choose a selective group in the left panel, the Properties,
Priorities, and Matching Criteria tabs display in the right panel of the Group Definition window.


Note   When you select a top-level group, only the Properties tab is displayed. Top-level selective groups
do not have priority or matching criteria.


Priority and matching criteria determine which topology elements are members of each group. If you have
worked with configuration groups (Polling Groups and Threshold Groups) for VMware Smart Assurance
applications, the priority and matching criteria for topology groups function similarly.


Properties of selective groups describe priority and matching criteria.


The toolbar of the Group Definition window contains four buttons:


n Delete removes the specified group from the topology of the Global Manager. If the deleted group
contains child groups, the child groups are also deleted.


Note   The Delete command does not remove hierarchical groups.


n Regroup tells the Global Manager to rebuild the selective groups from the selected group down to the
bottom of the group hierarchy. If you select the Global Manager icon and invoke Regroup, the
Global Manager rebuilds all of the selective groups. This, however, is not usually necessary. It is more
efficient to regroup a section of the group hierarchy when there are large number of topology
elements in each group.
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You need to invoke Regroup after you make changes to the priority or matching criteria of a group.
The Global Manager automatically regroups the topology when it synchronizes its topology with the
underlying domains.


Note   The Regroup command does not affect hierarchical groups.


n Create Top Level Group displays the New Group dialog box where you specify the name, description,
and target class for the group. This command is only available when the Global Manager is selected.


n Create New Group displays the New Group dialog box where you specify the name, description, and
target class for a child group. This command is available when a group is selected in the group tree
hierarchy in the left panel of the Group Definition window.


You can also find these commands under the Group menu. In addition, the Group menu also contains
the Save Groups command. When you invoke Save Groups, the Global Manager saves its in-
memory database to the repository file.


Method for creating selective groups
To create a selective group:


1 Select Groups from the Configure menu of the Global Console. The Group Definition window
appears.


Note   This requires administrator privileges. The Configure menu is not displayed for users with
monitoring privileges.


2 To create a top-level group, select the Global Manager icon and click the Create Top Level Group
toolbar button.


To create a child group, select the parent group and click the Create New Group toolbar button. The
New Group dialog box appears.


3 Specify a name, description, and target class for the group. After you finish specifying values for
these three fields, click OK.


The new group displays in the Group Definition window. You can also see the group as an instance
of the SelectiveGroup class in the Topology Browser Console or as a group in the Groups tab of the
Map Console.


4 Change the priority of the new group. If there are other groups at the same level of the group
hierarchy, they are listed under the Priorities tab. By default, a new group is assigned the lowest
priority.


To change a group’s priority, select the group whose priority you want to change. Under the Priorities
tab, click the up arrow to give the group a higher priority or click the down arrow to give the group a
lower priority.
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5 Click the Matching Criteria tab and specify a matching pattern for the group. By default, a new group
does not contain matching criteria, meaning it matches all possible elements.


For example, if you want to create a group that includes systems from a certain geographical area,
then you might match against the value of the Type and Location attributes.


For example:


n Specify a pattern that matches the type of systems you want to group.


To create a group of routers you would add Type as a matching criteria attribute and specify a
matching pattern of Router.


n Specify a pattern that matches against the geographical locale specified in the system’s
Location attribute.


To match against routers in New York, you could add Location as a matching criteria attribute
and specify a pattern of “*NY*|*New York*”. This pattern would match against “NY” and “New
York” anywhere in the Location attribute. Method for creating selective groups lists the
classes whose values you can match against.


6 Select the parent for the newly created group, or the Global Manager, and click the Regroup toolbar
button.


Note   To create a catch-all group, create a group with no matching criteria and assign it the lowest
priority.


Editing the properties of a selective group
You can edit the description, target class, priority, and matching criteria of a selective group. Similar to
creating a group, you must attach to Global Manager with administrative privileges and select Groups
from the Configure menu.


You can edit all the properties of a group before applying the changes. However, if you select another
group before clicking Apply, your changes are not applied. In this case, the console displays a dialog box
asking if you want to abandon the changes that have not been applied.


To edit the properties of a selective group:


1 Select the group whose properties you want to edit.


The properties of the group appear in the right panel of the Group Definition window.


The description and target class of the group appear under the Properties tab.


2 Do one of the following:


n To change the target class, select a class from the pop-up menu.


n To change the description, edit the text in the Description text box.


3 Select the Priority tab to change the priority of the group.


4 Select the Matching Criteria tab to change the matching pattern of the group.
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5 Click Apply. If you change the target class, priority, or matching criteria, you also need to click
Regroup.


Creating hierarchical groups
This section describes how to create hierarchical groups, including the syntax of the group datafile and
how to load the group information into the Global Manager.


To create hierarchical groups:


1 Create one or more hierarchical group datafiles that specify the groups and their members. You can
also add new groups and their members to existing hierarchical group datafiles, including the two
example group datafiles (topology-group.data.template and service.data.template) that are provided
with the system. To use one of the example group datafiles, make a copy of the example file and
rename it appropriately. These data files must be located in the BASEDIR/smarts/local/conf/ics
directory. Syntax of hierarchical group datafiles describes the syntax of the group data files.


2 If necessary, edit the Business Templates options in the Global Manager Administration Console to
add or delete the names of hierarchical group datafiles.


3 If hierarchical group files are added or deleted, reconfigure the Global Manager. “Reconfiguring the
server” on page 106 describes how to reconfigure the Global Manager.


4 Import the group definitions by regrouping the group datafiles. Regrouping hierarchical group data
describes how to regroup the datafiles.


The Global Manager processes the group and service topology data specified in the
BusinessSection. If the Global Manager does not encounter any errors, it does the following:


n Adds any new group and service information to its topology


n Deletes any group and service information that is in the current topology but which has been
deleted in the new hierarchical group datafiles being imported


Note   Both reconfiguring and regrouping update the service topology used by
Business Impact Manager.


After the hierarchical group data is loaded into the Global Manager, you can view hierarchical
groups through the Global Console.


Syntax of hierarchical group datafiles
The syntax for group datafiles provide a means for specifying groups, children (subgroups), and
members. The following example illustrates the syntax of a hierarchical group datafile:


HierarchicalGroup NewYork children NY-Routers "NY Customers"


HierarchicalGroup NewYork children Queens Nassau HierarchicalGroup NewYork children Bronx 


HierarchicalGroup NewYork members Router::nyc1


HierarchicalGroup NY-Routers members Router::nyc1


HierarchicalGroup "NY Customers" members file:/opt/dev/incharge-sa/smarts/local/conf/ics/ny-


customers.members
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This example illustrates the following syntactic rules of hierarchical group datafiles:


n Each line that specifies a hierarchical group must start with the keyword HierarchicalGroup.


n Elements of a hierarchical group must be separated by one or more spaces.


n The name of the group follows the keyword HierarchicalGroup. The name of the group must be
unique for all existing groups. If the same group name is used in multiple lines, each line is referring
to the same instance. In the example above, all four lines starting with “HierarchicalGroup NewYork”
are defining either children or members of the NewYork group.


n If the name of a group contains a space, it must be enclosed in double quotes.


n The keyword children indicates that this line specifies subgroups of the named group. For example,
NY-Routers and “NY Customers” are child groups, or subgroups, of the group named NewYork.


n The keyword members indicates that this line specifies members of the named group. For example,
the router nyc1 is a member of the group named NY-Routers. You must specify the class name and
the instance name of the topology element, separating them with a double colon (::).


n You cannot specify child groups and members in the same line. You can, however, use multiple lines
to specify members or children for the same group.


n You can specify a list of members in a member file. For example, the file ny-customers.members lists
members of the “NY Customers” group. However, you must specify the full path to the file, by using
the correct syntax for the host operating system.


The following example shows the syntax of a file that lists the members of a group. Because the
hierarchical group datafile specifies the name of the group, you only need to specify the
<class>::<instance> pairs, one per line, for each member, for example:


Router::nycbrd1


Router::nycbrd3


Switch::nycs2


Reconfiguring the Global Manager
â€œReconfiguring the serverâ€� on page 106 provides additional information on reconfiguring the
Global Manager.


Regrouping hierarchical group data
To regroup the hierarchical group and service topology datafiles, invoke the following command from the
BASEDIR/smarts/bin directory:


tdmctl -s <global_manager> invoke GA_DaemonDriver::


         


            ICS-Group-Driver start s


Depending on your security configuration, you might be prompted for your VMware Smart Assurance
username and password.
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When the Global Manager regroups the topology information in the datafiles, it first checks for errors. If
the Global Manager encounters an error, it writes output to the terminal or its log file and does not
process the datafiles.


Purging of HierarchicalGroupManager instance
The HierarchicalGroupManager instance maintains relationships with HierarchicalGroups and
SelectiveGroups. SelectiveGroups are created using SAM console and HierarchicalGroups are created
from configuration files. Once HierarchicalGroupManager instance is purged, the group instances are not
visible since the relationship information is lost even though group instances are present in the repository.


To recreate SelectiveGroups, run the following command:


./sm_adapter -s INCHARGE-linux ics/ics-restore-selectivegroup.asl


In case of HierarchicalGroup instances, perform the following steps to recreate them:


1 In the Global Manager Administration Console, expand INCHARGE-SA > ICS Configuration and
click Business Templates.


2 Click Modify List on the Configure “Business Templates” screen.


3 On the Edit Business Template dialog-box, select a template from Selected Template Files and
remove it.


4 From Available Template Files, add the template you just removed.


5 Click OK on the Edit Business Template dialog-box.


6 Click Apply on the Configure “Business Templates” screen.


7 Start the group driver by running the following command:


dmctl -s INCHARGE-SA invoke GA_DaemonDriver::ICS-Group-Driver start


Custom icons for map nodes
An administrator with appropriate privileges can add or remove a custom icon to a class of elements or to
individual elements. A custom icon can be used to customize maps for your organization and to meet the
needs of your operators.


The Global Console includes a default set of icons for all ICIM elements. Icons can be associated with
classes or instances.


If an icon is not associated specifically with a class, the icon for the parent class is used; this is the
derived icon. In addition, the icon for a given class could be associated multiple levels up in the class
hierarchy.


The set of icons shipped with the console does not include one icon for each class. The derived icon
(from the parent class) is used for those classes that do not have a specific icon assigned to them.
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You can use two methods to assign icons to class or instances:


n Use the Edit Map Icons operation in either the Global Manager Administration Console or the Map
Console.


n Use the sm_config utility to specify the name of the map icon specification file. Chapter 16 XML
Reference describes how to assign map icons using sm_config.


Note   Map icon text defaults to Helvetica 12 point. You can customize the map icon text. “Adjusting
Java properties” in the VMware Smart Assurance Service Assurance Manager Operator Guide
provides detailed information.


Assigning icons to classes or instances
Before assigning images to map nodes, you must create the images and save them to the proper
directory on the host where the Global Manager is running. Note that the icons included in the console
are not loaded over the network.


The requirements for custom images are:


n Images must be in GIF format.


n Images must be 56 pixels square.


After you obtain the custom images, copy them to the BASEDIR/smarts/local/images/icons directory.
Images located in this directory are automatically displayed in the icon configuration dialog box. The
filename of the image, minus any file extension, is used to identify the image.


If an image file located on the Global Manager has the same name as an icon included with the
console, the image located on the Global Manager takes precedence.


Assigning an icon to a class
To assign an icon to a class:


1 Select Configure > Edit Map Icons operation in the Global Manager Administration Console.


The Select Icons for: < Global Manager > dialog box appears.


2 Select the class in the Classes list box.


The Classes list box displays the classes of managed elements. By default, all classes are assigned
an icon. However, it might be an icon associated with a parent class. Certain classes are assigned
the same icon as their parent class. For example, the Redundancy Group icon is used for the System
Redundancy Group, Network Connection Redundancy Group, and Network Adapter Redundancy
Group. You can determine what icon is used for the System Redundancy Group by selecting this
class in the Classes list and seeing what is displayed as the derived icon. The name of the class to
which the derived icon is assigned is also displayed.


3 Click Use the specific icon.


4 Scroll through the list at the bottom of the dialog box to choose an icon.
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5 Click Apply.


6 When you are finished, click OK.


Assigning an icon to an instance
You can assign an icon to an instance without changing the class icon.


To assign an icon to an instance:


1 Select Configure > Edit Map Icons operation in the Global Manager Administration Console.


The Select Icons for: <Global Manager> dialog box appears.


2 Select the appropriate class in the Classes list box.


3 Select Select Instances.


The Instances list box displays the instances of the selected class in the topology.


4 Select the instance in the Instances list box.


5 Click Use the specific icon.


6 Scroll through the list at the bottom of the dialog box to choose an icon.


7 Click Apply.


8 When you are finished, click OK.


Reassigning the derived icon to a class
To reassign the derived icon to a class:


1 Select Configure > Edit Map Icons operation in the Global Manager Administration Console.


The Select Icons for: <Global Manager> dialog box appears.


2 Select the class in the Classes list.


3 Click Use the derived icon.


4 Click Apply.


5 When you are finished, click OK.


Reassigning the derived icon to an instance
To reassign the derived icon to an instance:


1 Select Configure > Edit Map Icons operation in the Global Manager Administration Console.


The Select Icons for: <Global Manager> dialog box appears.


2 Select the class in the Classes list.


3 Click the Select Instances checkbox and then select the instance.


4 Click Use the derived icon.
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5 Click Apply.


6 When you are finished, click OK.
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Tool Configuration for the
Global Manager 9
This chapter includes the following topics:


n Types of program tools


n How tools are invoked


n Security considerations for tools


n Sample tool scripts


n Creating tools


n Running automated tools with sm_adapter


n Running tools over X Windows


n Adding domain configurations


Types of program tools
A tool is a script that is typically invoked in response to a notification. Such a response might be to ping
an affected device or to open a trouble ticket. Tools can also be invoked on topology elements.
Service Assurance supports three types of tools:


n Server tools


n Client tools


n Automated tools


Server and client tools are associated with a user profile and invoked by an operator using the Global
Console. Two tool submenus, Server Tools and Client Tools, appear in a pop-up menu when an
operator right-clicks a notification or a device. Access to server and client tools can be controlled by
associating or not associating tools to user profiles:


n The Server Tools menu in the Global Console displays a list of available server tools. Server tools are
invoked by the Global Manager and available to any console user. For the tools to be available for a
user, the user’s profile must include the tools. “Security considerations for tools” on page 142
provides additional information.
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n Client Tools are invoked on the host where the Global Console is running, which requires that the tool
scripts are installed on the host where the console is running. The Client Tools menu displays a list of
available client tools, provided the user’s profile includes the tool.


Note   Client tools can also be invoked from the web console. The
VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide describes
how to configure client tools for the web console and the Business Dashboard.


n An automated tool is a type of server tool that is invoked by an escalation policy or an adapter.
Automated tools are not visible to users of the Global Console.


Additional Service Assurance tools
In addition, Service Assurance provides the following tools that are described in separate documents.
They include:


n Business Process Tools. The VMware Smart Assurance Business Impact Manager User Guide
provides additional information.


n Report Manager tools. The VMware Smart Assurance Report Manager User Guide provides
additional information.


n Remedy tools. The VMware Smart Assurance Adapter for Remedy ARS User Guide provides
additional information.


n Concord eHealth tools. The VMware Smart Assurance Adapter for Concord eHealth User Guide
provides additional information.


How tools are invoked
This section describes how to invoke tools and where the output of server and client tools appears.


Invoking server and client tools
Server and client tools are invoked through the Global Console. Such tools are always invoked on a
particular target object by the console operator. The target object can be a notification or a topology
element such as a router. When an operator right-clicks the target, the pop-up menu lists the available
tools. The VMware Smart Assurance Service Assurance Manager Operator Guide describes how to
invoke tools from the Global Console.


Viewing the output of a server or client tool
Server and client tools, depending on their purpose, might produce output. For example, the output of a
ping tool indicates whether the ping completed successfully.


For client and server tools, you can configure whether a tool displays any output. When a server tool is
configured to display output, the output is echoed to stdout and collected by the Global Manager. The
Global Manager sends the output back to the console where the tool was invoked.
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The output of server and client tools is displayed in the Tool Output window. The Tool Output window
opens when the tool is invoked. Output is written to the window while the tool is running. If a tool
produces an error, the error message is also displayed in the Tool Output window. If an error occurs for a
server tool that is not configured to display output, the Tool Output window displays the return code of the
tool.


Note   If the SAM server is started by attaching the server to a broker address that is different from the
one specified during SAM installation, then the SM_BROKER variable for the non-default broker must be
specified in the local/conf/runcmd_env.sh file. If the SM_BROKER variable for the non-default broker is
not specified, the server tool will not work as expected.


The Tool Output dialog box includes a Stop button. Client tools, such as shell scripts that do not respond
to a SIGTERM signal will not stop when an operator clicks Stop. Create a client tool script that responds
to a SIGTERM signal or manually stop the process from the command line or from the Task Manager.


Invoking automated tools
An automated tool is run when it is triggered based on the settings of an escalation policy. An escalation
policy is configured to invoke automatic tools to run on notifications that meet the escalation criteria for
specified periods of time. Chapter 10 Escalation Configuration for the Global Manager includes additional
information on configuring the Global Manager.


Alternatively, an automated tool runs with the automatic action adapter on the same host as the
Global Manager. Start this adapter by invoking the sm_adapter command and supplying a list of
arguments. After starting the automatic action adapter, no further intervention is required. The adapter
uses a notification list to listen for particular notifications. When it receives a matching notification, it
automatically responds by invoking the specified tools through the Global Manager.


Once started, the automatic action adapter runs in the background and responds to notifications that
match its notification list. For example, the automatic action adapter, configured with a trouble-ticket
system tool, could respond to a notification by opening a trouble ticket. Modifying a tool includes
additional information about creating an automated tool.


Information recorded to a notification’s audit log
When a server or automated tool is invoked on a notification, information about the tool is recorded to the
notification’s audit log. This information includes:


n Date and time when the tool was invoked.


n Name of user that invoked the tool.


n Whether the tool completed successfully.


n Name of the tool.
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Security considerations for tools
If a tool invokes an VMware Smart Assurance utility, such as dmctl, or otherwise initiates a connection to
the Global Manager, you must configure security to enable that connection. An essential piece of
information is knowing the username under which the tool is invoked, for example:


n Client tools are invoked under the username of the operator who started the Global Console.


n Server tools are invoked under the username that the Global Manager is running under. Remember,
server tools are invoked on the same host as the Global Manager.


n Automated tools are invoked under the username that started the sm_adapter command or by the
name of the Global Manager.


If a client tool needs to connect to the Global Manager and perform an action that requires
administrative privileges, you have two choices:


n Provide the operator with administrative privileges.


n Create a server tool that performs the action.


As the server tools run under the username that invoked the Global Manager process, this user must
have an authentication record in the clientConnect.conf and serverConnect.conf files on the host
where the tool is to be executed. You must configure the authentication records for this account so
that prompting is not required. Prompting should not be used for automated tools.


Sample tool scripts
VMware Smart Assurance provides a number of sample tool scripts that, with minor modifications, work
on most systems. The main purpose of these scripts, however, is to provide examples that you can
examine when developing your own tools.


Note   The ping and Telnet tools are sample scripts. You need to customize them to meet the needs of
your environment. For example, the sample scripts do not take firewalls into account.


Sample server tool scripts lists the sample server and automated tools, the display name for the tool as
seen by users in the Global Console, and provides a brief description. Server and automated tools are
located in the BASEDIR/smarts/actions/server directory.


To modify one of the sample tool scripts, open it with the sm_edit utility to create a local copy of the
script.
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Table 9‑1.  Sample server tool scripts


Server tool script Display name for tool Description


ics-closetkt Sample - Close Trouble Ticket This tool inserts a static value into the field of a notification. The
context and Status Criteria specify that this tool is only active for
notifications with the text OPEN in the TroubleTicketID field.


ics-opentkt Sample - Open Trouble Ticket This tool inserts a static value into the field of a notification. The
context and Status Criteria specify that this tool is only active for
notifications without the text OPEN in the TroubleTicketID field.


ics-ping-interface Sample - Ping-Interface This tool pings an IP interface. The Context Criteria specify that this
tool is active for notifications with a value of “Interface” for the
ClassName attribute.


ics-ping-IP Sample - Ping-IP This tool pings an IP interface. The Context Criteria specify that this
tool is active for notifications with a value of “IP” for the ClassName
attribute.


ics-ping-all Sample - Ping-all This tool pings all the IP interfaces associated with a device. The
Context Criteria specify that this tool is active when the target is a
UnitaryComputerSystem. As such, valid targets include both
notifications and instances.


When invoked, this tool retrieves all of the IP addresses associated
with the target instance from one or more underlying domains. Two
variables that control the behavior of the tool:
n PING_ALL_DOMAINS controls whether the tool retrieves IP


addresses from each underlying domain that manages the
instance. When set to 0, the default, the tool retrieves IP
addresses from a single domain. When set to 1, the tool
retrieves IP addresses from all domains.


n PING_ONCE controls whether the tool pings each retrieved IP
address or whether it stops after the first successful ping. When
set to 0, the tool stops after the first successful ping. When set
to 1, the default, the tool pings all available IP addresses.
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Table 9‑1.  Sample server tool scripts (Continued)


Server tool script Display name for tool Description


ics-ping-device Sample - Ping-device This tool pings the IP address of the SNMP agent for the affected
element. The Context Criteria specify that this tool is active when
the target is a UnitaryComputerSystem. As such, valid targets
include both notifications and instances.


When invoked, this tool retrieves the IP address of the SNMP agent
associated with the target instance from one or more underlying
domains.


The tools script includes one variable that controls the behavior of
the tool:
n PING_ALL_DOMAINS controls whether the tool retrieves IP


addresses from each underlying domain that manages the
instance. When set to 0, the default, the tool retrieves IP
addresses from a single domain. When set to 1, the tool
retrieves IP addresses from all domains.


ics-telnet Sample - Telnet This tool opens a Telnet session with the affected device. The .sh
version of this script pings an IP address of the affected device
before attempting to connect. If the ping fails, the script pings
another IP address on the device, and so on until a ping succeeds
or all the pings fail. When a ping succeeds, the script connects to
the IP address where the ping succeeded.


If this tool is invoked from a console that is running over X
Windows, the script opens a separate window on the user’s display
to invoke the Telnet session.


Sample client tools scripts lists the sample client tools and provides a brief description of each. Client
tools are located in the BASEDIR/smarts/actions/client directory.


Table 9‑2.  Sample client tools scripts


Client tool Description


SmGetEnv This tool parses the environment variables passed by the Global Manager to the tool
script. It also prints all environment variables to the Tool Output window. A version of this
tool script is also provided in Perl.


SmLaunchPerlScript This tool launches the SmGetEnv.pl tool script to illustrate how you can launch Perl
scripts from a tool.


You must edit this script to specify the location where Service Assurance is installed.


browser This tool opens a web browser. You must edit this script to specify the location where
your browser is installed.


ciscoworks This tool opens a web browser that loads the administration page for CiscoWorks. You
must edit this script to specify the location of your browser and the host where
CiscoWorks is running.
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Table 9‑2.  Sample client tools scripts (Continued)


Client tool Description


pinger This tool pings the name of the specified element.


Reporting This action accesses reports available through the Service Assurance Report Manager. It
opens a web browser with the URL set to the location of the Crystal Enterprise EportFolio
application. You must edit this script to specify both the web browser and the URL.


Remember that tool scripts are system-specific. You can also write a tool script in a language such as
Perl, which runs on different platforms with little or no modification.


Creating tools
This section provides the information necessary to create and configure a tool script.


Follow these steps to develop and use a tool script:


1 Determine the action to be performed by the tool and write the script.


2 Save the script to the proper location.


3 Test the tool script to ensure that it executes properly.


4 Assign the proper read and execute permissions to the tool script.


5 Configure the tool to invoke the script. In addition, client and server tools must be associated with the
appropriate user profile. For automated tools, you must create an adapter or escalation policy to
invoke the tool.


You can configure tools by using one of the following tools:


n Global Manager Administration Console, as described in this section.


n The sm_config utility, Chapter 12 Importing and Exporting Configurations provides additional
information.


How data is passed to a tool script
When a tool is invoked, the attributes of the tool target are automatically passed to the tool script. The
attributes are passed to the tool script as environment variables in the form:


 SM_OBJ_<NAME>=<value>


The <NAME> parameter identifies the attribute and the <value> parameter contains the attribute’s value.
For example, the ClassName attribute would be passed in the environment variable:


 SM_OBJ_CLASSNAME=Router
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Your tool script must parse these environment variables and extract the information required by the
program invoked by the tool script. For example, if you want a tool that telnets to a device, you need to
extract the environment variable that contains the name or IP address of the device, as shown in the
example code :


rem if SM_OBJ_Name isn't set in environment report an error


if not defined SM_OBJ_Name (


   echo Invalid SM_OBJ_NAME


   exit 0 


)


rem Use the value of SM_OBJ_Name to connect to the device


start /wait cmd /c "telnet %SM_OBJ_Name% "


The tool target can either be a notification or an instance. For both types of targets, a tool script receives
the attributes listed in Attributes passed to all tool scripts as environment variables.


Table 9‑3.  Attributes passed to all tool scripts


Environment variable Description


SM_REMOTE_USER Specifies the VMware Smart Assurance username of the person
that invoked the tool.


SM_SERVER_NAME Specifies the name of the Global Manager that executes the tool
script.


Attributes for element targets lists the attributes that are passed to the tool script when the target is an
instance.


Table 9‑4.  Attributes for element targets


Element target attributes Description


SM_OBJ_CLASS_NAME Class name of the system. For example, Router.


SM_OBJ_INSTANCE_NAME Name of the system.


SM_OBJ_DOMAIN_NAME Name of the Global Manager.


Attributes for notification targets lists the attributes that are passed to the tool script when the target is a
notification.


Table 9‑5.  Attributes for notification targets


Notification target attributes Description


SM_OBJ_Acknowledged Specifies whether the notification is acknowledged. TRUE if the
notification has been acknowledged, FALSE if not.


SM_OBJ_Active Specifies whether the notification is active. TRUE if the notification is
active, FALSE if not.
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Table 9‑5.  Attributes for notification targets (Continued)


Notification target attributes Description


SM_OBJ_Category Type of notification sent by the Global Manager. Possible values
include:
n BackplaneUtilization
n Error
n Performance
n PowerSupply
n Resource
n SystemConnectivity
n Temperature
n VLANConnectivity


SM_OBJ_Certainty Confidence that this notification is the correct diagnosis. Value
ranges from 0 to 100.


SM_OBJ_ClassDisplayName Name of the ClassName that is displayed to the user.


SM_OBJ_ClassName Name of the class where the event occurred. Might not be the same
as SM_OBJ_ClassDisplayName.


SM_OBJ_ElementClassName Class name of the managed element most closely related to this
event.


SM_OBJ_ElementName Name of the managed element most closely related to this event.


SM_OBJ_EventDisplayName Name of the EventName that is displayed to the user.


SM_OBJ_EventName Name of the event. Might not be the same as
SM_OBJ_EventDisplayName.


SM_OBJ_EventText A description of the notification.


SM_OBJ_EventType MOMENTARY when the notification has no duration. DURABLE if
the notification has a period for which it is active, such as a link
failure.


SM_EventState State of the event. Possible values include:
n ACTIVE
n WAS_ACTIVE
n SUSPENDED
n INACTIVE


The UNITIALIZED state is not relevant here.


SM_OBJ_FirstNotifiedAt Time, in seconds, when the notification first became active.


SM_OBJ_Impact Numeric value that indicates the effect of this event on related
elements.


SM_OBJ_InMaintenance TRUE if the device is in maintenance mode, FALSE if not.


SM_OBJ_InstanceDisplayName Name of the InstanceName that is displayed to the user.


SM_OBJ_InstanceName Name of the instance where the event occurred. Might not be the
same as SM_OBJ_InstanceDisplayName.


SM_OBJ_IsProblem TRUE if (and only if) at least one of the types is “PROBLEM”, and
none of the types are anything other


than “PROBLEM” or “UNKNOWN”.
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Table 9‑5.  Attributes for notification targets (Continued)


Notification target attributes Description


SM_OBJ_IsRoot TRUE if the notification is a root cause, FALSE if not.


SM_OBJ_LastChangedAt Time, in seconds, when the status of the notification last changed.


SM_OBJ_LastClearedAt Time, in seconds, when the notification was last cleared.


SM_OBJ_LastNotifiedAt Time, in seconds, when the notification was last notified.


SM_OBJ_Name InternalEventHandle for the notification.


SM_OBJ_OccurrenceCount Number of times the notification has occurred.


SM_OBJ_Owner Name of the person responsible for this notification. Value is
SYSTEM when acknowledged by the Global Manager.


SM_OBJ_Severity Level of severity for this notification.


1 = CRITICAL


2 = MAJOR


3 = MINOR


4 = UNKNOWN


5 = NORMAL


SM_OBJ_SourceDomainName Name of the underlying domain that sent this notification. If more
than one domain is listed, the names are separated by commas.


SM_OBJ_SourceEventType Indicates the type of event from an underlying source or sources.
Value can be: PROBLEM, EVENT, AGGREGATE, or UNKNOWN.
The default value is UNKNOWN.


SM_OBJ_TroubleTicketID Trouble-ticket number associated with this notification.


SM_OBJ_UserDefined1-20 Twenty user-defined fields.You can populate these fields with data
with an ASL hook script.


Attributes for escalation targets lists additional attributes that are passed to the tool script when the tool is
invoked through an escalation policy.


Table 9‑6.  Attributes for escalation targets


Element target attributes Description


SM_POBJ_POLICY Name of the policy that executed the tool.


SM_POBJ_PATH Name of the path that executed the tool.


SM_POBJ_LEVEL Name of the level that executed the tool.


In addition to the attributes listed above, a server tool script receives the DISPLAY environment variable.
The value of this variable is used to determine the location of the user’s X Window System display.
“Running tools over X Windows” on page 156 includes detailed information for invoking server tools
through an X Windows System.
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Where to save tool scripts
After you write a script, you need to save it to the proper location and ensure that it is executable. A
server tool, which includes automated tools, must be located in the BASEDIR/smarts/local/actions/server
directory on the host where the Global Manager is running. The Global Manager must be able to execute
the script.


A client script must be located on the host where the Global Console is installed. The proper location is
the BASEDIR/smarts/local/actions/client directory. The console user must be able to execute the script.
Server and client tools are configured in the Global Manager Administration Console.


Configuring with the Global Manager Administration Console
New tools, or modifications to existing tools, are not available to console users until they restart the
Global Console.


To configure a tool by using the Global Manager Administration Console:


1 Select the type of tool you need to configure from the Edit menu or click the appropriate toolbar
button. This displays one of the following wizards:


n Automated Tool Creation Wizard


n Client Tool Creation Wizard


n Server Tool Creation Wizard


2 Type a name for the tool. This name is displayed in the Global Manager Administration Console, and,
for server and client tools, in the Global Console.


3 Do one of the following:


n Click Create New.


n Click Copy Existing.


When you copy an existing tool, the configuration parameters for the tool are the same as the
copied tool.


4 Click Next.


5 Define the following tool parameters:


n Program to run


n Time-out Interval


n Trace


n Display (client and server tools only)


n User Profiles (client and server tools only)


Tool parameters describes these parameters.


6 Click Next.
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7 Use the Filter Builder to specify the Context Criteria for a server or client tool and click Next.


Using the Filter Builder, includes detailed information on the Filter Builder. Context and Status Criteria
for client and server tools includes additional information on Context and Status Criteria.


8 Use the Filter Builder to specify the Status Criteria for a server or client and click Next to advance to
the confirmation screen.


9 Click Finish to create the tool. You will receive an error message or a success message based on the
result.


Tool parameters
Server tool configuration parameters describes the configuration parameters for tools. Only a subset of
these parameters are available for automated tools.


Table 9‑7.  Server tool configuration parameters


Parameter Description


Name Name of the tool that is displayed in the console.


Program Specifies the name of the program that is invoked when the tool runs. Type the program name or
select a program from the pop-up menu:
n For client tools, this is a list of tools in the BASEDIR/smarts/actions/client and


BASEDIR/smarts/local/actions/client directories on the host where the Global Manager
Administration Console is running.


n For server or automatic tools, this is a list of tools in the BASEDIR/smarts/actions/server and
BASEDIR/smarts/local/actions/server directories. This parameter cannot contain path separators.
This is a list box of existing server or client scripts.


The name cannot contain path separators.


Timeout Interval Specifies the number of seconds to wait for a tool script to complete. If the tool script does not
complete within the specified time, the tool process is terminated. The default is 30 seconds.


Trace Specifies whether trace output, used for debugging, should appear in the tool output window when a
tool is run.


Display Output Specifies whether a tool script should display output to the console. If this parameter is set to true,
the console opens the Tool Output window immediately after invoking the tool. If false, the Tool
Output window opens only if the tool returns an error. If this parameter is omitted, it defaults to true.
This parameter is not applicable to automated tools.


User Profiles Specifies the user profiles that include this tool. This parameter is not applicable to automated tools.


Context Determines whether a tool displays in the console’s pop-up menu when the user right-clicks on a tool
target. A tool always displays when this parameter is omitted. This parameter is not applicable to
automated tools.


Status Determines whether a tool is enabled or disabled in the console’s pop-up menu. A tool is always
enabled when this parameter is omitted. This parameter is not applicable to automated tools.


Configuration of server tools prompts
Server tools include the capability of prompting for input when a user invokes the tool. The input provided
by the user is passed to the server tool when it runs.
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Administrators, using the Server Tool Wizard in the Global Manager Administration Console, can specify
the parameters that are displayed to the user in the prompt. Each parameter includes three fields:


n Name, which is required, is the internal name of the parameter


n Text, which is the description displayed to the user


n Width, which specifies the visible size of the input field in characters


Parameters are passed from the Global Console to the script, by way of the Global Manager, as
environment variables in the form SM_POBJ_<name>, where <name> is the internal name of the
parameter.


Context and Status Criteria for client and server tools
Context Criteria and Status Criteria determine whether a tool is applicable to the selected target. If an
operator selects an instance, then the target is an instance. If an operator selects a notification, the target
can be either the notification or the instance where the notification occurred, as identified by the
ElementClass and ElementInstance attributes.


Context Criteria determine whether a tool is displayed in the menu when a target is selected. The console
checks the Context Criteria when the notification is received and does not re-check until the notification is
archived and re-notified. Hence, you must apply context checking to attributes whose values do not
change:


n Category


n ClassDisplayName


n ClassName


n ElementClassName


n ElementName


n EventDisplayName


n EventName


n EventType


n InstanceDisplayName


n InstanceName


Although you can apply context checking to other attributes, the results are based on the initial value
of the attribute.


Status Criteria determines whether a tool is active. The name of a disabled tool is dimmed in the
menu and cannot be invoked. You should apply Status Criteria to attributes whose value might
change, including:


n Acknowledged


n Active
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n Certainty


n ClearOnAcknowledge


n EventState


n EventText


n Impact


n InMaintenance


n IsProblem


n IsRoot


n OccurrenceCount


n Owner


n Priority


n Severity


n SourceDomainName


n SourceEventType


n TroubleTicketID


The tool target determines what attributes are passed to the tool to be matched against the Context
Criteria. For example:


n When the target is an element, you can match against the attributes specified in Context and Status
Criteria for client and server tools.


n When the target is a notification, the matching criteria determine which attributes are passed to the
Context Criteria.


Results differ depending on the matching criteria:


n If the matching criteria specify a notification attribute, then the attributes of a notification, from Context
and Status Criteria for client and server tools, are passed.


n If the matching criteria specify an element, then the attributes of an element are passed.


Creating Context and Status Criteria
Chapter 11 Working with Filters provides information on specifying Context and Status Criteria by using
the Filter Builder. You can use an expression filter or an ASL filter to specify context and Status Criteria.
Unlike the filters you can create for notification lists, you can use either an expression filter or an ASL
filter, but not both.
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The following example illustrates creating Context Criteria using Filter Builder:


1 Select a class from the Context object list box. The filter expression is matched against one or more
attributes of the selected class.


For example, select the UnitaryComputerSystem class.


2 Add an attribute to the filter sheet to specify a wildcard expression against an attribute of
UnitaryComputerSystem. This enables you to narrow the range of notifications for which the tool is
displayed.


If you do not add an attribute, the Context Criteria matches all instances of UnitaryComputerSystem
or its subclasses.


3 Click Next. The filter sheet for Status Criteria appears.


4 Select a class from the Status object list box. The filter expression is matched against one or more
attributes of the selected class.


For example, to match Routers, select the Router class.


5 Add an attribute to the filter sheet to specify a wildcard expression against an attribute of the Router
class.


If do not add an attribute, the Status Criteria matches all instances of the Router class.


6 For example, select the Vendor attribute and type a value of CISCO. The Status and Context Criteria
for this tool specify that it displays in the Server Tools menu for any system element or any notification
for which the failing element is a system. If that system is a router with a value of CISCO for its
Vendor attribute, the tool is active and can be invoked.


7 Do the following:


n Click Next to view the confirmation screen.


n Click Finish to create the tool configuration.


Modifying a tool
To modify an existing server, client, or automated tool:


1 Select the tool in the tree of the Global Manager Administration Console.


The Configure Tool panel appears.


2 Modify the appropriate parameters.


3 Click Apply to synchronize the changes in the Global Manager.


Disabling a tool
You can disable server, client, and automated tools. This allows you to prevent the tool from being used.
Disabled tools are not displayed in the Global Console and do not execute when launched through an
escalation policy or through sm_adapter.
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To disable a tool:


1 Select the appropriate client, server, or automated tool in the Global Manager Administration
Console.


2 On the configuration panel, clear the Enable checkbox.


The name of disabled tool displays in gray in the navigation tree.


3 Click Apply.


Changing the order in which tools are displayed
You can determine the order in which tools are displayed in the Server Tools and Client Tools menus of
the Global Console.


To change the display order:


1 In the Global Manager Administration Console, select Automatic, Client, or Server under Tools
in the tree.


The Prioritize Tools panel appears.


2 Use the up and down arrows to move a tool up or down in the menu list.


3 Click Apply. The changes become effective immediately.


Running automated tools with sm_adapter
The configuration options for an automated tool are specified as arguments to the sm_adapter program
when you invoke it at the command line. Arguments to sm_adapter for automated action lists the
arguments you should specify when invoking an automated tool.


Table 9‑8.  Arguments to sm_adapter for automated action


Argument Default value Description


--server= INCHARGE-SA The name of the Global Manager from which the adapter
receives its notification list and notifications.


--subscribe= N/A Name of the notification list received from the Global Manager.


-DNotifyAction= N/A Name of the tool as specified in the Global Manager
Administration Console. This is the tool to invoke when a
notification is active. This argument is optional.


-DClearAction= N/A Name of the tool as specified in the Global Manager
Administration Console. This is the tool to invoke when the
notification clears. This argument is optional.


-DLogActions= FALSE Specifies whether the adapter should log each action to stdout.
This argument is optional.


--output N/A Redirects the output from the adapter to a log file in
BASEDIR/smarts/local/logs. The --DLogActions argument must
be true to enable output.


rules/ics/auto-action.asl N/A Script required to perform the automated action.
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The following example shows the arguments for the automatic action adapter that invokes the “Open
Trouble Ticket” script when a notification becomes active (is notified) and invokes the “Close Trouble
Ticket” tool when the notification becomes inactive (clears):


t BASEDIR/smarts/bin/sm_adapter   --server=INCHARGE-SA \


    --subscribe=TicketingNL/n  \


   -DNotifyAction="Open Trouble Ticket"  \


   -DClearAction="Close Trouble Ticket"  \


   -DLogActions=TRUE  \


   --output  \


   ../rules/ics/auto-action.asl s


Running tools over X Windows
If necessary, you can configure a server tool to invoke an X Windows application. The console user that
invokes such an action must run an X server in order to display the X window. When the Global Console
attaches to the Global Manager, it passes the user’s display information to the Global Manager.


The Global Console determines a user’s display by using the following rules:


n If the environment variable SM_DISPLAY is set, its value is passed to the Global Manager.


n If the environment variable DISPLAY is set, its value is passed to the Global Manager.


n The value is set to <host>:0.0 where <host> is the name of the user’s system.


Because X Windows applications are typically long running, take special care when writing the tool
script to avoid unwanted interactions with the tool timeout. You should write the tool script so that the
X Window application runs in the background. This allows the tool script to exit and the
Global Manager to stop the timeout. If the tool’s script runs in the foreground, the Global Manager
terminates the process when the timeout expires.


The sm_xcmd utility is provided by VMware Smart Assurance for executing an X Windows
application in the background. The utility performs a basic connectivity test of the user's X Windows
display. The ics-telnet.sh server tool is an example of a tool script that uses sm_xcmd to run an
application over X Windows.


Adding domain configurations
Domains are configured using the graphical interface accessed from the Global Manager Administration
Console. The domain configuration information is saved to repository files. The repository files include
information for the following predefined domains:


n INCHARGE-AM


n INCHARGE-PM


n INCHARGE-AM-PM


n INCHARGE-AM2


n INCHARGE-OI
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n NCM


n INCHARGE-DISCMGR


n INCHARGE-MPLS-ANALYSIS


n INCHARGE-MPLS-MONITORING


n INCHARGE-MPLS-TOPOLOGY


Note   Only the INCHARGE-AM domain is enabled. You must enable other domains or create new
ones as necessary.


If your domain configurations are not predefined in the Service Assurance Manager server, you can
use the following tools to add new configurations to the Service Assurance Manager server:


n Import XML Domain Configurations


n Import XML Configurations


Chapter 6 Configuring Domainsprovides additional information on the ics-default.xml file.


Importing XML Domain Configurations
To add new configurations using the XML domain configuration tool:


1 Open the Topology Browser Console.


2 Right-click the instance of the local InChargeDomain representing the Service Assurance Manager
server.


3 Select Server Tools > Import XML Domain Configuration.


The Import XML Domain Configuration dialog box appears, as illustrated in Import XML Domain
Configuration dialog box.


Figure 9‑1.  Import XML Domain Configuration dialog box


4 Type a domain type descriptor in the Domain Type Descriptor field.


Available domain type descriptors defines domain type descriptors for all available domain
configuration files.
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Table 9‑9.  Available domain type descriptors


Domain type
descriptor Filename Description


acm ics-acm-default.xml Application Connectivity Manager post 1.0


acm-1.0 ics-acm-1.0-default.xml Application Connectivity Manager 1.0


ai ics-ai-default.xml Application Insight


app-poller ics-app-poller-default.xml Application Poller


asm ics-asm-default.xml Application Services Manager


atm ics-atm-default.xml ATM-Frame Relay Manager


bmc cs-bmc-default.xml --


ciena ics-ciena-default.xml Ciena TMF14 Adapter


ctm ics-ctm-default.xml Cisco TMF814 Adapter


dfm ics-dfm-default.xml Device Fault Manager


mcast ics-mcast-default.xml Multicast Manager


mpls ics-mpls-default.xml MPLS Manager


mpls1.3 ics-mpls1.3-default.xml MPLS Manager 1.3 and earlier


npm ics-npm-default.xml Network Protocol Manager


oi ics-oi-default.xml Open Integration Server


sam ics-sam-default.xml Hierarchical SAM


sdi ics-sdi-default.xml SQL Data Interface


sia ics-sia-default.xml Storage Insight


sia-group ics-sia-group-default.xml Storage Insight using the new domain group mechanism


sim ics-sim-default.xml Security Infrastructure Manager


sonet ics-sonet-default.xml --


vhm ics-vhm-default.xml Voice Health Manager


voip ics-voip-default.xml Voice over IP Manager


wdm ics-wdm-default.xml --


xdatmfrip ics-xdatmfrip-default.xml Cross Domain ATM-FR to IP


xdotmip ics-xdotmip-default.xml Cross Domain OTM to IP


1 Click the Apply these values to all selected objects option to have the domain values applied to
selected objects.
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2 Click OK.


Note   The domain configuration is imported in a disabled state. To begin synchronization with
Service Assurance Manager, enable the domain and click the Launch Server Reconfiguration
toolbar button located on the Global Manager Administration Console toolbar menu.


If the SAM server is started on a non-default broker, importing an XML Domain configuration throws
an error. This issue can be avoided by updating the value of the non-default broker under
SM_BROKER_DEFAULT in the runcmd_env.sh file.


Importing XML configurations
To add new configurations using the generic configuration tool:


1 Open the Topology Browser Console.


2 Right-click the instance of the local InChargeDomain representing the Service Assurance Manager
server.


3 Select Server Tools > Import XML Configuration. The Import XML Configuration dialog box
appears, as illustrated in Import XML Configuration dialog box.


Figure 9‑2.  Import XML Configuration dialog box


4 Type the name of the XML file you want to load in the Configuration File to Load field.


Note   The XML being added must reside in the SITEMOD/conf/ics directory.


5 Click OK.
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Escalation Configuration for the
Global Manager 10
This chapter includes the following topics:


n Overview of escalation


n How notifications are scheduled for escalation


n Developing escalation policies


n Modifying escalation policies and paths


n Removing or deleting escalation paths and policies


n Testing and troubleshooting escalation policies


Overview of escalation
Escalation provides a method for automatically responding to a notification:


n As soon as the notification is received by the Global Manager.


n When the notification satisfies certain conditions.


Automatic escalation can enhance your problem resolution process by:


n Dispatching maintenance staff with a description of hardware failures and the specific parts they will
need.


n Restoring service by restarting applications, initiating failover processes, or rerouting services around
failed components.


n Notifying customers of service outages and providing status updates.


n Alerting successive layers of management of unresolved problems to ensure that they receive the
proper level of attention.


Escalation helps prevent important notifications from being overlooked or ignored and can
immediately start the process of remedying the situation that caused the notification.


For example, you can create an escalation policy that is activated when a specific router goes down.
When this notification occurs, the Global Manager matches it to the appropriate escalation policy and
path. The path then begins invoking tools such as opening a trouble ticket and paging technicians.
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A notification continues to escalate while it matches the filter criteria of the path. As time progresses,
the notification may escalate to different levels in the path based on the duration, and the path may
invoke additional tools to respond to the notification. If the status of the notification changes in such a
way so that it no longer matches the path’s filter criteria, the notification no longer escalates to the
next path level.


For example, if a Router Down notification matches against the path filter for 15 minutes, the
notification is escalated to the next level. At this level, the escalation path could invoke a tool that
sends email to a manager. But, if a technician acknowledges the notification after 10 minutes, and
this acknowledgement causes the notification to no longer match the path filter criteria, the notification
does not escalate to the next level.


Escalation policy structure
An escalation policy is a set of related escalation paths. An escalation policy includes a policy filter and
one or more escalation paths, as shown in Escalation policy structure. Notifications that match the policy
filter are passed to the escalation paths. If a notification does not match the policy filter, it is ignored. If a
policy filter is not defined, all notifications are passed to the escalation paths.


An Escalation Path also includes a filter and up to six escalation levels. A notification must match both the
policy filter and the path filter to begin at the first escalation level, Level 0.


Each escalation level includes one or more automated tools to invoke and a time duration, after which a
notification advances to the next level. An escalation level cannot have a duration of less than 1 minute.
You can, if necessary, create an escalation level that does not invoke a tool.


Figure 10‑1.  Escalation policy structure
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When a notification matches both the policy and path filters, it starts at escalation level 0. When a
notification reaches level 0, the tools associated with level 0 are invoked immediately. The notification
remains at Level 0 for the specified duration, shown as T0 in Escalation policy structure, before escalating
to Level 1. At this point, all Level 1 tools are invoked and, after the duration of T1, the notification
escalates to Level 2. This process repeats through each level defined for the path. If the notification
changes during escalation and no longer matches the path and policy filters, it leaves the escalation path
without invoking any additional tools.


Viewing an escalation policy
You create, configure, and monitor escalation policies with the Global Manager Administration Console.
Expanding Escalation Policies in the administration tree lists escalation policies. Selecting a policy in the
administration tree displays the Escalation Policy view, as shown in Escalation policy view .


Policy names in the administration tree are black when any escalation path in the policy is enabled. When
all paths in a policy are disabled, the policy name is dimmed.


The Configure Escalation Policy view allows you to create, modify, and delete escalation policies, paths,
and levels. In addition, you can monitor the status of an escalation policy by right-clicking on an
escalation path and selecting Show Notifications from the menu.


Escalation paths are displayed as horizontal bars. The name on the left of the escalation path is the
pathname. Within each bar are shaded blocks, each of which represents an escalation level within the
path. The duration and automated tools are listed within each escalation level of the path.


An enabled escalation path is displayed with each level a different color. A disabled path is dimmed. All
the escalation paths shown in Escalation policy view are enabled.
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Figure 10‑2.  Escalation policy view


When you hold the cursor over an escalation level, a tooltip window displays:


n Level: Indicates the level (0–5) within the path.


n Time to level: Indicates the amount of time it takes a notification to reach this level within the path.


n Duration: Indicates the amount of time a notification spends at this level before advancing to the next
level. However, Duration does not include the time it takes to invoke any tools. When a level is
reached, actions are executed first. When all actions have finished executing, the notification is
scheduled to enter the next level. The notification will enter the next level after the amount of time set
by Duration.


n Tools: Lists the automated tools that are invoked at this level.


At the bottom of the Configure Escalation Policy window are three buttons:


n Add Path — Adds a new escalation path to the displayed policy. This is equivalent to selecting
Escalation > Path > New.


n Apply — Saves any changes made to the escalation configuration to the Global Manager. If you have
unsaved changes, you are prompted to save before leaving the view.
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n Refresh — Retrieves the configuration of current escalation policy from the Global Manager. This is
important if another administrator might be modifying the policy that you are currently viewing. The
Global Manager prevents two administrators from overwriting each other’s changes without first
viewing the changes. For example, if you make changes to an escalation policy and apply them while
another administrator is also making changes, the other administrator will not be able to apply the
changes. The Global Administration Manager Console prompts the other administrator to refresh their
policy view.


Refresh can also be used to cancel changes that have not been applied.


How notifications are scheduled for escalation
When the Global Manager receives or creates a notification, it compares the notification against the filter
for each policy and path. If the notification matches a policy and path filter, the Global Manager schedules
the notification for escalation. When a level is reached, actions are executed first. When all actions have
finished executing, the notification is scheduled to enter the next level. The notification will enter the next
level after the amount of time set by the duration of the level.


The Last Notify time, or the LastNotifiedAt notification attribute, also determines whether a notification
enters into an escalation policy. The Last Notify Time must be later than the time at which the path was
enabled in order for the notification to escalate.


If a Global Manager is stopped and restarted, the Global Manager restores the state of escalated
notifications. Notifications which are scheduled to escalate to a new level before the Global Manager
stops are rescheduled based on the current time when the Global Manager is restarted.


The rescheduled escalation time accounts for the time that the Global Manager was not running. A
rescheduled notification, however, will never escalate more than one level as a result of the time the
Global Manager was not running.


Effect of Global Manager restart on escalation
The following examples illustrate the effect of a Global Manager restart on escalating notifications.


Example 1
1 A notification enters escalation level 0 at 1 P.M. The duration of the level is 1 hour.


2 At 1:10 P.M. the Global Manager is shut down.


3 At 1:25 P.M. the Global Manager is restarted.


The notification was scheduled to escalate to level 1 at 2 P.M. When the Global Manager restarts, this
notification is rescheduled to escalate at 2 P.M.


Example 2
1 A notification enters escalation level 1 at 2 P.M. The duration of level 1 is 10 minutes and the duration


of level 2 is 10 minutes.
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2 The Global Manager is shut down at 2:05 P.M. and restarted 20 minutes later at 2:25 P.M.


Prior to the Global Manager shutting down at 2:05 P.M., the notification would have escalated to level
2 at 2:10 P.M. and was scheduled to escalate to level 3 at 2:20 P.M. (the duration of level 2 is 10
minutes).


Since the notification was in level 1 when the Global Manager was shutdown, it needs to be
rescheduled for the next level (level 2) when the Global Manager is restarted. Therefore, when the
Global Manager is restarted, it reschedules the notification to escalate to level 2 immediately at 2:25
P.M. Upon entering level 2 and performing actions, the notification is scheduled for level 3 at 2:35
P.M.


Developing escalation policies
The first step in creating an escalation policy is to formalize your response plans to the notifications you
are likely to encounter. You may need to assign responsibilities and determine how quickly your
organization is required to respond to various types of system and network failures. These plans form the
template for your escalation paths and levels.


You may also need to create automated tools to initiate your response to incoming notifications. 
Chapter 9 Tool Configuration for the Global Manager describes how to create and configure automated
tools.


The process of creating an escalation policy at the Global Manager Administration Console consists of
the following steps:


1 Create an escalation policy by copying an existing policy or creating a new policy.


2 Add one or more escalation paths to the policy. Again, you can copy an existing path or create a new
path.


3 Add escalation levels, up to six, to each path.


Creating an escalation policy
To create an escalation policy, complete the following steps by using the Global Manager Administration
Console:


1 Select Escalation > Policy > New. The Create a New Escalation Policy dialog box appears.


2 Type the name for the escalation policy.


Create the policy by copying an existing policy or by creating a new policy. When you create a new
policy, the parameters of the policy, such as filters and paths, must be created. When you copy a
policy, all the properties of the existing policy are copied to the new policy. However, the name of the
newly created escalation policy always appears dimmed in the administration tree even if the original
policy name appears bright.
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3 Click Edit Filter to create or modify the filter that is matched against notifications to determine
whether they qualify for the policy. The Filtering New Policy textdialog box appears.


You can specify an expression filter, an ASL filter, or both. When you combine filters, by adding filter
sheets, a notification must match at least one of the filter sheets to pass the filter. Chapter 11 Working
with Filters includes additional information about the Filtering New Policy dialog box.


4 When you finish creating filters, click OK to close the Filtering New Policy dialog box.


5 Click OK to close the Create a new Escalation policy dialog box. The name of the escalation policy
appears in the administration tree and at the top of the Configure Escalation Policy window.


When using ASL filter under Edit Filter, the escalation policy is created only if the relative path to the
ASL file is provided as ics/<asl file name>. By default, Global Manager searches for the ASL file
under local/rules and the policy is not created even though the ASL file exists under
BAEDIR/rules/ics. Also, the escalation policy is not created if the absolute path to the ASL file is
specified, which is BAEDIR/rules/ics/<asl file name>.


Creating an escalation path
You can create an unlimited number of paths within a policy, but it is usually easier to organize and
manage smaller groups of paths in more policies.


To create an escalation path:


1 Select the escalation policy in the administration tree.


The Configure Escalation Policy panel appears.


2 Create an escalation path by adding a new path or copying an existing path.


n To create a new blank path, select Escalation > Path > New or click Add Path at the bottom of
the Escalation Policy View panel.


The Create a new Escalation Path dialog box appears.


n To copy a path, select the path you wish to copy and select Escalation > Path > Copy.


The Copy Escalation Path dialog box appears.


Note   You can only copy a path from the current policy.


3 Type the name of the escalation path. If you are copying the path, modify it to suit your needs. 
Modifying escalation policies and paths provides additional information.


4 Click Edit Filter to create or modify the path filter.


The Filtering New Path dialog box appears.
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The filter determines what notifications follow this path of the policy. Similar to the policy filter, you can
specify an expression filter, an ASL filter, or both. Chapter 11 Working with Filters includes information
on setting up a filter.


Note   For most escalation paths, you should add a filter that matches active notifications to ensure
that you only escalate active notifications.


5 When you finish creating filters, click OK to close the Filtering New Path dialog box.


6 Click OK to close the Create a new Escalation Path dialog box.


Your path is displayed in the Configure Escalation Policy panel of the Global Manager
Administration Console.


7 Repeat this procedure for each escalation path.


The next step is to add one or more levels to each escalation path.


Adding escalation levels


Note   An escalation path requires at least one level. You can add up to six levels to each path.


To add escalation levels:


1 Right-click the path and select Level > Insert or select the path and choose Escalation > Level >
Insert. The Insert Level dialog box appears.


If the escalation path already contains a level, you can control where the new level is inserted:


n To insert a new level at the end of the path, select the box at the end of the path to insert the
level.


n To insert a level before an existing level, select the level that you want to insert the new level
in front of to insert the level.


2 Specify the duration of the level by typing a number and selecting the time unit from the list box.


3 Select automated tools from the Available Tools list and move them to the Invoked Tools list. Tools
are invoked immediately after a notification reaches this level. Chapter 9 Tool Configuration for the
Global Manager includes information on creating tools.


4 Click OK to close the Insert Level dialog box.


The new level appears in the escalation path.


5 Repeat these steps for each level in the escalation path.


6 When the path is complete, click Apply to save the changes to the Global Manager.


7 Repeat this procedure for each escalation path in the escalation policy.


After you finish an escalation policy, you can enable one or more of its paths.
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Modifying escalation policies and paths
The types of modifications you can make to an escalation path are determined by whether the escalation
path is enabled or disabled. For example, when:


n A path is enabled, you can edit the duration and tools for any escalation level in the path. You cannot
add or remove escalation levels from the path or change the policy or path filters. However, you can
change the script when asl script is used as a filter.


n A path is disabled, you can edit the escalation path filter and change the duration or invoked tools at
any escalation level. In addition, you can add or remove escalation levels.


n All paths in a policy are disabled, you can edit the escalation policy filter.


Enabling and disabling escalation paths
Escalation policies cannot be enabled or disabled. Instead, you can enable or disable the escalation
paths within a policy. When all of the escalation paths within a policy are disabled, the policy is effectively
disabled.


Disabling an escalation path cancels the escalation of all notifications currently scheduled within the path.
New notifications are not added to a disabled path. To avoid losing any notifications currently scheduled
on the path, but to prevent new notifications from being scheduled, you can retire the path instead of
disabling it. Retiring an escalation path includes more information on retiring a path.


Disable an escalation path
To disable an escalation path:


1 Select the escalation policy in the administration tree of the Global Manager Administration
Console. The Configure Escalation Policy panel appears.


2 Right-click the path and select Path > Disable. You are prompted to confirm this choice.


3 Click Yes to disable the path. The path is dimmed to indicate it is disabled.


4 Click Apply.


When all of the paths for an escalation policy are disabled, the name of the policy in the
administration tree is dimmed to indicate that the policy has no active paths.


Enable an escalation path
When a path is enabled, the path begins to process any notifications with a Last Notify time that is later
than when the path was enabled.


To enable an escalation path:


1 Select the policy in the administration tree.


The Configure Escalation Policy panel appears in the Global Manager Administration Console.
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2 Right-click the path and select Path > Enable from the menu.


The path is enabled.


3 Click Apply to save the change to the Global Manager.


Modifying an enabled escalation path
When you change the tools or duration of a level in an enabled path, the following is true:


n Notifications escalated beyond this level are unaffected.


n Notifications not yet escalated to this level are subject to the new duration or tools.


n Notifications currently at the modified level are rescheduled according to the new duration or use the
new tools.


The following example illustrates what happens when the duration of a level is increased:


a A notification enters Level 1 of an escalation path at 1 P.M. The duration of the level is 20 minutes
and the notification is scheduled to escalate to Level 2


b at 1:20 P.M.


c At 1:10 P.M., the duration of this level is increased to 30 minutes. As a result, the notification is
rescheduled to escalate to Level 2 at 1:30 P.M.


The following example illustrates what happens when the duration of a level is decreased:


d A notification enters Level 1 of an escalation path at 1 P.M. The duration of the level is 30 minutes
and the notification is scheduled to escalate to Level 2


e at 1:30 P.M.


f The notification is scheduled to enter Level 2 at 1:30 P.M. The duration of Level 2 is 5 minutes
and the notification is scheduled to enter Level 3 at 1:35 P.M.


g At 1:20 P.M., the duration of Level 1 is decreased to 10 minutes. As a result, the notification
escalates to Level 2 immediately. At Level 2, the notification is scheduled to escalate to level 3 at
1:25 P.M. because the duration of Level 2 is 5 minutes.


A change in duration will not cause a notification to escalate more than one level.


Changing the tools or duration of a level
To change the tools or duration of a level in an enabled escalation path:


1 Select the escalation policy name in the administration tree. The policy appears in the Configure
Escalation Policy panel of the Global Manager Administration Console.


2 Right-click the level you want to modify and select Level > Edit Properties. The Edit Level dialog
box appears.
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3 Change the Duration or Invoked Tools:


n Type a new value for Duration and select the units from the list box.


n Change the Invoked Tools list:


n Select a tool in the Invoked Tools list and click ® (right arrow) to remove it.


n Select a tool in the Available Tools list and click ¬ (the left arrow) to move the tool to the
Invoked Tools list.


Note    If a tool is not available, you can create the tool by clicking Tool Wizard. 
Chapter 9 Tool Configuration for the Global Manager includes information on creating
automated tools.


4 Click OK to close the Edit Level dialog box. The changes to the level appear in the path.


5 Click Apply to send the change to the Global Manager.


Modifying disabled escalation paths or policies
When an escalation path is disabled, you can modify the path filter and add or remove levels. If you
disable all of the paths in an escalation policy, you can edit the escalation policy filter.


Disabling a path cancels the escalation of any notifications along the path. If you want to modify a path or
policy but do not want to cancel any scheduled notifications, you can retire the path or paths instead. This
prevents new notifications from joining the path but allows scheduled notifications to continue to escalate. 
Retiring an escalation path includes information on retiring a path.


Modifying an escalation policy filter
To modify the filter of an escalation policy, you must first disable all of the paths within the policy:


1 Select the escalation policy in the administration tree of the Global Manager Administration
Console. The policy appears in the Escalation Policy Configuration panel.


2 Select Escalation > Policy > Edit Properties. The Edit selected Policy dialog box appears.


3 Click Edit Filter. The Filtering Policy test dialog box appears.


4 Change the filters as needed.


Note   Chapter 11 Working with Filters contains information on changing a filter.


5 When you finish editing the filters, click OK to close the Filtering Policy test dialog box.


6 Click OK to close the Edit selected Policy dialog box.


7 Click Apply to send the changes to the Global Manager. You can now enable the paths in the policy.
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Modifying an escalation path filter
To change a path filter, you must first disable the path:


1 Select the escalation policy in the administration tree of the Global Manager Administration
Console. The policy appears in the Escalation Policy Configuration panel.


2 Right-click the path and select Path > Edit Properties. The Edit selected Path dialog box appears.


3 Click Edit Filter. The Filtering Path test dialog box appears.


4 Change the filters as needed.


Note   Chapter 11 Working with Filters contains information on changing a filter.


5 When you finish editing the filters, click OK to close the Filtering Path test dialog box.


6 Click OK to close the Edit selected Path dialog box.


7 Click Apply to send the changes to the Global Manager. You can now enable the path.


Inserting escalation levels in a path
To insert escalation levels in a path:


1 For a disabled path, select the level (or Path End box) that will follow the new level. The selected
level or box changes color to indicate that is selected.


2 Right-click to display the Path menu.


3 Select Level > Insert.


The Insert Level dialog box appears.


4 Type the Duration and select the units from the list box.


5 Select any quantity or combination of tools from the Available Tools list.


Note   If a tool is not available, create the tool by clicking Tool Wizard. Chapter 9 Tool Configuration
for the Global Manager includes information on creating automated tool.


6 Click ¬ ( left arrow) to move the selected tools to the Invoked Tools list.


7 Click OK to close the Insert Level dialog box. The level appears in the path.


8 Repeat steps 1 through 6 to add additional levels up to a total of six levels.


Note   Remember that new levels are always inserted in front of the selected level.


9 When your path is complete, click Apply to send the changes to the Global Manager.


You can now enable the path. Enable an escalation path provides detailed information on enabling
paths.
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Removing escalation levels from a path
To remove escalation levels from a path:


1 For a disabled path, select the level to remove. The selected level changes color to indicate that it is
selected.


2 Right-click to display the Path menu.


3 Select Level > Remove. The level disappears from the path.


4 Repeat step 1 through 3 to remove additional levels.


Note   A valid path must have at least one level.


5 When your path is complete, click Apply to send the changes to the Global Manager.


You can now enable the path. Enable an escalation path provides detailed information on enabling
paths.


Modifying tools or duration at an escalation level
This procedure is identical to the one performed when the path is enabled. Changing the tools or duration
of a level includes information on modifying tools or duration at an escalation level.


Retiring an escalation path
To avoid losing escalations, consider retiring the path. Retiring an escalation path allows all notifications
with a Last Notify time earlier than the retirement time to enter or continue escalation through the path.
The path will not escalate any notifications with later Last Notify times.


To retire an escalation path:


1 Select the escalation policy in the administration tree of the Global Manager Administration
Console. The policy appears in the Escalation Policy Configuration panel.


2 Select the appropriate path by clicking a level in the path. The level changes color indicating it is
selected.


3 From the Escalation menu, select Path > Retire. The Confirm Disable dialog box appears.


4 Click Yes to retire the path. All levels in the path change color (to one shade of blue) indicating the
path is retired.


5 Click Apply to send the change to the Global Manager.


6 After checking the retired path to determine whether any notifications are being escalated, disable or
remove the path.


Modifying escalation paths by using the Retire option
You may need to modify a path to add escalation levels or edit the filter. These changes require that the
path is disabled. Disabling the path immediately terminates the escalation of any scheduled notifications.
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The Retire option enables you to avoid this issue and provides a smooth transition to a new path. When a
path is retired, notifications that are currently being escalated through the path continue to follow the
escalation path. In addition, existing notifications that now meet the filtering criteria for the retired path will
enter the path (from level 0). However, new notifications that meet the filtering criteria for the retired path
are not added to the path.


To retire an existing path and replace it with a modified path:


1 Copy the enabled path you want to change.


Note   The copied path will be disabled.


2 Modify the path you copied.


3 Enable the new path, but do not apply the changes.


4 Retire the existing path. Retiring an escalation path includes information for retiring an escalation
path.


5 Click Apply to simultaneously enable the new path and retire the original path. Notifications on the
retired path continue to escalate while any new notifications are handled by the new path.


6 Remove the retired path when all notifications escalate through the entire path.


The new path only processes notifications that are notified after the enable time of the path. The
existing path, because it is retired, processes any notifications with a notify time less than the time
that the path was retired.


Removing or deleting escalation paths and policies
Enabled paths and policies can be removed or deleted. This terminates all scheduled escalations for the
removed path or for all paths in a deleted policy.


Removing an escalation path
A path can be removed when it is enabled, disabled, or retired.


To remove an escalation path:


1 Select the policy name in the administration tree. The policy appears in the Escalation Policy
Configuration panel.


2 Select the path.


3 From the Escalation menu, select Path > Remove. The path is removed from the Escalation Policy
Configuration panel.


4 Click Apply to send the change to the Global Manager.
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Deleting an escalation policy
A policy can be removed with enabled, disabled, or retired paths. When an escalation policy is deleted, all
escalation paths within the policy are deleted. All currently scheduled escalations will be unscheduled,
and the policy will be removed from the system and no longer process any notifications.


To delete an escalation policy:


1 Select the policy name in the administration tree. The policy appears in the Escalation Policy
Configuration panel.


2 From the Escalation menu, select Policy > Delete. The Confirm Delete dialog box appears.


3 Click Yes to confirm the policy deletion. The policy name is removed from the administration tree in
the Administration Console.


Testing and troubleshooting escalation policies
As escalation policies usually handle important notifications, test your escalation paths to ensure they
function appropriately.


VMware Smart Assurance software allows you to quickly test and verify escalation paths through the use
of sm_ems, the Audit log, and the automated tools you intend to invoke.


After configuring and enabling escalation policy and paths, use sm_ems with the notify command option
to issue a sample of the specific notification that you hope to escalate. The
VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide describes the
sm_ems utility.


Once your sample notification appears in Notification Log Console, double-click the notification and select
the Audit Log tab. Check the log for escalation-related entries in Escalation-related entries in the Audit
Log . Escalation-related Audit Log entries always have the userid of SYSTEM.


Finally, ensure your automated tools are invoked and function as intended.


Table 10‑1.  Escalation-related entries in the Audit Log


Type Audit Log description Description


Action Completed <tool name> The named automated tool was invoked and completed.


Action Failed <tool name> The named automated tool was invoked, but failed.


Action Invoked <tool name> The named automated tool was invoked.


ESCALATION MATCHED:<policy name/path name> Notification has characteristics that match the filter criteria
for the specified escalation policy and path.


ESCALATION REACHED:<policy name>/<path name>,
<level number>


Notification has reached the indicated escalation level in
the specified path.


ESCALATION SCHEDULED:<policy name>/<path name> for
<level number> at <date> <time>


Notification is scheduled to reach the next escalation
level at the specified date and time.


ESCALATION TERMINATED ESCALATION: Unmatched
<policy name>/<path name>


A change in the notification means it no longer matches
the filter criteria for the escalation policy and path and is
removed from the policy.
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Table 10‑1.  Escalation-related entries in the Audit Log (Continued)


Type Audit Log description Description


ESCALATION TERMINATED ESCALATION: Disabled
<policy name>/<path name>


The escalation policy or path was disabled and
notifications are no longer escalated within the policy or
path.


ESCALATION TERMINATED ESCALATION: Notification
Archived, <policy name>/<path name>


The notification was archived after it entered the
escalation policy and was removed from the policy.


ESCALATION RESCHEDULED: <policy name>/<path
name> from <level> due at <datestamp>
<timestamp>


An action within a level was rescheduled to a new date or
time.


ESCALATION END OF PATH:<policy name>/<path name>,
<level number>


Notification has gone through all escalation levels and
reached the end of the named escalation path.


Viewing notifications being escalated
Once an escalation path is enabled, you can monitor any notifications that escalate through the path. You
can select an escalation level within a path and view the notifications which are currently escalated to the
level. You can then select any of the notifications to see the notification properties.


To view notifications being escalated:


1 Select the policy name in the administration tree. The policy appears in the Escalation Policy
Configuration panel.


2 Select the appropriate path by clicking a level in the path. The level changes color.


3 From the Escalation menu, select Level > Show Notifications. The Escalated Notifications dialog
box displays any escalated notifications currently at the level.


4 Double-click an escalated notification to display its notification properties.


Note   Notification data displayed is static. Changes are not automatically updated in the view. Click
Refresh to update the view.


5 Click Close to close the Escalated Notifications dialog box.
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Working with Filters 11
This chapter includes the following topics:


n Overview


n Building expression filters


n ASL filters


Overview
A filter screens incoming notifications by comparing a set of defined criteria against the attributes of a
notification or ICIM class. Values that match the criteria pass through the filter. Filters are used to
configure:


n Notification lists — Notification lists provides additional information.


n Context and Status Criteria of client and server tools — Context and Status Criteria for client and
server tools provides additional information.


n Escalation paths and policies — “Developing escalation policies” on page 166 provides additional
information.


You can define two types of filters: an expression filter or an ASL filter. You create an expression filter
using the Filter Builder, which is described in the next section. An ASL filter, specified in the ASL Filter
checkbox of the Filter Builder, is defined in a separate ASL file. “ASL filters” on page 186 provides
more information about creating ASL filters.


Building expression filters
An expression filter uses matching criteria to filter against the value of an attribute of the specified class.
Matching criteria comprises a series of characters, and optionally, wildcards:


n Attributes for matching notification properties includes a complete list of notification attributes.


n Chapter 15 Wildcard Patterns provides a description of wildcards.


Expression filter fields describes the parameters of an expression filter.
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Table 11‑1.  Expression filter fields


Parameter Description


Attribute Name of the attribute. The expression filter matches against the value of this attribute.


matches Matching pattern that is compared against the value of an attribute:
n For Boolean attributes, a menu lists the values.
n For attributes whose values are known, the Helper button lists potential values, taken from the


notifications in the Global Manager. You can use wildcards within the value field.


AND


(green plus sign)


Add more attributes to the filter sheet to match against, creating a more narrow filter. A notification
must match all of the attributes on a sheet to pass the filter.


OR


(Sheet Tab)


Add more filter sheets to filter. A notification must match at least one of the filter sheets to pass the
filter. You can add sheets by clicking Add Sheet or selecting Edit > Add Sheet.


Layout of the Filter Builder
The Filter Builder interface differs for notification filters, context and status criteria, and escalation policies.


Filter Builder for notification lists
The Filter Builder for notification lists opens with a blank “Sheet:1” tab. The sheet contains a Use ASL
Script checkbox and a green plus sign, which is used to add notification attributes to the sheet. For
notification lists, you can specify an ASL filter, an expression filter, or both. If you use a sheet to specify
an ASL filter, you cannot specify an expression filter on that same sheet.


Menus for each filter criterion enable you to select a notification attribute and one of the following
conditions, if applicable:


n A match condition such as a specific value or expression. You can also specify wildcard characters in
a match condition. Values are case-sensitive.


Note   Values entered into the notification list filter from the Global Console are not case-sensitive.


n The is child of condition (the IsA filter option) for notification attributes that have a class name for their
value. IsA Filter option for notification lists and logs provides more information on this option.


To treat a wildcard character as a text character, insert a backslash (\) before the wildcard character.
For example, to filter on all event names that include a bracket, specify “*\]*”. (Do not include the
quotation marks in the expression.)


Filter Builder for Context and Status Criteria
The Filter Builder for specifying Context Criteria and Status Criteria opens with a blank “Sheet:1” tab. At
the top, the sheet contains a Use ASL Script checkbox and a list box that lists Context objects or Status
objects. For expression filters, you select a class from the object menu and then click the plus sign to add
attributes that your expression matches against. When using the Filter Builder for Context and Status
Criteria, you can use either an expression filter or an ASL filter, but not both. In addition, you cannot add
more sheets.
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Filter Builder for escalation policies
The Filter Builder is used to specify policy filters and path filters. In both cases, you are matching against
notification attributes. The Filter Builder dialog box provides an Edit menu from which you can use to add,
copy, or delete sheets from your filter. Select the Use ASL Script checkbox to specify an ASL filter or click
the plus sign (+) to create an expression filter.


At the top of the dialog box, the Edit menu enables you to add, copy, or delete a Sheet tab. On the left,
the plus sign (+) button enables you to add one filter criterion at a time. Menus for each filter criterion
enable you to select a notification attribute and a match condition such as a specific value or expression.
The IsA Filter option is available when supported on the server. You can also specify wildcard characters
in a match condition. Values are case-sensitive.


IsA Filter option for notification lists and logs


Note   The IsA Filter option is available for filtering the notification log and summary views on clients
whether or not the Global Manager supports it, because the filtering is performed by the client. The option
is only available for Notification List and Escalation filtering on the server if the server supports it; this is
because the filtering is on the server.


The IsA filter option, displayed as is child of, only appears for notification attributes that have a class
name for their value, including:


n Class


n ClassName


n ElementClass


To create an IsA filter for one of these notification attributes:


a Select the class and the is child of option from the pull-down menus.


b Click OK to apply your filter and exit the dialog box.


The Notification Log Console then displays only those notifications for instances of the
specified class and its subclasses.


Note   Only a single class name, without any wildcard characters of any kind, may be specified
for an IsA filter.


For example, if IsA filter is used and based on the RedundancyGroup class, the notification log
would display only all notifications related to instances of the following:


n WebServerRedundancyGroup


n DatabaseRedundancyGroup


n OracleRAC


n ApplicationServerRedundancyGroup
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n WebSphereCluster


Using the Filter Builder
An expression filter comprises one or more sheets. Each sheet specifies an ASL filter or is composed of
one or more attribute/value pairs. Each pair includes the attribute name and an expression to match
against that attribute’s value. To match a given sheet, a notification or topological element must match
every attribute/value pair specified in the sheet.


You can specify multiple sheets. A notification or topological element passes the filter if it matches at least
one sheet.


Using the Value Helper
When defining the expression for a filter, you can use the Helper button to open a dialog box that enables
you to add values to an expression. The type of help provided depends on the value type of the attribute
for which you are defining an expression. For example, the Value Expression Helper for the Certainty
notification attribute allows you to specify a range. An expression for a string field can include wildcard
patterns as well as characters. For example, the Element Class helper displays a list of known Element
Classes. You can select multiple names and the helper dialog box automatically creates an OR
expression with the selected values.


You can also use wildcards in the Value field. Type one or more characters in the Value field and specify a
wildcard. After you type the Value field, the Value Helper is disabled. Chapter 15 Wildcard Patterns
provides additional information on wildcards.


Filter Value Helper dialog box illustrates the Value Helper dialog box with two Element Class elements
selected.


Figure 11‑1.  Filter Value Helper dialog box


After clicking OK, the dialog box is closed and the expression is listed to the right of the attribute in the
filter builder where you can manually edit it.


Filter examples
Filter notifications with severity of 1or 2 illustrates different expression filters. The filter in the first example
matches all notifications with a severity of 1 or 2.
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Figure 11‑2.  Filter notifications with severity of 1or 2


The filter in Filter notifications of element class router matches all notifications with a value of Router or
Switch in the Element Class attribute.


Figure 11‑3.  Filter notifications of element class router


The filter inFilter notifications with severity of 1-2 or an impact of 5 or more uses an implicit “or” condition
by adding a second sheet. When you specify multiple sets of criteria as shown in the example, a
notification passes the filter if it matches all of the conditions in one sheet. In this example, a notification
passes the filter if it has a severity of one or two OR an impact between 5 and 100.
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Figure 11‑4.  Filter notifications with severity of 1-2 or an impact of 5 or more


The filter example in Filter showing notifications owned by all users other than “SYSTEM” or “maint”
matches all notifications that have an owner assigned to them unless that owner is SYSTEM or maint.


Figure 11‑5.  Filter showing notifications owned by all users other than “SYSTEM” or “maint”


The filter example in Figure 19 on page 172 matches all notifications for routers with a value of 1 in the
severity field.
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Figure 11‑6.  Filter showing routers with severity 1


ASL filters
If an expression filter does not provide enough flexibility to define filtering criteria, you can use an ASL
filter. An ASL filter is an ASL program that processes each notification or other type of object.


The VMware Smart Assurance ASL Reference Guide provides detailed information on ASL expressions.


An example ASL filter script, nl-sample-filter.asl, is included in the BASEDIR/smarts/rules/ics directory.


Using ASL filter to load Notif remotely
To reload Notif remotely using ASL, invoke the clearConfigCache method on
singletonNotifProcessorInterface instance of notifProcessorInterface(class) on the appropriate SAM
server.


Here is an example of the command:


$./dmctl -b localhost:8822 -s INCHARGE-OI invoke 


notifProcessorInterface::singletonNotifProcessorInterface clearConfigCache


where localhost:8822 is the port on which the Broker is running and INCHARGE-OI is the name of the
server.


This command, when successfully executed, will reload the Notif processor with all the .ncf files available
in all the SITEMOD locations, and display TRUE as output on the CLI.


Notification lists and escalation policies
The following example illustrates the format of an ASL filter used to filter Notification List and Escalation
Policies. It filters for notifications with an EventName attribute “Failure.”
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The name of the notification object is assigned to the variable notification. If the value of EventName is
Failure, the value of Result is set to TRUE and the notification passes the filter, as illustrated in the
following code sample:


START do {


      notification = object(NotificationName);


      if (notification->EventName == "Failure")


      {


         Result = TRUE;


      }


      else


      {


         Result = FALSE;


      }


}


To apply the ASL filter, access the filter builder. Select the Use ASL Script checkbox and type the name of
the ASL script.


Context and Status Criteria for client and server tools
The following example illustrates the format of an ASL filter used to filter context and status criteria for
client and server tools. It filters for notifications with an EventName attribute Failure.


The name of the object is assigned to the variable ObjectName. If the value of ObjectName is Failure, the
value of Result is set to TRUE and the notification passes the filter, as illustrated in the following code
sample:


START do {


 timeNow = object(ObjectName)->nowString


 if (glob("*1<0-1>:*:* AM*|*<1-5>:*:* PM*|*12:*:* PM*", timeNow)) 


 {


  Result = "TRUE";


 } 


 else 


 {


  Result = "FALSE";


 }


}


To apply the ASL filter:


1 Open the filter builder.


2 Click Use ASL Script.


3 Type the name of the ASL script.


Saving ASL filters
The ASL filter files must be located in the appropriate directory under the BASEDIR/smarts/local/rules
directory. The files are located in different subdirectories for different products.
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For example, when saving files:


n Global Manager ASL files should be saved in the BASEDIR/smarts/local/rules/ics directory.


n When changed, the Global Manager’s nl-sample-filter.asl file must be saved as
BASEDIR/smarts/local/rules/ics/nl-sample-filter.asl.


n Adapter Platform ASL files should be saved in the BASEDIR/smarts/local/rules/icoi directory.


Note   When you save a file, specify the path to a specific BASEDIR/smarts/local/rules directory.
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Importing and Exporting
Configurations 12
This chapter includes the following topics:
n Overview


n About the default XML files


n Running sm_config


n Importing configurations


n Exporting configurations


n Modifying individual repository objects


n Importing tools implemented by VMware Smart Assurance adapters


Overview
This chapter describes how to use sm_config to import and export repository objects such as notification
lists, users, user profiles, tools, and escalation policies. It also describes how to use sm_config for
configuring map icons.


The sm_config utility imports configurations, written in XML, for the Global Manager and the
Adapter Platform. The sm_config utility is used for the following purposes:


n As an alternative to creating notification lists, users and user profiles in the Global Manager
Administration Console.


n To batch process multiple configurations.


n To duplicate configurations between Global Managers.


n To import tools for third-party applications.


A strong understanding of XML is necessary if you intend to create and manage repository objects
using XML. Chapter 16 XML Reference provides a guide for creating notification lists, user profiles,
users, tools and escalation policies according to the ics-config.dtd XML specification.
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About the default XML files
Default configuration settings for the Global Manager are shipped in BASEDIR/smarts/conf/ics in a file
called ics-default.xml. This file requires the Document Type Definition (DTD), which must be in the same
directory. The name of the DTD is ics-config.dtd.


The ics-default.xml file is only used when the Global Manager is started without a repository (*.rps) file. It
creates the default repository objects if none are defined in the repository. For example, the ics-
default.xml file creates the default notification lists if there are no notification lists found in the repository.


The ics-default.xml file also reads:


n The console_operations.xml file


The console_operations.xml file resides in the BASEDIR/smarts/conf/ics directory. This file requires a
DTD, consoleoper-config.dtd. The console_operations.xml file and the consoleoper-config.dtd must
be stored in the same directory.


n The map_gif.xml file


The map_gif.xml file resides in the BASEDIR/smarts/conf/maps directory. This file also requires a
DTD, map-config.dtd. The map_gif.xml file and the map-config.dtd must be stored in the same
directory.


If you start the Global Manager without a repository, the ics-default.xml file is read to instantiate the
Global Manager with default configurations. These default configurations include objects which are
added to the Global Manager. Objects included in each of the default XML files are:


n ics-default.xml


n Business Templates:


n Topology-group.data.template


n service.data.template


n Domains:


n INCHARGE-AM


n INCHARGE-PM


n INCHARGE-AM-PM


n INCHARGE-AM2


n INCHARGE-OI


n NCM


n INCHARGE-DISCMGR


n INCHARGE-MPLS-ANALYSIS


n INCHARGE-MPLS-MONITORING
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n INCHARGE-MPLS-TOPOLOGY


n Notification Lists:


n Default


n Maintenance


n Server Tools:


n Clear Business Process Event


n Disable BypassPropogateNotifications


n Disable Maintenance Tracking


n Enable BypassPropogateNotifications


n Enable Maintenance Tracking


n Import XML Configuration


n Import XML Domain Configuration


n Notify Business Process Event


n Sample - Close Trouble Ticket


n Sample - Open Trouble Ticket


n Sample - Ping-all


n Sample - Ping-device


n Sample - Ping-Interface


n Sample - Ping-IP


n Sample - Telnet


n Show Storage Impacts


n Update Business Process Event


n Client Tools:


n Report Manager


n Launch Web Browser


n Dump Properties


n Ping


n User Profiles:


n admin-profile


n default-profile


n maint-profile


n oper-profile
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n Users:


n admin


n default


n maint


n oper


n console_operations.xml


The console_operations.xml file contains configuration information related to console operations. This
file cannot be modified.


n map_gif.xml


The map_gif.xml file sets the default image file that is used as a map icon for ICIM classes. This file
cannot be modified.


Running sm_config
Using the sm_config command you can import objects into and export objects from the repository. In
addition, the command allows you to enable, disable, and delete objects.


The options for importing, exporting, and enabling configurations are specified as commands to
sm_config when you invoke it at the command line. Arguments to sm_config for managing configurations
lists the arguments you should specify when invoking sm_config, which is run from BASEDIR/smarts/bin.


Note   The information included in Arguments to sm_config for managing configurations can be retrieved
by entering the --help argument when invoking sm_config from the command line.


Table 12‑1.  Arguments to sm_config for managing configurations


Command option / argument Description


Commands


import


[command-options] <input-xmlfile>


Imports the specified XML file into the Global Manager.


export --server=


[<output-xmlfile>]


Exports the current object configurations to XML. If no output XML filename
is specified, the XML is exported as standard output.


delete --classname=<class> --
instancename=<instance> [--type=<action_type>]


Removes the specified instance from the Global Manager repository.


enable --classname=<class> --
instancename=<instance>[--type=<action_type>]


Enables the specified instance in the Global Manager repository.


disable --classname=<class> --
instancename=<instance> [--type=<action_type>]


Disables, but does not delete, the specified instance in the Global Manager
repository.


--help Displays the sm_config command option / argument help.


Command options
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Table 12‑1.  Arguments to sm_config for managing configurations (Continued)


Command option / argument Description


--force To be used with the import command. Imports repository objects even if
existing objects were modified since the XML was last exported. This
overwrites existing repository objects that may have been changed.


Also -f can be used.


--replace To be used with the import command. Deletes all the XML-configured
repository objects that currently exist in the Global Manager (specifically
notification lists, user profiles, users, tools, escalation policies, and actions).
New repository objects, as specified in the XML file, are created in their
place.


Also -r can be used.


--classname=<class> To be used with the delete, enable, or disable command. Specifies the class
name of the object you want to modify.


Also -c <class> can be used.


--instancename=<instance> To be used with the delete, enable, or disable command. Specifies the
instance name of the object you want to modify.


Also -i <instance> can be used.


--type=<action_type> To be used with the delete, enable, or disable command when you are
modifying an action or tool. Specifies the action type. The possible values
are server, client, or auto.


Also -t <action_type>.


Note   This option is required if --classname=Action can be used.


Arguments


<input-xmlfile> Name of the Input XML file.


Input XML files for Service Assurance Manager must be located in
BASEDIR/smarts/local/conf/ics.


Note   Only the filename (including the file extension) must be specified, not
the path to the file.


<output-xmlfile> Name of the file that is generated when exporting configurations.


Output XML files for Service Assurance Manager are created in
BASEDIR/smarts/local/conf/ics.


Output XML files for the Adapter Platform are created in
BASEDIR/smarts/local/conf/icoi.


If an output XML File is not specified, the XML is written to standard output.


<class> Supported Values:
n Action (To be used for client, server, and automatic tools.)
n AutoActionPolicy (To be used for Escalation Policies.)
n NotificationList
n UserProfile
n User


Note   There is no map icon support for <class>. You cannot import an
individual instance of a map icon.


<instance> Instance value is the logical name of the repository object.
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Table 12‑1.  Arguments to sm_config for managing configurations (Continued)


Command option / argument Description


<action_type> Used with the --type command option to specify the type of action to delete,
enable, or disable. Possible values are:
n client
n server
n auto


Standard options


--broker=<broker_location> Alternate location of the broker as <host>:<port>. This value can be verified
in the SM_BROKER environment variable.


Note   This argument is optional.


Also -b <broker_location> can be used.


--server=<server_name> Name of Global Manager or Adapter Platform.


Note   This argument is required.


Also -s <server_name> can be used.


Importing configurations
Adding new objects and modifying existing objects requires the following steps:


1 Define the objects in an XML file.


2 Import the XML file.


Defining objects in XML
You have several options for creating XML files for import with sm_config, including:


n Export the current configurations to a file and modify the XML as needed. “Exporting configurations”
on page 198 provides additional information on exporting configurations.


n Copy and modify an existing object from one of the XML sample files located in
BASEDIR/smarts/conf/ics.


n Write the XML for the new object.


When making any modifications to the XML, be sure to adhere to the standards of the following
DTDs:


n ics-config.dtd located in BASEDIR/smarts/conf/ics


n map_config.dtd located in BASEDIR/smarts/conf/maps.


Chapter 16 XML Reference provides additional information on Service Assurance XML standards.
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Sample XML configuration files
Sample XML documents are provided for use as templates and can be edited to suit your needs. The
following sample files are located in BASEDIR/smarts/conf/ics:


n Tools: actionconfig-sample.xml


n Notification lists: nlconfig-sample.xml


n Escalation policy: policyconfig-sample.xml


n User profile: profileconfig-sample.xml


n User: userconfig-sample.xml


n Multiple types of repository objects: ics-config-sample.xml


n Map icons: mapgif-sample.xml


Work ing with XML sample files
The simplest way to create new repository objects in XML is to use a template. Sample XML files located
in BASEDIR/smarts/conf/ics are provided for this purpose. Use sm_edit to open and save a copy of this
file in your BASEDIR/smarts/local directory. For example, to create a new notification list, open the
nlconfig-sample.xml file using sm_edit:


         BASEDIR/smarts/bin>sm_edit ../conf/ics/nlconfig-sample.xml


      


Modify the current notification list example to create a new one that suits your needs.


For example, change the name="Default" attribute to name="NotificationList_1". Remove everything up to
the ColumnHeading declaration and then change one of the column headings to display the "Certainty"
percentage of the event.


The revised portion of the sample files looks like:


<ics_config>


  


 <nlconfig name="NotificationList_1" enable="True" timestamp="0">


  <filterconfig type="Expression">


       <criterion attribute="Owner">~maint</criterion>


   <criterion attribute="Owner">~SYSTEM</criterion>


      </filterconfig>


  <columnheading 


   column="InstanceDisplayName">"Name"


  </columnheading>


  <columnheading 


   column="EventDisplayName">"Event"


  </columnheading>


  <columnheading 
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   column="Certainty">"Certainty"


  </columnheading>


 </nlconfig>


</ics_config>


You can subscribe to multiple notification lists by adding multiple nlconfig elements to the nlconfig XML
file. For example, you can add:


 <nlconfig name="NotificationList_2" enable="True" timestamp="0">


  <filterconfig type="Expression">


       <criterion attribute="Owner">~maint</criterion>


   <criterion attribute="Owner">~SYSTEM</criterion>


      </filterconfig>


  <columnheading 


   column="InstanceDisplayName">"Name"


  </columnheading>


  <columnheading 


   column="EventDisplayName">"Event"


  </columnheading>


  <columnheading 


   column="Certainty">"Certainty"


  </columnheading>


 </nlconfig>


Importing XML files to the Global Manager
When you have prepared an XML file with the appropriate additions or changes, you can import it into the
Global Manager. By default, the sm_config import command will add new objects but will not allow
modification to objects that exist in the repository. For example, to import a file called NewUsers.xml
located in BASEDIR/smarts/local/conf/ics, use the following procedure:


1 Change directory to BASEDIR/smarts/bin.


2 Run the command:


sm_config -s INCHARGE-SA import NewUsers.xml


3 Verify that the new configurations were imported by viewing them in the Global Manager
Administration Console.


Importing options
There are two options for the sm_config import command:


n --force: Use this option to override the default and allow modification of existing XML-configurable
objects with those in your XML import file.


n --replace: Use this option when you want to remove all the XML-configurable objects that exist in the
repository and replace them with the objects in your XML import file. This option is typically used
when copying configurations from one Global Manager to another Global Manager in order to
duplicate the repository objects.
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As an example, use the following command to import configuration objects from a file called ics-
conf.xml into a Global Manager called INCHARGE-SA and overwrite any existing configurations:


               sm_config -s INCHARGE-SA import --force ics-conf.xml


            


Exporting configurations
Exporting the repository objects to XML enables you to view the current configurations of your
Global Manager. Exporting configuration-related objects from one Global Manager in XML and then
importing them to a second Global Manager allows you to duplicate configurations between
Global Managers.


Before exporting, you need to know the name of the appropriate Manager and the location (host and port)
of the broker. Exporting produces an XML representation of the current configurations for your notification
lists, users, user profiles, tools, escalation policies, and map icons. By default, the XML file is created in
the BASEDIR/smarts/local/conf/ics directory.


To export the repository object configurations, use the following command syntax:


tsm_config -s <Global_Manager_Name>


          --broker=<host:port> export <file_name>.xml s 


For example, to create an XML file called Current_Configuration.xml containing the repository objects in
the INCHARGE-SA Global Manager on the host and port MyHost:426, the following command is used:


t sm_config -s INCHARGE-SA 


          --broker=MyHost:426 export Current_Configuration.xml s


Importing XML files to the Global Manager provides detailed information on importing the XML file.


Modifying individual repository objects
Using sm_config you can also enable, disable, and delete individual repository objects. To modify these
configurations, you need to know:


n Class name


n Instance name


n Action type (if the class name is Action)


Enabling or disabling repository objects
Disabling an object deactivates it and prevents it from being used. To disable or enable an object from the
repository, use the following command syntax:


tsm_config [options...] disable --classname=<class>


          --instancename=<instance> s
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To enable the object, replace the disable command with the enable command. For example, to enable a
user profile called UserProfile1 in a Global Manager named INCHARGE-SA, use the following command:


t sm_config -s INCHARGE-SA enable --classname=ICS_UserProfile 


          --instancename=ICS-Profile1 s


Deleting repository objects
Deleting a repository object completely removes it from the Global Manager. If you are not completely
sure you want to remove it, consider disabling the object instead. Enabling or disabling repository objects
provides additional information.


Note   Map objects cannot be deleted.


To delete an object from the repository, use the following command syntax:


t


         sm_config [options...] delete --classname=<class>


          --instancename=<instance> s


For example, to delete a server action named Telnet from a Global Manager named INCHARGE-SA, use
the following command:


t sm_config -s INCHARGE-SA delete --classname=ICS_Action 


          --instancename=Telnet --type=server s


Importing tools implemented by
VMware Smart Assurance adapters
If you are deploying an VMware Smart Assurance adapter that integrates with a third-party application,
you may need to import an XML definition file for the tools implemented by that adapter.


The XML definition files for these adapters are imported into the Global Manager using sm_config. 
Importing XML files to the Global Manager provides detailed information on importing XML files. Refer to
the user guide for that adapter for more information regarding the specific tool.


For example, to import the tools definition for the Concord eHealth tool from a file called
configureEHealthTools.xml into a Global Manager called INCHARGE-SA, type the following command:


         sm_config -s INCHARGE-SA import configureEHealthTools.xml
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SAM Configuration Parameters 13
This chapter includes the following topics:
n System default parameters


n ics-event-processing parameters


n ics-nl-processing parameters


n ics-topology-sync.asl parameters


n Console parameters


n trap.d conf parameters


n Environment variables


System default parameters
System defaults are system-wide settings that affect the Global Manager and its clients. System default
parameters describes the System Defaults parameters.


Table 13‑1.  System Defaults parameters


Parameter Description


Auto Acknowledgement Interval Defines interval, in seconds, after which an inactive and unowned notification is
acknowledged. Notifications that are acknowledged by the Global Manager are
owned by the user SYSTEM.


Default: 300 seconds


Inactive Auto Archive Interval Defines interval, in seconds, after which an inactive and acknowledged notification is
archived. If this value is set to zero, archiving is disabled and notifications will not be
deleted, causing Global Manager to use more memory.


Default: 14400 seconds (4 hours)


Audit Trail Size Limit Defines the number of audit log entries for each notification that are saved and
visible in the Global Console before the log contents are archived. When this limit is
reached, half of the entries are written to the notification archive.


Default: 100 entries
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Table 13‑1.  System Defaults parameters (Continued)


Parameter Description


SMTP Server Defines the name of the SMTP mail server through which mail messages sent by the
Global Console’s Mail tool are sent. This mail server must be reachable from the
host where the Global Manager is running. This value can be overridden in the
Global Console.


Default: “localhost”


Fetch Local Notification Properties Defines how the properties of a particular notification are retrieved when requested
by a client application. Client applications include the Global Console, the dmctl
utility, and adapters.


If set to “true”, properties are retrieved from the Global Manager. If set to “false”,
properties are retrieved from the Global Manager and from the underlying domain.


Default: False


RMI Time Out Defines the maximum amount of time, in seconds, the Global Manager is allotted to
retrieve Notification Properties, Find System, or get System Containment information
from an underlying domain. If a negative value is specified, no time-out value is set.


Default: 60 seconds


Number Of Worker Threads Defines the number of worker threads used by the escalation mechanism in
executing tools associated with escalation levels in escalation paths. Increase the
number of threads if the escalation mechanism falls behind in executing tools for
escalation levels. Valid values are 1 - 10.


Default: 2
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Table 13‑1.  System Defaults parameters (Continued)


Parameter Description


Broadcast Event State on Restart Defines whether notifications that result from internal Global Manager events are
propagated to clients that subscribe to them. Internal Global Manager events include
system disconnects and system reconfigurations. If set to True, notifications
resulting from internal Global Manager events are propagated. If set to False, the
events are not propagated.


Example:


In the case of the value being TRUE in a hierarchical SAM configuration,
notifications at presentation level SAM will go to ‘Suspended’ state if there is a
disconnect between aggregation level SAM and a source domain. This will happen
because aggregation SAM will broadcast the notification state change from Active to
WAS_ACTIVE. In the case of the value being False, the notifications in the
aggregation SAM will change to WAS_ACTIVE, but no change will be sent to
presentation level SAM. When aggregation SAM reconnects to the source domain
events it will send clears for notifications that are no longer active.


When configuring this parameter, the value must be identical for all Service
Assurance Manager servers within your Service Assurance Manager deployment.
For changes to this parameter configuration to take effect, the
Service Assurance Manager servers must be restarted.


Note   For optimum benefit, configure this parameter as early in your
Service Assurance Manager deployment as possible, before all source domains are
added to the Service Assurance Manager server. The quickest way to apply this
parameter configuration is to restart the Service Assurance Manager server.
However, if you are configuring this parameter in a production environment, apply
the parameter configuration to the Service Assurance Manager server by making a
minimal change to the configuration of each of the underlying source domain types,
and clicking the Reconfigure button. One example of a minimal configuration
change is to modify the value for the Smoothing Interval parameter. A minimal
configuration change is required for each domain type. This results in the
Service Assurance Manager server disconnecting from each underlying domain,
rereading all the settings including the new modification, and then reconnecting to
the underlying domains.


Default: True


Hierarchical Acknowledge Defines whether acknowledging or unacknowledging a notification in the server
sends the acknowledge (or unacknowledged) information to the underlying servers.
If set to True, the notification in the underlying servers are also acknowledged or
unacknowledged. If set to False, the notification in the underlying servers are not
changed.


Default: True


Companion UI Hostname Defines the location of the related Companion UI vApp. The accepted values are the
Domain Name System (DNS) host or the IP address of the vApp (for example,
companionUI or companionUI.mycompany.com).


Use DNS Lookup in This Domain Defines whether the system performs Domain Name System (DNS) searches when
searching for computer systems. If set to True, the system queries the DNS in this
domain.


Note   When performing a DNS search, perform the search from the Adapter
Platform (OI).


Default: True
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Table 13‑1.  System Defaults parameters (Continued)


Parameter Description


Use DNS Lookup in Underlying Domains Defines whether the system performs Domain Name when searching for computer
systems. If set to True, the system queries the DNS in underlying domains.


Default: True


Use DNS Domains in DNS Lookup Defines whether DNS domains are used when the system performs a DNS search. If
set to false, only original domain names are used during the DNS search.


Default: False


DNS Domain Names Defines the list of domain names the system uses when performing a DNS search.


Note   When entering multiple domain names, separate each domain name with a
comma.


Underlying Domains Order Defines the order in which the underlying domains are searched.


Note   When entering multiple domain names, separate each domain name with a
comma.


Fully Qualified Domain Name Suffixes Defines which domain names returned as a result of performing a DNS search are
considered to be fully qualified. Domain names matching suffixes entered in this
parameter are considered fully qualified.


ics-event-processing parameters
ics-event-processing parameters describes the ics-event-processing parameters.


Table 13‑2.  ics-event-processing parameters


Parameter Description


default debug This parameter helps track the event flow. If set to true, it prints all the
messages under debug flag.


Default: FALSE


default detailDebug If set to true, it prints all the messages under detail debug flag.
Default: FALSE


default elementType It refers to domain type of the server.


Default: INCHARGE


default XDImpact Defines whether we need to refresh impacts or not.
Default: FALSE


default timeoutTopoValue This prevents topology synchronization operations from waiting
indefinitely. Depending on the value you specify for this parameter in the
configuration file, if the child (underlying domain) has gone down, then
the parent (domain) waits for the time interval specified here before
starting off topology synchronization operations. The default value of 600
seconds can be increased on the basis of size and complexity of the
topology.
Default: 600 seconds


default impactsInterval Time interval before refreshing the impacts for a problem. After the specified
time interval, a refresh will occur for any impact.


Default: 61 seconds
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Table 13‑2.  ics-event-processing parameters (Continued)


Parameter Description


default problemAgingInterval Indicates the time for which a problem persists, after which it is considered as
an active proble. It is the cut-off time for a problem to update its causes and
causedby relationship. Default: 900


default noImpactChange If you set the value for this paramreter to FALSE, the system will update
the notification whenever there is an impact change for the event. If set to
FALSE, the notifications are not updated for any impact cange to an
event.
Default: TRUE


default noRootChange If the root of the event is changed then this flag is set to true.


Default: FALSE


default updateImpactList If set to true, then impact list will be updated.


Default: FALSE


default broadcastEventState This variable allows you to customize and bypass internal event storms.
It displays information about domain-related events, such as system
disconnects and system reconfigurations. This parameter is set using the
Global Console.


Default: TRUE


ics-nl-processing parameters
ics-nl-processing parameters describes the ics-nl-processing parameters.


Table 13‑3.  ics-nl-processing parameters


Parameter Description


default debug If set to true, it prints all the messages under debug flag.


Default: FALSE


default detailDebug If set to true, it prints all the messages under detail debug flag.
Default: FALSE


default debugDumpFields If the value for this parameter is set to TRUE, then the system dumps the full
notification for a particular underlying field for SAM or OI. This parameter only
applies to SAM.


Default: FALSE


default debugIncoming This flag is used to keep track of 1000 notifications from any particular
underlying domain. If the value for this parameter is set to TRUE, a
message is displayed when the 1000 notifications limit is reached.
Default: FALSE


default propagateImpacts A value of TRUE, indicates that impacts are updated. This is usually set to
FALSE to disable propagating of impacts in a high latency connection.
Default: TRUE
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Table 13‑3.  ics-nl-processing parameters (Continued)


Parameter Description


default getRemoteAttributes If set to TRUE, the system copies attributes of the top level SAM from the
underlying domain. In this case it will update each SAM topology instance with
all the attributes from the corresponding underlying domain instance. This
parameter is set through the configuartion file.


Default: FALSE


default noImpactChange If there is any impact change for the event then this flag is set to false.


Default: TRUE


default noRootChange If the root of the event is changed then this flag is set to true.
Default: FALSE


default updateImpactList If set to true ,then impact list will be updated.


Default: FALSE


default broadcastEventState This variable allows you to customize and bypass internal event storms.
Default: True


default timeoutTopoValue This prevents topology synchronization operations waiting indefinitely.
Default: 600 seconds


ics-topology-sync.asl parameters
ics-topology-sync.asl parameters describes the ics-topology-sync.asl parameters.


Table 13‑4.  ics-topology-sync.asl parameters


Parameter Description


default debug If set to true, it prints all the messages under debug flag.


Default: FALSE


default do_bulk This flag is obselete.
Default: FALSE


default do_bimSync If set to true, then it triggers BIM topology synchronization..


Default: FALSE


default displayStats This flag displays instances and it's attributes
Default: TRUE


default isSingleTopologySource This flag is set to true if elementType is "INCHARGE-SINGLE-TOPOLOGY-
SOURCE".
Default: FALSE


Console parameters
Console parameters describes the Console parameters.
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Table 13‑5.  Console parameters


Parameter Description


com.smarts.connectionTimeout This property indicates the maximum amount of


time that the console will wait for the Domain


Manager pulse check (the upTime attribute) to


respond. If there is no response within the


specified time, the console disconnects from the


Domain Manager.


Default: 300 seconds (5 minutes)


com.smarts.highLatency This will be set to true in high latency environment.
Default: FALSE


com.smarts.securityMessage Defines the name of the ASCII file containing the


security warning message.


Default: String


com.smarts.server.logMessages If set to true, causes the server to write messages to the
server log file.
Default:TRUE


com.smarts.mapNodeText.font Allows the user to define the map icon font..
Default: Helvetica


com.smarts.mapNodeText.fontSize Allows the user to define the map icon font size.
Default: 12 point


com.smarts.java.log If specified, the Java log contents are saved to the


specified file.


Default: No file specified


com.smarts.informs If specified, this property controls which underlying Domain Managers
are accessible by using Browse Detail from the Notification Log view.
A user-defined field must be configured to contain the names of the
underlying Domain Managers.
Default: FALSE


com.smarts.map.showAllBusiness If set to true, it shows all nodes and edges in a Business


Services map, including those that are not part of


paths that originate from or terminate at the map


central node. If set to false, it shows the nodes and edges in a Business
Services map that either originate from or


terminate at the map central node.


Default: TRUE


com.smarts.map.showNormalBanner If set to True, it shows map nodes with the status of
Normal with a green color bar underneath the icon. If false, shows
map nodes with the status of Normal without a green color bar
underneath the icon.
Default: FALSE
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Table 13‑5.  Console parameters (Continued)


Parameter Description


com.smarts.mapBackgroundColor Enables you to specify a single background color
for all maps. This parameter overrides the default
color for all map types. Note that if the setting you
enter is invalid, the background color for all maps
will be white.
Default: 600 seconds


com.smarts.showDomainConsistsOf Defines whether the InChargeDomainConsistsOf


relationship displays in the topology view. If


configured to false, the


InChargeDomainConsistsOf relationship does not


display in the topology view reducing the


possibility of the console not responding. If


configured to true, all the information for the


ConsistsOf relationship displays in the topology


view.


Default: FALSE


com.smarts.fasttopologybrowse Defines whether the topology browser


performance is enhanced for displaying related


instance information. Options include:
n Off — Default value
n On — Speed up enhancement is activated with instance information


sorted
n Nosort — Speed up enhancement is activated with instance information


not sorted


Default: OFF


com.smarts.clientTool.setEnv Defines the method of passing parameters to client scripts. If configured to
true, the console directly loads parameters passed to the client script into
the environment.


If configured to false (or when a value is not specified), the console passes
parameters to the client scripts as command line arguments and requires
the client script to parse the parameters to load them into the environment.


Default: FALSE


com.smarts.getMap.timeout Defines the time, in seconds, that the Get Map function tries to retrieve map
data before the function times out. Once the Get Map function times out,
the Get map timed out message appears.


Default: 120


com.smarts.oldGetMap Defines whether the console retrieves map data as a string or as formatted
data. If set to true, the console retrieves map data as formatted data.


Default: FALSE


com.smarts.timestampFormat Overrides the default formatting of timestamps in


the console, for example, the First Notify, Last


Notify, and Last Change fields in the notification


view.
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Table 13‑5.  Console parameters (Continued)


Parameter Description


com.smarts.user.timezone Causes the console to format all times and timestamps according to the
specified time zone. Examples of acceptable values are: PST for U.S.
Pacific Standard Time and GMT for Greenwich Mean Time.


The default is the time zone where the console is


running. Class TimeZone at the Java website includes


additional information.


com.smarts.debugConnection If set to true, it logs all the console operations in SAM log.


Default: FALSE


com.smarts.writeable Defines the location of console logs.


smarts.remote.broker Defines the default broker for domain attach dialog boxes.


Default: host:port


com.smarts.securityEnabled If set to true, security is enabled. This is the default value when the
sm_gui.exe is executed. If set to false, security is disabled.


com.smarts.log.level Defines the level of messages written to the console java log. Options
include:
n FATAL
n SEVERE
n SERIOUS
n DEFAULT (default option)
n WARNING
n INFO
n CONFIG
n DEBUG
n TRACE


com.smarts.disable_keepalives If enabled then console doesnot get disconnected from SAM server after
few missed keepalives


smarts.allowBGjpegs If set to true, it allows map background files to be saved in jpeg (.jpg)
format.If set to false, map background files will not be saved in jpeg format.


com.smarts.viewer.map.disableMaps If set to true, it disables the display of maps. If set to false, it does not diable
maps.


Default: TRUE


com.smarts.viewer.hideToolbarText If set to true, it hides the display text for the toolbar


buttons. If set to false, shows the text for the toolbar buttons.


Default: TRUE


com.smarts.maxTopoInstances It determines the number of topology instances that will be displayed on the
browser.


Default: 10000


VMware Smart Assurance Service Assurance Manager Configuration Guide


VMware, Inc.  181







Table 13‑5.  Console parameters (Continued)


Parameter Description


smarts.maps.maxGroupMembers A positive integer. This is the maximum number of


members of a leaf group that will display for a


Group Membership map without a prompt dialog


box. The dialog box prompts the operator when


there is a large number of members to display.


Default: 100


com.smarts.maxFilterInstances Enables you to change the maximum number of


instances that will automatically display in the


Topological Filter tab.


Default: 50


trap.d conf parameters
The VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide provides details
on the trap.d conf parameters.


Environment variables
Environment variables describes the environment variables.


Table 13‑6.  Environment variables


Parameter Description


SM_NOTIF_DISPLAY_INFO If set to true, it display verbose information regarding notifications.
Default: FALSE


SM_NOTIF_DISPLAY_PACKET If set to true, it displays packet information regarding notification.
Default: FALSE


SM_NOTIF_CLEANUP_SECONDS Sets the time duration for cleanup of notifications.


Default: 15*60


SM_NOTIF_MAX_NOTIF_IN_PKT Sets the maximum notifications to send in one packet.
Default: 5000


SM_SAM_TO_SAM_HYPER_NOTIF_SLEEP Sets the polling interval to fetch notifications.
Default: 10


SM_MAX_CONNECTIONS_TO_UNDERLYING_DO
MAIN


Determines the maximum number of connections from SAM to each
underlying domain.


Default: 10


SM_MAX_SIZE_NOT_TO_COMPRESS Sets the maximum size in bytes not to compress during data transfer.


Default: 100000


SM_DISPLAY_DXA_REL_INFO If set to true, displays debug information during topology
synchronization.


Default: FALSE
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Table 13‑6.  Environment variables (Continued)


Parameter Description


SM_DISPLAY_DXA_TIMINGS If set to true, displays time information during topology synchronization.


Default: FALSE


SM_ENABLE_SERIAL_SYNCS If set to true, enables serial mode for topology synchronization.


Default: FALSE


SM_DELAY_BETWEEN_TOPO_SYNCS Sets the minimum delay between two successive synchronization to a
domain.


Default: 120 seconds


SM_KEEP_LOCAL_OBJECTS If elementname and elementclassname are found empty for notifications
in the Notification Log Console, it is likely that corresponding local
objects were deleted during topology synchronization with underlying
domain managers but notifications were not cleared.


To avoid local objects that have an associated notification instance from
being deleted, set the following property in the local/conf/runcmd_env.sh
file.


Default: YES


SM_JDK_HOME The SM_JDK_HOME environment variable is used to indicate the
location of the JDK, if present. If you provide the location of the JDK
while running the appropriate setup script, then the SM_JDK_HOME
variable will be defined in the runcmd script.


SM_JAVA The SM_JAVA environment variable specifies a Java Runtime
Environment (JRE) other than that in BASEDIR/smarts/jre. The contents
are the paths to the libraries of the JRE. On UNIX, the value of
SM_JAVA is added to the LD_LIBRARY_PATH (Solaris and Linux).


This variable is optional. If not set, runcmd will assume standard paths
relative to the value of SM_JAVAHOME.


SM_JAVAHOME The SM_JAVAHOME environment variable is used in conjunction with
SM_JAVA to specify a non-standard JRE. It specifies the location of the
JRE, and defines the value


of the JVM's ""java.home"" system property.
n If SM_JAVAHOME is left unset and SM_JDK_HOME was specified,


then SM_JAVAHOME will effectively be set to SM_JDK_HOME/jre.
n If left is not set and SM_JDK_HOME is also unset, and if the


BASEDIR/jre directory exists, then SM_JAVAHOME will effectively
be set to BASEDIR/jre.


SM_JAVA_ENABLED Set this environment variable to Yes in the BASEDIR directory path to
ensure that Java can be successfully started for NOTIF.
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ICIM Classes Used with
Matching Criteria 14
This chapter includes the following topics:


n Classes and attributes for matching managed systems


n Attributes for matching notification properties


Classes and attributes for matching managed systems
To configure the Global Manager, you may need to specify a matching pattern or matching criteria. The
matching pattern or criteria are compared to the name or value of system and notification attributes.
Tasks where you might specify a matching pattern include:


n Creating notification lists


n Specifying tagging patterns


n Determining the status or criteria of tools


n Creating selective groups with the Global Console


Matching criteria are strings that are matched against the value of the specified attribute. The criteria
can contain any combination of text, integers, and wildcards.


System classes and their attributes lists the attributes of the system class hierarchy. The
ICIM_System class is at the top of the hierarchy. As you move down the table, the classes become
increasingly more specialized until you reach classes that represent specific systems such as routers
and switches.


Note   Classes lower in the hierarchy inherit the attributes of classes higher in the hierarchy.


Table 14‑1.  System classes and their attributes


System class Attributes Type Description


ICIM_System CreationClassName String Name of the class from which the element was
instantiated.


DisplayClassName String Name of the system’s class that is displayed in the
console.


DisplayName String Name of the system that is displayed in the
console.


Description String Description of the system.
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Table 14‑1.  System classes and their attributes (Continued)


System class Attributes Type Description


IsManaged Boolean Determines if the system is managed by the
underlying domain.


Note   Unmanaged elements do not appear in the
Global Manager topology.


Name String Name of the system.


PrimaryOwnerContact String Contact information for the primary owner of this
system.


PrimaryOwnerName String Name of the primary owner of this system.


SystemName String Name of the system of which this component is a
part of or this service is hosted by.


ICIM_ComputerSystem ICIM_ComputerSystem does not add attributes to
the system class hierarchy. A computer system is
a collection of managed system elements such as
file systems, processors, and memory.


UnitaryComputerSystem Certification String Level of certification assigned to this device during
discovery. Possible values are:
n CERTIFIED
n VALIDATED
n TEMPLATE
n GENERIC
n UNCERTIFIED
n UNDISCOVERED
n UNSUPPORTED


Location String Description of the physical location of this system.


Model String Vendor name for the system.


Type String Type of the computer system. Possible values are:
n BRIDGE
n FIREWALL
n HOST
n HUB
n LOADBALANCER
n MSFC
n NODE
n PROBE
n ROUTER
n RSFC
n RSM
n SWITCH
n TERMINALSERVER
n UNCERTIFIED


Vendor String Name of the system’s manufacturer.
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Table 14‑1.  System classes and their attributes (Continued)


System class Attributes Type Description


Bridge Type String Unitary computer system that bridges packets
between separate segments. Value is BRIDGE.


Firewall Type String Unitary computer system that controls the flow of
traffic between networks. Value is FIREWALL.


Host Type String Unitary computer system that represents a
workstation or server. Value is HOST.


Hub Type String Unitary computer system that connects multiple
segments. Value is HUB.


LoadBalancer Type String Unitary computer system that distributes client
traffic across multiple web servers. Value is
LOADBALANCER.


MSFC Type String Unitary computer system that represents a Multi
Layer Switch Feature Card. An MSFC is a card
installed into a switch to perform routing between
VLANs. Value is MSFC.


Node Type String Unitary computer system that has not yet been
certified by discovery.


Probe Type String Unitary computer system that monitors networks
or systems. Value is PROBE.


Router Type String Unitary computer system that routes packets
between computer networks. Value is ROUTER.


RSFC Type String Unitary computer system that represents a Router
Switch Feature Card. An RSFC runs Cisco IOS
router software and directly interfaces with
Catalyst switches to provide inter-VLAN routing.
Value is RSFC.


RSM Type String Unitary computer system that represents a Router
Switch Module. Often installed in switches to route
packets between VLANs. Value is RSM.


Switch Type String Unitary computer system that switches packets
between separate segments. Value is SWITCH.


TerminalServer Type String Unitary computer system that represents a
terminal server or similar access device. Value is
TERMINALSERVER.


Uncertified Type String [Deprecated, replaced by Node] Unitary computer
system that represents a system that has not yet
been certified by discovery. Value is HOST.


Attributes for matching notification properties
Notification attributes lists the notification attributes that are contained in notifications generated by the
Global Manager. When you create a matching pattern, use the name of the attribute, not the column
heading from the Notification Log.
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Table 14‑2.  Notification attributes


Attribute Default column name Value type Description


Acknowledged Acknowledged Boolean Indicates if a notification has been acknowledged.
Possible values include:
n TRUE if the notification has been acknowledged.
n FALSE if not.


Active Active Boolean Indicates if a notification is active. Possible values
include:
n TRUE if the notification is active.
n FALSE if not.


AuditTrail n/a String Audit trail includes five fields separated by spaces. The
fields include:
n Serial number — A unique number that identifies the


audit trail entry.
n Timestamp — Identifies when this audit trail entry


was written.
n User — The InCharge username associated with this


audit trial entry.
n Action type — Identifies the reason for the audit trail


entry.
n Text — A brief description of the audit trail entry.


Category Category String Type of notification sent by the Global Manager. Possible
values include:
n Availability
n Discovery
n Error
n IMPACT
n Operational
n Performance
n PowerSupply
n Resource
n Temperature


Certainty Certainty Float Confidence that this notification is the correct diagnosis.
Value ranges from 0 to 100.


ClassDisplayName Class String Name of the class that appears to the user.


ClassName ClassName String Class name of the instance where this event occurred.
This attribute, with InstanceName and EventName
uniquely identifies this notification.


ClearOnAcknowledge n/a Boolean Indicates that this event should be cleared when it is
acknowledged. Default is FALSE.


ElementClassName Element Class String Class name of the managed element most closely related
to this event.


ElementName Element Name String Name of the managed element most closely related to
this event.


EventDisplayName Event String Name of the notification that appears to the user.
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Table 14‑2.  Notification attributes (Continued)


Attribute Default column name Value type Description


EventName EventName String Name of this notification. This attribute, with ClassName
and InstanceName, uniquely identify this notification.


EventState Event State String Describes the state of the event. Value can be one of:
n ACTIVE
n WAS_ACTIVE
n SUSPENDED
n INACTIVE
n UNITIALIZED


EventText Event Text String A description of the notification.


EventType Event Type String MOMENTARY when the notification has no duration.
DURABLE if the notification has a period for which it is
active, such as a link failure.


FirstNotifiedAt First Notify Integer Time, in seconds, when the notification first became
active.


Events diagnosed by an underlying domain include
timestamps that accurately reflect when the event
occurred. The Global Manager uses this value from the
event for the FirstNotifiedAt/LastNotifiedAt times when it
creates the notification.


Impact Impact Integer Numeric value that indicates the effect of this event on
related elements.


InMaintenance In Maintenance Boolean Indicates if the device is in maintenance mode. Possible
values include:
n TRUE if the device is in maintenance mode.
n FALSE if not.


InstanceDisplayName Name String Name of the instance that is displayed to the user.


InstanceName InstanceName String Name of the object where this notification occurred. This
attribute, with ClassName and EventName, uniquely
identify this notification.


IsProblem IsProblem Boolean IsProblem is defined as TRUE if (and only if) at least one
of the types is “PROBLEM”, and none of the types are
anything other


than “PROBLEM” or “UNKNOWN”.


Note   Since filtering on IsRoot can result in transient
behavior, it is recommended to filter on IsProblem
instead.
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Table 14‑2.  Notification attributes (Continued)


Attribute Default column name Value type Description


IsRoot IsRoot Boolean Indicates if the notification is an authentic problem.
Possible values include:
n TRUE if the notification is an authentic problem (root


cause).
n FALSE if not.


If a given notification has no CausedBy relationship, it is
declared to be a root event, and IsRoot for that
notification is set to TRUE.


It is often useful to filter on IsRoot to find those
notifications which require immediate attention.


LastChangedAt Last Change Integer Time, in seconds, when the status of the notification last
changed.


LastClearedAt Last Clear Integer Time, in seconds, when the notification was last cleared.


LastNotifiedAt Last Notify Integer Time, in seconds, when the notification was last notified.


OccurrenceCount Count Integer Number of times the notification has occurred.


Owner Owner String Name of the person responsible for this notification.
Value is SYSTEM when acknowledged by the
Global Manager.


Severity Severity Integer Level of severity for this notification.


1 = CRITICAL


2 = MAJOR


3 = MINOR


4 = UNKNOWN


5 = NORMAL


Note   Only the numbers, not the text descriptions, are
passed by the Global Manager.


SourceDomainName Source String Name of the underlying domain that sent this notification.
If more than one domain is listed, the names are
separated by commas.


SourceEventType SourceEventType String Indicates the type of event from an underlying source or
sources. Value can be one of:
n PROBLEM
n EVENT
n AGGREGATE
n UNKNOWN.


The default value is UNKNOWN. (Not to be confused
with Event Type.)


TroubleTicketID Ticket ID String Trouble-ticket number associated with this notification.


UserDefined1-20 User Defined 1-20 String Twenty notification attributes can be defined by the user.
You can set a value with a hook script specified in
DomainType section of ics-default.xml file.
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Note   For attributes that contain a time value, time is counted from Midnight, January 1st, 1970 (GMT). In
the Global Console, these values are converted to a date and time.
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Wildcard Patterns 15
This appendix contains the following information:


n Types of wildcard patterns


Types of wildcard patterns
A wildcard pattern is a series of characters that are matched against incoming character strings. You can
use these patterns when you define pattern matching criteria.


Matching is done strictly from left to right, one character or basic wildcard pattern at a time. Basic wildcard
patterns are defined in Basic wildcard patterns. Characters that are not part of match constructs match
themselves. The pattern and the incoming string must match completely. For example, the pattern abcd
does not match the input abcde or abc.


A compound wildcard pattern consists of one or more basic wildcard patterns separated by ampersand
(&) or tilde (~) characters. A compound wildcard pattern is matched by attempting to match each of its
component basic wildcard patterns against the entire input string. Compound wildcard patterns are listed
in Compound wildcard patterns.


If the first character of a compound wildcard pattern is an ampersand (&) or tilde (~) character, the
compound is interpreted as if an asterisk (*) appeared at the beginning of the pattern. For example, the
pattern ~*[0-9]* matches any string not containing any digits. A trailing instance of an ampersand
character (&) can only match the empty string. A trailing instance of a tilde character (~) can be read as
“except for the empty string.”


Note   Spaces are interpreted as characters and are subject to matching even if they are adjacent to
operators like “&”.


Table 15‑1.  Basic wildcard patterns


Character Description


? Matches any single character.


For example, server?.example.com matches server3.example.com and serverB.example.com, but not
server10.example.com.


* Matches an arbitrary string of characters. The string can be empty.


For example, server*.example.com matches server-ny.example.com and server.example.com (an empty
match).
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Table 15‑1.  Basic wildcard patterns (Continued)


Character Description


[set] Matches any single character that appears within [set]; or, if the first character of [set] is (^), any single
character that is not in the set. A hyphen (-) within [set] indicates a range, so that [a-d] is equivalent to
[abcd]. The character before the hyphen (-) must precede the character after it or the range will be empty.
The character (^) in any position except the first, or a hyphen (-) at the first or last position, has no special
meaning.


For example, server[789-].example.com matches server7.example.com through server9.example.com,
but not server6.example.com. It also matches server-.example.com.


For example, server[^12].example.com does not match server1.example.com or server2.example.com,
but will match server8.example.com.


<n1-n2> Matches numbers in a given range. Both n1 and n2 must be strings of digits, which represent
nonnegative integer values. The matching characters are a non-empty string of digits whose value, as a
nonnegative integer, is greater than or equal to n1 and less than or equal to n2. If either end of the range
is omitted, no limitation is placed on the accepted number.


For example, 98.49.<1-100>.10 matches a range of IPv4 addresses from 98.49.1.10 through
98.49.100.10.


Example of an omitted high end of the range: <50-> matches any string of digits with a value greater than
or equal to 50.


Example of an omitted low end of the range: <-150> matches any value between zero and 150.


For a more subtle example: The pattern <1-10>* matches 1, 2, up through 10, with * matching no
characters. Similarly, it matches strings like 9x, with * matching the trailing x. However, it does not match
11, because <1-10> always extracts the longest possible string of digits (11) and then matches only if the
number it represents is in range.


| Matches alternatives. For example,”ab|bc|cd” without spaces matches exactly the three following strings:
“ab”, “bc”, and “cd”. A | as the first or last character of a pattern accepts an empty string as a match.


Example with spaces “ab | bc” matches the strings “ab” and “ bc”.


\ Removes the special status, if any, of the following character. Backslash (\) has no special meaning
within a set ([set]) or range (<n1-n2>) construct.


Special characters for compound wildcard patterns are summarized in Compound wildcard patterns.


Character Description


& “And Also” for a compound wildcard pattern. If a component basic wildcard pattern is preceded by & (or is the
first basic wildcard pattern in the compound wildcard pattern), it must successfully match.


Example: *NY*&*Router* matches all strings which contain NY and also contain Router.


Example: <1-100>&*[02468] matches even numbers between 1 and 100 inclusive. The <1-100> component
only passes numbers in the correct range and the *[02468] component only passes numbers that end in an
even digit.


Example: *A*|*B*&*C* matches strings that contain either an A or a B, and also contain a C.


~ “Except” for a compound wildcard pattern (opposite function of &).If a component basic wildcard pattern is
preceded by ~, it must not match.


Example: 10.20.30.*~10.20.30.50 matches all devices on network 10.20.30 except 10.20.30.50.


Example: *Router*~*Cisco*&*10.20.30.*~10.20.30.<10-20>* matches a Router, except a Cisco router, with an
address on network 10.20.30, except not 10.20.30.10 through 10.20.30.20.
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XML Reference 16
This chapter includes the following topics:


n Sample XML files


n Structure of an XML document


n Configuration elements


n Global Manager configuration DTDs


Sample XML files
This chapter describes the XML needed to create and modify repository objects such as notification lists,
users, user profiles, tools, escalation policies, console operations, and map icons. The XML files are
imported into the repository using the sm_config utility. Chapter 12 Importing and Exporting
Configurations provides additional information. You must have a strong understanding of XML if you
intend to create and manage repository objects using XML.


Sample XML documents are provided to use as a template and can be edited to suit your needs. The
following sample files are located in the BASEDIR/smarts/conf/ics directory:


n Tools: actionconfig-sample.xml


n Notification Lists: nlconfig-sample.xml


n Escalation Policy: policyconfig-sample.xml


n User Profile: profileconfig-sample.xml


n User: userconfig-sample.xml


n Multiple types of repository objects: ics-config-sample.xml


n Map Icons: mapgif-sample.xml


Note   The instance_maptype-sample.xml file is reserved for future use.


A useful way of viewing valid, complex XML is to export the configurations you make in the
Global Manager Administration Console. “Exporting configurations” on page 198 describes how to
export the configuration of a Global Manager.
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Structure of an XML document
The basic building blocks of an XML document are elements, attributes, and values. Tag is a general term
that can be used for elements and attributes. A relevant sample of the Global Manager configuration XML
DTD is provided with each of the structural descriptions.


Element
An element is a tag that is a container for subelements and attributes. For example, the nlconfig element
contains defining information for the notification list you are adding or editing in the repository. If an
element comprises any subelements, these are defined in parentheses after the element declaration in
the DTD. For example, the notification list element, nlconfig, comprises a filter, column heading, and user
profile as seen in this sample of the DTD:


<!ELEMENT  nlconfig  (filterconfig | columnheading | userprofile)*>


Attribute declaration (attribute list)
Attribute declarations, as defined in the ATTList tag of the DTD, provide a detailed definition for an
element. Many elements use name declarations to identify the element as well as enable declarations
that instruct the Global Manager to create and enable the object in repository.


An attribute is a source of additional information about an element, used to define the element:


n The value of an attribute must match one of the values listed. Values must appear in parentheses and
be separated by OR (|) symbols.


n Attribute may be required (#REQUIRED), optional (#IMPLIED), or have a default value in quotes.


n All attribute values must be quoted.


The following is an example of an attribute declaration in the DTD for the notification (nlconfig)
element:


<!ATTLIST nlconfig 


 name CDATA #REQUIRED


 enable (TRUE | FALSE | true | false | True | False) "true"


 timestamp CDATA "0">


This indicates that the notification list element has three attributes:


n Name — A character string that is required.


n Enable — Determines whether the repository object is enabled when it is imported. This attribute can
take one of the values in parentheses. The default value is true.


n Timestamp — Character string that identifies the date and time the object was last modified. The 0
indicates that, by default, there is no timestamp.
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Value
The value setting of the attribute declaration is paired with the declaration in name=value groupings. The
values define the properties of the element you are adding, modifying, or deleting in the repository. In the
following example, the notification list element is made up of a notification list element tag (“nlconfig”),
attributes (name and enable), values (Hosts_and_Routers and false), and a close tag for the element (/>):


<nlconfig name="Hosts_and_Routers" enable="false"> </nlconfig>


An attribute value is either required or implied. If the value is an attribute that you must define such as the
name of the object, this is indicated by the phrase #REQUIRED after the attribute in the DTD. If the value
is implied, then a default value is indicated in quotes. For example, TRUE is the default value for the
enable attribute of the actionconfig element:


<!ATTLIST actionconfig


 name CDATA #REQUIRED


 enable (TRUE | FALSE | true | false | True | False) "TRUE"


 type ( server | client | auto ) #REQUIRED >


Value indicators
XML value indicators lists the terms and symbols used to build the XML expressions with proper syntax
structure.


Table 16‑1.  XML value indicators


Value indicator Description


CDATA Character data (CDATA) type attributes may contain only character data.


#PCDATA Parsed character data is text that will be examined by the parser for entities and proper syntax.


<element>* The asterisk (*) indicates that the content is optional (may occur zero or more times).


<element>? The question mark (?) after an element makes it optional, but only one may appear.


Configuration elements
This section describes the elements of the ics-config.dtd. For each element, an explanation of the
attributes and values is provided as defined by the DTD. An XML example for most elements is provided.
Additional requirements and guidelines for the XML representations are defined in the Semantics section
of each element.


ics_config
This is the root element of any Service Assurance configuration XML document. In any XML document
that you create for import into the Global Manager, this root element must be the opening and closing tag
of the document. There are no attributes for the ics_config element. All configuration elements are
contained within the ics_config element tags.
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ics_config DTD description
Within the DTD, ics_config is defined as the root element. The nlconfig, actionconfig, userprofileconfig,
userconfig, and policyconfig elements are listed as subelements in parentheses:


<!ELEMENT ics_config (nlconfig | actionconfig | userprofileconfig | userconfig | policyconfig | 


consoleoperationconfig | map_gifconfig )*>


ics_config XML example


For example, to define a new user profile, it must be nested within the root ics_config element:


<ics_config> 


 <userprofileconfig name="default" enable="True" timestamp="0">


  <nl>Default</nl>


  <user>user-default</user>


  <console>NotificationLog</console>


 </userprofileconfig>


</ics_config> 


Notification list (nlconfig)
This declares the notification list object and indicates that the subelements that can be nested are filters,
column headings, and user profiles.


nlconfig DTD description
The nlconfig element defines the notification list repository object. In the ics-config.dtd, the element is
defined as:


<!ELEMENT nlconfig (filterconfig | columnheading | userprofile)>


 <!ATTLIST nlconfig 


 name     CDATA #REQUIRED 


 enable   (TRUE | FALSE | true | false | True | False) "TRUE" 


 timestamp    CDATA "0" >


Attribute-list declarations for the nlconfig element identifies the attribute declarations and possible values
for the nlconfig element.


VMware Smart Assurance Service Assurance Manager Configuration Guide


VMware, Inc.  196







Table 16‑2.  Attribute-list declarations for the nlconfig element


XML attribute Description Possible value
Value required/
default value


name A unique name for the notification list. CDATA Required.


enable Indicates whether the notification list should be
enabled when imported into the
Global Manager or whether it was enabled at
the time of export.


TRUE


True


true


FALSE


False


false


Not Required.


Default is “True” so the
notification list is enabled
when imported.


timestamp When exporting, the value is the last time the
object was modified by any user through the
Administration Console or through sm_config.


When importing, the timestamp defined in the
XML file is compared with the timestamp of the
object in the repository. Modifications to an
existing object will fail when the import
timestamp is later than the existing repository
timestamp (unless the force option is used).


CDATA Not Required.


Default is “0”.


nlconfig XML example


For example, a notification list named "NL1" that is enabled without a specific timestamp would be defined
as:


<nlconfig name="NL1" enable="True" timestamp="0"> </nlconfig>


Filter (filterconfig)
The filterconfig element defines filter criteria that determines which notifications or topology elements may
pass through it. The filterconfig element is a subelement to the following elements:


n nlconfig


n policyconfig


n pathconfig


n status_criteria (for actions)


n context_criteria (for actions)


filterconfig DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  filterconfig (isa?, (criterion* | filename))>
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This declares the filter object and indicates that the subelements that can be nested are isa, criterion, and
filenames.


<!ATTLIST filterconfig


 type (ASL | EXPRESSION | asl | expression | Expression)  #REQUIRED 


 enable  (TRUE | FALSE | true | false | True | False)  "TRUE">


Attribute-list declarations for the filterconfig element identifies the attribute declarations for the filterconfig
element.


Table 16‑3.  Attribute-list declarations for the filterconfig element


XML attribute Description Possible value
Value required/
default value


type One of two types of notification filters. Chapter 11
Working with Filters describes expression and
ASL filters.


EXPRESSION


Expression


expression


ASL


asl


Required.


enable Indicates whether the filter should be enabled
when imported into the Global Manager or
whether it was enabled at the time of export.


TRUE


True


true


FALSE


False


false


Not required


Default is "True"
so the filter is
enabled when
imported.


filterconfig XML example


For example, to indicate that an ASL filter called nl_notify.asl is to be utilized for a notification list called
NL1, use the following syntax:


<nlconfig name="NL1" enable="True" timestamp="0"> 


 <filterconfig type="ASL"> 


  <filename>nl_notify.asl</filename>


 </filterconfig>


</nlconfig>


In another example, the ics-default.xml file defines a filter for the default notification list that allows all
notifications not owned by maint or system. The XML representation of this is:


 <filterconfig type="EXPRESSION" enable="TRUE"> 


 <criterion attribute="Owner">~maint</criterion> 


 <criterion attribute="Owner">~SYSTEM</criterion> 


</filterconfig>


filterconfig semantics


You can have multiple criteria defined in a filter; these criteria are grouped by AND. If you have multiple
filterconfig definitions, these are grouped by OR.
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filename
This subelement is used when you are using an ASL filter. The filename refers to the ASL file to be used
as the filter for the notification list. In the ics-config.dtd, the element is defined as:


<!ELEMENT filename (#PCDATA)>


filename XML example


For example, to define an ASL filter using a file called nl_notify.asl, use the following syntax:


<filterconfig type="ASL" enable="TRUE"> 


 <filename>nl_notify.asl</filename> 


</filterconfig> 


isa
This isa element is used to define a filter for a particular ICIM class. There are no attributes associated
with the isa element. In the ics-config.dtd, the element is defined as:


<!ELEMENT isa  (#PCDATA)>


Any ICIM class name is a valid #PCDATA value for this element.


isa XML example


For example, to define an expression filter that allows all instances of the UnitaryComputerSystem class
to pass through, use the following syntax:


<filterconfig type="Expression" enable="TRUE"> 


 <isa>UnitaryComputerSystem</isa> 


</filterconfig> 


criterion
The criterion element is used to populate an expression filter with the notification attributes against which
the notifications or topology elements are matched.


Note   The criterion element utilizes wildcards to build expressions. Chapter 15 Wildcard Patterns
describes wildcards.


criterion DTD description


In the ics-config.dtd, the element is defined as:


<!ELEMENT criterion (#PCDATA)>


<!ATTLIST criterion


 attribute   CDATA  #REQUIRED>
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Attribute-list declarations for the criterion element identifies the attribute declarations for the criterion
element.


Table 16‑4.  Attribute-list declarations for the criterion element


XML attribute Description Possible value
Value required/
default value


attribute Name of the notification attribute. Must be one of the
attributes listed in “Attributes for matching
notification properties” on page 215.


#PCDATA Required


criterion XML example


For example, to define an expression filter that will only pass on notifications that do not have an open
trouble ticket ID (~*OPEN*), use the following syntax:


<filterconfig type="Expression" enable="TRUE"> 


 <criterion attribute="TroubleTicketID">~*OPEN*</criterion> 


</filterconfig>


Column heading (columnheading)
The columnheading element defines the names of the columns in the notification log in the
Global Console.


columnheading DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT columnheading (#PCDATA)>


<!ATTLIST columnheading


 column  CDATA   #REQUIRED


 column  (String | Boolean | Time | Integer | Float | Percentage )      "String">


Attribute-list declarations for the columnheading element identifies the attribute declarations for the
columnheading element.


Table 16‑5.  Attribute-list declarations for the columnheading element


XML attribute Description Possible value
Value required/
default value


column The name of the notification attribute. CDATA


(string?)


Required.


column The text you want to display as the
column heading in the Global Console
for users of this notification list.


String


Boolean


Time


Integer


Float


Percentage


Not required


Default is "String" so the
column heading text must
be defined.
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columnheading XML example


For example, this sample represents a notification list called NL1 with three columns. The
ClassDisplayName attribute will be displayed in the NL1 Class Name column. The InstanceDisplayName
attribute will be displayed in the NL1 Display Name column. Finally, the EventDisplayName attribute will
be displayed in the NL1 Event Name column:


<nlconfig name="NL1" enable="True" timestamp="0"> 


 <columnheading column="ClassDisplayName">NL1 Class Name


  </columnheading> 


 <columnheading column="InstanceDisplayName">NL1 Instance Name


  </columnheading> 


 <columnheading column="EventDisplayName">NL1 Event Name


  </columnheading> 


</nlconfig>


Column heading values
The column headings for a notification list correspond to notification attributes. Column heading attributes
and default display names describes the notification attributes, data types, and default display names of
the column headings.


Table 16‑6.  Column heading attributes and default display names


Notification attributes Data type Default column name


Name STRING InternalEventHandle


ClassName STRING ClassName


InstanceName STRING InstanceName


EventName STRING EventName


ClassDisplayName STRING Class


InstanceDisplayName STRING Name


EventDisplayName STRING Event


ElementClassName STRING Element Class


ElementName STRING Element Name


SourceDomainName STRING Source


Active BOOLEAN Active


OccurrenceCount INTEGER Count


FirstNotifiedAt TIME First Notify


LastNotifiedAt TIME Last Notify


LastClearedAt TIME Last Clear


LastChangedAt TIME Last Change


IsRoot BOOLEAN IsRoot


Acknowledged BOOLEAN Acknowledged


Owner STRING Owner
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Table 16‑6.  Column heading attributes and default display names (Continued)


Notification attributes Data type Default column name


EventType STRING Event Type


EventState STRING Event State


Category STRING Category


EventText STRING Event Text


Severity INTEGER Severity


Impact INTEGER Impact


Certainty PERCENTAGE Certainty


InMaintenance BOOLEAN In Maintenance


TroubleTicketID STRING Ticket ID


UserDefinedN STRING User Defined N


Tool/Action (actionconfig)
The actionconfig element identifies the tool repository object. Chapter 9 Tool Configuration for the Global
Manager describes tool configuration.


actionconfig DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  actionconfig (program_name | timeout? | trace | display | status_criteria? | 


context_criteria | userprofile )*> 


<!ATTLIST actionconfig


  name    CDATA  #REQUIRED 


  enable   (TRUE | FALSE | true | false | True | False) "TRUE" 


  type  (SERVER | CLIENT | AUTO | server | client | auto | Server |


   Client | Auto)     #REQUIRED


  timestamp    CDATA  "0">


This declares the tool object and indicates that the allowable subelements to be nested are:


n Program Name (program_name DTD description provides additional information)


n Timeout (timeout DTD description (for actionconfig) provides additional information)


n Trace (trace DTD description provides additional information)


n Display (display DTD description provides additional information)


n Status Criteria (status_criteria DTD description provides additional information)


n Context Criteria (context_criteria DTD description provides additional information)


Attribute-list declarations for the actionconfig element identifies the attribute declarations for the
actionconfig element.
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Table 16‑7.  Attribute-list declarations for the actionconfig element


XML attribute Description Possible value
Value required/
default value


name A unique name for the tool. CDATA


(string?)


Required.


enable Indicates whether the tool should be enabled when
imported into the Global Manager or whether it
was enabled at the time of export.


TRUE


True


true


FALSE


False


false


Not required


Default is True so the tool is
enabled when imported.


type Indicates the classification of the tool:
n Server — Tools executed on the same host as


the Global Manager. These are displayed in
the Tools menu on the Global Console.


n Client — Tools executed locally by the
console. These are displayed in the Tools
menu on the Global Console.


n Auto — Tools executed automatically through
escalation policies or the automatic action
adapter (sm_adapter). These are not visible in
the tools menu on the Global Console.


SERVER


Server


server


CLIENT


Client


client


AUTO


Auto


auto


Required.


timestamp When exporting, the value is the last time the
object was modified by any user through the
Global Manager Administration Console or through
sm_config.


When importing, the timestamp defined in the XML
file is compared with the timestamp of the object in
the repository. Modifications to an existing object
will fail when the import timestamp is later than the
existing repository timestamp (unless the force
option is used).


CDATA Not required


Default is "0".


actionconfig XML example


For example, a server tool named Action1 that is enabled, running a server type program called server-
action.sh without a specific timestamp would be defined as:


<actionconfig name="Action1" type="Server" enable="True" timestamp="0">


 <program_name>server-action.sh</program_name>    


</actionconfig>


Program name (program_name)
This is the name of the program that the Global Manager (for server and automatic tools) or the host
running the Global Console (for client tools) executes when the tool is invoked. This subelement is
implicitly required when defining an action in XML.
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program_name DTD description
There are no attributes associated with the program_name element. In the ics-config.dtd, the element is
defined as:


<!ELEMENT program_name (#PCDATA)>


program_name XML example


For example, if the server tool called Action1 is designed to execute a program called server-action.sh,
use the following syntax:


<actionconfig name="Action1" type="Server" enable="True" timestamp="0">


 <program_name>server-action.sh</program_name>    


</actionconfig>


Timeout (actionconfig)
This specifies the maximum number of seconds to wait for the tool script to complete. If the tool script
does not complete within the specified timeout interval, the Global Manager terminates the tool.


timeout DTD description (for actionconfig)
There are no attributes associated with the timeout element. In the ics-config.dtd, the element is defined
as:


<!ELEMENT timeout (#PCDATA)>


timeout XML example (for actionconfig)


For example, if the server tool called Action1 is designed to execute a program called server-action.sh
with a timeout value of 60 seconds, then the syntax to define that would look like this:


<actionconfig name="Action1" type="Server" enable="True" timestamp="0">


 <timeout>60</timeout>


 <program_name>server-action.sh</program_name>   


</actionconfig>


Display (display)
This specifies whether the tool should display output to the console. If this parameter is set to true, the
console will open the Tool Output window immediately after running the tool. If false, the console only
opens the Tool Output window if there is an error. The default is true.
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display DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT display EMPTY>


<!ATTLIST display


    display_value  (FALSE | TRUE | true | false | True | False) "TRUE">


Attribute-list declarations for the display element identifies the attribute declarations for the display
element.


Table 16‑8.  Attribute-list declarations for the display element


XML attribute Description Possible value
Value required/
default value


display_value Indicates whether or not to open the Tool
Output window when running the tool. If false,
the Tool Output window will only open if an
error occurs when the tool runs.


TRUE


True


true


FALSE


False


false


Not required.


Default is "TRUE".


display XML example


For example, if the server tool called "Action1" is designed to execute a program called "server-action.sh"
with a timeout value of 60 seconds, and you want to see the display output, then the syntax to define that
would look like this:


<actionconfig name="Action1" type="Server" enable="True" timestamp="0">


 <timeout>60</timeout>


 <program_name>server-action.sh</program_name>   


 <display display_value="True" />


</actionconfig>


Trace (trace)
Trace indicates that additional debugging information will be included in the display output of the tool. This
element is only valid if the display element is also declared.


trace DTD description
There are no attributes associated with the trace element. In the ics-config.dtd, the element is defined as:


<!ELEMENT trace EMPTY>


<!ATTLIST trace


    trace_value  (FALSE | TRUE | true | false | True | False) "FALSE">


The EMPTY declaration indicates that the element has no sub-elements or character data associated
with it.
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trace XML example


For example, to turn on the trace utility when defining an action, use the following syntax:


<actionconfig name="Action1" type="Server" enable="True" timestamp="0">


 <timeout>60</timeout>


 <program_name>server-action.sh</program_name>   


 <display display_value="True" /diplay>


 <trace trace_value="True"/> 


</actionconfig>


Status criteria (status_criteria)
This element determines whether a client or server tool is accessible from the popup menu in the Global
Console. The tool is always accessible when the status_criteria element is omitted. This parameter is not
available for automated tools.


status_criteria DTD description
There are no attributes associated with the status_criteria element. But, there is a filterconfig subelement
that determines which notifications utilize the tool. In the ics-config.dtd, the element is defined as:


<!ELEMENT status_criteria (filterconfig?)>


status_criteria XML example


For example, there is a server tool called Action1 designed to execute a program called server-action.sh
with a timeout value of 60 seconds, with a display output. To set the status criteria to ensure that the tool
only appears in the popup menu if there is an open trouble ticket for that notification, use the following
syntax:


<actionconfig name="Action1" type="Server" enable="True" timestamp="0">


 <timeout>60</timeout>


 <program_name>server-action.sh</program_name>   


 <display display_value="True" /diplay>


 <status_criteria>


  <filterconfig type="Expression">


   <criterion attribute="TroubleTicketID">~*OPEN*</criterion>


   </filterconfig>


 </status_criteria>


</actionconfig>


Context criteria (context_criteria)
This determines whether the tool appears on the tool menu in the Global Console when the user right-
clicks on a notification. The tool automatically appears in the tool menu when this parameter is omitted.
This parameter is not available for automated tools.
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context_criteria DTD description
There are no attributes associated with the context_criteria element. But, there is a filterconfig
subelement that determines which notifications utilize the tool. In the ics-config.dtd, the element is defined
as:


<!ELEMENT context_criteria (filterconfig?)>


For example, there is a server tool called Action1 that executes a program called server-action.sh with a
timeout value of 60 seconds, with a display output. To make sure that the tool is enabled in the popup
menu for Router notifications, the syntax is:


<actionconfig name="Action1" type="Server" enable="True" timestamp="0">


 <timeout>60</timeout>


 <program_name>server-action.sh</program_name>   


 <display display_value="True" /diplay>


 <context_criteria>


  <filterconfig type="Expression">


   <isa>ICIM_Notification</isa>


   <criterion attribute="ClassName">Router</criterion>


  </filterconfig>


 </context_criteria>


</actionconfig>


User (userconfig)
A user is an individual member of a user profile. If no user profile is specified, then the users are assigned
to the Default user profile.


Note   The userconfig element contains a subelement called userprofile. This subelement is used by the
Global Console to reference the user profile in the display. This is not used for configuration. “User profile
(userprofileconfig)” on page 239 describes the userprofileconfig element which is used to configure user
profiles.


userconfig DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  userconfig (userprofile)*>


<!ATTLIST userconfig


 name   CDATA     #REQUIRED 


    enable  (TRUE | FALSE | true | false | True | False) "TRUE"


  timestamp   CDATA  "0">


Attribute-list declarations for the userconfig element identifies the attribute declarations and possible
values for the userconfig element.
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Table 16‑9.  Attribute-list declarations for the userconfig element


XML attribute Description Possible value
Value required/
default value


name A unique name for the user. CDATA Required.


enable Indicates whether the user should be enabled
when imported into the Global Manager or
whether it was enabled at the time of export.


TRUE


True


true


FALSE


False


false


Not required.


Default is "True" so the
notification list is enabled
when imported.


timestamp When exporting, the value is the last time the
object was modified by any user through the
Administration Console or through sm_config.


When importing, the timestamp defined in the
XML file is compared with the timestamp of the
object in the repository. Modifications to an
existing object will fail when the import
timestamp is later than the existing repository
timestamp (unless the force option is used).


CDATA Not required.


Default is "0".


userconfig XML example


For example, if two users called User1 and User2 are designed to be enabled with no specific timestamp,
then the syntax to define that would look like this:


<userconfig name="User1" enable="True" timestamp="0"> </userconfig>


<userconfig name="User2" enable="True" timestamp="0"> </userconfig>


User profile (userprofileconfig)
A user profile defines what a set of users can see and do when they log in to the Global Console. The
user profile determines what notification lists, consoles, and actions a set of users can access.


userprofileconfig DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  userprofileconfig (nl | console | user | action | consoleoperation)*> <!ATTLIST 


userprofileconfig


    name   CDATA    #REQUIRED 


    enable  (TRUE | FALSE | true | false | True | False) "TRUE"


    timestamp   CDATA          "0">


This declaration states that the userprofileconfig element has four required subelements: nl, console,
user, and action.


Attribute-list declarations for the userprofileconfig element identifies the attribute declarations and
possible values for the userprofileconfig element.
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Table 16‑10.  Attribute-list declarations for the userprofileconfig element


XML attribute Description Possible value
Value required/
default value


name A unique name for the user profile. CDATA


(string?)


Required.


enable Indicates whether the user profile should be
enabled when imported into the
Global Manager or whether it was enabled at
the time of export.


TRUE


True


true


FALSE


False


false


Not required.


Default is "True" so the
notification list is enabled
when imported.


timestamp When exporting, the value is the last time the
object was modified by any user through the
Administration Console or through sm_config.


When importing, the timestamp defined in the
XML file is compared with the timestamp of the
object in the repository. Modifications to an
existing object will fail when the import
timestamp is later than the existing repository
timestamp (unless the force option is used).


CDATA Not required.


Default is "0".


userprofileconfig XML example


For example, in the ics-default.xml file, the "maint-profile" user profile is defined. It has the following
attributes:


n One notification list (Maintenance).


n One console (NotificationLog).


n One user associated with it (maint).


The maint-profile user profile also has several actions and console operations defined:


<userprofileconfig name="maint-profile" enable="True" timestamp="0"> 


 <nl>Maintenance</nl> 


 <console>NotificationLog</console>


 <user>maint</user>


 <action type="server">Sample - Telnet</action>


 <action type="server">Sample - Ping-Interface</action>


 <action type="server">Sample - Ping-IP</action>


 .


 .


 .


 <consoleoperation>Browse</consoleoperation>


 <consoleoperation>BrowseDetail</consoleoperation>


 <consoleoperation>ExpandMapNode</consoleoperation>


 <consoleoperation>ShowContainment</consoleoperation>


 .


 .


</userprofileconfig>
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Notification list (nl)
The nl is the name of notification list defined by the nlconfig element. Notification list (nlconfig) provides
additional information.


nl DTD description
There are no attributes associated with the timeout element. In the ics-config.dtd, the element is defined
as:


<!ELEMENT nl (#PCDATA)>


nl XML example


For example, in this user profile called UserProfile1 there is a notification list called NL1:


<userprofileconfig name="UserProfile1" enable="True" timestamp="0"> 


 <nl>NL1</nl> 


 <console>Console1</console> 


 <console>Console2</console> 


 <user>User1</user> 


 <user>User2</user> 


 <user>User3</user> 


 <action type="server">Action1</action> 


 <action type="client">Action1</action> 


</userprofileconfig>


nl semantics


When defining a user profile, you are required to provide a notification list. The nl subelement is required
and only one is allowed.


Console (console)
The console element is the name of an InCharge console file (by default, the file extension is *.iccon and
does not need to be typed in the declaration). The console files are located in BASEDIR/smarts/consoles
or BASEDIR/smarts/local/consoles.


console DTD description
There are no attributes associated with the console element. In the ics-config.dtd, the element is defined
as:


<!ELEMENT console (#PCDATA)>
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console XML example


For example, in this user profile called UserProfile1 there are two consoles called Console1 and
Console2:


<userprofileconfig name="UserProfile1" enable="True" timestamp="0"> 


 <nl>NL1</nl> 


 <console>Console1</console> 


 <console>Console2</console> 


 <user>User1</user> 


 <user>User2</user> 


 <user>User3</user> 


 <action type="server">Action1</action> 


 <action type="client">Action1</action> 


</userprofileconfig>


console semantics


The console subelement is required and multiple consoles are allowed.


User (user)
The user element is the name of user defined by the userconfig element. “User (userconfig)” on page 238
provides additional information.


user DTD description
There are no attributes associated with the user element. In the ics-config.dtd, the element is defined as:


<!ELEMENT user (#PCDATA)>


user XML example


For example, in this user profile called UserProfile1 there are three users called User1, User2, and User3:


<userprofileconfig name="UserProfile1" enable="True" timestamp="0"> 


 <nl>NL1</nl> 


 <console>Console1</console> 


 <console>Console2</console> 


 <user>User1</user> 


 <user>User2</user> 


 <user>User3</user> 


 <action type="server">Action1</action> 


 <action type="client">Action1</action> 


</userprofileconfig>


user semantics


This subelement is not required but if user(s) are not defined no user will access the profile.
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Tool/Action (action)
The action subelement refers to the name of a tool defined by the actionconfig element. “Tool/Action
(actionconfig)” on page 232 provides additional information. In addition to the name of the tool, you are
required to define the type of tool (server, client, or automatic).


action DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT action (#PCDATA)>


<!ATTLIST action


    type  (SERVER | CLIENT | AUTO | server | client | auto | 


        Server | Client | Auto)  #REQUIRED>


Attribute-list declarations for the actionconfig element identifies the attribute declarations for the
actionconfig element.


Table 16‑11.  Attribute-list declarations for the actionconfig element


XML attribute Description Possible value
Value required/
default value


type Indicates the classification of the tool:
n Server: tools executed on the same host


as the Global Manager. These are
displayed in the Tools menu on the Global
Console.


n Client: tools executed locally by the
console. These are displayed in the Tools
menu on the Global Console.


n Auto: tools executed automatically through
escalation policies or the automatic action
adapter (sm_adapter). These are not
visible in the tools menu on the Global
Console.


SERVER


Server


server


CLIENT


Client


client


AUTO


Auto


auto


Required


action XML example


For example, in this user profile called UserProfile there are two tools defined. The first is a server tool
called Action1 and the second is a client tool called Action1:


<userprofileconfig name="UserProfile1" enable="True" timestamp="0"> 


 <nl>NL1</nl> 


 <console>Console1</console> 


 <console>Console2</console> 


 <user>User1</user> 


 <user>User2</user> 
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 <user>User3</user> 


 <action type="server">Action1</action> 


 <action type="client">Action1</action> 


</userprofileconfig>


action semantics


If actions(s) are not defined, the user will have no tools available in the tools menu of the Global Console.
Multiple actions may be listed.


Console operation (consoleoperation)
The consoleoperation element is the list of console operations associated with a user profile.


consoleoperation DTD description
There are no attributes associated with the consoleoperation element. In the consoleoper-config.dtd, the
element is defined as:


<!ELEMENT consoleoperation (#PCDATA)>


consoleoperation XML example


The following example shows the console operations associated with the training-profile user profile:


<userprofileconfig name="training-profile" enable="True">


  <nl>Maintenance</nl>


   <console>NotificationLog</console>


   <user>User1</user>


  <consoleoperation>Browse</consoleoperation>


  <consoleoperation>BrowseDetail</consoleoperation>


  <consoleoperation>ExpandMapNode</consoleoperation>


  <consoleoperation>ShowContainment</consoleoperation>


</userprofileconfig>


Escalation policy (policyconfig)
An Escalation Policy is composed of a policy filter and one or more escalation paths. If a policy filter is not
defined, all notifications will be passed on to the paths for escalation.


policyconfig DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  policyconfig  (filterconfig | pathconfig)*> <!ATTLIST policyconfig


 name   CDATA    #REQUIRED 


    timestamp   CDATA          "0"


Attribute-list declarations for the policyconfig element identifies the attribute declarations and possible
values for the policyconfig element.
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Table 16‑12.  Attribute-list declarations for the policyconfig element


XML attribute Description Possible value
Value required/
default value


name A unique name for the escalation policy. CDATA Required.


timestamp When exporting, the value is the last time the
object was modified by any user through the
Administration Console or through sm_config.


When importing, the timestamp defined in the
XML file is compared with the timestamp of the
object in the repository. Modifications to an
existing object will fail when the import
timestamp is later than the existing repository
timestamp (unless the force option is used).


CDATA Not required.


Default is "0".


policyconfig XML example


This XML sample describes a policy called Policy-Host The expression filter indicates that all notifications
pertaining to the ICIM class of Host will be entered into the policy.


There is one escalation path defined called path1. An expression filter at the path level determines that
only notifications with a Trouble Ticket ID are escalated.


The escalation actions open a trouble ticket for the notification after 60 minutes, then follows up with an
email after another 30 minutes:


<policyconfig name="Policy-Host" timestamp="0">


 <filterconfig type="EXPRESSION">


  <isa>ICIM_Notification</isa>


  <criterion attribute="ClassName">Host</criterion>


 </filterconfig>


 <pathconfig enable="TRUE" name="path1" retire="FALSE"> 


  <retireTime>0</retireTime> <enableTime>0</enableTime> 


  <filterconfig type="EXPRESSION"> 


   <isa>ICIM_Notification</isa> 


   <criterion attribute="TroubleTicketID"> </criterion> 


  </filterconfig> <escalationlevel interval="1800" level="0"> 


  </escalationlevel> <escalationlevel interval="900" level="1"> 


  <action type="auto">Open Trouble Ticket</action> 


  </escalationlevel> <escalationlevel interval="900" level="2"> 


  <action type="auto">Email Manager</action> </escalationlevel> 


 </pathconfig> 


</policyconfig>


Filter (filterconfig)
The filterconfig element within the policyconfig element is the filter on the entire policy. This filter
determines which notifications enter into the policy.
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The filterconfig element within the pathconfig element is a filter on the escalation path. Notifications that
enter the policy are filtered again to determine the path on which they will escalate.


Filter (filterconfig) provides filter element details.


Escalation path (pathconfig)
You may have multiple escalation paths within an escalation policy.


pathconfig DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  pathconfig  (filterconfig | retireTime | enableTime | escalationlevel)*> <!ATTLIST 


pathconfig


 name   CDATA  #REQUIRED 


    enable   (TRUE | FALSE | true | false | True | False) "False" 


    retire     (TRUE | FALSE | true | false | True | False) "False" >


Attribute-list declarations for the pathconfig element identifies the attribute declarations and possible
values for the pathconfig element.


Table 16‑13.  Attribute-list declarations for the pathconfig element


XML attribute Description Possible value
Value required/
default value


name A unique name for the escalation path. CDATA Required.


enable Indicates whether the escalation path should
be enabled when imported into the
Global Manager or whether it was enabled at
the time of export.


TRUE


True


true


FALSE


False


false


Not Required.


Default is “False”.


retire Indicates whether the escalation path should
be retired when imported into the
Global Manager or whether it was retired at the
time of export


TRUE


True


true


FALSE


False


false


Not Required.


Default is “False”.


pathconfig XML example


For example, this XML sample defines an escalation path called “Path1:”


<pathconfig enable="TRUE" name="path1" retire="FALSE"> 


 <retireTime>0</retireTime> 


 <enableTime>0</enableTime> 


 <filterconfig type="EXPRESSION"> 


  <isa>ICIM_Notification</isa> 
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  <criterion attribute="TroubleTicketID"> </criterion> 


 </filterconfig> <escalationlevel interval="1800"


 level="0"> 


</pathconfig>


Retire time (retireTime)
This is the time interval, in seconds, for which an escalation path is retired.


retireTime DTD description
There are no attributes associated with the user element. In the ics-config.dtd, the element is defined as:


<!ELEMENT retireTime (#PCDATA)>


retireTime XML example


For example, this XML sample defines an escalation path called Path1 with a retireTime of 5 minutes
(300 seconds):


<pathconfig enable="TRUE" name="path1" retire="FALSE"> 


 <retireTime>300</retireTime> 


 <enableTime>0</enableTime> 


 <filterconfig type="EXPRESSION"> 


  <isa>ICIM_Notification</isa> 


  <criterion attribute="TroubleTicketID"> </criterion> 


 </filterconfig> 


<escalationlevel interval="1800" level="0"> 


Enable time (enableTime)
This is the duration for an escalation path that is retired.


enableTime DTD description
There are no attributes associated with the user element. In the ics-config.dtd, the element is defined as:


<!ELEMENT enableTime (#PCDATA)>


enabletime XML example


For example, this XML sample defines an escalation path called “Path1” with an enable interval of 15
minutes (900 seconds):


<pathconfig enable="TRUE" name="path1" retire="FALSE"> 


 <retireTime>0</retireTime> 


 <enableTime>900</enableTime> 


 <filterconfig type="EXPRESSION"> 
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  <isa>ICIM_Notification</isa> 


  <criterion attribute="TroubleTicketID"> </criterion> 


 </filterconfig> 


<escalationlevel interval="1800" level="0"> 


Escalation level (escalationlevel)
Each Escalation Level includes a set of automatic tools to invoke and a time duration before a notification
advances to the next level. As time progresses, a notification escalates to different levels in the path
based on the level duration, and invokes tools to handle the notification.


escalationlevel DTD description
In the ics-config.dtd, the element is defined as:


<!ELEMENT  escalationlevel (action)*>


<!ATTLIST escalationlevel


 level      CDATA    #REQUIRED  


    interval   CDATA    #REQUIRED >


Attribute-list declarations for the escalationlevel element identifies the attribute declarations and possible
values for the escalationlevel element.


Table 16‑14.  Attribute-list declarations for the escalationlevel element


XML attribute Description Possible value
Value required/
default value


level Level indicates the order of the level. Levels
must be consecutive numbers beginning with
“0”.


CDATA


(0-5)


Required.


interval The duration of time the notification spends in a
level before going on to next level. This includes
the time it takes to invoke the action at this level.


CDATA


(in seconds)


Required.


escalationlevel XML example


For example, this sample defines two escalation levels:


n Level 0 will open a trouble ticket after a duration of 15 minutes (900 seconds)


n Level 1 will email a manager after a second duration of 15 minutes (900 seconds)


  </escalationlevel> <escalationlevel interval="900" level="0"> 


   <action type="auto">Open Trouble Ticket</action> 


  </escalationlevel> <escalationlevel interval="900" level="1"> 


   <action type="auto">Email Manager</action> 


  </escalationlevel>  


escalationlevel semantics


You can specify that no tools are invoked at a level, but the duration cannot be less than 1 minute.
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Map icon configuration
Custom map icons can also be configured using the XML interface. The specification for map icons has
its own DTD, map-config.dtd, which is located in the BASEDIR/smarts/conf/maps directory.


The map-config.dtd defines the mapgifconfig element.


mapgifconfig element
The mapgifconfig element is the root element of the map-config.dtd. It defines the subelements that
specify the configuration for a map icon.


mapgifconfig DTD description
In the map-config.dtd, the element is defined as:


<!ELEMENT  map_gifconfig  (map | repos | image)*>


The map element is not currently used.


repos element
The repos element specifies a map configuration:


<!ELEMENT repos (#PCDATA)>


<!ATTLIST repos


  class  CDATA   #REQUIRED


  class (String | Boolean | Time | Integer | Float | Percentage )  "String"


>


Attribute-list declarations for the map element identifies the attribute declarations for the map element.


Table 16‑15.  Attribute-list declarations for the map element


XML attribute Description Possible value
Value required/
default value


class The name of the ICIM class that the icon will
represent.


CDATA


(string)


Required.


class The instance name of the ICIM class. If instance
name is specified, the image/gif will be applied
for that particular instance, otherwise "*"
indicates that the image/gif is applied to all
instances of that class.


String


Boolean


Time


Integer


Float


Percentage


Not required.


Default is "String" so the
column heading text must
be defined.
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repos XML example


The following example specifies a map icon for the DatabaseServer ICIM class:


<map_gifconfig>


    <repos class="DatabaseServer">*</repos>


    <image>DatabaseServer</image>


</map_gifconfig>


image element
The image element specifies the name of the icon file, it has no attributes. The icon file must be of GIF
format. It is not necessary to specify a filename extension such as .gif. The icon file must be located in the
BASEDIR/smarts/local/conf/icons directory.


image XML example


The following example specifies the DatabaseServer image for the specified class:


<map_gifconfig>


    <repos class="DatabaseServer">*</repos>


    <image>DatabaseServer</image>


</map_gifconfig>


Global Manager configuration DTDs
The following DTDs identify the XML elements, attributes, and values for Global Manager configuration.


ics-config.dtd
The ics-config.dtd is located in the BASEDIR/smarts/conf/ics directory:


<?xml encoding="ISO-8859-1"?>


<!ELEMENT ics_config (nlconfig | actionconfig | userprofileconfig | userconfig | policyconfig | 


consoleoperationconfig | consoleoperationgroupconfig | map_gifconfig)*>


<!ELEMENT  nlconfig  (filterconfig | columnheading | userprofile)*>


<!ATTLIST nlconfig


 name   CDATA    #REQUIRED 


    enable  (TRUE | FALSE | true | false | True | False) "TRUE" 


    timestamp   CDATA          "0"


>


<!ELEMENT columnheading (#PCDATA)>


<!ATTLIST columnheading


 column  CDATA   #REQUIRED


 column  (String | Boolean | Time | Integer | Float | Percentage )      "String"


>


<!ELEMENT userprofile (#PCDATA)>


<!ELEMENT  userprofileconfig (nl | console | user | action | consoleoperation)*>


<!ATTLIST userprofileconfig
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 name   CDATA    #REQUIRED 


    enable  (TRUE | FALSE | true | false | True | False) "TRUE"


    timestamp   CDATA          "0"


>


<!ELEMENT nl (#PCDATA)>


<!ELEMENT user (#PCDATA)>


<!ELEMENT action (#PCDATA)>


<!ATTLIST action


    type  (SERVER | CLIENT | AUTO | server | client | auto | Server | Client | Auto)  #REQUIRED


>


<!ELEMENT console (#PCDATA)>


<!ELEMENT  userconfig (userprofile)*>


<!ATTLIST userconfig


 name   CDATA    #REQUIRED 


    enable  (TRUE | FALSE | true | false | True | False) "TRUE"


    timestamp   CDATA          "0"


>


<!ELEMENT  actionconfig (program_name | timeout? | trace | display | status_criteria? | 


context_criteria | user_prompts? | userprofile)*>


<!ATTLIST actionconfig


 name   CDATA     #REQUIRED 


    enable  (TRUE | FALSE | true | false | True | False) "TRUE" 


    type  (SERVER | CLIENT | AUTO | server | client | auto | Server | Client | Auto) #REQUIRED


    timestamp   CDATA          "0"


>


<!ELEMENT trace EMPTY>


<!ATTLIST trace


    trace_value  (FALSE | TRUE | true | false | True | False) "FALSE"


>


<!ELEMENT display EMPTY>


<!ATTLIST display


    display_value  (FALSE | TRUE | true | false | True | False) "TRUE"


>


<!ELEMENT program_name (#PCDATA)>


<!ELEMENT timeout (#PCDATA)>


<!-- Note: user prompts are only allowed on server-side actions -->


<!ELEMENT user_prompts (one_prompt*)>


<!ELEMENT one_prompt (#PCDATA)>


<!ATTLIST one_prompt name CDATA #REQUIRED>


<!ELEMENT status_criteria  (filterconfig?)>


<!ELEMENT context_criteria  (filterconfig?)>


<!ELEMENT  filterconfig (isa?, (criterion* | filename))>


<!ATTLIST filterconfig


 type  (ASL | EXPRESSION | asl | expression | Expression)  #REQUIRED  


    enable  (TRUE | FALSE | true | false | True | False)      "TRUE"


>


<!ELEMENT isa  (#PCDATA)>


<!ELEMENT filename (#PCDATA)>


<!ELEMENT criterion (#PCDATA)>


<!ATTLIST criterion


 attribute  CDATA   #REQUIRED


>


<!ELEMENT  policyconfig  (filterconfig | pathconfig)*>


<!ATTLIST policyconfig


 name   CDATA    #REQUIRED 
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    timestamp   CDATA          "0"


>


<!ELEMENT  pathconfig  (filterconfig | retireTime | enableTime | escalationlevel)*>


<!ATTLIST pathconfig


 name   CDATA    #REQUIRED 


    enable  (TRUE | FALSE | true | false | True | False) "False" 


    retire     (TRUE | FALSE | true | false | True | False) "False" 


>


<!ELEMENT retireTime (#PCDATA)>


<!ELEMENT enableTime (#PCDATA)>


<!ELEMENT  escalationlevel (action)*>


<!ATTLIST escalationlevel


 level      CDATA    #REQUIRED  


    interval   CDATA    #REQUIRED 


>


<!ENTITY % consoleoper-config SYSTEM "consoleoper-config.dtd">


&consoleoper-config;


<!ENTITY % map-config SYSTEM "../maps/map-config.dtd">


%map-config;


consoleoper-config.dtd
The consoleoper-config.dtd is located in the BASEDIR/smarts/conf/ics directory:


<?xml encoding="ISO-8859-1"?>


<!ELEMENT consoleoperation (#PCDATA)>


<!ELEMENT consoleoperationconfig (#PCDATA)>


<!ATTLIST consoleoperationconfig 


    name CDATA #REQUIRED


    enable (TRUE | FALSE | true | false | True | False) "TRUE"


    timestamp CDATA "0"


>


<!ELEMENT consoleoperationgroupconfig (consoleoperation)*>


<!ATTLIST consoleoperationgroupconfig


    name CDATA #REQUIRED


    displayname CDATA ""


    template (TRUE | FALSE | true | false | True | False) "FALSE"


    enable (TRUE | FALSE | true | false | True | False) "TRUE"    


   timestamp CDATA "0" >


map-config.dtd
The map-config.dtd is located in the BASEDIR/smarts/conf/maps directory:


<?xml encoding="ISO-8859-1"?>


<!ELEMENT  map_gifconfig  (map | repos | image)*>


<!ELEMENT map (#PCDATA)>


<!ATTLIST map


 class  CDATA   #REQUIRED


 class  (String | Boolean | Time | Integer | Float | Percentage )  "String"


>


<!ELEMENT repos (#PCDATA)>
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<!ATTLIST repos


 class  CDATA   #REQUIRED


 class  (String | Boolean | Time | Integer | Float | Percentage )  "String"


>


<!ELEMENT image (#PCDATA)>
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Preface 1
As part of an effort to improve its product lines, VMware periodically releases revisions of its software and
hardware. Therefore, some functions described in this document might not be supported by all versions of
the software or hardware currently in use. The product release notes provide the most up-to-date
information on product features.


Contact your VMware technical support professional if a product does not function properly or does not
function as described in this document.


Note   This document was accurate at publication time. Go to VMware Online Support docs.vmware.com
to ensure that you are using the latest version of this document.


This chapter includes the following topics:


n Purpose


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n VMware Smart Assurance Service Assurance Manager


n Related documentation


n Suggestions for searching PDF files


n Conventions used in this document


n Pathname conventions


n Graphical conventions


n Manager


n Where to get help


n Your comments


Purpose
The VMware Smart Assurance Service Assurance Manager Operator Guide describes how to use the
Global Console to access event information and diagnostic results that the Service Assurance Global
Manager abstracted and consolidated from underlying domains.
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Audience
This guide is intended for administrators who are responsible for deploying, installing, and configuring the
Global Manager. IT managers who seek to understand the role of the Global Manager in the context of an
VMware Smart Assurance solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should also read the
VMware Smart Assurance Service Assurance Manager Deployment Guide and the
VMware Smart Assurance System Administration Guide Guide.


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<productsuite>.


n For example, on UNIX operating systems, VMware Smart Assurance Service Assurance Manager is,
by default, installed to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than /opt/InCharge (on UNIX)
but you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.


VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System


n Global Console


n Business Dashboard


n Companion UI


n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)


n VMware Smart Assurance Adapter for UIM/O


n XML Adapter
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Related documentation
In addition to this document, VMware Corporation provides a help system for command line programs as
well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


n VMware Smart Assurance Common Information Model (ICIM) 1.11 Reference for Non-Service
Assurance Manager Products


n VMware Smart Assurance Common Information Model (ICIM) Reference for Service Assurance
Manager


n VMware Smart Assurance Foundation Documentation Portfolio


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ASL Reference Guide


n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide


VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes


n VMware Smart Assurance Open Source License and Copyright Information


n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


n VMware Smart Assurance Service Assurance Manager Deployment Guide


n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide
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n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide


n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance Companion UI Open Source License and Copyright Information for GPLv3
as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1 If the documentation is not accessible to all users of the VMware Smart Assurance product, copy the
contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a shared drive on
your LAN, so that operators and others can view the documentation.


2 To search throughout the documentation library, open the Acrobat Reader software:


3 Select Edit > Search, and type a word or phrase.


4 Select All PDF Documents in, in the Where would you like to search option, and type the
pathname of the location where the PDF documents reside.


If you have more than one VMware Smart Assurance product installed, you can set up cross-product
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each product into
this common documentation directory path.


Conventions used in this document
VMware uses the following convention for special notices:


Note   NOTICE is used to address practices not related to personal injury.
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Typographical conventions
VMware uses the following type style conventions in this document:


Bold Use for names of interface elements


Italic Use for full titles of publications referenced in text


Monospace
Use for:
n System output, such as an error message or script
n System code
n Pathnames, filenames, prompts, and syntax
n Commands and options


                      
  Monospace italic
                     


Use for variables.


                      
  Monospace bold
                     


Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example


Pathname conventions
Directory pathnames are shown with forward slashes (/).


Graphical conventions
Under UNIX, the consoles appear with slight differences. For example, in views that display items in a
tree hierarchy such as the Topology Browser an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to VMware Smart Assurance programs
such as Domain Managers, Global Managers, and adapters.


Where to get help
VMware support, product, and licensing information can be obtained as follows:


Product information
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For documentation, release notes, software updates, or information about VMware products, go to
VMware Online Support at:


docs.vmware.com


Technical support


Go to VMware Online Support. You will see several options for contacting VMware Technical Support.
Note that to open a service request, you must have a valid support agreement. Contact your VMware
sales representative for details about obtaining a valid support agreement or with questions about your
account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:docs.vmware.com.
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Introduction 2
This guide is intended for operators who are responsible for acting upon the failures reported by the
VMware Smart Assurance Service Assurance Manager( Service Assurance) product.


This chapter includes the following topics:


n Overview


n Notification concepts


n Global Console overview


n Watch4net


Overview
In a typical Operations center, there are several operators who may perform monitoring duties and assist
with or perform problem resolution. In order to perform their duties, operators need information about their
managed domains and the events that occur. For example, they may need information about topological
relationships, sources of notifications, and how the events affect other infrastructure devices.


Note   Console access is controlled by the user profile that is associated with a user account. Therefore,
users might have access to different types of consoles and console operations. For example, a user might
be able to browse for details but not be able to acknowledge a notification or add a view to a console.
Also, certain features are controlled by your VMware Smart Assurance license. The
VMware Smart Assurance Service Assurance Manager Configuration Guide provides additional console
operations information.


Using the Global Console, an operator with access to the appropriate console operations can:


n Investigate topological information, including detailed information about an element’s internal
components. Topological information is presented in a topological tree format and map
representations.


n Monitor notifications and identify the causes of each failure and systems that the failure affects.


n Respond to notifications. For example, operators can take ownership of notifications, open trouble
tickets, or ping a device.
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n Save information, print information, and record tracking comments in notification audit logs.


In addition, users can perform administrative tasks such as configuring Global Managers and
managing underlying Domain Managers if they have administrative privileges and access to those
console operations.


If you have installed Watch4net 6.2 along with Service Assurance Manager 9.2, you can access
various console components from within Watch4net. For more information on installing and
configuring Watch4net, refer to the
VMware Smart Assurance SolutionPack Installation and Configuration Guide.


Global Console overview on page 20 contains a discussion of the layout and features of the
Global Console. Notification concepts on page 19 includes a general discussion of notifications.


Notification concepts
Service Assurance notifications are generated when abnormal conditions occur in your underlying
managed domains. The underlying domains, such as VMware Smart Assurance IP Availability Manager
and VMware Smart Assurance IP Performance Manager, pass the notifications and any relevant event or
topological information to the Service Assurance Global Manager. The Global Manager, in turn,
consolidates, abstracts, and passes the notifications to clients such as the Global Console or adapters.


Notifications are objects in the Global Manager or Adapter Platform. Notifications represent the events
received from Domain Managers, adapters, or other underlying sources or notifications received from
Global Managers or Adapter Platforms. Each notification consists of a set of attributes that describe
properties of the notification, such as the severity of the notification and a textual description of the event.
(Notification Log columns contains a list of visible attributes.)


A notification list configured by your administrator determines which notifications appear in your console
and are reflected in a map. Your administrator can use special filters to organize notifications by some
useful criteria and then associate the filtered list with your user profile. As a result, your console may
display all or a subset of possible notifications. As an operator, you can further refine your display by
setting additional filters provided as console options.


The severity of notifications is reflected in severity icons, color-coded rows and indicator bars underneath
map icons. “About notifications” on page 56 and “Displaying notification properties” on page 62 contains a
description of notifications, severity icons, their color coding, and how to display their properties.
“Representing notifications in maps” on page 88 includes a description of map icons and their color
coding.


Note   If a notification list does not include an event, notifications for the event will not appear in your
console or be reflected in the map icons. For example, if a notification list excludes all events from a
specific router, the router always appears with a normal state in the map. (If your console does not
accurately reflect observed conditions, contact your administrator.)
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Service Assurance information is archived at time intervals specified by the administrator and can be
viewed later using a text editor. The archives include notifications that are acknowledged and their related
audit logs. Once notifications are archived, they no longer display in the Global Console. The
VMware Smart Assurance Service Assurance Manager Configuration Guide includes information about
archival parameters and the archived files.


Service Assurance notifications
Most of the notifications that appear in the Global Console are generated by underlying Managers.
However, the Global Manager will generate a Session Disconnected notification when an underlying
Manager disconnects from it. Also, if Business Impact Manager is deployed, the Global Manager will
generate business impact notifications. Chapter 11 Troubleshooting includes information about
disconnect situations. The VMware Smart Assurance Business Impact Manager User Guide includes
information about business impact notifications.


Detailed descriptions of diagnostic results for specific VMware Smart Assurance applications like
VMware Smart Assurance IP Availability Manager, VMware Smart Assurance IP Performance Manager,
and VMware Smart Assurance IP Discovery Manager are described in their respective user guides.


Types of managers
Depending upon your Service Assurance deployment, a Global Manager can be: a Service Assurance
Global Manager or SAM Adapter Platform.


A Domain Manager can be: an IP Availability Manager, IP Performance Manager, Discovery Manager, or
Application Connectivity Monitor Manager.


The term Manager refers to either a Global Manager or Domain Manager.


Global Console overview
The Global Console is a collection of consoles:


n The Notification Log Console presents notifications in tabular format.


From the Notification Log Console for a selected notification, you can also open the Notification
Properties workspace in a browser. The workspace may contain one or more apps that provide
detailed information about the notification. Online help in the Companion UI provides complete
information about the available apps and features.


n The Map Console graphically represents your topology in a map format. In the map, icons change
color when they are affected by one or more abnormal conditions.


n The Topology Browser Console represents the topology in a hierarchical format and provides
topological information.


n The Summary View Console represents overviews or summaries of notifications organized by
meaningful criteria.
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n The Status Table Console represents the status of underlying infrastructure elements as they affect
the collection objects (ServiceOffering, ServiceSubscriber, or any group created by your
administrator) specified in the Status Table.


n The Web Console provides Global Console functionality in a standard web browser.


n The Domain Manager Administration Console enables administrators to discover topology and
manage underlying Domain Managers.


The VMware Smart Assurance IP Manager Concepts Guide contains information about discovery.
Information about polling and thresholds accessed by the Domain Manager Administration Console
for specific VMware Smart Assurance applications is provided in their respective user guides.


n The Global Manager Administration Console enables administrators to configure Global Managers.


The VMware Smart Assurance Service Assurance Manager Configuration Guide includes information
about the Global Manager Administration Console.


n The Topology Builder Console enables administrators to modify and refine the topology stored in the
VMware Smart Assurance repository.


This console is available if Business Impact Manager is deployed. The
VMware Smart Assurance Business Impact Manager User Guide includes information about the
Topology Builder Console.


The following consoles display information from or manage:


n Global Managers — A Notification Log Console, Map Console, Summary Console, Status Table
Console, Global Manager Administration Console, Topology Builder Console for Business Impact
Manager, and views.


n Domain Managers — A Domain Manager Administration Console.


A Topology Browser Console or view can display information from Global Managers and Domain
Managers.


After you log in, one or more consoles appear, depending upon your user profile. For example, if your
user profile is configured for the Notification Log Console and Map Console, then two consoles will
appear after you log in. Since Domain Managers do not maintain user profiles, if you log in to a
Domain Manager, the Topology Browser Console appears first.


You can also customize a console for your operational needs, save it, and continue to use it. For
example, you can add one or more views to a console.


The layout of each console, including menu options and toolbar buttons, is briefly described in the
subsequent sections. More complete information about individual menu options is provided in
subsequent chapters. Menu options and toolbar buttons might be disabled or not appear if you do not
have access to those console operations.
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Tool tips are available for each console. A tool tip provides information about console components,
notifications, map icons, and summaries. To activate a tool tip, hold the cursor over the object. For
example, in the Topology View topology tree, if you hold the cursor over a Global Manager, the tool tip
provides the IP address and port number. If the text in an attribute field of the Notification Log is
truncated, the full text is displayed in the tool tip.


The status bar for each console displays status Ready for example, and the following information:


n For a locally saved console, the directory path and its filename.


n For a remotely saved console, the Manager or IP address where it is saved, username, and the
console name.


If you logged in using a default user profile, the console name Notification Log appears unless the
name has been modified by an administrator.


n For an unsaved console, the text "Not saved" appears.


To quickly open menus in the consoles, press Alt + underlined character. For example, to open the
File menu, press Alt + F.


View concepts
VMware Smart Assurance information is displayed in the following views:


n Notification Log


n Map


n Topology Browser


n Summary View


n Status Table


n Notification Properties


n Containment


Depending on your VMware Smart Assurance deployment, you will see these views in a Global
Console window, Web Console window (available through a Web Browser), in a Business Dashboard
configured by your administrator, or in a third-party Web Portal product.


You or your administrator can configure views to display certain information, for example, by applying
filters. These views can be saved and associated with user accounts and user profiles. Views that are
saved in HTML (as Java applets) for display in web browsers are called dashboard viewlets.
Dashboard viewlets are available when the VMware Smart Assurance Business Dashboard is
installed.


You can display more than one view in a Global Console window. For example, if you wish, you can
include a Notification Log view along with a Map and a Status Table in a console. “Tailoring your
console with views” on page 158 includes additional information about managing view display.


In a view, to perform actions such as saving or deleting, or to access menu options, you need to
activate the view. To do so, click anywhere in the view. The active view has a black border.
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Availability of Dashboard viewlets
Generally, views that are available for the Global Console are available for the Web Console (as views),
Business Dashboard (as dashboard viewlets), and third-party Web Portal products (as dashboard
viewlets). Table 1 on page 22 indicates which views can be implemented as dashboard viewlets.


Table 2‑1.  View availability


Views Available as Dashboard viewlets?


Notification Log view Yes


Map Yes


Summary view Yes


Status Table view Yes


Notification Properties view Yes


Containment view Yes


Topology Browser view No


Layout of a Notification Log Console
The Notification Log Console is designed specifically for viewing notifications. It consists of one view, the
Notification Log view. Figure 1 on page 23 illustrates one example of a Notification Log Console for an
administrator. Your Notification Log Console may look slightly different.


Notification Log menus and shortcut menus summarizes menu options for the Notification Log Console. 
Notification Log Console toolbar buttons summarizes toolbar buttons.


The notification list configured by your administrator is included in the title of the Notification Log view. For
example, the title "Notification Log - Default" identifies a notification list named Default.


The Manager menu lists attached Global Managers. You can view notifications for a different attached
Global Manager by selecting it from the menu. Domain Managers are not listed in the menu.


The notification legend and icons in the Severity column provide the color indicators that reflect the
notifications’ severity.


You can also customize the Notification Log view with a filter. The filter enables you to select attributes
and specify wildcard characters to control which notifications appear in the view.


Figure 1 on page 23 provides an example of a Notification Log Console for an administrator.
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Figure 2‑1.  Notification Log Console for an administrator


Notification Log menus and shortcut menus
Table 2 on page 24 summarizes the menus that are available for the Notification Log Console or view.
The two menu items, Event and Log, are specific to the Notification Log. The Configure menu is displayed
depending on your user access control privileges.


Table 2‑2.  Notification Log menus and their options


Menu Option Description


File New Opens a new console.


Open Opens an existing console, locally saved or remotely saved.


Close Closes an individual console.


Save Saves an unsaved console on a local or remote host. Saves a saved
console to a previously-specified destination.


Save As Saves a console on a local or remote host.


Layout Arranges multiple views in a console and changes console title.


Exit Ends the session and closes all consoles.


Edit Find Instance Searches for any topological element in any class including application
services, service offerings, service subscribers, and systems.


Find System Searches for a system (infrastructure element).


Recipients Opens the Recipient Editor dialog box for email or pager tools.


View Java Console Displays console debugging information, including store exceptions,
errors reading attributes, and stack traces.


Message Log Displays communications sent from a Manager to the console.


Toolbar Toggles the display of the toolbar buttons.


Status Toggles the display of the status bar.


Add View Inserts a view in the current console.
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Table 2‑2.  Notification Log menus and their options (Continued)


Menu Option Description


Copy View Copies a view in the current console or to another new console.


Save View As dashboard
Viewlet


Saves a view as a dashboard viewlet for the Web pages or third-party
Web Portal products; Business Dashboard must be installed.


Delete View Removes a view from the current console.


Listen to Context Configures a view for context sharing.


Refresh Redisplays the console.


Manager Attach Connects to a Manager.


Detach Disconnects from a Manager.


Configure Groups Creates groups or child groups of infrastructure elements. The
VMware Smart Assurance Service Assurance Manager Configuration
Guide includes information about creating groups.


Global Manager
Administration Console


Opens a Global Manager Administration Console for configuring
Global Managers.


Domain Manager
Administration Console


Opens a Domain Manager Administration Console for managing
underlying Domain Managers.


Topology Builder Opens a Topology Builder Console. The
VMware Smart Assurance Business Impact Manager User Guide
includes information about the Topology Builder Console.


Event Companion UI Opens the Notification Properties workspace in a browser for a
selected notification. The workspace may contain one or more apps
that provide detailed information about the notification.


The
VMware Smart Assurance SolutionPack Installation and Configuration
Guide provides configuration information for the
VMware Smart Assurance Companion UI.


Properties Displays notification properties for a selected notification.


Acknowledge Acknowledges a selected notification.


Unacknowledge Removes acknowledgement.


Take Ownership Assigns a username to a selected notification for problem resolution.


Release Ownership Removes a username.


Add to Audit Log Adds comment entries to notification audit log.


Audit Log Opens the audit log.


Browse Opens the Topology Browser view for the current Global Manager that
contains the selected element in a secondary window.


Browse Detail Opens the Topology Browser view for the underlying Manager that
contains the selected element in a secondary window.


Containment Displays an element’s components.


Show Map Opens the Map Console in a secondary window.


Mail Opens the email tool for a selected notification.
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Table 2‑2.  Notification Log menus and their options (Continued)


Menu Option Description


Page Opens the pager message tool for a selected notification.


Log Select Columns Controls which columns are displayed in the Notification Log view.


Save log contents to file Saves the contents of the Notification Log view locally as a text file.


Sort Columns Sorts columns in the Notification Log view.


Filter Specifies a filter for the Notification Log view.


Log Properties Changes the title of the Notification Log view and specifies continuous
or scheduled display updates of notifications.


Freeze Display Stops the display from changing in the Notification Log view.


Help About Global Console Lists Global Console information: version, contact, and outsourcing
information.


Shortcut menus are also available when you right-click on selected entities. Table 3 on page 26
summarizes the options and selection criteria.


Table 2‑3.  Notification Log shortcut menus


Selection criteria Option Shortcut menu options


Right-click on or near the
view title


Same as Log menu options.


For a Notification Log view launched from a summary, only the Select Columns option is available.


Right-click a column
heading


Hide Column Hides a column from display.


Insert Column Inserts a column to the left of the selected column.


Right-click a notification Same as Event menu options with the addition of maintenance tracking options, if enabled:
Schedule Maintenance and Repair Time.


Plus, the Server Tools and Client Tools options for tools if they are enabled. The
VMware Smart Assurance Service Assurance Manager Configuration Guide includes information on
configuring tools.


Notification Log Console toolbar buttons
In the Notification Log Console, certain menu options are provided as toolbar buttons. They are
summarized in Table 4 on page 27.


Button Description


Opens a local console.


Saves an unsaved console on a local or remote host. Saves a saved console to a previously-
specified destination.


Displays the Select Context(s) To Listen To dialog box for configuring context sharing.
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Opens a browser for reporting. The VMware Smart Assurance Report Manager User Guide
includes additional information.


Displays the Notification Properties dialog box for a selected notification.


Acknowledges an active, selected notification.


Displays the Map Console for selected notification.


Layout of a Map Console
The Map Console is designed specifically for viewing maps. When you open the Map Console (see 
Figure 2 on page 29), it consists of two panels.


Left panel
In the left panel, you can select a Global Manager from the Manager menu to see maps for that manager.
The menu lists attached Global Managers. Domain Managers are not listed in the menu.


At the bottom of the left panel are two tabs:


n The Topology tab displays a map tree that is a hierarchical representation of the attached Global
Managers, classes of infrastructure elements, logical groups such as IP networks and VLANs,
business services, software services, and the instances available for each class.


n The Groups tab displays user-defined groups of topological elements if the groups exist. (Your
administrator can create groups. The
VMware Smart Assurance Service Assurance Manager Configuration Guide includes information on
groups.)


Different types of maps are available for the instances in each tab.


Right panel
The right panel displays the map. After you select an instance from the expanded map tree, the map
displays and the selected device is surrounded by a blue box. Alternatively, if you used the Show Map
option for a selected notification, this panel shows a map containing your selection.


Map menus and shortcut menus summarizes menu options for the Map Console. Map Console toolbar
buttons summarizes toolbar buttons specific to the Map Console.


The left arrowhead on the panel divider hides the map tree and enlarges the right panel for a larger
display area. The right arrowhead on the panel divider unhides or enlarges the map tree.


Indicators, at the top of the right panel, show if coloring by root cause is enabled and the map’s layout
type. “Adjusting the appearance of a map” on page 94 includes additional information.


A history field list box lists the current map (instance and map type) and other recently viewed maps.


VMware Smart Assurance Service Assurance Manager Operator Guide


VMware, Inc.  21







The map legend provides a list of map elements and color indicators. To view the legend, select Map >
Map Legend.


You can customize individual maps with a map filter. The filter enables you to add and remove classes
from a map.


Note   You can customize the font and point size of the map icon text. The default map icon font is
Helvetica. The default map icon font size is 12 point. The font and font size can be modified by changing
the com.smarts.mapNodeText.font and the con.smarts.mapNodeText.fontsize properties. “Adjusting Java
properties” on page 151 provides detailed information.


Figure 2 on page 29 displays an example of a Physical Connectivity map.


Figure 2‑2.  Map Console


Map menus and shortcut menus
Table 5 on page 30 summarizes the menus that are available for the Map Console. Two menus, Layout
and Map, are specific to the Map Console. The Configure menu is displayed depending on your user
access control privileges.


Table 2‑5.  Map menus and their options


Menu Option Description


File New Opens a new console.


Open Opens an existing console, locally saved or remotely saved.


Close Closes an individual console.


Save Saves an unsaved console on a local or remote host. Saves a saved
console to a previously specified destination.


Save As Saves a console on a local or remote host.
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Table 2‑5.  Map menus and their options (Continued)


Menu Option Description


Layout Arranges multiple views in a console and changes console title.


Exit Ends the session and closes all consoles.


Edit Find Instance Searches for any topological element in any class including application
services, service offerings, service subscribers, and systems.


Find System Searches for a system (infrastructure element).


View Java Console Displays console debugging information, including store exceptions,
errors reading attributes, and stack traces.


Message Log Displays communications sent from a Manager to the console.


Toolbar Toggles the display of the toolbar buttons.


Status Toggles the display of the status bar.


Add View Inserts a view in the current console.


Copy View Copies a view in the current console or to another new console.


Delete View Removes a view from the current console.


Listen to Context Configures a view for context sharing.


Refresh Redisplays the console.


Manager Attach Connects to a Manager.


Detach Disconnects from a Manager.


Layout Circular Layout Displays circular layout of a map.


Hierarchical Layout Displays hierarchical layout of a map.


Organize Displays layout based on internal logic.


Note   For a Multiprotocol Label Switching (MPLS) VPN map.


Orthogonal Layout Displays orthogonal layout of a map.


Manual Layout Enables manual positioning of nodes in a map.


Fit in Window Fits the map to the size of the right panel.


Map Save Map Saves an individual map.


Edit Map Filter Specifies a filter for a map.


Expand Map Element Expands one or more individual nodes or elements.


Increment Hops Expands an entire map by one hop.


Decrement Hops Decreases an entire map by one hop.


Map Legend Displays a list of map icons and colors.


Print Map Prints a map.


Overview Opens the Overview window for magnification.


Reset Map Resets changes made to a map or returns to the saved map.


Set Background Specifies a user-defined background image for a map.
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Table 2‑5.  Map menus and their options (Continued)


Menu Option Description


Node Labels For Network Protocol Manager (NPM) maps, enables the display of
labels for routers.


Align nodes to grid Aligns nodes to the grid.


Grid options Displays map grid options.


Configure Groups Creates groups or child groups of infrastructure elements. The
VMware Smart Assurance Service Assurance Manager Configuration
Guide contains information about creating groups.


Global Manager
Administration Console


Opens a Global Manager Administration Console for configuring
Global Managers.


Domain Manager
Administration Console


Opens a Domain Manager Administration Console for managing
underlying Domain Managers.


Topology Builder Opens a Topology Builder Console. The
VMware Smart Assurance Business Impact Manager User Guide and
the VMware Smart Assurance Application Services Manager
Discovery Guide contains information about the Topology Builder
Console.


Edit Map Icons Assigns custom icons for a class or an instance.


Help About Global Console Lists Global Console information: version, contact, and outsourcing
information.


Shortcut menus are also available when you right-click on selected entities. Table 6 on page 32
summarizes the options and selection criteria.


Table 2‑6.  Map shortcut menus


Selection criteria Option Description


Right-click an instance in
the Topology tab


Available maps for display Available maps depend upon the selected instance.


Note   “Types of maps” on page 90 includes additional information.


Browse Opens the Topology Browser view for the current Global Manager
that contains the selected element in a secondary window.


Browse Detail Opens the Topology Browser view for the underlying Manager that
contains the selected element in a secondary window.


Containment Displays an element’s components.


Edit Map Icons Assigns custom icons for a class or an instance.


Server Tools Displays a list of server tools if enabled.


Client Tools Displays a list of client tools if enabled.


Right-click an instance in
the Groups tab


Available maps for display Available maps depend upon the selected instance.


Note   “Types of maps” on page 90 includes additional information.


Right-click in the
background of a map


Circular Layout Displays circular layout of a map.


Manual Layout Enables manual positioning of nodes in a map.
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Table 2‑6.  Map shortcut menus (Continued)


Selection criteria Option Description


Hierarchical Layout Displays hierarchical layout of a map.


Orthogonal Layout Displays orthogonal layout of a map.


Organize For a Multiprotocol Label Switching (MPLS) VPN map, displays
layout based on internal logic.


Fit in Window Fits the map to the size of the right panel.


Increment Hops Expands an entire map by one hop.


Decrement Hops Decreases an entire map by one hop.


Reset Map Resets changes made to a map or returns to the saved map.


Edit Map Icons Assigns custom icons for a class or an instance.


Set Background Specifies a user-defined background for maps.


Align nodes to grid Aligns nodes to the grid.


Grid options Displays map grid options.


Right-click a selected
node in a map


Available maps for display Available maps depend upon the selected instance.


Note   “Types of maps” on page 90 includes additional information.


Notification Properties Displays notification properties.


Browse Opens the Topology Browser view for the current Global Manager
that contains the selected element in a secondary window.


Browse Detail Opens the Topology Browser view for the underlying Manager that
contains the selected element in a secondary window.


Containment Displays an element’s components.


Schedule Maintenance Displays the Schedule Maintenance dialog box.


Edit Map Icons Assigns custom icons for a class or an instance.


Expand Map Element Expands one or more individual nodes or elements.


Map Window Opens another map in a secondary window.


Server Tools Displays a list of server tools if enabled.


Client Tools Displays a list of client tools if enabled.


Right-click a selected
edge in a map


Notification Properties Displays notification properties.


Browse Opens the Topology Browser view for the current Global Manager
that contains the selected element in a secondary window.


Browse Detail Opens the Topology Browser view for the underlying Manager that
contains the selected element in a secondary window.


Map Console toolbar buttons
In the Map Console, certain menu options are provided as toolbar buttons. They are summarized in 
Table 7 on page 34.
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Button Description


Opens a Notification Log Console.


Displays the Select Context(s) To Listen To dialog box for configuring context sharing.


Opens a browser for reporting. The VMware Smart Assurance Report Manager User Guide
includes additional information.


Displays circular layout of a map. This is the default layout for all maps except for Business
Services maps.


Button Description


Displays hierarchical layout of a map. This is the default layout for Business Services maps.


Displays orthogonal layout of a map.


Allows manual layout of a map, leaving nodes where you place them (important when you
place nodes on a custom map background such as a geographic map).


For Multiprotocol Label Switching (MPLS) VPN map, displays layout based on internal logic.


Fits the map to the size of the right panel.


Zoom out, shrink map.


Zoom in, magnify map.


Opens the Overview window.


Shows previous map.


Shows next map.


Expands selected node or element. A plus sign next to a node indicates that the node or
element can be expanded.


Changes the color of map objects. Only objects experiencing root-cause events are colored.
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Layout of a Topology Browser Console
The Topology Browser Console is designed specifically for viewing the topology of any Manager:


n For a Global Manager, the Topology Browser presents an abstracted topology.


n For a Domain Manager, the Topology Browser presents a complete topology.


It also displays detailed topology if a selected topology element has an underlying topology source. It
consists of one view, the Topology Browser view. Figure 3 on page 36 illustrates an example of a
Topology Browser Console.


In the left panel, you can select a Manager from the Manager menu to see the topology for that
manager. You can expand each object in the topology tree and see its contents.


If multiple Managers are attached, the console displays the Managers one at a time, classes,
instances of each class, and their relationships. For each object you select, a corresponding property
sheet with one or more tabs is displayed in the right panel:


n For a Manager, the Modules and Threads tabs provide information about models, programs, and
process threads.


n For classes, the Description and Attributes tabs describe the class and its attributes.


n For elements (instances):


n Attributes tab lists the attribute names, data types, values, and descriptions of the attributes.


n Groups tab displays groups if the instance belongs to any groups.


n Global Manager only, the Events tab displays notifications if they are generated.


In the Topology Browser Console, the menu options and toolbar buttons are the same as those in
the Notification Log Console, except that the following do not exist for the Topology Browser
Console. Table 2 on page 24 and Table 4 on page 27 provide information on Notification Log
menus and their options and Notification Log Console toolbar buttons, respectively:


n Event and Log menus


n View menu options: Save as Viewlet and Listen to Context


Topology Browser shortcut menus summarizes shortcut menu options.


Figure 3 on page 36 illustrates a typical Topology Browser Console. In the left panel, the tree displays
an instance of a probe, 172.16.1.254, and the right panel displays the Attributes tab for the probe.
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Figure 2‑3.  Topology Browser Console


Topology Browser shortcut menus
Shortcut menus are also available when you right-click on selected entities. Table 8 on page 37
summarizes the options and selection criteria.


Table 2‑8.  Topology Browser shortcut menus


Selection criteria Option Description


Right-click in panel of the
topology tree


Select Specifies a filter for a topology tree.


Refresh Tree Refreshes the tree contents.


Right-click an instance in
the topology tree


Make Root Begins the tree with the selected instance as the root.


Browse Opens the Topology Browser view for the current Manager that
contains the selected element in a secondary window.


Browse Detail Opens the Topology Browser view for the underlying Manager that
contains the selected element in a secondary window.


Containment Displays an element’s components.


Show Map Opens the Map Console in a secondary window.


Schedule Maintenance Displays the Schedule Maintenance dialog box.


Server Tools Displays a list of server tools if enabled.


Client Tools Displays a list of client tools if enabled.


Right-click the notification
in the Events tab


Properties Displays notification properties.
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Table 2‑8.  Topology Browser shortcut menus (Continued)


Selection criteria Option Description


Browse Opens the Topology Browser view for the current Manager that
contains the selected element in a secondary window.


Show Map Opens the Map Console in a secondary window.


Server Tools Displays a list of server tools if enabled.


Client Tools Displays a list of client tools if enabled.


Right-click in the Group
tab


Browse Opens the Topology Browser view for the current Manager that
contains the selected element in a secondary window.


Show Map Opens the Map Console in a secondary window.


Layout of a Summary View Console
The Summary View Console is designed to present overviews or summaries of notifications. The console
consists of one view, the Summary view. Each summary represents information in a horizontal bar chart
or pie chart, organized by meaningful criteria. For example, a summary can organize notifications by
severity. A Summary View Console can present summaries for one or more Global Managers. Figure 4
on page 38 illustrates an example of a Summary View Console.


You can customize a summary. For example, you can edit its parameters to change its contents or apply
a filter. You can also display a Notification Log view or map for a selected summary in a secondary
window. Chapter 7 Examining Summaries includes additional information.


In the Summary View Console, the menu options are the same as those in the Notification Log Console
(see Table 2 on page 24), except that the Event and Log menus do not exist for the Summary View
Console. One menu, Summary, is specific to the Summary View Console (see Table 9 on page 39).
Shortcut menu options are summarized in Table 11 on page 40. Toolbar buttons are also summarized in 
Table 11 on page 40.
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Figure 2‑4.  Summary View Console


Summary View menu and shortcut menus
One menu, Summary, is specific to the Summary View Console. Table 9 on page 39 provides additional
information. Shortcut menu options are summarized in Table 10 on page 39.


Table 9 on page 39 summarizes the Summary menu.


Table 2‑9.  Summary View menus and their options


Menu Option Description


Summary Edit Summary Parameters Changes a summary’s contents, its title, and its chart type (horizontal
bar or pie chart), and specifies continuous or scheduled display
updates of notifications, alarmed elements, and impacts.


Filter Specifies a filter for a selected summary.


Show Notifications Displays a Notification Log view for a selected summary in a
secondary window.


Move Summary Left Moves a summary one cell to the left.


Move Summary Right Moves a summary one cell to the right.


Add Summary Adds a summary to the Summary view.


Layout Specifies the maximum number of summaries per row in a Summary
view.


Delete Summary Deletes a selected summary from the Summary view.


Shortcut menus are also available when you right-click on selected entities. Table 10 on page 39
summarizes the options and selection criteria.
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Table 2‑10.  Summary View shortcut menus


Selection criteria Option Description


Right-click on or near the
summary title


Edit Summary Parameters Changes a summary’s contents, its title, and its chart type (horizontal
bar or pie chart), and specifies continuous or scheduled display
updates of notifications, alarmed elements and impacts.


Filter Specifies a filter for a selected summary.


Show Notifications Displays a Notification Log view for a selected summary in a
secondary window.


Show Map Displays a map for a selected summary in a secondary window.


Delete Summary Deletes a selected summary from the Summary view.


Right-click in a view Add Summary Adds a summary to the Summary view.


Layout Specifies the maximum number of summaries per row in a Summary
view.


Note   Shortcut menus for a Notification Log view for a summary are described in Table 3 on page 26. A
Notification Log view for a summary only supports the shortcut menu that results from right-clicking a
notification.


Summary View Console toolbar buttons
In the Summary View Console, certain menu options are provided as toolbar buttons. They are
summarized in Table 11 on page 40.


Button Description


Opens a local console.


Saves an unsaved console on a local or remote host. Saves a saved console to a previously
specified destination.


Displays the Select Context(s) To Listen To dialog box for configuring context sharing.


Opens a browser for reporting. The VMware Smart Assurance Report Manager User Guide
includes additional information.


Displays the Notification Properties dialog box for a selected notification.


Acknowledges an active, selected notification.


Displays the Map Console.


Edits the parameters of a selected summary. Changes a summary’s contents, its title, and its
chart type, and specifies continuous or scheduled display updates of notifications.
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Specifies a filter for a selected summary.


Displays a Notification Log view for a selected summary in a secondary window.


Moves a selected summary one cell to the left.


Moves a selected summary one cell to the right.


Layout of a Status Table Console
A Status Table Console provides a high-level overview of the status of the underlying elements that affect
the operation of business entities such as business processes, customers, and lines of business.


Note   The Status Table Console is available when the VMware Smart Assurance Business Dashboard is
installed.


The Status Table Console displays a grid comprised of the following:


n Primary Class (y-axis) — Selection from a group of collection objects (ServiceOffering,
ServiceSubscriber, or any group created by your administrator).


n Secondary Class (x-axis) — Selection from the group of corresponding instances of the Primary
Class. Note that these options change as the Primary Class changes.


For example, for the class, Customer, a Status Table view can show the instances and notification
status of the various service offerings available to the Customer class.


Your administrator can configure the groups (business entities) and Status Table views. “Configuring
a Status Table view” on page 113 includes information on configuring Status Table views.


In the Status Table Console, the menu options are similar to those in the Notification Log Console
(see Table 2 on page 24), except that the Event and Log menus do not exist for the Status Table
Console. One menu, Status Table, is specific to the Status Table Console. Status Table menu and
shortcut menus contains additional information.


Figure 5 on page 42 illustrates instances of the Service Offerings (x-axis) provided by the Service
Subscribers listed on the y-axis.
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Figure 2‑5.  Status Table Console


Status Table menu and shortcut menus
One menu, Status Table, is specific to the Status Table Console. This menu includes one option,
Configure Status Table. The Configure Status Table menu is displayed depending on your user access
control privileges.


A shortcut menu is available when you right-click on the severity icon for an entity in the table, or on a
class or instance name (on the x- and y-axis). Table 12 on page 43


Table 2‑12.  Status Table shortcut menus


Selection criteria Option Description


Right-click the
severity icon for an
instance


Browse Opens the Topology Browser view for the current Global Manager
that contains the selected element in a secondary window.


Containment Displays an element’s components.


Notification Properties Displays notification properties for that element.


Show Map Opens a map with that element as focus.


Server Tools Displays a submenu listing available server tools.


Client Tools Displays a submenu listing available client tools.


Table shortcut menu options.
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Status Table Console toolbar buttons
In the Status Table Console, certain menu options are provided as toolbar buttons. They are summarized
in Table 13 on page 43.


Button Description


Opens a local console.


Saves an unsaved console on a local or remote host. Saves a saved console to a previously
specified destination.


Opens the Configure Status Table dialog box.


Displays the Select Context(s) To Listen To dialog box for configuring context sharing.


Note   Client and server tools can be invoked from an instance node displayed in the Status Table.


Watch4net
With the introduction of Watch4net 6.2, the user interface for Smarts products has been enhanced such
that you have more choices for viewing the notifications and network activity monitored by the domain
managers. You may choose from the following deployment scenarios:


1 Classic Service Assurance Manager console views — This option provides management of the
Service Assurance Manager server similar to earlier releases of the product.


2 Service Assurance Manager consoles displayed inside a Watch4net outer frame — This option
requires installation of the SAM Web Console and configuration of Service Assurance Manager,
Watch4net, and the VMware Smart Assurance Console SolutionPack. This deployment option
requires you to have separate logins for each product.


3 Service Assurance Manager with both Companion UI and Watch4net views — This option requires
access to a virtual environment for installing Companion UI plus installation and configuration of SAM
Web Console, Watch4net, and the VMware Smart Assurance Console SolutionPack. This
deployment option provides single sign-on capability. Use of an LDAP server is recommended. For
more information on enabling single sign-on for SAM, refer to the
VMware Smart Assurance SolutionPack Installation and Configuration Guide.


The VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers
provides information for installing Service Assurance Manager and Service Assurance Manager
Console.


The VMware Smart Assurance SolutionPack Installation and Configuration Guide provides
information for installing Watch4net and Companion UI and for configuring all of the components as
an integrated solution.
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SAM views through Watch4net
You can access the following SAM views by logging into Watch4net:


n Notification Log Console


n Map Console


n Summary View Console


n Status Table Console


n Web Console
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Starting a Session 3
This chapter includes the following topics:


n Overview


n Run MSA server


n Opening the Global Console


n Opening an additional Global Console


n Opening a Web Console


n Closing a console and ending a session


n Attaching to different or multiple Managers


Overview
A Global Console can be opened as an application in UNIX environment, as a Web Console in a Web
Browser, or with Java Web Start.


When you open a console at the beginning of your session, you will need to log in. This involves
specifying your VMware Smart Assurance username and password, broker information, and the Manager
name for attachment.


If you initially attach to a Global Manager, one or more consoles display after you log in, depending upon
your user profile or the default user profile. For example, if your user profile is configured for the
Notification Log and Map Consoles, then two consoles will appear after you log in. If you attach to a
Domain Manager, the Topology Browser Console appears first since Domain Managers do not maintain
user profiles.


Run MSA server
You can run the MSA 2.0 server with the Tomcat server of SAM Console to use the MSA API.


1 Go to http://java.comand install JRE 7 on your machine and locate the top level directory of the JRE 7
installation.
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2 Go to BASEDIR/local/conf and edit the runcmd_env.shfile to add the following lines:


SM_JAVA=<JAVA_HOME>/jre/bin;<JAVA_HOME>/jre/bin/client


SM_JAVAHOME=<JAVA_HOME>/jre


3 Copy the file, msa20-dmt-9.1.1.0.143.warfrom BASEDIR/tomcat/webapps/msa directory to
BASEDIR/tomcat/webapps directory.


4 Rename msa20-dmt-9.1.1.0.143.war under BASEDIR/tomcat/webapps directory to msa20-dmt.war.


5 Start the Tomcat server by typing the following command:


#BASEDIR/bin/sm_tomcat start


6 Stop the Tomcat server by typing the following command:


#BASEDIR/bin/sm_tomcat stop


7 Go to BASEDIR/tomcat/webapps/msa20-dmt/WEB-INF/classes, and edit the msa-sources.xmlfile to
add the SAM server and Broker information.


8 Start the Tomcat server by typing the following command:


#BASEDIR/bin/sm_tomcat start


9 Type the following address in your web browser:


http://<host>:8080/msa20-dmt/msa/


Starting the MSA 2.0 server and the Tomcat server will not start the SAM Console. Start the Global
Console as described in Opening the Global Console.


Opening the Global Console
This section describes how to start a Global Console session.


Opening a Global Console in a UNIX environment
To start a new session and open a new console in a UNIX environment, use the sm_gui command:


% BASEDIR/smarts/bin/sm_gui
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Logging on and attaching to a Manager
Before the console appears, you are prompted to log in and attach to a Manager:


1 For the Brokerfield, the broker hostname and port number values (that were provided during the
installation process) appear. You may need to change them; check with your administrator for the
correct values.


For example, in Managerdialog box, the broker hostname is smarts-broker and the port number is
426.


Figure 3‑1.  Manager dialog box


2 Click the Managerlist box or the Browsebutton to display a list of active (running) Managers.


Note   If the specified broker is a secure broker, when you click the Managerlist box or the Browse
button, you might be prompted to supply an VMware Smart Assuranceusername and password for
the broker, depending upon the security configuration. Click OKand then select a Managerfrom the
displayed list.


3 In the User namefield, type your VMware Smart Assuranceusername.


4 In the Passwordfield, type your password.


5 Click OK.


After you click OK, the console appears. To close the dialog box and end the session, click Cancel.


Older versions of consoles will not connect to new versions of the Service Assurance Managerserver.
When you attempt to connect to a new version of the Service Assurance Managerserver using an
older version of the console, please select Incharge Manager to attach message appears, as
illustrated in Please select InCharge Manager to attach error message. This message notifies you
that the login failed and that you need to upgrade the Global Consoleto a compatible version of the
Service Assurance Managerserver.
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Figure 3‑2.  Please select InCharge Manager to attach error message


Note   This message appears when the SM_REJECT_OLD_CONSOLES parameter is configured to
true. The SM_REJECT_OLD_CONSOLES parameter is located in the runcmd_env.sh file. Setting the
SM_REJECT_OLD_CONSOLES parameter to true prohibits Service Assurance Manager (SAM) 7.0
consoles and previous versions of the console from connecting to the SAM 7.2 server. When this
parameter is set to true, SAM 7.1 consoles and subsequent versions of the console connect
successfully to the SAM 7.2 or later servers.


IPv6 address environments
In environments where domains can have IPv6 addresses, domain names appear in the Manager dialog
box with the text [IPv6] amended to the domain name. In IPv6 environments, two entries for each domain
may exist; one entry for the domain’s IPv6 address and another for the domain’s IPv4 address. If either
address does not exist, the connection for that address is not included in the Manager dialog box. You
can only connect to domains displaying a status of Running. Where both IPv4 and IPv6 connections
display a status of running, you can choose either of the connections. If you choose a connection that
uses an IP version that is not available, a message appears notifying you that the selected protocol is not
available.


Opening an additional Global Console
If you already started a session, you can open a new console or a saved console from your current
console.


Note   When opening a console saved on a server, you can select consoles saved in your user profile,
saved in your user ID, and consoles saved globally.


Opening a new console
You can open a new console from any running console in a session. Select one of the following consoles:


n File > New > Notification Log Console


n File > New > Map Console


n File > New > Topology Browser Console


n File > New > Summary View Console
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n File > New > Status Table Console


This opens a console and attaches it to the same Managers as the running console. In the status bar,
the text "Not saved" appears since it is an unsaved console. The new console is part of the same
session as the running console.


If the value “None” appears in the Manager menu, you need to select a Global Manager or a Manager
from the menu, depending on the type of console. A new Summary View Console displays one
default summary for each attached Global Manager.


Opening a locally saved console
To open a console saved on the host where the Global Console is running:


1 Select File > Open > Open Local.


2 or


3 Click the Open Local toolbar button. This displays the Open Console dialog box.


4 In the Open Console dialog box, select the console and click Open. This opens the console. The
status bar displays the directory path and its filename.


Opening a remotely saved console
To open a console saved on the host where a Manager is running:


1 Select File > Open > Open Remote . This displays the Open Remote Console dialog box.


2 In the Open Remote Console dialog box, select the location of the saved console:


n Choose an Manager.


n Select the console from the Load from list box.


3 Click OK. This opens the console. The status bar displays the Manager where it is saved, username,
and the console name.


Opening a Web Console
You can open a Web Console, which provides Global Console functionality, in a web browser. When you
open a Web Console, the console opens within the browser, not in a separate window.


The VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managersincludes
browser requirement information.


Note   If a message prompting you to install the latest J2SE Runtime Environment appears, click Yes (or
the link) and follow the steps to install the software.
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To open a Web Console:


1 Start your browser and point it at the following URL:


http://


                    


                        <Tomcat


               _


               host>:8080/webconsole/InChargeApplet.html


2 In the Java Security Warningdialog box, click Yesor Always.


Yesor Alwaysgrants the Web Console full access to your machine. This allows the console to
connect to any Managerfrom your machine, provided your login ID has authorization, and the console
can save files locally.


Noallows the Web Console to run without full access to your machine.


3 Log in as described in Logging on and attaching to a Manager.


Using Java Web Start (optional)
To use Java Web Start with the Web Console, specify the following URL or select its icon if Java Web
Start is installed.


To download and install Java Web Start:


1 Start your browser and point it at the following URL:


http://


                    


                        <Tomcat


               _


               host>:8080/webconsole/globalConsoleCached.html


2 Optionally, select the option to download and install the Java Web Start product and the application.


A Java Web Start icon will install on your desktop or your Start menu. To start the Web Console after
this, click this icon.


3 Log in as described in Logging on and attaching to a Manager.


If you do not have Java Web Start installed, you might be prompted to use an automatic installer or
be directed to a Sun Microsystems web page, depending upon your operating system or browser.


Note   The
VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guideprovides
detailed Web Console and Java Web Start information.


Closing a console and ending a session
If you have one or more consoles running, you can close specific consoles or end the entire session.
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Closing a console
To close a console:


1 Select File > Close.


The Close command closes an individual console and the session continues. The Manager is not
affected by this operation.


If the console is the last opened one, you are prompted to confirm whether to close it.


2 Click Yes to close it.


When you close the last console, you end the session.


Note   When you close a web-browser window, the console closes. If that is the only open window for
this session, the session closes. In the Web Console, you may not be prompted to confirm closing the
last open console.


Ending a session
To close a session and exit a console:


1 Select File > Exit.


2 Click Yes to confirm. All consoles that are part of the session are closed and the session ends. The
Manager is not affected by this operation.


Attaching to different or multiple Manager s
After you log in, if you need to use a different Manager, you can attach to another manager without exiting
the console. If you detach from a Manager, you can attach to it again at any time.


If you need to access multiple Managers, you can attach to them, one at a time.


The attach procedure is similar to the logon procedure with some minor differences. For the attach
procedure, you can use the same login username and re-enter your password or specify a different login
ID. If you want to attach to a Manager using a different login ID, you do not have to start another Service
Assurance session.


Detaching from a Manager
Detach from a Manager when you no longer want to interact with it. The detach operation does not stop
the Manager.


To detach from an Manager:


1 Select Manager > Detach.
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2 Click Yes to confirm the detach.


If multiple Managers are attached, the Detach Manager dialog box appears. Select the Manager you
want to detach and click OK or click Cancel.


For the detached Manager, the value “None” appears in the Manager menu; other attached
Managers remain listed and available. If you are using the Summary View Console, the summaries
for the detached Global Manager turn gray.


Attaching to a Manager
To attach to an Manager:


1 Select Manager > Attach. This displays the Attach Manager dialog box.


2 The last attached Manager appears in the Manager menu. If you want to reattach, accept the value.
Or, click the Manager list box or the Browse button to select another Manager.


Note   If the specified broker is a secure broker, when you click the Manager list box or the Browse
button, you might be prompted to supply your VMware Smart Assurance username and password,
depending upon the security configuration. Click OK and then select a Manager from the displayed
list.


3 Type your password in the Password field.


You do not need to change the values for the Broker field or the Username field.


If you want to specify a different login ID, you can change the values for the User name and
Password fields.


4 Click OK.


To close the dialog box without attaching to a Manager, click Cancel.


The name of Manager is listed in the Manager list box. If you are using the Summary View Console,
the Global Manager’s name is listed at the bottom of a summary after it is added to the view.
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Examining Notifications 4
As you monitor your managed domain, you might need to examine notifications or investigate their
causes. You may also need to refine the appearance of diagnostic results in your console.


This chapter includes the following topics:


n Accessing notifications


n About notifications


n Displaying notification properties


n Adjusting the contents of a Notification Log view


n Using filters


Accessing notifications
Once you start a session, events may appear as notifications in your Notification Log Console and may
update summaries in your Summary View Console. Or, you can display topological information in a map
or topology tree.


Once any console is opened, there are alternative methods for accessing notification information:


n Add a Notification Log view to any console. Chapter 10 Customizing Your Console includes
information about views and adding views.


n Check the Events tab of the Topology Browser for any available notifications.


n Display notification properties by double-clicking an affected node


n (non-green color) in a map or on a selected notification.


n Use the Open a Notification Log console toolbar button to display a Notification Log view for a
selected summary in a secondary window.


About notifications
When you are interpreting notifications, you should be aware of the different severity levels for
notifications, and important attributes such as Source, IsRoot, and Impact that appear as columns in your
console. This section also explains how to obtain more information about notification properties.


VMware, Inc.  44







Notification information is displayed in:


n The Notification Log Console or view (including a view for a selected summary), when events occur.


n The Events tab of the Topology Browser for the object where the problem or event occurs.


n The Notification Properties view. “Displaying notification properties” on page 62 contains additional
information.


n Maps where notifications affect the state of icons. “Adjusting the appearance of a map” on page 94
contains additional information.


n Status Table Console, for status of the underlying elements that affect the operation of business
entities. Chapter 8 Examining Status Tables contains additional information.


Notification naming convention
Each notification has a unique name. A notification’s name consists of the class name and instance name
where the event occurred, and the event name. The notification naming convention is:


NOTIFICATION-ClassName_InstanceName_EventName


For example, the notification NOTIFICATION-Router_R1_Down identifies the event Down, which
occurred in instance R1 of the Router class.


Unique notification names with this convention are displayed in the InternalEventHandle column. By
default, the InternalEventHandle column is not displayed in the Notification Log Console, but you can add
it by selecting Log > Select Columns. The Class, Name, and Event columns display a more readable
form of this information.


The Notification Log Console will not list more than one notification with this name. If the event clears and
occurs again before it is archived, the Count field is increased accordingly. “The notification life cycle” on
page 116 contains additional information about notification archival.


Notification severity
Service Assurance generates the following five levels of severity for notifications:


n Critical


n Major


n Minor


n Unknown
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n Normal


Each level has an associated severity icon, a unique color-coded icon. Notifications and console
display summarizes severity and how severity appears in the Notification Log Console.


Note   The notification list configured by your administrator determines which notifications appear in
your console. If the notification list does not include an event, notifications for the event will not
appear in your console. If your Notification Log Console does not accurately reflect observed
conditions, contact your administrator.


Table 4‑1.  Notifications and console display


Severity level Description Severity icon


Critical (red)


Severity 1


A critical notification identifies a fatal condition. It requires immediate
attention.


When you receive multiple critical notifications, it means that Service
Assurance has determined several independent fatal conditions.


Major (orange)


Severity 2


This represents a serious condition. It requires immediate attention.


Minor (yellow)


Severity 3


This represents an abnormal condition. Action is required but the
condition is not serious.


Unknown (blue)


Severity 4


This represents elements and/or events that are in an unknown state
because of network or management connectivity failures. It requires
investigation.


Normal (green)


Severity 5


This represents a normal state and is usually displayed when an
event is informational.


Other indicators Description Color of item


Inactive
This indicates that the state cleared (changed to INACTIVE) and
notification turns transparent.


White with black text


Selected
Clicking on a notification selects it. Black border surrounding


notification


Unmonitored or
suspended


In the Notification Properties view, this indicates an event is
unmonitored or suspended.


Gray text


When an event’s state changes from ACTIVE (notified) to INACTIVE (cleared), the notification turns
transparent (white). An inactive state means that the event is no longer occurring. If an event recurs, the
Global Manager sends another notification, the state of the event returns to active, and the event counter
is incremented.


Notification Log columns
In the Notification Log view, notification attributes appear as column headings. Columns in the Notification
Log view lists the column names and their descriptions.
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Table 4‑2.  Columns in the Notification Log view


Column / Attribute Description


Acknowledged Indicates the event has been acknowledged.


Active Indicates if the event is active.


Category Represents a broad categorization of the event (for example, Availability against
Temperature). Valid values can be: Availability, Discovery, Error, Operational,
Performance, PowerSupply, Resource, Temperature, and IMPACT.


Certainty The certainty of this event.


Class Display name for the event class.


ClassName Class name of the managed element where the event occurred. One of three attributes
that uniquely identifies a notification, not modifiable.


ClearOnAcknowledge Indicates whether the event is automatically cleared from the Notification Log view when
the event is acknowledged.


Count The number of occurrences of this event starting from First Notify until Last Notify.


For a momentary event (no duration), each occurrence increases the count value
regardless of the current event state.


For a durable event (a duration), the count value increments whenever the event
reoccurs (cleared and renotified).


Element Class The class name of the topology element associated with the event in the repository
where this event resides. This may or may not have the same value as Class or may be
empty.


Element Name The name of the topology element associated with the event in the repository where this
event resides. The string is empty if there is no related element. This may or may not
have the same value as InstanceName.


Event Display name for the event name.


Event State Indicates the state of the event. Values can be ACTIVE (notified), SUSPENDED,
WAS_ACTIVE, or INACTIVE (cleared).


Event Text A longer textual description of the event.


Event Type Indicates the nature of the event. Value can be either MOMENTARY or DURABLE. A
momentary event has no duration. A durable event has a period during which the event
is active and after which the event is no longer active.


EventName Name of the event. One of three attributes that uniquely identifies a notification, not
modifiable.


First Notify First notification time. (This value is reset after an event is archived.)


Events diagnosed by an underlying domain include timestamps that accurately reflect
when the event occurred. The Global Manager uses this value from the event for the
FirstNotifiedAt/LastNotifiedAt times when it creates the notification.


Impact If Business Impact Manager is available, the sum of the weights for all affected elements.
The default weight for each affected element is 1. Weights quantify the event impact on
the infrastructure and business processes. A large numeric value indicates a large
impact.


In Maintenance Indicates whether this event occurred during a maintenance period.


InstanceName Name of the instance where the problem was diagnosed. One of three attributes that
uniquely identifies a notification, not modifiable.
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Table 4‑2.  Columns in the Notification Log view (Continued)


Column / Attribute Description


InternalEventHandle A unique key (Name attribute) that identifies the notification.


IsProblem Yes indicates if (and only if) at least one of the source event types is “PROBLEM”, and
other source event types are either “PROBLEM” or “UNKNOWN”.


No indicates that one or more of the source event types is “EVENT” or “AGGREGATE”.


Since filtering on IsRoot can result in transient behavior when events are received from
multiple underlying sources, it is recommended to filter on IsProblem instead.


IsRoot Yes indicates that the current notification is the root event.


No indicates that the current notification is not a root event and is caused by another
event.


It is often useful to filter on IsRoot to find those notifications that require immediate
attention.


Last Change Time of last event change.


Last Clear Last clear time. "Never" indicates the notification has never cleared.


Last Notify Last notification time.


Name Display name for the event instance.


Owner The username of the person responsible for handling the event.


Severity A graphical severity icon (color-coded icon) that categorizes the severity level of the
event from the notifier's point of view:


1 Critical indicates a fatal condition and that the scope is broad (for example, an
outage to a critical resource).


2 Major indicates a serious condition.


3 Minor indicates an abnormal condition but not a serious one.


4 Unknown indicates that elements and/or events that are in an unknown state
because of network or management connectivity failures.


5 Normal indicates a normal state and that an event is purely informational.


Notification Log columns provides examples of the severity icons.


Source Identifies the software component(s) that diagnosed the event, where the event
originated (for example, a Global Manager, Domain Manager, SAM Adapter Platform, or
SAM adapter).


If there is more than one source, the attribute lists each separated by a comma.


An intermediary Manager that relays an event is not listed as a source. For example,
“Trap Processor” (SNMP Trap Adapter) is listed as the source of a notification and not
the intermediary SAM Adapter Platform server.


SourceEventType Indicates the type of event from an underlying source or sources. Value can be:
PROBLEM, EVENT, AGGREGATE, or UNKNOWN. The default value is UNKNOWN.
(Not to be confused with Event Type.)


Ticket ID Trouble ticket ID.


UserDefined1 - 20 Twenty user-defined fields. Reserved for custom configuration.


In the Notification Properties view, the Caused By tab and Impact tab provide more information about the
IsRoot and Impact attributes, respectively:


n The Caused By tab lists another event that caused a selected notification if the IsRoot value is No.
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n The Impact tab lists all of the affected elements for the selected notification.


Note   The default weight can be changed by your administrator. Contact your administrator for
acceptable values if you intend to specify this attribute in a notification filter.


The VMware Smart Assurance Service Assurance Manager Configuration Guide contains complete
information about attributes.


Displaying notification properties
To obtain detailed information about individual notifications, you can display notification properties
information in either a dialog box, or a view, or in the Notification Properties workspace in the Companion
UI. To do so, you can:


n Double-click a notification in the Notification Log view.


n Select a notification and click the Show Notification Properties toolbar button.


n Select Event > Properties.


n Right-click a selected notification and select the Properties option in the shortcut menu.


n Double-click a map icon if it is affected by active events and is no longer green. Or, right-click a
selected map icon and select the Notification Properties option in the shortcut menu.


n Add a Notification Properties view using View > Add View.Select Event > Companion UI.


n Right-click a selected notification and select the Companion UI option in the shortcut menu.


n When you select the Companion UI for the first time, you are prompted for your CUI user name and
password. VMware Smart Assurance recommends that you leave the browser open so you will not be
prompted for your login credentials each time you select a notification. The Notification Properties
workspace opens in a separate browser.


Depending on the type of event and information available for display, the Notification Properties view
displays up to seven types of tabs and up to five buttons. The Smarts CUI Notification Properties
workspace displays as many apps as you wish. Online help in the Companion UI provides complete
information about the available apps and features.


In the Notification Properties view, the tabs are:


n General


n Audit Log


n Codebook


n Impact


n Details


n Caused By
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n Aggregates


Note   If a tab does not display but Fetch Details is enabled, click Fetch Details..


For the Notification Properties view, the buttons are:


n Refresh – Click this button to update values.


n Browse – Click this button to display the Topology Browser for the instance of the event.


n Fetch Details – Click this button to display information from underlying Managers.


n Containment – Click this button to display containment information.


n Close – Click this button to exit the dialog box.


The Notification Properties view is available regardless of the notification’s state (active or inactive).


Depending upon the Global Manager’s configuration, the detailed information is retrieved from the
Global Manager and may include information from underlying Managers. One indication is whether or
not the Fetch Details button appears in the view:


n If the Fetch Details button does not exist, the information is retrieved from the Global Manager and
its underlying Managers.


n If the Fetch Details button exists, the information is retrieved from only the Global Manager.


To display information from the underlying Managers, click Fetch Details.


The Fetch Details button appears only if your administrator configured the
FetchLocalNotificationProperties parameter to true. In this case, when you open the Notification
Properties view, initially only the Global Manager information appears, and information from
underlying servers is retrieved only when the Fetch Details button is pressed.


If the default setting (set to false) for the FetchLocalNotificationProperties parameter is used, the
Notification Properties view initially displays all information, both the information from the Global
Manager and information the Global Manger retrieves from the underlying servers. Set the
FetchLocalNotificationProperties parameter to true in configurations where it may take the Global
Manager a significant amount of time to retrieve the information from the underlying servers. This
allows the initial notification properties information to appear quickly.


Note   If you click the Fetch Details button and the information from the underlying servers takes a
significant amount of time to appear, the Refresh button is disabled until the information from the
underlying servers is displayed. During this time you can do other console operations.


General tab
The General tab lists the current values of the notification attributes.


Audit Log tab
The Audit Log tab displays the audit trail for the selected notification.
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In the log, each row is an entry. To view the full entry, select the row and click Show Full Entry. To insert
additional entries, click Add to Audit Log.


System actions such as archiving and user actions such as acknowledgement, ownership, and actions
performed using server and automatic tools are recorded as entries in the audit log. Inserted comments
cannot be edited or deleted and are archived as part of the audit log. Adding comments to a notification’s
audit log contains additional information.


To save a copy of the current contents of an audit log locally as a text file, click Save table to file. In the
Save table to file dialog box, you can choose field delimiters, whether to include column headers, and a
location for the file. Click OK to save the audit log. Saving audit log and containment information contains
additional information.


Codebook tab
The Codebook tab only appears for a selected notification that represents a root-cause event from an
underlying Manager. Such a notification, regardless of its severity, has a value of Yes for its IsRoot
attribute. If a notification is notified as a root cause from multiple sources, one Codebook tab is displayed
for each source. If the Codebook tab is not displayed but the Fetch Details button is enabled, click Fetch
Details to display the tab.


The Codebook tab displays all symptomatic events used in the analysis of a root-cause event. The
notification for an active symptomatic event indicates an abnormal condition in an underlying Manager.
Notifications for symptomatic events are primarily displayed in this tab and might be displayed in the
Notification Log Console. Their display in the console can be configured by your administrator.


In the Codebook tab, information is presented as a tree. Each tree node represents a class associated
with a symptomatic event. You can expand the node to display its instance or instances.


The coloring of an active notification for a symptomatic event is determined by its underlying source or
whether the event has already been imported into the Global Manager. Typically, the coloring is:


n Orange if the symptomatic event is active.


n White with black text if the event is inactive.


n Gray text if the event is unmonitored or suspended.


In the Codebook tab, if you right-click the background area, a menu with two options appears:


n Show Active Only


Click this menu option to display either active and inactive symptomatic event. A check mark appears
when only active events are displayed.


n Collapsed


Click this menu option to collapse the tree hierarchy. To expand the subtree, select Collapsed again.
A check mark appears when the collapsed state is selected.
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When the tree hierarchy is collapsed, you can right-click or double-click an instance in the tree to
display the Notification Properties dialog box to display additional information.


The instance’s tool tip provides information on the state of the symptomatic event. For example, use a
tool tip to determine whether an event is unmonitored or suspended.


Impact tab
The Impact tab displays the objects affected by the selected notification. This tab appears for any type of
event, including critical problems. Not all events affect other objects, so the Impact tab may not display.


The tab presents information in a table. To sort it, click one of the column headings. In the table, you can
view the affected object’s class and event.


For more information about an object, you can double-click its row to display the Notification Properties
dialog box. Or, right-click it and select Browse to display a Topology Browser. You can also right-click a
row and select Show Map to display it in a Map Console.


Caused By tab contains information on displaying the events which, in turn, cause the selected
notification.


Note   Client and server tools can be invoked from notifications displayed in the Notification Properties
Impact tab.


Details tab
The Details tab displays the Manager (source), the object’s attributes and their corresponding values
relevant to the event. If a notification has multiple sources, one Detail tab appears for each source.


The tab presents information in one of three formats:


n A table of attributes and values


n A table of thresholds and their related attributes and values


n A sum or total value with a table of other attributes compared against a threshold value


A gray line may appear in place of an attribute value in either the Details tab of the Notification
Properties view or the Attribute tab in the Topology Browser.


If a gray line appears in place of an attribute value, the value cannot be obtained by Service
Assurance because:


n It is unnecessary for the underlying Manager to poll the attribute value of an external device at this
time. To minimize network overhead, the Manager polls only those values it needs to analyze your
devices.


n The underlying Manager has encountered an error while polling the attribute value of an external
device. For example, the device might be down, or it might be up but inaccessible due to network
problems. In this case, you receive a notification of the critical problem, but the value remains
unavailable.


VMware Smart Assurance Service Assurance Manager Operator Guide


VMware, Inc.  52







Caused By tab
The Caused By tab displays the events that are causing the selected notification. It also displays the
objects where the events occur.


The tab presents information in a table. To sort it, click one of the column headings.


For more information about an object, you can double-click its row to display the Notification Properties
dialog box. Or, right-click it and select Browse to display a Topology Browser. You can also right-click a
row and select Show Map to display it in a Map Console.


Note   Client and server tools can be invoked from notifications displayed in the Notification Properties
Caused By tab.


Aggregates tab
The Aggregates tab appears if the selected notification is an aggregate. This tab enables you to examine
the component notifications of an aggregate.


An aggregate is a notification that consists of one or more component notifications.


The tab displays the components of the aggregate, their class, object names, and the Manager (source).
If a notification has multiple sources, one Aggregates tab appears for each source. To sort the table of
information, click one of the column headings.


In the tab, a component notification is colored:


n According to its severity if it is active.


n White with black text if it is inactive.


n Gray text if it is unmonitored or suspended.


For more information about a component notification, you can double-click it to display the
Notification Properties dialog box. Or, right-click it and select Browse or Show Map to display a
Topology Browser or a Map Console, respectively.


Note   Client and server tools can be invoked from notifications displayed in the Notification
Properties Aggregates tab.


A map consideration
If you double-click a colored map node (or right-click a colored edge) and:


n One notification exists, the Notification Properties dialog box appears.


n Multiple notifications exist, the Active Notifications dialog box appears.


In the Active Notifications dialog box, select the notification you want to see and click Properties to
display the Notification Properties view or click Close.
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Notification Properties tab examples
Codebook tab shows the active symptomatic events for an Interface Disabled notification for the interface
IF-lab-gw.


Figure 4‑1.  Codebook tab


Audit Log tab shows an audit log for a Router Unresponsive notification for the router moto-gw.


Figure 4‑2.  Audit Log tab


Impact tab shows objects affected by a Card Down notification for the card wrcaswsjc4/4.
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Figure 4‑3.  Impact tab


Adjusting the contents of a Notification Log view
To make it easier to examine the contents of your console(s), you can rearrange or adjust the contents.
This section describes how to:


n Change the contents of a Notification Log view.


n Adjust the appearance of a Notification Log Console (for example, how to rearrange columns, sort by
column, and control the display of columns).


You can also adjust the contents by applying filters. “Using filters” on page 72 contains additional
information.


Chapter 10 Customizing Your Console contains additional information on creating a customized
console.


Changing the contents of a Notification Log view
In a single Notification Log view, you can display notifications from different Global Managers by changing
the selection in the Manager menu.


Adjusting the appearance of a Notification Log Console or view
In your Notification Log Console or view, you can:


n Control which columns are displayed.


n Adjust the column width.


n Rearrange the order of columns.


Note   In the following sections, some menu options are not available when you display a Notification
Log view for a summary. In this case, the Notification Log view only supports the menu options that
result from right-clicking a notification (see Adjusting the appearance of a Notification Log Console or
view).


Notification Log columns contains descriptions of notification columns.
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Controlling the column display
Certain columns may be extraneous for your work. To control which columns display:


1 Select Log > Select Columns. Or, right-click in the area near the view title and select Select
Columns in the shortcut menu. The Select Columns dialog box displays.


2 To add or hide a column from your display, select or clear the appropriate checkbox.


3 Click OK to apply your changes.


Optionally, you can right-click a column heading to hide it or to add another column next to it.


n To hide a column, right-click its heading and select Hide Column in the shortcut menu.


n To add a new column, right-click a column heading, select Insert Column in the shortcut menu,
and select a new column in the submenu. The new column is inserted to the left of the selected
column.


Adjusting the column width
You can adjust the column width, if necessary. To adjust the width of a column, select the divider between
column titles and drag it with the mouse.


Rearranging the order of columns
To rearrange the order of columns, select a columntitle and drag it to the left or right.


To move a column, right-click a column heading, select Insert, and, in the submenu, select the column
you want to move. The column is moved to the left of the selected column.


Sorting notifications
Two methods are available for sorting notifications:


n Click Sort


n Column Sort Order dialog box


A Notification Log view, by default, is unsorted.


Click Sort method
To sort notifications by one column, click the column title you want to use for sorting. Note that a triangular
marker appears in the column title:


n First click sorts the notifications in ascending order. The triangular marker points up.


n Second click sorts the notifications in descending order. The triangular marker points down.
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n Third click disables the sort. The triangular marker is removed.


Note   If you disable the Click Sort functionality and there are other sort columns specified in the
Column Sort Order dialog box, the specified sort columns determine the sort order.


Columns that are moved and hidden from display may continue to affect the sort order.


Column Sort Order dialog box
To sort notifications by multiple columns:


1 Select Log > Sort Columns. Or, right-click in the area near the view title and select Sort Columns in
the shortcut menu. The Column Sort Order dialog box displays.


2 Select the columns from the list boxes. Select Descending for a descending sort order; Ascending is
the default.


If you already used Click Sort, your choice appears in the dialog box. You can also specify a Click
Sort column. If you clear the Enabled checkbox, Click Sort is disabled until the next time you click a
column title or select the Enabled checkbox.


The primary sort field is the Click Sort column or, if no Click Sort column is specified, the first field
that you specify in the dialog box.


If you need to reset your selections, click Reset.


3 Click OK to apply your changes.


Note   Except for the Click Sort selection, sorting, as determined by the selected columns in the
Column Sort Order dialog box, is retained if you save a console.


Updating and freezing notifications
You can:


n Control whether the display of notifications is updated continuously or at scheduled interval.


n Freeze the notifications and prevent the display from updating.


Specifying display updates for notifications
Notifications are constantly being updated in your console by default. If you want to control how often
notifications are updated, you can specify a time interval for scheduled updates.


You should consider the following before you specify a time interval:


n You should balance the update period between timely updates and the processing resources required
to continually update the Notification Log Console. Check with your system administrator about an
appropriate setting.
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n Simultaneous displays of notifications might be inconsistent. If you specify a time interval for
scheduled updates, users’ actions, including your own, that occur during the interval are not updated
in the display until after the interval. For example, you might acknowledge a notification that another
user has already acknowledged. If this is a concern, use the time interval feature (the Update Every
field) sparingly.


To specify an interval for scheduled updates:


a Select Log > Log Properties . Or, right-click in the area near the view title and select Log
Properties in the shortcut menu. The Log Properties dialog box displays.


b Clear the Update Continuously checkbox and specify the time in the Update Every field.


c Click OK .


Freezing your display
To stop notifications from changing in the display, select Log > Freeze Display. Or, right-click in the area
near the view title and select Freeze Display in the shortcut menu. In the left corner of the view, a box
icon appears.


To unfreeze the display, select Log > Freeze Display again or click the box icon. The box icon in the left
corner is removed.


Using filters
Filters enable you to control the contents of your console, view, or individual summaries. You apply a filter
to notification attributes, any class, or instance, or both. For example, you may want to monitor only
critical notifications with high impact on your business operations. There is one filter per view or summary.
Filter criteria are saved if you save your consoles.


This section describes how to filter notifications with the Filter Builder dialog box. Filtering summaries
includes information on applying a topological filter to a summary using the Filter Builder.


Filtering topology contains additional information about filtering a topology tree. â€œFiltering mapsâ€� on
page 99 includes information about filtering class instances in a map.


Filtering notifications
You can apply a filter to your Notification Log view. The filter can consist of one or more criteria. Only
notifications that match all of your criteria are displayed. Filter criteria are saved if you save your console.


Use one of the following methods to open the Filter Builder dialog box:


n Click a Notification Log view and select Log > Filter.


n Right-click in the title area of the view and select Filter in the shortcut menu.


Layout of the Filter Builder
Initially, the Filter Builder dialog box opens with a blank Sheet1 tab. At the top, the Edit menu enables you
to add, copy, or delete a Sheet tab.
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On the left, the green plus sign button enables you to add one filter criterion at a time. Menus for each
filter criterion enable you to select a notification attribute and one of the following conditions, if applicable:


n A match condition such as a specific value or expression. You can also specify wildcard characters in
a match condition. Values are case-sensitive.


n The is child of condition (the IsA filter option) for notification attributes that have a class name for their
value. IsA (“is child class of”) filter option includes additional information.


If you want to treat a wildcard character as a text character, insert a backslash (\) before the wildcard
character. For example, to filter on all event names that include a bracket, specify “*\]*”. (Do not
include the quotation marks in the expression.)


The Helper button is displayed depending on the selected notification attribute. This button:


n Provides a list of acceptable values.


n Prompts you for a range of values.


n Enables you to define an expression.


If you add a wildcard character to an expression, the Helper button is disabled.


The red X button deletes a specific filter criterion.


At the bottom of the dialog box are the following buttons: OK, Cancel, and Refresh. To apply your
filter and exit the dialog box, click OK. Click Cancel to exit without applying your changes. Refresh
resets the Filter Builder dialog box to its original or previously applied filter criteria.


Notification Log columns includes descriptions of notification attributes. Chapter 12 Wildcard Patterns
includes a list of wildcards.


Pattern matching
When you create a filter, you can specify as many attribute-value pairs as you want. Each pair is a filter
criterion. There is one filter per view. See Pattern matching for an example.


To pass a filter, notifications must satisfy all conditions in at least one Sheet tab:


n In a Sheet tab, criteria are related to one another with a logical operator AND. To satisfy a given tab,
notifications must satisfy all conditions specified in the tab.


n Individual Sheet tabs are related to one another with a logical operator OR. Notifications must satisfy
the conditions in at least one tab.


IsA (“is child class of”) filter option
The IsA filter option, displayed as is child of, only appears for notification attributes that have a class
name for their value, including: Class, ClassName, and ElementClass.


To create an IsA filter for one of these notification attributes, select the class and the is child of option
from the menus. To apply your filter and exit the dialog box, click OK.
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The Notification Log Console then displays only the notifications for instances of the specified class and
all of its subclasses.


Note   Only a single class name, without any wildcard characters of any kind, may be specified for an IsA
filter.


Example of a filter
To display only critical notifications for Down events for a router or a host that impact your business
operations, specify:


n A value of 1 for Severity, Down for Event


n A value of "~0" (not zero) for Impact, and any router or host


Figure 4‑4.  Filter Builder dialog box
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Examining Topology 5
Service Assurance abstracts topological information from Managers and third-party applications. As you
monitor your managed domain, you might need to examine your topology. The Topology Browser Console
displays the topology of any attached Manager.


This chapter includes the following topics:


n Accessing topology


n Available topological information and its representation


n Topology Browser Console or view


n Finding an instance or device


n Using the Containment dialog box


Accessing topology
This section describes alternative methods for accessing topological information.


Once any console is opened, there are alternative methods for accessing topological information:


n Add a Topology Browser view to any existing console. Chapter 10 Customizing Your Console includes
information about views and adding views.


Note   The Topology Browser is not available as a dashboard viewlet. However, topology can be
examined in the Business Dashboard, for example, by right-clicking a notification or map node, and
selecting Browse or Browse Detail, or by clicking the Browse button in a Notification Properties or
Containment view. These actions open an additional topology browsing window.


n Browse opens the Topology Browser view in a secondary window to access topological information.
Browse is available as a button in most secondary window and dialog boxes or as an Event option in
the menu for selected notifications. For example, the Browse button appears in the Notification
Properties dialog box and the Find Instance dialog box. (The button is activated when you select a
row in the table.)


n The Browse Detail option under Event menu opens the Topology Browser view with topology from
an underlying Manager in a secondary window.


n The Containment dialog box displays information and components for a selected element. “Using the
Containment dialog box” on page 81 includes additional information.


VMware, Inc.  61







Available topological information and its representation
For most situations, the Topology Browser Console and Map Console provide the most complete
representations of your topology.


There are different kinds of topological information. For example:


n Devices, logical groups such as IP networks and VLANs, and other infrastructure elements (such as
network connections) that compose the domains managed by underlying Managers.


n User-defined groups of elements (configured by your administrator).


n Business elements such as application services, service offerings (such as Web hosting contracts),
and service subscribers (such as customers, business units, or corporations). Service information and
service classes may not be available for your site.


Topology is represented in a tree format as in the map tree and the Topology Browser Console or by
map icons in a map.


Chapter 6 Examining Maps includes information about the Map Console, including how maps
represent topological information and map color-coding.


Topology Browser Console or view
The Topology Browser (console, view, or secondary window) presents the topology of any Manager as a
topology tree. Operators can view the topology of any attached Manager by selecting it from the Manager
list box.


Displaying topology
To display an expanded topology tree in the left panel, you need to select a Manager from the Manager
menu above the left panel.


Note   A plus (+) sign indicates unexpanded objects. (On some systems, an open circle appears instead
of a plus sign.)


If you already used the Browse option, the Manager icon is already expanded beginning with the class of
your selection.


To navigate the topology tree:


1 Click the plus sign next to a class to view its elements (instances).


2 Click an element in the topology tree to display tabs of information in the right panel.


3 Click the plus sign next to an element to display its relationships.


4 Click the plus sign next to a relationship to display classes of related elements.
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5 Click the plus sign next to a related class to display the related instances.


To refresh the contents of a topology tree, right-click in the background area and select Refresh Tree
from the shortcut menu. Then, expand the tree.


For each object you select, a corresponding property sheet with one or more tabs is also displayed:


n For an Manager, the Modules and Threads tabs provide information about models, programs,
and process threads. For a Domain Manager, the Correlation tab also displays and provides
correlation information such as the correlation interval.


n For classes, the Description and Attributes tabs describe the class and its attributes.


n For elements (instances):


n Attributes tab lists the attribute names, data types, values, and descriptions of the attributes.


n Groups tab displays groups if the instances belong to any groups.


n (Global Manager only) The Events tab displays notifications if they are generated. The
Events tab does not display for a selected element of a Domain Manager.


Note   If your user ID has the required authorization, for elements of a selected Domain
Manager, you can modify attribute values. Double-click in the Value column, modify the value,
and select Apply.


In the Topology Browser, an individual object with a plus (+) sign does not open or expand if a
class exceeds 1,000 instances. Instead, a node displays, reporting that there are more than
1,000 instances. This limit can be changed by specifying the com.smarts.maxTopoInstances
property during console startup. Chapter 10 Customizing Your Console provides detailed
information on tailoring console properties.


Select Edit > Find Instances to find an individual instance and display related topology.
(“Finding an instance or device” on page 80 includes additional information.)


Also, the tool tip displays the correct number of instances. To activate the tool tip, hold the
cursor over the object you wish to expand.


Browse Detail
The Browse Detail menu option is available:


n In the shortcut menu of the Topology Browser Console. Right-click a selected element in the tree and
select Browse Detail in the menu.


n In the Event menu or the shortcut menu of the Notification Log Console. Right-click a selected
notification and select Browse Detail in the menu.


n In a map. Right-click a node or an edge and select Browse Detail in the shortcut menu.


Browse Detail provides a submenu that lists all of the underlying Managers that contain the selected
element in their topology. You can select one of the underlying sources and display it in a Topology
Browser view. Browse Detail example shows an example.
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Figure 5‑1.  Browse Detail example


If the underlying Manager is not attached to the console, the console establishes a connection
automatically with your login ID. If this is not possible, you might be prompted to supply another
VMware Smart Assurance username and password.


If the selected element does not have any underlying sources, Browse Detail is disabled. Also,
Browse Detail is not available for notifications generated by non-VMware Smart Assurance sources
such as third-party adapters.


For hierarchical Service Assurance deployments, you can select Browse Detail as many times as
necessary to navigate to the desired Manager.


Filtering topology
The topology filter enables you to control which classes and specific instances appear in the Topology
Browser. You can specify a filter for each attached Manager and create a general filter for attached
Managers that are not assigned filters. Filter criteria are saved if you save your consoles.


To specify filtering criteria:


1 Right-click in the topology tree panel.


2 In the shortcut menu, select Select to display the Select tree content dialog box.


3 In the Select tree content dialog box, you can:


n Select All attached domains to apply the filter to all attached Managers.


n Select Current domain to apply the filter to the selected Manager.


n Display all the classes including classes without instances. Select the Show classes with no
instances checkbox.


n Display one or more specific classes. Select the class. To select multiple classes, press the
Ctrl key while making your selections.


n If you select classes that have instances, you can also select specific instances.
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4 To make your changes take effect, you must click OK.


To undo filter changes:


5 Display the Select tree content dialog box.


6 Clear the Include only selected classes checkbox.


7 Click OK.


Note   To make additional changes, right-click and choose Select again. When the tree is expanded,
you can select and right-click an instance and select the Make Root menu option. This will refresh the
tree to list the selected instance as root. To return the display to the entire tree, right-click in the tree’s
background and choose Select again.


Finding an instance or device
If you need to locate an element by name, class, or IP address, use one of the following search tools. For
example, if the class exceeds 1,000 elements and the Topology Browser does not expand, you can select
the class in the Find Instance search tool to list all of its instances. After you receive search results, you
can open the Topology Browser for topological information about the element, examine components of
the element with the Containment dialog box, or display a map of it using Show Map.


In the consoles, the Edit menu lists the options, Find Instance and Find System:


n Use Find Instance to locate any topological element including application services, service offerings,
service subscribers, and systems.


n Use Find System to locate systems or devices like routers and switches.


Finding an instance
To search for an instance:


1 Select Edit > Find Instance in your console. The Find Instance dialog box displays.


2 Fill in the fields, as described below. The fields are:


n Manager lists the Managers to search. Select one.


n Classes is a list of classes to search. You must select one or more classes. (To select
multiple classes, press the Ctrl or Shift key while making your selections.)


n Instance name is the instance you want to find. You can specify a complete name, a partial
name with wildcard characters, or the asterisk (*) wildcard if the name is unknown and you
wish to search for all instances. Chapter 12 Wildcard Patterns includes a list of wildcards.


3 Click Find to start the search. The results display in a table.


The Find Instance dialog box limits the number of "matches" that display. If more than the limit
number of matches is returned, a message displays asking you to refine your search.
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The maximum number of instances that can display defaults to 1000 unless you configure the -
Dcom.smarts.maxTopoInstances parameter to display more than 1000. The -
Dcom.smarts.maxTopoInstances parameter limits the number of instances that are displayed in a
topology tree. A new parameter, -Dcom.smarts.maxFindInstances, when configured, can override the
-Dcom.smarts.maxTopoInstances parameter, for example, you can configure the value of the
maxTopoInstances parameter to be a value of 3000 and the value for the maxFindInstances
parameter to be a value of 500.


Note   The value for the FindInstances parameter is not the number of instances searched, but the
number of matches to be displayed. If the maxTopoInstances parameter is configured with a value of
100, the FindInstances parameter can still return matches for a class with 150,000 instances,
provided there are less than 100 "matches" for the search string among the 150,000 instances.


Finding a system
To search for a system:


1 Select Edit > Find System in your console. The Find System dialog box displays.


2 Fill in the fields, as described below. The fields are:


n Manager lists the Managers to search. Select one.


n System name or IP Address to find lists the device or IP address you want to find. Specify
the device name (for example, moto-gw), a complete name (for example, moto-
gw.smarts.com), or an IP address.


Note   Wildcard characters are not permitted.


3 Click Find to start the search.


If the server takes a significant amount of time searching for the specified system, the Find button is
disabled until the server returns the search results. During this time you can perform additional
console operations.


Search results
After the search results display in the table, you can sort them by clicking one of the column headings.
You can also select one of the table rows and click one of the buttons located at the bottom of the dialog
box. The available buttons are:


n Browse – Click this button to display the Topology Browser for the instance.


n Containment – Click this button to display a Containment dialog box of the instance.


n Show Map – Click this button to display the instance in the Map Console.


n Close – Click this button to exit the dialog box.
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Using the Containment dialog box
The Containment dialog box displays information about an element’s containment in tabular format. It
provides information and components for a selected element. For example, for a selected port or
interface, the Network Adapters tab displays its status, mode, current utilization, and the name of a peer
network adapter.


Note   Containment is not available for user-defined groups and services.


Several methods exist to display a Containment dialog box. For example, you can display containment
information in either a dialog box or a view. To do so, you can:


n From the map tree, select an instance in the map tree, right-click and select Containment in the
shortcut menu.


n In a map, right-click a node and select Containment in the shortcut menu. For a normal (status color
green) node, double-click it to display the dialog box.


n From Find Instance or Find System dialog boxes, click Containment.


n In the Event menu or the shortcut menu, right-click a selected notification and select Containment in
the menu.


n In the shortcut menu of the Topology Browser Console, right-click a selected element in the tree
and select Containment in the menu.


n Add a Containment view using View > Add View. This view is context-sensitive, and can show
containment information for the currently selected element in a different view in the same console, for
example, if you select a notification in a Notification View in the same console.


Note   If the server takes a significant amount of time to respond to a containment request, the
Containment window displays the Getting data from ... message until the server returns the data.
During this time, you can perform additional console operations.


In the Containment dialog box, information is organized using tabs. Each tab consists of a table.
Depending upon the type of element and the type of analysis being performed by the underlying
domain, different information is available.


For example, if VMware Smart Assurance IP Performance Manager is enabled on the underlying
Domain Manager, then tabs for memory, processor, and environment display. If IP Performance
Manager is not enabled, the tabs do not display or specific columns such as CurrentUtilization appear
blank.


The following buttons are available: Refresh, Browse, Save Table, and Close. The Save Table button
saves the contents of a selected tab locally as a text file. (Saving audit log and containment
information includes additional information.)
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Containment dialog box example
Containment dialog box shows an example of a Containment dialog box for router moto-gw.


Figure 5‑2.  Containment dialog box
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Examining Maps 6
A map provides a graphical representation of your topology and, by default, is updated continuously. As
you monitor your managed domain, you might need to examine the elements of your maps and
investigate the active events that affect them.


This chapter includes the following topics:


n Accessing maps


n Available topological information and its representation


n Representing notifications in maps


n Types of maps


n Adjusting the appearance of a map


n Customizing map backgrounds


n Viewing large maps: Overview window


n Filtering maps


Accessing maps
This section describes alternative methods for accessing individual maps and how to navigate among
maps.


In addition to the different methods for opening available consoles (Chapter 3 Starting a Session), you
can access a map using the Show Map option from any existing console. Show Map functionality opens
the Map Console and displays the default map for the selected element. Show Map is available as a
button in some secondary window and dialog boxes or as a menu option for selected notifications. For
example:


n The Show Map button appears in the Find Instance and Find System dialog boxes. (The button is
activated when you select a row in the table.)


n The Show Map option appears in the Event menu or the shortcut menu if you right-click on a selected
notification.
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n Use the Show Map button on the toolbar to display a default type of map for a selected summary.
Show Map is enabled if a topological filter is specified for the summary. Filtering summaries contains
additional information.


Note   If the Map Console is open, these options display the selected map in the currently open Map
Console. A second Map Console does not open.


Opening a map
When you open a Map Console, you need to select a Global Manager from the Manager menu to display
an expanded map tree in the Topology tab of the left panel. In a tree, a plus (+) sign indicates that the
object or class can be expanded. (On some systems, an open circle appears instead of a plus sign.)


The Groups tab in the left panel displays a tree of user-defined groups for topological elements if groups
exist.


Different types of maps are available for the instances in each tab.


If relevant topological information is not available for a selected instance, a message appears, stating that
a map is not available.


To open a map in either tab:


1 Select a Global Manager from the Manager menu to display an expanded map tree in the Topology
tab.


Or, click the plus sign next to a group in the Groups tab:


n For a class in the Topology tab, you can view its elements (instances).


n For a group in the Groups tab, you can view its subgroups.


2 For the default type of map, you can click an instance in the map tree. Or, right-click an instance and
select the type of map you want to display from the shortcut menu. The map appears in the right
panel.


Also, you can right-click an icon in the existing map and select another type of map from the shortcut
menu.


Note   If a saved map of a given map type exists for the selected element, it is displayed. Saving a
map includes additional information.


To display more than one map concurrently, right-click a node in an existing map. Then, select Map
Window from the shortcut menu. Select a map type in the submenu. A secondary window displays
the additional map.


Navigating among maps
To navigate between multiple maps, the Map Console provides several navigation methods:


n The map tree — Select an element in the map tree to display the default type of map. Or, you can
select an element in the tree, right-click, and select another type of map from the shortcut menu.
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n A node in a map — Right-click a node in an existing map and select another map type from the
submenu.


n A history field list box — Lists the current map (instance and map type) and other recently viewed
maps. To re-display a map, select it from the history field list box located in the top border of the Map
Console.


n Previous and Next toolbar buttons — Enables you to move quickly between maps.


n Multiple window of maps — Opens additional window to concurrently display maps of your selected
node. To do so, right-click a selected node in a map, select Map Window, and choose a map type.


Available topological information and its representation
The Map Console is designed especially to display information about a managed topology using a variety
of map types. For example, the VLAN Connectivity map reveals the connections to a VLAN and the VLAN
Membership map reveals the members of a VLAN.


You can broaden the scope of the map by expanding nodes and incrementing map hops to reveal
additional relationships.


Map scope
For most maps, a map is centered around a selected node (for example, a device, IP network, VLAN, or
service) and shows connections to the selected entity (one hop away). You can change the scope of the
elements displayed in the map to see additional connected elements by incrementing the number of
hops. You can expand an entire map, one or more individual devices, or a service one increment at a
time. A hop is the distance between two nodes that are either physically or logically connected.


n For an entire map, the scope of a map is defined by the number of hops from the focal object (boxed
icon). Each time you select the Increment Hops option, a map expands by adding all nodes (and
their edges) that are one hop away from any existing, expandable node.


n For individual devices, when you select a device and use the Expand Map Element option, a map
expands by adding all nodes (and their edges) that are one hop away from the selected device. (You
can select more than one individual device by pressing the Ctrl key while you use the Expand Map
Element option.)
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n For Storage Insight NAS and SAN Connectivity maps, when you select an edge with a plus sign (+)
and use the Expand Map Element option, the edge expands by one hop.


Using the Expand Map Element option and the Increment Hops or Decrement Hops options together
may result in unexpected behavior. To avoid this, use the Reset Map option after the Expand Map
Element option but before you use the Increment Hops or Decrement Hops option.


Note   The options Increment Hops, Decrement Hops, and Expand Map Element are not available for
IP Network Membership, VLAN Membership, IP Network Physical Connectivity, VLAN Physical
Connectivity, and any type of Group map. The scope of these maps always includes the set of
devices in the selected IP network, VLAN, or group.


Applications and Business Services maps support the Expand Map Element option, but not Increment
Hops.


Common map attributes
The following attributes, classified by entity, are common to all maps:


n Nodes — A node represents a device, IP network, VLAN instance, service subscriber, service
offering, an application, or a user-defined group. The icon used to depict a node depends on the class
of the instance. A severity icon bar underneath a node is colored to indicate that its state is normal,
affected by one or more abnormal conditions, or unknown. A plus sign (+) next to a node indicates
that it is connected to additional nodes not currently shown in the map. A box outlining a node
indicates that the node is a map focal node. One or more nodes compose a map. You can
incrementally expand the scope of the map to show the additional nodes connected to devices.


The com.smarts.map.showNormalBanner property determines whether normal map nodes display a
green banner. The default value for this property is false, no banner is shown under normal nodes. If
the node can be expanded, a small green + displays at the right side of the node. Setting the
com.smarts.map.showNormalBanner property to true displays a full-width green banner below each
normal map node. Chapter 10 Customizing Your Console provides detailed console-property
information.


n Edges — An edge represents a relationship or connection between nodes (for example, a physical
connection such as a cable on a Physical Connectivity map), or participation in a logical group (for
example, routers participating in a VLAN for a VLAN Connectivity map). The representation depends
on the type of map. An edge that represents a topological instance is colored to indicate its status (for
example, green for Normal). If an edge represents a relationship, it is colored black.


Tool tips in maps
To activate a tool tip, hold the cursor over the object. A tool tip provides the following information for the
following map icons:


n A device (node). Tool tip lists the device’s name, model, location, contact, and description.


n An IP network (node). Tool tip lists the number of devices, by type, that are member systems of the IP
network.
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n A VLAN (node). Tool tip lists the number of devices, by type, that are member systems of the VLAN.


n A group (node). Tool tip lists the group’s name, number of individual members, and number of
subgroups.


n A service (node):


n Software service. Tool tip lists the software service’s name, the device that hosts it, and a
description.


n Software service redundancy group. Tool tip lists the class and name of the object.


n Service subscriber. Tool tip lists the service subscriber’s name and number of service offerings.


n Service offering. Tool tip lists the service offering’s name and number of service subscribers.


n Edges:


n Physical connectivity or network connection. Tool tip lists interface and port endpoint information.


n All other map edges. Tool tip lists the object’s name at each endpoint.


Note   Tool tip information for edges in Group maps is not available.


For example, a Physical Connectivity map containing routers, switches, and their physical
connections, the tool tip displays:


n For each router and switch, the device’s name, model, location, contact, and description.


n For the physical connections, the interface or port number at each end of the connection.


Representing notifications in maps
In a map, the icons (nodes and edges) reflect the collective state of active events on an object.


Understanding color coding and icons
Similar to notifications in the Notification Log Console, the map uses color to indicate that elements are
affected by one or more abnormal conditions. A color-coded severity bar indicates the state of the node.


The color-coded severity bar is not displayed for nodes whose state is normal, unless the
com.smarts.map.showNormalBanner property is set to true.


Note   The notification list configured by your administrator determines which notifications are reflected in
your Map Console. If the notification list does not include an event, notifications for the event will not be
reflected in the map icons. For example, if a notification list excludes all events from a specific router, the
router always appears with a normal state in the map. If your Map Console does not accurately reflect
observed conditions, contact your administrator.


Colors and meanings summarizes the colors that display in a map.
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Table 6‑1.  Colors and meanings


Condition Severity icon (nodes only) Color (nodes and edges)


Critical event Red


Major event Orange


Minor event Yellow


Unknown Light blue


Normal/okay Green


Note   The severity icon does not display for edges. However, the color of an edge is meaningful, as follows:


n Edges that represent topology instances are color-coded to reflect status.
n Edges that represent relationships such as VLAN Membership and IP Network Membership are colored black.


Note   In an IP Network map, the node for an IP network is always normal, even if the network is
inaccessible.


By default, the Normal status indicator is not displayed. However, you can change the setting that controls
this display by setting the com.smarts.map.showNormalBanner to true. Command syntax for the -D option
contains additional information.


To view the icons and other visual indicators used in maps, select Map > Map Legend.


Your administrator can configure custom map icons to represent map elements. The
VMware Smart Assurance Service Assurance Manager Configuration Guide contains additional
information.


Displaying notification and topological information
To display detailed diagnostic information, you can:


n Double-click a node or group icon with a severity bar to display the Notification Properties dialog
box. Or, right-click and select Notification Properties in the shortcut menu. “Displaying notification
properties” on page 62 includes information about the Notification Properties dialog box.


If more than one notification affects the icon, you are prompted to select one. A map consideration
contains additional information.


Note   Double-clicking a normal node (severity bar not displayed or green) displays the Containment
dialog box if component information is available. “Using the Containment dialog box” on page 81
contains additional information.


n Right-click a selected edge (solid line or jagged line) in a Physical Connectivity, IP Network
Connectivity, or VLAN Connectivity map. The shortcut menu lists NotificationProperties and the
Browse option for the Topology Browser.


n Right-click a selected node, select the Browse option, and view the colored events in the Events tab.
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Types of maps
The types of maps that are available depend on your license(s) and user profile. The Group maps need to
be configured by your administrator and may not be available for your session.


Network topology maps
The network topology maps and related classes are available for the IP Availability Manager or IP
Performance Manager.


Network topology maps contain elements such as IP networks, VLANs, routers, switches, and hosts, and
various types of connections such as cables and trunk cables. The maps typically depict connectivity
between elements or device membership. The VMware Smart Assurance IP Availability Manager User’s
Guide and the VMware Smart Assurance IP Performance Manager and Server Performance Manager
User’s Guide describe network topology maps in greater detail.


Types of network topology maps are:


n Physical Connectivity Map


n IP Network Connectivity Map


n IP Network Membership Map


n VLAN Connectivity Map


n VLAN Membership Map


Business Services maps
The Business Services map and related classes are available for the Business Impact Manager.


Business Services maps display service subscribers (organizations, business units, lines of business
(LOBs), departments, and customers), business processes, service offerings (for example, order capture,
Router Services, Domain Name Service), software services (for example, InCharge services),
redundancy groups, and related elements. The Business Services maps are available for infrastructure
elements in the Topology tab and groups in the Groups tab.


The VMware Smart Assurance Business Impact Manager User Guide describes Business Services maps.


Applications map
The Applications map and related classes are available for the Application Insight Domain Manager and
Application Connectivity Monitor Domain Manager.


An Applications map displays the topological elements related to the delivery of application services.
Such elements may include the systems that host software services, redundancy groups, and checks.


Applications maps are described more completely in VMware Smart Assurance Application Insight
documentation and VMware Smart Assurance Application Connectivity Monitor documentation.
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Network Protocol Manager Connectivity maps
Network Protocol Manager (NPM) maps depict BGP and OSPF topologies and connectivity between
topological elements.


Types of NPM maps are:


n An OSPF topology map contains elements such as OSPF areas, services, networks, neighbor
relationships, and virtual links; and relationships and connections.


n A BGP topology map contains elements such as autonomous systems, BGP services, and BGP
sessions; and relationships and connections.


n An EIGRP topology map contains EIGRP elements along with their relationships and connections.


n An IS-IS topology map shows the status of the IS-IS and transport network elements and their many
relationships.


These maps are described more completely in VMware Smart Assurance Network Protocol Manager
documentation.


Multiprotocol Label Switching maps
Multiprotocol Label Switching (MPLS) maps depict MPLS topology. The maps might contain router, LSP,
LSP hop, VPN, VRF, Forwarder, and PseudoWire elements, along with their relationships and
connections.


Types of MPLS maps are:


n LSP map


n LSP Hops map


n VPN map


n PseudoWire map


These maps are described more completely in VMware Smart Assurance MPLS Manager
documentation.


Storage Insight maps
Storage Insight maps depict storage network topology. The maps might contain storage network elements
such as HostSystem and connections such as Powerpath_DataPath and PowerPathRedundancyGroup.


Types of Storage Insight maps are:


n Storage Insight NAS Connectivity Map


n Storage Insight SAN Connectivity Map


These maps are described more completely in VMware Smart Assurance Storage Insight Manager
documentation.
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Multicast map
The Multicast map depicts multicast topology, such as instances of the MulticastService, MulticastGroup,
MulticastTree, MulticastSource, and MulticastRedundancyGroup classes, and connectivity between
topological elements. The maps in the Global Console show labels for devices with special roles within
Multicast.


The type of Multicast map is Multicast Connectivity (distribution tree).


The Multicast map is described more completely in VMware Smart Assurance Multicast Manager
documentation.


VoIP map
For Voice Over IP (VoIP), the Applications map displays the topological elements related to the delivery of
application services. Such elements may include the systems that host software services, redundancy
groups, and checks.


Group maps
A group consists of one or more infrastructure devices, IP networks, VLANs, subgroups, and services.
Groups are created by your administrator and may not be available for your session. The
VMware Smart Assurance Service Assurance Manager Configuration Guide includes additional
information on creating groups and importing data for groups.


A member can be an infrastructure device, IP network, VLAN, software service, service subscriber, or
service offering. A member cannot be a subgroup.


A group map can display other groups (subgroups/child groups). To display the elements belonging to a
group, double-click a selected group node. If the elements exceed 100, you are prompted to confirm
whether to display them.


For a high-level group, individual members not assigned to any subgroups do not display in a map.
Members are only displayed for groups that do not have subgroups.


The group node is colored to indicate that its state is normal, affected by one or more abnormal
conditions, or unknown. The color is determined by the highest severity condition affecting the elements
of the group. For example, if an element is experiencing a critical failure, the status bar is colored red.
Edges for groups do not change colors.


In a Connectivity group map, one solid line edge represents aggregated relationships. Elements of one
group have one or more connections with elements of another group.


Types of group maps are:


n Group Physical Connectivity map. This map displays physical connectivity between group elements.
The solid line edges between groups represent one or more physical connections between elements
of different groups. The edges do not change colors to reflect their state. The number of hops cannot
be changed.
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n Group IP Network Connectivity map. In this map, an edge between two groups indicates that there
are one or more IP networks common to the two groups. The group icon containing the IP network is
displayed; an IP network icon is not displayed. The number of hops cannot be changed.


n Group VLAN Connectivity map. In this map, an edge between two groups indicates that there are one
or more VLANs common to the two groups. The group icon containing the VLAN is displayed; the
VLAN icon is not displayed. The number of hops cannot be changed.


n Group Membership map. This map displays all of the elements of a selected group or a subgroup.
The edges do not display. The concept of a hop is not applicable.


Group IPNetwork Connectivity map example
To display a Group IPNetwork Connectivity map:


1 Open the Map Console.


2 Select a group in the Groups tab.


3 Right-click and select Group IPNetwork Connectivity in the shortcut menu. The map displays.


Group IP Network Connectivity map shows a Group IPNetwork Connectivity map for the group USA.
Within the USA group, the subgroups have devices that share common IP networks. Notice that two
subgroups, Denver and Boston, are orange, indicating serious (major) conditions.


Figure 6‑1.  Group IP Network Connectivity map
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Adjusting the appearance of a map
Several methods exist to adjust or fine-tune the appearance of your map. You can:


n Change the layout from circular to hierarchical. Right-click in the map and select Hierarchical Layout
from the shortcut menu. Objects in your map are rearranged and the layout indicator changes
accordingly.


n Change the layout from circular to orthogonal. Right-click in the map and select Orthogonal Layout
from the shortcut menu. Objects in your map are rearranged and the layout indicator changes
accordingly.


n Change the layout to manual. Right-click in the map and select Manual Layout from the shortcut
menu. The initial positions of existing nodes are retained. (This option is especially useful for large,
complex maps.)


In manual layout, any new nodes or edges that appear later due to topology changes, the Expand
Map Element option, or Increment Hops, display in the lower-left area of the map. You can drag them
from the center to new positions that will be maintained as long as the layout type is manual.


When elements on a map are removed from the topology, their corresponding representation on the
map is also removed. When you view the map in Manual Layout, the remaining map elements are not
repositioned.


If you change the manual layout to circular or hierarchical, all manual positions are lost. If you save a
map with manual layout, the positions are saved. To return to the map’s default layout or to its layout
when last saved, select Map > Reset Map (this resets all map attributes). A layout indicator at the top
of the right panel identifies the layout of a selected map.


n For a MPLS VPN map, change the layout based on internal logic. Right-click in the map and select
Organize from the shortcut menu.


n For NPM maps, enable the display of labels for routers. Right-click in the map and select Node
Labels from the shortcut menu.


n Move or reposition individual nodes in the map by dragging them.


Note   To select multiple nodes, press Ctrl while making your selections.


n Enlarge the right panel and hide the map tree. To do so, click the leftarrowhead on the panel divider.
To display the map tree again, click the rightarrowhead.


n Scale the entire map to fit the right panel of the Map Console.


n Right-click in the map and select Fit to Window from the shortcut menu.


n Magnify or shrink a map with Zoom or Overview toolbar buttons.


n Increase or decrease the scope of your map by one increment at a time. This adds new nodes to or
subtracts nodes from an existing map.


Right-click in the map and select Increment Hops or Decrement Hops from the shortcut menu.
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n Expand a selected node with the plus sign to increase the scope for it. Right-click the node and select
Expand Map Element from the shortcut menu. This adds new nodes connected to the selected
node.


Note   To select multiple nodes, press Ctrl while making your selections and continue to press the
Ctrl key when you select Expand Map Element.


Using the Expand Map Element option and the Increment Hops or Decrement Hops options together
may result in unexpected behavior. To avoid this, use the Reset Map option after the Expand Map
Element option but before you use the Increment Hops or Decrement Hops option.


n Add and remove classes using a filter. “Filtering maps” on page 99 contains additional information.


n Color only map objects experiencing root-cause events (IsRoot = Yes). Click the Color-by-Root-
Cause toolbar button (tool tip labeled Toggle Root Cause Coloring). Map objects without root-cause
events turn gray. Map objects with root-cause events are colored based only on the severity of the
root-cause events.


The Color-by-Root-Cause indicator, at the top of the right panel, indicates when this option is
enabled. This option remains enabled for allmaps until you click the toolbar button again.


For example, a router with two events—a non-root event (IsRoot = No) with severity 1 and a root-
cause event (IsRoot = Yes) with severity 2—is colored red. It is colored to reflect the collective state
of the active events and, in this case, the most critical severity is 1 (red). If you click the Color-by-
Root-Causetoolbar button, the router changes from red to orange, because the lone root-cause event
has a severity 2.


n Specify a user-defined background. “Customizing map backgrounds” on page 96 contains additional
information.


To undo your adjustments, including those made by a filter, and reset the map back to its original
layout, select Map > Reset Map.


Saving a map contains additional information.


Navigating among maps describes several navigation methods.


Chapter 10 Customizing Your Console contains additional information on creating a customized
console.


Customizing map backgrounds
You can change the map background color and use custom background images.


Map background colors
By default, different kinds of maps are displayed with different color backgrounds. Default map
background colors shows the default map background colors.


Background color Type of map


Light blue background Physical Connectivity and Group Physical Connectivity maps
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Light yellow background IP Connectivity and Group IP Connectivity maps


Light green background VLAN Connectivity and Group VLAN Connectivity maps


Beige background IP Membership, VLAN Membership, and Group Membership maps


Yellow background Business Services maps


Purple background Applications maps


Note   You can set a parameter, com.smarts.mapBackgroundColor, to customize the background color.
When the com.smarts.mapBackgroundColor property is specified, all maps display the specified
background color. When a map is saved, the background color is not included in the saved information. 
Command syntax for the -D option contains additional information.


Creating custom backgrounds
You can create and install custom map backgrounds using your own images. Examples may include
geographic maps, where map nodes are placed over the regions they serve, or organizational charts,
where map nodes are placed over the organizational departments they serve.


Custom background requirements
Ensure that the map background file meets the following requirements:


n Required file format— Must be .gif format.


Note   The map background filename must be saved with the .gif extension. The .gif extension must
be in lowercase. If the filename for your map background file is .GIF, save the file as .gif. To save the
map background file with the .jpg extension, set the smarts.allowBGjpegs property to true. Command
syntax for the -D option provides additional information.


n Image size — Must be no larger than 1500 pixels high or 2000 pixels wide.


n Image file location — Store the graphic file in the BASEDIR/smarts/local/images/<background
directory> where, <background directory> is the host where the Global Manager is running.


Adding a custom background
To add a custom map background, do the following:


1 Set the Map Console to Manual Layout (as opposed to Hierarchical, Circular, or Orthogonal Layout):
Right-click the map and select Manual Layout from the shortcut menu.


Setting the map to Manual Layout ensures that the position of map elements will not change in regard
to one another or to their position on the map background. In addition, with Manual Layout, the Global
Console automatically centers the map background within the map window.
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2 Right-click the map and select Set Background from the shortcut menu.


The Set Map Background dialog box displays that shows thumbnails of the map background images
available in the BASEDIR/smarts/local/images/<background directory> where, <background
directory> is the host where the Global Manager is running.


3 In the Set Map Background dialog box, select an image, adjust the image size using the controls at
the bottom of the dialog box, and then click OK. You can also click Apply to preview the map.


The Global Console loads the image so that it is centered over the minimum rectangular bounding
box that includes all of the map nodes.


4 After the map is loaded, you can move the map nodes to the appropriate locations on the background
image.


If you repositioned the nodes, right-click the map and select Fit in Window from the shortcut menu.


5 Save the map. When a saved map is opened, map nodes retain their position. Saving a map contains
additional information.


Removing a custom background
To remove a custom background and return to the default background:


1 Open the Set Map Background dialog box.


2 Select No background image from the Map Background File list box.


3 Click OK.


Viewing large maps: Overview window
The Overview window displays the entire contents of the map currently being viewed in the right panel as
in Map Console with Overview window. This feature is useful for viewing precise areas of a large map.


To magnify areas in your map:


1 Click the Overview toolbar button or select Map > Overview.


2 Click and drag the pointer to outline a small rectangular area. This area is then magnified and
displayed in the right panel.


To resize the rectangle, click and drag its borders in the Overview window. The smaller you make the
rectangle, the more magnified the view becomes in the right panel.


You can also move the rectangle to a new area as well, by clicking and dragging it. As the rectangle is
moved, the view in the right panel changes accordingly.
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Figure 6‑2.  Map Console with Overview window


Filtering maps
The map filter enables you to control which classes of instances appear in a specific map. You can
remove classes of devices (systems) and logical groups and add them back again. Filter criteria are
saved if you save your maps. Saving a map includes additional information.


You can also filter a map by root cause. “Adjusting the appearance of a map” on page 94 includes
additional information.


Removing a class
To remove one or more classes:


1 Select Map > Edit Map Filter in the Map Console. The Map Filter dialog box displays.


2 Select a class from the Included Classes list.


3 Click Remove. The class is moved to the Filtered Classes list.


Note   To remove another class, repeat step 2.


4 After the last selection, click OK.


Adding a class
To add one or more classes:


1 Select Map > Edit Map Filter in the Map Console.
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2 Select a class from the Filtered Classes list.


3 Click Add. The class is moved to the Included Classes list.


Note   To add another class, repeat step 2.


4 After the last selection, click OK.
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Examining Summaries 7
The Summary View Console provides a graphical overview of notifications, alarmed elements, and
business impact instances. By default, a summary is updated continuously. As you monitor your managed
domain, you might need more information about a specific summary or to investigate the attributes that
compose it. You may also need to add new summaries or modify existing ones.


This chapter includes the following topics:


n Accessing summary information


n About summaries


n Adjusting the contents of a Summary view


Accessing summary information
This section describes another method to access summary information and how to navigate between a
summary and its notifications or its default map.


In addition to the different methods for opening available consoles (Chapter 3 Starting a Session), you
can add a Summary view to any existing console to access summary information. (Chapter 10
Customizing Your Console includes information about views and adding views.)


To navigate between an individual summary and its corresponding Notification Log view:


1 Right-click the summary and select Show Notifications in the shortcut menu. Or, for the selected
summary, click Summary > Show Notifications or the Show Notifications toolbar button.


The Notification Log view for the selected summary displays in a secondary window.


2 To return to the Summary view, click Close in the Notification Log view.


To navigate between an individual summary and its corresponding default map:


3 Right-click the summary and select Show Map in the shortcut menu. The default type of map for the
selected summary displays in a secondary window.


4 To return to the Summary view, click Close.


Note   Show Map is enabled if a topological filter is specified for the summary. Topology Filter dialog
box includes additional information.
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About summaries
A summary provides a graphical overview (bar chart or pie chart) of notifications from one source, a
Global Manager. A Summary view can contain several summaries attached to either the same Global
Manager or to different Global Managers.


Summaries can represent notifications for infrastructure elements and collection objects (ServiceOffering,
ServiceSubscriber, or any group created by your administrator), organized in some meaningful way. The
content is determined by summary parameters and, optionally, a filter. “Adjusting the contents of a
Summary view” on page 104includes information on summary parameters. Filtering summariesincludes
additional information on filters.


When you are interpreting summaries, you should be aware of the different components of a summary
and the information they represent.


Summary components
A summary view is a graphical display of information in either a horizontal bar chart or a pie chart. The
chart represents the number (horizontal bar chart) or percentage (pie chart) of counted items
(notifications, alarmed elements, or impacts). For example, a chart might show the number of
Notifications categorized by severity level, or the number of Notifications that have been acknowledged. 
Displaying all elements by severity includes additional information on displaying elements by severity
levels.


A summary includes the summary title, which is the user-configurable display name of the summary. The
default title of a summary is the name of the group, service offering, subscriber, or Notification Log. In
addition, the summary identifies the Global Manager that is the source of the summary information.


The summary represents the counts by numeric values (labels) and visually by horizontal bars or sections
of a pie.


Note   If the criterion is Severity, the colors of the horizontal bars correspond to those in the Notification
Log legend; otherwise, the colors are not significant.


In a horizontal-bar chart, the labels are displayed as a vertical list along the left side of the bars, while the
counts for each category are displayed horizontally across the bottom. In a pie chart, the sections
represent the percentage of each category, with a legend indicating the category criteria.


To display the count or the percentage information in a tool tip, hold your cursor over a horizontal bar or
pie section.


Modifying a new summary or an existing one includes instructions about changing the contents of a
summary (for example, its title, counted elements, or criterion).
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Unavailable (gray) content
Sometimes, the contents of a summary turn gray. This occurs if:


n The Global Console disconnects from the Global Manager. When the connection is re-established,
the affected summaries in the Summary view are automatically recounted and displayed.


n A collection object specified for a summary’s topological filter is removed from the topology.


Calculation notes
Depending on the summary, when a counted item (an affected element, an event, or impact value)
matches more than one value of the criterion, the sum of the detailed counts might exceed the totals. For
example, if affected devices are counted by instance name such as RouterCore*, Router*, and Switch*,
the detailed counts might exceed the number of affected devices in the total count because, for example,
any instance name that matches RouterCore will also match Router, and will therefore be counted twice.


How percentages are calculated
To display percentages or total count, use a tool tip. Hold your cursor over a horizontal bar or pie section.


Percentages are calculated as follows:


n For counted elements, the percentage is the number of elements experiencing events for a given
value of the criterion, divided by the total number of elements in the summary.


For example, for elements counted by the criterion severity, 12 (14 percent) for the value Critical
indicates that 12 elements have critical events. This represents 14 percent of 83 elements in a
summary.


n For counted notifications, the percentage is the number of events for a given value of the criterion,
divided by the total number of events in the summary.


n For counted impact, the percentage is the sum of the impacts for all events for a given value of the
criterion, divided by the sum of the impacts for all events in the summary.


Adjusting the contents of a Summary view
Several methods exist to adjust the appearance of your Summary view. You can:


n Modify a new or an existing summary in a Summary view.


n Rename a summary.


n Specify a display update interval for a summary.


n Add a new summary to a Summary view.


n Delete a summary from a Summary view.


n Rearrange summaries within a Summary view.
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n Apply a filter to a summary.


You can also change the name of a Summary View Console, add different views to it, and save the
console with customizations. Chapter 10 Customizing Your Console contains additional information.


Modifying a new summary or an existing one
When you initially open a Summary View Console (File > New) or add a Summary view (View > Add
View) to a console, it contains one default summary for each attached Global Manager.


To modify a specific summary, edit its parameters and apply or change its filter, as illustrated in Edit
Summary Parameters dialog box. Changes to a summary are saved when you save the console.


Note   Filtering summaries includes information on filters.


To edit summary parameters:


1 Click a summary.


2 Select Summary > Edit Summary Params . Or, right-click in the area near the summary title and
select Edit Summary Params in the shortcut menu. The Edit Summary Parameters dialog box
displays.


Figure 7‑1.  Edit Summary Parameters dialog box


3 In the General tab, you can change the following:


n Manager — Select the Manager from the Manager menu.


n Chart Type — Select Horizontal Bar or Pie in the Chart Type menu.


n All elements by severity — Select this option to display all elements by severity in a
summary.


n Title — Select the button for the empty Title field and type the new name. To return to the
Default title, select the Use Default option.


n Update Interval — Select the Update Continuously checkbox, or clear the checkbox and
specify the time in the Update Every field.


4 Click Apply to see the results in the selected summary, then click OK when you are finished. Or, you
can click the Attributes tab.


5 In the Attributes tab, you can change the summary parameters, as follows:


n Change the criterion used to organize the counts by selecting a category in the Count menu and
an attribute in the categorized by menu. For example, you can choose to count notifications
categorized by Class, or Alarmed Elements categorized by Acknowledged. Notification Log
columns includes attribute descriptions.


n Specify values for the criterion. For some attributes like Severity, the values are predefined.
For other attributes like InstanceName, you can specify exact names or names with wildcard
characters for pattern matching. Values are case-sensitive. (Chapter 12 Wildcard Patterns
includes a list of wildcards.)
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For some attributes like Event, there is an Enable Top 5 Occurrences checkbox, which is
selected by default, and which sets the criteria to the five most frequently occurring values.
You can clear the checkbox to specify your own criteria instead of the default “top 5”.


Use the Other checkbox to count events that do not match any of the values.


6 Click Apply to see the results in the selected summary, then click OK when you are finished.


Displaying all elements by severity
To display all elements by severity in a Summary view, click the All elements by severity checkbox. When
this option is selected, additional summary parameters are not required and the Attributes tab does not
display. The resulting summary lists the number of alarmed elements as a fraction of the total number of
elements.


If an element has multiple severity notifications, the element is listed only once, at the highest severity
notification level. For example, if a Global Manager has two elements, one element listed as normal and
one element listed as having one Critical, one Major, and three Unknown notifications, the summary will
list:


n One element as normal


n One element as Critical


Note   When the All elements by severity option is selected, you cannot modify or set filter options for
the summary. You can change the topological filer allowing you to select a group as the basis for the
summary.


Modifying a summary’s title
In the Edit Summary Parameter dialog box, you can also rename a summary. To rename a summary,
specify a new name in the Title field of the Edit Summary Parameter dialog box and click OK.
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Specifying a display update interval for a summary
In the Edit Summary Parameter dialog box, you can also specify an interval for scheduled updates.
Summaries are constantly being updated in your console by default. If you want to control how often
summaries are updated, you can specify time intervals for scheduled updates.


To specify an interval for scheduled updates:


1 Clear the Update Continuously checkbox and specify the time in the Update Every field.


2 Click OK .


Adding a new summary to a Summary view
To add a summary to a Summary view:


1 Click on the view to activate it. The active view has a dark gray border.


2 Select Summary > Add Summary. An additional summary appears in the Summary View Console.


Deleting a summary from a Summary view
To delete a summary from a Summary view:


1 Click on the summary you want to delete.


2 Select Summary > Delete Summary.


Rearranging summaries in a Summary view
You can reposition summaries with the arrow toolbar buttons. Click the toolbar button to move a summary
one cell to the left or right. If another summary is next to the selected summary, click the toolbar button to
change the order of the summaries.


To specify how many summaries appear per row in a Summary view:


1 Click the view.


2 Select Summary > Layout.The default value is four. Specify a number.


3 Click OK.


Filtering summaries
The Summary view uses the same filtering mechanism as the Notification Log view except that there is an
additional topological filter and a default filter criterion for active events. The default filter criterion for
active events ensures that the summary represents only active events. There is one filter per summary.
Filter criteria are saved if you save your console.


To customize a summary’s filter criteria, use the Filter Builder dialog box, which is accessed by right-
clicking the area near the summary title and selecting Filter in the shortcut menu.
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A topological filter enables you to limit the display of notifications for all of the members of a specified
collection object. A collection object can be a service offering, service subscriber, or any group created by
your administrator.


If a topological filter is not specified, the total count indicates the number of affected elements for the
entire topology and disables the Show Map toolbar button for a given summary.


In addition, you can apply filters from the Filter Builder dialog box that control which notifications might
appear in the summaries. Filtering notifications includes additional information.


Use one of the following methods to open the Filter Builder dialog box:


n In the Summary View Console, click a summary and select Summary > Filter.


n Right-click in the area near the summary title and select Filter in the shortcut menu.


Topology Filter dialog box
The Topology Filter button appears in the Filter Builder dialog box when a summary is selected. To
specify a topological filter:


1 In the Filter Builder dialog box, click Topology Filter. The Topology Filter dialog box appears.


2 In the Class Name menu, select a collection object (ServiceOffering, ServiceSubscriber, or group).


The value None allows all of notifications to display in a summary unless you specify other filter
criteria.


3 Select a class instance from the Select instance list.


If instances do not display in the Select instance list, click Get instances to retrieve a list.
Depending upon your network configuration and if the collection object has thousands of instances, it
might take a few minutes to retrieve a list.


Instances appear, by default, in the Select instance list if the collection object has fewer than 50
instances. “Adjusting Java properties” on page 151 includes information on the
com.smarts.maxFilterInstances property.


The instance’s name displays as a summary title unless you specified a title using the Edit Summary
Parameter dialog box. Modifying a summary’s title includes additional information.


4 Click OK after your last selection. This immediately applies the topological filter to the selected
summary and closes the Topology Filter dialog box.


If you want, you can continue to create or modify filter criteria in the Filter Builder dialog box. Filter
criteria specified in the Filter Builder affect notifications that might affect summaries.


Note   If you click Cancel in the Filter Builder dialog box after applying a topological filter, the newly
created topological filter is not cancelled.
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Examining Status Tables 8
A Status Table Console provides a high-level graphical overview of the status of underlying infrastructure
elements as they affect the collection objects (ServiceOffering, ServiceSubscriber, or any group created
by your administrator) specified in the Status Table. For example, in a Status Table view, you can
determine at a glance which services or applications used by corresponding business elements are
affected by the health of managed infrastructure elements.


A Status Table view is dynamically updated as the state of elements and notifications within the Global
Manager’s topology is updated. In addition, the Status Table view is updated as elements are added or
removed from the topology.


The ability to view and configure a Status Table is associated with your user profile. Your administrator
can configure Status Table views and then associate them with your user profile. As a result, your console
may or may not display Status Table information.


This chapter includes the following topics:


n Accessing Status Table information


n About Status Table information


n Configuring a Status Table view


Accessing Status Table information
To open a new Status Table Console from an existing console, select File > New > Status Table
Console . The Status Table Console displays in a secondary window.


To refresh the information in a row or column, click the name of an element in the row or column.


Another method to access Status Table information is to add the Status Table view to your console.
Select View > Add View. “Tailoring your console with views” on page 158 includes additional information.


About Status Table information
The Status Table Console displays a grid comprised of the following:


n Primary Class (y-axis) — Selection from a group of collection objects (ServiceOffering,
ServiceSubscriber, or any group created by your administrator).
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n Secondary Class (x-axis) — Selection from the group of corresponding instances of the Primary
Class.


For example, if primary class, Customer, and secondary class, ServiceOffering is selected the Status
Table view can show the instances and notification status of the various service offerings available to
each customer.


For each point on the grid where an instance of the Secondary Class is located on a Primary Class
row, the table displays the severity icon for the corresponding infrastructure element with the highest
severity status, including the status, Normal. If there is no severity icon, there is no instance of that
element for that class.


From the Status Table, you can obtain detailed information about the element by right-clicking its icon.


Note   Client and server tools can be invoked from an instance node displayed in the Status Table.


Examining element details
To see detailed information about an element, right-click the severity icon for the element, and then select
one of the options, listed in Status Table shortcut menus, from the shortcut menu.


Table 8‑1.  Status Table shortcut menus


Selection criteria Option Description


Right-click the
severity icon for an
instance


Browse Opens the Topology Browser view for the current Global Manager
that contains the selected element in a secondary window


Containment Displays an element’s components


Notification Properties Displays notification properties for that element


Show Map Opens a map with that element as focus


Server Tools Displays a list of server tools if enabled


Client Tools Displays a list of client tools if enabled


Configuring a Status Table view
To configure a status table view:


1 Click the status table view to activate it. The active view has a black border.
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2 Select Status Table> Configure Status Table. The Configure Status Tabledialog box displays as
illustrated in Configure Status Table dialog box


Figure 8‑1.  Configure Status Table dialog box


The Configure Status Table dialog box contains two tabs:


n General — Options allow you to select a manager and to add a title and axis labels to the status
table.


n Attributes — Functionality allows you to select multiple classes and class instances.


Adding a title and axis labels to the Status Table view
To add a title and axis labels:


1 Display the Configure Status Table dialog box.


2 From the General tab:


n Select the manager from the Manager list box.


n Type a title for the Status Table in the Title field.


n Type a label for the Primary axis in the Primary axis label field.


n Type a label for the Secondary axis in the Secondary axis label field.


3 Click OK.


Configuring the Status Table primary and secondary axes
To configure the status table view’s primary and secondary axes:


1 Display the Configure Status Table dialog box.


2 Click the Attributes tab.


3 Select the classes for the Primary Class (y-axis) and the Secondary Class (x-axis).


VMware Smart Assurance Service Assurance Manager Operator Guide


VMware, Inc.  94







4 Click OK.


The Status Table Console displays using the parameters you typed.


Using Save includes information on saving your Status Table console.


The VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide includes
additional information about the Status Table as a dashboard viewlet.
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Responding to Notifications 9
Operators can perform a variety of tasks in response to notifications or to changed states of map icons.
Operators usually address the notifications based upon their severity and perform exploratory or
corrective actions. This chapter provides step-by-step instructions for acting upon notifications and for
saving and recording information.


Note   Depending upon their user profiles defined by the VMware Smart Assuranceadministrator,
operators might have access to different types of consoles and console operations.


Instructions apply to the following consoles: Notification Log, Map, Topology Browser, and Summary View,
unless noted otherwise.


This chapter includes the following topics:


n The notification life cycle


n Taking action


n Saving and recording information


n HyperNotif Statistics


The notification life cycle
A notification can be in one of five states. If the Event State column in your Notification Log view is
displayed, you can view the event state. The five event states are:


n UNINITIALIZED — The original event state of a notification.


The UNINITIALIZED state is not visible in the console because, like any client, the console does not
receive uninitialized notifications.


n ACTIVE — The event state of a notification when an event occurs and the notification informs
(notifies) a client of the event.


When a notification is notified, the event state changes from the current value to ACTIVE. The
notification displays in the Global Console unless an administrator sets a notification list filter that
prevents it from displaying.
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n SUSPENDED — The event state of a notification when the Global Manager can no longer receive
information about an active notification (for example, an agent is not responding).


In this case, the notification remains active although its event state changes to SUSPENDED and its
severity level changes to Unknown (severity=4).


Note   The SUSPENDED attribute is not applicable when the Broadcast Event State on Restart
parameter system default is configured to FALSE. The “Defining System Defaults” section of the
VMware Smart Assurance Service Assurance Manager Configuration Guide provides detailed
information.


n WAS_ACTIVE — The event state of a notification when an underlying Manager disconnects from a
Global Manager (due to a network outage, for example) or a Global Manager is restarted.


In this case, the notification remains active although its event state changes to WAS_ACTIVE. If the
session connection cannot be re-established, the severity level also changes to Unknown
(severity=4).


Once the session connection is re-established and the notification is re-notified, the WAS_ACTIVE
state changes back to ACTIVE. If an underlying Manager fails to re-notify an active notification, the
system clears the event and state of the notification changes from WAS_ACTIVE to INACTIVE.


Note   The WAS_ACTIVE attribute is not applicable when the Broadcast Event State on Restart
parameter system default is configured to FALSE. The “Defining System Defaults” section of the
VMware Smart Assurance Service Assurance Manager Configuration Guide provides detailed
information.


n INACTIVE — The event state of a notification when a notification has stopped occurring. When a
notification is in the INACTIVE state, it is said to be cleared.


Summary of event states summarizes possible event states of a notification and columns that might
appear in your console.


Table 9‑1.  Summary of event states


Event State column Active column Severity column


ACTIVE True Can be severity levels 1–5


SUSPENDED True Severity level 4


WAS_ACTIVE True Severity level 4


INACTIVE False Severity level from when notification was
active


Note   The UNINITIALIZED event state is not visible in the console.


Notification severity includes a description of icons that correspond to severity levels.
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Acknowledgement
Operators usually address the notifications based upon their severity and perform exploratory or
corrective actions. “Taking action” on page 122 includes a list of actions.


One of the actions that an operator can take is acknowledgement. After an operator completes corrective
actions or determines that notifications do not require attention, an operator can acknowledge active and
inactive notifications. Acknowledgement informs fellow operators that they can ignore the specific
notification. When an operator acknowledges a notification, the notification ownership (Owner field) is
changed to the operator who acknowledged the notification and the value Yes displays in the
Acknowledged field.


Inactive notifications can also be automatically acknowledged by the Global Manager. When the Global
Manager acknowledges an inactive notification, the notification ownership is changed to SYSTEM.


Note   Acknowledgement does not change a notification’s state unless the notification attribute
ClearOnAcknowledge is set to True for a specific notification. Methods to clear active notifications
includes information about the ClearOnAcknowledge attribute.


Methods to clear active notifications
Active notifications may become inactive (cleared) in the following ways:


n When an underlying Manager determines that an event is no longer occurring, the state of its
notification is changed to inactive and the changed state is recorded in the audit log. The Manager,
the source of the notification, clears the event.


n If the source of the notification is not capable of clearing an event, the event can be cleared after an
expiration interval provided by the source.


n When the notification attribute ClearOnAcknowledge is set to True for a specific notification, the
notification becomes inactive when an operator acknowledges it.


n When an underlying Manager fails to re-notify an active notification after a disconnect condition is
restored, the state of the notification changes from WAS_ACTIVE to INACTIVE. The system clears
the event.


Notification archival
The system archives inactive notifications if:


n They have been acknowledged.


n The time interval set for the InactiveAutoArchiveIntervalArchival parameter has passed. The
parameter is specified in the Service Assurance configuration file, ics-default.xml file.


Related audit logs are also archived. Unacknowledged notifications cannot be archived. Configuration
parameters related to notifications includes information about archival parameters.
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Archived notifications are removed from the Global Manager’s memory-resident database and are
written to an archive file. The notification archive file is named global_manager.archive and located in
the BASEDIR/smarts/local/logs directory.


After a notification is archived, the Global Manager treats a recurrence of that notification as though it
were a first occurrence. The values of notification attributes start all over again: new First Notify time,
Count starts at 1, and so on.


Removal from display
Notifications, active or inactive, are removed from the console display if they are:


n Filtered out by notification list filter criteria


n Filtered out by console filter option


n Archived


Example of a notification’s life cycle
Each notification has a unique name. A notification’s name consists of the class name and instance name
where the event occurred, and the event name. The notification naming convention is:


NOTIFICATION-ClassName_InstanceName_EventName


For example, the notification NOTIFICATION-Router_R1_Down identifies the event Down, which
occurred in instance R1 of the Router class.


The Notification Log Console will not list more than one notification with this name. If the event clears and
occurs again before it is archived, the Count field is increased accordingly.


The following notification attributes are related to a notification’s state:


n First Notify — Is the first time a notification occurs.


n Last Notify — Is the last time a notification occurs.


n Last Clear — Is the last time a notification cleared.


n Last Change — Is the last time a notification changed.


n Count — Is the number of occurrences of an event starting from First Notify until Last Notify.


For the First Notify and Last Notify attributes, the timestamp value is provided by the underlying
domain that diagnosed the event.


Notification Log columns includes additional notification attributes information.
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States of NOTIFICATION-Router_R1_Down illustrates the states of the notification NOTIFICATION-
Router_R1_Down. For the First Notify and Last Notify attributes, the timestamp value is provided by
the underlying domain that diagnosed the event. Values for Last Change, Count, and Last Clear (not
shown) are provided by the Global Manager.


Note   When a Global Manager disconnects from an underlying Domain Manager, all notifications
identified as ACTIVE are marked as WAS_ACTIVE. When the Global Manager reconnects to the
underlying Domain Manager, the Global Manager refreshes its subscriptions and starts receiving
currently active events from the Domain Manager. Existing WAS_ACTIVE notifications are interpreted
as resubscription messages, not as re-occurrences of notifications. The notification is updated to a
state of ACTIVE, the Last Change attribute is assigned the current time, and the Last Notify attribute
value remains unchanged.


Table 9‑2.  States of NOTIFICATION-Router_R1_Down


Time
User/system
actions


Notification
status


Time of first
notify


Time of last
notify


Time of last
change Count


2:00 Notify 1:00 1:00 2:00 1


2:15 Clear 1:00 1:00 2:15 1


2:25 Notify 1:00 2:25 2:25 2


2:35 Clear 1:00 2:25 2:35 2


3:00 Acknowledge 1:00 2:25 3:00 2


3:05 Archived 1:00 2:25 3:00 2


3:55 Notify 3:55 3:55 3:55 1


4:00 Disconnect 3:55 3:55 4:00 1


4:05 Notify 3:55 3:55 4:05 1


In this example, an Availability Manager generated a Down event at 1:00.


At 2:00, the Global Manager connected to the Availability Manager and the Global Manager created the
notification NOTIFICATION-Router_R1_Down for the Down event. The Global Manager retains the
original timestamp of the event and stores it in the notification—First Notify and Last Notify are assigned
the values of 1:00. The notification’s EventState is ACTIVE.


At 2:15, the notification is cleared.


At 2:25, the Availability Manager generated the same Down event again, the Availability Manager was
already connected to the Global Manager, and the Global Manager reactivates the notification. The First
Notify remains 1:00 and the Last Notify reads 2:25. The notification’s EventState changes to ACTIVE.


At 2:35, the notification is cleared. The notification’s EventState changes to INACTIVE.


At 3:00, the operator acknowledged the notification. The notification’s EventState changes to INACTIVE.
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Notice at 3:05, the notification is archived and the archive action records the most recent values for First
Notify, Last Notify, and Last Change. A notification cannot be archived until it has been acknowledged.
Acknowledgement does not change a notification’s state unless the notification attribute
ClearOnAcknowledge is set to True for a specific notification. The notification is removed from the
notification view.


At 3:55, the Availability Manager generated a Down event again and the Global Manager created the
notification again. After a notification is archived, the Global Manager treats a recurrence of that
notification as though it were a first occurrence. The notification’s EventState is ACTIVE. The value of
notification attributes start all over again: new First Notify time, Count starts at 1, and so on.


At 4:00, the Availability Manager disconnects from the Global Manager. The Global Manager marks the
notification as WAS_ACTIVE. Last Change value is updated as whenever a change is applied to a
notification.


At 4:05, the Availability Manager is restarted and reconnects to the Global Manager. Since a reconnection
causes a client to re-subscribe to remote server’s events, all currently active alarms in the Availability
Manager that the Global Manager subscribed are re-sent to the Global Manager. The Global Manager
uses these event messages to update the event state of existing notifications. Notifications that did not
previously exist or were INACTIVE before the disconnect, are notified with their Last Notify and Last
Change times initialized or updated appropriately, and the notifications’ EventState is ACTIVE. For
existing WAS_ACTIVE notifications, the event message is interpreted as a re-subscription message, in
other words not as a re-occurrence of the notification. The notification’s Last Notify does not change. Its
EventState is updated to ACTIVE and Last Change time is assigned the current time since changes were
applied to it. In short, Last Notify attribute value is not updated when a notification transitions from
WAS_ACTIVE to ACTIVE.


Configuration parameters related to notifications
Inactive acknowledged notifications can be archived after a time interval specified by the System
Administrator in the Global Manager Administration Console. The System Administrator can also specify
an interval for INACTIVE unowned notifications to be automatically acknowledged. Related audit logs are
also archived. Unacknowledged notifications cannot be archived.


Durable, momentary, and stale notifications
Some notifications are caused by durable events. A durable event has a measurable duration; it is active
for a period of time (for example, a link failure). Durable events are sent from underlying Managers.


Other notifications are caused by momentary events. A momentary event occurs and is significant for only
a specific point in time (for example, an authentication failure event for a device).
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Whether an event is durable or momentary is indicated in the Event Type column of your Notification Log
Console. (“About notifications” on page 56 includes column descriptions and also severities.)


Note   Sometimes, notifications become outdated (or "stale"). Due to network outages, it is possible that
the underlying Managers disconnect from the Global Manager. At this point, a Session Disconnected
notification displays to inform the operator that disconnected sources are detected. The notifications from
the unavailable sources are not updated in the console. Responding to disconnected Managers includes
additional information.


Taking action
When an event occurs and Service Assurance generates a notification and displays a severity icon, you
can respond and perform corrective procedures.


You can:


n Acknowledge notifications.


n Take and release ownership of notifications while you are working on them.


n Invoke tools such as Telnet, Ping, email, or pager messages, or open and close trouble tickets if they
have been configured by your administrator.


Acknowledging notifications
To inform your fellow operators that they can ignore a notification, you can acknowledge the notification if
you have completed some corrective action for it or determined that it can be disregarded. You can
acknowledge active and inactive notifications.


To acknowledge one or more notifications:


1 In the Notification Log Console, select a notification. (To select multiple notifications, press the Ctrl
key while making your selections.)


2 Select Event > Acknowledge in the Notification Console’s Event menu. (Alternatively, right-click the
notification and select the Acknowledge option from the shortcut menu.)


The value Yes displays in the Acknowledged field.


When a notification is acknowledged, an entry is added to its audit log. Acknowledged notifications
may be archived after some period of time, depending on your Service Assurance configuration. By
acknowledging a notification, you automatically take ownership of it.


Unacknowledging notifications
If you decide that certain acknowledged notifications do require additional attention, you can reset
acknowledgement to unacknowledgement.
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To unacknowledge notifications:


1 In the Notification Log Console, select a notification.


Note   To select multiple notifications, press the Ctrl key while making your selections.


2 Select Event > Unacknowledge in the Notification Console’s Event menu. Alternatively, right-click
the notification and select the Unacknowledge option from the shortcut menu.


The value No displays in the Acknowledged field.


When notifications are unacknowledged, entries are added to their audit logs. Unacknowledged
notifications are not archived. Unacknowledging a notification does not change its ownership.


Taking ownership
To inform your fellow operators that you are working on a notification, you can insert your username in the
notification’s Owner field. To do so:


1 In the Notification Log Console, select the notification.


2 Select Event > Take Ownership or right-click and select Take Ownership from the shortcut menu.


Your username is added to the Owner field and it is also recorded as an entry in the audit log.


The Owner field is informative; no additional rights are granted to the owner. Also, if there is an
existing owner listed, you can overwrite it when you take ownership.


Releasing ownership
To inform your fellow operators that you are no longer working on a notification, you can remove your
username from the Owner field. To do so:


1 In the Notification Log Console, select the notification.


2 Select Event > Release Ownership or right-click and select Release Ownership from the shortcut
menu.


Your username is deleted from the Owner field and the deletion is also recorded as an entry in the
audit log.


Scheduling maintenance
To inform your fellow operators that a specific managed element is entering its scheduled maintenance
period, you can set the In Maintenance option in a notification. When a managed element enters its
scheduled maintenance period, all active, existing, and newly generated notifications for the scheduled
element or related managed entity display the In Maintenance option.


You can schedule maintenance by:


n Interactively using the console
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n In bulk using the command line


Note   By default, the Schedule Maintenance functionality is only enabled for administrators. If this
functionality is not available to you, contact your administrator to have this functionality enabled for
you. The VMware Smart Assurance Service Assurance Manager Configuration Guide provides
additional information on removing console operations.


The Schedule Maintenance functionality is available only for classes which belong to the following
categories:


n UnitaryComputerSystem


n ICIMServiceConnection


n SoftwareService


n NetworkConnection


To schedule maintenance:


a Ensure that the Business Impact Manager server is running and that the MBIM domain has been
defined and enabled.


Note   The VMware Smart Assurance Service Assurance Manager Configuration Guide provides
detailed information on defining and enabling domains.


b In the Notification Log Console, right-click a notification.


The submenu appears.


c Select Schedule Maintenance.


The Schedule Maintenance dialog box appears, as illustrated in Schedule Maintenance dialog
box.


Figure 9‑1.  Schedule Maintenance dialog box


d Type the starting date and time for the maintenance period in the Start Date/Time fields.


e Type the ending date and time for the maintenance period in the End Date/Time fields.


f Type a reason for the maintenance period in the Explanation field.
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g Click OK.


The notification for the managed element displays SchedMaint in the Event column, as illustrated
in Notification displaying SchedMaint.


Figure 9‑2.  Notification displaying SchedMaint


Double-clicking the SchedMaint notification displays the Notification Properties dialog box.


Scheduled maintenance fields defines scheduled maintenance fields available in the General tab.


Table 9‑3.  Scheduled maintenance fields


Field Definition


UserDefined1 Defines the duration of the maintenance interval in seconds.


Note   If the user specifies a maintenance interval beginning before the current time, this duration will
only be the time remaining until the end of the maintenance interval, not the length of the whole
interval. Example: If user specifies interval from 9:00 to 10:00, and it is 9:30 when the Schedule
Maintenance request is submitted, UserDefined1 will have the value of 30 minutes, not 60 minutes.


UserDefined2 Defines the end of the maintenance period.


EventText Defines the following scheduled maintenance information:
n Start time
n End time
n User ID (identifies the user scheduling the maintenance)
n Explanation text (text entered in the Scheduled Maintenance dialog box’s Explanation field, see 


Schedule Maintenance dialog box)


Note   When you schedule maintenance to begin in the future, a SchedMaint notification is created. When
the maintenance period begins, the Service Assurance Manager server generates an InMaint notification.
This notification lists only the maintenance period end time.


When the date and time of the scheduled maintenance period has arrived, the notification displays
InMaint in the Event column, as illustrated in Notification displaying InMaint.
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Figure 9‑3.  Notification displaying InMaint


The notification is cleared when the maintenance date and time have ended.


Clearing a scheduled maintenance period
To clear a scheduled maintenance notification:


1 In the Notification Log Console, right-click an InMaint notification.


2 Select Acknowledge.


The scheduled maintenance notification is cleared.


Deleting a scheduled maintenance period


Note   You can only delete a scheduled maintenance notification if it has not entered the scheduled
maintenance period.


To delete a scheduled maintenance notification:


1 Log in to the console without user maint privileges.


2 In the Notification Log Console, right-click a SchedMaint notification.


3 Select Acknowledge.


The scheduled maintenance notification is removed.


Forcing a scheduled maintenance period
If you have scheduled a maintenance period for the future, you can force a scheduled maintenance to
take place immediately.


To force a scheduled maintenance:


1 Log in to the console with user maint privileges.


2 In the Notification Log Console, right-click a SchedMaint notification.
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3 Select Acknowledge.


4 Right-click the notification and select Schedule Maintenance.


The Schedule Maintenance dialog box appears.


5 Type the starting date and time for the maintenance period in the Start Date/Time fields.


6 Type the ending date and time for the maintenance period in the End Date/Time fields.


7 Type a reason for the maintenance period in the Explanation field.


8 Click OK.


Enabling maintenance tracking
To enable maintenance tracking:


1 Log in to the console.


2 Define and enable the MBIM domain.


Note   The VMware Smart Assurance Service Assurance Manager Configuration Guide provides
detailed information on defining and enabling domains.


3 In the Domain Manager Administration Console, select INCHARGE-MBIM from the Manager list
box, and select Topology > Add Source to launch the Add Source dialog box.


4 In the dialog box, select SA from the Element Type list box, type the name of the Service Assurance
Manager server (for example, INCHARGE-SA) in the Element Name field, and then click OK to add
the Service Assurance Manager server as a topology source.


5 In the Topology Browser Console, right-click the instance of the local Service Assurance Manager
server in the InChargeDomain class.


A submenu appears.


6 Select Enable Maintenance.


Disabling maintenance tracking
To disable maintenance tracking:


1 Log in to the console.


2 In the Topology Browser Console, right-click the instance of the local Service Assurance Manager
server in the InChargeDomain class.


A submenu appears.


3 Click Disable Maintenance.
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Scheduling bulk maintenance
At times, you might want to schedule multiple devices and groups for maintenance. You can schedule
multiple devices and groups for maintenance using a text file (for use with the bulk maintenance adapter)
or an XML file (to be used with the sm_config functionality). When a group is scheduled for maintenance,
a schedMaint notification for the group is created, resulting in all the members of the group being
scheduled for maintenance.


Scheduling bulk maintenance using a text file
To schedule bulk maintenance using a text file:


1 Open a text editor.


2 Create a file with the format:


ClassName InstanceName startDate startTime endDate endTime


# This is the input file for bulk maintenance


# Hosts to be scheduled for maintence are


Host    MAJOR-WIN2K-VM  06-23-2009  16:00   06-23-2009  18:59 


Host    USENSMAJORL2E   06-23-2009  16:00   06-23-2009  18:59


# The following group is scheduled for maintence


SelectiveGroup HGRP-TL/G1 07-09-2009  11:58   07-15-2009  16:57


3 Save and exit the file.


4 Upload the file to the server.


Loading the bulk maintenance text tile provides detailed information for uploading the text file to the
server.


Loading the bulk maintenance text tile


To load the bulk maintenance text tile:


1 Open a Command Prompt window.


2 Change directory to the smarts/bin directory.


3 Type the following command:


t Sm_adapter -s samserver --file=fileName --output=outputfileName ../rules/ics/ics-bulk-maint.asls


“In maint, based on group HGRP-TL/G1, until 7-15-2009 16:57”


Scheduling bulk maintenance using an XML file
To schedule bulk maintenance using an XML file:


1 Open an XML editor.


Note   An XML template file, bulk-maint-sample.xml, is located in the conf/ics directory.
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2 Create a file with the format:


<?xml version="1.0" encoding="iso-8859-1"?>


<!DOCTYPE ics_config SYSTEM "ics-config.dtd">


<ics_config version="2">


   <maintconfig className = "Host" instanceName = "hostb"


      startYear = "2009"


      startMonth = "7"


      startDay = "11"


      startHour= "10"


      startMinute= "20"


      endYear = "2009"


      endMonth = "7"


      endDay = "11"


      endHour= "12"


      endMinute = "20"/>


</ics_config>


3 Save and close the file.


Note   Save the file in the local/conf/ics directory.


4 Upload the file to the server.


Loading the bulk maintenance XML file provides detailed information on uploading the XML file to the
server.


Loading the bulk maintenance XML file


To load the bulk maintenance XML file:


From a Command Prompt window, type the following command:


sm_config –s <SAMserverName> import –force <xmlfileName> 


The output from running the command is added to the SAM server log file.


Scheduling bulk maintenance for port and interface components
You schedule bulk maintenance for port and interface components by specifying the component’s
SystemName, the device instance name, in either a text file or an XML file.


Scheduling bulk maintenance for port and interface components using a text file


To schedule bulk maintenance for port and interface components using a text file:


1 Open a text editor.


2 Create a file with the format:


ClassName InstanceName startdate startTime enddate endTime SystemName


# This is the input file for bulk maintenance for ports and interfaces


# Ports to be scheduled for maintence are


Port abc 08-05-2009 16:00 08-05-2009 19:00 router1 
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3 Save and exit the file.


4 Upload the file into the server.


Loading the bulk maintenance text tile provides detailed information for uploading the text file to the
server.


Scheduling bulk maintenance for port and interface components using an XML file


To schedule bulk maintenance for port and interface components using an XML file:


1 Open an XML editor.


2 Create a file with the format:


<?xml version="1.0" encoding="iso-8859-1"?>


<!DOCTYPE ics_config SYSTEM "ics-config.dtd">


<ics_config version="2">


 <maintconfig className = "Port" instanceName = "abc"


      startYear = "2009"


      startMonth = "7"


      startDay = "26"


      startHour= "10"


      startMinute= "00"


      endYear = "2009"


      endMonth = "7"


      endDay = "28"


      endHour= "16"


      endMinute = "00"


      systemName = "router1"/>


</ics_config>


3 Save and close the file.


4 Upload the XML file to the server.


Loading the bulk maintenance XML file provides detailed information on uploading the XML file to the
server.


Unscheduling bulk maintenance
If errors exist in the maintenance schedule, you might want to unschedule the devices from maintenance.
If the devices to be unscheduled from maintenance have not entered their maintenance period, their
corresponding schedMaint notification is archived. If the devices to be unscheduled from maintenance
have entered their maintenance period, unscheduling the devices clears their corresponding InMaint
notification and all the related notification’s InMaintenance attributes are set to false. If maintenance
period for the devices to be unscheduled from maintenance has passed, unscheduling the devices from
maintenance has not effect on their corresponding notifications.
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Unscheduling bulk maintenance using a text file
Use the text file containing the original maintenance entries you want to remove from maintenance when
removing devices from maintenance. Define the variable, removeSchedMaint, using the -D sm_adapter
option.


To unschedule bulk maintenance using a text file:


From a Command Prompt window, type the following command:


t Sm_adapter –s SAMServer –DremoveSchedMaint=true --file=fileName ../rules/ics/ics-bulk-maint.asl s


Unscheduling bulk maintenance using an XML file
To unschedule bulk maintenance using an XML file:


1 Open the original XML file containing the device entries you want to remove from maintenance in an
XML editor.


2 Type the following line in the first device entry:


removeSchedMaint = “TRUE”


<?xml version="1.0" encoding="iso-8859-1"?>


<!DOCTYPE ics_config SYSTEM "ics-config.dtd">


<ics_config version="2">


   <maintconfig className = "Host" instanceName = "hostb"


      startYear = "2009"


      startMonth = "8"


      startDay = "11"


      startHour= "10"


      startMinute= "20"


      endYear = "2009"


      endMonth = "8"


      endDay = "11"


      endHour= "12"


      endMinute = "20"


      removeSchedMaint = “TRUE”/>


     <maintconfig className = "Router" instanceName = "10.9.131.17"


      startYear = "2009"


      startMonth = "8"


      startDay = "16"


      startHour= "13"


      startMinute= "00"


      endYear = "2009"


      endMonth = "8"


      endDay = "16"


      endHour= "14"


      endMinute = "20"/>


</ics_config>
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3 Save and close the file.


Note   Save the file in the local/conf/ics directory. An example XML file, bulk-maint-sample.xml, is
located in the conf/ics directory.


4 Reload the XML file into the server.


Loading the bulk maintenance XML file provides detailed information for loading the XML file into the
server.


Scheduling repair time
The Repair Time dialog box is accessed from a root-cause notification. The Repair Time dialog box allows
you to type an estimated repair time and have it display in a notification field. Any notifications that are
caused by the selected notification also get the specified repair time.


The console does not support Repair Time as one of the standard default Notification Console columns.
However, you can configure one of the User Defined columns to include this information.


To access the Repair Time functionality, your administrator should configure one of the User Defined
Notification Log Console columns to display the heading "Repair Time". Your administrator must enable
the Schedule Maintenance Administration console operation for each user profile permitted to display the
Repair Time dialog box. The “Modifying a notification list” section of the
VMware Smart Assurance Service Assurance Manager Configuration Guide provides detailed
information.


Note   Repair time data is for informational purposes only.


To schedule repair time for a managed element:


1 In the Notification Log Console, right-click a notification.


2 Select Repair Time.


The Repair Time dialog box appears, as illustrated in Repair Time dialog box.


Figure 9‑4.  Repair Time dialog box


3 Type the amount of time the repair will take to be complete.


4 Click OK.


The Repair Time notification field displays the time when the repair is expected to be completed.
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About tools
A tool is a program that you can invoke in response to a notification or for a topology element. Such an
action might be to ping or to Telnet to the affected system, or to open a trouble ticket for a specific
notification.


The Global Console supports these types of tools:


n Server tools are executed by the Global Manager and are available to any console that attaches to
the Global Manager.


In console shortcut menus, the server tools are listed in the Server Tools submenu.


Server actions are also recorded as entries in the server’s audit log.


n Client tools are executed by the Global Console and are available to locally installed consoles.


In console shortcut menus, the client tools are listed in the Client Tools submenu.


Note   Some tools prompt for runtime user-specified parameter values. If multiple instances are
selected when you launch these tools, the Specify Options for get properties tool dialog box includes
an option allowing you to specify values once and apply the specified values to all selected objects.
With this option selected, you only need to type the runtime parameters once for all selected objects.


Your administrator can configure tools for server or client execution. For example, some available
tools include:


n Ping


n Telnet


n Trouble tickets, opening and closing (server only)


n Email


n Pager message


n LSP Ping


n Launch ADM Web Console


n Get SCM Alert Details


n Get SCM Server Details


Note   The Get SCM Alert Details and the Get SCM Server Details tools are only available from
Global Consoles accessed through Internet Explorer.


In addition, your administrator can modify these sample tool programs, provided by VMware, Inc., and
rename the menu options that appear in your consoles:


n Sample—Ping, Ping Interface, Ping Device, Ping All


n Sample—Telnet
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n Sample—Open Trouble Ticket


n Sample—Close Trouble Ticket


The following sections describe how to use Ping and Telnet, open and close trouble tickets, display
the Tool Output window, and use Email, pager message, and their recipients dialog box.


Using ping and telnet
The tools ping and telnet are available from the Global Console. To invoke either tool:


1 Right-click one of the following selections:


n A notification in the Notification Log Console


n A map icon in the Map Console


n A managed element in the topology tree of the Topology Browser Console


2 Select a tool from the shortcut menu.


Server tools are listed under the Server Tools submenu.


Client tools are listed under the Client Tools submenu.


Note   These submenus only display if the tools are configured and are relevant for the selected
entity.


Menu option names for these tools may have been modified by your administrator.


Opening and closing trouble tickets
Trouble tickets are sometimes used to track notifications while the operators are working on them. If the
trouble ticket tools (Open and Close programs) are configured by your administrator, you can open a
trouble ticket (insert a Ticket ID number) for a notification or close a trouble ticket.


To open and close a trouble ticket for a notification, use the tools Open Trouble Ticket and Close Trouble
Ticket, respectively.


Note   Menu option names for these tools may have been modified by your administrator.


Opening a trouble ticket
To open a trouble ticket:


1 Right-click a selected notification in the Notification Log Console.


2 In the shortcut menu, select Server Tools > Open Trouble Ticket.


Closing a trouble ticket
To close a trouble ticket for a notification:


1 Right-click a selection.
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2 In the shortcut menu, select Server Tools > Close Trouble Ticket.


Using the Tool Output window
Viewing tool output depends on the tool’s configuration. Typically, the output displays in the Tool Output
shortcut window, which opens when the tool is invoked.


In the Tool Output shortcut window, the buttons are:


n Stop — Stops the tool program while it is running.


n Print — Prints the output to your default printer.


n Close — Closes the window after the tool program completes processing or is stopped; you cannot
close the window while the tool is running.


If the tool produces an error, a message is displayed in the window. (For Server tools, an error
message is displayed in the window on the host where the console is running.)


For example, Example of a Tool Output window displays the result for the Ping tool when it is invoked
for a router notification.


Figure 9‑5.  Example of a Tool Output window


Email, Pager Message, and their recipients dialog box
The tools Mail and Pager are available in the Notification Log Console.


To invoke either tool:


1 Right-click a selected notification in the Notification Log Console. (To include multiple notifications
in your message, press the Ctrl key while making your selections.)


You can right-click the selection regardless of its state (active or inactive): A cleared problem can be
as important as a problem that has occurred.
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2 Select Mail or Page in the shortcut menu.


This displays the Mail Action or Pager Action dialog box.


3 In the dialog box, fill in the fields. The Mail Action and Pager Action dialog boxes are the same,
except for the Mail Subject field and the resulting action.


The dialog box fields are:


n Manager — Is the Manager for the recipients listed in the To field. If you are attached to multiple
Managers, select one.


n To — Designates a recipient for the action. You must select a recipient. If you need to send
an action to someone who is not listed, click Configuration to display the Recipients Editor
dialog box and add the person to the list.


n Subject — Identifies the subject of the email message. You can change it if you wish.


n Message — Is the body of the email or pager message. The message text includes the event
and related notification attributes. This is not always enough information, however, for the
person receiving the message. You may wish to add a brief note that provides more
information about the event.


4 Select the recipient.


If you open a Mail or Pager Action dialog box and the To section does not initially list recipients, you
need to create a distribution list of recipients. Preparing a distribution list includes instructions.


5 Click OK to apply your changes and send the email or pager message.


Note   The mail action uses the industry-standard SMTP for email. In the Recipients Editor dialog
box, you need to verify the values in the Mail server and Sender email address section that define the
values for the mail services running at your site.The pager action requires a shell script, provided by
your systems administrator, to access the pager software. Your administrator needs to create a script
named pager.sh in the BASEDIR/smarts/local/actions directory.


Preparing a distribution list
The Recipients Editor dialog box enables you to create a list of people to receive email or pager actions.


To open the Recipients Editor dialog box, select Edit > Recipients or click Configuration in an open
Mail Action or Pager Action dialog box.


The Recipients Editor dialog box is divided into four sections:


n Manager section lists the Manager for the recipients. If you are attached to multiple Managers, select
one.


n Current Recipients section lists the recipients for a selected Manager. To delete an entry from the list,
select it and click Delete. (To select multiple entries, press Ctrl while making your selections.) Click
OK to apply your changes.


n The Recipient Information section is where you add new recipients to the list or change existing
information.
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n Mail server and Sender e-mail address section. The information in this section must be correct in
order to successfully send email. You can change the mail server name and email address:


n The Mail server field must be set to the hostname where the mail services are running and should
match the value specified by your system administrator in the Service Assurance Manager’s
configuration. The default value is localhost.


If you specify a mail server name in the Recipients Editor dialog box that is different from the
configuration value, the value in the dialog box temporarily overrides the configuration value. To
change the name permanently, contact your administrator.


n The Sender email address field identifies the operator who is sending the email. By default, it
displays your email information.


Adding a recipient
To add a recipient in Recipients Editor dialog box:


1 From the Manager list, select the manager where you want to save the recipient.


2 Provide the recipient’s name.


3 Add the recipient’s email address or pager number. When you choose an action, the appropriate
phone number or email address is sent to the pager or email software.


4 Supply a password if it is required to send a pager message. The password value is passed as a
parameter to the pager script.


5 (Optional) Add a description for your records.


6 Click Apply or Create. The new recipient appears in the list of Current Recipients.


7 Click OK to apply your changes.


Launching an ADM web console
Use the Launch in Context functionality to open an Application Discovery Manager (ADM) Console in
context. The ADM Console includes functionality to display detailed information about selected objects
populated into the Service Assurance Manager as a result of the integration with ADM. The Launch ADM
Web Console tool is available from the Map Console.


Note   The VMware Smart Assurance Application Discovery Manager Integration Guide provides detailed
information.


To launch an ADM web console:


1 From the Map Console, right-click an object.


The shortcut menu displays.


2 Select Client Tools.


3 Select Launch ADM Web Console.


The ADM web console appears.
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Viewing SCM alert and server details
When the Service Assurance Manager is integrated with the Server Configuration Manager (SCM), the
Global Manager can receive alerts from SCM, allowing you access to SCM reports listing the Change and
Compliance alerts collected by the SCM for machines monitored by the Service Assurance Manager.


Note   The VMware SCM Integration with VMware Smart Assurance Configuration and User Guide
provides detailed information on configuring the integration between the Service Assurance Manager and
SCM and viewing detail reports.


To view SCM alert and server details:


1 Right-click a Change or Compliance alert in the Notification Log Console.


2 In the shortcut menu, select Client Tools.


3 Select one of the following:


n Display SCM Alert Details — To display Alert Details Reports.


n Display SCM Server Details — To display the Server Details Reports.


The report displays in a Report Viewer.


Note   The Display SCM Alert Details and the Display SCM Server Details tools are only
available from Global Consoles accessed through Internet Explorer.


Saving and recording information
In addition to acting upon notifications or the state of icons in maps, you may need to add comments to
audit logs, save notification information and maps, and print tool output and maps.


Adding comments to a notification’s audit log
Sometimes for documentation purposes, you may need to add comments to an audit log for a specific
notification. For example, you may want to log a summary of actions taken to solve a problem or list
pending issues for the operators on the next shift. The inserted entries cannot be edited or deleted and
they are archived as part of the audit log. Append new item to Audit Log dialog box shows an example.


To add comments:


1 In the Notification Log Console, right-click a notification.


The notification shortcut menu appears.


2 Click Add to Audit Log.


Note   Alternatively, select Event > Add to Audit Log from the console’s menu bar.


The Append new item to Audit Log dialog box displays.
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Figure 9‑6.  Append new item to Audit Log dialog box


3 Type your comments for one entry and click OK. For more than one entry, click Apply after each
entry, then click OK when you are finished.


An alternate method for opening the Append new item to Audit Log dialog box is to open the
Notification Properties dialog box.


To open the Notification Properties dialog box:


4 In the Notification Log Console, right-click a notification.


The notification shortcut menu appears.


5 Click Properties.


Note   Alternatively, select Event > Properties from the console’s menu bar.


6 Select the Audit Log tab.


7 Click Add to Audit Log.


â€œDisplaying notification propertiesâ€� on page 62 includes additional information about the
Notification Properties dialog box.


Saving Notification Log information
You can save the contents of a Notification Log view. The information is stored locally as an ASCII file.
Each row of information is saved as a separate line of text in the file. The resulting file can be imported
into other applications such as a spreadsheet program or printed.


To save notification information, in a Notification Log Console, select Log > Save log contents to file or
right-click the view title and select Save Log Contents to File from the shortcut menu.


In the Save log contents to file dialog box, you can choose format settings and a location for the file.
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The Save log contents to file dialog box is divided into four sections and a Save location field:


n Field delimiter — Separates each field within a line using a tab character or a user-specified character
such as vertical bar (|). To specify a custom delimiter, click the Use custom delimiter option and
specify the character; tab is the default.


n Column headers — Includes column headers as the first line. To exclude the headers, clear the
Include column headers checkbox.


n Columns to include — Includes columns that are visible, which is the default, or all columns.


n Notifications to include — Includes all notification rows, which is the default, or only selected rows.


n Save location — Specify a directory path and filename, including the file extension (.txt). If you do not
specify a path, the file is saved locally to the BASEDIR/smarts/local/logs directory by default. Or, you
can click Browse and choose a location in the Select filename dialog box.


Click OK or Apply to create the text file. If the file already exists, its contents are overwritten.


Saving audit log and containment information
You can save the contents of an audit log and a selected table of the Containment dialog box. The
information is stored locally as an ASCII file. Each row of information is saved as a separate line of text in
the file. The resulting file can be imported into other applications such as a spreadsheet program or
printed.


To save the information, you can:


n In the Audit Log tab of the Notification Properties dialog box, click Save table to file.


n For a selected tab in the Containment dialog box, click Save Table.


In the Save table to file dialog box, you can choose format settings and a location for the file.


The Save table to file dialog box is divided into two sections and a Save location field:


n Field Delimiter — Separates each field within a line using a tab character or a user-specified
character such as vertical bar (|). To specify a custom delimiter, click the Use custom delimiter option
and specify the character; tab is the default.


n Column Headers — Includes column headers as the first line. To exclude the headers, clear the
Include column headers checkbox.


n Save location — Specify a directory path and filename, including the file extension (.txt). If you do not
specify a path, the file is saved locally to the BASEDIR/smarts/local/logs directory by default. Or, you
can click Browse and choose a location in the Select filename dialog box.


Click OK or Apply to create the text file. If the file already exists, its contents are overwritten.


Saving a map
You can save a map of each map type for each instance in the map tree. The purpose of saving a map is
to override the default map of the selected type (for example, Group Membership or VLAN Connection)
for a specific device, IP network, VLAN, group, service, or application.
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To save a map, in the Map Console, select Map > Save Map. Click OK to acknowledge the informational
message that displays the location of the saved map. The map is saved in the
BASEDIR/smarts/consoles/<userid> directory on the host where the Global Manager is running.


Some changes you make to the map before saving are also saved. These changes can include:


n Adjusted scope (for example, expanded nodes)


n Node positions


n Layout type (circular, hierarchical, or manual)


n Filtered classes


n User-defined backgrounds


n Zoom level


If you use the Color-by-Root-cause toolbar button (tool tip labeled Toggle Root Cause Coloring) to
color a map, the map coloring is not saved.


If the topology changes after a map is saved, the changes are applied to the information displayed in
the map view when the map is redisplayed. (The saved map is updated only when the updated map
is saved.)


If you save a map that already exists in your userid directory for a specific element and map type, it is
replaced.


When you click a managed element in the map tree, the Global Console queries the Global Manager
for a saved map in the following order:


a The Global Manager checks your remote directory, the BASEDIR/smarts/local/consoles/<userid>
directory, for any saved maps for that element. If a saved map exists, it displays.


b If there is no saved map in your user directory, it then checks for a shared, saved map in the
BASEDIR/smarts/local/consoles directory on the host where the Global Manager is running.


c If a saved map exists in the /consoles directory for the selected element, it displays. If no map
exists, then the Global Console uses the default map for the selected element.


Sharing a saved map
To share a map saved in your directory with other users, in a UNIX shell, copy the saved map file from
your BASEDIR/smarts/local/consoles/<userid> directory to the BASEDIR/smarts/local/consoles directory
on the host where the Global Manager is running. Once the saved map has been copied to this directory,
all users of the Domain Manager have access to view the saved map. The map file naming convention is
described below.


Note   Write permission to the remote host directory is required for the copy operation.


To share a saved map with only selected users, copy the saved map file to the
BASEDIR/smarts/local/consoles/<userid> directory of each user who is to share the map.
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Map file naming convention
Maps are automatically assigned filenames by the Global Manager when they are saved. The filename
given is a combination of the Global Manager name, the instance name, and the map type represented
by a number. The suffix of the filename is icsvm. Table 22 on page 144 lists the numeric representation
for each map.


For example, an INCHARGE-SA Global Manager Physical Connectivity map of router moto-gw is
assigned the filename:


INCHARGE-SAmoto-gw1.icsvm


Printing a map
To print a map, in the Map Console, select Map > Print Map. In the window, you can select the following
buttons:


n Print — Prints your map. The Print dialog box for your default printer displays. Check your settings for
paper orientation and resolution if necessary. Click OK.


n Print Setup — Enables you to format your map as follows:


n To print the whole map with all nodes, select the Print Entire Graph option.


n To print the portion of the map that appears in the Map window, select the Print Current Window
option.


n To print selected elements that you have selected in the map, select the Print Current Selected
option.


n To title the print, type the name in the Caption box, ensure that the Print Caption checkbox is
selected. You can format the title using the Font button and the Position list box.


Also, you can format the print using the Margins, Multipage Printing and Other options.


Click OK.


n Zoom In and Zoom Out — To scale the map view.


n Fit In Window — Fits the map to the size of the panel.


n Close — Closes the window.


Printing Tool Output
When you invoke a tool such as Ping or Open Trouble Ticket from the Global Console, the output usually
displays in the Tool Output shortcut window.


To print the output:


1 Click Print . The Print dialog box for your default printer displays.


2 Check your settings for paper orientation and resolution if necessary.
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3 Click OK .


Using the Tool Output window includes additional information about tool output.


HyperNotif Statistics
HyperNotif Statistics is a debug tool that reports two specific kind of notification data, namely Client
Statistics and Server Statistics.


n Client Statistics — With respect to a Service Assurance Manager server, Client Statistics provides the
notification data statistics for notifications received from the underlying Service Assurance Manager
server.


Note   If the underlying Domain Manager is not a Service Assurance Manager 8.0 or later, then the
data will not be available as there are no HyperNotif transactions. In such cases, use the debug tool
dmdebug ---queues.


n Server Statistics — With respect to a Service Assurance Manager server, Server Statistics provides
notification data statistics for notifications sent to each of the HyperNotif client connected to the
Service Assurance Manager server. The HyperNotif Client can be:


n Service Assurance Manager Console


n Service Assurance Manager (Presentation server), under which lies this Service Assurance
Manager (Aggregate server).


Command
The command to run the HyperNotifStatistics tool:


#dmctl  -s <server name> invoke ICS_NLManager::ICS-NLManager reportHyperNotifStats


Sample output


SA-9.0_NL-Driver-HyperNotif     [1 worker(s)]


Current Size 0 , max 0; processed entries 0


SM_ProtocolEngine-1 19527 SA    [1 worker(s)]


Current Size 0 , max 27; processed entries 32


SM_ProtocolEngine-4 3340 IC Console - V9.1.0.0  [0 worker(s)]


Current Size 0 , max 26; processed entries 29


In the output:


n SA-9.0_NL-Driver-HyperNotif — Indicates the name of the thread along with the number of workers,
which is the number of threads in the process.


n Current size — Indicates the current size of the queue.


n Max — Indicates the maximum size of the queue, at any point in time. This is a historical data.
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n Processed entries — Indicates the total number of entries processed.


Note   The HyperNotif Connections are cleaned up only after 45 minutes of inactivity. Therefore, the
stale connections will be reported for that duration. For example, if a Service Assurance Manager
Console is detached, or if a Console is closed, and the command is run, then the output will still show
the stale connections.


VMware Smart Assurance Service Assurance Manager Operator Guide


VMware, Inc.  124







Customizing Your Console 10
The Global Console can be customized according to an operator’s preferences. This chapter describes
how to change the appearance of your console, customize it with views, and save the customized
console. Two examples of consoles illustrate these customization options.


This chapter includes the following topics:
n Changing the console appearance


n Adjusting Java properties


n Tailoring your console with views


n Saving a console


Changing the console appearance
This section describes how to control the display of the toolbar buttons and status bar, the layout of
multiple views, and how to revise the text in a console title bar.


Hiding the toolbar and status bar
In a Global Console, toolbar buttons are located below the menus and the status bar is located at the
bottom of the console. You can control the display of the toolbar and status bar. For example, if you prefer
to work without toolbar buttons, you can hide them:


n To hide the toolbar, select View > Toolbar to clear the Toolbar option.


n To hide the status bar, select View > Status to clear the Status option.


To re-display the hidden bar, reselect the appropriate option in the View menu.
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Changing the console layout of views
If your console consists of multiple views, you can change the console layout by rearranging the views. To
change the layout of a console:


1 Select File > Layout to display the Console Layout dialog box. In the Console Panel Layout section
of the dialog box, two list boxes appear:


n Panel determines which panel the Tile operation affects.


n Tile controls how multiple views in a panel are displayed. Right To Left places the views in a
row. Top To Bottom stacks them one on top of the next.


2 Click OK .


Note   You can also change the console layout while you are adding or copying views to a current
console. In the Add View or Copy View dialog boxes, use the Console Panel list box. Adding a view
or Copying a view in a current console provides additional information.


Changing the title of a console
If you want, you can revise or replace the console title. To change the text in the title bar of a console:


1 Select File > Layout to display the Console Layout dialog box.


2 In the Title field, type the new console name.


3 Click OK .


Adjusting Java properties
The -D option for the sm_gui command enables you to adjust specific Java properties that affect the
Global Console. For example, you can control the display of text for toolbar buttons, maps, and the font
that displays throughout the console. You can also redefine the Java log file location and specify the
connection timeout for the console.


Command syntax for the -D option
You can specify the sm_gui command with -D parameter options from UNIX command line. You can also
use sm_edit to add properties in the BASEDIR/smarts/conf/console/properties.conf file. When properties
are added to the properties.conf file, the -D parameter options are not used. The tutorial information
included in the properties.conf file provides additional information.


The -D option for the sm_gui command is:


tsm_gui -Dproperty1=value1 -Dproperty2=value2-D ... 


-Dpropertyn=valuen s
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Specify the -D option for each property/value pair. For example, to change the font to Arial and set the
font to 20 points, specify:


         sm_gui -Dcom.smarts.font=Arial -Dcom.smarts.fontSize=20


      


Properties and their acceptable values are listed in Properties and their values.


Table 10‑1.  Properties and their values


Property
Acceptable
value Description


com.smarts.securityMessage string Defines the name of the ASCII file containing the security
warning message.


Note   The file must be located in the directory where the
HTML and properties files are located.


com.smarts.server.logMessages true or false True — Causes the server to write messages to the server
log file.


False — Does not cause the server to write messages to the
server log file.


Note   The ServerMesg_<userid>.log is created when the
com.somarts.server.logMessages parameter is set to true.
This log contains all sever events associated with a specific
user. For example, if UserA is logged onto the system and
the com.smarts.server.logMessages parameter is configured
to true, messages would be written to
SeverMesg_UserA.log.


com.smarts.mapNodeText.font string Allows the user to define the map icon font.


Default value: Helvetica


com.smarts.mapNodeText.fontSize integer Allows the user to define the map icon font size.


Default value: 12 point


com.smarts.connectionTimeout integer


(in seconds)


This property indicates the maximum amount of time that
the console will wait for the Manager pulse check (the
upTime attribute) to respond. If there is no response within
the specified time, the console disconnects from the
Manager.


The default is 300 seconds (5 minutes).


Any integer between 1 - 89 is changed to a minimum value
of 90.


Zero (0) or any integer below disables the timeout.


com.smarts.font string Enables a user-specified font to display throughout the
Global Console. The font must be a Java-supported font
appropriate for the operating system or it is ignored. The
font should reside in the directory location as described by
Java documentation.


com.smarts.fontSize integer Enables a user-specified font size to display throughout the
Global Console. The font size must be compatible with the
com.smarts.font property or it is ignored.
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Table 10‑1.  Properties and their values (Continued)


Property
Acceptable
value Description


com.smarts.java.log fully qualified
filename


If specified, the Java log contents are saved to the specified
file. (The default is no file specified.)


com.smarts.informs user-defined
field


If specified, this property controls which underlying
Managers are accessible by using Browse Detail from the
Notification Log view. A user-defined field must be
configured to contain the names of the underlying
Managers. The
VMware Smart Assurance Service Assurance Manager
Configuration Guide includes information about customizing
user-defined notification attributes.


com.smarts.map.showAllBusiness true or false True — Shows all nodes and edges in a Business Services
map, including those that are not part of paths that originate
from or terminate at the map central node. (This is the
default.)


False — Shows the nodes and edges in a Business
Services map that either originate from or terminate at the
map central node.


com.smarts.map.showNormalBanner true or false True — Shows map nodes with the status of Normal with a
green color bar underneath the icon.


False — Shows map nodes with the status of Normal
without a green color bar underneath the icon. (This is the
default.)


com.smarts.mapBackgroundColor string Enables you to specify a single background color for all
maps. This parameter overrides the default color for all map
types. Note that if the setting you enter is invalid, the
background color for all maps will be white.


Use a six-character string, RRGGBB, where RR is a
hexadecimal value between 00 and ff (= 0 to 255),
specifying the red component; GG specifies the green
component; and BB specifies the blue component. For
example, to specify the beige color called “antique white” in
Netscape, the string is:


com.smarts.mapBackgroundColor=FAEBD7


Map background colors includes information on default
background colors.


com.smarts.maxFilterInstances integer Enables you to change the maximum number of instances
that will automatically display in the Topological Filter tab. 50
is the default. If a class has more instances than the
maximum number, you need to click Get instances to
retrieve a list.


smarts.maps.maxGroupMembers a positive
integer


A positive integer. This is the maximum number of members
of a leaf group that will display for a Group Membership map
without a prompt dialog box. The dialog box prompts the
operator when there is a large number of members to
display.


100 is the default.
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Table 10‑1.  Properties and their values (Continued)


Property
Acceptable
value Description


com.smarts.maxTopoInstances integer Enables you to change the maximum number of instances
that display for a class or relationship in the Topology
Browser.


The default is 1000. VMware, Inc. recommends not
changing the default unless it is necessary because it
affects performance and usability.


com.smarts.viewer.hideToolbarText true or false True — Hides the display text for the toolbar buttons. (This
is the default.)


False — Shows the text for the toolbar buttons.


com.smarts.viewer.map.disableMaps true or false True — Disables the display of maps.


False — Does not disable maps. (This is the default.)


smarts.allowBGjpegs true or false True — Allows map background files to be saved in jpeg
(.jpg) format.


False — Does not allow map background files to be saved
in jpeg format.


com.smarts.disable_keepalives integer Enables you to disable KeepAlive messages for the
Global Console. Specify a non-zero number to disable
KeepAlive messages. Zero (0) enables KeepAlive
messages.


com.smarts.log.level option Defines the level of messages written to the console java
log. Options include:
n FATAL
n SEVERE
n SERIOUS
n DEFAULT (default option)
n WARNING
n INFO
n CONFIG
n DEBUG
n TRACE


Note   Options are listed in order from display least
information to display most information.


com.smarts.securityEnabled true or false True — Enables security. (This is the default when the
sm_gui.exe is executed.)


False — Disables security.


Note   This property must be specifically declared and set to
true in the Web Console and in the viewlets.


smarts.remote.broker host:port Defines the default broker for domain attach dialog boxes.


com.smarts.writeable path string Defines the location of console logs.
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Table 10‑1.  Properties and their values (Continued)


Property
Acceptable
value Description


com.smarts.debugConnection true or false True — Causes the server to write all console operation
invocations received from the console to the server log file.


False — Does not cause the server to write console
operation invocations received from the console to the
server log file.


com.smarts.highLatency true or false True — Reduces the number of calls to the server to obtain
property values. Returns larger packets of data containing
bundled property values.


False — Smaller multiple calls are sent to the server to
obtain multiple property values.


The highLatency parameter can be added to any
Service Assurance Manager related dxa configuration file
used to import data from an underlying server that is part of
a high latency network environment. Examples of applicable
dxa configuration files include dxa-conn.conf, dxa-sam.conf,
and dxa-oi.conf. For the majority of configurations, the
highLatency parameter will apply to the presentation
Service Assurance Manager server (dxa-sam.conf) when
the underlying aggregation Service Assurance Manager
server is remotely located.


Note   Before updating the dxa-conn.conf file, back up the
file.


com.smarts.user.timezone timezone name Causes the console to format all times and timestamps
according to the specified time zone.


Examples of acceptable values are: PST for U.S. Pacific
Standard Time and GMT for Greenwich Mean Time.


The default is the time zone where the console is running.


Class TimeZone at the Java website includes additional
information.


Note   Older versions of the console used the Java
user.timezone parameter to change the time zone, but the
user.timezone parameter does not work with the Web
Console or Java Web Start.
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Table 10‑1.  Properties and their values (Continued)


Property
Acceptable
value Description


com.smarts.timestampFormat pattern-format
string


Overrides the default formatting of timestamps in the
console, for example, the First Notify, Last Notify, and Last
Change fields in the notification view.


An example of the default format is 28 Mar 17:08:09.


Using the new parameter, you can change this to a different
format. The following examples illustrate different
configurations of the com.smarts.timestampFormat
parameter:
n 03.28 17:08:09-0500 — Displays the local time zone


offset from GMT.
n 28 Mar 17:08:09 EDT — Displays the local time zone as


text.
n 07.03.28 17:08:09 — Displays the year.


To configure the com.smarts.timestampFormat parameter,
enter a Java SimpleDataFormat pattern-format string as the
value of the parameter.


The format language for constructing the pattern string is
specified in the Java J2SE 5.0 documentation, available
from the Sun website, in the description of the
java.text.SimpleDateFormat class.


For example, the console’s default timestamp format is: dd
MMM HH:mm:ss. The alternative formats illustrated above
have the following pattern strings:
n "03.28 17:08:09-0500" "MM.dd HH:mm:ssZ" (to display


the local time zone offset from GMT)
n "28 Mar 17:08:09 EDT" "dd MMM HH:mm:ss z" (to


display the local time zone as text)
n "07.03.28 17:08:09" "YY.MM.dd HH:mm:ss" (to display


the year)


Note   Characters in the format string are case
sensitive: "Z" means something different and will
produce different strings than "z".


com.smarts.oldGetMap true or false Defines whether the console retrieves map data as a string
or as formatted data. If set to true, the console retrieves map
data as formatted data.


Default value: False


com.smarts.getMap.timeout integer Defines the time, in seconds, that the Get Map function tries
to retrieve map data before the function times out. Once the
Get Map function times out, the Get map timed out message
appears.


Default value: 120
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Table 10‑1.  Properties and their values (Continued)


Property
Acceptable
value Description


com.smarts.clientTool.setEnv true or false Defines the method of passing parameters to client scripts.
If configured to true, the console directly loads parameters
passed to the client script into the environment.


If configured to false (or when a value is not specified), the
console passes parameters to the client scripts as command
line arguments and requires the client script to parse the
parameters to load them into the environment.


Note   Setting this property to false is backward compatible
for existing scripts that parse the command line parameters
and create environment variables. When this property is set
to true, the script does not receive any command line
parameters to parse, because the properties already exist
as variables in the environment, as if the script had parsed
and set them but without the script actually having to do so.


com.smarts.fasttopologybrowse option Defines whether the topology browser performance is
enhanced for displaying related instance information.
Options include:
n Off — Default value
n On — Speed up enhancement is activated with instance


information sorted
n Nosort — Speed up enhancement is activated with


instance information not sorted


Note   When configuring this property to nosort, relation
information displays more quickly in the topology tree in
high latency environments because instance names are
not sorted. When many related instances for a class are
displayed, specific instances may be difficult to locate
because instance names beginning with identical
characters may not be grouped together. For example,
when this property is configured to nosort, not all router
instances beginning with the characters Chicago may be
displayed together.


com.smarts.showDomainConsistsOf true or false Defines whether the InChargeDomainConsistsOf
relationship displays in the topology view. If configured to
false, the InChargeDomainConsistsOf relationship does not
display in the topology view reducing the possibility of the
console not responding. If configured to true, all the
information for the ConsistsOf relationship displays in the
topology view.


Default value: False


Increasing the Java heap space size
If the console runs out of memory, the maximum amount of heap space available to the console must be
adjusted by specifying the -H (or --heapsize=) parameter to the sm_gui command.
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The default heap allocation is 350 megabytes, which may not be sufficient for large or complex
deployments. (The previous default heap space size was 256 megabytes.) As heap space becomes close
to being fully allocated, the console tries to enter warning messages in the console’s Java Message Log.
But often, the memory is allocated in a single uninterrupted operation, resulting in no message being
written to the console’s Java Message Log. For example, during the initial loading of notifications at
startup time, if there are more than 60,000 notifications to be loaded and the available heap space is less
than 270 megabytes, the console may close down without any warning message. However, in this
example if just enough space is available, the console may become unresponsive due to Java’s attempts
to find space in a garbage collection.


To increase the Java heap space size, allocate additional heap space. For example, to allocate 800
megabytes of heap space, type the following from the command line:


         sm_gui -H800M <


         other -D parameters ...


         >


      


Tailoring your console with views
The Global Console is usually defined by one default view, console-specific toolbar buttons, and menus.
However, the Global Console can consist of multiple views. The following console views are available:
Notification Log, Map, Topology Browser, Summary, Status Table, Notification Properties, and
Containment.


You can customize a console to display multiple views. For example, you can add a Topology Browser
view to your Notification Log Console. Or, you can add three Notification Log views to a console; each
view using a filter for specific notifications. Or, you can customize a Notification Log view and copy it in
order to provide a consistent display and minimize your customization effort.


Note   The following types of views, Notification Log, Topology Browser, Summary, Status Table,
Notification Properties, and Containment, can be added, copied, or deleted in consoles. In the Map
Console, the default Map view cannot be added, copied, or deleted. Also, a Map view cannot be added to
a console. Unlike other types of consoles, there can only be one Map Console.


Availability of Dashboard viewlets includes additional information about which views are available through
the Global Console, Web Console, Business Dashboard, and third-party Web Portal products.


Adding a view
To add a view:


1 Select View > Add View.


The Add View dialog box appears.
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2 Click the View Type menu to list the available views. Select the view you want to add to the console.
(A custom view is one that has been developed by a programmer to work with the Notification Log
Console.)


3 Use the Console Panel list boxes to arrange views within the console:


n The Panel list box determines where the view appears within the console.


n The Tile list box determines how multiple views within the same panel are arranged. Views
that are oriented horizontally, such as Notification Log, usually display better when they are
tiled Top To Bottom.


4 Click OK .


Note   To add multiple views, reopen the Add View dialog box for each view you want to add.


Adding a custom view containing a Java component
To add a custom view containing a Java component in the console or in the Web console or dashboard:


1 Create a class derived from the component.


The component must be in a Java package that does not match any of the existing Java packages,
for example, com.<customercompanyname>.


2 Create a jar file containing compiled class file(s).


The jar file is specified in the SM_CLASSPATH variable of the runcmd_env.sh. This variable can also
be set in the individual command window. The fully qualified path of the jar file must be specified.


Example:


SM_CLASSPATH=C:\SAM-NEC4\SAM\smarts\local\classes\foreign.jar


3 From the console, select View > Add View > Custom View.


4 Type the full class path of the component in the Custom View field.


For example, if the component is compiled into the jar file as
com.<customercompanyname>.Ourview.class, type com.<customercompanyname>.Ourview.


The component appears in a new view in the console.


Note   To add a view containing a Java component for Java Web Start, you must have your private jar
file signed with the VMware certificate. Java Web Start requires all jar files to be signed with the same
certificate.


Copying a view in a current console
To copy a view in the current console:


1 Click the view you want to copy to activate it. The active view has a black border.


2 Select View > Copy View > Copy View. This displays the Copy View dialog box.
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3 Use the Console Panel list boxes to arrange views within the console:


n The Panel list box determines where the view appears within the console.


n The Tile list box determines how multiple views within the same panel are arranged. Views
that are oriented horizontally, such as Notification Log, usually display better when they are
tiled Top To Bottom.


4 Click OK .


Note   This option is not available for the Map view.


Copying a view to a new console
You can copy the following views to a new console: Notification Log, Topology Browser, and Summary.


To copy a view to a new console:


1 Click the view you want to copy to activate it. The active view has a black border.


2 Select View > Copy View > Copy View as new console.


The new console displays over the existing console.


Note   This option is not available for Status Table, Notification Properties, Containment, or Map.


Deleting a view
To delete a view from the console:


1 Click the view you want to delete to activate it. The active view has a dark gray border.


2 Select View > Delete View.


Saving a view as a dashboard viewlet
To save a view as a dashboard viewlet:


1 Select View > Save View As dashboard viewlet. The Configure Save View as dashboard viewlet
dialog box displays.


2 Select the manager from the list.


3 Click either Save for User or Save for Profile, and then select a user or user-profile from the list.


4 Select or type a name in the View Name field.


5 Click OK after your last selection. This immediately applies the parameters to the view and closes the
dialog box.


The VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide includes
additional information on deploying dashboard viewlets.
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Changing the title of a Notification Log view
To change the title of a Notification Log view:


1 Select Log > Log Properties to display the Log Properties dialog box.


2 In the Title field, type the new view name.


3 Click OK .


This is useful when you have multiple Notification Log views with different filtering criteria.


Context sharing concepts
You can set up context sharing so that a selected entity in one view determines the content that is
displayed in one or more other views. For example, you can set up context sharing so that each time you
select a notification in a Notification Log, a Map view displays a map for that notification. In this example,
the Notification Log acts as a source, while the Map view acts as a listener. Without context sharing, you
have to select a notification in the Notification Log, right-click, and select Show Map to display a map for
each notification.


Views can participate in context sharing as sources, listeners, or both. To enable context sharing, you
need to configure listening views as described in Setting up context sharing. Source and listening views
can also exist in separate consoles.


Source views and elements for context sharing shows the views that can act as sources and indicates
which entities you can select to change the content in listening views.


Table 10‑2.  Source views and elements for context sharing


Views that can act as sources Entity to select


Notification Log view Notification


Summary view Summary


Note   When you select a summary as a source, the Notification Log
configured as a listener displays the set of notifications associated with
that summary.


Map view Node or edge


Status Table view (source only) One of the following classes on the y-axis:
n ServiceOffering and subclasses
n ServiceSubscriber and subclasses
n HierarchicalGroup
n SelectiveGroup
n ApplicationGroup


Any instance on the x-axis.


Topology view (source only) Topology instance


The following views can act as listeners:


n Notification Properties (listen only)
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n Notification Log


n Summary


n Map


n Containment (listen only).


Context sharing roles and icons describes the context sharing roles, and shows the icons that display
when context sharing is implemented.


Table 10‑3.  Context sharing roles and icons


Role Description Icon


Source User selection in a source view changes the content in a listening view. --


Listener The content changes based upon user selection in a source view. Any filters set
for the listening view will continue to control the display.


--


In the title area, this icon indicates that a view is configured as a listener. The tool
tip for the icon indicates which entities the view is configured to listen to.


In the title area, this icon indicates that a view is actively listening (a user selection
in a source view is affecting the view).


When a Notification Log is configured as a listener, you can click this icon to
display the original notifications again.


In the Notification and Map view, the tool tip for the icon indicates the entity the
view is currently listening to.


Context sharing is disabled for a Notification Log view if the Freeze Display option is enabled. To enable
context sharing, first unfreeze the display by clicking the box icon in the title area. Freezing your display
includes additional information.


Setting up context sharing
To configure a view as a listener:


1 Select the view to make it active, and then select View > Listen to Context or click the Listen to
Context toolbar button. The Select Context To Listen To dialog box displays with the options that
are appropriate for that view.


2 Select one of the following options:


n Listen to ALL — Select all options that this view can listen to


n Collection Entity


n Instance


n Summary


n Notification


3 Click OK after your last selection. This immediately applies the parameter to the view and closes the
dialog box.
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Removing context sharing
To remove context sharing from a view:


1 Select the view to make it active, then select View > Listen to Context or click the Listen to Context
toolbar button. The Select Context(s) To Listen To dialog box displays.


2 Select Listen to NONE or any one of the available options that you do not want to listen to.


3 Click OK. The Listening to Context icons are removed from the listener view (if the view is no longer
listening to any option).


Saving a console
After you customize your console, you can save your console locally on the host where the Global
Console is running or remotely on the host where the Global Manager is running. Summary of saved
customizations summarizes the customizations and information that is saved for your console.


Table 10‑4.  Summary of saved customizations


What’s saved What’s not saved


Console customizations (hidden bars, layout, titles, views) Topology


Content customizations (filters and selections in the Column Sort
Order dialog box, except for Click Sort)


Click Sort selections


The names of the Global Managers you attached to The actual notifications or maps


Note   To save maps, you must save them separately (“Saving a map” on page 143 includes additional information.)


Console file naming conventions
In order for a console to be saved, you must follow these file naming conventions:


n Filenames must consist of letters, numbers, underscores, dashes, or any combination thereof.


n Filenames must not contain spaces.


Examples of recommended filenames are: Console_SA, SA-Map, or Notification-Log3Views.


Using Save
To save a console:


1 Select File > Save or click the Save toolbar button. The Specify save destination dialog box appears
if you are saving the console for the first time.


2 Click the Local button or the Remote button in the dialog box and perform the steps described in 
Saving a console locally, starting with step 2.


If you have previously saved the console, your customizations are saved accordingly and the Specify
save destination dialog box does not appear.
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Saving a console locally
To save a console locally:


1 Select File > Save As > Save Local As. This displays the Save Console dialog box.


2 Type a name for the console in the Object name field. For a previously saved console, the name
displays in the field. You can also specify another name with the extension .iccon.


3 Choose where you want to save the console or note the default location,
BASEDIR/smarts/local/consoles.


4 Click Save.


5 In the Select Domains to Reattach dialog box, select one or more Manager that the saved console
will automatically attach to when the console is opened. (To select multiple managers, press the Ctrl
or Shift key while making your selections.)


This command saves the console settings to a local file. Whenever you start a session, to use the
local console, you must open it from a running console (File > Open > Open Local).


Saving a console remotely
To save a console remotely:


1 Select File > Save As > Save Remote As. This displays the Save Remote Console dialog box, as
shown in Save Remote Console dialog box.


Figure 10‑1.  Save Remote Console dialog box


2 Select a location to save the console. Choose a Manager.


3 The Save as field lists the names of existing remote consoles. For a previously saved console, the
name displays in the field. You can also specify another name without the extension .iccon.


If a remote console name appears in the field, the existing console might be part of your user profile.
Contact your administrator to see if you should overwrite the existing console.


4 In the Select Domains to Reattach dialog box, select one or more Managers that the saved console
will automatically attach to when the console is opened. (To select multiple managers, press the Ctrl
or Shift key while making your selections.)


5 Click OK. To use the customized console, you must open it from a running console (File > Open >
Open Remote).
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6 (Optional) To share the console with other users, in a UNIX shell, copy the console file from the
BASEDIR/smarts/local/consoles/<userid> directory or the
BASEDIR/smarts/local/consoles/<user_profile> directory to the BASEDIR/smarts/local/consoles
directory on the remote host.


Note   Write permission to the remote host directory is required for the copy operation.
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Troubleshooting 11
This chapter includes the following topics:


n Common issues and resolutions


n Common issues for Companion UI


Common issues and resolutions
The following topics are included in this section:


n Checking Manager status


n Identifying a port number


n Refreshing the console


n Reattaching to a Manager


n Responding to disconnected Managers


n Accessing console message logs


Checking Manager status
If you do not know the operational status of your Manager, use the brcontrol command or the Browse
button in the Attach Manager dialog box to list the Managers and their status. The status listed for your
Manager should be Running. If your Manager is not running, contact your administrator, consult the
VMware Smart Assurance System Administration Guide, or refer to your specific product’s Installation
Guide for instructions on starting the Manager.


For the brcontrolcommand, type one of the command lines shown in The brcontrol command.


Table 11‑1.  The brcontrol command


Operating system Example


UNIX BASEDIR/smarts/bin/brcontrol


Identifying a port number
If you do not know the port number of a Manager, use the brcontrolcommand or the Browse button in the
Attach Manager dialog box to display the port number.
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Refreshing the console
If your console does not display properly, you can force the console to redisplay. For example, if
fragments of menus or fields from dialog boxes linger after the menus or dialog boxes close, you can
redisplay the console.


To refresh a console, select View > Refresh.


Reattaching to a Manager
Initially, when you log in to start a session, you specify the Manager to which you want to attach.
Ordinarily, you do not have to attach again during your session.


If the machine running Service Assurance becomes unavailable, the Global Console polls the broker
every 30 seconds and reattaches when the Manager is operational. Attaching to a Manager includes
instructions on manually attaching or reattaching to an VMware Smart Assurance Manager.


Note   If an VMware Smart Assurance Manager disconnects, a Domain Disconnected message appears
informing you that the manager disconnected and that the console will reconnect when the domain
becomes available.


Responding to disconnected Manager s
When underlying Managers disconnect from the Global Manager (for example, due to a network outage),
the notifications from the unavailable sources are not updated in the console. The affected notifications,
maps, and summaries no longer reflect the current conditions.


If a disconnect situation occurs, a Session Disconnected notification informs you that a specific Manager
is disconnected and a similar entry is added to the audit log.


When the Manager reconnects, the Session Disconnected notification clears, and it is recorded in the
audit log.


If you receive a Session Disconnected notification, your administrator should investigate it for a network
connection failure or an operational problem. The Manager may need to be restarted.


Accessing console message logs
The Global Console has two logs which are useful for troubleshooting:


n The Java console is the first tool to use for console debugging. It shows store exceptions, errors
reading attributes, and stack traces.


To collect the most information about potential console problems, specify the -
Dcom.smarts.log.level=TRACE property.


Java console information can automatically be saved to a file on your local workstation by specifying
the -Dcom.smarts.java.log=<filename> property. When specifying this property, the file is written in
the <SM_WRITEABLE>/logs directory.
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SM_WRITEABLE is an environment variable whose default value can be changed in the
runcmd_env.sh. Use this console information to assist with debugging issues.


Note   Before starting the console with the -Dcom.smarts.java.log=<filename> property, verify that the
<SM_WRITEABLE>/logs directory exists under BASEDIR/smarts/local.


n The message log shows everything the Manager sends to the console while the log window is
activated (opened or minimized).


This information can automatically be saved to a file on your local workstation by specifying the -
Dcom.smarts.server.logMessages=true property. When specifying this property, the file is written to
the <SM_WRITEABLE>/logs directory. Use this information to assist with debugging issues when the
console stops responding.


Note   Before starting the console with the -Dcom.smarts.server.logMessages=true property, verify
that the <SM_WRITEABLE>/logs directory exists.


To access the log views, select View > Java Console or View > Message Log.


In the Java console, the following warning is benign:


Warning: Could not get the full set of system properties


Common issues for Companion UI
The following topics are included in this section:


n HTTP error page


n Domain Manager not configured


n Internal error in the Global Manager, Global Console, or Smarts CUI


When you launch Companion UI from a selected notification in the Notification Log Console or view,
the following types of errors may appear as a web page in your browser.


HTTP error page
During launching if Companion UI encounters an error whereby it fails to access a service, an HTTP error
page appears in your browser.


For example, if the Tomcat service is not running, the following error appears:


404 Page Not Found
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Domain Manager not configured
If your Domain Manager is not configured as a data source in Companion UI , this error appears in your
browser:


Launch Companion UI: <domain name> not configured. Please contact your System Administrator.


Contact your Smarts CUI administrator for assistance. Also, the
VMware Smart Assurance SolutionPack Installation and Configuration Guide provides information about
adding data sources to Smarts CUI.


Internal error in the Global Manager , Global Console , or Smarts
CUI
If an internal error occurs in the top-level Global Manager, Global Console, or Companion UI, this error
appears in your browser:


Launch Companion UI: â€¦


In a Smarts CUI deployment, the top-level Global Manager is configured as the SAM Presentation Server.
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Wildcard Patterns 12
Types of wildcard patterns
A wildcard pattern is a series of characters that are matched against incoming character strings. You can
use these patterns when you define pattern matching criteria.


Matching is done strictly from left to right, one character or basic wildcard pattern at a time. Basic wildcard
patterns are defined in Basic wildcard patterns. Characters that are not part of match constructs match
themselves. The pattern and the incoming string must match completely. For example, the pattern abcd
does not match the input abcde or abc.


A compound wildcard pattern consists of one or more basic wildcard patterns separated by ampersand
(&) or tilde (~) characters. A compound wildcard pattern is matched by attempting to match each of its
component basic wildcard patterns against the entire input string. Compound wildcard patterns are listed
in Compound wildcard patterns.


If the first character of a compound wildcard pattern is an ampersand (&) or tilde (~) character, the
compound is interpreted as if an asterisk (*) appeared at the beginning of the pattern. For example, the
pattern ~*[0-9]* matches any string not containing any digits. A trailing instance of an ampersand
character (&) can only match the empty string. A trailing instance of a tilde character (~) can be read as
“except for the empty string.”


Note   Spaces are interpreted as characters and are subject to matching even if they are adjacent to
operators like “&”.


Table 12‑1.  Basic wildcard patterns


Character Description


? Matches any single character.


For example, server?.example.com matches server3.example.com and serverB.example.com, but not
server10.example.com.


* Matches an arbitrary string of characters. The string can be empty.


For example, server*.example.com matches server-ny.example.com and server.example.com (an empty
match).
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Table 12‑1.  Basic wildcard patterns (Continued)


Character Description


[set] Matches any single character that appears within [set]; or, if the first character of [set] is (^), any single
character that is not in the set. A hyphen (-) within [set] indicates a range, so that [a-d] is equivalent to
[abcd]. The character before the hyphen (-) must precede the character after it or the range will be empty.
The character (^) in any position except the first, or a hyphen (-) at the first or last position, has no special
meaning.


For example, server[789-].example.com matches server7.example.com through server9.example.com,
but not server6.example.com. It also matches server-.example.com.


For example, server[^12].example.com does not match server1.example.com or server2.example.com,
but will match server8.example.com.


<n1-n2> Matches numbers in a given range. Both n1 and n2 must be strings of digits, which represent
nonnegative integer values. The matching characters are a non-empty string of digits whose value, as a
nonnegative integer, is greater than or equal to n1 and less than or equal to n2. If either end of the range
is omitted, no limitation is placed on the accepted number.


For example, 98.49.<1-100>.10 matches a range of IPv4 addresses from 98.49.1.10 through
98.49.100.10.


Example of an omitted high end of the range: <50-> matches any string of digits with a value greater than
or equal to 50.


Example of an omitted low end of the range: <-150> matches any value between zero and 150.


For a more subtle example: The pattern <1-10>* matches 1, 2, up through 10, with * matching no
characters. Similarly, it matches strings like 9x, with * matching the trailing x. However, it does not match
11, because <1-10> always extracts the longest possible string of digits (11) and then matches only if the
number it represents is in range.


| Matches alternatives. For example, ”ab|bc|cd” without spaces matches exactly the three following strings:
“ab”, “bc”, and “cd”. A | as the first or last character of a pattern accepts an empty string as a match.


Example with spaces “ab | bc” matches the strings “ab” and “ bc”.


\ Removes the special status, if any, of the following character. Backslash (\) has no special meaning
within a set ([set]) or range (<n1-n2>) construct.


Special characters for compound wildcard patterns are summarized in Compound wildcard patterns.


Character Description


& “And Also” for a compound wildcard pattern. If a component basic wildcard pattern is preceded by & (or is the
first basic wildcard pattern in the compound wildcard pattern), it must successfully match.


Example: *NY*&*Router* matches all strings which contain NY and also contain Router.


Example: <1-100>&*[02468] matches even numbers between 1 and 100 inclusive. The <1-100> component
only passes numbers in the correct range and the *[02468] component only passes numbers that end in an
even digit.


Example: *A*|*B*&*C* matches strings that contain either an A or a B, and also contain a C.


~ “Except” for a compound wildcard pattern (opposite function of &).If a component basic wildcard pattern is
preceded by ~, it must not match.


Example: 10.20.30.*~10.20.30.50 matches all devices on network 10.20.30 except 10.20.30.50.


Example: *Router*~*Cisco*&*10.20.30.*~10.20.30.<10-20>* matches a Router, except a Cisco router, with an
address on network 10.20.30, except not 10.20.30.10 through 10.20.30.20.
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Preface 1
As part of an effort to improve its product lines, VMware periodically releases revisions of its software and
hardware. Therefore, some functions described in this document might not be supported by all versions of
the software or hardware currently in use. The product release notes provide the most up-to-date
information on product features.


Contact your VMware technical support professional if a product does not function properly or does not
function as described in this document.


Note   This document was accurate at publication time. Go to VMware Online Support docs.vmware.com
to ensure that you are using the latest version of this document.


This chapter includes the following topics:


n Purpose


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n VMware Smart Assurance Service Assurance Manager


n Related documentation


n Suggestions for searching PDF files


n Conventions used in this document


n Pathname conventions


n Graphical conventions


n Manager


n Where to get help


n Your comments


Purpose
The purpose of this guide is to provide information about how VMware Smart Assurance Service
Assurance Manager Notification Adapters manage the flow of data between your Global Manager (or
Domain Manager) and other applications or locations on the network.
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Audience
This guide is intended for administrators who are responsible for deploying, installing, and configuring the
Global Manager. IT managers who seek to understand the role of the Global Manager in the context of an
VMware Smart Assurance solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should also read the
VMware Smart Assurance Service Assurance Manager Deployment Guide and the
VMware Smart Assurance System Administration Guide Guide.


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<productsuite>.


For example, on UNIX operating systems, VMware Smart Assurance Service Assurance Manager is,
by default, installed to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than /opt/InCharge (on UNIX)
but you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.


VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System


n Global Console


n Business Dashboard


n Companion UI


n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)


n VMware Smart Assurance Adapter for UIM/O


n XML Adapter
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Related documentation
In addition to this document, VMware Corporation provides a help system for command line programs as
well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n VMware Smart Assurance Documentation Catalog


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ICIM Reference


n VMware Smart Assurance ASL Reference Guide


n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide


VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes


n VMware Smart Assurance Open Source License and Copyright Information


n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


n VMware Smart Assurance Service Assurance Manager Deployment Guide


n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide


n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide
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n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Installation and Configuration Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance Companion UI Open Source License and Copyright Information for GPLv3
as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1 If the documentation is not accessible to all users of the VMware Smart Assurance product, copy the
contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a shared drive on
your LAN, so that operators and others can view the documentation.


2 To search throughout the documentation library, open the Acrobat Reader software:


3 Select Edit > Search, and type a word or phrase.


4 Select All PDF Documents in, in the Where would you like to search option, and type the
pathname of the location where the PDF documents reside.


If you have more than one VMware Smart Assurance product installed, you can set up cross-product
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each product into
this common documentation directory path.


Conventions used in this document
VMware uses the following convention for special notices:


Note   NOTICE is used to address practices not related to personal injury.


Typographical conventions
VMware uses the following type style conventions in this document:


Bold Use for names of interface elements


Italic Use for full titles of publications referenced in text
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Monospace
Use for:
n System output, such as an error message or script
n System code
n Pathnames, filenames, prompts, and syntax
n Commands and options


                      
  Monospace italic
                     


Use for variables.


                      
  Monospace bold
                     


Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example


Pathname conventions
Directory pathnames are shown with forward slashes (/).


Graphical conventions
Under UNIX, the consoles appear with slight differences. For example, in views that display items in a
tree hierarchy such as the Topology Browser, an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to VMware Smart Assurance programs
such as Domain Managers, Global Managers, and adapters.


Where to get help
VMware support, product, and licensing information can be obtained as follows:


Product information


For documentation, release notes, software updates, or information about VMware products, go to
VMware Online Support at:


docs.vmware.com


Technical support
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Go to VMware Online Support. You will see several options for contacting VMware Technical Support.
Note that to open a service request, you must have a valid support agreement. Contact your VMware
sales representative for details about obtaining a valid support agreement or with questions about your
account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:docs.vmware.com.
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Introduction 2
This chapter includes the following topics:


n Overview


n Implementing adapters


Overview
Use an VMware Smart Assurance Notification Adapter (notifier) to pass information contained in
VMware Smart Assurance Service Assurance Manager notifications to other applications or to users. For
example, you can use a notifier to:


n Convert notifications into email messages or SNMP traps


n Write the notification text to a log file


n Execute a script upon receiving a notification


Notification adapters and descriptions describes the purpose of each notifier.


Table 2‑1.  Notification adapters and descriptions


Adapter Description


Email Notifier Adapter Sends notifications from a Global Manager to specific addresses in an email
system


Log File Notifier Adapter Logs notifications from a Global Manager to a file


SNMP Trap Notifier Adapter Converts notifications into SNMP traps and sends the traps to specified locations


Script Notifier Adapter Calls a custom script when a notification is received


VMware Smart Assurance Adapter for
TIBCO Rendezvous


Publishes notifications as TIB/Rendezvous messages so that other
TIB/Rendezvous applications can subscribe (listen) to them


Note   VMware, Inc. recommends using the notification adapters with the
VMware Smart Assurance Service Assurance Manager (Global Manager). The notification adapters,
except for the VMware Smart Assurance Adapter for TIBCO Rendezvous, may also be used with
Domain Managers.


The following are additional examples of typical notifier usage:


n Write notifications to a log.
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n Execute a program, such as a paging service or email, upon receipt of a notification.


n Extend and get additional information about a notification:


n Get the impact when you receive a notification.


n Get the system location of a failing device.


n Open a trouble ticket using a third-party package.


Implementing adapters
This section describes the high-level tasks necessary to configure and start notification adapters. Before
you begin, ensure that the VMware Smart Assurance Service Assurance Manager is properly installed
and functional. The notification adapters are installed automatically as part of SAM. The
VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers contains
additional information. This document assumes the adapters are installed:


1 If the notification adapter is already running, stop it. “Starting and stopping notification adapters” on
page 23 contains instructional information.


2 Verify the parameters in your adapter’s configuration file. If necessary, use the sm_edit utility to
modify them. For example, you might need to define a destination or modify the default value of the
serverName parameter to match the name of your Global Manager or Domain Manager.


Configuration files on page 20 and the respective adapter chapter contains detailed instructions.


3 Verify the SubscribesTo section in your adapter’s configuration file. The default subscription is for a
Global Manager. If the adapter needs to subscribe to a Domain Manager, then you need to modify
the file. Specifying subscriptions in the configuration file contains additional information.


4 Check that the appropriate authentication is set in the security configuration files. “Securing access”
on page 22 contains additional information.


5 Start the notification adapter. “Starting and stopping notification adapters” on page 23 contains
additional information.
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Running the Notification
Adapters 3
This chapter includes the following topics:


n Configuration files


n Securing access


n Starting and stopping notification adapters


n Logging notification adapter history


Configuration files
When a notifier starts, it reads a configuration file (*.conf). Original versions of the adapter configuration
files are installed to the BASEDIR/smarts/conf/notifier directory. Retain the original (unedited) version of
each configuration file. If you intend to modify a configuration file, use the sm_edit utility provided with
your VMware Smart Assurance software. This will ensure that you modify a copy of the file and this copy
is placed in the proper local subdirectory. Editing notification adapter files contains additional information
on modifying files and using sm_edit. Notification adapter configuration files lists the name of each
notifier’s configuration file.


Table 3‑1.  Notification adapter configuration files


Adapter Configuration filename


Email Notifier Adapter mail-notify.conf


Log File Notifier Adapter file-notify.conf


SNMP Trap Notifier Adapter trap-notify.conf


Script Notifier Adapter script-notify.conf


VMware Smart Assurance Adapter for TIBCO Rendezvous tibrv-notify.conf


The configuration files for each of these notifiers share some common parameters and subscription
information. The configuration files are text files.


Note   Whenever you modify a configuration file, you must stop and restart the notifier for the changes to
take effect.
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Editing notification adapter files
As part of the VMware Smart Assurance deployment and configuration process, you need to modify
certain files. User modifiable files include configuration files, rule set files, templates, and files (such as
seed files, and security configuration files) that contain encrypted passwords. Original versions of these
files are installed into appropriate subdirectories under the BASEDIR/smarts/ directory.


Original versions of files should not be altered. If a file requires modification, it must be stored as a local
copy of the file in BASEDIR/smarts/local or one of its subdirectories.


Example 1: Modify serverConnect.conf
In UNIX:


n The original version of the server connect (serverConnect.conf) security configuration file on UNIX is
installed to:


/opt/InCharge/SAM/smarts/conf


n A modified serverConnect.conf security configuration file on UNIX should be saved to:


/opt/InCharge/SAM/smarts/local/conf


n VMware Smart Assurance software is designed to first search for user modifiable files in
BASEDIR/smarts/local or one of its subdirectories. If a modified version of a file is not found in the
local area, VMware Smart Assurance software then searches appropriate non-local directories.


To facilitate proper file editing, VMware Corporation provides the sm_edit utility with every
VMware Smart Assurance products. When used to modify an original version of a file, this utility
automatically creates a local copy of the file and places it in the appropriate location under
BASEDIR/smarts/local. This ensures that the original version of the file remains unchanged. You can
invoke sm_edit from the command line.


To invoke the sm_edit utility from the command line, specify the path and the name of the file to edit
under BASEDIR/smarts. If multiple VMware Smart Assurance products are running on the same host,
invoke sm_edit from the bin directory of the product with the files to edit.


Example 2: Edit a configuration file
To edit the configuration file for connecting to a server (serverConnect.conf), invoke the sm_edit utility as
follows:


         /opt/InCharge/SAM/smarts/bin>sm_edit conf/serverConnect.conf
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In this example, the sm_edit utility automatically creates a local copy of the serverConnect.conf file in
the /opt/InCharge/SAM/smarts/local/conf directory and opens the file in a text editor. If a local version of
the file already exists, the sm_edit utility opens the local version in a text editor. In addition, sm_edit
creates any necessary subdirectories.


The VMware Smart Assurance System Administration Guide provides additional information about the
sm_edit utility.


Specifying subscriptions in the configuration file
The notifiers can subscribe to either an VMware Smart Assurance Service Assurance Manager (Global
Manager) or to a Domain Manager.


To indicate which notifications (or event information) the adapter will process, you specify this in the
Subscriptions section of the notifier’s configuration file. VMware Corporation recommends that you
subscribe to the Global Manager.


By default, the notifiers subscribe to a Global Manager. To subscribe to a Domain Manager, you must
uncomment the code in the Subscriptions section and comment out the code for the Global Manager
(insert a # character at the beginning of the lines that are not needed).


VMware Smart Assurance Service Assurance Manager
You use a notification list to subscribe an adapter to a Global Manager. For example, to subscribe the Log
File Notifier Adapter to the default notification list, use the following:


SubscribesTo = 


 {


GA_NLSubscription::file-Default-NLSubscriptions


 {


  NLName = "Default"


 }


}


VMware Smart Assurance Domain Manager
Use the choice subscription to subscribe an adapter to a Domain Manager (for example, Availability
Manager). For example, to subscribe the SNMP Trap Notifier Adapter the VMware Smart Assurance
Adapter for TIBCO Rendezvousto all problems reported in a Domain Manager, use the following:


SubscribesTo =


{


 GA_ChoiceSubscription::trap tibrv-All-Problems-Subscriptions


 {


  className = ".*"


  instanceName = ".*"


  eventName = ".*"


  problems = TRUE
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  aggregates = FALSE


  symptoms = FALSE


 }


}


Securing access
Before you start your notification adapter, check that the appropriate authentication is set in the security
configuration files. Depending on your adapter, you will need to modify default values or add
authentication records to one or both of these files:


n The clientConnect.conf file since the notification adapter acts as a client when it connects to an
VMware Smart Assurance Manager.


n The serverConnect.conf file if the notification adapter acts as a server and is registered with the
VMware Smart Assurance Broker. Table sm_notify parameters and descriptions lists the name
parameters used to register the notification adapter with the Broker. A notification adapter acting as a
server will need to authenticate incoming connections from users or other applications.


These security configuration files are located in the BASEDIR/smarts/conf directory of the
VMware Smart Assurance Service Assurance Manager.


The VMware Smart Assurance System Administration Guide contains information about security and
configuring the clientConnect.conf and serverConnect.conf files.


Starting and stopping notification adapters
This section describes how to use:


n The sm_notify command to start notification adapters. This method is useful if you intend to run the
adapter once for a short period of time. For example, if you need to run a Log File Notifier Adapter to
log notifications for testing purposes, use the sm_notify command. Using sm_notify to start
notification adapters contains additional information.


n Platform commands to stop notification adapters that were started with sm_notify. Stopping a
notification adapter contains additional information.


n The sm_service utility to install notification adapters as services. This method is recommended if you
intend to run the adapter for a long period of time and want it to start automatically when the system
starts. For example, if a notification adapter is part of your deployment, manually install the adapter
as a service. Installing a notification adapter as a service contains additional information.


n The sm_service utility to start and stop services. Starting and stopping a service contains additional
information.


Note   The installation process installs notification adapters but does not configure them to run as
services. However, you can use the sm_service utility to install the notification adapters as services
at any time.
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Using sm_notify to start notification adapters
You start these notifiers manually. To start the notifiers, use the following syntax:


tBASEDIR/smarts/bin/sm_notify --output[=<file>]


[<param> ...] <notifier> s


where <param> is one or more of the parameters listed in sm_notify parameters and descriptions and
<notifier> is one of the following: mail, file, trap, script, or tibrv.


Note   The command must be typed as one line.


Notification adapters and names defines the Notification adapters names.


Table 3‑2.  Notification adapters and names


Adapter Adapter name


Email Notifier Adapter mail


Log File Notifier Adapter file


SNMP Trap Notifier Adapter trap


Script Notifier Adapter script


VMware Smarts Adapter for TIBCO Rendezvous tibrv


Use additional parameters with the sm_notify command to override information about the Global
Manager or the Broker, change logging information, or run the notifier as a daemon (UNIX only). 
sm_notify parameters and descriptions lists some of the parameters that can be set for sm_notify.


Table 3‑3.  sm_notify parameters and descriptions


Parameter Description


--server=<name> Sets the VMware Smart Assurance Manager connection.


If this is not specified, the notifier uses the value in the configuration file.


--broker=<location> Overrides the use of the variable SM_BROKER (Environment variable in UNIX ).


The format of <location> is <host>:<port>


--name=<notifier_name> Specifies a name for the notifier. The name is used to register the notifier with the
Broker.


This parameter is rarely used unless directed by VMware Global Services.
Notification adapters are not required to be registered with the Broker.


Starting a new log file contains additional information.


--daemon Runs the process as a daemon (UNIX only).


--output[=<file>] Redirects the output (stdout and stderr) to BASEDIR/smarts/local/logs/<file>.log by
default. The filename is <file>, or the --logname value if <file> is omitted.


If you run multiple instances of the same notifier on the same machine, you must
specify an output location for each of the log files. The notifiers cannot write to the
same log file.
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Table 3‑3.  sm_notify parameters and descriptions (Continued)


Parameter Description


--conf[=<conf_file>] Specifies the configuration file to use for the notifier.


If this is not specified, the notifier uses the default configuration file, <notifier>-
notify.conf in BASEDIR/smarts/conf/notifier.


This parameter is useful if you need to use the sm_notify command to start more
than one notifier (such as two Email Notifier Adapters) on a single host. Since each
notifier references a unique configuration file, the notifiers can be configured to
behave differently by, for example, subscribing to different notifications or sending
the notifications to different locations.Starting the customized notification adapter
contains additional information.


--confdir[=<dir>] Specifies the location (directory) of the notifier’s configuration file.


If this is not specified, the notifier uses the default directory,
BASEDIR/smarts/conf/notifier.


This parameter can also be used to start multiple copies of a notifier on the same
host or it can be used to start many notifiers from a centrally located set of
configuration files.


<notifier> Notification adapter. Acceptable values are: mail, file, trap, script, or tibrv.


For additional information about the sm_notify command, type:


         BASEDIR/smarts/bin/sm_notify --help


      


Running multiple copies of a notification adapter
If you want to start more than one copy of the same notifier, for example, to use two Log File Notifier
Adapters with a different Global Manager or to have two Email Notifier Adapters subscribe to different
notifications from the same Global Manager, you should use the --conf or --confdir parameters.


Stopping a notification adapter
To stop a notifier, terminate the process in UNIX. (Starting and stopping a service contains additional
information if the notification adapter was manually installed as a service.)


UNIX
To terminate the process in UNIX, locate the process ID and then terminate the process:


% ps -elf | grep sm_notify


janedoe  14563 3830  0 14:38:14 pts/35   0:01 sm_notify mail


% kill 14563


Installing a notification adapter as a service


Note   To use the sm_service utility to install a service or start a service, you must have administrative
privileges on the local host.
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The syntax for the sm_service install command for a notification adapter is:


tBASEDIR/smarts/bin/sm_service install --force 


--name=<service_name> --startmode=<mode>


--description="<DESC>"


BASEDIR/smarts/bin/sm_notify --output[=<file>] [<param> ...] <notifier> s


The parameters for the sm_service install command are described in sm_service install parameters and
descriptions.


The sm_service install command uses the same sm_notify parameters as previously described in 
Installing a notification adapter as a service. The exception is the --daemon parameter which is not
applicable for the sm_service utility.


Table 3‑4.  sm_service install parameters and descriptions


Parameter Description


--force Overwrites an existing service with the same name. This parameter is used to update
or modify the parameters of an existing service.


--name=<service_name> Display name of the service.


--startmode=<mode> Service start policy. The value for <mode> is one of the following:
n Runonce (start automatically when sm_serviced starts)
n Automatic (starts automatically when sm_serviced does not detect that it is


running)
n Manual (requires an explicit start request)
n Disable (cannot be started)


The default is runonce.


--description="<DESC>" Short description of the service. Enclose the description with double quotation marks.


On UNIX platforms, the description information is printed with the name of the
service when the sm_service show action is invoked.


--env=<NAME>=<VALUE> Specifies environment variables. This parameter is required for the VMware Smarts
Adapter for TIBCO Rendezvous. “Setting environment variables” on page 7-5
contains additional information on specifying TIBCO libraries.


A <NAME>=<VALUE> pair that will be placed in the process environment of the
launched service. As many --env pairs as necessary can be specified.


The syntax <NAME>= (with no specified value) has the effect of unsetting <NAME>
in the environment of the launched program.


The --env arguments are applied left to right as they appear on the command line,
and this ordering is preserved in the database.


Examples of the sm_service install command
To manually install the program for an Email Notifier Adapter as a service, issue:
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UNIX


t# /opt/InCharge/SAM/smarts/bin/sm_service install --force --name=ic-email_notifier-adapter


--startmode=manual


--description="SMARTS E-Mail Notifier Adapter"


/opt/InCharge/SAM/smarts/bin/sm_notify 


--output=mail-output 


--server=INCHARGE-SA


mail s


To manually install the program for VMware Smart Assurance Adapter for TIBCO Rendezvous as a
service, issue:


UNIX:


t# /opt/InCharge7/SAM/smarts/bin/sm_service install --force --name=ic-tibrv_notifier-adapter


--startmode=manual


--description="SMARTS TIBCO Rendezvous Adapter"


--env=SM_PATH_PREPEND=TIBRV/bin


--env=SM_LIBPATH=TIBRV/lib


/opt/InCharge7/SAM/smarts/bin/sm_notify


--output


--server=INCHARGE-SA


tibrv s


TIBRV represents the actual location of the TIB/Rendezvous software.


The VMware Smart Assurance System Administration Guide contains additional information about using
the sm_service utility.


Starting and stopping a service
To start or stop a service manually, use the sm_service utility.


To start a service, issue the command:


sm_service start <service_name> [<service_name> ...]


To stop a service, specify stop instead of start.


For example, to start an Email Notifier Adapter that has been manually installed as a service, issue:
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UNIX


t# /opt/InCharge/SAM/smarts/bin>./sm_service start 


ic-email_notifier-adapter s


Logging notification adapter history
When the --output option is specified for the sm_notify command, each notifier stores its working history
in a log file. Every time a notifier starts, when errors occur, or when the connection with a Global Manager
is lost, the notifier writes information to the log file.


Each notifier writes its log file to BASEDIR/smarts/local/logs. When the notification notifiers run on the
same machine, specify a unique name for the log file of each notifier.


All log files have a .log file type. The default name of a log file is based on the program’s name. For a
notification adapter, the default name of the log file is sm_notify.log. To change the default name, specify
a filename with the --output option for the sm_notify command. For example, for an Email Notifier
Adapter, specify --output=MailAdapter and the name of the log will be MailAdapter.log.


VMware Smart Assurance software can maintain up to 1,000 different copies of backup log files. The
number of saved log files is determined by the value of the SM_BACKUP_FILE_LIMIT environment
variable. When an adapter starts up, it renames a file that matches its log filename and adds a .bak to the
name (for example, MailAdapter.log to MailAdapter.log.bak). If a file with this name already exists, it is
renamed MailAdapter.log.bak.NNN, and a new MailAdapter.log.bak is created. By default,
VMware Smart Assurance programs save two log files, which do not include the active log file.


Starting a new log file
You can request that an adapter create a new log file, often referred to as rolling over a log file. Typically,
this is done when a log file becomes quite large. Log files grow indefinitely, though slowly under normal
conditions.


Most notification adapter log files are small and rolling over a log file is not necessary. However, if you
need to start a new log file, use the following methods:


n For UNIX systems only, use the kill command.


n For UNIX use the roll_log command.


You can repeat the log file roll-over process as many times as you like. If you need to retain log files
beyond the limit specified by the SM_BACKUP_FILE_LIMIT environment variable, you should copy or
at least rename the .log.bak files as soon as they are created. The
VMware Smart Assurance System Administration Guide contains additional information about
managing and rolling over log files.
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The kill command method for UNIX systems
On UNIX systems only, it is possible to request that a notifier “roll over” its log files. You do this by sending
a SIGUSR1 signal to the process ID writing the log file. Use the kill command of your shell:


% kill -USR1 <pid>


Upon receipt of the USR1 signal, a notifier first writes an informational message to the end of the current
log file, repeats the steps it executed at startup, and creates a new log file and a backup log file as
previously described.


The roll_log command method
The roll_log command is invoked through the dmctl utility, which requires that you attach to the adapter
with administrative privileges.


Note   Use the roll_log command to register the notification adapter with the Broker using the --name
option. Using sm_notify to start notification adapters contains additional information.


The syntax of the command is:


roll_log [<file-name>]


The <file-name> option enables you to specify a new name for current and subsequent log files. If you
omit this option, the current naming convention is retained. If you specify a name, the new log file uses
that name. Any new log files created with roll_log will also use this name if a different name is not
specified. The new name specified by <file-name> is handled in exactly the same manner as the --output
option to the sm_notify command.


On UNIX systems, the equivalent command is:


t% /opt/InCharge/SAM/smarts/bin/dmctl -s MailAdapter exec roll_log s


When roll_log is invoked, the adapter writes an informational message to the end of the current log file,
repeats the steps it executed at startup, and creates a new log file and a backup log file as previously
described.
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Email Notifier Adapter 4
This chapter includes the following topics:


n Email Notifier Adapter overview


n Configuring the Email Notifier Adapter


Email Notifier Adapter overview
The Email Notifier Adapter sends email, based on notifications, to a designated list of users using an
SMTP server.


All notifications received by the Email Notifier Adapter are sent as email to one or more users, as shown
in Email Notifier Adapter. The Email Notifier Adapter sends the same information to all of the recipients.


Figure 4‑1.  Email Notifier Adapter


The Email Notifier Adapter sends information about event notifications. By default, it does not send
information when an event is cleared.


Each email sent has the form:


Subject:


NOTIFY <Affected_Instance_Name> <Event_Name>


Body:


InCharge Server <serverName>:


NOTIFY <Class_Name> <Affected_Instance_Name> <Event_Name> 


(<Certainty %>)


<Event_Description>
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Configuring the Email Notifier Adapter
The file, mail-notify.conf, configures the notifier. The original version of the file is located in
BASEDIR/smarts/conf/notifier. You should retain the original (unedited) version of the configuration file. A
local copy should be made if you intend to make any modifications. If you intend to modify a configuration
file, you should use the sm_edit utility provided with your VMware Smart Assurance software. This will
ensure that you modify a copy of the file and that the copy is placed in the proper local subdirectory. 
Editing notification adapter files contains additional information on modifying files and using sm_edit.


If you modify the configuration file while the notifier is running, you will need to restart the notifier so that it
rereads its configuration file.


Email Notifier Adapter parameters
Before you start this notifier, you must set values for the following parameters:


n MailServer


n SenderID


n Recipients


The other parameters may remain unchanged. You can also change the subscriptions for this notifier. 
Specifying subscriptions in the configuration file contains additional information. Email Notifier
Adapter parameters and descriptions describes each Email Notifier Adapter parameter.


Table 4‑1.  Email Notifier Adapter parameters and descriptions


Parameter Description


serverName Default name of the VMware Manager to connect to.


The default is INCHARGE-SA.


eventSmoothingInterval Time that an event must remain active before the notifier sends a notification.


This parameter is used only if the notifier is subscribed to a Domain Manager.


If the notifier is subscribed to a Global Manager, this parameter is not applicable and the
value is 0 seconds.


The default is 0 seconds.


minimumCertainty Threshold above which notifications are sent. Any notification with a certainty below the
threshold is discarded. This value must be a number between 0.0 and 1.0.
Service Assurance uses the value from the NotificationList definition.


The default is a certainty of 0.01.


initialEventDelay Time interval the notifier should wait after it connects to the VMware Manager before
accepting events.


The default is 0 seconds.


MailServer Name of the mail server. For example:


MailServer = "localhost"
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Table 4‑1.  Email Notifier Adapter parameters and descriptions (Continued)


Parameter Description


SenderId Email address associated with the notifier. Users can reply to this address. This address
must be recognized by the mail server. For example:


SenderID = "daemon@localhost"


Recipients Comma-separated list of the recipients of the emails. The recipients in the list must be
recognized by the mail server. For example:


Recipients = "root@localhost,recipient@your_company.com"


Chapter 10 Customizing a Notification Adapter contains additional information about customizing a
notification adapter.
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Log File Notifier Adapter 5
This chapter includes the following topics:
n Log File Notifier Adapter overview


n Configuring the Log File Notifier Adapter


Log File Notifier Adapter overview
The Log File Notifier Adapter writes notifications (that it subscribes to) to a file. This notification file can
include event notifications (including cleared events). The output is a single line with the following fields:


Current_Time 


Event_Type 


Class_Name 


Affected_Instance_Name 


Event_Name 


Certainty 


Event_Description


The notifier saves the notification file to the BASEDIR/smarts/local/logs directory. By default, the name of
the file is:


<InCharge_Manager>-alarms.log


Log File Notifier Adapter illustrates how the Log File Notifier Adapter receives notifications and adds them
to a notification file.


Figure 5‑1.  Log File Notifier Adapter


VMware, Inc.  26







Configuring the Log File Notifier Adapter
The configuration file, file-notify.conf, configures the notifier. The original version of the file is located in
BASEDIR/smarts/conf/notifier. You should retain the original (unedited) version of the configuration file. If
you intend to modify a configuration file, you should use the sm_edit utility provided with your
VMware Smart Assurance software. This ensures that you modify a copy of the file and the copy is
placed in the proper local subdirectory.


Do not change any of the parameters in the configuration file before starting this notifier. If you decide to
change a parameter, use the sm_edit utility to edit the configuration file. Editing notification adapter files
contains additional information on modifying files and using sm_edit.


If you edit the configuration file while the notifier is running, restart the notifier so that it rereads its
configuration file.


Log File Notifier Adapter parameters
Log File Notifier Adapter parameters and descriptions describes each parameter for the
Log File Notifier Adapter. Specifying subscriptions in the configuration file contains additional information
on optionally changing the subscriptions for this notifier to receive different types of notifications.


Table 5‑1.  Log File Notifier Adapter parameters and descriptions


Parameter Description


serverName Default name of the VMware Manager to connect to.


The default is INCHARGE-SA.


eventSmoothingInterval Time that an event must remain active before the notifier sends a notification.


This parameter is used only if the notifier is subscribed to a Domain Manager.


If the notifier is subscribed to a Global Manager, this parameter is not applicable and
the value is 0 seconds.


The default is 0 seconds.


minimumCertainty Threshold above which notifications are sent. Any notification with a certainty below
the threshold is discarded. This value must be a number between 0.0 and 1.0.
Service Assurance uses the value from the NotificationList definition.


The default is a certainty of 0.01.


initialEventDelay Time interval the notifier should wait after it connects to the VMware Manager before
accepting events.


The default is 0 seconds.


fileName Full name of the notification file. The name cannot contain path separators.


If you do not assign a value, the name of the notification file is <InCharge_Manager>-
alarms.log.


Chapter 10 Customizing a Notification Adapter contains additional information.
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SNMP Trap Notifier Adapter 6
This chapter includes the following topics:


n SNMP Trap Notifier Adapteroverview


n Configuring the SNMP Trap Notifier Adapter


SNMP Trap Notifier Adapter overview
The SNMP Trap Notifier Adapterconverts notifications into SNMP traps. This notifier sends the traps to
specific trap receivers on the network as shown in SNMP Trap Notifier Adapter.


Figure 6‑1.  SNMP Trap Notifier Adapter


Note   The SNMP Trap Notifier Adaptersupports SNMP V1, SNMP V3, and V2C traps.


All traps sent by the SNMP Trap Notifier Adapterinclude the same information:


n Agent Address = IP address for host running the notifier


n Enterprise OID = enterprises.733 (Full OID is .1.3.6.1.4.1.733)


n Generic Trap Number = 6


n Varbind sequence always the same for all of the traps


Trap typesshows the types of traps the SNMP Trap Notifier Adaptersends.


Table 6‑1.  Trap types


Trap name Trap number


smTrapNotification 4


smTrapNotificationClear 7


smTrapNotificationChange 98


smTrapNotificationDelete 99
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Varbinds of the SNMP Trapsshows the varbinds of the SNMP Traps the
SNMP Trap Notifier Adaptersends.


Table 6‑2.  Varbinds of the SNMP Traps


Varbind name Varbind number Description


smNotifTimestamp enterprises.733.2.1.1.0 Timestamp of the notification. (unsigned 32-bit
integer)


smNotifServer enterprises.733.2.1.2.0 Name of the Global Managersending notifications to
the SNMP Trap Notifier Adapter. (string)


smNotifClass enterprises.733.2.1.3.0 Class name associated with an event. (string)


smNotifInstance enterprises.733.2.1.4.0 Instance display name associated with an event.
(string)


smEventName enterprises.733.2.1.5.0 Event name. (string)


smNotifInstanceID enterprises.733.2.1.6.0 Combination of class name and the instance name
(as stored in the repository). Has the form < class
name>::< instancename>. (string)


smNotifDescription enterprises.733.2.1.7.0 Description of the event. (string)


smNotifCertainty enterprises.733.2.1.8.0 Printed value of a floating point number that is the
certainty of an event. (string)


smNotifSeverity enterprises.733.2.1.9.0 Severity of the event. (integer)


Chapter 13 VMware Smart AssuranceMIB for SNMP Trapscontains additional information on the
VMware Smart AssuranceMIB implemented by VMware, Inc.for SNMP Traps.


Configuring the SNMP Trap Notifier Adapter
The file, trap-notify.conf, configures this notifier. The original version of the file is located in
BASEDIR/smarts/conf/notifier. You should retain the original (unedited) version of the configuration file. To
modify the configuration file, use the sm_edit utility provided with your VMware Smart Assurance
software. This will ensure that you modify a copy of the file and that the copy is placed in the proper local
subdirectory. Editing notification adapter files contains additional information on modifying files and using
sm_edit.


If you edit the configuration file while the notifier is running, restart the notifier so that it rereads its
configuration file.


SNMP Trap Notifier Adapter parameters
Before this notifier will work, you must set values for the destinations. The other parameters may remain
unchanged. SNMP Trap Notifier Adapter parameters and descriptions describes the parameters for the
SNMP Trap Notifier Adapter. Specifying subscriptions in the configuration file contains additional
information on changing the subscriptions for this notifier.
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Table 6‑3.  SNMP Trap Notifier Adapter parameters and descriptions


Parameter Description


serverName Default name of the VMware Manager to connect to.


The default is INCHARGE-SA.


eventSmoothingInterval Time that an event must remain active before the notifier sends a notification.


This parameter is used only if the notifier is subscribed to a Domain Manager.


If the notifier is subscribed to a Global Manager, this parameter is not applicable and the
value is 0 seconds.


The default is 0 seconds.


minimumCertainty Threshold above which notifications are sent. Any notification with a certainty below the
threshold is discarded. This value must be a number between 0.0 and 1.0.
Service Assurance uses the value from the NotificationList definition.


The default is a certainty of 0.01.


initialEventDelay Time interval the notifier should wait after it connects to the VMware Manager before
accepting events.


The default is 0 seconds.


Destinations Table of destinations for the SNMP traps.


Each row consists of three different values: hostname or IP address, port number, and
SNMP version. The values are separated by commas. Surround each row with curly
braces. Each row is also separated from the next by a comma. Also, surround the
complete set of rows with curly braces.


The format for the destinations parameter is:


Destinations = { {"host_or_IP", port_number, "SNMP_Version"}


             }


You need to surround each single destination with a pair of curly braces and the entire set of destinations
with another pair of curly braces. Even for a single destination, you must use both pairs of braces. For
multiple destinations, separate each destination with a comma.


Surround the hostname or IP address with quotation marks.


Valid values for SNMP_Version are V1 and V2C. You must use uppercase letters and quotation marks.


An example of destinations:


Destinations = { {"localhost", 162, "V1"},


               {"other-host", 30162, "V2C"}


             }


Chapter 10 Customizing a Notification Adapter contains additional information on customizing a
notification adapter.
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Script Notifier Adapter 7
This chapter includes the following topics:


n Script Notifier Adapter overview


n Configuring the Script Notifier Adapter


n Script Notifier Adapter compared with sm_adapter automated tools


Script Notifier Adapter overview
The Script Notifier Adapter allows you to automatically take an action when a notification is received.
Upon receiving a notification, the Script Notifier Adapter invokes a custom script supplied by you that
performs user-defined actions. For example, you can create a Script Notifier Adapter to send a page,
using a paging service. Another Script Notifier Adapter might invoke an audible alarm when mission
critical notifications are received.


Script Notifier Adapter illustrates how the Script Notifier Adapter receives notifications and invokes a
script.


Figure 7‑1.  Script Notifier Adapter


Configuring the Script Notifier Adapter
The configuration file, script-notify.conf, configures this notifier. The original version of the file is located in
BASEDIR/smarts/conf/notifier. Retain the original (unedited) version of the configuration file. To modify a
configuration file, use the sm_edit utility provided with your VMware Smart Assurance software. This will
ensure that you modify a copy of the file and the copy is placed in the proper local subdirectory. Editing
notification adapter files contains additional information on modifying files and using sm_edit.


If you edit the configuration file while the notifier is running, restart the notifier so that it rereads its
configuration file.


For the Script Notifier Adapter to function, create a script to perform the desired action. Whenever the
notifier receives a notification, it will call the script you created. Save your custom script in
BASEDIR/smarts/local/actions. The Script Notifier Adapter arguments for your script are located in
BASEDIR/smarts/local/rules/notifier/script/script-custom.asl.
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You also need to change the scriptName parameter in the script-notify.conf file. To do this, delete the #
character at the beginning of the line and replace the string “myScript” with the name of the custom script
you want to run.


The script files must have appropriate read/execute permissions, and must return an exit status of 0 for
success and non-zero for failure.


Script Notifier Adapter parameters
Script Notifier Adapter parameters and descriptions describes each parameter for the
Script Notifier Adapter. Specifying subscriptions in the configuration file contains additional information on
changing the subscriptions for this notifier to receive different types of notifications. Chapter 10
Customizing a Notification Adapter contains additional information on customizing a notification adapter.


Table 7‑1.  Script Notifier Adapter parameters and descriptions


Parameter Description


serverName Default name of the VMware Manager to connect to.


The default is INCHARGE-SA.


scriptName Base name of the script to execute. The name cannot contain path separators. The
custom script resides in BASEDIR/smarts/local/actions.


eventSmoothingInterval Time that an event must remain active before the notifier sends a notification.


This parameter is used only if the notifier is subscribed to a Domain Manager.


If the notifier is subscribed to a Global Manager, this parameter is not applicable and the
value is 0 seconds.


The default is 0 seconds.


minimumCertainty Threshold above which notifications are sent. Any notification with a certainty below the
threshold is discarded. This value must be a number between 0.0 and 1.0.
Service Assurance uses the value from the NotificationList definition.


The default is a certainty of 0.01.


initialEventDelay Time interval the notifier should wait after it connects to the VMware Manager before
accepting events.


The default is 0 seconds.


Script Notifier Adapter compared with sm_adapter
automated tools
VMware Smart Assurance Service Assurance Manager also provides the sm_adapter command line
option, which can automate a server tool (script). The following summarizes functional differences
between an automated tool action and a Script Notifier Adapter action:


n Automated Service Assurance actions execute on the Global Manager by the user running the
Global Manager (with all the security implications, and the overhead for the Global Manager process);
Script Notifier Adapter actions run on any sm_notify adapter host (with all the connectivity
implications), by any user. The VMware Smart Assurance System Administration Guide contains
additional information on security implications.
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n Parameters to automate Service Assurance actions are passed as environment variables,
preconfigured (hard-coded) by VMware, Inc.; parameters to Script Notifier Adapter actions are
passed from the script-custom.asl, and are user configurable.


n Automated Service Assurance actions can return an output to the caller; Script Notifier Adapter
actions can only return a status.


n Script Notifier Adapter actions are synchronous; by default, automated Service Assurance actions are
synchronous as well, but you can use asynchronous actions if you make minor modifications to the
auto-action.asl file.


n Script Notifier Adapter actions can be used with any VMware Smart Assurance application, not just
Service Assurance; meaning you can subscribe and trigger a Script Notifier Adapter action upon
receipt of a notification from any VMware Smart Assurance application.


The VMware Smart Assurance Service Assurance Manager Configuration Guide contains additional
information about automated tools.
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Notification Adapter Framework 8
ASL scripts overview
The notification adapter framework is comprised of five ASL scripts (rulesets) that control the operation of
a notification adapter. Each notification adapter uses its own version of each ASL script. Each ASL script
performs a specific function. The original versions of the ASL scripts are located in
BASEDIR/smarts/rules/notifier/<adapter_name>, where <adapter_name> is the name of the notification
adapter (for example, mail, file, trap, script, or tibrv).


Typically, it is unnecessary to edit the ASL scripts. This is reserved for more advanced adapter
customizations. However, if you want to customize an adapter, retain the original (unedited) version of the
ASL scripts. To modify an ASL script, use the sm_edit utility provided with your
VMware Smart Assurance software. This will ensure that you modify a copy of the file and the copy is
placed in the proper local subdirectory. Editing notification adapter files contains additional information on
modifying files and using sm_edit.


If you edit the file while the notifier is running, restart the notifier so that it rereads its framework script file:


n Init <adapter_name>-init.asl


n Sync <adapter_name>-sync.asl


n Filter <adapter_name>-filter.asl


n Notify <adapter_name>-notify.asl


n Custom <adapter_name>-custom.asl


For example, the Log File Notifier Adapter's scripts are: file-init.asl, file-sync.asl, file-notify.asl, file-
filter.asl, and file-custom.asl.


Notification adapters scripts contains descriptions for the ASL scripts associated with each of the
notification adapters and indicates whether an ASL script is intended to be modified during the
customization process.
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Table 8‑1.  Notification adapters scripts


ASL script filename
To be
modified Description


Init


<adapter_name>-init.asl


No Invoked when the adapter starts and shuts down. Adapter-
specific initialization and preshutdown tasks are included in this
script.


Sync


<adapter_name>-sync.asl


No Invoked whenever the adapter connects or disconnects from a
Domain Manager. This script is used for synchronization with
the Domain Manager.


Filter


<adapter_name>-filter.asl


Yes This ASL script is the first to run during normal event
processing. Its purpose is twofold:
n It can filter out events, terminating further processing.
n It may initiate customizations that will occur before main


processing.


Within this script, add the “sentByCustom = TRUE” flag in
order to execute customizations.


Notify


<adapter_name>-notify.asl


No This ASL script is responsible for processing notifications and
contains most of the processing directions. It performs the
defined actions such as sending traps or emails.


Custom


<adapter_name>-custom.asl


Yes This is the last ASL script invoked during normal event
processing. Any customizations to be made belong in this ASL
script.


Chapter 10 Customizing a Notification Adapter contains additional information on customizing an adapter.
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Attributes 9
Overview of current event object attributes
Notification adapters receive events from Domain Managers or notifications from Global Managers. The
information from the event or notification is available in the Notification Adapter in a current event object.
The attributes of this object describe the properties of the notification or event such as the time the event
occurred, the name of the object where the event occurred, the type of event, and additional information.


The filter, notify, and custom scripts, described in Chapter 8 Notification Adapter Framework utilize the
current event object to access the attributes of an event or notification. In these scripts, the variable
currentEvent represents the current event object. For example, the following code may be used to access
the instance display name from a notification:


x = currentEvent->icInstanceDisplayName;


Current event object attributes for events from Domain Manager
Current event object attributes for events from Domain Managers describes the attributes contained in
current event objects in the Notification Adapter generated by a Domain Manager. When customizing the
notification adapters, use these attributes to retrieve the specific information you require regarding each
event.


All attributes for timestamps represent units of time in seconds. The attribute’s value is the number of
seconds since January 31, 1970 (Greenwich Mean Time, GMT).


Table 9‑1.  Current event object attributes for events from Domain Manager s


Notification attribute Type Description


icCertainty Float Confidence that this notification is the correct diagnosis. Value
ranges from 0 to 100.


icClass String The class of the object triggering the event.


icClassDisplayName String The display class name of the object that triggered the event.


icDisplayName String The display name of the object triggering the event.
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Table 9‑1.  Current event object attributes for events from Domain Manager s (Continued)


Notification attribute Type Description


icDisplayType String Display string of the notification type that abstracts the difference
between the notifications from the Global Manager and the events
from the Domain Manager (for example, NOTIFY, CLEAR, and
TIMER_ALARM).


Note   The icType field contains the detailed type information.


icEventDescription String The event description.


icEventDisplayName String The event name, which has the same value as icEvent.


icEvent String The event name.


Note   The attribute icEventName is also available for backward
compatibility and has the same value as icEvent.


icEventType String The event type. The valid types are:
n PROBLEM
n SYMPTOM
n EVENT
n AGGREGATION


icId String A unique identification for this event.


As previously received notifications are cleared (CLEAR), or
changed (CERTAINTY_CHANGE), these new messages have the
same ID as the original event (NOTIFY).


Customizations to the ASL scripts that need to match such
messages should use this attribute.


icInstance String The instance name of the object triggering the event.


icInstanceDisplayName String Name of the instance that is displayed to the user.


icIsRoot Boolean TRUE if the notification is a root cause, FALSE if not.


icServerName String The name of the Domain Manager that notified the event.


icSystemDescription String Description of the system specified in the icSystemName field.


icSystemName String The display name of the computer system most closely associated
with the event. In cases where there is no relevant system, the
attribute’s value will be an empty string.
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Table 9‑1.  Current event object attributes for events from Domain Manager s (Continued)


Notification attribute Type Description


icSystemType String Type of the system specified in icSystemName field.


The attribute’s value may be an empty string, the
DisplayClassName of the system’s class, or one of the following:
n HOST
n ROUTER
n SWITCH
n HUB
n SERVER
n BRIDGE
n REPEATER
n PROBE
n OTHER
n TERMINALSERVER


icTimestamp Integer The time when the Domain Manager notifies a client about an
event, clears an event, or changes the certainty of an event.


icType String Notification Type. The valid types are:
n NOTIFY
n CERTAINTY_CHANGE
n CLEAR


Current event object attributes for notifications from
Global Manager
Current event object attributes for events from the Global Manager describes the attributes contained in
current event objects in the Notification Adapter generated by the Service Assurance Global Manager.
When customizing the notification adapters, combine these attributes to include the specific information
you require regarding each notification.


All attributes for timestamps represent units of time in seconds. The attribute’s value is the number of
seconds since January 31, 1970 (Greenwich Mean Time, GMT).


Table 9‑2.  Current event object attributes for events from the Global Manager


Notification attribute Type Description


icAcknowledged Boolean TRUE if the notification is acknowledged, FALSE if not.


icActive Boolean TRUE if the event is active, FALSE if not.
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Table 9‑2.  Current event object attributes for events from the Global Manager (Continued)


Notification attribute Type Description


icCategory String Type of notification sent by the Global Manager. For example:
n Availability
n Discovery
n Error
n Operational
n Performance
n PowerSupply
n Resource
n Temperature


icCertainty Float Confidence that this notification is the correct diagnosis. Value
ranges from 0 to 100.


icClass String Class of the object triggering the event.


icClassDisplayName String The display class name of the object triggering the event.


icDisplayName String Display name for the instance that triggered this event. This value
is the same as icInstanceDisplayName.


icDisplayType String Display string of the notification type that abstracts the difference
between the notifications from the Global Manager and the events
from the Domain Manager (for example, NOTIFY, CLEAR, and
TIMER_ALARM).


Note   The icType field contains the detailed type information.


icElementClassName String Class name of the managed element most closely related to this
event. The attribute’s value may be an empty string.


icElementName String Name of the managed element most closely related to this event.
The attribute’s value may be an empty string.


icEvent String Event name such as DOWN or NOT RESPONDING.


icEventDescription String Description of the event.


icEventDisplayName String The event name. This has the same value as icEvent.


icEventType String The event type. The valid event types are:
n MOMENTARY
n DURABLE


icFirstNotifiedAt Integer Timestamp of the first notification.


icId String A unique identification for this notification.


As previously-received notifications are cleared (NL_CLEAR),
these new messages have the same ID as the original notification
(NL_NOTIFY).


Customizations to the ASL scripts that need to match such
messages should use this attribute.


icImpact Integer Numeric value that indicates the effect of this event on related
elements.


icInMaintenance Boolean TRUE if the device is in maintenance mode, FALSE if not.


icInstance String Instance name of the object that triggered the event.
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Table 9‑2.  Current event object attributes for events from the Global Manager (Continued)


Notification attribute Type Description


icInstanceDisplayName String Display name for the instance triggering this event. This value is
the same as icDisplayName.


icIsRoot Boolean TRUE if the notification is a root cause; FALSE if not.


icIsProblem Boolean Yes indicates if (and only if) at least one of the source event types
is “PROBLEM”, and other source event types are either
“PROBLEM” or “UNKNOWN.”


No indicates that one or more of the source event types is
“EVENT” or “AGGREGATE.”


Since filtering on IsRoot can result in transient behavior when
events are received from multiple underlying sources, it is
recommended to filter on IsProblem instead.


icLastChangedAt Integer Timestamp, in seconds, when the notification was last changed.


icLastClearedAt Integer Timestamp, in seconds, when the notification was last cleared.


icLastNotifiedAt Integer Timestamp when the Global Manager was last notified of the
occurrence of this notification.


icNLObjectName String The object name of the notification list that generated this
notification.


icNotificationName String Name of the notification object. It can be used to retrieve additional
information about the notification not sent to the adapter by default.


icOccurrenceCount Integer Number of times the notification occurred.


icOwner String Name of the person responsible for this notification. Value is
SYSTEM when acknowledged by the Global Manager.


icServerName String Name of the VMware Manager to whom the adapter listens.


icSeverity Integer Level of severity for the notification:


1 = CRITICAL


2 = MAJOR


3 = MINOR


4 = UNKNOWN


5 = NORMAL


Note   Only the numbers, not the text descriptions are contained in
this attribute.


icSourceDomainName String A comma-separated list of sources for this notification.


These are names of the underlying notifying sources. There may
be more than one in case underlying sources have an overlapping
topology.


icSourceEventType String Indicates the type of event from an underlying source or sources.
Value can be: PROBLEM, EVENT, AGGREGATE, or UNKNOWN.
The default value is UNKNOWN. (Not to be confused with Event
Type.)


icSystemDescription String Description of the system specified in the icSystemName field.
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Table 9‑2.  Current event object attributes for events from the Global Manager (Continued)


Notification attribute Type Description


icSystemName String The display name of the computer system most closely associated
with the event. In cases where there is no relevant system, the
attribute’s value will be an empty string.


icSystemType String Type of the system specified in icSystemName field.


The attribute’s value may be an empty string, the
DisplayClassName of the system’s class, or one of the system’s
class such as HOST, ROUTER, or SWITCH.


icTimestamp Integer The time when the Global Manager notifies a client that a change
occurred for the notification.


For the Global Manager, note that the following attributes are
typically used instead of icTimestamp: icFirstNotifiedAt,
icLastChangedAt, icLastClearedAt, and icLastNotifiedAt.


icTroubleTicketId String Trouble ticket ID.


icType String Notification Type. The valid types are:
n NL_NOTIFY
n NL_CHANGE
n NL_CLEAR
n NL_DELETE
n TIMER_ALARM


Note   Now the notification adapters do not send notifications
for NL_CHANGE or NL_DELETE event types. You cannot use
an adapter to inform another application about notification
changes or deletions.


icUserDefined1-10 String Ten user-defined fields. Reserved for custom configuration.
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Customizing a Notification
Adapter 10
This appendix describes how to customize a notification adapter and contains the following information:


n Customization overview


Note   The tasks are essentially the same for all the notification adapters. Specific adapter
parameters are described in previous chapters.


It also provides an example procedure for customizing the Email Notifier Adapterto display specific
Service Assurancenotification information.


Customization overview
To customize a notification adapter:


1 Stop the notification adapter if it is running


2 Modify the Filter script.


3 Modify the Custom script.


4 Modify the configuration file.


5 Start the notification adapter.


Modifying local copies of files
Original versions of the ASL and configuration files for adapters should not be changed:


n The original versions of the ASL scripts are located in
BASEDIR/smarts/rules/notifier/<adapter_name>, where <adapter_name> is the name of the
notification adapter (for example, mail, file, trap, script, or tibrv).


n The original versions of the adapter configuration files are installed to the
BASEDIR/smarts/conf/notifier directory.


Use the sm_edit utility to edit the configuration and rules files to ensure that the original versions are
retained and that modified files are saved to the proper local directory. Editing notification adapter
files provides additional information on using sm_edit.
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Stopping the notification adapter
If you are currently running a notification adapter, stop it before making any customizations. Stopping a
notification adapter and “Starting and stopping notification adapters” on page 23 contains detailed
instructions.


Modifying the filter script
The filter script, <adapter_name>-filter.asl, filters network events from being processed any further as
notifications and also contains some instructions for processing notifications that will utilize the notification
adapter. Add a variable, sentByCustom, which invokes the script running the customization actions you
want from the custom script, <adapter_name>-custom.asl.


To modify the filter script:


1 Using sm_edit, open the filterscript.


2 Add the following line for the sentByCustom variable to the end of the script (as shown in bold type):


...


START() {


/* 


 * Filter cleared events.


 */


OMIT_CLEAR_EVENTS()


 do { 


  if (currentEvent->icType == "CLEAR"


   || currentEvent->icType == "NL_CLEAR" )


  { currentEvent->filterMe = TRUE;


currentEvent->sentByCustom = TRUE;


  }


  }


 }


3 Save the modified script. The sm_edit utility automatically saves the script to the appropriate local
directory, located in BASEDIR/smarts/local/rules/notifier.


Email Notifier Adapter example: Modifying the mail-filter.asl script
To customize an Email Notifier Adapter, add the sentByCustom variable to the mail-filter.asl script. In
addition, you need to modify the filter script to send emails when a notification is cleared:


1 Using sm_edit, open the mail-filter.asl script. Open the file using the following command:


t BASEDIR/smarts/bin>sm_edit rules/notifier/mail/


mail-filter.asl s
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2 Add the following line for the sentByCustom variable to the end of the script (as shown below in bold
type).


By default, when a network problem is resolved and a CLEAR notification is received, an email is not
sent to the administrators involved in the repair. Within the mail-filter.asl script, you can use the
filterMe variable to indicate whether or not you want an email to be delivered when a notification is
cleared (when the problem is resolved).


To have emails sent on CLEAR notifications, change the filterMe = TRUE Boolean value to FALSE
(as shown in bold type):


...


START() {


/* 


 * Filter cleared events.


 */


OMIT_CLEAR_EVENTS() filter { 


    (currentEvent->icType == "CLEAR" || currentEvent->icType 


     == "NL_CLEAR")


} do {


                   currentEvent->filterMe = FALSE;


currentEvent->sentByCustom = TRUE;


}


 }


3 Save the modified script. The sm_edit utility automatically saves the script to the
BASEDIR/smarts/local/rules/notifier/mail directory.


Modifying the custom script
The custom script, <adapter_name>-custom.asl, contains the details of the script. Modifying the custom
script allows you to specify which combination of notification attributes will be included in the adapter’s
output (for example, an email, information sent to a file or custom script, and SNMP traps, and TIBCO
Rendezvous messages).


Chapter 9 Attributes contains a list of attributes and their descriptions.


To modify the custom script:


1 Using sm_edit, open the customscript.


2 Add or comment out the attributes.


3 Save the modified script. The sm_edit utility automatically saves the script to the appropriate local
directory, located in BASEDIR/smarts/local/rules/notifier.


Email Notifier Adapter example: Modifying the mail-custom.asl script
For an Email Notifier Adapter, the mail-custom.asl script contains the details of the script. Modifying the
mail-custom.asl script allows you to specify which combination of notification attributes will be included in
the email.
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To modify the mail-custom.asl script:


1 Using sm_edit, open the mail-custom.asl script. For example:


t BASEDIR/smarts/bin>sm_edit rules/notifier/mail/mail-custom.asl s


2 Add the notification attributes for the subject and body of the email message you want generated for
the notification.


For example, if you want to add the timestamp attribute to the subject and the event type attribute to
the body of the email message, edit mail-custom.asl as follows (the bold attributes indicate the
modifications):


START() {


    local subject = "";


    local body = "";


} filter {


    /*


     * Only send here if sentByCustom is TRUE.


     */


    (currentEvent->sentByCustom)


} do {


subject = currentEvent->icTimestamp." ". 


currentEvent->icDisplayType." ".


currentEvent->icInstanceDisplayName." ".


currentEvent->icEventDisplayName;


    body = ("  InCharge Server " . serverName . ":\n " .


            currentEvent->icDisplayType . " " .


            currentEvent->icClassDisplayName . " " . 


            currentEvent->icInstanceDisplayName . " ".


currentEvent->icEventType . " ".


currentEvent->icEventDisplayName .


" (" . string(currentEvent->icCertainty) . "%):\n " .


            currentEvent->icEventDescription . "\n");


    mailer->sendmail(sender, recipients, subject, body) ? LOG,STOP;


}


3 Save the modified script. The sm_edit utility automatically saves the script to the
BASEDIR/smarts/local/rules/notifier/mail directory.


Modifying the configuration file
When you start and run a notification adapter, it reads a configuration file, <adapter_name>-notify.conf.
Use the following procedure to modify the configuration file to run your customizations.
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If you are developing multiple customized notification adapters with different subscriptions, you need a
configuration file for each adapter. For each notification list (in Service Assurance) or event subscriptions
(in IP Availability Manager) you subscribe to, create an individual configuration file:


Note   Whenever you modify a configuration file, stop and restart the notifier for the changes to take
effect.


1 Using the sm_edit utility, open the configuration file:


tBASEDIR/smarts/bin>./sm_edit conf/notifier/<adapter_name>-notify.confs


2 Add the following lines to specify the ASL scripts that contain your customizations. The lines should
be added to the end of the file below the initialEventDelay parameter:


filterRuleSet = "notifier/mail/mail-filter.asl"


customRuleSet ="notifier/mail/mail-custom.asl" 


3 Modify the SubscribesTo parameter if necessary.


By default, the notifiers subscribe to a Global Manager. To subscribe to a Domain Manager, you must
uncomment the code in the Subscriptions section and comment out the code for the Global Manager
(insert a # character at the beginning of the lines that are not needed). Specifying subscriptions in the
configuration file contains additional information.


4 Modify other adapter parameters as desired.


Note   For information about parameters and their acceptable values, see the chapter for the
individual notification adapter.


5 Save the modified configuration file. The sm_edit utility automatically saves the file to the
BASEDIR/smarts/local/conf/notifier directory.


Email Notifier Adapter example: Modifying the mail-notify.conf file
For an Email Notifier Adapter, the configuration file is mail-notify.conf:


Note   Whenever you modify a configuration file, you need to stop and restart the notifier for the changes
to take effect.


1 Using the sm_edit utility, open the configuration file:


BASEDIR/smarts/bin>./sm_edit conf/notifier/mail-notify.conf


2 If you are developing multiple customized notification adapters, rename the configuration file, giving
the file a relevant name (for example, if you are going to customize the Email Notifier Adapter to send
emails for all problems related to Routers, you could name the file mail-notify-Router.conf). The
sm_edit utility automatically saves this file to the BASEDIR/smarts/local/conf/notifierdirectory.
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3 Modify the file to change the name of the Domain Manager or Global Manager:


serverName = <YOUR_INCHARGE_MANAGER>


4 Define the hostname of the appropriate mail server:


MailServer = "localhost"


5 Definethe recipients for the notification email. Multiple email addresses should be separated by a
comma:


Recipients = "root@localhost,recipient@your_company.com"


6 Define the email address of the sender. This address will display in the From field of the email
message:


SenderId = "daemon@localhost"


7 Add the following lines to specify the ASL scripts that contain your customizations. The lines should
be added to the end of the file below the initialEventDelay parameter:


filterRuleSet = "notifier/mail/mail-filter.asl"


customRuleSet ="notifier/mail/mail-custom.asl" 


8 Modify the SubscribesTo parameter to define the specific notifications for which you want email alerts
sent.


For a Global Manager, you indicate which notifications generate


emails by defining a notification list in the Subscriptions section:


 SubscribesTo = 


         {


              #


              # NL subscription.


              #


              GA_NLSubscription::mail-Default-Subscriptions


              {


                       NLName = "Default"


              }


         }


9 Save the modified configuration file. The sm_edit utility automatically saves the file to the
BASEDIR/smarts/local/conf/notifier directory.


Note   Chapter 11 Example Files contains complete samples of the configuration file.
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Starting the customized notification adapter
After creating configuration files and ASL scripts for each of the notification adapters you want to run,
start each adapter. Using sm_notify to start notification adapters and “Starting and stopping notification
adapters” on page 23 contain detailed instructions.


Email Notifier Adapter example: Start the adapter with the sm_notify
command
The Email Notifier Adapter is started manually using the sm_notify command or the sm_service start
command. For a customized Email Notifier Adapter, you must also specify the location and name of the
configuration file that contains the customization information.


The syntax to start a customized Email Notifier Adapter using the sm_notify command is:


tBASEDIR/smarts/bin/sm_notify --output --confdir=<DIRECTORY> --conf=<CONF_FILE_NAME> mails


The parameters --conf and --confdir are used with the sm_notify command to override the default
configuration files for each adapter. Email Notifier Adapter example: Start the adapter with the sm_notify
command describes these parameters.


Note   If you have renamed your configuration files, but have kept them in default
BASEDIR/smarts/local/conf/notifier directory, use the --conf startup parameter. If your configuration files
retain the default names, but are in a new location, use the --confdir startup parameter.


Modifying the configuration file contains a UNIX example on starting the Email Notifier Adapter, issue:


t# BASEDIR/smarts/bin/sm_notify --output 


--confdir=BASEDIR/smarts/Custom/mail/conf 


--conf=mail-notify-Router.conf mails


Email Notifier Adapter example: Start the adapter as a service
To start a customized adapter as a service, use the sm_service start command. Starting and stopping a
service contains additional information.


The equivalent command to start the Email Notifier Adapter defined in Modifying the configuration file for
UNIX is:


# BASEDIR/smarts/bin>./sm_service start mail
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Running multiple copies of a notification adapter
You may have developed more than one customized notification adapter (for example, more than one
Email Notifier Adapter especially if you want to send emails based on different notification subscriptions).
Since you created separate configuration files for each adapter, you must specify the location and
filename of the configuration file at startup.


The adapters should be started individually by specifying the appropriate configuration file for that
adapter. To do this, use the --confdir or --conf parameters.
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Example Files 11
This chapter includes the following topics:
n Overview


n Example: mail-notify.conf file for an VMware Smart Assurance IP Availability Manager


n Example: mail-notify.conf file for a Global Manager


n Example: mail-custom.asl file


Overview
This appendix provides examples of the files used in the customization procedure described in 
Chapter 10 Customizing a Notification Adapter:


n A sample configuration file (mail-notify.conf) for the Email Notifier Adapter for
VMware Smart Assurance IP Availability Manager.


n A sample configuration file (mail-notify.conf) for the Email Notifier Adapter for a Global Manager.


n An original version of an ASL file (mail-custom.asl) for the Email Notifier Adapter for both
VMware Smart Assurance IP Availability Manager and
VMware Smart Assurance Service Assurance Manager (Global Manager). Chapter 8 Notification
Adapter Framework contains a description of ASL files.


Example: mail-notify.conf file for an
VMware Smart Assurance IP Availability Manager
The following is a sample configuration file (mail-notify.conf) for the Email Notifier Adapter for
VMware Smart Assurance IP Availability Manager:


# mail-notify.conf - Configuration for the mail notification # adapter


#


# Copyright (C) 1999-2011 VMware Corporation


# All Rights Reserved


#


# $Id: mail-notify.conf,v 1.4 2000/08/22 13:16:51 boaz Exp $


#


GNA_Notifier::mail-Notifier


{


    #
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    # Name of the InCharge Server from which to receive 


    # notifications.


    #


    serverName = "INCHARGE-AM"


    ConfiguredBy = MailConfiguration::Mail-Configuration


    {


         #


         # Name of mail server host.


         #


         MailServer = "localhost"


         #


         # Sender identity.  


         # Must be a valid email address, recognized by the 


         # mail server.


         #


   SenderId = "daemon@localhost"


   #


         # Comma-separated list of users to whom notifications 


         # should be sent to.


         #


         Recipients = "root@localhost"


    }


    ReadsInputFrom = GA_SubscriberFE::mail-Subscriber-


    FrontEnd


    {


         #


         # How long, in seconds, an event must remain active 


         # before the adapter sends a notification.


         #


         eventSmoothingInterval = 0


         #


         # Notification threshold; discard notifications with 


         # a certainty below this value, which should be 


         # between 0.0 and 


         # 1.0.


         #


         minimumCertainty = 0.01


         #


         # Subscriptions.


         #


         SubscribesTo = 


         {


              #


              # Choice subscription.


              #


              GA_ChoiceSubscription::mail-All-Subscriptions


              {


                       className = ".*"


                    instanceName = ".*"


                       eventName = ".*"


                        problems = TRUE


                      aggregates = FALSE


                        symptoms = FALSE


              }


#              #
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#              # Profile subscription.


#              #


#              GA_ProfileSubscription::file-Default-Profile-


Subscriptions


#              {


#                   profileName = "default"


#              }


         }


    }


    #


    # How long, in seconds, to ignore notifications from the 


    # server after it connects.  Use this parameter to avoid 


    # receiving the initial flood of notifications when the 


    # server (re)connects.


    #


    initialEventDelay = 0


   


    filterRuleSet = "$Basedir/smarts/Custom/mail/rules/mail-


    filter.asl"


    


    customRuleSet = "$Basedir/smarts/Custom/mail/rules/mail-


    custom.asl"


}


Example: mail-notify.conf file for a Global Manager
The following is a sample configuration file (mail-notify.conf) for the Email Notifier Adapter for
VMware Smart Assurance Service Assurance Manager:


# mail-notify.conf - Configuration for the mail notification 


# adapter


#


# Copyright (C) 1999-2011 VMware Corporation


# All Rights Reserved


#


# $Id: mail-notify.conf,v 1.4.8.1 2001/06/13 14:42:01 boaz 


# Exp $


#


GNA_Notifier::mail-Notifier


{


    #


    # Name of the InCharge Server from which to receive 


    # notifications.


    #


    serverName = "INCHARGE-SA"


    ConfiguredBy = MailConfiguration::Mail-Configuration


    {


         #


         # Name of mail server host.


         #


         MailServer = "localhost"


         #


         # Sender identity.  
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         # Must be a valid email address, 


   # recognized by the mail server.


         #


         SenderId = "daemon@localhost"


         #


         # Comma-separated list of users to whom notifications 


         # should be sent to.


         #


         Recipients = "root@localhost"


    }


ReadsInputFrom = GA_SubscriberFE::mail-Subscriber-FrontEnd


    {


         #


         # How long, in seconds, an event must remain active 


         # before the adapter sends a notification.


         #


         eventSmoothingInterval = 0


         #


         # Notification threshold; discard notifications with 


         # a certainty below this value, which should be 


         # between 0.0 and 1.0.


         #


         minimumCertainty = 0.01


         #


         # Subscriptions.


         #


         SubscribesTo = 


         {


              #


              # NL subscription.


              #


              GA_NLSubscription::mail-Default-Subscriptions


              {


                       NLName = "Default"


              }


         }


    }


    #


    # How long, in seconds, to ignore notifications from the 


    # server after it connects.  Use this parameter to avoid 


    # receiving the initial flood of notifications when the 


    # server (re)connects.


    #


    initialEventDelay = 0


    filterRuleSet = "notifier/mail/mail-filter.asl"


    


    customRuleSet = "notifier/mail/mail-custom.asl"


}
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Example: mail-custom.asl file
The following is an original version of the mail-custom.asl file for the Email Notifier Adapter for both
VMware Smart Assurance IP Availability Manager and
VMware Smart Assurance Service Assurance Manager:


/* mail-custom.asl - Custom script for the mail notification adapter.


 *


 * Copyright (C) 1999-2011, VMware Corporation


 * All Rights Reserved


 *


 * RCS $Id:mail-custom.asl,v 1.6 2002/01/30 23:27:26 boaz Exp $


 */


/** No word delimiter needed.*/


delim = "";


/*


 * Required variables.*/


default debug = FALSE;


default test = FALSE;


default NotifierName = "<error>";


notifier = self->object("GNA_Notifier", NotifierName) ? LOG,STOP;


currentEvent = notifier->CurrentEvent ? LOG,STOP;


mailer = self->object("ACT_Mail", "ACT-Mail") ? LOG,STOP;


mailer->test = test;


mailer->trace = debug;


serverName = notifier->serverName;


/** User-provided parameters.*/


sender = notifier->ConfiguredBy->SenderId;


recipients = notifier->ConfiguredBy->Recipients;


/*


 * Rules.


 */


START() {


    local subject = "";


    local body = "";


} filter {


    /*


     * Only send here if sentByCustom is TRUE.


     */


    (currentEvent->sentByCustom)


} do {


    /*


     * This is how the adapter constructs the default message.  


     * Edit to suit your tastes.


     */


    subject = currentEvent->icDisplayType." ".


              currentEvent->icInstanceDisplayName." ".


              currentEvent->icEventDisplayName;


    body = ("  InCharge Server " . serverName . ":\n " .


            currentEvent->icDisplayType . " " .


            currentEvent->icClassDisplayName . " " . 


            currentEvent->icInstanceDisplayName . " ".
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            currentEvent->icEventDisplayName .


            " (" . string(currentEvent->icCertainty) . "%):\n " .


            currentEvent->icEventDescription . "\n");


    mailer->sendmail(sender, recipients, subject, body) ? LOG,STOP;


}


/*


 * Local Variables:


 * mode: C++


 * End:


 */
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Troubleshooting Adapters 12
This chapter includes the following topics:


n Overview


n Notification adapter issues


Overview
This appendix contains resolutions to common issues experienced by adapter users involving notification
adapters.


Each section begins by addressing general issues. For example, the first issue describes what to check if
this type of adapter fails to start. Subsequent sections address issues specific to a particular adapter. For
each issue there may be more than one suggested action to follow.


Issues covered in this appendix includes the complete list of common issues and their solutions covered
in this appendix, organized by adapter.


Table 12‑1.  Issues covered in this appendix


Issues Solution


Email Notifier Adapter


Does not start. Notification adapter fails to start


Does not connect to InChange Manager. Notification adapter starts, but fails to connect to the VMware
Manager


No email is received. Email not received


Only some email is received. Email received, but not for all events


Log File Notifier Adapter


Does not start. Notification adapter fails to start


Does not connect to VMware Manager. Notification adapter starts, but fails to connect to the VMware
Manager


Notification file is not created or updated. Notification file not created


Notification file does not include all events. Information in the notification file does not include all events


SNMP Trap Notifier Adapter


Does not start. Notification adapter fails to start
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Table 12‑1.  Issues covered in this appendix (Continued)


Issues Solution


Does not connect to VMware Manager. Notification adapter starts, but fails to connect to the VMware
Manager


Destinations do not receive any traps. No traps delivered to destination


Destinations receive only some traps. Not all traps delivered to destination


Script Notifier Adapter


Does not start. Notification adapter fails to start


Does not connect to VMware Manager. Notification adapter starts, but fails to connect to the VMware
Manager


Script is not invoked. Script is not invoked for Script Notifier Adapter


Notification adapter issues
The issues covered here apply to the:


n Email Notifier Adapters


n Log File Notifier Adapters


n SNMP Trap Notifier Adapters


n Script Notifier Adapters


Notification adapter fails to start


Note   Applies to the Email Notifier Adapter, the Log File Notifier Adapter, the
SNMP Trap Notifier Adapter, and the Script Notifier Adapter.


When a notification adapter appears not to start, check the status of its process or service.


For an adapter started with the sm_notify command
For UNIX, use:


ps -ef | grep sm_notify


The command returns a list of process statuses for the notification adapters. To identify each adapter,
look for the adapter name: mail, file, trap, or script.
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For an adapter started as a service
For UNIX, to check the status of a service, issue the sm_service show command from the
BASEDIR/smarts/bindirectory:


# sm_service show 


Notification adapter starts, but fails to connect to the VMware
Manager


Note   Applies to the Email Notifier Adapter, the Log File Notifier Adapter, the
SNMP Trap Notifier Adapter, and the Script Notifier Adapter.


When an adapter cannot connect to an VMware Manager, it is usually for one of the following reasons:


n VMware Manager is not running.


n Name of the VMware Manager is not the same as the name specified in the adapter’s configuration
file.


n VMware Manager cannot be reached from the host running the adapter.


Check the status of the VMware Manager
Use the brcontrol command to check the status of the VMware Manager. The syntax is:


BASEDIR/smarts/bin/brcontrol


      


By default, this command returns a list of VMware Managers registered with the broker and their current
state. The list indicates whether an VMware Manager’s state is RUNNING or DEAD.


If the VMware Manager is not running or included in the list, restart the VMware Manager.


Check the name of the VMware Manager in the configuration file
The configuration file of each adapter contains the name of the VMware Manager to which it connects.
This value in the configuration file can be overridden by using the --server option with the sm_notify
command.


In cases where an adapter cannot connect, check that the --server option, if used, points to a valid
VMware Manager. If that is not the issue, check that the appropriate VMware Manager is specified in the
adapter’s configuration file. Adapters and VMware Manager parameters lists the configuration file and
parameter to check for each adapter.
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Table 12‑2.  Adapters and VMware Manager parameters


Adapter
Location and name (relative to
BASEDIR/smarts/conf) VMware Manager parameter


Email Notifier Adapter /notifier/mail-notify.conf serverName


Log File Notifier Adapter /notifier/file-notify.conf serverName


SNMP Trap Notifier Adapter /notifier/trap-notify.conf serverName


Script Notifier Adapter /notifier/script-notify.conf serverName


Check communication to the VMware Manager ’s host
If the adapter and the VMware Manager run on different hosts, the adapter’s host might not be able to
communicate with the VMware Manager’s host. From the adapter’s host, run the following command:


         dmctl --server=<


         InCharge_Manager


         > ping


      


The results of this command show whether the VMware Manager is alive or unavailable.


Email not received


Note   Applies to the Email Notifier Adapter.


When the Email Notifier Adapter starts and connects to the Domain Manager and the intended recipient
receives no email, the issue is usually an incorrect configuration. The configuration file for the
Email Notifier Adapter is mail-notify.conf. This file resides in the BASEDIR/smarts/notifier directory.


There are three parameters that specify where the Email Notifier Adapter delivers information. 
Parameters needed to receive emaillists these parameters.


Parameter Description


MailServer Name for the mail server. For example:


MailServer = "localhost"


SenderId Email address associated with the adapter. Users can reply to this address. This address
must be recognized by the mail server. For example:


SenderId = "daemon@localhost"


Recipients A comma-separated list of the recipients of the emails. The recipients in the list must be
recognized by the mail server. For example:


Recipients = "root@localhost,recipient@your_company.com"


Check the parameters in the configuration file and verify them with your email administrator. All three
must have a valid value for the Email Notifier Adapter to work. For the changes to the configuration file to
take effect, the adapter must be restarted.
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Email received, but not for all events


Note   Applies to the Email Notifier Adapter.


If the Email Notifier Adapter does not seem to be sending messages for all of the correct events, it could
be that the subscription profile is incorrect or that you expect the adapter to be sending messages when
notifications clear.


Modify the subscription profile
When the Email Notifier Adapter sends email, but does not send them for all expected events, the issue
usually is improper subscriptions. Specifying subscriptions in the configuration file contains instructions on
modifying the subscription profile for this adapter.


Change the Email Notifier Adapter to send notifications of cleared events
By default, the Email Notifier Adapter does not send messages when a notification clears. It only sends
messages for new notifications or when the certainty of the notification changes.


To enable the Email Notifier Adapter to send CLEAR notifications, change the following in the file,
BASEDIR/rules/notifier/mail/mail-filter.asl:


START () {


     OMIT_CLEAR_EVENTS


}


to


START () {


//   OMIT_CLEAR_EVENTS


}


After making changes to the file, restart the adapter for the changes to take effect.


Notification file not created


Note   Applies to the Log File Notifier Adapter.
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When the Log File Notifier Adapter starts and connects to the VMware Manager, but it does not appear to
create the notification file, check to ensure the filename is the one you expect. The
Log File Notifier Adapter’s configuration file, file-notify.conf, contains the name of the notification file. The
file-notify.conf file resides in the BASEDIR/smarts/conf/notifier directory. The parameter, fileName, defines
the name of the notification file that the adapter creates for its output. The adapter always creates the
notification file in the BASEDIR/smarts/local/logs directory. If you do not specify a value, the adapter
creates a default file named <InCharge_Manager>-alarms.log.


Note   Do not confuse this adapter’s output file with its log file. The log file also appears in the
BASEDIR/smarts/local/logs directory. You determine the log file’s name when the adapter starts using the
--output command option. The default name of the log file is sm_notify.log.


Never use the same name for both the notification file and the Log File Notifier Adapter’s log file.


Information in the notification file does not include all events


Note   Applies to the Log File Notifier Adapter.


When the Log File Notifier Adapter sends information to the notification file, but does not send it for all of
the correct events, the issue usually is improper subscriptions. Specifying subscriptions in the
configuration file contains instructions on modifying the subscription profile for this adapter.


No traps delivered to destination


Note   Applies to the SNMP Trap Notifier Adapter.


When the SNMP Trap Notifier Adapter starts and connects to the VMware Manager and does not send
the SNMP Traps, the issue is usually the format of the parameter Destinations.


The parameter, Destinations, is a table that contains the SNMP trap destinations. Each row in the table is
surrounded by curly braces and consists of three different values: hostname or IP address, port number,
and SNMP version. The values are separated by commas. There are two valid values for SNMP version:
V1 and V2C. These values and the values for host name or IP address must be surrounded by quotation
marks. The port number is an integer value with no quotation marks.


Each row in the table is separated from the next by a comma. Place a comma after the curly brace that
marks the end of each row in the table except for the last. An outer set of curly braces defines the entire
table.


For example, the Destinations parameter could appear as follows:


Destinations = {


                 {"localhost", 162, "V1"},


                 {"other-host", 30162, "V2C"},


                 {"195.67.23.103",21539, "V2C"}


               }
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Not all traps delivered to destination


Note   Applies to the SNMP Trap Notifier Adapter.


When the SNMP Trap Notifier Adapter sends traps, but does not send them for the correct events, the
issue is usually improper subscriptions. Specifying subscriptions in the configuration file contains
instructions on modifying the subscription profile for this adapter.


Script is not invoked for Script Notifier Adapter


Note   Applies to the Script Notifier Adapter .


1 Ensure your script is located in BASEDIR/smarts/local/actions, and that it is readable and executable.


2 Check the configuration file to see that you have altered the file to include the correct name for the
script you want to invoke.
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VMware Smart Assurance MIB
for SNMP Traps 13
VMware Smart Assurance MIB implemented by
VMware, Inc. for SNMP Traps
-- SMARTS-MIB.my:  VMware Smart Assurance corporate MIB


--


-- Copyright 1999-2011 by VMware Corporation ("VMware").


-- All rights reserved.


--


-- UNPUBLISHED CONFIDENTIAL AND PROPRIETARY PROPERTY OF VMware.  The


-- copyright notice above does not evidence any actual or intended


-- publication of this software.  Disclosure and dissemination are


-- pursuant to separate agreements.  Unauthorized use, distribution


-- or dissemination are strictly prohibited.


--


-- RCS $Id: SMARTS-MIB.my,v 1.1.38.2 2006/02/06 23:41:15 eo1 Exp $


--


SMARTS-MIB DEFINITIONS ::= BEGIN


IMPORTS


        enterprises, Counter32, OBJECT-TYPE,


        MODULE-IDENTITY, OBJECT-IDENTITY, NOTIFICATION-TYPE


                FROM SNMPv2-SMI;


smartsMIB MODULE-IDENTITY


        LAST-UPDATED "200602070000Z"


        ORGANIZATION "VMware Corporation"


        CONTACT-INFO


                "       Support


                Postal: VMware Corporation


                        Corporate Headquarters


                        176 South Street


                        Hopkinton, MA 01748-9103


                        US


                Phone:


                  United States: (800) 782-4362 (SVC-4VMware)


                  Canada:        (800) 543-4782 (543-4SVC)


                  Worldwide:     (508) 497-7901


 Web: http://powerlink.VMware.com"


                DESCRIPTION


                        "The MIB module for VMware Smart Assurance entities defined by


                        VMware Corporation."


        ::= { enterprises 733 }


-- top level groups in the SMARTS-MIB
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-- The smNotificationTrap Group.


smNotificationTrap OBJECT-IDENTITY


        STATUS  current


        DESCRIPTION


         "This group is acutally the prefix one uses when creating


          enterprise-specific trap OID's for an SNMPv2 trap.  It is


          used in the SMARTS MIBS when defining traps."


        ::= { smartsMIB 0 }


-- The smNotificationData Group.


smNotificationData OBJECT-IDENTITY


        STATUS  current


        DESCRIPTION


         "The members of this group are the OIDs for VarBinds


          containing notification data."


        ::= { smartsMIB 2 }


-- Group for generic notification data.


smGenericNotify OBJECT-IDENTITY


        STATUS  current


        DESCRIPTION


         "The members of this group are the OIDs for VarBinds


          containing generic notification data."


        ::= { smNotificationData 1 }


smNotifTimestamp OBJECT-TYPE


        SYNTAX Counter32


        MAX-ACCESS accessible-for-notify


        STATUS  current


        DESCRIPTION


         "The timestamp of the notification."


        ::= { smGenericNotify 1 }


smNotifServer OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


         "The name of the server that is sending the notification."


        ::= { smGenericNotify 2 }


smNotifClass OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


         "The class of the object associated with the notification."


        ::= { smGenericNotify 3 }


smNotifInstance OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


        "The instance name of the object associated with the notification."


        ::= { smGenericNotify 4 }


smNotifEventName OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION
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        "The name of the event causing the notification."


        ::= { smGenericNotify 5 }


smNotifInstanceID OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


         "The unique InCharge inventory identification 


          for the object associated with the notification."


        ::= { smGenericNotify 6 }


smNotifDescription OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


         "A complete description of the event."


        ::= { smGenericNotify 7 }


smNotifCertainty OBJECT-TYPE


        SYNTAX OCTET STRING


        MAX-ACCESS accessible-for-notify


        STATUS current


        DESCRIPTION


         "The certainty of the event.  Floating-point number in the


          range 0-100, stored as a string."


        ::= { smGenericNotify 8 }


smNotifSeverity OBJECT-TYPE


        SYNTAX INTEGER {


                notApplicable (1),


                informational (2),


                warning (3),


                minor (4),


                major (5),


                severe (6)


        }


        MAX-ACCESS accessible-for-notify


        STATUS  current


        DESCRIPTION


         "The severity of the event.  Integer number in the range 1-6."


        ::= { smGenericNotify 9 }


-- The SMARTS enterprise Traps


--


-- These are the enterprise-specific trap codes currently in-use in


-- SMARTS software.  The final sub-OID of each object is the code sent


-- in the "specific-trap" field of an SNMPv1 Trap-PDU.


--


-- The definition of these objects mimics the SNMPv2 convention for


-- sending traps:  Take the enterprise OID, append 0, then append the


-- trap code.


-- TRAP NUMBER USE: Trap code 0 is reserved (by SNMP).


--                  Trap codes 1-3 are used by the SMARTS-OV-NV-MIB.


-- TRAPS 4-7: The "smTrap*" series of traps define "base" trap


--            numbers, ones with a generic purpose.  These traps are


--            also used by the generic Trap Adapter.


          smTrapNotification NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,
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                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


               }


            STATUS current


            DESCRIPTION


             "A trap describing an InCharge root cause notification.


              The text in smNotifDescription indicates the nature of


              the problem."


          ::= { smNotificationTrap 4 }


          smTrapCertaintyChange NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


                }


             STATUS current


             DESCRIPTION


              "A trap indicating a certainty change of an InCharge


               notification. The text in smNotifDescription indicates


               the nature of the problem."


           ::= { smNotificationTrap 5 }


           smTrapSeverityChange NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


                }


             STATUS current


             DESCRIPTION


              "A trap indicating a severity change of an InCharge


               notification. The text in smNotifDescription indicates


               the nature of the notification."


           ::= { smNotificationTrap 6 }


           smTrapNotificationClear NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,
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                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


                 }


              STATUS current


              DESCRIPTION


               "A trap indicating the clear of an InCharge notification."


           ::= { smNotificationTrap 7 }


           smTrapNotificationChange NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


                 }


              STATUS current


              DESCRIPTION


               "A trap indicating the change of an InCharge notification."


           ::= { smNotificationTrap 98 }


           smTrapNotificationDelete NOTIFICATION-TYPE


            OBJECTS {   smNotifTimestamp,


                        smNotifServer,


                        smNotifClass,


                        smNotifInstance,


                        smNotifEventName,


                        smNotifInstanceID,


                        smNotifDescription,


                        smNotifCertainty,


                        smNotifSeverity


                 }


              STATUS current


              DESCRIPTION


               "A trap indicating the delete of an InCharge notification."


           ::= { smNotificationTrap 99 }


-- TRAP NUMBER USE: Trap codes 8-99 are reserved for future "base trap number"


--                  use.


--


--                  Trap codes 100-133 are used by SMARTS-PERFORMANCE-MIB.


--                  Trap codes 134-199 are reserved for future use by


--                  SMARTS-PERFORMANCE-MIB. 


END
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Preface 1
As part of an effort to improve its product lines, VMware Smart Assurance periodically releases revisions
of its software and hardware. Therefore, some functions described in this document might not be
supported by all versions of the software or hardware currently in use. The product release notes provide
the most up-to-date information on product features.


Contact your VMware technical support professional if a product does not function properly or does not
function as described in this document.


Note   This document was accurate at publication time. Go to VMware Online Support docs.vmware.com
to ensure that you are using the latest version of this document.


This chapter includes the following topics:


n Purpose


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n VMware Smart Assurance Service Assurance Manager


n Related documentation


n Suggestions for searching PDF files


n Conventions used in this document


n Pathname conventions


n Graphical conventions


n Manager


n Where to get help


n Your comments


Purpose
This document describes the configuration and operation of the VMware Smart Assurance XML Adapter
and is intended for integrators using the VMware Smart Assurance XML Adapter to exchange topological
information between VMware Smart Assurance and other applications.
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Audience
This guide is intended for administrators who are responsible for deploying, installing, and configuring the
Global Manager. IT managers who seek to understand the role of the Global Manager in the context of an
VMware Smart Assurance solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should also read the
VMware Smart Assurance Service Assurance Manager Deployment Guide and the
VMware Smart Assurance System Administration Guide Guide.


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<productsuite>.


For example, on UNIX operating systems, VMware Smart Assurance Service Assurance Manager is,
by default, installed to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than/opt/InCharge (on UNIX)
but you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.


VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System


n Global Console


n Business Dashboard


n Companion UI


n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)


n VMware Smart Assurance Adapter for UIM/O


n XML Adapter
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Related documentation
In addition to this document, VMware Smart Assurance Corporation provides a help system for command
line programs as well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


n VMware Smart Assurance Common Information Model (ICIM) 1.11 Reference for Non-Service
Assurance Manager Products


n VMware Smart Assurance Common Information Model (ICIM) Reference for Service Assurance
Manager


n VMware Smart Assurance Foundation Documentation Portfolio


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ASL Reference Guide


n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide


VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes


n VMware Smart Assurance Open Source License and Copyright Information


n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


n VMware Smart Assurance Service Assurance Manager Deployment Guide


n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide
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n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide


n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance Companion UI Open Source License and Copyright Information for GPLv3
as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1 If the documentation is not accessible to all users of the VMware Smart Assurance product, copy the
contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a shared drive on
your LAN, so that operators and others can view the documentation.


2 To search throughout the documentation library, open the Acrobat Reader software:


3 Select Edit > Search, and type a word or phrase.


4 Select All PDF Documents in, in the Where would you like to search option, and type the
pathname of the location where the PDF documents reside.


If you have more than one VMware Smart Assurance product installed, you can set up cross-product
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each product into
this common documentation directory path.


Conventions used in this document
VMware Smart Assurance uses the following convention for special notices:


Note   NOTICE is used to address practices not related to personal injury.
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Typographical conventions
VMware Smart Assurance uses the following type style conventions in this document:


Bold Use for names of interface elements.


Italic Use for full titles of publications referenced in text


Monospace
Use for:
n System output, such as an error message or script
n System code
n Pathnames, filenames, prompts, and syntax
n Commands and options


                      
  Monospace italic
                     


Use for variables.


                      
  Monospace bold
                     


Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example


Pathname conventions
Directory pathnames are shown with forward slashes (/).


Graphical conventions
Under UNIX, the consoles appear with slight differences. For example, in views that display items in a
tree hierarchy such as the Topology Browser, an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to VMware Smart Assurance programs
such as Domain Managers, Global Managers, and adapters.


Where to get help
VMware Smart Assurance support, product, and licensing information can be obtained as follows:


Product information
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For documentation, release notes, software updates, or information about VMware products, go to
VMware Online Support at:


docs.vmware.com


Technical support


Go to VMware Online Support. You will see several options for contacting VMware Technical Support.
Note that to open a service request, you must have a valid support agreement. Contact your VMware
sales representative for details about obtaining a valid support agreement or with questions about your
account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:docs.vmware.com.
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Introduction 2
This chapter includes the following topics:
n Purpose of the XML Adapter


n Framework description


n Structure of the XML document


Purpose of the XML Adapter
An adapter controls the communication of information between devices or applications and a Manager.
An adapter normalizes topology and event information from sources other than
VMware Smart Assurance. Typical sources include SNMP traps or system log files. Once normalized to
the ICIM data model, the information is transferred to a Manager (including either Service Assurance
Global Manager or Domain Manager).


Adapters work with third-party applications in a variety of ways to import topology and event information
and prepare it for use by the Global Manager. The XML Adapter is ideal for exchanging topology
information with a system for which there is no native VMware Smart Assurance adapter. The
XML Adapter can import topology into a Global Manager or underlying domain as well as export from a
Global Manager or Domain Manager. Using the XML Adapter, topology information can be exchanged
between Global Managers or underlying domains.
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XML Adapter process
When importing topology into VMware Smart Assurance, start with an XML document that complies with
the ICIM/XML standard and represents any topological elements managed by VMware Smart Assurance.
The XML document is imported into the Manager using the XML Adapter and the objects are migrated
into the repository of the Manager. VMware Smart Assurance XML Adapter import process illustrates the
XML Adapter import process.


Figure 2‑1.  VMware Smart Assurance XML Adapter import process


The XML Adapter can import a large set of topology elements in one process or it can be used to make
incremental updates to existing objects in the repository.


When exporting topology from VMware Smart Assurance, the XML Adapter extracts topological
information from the Manager and produces an ICIM/XML-compliant document. VMware Smart
Assurance XML Adapter export process illustrates the export process for the XML Adapter.
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Figure 2‑2.  VMware Smart Assurance XML Adapter export process


The XML Adapter provides a structured method for transferring information in and out of a running
Manager. Use it to perform these tasks, including:


n Adding or deleting objects


n Setting the value of attributes


n Inserting objects in or removing objects from relationships


Framework description
This section includes the following information:


n ICIM/XML DTD specification


n ICIM/XML document


n Command-line interface (sm_xml)


n ASL script


ICIM/XML DTD specification
The Document Type Definition (DTD) defines the building blocks of the XML document structure. It
provides a list of allowable elements that can be used in the XML file. XML tags are formally described in
this document. The DTD is declared as an external document.


Attributes are used to associate name-value pairs within elements. Attributes may appear only within
open tags of the element. Attribute-list declarations in the DTD are used to define the set of attributes
pertaining to a given element type or to provide default values for attributes.


The type of information associated with the source objects must be identical to the information associated
with objects in the repository. For example, to import objects from an existing data source, ensure that the
data source and the target repository database contain the same information in the same format, prior to
importing. If the information models do not correspond exactly, you will lose data. The DTD specification
is a guide to correctly map your data to objects to the repository.


ICIM/XML DTD specification on page 30 contains detailed ICIM/SML DTD information.


ICIM/XML document
Each XML document has both a physical and a logical structure. Physically, the document is composed of
units called entities. An entity may refer to other entities to cause their inclusion in the document. A
document begins in a "root" or document entity and is structured with objects, attributes and relationships.
Logically, the document is composed of declarations, elements, comments, character references, and
processing instructions, all of which are indicated in the document by explicit markup.


The XML DTD contains markup declarations that provide a grammar for the XML documents.
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Each XML document contains one or more elements, the boundaries of which are delimited by open and
close tags. Each element has a type (object, attribute, or relationship) and may have a set of attribute
specifications. Each attribute specification has a name and a value.


Chapter 3 ICIM XML Elements contains detailed information on the structure of the ICIM/XML document.


Command-line interface (sm_xml)
The sm_xml command line utility is used to perform the import and export functions to the Manager. The
sm_xml file is found in BASEDIR/smarts/bin. This interface can receive information from the Manager and
send the output to a file or to standard output. It can also import a file of defined objects into the
repository.


XML export ASL script
When exporting repository objects to XML, this adapter script extracts the VMware Smart Assurance
objects to be represented in the XML output file. This Adapter Scripting Language (ASL) file utilizes the
Adapter Scripting Language in addition to some unique commands for extracting the objects into an XML
output file. A sample file, xml-export-sample.asl, is located in BASEDIR/smarts/rules/xml-if.


Chapter 5 Exporting VMware Smart AssuranceInformation to XML contains detailed information on
exporting VMware Smart Assurance information to XML.


Structure of the XML document
The basic building blocks of an XML document are elements, attributes, and values. "Tag" is a general
term that can be used for elements and attributes. A relevant sample of the ICIM/XML DTD is provided
with each of the following descriptions.


Element
An element is a tag that is a container for subelements and attributes. For example, the object element
contains defining information for the instance you are adding into the repository.


The root element, <icim>, is shown as the opening and closing tags for the entire file. For example, the
ICIM/XML DTD allows you to import and export object, relationship, and attribute elements:


<!ELEMENT object ( attribute | relationship )* >


<!ELEMENT relationship ( object )* >


<!ELEMENT attribute (


        char | string | int | unsignedint | short |


   unsignedshort | long | unsignedlong | boolean | struct    | float   | double )* >


Attribute declaration (attribute list)
Attribute declarations, as defined in the ATTList of the DTD, expand the details of an element. All
elements utilize a name declaration to identify it as well as a method declaration that instructs the adapter
on whether to insert, update, or delete information about the element.
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An attribute, as defined by the Attribute List in the DTD help identify the object instance. This should not
be confused with an ICIM object attribute that describes the particular instance. For example:


<!ATTLIST object


        class     CDATA #IMPLIED


        name      CDATA #IMPLIED


        method    ( delete | update ) "update" >


<!ATTLIST relationship


        name      CDATA #REQUIRED


        method  ( insert | remove | put ) "put" >


Value
The value setting of the attribute declaration is paired with the declaration in name=value groupings. The
values define the properties of the element you are adding, modifying, or deleting in the repository.


In the following example, the Object element is made up of an element start tag (<object>), attributes
(Class, Name, and Method), values ("Application," "Banking," and "update"), and a close tag for the
element (</Object>):


<object class="Application" name="Banking" method="update" />


Rules for a well-formed XML document
Follow these syntax rules when creating an XML document:


n Root element contains all other elements


n Elements and subelements are properly nested:


n <A><B></B></A> not <A><B></A></B>


n All elements have start and close tags:


n <object>Router</object> as opposed to <object>Router


n Start and close tags should match cases:


n <B>word</B> not <B>word</b>


n Attribute declaration values should be in single or double quotes:


n <attribute name="Customer 1"> not


n <attribute name=Customer 1>
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ICIM XML Elements 3
This chapter describes the elements used in ICIM XML and the syntax required to use them properly.
“ICIM/XML DTD specification” on page 30includes a complete version of the ICIM/XML DTD.


This chapter includes the following topics:
n Element declarations


n Attribute-list declarations


n Object elements


n Attribute elements


n Relationship elements


n ICIM/XML DTD specification


Element declarations
The XML document type declaration contains or points to markup declarations that provide a grammar for
a class of documents. This grammar is known as a document type definition or DTD.


Four elements are defined within the ICIM/XML document:


n ICIM Root


n Objects


n Attributes


n Relationships


For each element declaration, you may have a set of attribute declarations that can include the class,
name, or method of the element.


Note   The ICIM Root element is created when the XML document is generated. Create the
remaining elements.
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Attribute-list declarations
For each ICIM/XML element, there is an attribute-list declaration that defines values for that element.
Attribute-list declarations specify the name, datatype, and default value (if any) of each attribute
associated with a given element type. The attribute-list also defines whether the value is required or
implied. If the value is required, define it in the document. If the value is implied, there is a default value
for that attribute.


The syntax of the ATTLIST is defined as:


<!ATTLIST <element-name> <attribute-name> <attribute-type> default-value>


Class
The class attribute defines the ICIM objects with common properties, common behaviors, and similar
relationships. Examples of classes are Switches, Routers, Applications, Service Subscribers, and Service
Offerings. Any class already modelled and existing in your current repository is allowable in the XML
document.


Name
This attribute identifies a unique name of the element or subelement displayed in the repository.


Method
The method attribute is used to declare the specific topology change you want to make. In the following
examples, the Service Offering named GE is being updated and deleted:


<object class="ServiceOffering" name="GE" method="update" />


<object class="ServiceOffering" name="GE" method="delete" />


Method descriptions for ICIM XML references identifies the methods associated with each element type.


Table 3‑1.  Method descriptions for ICIM XML references


Element Method Description


<object> update Modifies the properties of an existing object or creates the object if it
does not exist.


delete Removes an object from the repository.


<attribute> insert Adds a value to a set of attributes.


remove Removes an attribute from an object.


put Assigns a value to an attribute.


<relationship> insert Adds an object to a relationship.
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Table 3‑1.  Method descriptions for ICIM XML references (Continued)


Element Method Description


remove Removes an object from a relationship.


put Assigns an object or set of objects to a relationship.


Note   A "put" associates a value or structure of values with an object. If a value already exists, it will be
overwritten. An “insert” adds a value to a set of attributes if the attribute allows for multiple values. If the
attribute can only have one value, then using the insert method will replace the existing single value.
Propagated attributes, instrumented attributes, and computed attributes cannot be modified with the insert
or put methods.


Object elements
An <object> element identifies a repository object.


In the ICIM/XML DTD specification, the object element is declared as:


<!ELEMENT object (attribute | relationship)> 


This declares the VMware Smart Assurance object element to be modified. Nested in this element will be
subelements that define the attribute information associated with it. The subelement of the object element
can be one or more ICIM attributes or ICIM relationships.


<Object> element attribute list declarations
An example of an <object> element attribute list declaration is:


<!ATTLIST object 


       class     CDATA #IMPLIED 


  name      CDATA #IMPLIED


  method    ( update | delete ) "update" >


Attribute-list declarations for the object element identifies the attribute declarations for the <object>
element. If the object you specify does not already exist in the repository, define the class of the instance
to be created.
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Table 3‑2.  Attribute-list declarations for the object element


XML attribute Description Possible value Value required/implied


class The ICIM class of the object being
declared. This can be any ICIM
class name.


CDATA Implied


Default is MR_Object


name Name of the object instance. CDATA Implied


No default value


method Specifies the desired topology
change. You can delete or update
an existing object.


An update will create the object if it
does not exist in the repository.


delete


update


Implied


Default is "update"


An object will have zero or more attributes or relationships within one declaration.


Attribute elements
An attribute element specifies a property present for a particular object element. Attributes expand the
details of an object. For instance, DisplayName is an attribute of the element Application and sets how
the instance will be identified in the Global Console. An attribute declaration includes the attribute’s type
and value. The value describes the state of the instance.


The attribute element must be nested within the object element.


<Attribute> element attribute-list declarations
For the <attribute> element, the ATTLIST is defined as:


<!ELEMENT attribute ( 


  char    | string        | int     | unsignedint 


  short   | unsignedshort | long    | unsignedlong  | 


  boolean | struct        | float   | double        )* >


<!ATTLIST attribute 


 name      CDATA #REQUIRED


 method ( insert | remove | put ) "put" >


Attribute-list declarations for the attribute element identifies the attribute list declarations for the
<attribute> element.


Table 3‑3.  Attribute-list declarations for the attribute element


XML attribute Description Possible value Value required/implied


name Name of the object instance. CDATA Required


method Specifies the desired topology
change. You can create a new
attribute, remove an existing
attribute, or update (put) an existing
attribute.


insert


remove


put


Implied


Default is "put"
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For example, the following sample identifies an Application named App-BankingDataBase having a
display name of Banking:


<object class="Application" name="APP-BankingDataBase">


 <attribute name="DisplayName">


  <string>Banking</string>


 </attribute> 


</object>


In this example, the UtilizationThreshold attribute is set with an integer datatype:


<attribute name="UtilizationThreshold">


 <int>75</int>


</attribute>


Applying multiple attributes to an object
Since an attribute element can have one or more values within one declaration, you must be able to apply
values in multiples. If the target to be modified is a table, the <attribute> element may be modified using a
<struct> tag to modify multiple values. A struct is a collection of different datatypes. It allows you to apply
a set of values to an element (such as string, integer, boolean). For example, to add two properties of
different types (string and unsignedshort) to the AgentInfoSet attribute, use the following syntax:


<attribute name="AgentInfoSet" method="insert">


 <struct>


  <string>public</string>


  <unsignedshort>162</unsignedshort>


 </struct>


</attribute>


If an object contains an attribute called IntegerList, which contains a list of three integers, this attribute
can be set in the following way:


<attribute name="IntegerList">


 <struct>


  <int>4</int>


  <int>8</int>


  <int>9</int>


 </struct>


</attribute>


If the attribute represents an IntegerList2, which has an unspecified number of integers, it can be
imported in the following manner:


<attribute name="IntegerList2">


 <struct><int>4</int></struct>


 <struct><int>8</int></struct>


 <struct><int>9</int></struct>


</attribute>
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Relationship elements
A relationship maps instances of one class to instances of the same or another class. For each
relationship, an inverse relationship may also exist that maps from the related class back to the
originating class.


The <relationship> element modifies a relationship. Like the <attribute> element, <relationship> may be
used to put, insert, or remove an object from a relationship.


<Relationship> element attribute list declarations
Am example of the <relationship> element is:


<!ELEMENT relationship ( object )* >


<!ATTLIST relationship 


 name      CDATA #REQUIRED


 method  ( insert | remove | put ) "put" >


Attribute-list declarations for the relationship element identifies the attribute declarations available for the
<relationship> element.


Table 3‑4.  Attribute-list declarations for the relationship element


XML attribute Description Possible value Value required/implied


name Name of the object instance. CDATA Required


method Specifies the desired topology
change. You can create a new
relationship, delete an existing
relationship, or update an existing
relationship.


insert


remove


put


IMPLIED


Default is "put"


For example, to add the HostedBy relationship between the application Banking and the host
BankingHost, use the following syntax:


<object class="Application" name="Banking">


 <relationship name="HostedBy" method="put" />


  <object class="Host" name="BankingHost" method="update" />


 </relationship>


</object>


If multiple objects are specified when the method is "insert" (or "remove") then all are inserted (or
removed). The methods "put" and "insert" are equivalent if the relationship is a singleton. The "remove"
method may be used to clear a singleton relationship:


<relationship name="HostedBy" method="remove" />
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A relationship can have zero or more objects associated with it within one declaration, meaning you may
want to add a relationship even if you do not have a specific object to assign to it. To declare zero objects,
put or insert the NULL object declaration:


<relationship name="HostedBy"> 


 <object/>


</relationship>


ICIM/XML DTD specification
The ICIM/XML DTD file is icim_xml.dtd and is in BASEDIR/smarts/rules/xml-if.The contents of this file
cannot be modified. The icim_xml.dtd file contains the following:


<!ELEMENT icim ( object )* >


<!ATTLIST icim source CDATA #IMPLIED >


<!ELEMENT object ( attribute | relationship )* >


<!ATTLIST object


        class     CDATA #IMPLIED


        name      CDATA #IMPLIED


        method    ( delete | update ) "update" >


<!ELEMENT relationship ( object )* >


<!ATTLIST relationship


        name      CDATA #REQUIRED


        method  ( insert | remove | put ) "put" >


<!ELEMENT attribute (


        char | string | int | unsignedint | short |


   unsignedshort | long | unsignedlong | boolean | struct    | float   | double )* >


<!ATTLIST attribute


        name      CDATA #REQUIRED


        method ( insert | remove | put ) "put" >


<!ELEMENT string          ( #PCDATA ) >


<!ELEMENT char            ( #PCDATA ) >


<!ELEMENT int             ( #PCDATA ) >


<!ELEMENT unsignedint     ( #PCDATA ) >


<!ELEMENT short           ( #PCDATA ) >


<!ELEMENT unsignedshort   ( #PCDATA ) >


<!ELEMENT long            ( #PCDATA ) >


<!ELEMENT unsignedlong    ( #PCDATA ) >


<!ELEMENT boolean         ( #PCDATA ) >


<!ELEMENT float           ( #PCDATA ) >


<!ELEMENT double          ( #PCDATA ) >


<!ELEMENT struct          ( 


  char | string | int | unsignedint | short |


  unsignedshort | long  | unsignedlong | boolean |


  struct| float | double )* >
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Building Topology in XML 4
This chapter includes the following topics:


n Overview


n Using XML for VMware Smart Assurance


n Adding and updating topology


n Removing topology


n Datatypes


Overview
The XML document is a database. The following actions can be controlled using XML:


n Add topology


n Update topology


n Delete topology


n Assign values to an attribute, relationship, or relationship set


n Insert and remove information in a table attribute or relationship set


Using XML for VMware Smart Assurance
Working with objects in XML means you are creating, updating, and removing instances of classes in the
Manager. Classes cannot be added to VMware Smart Assurance using the XML Adapter; only add
instances and relationships can be added to existing classes.


This section contains XML excerpts to introduce the basic XML declarations to use to import topology
changes. This set of examples is importing Business Impact Manager topology into the
Service Assurance Manager. For some examples, a Services Map in the Global Console illustrates the
results of the topology import.


Adding and updating topology
This section shows examples to represent new objects, relationships, and attributes in XML.
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Adding objects
Importing instances requires creating objects in the XML file. Two ServiceSubscriber instances, called
Cust1 and Cust2, are created in the XML file, for example:


<icim>


 <object class="ServiceSubscriber" name="Cust1" />


 <object class="ServiceSubscriber" name="Cust2" />


</icim>


By default, the method for an object element is "update," so it is unnecessary to specify it. If the object
does not exist, then the update method automatically adds it to the repository. Map of imported Service
Subscribers illustrates a Services Map and topology browser after importing these Service Subscribers.


Figure 4‑1.  Map of imported Service Subscribers


Adding attributes
Adding attribute elements requires nesting the attribute declaration within the appropriate object
declaration. This example adds the Display Name attribute to the Service Subscribers you created. This
changes the Display Name of "Cust1" to "Customer 1" and "Cust2" to "Customer 2". For example:


<icim>


<object class="ServiceSubscriber" name="Cust1" method="update">


 <attribute name="DisplayName" method="put">


     <string>Customer 1</string>


 </attribute>


</object>
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<object class="ServiceSubscriber" name="Cust2" method="update">


 <attribute name="DisplayName" method="put">


     <string>Customer 2</string>


 </attribute>


</object>


</icim>


Map of imported Service Subscribers with new display names illustrates the Services Subscribers with
their new display names.


Figure 4‑2.  Map of imported Service Subscribers with new display names


Adding relationships using the put method
Adding relationships requires nesting the relationship declarations within the object declarations. Using
the "put" method means you are assigning the only attribute intended for that object. The following
example shows how to add a Service Offering called "EastCoast" and use the "Subscriptions" relationship
to associate that offering with the Customer 1 subscriber created previously. For example:


<icim>


    <object class="ServiceSubscriber" name="Cust 1" method="update">


 <relationship name="Subscriptions" method="put">


      <object class="ServiceOffering" name="EastCoast" />


 </relationship>


    </object>


</icim>


Map of imported Service Subscribers and Service Offering illustrates the new Service Offering, EastCoast
and Services Subscriber, Customer 1 with a Subscriptions relationship.
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Figure 4‑3.  Map of imported Service Subscribers and Service Offering


Adding relationships using the insert method
Using the "insert" method allows you to add to the list of attributes intended for that object. The following
example shows how to insert another Service Offering called MidWest into the Subscriptions relationship
for Customer 1. For example:


<icim>


<object class="ServiceSubscriber" name="Cust 1" method="update">


  <relationship name="Subscriptions" method="insert">


     <object class="ServiceOffering" name="MidWest" />


 </relationship>


    </object>


</icim>


Map of imported Service Subscribers and Service Offering illustrates the new Service Offering, MidWest,
and Services Subscriber, Customer 1 with a Subscriptions relationship.
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Figure 4‑4.  Map of imported Service Subscribers and Service Offering


Removing topology
This section describes how to remove topology from a Manager.


Attempting to perform the following tasks causes a runtime error when you import the XML file:


n Deleting a nonexistent object


n Deleting a nonexistent attribute or relationship


Removing objects
To remove an object from the repository, use the "delete" method for an object element that already
exists. For example, to delete the ServiceSubscriber called Cust 2, use the following syntax:


<object class="ServiceSubscriber" name="Cust 2" method="delete" />
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Removing attributes and relationships
To remove a particular attribute or relationship for an object, adhere to the syntax of the ICIM/XML DTD.
This means that the relationship and attribute updates must be nested within the appropriate object
declaration. For example, to remove the Subscriptions relationship from the EastCoast service offering,
use the following syntax:


<icim>


    <object class="ServiceSubscriber" name="Cust 1" method="update">


  <relationship name="Subscriptions" method="remove">


        <object class="ServiceOffering" name="EastCoast" />


  </relationship>


    </object>


</icim>


The topology returns to look as it did in Removing attributes and relationships.


Datatypes
Supported datatypes lists the datatypes supported in the ICIM/XML DTD.


Table 4‑1.  Supported datatypes


Value Description


boolean Datatype defined as two possible values (such as 0 or 1, on or off, true or false)


char Any single ASCII character


double Any double-precision floating point number (similar to C++)


float Any single-precision floating point number (similar to C++)


int A 32-bit integer ranging from -2^31 to +(2^31 -1)


long A 64-bit integer ranging from -2^63 to +(2^63 -1)


short A 16-bit integer ranging from -32,768 to 32,767


string An ordered list of characters


struct A collection of fields, each field specifies its own type


unsignedint Unsigned 32-bit integer 232-1


unsignedlong Unsigned 64-bit integer ranging from 264-1 to +263 -1


unsignedshort Unsigned 16-bit integer 216-1
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Exporting
VMware Smart Assurance
Information to XML 5
This chapter includes the following topics:


n Overview


n The ASL Export script


n Building the ASL Export script


n Parsing the XML


n Running sm_xml for export


n Sample ASL Export script


Overview
Exporting object data to an XML file is a convenient way to move and store repository information in a
format that can be used across the web or by another Manager.


To export data to XML, you must define an ASL script that queries the repository. In the ASL script, you
specify the information and matching criteria for the objects to be gathered and exported. A sample ASL
file, xml-export-sample.asl, is provided in BASEDIR/smarts/rules/xml-if.


The XML Adapter invokes the specified ASL script against the specified Manager and produces the
specified XML output file. Process diagram: Exporting VMware Smart Assurance data in XML illustrates
the process for exporting VMware Smart Assurance data in XML.


Figure 5‑1.  Process diagram: Exporting VMware Smart Assurance data in XML
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The ASL Export script
A template for the ASL Export script, called xml-export-sample.asl, is installed in
BASEDIR/smarts/rules/xml-if. Use ASL to modify the functionality of the local copy of the script. Use the
sm_edit utility to modify the ASL script so that a copy is made in the local directory and the proper
permissions are associated to it. Chapter 7 Understanding the sm_edit Utility includes information on
using the sm_edit utility.


To open a file called xml-export-sample.asl using sm_edit:


t# BASEDIR/smarts/bin>sm_edit BASEDIR/smarts/rules/xml-if/xml-export-sample.asl s


Save this file with a new name, replacing "sample" with an appropriate grouping name (for example,
"Services" for an ASL file intended to gather information on Service Subscribers and Service Offerings).


Understanding the ASL script


Note   A thorough understanding of ASL is required to work in the export script. The
VMware Smart Assurance ASL Reference Guide provides detailed information on working with the
Adapter Scripting Language.


The first rule executed in the ASL script is the START rule. The START rule runs repeatedly until all the
data input is processed. This rule invokes other rules or can specify which objects, attributes, and
relationships to export.


Data input gets processed as it is matched with all the patterns of a rule. The START rule has
components in which the request details are defined.


The XML headers and the ICIM root element are added automatically to the XML document by the
sm_XML Adapter. The ASL script is responsible for gathering and adding the object, attribute, and
relationship elements to the XML file.


Any modifications to the action blocks are made after the following comment:


"NOTE:  Customize the script from this point on"


These modifications define the specific information to retrieve from the repository.


After the ASL script is executed, the closing tag for the ICIM root element is added to the document
automatically.


Building the ASL Export script
This section describes how to retrieve specific instances of objects, build foreach statements and use the
builder statements to export the exact information you need from the repository.


The ASL file is constructed from these functions and statements: getInstance, foreach statements and
builder statements.
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getInstance function
The getInstances function returns a list of object names for the given class. The syntax of the
getInstances function is:


listname = getInstances(<classname>);


For example, to retrieve all instances of the ServiceSubscriber class and add them to your XML
document, begin with the following line:


EXPORT_SERVICESUBSCRIBER {


} do {


  svcSubList = getInstances("ServiceSubscriber");


...


}


Once the objects you want to export are defined, then define how to handle them. Use the builder
statements described in builder statements and the foreach statements that follow to complete this task.


foreach statement
The foreach statement iterates through all the members of a list or a table. The syntax of the foreach
statement is:


foreach variable (listortablename) {statements}


When the foreach statement is used with a loop, the variable stores the value of each member of the list
every time the foreach statement loops. The members returned are in numerical order by their list indices.


Building on our ServiceSubscriber example above, add the following statements:


EXPORT_SERVICESUBSCRIBER {


} do {


 svcSubList = getInstances("ServiceSubscriber")? LOG, NEXT;


 foreach svcSub (svcSubList) {


  builder->addObject(svcSub, "ServiceSubscriber");


  builder->addAttribute(svcSub, "DisplayName");


  builder->addObjectClosing();


    }


}


builder statements
Each element is created and formatted in the ICIM/XML document using builder statements that define
the objects, attributes, and relationships. The syntax for the builder statements is as follows:


builder-> <BuilderStatement>(<Argument>,"<Value>");
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Object element type builder statements
An object element requires two builder statements. Builder statements for the object element type
describes the builder statements and arguments for an object element.


Table 5‑1.  Builder statements for the object element type


Builder statement Description Arguments
Required /
optional


addObject() Adds the instance to the XML document. It creates
the open tag for the object declaration.


Instance Name Optional


Class Name Required


Method Optional


addObjectClosing() Adds the closing tag for the object declaration in
the XML file.


No Arguments N/A


addNullObject Adds a null object "<object/>" into the output XML
document.


No Argument N/A


For example, to export an instance of the ServiceSubscriber class to the XML document, the builder
statement resembles this:


foreach svcSub (svcSubList) {


 builder->addObject(svcSub, "ServiceSubscriber");


 builder->addAttribute(svcSub, "DisplayName");


 builder->addObjectClosing();


Relationship element type builder statements
A relationship element has two required builder statements. Builder statements for the relationship
element type describes the builder statements and arguments for a relationship element.


Table 5‑2.  Builder statements for the relationship element type


Builder statement Description Arguments
Required /
optional


addRelationship( ) This adds the relationship to the XML
document. It creates the open tag for
the relationship declaration.


Relationship Name Required


Method Optional


addRelationshipClosing () Adds the closing tag for the
relationship declaration in the XML
file.


No Arguments N/A


For example, to export all the objects with a Subscriptions relationship to the XML document, the builder
statement resembles this:


builder->addRelationship("Subscriptions");


 foreach...


builder->addRelationshipClosing();
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Attribute element type builder statements
An attribute element has only one required builder statement. Builder statements for the attribute element
type describes the builder statement and arguments for an attribute element.


Table 5‑3.  Builder statements for the attribute element type


Builder statement Description Arguments
Required /
optional


addAttribute( ) This adds the attributes of the instance to
the XML document.


Instance Name Required


Attribute Name Required


Method Optional


Note   The closing builder statement is unnecessary for this element because there is no recursive part
so we can predict the end of the statement.


Since the ICIM/XML DTD requires that attribute definitions are nested within an object definition, this
builder statement is defined with an object element. For example, to export instances of the
ServiceSubscriber class, with their display names, to the XML document the builder statement resembles
the following:


builder->addObject(svcSub, "ServiceSubscriber");


builder->addAttribute (svcSub, "DisplayName");


builder->addObjectClosing();


String builder statement
Optionally, you can add text into the XML document along with any of the declarations. After any of the
builder statements defined above, you can use the addText statement. The argument may be any string
that complies with the ICIM/XML DTD. Builder statements for the string describes the builder statement
and arguments for this element.


Table 5‑4.  Builder statements for the string


Builder statement Description Arguments
Required /
optional


addText( ) Adds optional text to the XML
declaration.


String Required


For example, to export instances of the ServiceSubscriber class, with their display names, and additional
text that says Sample Offeringto the XML document, use the following syntax:


builder->addObject(svcSub, "ServiceSubscriber");


builder->addAttribute (svcSub, "DisplayName");


builder->addObjectClosing();


builder->addText("<object class=\"ServiceOffering"\) name=\"Sample Offering"\ method=\"update"\ />;
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Parsing the XML
The resulting XML generated by the ASL script and the XML Adapter is passed through a validating
parser. This is to ensure compliance with the ICIM/XML DTD. This parser, enables the XML Adapter to
read and write XML data.


VMware, Inc. provides the Xerces XML Parser with the installation of the XML Adapter.


Running sm_xml for export
XML exporter command parameters describes four export-specific parameters associated with the
sm_xml utility.


Table 5‑5.  XML exporter command parameters


Parameter Description Optional flag


Options:


--server=<name> Name of the Manager from which you are retrieving repository information.
By default, this Manager name is INCHARGE.


-s


--broker=<location> Alternate location of the VMware Smart Assurance broker. Must be typed
as host:port. The default is the broker specified for the Manager at
installation.


-b


Commands:


export --xmlfile=<output-
xmlfile> <asl-script>


Export an XML document using the XML export ASL script named <asl-
script>. By default, the XML is written to standard output.


Optionally, the XML can be written to a file if you specify: --xmlfile=<output-
xmlfile>.


-x <output-xmlfile>


Command arguments:


output=<xmlfile> Name of the resulting XML file (and qualified path to save the file).
Optionally, you can choose not to define a directory and filename and the
resulting XML will be displayed in standard output.


-x


<asl-script> The ASL rule script used to export the VMware Smart Assurance topology.
The adapter will look for the ASL script in BASEDIR/local/rules/xml-if first. If
it is not found there, it will locate it in BASEDIR/rules/xml-if.


N/A


The resulting XML is passed through a validating parser. If the document is noncompliant with the
ICIM/XML DTD, an error will appear and the program will exit with a nonzero exit status. When an error
occurs, the XML is still written to standard output.


For example, to generate an XML file called InChargeApplications.xml containing information from a
Manager called INCHARGE, with an ASL Export script called xml-export-Applications.asl, use the
following command:


tsm_xml --server=<


         INCHARGE


         > export --xmlfile=InChargeApplications.xml xml-export-Applications.asls
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Sample ASL Export script
In this example ASL script, you are requesting XML output for all instances of the ServiceSubscriber
class, the ServiceOfferings to which they are subscribed, and the Applications that compose the
ServiceOfferings:


/* xml-export-sample.asl


 *


 * Copyright (C) 2003, System Management ARTS (SMARTS)


 * All Rights Reserved


 *


 * Sample Rule Set to export the topology of the ServiceSubscribers, the


 * ServiceOfferings they are subscribed to, the Applications that these


 * ServiceOfferings are composedOf, and the Hosts that Host these


*  Applications from the server into an XML document that will confirm 


* to the ICIM/XML DTD specifications.


 *


 * This is a sample xml-export-*.asl file. Users should make copies of this


 * file, and edit them according to their needs. But they should always name


 * these asl files according to the Naming convention, xml-export-<name>.asl


 */


/*


 * the XML_Builder object


 */


default builderName = "";


aslname = " ".getRuleFileName().": ";


builder = self->object("XML_Builder", builderName)? LOG, STOP;


if (builder->isNull()) {


    print(aslname."ERROR: The Wrapper object has not been created.");


    print(aslname."ERROR: Please make sure the CREATE_BUILDER is called ".


                        "before calling the INITIALIZE rule in the script.");


    stop();


}


/*


 * NOTE: Customize the script from this point on.


 */


START() {


    .. eol


    EXPORT_BIM_INSTANCES


}


EXPORT_BIM_INSTANCES {


    EXPORT_SERVICESUBSCRIBER


    EXPORT_SERVICEOFFERRING


    EXPORT_APPLICATION


}


EXPORT_SERVICESUBSCRIBER {


} do {


    /*


     * Get all the instances of ServiceSubscriber class and start adding to the


     * XML Document.


     */


    svcSubList = getInstances("ServiceSubscriber")? LOG, NEXT;


    foreach svcSub (svcSubList) {
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        svcSubObj = object("ServiceSubscriber", svcSub)? LOG, IGNORE;


        builder->addObject(svcSub, "ServiceSubscriber");


        builder->addAttribute(svcSub, "DisplayName");


        builder->addRelationship("Subscriptions");


        /*


         * Get all the ServiceOffering objects that each of these


         * ServiceSubscribers subscribe to, and add them to the document.


         */


        foreach svcOffObj (svcSubObj->Subscriptions) {


            builder->addObject(svcOffObj->Name, svcOffObj->CreationClassName);


            builder->addObjectClosing();


        }


        builder->addRelationshipClosing();


        builder->addObjectClosing();


    }


}


EXPORT_SERVICEOFFERRING {


} do {


    /*


     * Get all the instances of ServiceOffering class and start adding to the


     * XML Document.


     */


    svcOffList = getInstances("ServiceOffering")? LOG, NEXT;


    foreach svcOff (svcOffList) {


        svcOffObj = object("ServiceOffering", svcOff)? LOG, IGNORE;


        builder->addObject(svcOff, "ServiceOffering");


        builder->addAttribute(svcOff, "DisplayName");


        builder->addRelationship("ConsistsOf");


        /*


         * Get all the <infrastructure> objects that each of these


         * ServiceOfferings consists of, and add them to the document.


         */


        foreach infObj (svcOffObj->ConsistsOf) {


            builder->addObject(infObj->Name, infObj->CreationClassName);


            builder->addObjectClosing();


        }


        builder->addRelationshipClosing();


        builder->addObjectClosing();


    }


}


EXPORT_APPLICATION {


} do {


    /*


     * Get all the instances of Application class and start adding to the


     * XML Document.


     */


    appList = getInstances("Application")? LOG, NEXT;


    foreach app (appList) {


        appObj = object("Application", app)? LOG, IGNORE;


        builder->addObject(app, "Application");


        builder->addAttribute(app, "DisplayName");


/*


         * Get the Host object that this Application is HostedBy,


         * and add it to the document.


         */
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        hostObj = appObj->HostedBy;


        builder->addRelationship("HostedBy");


        builder->addObject(hostObj->Name, hostObj->CreationClassName);


        builder->addObjectClosing();


        builder->addRelationshipClosing();


        /*


         * Get all the Transaction objects that these Applications Produce and


         * Consume, and export them to the XML Document also.


         */


        builder->addRelationship("Produces");


        foreach trans (appObj->Produces) {


            builder->addObjectClosing();


        }


builder->addRelationshipClosing();


        builder->addRelationship("Consumes");


        foreach trans (appObj->Consumes) {


            builder->addObject(trans->Name, trans->CreationClassName);


            builder->addObjectClosing();


        }


        builder->addRelationshipClosing();


        builder->addObjectClosing();


    }


}
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Importing Information into
VMware Smart Assurance 6
This chapter describes how to import XML data into the repository and contains the following information:


n XML import process


XML import process
To import an XML document containing topology, events, or other objects, your XML document must
comply with the ICIM/XML DTD. Process diagram: Importing XML data into VMware Smart Assurance
illustrates the XML import process. You may have a utility that exports the desired topology data as XML
using a unique DTD as in Option A. If this is the case, use an XSL Transformation (XSLT), which is a
language for transforming XML documents into other XML documents.


Alternatively, you can manually create an XML file that complies with the ICIM/XML DTD as in Option B.


When your XML document is ready, use the sm_XML Adapter to import the new objects into the
repository. Process diagram: Importing XML data into VMware Smart Assurancedisplays the import
process.
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Figure 6‑1.  Process diagram: Importing XML data into VMware Smart Assurance


Before importing XML
It is unnecessary to shut down the Manager before you import the XML file. However, when importing,
verify your XML is valid according to the ICIM/XML DTD. The DTD file, called icim_xml.dtd is located in
BASEDIR/smarts/conf/xml-if.


A runtime error is generated if the XML importer cannot execute the instructions encoded in the XML
document. By default, the importer skips any element (or child element) containing an error. It continues
with the next element and generates a report of errors at the end.


To determine if the XML is valid and complies with the ICIM/XML DTD, run the following command:


tsm_xml --server=<


         INCHARGE


         > import <


         Applications.xml


         >


         --verifys


If there are any errors within your XML document, they are listed so that you can address them.


Note   If you create an object with read-only attributes (such as ICS_Notification), those attributes may
cause a runtime error.


Running sm_xml to import XML
XML exporter command parameters describes the command parameters to use with sm_xml.


Table 6‑1.  XML exporter command parameters


Parameter Description Optional flag


Options:


--server=<name> Name of the target manager. By default, this manager name is INCHARGE. -s


--broker=<location> Alternate location of the VMware Smart Assurance broker. Must be typed as
host:port. The default is the broker specified for the manager at installation.


-b


Commands:


import [--exit-on-error] [--
verify] <input-xmlfile>


Import an XML document called <input-xmlfile>.


Optionally, the XML can be verified without importing it to the manager using --
verify. Additionally, using --exit-on-error, the XML can be imported, but the import
process will stop when an error is detected.


Command arguments:


<input-xmlfile> The XML file used to import the VMware Smart Assurance topology. N/A
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Table 6‑1.  XML exporter command parameters (Continued)


Parameter Description Optional flag


--exit-on-error This option allows you to import the XML, but stops the import process when a
runtime error is encountered.


By default, without this command option, a runtime error is reported, but the
import process resumes at the next element.


Note   Anything imported prior to the runtime error remains in the repository.


-e


--verify This option validates the XML file against the ICIM/XML DTD specification, but
does not import the XML to the Manager.


N/A


For example, to import a file called Applications.xml into a Manager called INCHARGE, use the following
command:


         sm_xml import --exit-on-error Applications.xml


      


Handling runtime errors
A runtime error is generated if the XML importer cannot execute the instructions encoded in the XML
document. By default, the importer skips any element (or subelement) containing an error. It continues
with the next element and generates an error report at the end.


There are two ways to avoid the runtime error:


n --verify: Without importing the ICIM/XML document, run the XML to see if it will be validated by the
parser.


n --exit-on-error: By default, objects will be imported as they are interpreted from the XML document
and any invalid objects will be identified in a summary file. Use this command option to quit the import
process when the adapter detects an error.


Note   Any objects imported before the error was detected will remain in the repository.
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Understanding the sm_edit
Utility 7
As part of the VMware Smart Assurancedeployment and configuration process, you need to modify
certain files. User modifiable files include configuration files, rule set files, templates, and files (such as
seed files, and security configuration files) that contain encrypted passwords. Original versions of these
files are installed into appropriate subdirectories under the BASEDIR/smarts/ directory.


Original versions of files should not be altered. If a file requires modification, it must be stored as a local
copy of the file in BASEDIR/smarts/local or one of its subdirectories.


This chapter includes the following topics:


n Example 1


n Example 2


Example 1


Modify serverConnect.conf
VMware Smart Assurance software is designed to first search for user modifiable files in
BASEDIR/smarts/local or one of its subdirectories. If a modified version of a file is not found in the local
area, VMware Smart Assurance software then searches appropriate nonlocal directories.


To facilitate proper file editing, VMware, Inc. provides the sm_edit utility with every
VMware Smart Assurance products. When used to modify an original version of a file, this utility
automatically creates a local copy of the file and places it in the appropriate location under
BASEDIR/smarts/local. This ensures that the original version of the file remains unchanged. You can
invoke sm_edit from the command line.


To invoke the sm_edit utility from the command line, specify the path and the name of the file to edit
under BASEDIR/smarts. If multiple VMware Smart Assurance products are running on the same host,
invoke sm_edit from the bin directory of the product with the files to edit.


Example 2
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Edit a configuration file
To edit the configuration file for connecting to a server (serverConnect.conf), invoke the sm_edit utility as
follows:


         /opt/InCharge/SAM/smarts/bin>sm_edit conf/serverConnect.conf


      


In this example, the sm_edit utility automatically creates a local copy of the serverConnect.conf file in
the /opt/InCharge/SAM/smarts/local/conf directory and opens the file in a text editor. If a local version of
the file already exists, the sm_edit utility opens the local version in a text editor. In addition, sm_edit
creates any necessary subdirectories.


The VMware Smart Assurance System Administration Guide provides additional information about the
sm_edit utility.
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Preface 1
As part of an effort to improve its product lines, VMware periodically releases revisions of its software and
hardware. Therefore, some functions described in this document might not be supported by all versions of
the software or hardware currently in use. The product release notes provide the most up-to-date
information on product features.


Contact your VMware representative if a product does not function properly or does not function as
described in this document.


Note   This document was accurate at publication time. New versions of this document might be released
on the VMware online support website. Check the VMware online support website to ensure that you are
using the latest version of this document.


This chapter includes the following topics:
n Purpose


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n VMware Smart Assurance Service Assurance Manager


n Related documentation


n VMware Smart Assurance Service Assurance Manager documentation


n Conventions used in this document


n Where to get help


n Your comments


Purpose
The Service Assurance Manager (Service Assurance) solution automatically correlates topology and
event data from multiple VMware Smart Assurance managed domains to diagnose root-cause problems
and (with Business Impact Manager) the impact that those problems have on business-critical processes
and services. VMware Smart Assurance managed domains can include IP networks, systems, routing
protocols, ATM/Frame Relay, applications, and business entities. Service Assurance Manager enables
operations personnel to effectively prioritize their time and resources to maintain and sustain the
business-critical processes and services.
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VMware Smart Assurance Service Assurance Manager Introduction provides high-level architectural and
functional overviews of the VMware Smart Assurance Service Assurance Manager solution. It also
provides several examples of implementation scenarios.


Audience
This document is intended for operations staff, managers, and administrators who are interested in
automated Service Assurance solutions.


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<productsuite>.


For example, on UNIX operating systems, VMware Smart Assurance Service Assurance Manager is,
by default, installed to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than/opt/InCharge (on UNIX),
but you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.


VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System


n Global Console


n Business Dashboard


n Companion UI


n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)


n XML Adapter


n VMware Smart Assurance Adapter for UIM/O
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Related documentation
In addition to this document, VMware Corporation provides a help system for command line programs as
well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


n VMware Smart Assurance Common Information Model (ICIM) 1.11 Reference for Non-Service
Assurance Manager Products


n VMware Smart Assurance Common Information Model (ICIM) Reference for Service Assurance
Manager


n VMware Smart Assurance Foundation Documentation Portfolio


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ASL Reference Guide


n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide


Note   These documents are updated periodically. Electronic versions of the updated manuals are
available on the VMware online support website:


docs.vmware.com


VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes


n VMware Smart Assurance Open Source License and Copyright Information


n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers
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n VMware Smart Assurance Service Assurance Manager Deployment Guide


n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide


n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide


n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance Companion UI Open Source License and Copyright Information for GPLv3
as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance products.


Conventions used in this document
VMware uses the following conventions for special notices:


Note   NOTICE is used to address practices not related to personal injury.


Typographical conventions
VMware uses the following type style conventions in this document:


Normal Used in running (nonprocedural) text for:
n Names of interface elements
n Names of resources, attributes, pools, Boolean expressions, buttons, DQL statements, keywords,


clauses, environment variables, functions, and utilities
n URLs, pathnames, filenames, directory names, computer names, links, groups, service keys, file


systems, and notifications


Bold Used in running (nonprocedural) text for names of commands, daemons, options, programs,
processes, services, applications, utilities, kernels, notifications, system calls, and man pages
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Used in procedures for:
n Names of interface elements
n What the user specifically selects, clicks, presses, or types


Italic Used in all text (including procedures) for:
n Full titles of publications referenced in text
n Emphasis, for example, a new term
n Variables


Courier
Used for:
n System output, such as an error message or script
n URLs, complete paths, filenames, prompts, and syntax when shown outside of running text


                
        Courier 
bold
                
     


Used for specific user input, such as commands


                
        Courier 
italic
                
     


Used in procedures for:
n Variables on the command line
n User input variables


< > Angle brackets enclose parameter or variable values supplied by the user


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example


Pathname conventions
Directory pathnames are shown with forward slashes (/).


Graphical conventions
Under UNIX, the consoles appear with slight differences. For example, in views that display items in a
tree hierarchy such as the Topology Browser, an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to VMware Smart Assurance programs
such as Domain Managers, Global Managers, and adapters.


Where to get help
VMware support, product, and licensing information can be obtained as follows:
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Product information


For documentation, release notes, software updates, or information about VMware products, licensing,
and service, go to the VMware online support website (registration required) at:


         docs.vmware.com
      


For technical support, Create Service Requests or Contact Customer Service on VMware Online Support
at support.vmware.com. To open a service request through VMware Online Support, you must have a
valid support agreement. Contact your VMware Sales Representative for details about obtaining a valid
support agreement or to answer any questions about your account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:docs.vmware.com.
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Architectural Overview 2
This chapter provides an architectural overview of
VMware Smart Assurance Service Assurance Manager( Service Assurance), the
Service Assurance Manageradapters, and the Service Assurancemodules
( VMware Smart Assurance Business Impact Manager, Global Console, and Business Dashboard) that
can be implemented to extend the capabilities of Service Assurance.


VMware Smart Assurance Service Assurance Manageris a solution for managing the technology
infrastructure that supports business services. As the cornerstone of network operations management, it
provides integrated, unified, and individualized views of the systems, network infrastructure, applications,
and business entities that comprise the managed domain.


Service Assurance Managerimports topology and event information from the underlying managed
domains (distributed management applications), consolidates the information, and interprets problems in
the context of their impact on business services. Service Assuranceprovides operations personnel with
meaningful information with which automated corrective actions can be associated.


The Service Assurancemodules provide the capabilities to calculate the business impact of infrastructure
problems, to produce a wide variety of operational and management reports, and to display customer-
specific information to a given enterprise or service provider customer through a secure channel.


This chapter contains the following information:


n Service Assurance Manager architecture


n Service Assurance modules


This chapter includes the following topics:


n Service Assurance Manager architecture


n Service Assurance modules


Service Assurance Manager architecture
VMware Smart Assurance Service Assurance Manager architecture illustrates the
VMware Smart Assurance Service Assurance Manager architecture.
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Figure 2‑1.  VMware Smart Assurance Service Assurance Manager architecture


VMware Smart Assurance Service Assurance Manager abstracts topology information and cross-
correlates and consolidates event information from distributed VMware Smart Assurance applications and
third-party applications.


Note   VMware Smart Assurance applications are responsible for discovering and monitoring
infrastructure elements, and correlating event information within their respective managed domains.


Service Assurance Manager, other VMware Smart Assurance applications, or third-party applications
communicate by way of a shared Information Bus that employs the VMware Smart Assurance Common
Information Model™ (ICIM). After Service Assurance abstracts high-level views of the distributed
topologies from the underlying applications, it correlates, consolidates, and integrates event information
collected from the applications, and enriches the event information with the severity of the events.


Event information (for example, root-cause problems and their impacts and severities) are displayed in
the Notification Log Console, Topology Browser Console, Map Console, or Summary View Console. From
these consoles, operations personnel can invoke diagnostic or corrective tools, store the information for
management and operations reports, and send the information to third-party applications.


Service Assurance Manager
The Service Assurance Manager, also referred to as the Global Manager, is the Service Assurance
component that serves as the central point for monitoring and managing your entire technology
infrastructure by obtaining data from multiple distributed domains. The Global Manager communicates
with the underlying distributed VMware Smart Assurance applications and abstracts and consolidates:


n Network, system, application, and business resources


n Results of domain-specific root-cause analysis
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n Results of domain-specific impact analysis


The Global Manager scales to large topologies because it maintains a high-level, abstract
representation of the topology. The detailed topology information — and therefore the bulk of the data
— is kept in other VMware Smart Assurance applications. When needed, the Global Manager
retrieves detailed information from the underlying domains.


The Global Manager can attach to multiple, distributed VMware Smart Assurance applications as well
as other Global Managers. It can also be integrated with third-party applications from which it can
receive topology and event information, and to which it can send event information or initiate
corrective actions.


The Global Manager, in conjunction with Report Manager, sorts and stores event-related information
in an ODBC-compliant database from which users can produce a variety of management, operations,
and business impact reports.


Global Console
VMware Smart Assurance Service Assurance Manager includes a user interface that provides different
views into VMware Smart Assurance-managed domains.


The Global Console displays topology and notifications as well as summary, containment, and status
information. VMware Smart Assurance operators use the Global Console to monitor
VMware Smart Assurance domains, acquire detailed information (on demand) about topology and events,
respond to problems, and take corrective action. VMware Smart Assurance administrators with
appropriate privileges and access control can use the Global Console to discover topology, and
administer underlying domains, as well as administer VMware Smart Assurance users, user profiles,
program tools, and escalation policies.


The Global Console runs as a standalone Java program.


Companion User Interface
VMware Smart Assurance Service Assurance Manager Companion User Interface (SAM Companion UI)
supplements existing functionality in SAM, VMware Smart Assurance Network Configuration Manager
(NCM) and Watch4net Automated Performance Grapher (APG).


The SAM Companion UI is a VMware®-based appliance, that is, a virtual machine. The
VMware Smart Assurance SolutionPack Installation and Configuration Guide provides detailed
information about installing and configuring the SAM Companion UI.


Integration with third-party applications
Because VMware Smart Assurance Service Assurance Manager is an open solution, it is possible to
integrate Service Assurance with third-party applications and other VMware Smart Assurance
applications by way of Service Assurance Manager (SAM) adapters, as shown in Integration with third-
party applications.
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The VMware Smart Assurance Service Assurance Manager Adapter Platform, which normalizes data in
accordance with the ICIM, enables the import or export of topology and event information. The topology
information is stored in the repository of the Global Manager. As event data is forwarded to
Service Assurance through the adapters, the system correlates the third-party event data with the
corresponding elements in the Global Manager’s repository.


SAM adapters also enable VMware Smart Assurance Service Assurance Manager to forward event
information to third-party applications, such as trouble ticketing systems.


Figure 2‑2.  Integration with third-party applications


VMware Smart Assurance Adapter for UIM/O
The VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations (referred to as the
VMware Smart Assurance Adapter for UIM/O) provides integration between the
VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations (here in referred to as
UIM/O) and the Service Assurance Manager. The adapter retrieves alerts from UIM/O, creates
notifications from the alerts, and sends the notifications to the Global Manager.
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The
VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide 
provides deployment information, configuration instructions, and client tool examples.


Service Assurance Failover System 
To maintain critical availability, VMware Smart Assurance Service Assurance Manager can be
implemented with a failover system. The
VMware Smart Assurance Service Assurance Manager Failover System ensures that the managed
environment continues to be monitored when the primary Global Manager becomes unavailable because
of a hardware failure or system malfunction. Redundancy is provided by a secondary Global Manager
that serves as a backup to the primary Global Manager. The Failover System, which is configured to
match the primary system, monitors the primary Global Manager. The Failover System periodically copies
the repository file to the secondary Global Manager, thus preserving important topology and configuration
information.


If a failure occurs, the secondary Global Manager automatically starts. The secondary Global Manager
registers with the VMware Smart Assurance Broker using the name of the primary Global Manager.
Clients of the primary Global Manager (such as the Global Console and adapters) that become
disconnected can reconnect to the secondary Global Manager.


When the primary Global Manager is again available to monitor the managed environment, a reset script
copies the backup repository to the primary Global Manager, shuts down the secondary Global Manager,
and restarts the primary Global Manager.


Service Assurance modules
Several modules can be implemented with VMware Smart Assurance Service Assurance Manager to
extend Service Assurance’s capabilities. These include:


n VMware Smart Assurance Business Impact Manager.


n VMware Smart Assurance Report Manager.


n VMware Smart Assurance Web Console.


n VMware Smart Assurance Business Dashboard.


VMware Smart Assurance Business Impact Manager
VMware Smart Assurance Business Impact Manager (Business Impact Manager) extends the capabilities
of Service Assurance to analyze events by calculating the business impact of events and propagating the
impacts to affected business entities as discrete notifications that are linked to topology within the
managed domain. The impacts are displayed in the Business Services Maps.
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To accomplish its functions, Business Impact Manager includes facilities to import business entities, which
consist of subscribers and service offerings. Subscriber information may include customers as well as
organizations, business units, lines of business, and department entities. Service offerings include
business processes. For example, a subscriber can be a customer that subscribes to an IT service
offering that provides Internet access.


The imported business information can be also assigned to user-specified groups.


Additionally, Business Impact Manager provides facilities to assign weights to business entities and other
elements in your topology. The weights capability allows you to prioritize critical topology and to use the
prioritized information when calculating the business impact of events.


VMware Smart Assurance Report Manager 
VMware Smart Assurance Report Manager (Report Manager), which includes a Structured Query
Language (SQL) Data Interface, extracts notifications from Service Assurance, passes them to an Open
Database Connectivity (ODBC) driver, and stores the notification information in a relational database. The
database uses a special database schema designed for VMware Smart Assurance notifications.


Notification information can then be extracted from the database and imported into Crystal Enterprise
Reports or some other user-selected report application.


The Report Manager includes predefined report files (in Crystal format) that can be used to display or
print a wide variety of operational, management, and business impact reports.


VMware Smart Assurance Web Console
The contents of the Global Console can also be displayed as a Java applet within a web browser. The
Web Console capability allows you to connect to a Domain Manager from any system with a web browser
and does not require a Global Console installation on the system.


VMware Smart Assurance Business Dashboard
The VMware Smart Assurance Business Dashboard (Business Dashboard) is a flexible, business-
oriented alternative to the Web Console. The Business Dashboard displays a collection of
VMware Smart Assurance analysis data alongside important data from other sources. Components of the
collection of VMware Smart Assurance data are referred to as VMware Smart Assurance ViewletsTM.
The collection of viewlets can be loaded into your organization’s web page and can commingle with
important trouble-ticketing information or your company’s intranet news. VMware Smart Assurance
viewlets can also be embedded within a third-party Web Portal product.


Web Console and VMware Smart Assurance Business Dashboard architecture illustrates the architecture
of a Web Console and an VMware Smart Assurance Business Dashboard when loaded by a remote user.
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Figure 2‑3.  Web Console and VMware Smart Assurance Business Dashboard architecture
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Functional Overview 3
This chapter includes the following topics:
n Service Assurance Manager features and functions


n Automatic topology and event consolidation


n Automatic topology abstraction


n Global Console


n Service Assurance functions


n Service Assurance module functions


Service Assurance Manager features and functions
Service Assurance Manager provides the automated functions and features that are required by today’s
enterprise and service provider network operations centers. Its automation, intelligent analyses, and
adaptability can significantly reduce both the resources needed for pinpointing and resolving
infrastructure problems, and the costs of monitoring and managing distributed networks.


Automatic topology and event consolidation
One of the primary tasks of VMware Smart Assurance Service Assurance Manager is topology and event
consolidation. Service Assurance Manager imports infrastructure elements (such as hosts and routers)
and applications from each underlying managed domain. As it imports the elements, it consolidates
elements that are reported by different sources. Service Assurance Manager also imports the
relationships between the elements from the underlying managed domains. Using these relationships and
overlapping devices, Service Assurance Manager accurately pieces together a complete topology of the
managed environment.


When Service Assurance Manager imports events from the underlying managed domain, they are
automatically associated with the elements to which they apply. Notifications received from multiple
sources are consolidated into single events. Similarly, impacts reported by different sources for the same
problem are deduplicated and associated with the consolidated event in Service Assurance Manager.


Further, to provide business context, VMware Smart Assurance Service Assurance Manager provides a
facility that imports customer and service information from provisioning systems and other sources. Using
this data, Service Assurance Manager can automatically calculate the customer and service impact for
the consolidated events.
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Automatic topology abstraction
In order to scale to large numbers of underlying systems,
VMware Smart Assurance Service Assurance Manager performs topology abstraction. Difference
between detailed and abstracted representation illustrates the difference between a detailed
representation and an abstracted representation of network connectivity.


Figure 3‑1.  Difference between detailed and abstracted representation


Abstraction produces a coarse level of topology detail. A system, for example, is viewed as a single entity
rather than as a collection of its components, and connectivity is between systems as opposed to
between components in the system.


Although Service Assurance maintains a coarse level of topology detail, it stores sufficient information for
its varied Notification Log, Topology Browser, and Map views. When needed, detailed information can be
automatically retrieved from the underlying applications by Service Assurance.


Global Console
The Global Console provides a focal point through which operations personnel can monitor and manage
distributed systems and VMware Smart Assurance administrators can configure and administer Domain
Managers. VMware Smart Assurance administrators control the views, program tools, and access to
console operations for VMware Smart Assurance users. The following describes the full functionality of
each console. Certain functions require a license and thus may not be included in your
VMware Smart Assurance deployment. Also, an VMware Smart Assurance user’s access to some
console operations may be restricted based on the user’s connection privileges and user profile.


For any given event, operations personnel with appropriate access control can take ownership of the
event, acknowledge the event, add comments to the audit log of the event, or invoke tools for corrective
actions.


The Global Console provides the following console views:


n Notification Log Console
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n Topology Browser Console


n Map Console


n Summary View Console


n Status Table Console


n Domain Manager Administration Console


n Global Manager Administration Console


Notification Log Console
The Notification Log Console provides a view of a set of notifications, which is defined by the user profile
associated with the user. The notification information can include, for example, the type of event, the
element that is affected, and the severity of the event. Operations personnel can potentially open multiple
Notification Log Consoles, each customized to display different events, or show multiple lists in a single
console, as needed.


Operations personnel can also potentially access the details of the event through the use of the
Notification Properties dialog box. The Notification Properties dialog box provides detailed information
about a selected notification. The properties include, for example, attributes and values related to this
event, elements that are impacted by this event, an audit log of changes in this event’s history, or (if this
event is a root-cause problem) other events used in the analysis.


The viewable attributes of the displayed events in the Notification Log view (for example, event severity,
active event, or first notify) can be customized to meet the needs or preferences of operations personnel.
The order in which the attributes are displayed can also be modified. Operations personnel can sort on
any number of attributes (whether the attribute column is visible or not) by specifying up to five sorting
columns.


The notifications listed in the Notification Log view are color-coded in accordance with the severity of the
events. An icon is also used as another indicator of an event’s severity.


Topology Browser Console
The Topology Browser Console enables operations personnel to display the managed topology in a tree
format and traverse the topology. The console displays Domain Managers as well as Global Managers.
For the selected managed domain, the console displays the classes of elements, instances of each class,
and their relationships. Specified elements, a circle (on UNIX systems), can be expanded into instances,
properties, or relationships.


When an element in the topology tree is selected, the console displays a corresponding property sheet
with tabs for Attributes, Events, and Groups. The tabs, where applicable, include the following
information:


n Attributes — Provides general information about the selected element


n Events — For a selected Global Manager, displays the active events that Service Assurance may
notify for the element
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n Groups — Provides the current group membership of the element


In addition, the Topology Browser Console provides the Browse Detail menu option. When an
element in the topology tree is selected, Browse Detail displays a list of all underlying managed
domains that contain that element in their topology. Users can select an underlying managed domain
and display it in another Topology Browser view. For hierarchical Service Assurance deployments,
users can select Browse Detail as many times as necessary to navigate to the desired domain. Note
that Browse Detail is also available for selected notifications in the Notification Log Console and for
selected map icons and edges in the Map Console.


Map Console
The Map Console displays, by way of icons and edges, the managed elements in a given environment
and the relationships between them. Different types of maps are made available based upon the
elements in your managed topology. For example, with
VMware Smart Assurance IP Availability Manager, the console displays infrastructure elements in
network and connectivity maps. With the addition of Business Impact Manager, the console can also
display business services maps that show how the infrastructure elements are associated with business
services, as well as the customers that subscribe to those services.


Operations personnel can select elements in the maps and then display detailed information about the
elements, such as the ports or interfaces contained in a system.


If the status of a given element displayed in the Map Console indicates a problem, operations personnel
can view the audit logs of events by way of the Notification Properties dialog box. They can also select
and use tools such as on-demand pings and Telnet sessions.


The maps can be customized to meet your needs or preferences. For example, custom backgrounds and
element icons can be incorporated into the maps.


Summary View Console
The Summary View Console provides overviews or summaries of notifications. The console can contain
several summaries that are attached to either the same managed domain or to different domains.


Summaries offer concise, graphical representations of sets of notifications associated with groups of
elements. The summary can be depicted as a three-dimensional graph or pie chart. The summary counts
indicate the percentages of elements in the group with active events.


The summaries organized by severity are color-coded in accordance with the severity of the events.
Otherwise, for other criteria, the colors do not indicate event status.


Status Table Console
A Business Impact Manager user can view a Status Table to quickly determine the overall status of
customers and the services being delivered to those customers. In such a Status Table, customers would
be represented as the primary set of instances, and the services being delivered to them would be
represented as the secondary set of instances.
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To describe it in more general terms, a Status Table Console offers another way to present a concise
status of a set of instances. The information appears as a matrix, with a primary set of instances along
the y-axis and a secondary (related) set of instances along the x-axis. The status of the related instances
appears, when relevant, at the intersection points in the matrix to reflect the overall status for each
primary instance.


The Status Table functionality is very useful for the Business Impact Manager user. The Status Table
requires a Web Console or VMware Smart Assurance Business Dashboard license.


Domain Manager Administration Console
The Domain Manager Administration Console enables VMware Smart Assurance administrators to
configure and administer the underlying Domain Managers, and to perform tasks such as:


n Discover topology


n Manage and unmanage elements in the managed topology


n Access the Polling and Thresholds Console to fine-tune parameters of the polling and thresholds
settings in the underlying domain


The VMware Smart Assurance Storage Insight Management Suite Discovery Guide provides
information about the Domain Manager Administration Console. Information about polling and
thresholds for specific VMware Smart Assurance applications is provided in their respective user
guides.


Global Manager Administration Console
The Global Manager Administration Console enables VMware Smart Assurance administrators to
configure Global Managers, including Security Infrastructure Managers (SIMs), and the SAM Adapter
Platform.


For a selected Global Manager, VMware Smart Assurance administrators create and maintain
configuration entities such as notification lists, tools, users, user profiles, access control to console
operations, and escalation policies.


The VMware Smart Assurance Service Assurance Manager Configuration Guide contains information
about the Global Manager Administration Console.


Service Assurance functions
The following section describes many of the functions that are integral to the
VMware Smart Assurance Service Assurance Manager.


Notification severity
The VMware Smart Assurance Service Assurance Manager classifies notifications according to their
calculated severity.
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The notifications listed in the Notification Log Console and the Map Console are color-coded in
accordance with the severity of the events. Icons are also used in the notification log and the maps to
identify severity.


The color codes are explained in Notification severity levels.


Table 3‑1.  Notification severity levels


Level Icon Color Description


1 Red Critical — Identifies a specific failure that requires resolution.


2 Orange Major — Identifies a serious condition that requires immediate attention.


3 Yellow Minor — Identifies an abnormal condition that is not serious but requires some
action.


4 Blue Unknown — Identifies an unknown, unreachable, disconnected, or suspended
condition.


5 Green Normal — The element is in its normal state.


Notification List
A Notification List determines the events that are forwarded to a given client. Essentially, the list filters the
notifications that are sent from the Global Manager to a client. Additionally, the list, which is configured by
the VMware Smart Assurance administrator, can be assigned to one or more user profiles. The personnel
assigned to a specified list only see the set of events defined by the list.


The lists could be used to organize, for example:


n Business units


n Geographical regions


n Groups of resources


During day-to-day operations, operations personnel use the Global Console to monitor and manage
their areas of responsibility. In doing so, personnel see only the subset of notifications defined for
them in the Notification List.


VMware Smart Assurance adapters can also connect to a Notification List, and receive the
notifications that match the conditions specified in the list.


The VMware Smart Assurance Service Assurance Manager Configuration Guide contains information
about Notification Lists.
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Tools
Tools are programs that are executed by VMware Smart Assurance Service Assurance Manager. There
are two types of tools:


n Server and client tools can be invoked by operations personnel in the Global Console or can be
automated using escalation policies. Tools invoked by operators may produce output that can be sent
back to the console for display.


n Automatic tools are executed by administrator-specified escalation policies or by adapters. Output is
not sent back to the console for display.


Server and client tools are executed in the context of a particular target object. The target object may
be a notification, or it may be an infrastructure element such as a router. When invoked from the
Global Console, the specification of the target object is implicit.


Automatic tools are executed for notifications that meet the escalation criteria for specified periods of
time.


The VMware Smart Assurance Service Assurance Manager Configuration Guide contains additional
information about the Service Assurance tools.


Notification escalation
Escalation is a process that defines a sequence of corrective actions for notifications. Examples of
corrective actions include alerting responsible parties and executing automatic tools.
VMware Smart Assurance administrators use the Escalation view in the Global Manager Administration
Console to configure escalation policies.


Escalation policies enable VMware Smart Assurance administrators to automate responses to events. For
example, an administrator can configure an escalation policy to page a shift supervisor if no one takes
ownership of a problem for more than 15 minutes. If the problem remains unowned for 30 minutes, the
policy will page the operations manager. The administrator can define multiple policies to handle different
types of events.


Audit log
An audit log is associated with each of the notifications that the
VMware Smart Assurance Service Assurance Manager receives from the underlying
VMware Smart Assurance applications. The audit log includes the following information:


n Event


n Time of the update


n Name of the operations person or system that made the update


n Type of audit entry
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n Description of the entry (for example, Notify, Clear, or Suspend)


Service Assurance begins to create an audit log when it receives a notification, and relates the event
to an infrastructure element. Thereafter, Service Assurance adds actions for the event, any program
tools used for the event, and changes in the status of the event. Actions may include system actions
such as archiving and user actions such as acknowledgement and ownership. Comments can be
added directly to the audit log.


An audit log for each notification can be viewed in an audit log dialog box using the Global Console,
exported to spreadsheet applications, or printed as part of a report. All the audit log entries for
individual notifications are stored in one log file on the Global Manager.


Containment
The Containment dialog box provides detailed information about a managed element. Containment
information varies depending upon the type of element and the type of analysis being performed by the
underlying domain. As examples, for a network connection, the containment information includes details
about connection points; for a device managed by IP Performance Manager, containment information
includes details about the device’s memory.


The Containment dialog box is available for selected notifications in the Notification Log Console, for
selected instances in the Topology Browser Console, and for selected nodes in the Map Console. When
an element is managed by multiple Domain Managers, the Containment dialog box includes all the
containment information for each domain.


Security
Security is a critical concern in the world of large-scale distributed networks. Therefore, the
VMware Smart Assurance Service Assurance Manager provides several means by which
VMware Smart Assurance administrators can set up security and control access to the system. This
includes:


n User rights and privileges, including client authentication


n Encryption of passwords in files


n Encryption of communication channels


n Support for FIPS 140-2


An VMware Smart Assurance administrator can place access restrictions on certain console
operations by applying user profiles. Each user should be associated with a profile that defines the
appropriate level of access control (rights and privileges) for their position and job responsibilities.


Client/server connections are controlled on both the client and server sides of the system. The
system is secured using authentication records and by assigning connection privileges on the server
side. When a client initiates a connection to a server, the client must supply appropriate
authentication to the server before the connection (as defined by the connection privileges) is
permitted.


For added protection, authentication and other passwords are encrypted in the files that store them.
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Communication channels (that is, TCP connections made through Remote API) between
VMware Smart Assurance servers, brokers, and adapters can also be encrypted. Instead of passing
information as clear text, these components’ communications can be encrypted using either a site
secret, the Diffie Helman-Advanced Encryption Standard (DH-AES), or both. For new installations,
encryption by DH-AES is enabled by default between VMware Smart Assurance processes that
support encryption.


The Federal Information Processing Standard (FIPS) Publication 140-2 is a U.S. government
computer security standard governing cryptographic modules. FIPS 140 is required for any software
purchased by the U.S government and U.S military. This release specifically addresses U.S
Government accounts which require FIPS 140 compliance.


A configuration parameter, SM_FIPS140, has been introduced for FIPS 140 in the runcmd_env.sh
file. The SAM administrator can enable or disable this parameter as required. The default value of this
parameter is FALSE.


The VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers
provides additional information on FIPS 140-2.


The VMware Smart Assurance System Administration Guide contains additional information about
securing access to VMware Smart Assurance applications. The
VMware Smart Assurance Service Assurance Manager Configuration Guide includes additional
information about restricting access to certain Global Console operations.


Service Assurance module functions
The Service Assurance modules provide additional capabilities to calculate the business impact of
infrastructure problems, to produce a wide variety of operational and management reports, and to display
customer-specific information to a given enterprise or service-provider customer through
VMware Smart Assurance Business Dashboard.


VMware Smart Assurance Business Impact Manager functions
The degradation or failure of important infrastructure elements can slow or stop vital business processes
and business services, or dramatically reduce user productivity in needed business areas.
VMware Smart Assurance Business Impact Manager ensures maximum availability of services.


VMware Smart Assurance Business Impact Manager (Business Impact Manager) extends the capabilities
of Service Assurance to calculate the business impact of events, and to propagate the impacts to affected
business entities as discrete notifications that are linked to elements in the infrastructure.


Users can create business entities, such as organizations, business units, lines of business, and
departments, and relate them to corresponding infrastructure elements. Users can also create business
processes.


In Business Impact Manager, users can assign different weights to any elements in the business or
infrastructure topology. Business Impact Manager calculates the impact of root-cause problems by
summing up the weights of the impacted elements.
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The calculated impact enables operations management to prioritize notifications in accordance with
business needs, and to effectively use their time and resources to resolve problems that degrade or
threaten vital processes and services.


Business process tools are also provided for users to create, update, and delete events associated with
their business processes. For example, a user might create an event that represents a telephone call
from a supplier who is out of stock of a popular retail product, and then associate the event with the user’s
Order Fulfillment Business Process.


The VMware Smart Assurance Business Impact Manager User Guide includes detailed information
regarding Business Impact Manager.


VMware Smart Assurance Report Manager functions
The VMware Smart Assurance Service Assurance Manager collects a wealth of notification data. To make
this data available to operations personnel, Report Manager can be implemented with
Service Assurance Manager.


VMware Smart Assurance Report Manager (Report Manager), which includes a Structured Query
Language (SQL) Data Interface, extracts notifications by way of a Notification List from
Service Assurance, passes them to an Open Database Connectivity (ODBC) driver, and stores the
notification information in a relational database. The database uses a special database schema designed
for VMware Smart Assurance notifications.


Notification information can then be extracted from the database, and imported into Crystal Enterprise
Reports or some other user-selected report application.


The Report Manager includes predefined report files (in Crystal format) that can be used to display or
print a wide variety of operational and management reports. The predefined report files include:


n Day-to-day operations reports


n Operations management reports


n Maintenance reports


n Business impact reports


Day-to-day operations reports
The notification data stored by Service Assurance can be used to generate a variety of reports that are
helpful for day-to-day operations. For example:


n An open event report that lists all active events, sorted by duration


n A critical customers report that summarizes availability by customer and highlights those customers
with the lowest availability


n A critical devices report that allows operations management to review operations performance and
identify hot spots in the infrastructure (from a failure perspective)
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Operations management reports
The notification data can be used to generate management reports that provide high-level views of
service quality and staff performance. For example:


n An operator workload report that lists the workload of operators through their ownership of active
notifications


n A post mortem report that lists recently cleared events, sorted by duration


n An acknowledged events report that lists active, acknowledged root-cause events


n An unassigned events report that lists events that no one owns


n All active and inactive events for a specific element, showing the overall health of the element


Maintenance reports
The reports can be used to help identify problem equipment. For example:


n An availability report that summarizes the availability of all devices or just the devices of a specified
class


n A recurring problem report that lists those events with the most occurrences or greatest total impact
for a period of days, and highlights the most affected elements


Business impact reports
VMware Smart Assurance Business Impact Manager users also have predefined reports that track critical
business entities in the network. For example:


n A critical business users report that shows the availability of devices by customer


A critical business processes report that shows the availability of a
customer’s business processes
VMware Smart Assurance Business Dashboard functions
The VMware Smart Assurance Business Dashboard (Business Dashboard) displays views normally
available from the Global Console as a collection of VMware Smart Assurance viewlets within your
organization’s web page or a third-party web portal. VMware Smart Assurance viewlets can display a
variety of information including a Notification Log, Status Table, Map, Summary, Notification Properties, or
Containment view. Viewlets can also be customized to suit your needs. For example, a map viewlet can
be set up to show a specific topology instance as the focus of the map display.


Furthermore, the viewlets can function as sources for broadcasting context information to other, listener
viewlets. For example, a Status Table viewlet and a Notification Log viewlet can be displayed such that
selections in the Status Table result in the Notification Log showing notifications related to those Status
Table selections.
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Implementation Scenarios 4
This chapter includes the following topics:


n Challenges of network management


n VMware Smart Assurance solutions


n Enterprise provider


n Network service provider


Challenges of network management
Regardless of the business area, network management organizations everywhere are faced with the
following challenges:


n Improve service


n Reduce operational costs


n Integrate new tools with existing management and support systems


n Deliver a high return on investment


VMware Smart Assurance solutions
The features and functions of the VMware Smart Assurance solutions, which include
VMware Smart Assurance IP Availability Manager, VMware Smart Assurance IP Performance Manager,
VMware Smart Assurance Application Services Manager, VMware Smart Assurance ATM/Frame Relay
Manager, and VMware Smart Assurance Service Assurance Manager, address important challenges that
network management organizations face on a day-to-day basis.


Fast and accurate fault isolation
VMware Smart Assurance uses comprehensive topology models to quickly and accurately analyze and
isolate failures in networks of any size and complexity.


VMware Smart Assurance analysis improves service by greatly reducing manual problem isolation, which
accounts for up to 80 percent of total downtime. The analysis also lowers operational costs by reducing
the human effort involved in isolating problems, as well as the effort involved in chasing down all the
symptomatic events and false alerts.
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Automated corrective actions
Once a fault has been accurately isolated, Service Assurance Manager can be configured to initiate
automated responses to correct soft faults or to reroute services around failures. Because
VMware Smart Assurance can separate root-cause problems from symptomatic events and false alarms,
actions are only invoked when or where needed. With the VMware Smart Assurance topology models,
corrective actions can be invoked against both the failed component or any impacted services.


Service Assurance Manager’s automated actions avoid service downtime and provide virtually immediate
service restoration. They can also improve service by fixing problems before users become impacted.


Business focus
VMware Smart Assurance Business Impact Manager can import business information directly from
existing data sources such as provisioning systems. During its analysis, it places infrastructure problems
in their proper business context and analyzes their impact on services, business processes, and
customers. This enables managers to focus their efforts on the problems with the highest business
impact.


Integration
VMware Smart Assurance solutions are designed to integrate with management tools and other
operational support systems. VMware Smart Assurance leverages management data from third-party
sources while providing console access to third-party management applications.
VMware Smart Assurance software’s ability to distill countless events into a concise set of defined
problems and exceptions makes it a natural integration point for problem management (ticketing)
systems.


Service Assurance’s integration with other management applications lowers operational costs by
providing users with a single, consistent, intuitive interface for viewing all management data. At the same
time, Service Assurance improves operational control by presenting a concise display of network
problems in their full topology context, complete with their impacts and histories.


Rapid deployment and low maintenance
VMware Smart Assurance solutions are designed for rapid deployment and low maintenance. Unlike
other management solutions, VMware Smart Assurance software’s comprehensive set of problem and
impact models automatically adapt to the configuration of the network infrastructure — providing
immediate results. This same adaptability enables VMware Smart Assurance solutions to automatically
keep pace with future changes in the infrastructure without the need for expensive ongoing code
maintenance.
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VMware Smart Assurance has the ability to automatically adapt to changes due to use of ICIM models
that represent the various elements of the infrastructure, how they relate to one another, and how they
can affect one another. VMware Smart Assurance solutions then apply these models to the discovered
elements in a given network to provide problem and impact analysis specific to that network. Furthermore,
customers who need additional functionality can leverage these models to build solutions that also adapt
automatically to change.


This enables VMware Smart Assurance solutions to provide better return on investment than other
management solutions. Benefits include:


n Automatic adaptation reduces the head-count needed to maintain the management solution


n Analysis that automatically adapts to changes in the environment and provides more accurate results,
which reduces service downtime


n More accurate analysis frees up expensive engineering resources to work on more strategic
initiatives


Enterprise provider
A diversified financial services firm deployed an VMware Smart Assurance Service Assurance Manager
solution to help them manage their complex infrastructure as an integrated system rather than as sets of
unrelated silos.


The primary concern of the financial enterprise was that more than 100 mission-critical applications were
used by their business units, such as applications to monitor their exposure to interest and currency
fluctuations. Basically, the enterprise had too many mission-critical applications for the network teams to
track. At the same time, their network changed and evolved so quickly that the application teams could
not stay abreast of the changes.


As a result, when network failures occurred, or when network maintenance was required, they had no
way of knowing which applications were affected. Attempts to do this with traditional tools—where one
specified network dependencies for each application—failed because of the need to manually maintain
the correlation logic every time the network topology changed. If they missed a change, the correlation
would fail.


By deploying an VMware Smart Assurance solution, the enterprise was able to solve their problem by
separating the network, applications, and business analysis into separate domains, thus breaking the
problem into manageable pieces, as well as automating the most complicated part of their problem:
defining the network dependencies of the distributed applications. Their VMware Smart Assurance
solution consisted of the following:


n VMware Smart Assurance IP Availability Manager and IP Performance Manager — To monitor
failures in the network infrastructure and identify the affected systems, automatically calculating the
affect of any network path redundancies


n VMware Smart Assurance Application Services Manager — To perform root-cause and impact
analysis of distributed applications based on events and topology information imported from the
IP Availability Manager, IP Performance Manager, and the SAM adapters
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n VMware Smart Assurance Business Impact Manager — To correlate failures in the technology
infrastructure to the businesses they impact (for example, processing on NASDAQ trades)


n VMware Smart Assurance Service Assurance Manager — To bring it together into a single system,
where users can customize views of the data they need, and use the appropriate tools to quickly
restore service


n VMware Smart Assurance Business Dashboard — To provide web-based, personalized views for
business unit managers (for example, in the foreign exchange unit) showing a map representation
and a summary view of the status of their systems.


Enterprise solution illustrates their VMware Smart Assurance implementation.


Figure 4‑1.  Enterprise solution
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By connecting the analysis from the network, application, and business domains,
VMware Smart Assurance Service Assurance Manager provided the enterprise with an end-to-end
view of causes and impacts — automatically correlating network failures with their impacts on
applications and critical business processes. For example, it showed that a switch failure blocked
access to a Solaris system that ran one of the two Oracle databases that supported their accounts
receivable application. This resulted in degraded performance of the accounting application, and
placed their ability to complete their quarterly financial reporting on time at risk.


By knowing the business impact of each problem, the operations staff effectively prioritized their
support efforts on the most critical problems; that is, they aligned their efforts with the overall business
objectives of the enterprise.


At the same time, because VMware Smart Assurance IP Availability Manager and
VMware Smart Assurance IP Performance Manager automatically adapt to changes in the network
topology, operations did not need to devote teams of people to modify the analysis every time the
network topology changes. This dramatically reduced the cost to maintain their management
systems. In fact, because all of the logic is based on the infrastructure topology, they only needed to
manually maintain the business and application elements. VMware Smart Assurance software
automatically adapted everything else: root-cause and impact analysis, personalized views, and so
forth.


In addition to solving the problem of application and business impact, the
VMware Smart Assurance Service Assurance Manager also streamlined operational processes.


By identifying the root causes, the support staff eliminated most of the time-consuming fault isolation
process and immediately proceeded to problem resolution. By identifying which events are impacts of
other problems, the support staff avoided wasting time trying to chase down and fix symptoms of
other problems. Finally, by relating the root causes with the impacts, operations staff streamlined
communications. For example, when estimating the time to resolve a root-cause problem, that
information was automatically propagated to all affected systems, applications, and business
processes.


Because they identified the actual root-cause failures (for example, a card on a switch), they were
able to automate the dispatch of service technicians from their maintenance provider. More
importantly, because they positively identified the failed element, they avoided the delays caused by
technicians who arrived on site with the wrong parts.


By integrating the VMware Smart Assurance solution with their existing system and application
management tools (by way of SAM adapters), the enterprise was able to leverage their previous
investments in management tools and accelerate the deployment of the overall solution.


Network service provider
A large network service provider had been using traditional management tools to manage a broad array
of services. After several years of deployment and custom work, the systems were starting to improve
network operations. However, the maintenance costs were spiraling out of control and it was becoming
more difficult to keep up with changes in the managed environment. Worse, the operational
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improvements were not translating into higher customer satisfaction because of communications failures
between operations and the call center. The provider needed to find an alternative that could deliver real
improvements to customer satisfaction while reducing operational costs. The answer to this challenge
was an VMware Smart Assurance solution composed of:


n VMware Smart Assurance ATM/Frame Relay Manager


n VMware Smart Assurance IP Availability Manager


n VMware Smart Assurance IP Performance Manager


n VMware Smart Assurance Application Services Manager


n VMware Smart Assurance Service Assurance Manager Adapter Platform


n VMware Smart Assurance Business Impact Manager


n VMware Smart Assurance Service Assurance Manager


n VMware Smart Assurance Business Dashboard


With the autodiscovery feature of VMware Smart Assurance autodiscovery, built-in analysis, and
policy-based management, operations was able to immediately identify and isolate root-cause failures
in their networks. Because VMware Smart Assurance applications automatically detect and adapt to
changes in topology, the service provider no longer needed to dedicate teams of consultants to
maintain them. Also, because VMware Smart Assurance intelligently manages networks with
overlapping IP addresses (for example, private IPs), the provider could discontinue the expensive
process of dedicating a separate management system to each customer. These features helped the
provider to dramatically reduce the cost of managing their environment.


By integrating the VMware Smart Assurance solution with existing management tools (for example,
system and application agents from Concord), the service provider was able to use its existing
investments to cut deployment time.


The unique capability of VMware Smart Assurance to integrate not just events, but events in the
context of a comprehensive topology, allowed the service provider to more effectively integrate
operations with its other OSS applications. By integrating with their provisioning system, the provider
was able to automatically build their business topology, and relate customers to services and services
to elements in their network topology. This integration provided automated business impact analysis
for prioritization, and allowed users to view technology failures in their complete technical and
business context.


Leveraging this business topology, VMware Smart Assurance was able to automatically identify which
events customers would care about so that the call center could focus on customer impacts rather
than sifting through masses of arcane infrastructure events. Similarly, by using the customer data to
integrate with the CRM application, VMware Smart Assurance was able to identify the account
managers associated with each customer impact, and notify them of problems in real time.
Furthermore, the operations staff used this information to coordinate maintenance work with the
account managers of potentially affected customers.
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Because problem causes and impacts were linked, the provider was also able to streamline
communications between operations and the call center. For example, when operations identified a
problem and dispatched an engineer to resolve it, they could estimate a repair time and the system
automatically relayed that estimate for all customer impacts to the call center and customer web
applications so that everyone immediately knew when the service would be restored. Finally, when
customer relations faced a crisis and the customer assurance staff elevated the priorities of specific
customer impacts, VMware Smart Assurance automatically applied the priority changes to the root-
cause failures and notified engineering management so that operations could shift their activities
accordingly.


With the Business Dashboard, the provider's customers were able to get real-time views of their data.
Because these views use the same topology, the views changed automatically whenever the topology
changed. This, too, reduced the cost of servicing customers.


In conclusion, by effectively integrating the VMware Smart Assurance solution with its existing
applications (for example, provisioning, CRM, and call center), the service provider was able to show
a more professional face to its customer. In the past, customer calls to the call center typically
resulted in an operator taking messages, calling around operations to see what was happening, and
then calling the customer back — a time- consuming process that often left the customer wondering
what the provider was doing. Now, when the customer calls, the call center is not only aware of the
problem, but is also able to give the customer up-to-the-minute information about the status of the
problem and its resolution.
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Overview 1
This chapter includes the following topics:


n Product contents


n Product and version compatibility


n Installation tasks overview


n Upgrade tasks overview


n Migration tasks overview


n Uninstallation tasks overview


Product contents
This document provides installation, upgrade, migration, and uninstallation procedures for:


n VMware Smart Assurance Service Assurance Manager


n VMware Smart Assurance IP Manager


n VMware Smart Assurance MPLS Management Suite


n VMware Smart Assurance Server Manager


n VMware Smart Assurance Network Protocol Management Suite


The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager


The Service Assurance Manager product includes the following components:


n Global Manager


n VMware Smart Assurance Broker


n VMware Smart Assurance MBIM — Maintenance and Business Impact Manager Server


n Generic notification adapters such as Log File, SNMP Trap, Script, and email


n EMC Data Access API


n Smarts Foundation EMC Data Access API (Smarts EDAA)
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n Alert EMC Data Access API (EDAA)


n VMware Smart Assurance Data Web Applications (Tomcat)


n VMware Smart Assurance Notification Exchange (Rabbit MQ)


n VMware Smart Assurance Notification Cache (ElasticSearch)


Note   Some components, such as Business Impact Manager, require licensing.


n Global Console


The Global Console product is the graphical interface for all VMware Smart Assurance products.


Global Console functionality can also be deployed as a Web Console or a Business Dashboard.


n Adapter Platform


The SAM Adapter Platform product provides functionality to import and normalize topology and
events from outside the VMware Smart Assurance domain.


n Syslog Adapter


The Syslog Adapter product reads and processes system log (Syslog) messages. It requires the SAM
Adapter Platform.


n Smarts Notification Module


The Smarts Notification Module (NOTIF) augments VMware Smart Assurance solutions with event
management features that are configured through a graphical user interface (the Smarts NOTIF
Editor). Smarts NOTIF enables the user to easily optimize the flow of events and notifications sent
through any VMware Smart Assurance system. Smarts NOTIF can be installed on either the SAM
server or Adapter Platform server, or both. The internal event and notification processing features of
the standard SAM Adapter Platform are replaced by Smarts NOTIF.


Note   Smarts NOTIF functionality and architecture is discussed in the VMware Smart Assurance
Notification Module User Guide.


n Smarts Notification Module Cisco Syslog Processing Adapter


The Smarts Notification Module Cisco Syslog Processing Adapter (referred to as the Smarts NOTIF
Cisco Syslog Adapter) replaces the log file processing features of the standard Syslog Adapter. The
Smarts NOTIF Cisco Syslog Adapter processes the log file information into useful notifications with or
without the use of ASL scripts.


Note   The VMware Smart Assurance Notification Module Cisco Syslog Processing Adapter
Installation and User Guide provides additional information on this adapter.


n SNMP Trap Adapter


The SNMP Trap Adapter product reads SNMP traps and forwards traps to any
VMware Smart Assurance application. It requires the SAM Adapter Platform.
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n XML Adapter


The XML Adapter product imports and exports topology from any VMware Smart Assurance
application.


The VMware Smart Assurance IP Manager includes the following products:


n IP Availability Manager


n IP Performance Manager


n IP Server Performance Manager


n IP Availability Manager Extension for NAS


The VMware Smart Assurance MPLS Management Suite includes the following products:


n VMware Smart Assurance MPLS Manager is composed of three servers:


n MPLS Topology Server


n MPLS Monitoring Server


n MPLS Analysis Server


n MPLS VPN-Tagging Server


The VMware Smart Assurance Network Protocol Management Suite includes the following products:


n VMware Smart Assurance Network Protocol Manager for BGP


n VMware Smart Assurance Network Protocol Manager for EIGRP


n VMware Smart Assurance Network Protocol Manager for IS-IS


n VMware Smart Assurance Network Protocol Manager for OSPF


The VMware Smart Assurance Server Manager includes the Server Manager software.


Installation directory structure
The installation directory structure is shown in Installation directory structure. All
VMware Smart Assurance products use the same basic installation directory structure.


In Installation directory structure, notice that:


n BASEDIR, which is not an environment variable, is used in documentation to represent the top-level
directory structure of an VMware Smart Assurance product software installation.


For UNIX, this location is /opt/InCharge/<product>.


BASEDIR represents:


n For MPLS Management Suite —<installation_root_directory>/MPLS


n For IP Manager — <installation_root_directory>/IP


n For Service Assurance Manager — <installation_root_directory>/SAM


n For Server Manager — <installation_root_directory>/ESM
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n For Network Protocol Management Suite — <installation_root_directory>/NPM


By default, VMware Smart Assurance software is installed to BASEDIR/smarts.


Optionally, you can specify the root of BASEDIR to be something different, but you cannot
change the <product> location under the root directory.


n The VMware Smart Assurance sm_edit utility ensures that modified files are always saved to the
appropriate local area and that base (original) copies of the files remain unchanged. Chapter 10 The
sm_edit utility provides additional information.


The VMware Smart Assurance System Administration Guide provides detailed information about the
directory structure for VMware Smart Assurance software and the sm_edit utility.


Figure 1‑1.  


Product and version compatibility
The VMware Smart Assurance Support Matrix provides information about the products and the
compatible versions of the VMware Smart Assurance products.
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Installation tasks overview
To install VMware Smart Assurance Service Assurance Manager, IP Manager, MPLS Management Suite,
Server Manager, or the Network Protocol Management Suite, you need to meet the requirements or
perform the tasks that are listed in Installation requirements and tasks.


Note   To install additional components to an existing installation, you can perform an installation or an
upgrade.


Before you install


The Broker license host should be installed, configured, and
operating.


VMware Smart Assurance System Administration Guide


The Global Console, Global Manager, and Service Assurance
products should be installed, configured, and licensed.


VMware Smart Assurance Installation Guide


IP Manager should be installed, configured, and licensed. After
IP Manager is installed, you can install or upgrade other
Smarts products.


VMware Smart Assurance Installation Guide for SAM, IP, ESM,
MPLS, and NPM.


Review the important release issues for the product being
installed.


VMware Smart Assurance Release Note


Determine if the products are supported on your platform. VMware Smart Assurance Support Matrix


Review the patch requirements for your operating system. VMware Smart Assurance Support Matrix


Determine if your system meets the hardware requirements. VMware Smart Assurance Support Matrix


Installation method


Install the product. Select one of the following installation methods:
n Install using CLI mode
n Install using Unattended mode


After you install


If your product is part of a deployment that requires the Federal
Information Processing Standard (FIPS) Publication 140-2, a
U.S. government computer security standard governing
cryptographic modules, perform the procedure to enable
products in FIPS mode.


Support for FIPS 140-2 for Smart Assurance products


If you installed the products as services, start them for the first
time.


n Starting services on UNIX
n Start programs


Verify the current state of the products and the Broker. Verify the product status


Optional task:


After modifying your configuration files on one installation, you
can use the deployment utility to create a deployment package
of your configuration changes and deploy the package on other
installations.


Deployment utility overview
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Upgrade tasks overview
To upgrade, you need to meet the requirements or perform the tasks that are listed in Upgrade installation
requirements and tasks.


Before you upgrade


Review the release notes for important issues. VMware Smart Assurance Release Note


Determine if the products are supported for your platform. VMware Smart Assurance Support Matrix


Determine if your system meets the hardware requirements. VMware Smart Assurance Support Matrix


Upgrade installation


Upgrade the products in the following order:


1 Top-most SAM server


2 An Aggregation SAM server if it is a hierarchical SAM
deployment.


3 IP Manager.


4 Any order: Server Manager, MPLS Manager, and Network
Protocol Manager.


n For VMware Smart Assurance products: Chapter 5
Performing an Upgrade


After you install


Evaluate your custom code and review the tools for restoring
user customization.


Custom file migration use cases


If your product is part of a deployment that requires the Federal
Information Processing Standard (FIPS) Publication 140-2, a
U.S. government computer security standard governing
cryptographic modules, perform the procedure to upgrade
products in FIPS mode.


Upgrading Smart Assurance products in FIPS mode


If you installed the products as services, start them for the first
time.


n Starting services on UNIX
n Start programs


Verify the current state of the products and the Broker. Verify the product status


(Optional) After performing an upgrade and modifying your
configuration files on one installation, you can use the
deployment utility to create a deployment package of your
configuration changes and deploy the package on other
installations. After deploying the package on other installations,
you do not have to run the migrate utility to merge your
customizations.


“Deployment utility overview” on page 97


Migration tasks overview
To migrate to Version 10.0.0, you need to meet the requirements or perform the tasks that are listed in 
Migration requirements and tasks.


Before you migrate


Review the release notes for important issues. VMware Smart Assurance Release Note
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Determine if the products are supported for your platform. VMware Smart Assurance Support Matrix


Determine if your system meets the hardware requirements. VMware Smart Assurance Support Matrix


Installation and migration


Perform the migration in the following order:


1 Top-most SAM server


2 An Aggregation SAM server if it is a hierarchical SAM
deployment.


3 IP Manager.


4 Any order: Server Manager, MPLS Manager, and Network
Protocol Manager.


n For VMware Smart Assurance products: Chapter 6
Performing a Migration.


After you install


Evaluate your custom code and review the tools for restoring
user customization.


Custom file migration use cases


If you installed the products as services, start them for the first
time.


n Starting services on UNIX
n Start programs


Verify the current state of the products and the Broker. Verify the product status


(Optional) After performing a migration and modifying your
configuration files on one installation, you can use the
deployment utility to create a deployment package of your
configuration changes and deploy the package on other
installations. After deploying the package on other installations,
you do not have to run the migrate utility to merge your
customizations.


“Deployment utility overview” on page 97


Uninstallation tasks overview
To uninstall the product, you need to meet the requirements or perform the tasks that are listed in 
Uninstallation requirements and tasks.


Table 1‑4.  Uninstallation requirements and tasks


Before you uninstall


Review uninstall prerequisites. Chapter 9 Performing an Uninstallation


Uninstallation


Uninstall the product. n “Uninstall using Wizard mode” on page 125
n UNIX only, Uninstall using CLI mode
n Uninstall using Unattended mode
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Performing an Installation 2
This chapter includes the following topics:


n Installation overview


n Installation prerequisites


n Install the product


n Support for FIPS 140-2 for Smart Assurance products


n Next steps


Installation overview
The installation flow is shown in New installation flowchart. A new installation installs a new version of a
product on a host system that either has no software installed or has a previous version of the software
installed. Chapter 5 Performing an Upgrade provides instructions to install an upgrade installation.


Figure 2‑1.  New installation flowchart
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Installation prerequisites
Fulfill the following prerequisites before starting the installation:


n Ensure that you have superuser (User ID 0) or administrative privileges on the target host. The
installation program will halt if you do not have the appropriate privileges.


n Ensure that the required operating system patches have been installed. Clicking More Information
during the installation process will launch the System Information window and the Pass/Fail status of
the operating system patches. The VMware Smart Assurance Support Matrix provides information on
operating system patches.


n Determine the location of the VMware Smart Assurance Broker.


You must specify the location of the Broker during a new installation of VMware Smart Assurance
software. Typically, this location is chosen during the design of the VMware Smart Assurance
software deployment and before any installation begins. Consult with your deployment planner or
check the build guide that documents your deployment to determine the name of the host where the
Broker was installed and the port that the Broker uses.


If the location is the same host where you are installing this product, the installation program will
automatically install the Broker if it is not already on the host.


n (Service Assurance Manager only) Decide whether your operators will use the
Service Assurance Manager Notification Console (classic SAM functionality).


Install the product
You acquire the software for the VMware Smart Assurance Service Assurance Manager,
VMware Smart Assurance IP Manager, VMware Smart Assurance MPLS Management Suite,
VMware Smart Assurance Server Manager, and
VMware Smart Assurance Network Protocol Management Suite in one of two ways:


n From the installation CD/DVD-ROM.


Insert the CD/DVD-ROM into the optical drive of the host system. Chapter 12 Procedures for
CD/DVD-ROMs describes how to access the optical drive for various operating systems.


When you insert the installation CD/DVD, several minutes might pass between the InstallShield
preparation screen and the VMware Smart Assurance splash screen/installation dialog boxes. Be
patient. Do not eject/reinsert the CD/DVD to start a second install process.


n From the VMware online support website.


Go to the VMware online support website and download the installation file that is specific to your
platform.


You install each product in one of three ways: Wizard mode, CLI mode, or Unattended mode.
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Install using CLI mode
CLI mode provides a text-based method for invoking the installation program. This mode is intended for
UNIX platforms with non-graphics consoles. The CLI mode follows the same process flow as the Wizard
mode but uses text rather than graphics.


Running CLI mode
Table 2‑1.  Setup command syntax for CLI mode


Product Operating system Executable


Service Assurance Manager
Server


Linux ./setup-SAM-10_0_0_0-linux64.bin


Service Assurance Manager
Console


Linux ./setup-CONSOLE-10_0_0_0-linux.bin


IP Manager Linux ./setup-IP-10_0_0_0-linux64.bin


MPLS Management Suite Linux ./setup-MPLS-10_0_0_0-linux64.bin


Server Manager Linux ./setup-ESM-10_0_0_0-linux64.bin


Network Protocol
Management Suite


Linux ./setup-NPM-10_0_0_0-linux64.bin


User selections and navigation in CLI mode
During the installation and uninstallation processes, you are prompted with a series of steps and menus:


n For prompts, accept the default value or select another choice. The default values are indicated in
brackets. To accept the default value, press Enter. To reply “yes,” enter y or Y; to reply “no,” enter n
or N. Do not press Delete because doing so will cause the process to terminate with an error
message.


n For selections in menus, accept the default selections or type the number of the item and press
Enter.


If you incorrectly type an entry, press back to repeat the prompt and select the correct value. Arrow
keys and the Backspace key are not supported.


If your product is part of a deployment that requires the Federal Information Processing Standard (FIPS)
Publication 140-2, a U.S. government computer security standard governing cryptographic modules,
follow the instructions in Support for FIPS 140-2 for Smart Assurance products.


Next steps provides post-installation tasks.


Install using Unattended mode
Unattended mode reads the selections and settings for the installation from a user-modifiable response
file, which enables you to easily duplicate the installation on many computer systems. Manual intervention
is not necessary after you execute the setup command.
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The response file, named <product>-response.txt, is located on the CD/DVD-ROM in the /utils directory.
The file provides instructions and examples of command line options that are passed to the installation
program in Unattended mode. The command line options are organized by process flow, which is almost
identical to that of Wizard mode or CLI mode.


Note   For instructions on installing the Service Assurance Manager Server in Unattended mode,
complete the steps in the following section. To install other Service Assurance Manager products after
Server install, refer to “Installing the Service Assurance Manager Console, or the Smarts NOTIF Editor, or
both” on page 32.


Modifying the response file
To modify the response file:


1 Copy the response file from the CD/DVD’s /utils directory to a directory on your host, for example, to
the /tmp directory.


2 Using a text editor, modify the values for the command line options in the response file:


3 Specify the target directory.


4 Select a directory for the process log file.


5 Select the products to install. Ensure that the property value for the product is set to true.


6 Select the products to start as services. Ensure that the property value for the product is set to true.


7 Specify the location of the Broker. By default, the location is set to localhost at port 426.


8 Save the file.


Running Unattended mode
To start the Unattended mode, invoke the setup command with the -options command-line option,
followed by the full path to the response file as described in Setup command syntax for Unattended
mode.


Table 2‑2.  Setup command syntax for Unattended mode


Product Operating system Executable


Service Assurance
Manager Server


Linux ./setup-SAM-10_0_0_0-linux64.bin -i silent -f <path>/<product>-response.txt


Service Assurance
Manager Console


Linux ./setup-CONSOLE-10_0_0_0-linux64.bin -i silent -f <path>/<product>-
response.txt


IP Manager Linux ./setup-IP-10_0_0_0-linux64.bin -i silent -f <path>/<product>-response.txt


MPLS Management
Suite


Linux ./setup-MPLS-10_0_0_0-linux64.bin -i silent -f <path>/<product>-response.txt


Server Manager Linux ./setup-ESM-10_0_0_0-linux64.bin -i silent -f <path>/<product>-response.txt


VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


VMware, Inc.  16







Table 2‑2.  Setup command syntax for Unattended mode (Continued)


Product Operating system Executable


Network Protocol
Management Suite


Linux ./setup-NPM-10_0_0_0-linux64.bin -i silent -f <path>/<product>-response.txt


where <path> is the fully qualified path to the response file and <product> is the product name, for example,
IP_NETWORK_SUITE, MPLS_SUITE, or SAM_SUITE.


For example for MPLS Management Suite, to start the Unattended mode of installation on Linux when the
response file is located in /opt/home, enter:


         ./


         setup-MPLS-10_0_0_0-linux64.bin 


          -i silent -f <path>/<product>-response.txt


      


If your product is part of a deployment that requires the Federal Information Processing Standard (FIPS)
Publication 140-2, a U.S. government computer security standard governing cryptographic modules,
follow the instructions in Support for FIPS 140-2 for Smart Assurance products.


Next steps provides post-installation tasks.


Note   SAM and SAM-Console Custom feature is removed. Now, all the features are available as a
complete installation in both fresh installation and upgrade from older products.


Support for FIPS 140-2 for Smart Assurance products
The Federal Information Processing Standard (FIPS) Publication 140-2 is a U.S. government computer
security standard governing cryptographic modules. FIPS 140 is required for any software purchased by
the U.S government and U.S military. This release specifically addresses U.S Government accounts
which require FIPS 140 compliance.


A configuration parameter, SM_FIPS140, has been introduced for FIPS 140 in the runcmd_env.sh file.
The SAM or VMware Smart Assurance administrator can enable or disable this parameter as required.
The default value of this parameter is FALSE.


FIPS 140 mode allows you to use SNMP V1, SNMPV2C, SNMP V3, with SHA and AES 128 protocols.
FIPS 140 does not support the DES privacy protocol or the MD5 authentication protocol. When you
discover an SNMPv3 device, you need to select the option “V3” in the “Add Agent” window. The
“Authentication Protocol” option lists only SHA and not MD5, and the “Privacy Protocol” option lists only
AES and not DES. This is because MD5 and DES are not supported in FIPS 140 mode. When you
discover SNMPv3 devices with MD5 and DES protocol as seed, the devices go to the Pending List and
display as “Invalid” or “Unsupported SNMP V3 protocol.”


Note   FIPS 140 mode cannot be enabled or disabled after a server is started. FIPS 140-enabled
Domain Managers such as MPLS Management Suite, IP Manager, Service Assurance Manager, and
Server Manager can work only with the SAM Global Console 9.x or later for FIPS 140-2 mode.
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A non-FIPS 140 mode Broker will not be able to communicate with a FIPS 140-enabled Manager (IP
server, SAM server, or Domain Manager). Trying to establish such a connection will result in the enabled
Manager going into a DEAD state after couple of minutes. Communication should always happen
between FIPS 140-enabled Brokers and Managers.


Inter-domain and FIPS 140 Broker communication happens only when the Broker, Managers, and the
SAM Console are all in FIPS 140 mode, else the application will not be operational.


This section covers the following scenarios for FIPS 140:


n Enabling FIPS 140 mode on a new installation


n Disabling FIPS 140 mode


n Verify the FIPS 140 mode status


Enabling FIPS 140 mode on a new installation
When you install a 10.0.0 product, FIPS 140 is not enabled by default. You must enable FIPS 140 on a
clean installation or an upgrade, before the servers are started, using the following procedure:


1 Back up the imk.dat, brokerConnect.conf, serverConnect.conf and clientConnect.conf files from the
existing installation. These files are located in the BASEDIR/local/conf folder.


Note   The backup is necessary in case you need to disable FIPS 140 mode and remove FIPS 140-2
encryption.


2 Run the following command at the command line prompt:


               sm_rebond --upgrade --basedir=<


               BASEDIR


               >/smarts


               


               sm_rebond --upgrade --basedir=C:\InCharge\SAM\smarts


            


3 When prompted, type a password to regenerate the imk.dat file. The default password is Not a secret.


4 Set the value for the parameter SM_FIPS140 to TRUE in the runcmd_env.sh file. The file is located
under the BASEDIR/smarts/local/conf directory.


Enabling FIPS 140 mode on SAM Web Console
1 Perform steps 1 - 3 as described in the section, Enabling FIPS 140 mode on a new installation.


2 Go to the <BASEDIR>/smarts/jre/lib/security folder, and in the java.security file, change:


“sun.security.rsa.SunRsaSign” to “com.rsa.jsafe.provider.JsafeJCE” and
“com.sun.net.ssl.internal.ssl.Provider” to “com.rsa.jsse.JsseProvider.”


3 Set the value for the parameter SM_FIPS140 to TRUE in the runcmd_env.sh file. This file is located
under the <BASEDIR>/CONSOLE/smarts/local/conf folder of your Global Console installation.
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4 or


5 Use "-Dcom.smarts.fips_mode=true" as a command line parameter for the sm_gui command.


Enabling FIPS 140 mode on SAM Dashboard
1 Perform steps 1 - 3 as described in the section, Enabling FIPS 140 mode on a new installation.


2 Set the value for the com.smarts.fips_mode to TRUE in the corresponding webconsole.properties file
(located under <BASEDIR>/InCharge/CONSOLE/smarts/tomcat/webapps/webconsole folder)


3 or


4 dashboard.properties file (located under
<BASEDIR>/InCharge/CONSOLE/smarts/tomcat/webapps/templates).


5 Set the value for the parameter SM_FIPS140 to TRUE in the runcmd_env.sh file. This file is located
under the <BASEDIR>/CONSOLE/smarts/local/conf folder of your Global Console installation.


6 or


7 Use "-Dcom.smarts.fips_mode=true" as a command line parameter for the sm_gui command.


Enabling FIPS 140 mode on SAM NOTIF
1 Perform steps 1 - 3 as described in the section, Enabling FIPS 140 mode on a new installation.


2 Go to the <BASEDIR>/CONSOLE/smarts/notif/editor/ or the <BASEDIR>/SAM/smarts/notif/editor
folder, and edit the NotifGui.bat/NotifGui.sh file to replace the string,
“com.netmg.notif.gui.NotifApplication” with “-Dcom.smarts.fips_mode=true
com.netmg.notif.gui.NotifApplication.”


3 Set the value for the parameter SM_FIPS140 to TRUE in the runcmd_env.sh file. This file is located
under the <BASEDIR>/CONSOLE/smarts/local/conf folder of your Global Console installation.


4 or


5 Use "-Dcom.smarts.fips_mode=true" as a command line parameter for the sm_gui command.


Note   If you install the servers as a service on Linux platforms, the services will start automatically
after you issue the sm_rebond command. First stop the services, modify SM_FIPS140=TRUE in the
runcmd_env.sh file, and then manually start the services.


After enabling FIPS 140 mode, when you start the broker and the SAM server, you may see the
following message in the server log:


“CI-W-NOCGSS-No certificate loaded for INCHARGE-AM, generating self-signed certificate.”


This message is generated because FIPS 140 requires secure communication, which can be
achieved using SSL. If this certificate is not available, the SAM Manager generates a self-signed
certificate. This message is benign in nature and does not impact functionality.
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Disabling FIPS 140 mode
To disable FIPS 140:


1 Replace the imk.dat, brokerConnect.conf, serverConnect.conf and clientConnect.conf files in the
BASEDIR/local/conf folder, with the copies saved from prior to “Enabling FIPS 140 mode on a new
installation”. If you do not have a copy of these files saved, contact Technical Support.


2 Set the value for the SM_FIPS140 parameter to FALSE in the runcmd_env.sh file. This file is located
under BASEDIR/smarts/local/conf/runcmd_env.sh.


3 Restart all processes, such as the Broker, Domain Managers, SAM Global Manager, and
Global Console.


Note   RPS files started under FIPS mode cannot be re-used in non-FIPS mode. Domains will need
to be started either from scratch or pre-FIPS RPS files can be used in cases where topologies have
not changed. Restoring from older RPS files may not be productive as it will not contain any recent
topology.


Next steps
Perform the following tasks:


n Chapter 6 Performing a Migration describes additional tasks if you are migrating from a previous
version of the product.


n Chapter 8 Verifying the Installation describes tasks for verifying the proper installation of the software
and starting services.
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Performing an Installation in
Docker Container 3
This chapter includes the following topics:


n Installation overview


n Installation prerequisites


n Creating and starting Docker image


n Operations on Docker container


n Performing Smarts upgrade inside Docker


Installation overview
Docker is a tool for packaging and shipping applications. Based on the idea of a shipping container, it
provides a standardized way for administrators to create lightweight images, or collections of images, for
each element of an application, and then easily and quickly deploy the image.


Since the image is standardized, it can be uniformly deployed in development or production environment.


Note   You can install the Smarts applications in docker container only on the Linux platform. The Docker
script is written with the CentOS as the base operating system. VMware supports separate (explicit)
Docker containers for each product, so individual Docker scripts are written such that, on execution only
the respective product gets installed.


Installation prerequisites
Fulfill the following prerequisites before starting the docker installation:


n Ensure that you have docker installed on your system.


n The response file, named <product>-response.txt and docker script file, are located in the ISO file in
the /utils directory.


n The binary files are located in the ISO file in the /suite directory.


n Docker script includes few basic OS utilities that are required to execute the Smarts product
functionality. Utilities like Telnet and SSH are required for CLI discovery process. Any additional
utilities which is required for specific requirement, can be installed using “yum” inside container.
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n Ensure that you placed the following mentioned files in any folder on your system:


Table 3‑1.  Files needed to install Smarts application in docker container.


Setup File Response File Docker File


setup-IP-10_0_0_0-linux64.bin IP_NETWORK_SUITE-response.txt IP_NETWORK_SUITE-Dockerfile.txt


setup-SAM-10_0_0_0-linux64.bin SAM_SUITE-response.txt SAM_SUITE-Dockerfile.txt


setup-CONSOLE-10_0_0_0-linux.bin SAM_CONSOLE_SUITE-response.txt SAM_CONSOLE_SUITE-Dockerfile.txt


setup-ESM-10_0_0_0-linux64.bin ESM_SUITE-response.txt ESM_SUITE-Dockerfile.txt


setup-MPLS-10_0_0_0-linux64.bin MPLS_SUITE-response.txt MPLS_SUITE-Dockerfile.txt


setup-NPM-10_0_0_0-linux64.bin NPM_SUITE-response.txt NPM_SUITE-Dockerfile.txt


Note   The docker file creates the docker image with the help of above files mentioned in the table. In
order to disable EDAA mode and change to the broker host, edit <product>-response.txt. Install using
Unattended mode provides more information on installing the product using Unattended mode.


Creating and starting Docker image
You can create and start docker image for the VMware Smart Assurance Service Assurance Manager,
VMware Smart Assurance IP Manager, VMware Smart Assurance MPLS Management Suite,
VMware Smart Assurance Server Manager, and
VMware Smart Assurance Network Protocol Management Suite by using the following steps:


1 Run the following command, to build the docker image:


docker build -t <image-name> -f <docker file name> ./


2 Run the following command, to start the docker container in the host mode:


docker run -it --net=host --name <container name>  <docker-image-name>


3 Start the "ic-serviced" so that services can be created:


/etc/init.d/ic-serviced start


4 Start your servers with your environment specific options.


Operations on Docker container
You can perform various operations on docker container like add, remove, stop, and list the docker
container or docker image in the system. The docker commands used in this chapter are docker specific
and do not have any dependencies on Smarts product.


Note   In docker there is nothing called uninstallation, you just need to remove the container and the
image file from the system.
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To remove the docker containers and the image files, you need to perform the following series of task:


1 Search for the list of container present on your system, run the following command to list the
containers:


#docker ps -a


2 Run one of the following command, to attach the existing container (if any):


#docker attach <container ID>


or,


#docker attach <container name>


3 To stop the docker, run the following command:


n Invoke the following command, to stop all the containers running on your machine:


#docker stop $(docker ps -a -q)


#docker stop <container ID>


or,


#docker stop <container name>


4 To remove the container, run the following command:


n Invoke the following command, to remove all the containers on your machine:


#docker rm $(docker ps -a -q)


#docker rm <container ID>


or,


#docker rm<container name>


5 Search for the list of docker images present on your system, run the following command to list the
docker image:


#docker images --all


6 Invoke one of the following command, to remove the image:


#docker rmi <ImageID>


or,


#docker rmi <Image Name>


7 Invoke one of the following command in the Docker container to exit or stop the container:


#exit


Ctrl + C


Ctrl + \
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Performing Smarts upgrade inside Docker
You can upgrade the VMware Smart Assurance Service Assurance Manager,
VMware Smart Assurance IP Manager, VMware Smart Assurance MPLS Management Suite,
VMware Smart Assurance Server Manager, and
VMware Smart Assurance Network Protocol Management Suite in docker, by using the following steps:


1 Invoke the following command, to copy the build inside the docker container:


docker cp <build file> <container name>:<Path inside docker container>


2 Run the following command, to login to the docker container:


docker exec -it <container name> bash


3 To perform upgrade on the Linux platform, refer to Chapter 5 Performing an Upgrade.


Note   The regular upgrade procedure needs to be followed once the files are copied inside the
docker. An upgrade installation needs to triggered inside the docker.
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NAS Installation and Startup 4
This chapter includes the following topics:


n Overview


n Installing and starting the HTTPS Adapter service


Overview
The NAS Extension is installed with the IP Availability Manager. After installation, the
IP Availability Manager can discover NAS devices, and perform root cause and impact analysis on these
devices.


Configuring the NAS Extension involves the tasks summarized in Steps for configuring the NAS
Extension.


Table 4‑1.  Steps for configuring the NAS Extension


Reference


If necessary, configure the HTTPS Adapter to support
access to the managed Celerra devices.


For information about this requirement, refer to the “Configuring
Control Station usernames and passwords” chapter in the
VMware Smart Assurance IP Manager User Guide.


If necessary, configure external Control Station and Data
Mover IP addresses.


For information about this requirement, refer to the “Configuring
Control Station and Data Mover IP addresses” chapter in the
VMware Smart Assurance IP Manager User Guide , which also
refers you to the appropriate VMware documentation, if needed.


Install the HTTPS Adapter as a service and start the
service.


“Installing and starting the HTTPS Adapter service” on page 46.


Start the IP Availability Manager. VMware Smart Assurance Installation Guide for SAM, IP, ESM,
MPLS, and NPM Managers


Start the Global Manager. VMware Smart Assurance Installation Guide for SAM, IP, ESM,
MPLS, and NPM Managers.


For configuration information, refer to the
VMware Smart Assurance Service Assurance Manager
Configuration Guide.


Start the Global Console. VMware Smart Assurance Installation Guide for SAM, IP, ESM,
MPLS, and NPM Managers.
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Installing and starting the HTTPS Adapter service
The NAS Extension software includes an adapter process (the HTTPS Adapter), which probes the
Celerra devices using the HTTPS/XML probe to obtain internal topology information. While the installation
of this adapter is automatic, you must install the service and start it manually. Install the HTTPS Adapter
as a service and start the service manually, as described next for UNIX.


Once started, the HTTPS Adapter registers with the Broker. The
VMware Smart Assurance System Administration Guide provides more information about starting
services.


UNIX:
To install the HTTPS Adapter as a service on UNIX, issue the following command:


# sm_service install --force --unmanaged --startmode=manual \


'--name=<service_name>' \


'--description=<Smarts description>' \


'BASEDIR/smarts/bin/sm_adapter_java' 


'--name=<HTTPS_Adapter_Name>' \


'--output=<HTTPS_Adapter_Name>.log' \


'-J' \


'nas_probe.jar'


You can also specify the Broker and Port, if the IP Availability Manager with NAS Extension is registered
with a Broker and Port other than the default, localhost:426. To do this, add the following arguments to
the end of the command:


--broker=<IP Address or Hostname>:<Port Number>


      


To start the service, type the following command:


# BASEDIR/smarts/bin/sm_service start 


         <service_name> 


      


To stop the service, issue the following command:


# BASEDIR/smarts/bin/sm_service stop 


         <service_name> 


      


Running HTTPs adapter in FIPS mode
The NAS subsystem was changed to provide FIPS 140 support. Hence you need to download additional
JAR (Java Archive) files, else errors are seen in the NAS log when you run NAS discovery.
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Example


NAS Log Error Snippet:


MAIN_MSG-*-STDFD_OUT-stdout: javax.net.ssl.SSLException: java.security.InvalidKeyException: Illegal 


key size


[June 17, 2011 6:37:49 PM GMT+05:30 +227ms] t@1084229984 platform


MAIN_MSG-*-STDFD_OUT-stdout:


at com.rsa.sslj.x.aJ.b(Unknown Source)


at com.rsa.sslj.x.aJ.a(Unknown Source)


at com.rsa.sslj.x.aJ.b(Unknown Source)


at com.rsa.sslj.x.aU.d(Unknown Source)


at com.rsa.sslj.x.aU.a(Unknown Source)


at com.rsa.sslj.x.aU.h(Unknown Source)


at com.rsa.sslj.x.cI.startHandshake(Unknown Source)


at com.smarts.nas_probe.ControlStationInterface.getSSLSocket(ControlStationInterface.java:314)


at com.smarts.nas_probe.ControlStationInterface.post(ControlStationInterface.java:75)


at com.smarts.nas_probe.ControlStationInterface.getReply(ControlStationInterface.java:58)


at com.smarts.nas_probe.XMP.NasXML(XMP.java:25)


Caused by: com.rsa.sslj.x.ax: java.security.InvalidKeyException: Illegal key size


at com.rsa.sslj.x.aJ.b(Unknown Source)


at com.rsa.sslj.x.cR.k(Unknown Source)


at com.rsa.sslj.x.t.f(Unknown Source)


at com.rsa.sslj.x.t$a.run(Unknown Source)


at com.rsa.sslj.x.aJ$a$a.run(Unknown Source)


at java.security.AccessController.doPrivileged(Native Method)


at com.rsa.sslj.x.aJ$a.run(Unknown Source)


... 7 more


[June 17, 2011 6:37:49 PM GMT+05:30 +229ms] t@1084229984 platform


MAIN_MSG-*-STDFD_OUT-stdout: e


Caused by: java.security.InvalidKeyException: Illegal key size


at javax.crypto.Cipher.a(DashoA13*..)


at javax.crypto.Cipher.init(DashoA13*..)


at javax.crypto.Cipher.init(DashoA13*..)


at com.rsa.sslj.x.Y.<init>(Unknown Source)


......


With BSAFE SSL-J, some of the FIPS 140 cryptographic algorithms require Unlimited Strength
Jurisdiction Policy Files.


Unlimited Strength Jurisdiction Policy JAR Files for NAS discovery
Download and install the Unlimited Strength Jurisdiction Policy Files to run the NAS adapter in FIPS
mode using the following steps:


1 Download the Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction Policy Files 8 from
the Oracle website.


2 Extract the local_policy.jar and US_export_policy.jar files from the downloaded zip file.


3 Go to the smarts/jre/lib/security directory and then back up the existing policy files in this path.
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4 Overwrite the local_policy.jar and US_export_policy.jar files to the smarts/jre/lib/security directory.


Note   If you want to switch back from FIPS mode to non-FIPS mode, reset SM_FIPS140 to FALSE.
You do not need to remove the Unlimited Strength Jurisdiction Policy Files.
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Performing an Upgrade 5
This chapter includes the following topics:
n Upgrade installation overview


n Upgrade installation prerequisites


n Upgrade the product


n Upgrading Smart Assurance products in FIPS mode


n Next steps


Upgrade installation overview
This chapter describes how to perform an upgrade installation for the IP Manager,
Service Assurance Manager, MPLS Management Suite, Server Manager, and Network Protocol
Manager. An upgrade installation applies a new version of software to an existing version in the same
directory on the same host. An “upgrade installation” is also known as an “in-place upgrade.” During an
upgrade installation, new product services are not available to install, unless you select additional
products during the upgrade procedure.


You can upgrade the versions of software listed in the
VMware Smart Assurance SAM, IP, ESM, MPLS, and NPM Managers Support Matrix to Version 10.0
using the in-place upgrade instructions provided in this chapter.


The upgrade installation flow is shown in Upgrade installation flowchart.


1 Start with the top-most SAM server.


2 An Aggregation SAM server if it is a hierarchical SAM deployment.


3 IP Manager.
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4 Any order: Server Manager, MPLS Manager and Network Protocol Manager.


Figure 5‑1.  Upgrade installation flowchart


Installer tasks
During an upgrade installation, the installation program performs the following tasks:


1 All the smarts services needs to be stopped before upgrade or new installation. Use sm_service
command to stop the services manually.


./sm_service stop <SERVICE NAME>


2 Creates a backup copy of your customizations in the <BASEDIR>/smarts/.migrate.bkp.<version>
directory.


3 Removes the patch, if any, from the existing installation.


4 Installs the software.


5 Prompts you to merge your customizations files in the BASEDIR>/smarts/.migrate.bkp.<version>
directory to the BASEDIR/smarts/local directory.


Note   If the broker is running on the host with a IP Manager, then it will have to be stopped during an
upgrade. The broker has to be stopped to prevent the impact on all the other applications running on the
system.
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Installer-called utilities
The installation program invokes the sm_migrate utility to backup the existing user-customized files and
base files. It also presents the sm_migrate command to be run after the 10.0.0 installation to complete a
three-way merge of the following sets of files:


n Existing user-customized files in the <BASEDIR>/smarts/.migrate.bkp.<version> directory.


n Existing base files in the <BASEDIR>/smarts/.migrate.bkp.<version> directory.


n 10.0.0 base files in the BASEDIR/smarts directory


The sm_migrate utility invokes another utility, the sm_merge utility, for each of the files that requires a
three-way merge. Chapter 7 Migration Utilities explains how the sm_migrate and sm_merge utilities
work.


Upgrade installation prerequisites
Fulfill the following prerequisites before starting the upgrade installation:


n Ensure that you have superuser (User ID 0) or administrative privileges on the target host. The
installation program will halt if you do not have the appropriate privileges.


n Ensure that the required operating system patches have been installed. Clicking More Information
during the installation process will launch the System Information window and the Pass/Fail status of
the operating system patches. The VMware Smart Assurance Support Matrix provides information on
operating system patches.


n Remove all the unused files in the /local directory. The unused files will also include RPS files and
custom files created by you. The upgrade process uses the sm_migrate utility that creates a backup
of all the files in the local directory and copies them back to local directory after the upgrade. RPS
and custom files can be large, and may slow down the process.


n Disk space requirement—During an upgrade installation, the installer creates a backup of files in
actions, conf, model, repos, rules, script directories. Ensure that you have disk space of twice the size
of these directories available on the system. After the upgrade and verifying the installation, you can
archive or remove the backup directories. This requirement is in addition to the minimum disc
requirement outlined for each product in the VMware Smart Assurance Support Matrix.


Upgrade the product
You upgrade each product in one of three ways: CLI mode or Unattended mode.


Perform the following tasks:


1 Review the important release issues found in your product-specific release notes.


2 On the host where the target existing installation resides, log in as superuser (User ID 0) or
administrator.


3 Mount the CD/DVD-ROM. Chapter 12 Procedures for CD/DVD-ROMs provides more information.
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4 Choose CLI mode (UNIX only), or Unattended mode. The setup commands for invoking CLI mode
and Unattended mode are listed in Upgrade the product, Upgrade the product, and Upgrade the
product.


n In CLI mode, make the following additional selections:


n In the Upgrade or Install screen, select Upgrade existing suite and click Next or enter [1].


n In the Target Installation Selection screen (in which an existing product is selected
unless the product was previously installed to more than one directory, in which case you
will see multiple choices), select a target installation directory and click Next or enter [1].


n In the Choose Products screen, all of the existing products are selected to be upgraded.
You can select additional products to add to the installation.


n Specify any additional local directories created using SM_SITEMOD. Click Next or enter
[1].


n In Unattended mode, specify the following additional options in the response file (<product>-
response.txt). All previously installed products must have their product options set to “true” in
the response file.


n Uncomment the -INSTALL_TYPE.INSTALL_CHOICE option.


n Uncomment the -SITEMOD_BEAN.SITEMODS_VAR option, and provide one or more
directory locations to perform an upgrade. You can provide the name of the directories, or
the directory name with absolute path.


For example, on Linux:


SITEMOD_BEAN.SITEMODS_VAR=local-1:/opt/InCharge/SAM/smarts/Local-2


:local-3


Note   For specifying directory separators, use : on Linux.


n Uncomment the MERGE_OPTION_UPGRADE.MERGE_CHOICE=MERGE option to
perform the merge.


n Uncomment the < product >.installLocation option and set its property value to the
installation directory of the target installation.


5 The installation program displays the Directories created using SM_SITEMOD screen which allows
you to back up local directories that were created with SM_SITEMOD. If you used SM_SITEMOD to
create local directories, enter a list of local directories. Click Next or enter [1].


The installation program then runs the sm_migrate utility to create a backup file of the user-
customized files and base files in the existing installation. The backup file,
named .migrate.bkp.<version>, is saved to the BASEDIR/smarts directory.


6 The installation program removes the patch, if any, from the existing installation and installs the
software.
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7 After the installation, the installation program shows the Restore User Configurations Instructions
screen, which presents the sm_migrate command for restoring the old user-customizations in
the .migrate.bkp.<version> backup file to the BASEDIR/smarts/local directory. The screen provides
two options:


a Yes, merge the files - Select this option if you want the utility to automatically merge the files
modified by you.


b No, I will merge them later - Select this option if you want to manually merge the files modified
by you.


Click Next or enter [1] to view the Installation Summary.


Note   For Service Assurance Manager, the upgrade process inserts the _edaa user entry into
the security configuration file serverConnect.conf and the runcmd_env.sh file. The upgrade
process does not modify the clientConnect.conf, brokerConnect.conf, and imk.dat files. The
upgrade process does not insert the _edaa user entry into the files of Domain Managers.


For Domain Managers, copying the security configuration files clientConnect.conf,
serverConnect.conf, brokerConnect.conf, runcmd_env.sh, and imk.dat is not supported in an
upgrade installation. You can manually copy the security configuration files using sm_migrate
utility as described in Restoring customizations after an upgrade installation.


8 The Installation Summary shows informational messages such as successful confirmations, error
messages, and warnings. Investigate any errors or warnings.


If Next appears, your system needs to be rebooted because one or both of the following tasks are
pending on the system:


n A system-protected file was replaced during the installation and requires a restart.


n A pending restart was triggered by another application or by an operating system patch
installation.


Click Next or enter [1] and then reboot your system. Otherwise, click Finish or enter [1] to
exit the installation.


The installation program writes an install log file to the BASEDIR/smarts/setup/logs directory,
unless the installation fails at the very start, in which case the installation program writes the
log file to the /tmp directory. The log file is a text file with the naming convention
Install.<product>.<productversionNumber>.log.


9 Evaluate your custom code. Review the Custom file migration use cases. The sm_migrate utility
migrated all user-customized files from the existing installation to the BASEDIR/smarts/local directory
in the 10.0.0 installation. Review the output of the sm_migrate utility and evaluate if you would like to
keep the user-customized files in the new installation.


Configuration migration process logs provides more information on the log files that are created after
the migration of user-customized files.
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10 Depending on your deployment, ensure that the BASEDIR/smarts/local/conf/runcmd_env.sh file
includes the environment variables, SM_TLS_PROTOCOLS and SM_ALLOW_LEGACY_CRYPTO.


Use SM_TLS_PROTOCOLS set to the +TLSv1.1 value only if you need to interoperate with Smarts
products based on Foundation 9.0.0.0 Build 1345 through 9.2.x.


Use SM_ALLOW_LEGACY_CRYPTO set to TRUE only if you need to interoperate with Smarts
products based on Foundation versions prior to 9.0.0.0 Build 1345.


Check the version number provides the sm_server --version command to determine the Foundation
(DMT) version.


To ensure that the runcmd_env.sh file includes the environment variables:


a Go to the BASEDIR/smarts/bin directory and enter this command to open the runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


b Search for the environment variables. If they do not exist, add one or both depending on your
deployment:


SM_TLS_PROTOCOLS=+TLSv1.1


SM_ALLOW_LEGACY_CRYPTO=TRUE


c Save and close the file.


11 Optional for IP Manager, run the repository file migration utility (sm_migraterps) to make the
repository file compatible with the newer 10.0.0 version of the software as described in Automatically
migrate topology for IP Manager using RPS utility.


12 If your product is part of a deployment that requires the Federal Information Processing Standard
(FIPS) Publication 140-2, a U.S. government computer security standard governing cryptographic
modules, follow the instructions in Upgrading Smart Assurance products in FIPS mode.


13 If you installed the products as services, start the services. Starting services on UNIX provides more
information.


14 Verify the current state of the products and Broker. Verify the product status provides more
information.


15 Initiate a discovery. Consult the discovery guide or user guide for your product for more information
on this procedure.


16 For Server Manager,


a In the Domain Manager Administration Console, right-click on the ESM server (INCHARGE-ESM,
by default) in the left pane and select the Load All ESM Host monitoring data from Backup
option.


b Perform a discovery (Topology > Discover All) from the ESM server.


All of the applications that were configured prior to the upgrade are restored and Server Manager
starts to monitor those applications.
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Upgrading Smart Assurance products in FIPS mode
Note   Upgrading in FIPS mode is not available for Server Manager.


10.0.0 products do not use a Federal Information Processing Standard (FIPS 140-2) approved encryption
algorithm to protect the imk.dat file. By default, the 10.0.0 imk.dat file uses MD5, which is not a FIPS-
approved algorithm. Hence, while upgrading from previous versions of products to Version 10.0.0, the
imk.dat file needs to be regenerated in order to run in the FIPS mode.


In order to convert an existing installation to FIPS, use the sm_rebond (in non-FIPS mode) first to get
everything re-encoded in a FIPS compatible way. The steps are as follows:


1 Run the following command at the command line prompt:


               sm_rebond --upgrade --basedir=<


               BASEDIR


               >/smarts


               sm_rebond --upgrade --basedir=C:\InCharge\SAM\smarts


            


2 When prompted, type a password to regenerate the imk.dat file. The default password is Not a secret.


3 Set the value for the parameter SM_FIPS140 to TRUE in the runcmd_env.sh file. The file is located
under the BASEDIR/smarts/local/conf directory.


Next steps
Chapter 8 Verifying the Installation describes tasks for verifying the proper installation of the software and
starting services.
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Performing a Migration 6
This chapter includes the following topics:


n Migration overview


n Install and migrate on the same host


n Install and migrate on a different host


n Post-migration tasks


Migration overview
Consult the VMware Smart Assurance SAM, IP, ESM, MPLS, and NPM Managers Support Matrix for
software versions that require a manual migration to the latest version.


Two methods are available:


n Install and migrate on the same host


n Install and migrate on a different host


After the installation, run the sm_migrate utility to backup the user-customized files in the previous
version and migrate the files to the new version. Chapter 7 Migration Utilities explains how the
sm_migrate utility works.


Disk space requirement—During a migration, the sm_migrate creates a backup of files in actions,
conf, model, repos, rules, script directories. Ensure that you have disk space of four times the size of
these directories available on the system. After the migration and verifying the installation, you can
archive or remove the backup directories. This requirement is in addition to the minimum disk
requirement outlined for each product in the
VMware Smart Assurance SAM, IP, ESM, MPLS, and NPM Managers Support Matrix.


Server name requirement for migration—To preserve notification history and the original Source
attributes of notifications in the Service Assurance Manager, the server names of underlying Domain
Managers should remain the same. This way at the end of the migration of all Smarts Domain
Managers, the SAM server can correctly associate the pre-existing topology and notifications with the
topology and events coming from migrated Domain Managers. For example, if the Server Manager
has a server name INCHARGE-ESM, do not change it to a different name for the latest release.
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Make sure that you read Install and migrate on the same host and Install and migrate on a different
host in their entirety before proceeding.


Note   Remove all the unused files in the /local directory. The unused files will also include RPS files
and custom files created by you. The sm_migrate utility creates a backup of all the files in the local
directory and copies them back to local directory. RPS and custom files can be large, and may slow
down the process.


Install and migrate on the same host
To migrate from a previous version of a product to the new, current version on the same host, you must:


1 Install the product and specify an installation directory that is different from the one that is used for the
previous installation.


2 Stop the old services for the previous version, if necessary.


For UNIX, keep the service daemon (the sm_serviced component) running. If sm_serviced is
stopped, all VMware Smart Assurance products will stop and will need to be restarted.


For most cases, the installation program detects and stops all services, scheduled jobs, and
processes that use programs or libraries that are running from the existing installation.


It also stops the service daemon, sm_serviced, if it is running.


3 Migrate user-customized files from the previous installation to the new installation.


4 Reuse the customized Polling and Thresholds settings from the old repository.


Detailed instructions are described in Migration procedure for the same host.


For a test lab environment, since the two installations are on the same host, you can run both
installations in parallel. For parallel installations, both installations connect to the same Broker and
Global Manager, as long as the old and new product service and sm_server names are unique. In
this case, you will need to rename the service and sm_server for the previous product version.
Managers registered with the same Broker must have unique names.


For a production environment, VMware, Inc. recommends that you decommission the previous
version of product.


5 Start with the top-most SAM server.


6 An Aggregation SAM server if it is a hierarchical SAM deployment.


7 IP Manager.


8 Any order: Server Manager, MPLS Manager, and Network Protocol Manager.
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Migration procedure for the same host
To migrate the previous version of the product to the new version on the same host, perform the following
tasks:


1 Review the important release issues for the product, as described in the
VMware Smart Assurance IP Manager Release Notes.


2 Determine that the products that you are installing are supported for your platform. The
VMware Smart Assurance SAM, IP, ESM, MPLS, and NPM Managers Support Matrix provides more
information.


3 Determine if the host has enough disk space and memory to accommodate so both versions of the
product can co-exist. The
VMware Smart Assurance SAM, IP, ESM, MPLS, and NPM Managers Support Matrix provides more
information.


4 Mount the CD/DVD-ROM on the host as described in Chapter 12 Procedures for CD/DVD-ROMs


5 Uninstall any temporary test patches (TTPs), if they exist, in your old installation.


If a TTP has been installed on a Service Pack, you must first uninstall the TTP. Otherwise, the TTP
files will be treated as files modified by you and copied to the local directory in the new installation
area.


6 Install the new version of the product on the same host as described in Chapter 2 Performing an
Installation


n Specify an installation directory that is different from the old installation directory so both versions
of the product can co-exist.


n Install products as services. These services overwrite the old stopped services.


Note   If you need to continue to run the previous versions of the products, manually install
services for them with unique names and start them.


The installation program installs the software.


7 Run the sm_migrate utility to copy user-customized files from the previous installation to the new
installation. Migrating customizations on the same host provides instructions.


Note   Run the sm_migrate utility immediately after the installation and before you start any services
or modify any files in the new installation. The sm_migrate utility will not merge any files from the
previous installation local directory, if the same files are present in the new installation
BASEDIR/smarts/local directory.


8 Evaluate your security settings. Migration of security configuration files provides more information.


9 Evaluate the environment variables in the old runcmd_env.sh file. Migration of security configuration
files provides more information.
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10 Evaluate your custom code. Review the Custom file migration use cases to plan your post-migration
steps. The sm_migrate utility migrated all user-customized files from the previous installation to the
BASEDIR/smarts/local directory in the new installation. It also made a backup copy of the files under
the BASEDIR/smarts/.migrate.bkp.x.x directory (for example, .migrate.bkp.2.0.0.0). Review the output
of the sm_migrate utility and evaluate if you would like to keep the user-customized files in the new
installation.


11 Depending on your deployment, ensure that the BASEDIR/smarts/local/conf/runcmd_env.sh file
includes the environment variables, SM_TLS_PROTOCOLS and SM_ALLOW_LEGACY_CRYPTO.


Use SM_TLS_PROTOCOLS set to the +TLSv1.1 value only if you need to interoperate with Smarts
products based on Foundation 9.0.0.0 Build 1345 through 9.2.x.


Use SM_ALLOW_LEGACY_CRYPTO set to TRUE only if you need to interoperate with Smarts
products based on Foundation versions prior to 9.0.0.0 Build 1345.


Check the version number provides the sm_server --version command to determine the Foundation
(DMT) version.


a Go to the BASEDIR/smarts/bin directory and enter this command to open the runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


b Search for the environment variables. If they do not exist, add one or both depending on your
deployment:


SM_TLS_PROTOCOLS=+TLSv1.1


SM_ALLOW_LEGACY_CRYPTO=TRUE


c Save and close the file.


12 Rename the repository file before reusing it.


a Locate the existing repository file that was copied to the BASEDIR/smarts/local/repos/icf directory
in the new 10.0.0 installation.


b Rename the repository file by removing the version number extension. For example, the
repository file INCHARGE-MPLS-ANALYSIS.rps.3.1.0.2 should be renamed to INCHARGE-
MPLS-ANALYSIS.rps without the version number extension.


13 Optional for IP Manager, run the repository file migration utility (sm_migraterps) to make the
repository file compatible with the newer 10.0.0 version of the software as described in Automatically
migrate topology for IP Manager using RPS utility.


14 If you installed the products as services, start them for the first time. Starting services on UNIX
provide more information.


15 Verify the current state of the products and Broker. Verify the product status provides more
information.
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16 For Server Manager,


a In the Domain Manager Administration Console, right-click on the ESM server (INCHARGE-ESM,
by default) in the left pane and select the Load All ESM Host monitoring data from Backup
option.


b Perform a discovery (Topology > Discover All) from the ESM server.


All of the applications that were configured prior to the migration are restored and
Server Manager starts to monitor those applications.


17 Decommission the previous version of the products. For instructions, refer to the uninstallation
chapter in the installation guide for the previous software version.


Install and migrate on a different host
If you want to run the new version of the 10.0.0 product before decommissioning the previous version,
you must:


1 Install the new version of the 10.0.0 product on a different host.


2 Migrate any customized configuration file changes to the new installation.


Detailed instructions are described in Migration procedure for a different host.


Since the two installations are on different hosts, you can run both installations in parallel. You have
the option of:


n Having both installations connect to the same Global Manager and Broker.


Managers registered with the same Broker must have unique names. In this scenario, stop and
rename the services for the previous version and, when you install the 10.0.0 product, the
installation program will use the default server names.


n Having multiple instances of the Global Manager and Broker with each instance assigned to a
different version of the product.


For a production environment, VMware, Inc. recommends that you decommission the previous
version of product.


3 Start with the top-most SAM server.


4 An Aggregation SAM server if it is a hierarchical SAM deployment.


5 IP Manager.


6 Any order: Server Manager, MPLS Manager, and Network Protocol Manager.


Migration procedure for a different host
To migrate the previous version of the product to the new version on a different host, satisfy or perform
the following tasks:


1 Review the important release issues for the 10.0.0 product, as described in the
VMware Smart Assurance IP Manager Release Notes.
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2 Determine that the products that you are installing are supported for your platform. The
VMware Smart Assurance SAM, IP, ESM, MPLS, and NPM Managers Support Matrix provides more
information.


3 Determine if the host has enough disk space and memory to accommodate so both versions of the
product can co-exist. The
VMware Smart Assurance SAM, IP, ESM, MPLS, and NPM Managers Support Matrix provides more
information.


4 Mount the CD/DVD-ROM on the host as described in Chapter 12 Procedures for CD/DVD-ROMs


5 Uninstall any temporary test patches (TTPs), if they exist, in your old installation.


If a TTP has been installed on a Service Pack, you must first uninstall the TTP. Otherwise, the TTP
files will be treated as files modified by you and copied to the local directory in the new installation
area.


6 Install the new version of the product on the different host as described in Chapter 2 Performing an
Installation


The installation program installs the 10.0.0 software.


7 Run the sm_migrate utility to copy user-customized files from the previous installation to the new
10.0.0 installation. Migrating customizations to a different host provides instructions.


Note   Run the sm_migrate utility immediately after the installation and before you start any services
or modify any files in the new installation. The sm_migrate utility will not merge any files from the
previous installation local directory, if the same files are present in the new installation
BASEDIR/smarts/local directory.


8 Evaluate your security settings. Migration of security configuration files provides more information.


9 Evaluate the environment variables in the old runcmd_env.sh file. Migration of security configuration
files provides more information.


10 Evaluate your custom code. Review the Custom file migration use cases to plan your post-migration
steps. The sm_migrate utility migrated all user-customized files from the previous installation to the
BASEDIR/smarts/local directory in the new installation. It also made a backup copy of the files under
the BASEDIR/smarts/.migrate.bkp.x.x directory (for example, .migrate.bkp.2.0.0.0). Review the output
of the sm_migrate utility and evaluate if you would like to keep the user-customized files in the new
installation.


11 Depending on your deployment, ensure that the BASEDIR/smarts/local/conf/runcmd_env.sh file
includes the environment variables, SM_TLS_PROTOCOLS and SM_ALLOW_LEGACY_CRYPTO.


Use SM_TLS_PROTOCOLS set to the +TLSv1.1 value only if you need to interoperate with Smarts
products based on Foundation 9.0.0.0 Build 1345 through 9.2.x.


Use SM_ALLOW_LEGACY_CRYPTO set to TRUE only if you need to interoperate with Smarts
products based on Foundation versions prior to 9.0.0.0 Build 1345.
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Check the version number provides the sm_server --version command to determine the Foundation
(DMT) version.


a Go to the BASEDIR/smarts/bin directory and enter this command to open the runcmd_env.sh file:


sm_edit conf/runcmd_env.sh


b Search for the environment variables. If they do not exist, add one or both depending on your
deployment:


SM_TLS_PROTOCOLS=+TLSv1.1


SM_ALLOW_LEGACY_CRYPTO=TRUE


c Save and close the file.


12 Rename the repository file before reusing it.


a Locate the existing repository file that was copied to the BASEDIR/smarts/local/repos/icf directory
in the new 10.0.0 installation.


b Rename the repository file by removing the version number extension. For example, the
repository file INCHARGE-MPLS-ANALYSIS.rps.3.1.0.2 should be renamed to INCHARGE-
MPLS-ANALYSIS.rps without the version number extension.


13 Optional for IP Manager, run the repository file migration utility (sm_migraterps) to make the
repository file compatible with the newer 10.0.0 version of the software as described in Automatically
migrate topology for IP Manager using RPS utility.


14 If you installed the products as services, start them for the first time. Starting services on UNIX
provide more information.


15 Verify the current state of the products and Broker. Verify the product status provides more
information.


16 For Server Manager,


a In the Domain Manager Administration Console, right-click on the ESM server (INCHARGE-ESM,
by default) in the left pane and select the Load All ESM Host monitoring data from Backup
option.


b Perform a discovery (Topology > Discover All) from the ESM server.


All of the applications that were configured prior to the migration are restored and
Server Manager starts to monitor those applications.


17 Decommission the previous version of the products. For instructions, refer to the uninstallation
chapter in the installation guide for the previous software version.


Post-migration tasks
Perform these tasks after the data migration steps are complete:


1 Rename the repository file
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2 Ensure that the Broker host:port is updated in the runcmd_env.sh files


3 Remove the old out-of-date service entries


4 Change the secret phrase to match rest of deployment


5 Uninstall the old software


Rename the repository file
For a same host or different host migration, the old repository file is copied to the
BASEDIR/smarts/local/repos/icf directory in the 10.0.0 installation. Because the repository file has a
version number extension (for example, .2.0 extension), rename the repository file without the .2.0
extension before using it.


As further information, regardless of whether the old installation is on a UNIX system, sm_migrate saves
the old repository file and all other customization files in DOS format. If the new installation is on a UNIX
system, sm_migrate automatically converts the repository file and all other customization files to UNIX
format.


Ensure that the Broker host:port is updated in the runcmd_env.sh
files
If you are installing the 10.0.0 Broker during the installation to a location that is different from where the
Broker for the previous installation resides, for each server that is registered with the Broker, you need to
use the sm_edit utility to edit the SM_BROKER_DEFAULT variable in the runcmd_env.sh file in each of
those server’s BASEDIR/smarts/local/conf directory with the hostname (and port) of the host system that
is running the Broker:


If the Broker host is resolved using a DNS name, this step is not necessary. It is recommended not to use
Name Server Caching Daemon (NSCD) to cache DNS lookups (the host’s database) in Linux.


1 Run BASEDIR/smarts/bin/sm_service show --cmdline (UNIX).


2 For each service that you have installed, you will see output similar to the following:


sm_service install --force --name=ic-broker 


--description=”VMware Broker” --env=SM_CLIENTCONNECT=brokerConnect.conf --startmode=runonce 


C:\InCharge\IP\smarts\bin\brstart.exe --port=426 --


restore=C:\InCharge\IP\smarts/local/repos/broker/broker.rps --output


Remove the old out-of-date service entries
Use the following command to remove all old services that are going to be replaced by the 10.0.0
product:


         <BASEDIR>


         /smarts/bin/sm_service remove 


         <service name>
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For UNIX, you need to point the product to the new 10.0.0 services that will be installed. Do this by
making a copy of /etc/init.d/ic-serviced, change the SMHOME variable to point to the 10.0.0 services, and
place it in the 10.0.0 /etc/init.d directory.


Change the secret phrase to match rest of deployment
If the rest of the deployment uses a different site secret, and assuming that you want to employ secure
communications between the component applications in the deployment, you need to change the site
secret of this installation to match the rest of deployment. You do so by using the deployment’s site secret
to recreate and encrypt the clientConnect.conf, serverConnect.conf, brokerConnect.conf, and .imk.dat
files in the BASEDIR/smarts/local/conf directory of this installation.


Use the sm_rebond command to encrypt the files. For example, from the BASEDIR/smarts/bin directory,
enter:


sm_rebond --basedir=/opt/InCharge/IP/smarts


The VMware Smart Assurance System Administration Guide provides complete information about the
security files and encryption.


Uninstall the old software
If the new version of the product is functioning properly, all data has been migrated to the new version,
and all services are functioning properly, you should uninstall the previous version of the product.


Uninstalling the previous version of the product will prevent conflicts if the previous version is started by
mistake while 10.0.0 is running. Chapter 9 Performing an Uninstallation provides more information.


Uninstall will display errors if services were installed by the installation program when the old version was
installed, but were removed manually in a later step. The uninstall process will display errors because it
will not find the services when it tries to remove them.
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Migration Utilities 7
This chapter includes the following topics:


n Customization migration utility overview


n sm_migrate function


n Customization migration procedures


n Perform a rollback


n Custom file migration use cases


n Three-way merge utility


n Automatically migrate topology for IP Manager using RPS utility


n Deployment utility overview


Customization migration utility overview
The sm_migrate utility is used to migrate user-customized files from an old installation to a new
installation, where the old installation and the new installation are in different installation directories or, for
an upgrade installation, in the same installation directory. User-customized files include user-modified files
(using sm_edit), user-introduced files, and the repository file.


Note   If TTPs (Temporary Test Patch) are installed on a previous installation of SAM, you must first
uninstall the TTP and then run the utility. Else, TTP files will be treated as files modified by you and
copied to the local directory in the new installation area.


When migrating a customized file from an old installation to a new installation, if a file with the same name
exists in the local directory of the new installation, the Customization Migration Utility does not modify or
overwrite it. The utility skips all such files being considered for merging. For files being considered to be
copied-over, the utility migrates the files with the old version number appended to the file name.


sm_migrate modes of operation
The sm_migrate has seven command-line options:


n --old (or -o)
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n --new (or -n)


n --archive (or -a)


n --upgrade (or -u)


n --rollback (or -r)


n --silent (or -s)


n --sitemod (or -l)


n --help (or -h)


These command-line options can be used in pairs in the command line to achieve eight different
modes of operation described below.


SAME HOST MODE
This mode is used when the new installation and the old installation are on the same host, in two
separate locations. In this mode, sm_migrate migrates all customizations (non-binary files that have been
modified or introduced by you in the old installation) from the old installation to a new installation.


Note   All files that were modified or newly introduced in the old installation must be present only under
the BASEDIR/smarts/ directory.


When you use the --sitemod option, the migration utility will migrate all customized old files for all user
created locals.


DIFFERENT HOST - OLD MODE
This mode is used when the new installation and the old installation are on different hosts. In this mode,
sm_migrate backs up and creates tar or a zip archive (file) of the customizations in the old installation.
The tar or zip file resides in the location specified by you while executing the utility.


Note   To run the utility from an older version of a Smarts product that does not have the migration utility,
you must copy the sm_migrate.pl script and certain Perl files (packaged in migratePerlPkg.zip file) and
place them in the appropriate locations. The sm_migrate.pl must be placed in the bin directory and the
Perl package must be placed under the BASEDIR/smarts/local folder and extracted there.


When you use the --sitemod option, the migration utility will migrate all customized old files for all user
created locals.


After running DIFF_HOST_OLD mode and before running DIFF_HOST_NEW mode, you must manually
move the tar or zip archive from the old host to the new host, preferably under the smarts directory of your
new installation.
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DIFFERENT HOST - NEW MODE
This mode is also used when the new installation and the old installation are on different hosts. In this
mode, sm_migrate migrates the customizations from the tar or zip archive that was created in the old
installation to the local directory under the new installation and attempts to merge the files from your new
installation with the files present in the backup archive wherever applicable, and places them in your new
local directory.


UPGRADE MODE
This mode is used during an in-place upgrade, where the installer creates a backup of the files modified
or newly introduced by you in the old installation into a .migrate.bkp.<old_version> backup directory and
merges them into a new installation. This mode has been designed for the installer, but can be invoked by
you too.


Note   This mode must not be invoked by you if there are multiple .migrate.bkp.<version> directories
under the <BASEDIR/smarts directory.


ROLLBACK MODE
In any execution of the migration utility, before the utility migrates your customizations from the backup
directory to your new installation, it creates a backup of certain files in your current new local and stores it
in a .rollback_<version_timestamp> directory. Also, it records the version and timestamp before any
migration.


The rollback option allows you to reverse the changes made by the migration utility by restoring the local
version in your new installations using files from the .rollback_<version_timestamp> directory. Rollback
will contain only those locals which are part of migration.


Note   In some scenarios, if a file is copied to the new installation with .<old_version> extension, then this
file is not deleted when a rollback is performed.


The rollback action is restricted only to rollback points that were recorded in your current version. For
example if you upgrade from 9.4.0.0 to 9.5.0.0, and then install a patch (for example, 9.5.0.1), the rollback
utility will not allow you to rollback to your 9.5.0.0 local version. You have to manually uninstall the patch
in order to rollback to 9.5.0.0.


Note   You can use the rollback option only after an in-place upgrade or if you have previously run the
migration utility either in the SAME_HOST, DIFFERENT_HOST or UPGRADE_NEW modes.


Perform a rollback on page 90 describes the procedure for carrying out a rollback.
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sm_migrate function
The customization migration utility is capable of four major functions, which include:


n Copying all non-binary files from the <BASEDIR>/smarts/local folder that have been modified or
introduced by you in the previous version of the product into the appropriate backup directories under
the <BASEDIR>/smarts directory of the new installation. Details of backup folders created by
sm_migrate utility provides details on the backup directories created by the utility during the migration
and upgrade process.


Table 7‑1.  Details of backup folders created by sm_migrate utility


Scenario Name and location of backup folders under <BASEDIR>/smarts


Migration on same host .migrate.bkp.<old_version>, .rollback_<version_timestamp>


Migration on different host old mode user-defined tar or zip file name,


Migration on different host new mode .rollback_<version_timestamp>,


.migrate.bkp.<old_version>


Upgrade .migrate.bkp.<old_version>, .rollback_<version_timestamp>


For files that have been modified by you, the utility also creates a copy of the base files from the
<BASEDIR>/smarts folder. These files are backed up into .migrate.bkp.<old_version> directory. The
original and the local versions of the files from the old installation will be needed when the utility attempts
to merge your changes with the new installation files.


Under the smarts/.migrate.bkp.<old_version> and backup.tar or backup.zip directory you can find files
with the following extensions:


n .custom - files from the <BASEDIR>/smarts/local folder introduced by you and are not part of the
default installation


n .local - files from the <BASEDIR>/smarts/local folder that are part of the default installation and
have been modified from their original version, using sm_edit.


n .base - the <BASEDIR>/smarts version of these files with .local extension


Custom file migration use cases provide details.


n Copying the cacert.sso certificate file from <BASEDIR>/smarts/jre/lib/security directory into
the .migrate.bkp.<old_version>/jre/lib/security directory to retain the certificate file.


n Copying all files you have added into the <BASEDIR>/smarts/local folder of the new installation. This
allows for an easy and automatic migration of all customer files to the new installation, so that no
manual step is required for moving the files from the backup directory.


Note   All files, customized or newly introduced in the existing installation, must be present under the
<BASEDIR>/smarts/ folder only. The utility also copies the RPS files found in the old_local.
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n Merging .asl, .import, .conf, .xml, .pl, .sh and .cmd files modified by you into the new installation. The
utility first backs up the corresponding files from the old_base, and then migrates the files
from .migrate.bkp.<old_version> backup directory to the new installation.


Note   This is an optional function and you may skip it.


In order to merge the configurations from the existing installation into the new installation, the utility
uses files from:


n Original base installation (previous installation with <file_name>.base extension)


n Local directory of the previous installation (files you have modified with a <file_name>.local
extension)


n New installation (with <file_name> extension)


The files to be merged are put in the new_local after performing a three-way merge between the
two files in the backup directory and the corresponding file in the new base.


n Rolling back changes made by the sm_migrate utility in your current installation. It creates a backup
of the new_local, and allows you to rollback to multiple stages of backup, as long as the changes
were carried out in your current version. The backup consists of
all .conf, .import, .asl, .mdl, .xml, .template, .sh, .conflict, .automerge, .cmd, .dat, and .bat files found
in the new_local.


Note   Soft links created for product related files in the UNIX environment are not handled by
sm_migrate utility.


Customization migration procedures
Run the sm_migrate utility immediately after the installation and before you start any services or modify
any files in the new installation. Back up the BASEDIR/smarts/local directory in the new installation before
you run sm_migrate.


Note   When you run the sm_migrate utility, ensure that you run only one instance of sm_migrate utility.


Migrating customizations on the same host
Use the following steps to migrate customizations on the same host:


1 Go to the BASEDIR/smarts/bin directory of the new installation and type the following command on
one line to invoke the sm_migrate utility:


sm_perl sm_migrate.pl --old=<BASEDIR>/smarts (old installation) --new=<BASEDIR>/smarts (new 


installation) --sitemod=<BASEDIR>/smarts/local;local1
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IP Manager


c:\InCharge93\IP\smarts\bin>sm_perl sm_migrate.pl


--old=c:\Incharge93\IP\smarts --new=c:\Incharge94\IP\smarts --sitemod=c:\Incharge94\IP\smarts\local1; 


c:\Incharge94\IP\smarts\local2


Service Assurance Manager


c:\InCharge\SAM\smarts\bin>sm_perl sm_migrate.pl


MPLS Management Suite


c:\InCharge93\MPLS\smarts\bin>sm_perl sm_migrate.pl


--old=c:\Incharge93\MPLS\smarts --new=c:\Incharge94\MPLS\smarts --


sitemod=c:\Incharge94\MPLS\smarts\local1; c:\Incharge94\MPLS\smarts\local2


Server Manager


c:\InCharge\ESM\smarts\bin>sm_perl sm_migrate.pl


--old=c:\Incharge\ESM\smarts --new=c:\Incharge\ESM\smarts --sitemod=c:\Incharge94\ESM\smarts\local1; 


c:\Incharge94\ESM\smarts\local2


Network Protocol Management Suite


c:\InCharge\NPM\smarts\bin>sm_perl sm_migrate.pl


--old=c:\Incharge\NPM\smarts --new=c:\Incharge\NPM\smarts --sitemod=c:\Incharge94\NPM\smarts\local1; 


c:\Incharge94\NPM\smarts\local2


Migrating customizations to a different host
Use the following steps to migrate customizations on remote hosts:


1 Prepare to archive the customizations made in the old installation into a tar or zip archive by copying
the following files:


n Perl packages: Copy migrateperlpkg.zip from the BASEDIR/smarts/perl directory in the new
installation to the BASEDIR/smarts/local directory of the old installation. For Linux and CentOS,
use the unzip migrateperlpkg.zip command.


n sm_migrate.pl utility: Copy this file from the BASEDIR/smarts/bin directory of the new
installation to the BASEDIR/smarts/bin directory of your old installation.


2 Go to the BASEDIR/smarts/bin directory of your old installation and enter the following command on
one line to generate an archive of the customizations:


sm_perl sm_migrate.pl --old=<BASEDIR>/smarts (old installation) --archive=<BASEDIR>/smarts/<tar or 


zip file to contain customizations> ----sitemod==<BASEDIR>\smarts\local1; =<BASEDIR>\smarts\local2
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IP Manager


c:\InCharge93\IP\smarts\bin>sm_perl sm_migrate.pl --old=c:\InCharge93\IP\smarts --


archive=c:\InCharge93\IP\smarts\backup.zip --sitemod=c:\InCharge93\IP\smarts\local1;c:\InCharge93\IP\


smarts\local2


Service Assurance Manager


c:\InCharge\SAM\smarts\bin>sm_perl sm_migrate.pl --old=c:\InCharge\SAM\smarts --


archive=c:\InCharge\SAM\smarts\backup.tar --sitemod=c:\InCharge\SAM\smarts\local1;c:\InCharge\SAM\


smarts\local2


MPLS Management Suite


c:\InCharge93\MPLS\smarts\bin>sm_perl sm_migrate.pl --old=c:\InCharge93\MPLS\smarts --


archive=c:\InCharge93\MPLS\smarts\backup.zip --


sitemod=c:\InCharge93\MPLS\smarts\local1;c:\InCharge93\MPLS\


smarts\local2


Server Manager


c:\InCharge\ESM\smarts\bin>sm_perl sm_migrate.pl --old=c:\InCharge\ESM\smarts --


archive=c:\InCharge\ESM\smarts\backup.tar --


sitemod=c:\InCharge\ESM\smarts\local1;c:\InCharge\ESM\smarts\


local2


Network Protocol Management Suite


c:\InCharge\NPM\smarts\bin>sm_perl sm_migrate.pl --old=c:\InCharge\NPM\smarts --


archive=c:\InCharge\NPM\smarts\backup.tar --sitemod=c:\InCharge\NPM\smarts\local1;c:\InCharge\NPM\


smarts\local2


IP Manager


c:\InCharge93\IP\smarts\bin>sm_perl sm_migrate.pl --archive=c:\InCharge93\IP\smarts\backup.zip --


new=c:\InCharge93\IP\smarts


Service Assurance Manager


c:\InCharge\SAM\smarts\bin>sm_perl sm_migrate.pl --archive=c:\InCharge\SAM\smarts\backup.tar --


new=c:\InCharge\SAM\smarts
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MPLS Management Suite


c:\InCharge93\MPLS\smarts\bin>sm_perl sm_migrate.pl --archive=c:\InCharge93\MPLS\smarts\backup.zip --


new=c:\InCharge93\MPLS\smarts


Server Manager


c:\InCharge\ESM\smarts\bin>sm_perl sm_migrate.pl --archive=c:\InCharge\ESM\smarts\backup.tar --


new=c:\InCharge\ESM\smarts


Network Protocol Management Suite


c:\InCharge\NPM\smarts\bin>sm_perl sm_migrate.pl --archive=c:\InCharge\NPM\smarts\backup.tar --


new=c:\InCharge\NPM\smarts


Restoring customizations after an upgrade installation
During an upgrade, the installer creates a backup of your customizations and places them in the
<BASEDIR>/smarts/.migrate.bkp.<version> directory.


If during the installation you choose to skip migrating the files back into your new local directory, you may
either manually migrate or merge the files into your new local installation directory or run the sm_migrate
utility in the UPGRADE mode to perform this action.


Use the following steps to run the sm_migrate utility:


1 Go to the <BASEDIR>/smarts/bin folder.


2 Type the following command to migrate the backup directory to the new installation:


./sm_perl sm_migrate.pl


--new=<new installation location up to and including smarts> --upgrade --silent


c:\InCharge\SAM\smarts\bin>sm_perl sm_migrate.pl


--new=c:\InCharge\SAM\smarts --upgrade


3 Press y or any other key to start the file merge utility (sm_merge utility), and then press Enter. The
utility is invoked individually for each of the files that may require a three-way merge. Three-way
merge utility provides details. Once the utility completes merging the files, a message is displayed
indicating successful completion of the process.


or


Press n to skip the invocation of the file merge utility.


Note   You may use an additional --silent option to avoid this prompt. In which case, by default, the
utility will attempt the three-way merge.
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4 Press y or any other key to copy security configuration files, and then press Enter. This will copy the
security configuration files from .migrate.bkp.<version>/conf to local/conf of the new installation.


or


Press n to skip the copying of security configuration files.


5 Review the files (merged, auto-merged and .conflict) after the migration is over. Take appropriate
actions as mentioned in the 'User Action' column in Custom file migration use cases.


Perform a rollback
Use the following steps to rollback changes made by the sm_migrate utility:


1 Go to the <BASEDIR>/smarts/bin folder of your new installation, and type the following command to
rollback the changes made by sm_migrate utility to your new installation:


./sm_perl sm_migrate.pl --new=<new_installation location _upto_and including smarts> --rollback [--


silent]


c:\InCharge\SAM\smarts\bin>sm_perl sm_migrate.pl


--new=c:\InCharge\SAM\smarts --rollback


Custom file migration use cases
The use cases for custom file migration and resulting backup and merge activities are described in 
Custom file migration use cases .


Note   <file_name> with no extension represents a base file that is present under the BASEDIR/smarts
directory of the new installation.
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Table 7‑2.  Custom file migration use cases


Use case Backup action Merge Action


User actionOld installation


New installation:
BASEDIR/smarts/.migrate.b
kp.<version>


New_installation:BASEDI
R/smarts/local


There is a local copy of a file,
and changes were introduced
by you. The file is also used
in the new base installation.


Back up the base and the
local copies of the file. The
base copy is backed up with
“base” extension, as


<file_name>.base.


The local copy will be backed
up with “local” extension, as


<file_name>.local.


Local name will be
customized name of local.


For example:
<file_name>.local123.


Run sm_merge for:
n <file_name>.base
n <file_name>.local
n <file_name>


Merge Outcome:
n Changes made by you


are merged into the new
file and placed in
<New_installation>/smart
s/local/<file_name>.conf


n If the changes made by
you could not be merged
without a conflict,
a .conflict file is generated
and placed in
<New_installation>/smart
s/local/<file_name>.confli
ct


n Because the three-way
merge utility works at a
string level and not at a
code level for files such
as .asl, .xml, .cmd,
and .sh, the merge result
of these files is appended
with .automerge
extension. Review the
files, and if the changes
are acceptable, save the
file without .automerge
extension.


n Files with .import
and .conf extension are
not appended with an
automerge extension on
successful merge.


n For conflict files, review
the conflict file, manually
resolve the conflict, and
save the file without
a .conflict extension.


There is a file in old base, old
local and the same file exists
in new base.


No backup action. No merge. No user action required.


There is a file in old base and
the same file exists in new
base.


No backup action. No merge. No user action required.


The local copy of the file that
was introduced by a patch
and later modified by you.
The file exists in the new
base, but does not exist in the
old base.


Back up the local copy of the
file. The local copy will be
backed up with “local”
extension, as


<file_name>.local.


Local name will be
customized name of local.


For example:
<file_name>.local123.


sm_merge utility will compare
<file_name>.local and
<file_name>.


Merge Outcome:
<file_name>.conflict


Review the conflict file,
manually resolve the conflict
and save the file without
a .conflict extension.
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Table 7‑2.  Custom file migration use cases (Continued)


Use case Backup action Merge Action


User actionOld installation


New installation:
BASEDIR/smarts/.migrate.b
kp.<version>


New_installation:BASEDI
R/smarts/local


There is a local copy of the
file, and changes were
introduced by you, but the file
is no longer used in the new
release.


Backup the base and the
local copies of the file. The
base copy is backed up with
“base” extension, as


<file_name>.base.


The local copy will be backed
up with “local” extension, as


<file_name>.local.


Local name will be
customized name of local.


For example:
<file_name>.local123.


No merge The files remain in the backup
directory. Determine if the
customization is still relevant
to the new installation.


The local copy of the file was
introduced by a patch, and
changes were made by you.
The file does not exist in
either the new or old base.


Backup the local copy of the
file. The local copy will be
backed up with “local”
extension, as
<file_name>.local.


Local name will be
customized name of local.


For example:
<file_name>.local123.


No merge Determine if the
customization is still relevant
to the new installation.


There is a local copy of the
file, and changes were made
by you. The file is also used
in the new version, and there
is already a local copy of the
file in the new local.


Backup the local copy of the
file. The local copy will be
backed up with “local”
extension, as
<file_name>.local.


Local name will be
customized name of local.


For example:
<file_name>.local123.


No merge The sm_merge gives
precedence to the files in
new_local. No changes will
be made to the files that are
already under new_local.


Key exceptions to the rule are
covered in the Migration of
security configuration files.


There is a local copy of the
file, and custom code was
introduced by you. This code
does not exist in either the old
or the new base.


Back up the local copy of the
file. The local copy will be
backed up with “custom”
extension, as
<file_name>.custom.


No merge.


Copy the files (without
the .custom extension) from
New Installation:
BASEDIR/smarts/.migrate.bk
p.<version> to New
installation:
BASEDIR/smarts/local


Determine whether these
custom files are still needed
in your new installation.
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Table 7‑2.  Custom file migration use cases (Continued)


Use case Backup action Merge Action


User actionOld installation


New installation:
BASEDIR/smarts/.migrate.b
kp.<version>


New_installation:BASEDI
R/smarts/local


There is a local copy of the
file, and custom code was
introduced by you. This file is
also used in the new base.


Back up the local copy of the
file. The local copy will be
backed up with “custom”
extension, as
<file_name>.custom.


No merge.


Copy the files (without
the .custom extension) from
New Installation:
BASEDIR/smarts/.migrate.bk
p.<version> to New
installation:
BASEDIR/smarts/local


The file is copied
with .<old_version>
extension.


Determine whether these
custom files are still needed
in your new installation.


There is a local copy of the
file, and changes were made
by you. The file is also used
in the new version, and there
is already a local copy of the
file in the new local
introduced by a patch.


Back up the base and the
local copies of the file. The
base copy is backed up with
“base” extension, as
<file_name>.base.


The local copy will be backed
up with “local” extension, as
<file_name>.local.


Local name will be
customized name of local.


For example:
<file_name>.local123.


Run sm_merge for:
n <file_name>.base
n <file_name>.local
n <file_name>


Merge Outcome:
n Changes made by you


are merged into the new
file and placed in
<New_installation>/smart
s/local/<file_name>.conf


n If the changes made by
you could not be merged
without a conflict,
a .conflict file is generated
and placed in
<New_installation>/smart
s/local/<file_name>.confli
ct


n Because the three-way
merge utility works at a
string level and not at a
code level for files such
as .asl, .xml, .cmd,
and .sh, the merge result
of these files is appended
with .automerge
extension. Review the
files, and if the changes
are acceptable, save the
file without .automerge
extension.


n Files with .import
and .conf extension are
not appended with an
automerge extension on
successful merge.


n For conflict files, review
the conflict file, manually
resolve the conflict, and
save the file without
a .conflict extension.


Migration of security configuration files
The sm_migrate utility prompts you for copying the security configuration files serverConnect.conf,
clientConnect.conf, brokerConnect.conf, runcmd_env.sh and imk.dat. You can either choose to copy
these files into the local directory of the new installation or configure these files later, manually.


If you choose to copy and have changed the site secret in your previous installation, you need to run the
sm_rebond command to encrypt the files. For example:


./sm_rebond --basedir=C:\InCharge\IP\smarts
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After copying the files, the data in the old runcmd_env.sh file is appended to the new runcmd_env.sh file
and the new 10.0.0 version data is commented.


Note   Migration of security configuration files is not supported on cross platforms.


Migration of dynamic model files
The dynamic model files (files with .mdl and .ldm extension) are backed up in the .migrate.bkp.<version>
directory. These files are not considered by sm_migrate utility for merging. Remove the .ldm file from the
local directory of the new installation. Recompile the .mdl file before it is used in the new installation. A
new .ldm file will be generated once you recompile the .mdl file.


The VMware Smart Assurance Dynamic Modeling Tutorial explains the concepts and methods of dynamic
modeling.


Three-way merge utility
The three-way merge utility, sm_merge, helps incorporate configuration changes (made in
the .conf, .import .asl, .xml, .pl, .sh, and .cmd files) from an old installation into a new installation of a
product. The utility performs a three-way merge on each of the files that you have modified.


The utility uses <file_name>.base, <file_name>.local, and <file_name>, and finds the largest sequence of
lines that is common to all three files (this sequence need not necessarily be continuous lines). This
largest sequence of lines is called the Longest Common Subsequence (LCS). Then, for each of the three
files, it finds groups of lines in between two consecutive lines in the LCS. These groups are referred to as
“content blocks.” The utility compares these content blocks to decide on merge as given in Three-way
merge utility.


Use cases for content block comparison
The scenarios for comparison of content blocks during the three-way merge process are described in 
Content block comparison use cases. In this table, X, Y, and Z represent the content blocks, one from
each of the three files.
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Table 7‑3.  Content block comparison use cases


Scenario Content block comparison Result


XYY
n Content block in the <file_name>.base


looks like X
n Content block in <file_name>.local


looks like Y
n Content block in the <file_name> looks


like Y


The following content blocks are picked up:
n Content block in <file_name>.base = X


AllowPrivateIPAsName FALSE


n Content block in <files_name>.local = Y


AllowPrivateIPAsName TRUE


n Content block in <file_name> = Y


AllowPrivateIPAsName TRUE


Result: Y


Since the <file_name>.local
version and the <file_name>
version of the content blocks
match, the Y version is picked.


XYX
n Content block in the <file_name>.base


looks like X
n Content block in the <file_name>.local


looks like Y
n Content block in <file_name> looks like


X


The following content blocks are picked up:
n Content block in <file_name>.base = X


ERXIfExcludeSysPattern router*


n Content block in <files_name>.local = Y


ERXIfExcludeSysPattern *


n Content block in <file_name> = X


ERXIfExcludeSysPattern router*


Result : Y


This is the case where the file
modified by you (Y) is preserved
and is written to new_local.


X Y Z
n Content block in the <file_name>.base


looks like X
n Content block in the <file_name>.local


looks like Y
n Content block in the <file_name> looks


like Z. This is the case where
a .conflict file is created.


The following blocks sections are picked up:
n Content block in <file_name>.base = X


#Enable/Disable discovery of 
VLANs 
PropagateVRIfAlias  FALSE


n Content block in <files_name>.local = Y


#Enable/Disable discovery of 
Router 
PropagateVRIfAlias  TRUE 


n Content block in <file_name> = Z


#Enable/Disable discovery of 
Multicast # New install changes
PropagateVRIfAlias  FALSE


Result: Conflict


All three content blocks will be
written into a .conflict file.


During this process, modifications done on each of the files in the old installation are merged into the new
installation. The utility identifies the files to be copied and copies them into a predefined new directory in
the new installation with an appropriate suffix. Use cases for content block comparison provides details on
the files which will be copied:
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The utility performs the following functions:


n Automated analysis of the differences between any two files (for example, File A and File B), while
also considering the parent file.


n Incorporates the changes done to the parent file in File A and File B, and automatically merges the
two changes. This type of merge is used in revision control systems.


n It maintains a record of the conflicts encountered during the merge process in a .conflict file.


In case the utility is unable to merge the files due to some conflict, it creates a .conflict file for each
file. The .conflict file provides details of the files which were not completely merged by the three-way
utility. Each conflicting instance is recorded in the .conflict file. You can review the .conflict files to spot
the conflicts, and manually resolve the differences.


Configuration migration process logs
Log file and description lists the logs files that are created for the modified customization migration
process. These files are available under the BASEDIR/smarts/setup/logs directory.


Table 7‑4.  Log file and description


Log file name Description


Config_migration_copy.log Logs information about files that were modified during the previous installation, and
those which were backed up in the new installation.


Config_migration_merge.log Logs information about the files on which three-way merge was performed. It also
mentions whether the merge process was successful or if any conflicts arose during
the process.


<file_name>.conf.MergeLog


<file_name>.asl.MergeLog


<file_name>.import.MergeLog


<file_name>.xml.MergeLog


<file_name>.sh.MergeLog


<file_name>.cmd.MergeLog


For each type of file (.conf, .import .asl, .xml, .sh, and .cmd) merge logs are created.
These logs record the lines which the three-way merge process copied from the
previous installation, lines which were retained as-is, and those where conflicts were
observed.


Automatically migrate topology for IP Manager using RPS
utility
The repository file (RPS) migration utility (sm_migraterps) automatically converts the RPS file created by
the previous version of the software to an RPS file compatible with the newer version of the software. For
example, you can use the utility to automatically convert the IP 9.4.0.0 RPS file into a compatible version
of IP Manager 9.5. This tool allows the administrator to quickly migrate the product without going through
a rediscovery of the entire topology.


The RPS migration utility supports migration from IP Manager 9.x.x versions to IP Manager 9.5.x and
later.
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If you are migrating from IP Manager 9.4.x, running the RPS migration utility is optional. For example, if
you have an IP Manager 9.4 repository file that includes virtual switch systems in the topology, use the
sm_migraterps utility to remove VirtualSwitchSystemLink and make the repository compatible for
IP Manager 10.0.0.


This section covers the following:


n Functions of RPS migration utility


n Running RPS migration utility


Functions of RPS migration utility
The utility performs the following functions:


n Creates a temporary and a backup copy of the RPS file to be migrated. On successful migration, the
backup file is deleted. The tool then renames the temporary file as the new RPS and, the original
RPS file as the backup file with a .v70 suffix.


n Checks for the existence of the source RPS file. Users must ensure that they are using a valid source
RPS file.


Running RPS migration utility


Note   It is recommended to run the RPS migration utility only once. A second run will overwrite the older
backup file.


To run the RPS migration utility:


1 Go to the <BASEDIR>/smarts/bin folder.


2 Copy the previous version of the RPS file to the <BASEDIR>/smarts/bin folder.


3 Type the following command:


sm_migraterps <rps_file> --trace <logfilename>


4 Copy the migrated RPS file into the < BASEDIR >/smarts/local/repos/icf folder.


5 Use the --ignore-restore-errors option in the sm_service command to start the IP Manager with the
migrated repository file. Otherwise, the IP Manager may generate errors and may not start up with the
migrated repository file.


6 Initiate a full discovery (Discover All). Consult the discovery guide or user guide for your product for
more information on this procedure.


Note   A full discovery is required for the new version features and changes to take effect.
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Deployment utility overview
The Deployment Utility allows you to deploy customizations and configuration changes from an existing
installation to another installation on the same version of a product. The deployment can be carried out on
the same host or between two different hosts running the same operating system.


The utility is useful if you have to apply the same configurations on multiple installations of a product. Use
the utility if you have:


n Multiple new installation running on the same or multiple hosts that will need to share the same
configuration and customizations.


n Multiple installations on the same or multiple hosts that are upgraded and will share the same
configuration and customizations.


In both cases, you will need to start with one installation where you make all your modifications to
configuration files, <BASEDIR>/smarts/local files and, create and compile dynamic models. Then, run
the sm_deploy utility to create a package that contains your modifications. Use the sm_deploy utility
to apply the files collected from the first installation to the rest of your installations.


The Deployment Utility performs the following three functions:


n Create a package


n Deploy the package


n Rollback


Create a package


The utility enables you to create a deployment package which consists of all the customizations made to
files in an installation. In SAM, by specifying a broker and server information when you run the utility, you
can collect configuration settings from RPS into the package.


Deploy the package


The utility enables you to deploy a previously collected deployment package into other installations of the
same product running on the same version and operating system as the original installation. If you have
collected configuration settings from SAM RPS, the configurations will be available in the file,
<SAM_server>.xml under local/conf/ics directory.
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Rollback


Before deploying the package into an installation, the utility creates a rollback directory containing the
backup copy of files from the current installation which will be used incase of a rollback action. You can
rollback your configuration to that in your rollback directory, only if the version of your current installation
is the same as the version of the installation when the rollback directory was created.


Note   Soft links created for product related files in the UNIX environment are not handled by sm_deploy
utility.


Running the Deployment utility
To run the Deployment utility, go to <BASEDIR>/smarts/bin directory and type the following command:


./sm_perl sm_deploy.pl <options>


where, <options> refers to the options specified in the section,sm_deploy modes of operation.To run the
utility from an older version of a Smarts product that does not have the migration utility, you must copy the
sm_deploy.pl script and certain Perl files (packaged in migratePerlPkg.zip file) and place them in the
appropriate locations. The sm_deploy.pl must be placed in the bin directory and the Perl package must be
placed under the BASEDIR/smarts/local folder and extracted there.


sm_deploy modes of operation
The sm_deploy has the following command-line options:


n --install=<dir> – To install the utility.


n --create=<file> – To create the deployment package.


n --deploy=<file> – To deploy the package.


n --rollback – To rollback the configuration changes.


n --broker – The broker to which the SAM server is attached. Use this option to collect configuration
settings from SAM RPS.


n --server – The SAM server whose configuration settings from RPS are to be collected.


n --clean – To clean the files in the local directory.


n --silent


n --sitemod – To specify customer specific local directories.


n --help


The deployment utility must be used with at least one of these options.


Note   If you want to run this utility from older versions of VMware Smart Assurance products, you
must copy the sm_migrate.pl script, sm_deploy.pl script and, the Perl files packaged in a .zip file from
the 10.0.0 installation to the corresponding locations in the old installation.
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To create a deployment package
1 Go to the <BASEDIR>/smarts/bin folder of your target installation, and type the following command:


./sm_perl sm_deploy.pl --install=<BASEDIR>/smarts --create=<archive-name.tar> --


sitemod==<BASEDIR>/smarts/local


2 The utility identifies the files with customizations from the local directory under <BASEDIR>/smarts
directory of the installation that need to be copied to the deployment package. Local directory can be
local1, local2.


3 The utility copies the files from the local directory to the deployment backup
directory .deploy.bkp<pdt>.<version> under <BASEDIR>/smarts, archives these files to a specified
archive file and then deletes the backup directory.


Manage RPS file settings across multiple installations
The method of extracting the configuration settings from an RPS file into the deployment package varies
between SAM and IP Managers.


For SAM, use the deployment utility to extract the configuration settings from the RPS file.


Go to the <BASEDIR>/smarts/bin folder of your target installation, and type the following command:


./sm_perl sm_deploy.pl --install=<BASEDIR>/smarts --create=<archive-name.tar> --broker=<host:port> --


server=<SAM_server>


This can be a convenient way to deploy the configurations of aggregate SAM domain since they often
share the same configuration.


For IP, use the sm_settings.pl script of the IP-Configuration Manager tool to export the Polling and
Threshold groups from an existing domain and import them into the IP-Configuration Manager to be
deployed further on other domains.


For more information on loading settings into IP-Configuration Manager, refer to the VMware Smart
Assurance Smarts IP Manager User Guide.


For Network Protocol Manager, MPLS Manager, and Server Manager, the configuration settings from an
RPS file must be manually configured in all other installations of these products.


To deploy the package
1 Go to the <BASEDIR>/smarts/bin folder of your target installation, and type the following command:


./sm_perl sm_deploy.pl --install=<TargetBASEDIR>/smarts --deploy=<archive-name.tar>


2 Creates a rollback directory with the backup of files from the target installation which will be used
incase of a rollback action. Rollback will contain local folders which are part of the deployment
package.


VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


VMware, Inc.  63







3 Copies all the files from the deployment package to the local directory of the target installation.


4 Overwrites the files that are part of both, the deployment package and the local directory of the target
installation.


5 If the --clean option is specified, the files in the local directory of the target installation that are not part
of the deployment package are deleted.


Or


If --clean option is not specified, the files in the local directory of the target installation that are not part
of the deployment package are retained.


To deploy the SAM RPS settings,


n Manually import the <SAM_server>.xml file from local/conf/ics directory to the directory in the
target installation by typing the following sm_config command:


./sm_config --server=<SAM_server> import --force <SAM_server>.xml


To Rollback
1 Go to the <BASEDIR>/smarts/bin folder of your target installation, and type the following command:


./sm_perl sm_deploy.pl --install=<TargetBASEDIR>/smarts --rollback


2 Copies the files from the local directory of the installation whose rollback directory you choose to
rollback to, into the corresponding location in your current installation.


Note   If your current directory is a rollback directory location, it will not be displayed in the list of
rollback directory locations to which you can rollback.
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Verifying the Installation 8
This chapter includes the following topics:


n Check the version number


n Start services


n Start programs


n Service and program startup options


n Start Smarts NOTIF


n Verify the product status


n Verify the FIPS 140 mode status


n Collect system information


n Configuration Scanner Tool


Check the version number
When you run a utility to report the version number of the software, you will see both the version number
for the product as well as the version number for the underlying foundation software. These two version
numbers might differ.


To verify the version number, enter the following command from the <BASEDIR>/smarts/bin directory:


         sm_server --version


      


This command should return the following information:


n Operating system (OS) name on which the product is running and the OS version identifier.


n Version number of the product.


n Version number of the foundation (DMT) code, foundation build number, the date and time that the
build was made as well as whether you have installed a 64-bit version of the software. If you installed
the 64-bit version, you will see a “/64” after the foundation and the product version number.
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The “sm_server --version” output is the following:


Operating System <Identifier>


<product>: V<Number>(<InternalBuild>), <Date> 


Copyright 2019, VMware Inc - Build <Build>


Foundation V<Number>(<InternalBuild>), <Date>


Copyright 1995-2018, VMware - Build <Build>


For example, for IP Manager, the output might look similar to:


linux_rhAS50-x86-64/206320000


IP_NETWORK_SUITE: V10.0.0.0(174350), 22-Jan-2019 02:00:03 Copyright 2019, VMware Inc - Build 4


Foundation V10.0.0.0(174262), 18-Jan-2019 10:24:40 Copyright 2019, VMware Inc - Build 1


The product version number is displayed during the Wizard mode installation on the InstallShield
screen.


Be aware that product versions vary and do not always match the software foundation version
number. For example, if you select the About from the Help menu in the Global Console, you may see
a different number.


Start services
VMware, Inc. recommends installing VMware Smart Assurance products as services. If you installed the
products as services, you must start them for the first time. These services start automatically upon
system reboot.


Note   Start the Broker service first if it is not running.


Starting services on UNIX
Verify the status of the service daemon before starting a service.


Verifying the status of the service daemon
Use the ic-serviced command to check the status of the service daemon. The path to the ic-serviced
command varies by operating system.


CentOS


On CentOS systems, enter the following command to verify the status of the service daemon:


         /etc/init.d/ic-serviced status
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If the sm_serviced process does not respond, the process is not running. Start the service by entering the
command:


         /etc/init.d/ic-serviced start


      


Linux


On Linux systems, enter the following command to verify the status of the service daemon:


         /etc/init.d/ic-serviced status


      


If the sm_serviced process does not respond, the process is not running. Start the service by entering the
command:


         /etc/init.d/ic-serviced start


      


Starting services
To start or stop an VMware Smart Assurance service, use the sm_service utility. Type the command from
the BASEDIR/smarts/bin directory:


         sm_service start


         <service_name> [<service_name> ...]


where <service_name> is each service you need to start. Starting services provides a list of service
names.


Start programs
You can start VMware Smart Assurance programs from the terminal when the program is not intended to
be long-running or to perform testing. VMware, Inc. does not recommend using this method in a
production environment.


The VMware Smart Assurance System Administration Guide provides a complete description of the
command syntax.


To start a program, type the command with the appropriate options on one line.


n For UNIX, invoke the command from the BASEDIR/smarts/bin directory. Prefix the command with ./ (a
period followed by a forward slash).


Starting the VMware Smart Assurance Broker


./brstart --port=426 --output
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Starting a Manager


t ./sm_server --name=<server_name>


--config=<config_directory>


--port=0


--ignore-restore-errors


--output s


For UNIX, to run the program in the background, use the daemon option.


Note   Service Assurance Manager Console crashes when running commands on a Linux platform since
the FIPS library fails to load. SELinux prevents the shared libraries, libcryptocme2.so and
libccme_base.so from loading because of the existence of text relocation in the library.


The following workarounds are available to avoid the SAM Console crash:


1 Run the following commands to change the file context for the shared libraries, libcryptocme2.so and
libccme_base.so to textrel_shlib_t:


chcon -t textrel_shlib_t libcryptocme2.so


chcon -t textrel_shlib_t libccme_base.so


2 Set the parameter setenforce to 0 to run SELinux in permissive mode.


3 Navigate to Edit /etc/selinux/config and set the parameter SELINUX to Disabled.


Service and program startup options
Default service names, server names, and configuration directories lists service names, server names,
and configuration directories for VMware Smart Assurance products.


Table 8‑1.  Default service names, server names, and configuration directories


Product Service name Server name Config directory


Broker ic-broker Not applicable Not applicable


IP Manager


IP Availability Manager ic-am-server INCHARGE-AM icf


IP Performance Manager ic-pm-server INCHARGE-PM icf


IP Availability and Performance Manager ic-am-pm-server INCHARGE-AM-PM icf


Service Assurance Manager


Service Assurance Manager Server ic-sam-server INCHARGE-SA ics


Service Assurance Manager Adapter
Platform Server


ic-icoi-server INCHARGE-OI icoi


SNMP Trap Adapter ic-trapd-receiver TRAP-INCHARGE-OI icoi


Syslog Adapter ic-syslog-adapter SYSLOG-INCHARGE-OI Not applicable
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Table 8‑1.  Default service names, server names, and configuration directories (Continued)


Product Service name Server name Config directory


Business Impact Manager MBIM INCHARGE-MBIM bim


MPLS Management Suite


MPLS Analysis Server ic-mpls-analysis INCHARGE-MPLS-ANALYSIS mpls-a


MPLS Monitoring Server ic-mpls-monitoring INCHARGE-MPLS-MONITORING mpls-m


MPLS Topology Server ic-mpls-topology INCHARGE-MPLS-TOPOLOGY mpls-t


MPLS VPN-Tagging Server ic-vpn-tagging VPN-TAGGING vpn-tagging


Server Manager


Server Manager ic-esm-server INCHARGE-ESM esm


Network Protocol Management Suite products


Network Protocol Manager for BGP ic-npm-bgp-server INCHARGE-BGP conf/bgp


Network Protocol Manager for EIGRP ic-npm-eigrp-server INCHARGE-EIGRP conf/eigrp


Network Protocol Manager for IS-IS ic-npm-isis-server INCHARGE-ISIS conf/isis


Network Protocol Manager for OSPF ic-npm-ospf-server INCHARGE-OSPF conf/ospf


n Chapter 11 Manually Installing Services provides the default service and program parameters that are
used for the service install commands.


n The VMware Smart Assurance System Administration Guide provides information in regard to the
sm_server, sm_adapter, and sm_trapd programs.


Start Smarts NOTIF
To start Smarts NOTIF:


1 Set an environment variable in the BASEDIR directory path to ensure that Java can be successfully
started for Smarts NOTIF. In BASEDIR/smarts/local/conf/runcmd_env.sh, add the following line:


SM_JAVA_ENABLED=YES


2 Configure the SNMP Trap Adapter to use the Notif-trap_mgr_parse.asl script instead of the default
trap_mgr_parse.asl script so that Smarts NOTIF processes SNMP traps. For example:


./sm_service install --force --unmanaged --startmode=runonce \


'--name=ic-notif-trap' \


'--description=Notif Trap Receiver' \


'/opt/InCharge/SAM/smarts/bin/sm_trapd' \


'--name=NOTIF-TRAP' \


'--server=INCHARGE-OI' \


'--output' \


'--config=icoi' \


'--port=1162' \


'--model=sm_actions' \


'--rules=icoi-trapd/Notif-trap_mgr_parse.asl'
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3 Configure the Syslog Adapter to use the Notif-SysLog_mgr.asl script instead of the default
SysLog_mgr.asl script in order for Smarts NOTIF to process Cisco system log files.


For example:


./sm_service install --force --unmanaged --startmode=runonce \


'--name=ic-notif-syslog' \


'--description=Notif Syslog Adapter' \


'/opt/InCharge/SAM/smarts/bin/sm_adapter' \


'--name=NOTIF-SYSLOG' \


'--server=INCHARGE-OI' \


'--output' \


'--config=icoi' \


'--port=1162' \


'--model=sm_actions' \


'--model=sm_system'\


'--rules=icoi-syslog/Notif-SysLog_mgr.asl'\


'--tail=/opt/InCharge/SAM/smarts/local/logs/sample.txt'


4 Launch the Smarts NOTIF Editor by selecting Start > Programs > InCharge > Smarts NOTIF
Editor.


Note   You can also launch the editor by double-clicking the NotifGui.sh file (for UNIX systems) in the
BASEDIR/smarts/notif/editor directory.


5 Use the Smarts NOTIF Editor to connect to the running SAM server or Adapter Platform server.
Select Remote > Edit a server's settings in the Smarts NOTIF Editor. The Connect to a Server
dialog box appears, showing the list of available Adapter Platform and SAM server connections.


6 Choose a server from the list of available server connections in the Connect to a Server dialog box
and click OK.


If server connections are not displayed, perform the following to populate the list of server
connections:


7 Click More in the Connect to a Server dialog box. The Manage Connections dialog box appears
where you can add server connections.


8 Click Add in the Manage Connections dialog box. The Input dialog box appears.


9 Enter a connection reference name (for example, “Remote Smarts NOTIF OI server”) in the Input
dialog box and click OK.


10 Fill in the new connection record in the right pane of the Manage Connections dialog box.


11 Click OK to save the connection setup.


The Remote Server Settings dialog box appears that shows the server's current settings.


12 Select the Activate Smarts NOTIF checkbox, and then click OK.


Note   You can also change other server settings in the Remote Server Settings dialog box if
necessary.
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13 Restart your SAM server or Adapter Platform server.


Note   Server setting changes made in the Smarts NOTIF Editor Remote Server Settings dialog box
are persistent. When you change server settings in the Remote Server Settings dialog box and click
OK, the changes are saved to the Notif_Settings.import file that is generated and saved to the
BASEDIR/smarts/local/conf/<icoi or ics> directory in the Adapter Platform or SAM server where
Smarts NOTIF is running. Server setting changes made in the Smarts NOTIF Editor are preserved
even if the repository is deleted. For example, if the repository is erased because you used the --
norestore option for server startup, the server uses the last saved settings from the Smarts NOTIF
Editor saved in BASEDIR/smarts/local/conf/<icoi or ics>/Notif_Settings.import.


The VMware Smart Assurance Notification Module User Guide includes information on how to use
the Smarts NOTIF Editor.


Verify the product status
You can determine the current state of the products that register with the Broker by typing the following
command from the BASEDIR/smarts/bin directory:


         ./brcontrol


      


This command displays a list of VMware Smart Assurance Managers and adapters that are registered
with the Broker, their states (RUNNING, DEAD, UNKNOWN), process IDs, port numbers, and the last
time that their states changed.


Also check any log files for the products. Typically, these log files are in BASEDIR/smarts/local/logs.


Note   More than one log file may be generated due to changes in the foundation code that supports
internationalization. The VMware Smart Assurance System Administration Guide provides additional
information on log files.


If only one log file per server is desired, use sm_edit to update the
BASEDIR/smarts/local/conf/runcmd_env.sh file. To get a single log file, set the following environment
variables:


export SM_LOCALE=en_US (or appropriate locale code)


export SM_ENCODING_OUTPUT=UTF-8


Verify the FIPS 140 mode status
To verify if the installation is running in FIPS-140 mode, run the following command in the dmctl mode:


get SM_System::SM-System::FIPS


The value for this parameter must be TRUE.
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You can also check for the status of FIPS 140 in the log files in the BASEDIR/smarts/local/logs directory.
When the Broker and server start in FIPS 140 mode, a message similar to the following one is written to
the Broker and server log files:


RSA BSAFE: MES 3.2.4 26-May-2012/64(0), FIPS: RSA BSAFE Crypto-C Micro Edition FIPS 140-2 Module 


3.0.0.0/64(0), May 31 2008 13:19:56


Common issues


Domain registers with the broker, but appears DEAD after a few minutes
The domain is in FIPS 140 mode but the broker is not.


Domain is not able to register with the broker


The Broker is in FIPS 140 mode but the domain is not.


Broker or Domain log entry


CI-N-EWHILE-While executing function "queue_work”CI-EFLOWID-For flow CI_FlowTCP_U [Flow in 


negotiations Accepted physical flow] PHYSICAL @0x0000000000a38db  . *:v4:44445 KS N/A, KR N/A  . Open 


fd=10, conn August 17, 2011 3:27:43 PM EDT, disc N/A,  . 127.0.0.1:44445 -> 127.0.0.1:58347, tmo 0 


00:00:15 N/S 1/0 CI-EWHILE-While executing function ""CI_FlowTLS_U::handshake”” CI-BSAFE-error:


1407609C:SSLroutines:SSL23_GET_CLIENT_HELLO:http request: ; in file "s23_srvr.c" at line 746


The entry might also appear as: SSL routines:SSL23_GET_CLIENT_HELLO:unknown protocol.


This may be because the Domain (or Broker) is in FIPS 140 mode but the client is not. It may also be that
the client is a non-Smarts client (for example a load balancer’s HTTP check). In that case, switch the load
balancer to HTTPS check.


Client error


CI-E-EWHILE-While executing function ""CI_FlowTLS_U::handshake””CI-BSAFE-error:1408F10B:SSL 


routines:SSL3_GET_RECORD:wrong version number: ; in file "s3_pkt.c" at line 553CI-TLSPE-TLS protocol 


error


This may be because the Domain or Broker is not FIPS 140 capable but the client is operating in FIPS
140 mode.
Log errors


[July 11, 2011 5:09:41 PM EDT +385ms] t@31 PollingQueue #8CI-E-EDECRYPT-Cannot decrypt.CI-EDECRYPT-


Cannot decrypt.[July 11, 2011 5:09:41 PM EDT +386ms] t@31 PollingQueue #8IA-E-ERROR_EXECUTING_ACTION-


Error executing action MA-PerlScript-sihou513a.CI-EDECRYPT-Cannot decrypt.


This may be because the Imk.dat version or the password does not match between domains. Ensure that
the password and the version matches across all installs that inter operate.
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Error on startup of domain or other tools


[August 8, 2011 8:29:07 PM EDT +466ms] t@3916876800 <Primary Thread>CI-F-EBLACKSTRING_CONTEXT-While 


creating the contextCRPT-CRYPTO_MD5_INIT_FAILED-Failed to initialize the context for MD5 algorithm


This may be because you are trying to use a v1 imk.dat file in FIPS 140 mode. Ensure that you use v2.1
for FIPS 140 compatibility.


Collect system information
The sm_getinfo utility is used to collect data for troubleshooting VMware Smart Assurance Manager
(server) problems. The utility backs up the current configuration for a server by creating a tar archive of all
files and user customizations that are essential to troubleshooting the server. Customers then email the
tar archive to VMware Customer Support for problem resolution.


sm_getinfo files
The sm_getinfo utility, which is supported on CentOS, and Linux, creates four types of files in the
installation directory area from which it is invoked. The files are shown described in Files created by the
sm_getinfo utility.


Table 8‑2.  Files created by the sm_getinfo utility


Filename Description


Files in BASEDIR/smarts/local/logs directory


sm_getinfo<date>.tar.gz


Example:sm_getinfo26Mar2012-015952.tar.gz


A compressed tar archive in which the sm_getinfo utility stores a server ‘s
log files, repository files, core files (CentOS, Linux) , user-modified files
(using sm_edit), user-introduced files, and system environment
information. The actual content of the tar archive depends on the user-
specified options on the sm_getinfo invocation command line.


The name of the tar archive includes the date when the tar archive was
created.


MANIFEST A text file that lists all of the files that the sm_getinfo utility includes in the
tar archive.


Files in BASEDIR/smarts/local/logs/smgetinfo_files directory
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Table 8‑2.  Files created by the sm_getinfo utility (Continued)


Filename Description


smgetinfo-versions.log.<date>


Example:smgetinfo-versions.log.
26Mar2012-020004


Example of other files in smgetinfo_files:TTP-
Installed-versions.log.26Mar2012-020005


A log file in which the sm_getinfo utility writes information about a server’s
log file or repository file that is larger than 700 megabytes (MB). The
sm_getinfo utility does not include any log or repository file in a server’s tar
archive that exceeds 700 MB.


In addition, sm_getinfo writes system information to the log file.


The name of the log file includes the date when the log file was created.


Final_sm_getinfo<timestamp>.tar


Example:Final_sm_getinfo20Sep2012-005855.tar


The -k or --smconfigscan command invokes the Configuration Scanner
tool, and generates the Final_getinfo-<timestamp>.tar, along with other
Configuration Scanner tool-related files.


Note   If the sm_getinfo utility is run without the -k or --smconfigscan
command, a getinfo-<timestamp>.tar output file will be generated without
Final_ appended to the output. This implies that you will be running the
sm_getinfo tool as usual.


sm_getinfo command-line syntax
You run the sm_getinfo utility from the BASEDIR/smarts/bin directory. The options that you specify on the
invocation command line determine which files are included in the sm_getinfo-created tar archive.


Here is the command line syntax for sm_getinfo:


sm_perl sm_getinfo.pl


| --server <server name> --pid <server process ID>


| --broker <location>


| --log [<number of latest logs>]


| --nolog


| --repos [--latest]


| --norps


| --core


| --all


| --version


| --help


| --smmonitor “<sm_monitor options>”


| --flush


| --smconfigscan


where:


n <> Angle brackets are user-supplied parameter values (variables).


n [ ] Square brackets are optional entries.


n | Vertical bar symbols are alternate selections.


The command-line options are described in Command-line options for the sm_getinfo utility .
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Table 8‑3.  Command-line options for the sm_getinfo utility


Option Description


--server <server name> --pid <server process
ID> | -s <server name> -p <server process ID>


Specifies the VMware Smart Assurance server name and PID against which
the sm_getinfo utility will collect information. To dump a core file for a running
server on CentOS or Linux, the pid option must be provided. Also, the server
name is used to invoke the sm_monitor tool.


--broker <location> | -b <location> Specifies an alternate broker location as host:port.


--pid <pid> | -p <pid> PID of Domain Manager used to run gcore.


--log [<number of latest logs>] | -l [<number of
latest logs>]


For each VMware Smart Assurance server, collects and stores a user-
specified number of latest logs or all generated log files that are in the
BASEDIR/smarts/local/logs directory.


Note that whenever collecting a log, the related .audit and .archive files should
be collected as well.


If a server name is specified, only the files that correspond to the server will be
collected. To avoid generating a too-large tar archive (too large to email), any
log file that is larger than 700 MB will be excluded and its information will be
logged in smgetinfo-versions.log<date>.


--nolog | -g Excludes log files when collecting local files. This option and --log are mutually
exclusive.


--repos [--latest] | -r [-t] For each VMware Smart Assurance server, collects and stores the latest
repository file or all repository files. If a server name is specified, only the file
corresponding to the server will be collected. Any repository file that is larger
than 700 MB will be excluded and its information will be logged in smgetinfo-
versions.log<date>.


--norps | -n Excludes repository files when collecting local files. This option and --repos
are mutually exclusive.


--core | -c Collects and stores the core files (CentOS, Linux) that are generated by the
VMware Smart Assurance software, and the corresponding logs.


--all | -a All data and files in BASEDIR/smarts/local and BASEDIR/smarts/setup
directories will be collected and stored. If --all option is specified, the other
options will be ignored except --server and --pid.


--version | -v Print version information and exit.


--help | -h Print usage information and exit.


--smmonitor “<sm_monitor options>” | -m
“<sm_monitor options>”


Specifies the options for running sm_monitor, which will override the default
options “-m run-all -z.”


Approximately two cycles are run to collect the required information. The
collected information is output to the BASEDIR/smarts/local/logs/SM-Monitor-
<server name> directory.


--flush | -f Force a flush. Needed when the sm_getinfo utility is invoked from a remote
host.


--smconfigscan | -k


Note   This option is available for IP Manager
only.


Invokes the configuration scanner tool to provide a snapshot of all the
customizations introduced by you in your current installation. “Configuration
Scanner Tool” on page 116 provides more information on how to use the tool.


VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


VMware, Inc.  75







sm_getinfo invocation examples
To gather the five latest logs, enter:


         sm_perl sm_getinfo.pl  --logs 5


      


To gather the latest repository data and core files, enter:


         sm_perl sm_getinfo.pl  --repos --latest --core


      


To gather the entire BASEDIR/smarts/local directory, enter:


         sm_perl sm_getinfo.pl  --all


      


To invoke sm_monitor, enter:


On Linux:


         sm_perl sm_getinfo.pl -s 


         <server name>


         -m “-m correlation -z”


         sm_perl sm_getinfo.pl -s 


         <server name>


           -m “-m mem”


      


sm_getinfo data collection
If no command-line option is specified, the sm_getinfo utility will store the following information in the tar
archive:


n For each server, the latest server log file in BASEDIR/smarts/local/logs and the related .audit
and .archive files in BASEDIR/smarts/local/logs. If a server name is specified, only the files that
correspond to the server will be collected. To avoid generating a too-large tar archive (too large to
email), any log file that is larger than 700 MB will be excluded and its information will be logged in
smgetinfo-versions.log<date>.


n For each server, the latest repository file in BASEDIR/smarts/local/repos. If a server name is
specified, only the repository file for the server will be archived. Any repository file that is larger than
700 MB will be excluded and its information will be logged in smgetinfo-versions.log<date>.


n The local files that are not in the BASEDIR/smarts/local/logs and repos directories and changed since
last temporary test patch (TTP) and patch.


n The new local files that are not in the BASEDIR/smarts/local/logs and repos directories and were
added since the last TTP and patch.
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n All local files except the files in logs and repos directories if no TTP or patch is installed.


n All files in the BASEDIR/smarts/setup/info and BASEDIR/smarts/setup/logs directories.


n Core files (UNIX) that are generated by the VMware Smart Assurance software, and the
corresponding server log files. On Linux, some library (lib) files that are related to the cores are also
collected.


n VMware Smart Assurance TTP or patch version information. Additionally, it verifies MD5 checksum
for the installed TTP files and the files that are listed in manifest.md5 in the
BASEDIR/smarts/setup/info directory.


n The data collected by sm_monitor. If a server name is specified, only the files that correspond to the
server will be collected.


n The data generated by the VMware Smart Assurance Health Monitor (SHM).


n System environment information.


Configuration Scanner Tool
Note   This tool is available only for IP Manager.


The Configuration Scanner tool scans for configuration changes in your current installation. It scans for
customizations with regard to the following:


n Polling and threshold settings: The tool presents the non-default values and settings. That is, the
tool generates a list of polling settings and threshold parameters that have changed from their default
values, along with details of all the groups they are associated with. The output also includes tagging
settings. In case of CLI settings, the tool collects and displays the username and the associated
matching criteria.


n Configuration files: The tool generates a list of files that have changed from the default installation.
The tool scans the files in the SM_SITEMOD and base installation and does a two-way difference
analysis to figure out what files have changed, and displays the list of files, flagged appropriately as
modified or added. For discovery.conf, name-resolver.conf and tpmgr-param.conf files, the tool
parses through the content and presents the difference at an attribute->value pair level.


Note   The clientConnect.conf, serverConnect.conf, brokerConnect.conf, .imk.dat files and the l10n
classes and Perl directories are excluded from the scan.


The tool ignores service pack and patch files that are not modified by you.
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Running the Configuration Scanner tool from the sm_getinfo
utility
To run the Configuration Scanner tool:


1 Go to the <BASEDIR>/smarts/bin folder.


In this document, the term BASEDIR represents the location where VMware Smart Assurance
software is installed. For example:


For UNIX, this location is: /opt/InCharge/<product>.


On UNIX operating systems, IP Availability Manager is, by default, installed
to: /opt/InCharge/IP/smarts. Optionally, you can specify the root of BASEDIR to be something
different, but you cannot change the <product> location under the root directory.


2 Type the following command:


               sm_perl sm_getinfo <options> -k (or --smconfigscan)


sm_perl sm_getinfo --broker=localhost:5086 --server=INCHARGE-AM --smconfigscan


or


sm_perl sm_getinfo -b localhost:5086 -s pserver --smconfigscan


VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


VMware, Inc.  78







Performing an Uninstallation 9
This chapter includes the following topics:
n Before uninstallation


n Uninstall VMware Smart Assurance products


Before uninstallation
You should complete the following tasks before uninstalling the product:


n Remove manually installed services


n Determine order for removing products (UNIX only)


n Detect and stop programs


Remove manually installed services
Services that you manually installed with sm_service command are not removed by the uninstallation
program. You must remove these services manually before uninstalling the product software.


To remove a service, invoke sm_service from the BASEDIR/smarts/bin directory:


1 Use sm_service to list installed services.


               sm_service show


            


2 Remove the manually installed service.


               sm_service remove ic-


               <service name>


            


VMware, Inc.  79







Determine order for removing products (UNIX only)
When uninstalling VMware Smart Assurance products from the same server, the product that was
installed first must be uninstalled last. During the installation of the first product, the
VMware Smart Assurance Service Database is created and the other products subsequently access it.
Uninstalling the product installed first will also uninstall the Service Database that will disable the
sm_service command for those products, prevent their proper operation and uninstallation.


You can determine what product software was installed first by performing this check:


1 Use a text editor to open the ic-serviced script.


n For CentOS, ic-serviced is located in the /etc/init.d directory


n For Linux, ic-serviced is located in the /etc/init.d directory


2 Find the value of the SMHOME variable.


The value of SMHOME indicates which product was installed first.


Detect and stop programs
Before upgrading or uninstalling your product, you must stop all VMware Smart Assurance services,
VMware Smart Assurance scheduledjobs, and any other process that uses programs or libraries running
from the VMware Smart Assurance product.


Detecting programs
The sm_plist utility identifies all VMware Smart Assurance programs that are running for any product on
your machine. You can use the sm_plist utility whenever you need to identify VMware Smart Assurance
programs that are running (for example, before applying a service pack or patch and uninstalling the
product software).


To use the utility, invoke itfrom the BASEDIR/smarts/script directory. The utility displays active programs
in a window:


1 Go to the BASEDIR/smarts/script directory.


2 Start the sm_plist utility:


On UNIX, enter


               ./sm_plist.sh


               <BASEDIR2>


               cscript sm_plist.vbs


               <BASEDIR2>
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Stopping active programs (UNIX)
To stop active VMware Smart Assurance programs (UNIX):


1 Stop active VMware Smart Assurance services using the sm_service utility from
BASEDIR/smarts/bin:


               ./sm_service stop --all


            


2 Determine if any VMware Smart Assurance services are still running by using the brcontrol utility from
BASEDIR/smarts/bin:


               ./brcontrol -b


               <host>:<port>


            


Table 9‑1.  Next steps for detecting and stopping programs


The Broker is on the . . . And this displays . . . Do this . . .


Same host “Error attaching to Broker”
message


The Broker is not running. Go to step 4 .


List of servers registered
with the Broker


n The Broker or service daemon did not shut down.
n If any servers are still running on the host, these did not


shut down.


Go to step 3 .


Different host List of servers registered
with the Broker


n If any servers are still running on the host where you will
install the VMware Smart Assurance software, these did
not shut down. Go to step 3 .


1 Stop any VMware Smart Assurance server that is still running. If the Broker is on the host, stop the
local Broker:


n To stop any server that is still running, use the dmquit utility from BASEDIR/smarts/bin:


                     ./dmquit --server=<server name>


                      -b 


                     <host>:<port>


                     ./brquit --broker=localhost:


                     <port>
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2 Determine if any other VMware Smart Assurance processes are still running and shut the processes
down:


n Detect the processes using the following command:


                     ps -ef | grep “sm_”


                     kill


                     <pid>


                  


Uninstall VMware Smart Assurance products
VMware Smart Assurance product software uses the InstallShield program to install and uninstall
products. For UNIX, you invoke the uninstallation program from the system prompt. Failure to use the
appropriate method will result in an unstable system and/or inconsistent product directories.


Note   Do not manually delete the installed product directories. Before uninstallation, you must stop all the
Smarts services.


Also, if you plan to reinstall the product, save all of the customized files that are in the
BASEDIR/smarts/local directory before performing the uninstallation. The uninstallation program will
remove all of the files and directories in the BASEDIR/smarts directory, and then remove the smarts
directory.


Uninstall using CLI mode
To uninstall an VMware Smart Assurance product or product:


1 Go to the BASEDIR/_uninst directory and enter the following command:


               ./uninstaller


            


During the uninstallation processes, you are prompted with a series of steps and menus. You can
either accept the default value or select another choice. The default values are indicated in brackets
or as predefined selections (checkmarks) in menus. To accept the default value, press Enter.


When replying to a prompt, you can either accept the default value or select another choice.


To reply yes, enter Y


To reply no, enter N.


Do not press Delete; doing so will cause the process to terminate with an error message. For
selections in menus, you can accept default selections or type the number of the item and press
Enter.


If you incorrectly type an entry, type back to repeat the prompt and select the correct value. Arrow
keys and the backspace key are not supported.


2 Press Enter to continue.
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3 Upon completion, the uninstallation program will remove all of the files and directories in the
BASEDIR/smarts directory, and then remove the smarts directory.


The uninstallation program will also write an uninstall log file to the BASEDIR directory, unless the
uninstallation fails at the very start, in which case the installation program will write the log file to
the /tmp directory. The log file is a text file with the naming convention
Uninstall.<product>.<productversionNumber>.log.


Uninstall using Unattended mode
The Unattended mode enables you to automate the removal of the VMware Smart Assurance products.


1 Invoke the uninstallation program with appropriate options for the operating system:


2 On UNIX systems, go to the BASEDIR/_uninst directory and enter the following command:


                     uninstaller -i silent 


                     


                  


3 Upon completion, the uninstallation program will remove all of the files and directories in the
BASEDIR/smarts directory, and then remove the smarts directory.


The uninstallation program will also write an uninstall log file to the BASEDIR directory, unless the
uninstallation fails at the very start, in which case the installation program will write the log file to
the /tmp directory. A non-zero status indicates a failure. The log file is a text file with the naming
convention Uninstall.<product>.<productversionNumber>.log.
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The sm_edit utility 10
This chapter includes the following topics:
n sm_edit


n sm_edit example


sm_edit
As part of the VMware Smart Assurance deployment and configuration process, you need to modify
certain files. User modifiable files include configuration files, rule set files, templates, and seed files that
contain encrypted passwords. Original versions of these files are installed into appropriate subdirectories
under the BASEDIR/smarts/ directory.


The original versions of files should not be altered. If a file must be modified, a new version should be
created and then stored as a local copy of the file in BASEDIR/smarts/local or one of its subdirectories.


When VMware Smart Assurance software requires one of these files, it is designed to first search for a
modified file in BASEDIR/smarts/local or one of its subdirectories. If a modified version of a file is not
found in the local area, VMware Smart Assurance software then searches corresponding
BASEDIR/smarts directories for the original version of the file.


To ease file editing and storage, VMware, Inc. provides the sm_edit utility with the every
VMware Smart Assurance product. When invoked, sm_edit opens the specified file in a text editor. This
utility ensures that modified files are always saved to the appropriate local area and that non-local copies
of all files remain unchanged. If an appropriate subdirectory does not exist for the file you are modifying,
sm_edit creates the appropriate subdirectory before saving the modified file to that location. For files with
header information set for encryption, sm_edit encrypts certain fields in the file. In addition, sm_edit
preserves the file permissions of modified files, which helps ensure that important configuration files are
not altered by unauthorized users.


The VMware Smart Assurance System Administration Guide provides instructions on how to configure
the utility to use a specific editor.
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sm_edit example
To use sm_edit from the command line, specify the file name and include the subdirectory under
BASEDIR/smarts/local where the file resides. For example, to edit the trapd.conf, enter the following
command from the BASEDIR/smarts/bin directory:


         sm_edit conf/trapd/trapd.conf


      


In this example, sm_edit searches in the BASEDIR/smarts/local/conf/trapd directory for the trapd.conf file.
If it finds the trapd.conf file, it opens the file in a text editor. If sm_edit does not find the trapd.conf file in
the BASEDIR/smarts/local/conf/trapd directory, it creates a local copy of the trapd.conf file and writes it to
the BASEDIR/smarts/local/conf/trapd directory.


The VMware Smart Assurance System Administration Guide provides additional information about the
sm_edit utility.
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Manually Installing Services 11
This chapter includes the following topics:
n Overview


n Broker services


n Services for the IP Manager


n Services for the Service Assurance Manager


n Services for the MPLS Management Suite


n Services for the Server Manager


n Services for the Network Protocol Management Suite installation


Overview
If you did not install services when you installed the VMware Smart Assurance products, you may install
services manually. Services are programs that, once started, are generally intended to run continuously.
Components installed as services start automatically upon system reboot; those not installed as services
(manual processes or disabled processes) require that you issue commands to start and stop them as
necessary.


VMware, Inc. recommends that VMware Smart Assurance products be installed as services whenever
possible. Typical reasons to install products as services include the following conditions:


n (IP Manager only) There is a need to install services for a single product instead of the combined
IP Availability Manager and IP Performance Manager products (for example, IP Availability Manager
alone or IP Performance Manager alone). Selection of bootstrap files when installing services
provides more information.


n During installation of the product software, you chose to start product components manually and now
want to run the components as services.
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n Multiple instances of a single product component running as a service are required. During
installation, you can install only a single instance of a product component as a service.


To manually install a product as a service, use the sm_service installcommand with the appropriate
set of options.


The VMware Smart Assurance System Administration Guide provides a complete description of the
command syntax.


Selection of bootstrap files when installing services
When you install IP Manager 10.0.0 with all services selected, both IP Availability Manager and
IP Performance Manager services are installed. The default configuration file, bootstrap.conf, is used by
the IP Manager 10.0.0 installer.


If your deployment supports only IP Availability Manager or IP Performance Manager, you must manually
install these services for the IP Manager(s) using a bootstrap file different from bootstrap.conf.


Broker services
This section provides the default UNIX commands that are used to install the service manually for the
Broker. Type the command on one line.


UNIX


t BASEDIR/smarts/bin/sm_service install 


--force


--name=ic-broker


“--description= VMware Smart Assurance


         Broker”


--env=SM_CLIENTCONNECT=brokerConnect.conf


--startmode=runonce


BASEDIR/smarts/bin/brstart


--port=426


--output


--restore=BASEDIR/smarts/local/repos/ broker/broker.rps s


Services for the IP Manager
Here are the UNIX commands used to install services manually for the underlying servers in the
IP Manager.


IP Availability Manager -only server
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UNIX


t /opt/InCharge/IP/smarts/bin/sm_service install


--force


--name=ic-am-server


“--description= VMware Smart Assurance IP Availability Manager Server”


--startmode=runonce


/opt/InCharge/IP/smarts/bin/sm_server


--name=INCHARGE-AM


--config=icf


--bootstrap=bootstrap-am.conf


--port=0


--subscribe=default


--ignore-restore-errors


--outputs


IP Performance Manager -only Server


UNIX


t /opt/InCharge/IP/smarts/bin/sm_service install


--force


--name=ic-pm-server


“--description= VMware Smart Assurance IP Performance Manager Server”


--startmode=runonce


/opt/InCharge/IP/smarts/bin/sm_server


--name=INCHARGE-PM


--config=icf


--bootstrap=bootstrap-pm.conf


--port=0


--subscribe=default


--ignore-restore-errors


--outputs


IP Availability and Performance Manager Server


UNIX


t /opt/InCharge/IP/smarts/bin/sm_service install 


--force 


--name=ic-am-pm-server


“--description= VMware Smart Assurance IP Availability Manager and Performance Manager Server” 


--startmode=runonce 


/opt/InCharge/IP/smarts/bin/sm_server 


--name=INCHARGE-AM-PM 


--config=icf


--bootstrap=bootstrap-am-pm.conf 
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--port=0 


--subscribe=default 


--ignore-restore-errors 


--outputs


IP Configuration Manager


UNIX


/opt/InCharge/IP/smarts/bin/sm_service install


--force


--name=ic-ip-configuration


"--description=VMware Smarts IP Configuration Manager"


--startmode=runonce


/opt/InCharge/IP/smarts/bin/sm_server


--name=INCHARGE-CM


--config=icf-c


--bootstrap=bootstrap.conf


--port=0


--subscribe=default


--ignore-restore-errors


--nodx


--output


Services for the Service Assurance Manager
This section provides default service parameters for the
VMware Smart Assurance Service Assurance Manager.


VMware Smart Assurance Broker


UNIX


t/opt/InCharge/SAM/smarts/bin/sm_service install


 --force


 --startmode=runonce


 --name=ic-broker


 --description="VMware Smarts Broker"


 --env=SM_CLIENTCONNECT=brokerConnect.conf


/opt/InCharge/SAM/smarts/bin/brstart


--port=426


 --restore=/opt/InCharge/SAM/smarts/local/repos/broker/broker.rps


 --outputs


Service Assurance Manager (Presentation SAM server)
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UNIX


/opt/InCharge/SAM/smarts/bin/sm_service install 


--force  


--unmanaged  


--startmode=runonce 


--name=ic-sam-server-pres


--description=”VMware Smarts Service Assurance Manager Server (notification cache publishing)” 


/opt/InCharge/SAM/smarts/bin/sm_server 


-n INCHARGE-SA-PRES


--config=ics


--port=0


--edaa=sam-presentation/2.0


--bootstrap=bootstrap-amqp.conf


--ignore-restore-errors


--output


Service Assurance Manager ( Global Manager )


UNIX


t/opt/InCharge/SAM/smarts/bin/sm_service install


 --force


 --unmanaged


 --name=ic-sam-server


 --startmode=runonce 


 --description="VMware Smarts Service Assurance Manager


  Server"


 /opt/InCharge/SAM/smarts/bin/sm_server


 --name=INCHARGE-SA


 --config=ics


 --port=0


 --ignore-restore-errors


 --outputs


Business Impact Manager server


UNIX


t/opt/InCharge/SAM/smarts/bin/sm_service install 


--startmode=runonce


--name=MBIM


--description=”VMware Smarts MBIM – Maintenance and Business Impact Manager Server”


/opt/InCharge/SAM/smarts/bin/sm_server


--name=INCHARGE-MBIM
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--config=bim


--port=0


--ignore-restore-errors


--outputs


Adapter Platform


UNIX


t /opt/InCharge/SAM/smarts/bin/sm_service install


 --force


 --unmanaged


 --name=ic-icoi-server


 --startmode=runonce 


 --description="VMware Smarts SAM Adapter Platform Server"


 /opt/InCharge/SAM/smarts/bin/sm_server


 --name=INCHARGE-OI


 --config=icoi


 --port=0


 --ignore-restore-errors


 --outputs


Business Dashboard


UNIX


t/opt/InCharge/CONSOLE/smarts/bin/sm_service install


 --force


 --unmanaged


 --name=ic-business-dashboard


 --startmode=runonce 


 --description="VMware Smarts Servlet Engine"


 /opt/InCharge/CONSOLE/smarts/bin/sm_tomcat


 --output


 starts


Syslog Adapter
Before you configure the Syslog Adapter, identify the location of the SYSFILE you want the adapter to tail
and parse and ensure that sm_service install command line for the ic-syslog-adapter identifies this
location. The VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide
provides more information on configuring the Syslog Adapter.
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UNIX


t /opt/InCharge/SAM/smarts/bin/sm_service install 


 --force


 --unmanaged


 --name=ic-syslog-adapter


 --startmode=runonce


 --description="VMware Smarts Syslog Adapter"


 /opt/InCharge/SAM/smarts/bin/sm_adapter


 --name=SYSLOG-INCHARGE-OI


 --rserver=INCHARGE-OI


 --tail=/var/log/syslog


 --model=sm_system


 --model=sm_actions


 --output icoi-syslog/syslog_mgr.asls


SNMP Trap Adapter


UNIX


t /opt/InCharge/SAM/smarts/bin/sm_service install


 --force


 --unmanaged


 --name=ic-trapd-receiver


 --startmode=runonce 


 --description="VMware Smarts SNMP Trap Adapter"


 /opt/InCharge/SAM/smarts/bin/sm_trapd


 --name=TRAP-INCHARGE-OI


 --server=INCHARGE-OI


 --config=icoi


 --port=162


 --seed=seedfile


 --model=sm_actions


 --output


 --rules=icoi-trapd/trap_mgr_parse.asls


Notif trap Adapter


UNIX


t /opt/InCharge/SAM/smarts/bin/sm_service install --force -unmanaged


--startmode=runonce


--name=ic-notif-trapd-receiver


--description="VMware Smarts NOTIF SNMP Trap Adapter"


/opt/InCharge/SAM/smarts/bin/sm_trapd


--name=NOTIF-TRAP-INCHARGE-OI


--server=INCHARGE-OI


--config=icoi


--port=162
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--model=sm_actions


--rules=icoi-trapd/Notif-trap_mgr_parse.asl


--seed=seedfile


--outputs


Notif syslog adapter


UNIX


t /opt/InCharge/SAM/smarts/bin/sm_service install --force --unmanaged 


--startmode=runonce


--name=ic-notif-syslog-adapter


--description="VMware Smarts Syslog Adapter"


/opt/InCharge/SAM/smarts/bin/sm_adapter


--name=NOTIF-SYSLOG-INCHARGE-OI


--rserver=INCHARGE-OI


--tail=/var/log/syslog


--model=sm_system


--model=sm_actions


--output icoi-syslog/Notif-SysLog_mgr.asls


Smarts Data Web Applications (Tomcat)


UNIX


/opt/InCharge/SAM/smarts/bin/sm_service install --force  --unmanaged  --startmode=runonce 


--name=smarts-tomcat 


--description=”VMware Smarts Data Web Applications (Tomcat)”


/opt/InCharge/SAM/smarts/bin/sm_tomcat 


--ignoreme


Smarts Notification Exchange (Rabbit MQ)


UNIX


/opt/InCharge/SAM/smarts/bin/sm_service install --force  


--unmanaged  --startmode=runonce


--name=smarts-rabbitmq


--description=”VMware Smarts Notification Exchange (Rabbit MQ)” 


/opt/InCharge/SAM/smarts/bin/sm_rabbitmq


--ignoreme


Smarts Notification Cache (ElasticSearch)
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UNIX


/opt/InCharge/SAM/smarts/bin/sm_service install --force  


--unmanaged  --startmode=runonce 


--name=smarts-elasticsearch 


--description=”VMware Smarts Notification Cache (ElasticSearch)” 


/opt/InCharge/SAM/smarts/bin/sm_elasticsearch 


--ignoreme


Services for the MPLS Management Suite
This section provides the default UNIX commands that are used to install services manually for the
MPLS Management Suite. Type the command on one line.


For the MPLS Management Suite, when you install the services manually, if you specify custom service
and server names instead of the default names listed in Services for the MPLS Manager, you must run a
script next. Running the script is required so that proper domain communication can be established. 
Chapter 13 Using the MPLS server_config Utility provides information about the script.


MPLS Topology Server
When you start the MPLS Manager for the first time (and only the first time) after migrating from the
previous version to the new version, you must start the MPLS Topology Server with the --ignore-restore-
errors option.


UNIX


t /opt/InCharge/MPLS/smarts/bin/sm_service install 


--force 


--unmanaged 


--startmode=runonce 


--name=ic-mpls-topology 


--description=”VMware Smart Assurance


         MPLS Topology Server” 


/opt/InCharge/MPLS/smarts/bin/sm_server 


--name=INCHARGE-MPLS-TOPOLOGY 


--config=mpls-t 


--ignore-restore-errors 


--outputs


MPLS Monitoring Server
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UNIX


t/opt/InCharge/MPLS/smarts/bin/sm_service install 


--force 


--unmanaged 


--startmode=runonce 


--name=ic-mpls-monitoring 


--description=”VMware Smart Assurance


         MPLS Monitoring Server” 


/opt/InCharge/MPLS/smarts/bin/sm_server 


--name=INCHARGE-MPLS-MONITORING 


--config=mpls-m 


--ignore-restore-errors 


--outputs


MPLS Analysis Server


UNIX


t /opt/InCharge/MPLS/smarts/bin/sm_service install 


--force 


--unmanaged 


--startmode=runonce 


--name=ic-mpls-analysis 


--description=”VMware Smart Assurance


         MPLS Analysis Server” 


/opt/InCharge/MPLS/smarts/bin/sm_server 


--name=INCHARGE-MPLS-ANALYSIS 


--config=mpls-a 


--ignore-restore-errors 


--outputs


MPLS VPN-Tagging Server


UNIX


t /opt/InCharge/MPLS/smarts/bin/sm_service install 


--force 


--unmanaged 


--startmode=runonce 


--name=ic-vpn-tagging 


--description=”VMware Smart Assurance


         MPLS VPN-Tagging Server” 


/opt/InCharge/MPLS/smarts/bin/sm_server 


--name=VPN-TAGGING 


--config=vpn-tagging 


--ignore-restore-errors 


--outputs
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Services for the Server Manager
This section provides the default UNIX commands that are used to install the service manually for the
VMware Smart Assurance Server Manager. Type the command on one line.


Server Manager


UNIX


t opt/InCharge/ESM/smarts/bin/sm_service install 


 --force  


 --unmanaged


 --name=ic-esm-server 


 --description=”VMware Smarts Server Manager (ESM)” 


 --startmode=runonce 


 opt/InCharge/ESM/smarts/bin/sm_server 


 --name=INCHARGE-ESM 


 --config=esm 


 --subscribe=default 


 --output 


--ignore-restore-errorss


Services for the Network Protocol Management Suite
installation
This section provides the default UNIX commands that are used to install services manually for the
Network Protocol Management Suite. Type the command on one line.


Network Protocol Manager for BGP


UNIX (IPv6 and IPv4 mode)


/opt/InCharge/NPM/smarts/bin/sm_service install


--force


--name=ic-npm-bgp-server


--description=”VMware Smarts NPM for BGP Server” 


--startmode=runonce


/opt/InCharge/NPM/smarts/bin/sm_server


--name=INCHARGE-BGP


--config=bgp


--port=0


--subscribe=default


--output
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UNIX (IPv4 mode only)


/opt/InCharge/NPM/smarts/bin/sm_service install


--force


--name=ic-npm-bgp-server


--description=”VMware Smarts NPM for BGP Server”


--startmode=runonce 


/opt/InCharge/NPM/smarts/bin/sm_server


--name=INCHARGE-BGP


--config=bgp


--port=0


--bootstrap=bootstrap-ipv4.conf


--subscribe=default


--output


Network Protocol Manager for EIGRP


UNIX


/opt/InCharge/NPM/smarts/bin/sm_service install 


--force 


--name=ic-npm-eigrp-server 


--description=”VMware Smarts NPM for EIGRP Server” 


--startmode=runonce 


/opt/InCharge/NPM/smarts/bin/sm_server 


--name=INCHARGE-EIGRP 


--config=eigrp 


--port=0 


--subscribe=default 


--ignore-restore-errors 


--output


Network Protocol Manager for IS-IS


UNIX (IPv6 and IPv4 mode)


/opt/InCharge/NPM/smarts/bin/sm_service install


--force


--name=ic-npm-isis-server


--description=”VMware Smarts NPM for ISIS Server”


--startmode=runonce 


/opt/InCharge/NPM/smarts/bin/sm_server


--name=INCHARGE-ISIS


--config=isis


--port=0


--subscribe=default


--output
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UNIX (IPv4 mode only)


/opt/InCharge/NPM/smarts/bin/sm_service install


--force


--name=ic-npm-isis-server


--description=”VMware Smarts NPM for ISIS Server”


--startmode=runonce 


/opt/InCharge/NPM/smarts/bin/sm_server


--name=INCHARGE-ISIS


--config=isis


--port=0


--bootstrap=bootstrap-ipv4.conf


--subscribe=default


--output


Network Protocol Manager for OSPF


UNIX (IPv6 and IPv4 mode)


/opt/InCharge/NPM/smarts/bin/sm_service install


--force


--name=ic-npm-ospf-server


--description=”VMware Smarts NPM for OSPF Server”


--startmode=runonce 


/opt/InCharge/NPM/smarts/bin/sm_server


--name=INCHARGE-OSPF


--config=ospf


--port=0


--subscribe=default


--output


UNIX (IPv4 mode only)


/opt/InCharge/NPM/smarts/bin/sm_service install


--force


--name=ic-npm-OSPF-server


--description=”VMware Smarts NPM for OSPF Server”


--startmode=runonce 


/opt/InCharge/NPM/smarts/bin/sm_server


--name=INCHARGE-OSPF


--config=ospf


--port=0


--bootstrap=bootstrap-ipv4.conf


--subscribe=default


--output
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Procedures for CD/DVD-ROMs 12
Mounting a CD/DVD-ROM on UNIX systems
Use the following procedure to find the instructions appropriate for your operating system:


1 Insert the CD/DVD-ROM into the optical drive.


2 If the CD/DVD-ROM is automatically mounted, continue to step 3 . Otherwise, select the appropriate
mount command as shown in Mounting the CD/DVD-ROM for UNIX operating systems.


Table 12‑1.  Mounting the CD/DVD-ROM for UNIX operating systems


Operating system Commands and examples


CentOS
# mount -o ro -F hsfs <device> /mnt


Example:


# mount -o ro -F hsfs /dev/dsk/c0t6d0s0 /mnt


HP-UX
mount -ocdcase -o ro -F cdfs <
                        DEVICE
                        > /mnt/cdrom


mount -ocdcase -o ro -F cdfs /dev/cdrom /mnt/cdrom


Linux
# mount <device>
                     


Example:


# mount /dev/cdrom /mnt/cdrom


where <device> is the mount point for the optical drive.


1 Change to the CD/DVD-ROM directory by typing the appropriate command from Changing to the
CD/DVD-ROM directory in UNIX operating systems.
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Table 12‑2.  Changing to the CD/DVD-ROM directory in UNIX operating systems


Operating system Command


CentOS If Volume Manager (VM) is running:


# cd /cdrom/<os>/<product>_SUITE/suite


If VM is not running:


# cd /mnt/suite


HP-UX
# cd /mnt/cdrom/suite


Linux If Automount is running:


# cd /cdrom/<os>/<product>_SUITE/suite


If Automount is not running:


# cd /mnt/cdrom/suite


where: <os> is the operating system, for example, CentOS_64, linux_64, or winnt_64.


<product> is the product software, for example, IP or MPLS.
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Using the MPLS server_config
Utility 13
Use the server_config.pl script to change domain names


Purpose
When installed and unless the default domain name is changed during installation, MPLS Manager is
configured with the default domain group name of INCHARGE-MPLS.


From this default domain group name, the three MPLS Manager server names are constructed by
appending the function specific suffix to the default domain group name:


n INCHARGE-MPLS-TOPOLOGY


n INCHARGE-MPLS-MONITORING


n INCHARGE-MPLS-ANALYSIS


Note   TOPOLOGY, MONITORING, and ANALYSIS are always appended to the Domain Group
name to generate the three MPLS Manager domain managers.


A script (server_config.pl) is provided to make it easier to define server names, to update names, and
populate the domain names changes to the default configurations files. Once updated, these new
domain names are used by the TOPOLOGY, MONITORING and ANALYSIS servers.


Run the script
After the different servers have been installed with the default domain manager's names, you can use the
server_config script to customize the domain managers’ names.


The MPLS Manager post installation script uses the sm_perl command from either the MPLS
BASEDIR/smarts/bin directory or from the location where the server_config.pl post installation script is
located.
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From the Perl /bin directory
Invoke the post installation script from the directory where the MPLS Manager post installation script is
located.


sm_perl server_config.pl -o <OldGroupName> -n <NewGroupName> -b <BASEDIR>


      


From the MPLS installation directory
Invoke the post installation script from the directory where Perl is installed.


   ./sm_perl <BASEDIR>/smarts/script/mpls-tma/server_config.pl -o <OldGroupName> -n


<NewGroupName> -b <BASEDIR>


      


Invoke the command line script server_config.pl options from the BASEDIR/smarts/bin/ directory as
follows:


n Install services with default name if they have not been installed previously (see Example ).


server_config.pl -i -o <OldGroupName> -n<NewGroupName> -b<BASEDIR>


n Rename services that have been installed previously (see Example ).


server_config.pl -o <OldGroupName> -n<NewGroupName> -b<BASEDIR>


n Generate a list of services that have been installed previously (see Example ).


server_config.pl -s -b <BASEDIR>


n Display information on how to run the script with examples (see Example ).


server_config.pl -h


Example 1


         server_config.pl -i -o “INCHARGE-MPLS” -n “HQ-MPLS” -b opt/InCharge/MPLS/smarts/


      


Example 2


         server_config.pl -o “INCHARGE-MPLS” -n “HQ-MPLS” -b opt/InCharge/MPLS/smarts/


      


Example 3


         server_config.pl -s -b opt/InCharge/MPLS/smarts/
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Example 4


         server_config.pl -h


      


Script options
Following are the required and optional command line script parameters:


Note   Avoid using the following special characters when entering text strings for <OldGroupName> and
<NewGroupName>: $ / \


Table 13‑1.  server_config.pl script command line options


Option Purpose


--install-service


or


-i


Indicates that the service needs to be installed.
n This parameter must be used with the --old-group, --new-group, and --basedir


parameters.
n If the services are not installed, they are installed.
n If services are already installed, they are uninstalled and reinstalled with the


NewGroupName.


--old-group="<OldGroupName>"


or


-o "<OldGroupName>"


A required value that specifies the old group name to be changed.
n You must include the OldGroupName variable string in double quotes.
n This parameter must be used with the --new-group and --basedir parameters.
n If services are running, will terminate without doing anything.


--new-group="<NewGroupName>"


or


-n "<NewGroupName>"


A required value that specifies the new group name.
n You must include the NewGroupName variable string in double quotes.
n This parameter must be used with the --old-group and --basedir parameters.
n If services are running, will terminate without doing anything.


--basedir=<BASEDIR>


or


-b <BASEDIR>


A required value which specifies the installation base directory.
n This parameter must be used with the --old-group and --new-group parameters.
n If services are running, will terminate without doing anything.


--show


or


-s


Indicates that you want to see the current group names, services and Domain
Manager names.
n With this option, no changes are made to either the service or the configuration


file.
n This parameter must be used with the --basedir parameter.


--help


or


-h


--help or -h shows command line parameters and examples.


This parameter is used alone.


Note   The order of the parameters is not important.


Always include the BASEDIR of the installed services in the command line. The only instances where you
do not have to include it is when using the Help (-h) option.
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Following are the steps that the script performs once invoked:


1 If the local directory BASEDIR/smarts/local/conf/mpls-tma does not already exist, it is created and a
copy of the original mpls-tma.conf file from the BASEDIR/smarts/conf/mpls-tma directory is copied to
it.


2 If a service corresponding to the <OldGroupName> is installed, the following process is initiated:


3 If the service is running and the user command line argument is not -s or --show, the script displays
an error message and exits. You must stop the services before you can rename them.


4 If the service is not running and the Service Daemon is running, then the script uninstalls the service
for the current <OldGroupName>, installs the service for the <NewGroupName>, then continues to
step 4.


5 If the service is not running and the Service Daemon is not running, then the script displays a warning
that there is potential for mismatch, uninstalls the service for the current <OldGroupName>, installs
the service for the <NewGroupName>, then continues to step 4.


6 If a service corresponding to the <OldGroupName> is not installed, the following process is initiated:


7 If the installation option (--i or -install-service) is not specified, the scripts does not install the service.


8 If the installation option (--i or -install-service) is specified and if the Service Daemon is running, the
script installs the service corresponding to the <NewGroupName>.


9 If the installation option (--i or -install-service) is specified and if the Service Daemon is not running,
the script warns you that you must start it and exits without further action.


10 After step 2 or step 3 are performed, the script copies the previous local configuration file to a backup
file named .<OldGroupName><.bak>


11 The script then replaces the <OldGroupName> with <NewGroupName> in
BASEDIR/smarts/local/conf/mpls-tma/mpls-tma.conf and terminates.
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Configuration Scanner tool
Sample Output 14
This chapter includes the following topics:


n Files created by Configuration Scanner tool


n Sample outputs


Files created by Configuration Scanner tool
The following files are created by the tool:


n sm_configscan_report-<time_stamp>.txt: This is the report file created by the Configuration Scanner
tool. This file contains:


n List of files installed by the TTP, if any


n List of files introduced by the user


n Modifications made to the discovery.conf, tpmgr-param.conf and name-resolver.conf files


n List of file differences for each modified file


n List of modifications found in the server


Report when server is specified and Report when server is not specified provides sample outputs.


n sm_configscan-<time_stamp>.tar: This tar file contains the following:


n A copy of the Configuration Scanner report file


n sm_configscanner.log


n A copy of runcmd_env.sh


n ConfigScanAdapter.log


n PnTallOutput.txt: lists all the settings found on the server


n A directory containing the DIFF files for each modified files


The output files for the configuration scanner tool is available under the


<BASEDIR>/smarts/local/logs/Final_sm_getinfo<timesatamp>.tar file.
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Sample outputs
This section provides sample outputs for the following:


n Running Configuration Scanner tool with server name


n Report when server is specified


n Running Configuration Scanner tool without server name


n Report when server is not specified


Running Configuration Scanner tool with server name
You can run the tool by specifying a running server in the command line. In this scenario, the tool scans
for changes you have made in the values of both the polling and threshold settings and configuration files.
A sample output is provided:


C:\InCharge\IP\smarts\bin>sm_perl sm_getinfo -s INCHARGE-AMPM -k


Executing sm_configscan ...


===============================================================sm_monitor about to run!


Please enter the correct credentials in clientConnect.conf


Or be prepared to enter the credentials below:


===============================================================Getting hardware Info...


Getting AMPM show-dm-process info...


MAIN-N-Closing this log file at August 28, 2012 4:02:24 AM EDT; continuing in


C:\InCharge\IP\smarts\local\logs\AMPM-show-dm-proc-28Aug2012-040223_en_US_UTF-8.log


Getting AMPM stacktrace info...


Exiting eval via last at C:/InCharge/IP/smarts/bin//sm_monitor.pl line 180.


Getting AMPM queues info...


Getting AMPM subscriptions info...


Getting AMPM threads info...


Getting AMPM flows info...


Getting AMPM clients info...


Getting netstat info...


Getting tasklist info...


Getting log file...


Getting rps files...


Getting Monitor...


Getting Accessor Ping...


Getting Accessor Poll...


Getting Problems...


Getting instrumentation for IP...


MAIN-N-Closing this log file at August 28, 2012 4:05:13 AM EDT; continuing in


C:\InCharge\IP\smarts\local\logs\AMPM-instrumentation-28Aug2012-040223_en_US_UTF-8.log


Deleting files: C:\InCharge\IP\smarts\local\logs\smgetinfo_files\*smgetinfo-versions.log*


Getting the Smarts server version ...


Getting the Executable versions ...


Getting the Local lib versions ...


Getting the lib versions ...


Getting the list of installed TTPs ...


No TTPs currently installed


No patches currently installed.
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Archiving the files...


Writing to sm_getinfo28Aug2012-040132.tar.zip ...


... Done writing to Final_sm_getinfo28Aug2012-040132.tar.zip


Please send the file: C:\InCharge\IP\smarts\local\logs\Final_sm_getinfo28Aug2012-040132.tar.zip to 


VMware Support


Report when server is specified
The following is the sample of the report when the tool is run specifying a running server in the command
line:


Version: IP.9.1.0.0


These files have been modified in the installation:


===================================================


C:/InCharge/IP/smarts/local/conf/discovery/discovery.conf


C:/InCharge/IP/smarts/local/conf/discovery/name-resolver.conf


C:/InCharge/IP/smarts/local/conf/discovery/oid2type_Cisco.conf


C:/InCharge/IP/smarts/local/conf/discovery/oid2type_Misc.conf


C:/InCharge/IP/smarts/local/conf/discovery/tpmgr-param.conf


These files have been introduced in the installation: 


=====================================================


C:/InCharge/IP/smarts/local/repos/icf/INCHARGE-AMPM.rps


C:/InCharge/IP/smarts/local/repos/icf/INCHARGE-AMPM.rps.bak


Server Name: INCHARGE-AMPM


The following Polling and Threshold settings were modified in the installation: 


============================================================


POLLING::Polling Groups::5620 SAM Managed Systems::Connectivity Polling - External 


Poller::InstrumentCards


  Current Value : TRUE


  Default Value : FALSE


POLLING::Polling Groups::ComputeFabric::Environment Polling::PollingInterval


  Current Value : 120


  Default Value : 240


POLLING::Polling Groups::ComputeFabric::Environment Polling::Retries


  Current Value : 4


  Default Value : 3


POLLING::Polling Groups::ComputeFabric::Connectivity Polling::PollingInterval


  Current Value : 30


  Default Value : 240


POLLING::Polling Groups::Routers::Environment Polling::PollingInterval


  Current Value : 30


  Default Value : 240


THRESHOLD::Interface Groups::1 Gb Ethernet::Ethernet Interface/Port Performance::BroadcastThreshold


  Current Value : 10


  Default Value : 15


The following changes were made to some special configuration files: 


============================================================


File: C:/InCharge/IP/smarts/local/conf/discovery/discovery.conf


  Attribute Name : MetroEthernetEnabled


    Current Value  : TRUE


    Default Value  : FALSE


    Comment        : Modified


  Attribute Name : defaultTimeout
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    Current Value  : 2000


    Default Value  : 1000


    Comment        : Modified


  Attribute Name : defaultRetries


    Current Value  : 8


    Default Value  : 5


    Comment        : Modified


  Attribute Name : defaultSNMPAutoRetries


    Current Value  : 4


    Default Value  : 3


    Comment        : Modified


  Attribute Name : DiscoveryAddrPref


    Current Value  : "IPV4FIRST_IPV6NEXT"


    Default Value  : "IPV6FIRST_IPV4NEXT"


    Comment        : Modified


  Attribute Name : numberProbeThreads


    Current Value  : 15


    Default Value  : 10


    Comment        : Modified


  Attribute Name : LicenseThresholdPercentage


    Current Value  : 40


    Default Value  : 90


    Comment        : Modified


File: C:/InCharge/IP/smarts/local/conf/discovery/name-resolver.conf


  Attribute Name : NameFormat


    Current Value  : "TM_USESEEDNAME"


    Default Value  : "TM_USEAUTONAME"


    Comment        : Modified


  Attribute Name : TM_USEAGENTADDRESS


    Current Value  : 3


    Default Value  : 4


    Comment        : Modified


  Attribute Name : TM_USEPRIVATEIP


    Current Value  : 4


    Default Value  : 3


    Comment        : Modified


File: C:/InCharge/IP/smarts/local/conf/discovery/tpmgr-param.conf


  Attribute Name : maxOIDsPerPacketForASNMP


    Current Value  : 15


    Default Value  : 19


    Comment        : Modified


  Attribute Name : GetBulkPattern-.1.3.6.1.4.1.1872.1.15


    Current Value  : TRUE


    Default Value  : 


    Comment        : Newly added


  Attribute Name : GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15


    Current Value  : 1.5


    Default Value  : 


    Comment        : Newly added


  Attribute Name : GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15


    Current Value  : 2.5


    Default Value  : 


    Comment        : Newly added


  Attribute Name : IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4


    Current Value  : 
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    Default Value  : 39|53|1


    Comment        : Removed


  Attribute Name : IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8


    Current Value  : 


    Default Value  : 37


    Comment        : Removed


The following are two way text differences:


===========================================


<--- C:/InCharge/IP/smarts/conf/discovery/discovery.conf --->


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 54 to 54 >>>>>>>>>>>>>>


defaultRetries = 5 


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 54 to 54 <<<<<<<<<<<<<<


defaultRetries = 8 


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 61 to 61 >>>>>>>>>>>>>>


defaultTimeout = 1000


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 61 to 61 <<<<<<<<<<<<<<


defaultTimeout = 2000


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 82 to 82 >>>>>>>>>>>>>>


defaultSNMPAutoRetries = 3 


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 82 to 82 <<<<<<<<<<<<<<


defaultSNMPAutoRetries = 4 


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 97 to 97 >>>>>>>>>>>>>>


numberProbeThreads = 10


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 97 to 97 <<<<<<<<<<<<<<


numberProbeThreads = 15


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 280 to 280 >>>>>>>>>>>>>>


DiscoveryAddrPref =  "IPV6FIRST_IPV4NEXT"


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 280 to 280 <<<<<<<<<<<<<<


DiscoveryAddrPref =  "IPV4FIRST_IPV6NEXT"


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 287 to 287 >>>>>>>>>>>>>>


MetroEthernetEnabled = FALSE


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 287 to 287 <<<<<<<<<<<<<<


VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


VMware, Inc.  109







MetroEthernetEnabled = TRUE


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 290 to 290 >>>>>>>>>>>>>>


LicenseThresholdPercentage = 90 


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 290 to 290 <<<<<<<<<<<<<<


LicenseThresholdPercentage = 40 


<=============== End Difference ===============>


<----------------------------------------------->


<--- C:/InCharge/IP/smarts/conf/discovery/name-resolver.conf --->


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 19 to 18 >>>>>>>>>>>>>>


#NameFormat = "TM_USESEEDNAME"


NameFormat = "TM_USEAUTONAME"


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 18 to 19 <<<<<<<<<<<<<<


NameFormat = "TM_USESEEDNAME"


#NameFormat = "TM_USEAUTONAME"


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 30 to 29 >>>>>>>>>>>>>>


AutoNameOrder 3 TM_USEPRIVATEIP


AutoNameOrder 4 TM_USEAGENTADDRESS


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 29 to 30 <<<<<<<<<<<<<<


AutoNameOrder 3 TM_USEAGENTADDRESS


AutoNameOrder 4 TM_USEPRIVATEIP


<=============== End Difference ===============>


<----------------------------------------------->


<--C:/InCharge/IP/smarts/conf/discovery/oid2type_Cisco.conf ->


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 12369 to 12370 >>>>>>>>>>>>>>


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 12370 to 12384 <<<<<<<<<<<<<<


.1.3.6.1.4.1.9.1.916 {


TYPE = Firewall


VENDOR = Cisco


MODEL = ciscoASA5580sc


CERTIFICATION = CERTIFIED


CONT = Cisco-Entity


HEALTH = Cisco-Entity


INSTRUMENTATION:


CPU/Memory = CiscoRouter:DeviceID


Interface-Fault = MIB2


Interface-Performance = MIB2


}


<=============== End Difference ===============>


<----------------------------------------------->


<--C:/InCharge/IP/smarts/conf/discovery/oid2type_Misc.conf -->


<============== Start Difference ==============>
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>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 8816 to 8806 >>>>>>>>>>>>>>


.1.3.6.1.4.1.10734.1.3.8 {


TYPE = Firewall


VENDOR = TippingPoint


MODEL = TippingPointIPS


CERTIFICATION = CERTIFIED


CONT = MIB2-IfStack


INSTRUMENTATION:


Interface-Fault = MIB2


Interface-Performance     = MIB2


}


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 8806 to 8816 <<<<<<<<<<<<<<


#.1.3.6.1.4.1.10734.1.3.8 {


# TYPE = Firewall


# VENDOR = TippingPoint


# MODEL = TippingPointIPS


# CERTIFICATION = CERTIFIED


# CONT = MIB2-IfStack


#


#INSTRUMENTATION:


# Interface-Fault = MIB2


# Interface-Performance = MIB2


#}


<=============== End Difference ===============>


<----------------------------------------------->


<--C:/InCharge/IP/smarts/conf/discovery/tpmgr-param.conf --->


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 40 to 40 >>>>>>>>>>>>>>


IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4 39|53|1


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 40 to 40 <<<<<<<<<<<<<<


#IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4 39|53|1


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 125 to 125 >>>>>>>>>>>>>>


IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8 37


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 125 to 125 <<<<<<<<<<<<<<


#IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8 37


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 554 to 554 >>>>>>>>>>>>>>


#GetBulkPattern-.1.3.6.1.4.1.1872.1.15 TRUE


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 554 to 554 <<<<<<<<<<<<<<


GetBulkPattern-.1.3.6.1.4.1.1872.1.15 TRUE


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 565 to 565 >>>>>>>>>>>>>>
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#GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15 2.5


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 565 to 565 <<<<<<<<<<<<<<


GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15 2.5


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 576 to 576 >>>>>>>>>>>>>>


#GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15 1.5


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 576 to 576 <<<<<<<<<<<<<<


GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15 1.5


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 582 to 582 >>>>>>>>>>>>>>


maxOIDsPerPacketForASNMP 19


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 582 to 582 <<<<<<<<<<<<<<


maxOIDsPerPacketForASNMP 15


<=============== End Difference ===============>


<----------------------------------------------->


Running Configuration Scanner tool without server name
You can run the tool without specifying a running server in the command line. In this scenario, the tool
only scans for changes you made to the configuration files. A sample output is provided:


C:\InCharge\IP\smarts\bin>sm_perl sm_getinfo -k


Executing sm_configscan ...


Deleting files: C:\InCharge\IP\smarts\local\logs\smgetinfo_files\*smgetinfo-versions.log*


Getting the Smarts server version ...


Getting the Executable versions ...


Getting the Local lib versions ...


Getting the lib versions ...


Getting the list of installed TTPs ...


No TTPs currently installed


No patches currently installed.


Archiving the files...


Writing to sm_getinfo28Aug2012-044639.tar.zip ...


... Done writing to Final_sm_getinfo28Aug2012-044639.tar.zip


Please send the file: C:\InCharge\IP\smarts\local\logs\Final_sm_getinfo28Aug2012-044639.tar.zip to 
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Report when server is not specified
The following is the sample of the report when the tool is run without specifying a running server in the
command line:


Version: IP.9.1.0.0


These files have been modified in the installation: 


===================================================


C:/InCharge/IP/smarts/local/conf/discovery/discovery.conf


C:/InCharge/IP/smarts/local/conf/discovery/name-resolver.conf


C:/InCharge/IP/smarts/local/conf/discovery/oid2type_Cisco.conf


C:/InCharge/IP/smarts/local/conf/discovery/oid2type_Misc.conf


C:/InCharge/IP/smarts/local/conf/discovery/tpmgr-param.conf


These files have been introduced in the installation: 


=====================================================


C:/InCharge/IP/smarts/local/repos/icf/INCHARGE-AMPM.rps


C:/InCharge/IP/smarts/local/repos/icf/INCHARGE-AMPM.rps.bak


The following changes were made to some special configuration files: 


===============================================================


File: C:/InCharge/IP/smarts/local/conf/discovery/discovery.conf


  Attribute Name : MetroEthernetEnabled


    Current Value  : TRUE


    Default Value  : FALSE


    Comment        : Modified


  Attribute Name : defaultTimeout


    Current Value  : 2000


    Default Value  : 1000


    Comment        : Modified


  Attribute Name : defaultRetries


    Current Value  : 8


    Default Value  : 5


    Comment        : Modified


  Attribute Name : defaultSNMPAutoRetries


    Current Value  : 4


    Default Value  : 3


    Comment        : Modified


  Attribute Name : DiscoveryAddrPref


    Current Value  : "IPV4FIRST_IPV6NEXT"


    Default Value  : "IPV6FIRST_IPV4NEXT"


    Comment        : Modified


  Attribute Name : numberProbeThreads


    Current Value  : 15


    Default Value  : 10


    Comment        : Modified


  Attribute Name : LicenseThresholdPercentage


    Current Value  : 40


    Default Value  : 90


    Comment        : Modified


File: C:/InCharge/IP/smarts/local/conf/discovery/name-resolver.conf


  Attribute Name : NameFormat


    Current Value  : "TM_USESEEDNAME"


    Default Value  : "TM_USEAUTONAME"


    Comment        : Modified
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  Attribute Name : TM_USEAGENTADDRESS


    Current Value  : 3


    Default Value  : 4


    Comment        : Modified


  Attribute Name : TM_USEPRIVATEIP


    Current Value  : 4


    Default Value  : 3


    Comment        : Modified


File: C:/InCharge/IP/smarts/local/conf/discovery/tpmgr-param.conf


  Attribute Name : maxOIDsPerPacketForASNMP


    Current Value  : 15


    Default Value  : 19


    Comment        : Modified


  Attribute Name : GetBulkPattern-.1.3.6.1.4.1.1872.1.15


    Current Value  : TRUE


    Default Value  : 


    Comment        : Newly added


  Attribute Name : GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15


    Current Value  : 1.5


    Default Value  : 


    Comment        : Newly added


  Attribute Name : GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15


    Current Value  : 2.5


    Default Value  : 


    Comment        : Newly added


  Attribute Name : IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4


    Current Value  : 


    Default Value  : 39|53|1


    Comment        : Removed


  Attribute Name : IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8


    Current Value  : 


    Default Value  : 37


    Comment        : Removed


The following are two way text differences:


===========================================


<--- C:/InCharge/IP/smarts/conf/discovery/discovery.conf --->


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 54 to 54 >>>>>>>>>>>>>>


defaultRetries = 5 


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 54 to 54 <<<<<<<<<<<<<<


defaultRetries = 8 


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 61 to 61 >>>>>>>>>>>>>>


defaultTimeout = 1000


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 61 to 61 <<<<<<<<<<<<<<


defaultTimeout = 2000


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 82 to 82 >>>>>>>>>>>>>>
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defaultSNMPAutoRetries = 3 


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 82 to 82 <<<<<<<<<<<<<<


defaultSNMPAutoRetries = 4 


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 97 to 97 >>>>>>>>>>>>>>


numberProbeThreads = 10


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 97 to 97 <<<<<<<<<<<<<<


numberProbeThreads = 15


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 280 to 280 >>>>>>>>>>>>>>


DiscoveryAddrPref =  "IPV6FIRST_IPV4NEXT"


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 280 to 280 <<<<<<<<<<<<<<


DiscoveryAddrPref =  "IPV4FIRST_IPV6NEXT"


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 287 to 287 >>>>>>>>>>>>>>


MetroEthernetEnabled = FALSE


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 287 to 287 <<<<<<<<<<<<<<


MetroEthernetEnabled = TRUE


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 290 to 290 >>>>>>>>>>>>>>


LicenseThresholdPercentage = 90 


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 290 to 290 <<<<<<<<<<<<<<


LicenseThresholdPercentage = 40 


<=============== End Difference ===============>


<----------------------------------------------->


<--C:/InCharge/IP/smarts/conf/discovery/name-resolver.conf -->


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 19 to 18 >>>>>>>>>>>>>>


#NameFormat = "TM_USESEEDNAME"


NameFormat = "TM_USEAUTONAME"


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 18 to 19 <<<<<<<<<<<<<<


NameFormat = "TM_USESEEDNAME"


#NameFormat = "TM_USEAUTONAME"


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 30 to 29 >>>>>>>>>>>>>>


AutoNameOrder 3 TM_USEPRIVATEIP


AutoNameOrder 4 TM_USEAGENTADDRESS


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 
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<<<<<<<<<<<<<< From line: 29 to 30 <<<<<<<<<<<<<<


AutoNameOrder 3 TM_USEAGENTADDRESS


AutoNameOrder 4 TM_USEPRIVATEIP


<=============== End Difference ===============>


<----------------------------------------------->


<--C:/InCharge/IP/smarts/conf/discovery/oid2type_Cisco.conf-->


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 12369 to 12370 >>>>>>>>>>>>>>


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 12370 to 12384 <<<<<<<<<<<<<<


.1.3.6.1.4.1.9.1.916 {


TYPE = Firewall


VENDOR = Cisco


MODEL = ciscoASA5580sc


CERTIFICATION = CERTIFIED


CONT = Cisco-Entity


HEALTH = Cisco-Entity


INSTRUMENTATION:


CPU/Memory = CiscoRouter:DeviceID


Interface-Fault = MIB2


Interface-Performance = MIB2


}


<=============== End Difference ===============>


<----------------------------------------------->


<--C:/InCharge/IP/smarts/conf/discovery/oid2type_Misc.conf -->


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 8816 to 8806 >>>>>>>>>>>>>>


.1.3.6.1.4.1.10734.1.3.8 {


TYPE = Firewall


VENDOR = TippingPoint


MODEL = TippingPointIPS


CERTIFICATION = CERTIFIED


CONT = MIB2-IfStack


INSTRUMENTATION:


Interface-Fault           = MIB2


Interface-Performance     = MIB2


}


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 8806 to 8816 <<<<<<<<<<<<<<


#.1.3.6.1.4.1.10734.1.3.8 {


# TYPE = Firewall


# VENDOR = TippingPoint


# MODEL = TippingPointIPS


# CERTIFICATION = CERTIFIED


# CONT = MIB2-IfStack


#


#INSTRUMENTATION:


# Interface-Fault           = MIB2


# Interface-Performance     = MIB2


#}


<=============== End Difference ===============>


<----------------------------------------------->


<--C:/InCharge/IP/smarts/conf/discovery/tpmgr-param.conf --->
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<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 40 to 40 >>>>>>>>>>>>>>


IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4 39|53|1


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 40 to 40 <<<<<<<<<<<<<<


#IFTypePatternIFExt.1.3.6.1.4.1.119.1.3.13.4 39|53|1


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 125 to 125 >>>>>>>>>>>>>>


IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8 37


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 125 to 125 <<<<<<<<<<<<<<


#IFTypePattern-SwitchPort.1.3.6.1.4.1.119.1.14.8 37


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 554 to 554 >>>>>>>>>>>>>>


#GetBulkPattern-.1.3.6.1.4.1.1872.1.15 TRUE


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 554 to 554 <<<<<<<<<<<<<<


GetBulkPattern-.1.3.6.1.4.1.1872.1.15 TRUE


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 565 to 565 >>>>>>>>>>>>>>


#GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15 2.5


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 565 to 565 <<<<<<<<<<<<<<


GetBulkTimeoutOverrideRatio-.1.3.6.1.4.1.1872.1.15 2.5


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 576 to 576 >>>>>>>>>>>>>>


#GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15 1.5


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 576 to 576 <<<<<<<<<<<<<<


GetBulkRetriesOverrideRatio-.1.3.6.1.4.1.1872.1.15 1.5


<=============== End Difference ===============>


<============== Start Difference ==============>


>>>>>>>>>>>>>> Base File Contents >>>>>>>>>>>>>> 


>>>>>>>>>>>>>> From line: 582 to 582 >>>>>>>>>>>>>>


maxOIDsPerPacketForASNMP 19


<<<<<<<<<<<<<< Local File Contents <<<<<<<<<<<<<< 


<<<<<<<<<<<<<< From line: 582 to 582 <<<<<<<<<<<<<<


maxOIDsPerPacketForASNMP 15


<=============== End Difference ===============>


<----------------------------------------------->
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Preface 1
As part of an effort to improve its product lines, VMware periodically releases revisions of its software and
hardware. Therefore, some functions described in this document might not be supported by all versions of
the software or hardware currently in use. The product release notes provide the most up-to-date
information on product features.


Contact your VMware technical support professional if a product does not function properly or does not
function as described in this document.


Note   This document was accurate at publication time. Go to VMware Online Support docs.vmware.com
to ensure that you are using the latest version of this document.


This chapter includes the following topics:


n Purpose


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n VMware Smart Assurance Service Assurance Manager


n Related documentation


n VMware Smart Assurance Service Assurance Manager documentation


n Conventions used in this document


n Where to get help


n Your comments


Purpose
This guide provides instructions for using the VMware Smart Assurance Notification Module
(VMware Smart Assurance NOTIF) application within an VMware Smart Assurance environment to
process external events. VMware Smart Assurance NOTIF is a configuration tool and run-time product for
raw event and notification processing. Events and notifications are configured through the flexible
graphical user interface, the VMware Smart Assurance Notification Module Configuration Editor
(VMware Smart Assurance NOTIF Editor).
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In addition to the configuration guides for specific components, administrators should also read the
VMware Smart Assurance Service Assurance Manager Deployment Guide and the
VMware Smart Assurance System Administration Guide.


Audience
This guide is intended for users of VMware Smart Assurance products with domain knowledge of how an
event is to be processed and filtered. The person deploying and configuring VMware Smart Assurance
NOTIF should be familiar with the VMware Smart Assurance Service Assurance Manager (Global
Manager or SAM), Adapter Platform, and notifications. This guide is intended for any user who needs to
manage and import external events into VMware Smart Assurance Service Assurance Manager products.


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<product>.


The <product> represents the VMware Smart Assurance product to which the product belongs. For
example, on UNIX operating systems, VMware Smart Assurance Service Assurance Manager is, by
default, installed to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than /opt/InCharge (on UNIX)
but you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.


VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System


n Global Console


n Business Dashboard


n Companion UI


n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)
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n XML Adapter


n VMware Smart Assurance Adapter for UIM/O


Related documentation
In addition to this document, VMware Corporation provides a help system for command line programs as
well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


n VMware Smart Assurance Common Information Model (ICIM) 1.11 Reference for Non-Service
Assurance Manager Products


n VMware Smart Assurance Common Information Model (ICIM) Reference for Service Assurance
Manager


n VMware Smarts Foundation Documentation Portfolio


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ASL Reference Guide


n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide


Note   These documents are updated periodically. Electronic versions of the updated manuals are
available on the VMware online support website:


docs.vmware.com.


VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes


n VMware Smart Assurance Open Source License and Copyright Information
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n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


n VMware Smart Assurance Service Assurance Manager Deployment Guide


n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide


n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide


n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance Companion UI Open Source License and Copyright Information for GPLv3
as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance products.


Conventions used in this document
VMware uses the following conventions for special notices:


Note   NOTICE is used to address practices not related to personal injury.


Typographical conventions
VMware uses the following type style conventions in this document:


Bold Use for names of interface elements


Italic Use for full titles of publications referenced in text


Monospace
Use for:
n System output, such as an error message or script
n System code
n Pathnames, filenames, prompts, and syntax
n Commands and options


VMware Smart Assurance Notification Module User Guide


VMware, Inc.  8







                      
  Monospace italic
                     


Use for variables.


                      
  Monospace bold
                     


Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example


Where to get help
VMware support, product, and licensing information can be obtained as follows:


Product information


For documentation, release notes, software updates, or information about VMware products, go to
VMware Online Support at:


docs.vmware.com


Technical support


Go to VMware Online Support. You will see several options for contacting VMware Technical Support.
Note that to open a service request, you must have a valid support agreement. Contact your VMware
sales representative for details about obtaining a valid support agreement or with questions about your
account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:


docs.vmware.com.
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Introduction 2
This chapter includes the following topics:
n VMware Smart Assurance Notification Module overview


n VMware Smart Assurance Service Assurance Manager Adapter Platform architecture


n VMware Smart Assurance NOTIF integration with Adapter Platform architecture


n VMware Smart Assurance NOTIF architecture


n VMware Smart Assurance NOTIF processor functionality


n VMware Smart Assurance NOTIF Editor functionality


VMware Smart Assurance Notification Module overview
The VMware Smart Assurance Notification Module (VMware Smart Assurance NOTIF) augments the
VMware Smart Assurance solutions with event management features that are configurable through a
graphical user interface. The VMware Smart Assurance NOTIF user interface is referred to as the
VMware Smart Assurance Notification Module Configuration Editor (VMware Smart Assurance NOTIF
Editor). VMware Smart Assurance NOTIF replaces the internal event and notification processing features
of the standard VMware Smart Assurance Service Assurance Manager Adapter Platform.
VMware Smart Assurance NOTIF provides the user with event and notification configuration access,
maintenance, and documentation capabilities without requiring a complete understanding of the
underlying products, and without requiring extensive application-specific coding.


VMware Smart Assurance NOTIF represents an improvement over the standard
VMware Smart Assurance trap processing design. To configure the standard SNMP Trap Adapter to
process traps, you must decide which traps should become notifications and how the notifications should
appear at the Global Console. You can do this by editing the trap_mgr.conf file and then restarting the
server. VMware Smart Assurance NOTIF makes this process much more user-friendly and robust. With
VMware Smart Assurance NOTIF, you can make instantaneous trap processing configuration changes
through the VMware Smart Assurance NOTIF Editor without restarting any servers.
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Efficient event and notification processing presents the most important information to the operator by
using an VMware Smart Assurance Service Assurance Global Console. VMware Smart Assurance
NOTIF enables the user to easily optimize the flow of events and notifications sent through any
VMware Smart Assurance system. Advantages of using VMware Smart Assurance NOTIF include the
following:


n Handles notifications in a consistent and extensive manner.


n Facilitates configuration of events and notifications through a flexible, user-friendly interface, the
VMware Smart Assurance NOTIF Editor.


n Allows for real-time reconfiguration of event and notification processing without server restarts.


n Applies to any event source.


n Integrates with standard VMware Smart Assurance Service Assurance Manager (SAM) and
Adapter Platform (OI) repositories and servers.


n Supports current VMware Smart Assurance Service Assurance Manager Adapter Platform standard
SNMP event functions (that is, expiration clearing, unknown agents, logging specifications,
notification field setting).


n Provides converter tools for standard configuration sources (for example, trap_mgr.conf file).


n Packages event and notification configurations. This is useful for modular roll-out of configurations.


n Automatically generates an HTML-based document that provides information on all internal event and
notification configuration objects for review and documentation purposes.


n Requires no knowledge of the VMware Smart Assurance Adapter Scripting Language (ASL).


VMware Smart Assurance Service Assurance Manager
Adapter Platform architecture
To understand the event management capabilities and advantages that VMware Smart Assurance NOTIF
provides in an VMware Smart Assurance implementation, it is important to understand the
VMware Smart Assurance Service Assurance Manager Adapter Platform architecture and the standard
VMware Smart Assurance trap processing design.


Standard VMware Smart Assurance Service Assurance Manager Adapter Platform architecture is an
example of a basic SAM configuration. The Adapter Platform imports topology and event information from
third-party applications and prepares it for use by the Service Assurance Manager. Data from third-party
applications should not be sent directly to SAM. The Adapter Platform creates notifications from the
incoming information and can even associate these notifications to topology information supplied by
another VMware Smart Assurance application, such as the
VMware Smart Assurance IP Availability Manager as shown in Standard VMware Smart Assurance
Service Assurance Manager Adapter Platform architecture.
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Figure 2‑1.  Standard VMware Smart Assurance Service Assurance Manager Adapter Platform
architecture


The Adapter Platform consists of the SNMP Trap Adapter, as shown in Standard VMware Smart
Assurance Service Assurance Manager Adapter Platform architecture. The SNMP Trap Adapter parses
SNMP traps received and generates notifications based on the contents of the traps. The
SNMP Trap Adapter can receive SNMP v1, v2c, or v3 traps. However, it forwards only v1 or v2c traps. If
SNMPv3 traps are received, they are converted to one of the other formats before being sent to a domain
manager or to another trap receiver.


Note   The VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide provides
details on the Adapter Platform.


The SNMP Trap Adapter can be configured to handle many different types of traps through two
configuration files associated with the SNMP Trap Adapter:


n trapd.conf ” This is the configuration file for the VMware Smart Assurance SNMP Trap Adapter. This
conf file determines what port number the trap adapter listens to for traps, and enables trap
forwarding to VMware Smart Assurance domain managers (like the IP Availability Manager) and the
Adapter Platform.


n trap_mgr.conf ” This configuration file determines how specific traps are mapped into notifications that
are sent to the Global Console.
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VMware Smart Assurance NOTIF integration with
Adapter Platform architecture
VMware Smart Assurance NOTIF allows you to filter and forward events and perform other event
management configuration through Event Configuration Information (ECI) objects. The event
configuration features of VMware Smart Assurance NOTIF replace the trap_mgr.conf file in the
Adapter Platform (OI) server shown in Overlay of VMware Smart Assurance NOTIF functions on Adapter
Platform architecture, which performs the event filtering and determines which traps are forwarded for
further processing. The VMware Smart Assurance NOTIF functions are overlaid on the standard
VMware Smart Assurance Service Assurance Manager Adapter Platform architecture as shown in 
Overlay of VMware Smart Assurance NOTIF functions on Adapter Platform architecture.
VMware Smart Assurance NOTIF can be installed on an Adapter Platform server or a SAM server.


VMware Smart Assurance NOTIF also allows you to process notifications through Notification
Configuration Information (NCI) objects. The notification processing features of VMware Smart Assurance
NOTIF replace the internal notification processing in the Adapter Platform or SAM server, depending on
where VMware Smart Assurance NOTIF is installed, as shown in Overlay of VMware Smart Assurance
NOTIF functions on Adapter Platform architecture.


Note   VMware Smart Assurance NOTIF architecture provides details on ECI and NCI objects.


Figure 2‑2.  Overlay of VMware Smart Assurance NOTIF functions on Adapter Platform
architecture
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VMware Smart Assurance NOTIF architecture
There are two main components of VMware Smart Assurance NOTIF. The first is the real-time component
which processes SNMP traps or other raw event types according to configuration settings. This
configuration processing is performed on raw events by the Event Configuration Information
(EventConfigInfo or ECI) objects. ECI objects determine whether a particular event will be processed, that
is, whether a notification for an event will be created. ECI processing is discussed in Chapter 3 Event
Configuration Information Processing


The second VMware Smart Assurance NOTIF component is notification processing, which is configured
by the Notification Configuration Information (NCI) objects. NCI objects determine how notifications are
processed. NCI processing is discussed in Chapter 4 Notification Configuration Information Processing


It is important to note the separation of raw event processing (through ECI objects) versus notification
processing (through NCI objects) since this allows VMware Smart Assurance NOTIF to operate in various
architectures. The VMware Smart Assurance NOTIF Editor allows the user to manipulate the
configuration settings for both ECI and NCI objects.


In an VMware Smart Assurance implementation, VMware Smart Assurance NOTIF can reside on a SAM
server or an Adapter Platform Open Interface (OI) server. VMware Smart Assurance NOTIF ECI/NCI
structure in an VMware Smart Assurance environment shows how ECI and NCI objects are used in an
VMware Smart Assurance NOTIF solution where low-level raw events are filtered and processed, and
notifications are grouped within the Adapter Platform. An additional VMware Smart Assurance NOTIF
process is run within the SAM server to combine and group notifications from the adapter servers and
other (analysis) servers.
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Figure 2‑3.  VMware Smart Assurance NOTIF ECI/NCI structure in an
VMware Smart Assurance environment


Advantages of VMware Smart Assurance NOTIF architecture
In the VMware Smart Assurance NOTIF Editor, you configure ECI objects to determine how you want to
handle particular events. In the ECI setup window, in the VMware Smart Assurance NOTIF Editor, you
can select whether a particular raw event should be handled. If the event is to be processed, select the
Active checkbox in the VMware Smart Assurance NOTIF Editor as shown in this section. When you select
whether a particular event is Active, you save the configuration to the local Adapter Platform server (File >
Save Configuration or File > Save Configuration As... in the VMware Smart Assurance NOTIF Editor),
and you do not have to restart the Adapter Platform server.


The VMware Smart Assurance NOTIF Editor also allows you to make changes to varbinds associated
with ECI configuration parameters through the ECI setup window in the VMware Smart Assurance NOTIF
Editor. Without the VMware Smart Assurance NOTIF Editor, you would have to do this by writing hook
scripts.


Setting up ECI configuration parameters on page 32 provides details on how to configure ECI objects to
handle incoming events.
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VMware Smart Assurance NOTIF processor functionality
When the VMware Smart Assurance NOTIF processor starts up on a server or the Remote > Reload
server option in the VMware Smart Assurance NOTIF Editor is selected, VMware Smart Assurance
NOTIF browses the BASEDIR/smarts/conf/<config> and local/conf/<config> directories for files that end in
".ncf". The *.ncf files are VMware Smart Assurance NOTIF configuration files. VMware Smart Assurance
NOTIF loads each*.ncf file into the VMware Smart Assurance NOTIF processor and combines them to
create the running configuration on the Adapter Platform or SAM server where VMware Smart Assurance
NOTIF is running.


Note   The use of *.ncf files in VMware Smart Assurance NOTIF is a major architectural change from
previous versions of NOTIF. VMware Smart Assurance NOTIF now loads configurations from *.ncf files,
one at a time, rather than connect to an VMware Smart Assurance repository.


VMware Smart Assurance NOTIF configuration files (*.ncf files) are XML files that you can edit using the
VMware Smart Assurance NOTIF Editor. VMware Smart Assurance NOTIF Editor functionality provides
an overview of how the VMware Smart Assurance NOTIF Editor works.


When VMware Smart Assurance NOTIF reads an *.ncf configuration file and loads the entire
configuration from the configuration directories (that is, the /conf/<icoi or /ics> or /local/conf/<icoi or /ics>
directories), the cumulative configuration is written to an *.ncf file in the local/logs directory (for example,
the INCHARGE-OI.<configfilename>.ncf file). In this way, you can determine the specific
VMware Smart Assurance NOTIF configuration elements that are running on a particular server. The *.ncf
file written to the local/logs directory is generated when you either start up VMware Smart Assurance
NOTIF or select the Remote > Reload server option in the VMware Smart Assurance NOTIF Editor.


Note   When you install the VMware Smart Assurance Service Assurance Manager version 9.2,
VMware Smart Assurance NOTIF is not enabled by default. You must start VMware Smart Assurance
NOTIF by performing the steps described in “Starting VMware Smart Assurance NOTIF” on page 66.


VMware Smart Assurance NOTIF Editor functionality
The VMware Smart Assurance NOTIF Editor is designed to allow you to manipulate
VMware Smart Assurance NOTIF configuration files (*.ncf), both on the local machine that is running the
VMware Smart Assurance NOTIF Editor as well as remote servers. The VMware Smart Assurance
NOTIF Editor accesses local configuration *.ncf files under the File menu option, while remote operations
are located under the Remote menu option. Main menu options provides details on The
VMware Smart Assurance NOTIF Editor menu options.


The VMware Smart Assurance NOTIF Editor provides key functions through the main menu such as
retrieving configurations from remote servers, pushing (or storing) configurations to remote servers, and
managing connections to remote servers. VMware Smart Assurance NOTIF Editor functionality provides
a schematic overview of the VMware Smart Assurance NOTIF Editor functionality.
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Local *.ncf file configuration options (File menu)
On the local server, you can edit an. *ncf file through the following File menu options:


n New Configuration


n Open Configuration


n Merge Configuration


n Save Configuration


n Save Configuration As


n Close Configuration


You can also import trap_mgr.conf files to your local server through the Import trap_mgr.conf File
menu option. This option allows you to load the trap_mgr.conf files used to configure a TRAP-
INCHARGE-OI server (SNMP Trap Adapter) into VMware Smart Assurance NOTIF to replicate the
standard file-based functionality.


Note   File menu options provides more information on File menu options.


Connecting to a remote server through the
VMware Smart Assurance NOTIF Editor (Remote > Manage
connections)
Connections are defined within the VMware Smart Assurance NOTIF Editor to access remote servers.
Multiple connections may be defined and given a reference name for convenience. The Remote >
Manage connections menu option is used to add remote server connections in the
VMware Smart Assurance NOTIF Editor. When you select this option, you type a connection reference
name and connection details such as broker, domain, and user names.


Note   Manage connections... provides more information on how to set up remote server connections.
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Figure 2‑4.  VMware Smart Assurance NOTIF Editor functionality


Remote *.ncf file configuration options (Remote menu)
After you have established the remote server connection through the Remote > Manage connections
option, push or store a local *.ncf configuration file or package to a remote server through the following
VMware Smart Assurance NOTIF Editor options:


n Push to server
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n Push package to server


After the configurations are pushed to a remote server, they do not become active on the remote
server until you select the Remote > Reload Server option.


The Remote menu options associated with retrieving a running configuration or a specific *.ncf file
from a remote server to a local server are:


n Retrieve running configuration from server


n Retrieve a configuration file from server


This Remote > Edit a server’s settings option is used to change server settings on remote servers.
One of the settings you can change on a remote server is whether VMware Smart Assurance NOTIF
is active on that server. “Starting VMware Smart Assurance NOTIF” on page 66 provides details on
the process for activating VMware Smart Assurance NOTIF on a remote server by using the Edit a
server’s settings option.


Note   Remote menu options provides more information on Remote menu options.
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Event Configuration Information
Processing 3
This chapter includes the following topics:
n ECI processing overview


n Raw event normalization


n Pushing events into VMware Smart Assurance NOTIF


n ECI event matching


n Designing ECI naming conventions


n Enumeration of keyword/value pairs


n Value substitutions


n Setting up ECI configuration parameters


n Copying ECI configuration parameters


ECI processing overview
Event Configuration Information (ECI) processing involves two steps:


n Determining whether a raw event should be processed to create an unpublished notification that is
passed to notification processing (that is, filtering events at the lowest level possible).


n Determining the instance/class/event name of the notification that should be created if the event is
processed.


ECI processing and NCI processing steps within VMware Smart Assurance NOTIF shows the overall
flow of ECI processing steps. Chapter 4 Notification Configuration Information Processing provides
details on how ECI processing steps relate to the NCI processing steps.
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Figure 3‑1.  ECI processing and NCI processing steps within VMware Smart Assurance
NOTIF


Event information is passed to VMware Smart Assurance NOTIF through a common structure. This
packaging allows for common information to logically identify an event and pass additional
information that may be used to further convert raw information into a specific notification.


The packaging of the event data is performed by the specific adapter and should be referenced by
the individual adapter documentation. The general format of the wrapper is explained in “Raw event
normalization” on page 26.


Events are grouped by three identifying fields: baseID, sub1ID, and sub2ID. An event is only
processed if an associated ECI is found to match these fields.
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After an ECI matches a given raw event, a series of configuration tests are performed on the raw
event to determine if the event should be processed further. Configuration test checks on a raw event
include the following parameters:


Event Active The event must be active in order to be processed.


Is Managed Un-managed objects are not processed.


< x events in y minutes Sliding window squelch.


ASL hook Hard-coded test of other values.


Setting up ECI configuration parameters on page 32provides details on all the available ECI configuration
values. Failure of any raw event test prevents the ECI process from determining what unpublished
notification will be created or updated.


After basic event tests are complete, the event is formed into a notification. This phase of processing
allows the instance, class, event name and all notification values to be changed based upon event data
with variable substitution from raw event data. After this point, it is an unpublished notification that is no
longer connected to the raw event, though the event data may be passed in the notification.


Note   ECI configurations are saved as *.ncf files and remain unchanged through the stopping and
starting of the Adapter Platform (OI) server.


There are several ways in which ECI objects can be loaded or added into a SAM/Adapter Platform server.
ECI objects can be:


n Defined by *.ncf files provided from other sources (that is, pre-packaged configurations).


n Created directly from the VMware Smart Assurance NOTIF Editor from the Edit menu.


n Merged into the VMware Smart Assurance NOTIF Editor based on specifications in the trap_mgr.conf
file.


Additionally, the VMware Smart Assurance NOTIF Editor provides a means to copy an existing ECI
object as the basis for another, and to save all defined configurations to an .import file.


After a raw event arrives and the best ECI object match is found, the behavior of the configuration
object is performed relative to the event. If ECI objects are modified with the
VMware Smart Assurance NOTIF Editor, the effects of the modifications take place when the next
instance of the relevant event arrives.


Raw event normalization
Raw events are passed to VMware Smart Assurance NOTIF through adapters after being normalized into
a common structure. This structure provides the required basic event information and additional data
used for further processing. The format of the data stream is a pipe-separated ("|") string as shown below:


         <


         eventTimeStamp


         >|<


         eventAgent
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         >|<


         eventBaseID


         >|<


         eventSub1ID


         >|<


         eventSub2ID


         


         >|<


         Keyword1


         |


         Value1


         >|


         


         <


         Keyword2


         |


         Value2


         >.....


      


The pipe-separated data stream includes the following information:


n eventTimeStamp — Event occurrence time in UNIX time format; seconds since the Epoch


n eventAgent — Agent name or IP address


n eventBaseID — dot-separated hierarchical identifier string (abc.123.XYZ….)


n (for example, enterprise for SNMP)


n eventSub1ID — General identifier (generic trap number for SNMP)


n eventSub2ID — Specific identifier (specific trap number for SNMP)


n Keyword1|Value1 — Keyword|value pair (OID1|value for SNMP)


n Keyword2|Value2 — Keyword|value pair (OID2|value for SNMP)


The eventBaseID, eventSub1ID, and eventSub2ID parameters are used as the unique event
identifiers to match with ECI objects. The number of Keyword|Value pairs is variable. Event IDs may
use all three fields, the first two, or only the eventBaseID; it depends on the raw events being
processed.


For specific adapters, the adapter documentation provides details to obtain information on the
composition of the ID strings and the Keyword|Value pair mapping.


Note   VMware Smart Assurance NOTIF replaces pipe character ("|") in field.(varbind) by double
dashes ("--") to process the raw event.
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Pushing events into VMware Smart Assurance NOTIF
VMware Smart Assurance NOTIF uses a named queue to process incoming events. Events are
normalized into a common structure and pushed into this queue through MODEL methods. The named
queue for events is notifInterface::notifEventQueue. The method used to push an event into the queue is:


void pushEvent ( string encodedEvent, string sourceSystemId );


The encodedEvent is a pipe-separated ("|") string having the normalized format described in “Raw event
normalization” on page 26. The sourceSystemId is a string identifying where this event came from.


The following example ASL file shows how a raw SNMP event is pushed into VMware Smart Assurance
NOTIF:


rawEvent.asl


START {


 .. eol


}


do {


 queue = object("notifInterface", "notifEventQueue");


 if(queue->isNull()) {


  print(queue . " was null!");


  return;


 }


 eventTimeStamp = time();


 eventAgent = "192.168.1.100";


 enterprise = "TestECI";


 generic = "";


 specific = "";


 oid1 = "testOID";


 oidValue1 = "test value";


 completeString = eventTimeStamp . "|" . eventAgent . "|" . enterprise . "|" . generic . "|" . 


specific . "|" . oid1 . "|" . oidValue1;


 queue->pushEvent(completeString, "rawEvent.asl");


}


ECI event matching
EventConfigInfo objects (ECIs) are the configuration objects that instruct VMware Smart Assurance
NOTIF how to handle incoming raw events. When a raw event arrives, the best matching ECI is identified
and that is used to determine if a notification should be created, and if so, the instanceName and
eventName to be associated with the notification.


ECI objects are named based upon a tree structure from the most generic to the most specific field, in the
form of eventBaseID_eventSubID1_eventSubID2. An example would be:


Vendor.Product.Version.Equipment.Type_EquipmentSubType_SpecificType
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SNMP defines ECI objects as Enterprise_Generic_Specific. Examples of how these names relate to
events are given in the following section. ECI naming convention rules describes the ECI naming rules.


eventBaseID naming rules


n May be any number of dot-separated fields, the last of which may be *


eventSub1ID and eventSub2ID naming rules


n May be explicit, *, or null
n If eventSub2ID is explicit or *, eventSub1ID must be explicit or *
n eventSub1ID may exist with eventSub2ID null


Matching examples
When raw events are delivered to VMware Smart Assurance NOTIF, VMware Smart Assurance NOTIF
finds the best match between a raw event and an ECI in its repository to handle that event. A best match
is determined by first looking for an ECI that matches eventBaseID_eventSubID1_eventSubID2 (in
SNMP, these fields are referenced as enterprise, generic, and specific fields). If the original event is not
matched by an exact name for these parameters, wildcard evaluations are performed in order from right
to left.


Examples of how VMware Smart Assurance NOTIF matches raw events to ECI objects are:


Defined ECIs


1 ECI-ABC.123.XYZ_TEST_EVENT


2 ECI-ABC.123.XYZ_TEST_*


3 ECI-ABC.123.*_TEST_*


4 ECI-ABC.*_*_*


5 ECI-ABC.*_*


6 ECI-ABC.*


Raw event


(eventBaseID_eventSub1ID_eventSub2ID) ECI processing


ABC.123.XYZ_TEST_EVENT Uses ECI 1 — Exact match for all three
eventBaseID_eventSub1ID_eventSub2ID fields


ABC.123.XYZ_TEST_FOX Uses ECI 2


ABC.123.xyz_TEST_EVENT Uses ECI 3


ABC.123.xyz_CAT_EVENT Uses ECI 4


ABC.123.XYZ_TEST Uses ECI 5 — Does not match ECI 4 since the eventSub2ID field is
null


ABC.123.XYZ.wxy.zero Uses ECI 6 — Does not match ECI 4 or ECI 5 since the eventSub1ID
and eventSub2ID fields are null
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Designing ECI naming conventions
Although the naming of ECI objects is determined by the designer of the adapter, it is worth noting here
as the entire structure of the ECI tree is based on how this is accomplished. As an example, assume that
events are built based upon the date. Some events may use the time format mmm/dd/yyyy, others may
use yyyy/mmm/dd. If the former is used, (mmm/dd/yyyy), the month shows up as the primary ID
(eventBaseID), and the VMware Smart Assurance NOTIF Editor branch shows based on month:


Raw event wrapper of IDs


DATE.Apr_01_1996


DATE.Apr_01_1997


Specific defined ECIs


ECI-DATE.Apr_01_1996


ECI-DATE.Apr_01_1997


VMware Smart Assurance NOTIF Editor tree view


Apr -


01 -


1996


1997


1998


02 -


…


A single ECI may be defined to process any month of any year on a specific day by creating ECI-
DATE.*_01_*


However, a common ECI cannot be created to process any day of any year given this wrapper format. If
the wrapper format was yyyy/mmm/dd, then the tree would appear as:


VMware Smart Assurance NOTIF Editor tree view


1996 -


Apr -


01


02


...


1997 -


Apr -
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01


02


...


1998 -


Apr -


...


In this case, an ECI could be ECI-DATE.*_*_01 to process any event on the 1st:


ECI-DATE.*_Apr_* to handle any event in April.


ECI-DATE.1996_*_* to handle any event in 1996.


ECI-DATE.*_*_* to handle any event.


There are two issues from the previous example, first is the view from the VMware Smart Assurance
NOTIF Editor where it is undesirable to have hundreds of ECI objects showing under one branch. Second
is the selection of what fields are used for the eventBaseID, eventSubID1, eventSubID2 fields greatly
impact how ECI objects are designed.


ECI notification naming
The ECI object is responsible for creating the unpublished notification that will be processed by the NCI
thread for further processing. The primary keys for NCI matching are the instance ClassName and
EventName, both of which are determined in the ECI as shown in ECI notification naming.


Naming of the ECI is independent of the naming of the notification created by the ECI but consistency is
important to avoid confusion. For example, ECI-EventABC could create a notification with an event
named EventXYZ. Although this is possible, it is not desirable because the connection between an ECI
and an NCI will not be apparent. Avoid inconsistent translations of event names to notification names.


A feature of the NCI name matching allows for the use of a wildcard at the end of the event name, for
example: Down-on-port-*. It is important to construct the notification event name such that variables are
placed at the end of the event name string. Down-on-port-5 may use the above event name in the NCI for
a match whereas Port-5-Down does not facilitate an NCI wild carding match.


Enumeration of keyword/value pairs
After VMware Smart Assurance NOTIF has determined the appropriate ECI for a raw event, but before it
starts processing, it will see if the values for the keyword/value pairs should be translated based on
enumeration tables. For example, a keyword/value pair with


OID = .1.3.1.6.2.9.4432.12 may have a table that permits incoming values to be translated. The value 1
may mean off and the value 2 may mean on. In general, if an object ID (OID) has a translation table,
VMware Smart Assurance NOTIF converts the value supplied in the raw event to the translation value
specified by the table.
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In some situations, some devices may append additional nodes to the OID. For example, a device
appends an IP address to the OID so that a given raw event might be .1.3.1.6.2.9.4432.12.192.168.1.234.
VMware Smart Assurance NOTIF allows you to flag an ECI as one which might have pairs that could use
wildcard enumeration lookups. What this means is that VMware Smart Assurance NOTIF will first see if
there is an enumeration lookup table for .1.3.1.6.2.9.4432.12.192.168.1.234, and if none is found and
wildcards are possible for the ECI, then VMware Smart Assurance NOTIF would look for enumeration
mapping tables for .1.3.1.6.2.9.4432.12.192.168.1, .1.3.1.6.2.9.4432.12.192.168, .
1.3.1.6.2.9.4432.12.192, .1.3.1.6.2.9.4432.12, and so on till a lookup table is found or the name runs out
of dot-separated values. This is a relatively computationally intense process, so
VMware Smart Assurance NOTIF also permits the administrator to set a maximum number of trailing
nodes to check before giving up. In our example, where some devices are known to append IP
addresses, the administrator might set the maximum number of trailing nodes to be four.


To summarize wildcard enumeration lookups:


n At the system level (in the configuration file) indicate the maximum number of nodes to drop in
checking for enumeration tables.


n For specific ECIs that are used with raw events that might have OIDs that need wildcard lookups, set
the ECI Use Enum Wildcard flag to true.


Note this example is specific to SNMP, but any dot-separated keyword string will work in the same
manner. A keyword/value pair may appear as Smarts.textSeverity = Critical and be processed by an
enumeration of:


Critical -> 1


Major -> 2


....


The display name of enumerated values may be changed to make the VMware Smart Assurance
NOTIF Editor tree view more readable. For example, an enumerated value of .1.3.6.1.4.1.9.9.37.2.13
may not have much meaning to the reader, but typing a display name of Trap.Cisco.FRU.Status
makes it easy to identify the actual use of the enumerated value.


Value substitutions
The real-time substitution mechanism begins from the left of the string and finds the first substitution
instructions. It evaluates that substitution and comes up with a new version of the string and starts again
to evaluate from the left. Nesting of substitution strings may become complex and care should be taken to
confirm desired results through testing. An example of using substitution values would be configuring the
severity of an ECI to be $V2$, that is, the severity is set to the value of the second keyword/value pair.
The severity of an ECI may also use something like $extract(extract(V2,"[",3),"= ",1)$, but this requires a
full understanding of the input string and substitution use. A description of the scripting system used
within the substitution feature and a complete list of substitution values are listed in Chapter 6 Substitution
Scripting and Values
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Setting up ECI configuration parameters
After a matching ECI is identified for an incoming raw event, the configuration values for that ECI are
used to process the event. You can set the configuration values for an ECI through the following tabs in
the ECI Setup dialog box:


n General


n Event Setup


n Event Options


n User Defined


n Calc’d Values


This section provides screen shot examples of an ECI setup and descriptions of each field.


General values
The General tab of the ECI Setup dialog box shown in General tab of the ECI Setup dialog box defines
the basic behavior of the raw event.


Figure 3‑2.  General tab of the ECI Setup dialog box


The fields in General tab of the ECI Setup dialog box are:


n Active — Selecting this checkbox means that the corresponding raw alarm is to be handled.


n DedupOn — Selecting this checkbox means that the corresponding event will always be filtered
unless the notification has cleared. If the DedupOn checkbox is not selected, every occurrence of the
event will be forwarded with no filtering for deduplication.


n DedupResendInterval — If this value is greater than zero and the DedupOn option is selected, then
the event will be resent if the time since the event was last published is greater than this number of
seconds. For example, if the DedupResendInterval is 60, even if there is already one of these events,
if it is more than 60 seconds old, it will be resent.
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n ClearOnAcknowledge — Selecting this checkbox causes the resulting notifications to be cleared
when acknowledged.


n InMaintenance — Selecting this checkbox means the event occurred in maintenance.


n Event Fork — Selecting this checkbox means that the raw matching event will also look for <ECI-
name>-2 to create a second thread for additional processing. If the <ECI-name>-2 has Event Fork
selected, VMware Smart Assurance NOTIF will then look for <ECI-name>-3, and so on.


n TimeBasedThresholdActive — This checkbox should be selected if the values for
TimeBasedThresholdCount and TimeBasedThresholdWindow are to be used for x times in y seconds
time-based event thresholding (where x is the TimeBasedThresholdCount value and y is the
TimeBasedThresholdWindow value). For example, select the TimeBasedThresholdActive checkbox if
you want a particular event sent if it occurs three times in a 15-second window.


n TimeBasedThresholdCount — The number of events that occurs in a given amount of time (that is,
the TimeBasedThresholdWindow value) that triggers the forwarding of a particular event. For
example, if the TimeBasedThresholdCount value is 3, and the TimeBasedThresholdWindow value is
15, then that means the event should be sent if there are 3 of these events that occur in 15 seconds.
This enables you to filter out the odd once-in-a-while event.


n TimeBasedThresholdWindow — The number of seconds in which a particular number of events
(that is, the TimeBasedThresholdCount value) occur that triggers the forwarding of a particular event.
The TimeBasedThresholdWindow is a sliding window; for example, event 1 that occurs at 1 second,
event 2 that occurs at 14 seconds and event 3 that occurs at 16 seconds will not generate a
notification since all three of these events did not occur within a 15-second window, but event 4 that
occurs at 18 seconds will create a notification because events 2, 3, and 4 occurred within a 15-
second window.


The DedupOn feature can be used with time-based event thresholding to prevent multiple notification
updates. To explain how deduplication and time-based event thresholding work together, consider the
example in which there are 3 events of the same type in 15 seconds, but the events are all
deduplicated (that is the DedupOn checkbox is selected for this event type).


The underlying VMware Smart Assurance NOTIF behavior would be:


a The event is triggered the first time and ignored (since it has not yet hit the 3 events in 15
seconds threshold requirement).
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b The second and third events are deduplicated before they trigger the time-based thresholding
rule.


Note   To deduplicate this event and have it trigger the threshold would require the event to come
in an onset, then clear, then onset, then clear, and finally one last onset and clear. The reason is
that the deduplication will deduplicate any event coming in unless it is a clear.


Time-based thresholding generally has no clear event so the ClearOnAcknowledge feature
described above and/or the Expiration feature described in the Event Setup tab should be used to
clear the notification.


The ClearOnAcknowledge feature works at the SAM level, but does not by default clear the event
if it came from the Adapter Platform. This can create confusion between notifications in the
console between the Adapter Platform and SAM.


n CheckIsManaged — Selecting this checkbox means that the IsManaged property of the instance for
this event must be true in order for this event to be processed. If the IsManaged property of the
instance for this event is false, then the event will be logged and dropped.


n UsesEnumWildcard — Selecting this checkbox means that this ECI might have keyword/value pairs
that may use wildcard enumeration lookups.


Note   Enumeration of keyword/value pairs on page 31 provides more information on this feature.


A useful tip for navigating through the VMware Smart Assurance NOTIF Editor is that the description
of a specific configuration parameter will display when your mouse hovers over a checkbox or data
entry field in the VMware Smart Assurance NOTIF Editor. Example of mouse-hover tool in the
VMware Smart Assurance NOTIF Editor shows an example of when the mouse-hover tool is used for
the Event Fork checkbox for a particular ECI object. You can also use the mouse-hover tool for NCI
object VMware Smart Assurance NOTIF Editor parameters.


Figure 3‑3.  Example of mouse-hover tool in the VMware Smart Assurance NOTIF Editor
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Event Setup values
The Event Setup tab of the ECI Setup dialog box shown in Event Setup tab of the ECI Setup dialog box
defines the properties of the notification created by the raw event.


Figure 3‑4.  Event Setup tab of the ECI Setup dialog box


The fields in Event Setup tab of the ECI Setup dialog box are described below:


n ClassName — The class of the instance against which the notification is posted. This includes
substitution values.


n ElementClassName — The class of the element. This includes substitution values.


n InstanceName — The name of the instance. This includes substitution values.


n ElementName — The name of the element. This includes substitution values.


n EventName — The name of the event used in the notification. This includes substitution values.


n EventDisplayName — The name of the event displayed in the VMware Smart Assurance Notification
Log Console.


n State — The state used for the notification, which is either NOTIFY or CLEAR.


n Severity — The numeric VMware Smart Assurance value or substitution value.


n Expiration — The length of time in seconds the notification will remain active.


n EventText — The text of the notification, which includes substitution values.


n Category — The category of the event used in the notification.
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Event Options values
The Event Options tab of the ECI Setup dialog box shown in Event Options tab of the ECI Setup dialog
box defines additional event options for the notification.


Figure 3‑5.  Event Options tab of the ECI Setup dialog box


The fields in Event Options tab of the ECI Setup dialog box are described below:


n DisplayName — The display name of the event used in the notification.


n Description — The description of the event used in the notification.


n EventType — The type of event used in the notification, either DURABLE or MOMENTARY.


n ServiceName — The name of the service used in the notification.


n SysNameOrAddr — The system name or IP address associated with the event used in the
notification.


n ASL — The ASL script called before the posting of this notification.


Note   VMware Smart Assurance NOTIF uses the value stored in ASL to determine which file to load.
The named ASL script is invoked from the local/rules or /rules directories. For example, if you type
icoi-trapd/sample_hook.asl in the ASL field in the VMware Smart Assurance NOTIF Editor,
VMware Smart Assurance NOTIF will look up local/rules/icoi-trapd/sample_hook.asl and rules/icoi-
trapd/sample_hook.asl. Appendix B, “ASL and Java Interfacing with VMware Smart Assurance
NOTIF” provides more information on how to write ASL scripts for use with VMware Smart Assurance
NOTIF event processing.


n Java — The Java class called.


Note   Appendix B, ASL and Java Interfacing with VMware Smart Assurance NOTIF provides more
information on how to write Java classes for use with VMware Smart Assurance NOTIF event
processing.
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n Logfile — The name of the log file recording information about this event.


n UnknownAgent — The action taken if the agent is unknown, either CREATE which will create the
object, or IGNORE which will discard this event.


n Event Stream — When set, the processor guarantees that all events with a given event stream name
will be processed in the order in which they were received. If the Event Stream option is not set, there
is no such guarantee. An example of a scenario in which setting the Event Stream for an ECI would
be helpful is the following: a particular network component is flapping and is generating onsets and
clears for a single alarm very quickly. In this scenario, VMware Smart Assurance NOTIF could receive
an onset and then a clear within a few milliseconds. When the ECI does not have an Event Stream
set, VMware Smart Assurance NOTIF could schedule the onset into one processing queue, and the
clear into another. Because it is multithreaded, VMware Smart Assurance NOTIF could then possibly
process the clear first, which would be incorrect. By providing an Event Stream on the ECI, the user is
mandating VMware Smart Assurance NOTIF to process the onsets and clears in order, and the
problem is solved. Many ECIs can have the same Event Stream, and that guarantees that all of the
incoming events for any of those ECIs are processed in the order in which they were received.


User Defined values
The User Defined tab of the ECI Setup dialog box shown in User Defined tab of the ECI Setup dialog box
defines additional configurable fields that are passed to the notification. Substitution values may be used
in these user-defined fields. Both ASL and Java hook scripts can be initiated from
VMware Smart Assurance NOTIF processing, which can overwrite these and other notification values.


Figure 3‑6.  User Defined tab of the ECI Setup dialog box


Calculated values
The Calc’d Values tab of the ECI Setup dialog box shown in Calc’d Values tab of the ECI Setup dialog
box defines calculated value instructions. The calculated values feature allows the user configuring
VMware Smart Assurance NOTIF to write simple scripts that use information from the event (or
notification) being processed to calculate values for use in the VMware Smart Assurance NOTIF
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processor. For example, a user could write a calculated value script that decides to discard an event
when the value of SNMP trap varbind 3 (V3) is 0. Note that in the calculated values list in Calc’d Values
tab of the ECI Setup dialog box, literal values are enclosed with quotation marks (for example: “0”) and
variables are not (for example: V3).


Figure 3‑7.  Calc’d Values tab of the ECI Setup dialog box


Calculated values comprises of a condition (value) (conditional) (value) and assignment (attribute)
(value). Substitution values are allowed in any value field as shown in Calculated values or select Help >
Substitutions in the VMware Smart Assurance NOTIF Editor.


Allowed conditionals include:


==, !=, < , <=, >, >=, contains, (left string contains right string), does not contain, (left string does not
contain right string), starts with, ends with


Note    == means equal, and != means not equal.


Legal assignment attributes include:


n ASLEnabled


n Category


n ClassName


n ClearOnAcknowledge


n DiscardTrap


n ElementClassName


n ElementName


n EventName


n EventText


n EventType
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n Expiration


n InMaintenance


n InstanceName


n JavaEnabled


n Severity


n State


n UpdateUserDefinedFields


n UserDefined1 - 20


Examples of calculated values are the following:


n if V1 equals “1”, set Severity to “1”.


n if contains (SYS, “Demo”), set EventText to “Ignore events against”+SYS.


Adding calculated values
To add a calculated value to an ECI:


1 Select the ECI in the topology tree of the VMware Smart Assurance NOTIF Editor.


2 Select the Calc’d Values tab.


3 Click Add. The default Edit Calculated Value dialog box appears as shown in Edit Calculated Value
dialog box.


Figure 3‑8.  Edit Calculated Value dialog box


4 Type the appropriate values in this dialog box to create the calculated value for the ECI. For example:


Note   In the user-editable fields in the Edit Calculated Value dialog box, you must include dollar signs
for varbind variables; otherwise the variable will be read as literal text. For example, if V11 (instead of
$V11$) was typed in the Condition: field in the above example, VMware Smart Assurance NOTIF
would read the V11 entry as a literal text string (not as the value of V11).


Also, the text typed for values in conditions and assignments should be in upper case. For example,
State -> CLEAR, not State -> clear.
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5 Click OK. The calculated value appears in the calculated value list as shown in Example of adding a
Calculated Value to an ECI.


Note   In the calculated values list, literal values in the displayed calculated value are enclosed with
quotation marks (for example: “5”) and variables are not (for example: V11).


Figure 3‑9.  Example of adding a Calculated Value to an ECI


Editing calculated values
To edit a calculated value for an ECI:


1 Select the ECI in the topology tree of the VMware Smart AssuranceNOTIF Editor.


2 Select the Calc’d Valuestab.


3 Select the calculated value you want to edit in the calculated value list.
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4 Click Edit, or double-click the selected calculated value. The Edit Calculated Value dialog box
appears as shown in Example of editing a Calculated Value for an ECI


Figure 3‑10.  Example of editing a Calculated Value for an ECI


5 Type the appropriate values in the Edit Calculated Valuedialog box to edit the calculated value for
the ECI.


6 Click OK. The edited calculated value appears in the calculated value list.


When editing calculated values, consider the following:


n Calculated value instructions are evaluated from first to last in order. Later instructions can reset
values set in prior instructions. Therefore, the order in which the calculated value instructions
appear in this list is important.


n Some assignments affect processing. If ASLEnabled is set to false, then the ASL script will not
run, even if it is present. Similarly, if JavaEnabled is set to false, then the Java script will not run
even if present.


n In the user-editable fields in the Edit Calculated Value dialog box, you must include dollar signs
for varbind variables. Otherwise, the variable will be read as literal text. For example, if V11
(instead of $V11$) was typed in the Condition field, VMware Smart AssuranceNOTIF would read
the V11 as a literal text string (not as the value of V11).


n Text typed for values in conditions and assignments in the Edit Calculated Value dialog box
should be in upper case. For example, State ->CLEAR is an acceptable entry in the Edit
Calculated Value dialog box. If the user types State ->clear in the calculated value assignment,
VMware Smart AssuranceNOTIF will log an error.


n In the calculated values list in the right pane of the VMware Smart AssuranceNOTIF Editor, literal
text is enclosed with quotation marks, and variables are not. For example:


if V3 equals “4”, set Severity to “2”


n When assigning to a boolean field, VMware Smart AssuranceNOTIF converts string values that
are used for boolean expressions in the following manner:
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7 Converts the string to lower case.


8 Removes any leading or trailing whitespace.


9 Uses true if the string is one of: true, yes or on, or if the string evaluates to an integer that is not zero.


Copying ECI configuration parameters
You can copy ECI objects to reduce configuration time. To copy an ECI object, right-click the ECI object in
the topology tree in the left pane and select Copy as shown in ECI copy feature. The original ECI object
that you copy is referred to as the source. The new ECI object is referred to as the target. The source
object’s properties are copied into the target object. Everything is copied except the DisplayName


attribute.


Figure 3‑11.  ECI copy feature
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Notification Configuration
Information Processing 4
This chapter describes Event Configuration Information (EventConfigInfo or ECI) processing.


This chapter includes the following topics:
n NCI processing overview


n NCI notification matching


n Designing NCI naming conventions


n Setting up NCI configuration parameters


n Copying NCI configuration parameters
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NCI processing overview
Notification Configuration Information objects (NCIs) are the configuration objects that instruct
VMware Smart Assurance NOTIF to handle incoming unpublished notifications. After
VMware Smart Assurance NOTIF completes the ECI processing phase, unpublished notifications are
sent to the NCI portion of VMware Smart Assurance NOTIF to process interactions between notifications. 
NCI processing steps shows the NCI processing steps.


Figure 4‑1.  NCI processing steps


As shown in NCI processing steps, when VMware Smart Assurance NOTIF receives an incoming
unpublished notification, it looks for a matching NCI object. If a matching NCI object is found for the
incoming notification, VMware Smart Assurance NOTIF checks several configuration parameters that are
set in the NCI. If no matching NCI object is found for the incoming unpublished notification, the notification
is published without further consideration.


When a matching NCI object is found for an incoming unpublished notification, the NCI processing portion
of VMware Smart Assurance NOTIF checks for the following configuration parameters:


1 Active property of the NCI object (that is, whether the Active checkbox is selected in the NCI setup
VMware Smart Assurance NOTIF Editor as shown in NCI processing overview. If the NCI object is
Active, VMware Smart Assurance NOTIF continues to process that notification, checking the NCI
configuration parameters listed below. If the NCI object is not Active, VMware Smart Assurance
NOTIF does not publish the notification.
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2 Clearing behavior ” VMware Smart Assurance NOTIF checks to see if the incoming notification clears
other notifications, or inversely, whether this notification is cleared by other notifications.


3 Publish delay ” VMware Smart Assurance NOTIF checks to see if there is a specified delay
associated with the notification before further NCI processing continues.


4 Causality ” VMware Smart Assurance NOTIF checks to see if this notification causes another
notification, or inversely, if this notification is caused by another notification.


5 Aggregation ” VMware Smart Assurance NOTIF checks to see if this notification aggregates from
other notifications, or inversely, if this notification aggregates to another notification.


6 NCI hook script ” VMware Smart Assurance NOTIF checks to see whether there is an ASL hook
script that the NCI should call just before the notification is published (after all other NCI processing
has been completed).


7 Calculated Values ” VMware Smart Assurance NOTIF checks to see if there are any calculated
values associated with the notification.


These NCI configuration values are used to process the notification. The NCI process of
VMware Smart Assurance NOTIF is an independent thread that receives information from other
servers for the creation, deletion, and change of notifications through the ICS_NOTIFICATION hook
script. It is not directly associated with ECI processing as shown in NCI processing overview.


There are two reasons NCI objects exist within VMware Smart Assurance NOTIF. They are either
used to match incoming notifications, or they are used to create new notifications. In general, new
notifications are those created because of aggregation.


NCI notification matching
When unpublished notifications are delivered to VMware Smart Assurance NOTIF, it finds the best match
between a notification and an NCI object in its repository to handle that notification. The notification must
be active in order for it to be processed, that is, the Active checkbox in the NCI setup
VMware Smart Assurance NOTIF Editor must be selected as shown in NCI notification matching.


Processing of the notification begins by looking for an exact match of class and event. A best match is
determined by first looking for an NCI object that matches the ClassName.EventName of the incoming
notification. If that does not match an NCI, VMware Smart Assurance NOTIF will do the following:


1 VMware Smart Assurance NOTIF will first look for an NCI that matches ClassName.EventName* (any
ending). VMware Smart Assurance NOTIF looks for an NCI that contains an asterisk (*) at the end to
see if the EventName in the notification can match to the beginning of the EventName in the NCI (for
example, the NCI named Router.Down-* would match with the notification named Router.Down-2).
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2 If there is no NCI EventName with a wildcard to match the EventName in the incoming notification,
VMware Smart Assurance NOTIF then begins to climb the class hierarchy to determine if a superior
class will match. At each step up the hierarchy, VMware Smart Assurance NOTIF first checks for an
exact event name match then a wildcard match. In this manner, a single NCI object can handle sub-
classed objects as well as event names with different suffixes.


Note   Note that VMware Smart Assurance NOTIF expects either an exact event name match or a
single wildcard match; ambiguities in wildcard matches will have indeterminate results as to which
NCI configuration will be used for processing. A series of NCIs such as Router.Test-1-1-*,
Router.Test-1-*, and Router.Test-* will have no determinate order; the first NCI found will be used with
no further processing. Supporting the best match at the NCI EventName level has an exponential
impact on processing speed and is not practical.


For the same reason, regex expressions are not supported within the NCI EventName string, only a
trailing asterisk (*) is supported.


NCI notification matching process illustrates the NCI notification matching process.
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Figure 4‑2.  NCI notification matching process


Matching examples
NCI objects can be created for specific class instances or subclasses based on the overall design and
wildcarded EventNames. Examples of how VMware Smart Assurance NOTIF matches notifications to
NCI objects are provided below:
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Defined NCIs


1 XYZ-Router.Event-1


2 Router.Event-1


3 Router.Event-*


4 UnitaryComputerSystem.Event-1


Incoming notification (ClassName.EventName) NCI processing


XYZ-Router and Event-1 uses NCI 1 — Exact match for ClassName and EventName


ABC-Router and Event-1 uses NCI 2 — ABC-Router is a router


ABC-Router and Event-2 uses NCI 3 — ABC-Router and Event-2 match the wildcard
EventName


Host and Event-1 uses NCI 4f


In the examples above, any subclass of router with an event name of Event-1 will be processed by the
NCI named Router.Event-1 (that is, NCI 2), except for XYZ-Router which is a more specific router class
definition. As a theoretical example, the NCI named XYZ-Router.Event-1* could represent the handling of
any EventName other than that specified by Router.Event-1.


Designing NCI naming conventions
NCI objects are matched to incoming notifications based on the class and event name in the notification.
The information in the notification is dependent on the underlying ECI process that created the NCI
requirements. Therefore, the NCI requirements are determined in the configuration of the ECI object.


Note   ECI notification naming provides more information.


Setting up NCI configuration parameters
When setting up the configuration parameters for an NCI, there are six configuration parameters to
consider:


n Clearing behavior


n Publish delay


n Causality


n Aggregation


n NCI hook script


n Calculated Values


Clearing behavior
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ClearsForAllNotifications
An NCI can specify that it ClearsForAllNotifications as shown in General tab of the NCI Setup dialog box.
Selecting the ClearsForAllNotifications checkbox means that the given notification created for an event
will clear all active notifications involving the same instance and element as the given event. When such a
notification is created through an NCI, VMware Smart Assurance NOTIF considers all the notifications
related to the same instance (except the notification triggering this behavior), and clears them. The
original specification in the Event Setup tab in the ECI determines if the triggering notification will be a
NOTIFY or a CLEAR as shown in ClearsForAllNotifications.


Consider the following example of the ClearsForAllNotifications functionality. There are three notifications
(the Down, Faulty, and ActingUp notifications) for the Element::Instance named Interface::FaultyInterface.
There is something wrong with FaultyInterface and the Interface is generating several different error
alarms.


Assume that you have an NCI called Interface.InterfaceIsGoodAgain with ClearsForAllNotifications =
TRUE. FaultyInterface may send a trap that results in a notification like
Interface_FaultyInterface_InterfaceisGoodAgain being created when the interface finally fixes itself. This
notification will trigger the NCI named Interface.InterfaceIsGoodAgain. The NCI ClearsForAllNotifications
property will cause VMware Smart Assurance NOTIF to clear all of the notifications against
FaultyInterface. The InterfaceIsGoodAgain notification may or may not clear depending on its State
(NOTIFY or CLEAR). Most users would have an ECI trigger InterfaceIsGoodAgain with a CLEAR state.
The end result is that the device no longer shows active notifications on the console once the all clear
trap is seen by VMware Smart Assurance NOTIF.
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Notifications on Interfaces other than FaultyInterface (since this is the Instance the InterfaceIsGoodAgain
notification points to) would still remain active.


Note   If VMware Smart Assurance NOTIF is running on a SAM server, you must use the
ClearsForAllNotifications option with caution. If this option is enabled, then all notifications against that
particular instance (that is, router) are cleared and this may override the Caused/CausedBy relationship in
the SAM codebook correlation.


Figure 4‑3.  General tab of the NCI Setup dialog box


ClearsForOthers
You can specify more finely-tuned clearing of notifications in an NCI with the ClearsForOthers tab in the
NCI Setup dialog box (see ClearsForOthers tab in the NCI Setup dialog box). The
ClearsForOtherNotifications field in this tab allows you to specify one or more other NCIs that the given
NCI clears for. After the specified notification is created, VMware Smart Assurance NOTIF finds the
existing notifications related to the same instance and with eventNames as specified in the
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ClearsForOtherNotifications setting. When the instance and event names both match, the specified
companion NCI(s) are cleared. For example, a .Disk.Purged notification may be configured to ClearsFor
the .Disk.UsageExceeded and .Disk.UsageWarning notifications.


Figure 4‑4.  ClearsForOthers tab in the NCI Setup dialog box


ClearedByOthers
Inversely, a given NCI may be ClearedBy other notifications. In the ClearedByOthers tab, in the
ClearedByOtherNotifications field, you can add all the notifications that clear this NCI. For example, as
shown in ClearedByOthers tab in the NCI Setup dialog box, the NCI named Router.Alarm-3-1-3 is cleared
by the Router.Alarm-4-1-4 notification.
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Figure 4‑5.  ClearedByOthers tab in the NCI Setup dialog box


Publish delay
After an NCI is found for an incoming notification, clearing behaviors are performed as discussed in the
previous section. After any clearing is done, the notification may have a delay prior to checking Causes,
Aggregates, and getting published. This delay is set in the NCI (in the Publish Delay field in Publish
delay) and is specified in seconds. For example, if you set a publish delay for 60 seconds, that means
that the notification will be held for a minute before any further NCI processing is performed. If a clearing
comes in during that minute, then the notification will be discarded.


Causality
You can configure an NCI to indicate that one notification causes another notification, or inversely, that
one notification is caused by another notification. After VMware Smart Assurance NOTIF checks an
incoming notification for clearing behavior, and any publishing delay has expired,
VMware Smart Assurance NOTIF checks to see if the new incoming notification causes any other
notifications or is caused by any existing notifications. If VMware Smart Assurance NOTIF finds that the
given notification causes or is caused by other notifications, VMware Smart Assurance NOTIF relates the
appropriate notifications.


You set up causes/causedby relationships in the Causality tab in the NCI Setup dialog box. For example,
to set up a relationship where NCI-Router.Alarm-145-3-116 causes NCI-Router.Alarm-7-2-5, you would do
the following:


1 Click the Router.Alarm-145-3-116 NCI object in the topology tree of the VMware Smart Assurance
NOTIF Editor.


2 Select the Causality tab.


3 Click Add.


4 The Add Causes Relationship dialog box appears, as shown in Add Causes Relationship dialog
box. Select NCI-Router.Alarm-7-2-5 in the Caused NCI: drop-down list and click Add.


Figure 4‑6.  Add Causes Relationship dialog box
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5 The Causality tab for NCI-Router.Alarm-145-3-116 now shows that it causes NCI-
Router.Alarm-7-2-5, as shown in Causality tab shows NCI-Router.Alarm-145-3-116 cause NCI-
Router.Alarm-7-2-5.


Figure 4‑7.  Causality tab shows NCI-Router.Alarm-145-3-116 cause NCI-
Router.Alarm-7-2-5


When you click the Router.Alarm-7-2-5 NCI object in the topology tree of the
VMware Smart Assurance NOTIF Editor, the Causality tab shows that this NCI is caused by NCI-
Router.Alarm-145-3-116, as shown in Causality tab shows NCI-Router.Alarm-7-2-5 cause NCI-
Router.Alarm-145-3-116 .


Figure 4‑8.  Causality tab shows NCI-Router.Alarm-7-2-5 cause NCI-
Router.Alarm-145-3-116
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In VMware Smart Assurance systems, notifications usually occur on a particular instance within an
element. For example, a Loss of Signal notification might occur on a Port instance within a Router
element. VMware Smart Assurance NOTIF can use a notification's instance and element to find other
instances and elements, and then create causal relationships between the notifications on each of
them.


VMware Smart Assurance NOTIF traces causality through the VMware Smart Assurance objects that
correspond to the notifications. VMware Smart Assurance NOTIF determines causality by tracing the
topology objects in five ways:


n Occurring on the same instance


n Occurring on an instance related to the notified instance


n Occurring on the same element


n Occurring on an instance related to the notified element


n Occurring on an element related to the notified element


For example, in Causality tab shows NCI-Router.Alarm-7-2-5 cause NCI-
Router.Alarm-145-3-116 , the causality specification shows that the NCI named
Router.Alarm-7-2-5 is caused by the notification Router.Alarm-145-3-116. The relationship
between these two notifications is “Occurring on the same instance.”


The causality specification shows all the other notifications caused by a given configuration, and
the relationship between the given notification’s instance or element to other instances or
elements. The relationship tracing allows notifications of a different class and instance to be
related, that is, an interface down may be caused by a router down.
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Occurring on the same instance
The “Occurring on the same instance” causality relationship in the VMware Smart Assurance NOTIF
Editor allows a notification on an instance to be set to cause another notification on the same instance.
For example, consider the creation of a notification PowerSupply::network:86.2.2.2:PowerSupply-1::Down
(note this has class, instance, and eventName elements). Assume the corresponding NCI indicates this
notification causes PowerSupply-1.NotRespondingToAgent notifications. The PowerSupply-1.Down
notification is set to cause the PowerSupply-1.NotRespondingToAgent notification on the same instance,
PowerSupply-1.


Occurring on an instance related to the notified instance
This causality relationship means that using a given notification's instance and the designated relationship
you can find all other candidate instances. If there are active notifications for any of these instances,
those notifications will be related to the first notification.


For example, assume the PowerSupply::network:86.2.2.2:PowerSupply-1::Down notification has a
corresponding NCI that indicates this notification causes .Card.Down notifications for any Cards this
PowerSupply is Underlying. The creation of the notification and the NCI would have
VMware Smart Assurance NOTIF look for notifications whose instances are Cards and eventName is
Down, and which the PowerSupply is Underlying the Card. If any are found, they are related—the
PowerSupply.Down notification is set to cause the other notifications.


The above scenario describes one notification causing another. The inverse scenario is also possible
where for example, a .Card.Down notification is caused by PowerSupply.Down and the causality is the
same instance through the LayeredOver relationship (that is, the Card is LayeredOver the PowerSupply).


Another same instance example is shown in NCI causality relationship occurs on an instance related to a
notified instance where an Interface.Down notification on a particular interface causes an
Interface.Unresponsive notification for another interface, and the relationship is ConnectedTo. In this
example, the Interface.Down notification for the Router-A-Port-1 interface instance causes the
Interface.Unresponsive notification for the Router-B-Port-5 interface instance.


When the Interface::Router-A-Port-1::Down notification and the corresponding NCI are created,
VMware Smart Assurance NOTIF finds the instance (Interface::Router-A-Port-1) and follows the
ConnectedTo relationship. This finds the Interface::Router-B-Port-5 instance with the
Interface.Unresponsive notification, and the two notifications are related. The Interface::Router-A-
Port-1::Down notification causes the Interface::Router-B-Port-5::Unresponsive notification.
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Figure 4‑9.  NCI causality relationship occurs on an instance related to a notified instance


Occurring on the same element
The “Occurring on the same element” causality relationship in the VMware Smart Assurance NOTIF
Editor allows a notification on an element to be set to cause another notification on the same element. For
example, PowerSupply.Down may cause Router.Down.


Let us slightly change the preceding example where the NCI is for PowerSupply::network:
86.2.2.2:PowerSupply-1::Down, but it is specified as “occurring on the same element” in the
VMware Smart Assurance NOTIF Editor. Assume the .PowerSupply.Down causes .Router.Down. If
a .PowerSupply.Down notification is created, VMware Smart Assurance NOTIF will find its elements
(probably Routers) and if any of those routers had .Router.Down notifications, then those notifications
would be related to the .PowerSupply.Down notification.


Occurring on an instance related to the notified element
The causes that flow from an element to an instance through a relationship are determined as follows:


1 Find the element for a given notification


2 Use the specified relationship to find related instances


3 See if there are corresponding notifications


As an example, the PowerSupply::network:86.2.2.2:PowerSupply-1::Down NCI is specified as
“occurring on an instance related to the notified element” in the VMware Smart Assurance NOTIF
Editor and the relationship is ComposedOf. Assume the .PowerSupply.Down Causes .Card.Down. If
a .PowerSupply.Down notification is created, VMware Smart Assurance NOTIF will find its element
(probably a Router) then follow the ComposedOf relationship. This would find all the Router's Cards
and if any of those cards had Card.Down notifications, then those notifications would be related to
the .PowerSupply.Down notification.


The advantage of this specification is that several objects within the element may be able to transfer
causality without being directly related.
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Looking at this causality in the inverse direction, the Card.Down NCI would show that relationship is
followed in the instance to element direction and the relationship would be PartOf. When a
Card.Down notification is created, it would follow its PartOf relationship to find an element, then look
for all the notifications associated with that element, looking for a .PowerSupply.Down.


Note   The “occurring on an instance related to the notified element” specification can be very
processor-intensive for environments with large numbers of active notifications. Therefore, it is
recommended that use of this specification be kept to a minimum.


Occurring on an element related to the notified element
Causes that flow from one element to a related element through a relationship are determined as follows:
for a given notification, find its element. Then use the relationship to find another element. The
notifications associated with the second element are examined for matches to the specified target
notifications.


An example of an “occurring on an element related to the notified element” causality relationship is shown
in NCI causality relationship occurs on an element related to a notified element where an
SNMPTrap.Down notification on a particular host causes an SNMPTrap.Unresponsive notification on a
particular software service, and the relationship is HostsServices.


In this example, the SNMPTrap::DummyHost::Down notification causes the
SNMPTrap::DummySoftware::Unresponsive notification. When the SNMPTrap.Down notification is
created, VMware Smart Assurance NOTIF finds its element (the Host named test-host-1) and follows the
HostsServices relationship. This finds the SoftwareService element named test-software-1, and any
SNMP traps associated with this SoftwareService element that have SNMPTrap.Unresponsive
notifications. In this way, the SNMPTrap::DummySoftware::Unresponsive notification is related to (caused
by) the SNMPTrap::DummyHost::Down notification.


Figure 4‑10.  NCI causality relationship occurs on an element related to a notified element
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Aggregation
Notification aggregation occurs when one or more notifications on the same instance trigger the creation
of an Aggregate notification, which represents the summary of a complex problem. An Aggregate
notification sets a notification based on other events being active.


For example, assume an NCI is created where .NetworkConnection.Erratic is specified and it
AggregatesFrom:


.NetworkConnection.HighBitErrorRate,


.NetworkConnection.LostPacketsExceeded


.NetworkConnection.ExcessiveFramingErrors


Aggregation is useful when any number of notifications indicate a common problem. The severity of the
aggregate notification is that of the highest severity of the underlying notifications. When all underlying
notifications have cleared or expired, the aggregate itself will clear. This roll-up effect is applicable only
from a VMware Smart Assurance NOTIF Editor perspective, the individual notifications will still have the
isRoot attribute set to true. Aggregation is limited to notifications against the same class and element.


Notifications may be accessed either through the AggregatesFrom tab or the AggregatesTo tab as shown
in AggregatesFrom tab of the NCI Setup dialog box and AggregatesTo tab of the NCI Setup dialog box.
However, the Event Text field is only available in the AggregatesFrom tab. In this field you can type the
text of the notification and you can provide substitution values for user-defined values.


Figure 4‑11.  AggregatesFrom tab of the NCI Setup dialog box


In AggregatesTo tab of the NCI Setup dialog box, note that unpublished notifications may aggregate to
more than one aggregate notification.
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Figure 4‑12.  AggregatesTo tab of the NCI Setup dialog box


Mixing aggregation and causes
A useful feature of VMware Smart Assurance NOTIF is the ability to relate notifications both on the
aggregation level and the causes relationship level. The aggregate notification function allows you to
create an independent notification and then roll other notifications under its display; the CausedBy
relationship allows notifications from other servers to then be rolled under the aggregate notification. The
result is that only the aggregate notification is displayed as the root cause for notifications coming from
multiple servers.


NCI hook script
An NCI can be configured to call an ASL hook script just before notification publication; all other
VMware Smart Assurance NOTIF NCI processing is performed prior to this call. You can type the hook
script in the ASL Hook Script field in the General tab of the NCI Setup dialog box (see NCI hook script).
VMware Smart Assurance NOTIF looks up ASL hook scripts in the local/rules or /rules directories. For
example, if you type icoi-trapd/sample_hook.asl in the ASL Hook Script field in the General tab of the NCI
Setup dialog box, VMware Smart Assurance NOTIF will look up local/rules/icoi-trapd/sample_hook.asl
and rules/icoi-trapd/sample_hook.asl.


Note   Writing ASL for use with VMware Smart Assurance NOTIF NCI processing on page 106 provides
information on how to write an NCI ASL hook script.


VMware Smart Assurance NOTIF passes the necessary information to reference the notification to the
hook script. In return, the hook script passes a flag back to VMware Smart Assurance NOTIF that
indicates if the notification should be published. It is the responsibility of the hook script to determine if the
notification should be deleted, modified, or related to other notifications.
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The hook script is called both on setting and clearing of a notification generated by external sources, but
not for an aggregate notification created by this VMware Smart Assurance NOTIF server. In that case, the
hook script is only called for the onset of the aggregate since the clearing of the aggregate is done by the
internal VMware Smart Assurance processing.


Calculated Values
The VMware Smart Assurance NOTIF Editor allows you to define calculated value instructions for an NCI
through the Calc’d Values tab. You can add and edit calculated values to an NCI in the same manner as
you can for an ECI.


The only difference in defining calculated values for an NCI as compared to an ECI is that the legal
assignment attributes are different. Legal assignment attributes for NCI calculated values include:


n Discard


n ElementClassName


n EventDisplayName


n EventState


n EventText


n Severity


n UserDefined1 - 20


Note   Calculated values provides information on adding and editing calculated values.


Copying NCI configuration parameters
You can copy NCI objects to reduce configuration time. To copy an NCI object, right-click on the NCI
object and select Copy as shown in NCI copy feature. The original NCI object that you copy is referred to
as the source. The new NCI object is referred to as the target. The source object’s properties are copied
into the target object. Everything is copied except:


n The NotifConfigInfoRelationSpecifier instances that the NCI relates to


n The CausedBy attribute


n The Specifies attribute


The newly-copied NCI object therefore has the same AggregatesTo/


AggregatesFrom, ClearedByOthers/ClearsForOthers relationships and general attributes, but none of
the Causes/CausedBy relationships or associated NotifConfigInfoRelationSpecifiers. This is intended
by design. You must configure the Causes/CausedBy relationship information manually after the copy
operation.
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Figure 4‑13.  NCI copy feature
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Using VMware Smart Assurance
NOTIF 5
This chapter includes the following topics:


n Starting VMware Smart Assurance NOTIF


n Using the VMware Smart Assurance NOTIF Editor


n Generating VMware Smart AssuranceNOTIF documentation


n Disabling VMware Smart Assurance NOTIF


Starting VMware Smart Assurance NOTIF
When you install the VMware Smart Assurance Service Assurance Manager version 9.2,
VMware Smart Assurance NOTIF is not enabled by default; you must start VMware Smart Assurance
NOTIF by performing the following steps:


1 Set an environment variable in the BASEDIR directory path to ensure that Java can be successfully
started for VMware Smart Assurance NOTIF.


2 In BASEDIR/smarts/local/conf/runenv_cmd.sh, add the following line:


SM_JAVA_ENABLED=YES


3 If your setup contains SNMPv3 devices, create a seedfile with the device information using the
seedfile template in the IP Manager installation area.


To use the seedfile template to create a seed file:


4 Go to the BASEDIR/smarts/bin directory in the IP Manager installation area and type the following
command to open the seedfile template:


               sm_edit conf/seedfile


            


5 Press Enter.


6 Add the seed entries for the systems to be discovered.


7 Save and close the file.
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8 Configure the SNMP Trap Adapter to use the Notif-trap_mgr_parse.asl script instead of the default
trap_mgr_parse.asl script in order for VMware Smart Assurance NOTIF to process SNMP traps.


For example:


./sm_trapd --name=TRAP-OI --server=INCHARGE-OI --config=icoi


--port=9013 --model=sm_actions --output


--rules=icoi-trapd/Notif-trap_mgr_parse.asl --daemon


9 To process SNMPv3 traps, use the --seed option when starting the SNMP Trap Adapter to point to the
seed file you have created, as mentioned in step 2 .


For example:


./sm_trapd -n TRAP-INCHARGE-OI --server=INCHARGE-OI


--config=icoi --port=162


--model=sm_actions


--seed=C:\InCharge\SAM\smarts\local\conf\icoi\seedfile


--rules=icoi-trapd\trap_mgr_parse.asl --traceSNMP --output


10 Configure the Notif Trap Receiver as a service to automatically the SNMP Trap Adapter on system
restart.


For example:


sm_service install --force  --unmanaged  --startmode=runonce \


'--name=ic-notif-trap' \


'--description=Notif Trap Receiver' \


'/opt/InCharge/SAM/smarts/bin/sm_trapd' \


'--name=NOTIF-TRAP' \


'--server=INCHARGE-OI' \


'--output' \


'--config=icoi' \


'--port=1162' \


'--model=sm_actions' \


'--rules=icoi-trapd/Notif-trap_mgr_parse.asl'


11 Configure the Syslog Adapter to use the Notif-SysLog_mgr.asl script instead of the default
SysLog_mgr.asl script in order for VMware Smart Assurance NOTIF to process Cisco system log
files.


For example:


./sm_adapter.exe --NTsErViCeNaMe=ic-syslog-adapter --name=SYSLOG-OI --server=INCHARGE-OI --


tail=/var/log/syslog --model=sm_system --model=sm_actions --output icoi-syslog/Notif-SysLog_mgr.asl
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12 Configure the Notif Syslog Adapter as a service to automatically the Syslog Adapter on system
restart.


For example:


sm_service install --force  --unmanaged  --startmode=runonce \


'--name=ic-notif-syslog' \


'--description=Notif Syslog Adapter' \


'/opt/InCharge9/SAM/smarts/bin/sm_adapter' \


'--name=NOTIF-SYSLOG' \


'--server=INCHARGE-OI' \


'--output' \


'--config=icoi' \


'--port=1162' \


'--model=sm_actions' \


'--model=sm_system'\


'--rules=icoi-syslog/Notif-SysLog_mgr.asl'\


'--tail=/opt/InCharge9/SAM/smarts/local/logs/sample.txt'


13 Launch the VMware Smart Assurance NOTIF Editor by selecting Start > Programs > InCharge >
VMware Smart Assurance NOTIF Editor.


Note   You can also launch the editor by double-clicking the NotifGui.sh file (for UNIX systems) in the
BASEDIR/smarts/notif/editor directory.


14 Use the VMware Smart Assurance NOTIF Editor to connect to the running Adapter Platform or SAM
server. Select Remote > Edit a server's settings… in the VMware Smart Assurance NOTIF Editor.


15 The Connect to a Server dialog box appears that shows the list of available Adapter Platform or
SAM server connections, as shown in Connect to a Server dialog box. Choose a server in the
Connect to a Server dialog box and click OK.


Note   Manage connections... describes how to populate the list of server connections. Clicking
More... in the Connect to a Server dialog box launches the Manage Connections dialog box where
you can add additional server connections, if desired.


Figure 5‑1.  Connect to a Server dialog box
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16 Type the password to connect to the VMware Smart Assurance server and click OK.


Note   The first time you connect to a given server when you use the VMware Smart Assurance
NOTIF Editor during a given work session, you will be prompted for a password. After that, you are
not prompted for a password on that server for the remainder of your work session. If you restart the
VMware Smart Assurance NOTIF Editor, you must type the password again the first time you use a
connection.


Figure 5‑2.  Server connection Password dialog box


17 The Remote Server Settings dialog box appears that shows the server's current settings as shown
in Remote Server Settings dialog box. In the Remote Server Settings dialog box, select the Activate
VMware Smart Assurance NOTIF checkbox, and then click OK. You can also change other server
settings in the Remote Server Settings dialog box, if desired.


Note   Edit a server’s settings... provides more information on remote server settings.


Figure 5‑3.  Remote Server Settings dialog box


18 Restart the Adapter Platform/SAM server. VMware Smart Assurance NOTIF is now activated on the
Adapter Platform/SAM server.


Note   Server setting changes made in the Remote Server Settings dialog box are persistent. When
you change server settings in the Remote Server Settings dialog box and click OK, the changes are
saved to the Notif_Settings.import file that is generated and saved to the
BASEDIR/smarts/local/conf/<icoi or ics> directory in the Adapter Platform or SAM server where
VMware Smart Assurance NOTIF is running.
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Server setting changes made in the VMware Smart Assurance NOTIF Editor are preserved even if
the repository is deleted. For example, if the repository was erased because you used the --
norestore option for server startup, the server would still use the last saved settings from the
VMware Smart Assurance NOTIF Editor saved in BASEDIR/smarts/local/conf/<icoi or
ics>/Notif_Settings.import.


Using the VMware Smart Assurance NOTIF Editor
The VMware Smart Assurance NOTIF Editor allows you to save and restore configurations into the
internal ECI and NCI configuration objects used by the underlying event management processes.
Through the VMware Smart Assurance NOTIF Editor , you can view the ECI and NCI objects and the
configuration settings associated with them through a simple tree-view structure. As shown in VMware
Smart Assurance NOTIF configuration objects in the VMware Smart Assurance NOTIF Editor topology
tree , the left pane of the VMware Smart Assurance NOTIF Editor is used to navigate through
VMware Smart Assurance NOTIF objects, and the right pane displays configuration information about the
selected object.


Note   The title bar for the VMware Smart Assurance NOTIF Editor shows the source of the current
configuration. In this case, it is an VMware Smart Assurance NOTIF configuration file named running.ncf
in the user’s BASEDIR/smarts/local/conf/icoi directory.


Figure 5‑4.  VMware Smart Assurance NOTIF configuration objects in the
VMware Smart Assurance NOTIF Editor topology tree
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VMware Smart Assurance NOTIF Editor tree view
The VMware Smart Assurance NOTIF Editor allows you to browse the configuration objects associated
within the server for each of the main classes. In the VMware Smart Assurance NOTIF Editor topology
tree view, there are four main classes:


n EnumValueMapping


n EventConfigInfo


n NotifConfigInfo


n NotifPackage


The expanded VMware Smart Assurance NOTIF Editor view in Enumerated value mapping for EVM-.
1.3.6.1.4.1.9.9.385.1.3.1 shows the EnumValueMapping configuration parameters for the EVM object
named 1.2.3.4.5.6.47.108.9. An ECI may be configured such that it requires an enumeration table
lookup (an EVM object) based on the values in the incoming raw event. For example, an ECI that is
matched to a raw event with a keyword|value pair (OID|value for SNMP) of 1.2.3.4.5.6.47.108.9|3 will
result in a value of informational when VMware Smart Assurance NOTIF checks the enumerated
value mapping table as shown in Enumerated value mapping for EVM-.1.3.6.1.4.1.9.9.385.1.3.1 .


Note   Enumeration of keyword/value pairs on page 31 provides more information on enumerated
value mapping.


Figure 5‑5.  Enumerated value mapping for EVM-.1.3.6.1.4.1.9.9.385.1.3.1


SNMP trap configuration parameters for the ECI named 1.2.3.4.5.6.47.108.10_6_10 shows the
expanded view of the EventConfigInfo class. The figure shows the SNMP trap configuration
parameters for a specific ECI named .1.2.3.4.5.6.47.108.10_6_10.


Note   Setting up ECI configuration parameters on page 32 provides more information on setting
configuration parameters for ECI objects.
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Figure 5‑6.  SNMP trap configuration parameters for the ECI named
1.2.3.4.5.6.47.108.10_6_10


Configuration parameters for the NCI named Router.Alarm-4-84-70 shows the expanded view of the
NotifConfigInfo class. Note that there is a Router.Alarm grouping of NotifConfigInfo objects: all the
NCIs associated with router alarms are listed in this group. Configuration parameters for the NCI
named Router.Alarm-4-84-70 shows the configuration parameters for a specific NCI named
Router.Alarm-4-84-70.


Note   Setting up NCI configuration parameters on page 50 provides more information on setting
configuration parameters for NCI objects.


VMware Smart Assurance Notification Module User Guide


VMware, Inc.  65







Figure 5‑7.  Configuration parameters for the NCI named Router.Alarm-4-84-70


Settings for the NotifPackage named SNMP_Traps shows the expanded view of the NotifPackage
class. VMware Smart Assurance NOTIF packages allow you to group VMware Smart Assurance
NOTIF objects into logical areas of separation. For example, a set of ECIs, NCIs, and
EnumValueMapping objects that support SNMP traps might be assigned to the SNMP_Traps
package as seen in Settings for the NotifPackage named SNMP_Traps.


Note   An object may only be assigned to a single package.


Figure 5‑8.  Settings for the NotifPackage named SNMP_Traps


Main menu options
The VMware Smart Assurance NOTIF Editor allows you to manipulate VMware Smart Assurance NOTIF
configuration files (*.ncf), both on the local machine that is running the VMware Smart Assurance NOTIF
Editor as well as remote servers. The VMware Smart Assurance NOTIF Editor accesses local
configuration *.ncf files under the File menu option, while remote operations are located under the
Remote menu option.


The VMware Smart Assurance NOTIF Editor provides key functions through the main menu such as:
managing connections to servers, editing server settings, creating, changing, merging, and saving
configurations, retrieving configurations from remote servers, storing configurations on remote servers,
and generating HTML documentation. The following sections describe all of the main menu functions.


File menu options
This section describes the options available under the File menu for local *.ncf file configurations. The File
menu options are described in the order they appear in the VMware Smart Assurance NOTIF Editor, as
shown below.
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The File menu options associated with manipulating *.ncf files on your local server are:


n New Configuration


n Open Configuration...


n Merge Configuration...


n Save Configuration


n Save Configuration As...


n Close Configuration


The File menu options associated with importing a trap_mgr.conf file to your local server and
generating an HTML version of all NCI objects are:


n Import trap_mgr.conf


n Generate HTML.


New Configuration


This option creates a new configuration on the local server (that is, a new local *.ncf configuration file).
The New Configuration option erases the memory of the VMware Smart Assurance NOTIF Editor and
opens a blank topology tree in the left pane with an untitled configuration file, as shown in New
Configuration window in the VMware Smart Assurance NOTIF Editor.


Figure 5‑9.  New Configuration window in the VMware Smart Assurance NOTIF Editor


Open Configuration...


This option opens an existing configuration file on the local server. When this option is selected,
VMware Smart Assurance NOTIF looks for any *.ncf files in the BASEDIR/smarts/local/conf/<config>
directory or the BASEDIR/smarts/conf/<config> directory on the local server.
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When you select File > Open Configuration, the Open Notif Config Filedialog box appears, as shown in 
Open Notif Config File dialog box. Select the *.ncf file you would like to open and click Open. The
selected configuration is loaded into the VMware Smart Assurance NOTIF Editor.


Figure 5‑10.  Open Notif Config File dialog box


Merge Configuration...


This option adds another *.ncf file into the existing configuration in memory. Unlike the Create or Open
Configuration options, the Merge Configuration option adds to or overwrites the existing configuration.


When you select this option, the Merge Notif Config File dialog box appears as shown in Merge Notif
Config file dialog box. Select the *.ncf file that you want to merge with your existing configuration and click
Open.


Figure 5‑11.  Merge Notif Config file dialog box


If the two configurations (that is, the existing configuration and the configuration you want to merge) have
the same object, a prompt appears to choose between Keep Existing, Always Keep Existing, Use
Imported, or Always Use Imported (see Merge Conflict dialog box). The “Always" options stop the
prompting and VMware Smart Assurance NOTIF uses that choice for the remainder of the merge
operation.
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Figure 5‑12.  Merge Conflict dialog box


Save Configuration


This option saves the existing configuration to an *.ncf file on the local server. If the existing configuration
is untitled, the VMware Smart Assurance NOTIF Editor will prompt for a filename, and the Save dialog
box will display, as shown in Save dialog box . Name your *.ncf file and click Save.


Figure 5‑13.  Save dialog box


Save Configuration As...


This option saves your existing configuration to a new *.ncf file on the local server. You can name or
rename (if the existing configuration already has a name) an existing configuration to a specified
filename. When you select this option, the Save dialog box appears as shown in Save Configuration As....
Name your *.ncf file and click Save.


Close Configuration


The Close Configuration option clears the VMware Smart Assurance NOTIF Editor memory.


Import trap_mgr.conf


The trap_mgr.conf files used to configure a TRAP-INCHARGE-OI server (SNMP Trap Adapter) may be
loaded into VMware Smart Assurance NOTIF to replicate the standard file-based functionally. All .conf file
features and options are supported. Trap_mgr.conf files can be imported into a new configuration (File >
New Configuration) or an existing open configuration (File > Open Configuration...) in the
VMware Smart Assurance NOTIF Editor.


To import a trap_mgr.conf file into a new or open configuration:


1 In the VMware Smart Assurance NOTIF Editor, select File > Import trap_mgr.conf.
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2 The Loading trap_mgr.conf dialog box appears as shown in Loading trap_mgr.conf dialog box.
Select the trap_mgr.conf file that you want to import and click Open.


Figure 5‑14.  Loading trap_mgr.conf dialog box


The configuration from the trap_mgr.conf file is loaded into the VMware Smart Assurance NOTIF
Editor.


Note   If the trap definitions contain MAP statements, they will not be imported. You need to manually
specify a value for the EnumeratedValue option in order to obtain the Map statements. Mapping
statement functionally, (trap/varbind position dependant), is replaced with true enumerated value
substitutions, (EVM's in NOTIF), that require OID's for generic substitution. Aggregation definitions
within trap_mgr.conf generally reference substitution names such as '$E$-$G$-$SomethingElse$,'
which is undetermined within the scope of NOTIF aggregation. The user should review the
trap_mgr.conf file to determine what EVM's and aggregations need to be created in NOTIF given the
appropriate OID's and names.


3 In the VMware Smart Assurance NOTIF Editor, click File > Save Configuration or File > Save
Configuration As... to save the imported configuration.


Note   When you import configuration files, they only become persistent in the Adapter Platform or
SAM server when you click Save Configuration or Save Configuration As... Otherwise, the
imported configuration is only in memory (non-persistent).


Generate HTML


This option creates an HTML version of all NCI objects for review and documentation purposes.
Index.html will provide the link to each VMware Smart Assurance NOTIF instance (see “Generating
VMware Smart Assurance NOTIF documentation” on page 95).


Exit


This option provides clean shutdown of the VMware Smart Assurance NOTIF Editor.
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Edit menu options
This section describes the options available under the Edit menu for open configurations. The Edit menu
options are described in the order they appear in the VMware Smart Assurance NOTIF Editor, as follows:


The Edit menu options are:


n Create EventConfigInfo


n Create NotifConfigInfo


n Create EnumValueMapping


n Create Package


Create EventConfigInfo


This creates a new ECI object through the VMware Smart Assurance NOTIF Editor. When you select this
option, the dialog box shown in Create EventConfigInfo feature appears.
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Figure 5‑15.  Create EventConfigInfo feature


Create NotifConfigInfo


This creates a new NCI object through the VMware Smart Assurance NOTIF Editor. When you select this
option, the dialog box shown in Create NotifConfigInfo feature appears.


Figure 5‑16.  Create NotifConfigInfo feature


Create EnumValueMapping


This creates a new EnumValueMapping object through the VMware Smart Assurance NOTIF Editor.
When you select this option, the dialog box shown in Create EnumValueMapping feature appears.


Figure 5‑17.  Create EnumValueMapping feature


Create Package


Packages can be defined to group VMware Smart Assurance NOTIF objects into sets for maintainability
and transportability. These package sets can be created as a new NotifPackage object through the
Create Package option. When you select this option, the dialog box as shown in Create Package feature
appears.
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Figure 5‑18.  Create Package feature


Remote menu options
This section describes the options available under the Remote menu for remote *.ncf file configurations.
The Remote menu options are described in the order they appear in the VMware Smart Assurance
NOTIF Editor, as follows:


The Remote menu options associated with pushing (or storing) a local *.ncf configuration file or package
to a remote server are:


n Push to server...


n Push package to server...


n Reload server...


The Remote menu options associated with retrieving a running configuration or a specific *.ncf file
from a remote server to a local server are:
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n Retrieve running configuration from server...


n Retrieve a configuration file from server...


The Remote > Edit a server’s settings menu option is used to edit server settings on a remote server.
This menu option is used to activate VMware Smart Assurance NOTIF on a remote server, as
mentioned previously in the section “Starting VMware Smart Assurance NOTIF” on page 66. Using
this menu option creates persistent server settings. Edit a server’s settings... provides details.


The Remote > Manage connections menu option is used to manage remote server connections. 
Manage connections... provides details.


Push to server...


The VMware Smart AssuranceNOTIF Editor allows you to manipulate the *.ncf files on a remote
VMware Smart AssuranceNOTIF server by pushing (or storing) the VMware Smart AssuranceNOTIF
Editor configuration to the remote server and optionally instructing VMware Smart AssuranceNOTIF
within that server to reload the *.ncf files. Reloading of the *.ncf files reloads all*.ncf files in the
corresponding BASEDIR/smarts/local/conf/< config>directories in the remote
VMware Smart AssuranceNOTIF server.


Note   Ensure there are no conflicting configurations within multiple *.ncf files as the order in which these
files are read is undetermined. Use only one *.ncf file on a remote server.


The Push to server option saves the existing open configuration to a file on a remote
VMware Smart AssuranceNOTIF Adapter Platformor SAM server of your choice. When you select this
option:


1 The Connect to a Server dialog box appears as shown in Push to server.... Choose the remote
server where you want to store your configuration and click OK. A prompt may appear to type a
password to connect to the remote server as shown in Push to server....


Note   The first time you connect to a given server when you use the
VMware Smart AssuranceNOTIF Editor during a given work session, type a password when the
prompt appears. After that, the prompt to type a password does appear on that server.


2 The Directorydialog box appears as shown in Directory dialog box. Choose the directory location on
the remote server where you want to store your configuration and click OK.


Figure 5‑19.  Directory dialog box
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3 The Select Remote Filedialog box appears as shown in Select Remote File. This is the name of the
*.ncf file that you are storing on the remote server. The *.ncf file is always stored to the
BASEDIR/smarts/local/conf/< config>directory on the remote server. Select the *.ncf file you want to
push to the remote server and click OK.


Figure 5‑20.  Select Remote File


Note   If an *.ncf file already exists in the /local/conf/< config>directory on the remote server, a prompt
appears to overwrite the existing *.ncf file or cancel.


4 The Push Completedialog box appears as shown in Push Complete dialog box. This dialog confirms
that the *.ncf file has been pushed to the remote server and prompts you to reload the
VMware Smart AssuranceNOTIF processor on that server so that the new configuration takes effect.


Note   Reloading of the *.ncf file on a remote VMware Smart AssuranceNOTIF server reloads all*.ncf
files in the corresponding icoi/ics directories in that server. Care should be taken to ensure there are
no conflicting configurations within multiple *.ncf files as the order in which these files are read is
undetermined.


Figure 5‑21.  Push Complete dialog box


5 Click Yesto reload the VMware Smart AssuranceNOTIF processor to make the new configuration
active on the remote server.


6 The Reload Completedialog box appears as shown in Reload Complete dialog box. This dialog box
confirms that the new configuration in the *.ncf file has been reloaded and is persistent in the remote
server. Click OK.


Figure 5‑22.  Reload Complete dialog box
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Push package to server...


This option allows you to store a selected *.ncf package to a remote server. When you select this option:


1 The Connect to a Server dialog box appears as shown in Push package to server.... Choose the
remote server where you want to push the package and click OK.


2 The Directory dialog box appears as shown in Push package to server.... Choose the directory
location on the remote server where you want to push the package and click OK.


3 The Select Remote File dialog box appears as shown in Select Remote File dialog box. Select the
name of the *.ncf package file you want to push to the remote server and click OK.


Figure 5‑23.  Select Remote File dialog box


4 The Push Complete dialog box appears as shown in Push complete for package dialog box. This
dialog confirms that the *.ncf package file has been pushed to the remote server and prompts you to
reload the VMware Smart Assurance NOTIF processor on that server so that the new configuration
package takes effect on that server.


Note   Reloading of the *.ncf file on a remote VMware Smart Assurance NOTIF server reloads all
*.ncf files in the corresponding icoi/ics directories in that server. Care should be taken to ensure there
are no conflicting configurations within multiple *.ncf files as the order in which these files are read is
undetermined.


Figure 5‑24.  Push complete for package dialog box


5 Click Yes to reload the VMware Smart Assurance NOTIF processor to make the new configuration
package active on the remote server.


6 The Reload Complete dialog box appears as shown in Push package to server.... This dialog box
confirms that the new configuration in the *.ncf package file has been reloaded and is persistent in the
remote server. Click OK.
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Reload server...


This option allows you to request that a remote server running VMware Smart Assurance NOTIF reload
its *.ncf configuration files. The Reload server option is used to make configuration changes active on a
remote server. For example, if an *.ncf configuration file is pushed to a remote server through the Push to
server option, or a specific *.ncf package file is pushed to a remote server through the Push package to
server option, the configuration changes on the remote server will not become active unless the Reload
server menu option is selected.


Note   Care should be taken to ensure there are no conflicting configurations within multiple *.ncf files on
the remote server, as the order in which these files are read is undetermined. Use only one *.ncf file on a
remote server.


When you select the Reload server option in the VMware Smart Assurance NOTIF Editor:


1 The Connect to a Server dialog box appears as shown in Reload server.... Choose the remote
server where you want to reload the configuration file and click OK.


2 If there are other *.ncf files in the remote server besides the *.ncf file you are pushing from your local
server to the remote server, note that all of the *.ncf files on the remote VMware Smart Assurance
NOTIF Adapter Platform or SAM server will be reloaded in the corresponding
BASEDIR/smarts/local/conf/<config> directory.


3 After the remote server has reloaded the configuration file(s), the Reload Complete dialog box
shown in Reload server... appears. This dialog box confirms that the new configuration in the *.ncf file
has been reloaded and is persistent in the remote server. Click OK.


Retrieve running configuration from server...


This option retrieves a running configuration from a remote server (that is, the existing configuration
running in the VMware Smart Assurance NOTIF Editor on the remote server). When you select this
option:


1 The Connect to a Server dialog box appears (see Retrieve running configuration from server...).
Choose the remote server from which you want to retrieve the running configuration and click OK.


2 A progress bar at the bottom of the screen indicates that the running configuration from the remote
server is being loaded into the VMware Smart Assurance NOTIF Editor on the local server, as shown
in Loading a running configuration from a remote server. In this example, the running configuration
being retrieved is a configuration file named running.ncf on a remote Adapter Platform server named
OI81-Notif-ICB88-lin.
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Figure 5‑25.  Loading a running configuration from a remote server


3 When the configuration data from the remote server is imported into the VMware Smart Assurance
NOTIF Editor on the local server:


n The VMware Smart Assurance NOTIF configuration objects in the topology tree are populated
(that is, there are now EnumValueMapping, EventConfigInfo, NotifConfigInfo, and NotifPackage
objects in the tree), and


n The word “Ready” appears in the bottom-left corner of the VMware Smart Assurance NOTIF
Editor, as shown in Running configuration from remote server loaded into VMware Smart
Assurance NOTIF Editor.


Figure 5‑26.  Running configuration from remote server loaded into
VMware Smart Assurance NOTIF Editor


4 To save the configuration to your local server:


5 Select File > Save Configuration As... 


6 Name the .ncf file and select the directory on your local server where you want to store the
configuration in the Save dialog box as shown in Retrieve running configuration from server....


Retrieve a configuration file from server...


This option retrieves a specific named *.ncf file from the remote server’s configuration directories (that is,
from the BASEDIR/smarts/conf/<config> or BASEDIR/smarts/local/conf/<config> directories). When you
select this option:


1 The Connect to a Server dialog box appears as shown in Retrieve a configuration file from server....
Choose the remote server from which you want to retrieve the specific *.ncf file and click OK.
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2 The Directory dialog box appears as shown in Retrieve a configuration file from server.... Choose a
directory on the remote server from which you want to retrieve the *.ncf file and click OK.


3 The File dialog box appears, as shown in File dialog box. This dialog provides a drop-down list of the
*.ncf files in the selected directory.


Note   If you are retrieving an *.ncf file from a remote server, and you have existing *.ncf file(s) on
your local system, be careful to ensure that there are no conflicting configurations within multiple *.ncf
files as the order in which these files are read is undetermined.


Select the *.ncf file you want to retrieve from the remote server and click OK.


Figure 5‑27.  File dialog box


4 A progress bar at the bottom of the screen indicates that the selected remote *.ncf file is being loaded
into the VMware Smart Assurance NOTIF Editor on the local server, as shown in Loading an .ncf file
from a remote server. In this example, the *.ncf file being retrieved is a configuration file named test-
iter5.ncf on a remote Adapter Platform server named OI81-Notif-ICB88-lin.


Figure 5‑28.  Loading an .ncf file from a remote server
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5 When the *.ncf file from the remote server is imported into the VMware Smart Assurance NOTIF
Editor on the local server:


n The VMware Smart Assurance NOTIF configuration objects in the topology tree are populated
(that is, there are now EnumValueMapping, EventConfigInfo, NotifConfigInfo, and NotifPackage
objects in the tree), and


n The word “Ready” appears in the bottom-left corner of the VMware Smart Assurance NOTIF
Editor as shown in .ncf file from a remote server is now loaded into the VMware Smart
Assurance NOTIF Editor.


Figure 5‑29.  .ncf file from a remote server is now loaded into the
VMware Smart Assurance NOTIF Editor


6 To save the configuration to your local server:


7 Select File > Save Configuration As... 


8 Name the .ncf file and select the directory on your local server where you want to store the
configuration in the Save dialog box (see Retrieve a configuration file from server...).


Edit a server’s settings...


This option is used to change server settings on remote Adapter Platform/SAM servers. One of the
settings you can change on a remote server is whether VMware Smart Assurance NOTIF is active on that
server. The process for activating VMware Smart Assurance NOTIF on a remote server using the Edit a
server’s settings... option is described in “Starting VMware Smart Assurance NOTIF” on page 66.


To change settings on a remote Adapter Platform/SAM server:


1 Select Remote > Edit a server's settings.


2 The Connect to a Server dialog box appears, as shown in Edit a server’s settings.... Choose the
remote server where you want to change server settings and click OK.
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3 The Remote Server Settings dialog box appears that shows the server's current settings as shown
in Remote Server Settings dialog box. The options you can change in this dialog are defined in 
Remote Adapter Platform/SAM server settings .


Figure 5‑30.  Remote Server Settings dialog box


4 Make any setting changes to the remote server in the Remote Server Settings dialog box, and click
OK.


5 Restart the Adapter Platform/SAM server.


Note   Server setting changes made in the Remote Server Settings dialog box are persistent. When
you change server settings in the Remote Server Settings dialog box and click OK, the changes are
saved to the Notif_Settings.import file that is generated and saved to the
BASEDIR/smarts/local/conf/<icoi or ics> directory in the Adapter Platform or SAM server where
VMware Smart Assurance NOTIF is running.


Table 5‑1.  Remote Adapter Platform /SAM server settings


Parameter Type
Default
value Use


Activate
VMware Smart
Assurance NOTIF


Boolean Off Determines whether VMware Smart Assurance NOTIF is active on the
server.


Event Processors Integer 4 The number of threads desired to process incoming raw events. This
setting also implicitly determines how many connections will exist in the
VMware Smart Assurance NOTIF connection pool. It is recommended
that customers work with an VMware representative to determine the
best ProcessCount number for their particular deployment.


Max Event Queue Size Integer -1 The maximum number of unprocessed events that can wait in the event
queue. If the limit is exceeded, new events are dropped. The value “-1”
means no limit.


Max Notification Queue
Size


Integer -1 The maximum number of unprocessed notifications that can wait in the
notification queue. If the limit is exceeded, new notifications are
dropped. The value “-1” means no limit.
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Table 5‑1.  Remote Adapter Platform /SAM server settings (Continued)


Parameter Type
Default
value Use


MaxEnumWildcard Integer 4 If an ECI's varbinds are checking for wildcard enumerations,
VMware Smart Assurance NOTIF drops up to this many nodes in
looking for a match.


Number of Log Files Integer 6 The maximum number of log files VMware Smart Assurance NOTIF
maintains before deleting old ones.


LogSize Integer 2000000 When a VMware Smart Assurance NOTIF log reaches this size (in
kilobytes), the file is closed and a new one is started. The size of this
setting must be between 0 and 2,097,152 KB inclusive.


LogLevel Integer Events, Info,
Warnings,
Exceptions


The log level options are:
n Exceptions Only
n Events, Info, Warnings, Exceptions
n Everything, including debug info


Manage connections...


Connections are defined within the VMware Smart AssuranceNOTIF Editor to access remote servers.
Multiple connections may be defined and given a reference name for convenience. To add a remote
server connection in the VMware Smart AssuranceNOTIF Editor, perform the following steps:


1 Select Remote >Manage Connectionsin the VMware Smart AssuranceNOTIF Editor. The Manage
Connections dialog box appears as shown in Blank Manage Connections dialog box.


Figure 5‑31.  Blank Manage Connections dialog box


2 Click Add.
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3 The Inputdialog box appears as shown in Input dialog box for remote server connection reference
name. Type a connection reference name (for example, Remote VMware Smart AssuranceNOTIF OI
server) in the Inputdialog box and click OK.


Figure 5‑32.  Input dialog box for remote server connection reference name


4 Fill in the new connection record in the right pane of the Manage Connections dialog box. An
example is shown in Manage Connections dialog box with remote server connection reference name.


Figure 5‑33.  Manage Connections dialog box with remote server connection reference
name


5 If you are connecting to a broker:


n Type the broker name in the Broker:field.


n Click Browse Nowand select a domain in the Domain: drop-down list as shown in Selecting
a domain in the Manage Connections dialog box.


n Type the username in the User: field.


Note   If you are connecting to a broker that requires authentication, select the Requires
Authenticationcheckbox and type the username in the User:field below the checkbox.
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6 If you are connecting directly to a server (that is, the Broker:field is empty):


n Type the hostname in the Host: field.


n Select a domain in the Domain: drop-down list.


n Type the username in the User: field.


Figure 5‑34.  Selecting a domain in the Manage Connections dialog box


7 Click Testto try the remote server connection. If you are connected to the server, the
Connecteddialog box appears as shown in Connection confirmation dialog box.


Figure 5‑35.  Connection confirmation dialog box
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8 Save the connection setup by clicking OK. An example of a completed connection setup is shown in 
Completed connection setup data in the Manage Connections dialog box.


Figure 5‑36.  Completed connection setup data in the Manage Connections dialog box


Note   Connections are stored in the user's preferences data on the local system, so the connection
data is persistent.


Help menu options
This section describes the options available under the Help menu. The Help menu options are described
in the order they appear in the VMware Smart Assurance NOTIF Editor, as shown below.


The general Help menu options are:


n About


n Substitutions


The Help menu options associated with migrating configuration files or configurations from previous
NOTIF versions to VMware Smart Assurance NOTIF are under the Migration submenu:


n Import from file...


n Import from an older NOTIF server...


About


Provides information regarding the current version of the VMware Smart Assurance NOTIF Editor.
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Substitutions


Provides information about the substitution variables supported between raw event values and the
notifications created through the VMware Smart Assurance NOTIF Editor.


The Help menu options associated with importing configuration files to your local server are:


Import from file...


The Import from file... option loads an .import file that contains NOTIF configuration objects from a
previous NOTIF version into the VMware Smart Assurance NOTIF Editor memory. This allows you to edit
the configuration (if desired) in the VMware Smart Assurance NOTIF Editor and save the configuration
into an .ncf file. The Import from file... option migrates your previous NOTIF configuration .import file into
VMware Smart Assurance NOTIF and converts it into an .ncf file format.


To migrate an import configuration file from a previous NOTIF version into the VMware Smart Assurance
NOTIF Editor memory:


1 In the VMware Smart Assurance NOTIF Editor, select Help > Migration > Import from file…


2 The Loading Instances from an Import File dialog box appears as shown in Loading Instances
from an Import File dialog box. Select the .import file with the NOTIF configuration objects (from the
previous NOTIF version) that you want to migrate into the VMware Smart Assurance NOTIF Editor
and click Open.


Figure 5‑37.  Loading Instances from an Import File dialog box


The configuration from the .import file is loaded into the VMware Smart Assurance NOTIF Editor.


3 In the VMware Smart Assurance NOTIF Editor, click File > Save Configuration or File > Save
Configuration As... to save the imported configuration.


Note   When you import configuration files, they only become persistent in the Adapter Platform or
SAM server when you click Save Configuration or Save Configuration As... Otherwise, the
imported configuration is only in memory (non-persistent).


The Import from File option works as follows:


n If no configuration is open (that is, you just started the VMware Smart Assurance NOTIF Editor, or
you closed a configuration), the import will create a new configuration.
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n If a configuration is open, the VMware Smart Assurance NOTIF Editor will ask you if it should
Cancel Import, Create New, or Add to Current (see Overwrite Configuration dialog box).


Figure 5‑38.  Overwrite Configuration dialog box


n When creating a new configuration, if the current configuration is unsaved, the
VMware Smart Assurance NOTIF Editor warns of this and asks whether to proceed, as shown in 
Overwrite changed configuration dialog box.


Figure 5‑39.  Overwrite changed configuration dialog box


n When reading an object (during Create New or Add to Current configuration options), if the object
does not exist, it will be created with default values.


n VMware Smart Assurance NOTIF accepts incomplete objects in the import file. Missing attributes
will be default values (if the object didn't exist) or existing values.


Note   If an object selected in the VMware Smart Assurance NOTIF Editor is changed by an
import operation, the VMware Smart Assurance NOTIF Editor may not refresh the view. You have
to click elsewhere and then back to the changed object to see the update.


Import from an older NOTIF server...


This option allows you to import a configuration from a running SAM 7.x/NOTIF 2.x server into the
VMware Smart Assurance NOTIF Editor and save it as an .ncf file on a SAM
9.2/VMware Smart Assurance NOTIF server.


Note   This option functions in a similar fashion as the Import from file option previously described. For
example, if no configuration is open, the import will create a new configuration; if a configuration is open,
the VMware Smart Assurance NOTIF Editor will ask you if it should Cancel Import, Create New, or Add to
Current, and so on.


To import a configuration from an older NOTIF server:


1 In the VMware Smart Assurance NOTIF Editor, select Help > Migration > Import from an older
NOTIF server…
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2 The Connect to a Server dialog box appears, as shown in Import from an older NOTIF server... .
Choose the running SAM 7.x/NOTIF 2.x server where you want to import the configuration from and
click OK.


The configuration from the running SAM 7.x/NOTIF 2.x server is loaded into into the
VMware Smart Assurance NOTIF Editor.


3 Select Remote > Push to Server...


4 The Connect to a Server dialog box appears. Choose the SAM 9.2 server where you want to push
the older configuration to and click OK.


5 The Directory dialog box appears, as shown in Import from an older NOTIF server... . Choose the
directory location on the SAM 9.2 server where you want to store your configuration and click OK.


6 The Select Remote File dialog box appears as shown in Import from an older NOTIF server... . This
is the name of the *.ncf file you are storing on the SAM 9.2 server. The *.ncf file is always stored to
the BASEDIR/smarts/local/conf/<config> directory on the SAM 9.2 server. Name the *.ncf file that you
want to push to the SAM 9.2 server and click OK.


7 The Push Complete dialog box appears, as shown in Import from an older NOTIF server... . This
dialog confirms that the *.ncf file has been pushed to the SAM 9.2 server and prompts you to reload
the VMware Smart Assurance NOTIF processor on that server so that the new configuration takes
effect.


Note   Reloading of the *.ncf file on a remote VMware Smart Assurance NOTIF server reloads all
*.ncf files in the corresponding icoi/ics directories in that server. Care should be taken to ensure there
are no conflicting configurations within multiple *.ncf files as the order in which these files are read is
undetermined.


8 Click Yes to reload the VMware Smart Assurance NOTIF processor to make the new configuration
active on the SAM 9.2 server.


9 The Reload Complete dialog box appears as shown in Import from an older NOTIF server... . This
dialog box confirms that the new configuration in the *.ncf file has been reloaded and is persistent in
the SAM 9.2 server. Click OK.


Note   In SAM 8.1 and above, the configurations are saved to the .ncf file and can be imported to
SAM 9.2 using Open Configuration and Push to server operation . Open Configuration... and Push to
server... provide more details.


Generating VMware Smart Assurance NOTIF
documentation
A useful function provided by VMware Smart AssuranceNOTIF through the File, Generate HTML menu
option is that it automatically creates an HTML-based document that includes information on all the
VMware Smart AssuranceNOTIF internal configuration objects (EVM, ECI, NCI, and NotifPackage
objects). This makes it easy to view all the VMware Smart AssuranceNOTIF event and notification
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information in one place. As shown in VMware Smart AssuranceNOTIF HTML documentation, index.html
provides a link to each VMware Smart AssuranceNOTIF instance—in the example below the description
is shown for the NotifConfigInfo object named Router.Alarm-3-1-3.


Figure 5‑40.  VMware Smart Assurance NOTIF HTML documentation


Note   Ensure you regenerate the HTML file when you modify configurations.


Disabling VMware Smart Assurance NOTIF
The VMware Smart Assurance NOTIF application cannot be uninstalled separately from SAM 9.2
because the VMware Smart Assurance NOTIF processor is included as part of the SAM 9.2 server
application. However, you can disable VMware Smart Assurance NOTIF on an Adapter Platform/SAM
server by performing the following steps:


1 Launch the VMware Smart Assurance NOTIF Editor by selecting Start > Programs > InCharge >
VMware Smart Assurance NOTIF Editor.


Note   You can also launch the editor by double-clicking the NotifGui.sh file (for UNIX systems) in the
BASEDIR/smarts/notif/editor directory.


2 Use the VMware Smart Assurance NOTIF Editor to connect to the running Adapter Platform or SAM
server where you want to disable VMware Smart Assurance NOTIF . Select Remote > Edit a
server's settings… and choose a server in the Connect to a Server dialog box.
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3 The Remote Server Settings dialog box appears showing the server's current settings. In the
Remote Server Settings dialog box, clear the Activate VMware Smart Assurance NOTIF
checkbox, and then click OK.


4 Configure the SNMP Trap Adapter to use the default trap_mgr_parse.asl script instead of the Notif-
trap_mgr_parse.asl script.


For example:


./sm_trapd --name=TRAP-OI --server=INCHARGE-OI --config=icoi


--port=9013 --model=sm_actions --output


--rules=icoi-trapd/trap_mgr_parse.asl --daemon


5 Configure the Syslog Adapter to use the default SysLog_mgr.asl script instead of the Notif-
SysLog_mgr.asl script.


For example:


./sm_adapter.exe --NTsErViCeNaMe=ic-syslog-adapter --name=SYSLOG-OI --server=INCHARGE-OI --


tail=/var/log/syslog --model=sm_system --model=sm_actions --output icoi-syslog/SysLog_mgr.asl


6 Restart the Adapter Platform/SAM server.
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Substitution Scripting and
Values 6
This chapter includes the following topics:


n Script parsing overview for substitution features


n Built-in operators


n Built-in functions


n Substitution values for ECI configuration parameters


Script parsing overview for substitution features
For substitution, the input is a string with embedded script. The embedded script is signalled by
surrounding it with $:


n There is no script here.


n There is $ script $ here. — Evaluates script and replaces it within the string.


n $ "There is " + script + " here." $ — This is equivalent. It's using + for concatenation of string literals.


n This is a string without a $$ script — This is an example of embedding $ in a string without starting
a script block.


Scripts have identifiers, quoted strings, and numbers:


n Identifiers must start with a letter or underscore and continue until the first non-letter, non-digit, non-
underscore character:


n Examples of identifiers are foo, _bar, and abc123.


n Examples of illegal identifiers are 2b (it starts with a digit), foo-bar (it has an embedded hyphen).


n Quoted strings start and end with the double quote character (“). To embed a double quote, use a
backslash (\) before it. To embed a backward slash, use backward slash twice (\\):


n "This is a typical string."


n "This is a string with \" an embedded double quote."


n "This is a string with \\ a backslash."
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n "This is " not a legal string."


Whitespace in the script is ignored unless it is within a quoted string.


Scripts may have function calls. A function call is an identifier followed by a set of zero or more
comma-separated arguments. The arguments may be any valid expression. For example:


n foo ()


n foo ( "string 1", bar ( identifier1, identifier2 ) )


For example, toUpper (E) would report the event's enterprise value string in upper case.


Note   Script parsing overview for substitution features lists the substitution values that can be used in
ECI configuration parameters.


Built-in operators
VMware Smart Assurance NOTIF includes the following operators for use in scripting:


n str1 + str2 — Returns the concatenation of str1 and str2.


"abc" + "def" ---> "abcdef"


n number1 + number2 — Returns the sum of the two numbers.


123 + 456 ---> "579"


Note   The script evaluation of VMware Smart Assurance NOTIF is string-based.
VMware Smart Assurance NOTIF examines the two operands and, if both are legal numbers, it sums
them. Otherwise, the two strings are concatenated. To ensure a concatenation regardless of string
content, use the concat() function described.


n number1 * number2 — Returns the product of the two numbers.


3 * 4 ---> "12"


Built-in functions
VMware Smart AssuranceNOTIF includes the following built-in functions for use in scripting:


n toLower (string) — Returns the string in lower case.


n toUpper(string) — Returns the string in upper case.


n sizeOf(string) — Returns the length of a string.


n substr(string, startPosition, length) — Returns a substring of the string, starting at 'startPosition', for
'length' characters. The first character in the string is start position 1 (this is different from many
programming languages that use 0 for the first position). If the length requested exceeds the length
available, all of the remaining characters are returned. If the start position is less than 1, an evaluation
error occurs. If the start position is beyond the length of the string, an empty string is returned.
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n concat(string1, string2, ... ) — Returns the concatenation of two or more strings. concat ( "a", "b",
"c" ) --->"abc"


n time(), time (formatString) — Returns the current time, optionally formatted according to a format
string. The format string is the typical Java language date format string (for more information, see 
http://java.sun.com/j2se/1.4.2/docs/api/java/text/SimpleDateFormat.html. If no format string is
provided, the system uses EEE, d MMM yyyy HH:mm:ss Z, which results in a timestamp such as: "
Thu, 23 Aug 2007 16:01:21 -0400."


n extract(string, separator, field) — Splits the string using the 'separator' and returns the 'field'. The
separator value is a regular expression (for information on how to format 'separator', see 
http://java.sun.com/j2se/1.4.2/docs/api/java/lang/String.html#split(java.lang.String). If there are not
enough resulting fields, an empty string is returned:


n extract ( "1,2,3,4,5,6", "," ,4 ) --->4


n extract ( "abcdef", "c", 2 ) --->"def"


n extract ( "abcdef", "c", 3 ) --->""


Substitution values for ECI configuration parameters
Substitution values for ECI configuration parameters lists the substitution values that can be used in ECI
configuration parameters, such as User Defined values, Event Setup options, and Calculated values.


Table 6‑1.  Substitution values for ECI configuration parameters


Substitution Value Description


$A$ The source text in the event.


$E$ The enterprise text in the event.


$N$ The ‘generic’ field in the event.


$S$ The ‘specific’ field in the event.


$T$ The timestamp in the event.


$SYS$ Given the source IP of the event, the node hosting the IP will be substituted.


$EVENTTEXT$ The current value of EventText.


$V1$ ----> $V20$ Replaced with the text value in the respective varbind.


$OID1$ ----> $OID20$ Replaced with the OID value in the respective varbind.


$UserDefined1$ ---->
$UserDefined20$


Notification property that can be populated with any string.


$#$ Replaced with the number of varbinds in the event.


$*$ Replaced with text consisting of all varbind OIDs and values in the event.


$V*$ Replaced with text consisting of all varbind values in the event.
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Table 6‑1.  Substitution values for ECI configuration parameters (Continued)


Substitution Value Description


$Vx(n)c$ Varbind subfield extractor. If a varbind is itself a string with subfields that can be parsed
with a character token, you can extract a particular subfield by using Vx(n)c, where:
n x is the varbind number (x value represents a varbind 1–10).
n n is the subfield desired (n value is a number specifying which of the subfields should


be used in the substitution. Subfield numbering starts with 0).
n c is the tokenizer character. The c value is a single character that can be used as a


tokenizer to parse the varbind string. In many cases this is a comma.


Example: if $V1 is Tempe,AZ,85284 then $V1(2), would give AZ.


This can also be done with the extract function. The extract function takes three
parameters: string, separator, and field.


Example: if $V1 is Tempe,AZ,85284 then extract( $V1, ",", 2) would give AZ.


$concat(string1, string2, ...)$ Will return the concatenation of two or more strings.


Example: $concat(a, b, c) would return abc.


$contains(textToSearch,
textToLookFor)$


Will return true if textToLookFor exists in textToSearch string.


$endsWith(textToSearch,
textToLookFor)$


Will return true if textToLookFor is at the end of textToSearch.


$extract(string, separator, field)$ Will split the string using the separator and returns the field.


Examples:


extract ( "1,2,3,4,5,6", "," ,4 ) ---> 4


extract ( "abcdef", "c", 2 ) ---> "def"


$getAttribute(className,
instanceName, attributeName)$


Will return the value of the given attribute from the given class and instance.


$sizeOf(text)$ Will return the number of characters in text. Text can itself be a substitution, such as $V1$.


Example: $sizeOf(True) would produce 4.


$startsWith(textToSearch,
textToLookFor)$


Will return true if textToLookFor is at the start of textToSearch.


$substr(text, pos, length)$ Will extract characters from text starting at position pos for the specified length. Text can
itself be a substitution, such as $V1$.


Example: $substr(unknown,4,2) will produce no.


$time(format)$ Will produce a string based on the current time. The substitutions are as follows:
n HH — 24 hour of day
n MM — Minute of hour
n SS — Second of minute
n MTH — Month of year (numeric)
n DD — Day of month
n YY — Year
n DOW — Day of week (3 char alphabetic)


The format characters take elements from the current time to create the text.


Examples: $time(DOW HH:MM) could produce the text Wed 22:04.


                 $time(HH:MM:SS) could produce 15:23:40.
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Table 6‑1.  Substitution values for ECI configuration parameters (Continued)


Substitution Value Description


$toLower(text)$ Will convert the characters in text to lower case. Text can itself be a substitution, such as
$V1$.


Example: $toLower(TrUe) would produce true.


$toUpper(text) $ Will convert the characters in text to upper case. Text can itself be a substitution, such as
$V1$.


Example: $toUpper(cat) would produce CAT.


$varbindCount$ Will return the number of varbinds.


$varbindKeyValue$ Will return a list of each varbind in "key: value" format, separated by commas.


$varbindValues$ Will return a list of varbind values, separated by commas.
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ASL and Java Interfacing with
VMware Smart Assurance NOTIF 7
This chapter includes the following topics:


n Writing ASL for use with VMware Smart Assurance NOTIF ECI processing


n Writing ASL for use with VMware Smart Assurance NOTIF NCI processing


n Writing a Java class for use with VMware Smart Assurance NOTIF event processing


Writing ASL for use with VMware Smart Assurance NOTIF
ECI processing
ASL hook scripts called from VMware Smart Assurance NOTIF ECI specifications must include the
following two additional definitions in the Input/Output Variables section:


DISCARD_TRAP = "";


UPDATE_USERDEF_FIELDS = "";


Sample ECI ASL hook script
A sample ECI ASL hook script is provided below for reference:


/* 


 * Sample-ECI.asl - Hook adapter for any ECI related customizations.


 */


debug = FALSE;   


// Input/Output variables.


CLASSNAME = "";


INSTANCENAME = "";


EVENTNAME = "";


SEVERITY = "";


EVENTTEXT = "";


CATEGORY = "";


EXPIRATION = "";


STATE = "";


INMAINTENANCE = "";


CLEARONACKNOWLEDGE = "";


EVENTTYPE = "";


ELEMENTCLASSNAME = "";


EVENTDISPLAYNAME = "";


ELEMENTNAME = "";
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USERDEFINED1 = "";


USERDEFINED2 = "";


USERDEFINED3 = "";


USERDEFINED4 = "";


USERDEFINED5 = "";


USERDEFINED6 = "";


USERDEFINED7 = "";


USERDEFINED8 = "";


USERDEFINED9 = "";


USERDEFINED10 = "";


USERDEFINED11 = "";


USERDEFINED12 = "";


USERDEFINED13 = "";


USERDEFINED14 = "";


USERDEFINED15 = "";


USERDEFINED16 = "";


USERDEFINED17 = "";


USERDEFINED18 = "";


USERDEFINED19 = "";


USERDEFINED20 = "";


// Input Variables


TIMESTAMP = "0";


IPADDRESS = "";


SYSNAMEORADDR = "";


ENTERPRISE = "";


GENERIC = "9999";


SPECIFIC = "9999";


// Varbind and OID values


V1 = "";


V2 = "";


V3 = "";


V4 = "";


V5 = "";


V6 = "";


V7 = "";


V8 = "";


V9 = "";


V10 = "";


V11 = "";


V12 = "";


V13 = "";


V14 = "";


V15 = "";


V16 = "";


V17 = "";


V18 = "";


V19 = "";


V20 = "";


OID1 = "";


OID2 = "";


OID3 = "";


OID4 = "";


OID5 = "";


OID6 = "";


OID7 = "";
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OID8 = "";


OID9 = "";


OID10 = "";


OID11 = "";


OID12 = "";


OID13 = "";


OID14 = "";


OID15 = "";


OID16 = "";


OID17 = "";


OID18 = "";


OID19 = "";


OID20 = "";


// Flag to discard the trap, when set to TRUE.


DISCARD_TRAP = "FALSE";


NotificationName = "";


MessageType = "";


NotifIntegration = "TRUE";


// Flag to update the UserDefined[1-20] fields and EventText, upon CLEAR


// when set to TRUE.


UPDATE_USERDEF_FIELDS = "FALSE";


if (debug) { print("Running my ECI Hook.asl "); }


START {


    .. eol


} do {


    // Default output is the same as input.


    // Set attributes in ICS_Notification.  Add any more customizations here ...


    USERDEFINED3 = "Added this in custom ruleset";


    if (debug) { print("Done with my ECI Hook.asl ");}


    return;


}


/*


 * These variables describe the formatting of this file.  If you don't


  * like the template defaults, feel free to change them here (not in 


  * your .emacs file).


 *


 * Local Variables:


 * mode: C++


 * End:


 */


Writing ASL for use with VMware Smart Assurance NOTIF
NCI processing
A sample NCI ASL hook script is provided below for reference:


/* sampleNciHook.asl


 */


default debug = TRUE;


default detailedDebug = TRUE;


default NotificationName = "";


default DISCARD_IN_NOTIF = "";


DISCARD_IN_NOTIF = "FALSE";
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icsNotificationFactory = object();


ics_domain_name = getServerName();


user = "HOOK";


aslName = this->ReadsRulesFrom->fileName;


myThread = thread();


auditText = " ".aslName." Thread=".myThread." ";


START {


    local errorOrSkip = FALSE;


    .. eol


    errorOrSkip : VERIFY_INPUT


    (!errorOrSkip)


    errorOrSkip : PRINT_SOMETHING


    (!errorOrSkip)


    


}


//Grab the ICS_Notification object using the name passed in.


VERIFY_INPUT {


    local error = FALSE;


    do {


        nObj = self->object(NotificationName);


        if (NotificationName == "" || nObj->isNull()) {


            print(time().auditText." Internal Error: ".


                  " could not find the notification".


                  " object('".NotificationName."')!");


            error = TRUE;


        }


        return error;


    }


}


/* Sample activity.


*/


PRINT_SOMETHING {


    local skip = FALSE;


    do {


  print(time().auditText.nObj->InstanceName." FROM NOTIF NCI HOOK");


 }


}


Writing a Java class for use with
VMware Smart Assurance NOTIF event processing
In VMware Smart Assurance NOTIF, you can write Java classes which can be called during event
processing to:


n Modify the various parameters that are set prior to the notification being created.


or


n Instruct VMware Smart Assurance NOTIF to discard the event it is processing.


To use a custom Java class in the VMware Smart Assurance NOTIF processor:


a Write and compile one or more Java classes that implement the notifEventProcessor interface
with the following requirements:
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b Your class must have a default constructor (one that takes no arguments).


c The VMware Smart Assurance NOTIF .jar file must be available to your Java compiler when
building your class. The .jar file is BASEDIR/smarts/classes/notif.jar.


d Package your class or classes in a .jar file.


e Install your .jar file into the BASEDIR/smarts/local/classes directory.


f Update the Notif-init.asl script to include your .jar file in the CLASSPATH:


g Locate the Notif-init.asl file in the BASEDIR/smarts/rules/ics directory.


h Use the sm_edit utility to edit the script (or manually copy it to the
BASEDIR/smarts/local/rules/ics directory and edit it there).


Note   The VMware Smart Assurance System Administration Guide provides information on how
to use the sm_edit utility.


i Locate the lines that use add_archive to add the .jar file to the CLASSPATH.


j Duplicate one of those lines and replace the name of the .jar file with your own .jar file. Do not
specify a path for the .jar file. The VMware Smart Assurance NOTIF/SAM Java class loader is
designed to look in local/classes for your .jar file.


k Save the file.


l Restart the SAM/Adapter Platform server to pick up the changed CLASSPATH.


m Add your class name to an ECI in the VMware Smart Assurance NOTIF Editor (the Java field in
the Event Options tab as shown in Writing a Java class for use with VMware Smart Assurance
NOTIF event processing and save and deploy the new .ncf file.


VMware Smart Assurance NOTIF Java API
This section provides the sources for the two interfaces that comprise the VMware Smart Assurance
NOTIF Java API.


notifEventProcessor


         package com.vmware.smarts.notif.api;


public interface notifEventProcessor


{


void process ( notifEventDataAccessor eda );


}


package com.vmware.smarts.notif.api;


public interface notifEventDataAccessor


{


public String getClassName();


public void setClassName(String className);


public String getInstanceName();  


public void setInstanceName(String val);


public String getEventName();  
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public void setEventName(String val);


public String getSeverity();


public void setSeverity(String val);


public String getEventText();  


public void setEventText(String val);


public String getCategory(); 


public void setCategory(String val);


public String getExpiration();


public void setExpiration(String val);


public String getEventState(); 


 public void setEventState(String val);


public boolean getInMaintenance();  


public void setInMaintenance(boolean val);


public boolean getClearOnAcknowledge();


public void setClearOnAcknowledge(boolean val);  


public String getEventType();  


public void setEventType(String val);


public String getElementClassName(); 


public void setElementClassName(String val);


public String getElementName();  


public void setElementName(String val);


public String getUserDefined ( int i ); // 1-20  


 public void setUserDefined ( int i, String val );


public boolean getDiscardTrap();


public void setDiscardTrap(boolean val);


 // trap data


public String getTimestamp();  


public String getSource();  


public String getSysNameOrAddr();  


public String getEnterprise();  


public String getGeneric();  


public String getSpecific(); 


public String getVarbindValue(int which);


public String getVarbindOID(int which);


}


An example plug-in processor
A plug-in processor example is provided below for reference:


         package com.example.notif;


import com.vmware.smarts.notif.api.notifEventDataAccessor;


import com.vmware.smarts.notif.api.notifEventProcessor;


public class MyNotifPlugin implements notifEventProcessor


{


 // process gets called for each event matched to the ECI


public void process ( notifEventDataAccessor eda )


 {


  // if VarBind1 (aka V1) has value 'DiscardMe',
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  // discard this event


final String vb1 = eda.getVarbindValue ( 1 );


if ( vb1.equals ( "DiscardMe" ) )


  {


   eda.setDiscardTrap ( true );


  }


 }


}


Additional notes
n Note that varbind values are referred to by their natural numbers. The index of the value of the first


varbind is 1, not 0. The example code above retrieves the value of the first varbind with
eda.getVarbindValue ( 1 );


n When specifying your class in an ECI, use the full class name. For example,
"com.example.notif.MyNotifPlugin". The string you specify is passed without modification to the JVM's
default classloader via Class.forName ().


n Plug-in processors are intended to be lightweight and you must be careful not to deploy processors
that do significant work in the constructor or during the call to process. Deploying a slow processor,
especially if it is called from a frequently used ECI, can degrade performance of the entire
SAM/Adapter Platform system.


n It is also important to remember that the processor class will be instantiated for each event it handles.
Processors that need to retain information across calls to process() can use static member data to do
so, but keeping references to the notifEventDataAccessor instance is strongly discouraged. Doing so
can delay the JVM's garbage collection of internal VMware Smart Assurance NOTIF data structures
and cause the system to use more memory than usual.


n Any exceptions (including Throwable) that occur during the execution of your class are logged as
warnings in the VMware Smart Assurance NOTIF log.
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Introduction 1
This chapter includes the following topics:
n Setting the Locale


n Locating and modifying SDK files


n Licensing SDK software


n Controlling the startup of SDK programs


n Securing access to SDK software


n Operation of the Broker


n Managing log files


Setting the Locale
A locale is a combination of language and country identifiers, and the specification of the locale is
important for the purpose of SDK externalized textual data. Clients and Domain Managers can be running
in different locales but it is important that textual data transferred to a client as part of error handling by
the Domain Manager appear in the language and country of the client. Chapter 2 Locale describes how to
specify the locales.


Locating and modifying SDK files
Some SDK files can be modified to meet the needs of your network environment. Chapter 3 Locating and
Modifying VMware Smart Assurance Files describes the directory structure of the SDK software. The
chapter also discusses the files that can be modified and how to locate the files and provides procedures
for modifying those files. Additionally, the chapter describes the files created by SDK software (for
example, logs, repositories, and saved consoles), and details how to control their location.
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Licensing SDK software
SDK software requires a license file to function. To evaluate the software, you can obtain a time-limited
evaluation license that provides access to specified features. After you purchase the software, you will
need to set up a permanent license file. Chapter 4, “License Administration,” provides procedures for
obtaining both evaluation and permanent license files for your SDK software. Topics include:


n Setting up the license file


n Starting the FLEXnet license server


n Pointing the SDK software to the license server


n Licensing additional SDK programs and adding licenses


Controlling the startup of SDK programs
SDK programs are started can either be installed as services or as manual processes. The section 
Chapter 4 Controlling the Startup of VMware Smart Assurance Software provides procedures that use the
sm_service utility to:


n Install programs as services


n Start and stop servicesSDK programs


n Start and stop processes


n Modify the runtime parameters of servicesSDK programs


Securing access to SDK software
Security is a critical concern in the world of large-scale distributed networks. Therefore, SDK security
provides a means by which network administrators can set up security to control access to the software. 
Chapter 5 Securing Access to VMware Software describes how SDK security works, as well as the
authentication processes used by the software. It then provides procedures for setting up security and
controlling access to SDK programs. The chapter also discusses how to set up encrypted connections
between SDK clients and servers.


Operation of the Broker
SDK client programs, such as a console or an adapter, use the Broker to determine where Managers are
running. When a Manager starts, it registers the hostname of the machine it is running on, as well as the
TCP port it is listening to, with the Broker. Thereafter, SDK clients retrieve this information from the Broker
so that they can communicate with the Manager. Chapter 6 Operation of the Broker describes the
functions of the Broker, provides procedures for viewing the Broker’s registry, and explains how to change
the Broker’s environment variables.


VMware Smart Assurance System Administration Guide


VMware, Inc.  6







Managing log files
Log files grow indefinitely, though slowly, under normal conditions, and need to be managed. In addition,
SDK software can maintain up to 1,000 backup log files of each log. For example, if you are generating
two log files, MYDM_en_US_UTF-8.log and MYDM_fr_UTF-8.log file, you can maintain up to 1,000
backup log files for the MYDM_en_US_UTF-8.log and 1,000 backup log files for the MYDM_fr_UTF-8.log.


You can configure the number of log files retained by SDK software. Chapter 7 Managing Log Files
discusses the management of log files, and describes how to “roll over” the files.


VMware Smart Assurance System Administration Guide


VMware, Inc.  7







Locale 2
This chapter includes the following topics:


n What is a locale


n Locale types


n Standards


What is a locale
A locale is a set of parameters that defines:


1 Language


2 Country (or region)


3 Other specific cultural elements that vary


For the purpose of SDK externalized textual data, the language and country data of the locale
specification are important.


Languages are specified in two lowercase ASCII letters. Some examples are en for English and fr for
French.


Country identifiers are specified as two or three uppercase ASCII letters. Some examples are: US,
CA, FR, and JP, for United States, Canada, France, and Japan, respectively.


Standards on page 19 provides more information on language codes and country identifiers.


A locale is a combination of the language and country identifiers into one string, connected by the
underscore (_) character. For example, the locale for English (en) as spoken in the United States
(US) is defined as en_US.


Client and Domain Manager use different locales
Client programs may be running in a locale that is not the same as the locale of the Domain Manager. For
example, a Domain Manager may be running in a process where the locale is specified as “French as
used in France.” Different end-users of an application may be concurrently connected, and use different
locales, for example “German as spoken in Germany,” and “Spanish as spoken in Spain,” or “German as
spoken in Austria.”
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It is important that textual data transferred to the client as part of error handling by the Domain Manager
appear in the language and country of the client. A German client will see German exception messages,
even if the client application is connected to a Domain Manager whose preferred language (for logging) is
French.


The server will respect the locale of the client when rendering several types of textual output. Applications
may also use classes and methods in the clsapi subsystem to enable locale-aware operations, where
appropriate.


Locale types
Each process’ locale is determined by the SM_LOCALE environment variable, as seen by that process.
When a client process attaches to a server process, they negotiate on the locale for that session. The
SM_LOCALE environment variable is discussed in SM_LOCALE.


Process locale
You can specify the locale of any SDK program, such as a client, Broker, server, utility by using the
SM_LOCALE environment variable. For all such programs, the SDK initialization logic validates the
specified value, and ensures that all internationalization features can use it predictably.


The locale can also be specified for Java applications. Use the Java property
com.vmware.cmp.dmt.locale on the startup of the Java Virtual Machine or on the command line of any
SDK program that supports the -java command operand.


Client locale
The locale of a client program may be different from the locale of the Domain Manager. There are two
different types of client locales:


n Client process locale.


n Client session locale.


The client process locale and the client session locale do not need to be the same.


Client process locale
The client process locale is the locale that is set by the SM_LOCALE variable in the environment of the
client program, such as dmctl, brcontrol, and others. The client process locale is used by default when
rendering messages generated in the client process.


Client session locale
The client session locale is the locale that is sent to a Broker or Domain Manager in two possibly ways:


n The client process locale is by default sent to the Domain Manager, and identifies the initial session
locale.
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n The client session locale can be changed by calling the setLocale() or setRemoteLocale() method.
Calling one of these methods causes a protocol verb to be executed at the server, which causes the
server to remember the client session locale.


The client program may use the setLocale() client API calls to indicate to the Domain Manager a
select locale. Setting the locale that the Domain Manager remembers for the client does not change
the configured setting of the client process locale.


Domain Manager process locale
The Domain Manager process locale is the one set by the SM_LOCALE variable in the environment of
the Domain Manager. The Domain Manager locale primarily influences logging output, and does not
impact the processing of locale for client processes or the client sessions. Conversely, the client locale,
configured or set by API call, does not influence the locale handling for the Domain Manager output.


Support locale
The process locale specified by SM_LOCALE and the Java property specifies the language for output
that the user sees. However, VMware engineering and support teams must be able to interpret log data
and other output in English. SDK programs, primarily server processes, will always generate diagnostic
information in the support locale, which is en_US. The main impact of the difference between the process
locale and the support locale applies to the SDK logging system. See Overview of message logging for
more details.


Standards
Several internationalization standards apply directly to SDK applications.


Unicode
Unicode is the universal standard of encoding for written characters and text, covering all known world
languages. UTF-8 (8-bit form) is used by SDK applications.


ISO 639 language codes
Languages are specified in two lowercase ASCII letters. Some examples of standard codes for language
are: en, fr, and ja for English, French, and Japanese respectively.


ISO 3166 country codes
This standard defines the universally recognized codes for county (or region). There are two alphabetic
standards for country codes:


n ISO-3166-1 Alpha-2 describes the two-letter codes.
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n ISO-3166-1 Alpha-3 describes the three-letter codes.


Country identifiers are specified as two or three uppercase ASCII letters. For example, US for United
States and JP for Japan.


Language and country identifiers are combined into one string, connected by the underscore
character. For example, en_US for English as used in the US, and ja_JP for Japanese as used in
Japan.
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Locating and Modifying
VMware Smart Assurance Files 3
This chapter includes the following topics:
n VMware Smart Assurance directories


n User-modifiable files


n How SDK software locates user-modifiable files


n Where SDK software writes output files


VMware Smart Assurance directories
ITOps directories lists the SDK directories and a brief description of their contents


Table 3‑1.  SDK directories


Directory Contents


/bin Executables for starting and interacting with Domain Managers as well as utilities.


/classes SDK jar files and third-party jar files upon which SDK programs depend.


/conf Domain Manager configuration files.


/doc User and reference guides.


/examples Sample files for C, C++, and Java APIs as well as examples of MODEL applications and JIIM.


/include The .h and .mdl files for components of the SDK programs.


/integration Sample probe for the integration accessor.


/l10n The l10n directory name is a lowercase L, followed by the number 10 and then a lowercase n.


Contains Resource Packages (which hold externalized and localized data, such as error strings).


/lib Shared libraries.


/local Top-level directory where local copies of configuration, rules, and script files are created and stored.


The default location where files such as repository and log files are written. The/local/l10n directory
contains new Resource Packages introduced by update kits, patches, language packs, and so on.


/perl Files used for the Perl API.
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Table 3‑1.  SDK directories (Continued)


Directory Contents


/rules ASL rule sets.


/script Utility scripts such as the license server installation scripts.


In addition to the common subdirectories, the VMware Smart Assurance Service Assurance Manager
(/SAM) includes two additional subdirectories: /actions (client and server) and /consoles.


User-modifiable files
The SDK installation includes system files, configuration files, ASL rule set files, scripts, templates, as
well as third-party software files that the SDK software uses.


Never alter SDK system files, such as executables, shared libraries, MODEL files, and setup files. Do not
alter third-party software system files provided with the Java Runtime Environment.


As part of the configuration process, you will need to make changes to some of the user-modifiable files.
The following are examples of user-modifiable files:


n Configuration files, such as ics.conf, clientConnect.conf, and serverConnect.conf (you are required to
edit these)


n ASL rule sets, such as syslog_mgr.asl


n Sample actions, such as ics-ping and ics-telnet


n Template files used to import data, such as service.data.template and topology-group.data.template


Original versions of configuration files, ASL rule sets, scripts, and template files are installed to the
BASEDIR/smarts/conf, BASEDIR/smarts/rules, and BASEDIR/smarts/script directories. When you
need to alter a file in one of these directories, make those changes to a local copy of the file. By
default, local copies of user-modifiable files should reside in BASEDIR/smarts/local or one of its
subdirectories. SDK software is designed to first search for user-modifiable files in
BASEDIR/smarts/local or one of its subdirectories. If a modified version of a file is not found in the
local area, SDK software then searches appropriate non-local directories.


To edit a file, invoke the sm_edit utility from the BASEDIR/smarts/bin directory. When used, sm_edit
automatically opens a local copy of the specified file and saves the modified file to its appropriate
location. Modifying SDK files provides further information about how to use the sm_edit utility.


You should:


n Only modify local copies of user-modifiable files.


n Always retain the original, unedited, version of these files.


Subdirectories for user-modifiable files identifies the default subdirectories that include user-
modifiable files found under BASEDIR/smarts/local. The subdirectories vary by product suite.
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Table 3‑2.  Subdirectories for user-modifiable files


Installation path Directory Description


BASEDIR/smarts/local /actions Tool scripts


/conf Configuration files


/data Import files


/rules ASL rules files


Note   The BASEDIR/smarts/local directory has been reserved for directories with local copies of user-
modifiable files as well as writable files such as logs and repository files. It typically contains directories
listed in Subdirectories for user-modifiable files. During installation, SDK software may create empty
subdirectories under the BASEDIR/smarts/local directory. These directories are reserved for use for future
service packs and Rolling Patches. The exception is the BASEDIR/smarts/local/bin directory that contains
files necessary for the successful installation of SDK software.


In addition, the BASEDIR/smarts/local/conf directory contains the runcmd_env.sh file, which is created
during installation. The runcmd_env.sh is a file for setting environment variables, including the default
location for the Broker. You can edit this file to change the default location of the Broker or to define any
SDK-wide environment variable. “Methods for setting environment variables for ITOps software” on
page 138 provides information about setting environment variables.


The product-specific naming convention used for subdirectories under BASEDIR/smarts/local/conf and
BASEDIR/smarts/local/rules (as well as their non-local counterparts) typically reflects the SDK product or
module within a product suite that uses the files.


You can alter the location for rules files, as described in Controlling the location for rule set files.


Note   If VMware installs a site-specific patch at your location, then additional directories may be included
under BASEDIR/smarts/local. Never alter files in any of these additional subdirectories.


Modifying SDK files
After you install an SDK application, you may need to modify files as part of the configuration process.
For example, if you want to secure access to SDK software, you need to change the password for the
Admin account in the serverConnect.conf and clientConnect.conf files.


To modify SDK files, use sm_edit, an SDK utility that is installed with SDK software.


Note   You must use the sm_edit utility that is included with the installation of a product suite to modify
files applicable to that suite. Do not, for example, edit IP files with the sm_edit that is installed with SAM.
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When invoked, sm_edit opens the specified file in a text editor. This utility ensures that modified files are
always saved to the appropriate local area and that non-local copies of all files remain unchanged. If an
appropriate subdirectory does not exist for the file you are modifying, sm_edit creates the appropriate
subdirectory before saving the modified file to that location. For files with header information set for
encryption, sm_edit encrypts certain fields in the file. In addition, sm_edit preserves the file permissions of
modified files, which helps ensure that important configuration files are not altered by unauthorized users.


To use sm_edit from the command line, specify the filename and include the subdirectory under /local
where the file resides. For example, to edit the ics.conf file, type the following command by using
administrative privileges:


         BASEDIR/smarts/bin> sm_edit conf/ics/ics.conf


In this example, sm_edit searches in the BASEDIR/smarts/local/conf/ics directory for the ics.conf file. If it
finds the ics.conf file, it opens the file in a text editor. If sm_edit does not find the ics.conf file in the
BASEDIR/smarts/local/conf/ics directory, it creates a local copy of the ics.conf file and writes it to the
BASEDIR/smarts/local/conf/ics directory.


If the appropriate subdirectory does not exist in the local area for the file you are modifying, sm_edit
creates that subdirectory and saves the modified file there. This ensures that the original version of the
file remains unchanged.


Specifying the text editor used by the sm_edit utility
The sm_edit utility is not a text editor. Instead, it uses the text editor specified by one of the following
means:


n SM_EDITOR environment variable, as described in “Environment variables for users” on page 140.


n VISUAL environment variable


n EDITOR environment variable


n If the SM_EDITOR, VISUAL or EDITOR environment variables are not defined, sm_edit uses the
following:


n Edit program on UNIX


You can also specify the editor that sm_edit should use by providing the --editor argument when
invoking the utility.
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How SDK software locates user-modifiable files
It is important to understand how SDK software locates user-modifiable files at runtime. In general, when
looking for a user-modifiable file, SDK software first searches in BASEDIR/smarts/local or one of its
subdirectories. If the file is not found, SDK software then proceeds to look for the file in directories that
are not intended to contain modified files. For example, when SDK software searches for a configuration
file, it first looks in BASEDIR/smarts/local/conf. If the file is not found, then SDK software proceeds to look
in BASEDIR/smarts/conf.


Note   BASEDIR/smarts can refer to different product suite directories. Therefore, the configuration file in
this example could be a configuration file for any product suite such as the IP Manager or
Service Assurance Manager.


Controlling the location for rule set files
To locate your ASL rule sets in an area other than the default location (BASEDIR/smarts/local/rules), set
the SM_RULESET_PATH environment variable. When you set SM_RULESET_PATH, SDK software first
searches for rule set files in that path location or in one of its subdirectories. If the file is not found, SDK
software then proceeds to look in the default location for modifiable rule set files.


To set SM_RULESET_PATH, add it to the runcmd_env.sh file.


Note   You normally only define the SM_RULESET_PATH environment variable if you are writing custom
ASL rule sets to work with your SDK software.


Chapter 8 Environment Variables Used by VMware Software provides further information about
SM_RULESET_PATH.


Where SDK software writes output files
The BASEDIR/smarts/local directory is also the default location for files written by SDK software. Writable
files include logs, saved consoles, and repository files. If desired, you can alter the location for log files,
as described in Controlling where SDK software writes log files. Default subdirectories for ITOps writable
files defines the default subdirectories found under BASEDIR/smarts/local that contain writable files.


Table 3‑3.  Default subdirectories for SDK writable files


Installation path Directory Description


BASEDIR/smarts/local /consoles SDK consoles that have been saved.


/logs Manager and adapter log files that SDK software has written. Also
where archived notifications are saved.


Note that installation and uninstallation logs are written to the
BASEDIR/smarts/setup/logs directory.


/repos Repository files that SDK software has written.
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For Service Assurance Manager, the BASEDIR/smarts/local/logs directory includes a
<manager_name>.audit file. This file contains audit entries that are added to all notifications in
Service Assurance Manager. The entries, which are in time order, include the following information:
date/time, notification name, source, user, and action.


The directory also includes a <manager_name>-statistics.log. This file contains entries for every
invocation of the following operations:


dmctl -s <manager_name> invoke ICS_ActionManager::ICS-ActionManager dumpStatistics <filename> 


dmctl -s <manager_name> invoke ICS_AutoActionManager::ICS-AutoActionManager dumpStatistics <filename> 


The <filename> is optional; otherwise, it is <manager_name>-statistics.log.


The information in this file enables network personnel to monitor the execution of custom actions and the
performance of administrator-defined escalations.


Controlling where SDK software writes output files
SDK software defines the location of writable files by using the SM_WRITEABLE environment variable.
By default, SM_WRITEABLE is defined as BASEDIR/smarts/local.


This means the following:


n Saved consoles are written to BASEDIR/smarts/local/consoles.


n Log files are written to BASEDIR/smarts/local/logs.


n Repository files are written to BASEDIR/smarts/local/repos.


If you want all SDK writable files to be written elsewhere, set the path by using the SM_WRITEABLE
environment variable.


To set SM_WRITEABLE, add the variable to the runcmd_env.sh file.


Controlling where SDK software writes log files
If you want SDK software to write log files to an area other than the default location, set the path by using
the SM_LOGFILES environment variable.


To set SM_LOGFILES, add the variable to the runcmd_env.sh.


SM_LOGFILES takes precedence over SM_WRITEABLE, as described in SM_LOGFILES.


sm_logerror
On Solaris and Linux systems, every SDK process creates a child process, sm_logerror, at startup. This
process has one purpose: to print a stack trace of its parent (by invoking the pstack program) should the
parent request it (which usually happens only when the parent encounters a fatal error).
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Every SDK process also starts a child running an external authenticator, sm_authority (in the default
configuration). This program either gets client credentials to send to a Manager, or checks credentials
received by a Manager. Since the authenticator itself is an SDK program, it starts its own sm_logerror.
Thus, if you follow the tree of processes under an sm_server, you might find:


  sm_server


   sm_logerror


   sm_authority


    sm_logerror


Both sm_logerror and sm_authority spend their time reading a pipe that connects them to the process
that created them. However, this process is not necessarily their parent. When the Manager starts as a
service:


n The Domain Manager runs as a daemon after starting sm_logerror and sm_authority.


n The original sm_server process is replaced by a different one.


n The child processes, sm_logerror and sm_authority, become orphans and are then inherited by the
init process, which is always process 1.


The new sm_server process retains its connection to the pipes that connected the original to the
sm_logerror and sm_authority processes, and the processes work as intended


These processes must not be "killed". Killing sm_logerror will make it impossible to print a stack trace,
and make debugging more difficult. Killing sm_authority will cause connection attempts to fail when
credentials cannot be obtained or checked.


Using the smgetinfo utility to save modifications
Each SDK product suite includes an smgetinfo utility. The utility enables you to maintain a backup copy of
all essential files and customizations from your SDK installation. It also enables you to collect data about
your current installation so that you can send the data to VMware Global Services for support purposes.
The smgetinfo utility is located in the BASEDIR/smarts/script directory.


When run, the smgetinfo utility stores the following SDK directories in compressed files:


n /conf


n /local


n /rules


n /setup


It supports the following formats:


n For UNIX:  .tar.gz


n For UNIX:  .tar.Z file


n Versions and locations of all SDK installed products


n Version of SDK
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n Version of dmctl


n Versions of all executables in BASEDIR/smarts/bin/system


n Libraries in the BASEDIR/smarts/lib directories


n Information about the host, operating system, and CPU


To run the smgetinfo utility, change to the BASEDIR/smarts/script directory and execute the following
command with administrative privileges:


On UNIX:


smgetinfo


or


sh smgetinfo
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Controlling the Startup of
VMware Smart Assurance
Software 4
This chapter includes the following topics:


n Root access requirement on Unix and Linux


n Overview of services


n About the sm_service utility


n sm_serviced and ic-serviced


n The sm_service command line


n Installing programs as services with sm_service


n Displaying installed services and their status


n Starting and stopping services with sm_service


n Modifying service parameters with sm_service


n Removing services with sm_service


n Default parameters for VMware services


n Starting a Domain Manager


n Starting other DMT processes


n Running as non root on UNIX and Linux systems


Root access requirement on Unix and Linux
Super-user access is required on Unix and Linux systems for running the following:


n sm_server - Domain Manager, handling ICMP packets, SNMP trap receiving on default port 162


n brstart - Broker on default port 426


n sm_trapd - SNMP trap receiving on default port 162


A Domain Manager must bind to multiple low numbered (less than 1024) ports for listening for ICMP
traffic. In addition, the default port for starting a Broker (426) and SNMP trap processing (162) are
also low-numbered ports. Access to low-numbered ports requires root access on Unix and Linux
systems.
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You can also start a Domain Manager with root access and then open additional ports as a non-root
user, if this is required. Running as non root on UNIX and Linux systems on page 82 provides
additional information.


Overview of services
SDK programs can be installed as services. A service is a program that, once started, is intended to run
continuously. A service is administered by the sm_service utility. SDK programs installed as services start
automatically upon system reboot; those not installed as services (manual processes or disabled
processes) require that you issue commands to start and stop them as necessary.


VMware recommends that you install SDK programs as services. You are prompted to make this choice
during the software installation. When you choose to install a program as a service, the installation
process automatically sets up the program accordingly.


The following are examples of VMware programs that should be installed as services:


n Broker


n Service Assurance Global Manager


n Service Assurance Adapter Platform (including the SNMP Trap Adapter and Syslog Adapter)


n IP Availability Manager and IP Performance Manager


Although services start automatically upon system reboot, there will be occasion for you to manually
start (and stop) a program that was installed as a service. Starting and stopping services with
sm_service on page 74 describes starting and stopping services.


If you choose not to install a program as a service, the program is installed as a manual process. If
you install a program as a manual process, you can later change it to run as a service, described in
Installing programs as services with sm_service on page 71.


In addition, you can modify a service™s settings, as described in Modifying service parameters with
sm_service on page 76.


Note   The sm_service utility cannot be used with the Failover System. The
VMware Smart Assurance Failover System User Guide provides specific information about starting,
stopping, and configuring the Failover System scripts.


About the sm_service utility
The sm_service is a cross-platform utility that sets up the environment for standard SDK applications (for
example, the Broker, Domain Managers, and adapters), and that installs those applications as services.


Additionally, the sm_service utility can start non-SDK applications.
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The implementation of the sm_service utility on:


n UNIX includes two separate programs: sm_serviced, a long-running, system-level program, and
sm_service, a command-line tool that communicates user requests to sm_serviced.


The sm_service utility is installed with the SDK software (one per system), and is used from the
BASEDIR/smarts/bin directory. Select the BASEDIR/smarts with the latest version of software. The
utility can only be used to control services on the local machine.


sm_serviced and ic-serviced
UNIX includes two separate programs: sm_serviced, a long-running, system-level program, and
sm_service, a command-line tool that communicates user requests to sm_serviced.


The sm_serviced, the component of the sm_service utility that manages programs installed as services
(either at installation, or by way of the sm_service command line), is installed with the SDK software on
UNIX systems during the installation process, and automatically starts its operations.


Thereafter, a script, ic-serviced, can be used to start and stop sm_serviced. The script is stored in a
system-specific location: /etc/init.d on Solaris and Linux. The control of services can be affected through
sm_service. The sm_service command line on page 68 provides additional information.


The ic-serviced script includes several variables. Default settings are assigned to the variables during the
installation process. If necessary, the value for the SM_SERVICE_STARTDIR variable can be edited. The
default setting for this variable is / and specifies the directory into which core files are written. If it is
changed, the setting must point to a directory on a file system with enough free space to hold a core file
of the system™s largest server.


Note   Contact VMware Global Services for information about editing the remaining variables at the
beginning of the ic-serviced script.


The ic-serviced script enables you to start and stop sm_serviced on UNIX systems and to check the
status of sm_serviced.


If sm_serviced is not already running, issue the following command with administrative privileges to start
it:


<system-dependent path>/ic-serviced start


To stop sm_serviced and all of the services managed by it, issue the following command with
administrative privileges:


<system-dependent path>/ic-serviced stop
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To check that sm_serviced is running and responding, issue the following command with administrative
privileges:


<system-dependent path>/ic-serviced status


The sm_service command line
The sm_service command line is the tool through which you communicate user requests to sm_serviced.
The basic syntax for the command line is:


sm_service <action> <options> <arguments>


Standard options
Standard options for sm_service lists the standard options that can be used with the sm_service utility.


Table 4‑1.  Standard options for sm_service


Options Description


--help Print the help text and exit.


--version Print the program version and exit.


--logname=<name> Use <name> to identify sender in the system log.


Default: The program's name.


--loglevel=<level> Minimum system logging level. The level can be: None, Emergency, Alert, Fatal, Critical,
Error, Warning, Notice, Informational, Debug. Note that Fatal is equivalent to Emergency,
Alert, or Critical.


Default: Error.


--errlevel=<level> Minimum error printing level. The level can be: None, Emergency, Alert, Fatal, Critical,
Error, Warning, Notice, Informational, Debug. Note that Fatal is equivalent to Emergency,
Alert, or Critical.


Default: Warning.


--tracelevel=<level> Minimum stack trace level. The level can be: None, Emergency, Alert, Fatal, Critical, Error,
Warning, Notice, Informational, Debug. Note that Fatal is equivalent to Emergency, Alert, or
Critical.


Default: Fatal.


--output[=<file>] Redirect output (stdout and stderr). The filename is <file>, or the --logname value if <file> is
omitted. Log files are always placed in $SM_LOGFILES or $SM_WRITEABLE/logs.
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Table 4‑1.  Standard options for sm_service (Continued)


Options Description


--facility=<facility> Instructs the VMware program to log any syslog messages with the specified syslog facility
(UNIX/Linux only). The default is Daemon.


The <facility> setting can be one of the following:
n Kern
n User
n Mail
n Daemon
n Auth
n Lpr
n News
n Uucp
n Cron
n Local0
n Local1
n Local2
n Local3
n Local4
n Local5
n Local6
n Local7


-- Stop scanning for options.


The following example highlights the use of a standard option. You must type it with administrative
privileges.


         


            BASEDIR/smarts


         /bin/sm_service --help


sm_service actions
sm_service actions lists the actions that can be performed with the sm_service utility.


Table 4‑2.  sm_service actions


Actions Description


install Installs a program as a service. It can also be used to modify the parameters of a service.


show Displays the status of the installed services. It can also display the command lines of specified
services so that they can be replicated on other systems.


start Starts one or more installed services.


stop Stops one or more installed services.


isstopped Exits with a non-zero status if the requested set of services is in a state of not running.


remove Removes one or more installed services.
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The following example highlights an action with several install options. You must type it with
administrative privileges.


t


            BASEDIR/smarts


         /bin/sm_service install --startmode=runonce --name=ic-broker 


            BASEDIR/smarts


         /bin/brstart


 --port=1234 s


Installing programs as services with sm_service
If, at installation, you installed a program to run as a service, the service will automatically start up when
your system reboots. If you did not install a program as a service, you can use sm_service to install it as a
service at any time.


The install action enables you to install a program as a service. After you define the name, description,
startmode, and path of the program, sm_service stores the information in an sm_service database
located in the /var/smarts directory (on UNIX). The sm_service then uses the information to start and run
the program as a service. You must have administrative privileges to type this command.


The syntax for the sm_service install action is:


tsm_service install [<install options>] <name> path/to/exe


[<args>...] s


In addition to the common install options, such as name, description, and startmode, the command line
must include an absolute path to the program you want to the program that you want to install as a
service. Arguments that apply to the program, that you are installing as a service, can follow the path.


For example:


UNIX


t


            BASEDIR/smarts


         /bin/sm_service install --startmode=runonce --name=ic-broker 


            BASEDIR/smarts


         /bin/brstart --port=1234 s


Install options
Install options for sm_service lists the install options that can be used with the sm_service utility.
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Table 4‑3.  Install options for sm_service


Options Description


--force Overwrite an existing service with the same name. The option is used to update or
modify the parameters of an existing service.


"--description=<DESC>" A short description of the service. Enclose the option with double quotation marks.


--startmode=<mode> The service start policy. Where <mode> is one of the following:
n runonce (start automatically when sm_serviced starts)
n automatic (starts automatically when sm_serviced does not detect that it is running)
n manual (requires an explicit start request)
n disable (cannot be started).


Default: runonce


--env=<NAME>=<VALUE> A <NAME>=<VALUE> pair which will be placed in the process environment of the
launched service. As many --env pairs as necessary can be specified. <VALUE> may
contain one or more values, separated by commas.


The syntax <NAME>= (with no specified value) has the effect of unsetting <NAME> in
the environment of the launched program.


The --env arguments are applied left to right as they appear on the command line, and
this ordering is preserved in the database.


Examples of the sm_service install action
The following provides examples of sm_service install action command lines:


UNIX


t


            BASEDIR/smarts


         /bin/sm_service install --startmode=runonce


--name=ic-broker BASEDIR/smarts/bin/brstart --port=1234 s


t


            BASEDIR/smarts


         /bin/sm_service install --startmode=runonce


--env=SM_BROKER=localhost:1234 trapadapter


BASEDIR/smarts/bin/sm_trapd s


Displaying installed services and their status
On UNIX systems, the sm_service show action displays previously installed services and their status.


The syntax for the action is as follows. You must type this command with administrative privileges:


sm_service show <name> [<name> ...]
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The show action has one option:


--cmdline


When the action is used with its --cmdline option, it displays the sm_service command line that installed
the program as a service. The command line can be reproduced and used for installing the requested
service(s) on another system.


In the absence of the --cmdlineoption, the show action displays the status of the named service (or all
services, when <name> is not given), including:


n Whether the service is running


n The name of the service


n A brief description of the service


Examples of the sm_service show action
The following provides an example of the sm_service show action.


For the status of a service, type the following with administrative privileges:


         


            BASEDIR/smarts


         /bin/sm_service show ic-broker


Output:


RUNNING ic-broker


For the command line of a service, type the following with administrative privileges:


         


            BASEDIR/smarts


         /bin/sm_service show --cmdline ic-broker


Output:


sm_service install --force --unmanaged --startmode=runonce\


 '--name=ic-broker' \


 '--description=VMware Smart Assurance


         Broker' \


 '--env=SM_CLIENTCONNECT=brokerConnect.conf' \


 '


            BASEDIR/smarts


         /bin/brstart' \


 '--port=426' \
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 '--restore=


            BASEDIR/smarts


         /local/repos/broker/broker.rps' \


 '--output'


Starting and stopping services with sm_service
The sm_service utility can be used to start and stop programs when necessary. However, the programs,
which can be either manual processes or services, must be installed with sm_service before you can use
this action.


To start a program, type the following command with administrative privileges:


sm_service start [options]


To stop a program, type the following command with administrative privileges:


sm_service stop [options]


Start options
Start options for sm_service lists the options for the start action.


Table 4‑4.  Start options for sm_service


Options Description


<name> [<name>...] Start specified processes


--all Start all automatic or runonce services that are not running. (UNIX only).


--pattern= Start all processes with absolute paths that match the wildcard pattern.


Stop options
Stop options for sm_service lists the options for the stop action.


Table 4‑5.  Stop options for sm_service


Options Description


<name> [<name>...] Stop specified processes


--all Attempt to stop all running services (UNIX only).


--pattern= Stop all processes with absolute paths that match the wildcard pattern.


--force Do not consider it an error if the service is not running.


Examples of the sm_service start and stop actions
The following provides examples of the sm_service start and stop actions.
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For the start action, type the following command with administrative privileges:


         


            BASEDIR/smarts


         /bin/sm_service start ic-broker


For the stop action, type the following command with administrative privileges:


         


            BASEDIR/smarts


         /bin/sm_service stop ic-broker


Checking whether services are stopped
The isstopped action for sm_service exits with a non-zero status if any of the requested set of services
are not running.


Isstopped options for sm_service lists the options for the isstopped action.


Table 4‑6.  Isstopped options for sm_service


Options Description


<name> [<name>...] Return status for specified processes


--all Return the status of all processes.


--pattern= Return the status of all processes with absolute paths that match the wildcard pattern.


Examples of the sm_service isstopped action
The following provides examples of the sm_service isstopped actions on UNIX. These examples also
show the use of wildcards.


The isstopped action verifies whether all of the services started from the BASEDIR/smarts directory are
stopped:


sm_service isstopped --pattern '


            BASEDIR/smarts


         /*'


This example checks if all Managers are stopped:


sm_service isstopped --pattern '*sm_server*'


Modifying service parameters with sm_service
The parameters for a service can be modified with the sm_service install action. Installing programs as
services with sm_service on page 71 provides additional information. The --force option, which overwrites
the existing parameters, must be used with the install action when you modify a service.
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The syntax for the sm_service install action (to modify service parameters) is:


sm_service install --force


You must type this command with administrative privileges.


To modify service parameters:


1 Stop the existing service with the sm_service stop action.


2 Use the sm_service show action with the --cmdline option to display the command line that was
used to install the existing service.


3 Use the sm_service install action with the --force option, copy the displayed command line from 
step 2 after the --force option, and modify the parameters that need to be changed.


4 Start the modified service.


Removing services with sm_service
One or more existing services can be removed from the system, when necessary, with the sm_service
remove action.


The syntax for the sm_service remove action is:


sm_service remove <name> [<name>...]


You must have administrative privileges to type this command.


Example of the sm_service remove action
The following provides an example of the sm_service remove action.


         


            BASEDIR/smarts


         /bin/sm_service remove trapadapter


You must have administrative privileges to type this command.


Default parameters for VMware services
During installation, SDK products can be installed as services. When installed as services, default values
are specified for the parameters that are associated with the services.
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This section lists the default parameters associated with SDK products, and briefly describes them. The
installation guide that accompanied your product suite provides examples of using the sm_service install
command.


If you need to modify the default parameters of a currently installed service, use the steps found in
Modifying service parameters with sm_service on page 76.


Common sm_server options
Several sm_server options are common to all Managers that are installed as services (the
IP Availability Manager, for example, and the Service Assurance Manager). Common sm_server options
lists these sm_server options.


Exceptions to these parameters are noted and described with the default parameters for the individual
SDK products.


Table 4‑7.  Common sm_server options


Options Description


--name=<name> Specifies the name of the Manager (Manager or Global Manager).


--config=<cfg> Specifies the sm_server configuration file to use. Configuration files are loaded from
the directories BASEDIR/smarts/local/conf/<cfg> and BASEDIR/smarts/conf/<cfg>.


--port=<port> Specifies the alternate Manager port.


--bootstrap=<file> Specifies the alternate bootstrap configuration file. The file name is relative to the
configuration directory (as set by the --configoption). The default is bootstrap.conf.


--ignore-restore-errors Indicates ignore errors encountered while restoring the saved topology.


--norestore Indicates do not attempt to restore any saved objects.


--subscribe=<sub> Start a subscription adapter that automatically subscribes to the specified
notifications.


--broker=<location> Specifies the alternate Broker location as host:port. Also -b <location>.


--output[=<file>] Redirects the output (stdout and stderr). The file name is <file>, or the --logname
value if <file> is omitted. Log files are always placed in BASEDIR/smarts/local/logs.
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Table 4‑7.  Common sm_server options (Continued)


Options Description


--daemon Run the SDK program as a daemon (UNIX only). Messages generated from internal
logging calls are directed to the log file. Log files are written to the
BASEDIR/smarts/logs directory.


--facility=<facility> Instructs the VMware program to log any syslog messages with the specified syslog
facility (UNIX/Linux only). The default is Daemon.


The <facility> setting can be one of the following:
n Kern
n User
n Mail
n Daemon
n Auth
n Lpr
n News
n Uucp
n Cron
n Local0
n Local1
n Local2
n Local3
n Local4
n Local5
n Local6
n Local7


To display a complete list of the sm_server options on your system, type the following command with
administrative privileges:


         


            BASEDIR/smarts


         /bin/sm_server --help


Common sm_adapter options
Several sm_adapter parameters are common to all adapters that are installed as services (the
Syslog Adapter, for example, and the SNMP Trap Adapter). Common sm_adapter options lists these
sm_adapter parameters or options.


Exceptions to these parameters are noted and described with the default parameters for the individual
SDK products.


Table 4‑8.  Common sm_adapter options


Options Description


--name=<name> Specifies the name of the adapter.


--model=<name> Specifies the name of model library to load.
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Table 4‑8.  Common sm_adapter options (Continued)


Options Description


--tail=<path> Specifies read input by tailing a file.


--rserver=<name> Specifies auto-reconnect parser to Manager.


--server=<name> Specifies connect parser to Manager.


--broker=<location> Specifies the alternate Broker location as host:port. Also -b <location>.


--output=<file> Directs the output (stdout and stderr). The file name is <file>, or the --logname value if
<file> is omitted. Log files are always placed in BASEDIR/smarts/local/logs.


--daemon Run the SDK program as a daemon (UNIX only). Messages generated from internal
logging calls are directed to the log file. Log files are written to the BASEDIR/smarts/logs
directory.


--facility=<facility> Instructs the SDK program to log any syslog messages with the specified syslog facility
(UNIX/Linux only). The default is Daemon.


The <facility> setting can be one of the following:
n Kern
n User
n Mail
n Daemon
n Auth
n Lpr
n News
n Uucp
n Cron
n Local0
n Local1
n Local2
n Local3
n Local4
n Local5
n Local6
n Local7


To display a complete list of the sm_adapter options on your system, type the following command with
administrative privileges:


         


            BASEDIR/smarts


         /bin/sm_adapter --help


Common sm_sdi options
Several sm_sdi options are common to the components of the SQL Data Interface Adapter that are
installed as services. Common sm_sdi options lists these sm_sdi options.


Exceptions to these parameters are noted and described with the default parameters for the individual
SDK products.
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Table 4‑9.  Common sm_sdi options


Options Description


--broker=<location> The alternate Broker location as host:port. Also -b <location>.


--name=<name> The name of the SQL Data Interface Adapter component. Also -n <name>.


--config=<cfg> Specifies the directory of the sm_sdi configuration files: sdi_ics.conf, sdi_sql.conf and
sdi_odbc.conf. Configuration files are loaded from the directories
BASEDIR/smarts/local/conf/<cfg> and BASEDIR/smarts/conf/<cfg>.


--bootstrap=<file> Specifies the alternate bootstrap configuration file. The filename is relative to the
configuration directory (as set by the --configoption). The default is bootstrap.conf.


--nonpriv Allow sm_sdi to run under a nonprivileged user ID. This option must be specified in order
for a nonprivileged user to start sm_sdi.


To display a complete list of the sm_sdi options on your system, type the following command with
administrative privileges:


         


            BASEDIR/smarts


         /bin/sm_sdi --help


Starting a Domain Manager
The sm_server command can be used to start a Domain Manager. The syntax of the command is as
follows:


sm_server [<options>...] 


Some of the common sm_server options are described in Table 7 on page 60.


Table 4‑10.  Common sm_server options


Options Description


--name=<name> Specifies the name of the Manager.


--config=<cfg> Specifies the sm_server configuration file to use. Configuration files are loaded from
the directories BASEDIR/smarts/local/conf/<cfg> and BASEDIR/smarts/conf/<cfg>.


--port=<port> Specifies the alternate Manager port.


--bootstrap=<file> Specifies the alternate bootstrap configuration file. The file name is relative to the
configuration directory (as set by the --config option). The default is bootstrap.conf.


--ignore-restore-errors Indicates ignore errors encountered while restoring the saved topology.


--norestore Indicates do not attempt to restore any saved objects.


--subscribe=<sub> Specifies start a subscription adapter that automatically subscribes to the specified
notifications.


--broker=<location> Specifies the alternate Broker location as host:port. Also -b <location>.
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Table 4‑10.  Common sm_server options (Continued)


Options Description


--output[=<file>] Messages generated from internal logging calls are directed to the log file. The file
name is <file>, or the --logname value if <file> is omitted. Log files are always placed
in BASEDIR/smarts/local/logs.


--daemon Run the SDK program as a daemon (UNIX only). Messages generated from internal
logging calls are directed to the log file. Log files are written to the
BASEDIR/smarts/logs directory.


--facility=<facility> Instructs the DMT program to log any syslog messages with the specified syslog
facility (UNIX/Linux only). The default is Daemon.


The <facility> setting can be one of the following:
n Kern
n User
n Mail
n Daemon
n Auth
n Lpr
n News
n Uucp
n Cron
n Local0
n Local1
n Local2
n Local3
n Local4
n Local5
n Local6
n Local7


To display a complete list of the sm_server options on your system, type the following command with
administrative privileges:


BASEDIR/smarts /bin/sm_server --help


Starting other DMT processes
The SDK provides additional commands for starting Brokers and adapters.


Broker
The brstart command is used to start a Broker. The syntax of the brstart command is as follows:


brstart [<options>...]


brstart options describes the options available for the brstart command.
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Table 4‑11.  brstart options


Options Description


--backup=<file> Backup file for Broker state; default BASEDIR/smarts/repos/broker/broker.rps.


--restore=<file> Restore Broker state from a backup file. Also -R <file>.


--port=<port> Alternate Broker port; default 426. Also -p <port>.


Adapter
The sm_adapter command can be used to start an adapter. Common sm_adapter options describes the
common sm_adapter options.


Table 4‑12.  Common sm_adapter options


Options Description


--name=<name> Specifies the name of the adapter.


--model=<name> Specifies the name of model library to load.


--tail=<path> Specifies read input by tailing a file.


--rserver=<name> Specifies auto-reconnect parser to Manager.


--server=<name> Specifies connect parser to Manager.


--broker=<location> Specifies the alternate Broker location as host:port. Also -b <location>.


--output=<file> Messages generated from internal logging calls are directed to the log file. The file name is
<file>, or the --logname value if <file> is omitted. Log files are always placed in
BASEDIR/smarts/local/logs.
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Table 4‑12.  Common sm_adapter options (Continued)


Options Description


--daemon Run the SDK program as a daemon (UNIX only). Messages generated from internal
logging calls are directed to the log file. Log files are written to the BASEDIR/smarts/logs
directory.


--facility=<facility> Instructs the DMT program to log any syslog messages with the specified syslog facility
(UNIX/Linux only). The default is Daemon.


The <facility> setting can be one of the following:
n Kern
n User
n Mail
n Daemon
n Auth
n Lpr
n News
n Uucp
n Cron
n Local0
n Local1
n Local2
n Local3
n Local4
n Local5
n Local6
n Local7


To display a complete list of the sm_adapter options on your system, type the following command with
administrative privileges:


         


            BASEDIR/smarts


         /bin/sm_adapter --help


Running as non root on UNIX and Linux systems
Additional options for running as non rooton UNIX and Linux systems describes two options that are used
in conjunction with each other to run as non root. These two options are only available on UNIX and Linux
systems. These options are available for the sm_server, brstart, and sm_adapter commands.
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Table 4‑13.  Additional options for running as non rooton UNIX and Linux systems


Options Description


--privopen=<arg>[,<arg>] Note   This option is only used in conjuction with the --run-as-user option to run as non root.


Opens privileged sockets. The <arg> parameter has the following syntax:


<type>[:<family>]:<port>[,<count>]


where:
n <type> is one of the following:


TCP (for a TCP connection)


UDP (for a datagram)


IP (for a raw socket)
n <port> is one of the following:


The required privileged port for a TCP socket


The required privleged port for a UDP socket


The protocol for IP
n <family> is one of the following:


:v4 (IPv4 address family)


:v6 (IPv6 address family)


If <family> is not specified, the address family defaults to IPv4.
n <count> is the number of sockets of the type, family and port. The default count is 1.


--run-as-user=<username> Note   This option is only used in conjuction with the --privopen option to run as non root.


Specifies a valid user name.


The --privopen and --run-as-user options are used in conjunction to run a Domain Manager with non root
privileges. The Domain Manager can startup as root, open privileged ports, and change to a non root
user.


You can open multiple ports by repeating the <arg> parameter. Each instance is separated by a comma
(,). For example:


--privopen=UDP:v4:161,2 


--privopen=IP:1,4 


--privopen=IP:v6:1 


--run-as-user=testuser1


In this example:


n The first privopen line opens two UDP IPv4 sockets on port 161.


n The second privopen line opens four raw IPv4 sockets for ICMP.


n The third privopen line opens one raw IPv6: socket for ICMP.


After the sockets are opened, the process will change to run as user, "testuser1".
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Stopping DMT programs
This section describes how to stop active DMT programs.


Stopping active DMT programs (UNIX)
1 Determine if any Domain Managers are running by using the brcontrol utility from


BASEDIR/smarts /bin:


 # ./brcontrol -b <host>:<port>


               


            


Table 4‑14.  Next steps for detecting and stopping programs


The Broker is on the And brcontrol displays. Do this


Same host “Error attaching to broker”
message


The Broker is not running. Go to step 3 on page 65 .


List of servers registered
with the Broker


n The Broker did not shut down.
n If any servers are still running on the host, these did not shut


down.


Go to step 2 on page 65


Different host List of servers registered
with the Broker


n If any servers are still running on the host where you will install
the SDK, these did not shut down. Go to step 2 on page 65 .


1 Stop any Domain Manager that is still running. If the Broker is on the host, stop the local Broker:


n To stop any manager that is still running, use the dmquit utility from BASEDIR/smarts /bin:


  # ./dmquit --server=<


                     servername


                     >


                     


  # ./brquit --broker=localhost:<port>


                     


                  


2 Determine if any other DMT processes are still running and shut the processes down:


n Detect the processes using the following command:


 # ps -ef | grep sm_


 # kill <pid>
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Securing Access to VMware
Software 5
This chapter includes the following topics:
n SDK security features


n How SDK security works


n Configuring authentication


n Controlling authentication


n Encryption


n Encrypted passwords


n Encrypted seed files


n Encrypted connections


n Configuring a secure Broker


n Additional safeguards


n Example security configurations


SDK security features
SDK software provides multiple levels of security which SDK administrators can use to secure their
system and control access to it. The various levels of security can be implemented through:


n Authentication and user privileges


Client-server connections can be controlled on both the client and server sides of the system. The
system is secured by using authentication records and by assigning connection privileges on the
server side. When a client initiates a connection to a server, the client must supply appropriate
authentication to the server before the connection (as defined by the connection privileges) is
permitted. “Configuring authentication” on page 89 provides detailed information.
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n Encrypted passwords


Passwords can be encrypted in the serverConnect.conf, clientConnect.conf, and brokerConnect.conf
files. Encryption is based on a secret phrase, common to all of the SDK applications that must
interact, and is used to encrypt password fields in the authentication records. “Encrypted passwords”
on page 102 provides detailed information.


Passwords can also be encrypted in seed files. “Encrypted seed files” on page 104 provides detailed
information.


n Encrypted connections


SDK software can provide three levels of security above cleartext communication: Diffie Helman-
Advanced Encryption Standard (DH-AES), encryption based on the site secret, and DH-AES used in
conjunction with the site secret. The levels of security are configured by way of values for
environment variables. “Encrypted connections” on page 105 provides detailed information.


The SDK security features are enabled with default settings when you install SDK software. The
default security settings are thoroughly documented and permit access to the system. As a result, you
should change the default usernames, passwords, and the secret phrase to enforce access control to
SDK software. In addition, you should restrict access to the security configuration files, as described
in Specifying alternate security configuration files.


Note   An SDK administrator can also place access restrictions on certain console operations by
applying user profiles. This ability to restrict SDK users to certain operations is described in the
VMware Smart Assurance Service Assurance Manager Configuration Guide.


How SDK security works
SDK security features apply to authentication and communication connections.


Authentication occurs whenever a client program initiates a connection to a server program. The client
passes an SDK username and a password to the server. The server determines whether the client is
allowed to connect and, if the connection is allowed, what privileges the client is granted.


Secure communication connections are implemented through the use of the Diffie Helman-Advanced
Encryption Standard (DH-AES), encryption based on a site secret, or DH-AES used in conjunction with
the site secret.


To properly configure the security system, you must understand how the security system works. The
answers to the following questions will help:


n Which programs are servers and which are clients?


n How does a server authenticate a client?


n How does a client obtain a username and password to pass on to a server?
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n How does encryption apply to authentication as well as communication connections?


Note   For the UNIX account used to run SDK processes, if the system administrator sets explicit
permissions for the file mode creation mask (the umask) for a parent process, SDK software respects
those permissions. For processes started by the SDK sm_serviced program described in
sm_serviced and ic-serviced on page 67, the umask permission is inherited.


Server and client programs for SDK software
Knowing which SDK programs function as servers and which function as clients can help you understand
how to configure security. Simply stated, a client is any SDK program that initiates a connection to
another SDK program. Programs can act both as a client and as a server.


ITOps server and client programs lists some server and client programs and shows how they can interact.


Table 5‑1.  SDK server and client programs


Server programs Client programs


Broker Service Assurance Failover System


Command-line utilities such as dmctl and brcontrol


Global Console users


Global Manager


Notification Adapters


Service Assurance Adapter Platform


Tools


Report Manager


SDK Beacon


Application Connectivity Monitor


Broker Command-line utilities such as dmctl and brcontrol


Notification Adapters


Tools


Report Manager


SDK Beacon


Global Manager Service Assurance Failover System


Broker


Command-line utilities (dmctl)


Global Console users


Notification Adapters


Tools


Global Manager


Report Manager
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Table 5‑1.  SDK server and client programs (Continued)


Server programs Client programs


Service Assurance Adapter Platform Broker


Command-line utilities (dmctl)


Global Manager


sm_ems


SNMP Trap Adapter


Syslog Adapter


IP Availability Manager Global Console


IP Performance Manager Global Console


IP Discovery Manager Global Console


SDK Beacon Global Console


Application Connectivity Monitor Global Console


Note   The Broker functions as both a server and a client. In addition, when Service Assurance Managers
are deployed in a multi-tiered environment, a Service Assurance Manager may also function as both a
server and a client.


Note that the server and client programs listed in ITOps server and client programs can be installed on
the same host. For example, it is common for the Broker and a Service Assurance Manager to run on the
same host.


Server authentication
When a client program initiates a connection to a server, it must provide an SDK username and
password. A server authenticates a connection request by comparing the SDK username and password it
receives from a client to the authentication records in its configuration file, serverConnect.conf. The
server uses the first authentication record that matches the information sent by the client.


The authentication records are reread for each attempted connection so any changes to the file will take
effect immediately.


The Global Console always displays a log-on dialog box where a user must type an SDK username and
password. Other SDK applications can prompt for an SDK username and password or be configured to
automatically send the username and password.


For example, when a Global Console connects to a Service Assurance Manager, it sends an SDK
username and password to the Service Assurance Manager. The Service Assurance Manager compares
the credentials to the authentication record listed in its serverConnect.conf file. If the first matching record
allows the connection, the Service Assurance Manager accepts the connection and grants the user the
privileges specified by the authentication record. If the username and password do not match an
authentication record, the connection is refused.
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Client authentication
Other than the Global Console, most Most clients, by default, automatically send authentication
information to the server. This information is stored in a clientConnect.conf file. A client that uses
automatic authentication reads the records in the order that they appear, selecting the first record whose
login username matches the user that runs the client and whose target matches the name of the server
that is being connected to. Once it finds a match, the client sends the SDK username and password to
the target server as authentication credentials. If the authentication succeeds, the server tells the client its
access privilege. If the authentication fails, the server refuses the connection and the failure is recorded in
the server™s log file.


Client authentication files are reread for each attempted connection. As such, you can edit the
configuration files at any time and the changes take effect immediately.


The Broker uses its own client connection file, brokerConnect.conf.


For example, when a Domain Manager (such as an VMware Smart Assurance IP Availability Manager)
registers with a Broker, the Domain Manager sends an SDK username and password from its
clientConnect.conf to the Broker. The Broker checks the username and password against the records in
its serverConnect.conf. Based on the results, it will grant or deny a connection.


However, when the Broker checks whether a registered Domain Manager is alive (by pinging the
manager), the Broker must authenticate with that Domain Manager. To do this, it finds an SDK username
and password in its brokerConnect.conf file to send to the Domain Manager. The Domain Manager
checks for the username and password in its serverConnect.conf and either grants or denies the right for
the Broker to ping it.


Encryption
By default, encryption is enabled during the installation process. All SDK suites and applications that
interact with each other must share a common secret phrase. The security configuration files and files
with passwords to SNMP v3 devices all contain encrypted information.


The basis for encryption is a secret phrase that gets transformed into the imk.dat file. This file is the basis
of encryption for SDK programs. The programs use the site secret to encrypt passwords in the
configuration files and keywords in seed files, as well as to encrypt connections between SDK programs.


Configuring authentication
This section describes the components of authentication. It covers the content and syntax of the security
files, the default authentication records provided in each file, and how to specify alternate security
configuration files.


Syntax of the security files
This section describes the syntax of the serverConnect.conf, clientConnect.conf, and brokerConnect.conf
files.
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Each file consists of one or more authentication records, each of which contains four fields. Note the
following:


n A line that starts with two forward slashes (//) or a pound sign (#) is considered a comment and
ignored.


n The fields of each authentication record are separated by colons (:).


n Any white space before, after, or between fields, is ignored. If the field value contains a space, you
need to add an escape character, the backslash (\), before the space. When a backslash is
encountered, the following character loses any special significance and is used as is.


Note   The first line of each of the configuration files contains encryption information. Do not change
this line unless you want to disable encryption. To comment out the line, add a second pound sign.


The clientConnect.conf, brokerConnect.conf, and serverConnect.conf are read from top to bottom.
For example, when a client selects a record for automatic authentication, it uses the first record with a
matching target and SDK username. If that username is denied a connection by the server, the client
does not try again. The ordering of authentication records is important because you can use
wildcards for certain fields. In general, more specific authentication records should be listed first. 
Chapter 9 Wildcards Used by VMware Software provides additional information about wildcards.


Server authentication records
Server authentication involves setting up authentication records in the serverConnect.conf file. Each
record contains information to control access to a particular server, an SDK username and password, and
a connection privilege. To modify this file, use the sm_edit utility as described in Modifying SDK files.


Note   Always use sm_edit utility to edit the serverConnect.conf. This is particularly important if the
passwords are encrypted. When you use the sm_edit utility to edit the file, it saves changes to the file in
BASEDIR/smarts/local/conf and encrypts the passwords; it does not modify the default, non-encrypted
version of the file.


Description of serverConnect.conf
The serverConnect.conf file defines who can connect to which server and what privileges they are
granted. By default, separate versions of the file reside in the BASEDIR/smarts/conf and the
BASEDIR/smarts/local/conf directories on the system where the server is running. The first version does
not contain encrypted passwords, so the default values are accessible by anyone who can read the file.
The version in BASEDIR/smarts/local/conf contains encrypted passwords.


The format of a record in serverConnect.conf is:


<target>:<


            SDK


         


          username>:<password>:<privilege>
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Field descriptions for serverConnect.conf describes the four fields of an authentication record in the
serverConnect.conf file.


Table 5‑2.  Field descriptions for serverConnect.conf


Field Definition Value


<target> Name of the server for which this
connection is intended.


A server will only read this line if its
name matches the value of the target
field.


Can be a matching pattern with wildcards or one of the
following special values:
n <BROKER> indicates that this record applies only to the


Broker.
n ~<BROKER> indicates this record applies to all servers


except the Broker.


<SDK username> SDK username for the client
requesting a connection.


Can be a matching pattern with wildcards or the following
special value:
n <DEFAULT> is provided for legacy clients that cannot


send a username.
n <AUTO> is provided for site-specific credentials.


<password> Password for the SDK user requesting
a connection.


Can be a password or one of the following special values:
n <SYS> indicates that the SDK username must be a valid


login name on the local system. The server passes the
credentials to the host operating system for validation.


n <DEFAULT> is provided for legacy clients that cannot
send a password.


n <AUTO> is provided for site-specific credentials.


<privilege> Access privileges of the client. Valid values include:
n All
n Monitor
n None
n Ping


Remember that during the authentication process the server receives a connection target, SDK
username, and password from a client. The server checks each of its records looking for a match. When it
finds the first match, it sends the appropriate privilege back to the client. Otherwise, the server logs the
failed authentication.


Connection privileges
Connection privileges are specified in the serverConnect.conf file. SDK authentication features provide for
four levels of privileges:


n All provides full access to all server functions. It is required for all adapter-to-server and server-to-
server connections and by all command line utilities, with a few exceptions. This level of authorization
is also required by administrative consoles. However, this level of access can be further restricted
through user profiles. The
VMware Smart Assurance Service Assurance Manager Configuration Guide provides additional
information about using user profiles to restrict access to console operations.
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n Monitor access supports a monitoring console. A monitoring console cannot change server database
or configuration parameters except in special circumstances such as acknowledgement of
notifications. Only consoles support Monitor access. If you run a secure Broker, the Broker must also
support ping (<BROKER>:BrokerNonsecure:Nonsecure:ping).


n None prevents access to the server. This privilege can be used to explicitly prevent an SDK user from
accessing the server.


n Ping is a special access privilege that allows connections to a server, but only to ping the server and
check whether it is functioning. A Broker requires Ping access to check the status of servers and is
sufficient to allow the dmctl command line utility to connect to a server and execute the ping
command.


Client authentication records
Most clients connect to servers without requiring a user to type an SDK username or password. When
this happens, a client parses a configuration file for a username and password to send to the server for
authentication instead of prompting a user. Most clients use the clientConnect.conf. The Broker uses its
own file, brokerConnect.conf.


Note   The Broker only uses brokerConnect.conf to send authentication to other processes so that it can
ping them.


Description of clientConnect.conf and brokerConnect.conf
By default, these files are located in the BASEDIR/smarts/conf directory. The sm_edit utility saves
changes to the file in BASEDIR/smarts/local/conf and does not modify the original version of the file.


The format of a record in the clientConnect.conf or brokerConnect.conf is:


<login user>:<target>:<


            SDK


         


          username>:<password>


Fields for clientConnect.conf and brokerConnect.conf describes the four fields of an authentication record
in the clientConnect.conf and brokerConnect.conf files.


Table 5‑3.  Fields for clientConnect.conf and brokerConnect.conf


Field Definition Value


<login user> System login name of the person or
process attempting a connection.


Can be a matching pattern with wildcards.


<target > Name of the server to which the
client is trying to connect.


Can be a matching pattern with wildcards or one of the
following special values:
n <BROKER> indicates that this record applies only to the


Broker.
n ~<BROKER> indicates this record applies to all servers


except the Broker.
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Table 5‑3.  Fields for clientConnect.conf and brokerConnect.conf (Continued)


Field Definition Value


<SDK username> SDK username that is sent to server
for authentication.


Can be a username or one of the following special values:
n <USERNAME> indicates that the username under which


the current process is logged in as is sent as the SDK
username.


n <PROMPT> indicates that the client program asks the
user to provide an SDK username.


n <AUTO> is provided for site-specific credentials.
n <DEFAULT> mimics legacy client authentication.


<password> Password that is sent to the server
for authentication.


Can be a password or one of the following special values:
n <PROMPT> indicates that the client program asks the


user to provide a password.
n <AUTO> is provided for site-specific credentials.
n <DEFAULT> mimics legacy client authentication.


It is important to remember that an SDK program runs under the login name of the user who started it.
This has several implications:


n A user account must provide sufficient privileges for the program to function properly. For example, a
Manager may need to run with root privileges because it sends ICMP pings or receives SNMP traps.


n A Domain Manager is as a Broker, and the Broker is listening on port 426. Port 426 is a privileged
port, meaning the process must be running as root to open the port. Ports numbered below 1024
require root privileges.


Note   A process, without being root, can connect to a process listening on a port below 1024.


n A user’s system login name must correspond to an SDK username in the clientConnect.conf file or an
SDK username and password will not be sent to a server for authentication. In the clientConnect.conf
record, a user’s login name and SDK username do not have to be identical.


Running without root privileges
All Domain Managers do not need to send ICMP pings or receive SNMP traps and, therefore, do not
need to run with root privileges.


n Start a Broker on a port that is not privileged. VMware software registers the following non privileged
ports:


n Broker is port 426


n Domain Manager is port 4426


The Broker could be started on port 4426 if a well-known port is required.


n Domain Managers can startup as root, open privileged ports, and then change to a non root user, as
described in Running as non root on UNIX and Linux systems.
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Special authentication values
Special authentication describes the configuration of the serverConnect.conf, clientConnect.conf and
brokerConnect.conf by using the special values <SYS>, <PROMPT>, <AUTO>, and <DEFAULT>. These
values control system, site-specific and legacy authentication.


System authentication
System authentication uses the operating system username and password to authenticate clients. This
method is configured in serverConnect.conf. By using this method, you give every console operator an
account on the host on which the server runs. The operators log in by using the username and password
defined for that account. (The account can be disabled to prevent actual interactive access to the
system.) By using this method:


n Each console operator has a unique username and password.


n Accesses to the system can be traced to a particular user.


n Access can be individually revoked.


The use of <SYS> for the password allows the use of common password administration across
applications and avoids having the password appear in cleartext in the file in unencrypted
installations.


This mechanism can readily be extended to provide similar controlled access for administrators. For
example, you could add the following records to serverConnect.conf:


* : fred|george : <SYS> : All


* : * : <SYS> : Monitor


This example would grant the users “fred” and “george” All access, once they provide the passwords
for their accounts on the host. Other users providing the correct password are granted Monitor
access.


You could even define a class of administrative users, for example, with usernames that start with
ADM and provide all other users with Monitor access.


* : ADM* : <SYS> : All


* : * : <SYS> : Monitor


Console applications automatically prompt for a username and password and do not use
clientConnect.conf. In console applications, passwords display as masked characters (*) to avoid
displaying the passwords in cleartext. In order for nonconsole applications to prompt, the value
<PROMPT> must be used for the SDK username and password in clientConnect.conf.


Network account authentication
In UNIX systems, the system authenticates a username based on its password.
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Prompting for authentication
In order for nonconsole applications to prompt for a username and password, the corresponding fields in
clientConnect.conf must contain <PROMPT>. The client must be attached to a terminal, in order for the
system to prompt the user. Lines containing a <PROMPT> are skipped by programs that are not attached
to a terminal, even if they would otherwise be selected.


Responses to <PROMPT> are checked against username and password fields in serverConnect.conf.


Site-specific authentication
Site-specific authentication uses a site’s secret to authenticate connections. When corresponding records
in serverConnect.conf and clientConnect.conf contain the <AUTO> value for both the SDK username and
password, the client generates a password by using its secret. The server validates the password to
accept or reject the connection.


Note   Do not use this method unless you have changed the default site secret. The default site secret is
known to all SDK installations.


So for connections to a particular Domain Manager (such as Service Assurance Manager), you could
define a record in serverConnect.conf:


GM-Company-1:<AUTO>:<AUTO>:All


Then define a corresponding record in the clientConnect.conf files on the different hosts connecting to the
server:


*:GM-Company-1:<AUTO>:<AUTO>


As long as both the client and server use the same secret phrase, the server will authenticate each
connection to the Domain Manager.


Note   Do not use <AUTO> for the brokerConnect.conf if it is used for other connections, because the
Broker does not need All access, only Ping.


Legacy system authentication
To provide the ability to interoperate with older SDK software, which may not support authentication, SDK
software provides a “default account” mechanism. When an incoming connection does not provide any
authentication information, a server substitutes the standard username and password with <DEFAULT>.
After that substitution, the <DEFAULT>/<DEFAULT> authentication information is validated in exactly the
same way any other username/password combination is validated.


An incoming connection that explicitly specifies <DEFAULT>/<DEFAULT> is permitted. It is treated in
exactly the same way as a connection that supplied no authentication information.
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Default authentication records
This section describes the authentication records enabled by default. These default settings provide
examples of user records in serverConnect.conf as well as examples of how automatic authentication can
be set up in clientConnect.conf and brokerConnect.conf.


Authenticating legacy software
The Broker uses the following record in serverConnect.conf to authenticate legacy client connections and
provide full access. The target field, with a value of <BROKER>, identifies that the Broker is the sole
target for authentication. There are no corresponding entries in the clientConnect.conf or
brokerConnect.conf. Legacy system authentication provides additional information on the <DEFAULT>
value.


<BROKER> : <DEFAULT> : <DEFAULT> : All


In this configuration, the Global Console will not prompt for a username and password when connecting
to the Broker. The default configuration defines a nonsecure Broker, equivalent in security to Ionix
software prior to version 5.0.


Automating client authentication to the Broker
SDK programs connect to the Broker under the following conditions:


n When a server starts, it connects to the Broker as a client to register itself.


n When a client, including a console, needs to connect to a server, it connects to the Broker to query it
for the server's location.


The record in serverConnect.conf specifies that the Broker should grant any client that sends the
SDK username BrokerNonsecure and the password Nonsecure full access to the Broker.


<BROKER> : BrokerNonsecure : Nonsecure : All


The automatic authentication record in clientConnect.conf applies to any client that supports
authentication and needs to connect to the Broker. This record specifically selects the Broker as its
target.


* : <BROKER> :BrokerNonsecure : Nonsecure


These two records define a nonsecure configuration for the Broker. In this configuration, consoles do
not prompt for a username and password when connecting to the Broker. “Configuring a secure
Broker” on page 108 provides additional information regarding a secure Broker configuration.
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Automating Broker authentication to servers
The Broker periodically pings all registered servers to determine their status. When the Broker does this,
it acts as a client. This record in serverConnect.conf permits the Broker to ping a server to check if it is
running.


* : BrokerPing : Ping : Ping


The brokerConnect.conf file contains an automatic authentication record, the only record in the file.


* : * : BrokerPing : Ping


Connection privileges provides additional information about the Ping access permission.


Authenticating administrative users
The default administrative record provides full access to any server by using the serverConnect.conf file.


* : admin : changeme : All


This record authenticates clients that provide the SDK username “admin” and the password “changeme”.
This account grants administrative privileges or full access, which is denoted by the value of All in the
privilege field.


Note   Change the password for this account after installation. You must make any changes to the
corresponding records in both the serverConnect.conf and clientConnect.conf files. Replace the admin
user only after you have set up a corresponding administrative account in the Global Manager. You
should never remove or disable an administrative account in the Global Manager.


The corresponding automatic authentication record in clientConnect.conf grants any client, which uses
the file, full access to any server by using the corresponding record in the serverConnect.conf file.


* : * : admin : changeme


Since this record appears later in the clientConnect.conf file than the interactive users record (* : * :
<PROMPT> : <PROMPT>), only noninteractive clients will be granted full access, unless interactive users
type the correct username ("admin") and password ("changeme").


Connection privileges provides additional information about the All access permission.


Authenticating Global Console users
Two records in serverConnect.conf provide the console with monitoring access to servers. The first
authenticates console users who provide the SDK username maint and the password maint.


* : maint : maint : Monitor
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The second console record authenticates console users who provide the SDK username oper and the
password oper.


* : oper : oper : Monitor


Consoles do not use clientConnect.conf for authentication (there is no automatic authentication). The
console prompts the user for a username and password and passes the information to the server for
authentication.


Note   User profile restrictions can be used to further limit certain Global Console operations, as
described in the VMware Smart Assurance Service Assurance Manager Configuration Guide.


VMware recommends that you create separate accounts for each operator. Comment out these records
and use the authentication record that uses the system login facility.


Authenticating users with a valid system account
The last default authentication record in serverConnect.conf permits users with a valid login account on
the system where the server is running to connect. A client that uses this authentication record must type
a valid system username and password. For authentication, the system username becomes the SDK
username. This record provides monitoring privileges.


* : * : <SYS> : Monitor


Authenticating users interactively
This authentication record in the clientConnect.conf prompts users to type an SDK username and
password. This does not guarantee that the connection will be successful. The server must be able to
validate the username and password by using its serverConnect.conf file.


* : * : <PROMPT> : <PROMPT>


The position of this authentication record in the default clientConnect.conf file is important. Because it
uses wildcard patterns to match for both login user and target, this record is always selected for
interactive connections, even if a following record also matches. Noninteractive programs skip this record
because they cannot prompt for information.


This record could match the following serverConnect.conf authentication records, as described in the
followingAuthenticating users with a valid system account:


* : * : <SYS> : Monitor


* : maint : maint : Monitor


* : oper : oper : Monitor


* : * : <SYS> : Monitor
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Specifying alternate security configuration files
You can define separate serverConnect.conf and clientConnect.conf files on hosts where multiple servers
or clients are running. This enables you to configure a system where certain users and/or servers use one
file, and other users and/or servers reference a different file. Some installations can share the same
BASEDIR/smarts, but have requirements that stipulate that the servers and/or clients operate differently.


Two environment variables allow you to specify distinct configuration files:


n SM_SERVERCONNECT


n SM_CLIENTCONNECT


For each variable, the absolute path to the alternate security file must be specified. Because you
specify the filename, you can have multiple files in the same directory.


For server programs, you can specify an alternate serverConnect.conf file, by setting the
SM_SERVERCONNECT variable in the command line that starts the server.


For example, the following steps set the value of the SM_SERVERCONNECT environment variable
to point to the server_Connect_IP.conf file.


a Use the sm_service show action with the --cmdlineoption to display the existing command line
for the program. You must have administrative privileges when typing the following command.


                     


                        BASEDIR/smarts


                     /bin/sm_service show --cmdline ic-am-server


                        BASEDIR/smarts


                     /bin/sm_service install


 --startmode=runonce ic-am-server


    


                        BASEDIR/smarts


                     /bin/sm_server


        --name=INCHARGE-AM


        --config=icf


        --bootstrap=bootstrap-am.conf


        --port=0


        --ignore-restore-errors


        --output 


b Use the sm_service install action with the --forceoption to add the environment variable to the
command line. The --envoption specifies the environment variable.


t 


                        BASEDIR/smarts


                     /bin/sm_service install --force 


 --startmode=runonce


 --env=SM_SERVERCONNECT=


                        BASEDIR/smarts
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                     /conf/


  serverConnect_IP.conf


 ic-am-server


                        BASEDIR/smarts


                     /bin/sm_server


        --name=INCHARGE-AM


        --config=icf


        --bootstrap=bootstrap-am.conf


        --port=0


        --ignore-restore-errors


        --output s


c Do one of the following:


n Start the program.


n Stop and restart the program.


For client programs, you can specify an alternate clientConnect.conf file by setting the
SM_CLIENTCONNECT variable in the runcmd_env.sh file.


Controlling authentication
The environment variable SM_AUTHORITY controls the authentication security features provided by SDK
software. The authentication features are enabled by default. If necessary, you can set the value of this
variable to disable them. This environment variable must be set on each system where SDK software is
running.


The environment variable SM_AUTHORITY can have one of two values:


n <STD> enables security


n <NONE> disables security


When no value is specified, which is the default, SDK software treats this the same as <STD>.


Note   The angle brackets (< >) are required.


When SM_AUTHORITY is set to <NONE>, SDK software behaves as if no security features are in
effect:


n Clients do not read clientConnect.conf and never prompt for a username or password. They always
send <DEFAULT>/<DEFAULT> as their credentials.


n Servers ignore any incoming username or password and grant any connection All access.
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Setting the SM_AUTHORITY variable
To add and set the SM_AUTHORITY environment variable in the runcmd_env.sh file in the
BASEDIR/smarts/local/conf directory:


1 Use sm_edit to open the runcmd_env.sh file.


sm_edit conf/runcmd_env.sh


2 Add the environment variable and its value by using the following syntax:


 SM_AUTHORITY="<STD>"


3 Save the runcmd_env.sh file and close it.


Any SDK program started after this point will use the applicable environment variables specified in the
runcmd_env.sh file. SDK programs that are already running need to be restarted for any new
environment variable to take effect.


Encryption
By default, encryption is enabled during the installation process. The basis for encryption is a secret
phrase that gets transformed into the file imk.dat. The SDK programs use this site secret to encrypt
passwords in the configuration files and passwords to SNMP v3 devices in seed files, as well as to
encrypt connections between SDK programs.


At installation, encryption is enabled with a default secret phrase. This phrase is:


Not a secret (literally) 


and the imk.dat file can be copied. The imk.dat is found in the BASEDIR/smarts/local/conf directory.


Important   The imk.dat file can only be copied to other systems with the same operating system (OS)
and OS version.


To raise the level of security, you need to change the secret phrase by using the sm_rebond utility.
Thereafter, the secret phrase should be changed periodically to maintain a secure system.


Note   The secret phrase should be treated with the same care as a root password or highest level
system administration password.
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Changing the secret
The sm_rebond utility changes the secret phrase and re-encrypts the files affected by the secret. This
utility prompts for the old secret phrase and the new phrase, then generates an imk.dat file and updates
all the files containing encrypted information. This utility affects all of the applications that run on the same
host and use the same imk.dat file.


Note   The sm_rebond utility shuts down all of the processes run from the suite that were started by using
sm_service or sm_serviced, and that use the same imk.dat file. The sm_rebond utility re-encrypts the
security files and the seed files, then restarts the processes once the phrase and encryption changes are
made. All other processes should be shut down manually before running the utility and restarted once the
utility is finished.


To change the secret, perform the following steps:


1 Use the sm_rebond utility. You must type this command with administrative privileges.


sm_rebond --basedir=<base directory>


2 When the utility prompts for the old secret phrase, type it.


3 When the utility prompts for the new secret phase, type it. The secret phrase can consist of a
combination of printable characters, integers and special characters. The secret phrase cannot be
more than 1,024 characters long.


4 Retype the new secret to confirm it.


5 Close the utility.


Note   The sm_rebond utility encrypts only files that reside in BASEDIR/smarts/local/conf and three
levels of subdirectories below that. To encrypt files outside of that directory area, contact VMware
Global Services.


Using the secret for multiple suites and sites
The secret phrase can be used across multiple suites and sites. To use the secret phrase across suites
and sites, VMware, Inc. recommends that you perform the following steps:


1 Install one or more SDK suites on one or more hosts.


2 If short periods of interrupted communications are not detrimental, stop the Managers. However, if the
suites also use cleartext connections, you can use the sm_rebond utility without stopping the
Managers. Only that suite will lose connections for a short period of time.


3 Use the sm_rebond utility to change the secret phrase for each suite on each host.


Note   The secret phrase must be exactly the same for each suite on each host in order for the
applications to make connections.
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4 Use the sm_edit utility to update the security configuration files and seed files of the suites as
needed.


5 Restart the Managers if applicable.


Using the secret across large numbers of sites
For large numbers of sites, you can perform the following steps:


1 Install an SDK suite at the primary site.


2 Use the sm_rebond utility to change the secret phrase.


3 Use the sm_edit utility to update the security configuration files and seed files of the suite as needed.


4 Copy the imk.dat file, as well as the configuration files and seed files to the other installations of the
SDK software.


Important   The imk.dat file can only be copied to other systems with the same operating system
(OS) and OS version.


You will not have to use the sm_rebond utility on the other Managers if the files are moved to the
Managers before the Managers are started.


Locking the secret
If access to encrypted data is a critical issue for your organization, VMware provides the option to lock the
imk.dat file. This disables copies of the imk.dat file, even by restoration from a backup process. For more
information about this level of security, contact VMware Global Services.


Encrypted passwords
The encryption process uses the secret to encrypt passwords contained in the security configuration files.
The first line of the serverConnect.conf, clientConnect.conf, and brokerConnect.conf files indicates the
appropriate field to which encryption is applied.


The first line in the file must read as follows. It must begin with a pound sign (#).


#<encrypted field>:1.0:<n>


      


The value n refers to the position of the Password field in the configuration file’s record and should not be
changed:


n For serverConnect.conf, this value is 3.


n For clientConnect.conf and brokerConnect.conf, this value is 4.


To disable encryption, add a second pound sign (#) at the beginning of the line.


Note   Installation encrypts the password fields in the files by using the default secret. The encrypted
files reside in BASEDIR/smarts/local/conf.
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Encrypting passwords
Password is the only field in the security configuration files that is encrypted. The configuration files are
located in the BASEDIR/smarts/local/conf directory of a product suite.


To type or change a password in a configuration file:


1 Use sm_edit to open the file.


For example, to open the serverConnect.conf file, invoke sm_edit from the BASEDIR/smarts/bin
directory:


 sm_edit conf/serverConnect.conf


2 Review the contents of the file. For example, the serverConnect.conf file may include lines similar to
the following:


 #


 <BROKER>    :<DEFAULT>:<DEFAULT>:All


 InCharge    :admin    :<SYS>    :All


 InCharge-WP     :user5    :Password :Ping


 InCharge    :operator :Password :Monitor


 InCharge    :*        :<SYS>    :None


 #


3 Delete the current password and replace it with the new password in cleartext. If the current value is
encrypted, delete the <E-1.0> tag that marks the password as encrypted as well as the current
password. The special values <DEFAULT>, <PROMPT>, <SYS>, and <AUTO> in the files are not
encrypted.


4 Save the file and close the file.


The appropriate values are encrypted as part of the process.


5 Repeat the steps for all of the configuration files.


If a configuration file already includes the first line for encryption, specify the sm_edit utility with the --
noedit option to encrypt the file without opening it. You must have administrative privileges when
typing this command.


               


                  BASEDIR/smarts


               


               /local/conf/sm_edit --noedit <filename>


            


Encrypted seed files
The encryption for a seed file only applies to certain information that applies to SNMP v3 devices. For
these devices, a keyword that contains the authentication password can be encrypted.
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The first line of the seed file must read as follows; it must begin with a pound sign (#).


#<encrypted seed>:1.0:AUTHPASS,PRIVPASS


The AUTHPASS and PRIVPASS keywords specify the authentication and privacy passwords for an
SNMP v3 device.


To disable encryption, add a second pound sign (#) at the beginning of the line.


If a seed file already includes the first line for encryption, specify the sm_edit utility with the --noedit option
to encrypt the file without opening it. You must have administrative privileges when typing this command.


         


            BASEDIR/smarts


         


         /local/conf/sm_edit --noedit <filename>


      


Encrypted connections
SDK components communicate over TCP connections by using the Ionix Remote API. Clients which are
using Remote API connections, authenticate themselves to servers by sending credentials, nominally a
username and password. When the credentials are passed as cleartext, they can be snooped from the
network or accessed by using man-in-the-middle configurations.


You can encrypt certain connections by using different keys for the Advanced Encryption Standard based
on a combination of the Diffie Helman standard and the site secret associated with the SDK installation.
“Encryption” on page 100 provides additional information about the site secret.


Encrypted connections do not work with the following products:


n Perl API


n VMware Smart Assurance Adapter for NetIQ AppManager


Levels of encryption
SDK software provides three levels of security above cleartext communication: Diffie Helman-Advanced
Encryption Standard (DH-AES), encryption based on the site secret, and DH-AES used in conjunction
with the site secret.


Any encryption based on the site secret should only be used once the secret phrase has been changed
by using sm_rebond described in Changing the secret.


Encryption levels for connections lists the four types of encryption connections.
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Table 5‑4.  Encryption levels for connections


Security level Description Advantages Disadvantages


0, CLEAR, or
CLEARTEXT


no encrypted
communication


Backwards compatibility, no
configuration (default behavior)


No security, passwords passed to
servers as cleartext


1 DH-AES No site secret needed, no
configuration (default behavior for
new installations), protects against
eavesdroppers


Slower connection than cleartext or
level 2 security, not secure against
active attacks


2 Encryption based on site
secret


Protects against eavesdropping and
active attack, almost as fast as
cleartext


Must set site secret and keep it
common across all communicating
entities


3 DH-AES and site secret Protects against eavesdropping and
active attack, even by those who
know the site secret


Slower connection than cleartext or
level 2 security, must set site secret
and keep it common across all
communicating entities


Note   The Global Console supports both cleartext (Level 0) and Diffie Helman-Advanced Encryption
Standard (Level 1) encrypted connections.


Encrypting connections
Encrypted connections are configured by using two environment variables:


n SM_OUTGOING_PROTOCOL— Controls the connections that an SDK program acting as a client is
allowed to initiate.


n SM_INCOMING_PROTOCOL— Controls the connections that an SDK program acting as a server is
allowed to accept.


Each of these can contain a list of security levels. If you specify more than one, separate them with
commas. If you do not set the variable, it is the same as specifying “0”, or CLEARTEXT.


When two or more security levels are supported in common, the largest level number is used. For
example, if a client has SM_OUTGOING_PROTOCOL set to "0,1" and the server has
SM_INCOMING_PROTOCOL set to "0,1,2", the connection uses the highest common level, level 1.


The order in which the different levels are specified for the environment variables has no significance
—for example, "0,1" and "1,0" behave exactly the same.


Applications that do not support encryption are treated as only having a cleartext level of encryption.


When the two ends of the connection do not match, such as when SM_OUTGOING_PROTOCOL is 3
at server A and SM_INCOMING_PROTOCOL is 2 at server B, a connection cannot be formed. Both
client and server will report errors.
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To set the environment variables so that they can be used by the programs of an SDK product suite,
edit the runcmd_env.sh file, which is located in the BASEDIR/smarts/local/conf directory of that
product suite.


a Use sm_edit to open the runcmd_env.sh file. Invoke sm_edit from the BASEDIR/smarts/bin
directory:


 sm_edit conf/runcmd_env.sh


 C:\>sm_edit conf\runcmd_env.sh


b Review the contents of the file. The default values for the SM_INCOMING_PROTOCOL and
SM_OUTGOING PROTOCOL are 1 and 0.


 SM_INCOMING_PROTOCOL=1,0


 SM_OUTGOING_PROTOCOL=1,0


c Update the values for the variables to meet the needs of your system.


For example, to raise security to the next highest level, change 1 to 2:


 SM_INCOMING_PROTOCOL=2,0


 SM_OUTGOING_PROTOCOL=2,0


d Save the runcmd_env.sh file and close it.


e Any SDK program within the product suite started after this point will use the environment
variables specified in the runcmd_env.sh file. SDK programs that are already running need to be
restarted for any new environment variable to take effect.


Suggested encrypted connections
VMware recommends that you configure your system to use encrypted connections wherever possible.


n Brokers should be able to communicate with cleartext as well as encryption in both
SM_INCOMING_PROTOCOL and SM_OUTGOING_PROTOCOL if a client only supports cleartext.
This is required in this configuration since the Broker acts as both a client and a server, and must be
able to communicate with every component in the system. Brokers do not need to support cleartext if
all clients can make encrypted connections.


n If a Domain Manager must connect to a client that only supports cleartext, then set
SM_OUTGOING_PROTOCOL to cleartext as well as encryption.


n Configure adapters with SM_OUTGOING_PROTOCOL set to require encryption. Only adapters that
register with the Broker (--name option) can accept incoming connections. If you have adapters that
accept incoming connections, setting SM_INCOMING_PROTOCOL to require encryption is
appropriate.


Also, if the adapter must connect, or be connected, to clients that support only cleartext, then add the
cleartext option to the appropriate variable.
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n Configure any components that must run on networks outside the management domain with both
SM_INCOMING_PROTOCOL and SM_OUTGOING_PROTOCOL set to encryption. Depending on
the level of encryption, this will prevent snooping or man-in-the-middle attackers. You will not be able
to connect directly to such a component by using a console.


Configuring a secure Broker
You can configure the Broker to run in a secure manner. Use of a secure Broker results in the following
changes to how SDK software runs:


n Consoles prompt for a username and password to connect to the Broker. Without a secure Broker,
consoles connect to the Broker without authenticating.


n Other servers and clients use their respective clientConnect.conf files to determine what credentials
to send to the Broker, just as they use clientConnect.conf to determine what credentials to send to a
server. In particular, you can configure the clientConnect.conf files so that clients and servers prompt
for connections to the Broker, as the console does, or specify the password in clientConnect.conf.


To configure and run a secure Broker, complete the following steps:


a Choose a unique SDK username and password for the secure Broker credentials. The new SDK
username and password will be used by both servers and clients:


n Servers will use these credentials to register with the Broker.


n Clients will use these credentials to connect to the Broker and determine the location of a
server.


For example, you could use the SDK username “SecureBroker” and the password “Secure”.
Choose a unique SDK username and password.


b Use the sm_edit utility to open a local copy of the clientConnect.conf file, located in
BASEDIR/smarts/local/conf. Edit this file, used by all clients and servers, so that SDK programs
send the SecureBroker/Secure credentials when connecting to the Broker.


n Comment out the following line:


*:<BROKER>:BrokerNonsecure:Nonsecure


n Type a new line configuring a secure Broker. This new line is added below the
BrokerNonsecure line that you commented out.


For example:


#*:<BROKER>:BrokerNonsecure:Nonsecure


*: <BROKER> : SecureBroker : Secure


*: <BROKER> : SecureBroker : <PROMPT>


c Use sm_edit to make the following changes to the local serverConnect.conf file used by the
Broker:


n Delete the line granting <DEFAULT>/<DEFAULT> access to the Broker.
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n Change the BrokerNonsecure/Nonsecure line to grant Ping access rather than All access. Do
not, however, delete this authentication record.


n Add a new authentication record that grants All access to the SecureBroker/Secure
credentials This new record must be below the BrokerNonsecure/Nonsecure record. For
example:


<BROKER>:BrokerNonsecure:Nonsecure:Ping


<BROKER> : SecureBroker : Secure : All


Additional safeguards
In addition to encrypted passwords and encrypted connections, you can secure your system by using the
file permissions of the operating system, by limiting access to the security configuration files, and by
limiting access to the servers.


Using file permissions
You can limit access to the security configuration files by using the permissions feature of the operating
system. Only select users should be allowed access to the files. The users must include those who
launch the SDK applications requiring access to the authentication records.


Limiting access to the configuration files
You should configure security in such a way that each security file is only readable by those programs or
users that require it. The security configuration files installed with SDK software, which should be edited
after installation, are readable by anyone.


Because Managers and the Broker typically run with administrative privileges, the serverConnect.conf
and brokerConnect.conf files should only be readable by users with administrative privileges and no one
else.


The simplest method for creating a secure setup for users and client programs is to provide two separate
clientConnect.conf files. One clientConnect.conf file, which can remain readable by anyone, should only
contain entries that make client programs prompt for passwords. This clientConnect.conf file will not
contain passwords.


For client programs, create a separate clientConnect.conf file that contains the authentication information
necessary for non-prompting programs to access Managers. This clientConnect.conf should only be
readable by the user(s) under which these programs run. Client programs use the
SM_CLIENTCONNECT environment variable to find this clientConnect.conf file. You can specify
SM_CLIENTCONNECT in the service startup file for each service. For clients that are installed as
services, you can use the --env option to the sm_service utility to edit the parameters of a service.
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Limiting access to servers
The --acceptoption to the sm_server command, described in SM_SNMP_BUG_COMPATIBLE, provides
another method of access control. This option limits the hosts that can connect with the server. Before
other security measures occur, incoming connections must pass the --accept option before
authenticating.


Example security configurations
You can configure SDK installations to use a variety of levels of security. Higher levels of security require
more administrative effort, as well as extra effort on the part of users of the system, but give you better
control of the use of SDK software. The appropriate level of security for your site is determined by the
policies and procedures of your organization.


This section describes two levels of security, and their advantages and disadvantages. You can choose
one of these levels, or combine characteristics of several.


Default security
When initially installed, default security uses the security configuration files with encrypted passwords
based on the default secret phrase. The connection protocols are set to use Diffie Helman encryption and
cleartext. With the default security, you need to change the passwords for the SDK usernames in the
security configuration files. Default security prevents casual inspection, but does not pose much of a
deterrence from more strenuous efforts.


Note   It is essential that you change the default passwords for the usernames before using the system in
a production environment.


While the default security provides basic authentication, it does not provide much manageability or
security. The oper/oper credentials must be known to all console operators; the admin/changeme
credentials must be known to all administrators. This makes it difficult to know who is actually connected
to a server, based on their username. In addition, you cannot revoke the rights of one user without
changing the SDK username and password for all users at the same access level.


The serverConnect.conf and clientConnect.conf files include authentication records that improves user
administration. First, besides the oper/oper credentials, there are maint/maint credentials that also
provide Monitor access. This illustrates how one might define shared usernames that are still
differentiated on the basis of role. Second, serverConnect.conf contains the following line:


* : * : <SYS> : Monitor
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Anyone who can provide a username and password that the operating system considers valid is also
granted Monitor access. In this scenario, you can give every console operator an account on the host on
which the server they access runs. These operators log in by using the username and password defined
for that account. The account can be disabled to prevent actual interactive access to the system. In this
way, each console operator gets a unique username and password. Accesses to the system can be
traced to a particular user, and access can be individually revoked. Specifying <SYS> for the password
avoids having to potentially create a number of records in serverConnect.conf.


This mechanism can readily be extended to provide similar controlled access for administrators. For
example, you could add the following records to serverConnect.conf:


* : fred|george : <SYS> : All


* : * : <SYS> : Monitor


This would give the users “fred” and “george”, if they provide the passwords for their accounts on the
host, All access. You could even define a class of administrative users, for example, with usernames that
start with ADM.


* : ADM* : <SYS> : All


* : * : <SYS> : Monitor


Customized security
Customized security uses security files (with encrypted passwords), a new secret phrase, and passwords
for the SDK usernames in the security files that are different than their default values. Under customized
security, connection protocols are set to use the site secret and cleartext. This setup protects against
eavesdropping and active attacks as well as casual inspection.


To configure customized security:


1 Create a new secret phrase by using sm_rebond, as described in Changing the secret.


2 Change the username and passwords in serverConnect.conf, clientConnect.conf, and
brokerConnect.conf.


These should provide access control by individual users. Consider using system authentication to
authenticate Global Console users, as described in System authentication. The new usernames and
passwords should also address connections between servers and servers or servers and clients.


If your SDK software resides on a single host, a single username and password for automatic client
authentication is usually sufficient. However, if you have clients, such as adapters, on multiple hosts,
or generally in different security domains, you may use different usernames and passwords for
manageability. For example, if there is reason to believe that the username and password from one
machine have been compromised, you can change them without having to change the configuration
on any other machine.
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To achieve such a configuration, you need to assign unique usernames and passwords to clients that
you consider to reside in separate security domains. Add a line to grant access to each such
username/password credential to the serverConnect.conf file of each server the client will access.
Add a corresponding line to the clientConnect.conf file that the client will use.


Note   If you have multiple security domains on a single host, use the SM_CLIENTCONNECT
environment variable so that different clients read different clientConnect.conf files. You can use the --
env option of the sm_service utility to set the environment value when the service starts.


3 Configure the different SDK components to communicate with encrypted connections. The types of
allowed connections depend on the versions of SDK software in use.


n Most connections should be encrypted. The Broker does not need to support cleartext if all clients
can make encrypted connections.


Encrypted connections on page 105 provides additional information.


4 At the highest security level, you should run with a secure Broker as well. Setting up a secure Broker
is described in “Configuring a secure Broker” on page 108.
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Operation of the Broker 6
This chapter includes the following topics:
n Overview of the Broker


n Viewing the registry of the Broker


n How the SDK clients find the Broker


n How to change the Broker environment variable


n Securing the Broker


Overview of the Broker
An SDK client application, such as a console or an adapter, utilizes the Broker to determine where
Managers are running. When a Manager starts, it registers with the broker:


n Hostname of the machine it is running on


n TCP port it is listening on.


SDK clients retrieve this information from the Broker so that they can communicate with the Manager.


The Broker registry maintains the following information:


n Name of the Manager, including the host and TCP port it is running on.


n Status of each Manager.


The Broker checks the status of each Manager every five minutes by connecting to the host on which
SDK is running and determining if the SDK process is running properly. If the Broker is unable to
connect or the process is not running, the Broker changes the status of the Manager to Dead.


n Running indicates that the Broker is able to communicate with the Manager.


n Dead indicates that the Manager exited unexpectedly or is unreachable. When a Manager
properly shuts down, it notifies the Broker and the Broker removes it from its registry.


n Unknown indicates that the Broker was restarted and that it is querying its list of Managers to
determine their state.


n Process ID of each Manager. This is the process ID assigned by the host’s operating system. In
some cases when the Broker is restarted, the process ID of each Manager is set to zero to indicate
the Broker does not know the process ID of the Manager.
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n Last time the state of the Manager changed. This value is set when the Manager registers with the
Broker and is updated if the Broker determines that the Manager is dead. When the Broker restarts, it
changes the status of Managers marked Unknown to Running or Dead.


The Broker changes the status of the Manager to Dead when it cannot connect to the Manager.
However, the Broker continues to try to connect to the Manager every five minutes. If the Broker
succeeds in connecting to the Manager, it changes its status back to Running.


Viewing the registry of the Broker
The Broker is a component of an SDK application. The Broker is designed to automatically start each
time the host on which it is installed is started.


You can use the brcontrol utility to view the list of registered programs.


Broker command line option
To view the contents of the Broker from a command prompt, use the following command:


         


            BASEDIR/smarts


         /bin/brcontrol [-b <host>:<port>]


If the Broker resides on another system, specify the -b option with the host and port number.


How the SDK clients find the Broker
The Broker facilitates communication between SDK clients and Managers. During installation, you are
prompted for the host location of the Broker and its port number. This information is stored in the
SM_BROKER_DEFAULT environment variable. This variable is used by all SDK programs to find the
Broker. The default host setting for the variable is localhost, and the default port setting is 426.


An SDK client performs the following steps to determine the Broker’s location.


1 Verifies whether the Broker’s location was specified as an option at startup. When this option is
specified, no other options are checked.


2 Checks the value of the SM_BROKER_DEFAULT environment variable. If this variable is set, no
other options are checked.


3 Checks if the Broker is running on the host smarts-broker and listening on TCP port 426.


4 If smarts-broker is not defined, the program checks port 426 on localhost.


Note   The hostname smarts-broker is usually an alias, such as a DNS CNAME.


VMware Smart Assurance System Administration Guide


VMware, Inc.  69







How to change the Broker environment variable
The default location of the Broker is specified at installation and stored in the SM_BROKER_DEFAULT
environment variable.


There are two scenarios in which you may need to change the value of the environment variable after
SDK software is installed.


n If during installation, the default Broker host and/or port settings were changed, but the typed values
are incorrect.


n If the Broker is automatically installed when you install an SDK application or the adapters. Because
only one Broker should be active on a network, the Broker on one of the hosts must be disabled, and
the Broker environment variable on that host must point to the host where the Broker is running. This
typically occurs when an SDK application is installed on one host and the SDK adapters are installed
on a second host.


Correcting the Broker settings
In the first scenario, you must edit the Broker host and/or port value in two places.


1 First, change the SM_BROKER_DEFAULT environment variable in the runcmd_env.sh file, which is
located in the BASEDIR/smarts/local/conf directory:


 SM_BROKER_DEFAULT=<host>:<value>


2 Additionally, you must change the --port value in the sm_service install Broker command line to
match the port value you set in the SM_BROKER_DEFAULT environment variable.


Use the sm_service show action with the --cmdline option to display the existing install Broker
command line.


               


               


                  BASEDIR/smarts


               /bin/sm_service show --cmdline ic-broker


               


                  BASEDIR/smarts


               /bin/sm_service install


 --startmode=runonce 


 --env=SM_CLIENTCONNECT=brokerConnect.conf ic-broker


                  BASEDIR/smarts


               /bin/brstart 


 --port=<PORT> 


 --output 


 --restore=


                  BASEDIR/smarts


               /local/repos/broker/broker.rps
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t 


                  BASEDIR/smarts


               /bin/sm_service install --force


 --startmode=runonce 


 --env=SM_CLIENTCONNECT=brokerConnect.conf ic-broker 


               


                  BASEDIR/smarts


               /bin/brstart 


 --port=<NEW VALUE> 


 --output 


 --restore=


                  BASEDIR/smarts


               /local/repos/broker/broker.rps s


Disabling the Broker
In the second scenario, you must change the SM_BROKER_DEFAULT host variable in the
runcmd_env.sh file and change the --startmode value.


1 Change the SM_BROKER_DEFAULT host variable in the runcmd_env.sh file, which is located in the
BASEDIR/smarts/local/conf directory:


  SM_BROKER_DEFAULT=<host>:<value>


2 Additionally, you must change the --startmode value in the sm_service install Broker command line
from runonce to disable.


Use the sm_service show action with the --cmdline option to display the existing install Broker
command line.


               


               


                  BASEDIR/smarts


               /bin/sm_service show --cmdline ic-broker


               


                  BASEDIR/smarts


               /bin/sm_service install


  --startmode=runonce 


  --env=SM_CLIENTCONNECT=brokerConnect.conf ic-broker


                  BASEDIR/smarts


               /bin/brstart                                                  


  --port=<PORT> 


  --output 


  --restore=


                  BASEDIR/smarts


               /local/repos/broker/broker.rps
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t 


                  BASEDIR/smarts


               /bin/sm_service install --force


  --startmode=disable


  --env=SM_CLIENTCONNECT=brokerConnect.conf ic-broker


                  BASEDIR/smarts


               /bin/brstart                                                   


  --port=<PORT> 


  --output 


  --restore=


                  BASEDIR/smarts


               /local/repos/broker/broker.rps s


Securing the Broker
Securing access prevents unauthorized usage of the Broker, and protects it from being modified (for
example, Managers being deleted from the Broker). Authenticating users and determining their privileges
are accomplished by using two files: serverConnect.conf and brokerConnect.conf. These files ensure that
only authorized users access the Broker. You must modify the local copies of these files, which are
located in BASEDIR/smarts/local/conf. “Configuring a secure Broker” on page 108 provides additional
information.
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Managing Log Files 7
This chapter includes the following topics:


n Overview of message logging


n Retrieving and setting log, error and trace levels at runtime


n Log files


n Starting a new log file


n Controlling the number of saved log files


Overview of message logging
All SDKexecutable processes will create log data, and when the process is started with the --output
option this data is written to at least one log file. One log file is always created, but there may be two
different log files created, depending on the settings of the SM_LOCALE and SM_ENCODING_OUPUT
environment variables.


The name of a log file has the following syntax:


         <name>_


            


                <locale>_


            


                <encoding>.log


where:


n <name> in the log filename column is determined by the rules that apply to the --output command
option, as described in Command-line options that control VMwaremessages.


n <locale>is based on the value of the SM_LOCALE environment variable.


n <encoding>is based on the value of the SM_ENCODING_INPUT environment variable . 
SM_LOCALEand SM_ENCODING_*provide additional information.


A log file whose locale is en_US (default value of SM_LOCALE) and encoding is UTF-8 (default value
of SM_ENCODING_INPUT) is always created when the --output option is provided.
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n If the SM_LOCALE environment variable specifies the English locale (en_US), and the
SM_ENCODING_OUTPUT environment variable specifies UTF-8, then the English log is the only log
file produced.


n If the SM_LOCALE variable specifies a locale other than en_US , or the SM_ENCODING_OUTPUT
environment variable specifies something other than UTF-8, a second log file is created. Log
messages written to this second log are localized according to the setting of the SM_LOCALE 
variable, if such a localization exists.


n If SM_LOCALE specifies an invalid locale (one for which SDKsoftware has not been localized),
English log data will result in the process log file.


Log filenames, locales and encodingssummarizes the filename, locale and encoding of the log files
that are produced, including the system log containers.


Table 7‑1.  Log filenames, locales and encodings


Log use Log filename (if –output is used) Locale Encoding


English log <name>_en_US_UTF-8.log For example,
MYDM_en_US_UTF-8.log


en_US UTF-8


Non-english
log


<name>_ <locale>_ <encoding>.log For example,
MYDM_ja_JP_<encoding>.log


Defined by
SM_LOCALE


Specified by the
SM_OUTPUT_ENCODING
variable.


UNIX syslog lDefined by
SM_LOCALE


UTF-8 (permitted and expected by
the new IETF syslog-protocol
RFC, still in a draft form)


Win Event Log Defined by
SM_LOCALE


UTF-16


SM_LOCALE and SM_OUTPUT_ENCODING examplesprovides several examples of SM_LOCALE and
SM_ENCODING_OUTPUT variable settings and the resultant logs.


Table 7‑2.  SM_LOCALE and SM_OUTPUT_ENCODING examples


SM_LOCALE setting SM_OUTPUT_ENCODING value Logs that are produced


en_US UTF-8 <name>_en_US_UTF-8.log


en_US ShiftJIS <name>_en_US_UTF-8.log


<name>_en_US_ShiftJIS.log


fr UTF-8 <name>_en_US_UTF-8.log


<name>_fr_UTF-8.log


zh GB <name>_en_US_UTF-8.log


<name>_zh_GB.log


The volume of output to the system log containers is controlled by the --loglevel option. The volume of
output to the log files is controlled by the -–errlevel option, and by the environment variables that control
filtering on specific error tables and error codes.
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Log file management behavior applies to both log files. Log rolling is managed in a synchronized fashion
so that data in multiple logs can be correlated. Thus, when the English log rolls, the non-English log, if it is
being produced, will also roll.


Command-line options that control VMware messages
SDKmessages are controlled by the following standard options for the sm_server sm_service command
and environment variables.


For the sm_service sm_server options that use a minimum security level, the level can be: none,
emergency, alert, fatal, critical, error, warning, notice, informational, and debug. Note that fatal is
equivalent to emergency, alert, or critical. Foundation software (DMT) message loggingdisplays the range
of security levels.


n Option --output[= <file>]


Write all logging output for an SDKapplication to an SDKlog file in the BASEDIR/smarts/local/logs
directory. The name of the log file is <file>_ <locale>_ <encoding>.log, or the --logname value if
<file>is omitted. If --output is not specified in the invocation line, then no logs are produced.


n Option --errlevel= <min_severity_level>


Used by the SDKexception logging mechanism to determine the minimum exception level for writing
messages to the log files. By default, --errlevel is set to warning. Exceptions below this level are not
written to the log files.


n Option --loglevel= <min_severity_level>


Used by the SDKexception logging mechanism to determine the minimum exception level for sending
messages to the system error logger. By default, --loglevel is set to error. Exceptions below this level
are not forwarded to the system error logger.


n Option --logname= <name>


Used to specify the name of the SDKlog file and the name of the sending application in messages
destined for the system error logger. The default is the name of the application specified by the --
name option (or just -n).


n Option --tracelevel= <min_severity_level>


Used to print a stack trace to the SDKlog file when an exception at this level or above occurs. By
default, --tracelevel is set to fatal. Exceptions below this level do not write a stack trace.


n Environment variable SM_MAIN_OPTIONS


Used to set the defaults for the standard options for all SDKapplications. For example,


SM_MAIN_OPTIONS=--loglevel=None


n Environment variable SM_LOGFILES


Used to change the default log location for SDKlog files from BASEDIR/smarts/local/logs to a user-
specified location.
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Example


SM_LOGFILES=/u/ps/johndoe/ic/logs


The sm_service command line on page 68provides additional information about sm_service
command options. Starting a Domain Manager on page 60provides additional information about
sm_server command options. Chapter 8 Environment Variables Used by VMware Softwareprovides
additional information about environment variables.


Note   In Foundation software (DMT) message logging, the levels emergency, alert, and critical are
not shown; fatal is equivalent to emergency, alert, or critical.
a
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Figure 7‑1.  Foundation software (DMT) message logging


Note   An SDKapplication that makes use of the SDKlogging mechanism will make use of the flow in 
Foundation software (DMT) message loggingto log message to either the SDKlog file or to the
exception logging mechanism. Applications that write directly to stdout or stderr will not abide by this
flow diagram.
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Retrieving and setting log, error and trace levels at
runtime
There are three computed attributes available to get and set the log, error, and trace levels of a
Domain Manager at runtime. These computed attributes, described in Computed attributes to retrieve and
set log, error, and trace levels at runtime, are available on the SM_JIIM_Support object, and are therefore
available from within JIIM code. The SM_System object is a subclass of SM_JIIM_Support and also
inherits these computed attributes. The values of these computed attributes can be retrieved and set by
using dmctl.


Table 7‑3.  Computed attributes to retrieve and set log, error, and trace levels at runtime


Computed Attributes Description


logLevel The minimum exception level for sending messages to the system error logger.The logLevel
attributeis a string, and can be any one of the values set for the --loglevel command line option.


errLevel The minimum exception level for writing messages to the log files. The errLevel attributeis a
string, and can be any one of the values set for the --errlevel command line option.


traceLevel Used to print a stack trace to the SDK log file when an exception at this level or above occurs.
Exceptions below this level do not write a stack trace. The traceLevel attributeis a string, and
can be any one of the values set for the --tracelevel command line option.


Retrieving the current level
To retrieve the current levels, invoke the get method on SM_System::SM-System::logLevel,
SM_System::SM-System::errLevel, or SM_System::SM-System::traceLevel. Invoking the get method will
return a string representing the current level such as "Warning", "Error", or "Fatal".


In this example the error level setting in the MYDM Domain Manager is retrieved, by using dmctl:


dmctl -s MYDM get SM_System::SM-System::errLevel


Warning


Setting the level
To change the current levels, invoke the put method on SM_System::SM-System::logLevel,
SM_System::SM-System::errLevel, or SM_System::SM-System::traceLevel, and the level is changed
appropriately.


In this example, the trace level setting is changed to None in the MYDM Domain Manager.


dmctl -s MYDM put SM_System::SM-System::traceLevel None
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When you change the log, error or trace levels by using the put method on one of these computed
attributes, dmctl does not return anything. However, a message is printed in the log file. The log message
will appear similar to the following


[April 8, 2009 5:03:41 PM EDT +122ms] t@1149000000 SM_ProtocolEngine-6


JM_MSG-*-JM_TRACE_LEVEL_CHANGED-User 'user1', using remote dmctl client (id 6), on host host1 with 


credentials tpadmin1 has changed the Trace level to None; in file 


"/mypath/repos/jiim/SM_JIIM_Support_Impl.c" at line 458


Log files
When the --output option is specified for the sm_server sm_service command, each Manager stores its
working history in a log file. Every time a Manager starts, it writes information to the log file when one of
the following occurs:


n Error


n Connection is lost


Log files are, by default, written to the BASEDIR/smarts/local/logs directory. The SM_WRITEABLE
environment variable specifies the default locations for log files and other output files such as
repositories and saved consoles, as described in SM_WRITEABLE.


Also, the location where log files are saved can be separately controlled with the SM_LOGFILES
environment variable, as described in SM_LOGFILES.


All log files have a .log file type. The default name of a log file is based on the Manager's name. For
example, if the name of the Manager is MYDM, then the name of the English log file is
MYDM_en_US_UTF-8.log. To change the default name, specify a filename with the --output option
for the sm_server sm_service command.


The names of log files written by adapters are described in their respective user’s guides.


SDK programs can maintain up to 1,000 different copies of backup log files for each log that is being
generated. For example, if you are generating two log files, MYDM_en_US_UTF-8.log and
MYDM_fr_UTF-8.log file, you can maintain up to 1,000 backup log files for the
MYDM_en_US_UTF-8.log and 1,000 backup log files for the MYDM_fr_UTF-8.log.


The number of saved log files is determined by the value of the SM_BACKUP_FILE_LIMIT
environment variable. When a Manager starts up, it renames a file that matches its log filenames and
adds a .bak suffix to the name (for example, MYDM_en_US_UTF-8.log to
MYDM_en_US_UTF-8.log.bak). If a file with this name already exists, it is renamed
MYDM_en_US_UTF-8.log.NNN, and a new MYDM_en_US_UTF-8.log.bak is created. By default,
SDK programs save two log files, which does not include the active log file.


Log file management behavior applies to both log files. Log rolling is managed in a synchronized
fashion so that data in multiple logs can be correlated. Thus, when the non-English log rolls, the
English log, if it is being produced, will also roll.
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Diagnostic header
Every log file (initial and after any log rolling) starts with a diagnostic header which indicates the startup
and current information for an SDK process.


The diagnostic header is as follows:


MAIN_MSG-*-STARTUP-The following lines are routine diagnostic output; this is not a crash.


================================================================================


Start of process debug and runtime information:


================================================================================


<the standard header included with a stacktrace>


================================================================================


End of process debug and runtime information


================================================================================


The standard header for a stacktrace includes:


n Command line arguments of the process


n Which libraries are loaded


n The environment


Example


[May 18, 2009 3:18:37 PM EDT +399ms] t@4139505360 platform


MAIN_MSG-*-STARTUP-The following lines are routine diagnostic output; this is not a crash.


Process startup and runtime information:


================================================================================


Linux 206180000: 


IP_NETWORK_SUITE: V10.0.0.0(89403), 14-Apr-2019 16:07:05 Copyright 2019, VMware Inc - Build 106


sm_server --name=Network-Resource --port=46429 --config=icf-r --bootstrap=bootstrap.conf --ignore-


restore-errors --output


DMT: V10.0.0.0(89265), 08-Apr-2019 22:02:59 Copyright 2019, VMware Inc - Build 1161


libsm_clsapi.so (89265) 09-May-2019 02:04:49 UTC


libsm_servif.so (89265) 09-May-2019 02:06:35 UTC


sm_server (89266) 01-Apr-2019 02:58:21 UTC


IP_NETWORK_SUITE: V10.0.0.0(89403), 14-Apr-2019 16:07:05 Copyright 2019, VMware Inc - Build 106


    time=1242674317


    SM_HOME=/opt/InCharge8/IP/smarts


    CWD=/


    Initial uid=0 euid=0 gid=0 egid=0


    Current uid=0 euid=0 gid=0 egid=0


Environment:


    REMOTEHOST=USSAHATHAJL2C.corp.vmware.com


    HOSTNAME=docvm-lx1


    TERM=xterm


    SHELL=/bin/bash


    HISTSIZE=1000


    SM_NEED_PIPEDIR=YES
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    KDE_NO_IPV6=1


    WINDOWID=8388624


    SM_RUNCMD_DEPTH=1


    QTDIR=/usr/lib64/qt-3.3


    QTINC=/usr/lib64/qt-3.3/include


    SM_FIXED=/opt/InCharge8/IP/smarts


    SM_LICENSE=17955@smarts-lmgr92.smarts.com


    XTERM_SHELL=/bin/bash


    USER=root


    


LD_LIBRARY_PATH=/opt/InCharge8/IP/smarts/local/lib:/tmp/istemp5930135131105/_bundledJRE_/lib/i386/serve


r:/tmp/istemp5930135131105/_bundledJRE_/lib/i386:/tmp/istemp5930135131105/_bundledJRE_/../lib/i386:/op


t/InCharge8/IP/smarts/lib


    


LS_COLORS=no=00:fi=00:di=00;34:ln=00;36:pi=40;33:so=00;35:bd=40;33;01:cd=40;33;01:or=01;05;37;41:mi=01;


05;37;41:ex=00;32:*.cmd=00;32:*.exe=00;32:*.com=00;32:*.btm=00;32:*.bat=00;32:*.sh=00;32:*.csh=00;32:*.


tar=00;31:*.tgz=00;31:*.arj=00;31:*.taz=00;31:*.lzh=00;31:*.zip=00;31:*.z=00;31:*.Z=00;31:*.gz=00;31:*.


bz2=00;31:*.bz=00;31:*.tz=00;31:*.rpm=00;31:*.cpio=00;31:*.jpg=00;35:*.gif=00;35:*.bmp=00;35:*.xbm=00;3


5:*.xpm=00;35:*.png=00;35:*.tif=00;35:


    SUDO_USER=gossea


    SUDO_UID=53761


    SM_OUTGOING_PROTOCOL=1,0


    KDEDIR=/usr


    POSIXLY_CORRECT=y


    SM_BROKER_DEFAULT=localhost:426


    NLSPATH=/usr/dt/lib/nls/msg/%L/%N.cat


    SM_IP_VERSIONS=v6v4


    


PATH=/opt/InCharge8/IP/smarts/local/bin/system:/opt/InCharge8/IP/smarts/bin/system:/opt/InCharge8/IP/sm


arts/bin:/work/gossea/bin:/bin:/usr/bin:/opt/gnu/bin:/opt/misc/bin:/bin


    MAIL=/var/spool/mail/gossea


    SM_DEFHOME=/dev/null


    SM_HOME=/opt/InCharge8/IP/smarts


    PWD=/


    INPUTRC=/etc/inputrc


    SM_SITEMOD=/opt/InCharge8/IP/smarts/local:/opt/InCharge8/IP/smarts


    SM_INCOMING_PROTOCOL=1,0


    KDE_IS_PRELINKED=1


    LANG=en_US.UTF-8


    SM_SNMP_BUG_COMPATIBLE=TRUE


    XFILESEARCHPATH=/usr/dt/app-defaults/%L/Dt


    SM_WRITEABLE=/opt/InCharge8/IP/smarts/local


    LM_LICENSE_FILE=17955@smarts-lmgr92.smarts.com


    XTERM_VERSION=XTerm(215)


    SSH_ASKPASS=/usr/libexec/openssh/gnome-ssh-askpass


    SM_PIPEDIR=/var/smarts/pipes/


    HOME=/vmware/gossea


    SHLVL=4


    SUDO_COMMAND=./setup-IP-10_0_0_0-linux.bin


    SM_DEF=/dev/null


    


SM_POP_1=PATH=/opt/InCharge8/IP/smarts/bin:/work/gossea/bin:/bin:/usr/bin:/opt/gnu/bin:/opt/misc/bin:/b


in


    SM_POP_3=LM_LICENSE_FILE=


    REMOTEUSER=gossea
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    LOGNAME=root


    


SM_POP_2=LD_LIBRARY_PATH=/tmp/istemp5930135131105/_bundledJRE_/lib/i386/server:/tmp/istemp593013513110


5/_bundledJRE_/lib/i386:/tmp/istemp5930135131105/_bundledJRE_/../lib/i386


    CVS_RSH=ssh


    QTLIB=/usr/lib64/qt-3.3/lib


    SM_POP_5=SM_BROKER=


    SM_PROCESS_PATH=/opt/InCharge8/IP/smarts/bin/system/sm_server


    SM_POP_4=SM_LIBPATH=


    SM_POP_7=SM_PROCESS_PATH=


    LESSOPEN=|/usr/bin/lesspipe.sh %s


    SM_POP_6=SM_BROKER_DEFAULT=


    SM_BROKER=localhost:426


    SM_LOCALE=


    DISPLAY=10.4.145.237:0.0


    SUDO_GID=201


    


SM_LIBPATH=/opt/InCharge8/IP/smarts/local/lib:/tmp/istemp5930135131105/_bundledJRE_/lib/i386/server:/tm


p/istemp5930135131105/_bundledJRE_/lib/i386:/tmp/istemp5930135131105/_bundledJRE_/../lib/i386:/opt/InCh


arge8/IP/smarts/lib


    G_BROKEN_FILENAMES=1


    CMP_OSLS_PROCESS_PATH=/opt/InCharge8/IP/smarts/bin/system/sm_server/sm_server


Current limit on CORE file size: 4294967295


Current top of heap: 167768064


================================================================================


[May 18, 2009 3:19:53 PM EDT +254ms] t@4052745104 InCharge Framework


ICF_MSG-*-ICF_LICENSEDFEATURE-Enabling the following licensed feature(s):


      InCharge Availability Analysis


      InCharge Performance Analysis


      InCharge IPv6


      Certification of All Vendor Devices


      Certification for Cisco Devices


      Certification for Cisco HSRP support


      Incharge Resource Manager


      InCharge Autodiscovery


      InCharge NAS Host Discovery


      InCharge Virtual Router Discovery


      InCharge Host Resources Discovery


      Alcatel 5620 SAM User


[May 18, 2009 3:19:53 PM EDT +264ms] t@4052745104 InCharge Framework


ICF_MSG-*-ICF_RESTORESTART-PersistenceManager: restore started


[May 18, 2009 3:19:55 PM EDT +349ms] t@4052745104 InCharge Framework


MR-W-RPS_FORMAT_MISMATCH-Format of value for


    ‘ICF_TopologyManager::ICF-TopologyManager::FieldSeparator’ differs from


    the expected type ‘Byte’


[May 18, 2009 3:19:55 PM EDT +350ms] t@4052745104 InCharge Framework


MR-W-RPS_FORMAT_ERROR-Error in format value specified for


    ‘ICF_TopologyManager::ICF-TopologyManager’; in file


    “/work/redcurrent/DMT-10.0.0.0/1161/smarts/repos/mr/dyn_acc.c” at line 3300


 <OK>-<OK>-Normal successful completion


.


.


.
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Date and timestamp, and thread id in each log message
The date and timestamp is written at the beginning of each log record. The thread id is also included in
each log record, following the date and timestamp. For example:


[March 2, 2009 3:31:18 PM EDT +357ms] t@3012557744 SM_ProtocolEngine-1


SVIF_MSG-*-DSM-SM_DebugServer: purgeObserver()


Message at the end of a rolled log
When rolling a log, a message is printed at the bottom of the log file before it is rolled. The message is
similar to the following example:


MAIN-N-Closing this log file at March 19, 2009 9:48:19 PM EDT; continuing in


<BASEDIR>/local/logs/MYDM_en_US_UTF-8.log


Starting a new log file
You can request that a Manager or adapter create a new log file, often referred to as rolling over a log file.
Typically, this is done when a log file becomes quite large. Log files grow indefinitely, though slowly, under
normal conditions.


Most log files are small and rolling over a log file is not necessary. However, if you need to start a new log
file, use the following methods:


n For UNIX systems only, use the kill or roll_log commands.


You can repeat the log file roll-over process as many times as you like. If you need to retain log files
beyond the limit specified by the SM_BACKUP_FILE_LIMIT environment variable, copy or at least
rename the .log.bak files as soon as they are created.


Log rolling is managed in a synchronized fashion so that data in multiple logs can be correlated.
Thus, when the English log rolls, the non-English log, if it is being produced, will also roll.


The kill command method for UNIX systems
On UNIX systems only, it is possible to request that a Manager or an adapter process roll over its log files.
You do this by sending a SIGUSR1 signal to the process ID writing the log file. Use the kill command of
your shell:


kill -USR1 <pid>
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Upon receipt of the USR1 signal, a Manager or adapter process first writes an informational message to
the end of the current log file, repeats the steps it executed at startup, and creates a new log file and a
backup log file. All subsequent logging information is recorded to the new file.


Note   To determine the process number <pid>, you can use the brcontrol utility or for an adapter, use the
system™s ps command.


The roll_log command method
The roll_log command is invoked through the dmctl utility, which requires that you attach to a Manager or
adapter with administrative privileges. The syntax of the command is:


exec roll_log [<file-name>]


The <file-name> option enables you to specify a new name for current and subsequent log files. If you
omit this option, the current naming convention is retained. If you specify a name, the new log file uses
that name. Any new log files created with roll_log will also use this name if a different name is not
specified. The new name specified by <file-name> is handled in exactly the same manner as the --output
option of the sm_server command.


For example, on UNIX systems, the equivalent command is:


         


            BASEDIR/smarts


         /bin/dmctl -s MYDM exec roll_log


When roll_log is invoked, the Manager or adapter does the following:


1 Writes an informational message to the end of the current log files


2 Repeats the steps it executed at startup


3 Creates a new log file and a backup log file for each log file that was currently running.


All subsequent logging information is recorded to the new files.


Controlling the number of saved log files
SDK software can retain up to 1,000 rolled over log files for each log that is being generated. For
example, if you are generating two log files, MYDM_en_US_UTF-8.log and MYDM_fr_UTF-8.log file, you
can maintain up to 1,000 backup log files for the MYDM_en_US_UTF-8.log and 1,000 backup log files for
the MYDM_fr_UTF-8.log.


The number of log files retained is determined by the value of SM_BACKUP_FILE_LIMIT. When a
Manager starts up, it renames a file that matches its log filename, adding a .bak to the name. If there is
an existing .bak file, the .bak will be replaced with .NNN.


For example, if the SM_BACKUP_FILE_LIMIT environment variable is set to 3, the process is as follows:


1 A log file is created and it is named MYDM_en_US_UTF-8.log.
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2 The MYDM_en_US_UTF-8.log file created in step 1 is rolled over:


n The MYDM_en_US_UTF-8.log file created in step 1 is renamed to
MYDM_en_US_UTF-8.log.bak.


n A new MYDM_en_US_UTF-8.log file is created.


3 The MYDM_en_US_UTF-8.log file created in step 2 is rolled over:


n The MYDM_en_US_UTF-8.log.bak file renamed in step 2 is now renamed to
MYDM_en_US_UTF-8.log.001.


n The MYDM_en_US_UTF-8.log file created in step 2 is renamed to
MYDM_en_US_UTF-8.log.bak.


n A new MYDM_en_US_UTF-8.log file is created.


4 The MYDM_en_US_UTF-8.log file created in step 3 is rolled over:


n The MYDM_en_US_UTF-8.log.bak file renamed in step 3 is renamed to
MYDM_en_US_UTF-8.log.002.


n The MYDM_en_US_UTF-8.log file created in step 3 is renamed to
MYDM_en_US_UTF-8.log.bak.


n A new MYDM_en_US_UTF-8.log file is created.


5 The MYDM_en_US_UTF-8.log file created in step 4 is rolled over:


n The MYDM_en_US_UTF-8.log.bak file renamed in step 3 is renamed to
MYDM_en_US_UTF-8.log.003.


n The MYDM_en_US_UTF-8.log file created in step 4 is renamed to
MYDM_en_US_UTF-8.log.bak.


n A new MYDM_en_US_UTF-8.log file is created.


6 Since the limit of MYDM_en_US_UTF-8.log.NNN files that are retained is set to 3, when the
MYDM_en_US_UTF-8.log file created in step 5 is rolled over:


n The oldest log file, MYDM_en_US_UTF-8.log.001 from step 3 , is deleted.


n The MYDM_en_US_UTF-8.log.bak file renamed in step 5 is renamed
MYDM_en_US_UTF-8.log.004.


n The MYDM_en_US_UTF-8.log file created in step 5 is renamed
MYDM_en_US_UTF-8.log.bak.


n A new MYDM_en_US_UTF-8.log is created.
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Environment Variables Used by
VMware Software 8
This chapter includes the following topics:


n How variable values are interpreted


n Methods for setting environment variables for VMware software


n Environment variables for users


How variable values are interpreted
This section describes how SDK software interprets the value of an environment variable. If a variable,
such as SM_BROKER_DEFAULT, requires that its value be formatted in a particular manner, it is noted in
the description of the variable.


How integer variables are interpreted
When the value of an environment variable is to be expressed as an integer, SDK software interprets the
value of the variable as follows:


n Any leading white space is skipped. If the next character is a plus sign (+) or a minus sign (-), it is also
skipped. If the next character was a minus sign, the final numeric value is negated.


n If the value starts with a number other than zero, it may contain only the digits zero through nine, and
it is considered a decimal number.


n If the value starts with “0x” or “0X”, it may contain the digits zero through nine, as well as the letters
“a” through “f” and “A” through “F”. At least one digit or letter must follow the “x” or “X”. The value is
treated as a hexadecimal number.


n If the value starts with a zero and is not followed by a “x” or “X”, it may contain only the digits zero
through seven, and it is treated as an octal number.


Otherwise, the variable does not represent a numeric value. In most cases, an error message is
printed. In a few cases, the numeric value is simply taken to be zero.


Examples of numeric values provides examples of numeric values and how they are interpreted by
SDK software.
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Table 8‑1.  Examples of numeric values


Numeric value Meaning


"0" The value zero.


" 10" The value ten. The leading white space is ignored.


"+010" The value eight, octal.


"0x10" The value sixteen, hexadecimal.


"-123" The value negative one hundred twenty-three.


"abc" An illegal value, may be treated as zero.


"019" An illegal value, leading zero makes it octal, but octal numbers cannot contain a nine. This value
may be treated as zero.


"1 " An illegal value, leading white space is ignored but trailing white space is not. This value may be
treated as zero.


"0X" An illegal value, at least one digit or letter must follow the “OX”. This value may be treated as
zero.


"- 23" An illegal value, embedded white space is not permitted. This value may be treated as zero.


How Boolean variables are interpreted
When an environment variable is expressed as a Boolean, SDK software interprets the value of the
variable, when set, as follows:


n If the value starts with a letter, an uppercase “T” or a lowercase “t” or an uppercase “Y” or a
lowercase “y”, the variable is interpreted as true. If the value starts with any other letter, the variable is
interpreted as false.


n If the value can be interpreted as an integer variable, and it has a value of zero, the variable is
interpreted as false. If the value is anything other than zero, the variable is interpreted as true.


n For any other value, the variable is interpreted as false.


Methods for setting environment variables for VMware
software
You can use one of the following methods to set an environment variable. The difference between these
methods is that one sets the environment variable across an SDK product suite and the other sets the
environment variable for a particular program.


Setting an VMware environment variable suite-wide
When necessary, you can set an environment variable so that an SDK product suite installed in that
location can use it. For example, the SM_BROKER_DEFAULT variable, the value of which is set during
installation, is used in this manner.
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To set an environment variable so that it can be used by the programs of an SDK product suite, add it to
the runcmd_env.sh file, which is located in the BASEDIR/smarts/local/conf directory of that product suite.


1 Use sm_edit to open the runcmd_env.sh file. Invoke sm_edit from the BASEDIR/smarts /bin directory:


 sm_edit conf/runcmd_env.sh


2 Add the environment variable and its value by using the following syntax:


 SM_AUTHORITY="<STD>"


3 Save the runcmd_env.sh file and close it.


4 Any SDK program within a product suite started after this point will use the applicable environment
variables specified in the runcmd_env.sh file. SDK programs that are already running need to be
restarted for any new environment variable to take effect.


Setting an VMware environment variable for a program
You can also set an environment variable so that it only affects a particular program. Typically, this is done
by adding the environment variable to the program™s sm_service command line. For example, if you
want a Manager to use a particular serverConnect.conf file, you would specify the
SM_SERVERCONNECT variable in the sm_service command line for that program.


The following example sets the value of the SM_SERVERCONNECT environment variable to point to the
server_Connect_IP.conf file.


1 Use the sm_service show action with the --cmdline option to display the existing command line for
the program. You must have administrative privileges when typing this command.


 t 


                  BASEDIR/smarts


               /bin/sm_service show --cmdline ic-am-server s


                  BASEDIR/smarts


               /bin/sm_service install


 --startmode=runonce ic-am-server


  


                  BASEDIR/smarts


               /bin/sm_server


   --name=INCHARGE-AM


   --config=icf


    --bootstrap=bootstrap-am.conf


    --port=0


    --ignore-restore-errors


    --output
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2 Use the sm_service install action with the --force option to add the environment variable to the
command line. The --env option specifies the environment variable.


 t 


                  BASEDIR/smarts


               /bin/sm_service install --force 


 --startmode=runonce


 --env=SM_SERVERCONNECT=


                  BASEDIR/smarts


               /conf


 /serverConnect_IP.conf


 ic-am-server


  


                  BASEDIR/smarts


               /bin/sm_server


   --name=INCHARGE-AM


   --config=icf


   --bootstrap=bootstrap-am.conf


   --port=0


   --ignore-restore-errors


    --output s


3 Do one of the following:


n Start the program.


n Stop and restart the program.


Environment variables for users
The following list of environment variables can be applied to SDK software.


n SM_DISPLAY


n SM_EDITOR


n SM_SNMP_BUG_COMPATIBLE


n SM_SNMP_MAX_MESSAGE_SIZE


n SM_ENABLE_SNMP_SET


n SM_MAIN_OPTIONS


n SM_OUTGOING_PROTOCOL


n SM_INCOMING_PROTOCOL


n SM_DISABLE_KEEPALIVES


n SM_IP_VERSIONS


n SM_MAX_MONITORING_THREADS


n SM_AUDIT_CLIENT_ACTIONS
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n SM_AUDIT_ALL_CONNECTIONS


n SM_NO_LINE_FOLD


n SM_FOLD_WIDTH


n SM_HOSTSFILE


n SM_LOCALE


n SM_ENCODING_SHELL


n SM_ENCODING_SYSTEM


n SM_ENCODING_INPUT


n SM_ENCODING_OUTPUT


n SM_JAVA_PACKAGE_ROOT


n SM_JDK_HOME


n SM_JAVA


n SM_JAVAHOME


n SM_BROKER_DEFAULT


n SM_BROKER


n LM_LICENSE_FILE


n SM_LICENSE


n SM_LMGRD_LICENSE_FILE


n SM_AUTHORITY


n SM_KEYFILE


n SM_CLIENTCONNECT


n SM_OKLOGIN_LEVEL


n SM_SERVERCONNECT


n SM_DATETIME_FORMAT


n TZ


n LC_TIME


n SM_BACKUP_FILE_LIMIT


n SM_WRITEABLE


n SM_LOGFILES


n SM_RULESET_PATH


n SM_COUNT_REPOS_LOCKS


n SM_REPOS_LOCKS_LIMIT
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SM_DISPLAY
This environment variable specifies the location of a client’s X Window System display (typically for a
console user). Output from a server tool that uses the X protocol is directed to the display specified by
SM_DISPLAY. Only VMware Smart Assurance Service Assurance Manager uses this variable.


SM_EDITOR
This environment variables enables you to set the text editor that is invoked by the sm_edit utility. When
SM_EDITOR is not defined, the sm_edit utility uses the value of one of the following system environment
variables: VISUAL then EDITOR. If these environment variables are not defined, the sm_edit utility uses
the following editors:


n Edit editor on UNIX systems


SM_SNMP_BUG_COMPATIBLE
SDK implementation of the SNMP protocol is strict in that SDK software only sends or receives SNMP
messages that conform to the SNMP standard. By default, SDK software only accepts conforming SNMP
messages. Unfortunately, not all SNMP implementations are as strict. The result is that SDK programs
may receive nonconforming SNMP messages.


In some cases, SDK software can successfully interpret and handle nonconforming messages. If you set
the SM_SNMP_BUG_COMPATIBLE environment variable, SDK software will accept the nonconforming
SNMP messages in two cases:


n When the type of an SNMP variable is not the required type but the value can be unambiguously
interpreted as the required type. An example is when a TimeTicks variable type is sent as an
Unsigned32 or non-negative Integer32 variable.


n When the type of an SNMP variable is inconsistent with the version of the SNMP protocol that
delivers the message. An example is when a Counter64 variable is sent in a version 1 (v1) SNMP
message.


When the SM_SNMP_BUG_COMPATIBLE environment variable is set, any invalid SNMP message
that is accepted by the SDK software is logged at a warning level to pinpoint the source of the invalid
SNMP message and to determine the reason why it is invalid.


SM_SNMP_BUG_COMPATIBLE is a Boolean.


SM_SNMP_MAX_MESSAGE_SIZE
SM_SNMP_MAX_MESSAGE_SIZE is an environment variable that controls the maximum size of the
SNMP datagram that is processed. The default value is 8k (8192 bytes).
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The default size can be overridden by setting the environment variable
SM_SNMP_MAX_MESSAGE_SIZE to the required maximum size. For example, setting
SM_SNMP_MAX_MESSAGE_SIZE equal to 16384 sets the maximum to 16k, which is double the default
value.


If you try to set SM_SNMP_MAX_MESSAGE_SIZE to less than 1472 (the recommended minimum for
UDP/IPv4 per RFC-3417, section 3.2), it will be silently adjusted to be exactly 1472.


Note   Although SM_SNMP_MAX_MESSAGE_SIZE can be used to set the maximum SNMP datagram
size to less than the default 8k, this is strongly discouraged.


If you try to set SM_SNMP_MAX_MESSAGE_SIZE greater than 64k (65536 bytes), it will be set to
exactly 65536. A value of 65536 bytes is the largest possible datagram size supported by UDP.


Important   Setting SM_SNMP_MAX_MESSAGE_SIZE to large values will increase server memory
usage. This is especially true for trap processing during periods of high trap reception rate. Therefore, this
option should only be used when it is needed to communicate with SNMP devices sending unusually
large datagrams. Only increase the setting of this environment variable on the specific Domain Managers
which manage those devices.


SM_ENABLE_SNMP_SET
This environment variable is disabled by default.


n When set to 1, it enables the use of the SM_SNMP_Actions::Set( ) method.


n When it is disabled (set to 0), the method cannot be used to set the value of an OID.


SM_MAIN_OPTIONS
The environment variable SM_MAIN_OPTIONS enables you to set default values for the standard
options supported by SDK software, as described in Standard options supported by
SM_MAIN_OPTIONS. You can override the values specified by SM_MAIN_OPTIONS by providing
alternative values on the command line.


Table 8‑2.  Standard options supported by SM_MAIN_OPTIONS


Standard option Definition


--accept=<hosts> Specify a list of hosts, by name or IP address, from which SDK programs accept connections.
Multiple entries should be separated by commas.


By default, SDK programs accept connections from any host. SDK programs that accept
connections are dmstart, sm_server, sm_adapter, and sm_trapd. Note that sm_adapter and
sm_trapd accept only connections when started with the --name option.


To limit connections to the host on which SDK software is installed, specify the name or IP
address of the host instead of localhost.


--daemon Run the SDK program as a daemon (UNIX only). Messages generated from internal logging
calls are directed to the log file. Log files are written to the BASEDIR/smarts/logs directory.
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Table 8‑2.  Standard options supported by SM_MAIN_OPTIONS (Continued)


Standard option Definition


--facility=<facility> Instructs the SDK program to log any syslog messages with the specified syslog facility
(UNIX/Linux only). The default is Daemon.


The <facility> setting can be one of the following:
n Kern
n User
n Mail
n Daemon
n Auth
n Lpr
n News
n Uucp
n Cron
n Local0
n Local1
n Local2
n Local3
n Local4
n Local5
n Local6
n Local7


--errlevel=<level> Specify the minimum level at which error events are written to the standard error output.
Possible values include: none, emergency, alert, fatal, critical, error, warning, notice,
informational, debug. The default is warning. (Note that fatal is equivalent to emergency, alert,
or critical.)


--loglevel=<level> Specify the minimum level at which event messages are written to the system logging facility.
Possible values include: none, emergency, alert, fatal, critical, error, warning, notice,
informational, debug. The default is error. (Note that fatal is equivalent to emergency, alert, or
critical.)


--logname=<name> Specify the name used to identify the SDK program in the system log. On UNIX systems, the
default is the program name.


--output[=<file>] Messages generated from internal logging calls are directed to a log file. Log files are written
to the BASEDIR/smarts/logs directory. If <file> is not specified, the value of --logname is used.


If a log file with specified name already exists, it is moved to a backup file,
BASEDIR/smarts/local/logs/<file>.bak. If the backup file already exists, it is deleted.


--tracelevel=<level> Specify the minimum level at which a process stack trace is written to the standard error
output. Possible values include: none, emergency, alert, fatal, critical, error, warning, notice,
informational, debug. The default is fatal. (Note that fatal is equivalent to emergency, alert, or
critical.)
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Table 8‑2.  Standard options supported by SM_MAIN_OPTIONS (Continued)


Standard option Definition


--useif=<IP address> Specifies the IP address that the SDK program should use as the source address for outgoing
packets and the destination address for which it accepts incoming packets. <IP Address>
must be a *v4* address.


--version Print the version of the SDK program.


For example, if you set SM_MAIN_OPTIONS to --errlevel=fatal, then SDK programs will record all errors
with a level of fatal or higher.


SM_OUTGOING_PROTOCOL
This environment variable controls the kinds of connections that an SDK program acting as a client is
allowed to initiate. It can contain one or more numbers. These numbers specify the security level at which
communications can occur. If more than one is specified, they must be separated with commas. If the
variable is not set, it is the same as specifying "0".


SM_INCOMING_PROTOCOL
This environment variable controls the kinds of connections that an SDK program acting as a server is
allowed to accept. It can contain one or more numbers. If more than one is specified, they must be
separated with commas. If the variable is not set, it is the same as specifying "0".


SM_DISABLE_KEEPALIVES
This environment variable controls KeepAlive messages for both Managers and clients. To disable
KeepAlive messages, specify a nonzero number. To enable the messages, specify a zero (0).


SDK software uses KeepAlive messages to test TCP connections between SDK components. If a
KeepAlive message is not received, a message is written to the Manager’s log file. These logged
messages may indicate that failed KeepAlive messages may be the result of other software applications
and hardware not supporting TCP urgent data, and not the result of the connection being down.


To control KeepAlive messages for only the Global Console, specify the Java property
com.smarts.disable_keepalives as described in the
VMware Smart Assurance Service Assurance Manager Operator Guide.


SM_IP_VERSIONS
The SM_IP_VERSIONS environment variable enables you to control the address family used for
hostname resolution. It affects the following:


n VMware Smart Assurance utilities that use a command line (for example, sm_snmpwalk, dmctl,
sm_tpmgr)


n Name resolution during discovery


n ASL scripts


n Ping
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n DNS lookup


SM_IP_VERSIONS also controls which ports a Domain Manager listens on:


n If SM_IP_VERSIONS is set to "v4" or "v6", a Domain Manager will only open sockets and listen on
that address family.


n If SM_IP_VERSIONS is set to "v4v6" or "v6v4", a Domain Manager will listen on both address
families.


The SM_IP_VERSIONS setting is also dependent on the address family as follows:


n If you are running on a system which only supports a single address family, it is recommended that
SM_IP_VERSIONS be set to "v4" or "v6", as appropriate.


n If you are running on a system which supports both address families, set it to the value which best
describes your administrative preferences.


The variable can be set depending on the order in which you want to do hostname resolution.If the
variable is not set, and the address family is not explicitly provided on the command line (for example,
frame.someDomain.vmware.com:v4), the default behavior is to resolve the hostname as an IPv4
hostname. The variable should be set to the address family that is predominate for the network.


To set this variable, add it to the runcmd_env.sh file, which is located in the
BASEDIR/smarts/local/conf directory of the product suite.


The syntax of the environment variable is:


SM_IP_VERSIONS="<ip_value>"


Acceptable values for the SM_IP_VERSIONS environment variable lists acceptable values for the
SM_IP_VERSIONS environment variable.


Table 8‑3.  Acceptable values for the SM_IP_VERSIONS environment variable


ip_value Description


"V4" The hostname is resolved to an IPv4 hostname (default).


"V6" The hostname is resolved to an IPv6 hostname.


"V4V6" The hostname is resolved to an IPv4 hostname. If that fails, the Domain Name System server tries to
resolve the hostname to an IPv6 hostname.


"V6V4" The hostname is resolved to an IPv6 hostname. If that fails, the Domain Name System server tries to
resolve the hostname to an IPv4 hostname.


Note: The acceptable value can also be lowercase ("v4", "v6", "v4v6" or "v6v4").


Detailed instructions about setting environment variables and information about the runcmd_env.sh file is
provided in the Methods for setting environment variables for VMware software.


SM_MAX_MONITORING_THREADS
TheSM_MAX_MONITORING_THREADS environment variable represents the maximum number of
monitoring threads that the monitoring system will use for monitoring changes. The default value is 3.
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The recommended values are described in Recommended values for
SM_MAX_MONITORING_THREADS.


Table 8‑4.  Recommended values for SM_MAX_MONITORING_THREADS


Platform Recommended value


All supported platforms Up to 3, but no more than the number of CPUs on the machine.


SM_AUDIT_CLIENT_ACTIONS
Setting the SM_AUDIT_CLIENT_ACTIONS environment variable equal to 1 produces the log if the client
requests it. However, even if the client requests it, auditing does not occur if it has not been enabled on
the server with either the SM_AUDIT_CLIENT_ACTIONS variable, or the
SM_AUDIT_ALL_CONNECTIONS environment variable, which is described in 
SM_AUDIT_ALL_CONNECTIONS.


SM_AUDIT_ALL_CONNECTIONS
Setting the SM_AUDIT_ALL_CONNECTIONS environment variable equal to 1 forces the logging even if
the client does not request it. If you set SM_AUDIT_ALL_CONNECTIONS equal to 1, then you do not
have to set SM_AUDIT_CLIENT_ACTIONS, described in SM_AUDIT_CLIENT_ACTIONS.


If you set SM_AUDIT_ALL_CONNECTIONS, you do not need to modify the client. However, if you
suspect a specific client you might still want to use the by-request-only access provided by
SM_AUDIT_CLIENT_ACTIONS to reduce the amount of logging coming from other sources.


SM_NO_LINE_FOLD
The environment variable SM_NO_LINE_FOLD can be set to prevent the line wrapping in log files. Add
the following lines to the BASEDIR/local/conf/runcmd_env.sh file:


export SM_NO_LINE_FOLD


SM_NO_LINE_FOLD="TRUE"


You can use any string value for SM_NO_LINE_FOLD, it is only if it has no string associated with it that
lines fold.


SM_FOLD_WIDTH
The SM_FOLD_WIDTH environment variable removes the default line wrapping of exception messages
in the log file. The lines will only wrap if SM_FOLD_WIDTH=X where X specifies the column at which to
fold the lines.
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SM_HOSTSFILE
On 32-bit Solaris builds of SDK software, a bug in the Solaris system libraries prevents /etc/hosts from
being read properly if more than 256 file descriptors are in use. If you set SM_HOSTSFILE=1 in the
environment, then /etc/hosts is read using application code, bypassing the system libraries as a work-
around to this problem.


Note   This work-around only handles IPv4 addresses in /etc/hosts. The work-around does not work for
IPv6 addresses, and will not read /etc/ipnodes (or /etc/inet/ipnodes). IPv6 addresses obtained from DNS
are handled properly in all cases. If it is necessary to obtain IPv6 addresses from /etc/ipnodes, you should
use the 64-bit version of the product.


SM_HOSTSFILE is only available on Solaris versions of SDK software. It operates in both 32 and 64-bit
builds, but since the 64-bit system libraries work properly, it is recommended that it not be set on 64 bit
builds.


Variables that control the locale and encoding
These variables specify the local and encoding used by SDK programs.


SM_LOCALE
The SM_LOCALE environment variable specifies the appropriate language and region in which you want
to see output. In general, SM_LOCALE must be specified consistently with advice in IETF RFC
1766/3066. If you do not specify a value for SM_LOCALE, it defaults to en_US.


ICU allows for some flexibility on the case (upper and lower) of the language and country codes and for
the separator character used to join the two.


SDK software will convert the value specified in SM_LOCALE to a normalized form that can be
recognized by all ICU library functions which take a locale argument. The normalization (done by calling
the ICU function, uloc_canonicalize) enables ICU library functions to perform predictably.


export SM_LOCALE=ja_JP


sm_server –-name=Tokyo


SM_ENCODING_*
There are four SM_ENCODING_* environmental variables that can be set.


n SM_ENCODING_SHELL indicates the encoding used by the shell, primarily useful for specifying
what encoding is used for command line arguments.


n SM_ENCODING_SYSTEM indicates the encoding used for internal interaction with the operating
system.


n Primarily dictates the encoding used for file system access.


n Secondarily indicates the encoding used when internally accessing the environment.
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n SM_ENCODING_INPUT indicates the encoding used by stdin.


n SM_ENCODING_OUTPUT indicates the encoding used by stdout and stderr.


Tuning the SM_ENCODING_INPUT and SM_ENCODING_OUTPUT values is primarily useful if you
are redirecting or piping text somewhere other than the shell.


On UNIX the behavior is:


n If SM_ENCODING_SHELL is not set, then its value will default to "UTF-8."


n If SM_ENCODING_SYSTEM is not set, then its value will mirror SM_ENCODING_SHELL.


n If SM_ENCODING_INPUT is not set, then its value will mirror SM_ENCODING_SHELL.


n If SM_ENCODING_OUTPUT is not set, then its value will mirror SM_ENCODING_INPUT.


Note   In UNIX it generally makes sense to set all four values identically.


The following example sets the encoding to Shift_JIS.


export SM_ENCODING_INPUT=Shift_JIS


export SM_ENCODING_OUTPUT=Shift_JIS


export SM_ENCODING_SHELL=SHIFT_JIS


export SM_ENCODING_SYSTEM=Shift_JIS


Variables that control Java settings
These variables specify the Java settings.


SM_JAVA_PACKAGE_ROOT
The SM_JAVA_PACKAGE_ROOT environment variable can be used to specify the java package root.


SM_JDK_HOME
The SM_JDK_HOME environment variable is used to indicate the location of the JDK, if present. If you
provide the location of the JDK while running the appropriate setup script, then the SM_JDK_HOME
variable will be defined in the runcmd script.


Note   If you are using a 64-bit version of the SDK software, then you should set SM_JDK_HOME to the
location of a 64-bit version of the JDK. Likewise, if you are using a 32-bit version of the SDK software,
then you should set SM_JDK_HOME to indicate the location of a 32-bit version of the JDK.


SM_JAVA
The SM_JAVA environment variable specifies a Java Runtime Environment (JRE) other than that in
BASEDIR/smarts/jre. The contents are the paths to the libraries of the JRE. On UNIX, the value of
SM_JAVA is added to the LD_LIBRARY_PATH (Solaris and Linux).


This variable is optional. If left unset, runcmd will assume standard paths relative to the value of
SM_JAVAHOME.
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SM_JAVAHOME
The SM_JAVAHOME environment variable is used in conjunction with SM_JAVA to specify a non-
standard JRE. It specifies the location of the JRE, and defines the value of the JVM's "java.home" system
property.


n If SM_JAVAHOME is left unset and SM_JDK_HOME was specified, then SM_JAVAHOME will
effectively be set to SM_JDK_HOME/jre.


n If left unset and SM_JDK_HOME is also unset, and if the BASEDIR/jre directory exists, then
SM_JAVAHOME will effectively be set to BASEDIR/jre.


Variables that control the Broker
These variables control the location of the Broker.


SM_BROKER_DEFAULT
This environment variable specifies the default location of the Broker. When you install SDK software, you
are prompted for the host location of the Broker and its port number. The Broker’s location can be
specified in any one of the following formats: “host:port”, “host” or “:port”. When the host or port values are
omitted, the default value is used. The default host value is “smarts-broker” or “localhost”. The default port
value is 426. If the location of the Broker changes, you must edit the runcmd_env.sh file on all systems
where SDK software is installed. In addition, you may have to edit the Broker startup script.


SDK software follows these steps to determine the Broker’s location:


1 Verifies whether the Broker’s location was specified as an option at startup. When this option is
specified, no other options are checked.


2 It checks the value of the SM_BROKER_DEFAULT environment variable. If this variable is set, no
other options are checked.


3 It checks if the Broker is running on the host smarts-broker and listening on TCP port 426.


4 If smarts-broker is not defined, the program checks port 426 on localhost.


Note   The hostname smarts-broker is usually an alias, such as a DNS CNAME.


SM_BROKER
SM_BROKER should only be set in special cases when you want to override the default Broker. For
example, if you have to temporarily move your Broker in an emergency or test situation, you could set this
variable.


Under normal circumstances, you should use the SM_BROKER_DEFAULT environment variable to set
the default location of the Broker.


Variables that control VMware security
These variables specify the security used by SDK programs.
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SM_AUTHORITY
This environment variable determines the selection of the authority programs used by the SDK software
for different parts of the authentication process. For example:


SM_AUTHORITY=IDENTIFY=<program1>,AUTHENTICATE=<program2>


where:


n <program1> is the program granting credentials


n <program2> is the program validating credentials.


Note   Program1 and program2 may refer to the same program.


n SM_AUTHORITY=<STD> means:


 SM_AUTHORITY=IDENTIFY=sm_authority,AUTHENTICATE=sm_authority


n SM_AUTHORITY=<NONE> means:


 SM_AUTHORITY=IDENTIFY=sm_authnone,AUTHENTICATE=sm_authnone


n SM_AUTHORITY=someAuthority means:


 SM_AUTHORITY=IDENTIFY=someAuthority,AUTHENTICATE=someAuthority


Optional arguments can be specified after the authority name. A comma may not be included within
the program name. A comma may appear in the arguments if the argument is quoted.


If SM_AUTHORITY is not specified, SM_AUTHORITY=<STD> is assumed.


SM_KEYFILE
This environment variable specifies the location of the imk.dat file. By default, this variable refers to
BASEDIR/smarts/local/conf/imk.dat.


SM_CLIENTCONNECT
This environment variable enables you to specify an alternate location for the clientConnect.conf client-
side authorization file. You must specify the full path, including the filename. The default location is the
BASEDIR/smarts/local/conf/clientConnect.conf directory.


SM_OKLOGIN_LOGLEVEL
This environment variable enables the logging of successful logins at ERROR severity, rather than
NOTICE.


SM_OKLOGIN_LOGLEVEL is a Boolean.
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SM_SERVERCONNECT
This environment variable enables you to specify an alternate location for the serverConnect.conf server-
side authorization file. You must specify the full path, including the filename. The default location is the
BASEDIR/smarts/local/conf/serverConnect.conf directory.


Variables that control date and time formatting
Managers and adapters format dates and times for printing in log files, archive files, and various
messages. You can control many aspects of this formatting with the following variables.


Most dates and times displayed in SDK consoles are formatted by the consoles themselves and are not
controlled by these variables.


Additional information can be found on many systems, such as:


n man pages on UNIX systems


SM_DATETIME_FORMAT
The SM_DATETIME_FORMAT environment variable determines the default value for the
si_i18n_datetime_format() function. The si_i18n_datetime_format() function is the basis of CI_Time and
CI_Exception. In addition, CI_Logger uses CI_Time classes to render times. Therefore, the
SM_DATETIME_FORMAT environment variable determines the default rendering for any and all
timestamps.


The SM_DATETIME_FORMAT environment variable determines the default rendering for any and all
timestamps. The SM_DATETIME_FORMAT environment variable can be set to several different values. If
you do not set the value of the SM_DATETIME_FORMAT variable, then the default is SI_DAT_LONG.


The following examples show the output, based on the setting.


SM_DATETIME_FORMAT=SI_DAT_LOCALE_NEUTRAL


  1969/12/31 20:00:42


SM_DATETIME_FORMAT=SI_DAT_SHORT


  31/12/69 20:00


SM_DATETIME_FORMAT=SI_DAT_MEDIUM


  31 déc. 1969 20:00:42


SM_DATETIME_FORMAT=SI_DAT_LONG


  31 décembre 1969 20:00:42 HMG-05:00


SM_DATETIME_FORMAT=SI_DAT_FULL


  mercredi 31 décembre 1969 20:00:42 États-Unis (New York)


SM_DATETIME_FORMAT=SI_DAT_DEFAULT


  31 décembre 1969 20:00:42 HMG-05:00


SM_DATETIME_FORMAT=


  31 décembre 1969 20:00:42 HMG-05:00


SM_DATETIME_FORMAT=bogus


31 décembre 1969 20:00:42 HMG-05:00
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TZ
This system environment variable determines which time zone is used when formatting a time. As such, it
controls the conversion from an internal time base to the appropriate local time. The syntax is 
TZ=NNNshh:mmDDD, where:


n NNN is the time zone name.


n s is an optional sign.


n hh and mm are the offset in hours and minutes from GMT. Positive offsets represent time zones
behind GMT, negative offsets represent those ahead of GMT.


n DDD is the corresponding name of Daylight Savings time when it is in effect.


For example, in the eastern United States, TZ is set to EST5EDT - eastern standard time/eastern
daylight time, where EST is five hours behind GMT.


All UNIX systems use a system initialization file to set this variable.


LC_TIME
This system environment variable controls the formatting of dates and times. By default, Managers use
time and date formats that are sensitive to locale settings. For example, if you chose a date format that
includes the name of the day of the week, in the English locale, the first weekday is formatted as Monday,
while in the French locale it is formatted as Lundi.


If LC_TIME is not set, the system variable LC_ALL is used. If LC_ALL is not set either, the system
variable LANG is used. Finally, if LANG is not set, a default “C locale” (essentially US English) is used.


The locale names and available locales are system specific.


Variables that control how VMware programs read and write files
These variables control the location of SDK output, such as log files and repository. They also control the
location from which SDK programs read files, such as ASL scripts.


SM_BACKUP_FILE_LIMIT
SDK programs create a new log file when they are restarted or when the log file is rolled over. This
environment variable determines the number of log files that are saved by SDK programs. Chapter 7
Managing Log Files provides additional information, including an example.


If this environment variable is set to 0, only the current log file and a backup of the previous log file are
saved. If this variable is set to an invalid value, a warning message is written to the log file and the default
value is used instead. Valid values are 0 through 999; the default value is 3.


SM_WRITEABLE
This environment variable specifies the location where SDK software writes output files such as
repositories, log files, and saved consoles. By default, the location is set to BASEDIR/smarts/local. If you
set the SM_WRITEABLE variable, you must also create the underlying directories.
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Directories controlled by SM_WRITEABLE lists the directories whose location is controlled by
SM_WRITEABLE:


Table 8‑5.  Directories controlled by SM_WRITEABLE


Subdirectory Contents


/consoles Saved consoles


/logs Log files


/repos Repository files


The location where log files are saved can be separately controlled with the SM_LOGFILES environment
variable.


SM_LOGFILES
This environment variable is used to specify the location where log files should be written. Setting this
variable is optional. If there is no value assigned to this variable, the log files will be written to the location
SM_WRITEABLE/logs. If you set SM_LOGFILES, you must also create the /logs directory at the location
specified by the variable.


This variable takes precedence over the value of the SM_WRITEABLE environment variable.


SM_RULESET_PATH
By default, SDK programs only invoke ASL scripts located in the BASEDIR/smarts/rules directory, the
BASEDIR/smarts/local/rules directory, or a subdirectory of one of these directories. You can use this
environment variable to specify additional locations from which SDK programs can invoke ASL scripts.


When set, the directories specified by SM_RULESET_PATH are searched before the system defaults.


Variables that control thread locks
These variables control thread locking in SDK programs.


SM_COUNT_REPOS_LOCKS
A Manager crashes whenever the stack used by a thread exceeds the space allocated. Threads acquire
locks to access instances in the Manager’s repository. If a thread exceeds a certain number of locks, then
the lock fails with an error code of ELOOP and a message is written to the log file.


This environment variable is used to control lock counting. SM_COUNT_REPOS_LOCKS must be set
before starting the Manager. By default, the lock counting is turned off. To enable lock counting, set
SM_COUNT_REPOS_LOCKS to TRUE, yes, or 1.


SM_REPOS_LOCKS_LIMIT
This environment variable determines the number of locks which, if exceeded, causes the ELOOP error.
SM_REPOS_LOCKS_LIMIT must be an integer number. The default value is 50.
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VMware recommends a value that is less than 100. Setting low values might cause legitimate requests to
fail and affect analysis. Setting high values might allow the thread to run out of stack space before
reaching the lock count limit.
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Wildcards Used by VMware
Software 9
Types of wildcard patterns
A wildcard pattern is a series of characters that are matched against incoming character strings. You can
use these patterns when you define pattern matching criteria.


Matching is done strictly from left to right, one character or basic wildcard pattern at a time. Basic wildcard
patterns are defined in Basic wildcard patterns. Characters that are not part of match constructs match
themselves. The pattern and the incoming string must match completely. For example, the pattern abcd
does not match the input abcde or abc.


A compound wildcard pattern consists of one or more basic wildcard patterns separated by ampersand
(&) or tilde (~) characters. A compound wildcard pattern is matched by attempting to match each of its
component basic wildcard patterns against the entire input string. Compound wildcard patterns are listed
in Compound wildcard patterns.


If the first character of a compound wildcard pattern is an ampersand (&) or tilde (~) character, the
compound is interpreted as if an asterisk (*) appeared at the beginning of the pattern. For example, the
pattern ~*[0-9]* matches any string not containing any digits. A trailing instance of an ampersand
character (&) can only match the empty string. A trailing instance of a tilde character (~) can be read as
“except for the empty string.”


Note   Spaces are interpreted as characters and are subject to matching even if they are adjacent to
operators like “&”.


Table 9‑1.  Basic wildcard patterns


Character Description


? Matches any single character.


For example, server?.example.com matches server3.example.com and serverB.example.com, but not
server10.example.com.


* Matches an arbitrary string of characters. The string can be empty.


For example, server*.example.com matches server-ny.example.com and server.example.com (an empty
match).
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Table 9‑1.  Basic wildcard patterns (Continued)


Character Description


[set] Matches any single character that appears within [set]; or, if the first character of [set] is (^), any single
character that is not in the set. A hyphen (-) within [set] indicates a range, so that [a-d] is equivalent to
[abcd]. The character before the hyphen (-) must precede the character after it or the range will be empty.
The character (^) in any position except the first, or a hyphen (-) at the first or last position, has no special
meaning.


For example, server[789-].example.com matches server7.example.com through server9.example.com,
but not server6.example.com. It also matches server-.example.com.


For example, server[^12].example.com does not match server1.example.com or server2.example.com,
but will match server8.example.com.


<n1-n2> Matches numbers in a given range. Both n1 and n2 must be strings of digits, which represent
nonnegative integer values. The matching characters are a non-empty string of digits whose value, as a
nonnegative integer, is greater than or equal to n1 and less than or equal to n2. If either end of the range
is omitted, no limitation is placed on the accepted number.


For example, 98.49.<1-100>.10 matches a range of IPv4 addresses from 98.49.1.10 through
98.49.100.10.


Example of an omitted high end of the range: <50-> matches any string of digits with a value greater than
or equal to 50.


Example of an omitted low end of the range: <-150> matches any value between zero and 150.


For a more subtle example: The pattern <1-10>* matches 1, 2, up through 10, with * matching no
characters. Similarly, it matches strings like 9x, with * matching the trailing x. However, it does not match
11, because <1-10> always extracts the longest possible string of digits (11) and then matches only if the
number it represents is in range.


| Matches alternatives. For example,”ab|bc|cd” without spaces matches exactly the three following strings:
“ab”, “bc”, and “cd”. A | as the first or last character of a pattern accepts an empty string as a match.


Example with spaces “ab | bc” matches the strings “ab” and “ bc”.


\ Removes the special status, if any, of the following character. Backslash (\) has no special meaning
within a set ([set]) or range (<n1-n2>) construct.


Special characters for compound wildcard patterns are summarized in Compound wildcard patterns.


Character Description


& “And Also” for a compound wildcard pattern. If a component basic wildcard pattern is preceded by & (or is the
first basic wildcard pattern in the compound wildcard pattern), it must successfully match.


Example: *NY*&*Router* matches all strings that contain NY and also contain Router.


Example: <1-100>&*[02468] matches even numbers between 1 and 100 inclusive. The <1-100> component
only passes numbers in the correct range and the *[02468] component only passes numbers that end in an
even digit.


Example: *A*|*B*&*C* matches strings that contain either an A or a B, and also contain a C.


~ “Except” for a compound wildcard pattern (opposite function of &).If a component basic wildcard pattern is
preceded by ~, it must not match.


Example: 10.20.30.*~10.20.30.50 matches all devices on network 10.20.30 except 10.20.30.50.


Example: *Router*~*Cisco*&*10.20.30.*~10.20.30.<10-20>* matches a Router, except a Cisco router, with an
address on network 10.20.30, except not 10.20.30.10 through 10.20.30.20.
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Preface 1
As part of an effort to improve its product lines, VMware periodically releases revisions of its software and
hardware. Therefore, some functions described in this document might not be supported by all versions of
the software or hardware currently in use. The product release notes provide the most up-to-date
information on product features.


Contact your VMware technical support professional if a product does not function properly or does not
function as described in this document.


Note   This document was accurate at publication time. Go to VMware Online Support docs.vmware.com
to ensure that you are using the latest version of this document.


This chapter includes the following topics:


n Purpose


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n VMware Smart Assurance Service Assurance Manager


n Related documentation


n Suggestions for searching PDF files


n Conventions used in this document


n Pathname conventions


n Graphical conventions


n Manager


n Where to get help


n Your comments


Purpose
The VMware Smart Assurance Service Assurance Manager Deployment Guide describes how to deploy
the VMware Smart Assurance Service Assurance Manager and related components of the
VMware Smart Assurance Service Assurance Manager.
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This guide is intended as a comprehensive resource for deployment tasks. In many cases, you will be
referred to other VMware Smart Assurance documents for specific procedures and configuration tasks,
such as:


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers ” This
document that accompanied your software product contains detailed hardware requirements, platform
requirements, and installation procedures.


n VMware Smart Assurance Service Assurance Manager Configuration Guide ” This document
contains information about the Global Manager Administration Console.


n VMware Smart Assurance System Administration Guide ” This document contains detailed
administration procedures for the VMware Smart Assurance deployment.


Audience
This guide is intended for the following audiences:


n Network and system administrators who aid in designing and maintaining VMware Smart Assurance
deployments


n Integrators and network consultants who aid in designing VMware Smart Assurance deployments and
then install, validate, and tune the deployments


n Systems engineers who design VMware Smart Assurance deployments


n VMware Smart Assurance Professional Services personnel who design, install, validate, and tune
VMware Smart Assurance deployments


n VMware Smart Assurance Global Services personnel who respond to inquiries, problems, and issues
that arise during VMware Smart Assurance deployments


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<productsuite>.


n For example, on UNIX operating systems, VMware Smart Assurance Service Assurance Manager is,
by default, installed to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than/opt/InCharge (on UNIX)
but you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.
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VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System


n Global Console


n Business Dashboard


n Companion UI (CUI)


n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)


n VMware Smart Assurance Adapter for UIM/O


n XML Adapter


Related documentation
In addition to this document, VMware Corporation provides a help system for command line programs as
well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


n VMware Smart Assurance Common Information Model (ICIM) 1.11 Reference for Non-Service
Assurance Manager Products


n VMware Smart Assurance Common Information Model (ICIM) Reference for Service Assurance
Manager


n VMware Smart Assurance Foundation Documentation Portfolio


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ASL Reference Guide
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n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide


VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes


n VMware Smart Assurance Open Source License and Copyright Information


n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


n VMware Smart Assurance Service Assurance Manager Deployment Guide


n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide


n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide


n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance Companion UI Open Source License and Copyright Information for GPLv3
as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance products.
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Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1 If the documentation is not accessible to all users of the VMware Smart Assurance product, copy the
contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a shared drive on
your LAN, so that operators and others can view the documentation.


2 To search throughout the documentation library, open the Acrobat Reader software:


3 Select Edit > Search, and type a word or phrase.


4 Select All PDF Documents in, in the Where would you like to search option, and type the
pathname of the location where the PDF documents reside.


If you have more than one VMware Smart Assurance product installed, you can set up cross-product
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each product into
this common documentation directory path.


Conventions used in this document
VMware uses the following convention for special notices:


Note   NOTICE is used to address practices not related to personal injury.


Typographical conventions
VMware uses the following type style conventions in this document:


Normal Used in running (nonprocedural) text for:
n Names of interface elements
n Names of resources, attributes, pools, Boolean expressions, buttons, DQL statements, keywords,


clauses, environment variables, functions, and utilities
n URLs, pathnames, filenames, directory names, computer names, links, groups, service keys, file


systems, and notifications


Bold Used in running (nonprocedural) text for names of commands, daemons, options, programs,
processes, services, applications, utilities, kernels, notifications, system calls, and man pages


Used in procedures for:
n Names of interface elements
n What the user specifically selects, clicks, presses, or types


Italic Used in all text (including procedures) for:
n Full titles of publications referenced in text
n Emphasis, for example, a new term
n Variables


Courier
Used for:
n System output, such as an error message or script
n URLs, complete paths, filenames, prompts, and syntax when shown outside of running text
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        Courier 
bold
                
     


Used for specific user input, such as commands


                
        Courier 
italic
                
     


Used in procedures for:
n Variables on the command line
n User input variables


< > Angle brackets enclose parameter or variable values supplied by the user


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example


Pathname conventions
Directory pathnames are shown with forward slashes (/).


Graphical conventions
Under UNIX, the consoles appear with slight differences. For example, in views that display items in a
tree hierarchy such as the Topology Browser, an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to VMware Smart Assurance programs
such as Domain Managers, Global Managers, and adapters.


Where to get help
VMware support, product, and licensing information can be obtained as follows:


Product information


For documentation, release notes, software updates, or information about VMware products, go to
VMware Online Support at:


docs.vmware.com


Technical support
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Go to VMware Online Support. You will see several options for contacting VMware Technical Support.
Note that to open a service request, you must have a valid support agreement. Contact your VMware
sales representative for details about obtaining a valid support agreement or with questions about your
account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:


docs.vmware.com
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Overview of the
Service Assurance Deployment
Process 2
This chapter includes the following topics:
n VMware Smart Assurance architecture


n Deployment process


n Before you begin checklist


VMware Smart Assurance architecture
The VMware Smart Assurance is a fundamental part of all VMware Smart Assurance deployments. As
shown in VMware Smart Assurance Service Assurance Manager deployment architecture, it consists of
the following components and relationships:


n The Global Manager (Service Assurance Manager) is a manager of managers that provides end-to-
end views of the status of your managed IT environment. The Global Manager consolidates and
abstracts topology, analysis, and events from various sources, including VMware Smart Assurance
Domain Managers such as VMware Smart Assurance IP Availability Manager and
VMware Smart Assurance IP Performance Manager. In addition, the Global Manager serves as an
integration point for the VMware Smart Assurance products.


n The VMware Smart Assurance Business Impact Manager allows you to create and relate business-
level objects, such as departments, services, and customers, to applications and network
infrastructure. The Business Impact Manager can then determine the business impact of
infrastructure failures on business services and their users. The Business Impact Manager is installed
as part of the Global Manager. The Business Impact Manager has undergone an architectural
change, that is, the analysis has been separated into separate processes.


n The VMware Smart Assurance Global Console is a user interface that provides information about
VMware Smart Assurance analysis: root-cause failures, notifications, topology, and even business
views. The Global Console also provides configuration and administration controls. This functionality
can also be provided to a web browser by using a Java applet as the VMware Smart Assurance Web
Console. Both the Web Console and Global Console connect directly to the Global Manager.


Note   The Global Console, Web Console and Business Dashboard are installed from a separate CD.
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n The Business Dashboard is a flexible, business-oriented alternative to the Web Console. With the
Business Dashboard, a collection of VMware Smart Assurance analysis data can be displayed with
important data from other sources on an organization’s web page. Each component of
VMware Smart Assurance data is referred to as a Dashboard viewlet, which connects directly to the
Global Manager.


n VMware Smart Assurance Service Assurance Adapters (SAM Adapters),
VMware Smart Assurance Service Assurance Manager Adapter Platform (Adapter Platform) and
VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations
(VMware Smart Assurance Adapter for UIM/O) provide VMware Smart Assurance software with
additional sources of data when monitoring a network. The Adapter Platform normalizes and
consolidates data from adapters before it is passed to the Service Assurance Manager. This guide
covers deployment of the Adapter Platform and specifically describes two adapters that send data to
the Adapter Platform: the VMware Smart Assurance SNMP Trap Adapter and the
VMware Smart Assurance Syslog Adapter. The
VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide
provides deployment information, configuration instructions, and client tool examples on the
VMware Smart Assurance Adapter for UIM/O.


n VMware Smart Assurance Companion UI (Companion UI) supplements existing functionality in SAM,
VMware Smart Assurance Network Configuration Manager (NCM) and Watch4net Automated
Performance Grapher (APG). The Companion UI is a VMware®-based appliance, that is, a virtual
machine. In a solution, one Companion UI is deployed for one presentation SAM server. The
VMware Smart Assurance SolutionPack Installation and Configuration Guide provides detailed
information about installing and configuring the Companion UI.


Products such as the IP Manager and the Network Protocol Manager include Domain Managers that
discover or monitor objects for a particular domain.


The Domain Managers use Codebook Correlation Technology™ to perform root-cause analysis for
the related domain. These domains forward topology and events to the Global Manager, which in turn
provides this information in a consolidated and abstracted manner to the Global Console.


Design and deployment of the underlying Domain Managers is not covered in this guide. Individual
product deployment guides provide information on deploying underlying Domain Managers.
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Figure 2‑1.  VMware Smart Assurance Service Assurance Manager deployment
architecture


Deployment process
VMware Smart Assurance software is deployed in phases. In the first phase, the domains that feed the
VMware Smart Assurance Service Assurance Manager are deployed. If there are many types of
underlying VMware Smart Assurance domain, each type can be deployed in a separate phase. The
sequence of these initial phases is determined by the priorities of the organization and the complexity of
each domain.
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An VMware Smart Assurance Service Assurance Manager is typically deployed in the initial phases with
these underlying VMware Smart Assurance domains, but only in a simple, standard configuration. This
deployment is intended to only validate the operation of the VMware Smart Assurance domains and is
described in the deployment guide for that domain.


After the initial phases, the production design of the
VMware Smart Assurance Service Assurance Manager configuration is deployed. This deployment phase
is covered in this guide and includes the design, installation, and configuration of
VMware Smart Assurance Service Assurance Manager. The
VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers and the
VMware Smart Assurance Service Assurance Manager Configuration Guide provide specific installation
and configuration details.


As shown in Stages in an VMware Smart Assurance deployment phase, each phase in the deployment
process can be further divided into four distinct stages:


n Stage 1: Designing the deployment


n Stage 2: Installing and configuring the components


n Stage 3: Validating the deployment


n Stage 4: Tuning and maintaining the deployment to improve performance


Figure 2‑2.  Stages in an VMware Smart Assurance deployment phase


During each stage of deployment, it is vitally important that you document all aspects of the
deployment that could be required to recreate, troubleshoot, and reconfigure the installation.
“Document the deployment” on page 28 provides information on creating a document for this
information.


Stage 1: Designing the deployment
Designing an VMware Smart Assurance deployment consists of gathering necessary information and
then using the information to develop a plan for the deployment.


Gathering the information is a process that involves both the designer and the network and application
administrators. The administrators must provide details of their organization’s network and application
infrastructure. Chapter 3 Gathering Basic Information describes this process.
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This information is then applied to develop a deployment design that will properly support the
infrastructure. The design should also account for projected growth of the network and applications.


While the deployment is being designed, all plans, decisions, and supporting information must be
documented. Typically, this documentation takes the form of a solution architecture diagram and a
deployment build guide. In their preliminary stages, this diagram and guide may be used in the response
to an organization’s request for proposal (RFP) or request for quote (RFQ).


After a deployment is contracted, the information in the solution architecture diagram and deployment
build guide can be refined and verified.


Design is covered in the following chapters:


n Chapter 4 Designing the Service AssuranceDeployment


n Chapter 5 Designing for Topology Operations


n Chapter 6 Planning for Notifications


n Chapter 7 Designing for VMware Smart AssuranceUsers


n Chapter 8 Deploying Business Impact Processing (optional)


Normally, this design process is performed by VMware Smart Assurance Professional Services or an
VMware Smart Assurance partner with extensive input from the organization’s IT staff.


Stage 2: Installing and configuring the components
After the design is complete, the next stage is installing and configuring VMware Smart Assurance
components. This stage is usually broken down into deployment phases where related components are
installed and configured together. Each installed and configured phase is validated individually as
described in the next stage of the deployment process. This phased approach eases troubleshooting.


Many organizations have specific procedural requirements that must be met before and during installation
of new software products in their production environments. These requirements might include lab
installations with performance validations and pre-production deployments. Lab configurations usually
require the use of a testbed that is configured and equipped similarly to the production environment.
Before deployment in the production environment, acceptance tests may be performed. After the
production deployment, the lab or testbed may be used to test upgrades and, if required, patches.


Though this guide cannot cover organization-specific requirements, it does provide guidelines that may
aid you in responding to these conditions.


Chapter 9 Deploying Service Assurance provides information on installing and configuring the software.
The deployment information, including software locations and all configuration choices, should be
recorded in the deployment build guide. Normally, this stage is performed by the purchaser of the
deployment and either VMware Smart Assurance Professional Services or an VMware Smart Assurance
partner.
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Stage 3: Validating the deployment
Validating the deployment ensures that all installed components are operational and can communicate
with each other as required and that the appropriate components can properly discover and poll the
network.


Logical segments of VMware Smart Assurance software are usually installed and validated to ease
troubleshooting. After all individual segments are installed and validated, the complete deployment must
be validated from end to end. Included in this overall validation could be acceptance tests that
demonstrate the functionality of the installation. Criteria for acceptance tests should be defined during the
design stage. The execution of these acceptance tests and the results are usually included in an
installation or build report.


Chapter 10 Validating Your Deployment (Acceptance Testing) provides information on validating
components. Normally, this stage is performed by the purchaser of the deployment and either
VMware Smart Assurance Professional Services or an VMware Smart Assurance partner.


Stage 4: Monitoring and tuning the deployment
After VMware Smart Assurance software is deployed and validated, you must ensure that it is operating
at an optimal level. Tuning is the process of adjusting the configuration to improve performance; it should
be performed after all components are installed and validated.


Chapter 11 Monitoring the Performance of Your Deployment describes the process of monitoring a
deployment for tuning. Normally, this stage is initially performed by either VMware Smart Assurance
Professional Services or a partner and the knowledge is transferred to the purchasing organization™s
staff. As the network and application infrastructure grows, the organization™s staff will take on the task of
tuning the deployment to handle this growth. If the infrastructure growth is extensive, the original design
may no longer be sufficient and redesigning the deployment may be required.


Throughout the life of the deployment, administrators should repeat this stage to maintain the
deployment.


Before you begin checklist
Before you begin an VMware Smart Assurance deployment, you must meet the requirements described
in Before you begin checklist . Each chapter in this guide includes a checklist. Chapter 12 Design and
Deployment Checklists contains all available checklists.
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Table 2‑1.  Before you begin checklist


Complete Requirement Description


Possess an understanding of
the architecture and
capabilities.


At a minimum, you must understand the concepts and architecture described
in the following documents:
n VMware Smart Assurance Service Assurance Manager Introduction
n VMware Smart Assurance Service Assurance Manager Configuration


Guide
n VMware Smart Assurance Service Assurance Manager Adapter Platform


User Guide
n VMware Smart Assurance System Administration Guide
n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS,


and NPM Managers that accompanied your product
n VMware Smart Assurance user guides related to the underlying domains


in your deployment


To improve your understanding, attend training courses offered by VMware
Education Services and Development. Typically, deployment requires the
knowledge equivalent to what is provided in the training courses on:
n Global Manager
n VMware Smart Assurance Service Assurance Manager Adapter Platform
n Any underlying VMware Smart Assurance domain that will be part of your


deployment.


Obtain contact information for
the deployment team.


The contact list should include titles, responsibilities, and contact methods for
all team members.


Get non-disclosure
requirements and negotiate an
agreement.


Be aware of the requirements of the non-disclosure agreements that are in
place for the deployment.


Develop schedules and set
milestones for early
deliverable.


Scheduling a software deployment varies based on the size and scope of the
deployment and the organization’s requirements. Typical milestones might
include:
n Initial project meeting to define the deployment scope
n Purchase of VMware Smart Assurance software
n Project development begins
n Installation in test environment complete
n Testing complete
n Installation in production environment complete
n VMware Smart Assurance goes live


Additional information on scheduling is beyond the scope of this guide.
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Gathering Basic Information 3
This chapter describes the first step in designing a Service Assurance deployment, that is, gathering the
organizational and network-related information that is required to develop a successful design. This
chapter also describes how to document the information that you gather and your resulting design in a
solution architecture diagram and a deployment build guide.


This chapter includes the following topics:


n Document the deployment


n Gather information required to size Service Assurance


n Determine requirements for installing software


n Gather network security information


n Other network features affecting VMware Smart Assurance


n Basic Service Assurance information checklist


Document the deployment
The most useful way to document the managed environment and the design of your deployment is to
create a solution architecture diagram and record implementation details in a deployment build guide.


The solution architecture diagram
Based on the complexity of the deployment, a solution architecture diagram may actually be a set of
diagrams documenting various levels of the architecture.


The diagram relates the information that you gather on the environment to both physical and logical
choices for your architecture in an easily understood manner. This diagram illustrates your design choices
and will be an important part of the review and approval process for your design.


The solution architecture diagram should always include:


n Necessary information about the managed network and application environment


n A logical representation of the VMware Smart Assurance components that will be installed


n Locations for each component including the name and IP address of the host and the geographical
location of the host
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n Connections between components and the ports that are used for communications


n Connections, including port numbers, between VMware Smart Assurance components and external
sources such as networks and third-party software products


This diagram cannot be completed until the design is complete and deployed, so recommendations
for adding information to the diagram appear throughout this guide.


The deployment build guide
To record the specifics of the managed environment and the deployment design and implementation,
create a document called a deployment build guide. As with the solution architecture diagram, this
chapter describes information that you should add to the deployment build guide. The deployment build
guide should include the complete design and all installation specifications, validation results, and tuning
activities.


Start the deployment build guide by recording all the information that you gather on the network, some of
which may come from your planning of IP Availability Manager or IP Performance Manager installations.
As you continue the deployment process, this guide will include recommendations for adding other
information to the deployment build guide.


Gather information required to size Service Assurance
To determine the size and configuration of Service Assurance, including the number of Global Managers
and the equipment required to support them, gather the following information:


n The number of devices and applications to manage


n The number of Service Assurance clients


n The number of underlying managed domains


Determine how many devices and applications will be managed
One of the most important factors in determining the size of a Service Assurance deployment is quantity
of devices and applications that must be managed. Estimate all managed devices in a network once.
Include the following types of devices:


n All routers, including virtual routers


n All switches


n Hosts that will be managed, including virtual machines


n Any other devices that will be managed


All managed applications should also be counted: if an application consists of component processes,
count each process.


VMware, Inc. has determined that even in well-managed large networks, administrators can
underestimate the quantities of devices and applications that they intend to manage.
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If possible, validate the estimated quantities for some portion of the network. If the estimate does not
match, try to obtain an improved estimate for another part of the network and then validate again. If
improving the estimates is not possible, determine the percentage error and use it to adjust all the
other estimates.


As a final step in estimating the quantities of managed devices and applications, account for growth
of the organization’s network and for planned application deployments.


Your Service Assurance deployment design should account for network growth over the expected life
of the design. The network growth rate will relate to the vertical market environment and the
organization’s plans, so the organization must provide you with growth estimates.


Information on the future deployment of business applications may be more difficult to obtain. For
example, an organization’s budgetary plans may provide useful information, but may not be available
to you. Interviews with IT staff may be your best source of information.


Estimate quantities and types of Service Assurance clients
The number of Service Assurance clients will affect Global Manager configuration and equipment
choices. The clients can include any of the following:


n Users of the Global Console, Web Console, and Business Impact Manager.


n VMware Smart Assurance Adapters that connect to the Global Manager directly, including the
Service Assurance Manager Notification Adapters: SNMP Trap Notifier Adapter,
Script Notifier Adapter, and Log File Notifier Adapter.


Estimate the number of underlying VMware Smart Assurance
domains
Estimating the number of underlying domains requires that you size these domains following
VMware Smart Assurance Professional Services recommendations or by following the process described
in the underlying domain’s deployment guide, such as the
VMware Smart Assurance IP Manager Deployment Guide.


Determine requirements for installing software
Most organizations define some criteria for installing new software on their network. At a minimum, this
might include software testing requirements. In addition, plan on using a staging area before deploying.
By staging the deployment, you can maintain a clean software distribution that does not include unwanted
files, changes, and logs.
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Define requirements for integrating existing software with
VMware Smart Assurance
Integrating third-party software products with VMware Smart Assurance software requires the use of
VMware Smart Assurance adapters. Most integrations do one of the following:


n Exchange information. Determine the exact type of information (topology or events) that must be
exchanged with any third-party software products.


n Allow access to the third-party software from the Global Console. Some VMware Smart Assurance
adapters provide this capability as the Server Tools functionality. For example, both the
VMware Smart Assurance Adapter for InfoVista and
VMware Smart Assurance Adapter for Concord eHealth allow users at the Global Console to access
reports from these products.


VMware, Inc. has developed many adapters for use with VMware Smart Assurance software that may
already support the integration requirements of your deployment. Itemize the integration requirements
so that the suitability of existing VMware Smart Assurance adapters can be assessed by
VMware Smart Assurance Professional Services. This guide specifically covers the integration
capabilities provided by the VMware Smart Assurance SNMP Trap Adapter (Receiver). This guide
also addresses the basic information for other adapters.


Gather network security information
Determine the level of security for the network that VMware Smart Assurance software will monitor so that
the software can be configured to a corresponding level of security. For example, the security needs of a
network in a financial, defense, or health care vertical market may be greater than in the manufacturing
vertical market. Enumerate security preferences, such as the use of passwords, encrypted password
storage, and encrypted communications to guide you when configuring security capabilities.


Firewalls between parts of the VMware Smart Assurance
deployment
Appropriate Service Assurance components must be able to receive traps and communicate with other
VMware Smart Assurance components. Certain TCP and UDP ports will need to be opened in the
firewalls to facilitate these communications. “Considering security and firewalls” on page 51 provides
additional information.


Other network features affecting
VMware Smart Assurance
Other network features may affect the VMware Smart Assurance deployment design. Consider the
following questions when gathering information on the network:


n Does the organization require failover capabilities in network software?
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n Is there an “out-of-band” network just for management information? For example, are certain Ethernet
ports just for management information? This is typical with some deployments in the financial and
military or defense vertical markets.


n What are the issues related to network latency, bandwidth, and speed available for network
management traffic?


Basic Service Assurance information checklist
Use the checklist shown in Service Assurance information checklist to aid in gathering information for
your Service Assurance design. Each chapter in this guide includes a checklist. Chapter 12 Design and
Deployment Checklists contains all available checklists.


Table 3‑1.  Service Assurance information checklist


Complete Task Description Related documentation


Determine the number of
managed devices and
applications in the
environment.


Document all quantities in the deployment
build guide.


Determine how many devices
and applications will be
managed


Estimate potential growth in
quantity of managed devices.


The deployment must support potential
network growth. Estimate the growth over
a specific time period. Document the
calculations in the deployment build
guide.


Determine how many devices
and applications will be
managed


Get the organization’s
testing/acceptance
requirements.


Your design may be required to meet test
and acceptance requirements. Obtain any
specifications that cover integration
testing, user acceptance testing, and
operational acceptance testing. You may
be required to write an installation or
deployment report that follows an
organization’s particular standards.


“Determine requirements for
installing software” on page 30


Describe the organization’s
requirements for installing new
software.


Document these requirements and how
the design meets them in the deployment
build guide.


“Determine requirements for
installing software” on page 30


List the products that currently
monitor the network and will be
integrated with the
VMware Smart Assurance
deployment.


Document the products (including
version) in the deployment build guide.


Define requirements for
integrating existing software
with VMware Smart Assurance
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Table 3‑1.  Service Assurance information checklist (Continued)


Complete Task Description Related documentation


Describe the network security. Describe security features that will affect
the deployment.


Document the security features in the
deployment build guide.


“Gather network security
information” on page 31


List any other network
requirements or features that
may affect the
VMware Smart Assurance
deployment.


Document the features in the deployment
build guide.


“Other network features
affecting VMware Smart
Assurance” on page 32
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Designing the
Service Assurance Deployment 4
This chapter provides guidelines for producing an initial design of the Service Assurance deployment by
using the information you have gathered on the organization’s application and network environment.


This chapter includes the following topics:
n Determine the Service Assuranceconfiguration


n Web Console and Business Dashboard requirements


n Essential VMware Smart Assurance applications


n Locating the Global Managers in the network


n Considering security and firewalls


n Considering failover (high availability) configurations


n Designing acceptance tests


n Initial design checklist


Determine the Service Assurance configuration
A single Global Managercan support most Service Assurancedeployments, but there are cases where
multiple Global Managers are required. Use Determining the required Service Assuranceconfigurationto
determine the Service Assuranceconfiguration required to support your managed environment. The first
three columns in Determining the required Service Assuranceconfigurationidentify the quantities that will
determine the Service Assuranceconfiguration:


n The Managed devices and applications column details the total quantity that will be managed in the
Service Assurancedeployment. This number should include estimates for growth.


n The Underlying domains column details the total number of domains that will feed topology and
events to the Service Assurancedeployment.


n The Concurrently connected clients column details the total number of Service Assuranceclients that
will be connected concurrently, including Global Consoles, Web Consoles, Dashboard viewlets, and
any adapters that connect to the Global Managerdirectly.
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Table 4‑1.  Determining the required Service Assurance configuration


Using the quantities for the managed
environment Use this Service Assuranceconfiguration


Managed
devices and
applications


Underlying
domains


Concurrently
connected
clients


Global Manager
configuration


Global Managerplatform equipment
tier


Aggregation
layer (if used)


Presentation
layer (if used)


0 to 2,000


(small
deployment)


£ 10 £100 Standard Small


>100 Basic Hierarchical Small Medium


>10 £ 100 Standard Medium


>100 Basic hierarchical Medium Medium


2,001 to 6,000
(medium
deployment)


£ 10 £ 100 Standard Small


>100 Basic hierarchical Small Medium


>10 £ 100 Standard Medium


>100 Basic hierarchical Medium Medium


6,001 to
12,000 (large
deployment)


£ 10 £ 100 Basic hierarchical Medium Medium


>100 Hierarchical presentation Large All medium


>10 £ 100 Hierarchical aggregation All medium Large


>100 Hierarchical Mesh All large All Large


12,001 to
20,000 (extra
large
deployment)


£ 10 £ 100 Basic hierarchical Large Large


>100 Hierarchical presentation Extra large All large


>10 £ 100 Hierarchical aggregation All large Extra large


>100 Hierarchical mesh All extra large All extra large


Above 20,000 devices VMware Smart Assurancedeployments in this range are currently in
production. Consult with VMware Smart AssuranceProfessional Services
for aid in this design.


The columns in the Use this Service Assurance configuration section define recommendations to support
the deployment:


n The Global Managerconfiguration column details the recommendation for the number of
Global Managers, either a single one (Standard) or multiple (any of the hierarchical configurations). If
a hierarchical configuration is recommended, the specific structure is also defined. The
Global Managerconfigurations are explained in the following sections.


n The Global Managerplatform equipment tier columns define the hardware that is required to support
the Global Managers. For hierarchical configurations, two layers of Global Managers are defined: an
aggregation layer and a presentation layer. Domain Managers connect to a Global Managerat the
aggregation layer while Service Assuranceclients connect to a Global Managerat the presentation
layer. The table indicates the equipment required to support each layer. Hardware for Service
Assurance platform equipment tiersprovides definitions for the equipment tiers.
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Determining the required Service Assuranceconfigurationdefines Service Assuranceconfigurations for
coherent deployments. It is possible to create separate deployments in a managed environment that
do not feed events and topology to a single, central Global Manager. If this is the case, each of these
deployments must be treated separately with distinct Global Managerconfigurations based on unique
quantities for first three columns in Determining the required Service Assuranceconfiguration.


Standard Global Manager configuration
A single Global Manager, as shown in Standard Service Assurance configuration, should be able to
handle many typical deployments. This is called the Standard Configuration. In this configuration, there
are no links that introduce high latency between the main VMware Smart Assurance components.
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Figure 4‑1.  Standard Service Assurance configuration


Basic hierarchical Global Manager configuration
Deployments with either large numbers of clients or large numbers of domains can usually be supported
using the basic hierarchical configuration shown in Basic hierarchical Service Assurance configuration.
This hierarchical configuration separates the topology synchronization processing (aggregation) from the
client processing (presentation) to improve performance.


Figure 4‑2.  Basic hierarchical Service Assurance configuration


Hierarchical aggregation Global Manager configuration
The hierarchical aggregation configuration shown in Hierarchical aggregation Service Assurance
configuration uses multiple Global Managers at the aggregation layer to address these configurations:


n More than 10 underlying domains: It is recommended that each Global Manager at the aggregation
layer supports a maximum of 10 VMware Smart Assurance domains. The example in Hierarchical
aggregation Service Assurance configuration, therefore, would support 20 domains.
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n Geographically separate groups of domains: Using a standard Global Manager configuration would
force some domains to connect to a Global Manager over a high-latency link. Additional
Global Managers at the aggregation layer would be located in the same geographical area as the
domains.


To ensure that acknowledgements and ownership of notifications are properly propagated,
Service Assurance clients should connect only to the Global Manager at the presentation layer.


Figure 4‑3.  Hierarchical aggregation Service Assurance configuration


Hierarchical presentation Global Manager configuration
The hierarchical presentation configuration shown in Hierarchical presentation Service Assurance
configuration uses multiple Global Managers at the presentation layer to address these configurations:


n More than 100 Service Assurance clients that connect concurrently: This includes Global Consoles,
Web Consoles, Dashboard viewlets, and any adapters that connect to the Global Manager directly. It
is recommended that each Global Manager at the presentation layer supports up to 100 concurrently
connected clients. The example in Hierarchical presentation Service Assurance configuration,
therefore, would support 200 clients.
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n Geographically separate groups of clients: In these cases, using a standard Global Manager
configuration would force a group of clients to connect to a Global Manager over a high-latency link.
Additional Global Managers at the presentation layer would be located in the same geographical area
as the groups of clients.


To ensure that acknowledgements and ownership of notifications are properly propagated, some
customization may be required.


Figure 4‑4.  Hierarchical presentation Service Assurance configuration


Hierarchical mesh Global Manager configuration
The hierarchical mesh configuration shown in Hierarchical Mesh Service Assurance configuration is used
to support the largest, most complex deployments that require multiple Presentation Global Managers
and multiple Aggregation Global Managers.


As with the other hierarchical configurations, it is recommended that each additional Aggregation
Global Manager should support up to 10 underlying domains and each additional Presentation
Global Manager should support up to 100 simultaneously connected clients.


Deploying the hierarchical mesh configuration requires the aid of VMware Smart Assurance Professional
Services.
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Figure 4‑5.  Hierarchical Mesh Service Assurance configuration


Hardware for Service Assurance platform equipment tiers
Typical hardware for the equipment tiers and operating systems is listed in Typical hardware for the
equipment tiers.


Table 4‑2.  Typical hardware for the equipment tiers


Operating system


Platform equipment tier


Small (1–2 low end
CPUs, 2 GB RAM)


Medium (2 CPUs,
4 GB RAM)


Large (2 CPUs, 4 GB
RAM)


Extra large(4 CPUs,
4–8 GB RAM)


Red Hat Enterprise Linux Any vendor,


1-2 Xeon 2.8 GHz


Any vendor,


2 Xeon 2.8


GHz


Any vendor,


2 Xeon 2.8 GHz


Any vendor,


4 Xeon 3.0 GHz


Solaris UltraSPARC-T1
(T2000)


UltraSPARC-T2
(T5220)


SPARC64 VII (M4000) SPARC64 VII (M4000)
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It is recommended that you work with Sun Microsystems, Inc. to determine models that meet or exceed
these requirements in addressing your business needs.


Note   Xeon processors vary a lot across models. The Xeon 3GHz 5160 is rated at about 16 at SpecInt
for speed while the 2.93GHz Xeon X5670 is rated at about 37 for speed. If you require a specific speed
processor, VMware recommends using the SpecInt (SPEC Integer) benchmark published by SPEC both
for assessing the CPU speed and throughput ratings. SPEC is an organization of computer industry
vendors dedicated to developing standardized benchmarks and publishing reviewed results.


CPUs may have multiple cores and cores may have multiple hardware threads. Cores and threads may
share CPU resources with other cores and threads. This makes assessment of CPU capacity difficult.
VMware recommends using the benchmark published by SPEC for assessing expected relative CPU
performance. CPU2006 is the current version of the CPU component benchmark suite from SPEC.


The results are broken out by reported metric for:


n CPU Speed: You can access this benchmark from:


http://www.spec.org/cpu2006/results/cint2006.html


n CPU Throughput: You can access this benchmark from:


http://www.spec.org/cpu2006/results/rint2006.html


While cint runs one copy of the benchmark, rint runs as many copies as there are threads in the
machine.


CPU speed and the number of CPUs available affect performance. You can get a sense of the
expected performance by comparing the CPU speed directly to the speed ratings of the CPUs on
which the benchmark is based. The current strategy for assessing the number of effective CPUs in a
machine is to divide the throughput rating by the speed rating. In general, our software benefits more
from faster CPU speed, than the comparable addition of more CPUs. Thus, it is preferred to have 1
CPU rated at 20, than 2 rated at 10.


If you are installing more than one product, then your system must meet the products total memory
and data disk space requirements.


Hardware for Service Assurance platform equipment tiers lists disk space requirements for installing
the Service Assurance Manager Server.


Table 4‑3.  Required disk space for the Service Assurance Manager Server


Platform Disk space


Solaris 9 and 10 730 MB


Red Hat Enterprise Linux AS 4 and 5 475 MB


Required disk space for the Service Assurance Manager console lists disk space requirements for
installing the Service Assurance Manager console.
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Table 4‑4.  Required disk space for the Service Assurance Manager console


Platform Disk space


Solaris 10 485 MB


Red Hat Enterprise Linux AS 5 365 MB


CPU, memory, data disk space requirements lists minimum requirements for CPUs, memory, and data
disk space that is used by the software for writable files such as logs, repository files, and output files.


Table 4‑5.  CPU, memory, data disk space requirements


VMware Smart Assurance product CPUs
Memory
(RAM) Data disk space


Service Assurance Manager 2 512 MB 100 MB each


Global Console 1 256 MB Not applicable


Global Console, Web Console, and Business Dashboard 1 256 MB 150 MB


VMware Smart Assurance Service Assurance Manager
Adapter Platform


1 512 MB 100 MB each


Syslog Adapter 1 256 MB 50 MB each


SNMP Trap Adapter 1 256 MB 50 MB each


VMware Smart Assurance Adapter for UIM/O 1 256 MB 50 MB


XML Adapter 1 256 MB See the following Note.


Note   CPU means the number of physical CPU cores and not the number of CPUs displayed when
hyperthreading is activated.


For the XML Adapter, disk space depends on the size of the output that you want to export. Each output
file can range from 0 to 200 MB. If, for example, the XML Adapter communicates with 5
Service Assurance Global Managers and each output file is 200 MB, then 1 gigabyte (GB) is required.


If you are installing multiple products, then your system must meet the products’ total memory and data
disk space requirements. Hardware for Service Assurance platform equipment tiers defines required disk
space and CPU, memory, data disk space requirements lists CPU, memory, and data disk space
requirements.


Web Console and Business Dashboard requirements
The VMware Smart Assurance Global Console can also be deployed as either:


n VMware Smart Assurance Web Console


or
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n VMware Smart Assurance Business Dashboard


Note   Tomcat Servlet Engine version 6.0.30 or above is installed as part of the Web
Console/Business Dashboard. The Tomcat Servlet Engine serves the files used by the Web
applications.


Users who display Business Dashboard viewlets in a Web browser, or want to use the Web Console,
require the following software:One of the following Web browsers:


n Internet Explorer 6.0 with Service Pack 1, 7.0, 8.0, 9.0


n Firefox 2, 3.5, 3.6, 4.0, and 5.0


n Google Chrome 12.0


n Safari 3.0


n Browser that supports Java JRE 1.6.x


Note   Only browsers running on Linux and Solaris operating systems are supported.


n Also, a list of specific versions of browsers that are supported on different platforms can be found in
the Oracle website.


n Java 2 Platform Standard Edition 6.0, which includes the 1.6.x Web browser plug-in must be installed
on the client workstation.


If you are running any version prior to 1.6, when you try to start up and run the Dashboard or web
console, the applets inside the sample views that are shipped with the software do not display
properly.


If your client workstation does not have this version of JRE, you must obtain it and install it:


For all platforms, download it from the Sun Microsystems website.


If the JRE is not installed on your client workstation, you will be prompted to install it when you launch
the Web Console or Business Dashboard.


Note   In SAM 9.2, Red Hat Enterprise Linux AS 5 and Solaris 10, uses JRE version 1.6.0.26.


Java Web Start requirements for Web Console
Java Web Start is optional and can be invoked when the Web Console is executed.


Java Web Start must be installed and configured on the client machine:


n For UNIX, contact your system administrator to install and configure Java Web Start or follow the
instructions provided in the Sun Microsystems website.
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n To launch the Java Web Start version of the Web Console and use the automatic installer, point your
browser to the following URL:


http://<


                    


                        Tomcat_host>:8080/webconsole/globalConsoleCached.html


The VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guideprovides
information about using the Web Console.


Note   When launching the Web Console from the browser (using the globalConsoleCached.html and
JRE 1.6.13), an exception may be raised stating that the JAR resource in the JNLP file is not signed
by the same certificate.


Launch the Web Console from http://<servername>:8080/webconsole/to download the correct
(JRE 1.6_25) version.


Web browser requirements for the Smarts Adapter for UIM/O
The following web browsers are required for the Smarts Adapter for UIM/O:


n Internet Explorer 6.0 with Service Pack 1, 7.0, and 8.0


n Firefox 3.5, 3.6, 4.0, and 5.0


Java Standard Edition 6.0, which includes the 1.6.x Web browser plug-in, must be installed on the
client workstation. If your client workstation does not have the JRE 1.6, you must obtain it and install
it. For all platforms, download it from the Oracle website, http://www.oracle.com.


Note   The Deployment Guide may not be updated for patch or service pack releases. For the most
up-to-date information about a release, refer to the Release Notes.


Deploying Global Managers and Domain Managers
Deploy the Global Manager separately from the Domain Managers. After deployments become large, run
the Service Assurance Adapter Platform separately from the Global Manager. Avoid running any other
applications on these platforms to ensure that you do not adversely affect the performance of the
VMware Smart Assurance applications.


Adding information to the solution architecture diagram and build
guide
Include the Global Managers and related applications on the architecture solution diagram. Draw boxes to
show the platforms and include the names, locations, and, when applicable, port numbers for all the
VMware Smart Assurance components.


For the deployment build guide, document equipment choices and create a table that documents
VMware Smart Assurance components on each host.
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Essential VMware Smart Assurance applications
Every VMware Smart Assurance installation must include an VMware Smart Assurance Broker and a
license server. Both are critical components, without either, the installation will not work. Usually, you
install these two components together, in a single location. All of the VMware Smart Assurance
applications must be able to communicate with both applications.


Locating VMware Smart Assurance Brokers
The Broker manages a registry of VMware Smart Assurance server applications. When an
VMware Smart Assurance application needs to connect with another application, it gets the necessary
information from the Broker. Periodically, the Broker pings the applications in its registry to determine
whether they are still active.


Server applications, such as the Global Manager, IP Availability Manager, and Adapter Platform, are
maintained in the Broker’s registry. Applications such as the Global Console connect to the Broker to
determine the location of registered applications.


With most installations, the Broker is typically installed on the same machine as the license server. All
VMware Smart Assurance applications must be able to access the Broker. By default, the Broker uses
port 426.


It is recommended that you use a DNS alias to a machine for the Broker so that it is easier to redirect
other VMware Smart Assurance applications if it becomes necessary to move.


Add the following information for the Broker to the deployment build guide:


n Name of host where the Broker will reside


n Port number to be used by the Broker (the default is 426.)


n Information for the DNS broker alias


Installations use more than one Broker for failover configurations. Multiple Brokers require special
consideration to synchronize lists of registered servers. If you determine that your installation needs
more than one Broker, consult with the VMware Smart Assurance Professional Services organization.


Locating license servers
The license servers authenticate VMware Smart Assurance applications. Without proper licensing, the
applications will not work correctly. Licenses control access to applications and features as well as limit
the number of systems discovered.


It is recommended that the license server runs on the same host as the Broker—all applications need to
be able to access the license server. However, an existing FLEXnet License Server may be used if it
meets the VMware Smart Assurance specifications. If there is more than one Broker for the installation,
there may be good reason to use more than one license server.
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In certain cases, you may use multiple license servers in your network for the same reasons that you split
a topology or choose different locations for the Domain Managers: geographical requirements, corporate
organizational requirements, or the network’s security design. Multiple license servers would require the
corresponding number of licenses.


When multiple license servers are used, each domain will use blocks of licenses from a specific license
server. Therefore, the license blocks must be divided among multiple licenses and the appropriate license
must be deployed to each license server. Then, the Domain Managers that rely on a specific license
server will have the appropriate licenses to support the systems that they must manage.


Collect the following information for each license server and add it to the deployment build guide:


n The host ID of the computer where the FLEXnet license server is running


n The expected installation path to BASEDIR/smarts/bin on your broker (or to the
VMware Smart Assurance installation from which you want to run the license server)


n The operating system of the computer


n The port number used


The VMware Smart Assurance System Administration Guide provides additional information.


Locating the Global Manager s in the network
In choosing locations for the platforms that support the Global Managers, there may be restrictions on
locations that are not related to network and application efficiency. Locating the Global Managers may be
based on the following considerations:


n Geographical requirements: An organization may require that all VMware Smart Assurance Managers
be based in a single Network Operations Center (NOC). Other organizations might have the
Global Manager in the NOC and underlying Domain Managers located in regional data centers.


n Corporate organizational requirements: For example, organizations that have a distributed business
management might require that components be located to match the organization’s structure.


Communication between applications is influenced by network speed and latency. Avoid
configurations that require a Global Manager to receive information from other applications across
WAN links with high latency. Instead, consider placing Global Managers on both ends of high-latency
WAN links. The hierarchical Global Manager configurations can be used to eliminate high-latency link
issues for these situations:


n Domain Managers that connect to a Global Manager over a high-latency link: Use the basic
hierarchical, hierarchical aggregation, or hierarchical mesh configuration to place a Global Manager
on the same side of the high-latency link as the Domain Managers.
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n A group of clients that connect to a Global Manager over a high-latency link: Use the basic
hierarchical, hierarchical presentation, or hierarchical mesh configuration to place a Global Manager
on the same side of the high-latency link as the group of clients.


After you determine the configuration and locations of the Global Managers, add system names and
Global Manager names to your solution architecture diagram. Define IP addresses and dedicated port
numbers when needed. Establish a host naming convention and a Global Manager naming
convention before you settle on any names.


Considering security and firewalls
Based on the security information you obtained earlier, you must plan design solutions so that the
applications can function properly in the network’s security environment:


n Configure security policies (rules) to enable a one-way connection from the FLEXnet license server
and the Broker to the various applications.


For communication between Managers across firewalls, plan on opening a hole in the firewall for the
VMware Smart Assurance communications. Certain UDP and TCP ports must be opened for proper
communications:


n Broker: Port 426


n License Manager: Port 1744


n Manager: one port each, which can be configured


n Adapters, including SNMP Trap Adapter and Syslog Adapter. The
VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide provides
details.


n Consider proxy servers when communicating with VMware Smart Assurance applications that reside
behind firewalls. Using a proxy server reduces the number of firewall ports that need to be opened to
one firewall port. “Configuring the Java clients to use a proxy server” on page 86 provides additional
information on the procedure to configure the Java clients to use a proxy server.


n If access lists are used, plan on deploying the IP addresses of hosts that include Managers to the
access list of devices that will be managed. VMware Smart Assurance applications must have full
access to browse the MIBs of the devices. The VMware Smart Assurance IP Manager User Guide
lists the specific MIBs. Depending on the network size and complexity, this may require scheduling to
obtain support from the organization’s network personnel.


n You must have a listing of SNMP versions and related security parameter values that are used by
specific devices in the organization’s network. Due to security concerns, it may not be appropriate to
include them in the deployment build guide.
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Security levels and VMware Smart Assurance applications
In addition, consider the level of security to configure VMware Smart Assurance applications. The security
mechanisms support various levels of user authentication, and also authentication and encrypted
communication between applications. Ensure that you understand the capabilities described in the
VMware Smart Assurance System Administration Guide and then choose a level of security that is
appropriate for the deployment.


Considering failover (high availability) configurations
VMware Smart Assurance offers a failover product that works in conjunction with the Global Manager.
You can find information about configuring a failover solution in the
VMware Smart Assurance Failover System User Guide. For additional help, consult with
VMware Smart Assurance Professional Services.


Designing acceptance tests
Acceptance tests may be required for different portions of VMware Smart Assurance functionality. Be
aware of the requirements and develop acceptance criteria with the aid of the network administrators and
other organization personnel. Include all necessary acceptance tests in the deployment build guide for the
deployment. At a minimum, you must develop completion criteria that the organization’s project managers
approve. Document these completion criteria in the deployment build guide and use them in validation.


Initial design checklist
Document your initial overall design of the deployment.


Each chapter in this guide includes a checklist. Chapter 12 Design and Deployment Checklists contains
all the available checklists.


Table 4‑6.  Initial design checklist


Complete Task Description
Related
documentation


Determine the
configuration of the
Service Assurance
deployment.


Determine Service Assurance configuration, including
the number of Global Managers and how they are
organized in the deployment.


“Determine the Service
Assurance
configuration” on
page 36


Determine the hardware
required to support the
Service Assurance
deployment.


For each Global Manager in the Service Assurance
configuration, determine the type of equipment
required to support it.


Hardware for Service
Assurance platform
equipment tiers


Determine the location of
the
VMware Smart Assurance
Broker.


Choose a location for the Broker that will support the
deployment.


Locating VMware Smart
Assurance Brokers
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Table 4‑6.  Initial design checklist (Continued)


Complete Task Description
Related
documentation


Determine the location of
the License Server.


Choose a location for the License Server that will
support the deployment.


Locating license
servers


Determine the location of
the
VMware Smart Assurance
Global Managers.


Choose locations for the one or more
Global Managers that will support the deployment.


“Locating the Global
Managers in the
network” on page 50


Determine if the Service
Assurance Manager must
be configured with failover.


Determine if a high-availability configuration is
required.


“Considering failover
(high availability)
configurations” on
page 51


Determine if acceptance
tests are required.


Acceptance tests may be required for different
portions of functionality. Be aware of the
requirements and develop acceptance criteria.


“Designing acceptance
tests” on page 52


VMware Smart Assurance Service Assurance Manager Deployment Guide


VMware, Inc.  41







Designing for Topology
Operations 5
This chapter describes considerations for importing and organizing topology.


This chapter includes the following topics:
n Designing topology synchronization


n Designing topology groupings


n Designing topology operations checklist


Designing topology synchronization
A Global Manager imports topology from configured underlying VMware Smart Assurance domains. The
topology sources are specified in the Global Manager’s ics-default.xml file located in the
BASEDIR/smarts/conf/ics directory. A Global Manager synchronizes its topology whenever any of the
following occurs:


n The Global Manager is started.


n A reconfiguration to an underlying server is required.


n The analysis domain is reconnected after a connection loss or a restart.


n The analysis domain performs a full or incremental discovery, or rediscovers an object; or a manual
discovery is initiated.


Understanding topology synchronization
The Global Manager maintains an abstracted representation of the topology discovered by the
Domain Managers and the topology from the Adapter Platform. When the Domain Manager completes a
discovery, the Global Manager resynchronizes the topology from the Domain Managers.


In all cases, the Global Manager does a full topology synchronization, even when only one device is
added to an underlying domain. This means that topology synchronization is most efficient when it occurs
less frequently, but with larger sets of changed devices. The Global Manager resynchronizes topology
after a single device discovery, a pending discovery, or a full rediscovery.
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Another important aspect of topology synchronization is synchronization between the Global Manager
and the Adapter Platform. The Adapter Platform is typically configured to contain some of the topology
from the IP Availability Manager. With this topology, the Adapter Platform matches events to devices
managed in the IP Availability Manager. So, the Adapter Platform often contains all of the
IP Availability Manager topology and also some topology created based on events received as traps, or
from other sources.


When the Global Manager synchronizes topology with the Adapter Platform, the topology inherited from
the IP Availability Manager, as well as the topology created due to events from traps or other sources, is
synchronized. This means that a Global Manager may synchronize topology twice when a change is
made to a device in IP Availability Manager: once with the IP Availability Manager and then once with the
Adapter Platform.


The Adapter Platform does not contain all of the topology from the IP Availability Manager. So, the
synchronization it performs with the Global Manager for the topology from IP Availability Manager is less
performance-intensive than the synchronization between the Global Manager and the
IP Availability Manager.


Topology synchronizations in the Global Manager may be done concurrently. If there are a number of
underlying domains that need to synchronize topology at the same time, the Global Manager may
synchronize these at the same time. In most cases, this gives optimal performance. However, if there are
many concurrent topology synchronizations, the performance of the Global Manager may be adversely
affected. Also, topology synchronizations overall may take longer due to the contention caused by many
concurrent threads updating the Global Manager repository.


Planning for topology synchronization
If there is a large number of underlying domains and the topology of each changes frequently, it is likely
that the Global Manager will often be required to perform multiple concurrent topology synchronizations.


To optimize Global Manager performance, it is best to reduce the number of small discoveries, and
instead have a smaller number of larger discoveries. Also, if full rediscoveries are scheduled,
Global Manager performance can be improved by staggering the times of full rediscoveries of the
underlying domains.


Finally, if you expect a constantly changing network with a large number of discoveries, you may want to
reconsider your Global Manager configuration. If you are not already planning on implementing a
hierarchical aggregation Global Manager configuration or hierarchical mesh Global Manager
configuration, consider using one of these configurations. “Determine the Service Assurance
configuration” on page 36 provides additional information.


Designing topology groupings
Topology grouping is a visual tool that does not affect Global Manager performance. Groups help
organize topology elements. The groups can represent resources, geographical areas, business areas, or
entities of other organizations.
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Think about groups in terms of the business needs: Is your topology divided by region? Does the topology
correspond to business units? Is the topology allocated by customer or function?


Groups are organized into parent and child groups. A group can contain both members and child groups.
When planning group organization, you should try to restrict each group to hold only members or only
child groups. The Map Console will not show the members of a group if the group also contains child
groups.


There are two ways to create groups. The first method uses matching patterns entered through a Global
Console. This method creates selective groups. The second method relies on a file to determine group
hierarchy and membership. This method creates hierarchical groups.


For selective groups, you must define three properties to organize your groups: matching criteria, priority,
and target classes. You define hierarchical groups and their members by using files. One file contains
groups and child groups, which can also include members or links to files that contain members.


The VMware Smart Assurance Service Assurance Manager Configuration Guide provides additional
information about topology groupings.


Designing topology operations checklist
Designing topology operations checklist contains the designing topology operations checklist. Each
chapter in this guide includes a checklist. Chapter 12 Design and Deployment Checklists contain all


Table 5‑1.  Designing topology operations checklist


Complete Task Description
Related
documentation


Review topology
synchronization
issues.


Ensure that you understand how topology synchronization
affects Global Manager performance.


Understanding topology
synchronization


Plan topology
synchronizations.


To optimize Global Manager performance, it is best to reduce
the number of topology synchronizations where possible.


Planning for topology
synchronization


Plan topology
groups.


Topology grouping is a visual tool that doe not affect
Global Manager performance. Groups help organize topology
elements.


“Designing topology
groupings” on page 58
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Planning for Notifications 6
This chapter includes the following topics:
n Overview of notification processing


n Designing trap processing


n Trap processing performance


n Planning for notifications checklist


Overview of notification processing
In a typical configuration of the Global Manager, there are two types of information sources: the
Adapter Platform, which handles information from third-party applications, and the underlying
VMware Smart Assurance Domain Managers. After the Global Manager processes the information, it
forwards the results to end users through clients such as the Global Console or an adapter that sends
information to third-party applications.


Flow of event information in a basic Global Manager configuration is an example of a basic
Global Manager configuration. The lines show how information enters through either an
IP Availability Manager (or other underlying Domain Managers) or an Adapter Platform, is passed to a
Global Manager, and finally is passed to an end user or application. Note that the figure does not show
the connection that transports topological information between the IP Availability Manager and the
Adapter Platform.
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Figure 6‑1.  Flow of event information in a basic Global Manager configuration


The Adapter Platform imports topology and event information from third-party applications and prepares it
for use by the Global Manager; data from third-party applications should not be sent directly to the
Global Manager. The Adapter Platform creates notifications from the incoming information and can even
associate these notifications to topology information supplied by another VMware Smart Assurance
application. This connection is not shown in Flow of event information in a basic Global Manager
configuration.


Efficient notification processing presents the most important information to the operator who uses a
Global Console. One of the goals of deployment design is to plan to optimize the flow of notifications sent
through the system. This improves the performance of the deployment and the performance of the
operators who use VMware Smart Assurance products.


Notifications from the Adapter Platform
Ensure that only the notifications that are useful to Global Console operators reach the Global Manager.
When VMware Smart Assurance software is first deployed, a strategy to reduce and control the flow of
notifications from the Adapter Platform to the Global Manager temporarily is used. This is to prevent any
notifications from the Adapter Platform from being forwarded to the Global Manager by using notification
list filtering. Use the Global Console to connect directly to the Adapter Platform and observe the
notifications there; evaluate the notifications. Then, modify the notification list to forward useful
notifications to the Global Manager.
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Configuring notifications for clients
Notification lists are the mechanism that clients use to subscribe to and receive notifications from a
Global Manager. Smaller notification lists produce better performance in both the client and the
Global Manager.


Notification lists are associated with user profiles—one list per profile. When designing notification lists for
consoles, attempt to design them not to typically include more than 500 active notifications.


It is more efficient to prevent a notification from being sent to an VMware Smart Assurance client by using
a notification list than to use a filter to remove the notification from the Notification Log view at a client’s
console. These filters do not curtail the output of notification lists and do not provide any performance
benefit to the Global Manager.


Designing notification lists provides information about configuring clients to receive notifications.


Designing trap processing
Any VMware Smart Assurance deployment should include a plan to handle trap processing. This section
covers one method.


Recommended trap processing design
Recommended trap processing design presents the recommended design for trap processing. This
configuration relies on two instances of the SNMP Trap Adapter to handle trap processing and performs
well under the stress of high volumes of traps.


Instance 1 of the adapter is configured as a trap exploder that receives and forwards traps. In this
configuration, the trap exploder does not process traps into notifications or use any ASL scripts for
sophisticated trap processing. The trap exploder’s sole function is to filter and forward traps as follows:


n IP Availability Manager-required traps are forwarded to IP Availability Managers.


n Traps required for other VMware Smart Assurance domains are forwarded to the proper domain.


n Other useful traps are forwarded to Instance 2 of the SNMP Trap Adapter for processing into
notifications. These traps provide meaningful or actionable information to the administrators of the
network.


n Traps may be received in SNMP v1, v2c, or v3 formats; however, they are forwarded on to the
Adapter Platform or to other Domain Managers as SNMP v1 or v2c only.


n Other traps that administrators do not consider useful can be forwarded to an unused port to reduce
overhead at the SNMP Trap Adapter. Normally, the adapter logs an error message for each trap that
is not forwarded. This practice eliminates the processing associated with error message logging.
Another benefit is that forwarding these traps to a location permits you to set up a tool to collect the
traps.
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Instance 2 of the SNMP Trap Adapter performs the typical processing of traps into notifications and
may invoke ASL scripts for advanced processing. This instance does not forward any traps.


The two SNMP Trap Adapter instances are invoked using different configurations. The following is the
typical configuration when the instances are on a single host:


n The trap exploder, Instance 1 of the SNMP Trap Adapter, uses
BASEDIR/smarts/local/conf/trapd/trapd.conf. This trapd.conf file includes trap forwarding statements
and indicates the port to use when listening for traps.


n Instance 2 of the SNMP Trap Adapter processes traps into notifications and uses
BASEDIR/SAM/smarts/local/conf/icoi/trapd.conf and
BASEDIR/SAM/smarts/local/conf/icoi/trap_mgr.conf. This instance of the trapd.conf file does not
include trap forwarding statements. (If the Trap Adapter was installed as a service, these traps will be
forwarded to the Adapter Platform by default). The trap_mgr.conf file includes definitions for all traps
that will be forwarded as notifications.


Note   The trapd.conf files installed with IP Availability Manager and IP Performance Manager can be
configured to permit the IP Availability Manager and the IP Performance Manager to forward traps by
using their built-in trap receivers. This capability should not be used except for testing deployments or
when migrating traps from multiple locations to one destination. The
VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide provides a
complete description of the SNMP Trap Adapter.


VMware Smart Assurance Service Assurance Manager Deployment Guide


VMware, Inc.  48







Figure 6‑2.  Recommended trap processing design
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Batching to improve performance
In a deployment where a high frequency of traps is expected, plan on using the batching capability of the
SNMP Trap Adapter to improve performance of clients that process the notifications. The
BATCH_NOTIFY_INTERVAL in the trap_mgr.conf configuration file determines the length of the interval.
It may be necessary to fine tune this value under the typical trap load, so plan on monitoring the client
performance and adjusting this value.


Listening for traps
The SNMP Trap Adapter configured as the trap exploder should listen for traps on the standard port that
network devices use when forwarding traps. Typically, this is port 162.


If another application is listening for traps at this port, the application should be moved and the trap
exploder can forward needed traps to the application’s new location. The SNMP Trap Adapter is usually a
better choice for forwarding traps than other third-party software applications because the adapter can be
limited to the forwarding function.


The second instance of the SNMP Trap Adapter can listen on any port, but the trap exploder must be
configured to forward the appropriate traps to this port.


Trap forwarding
When defining trap forwarding, traps required by underlying VMware Smart Assurance domains are
already defined in the trapd.conf file. The only change that you must configure is to specify the specific
destination hosts and ports where the domains listen for traps. This change is only necessary in the
BASEDIR/smarts/local/conf/trapd/trapd.conf file for the trap exploder instance of the SNMP Trap Adapter
(Receiver).


Always try to minimize the volume of traps that are forwarded from the trap exploder to the second
instance of the SNMP Trap Adapter. If network administrators do not use the traps, discard them by
sending them to a nonexistent address. Judicious forwarding of traps can reduce or eliminate stressful
trap processing loads. Deployment administrators should be aware of how traps are discarded so that
they can choose to discard other useless traps as their experience with the network grows.


Each trap that is transformed into a notification will require an entry in the trap_mgr.conf file. If an entry
does not exist, the trap should not be forwarded to the second instance of the SNMP Trap Adapter.


Traps and notifications
When configuring the SNMP Trap Adapter to process traps, you must decide which traps should become
notifications and how the notifications should appear at the Global Console. This is defined in the
trap_mgr.conf configuration file which is described in the
VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide.
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Advanced trap processing by using ASL scripts
The VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide provides
specific information on advanced SNMP Trap integration. Typically, the ASL scripts (hook scripts) will
extract event text or other important information from network sources to populate the user defined fields
in the notification.


Include as much of the ASL processing definition as possible in the deployment build guide. When the
ASL scripts are complete, the code should be documented in the deployment build guide.


Trap processing performance
The following processing issues impact performance directly:


n Filtering traps in trap_mgr.conf


n Using trap manager hook scripts


n Adding new topology for received traps


n Looking up host names


n Batching traps


Consider them as you design and configure trap processing in your environment.


Filtering traps in trap_mgr.conf
The number of traps that are processed and specified in trap_mgr.conf is a factor in performance. The
smaller the number of received traps processed as events, the higher the overall rate of processing.


With trap receiver you can import subsets of traps into the Adapter Platform. Large numbers of traps may
be sent by network devices, but typically only a small subset are important to network operators. For
example, link up and down traps are sent frequently by devices but are not typically important to display
to the network operator since the IP Availability Manager already supplies authentic, root-cause problems
related to these traps.


Using trap manager hook scripts
With the trap manager, you can customize trap processing by using an ASL hook script. Typically, this
additional processing causes performance to be slightly slower than if no ASL hook scripts are used.


Adding new topology for received traps
The trap manager allows the Adapter Platform to create a topology element if a trap is received for an
element that is not already in the topology. The performance declines whenever a large percentage of the
traps processed result in topology creation and increases whenever all traps relate to existing topological
elements.
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Looking up host names
The trap processing logic may require a reverse host name lookup to find the logical name of the element
sending a trap based on the IP address. The speed of this host name lookup in a particular customer’s
environment may have a significant impact on trap processing rates. For example, if a customer uses a
DNS host lookup and a large number of traps are received for devices not listed in DNS, DNS time-outs
may significantly impact trap processing performance.


Batching traps
Configuring the trap manager to batch traps for the same notification results in improved performance due
to the reduced number of notifications and updates that need to be processed.


The trap manager has an option to batch traps whenever multiple traps for the same notification are
received within a configurable number of seconds. For example, if 50 identical traps are received from a
single device in 2 seconds, the result is 50 updates to the same notification. All clients receiving these
notifications would receive 50 updates to the notification. Setting a two-second batch interval, however,
means that there is only one update to the notification, even though 50 traps were sent.


Configuring trapd.conf file to manage flooding of traps
In order to avoid the trap receiver and trap exploder from crashing due to flooding of traps, the default
values for the QUEUE_LIMIT_MEGS and QUEUE_LIMIT_SECONDS parameters in the trapd.conf file
are set to 200 MB and 480 seconds, respectively. On reaching the limits set using these parameters, the
sm_trapd queue starts discarding traps. An alert, trapdDiscardingTraps, which is defined in the
trap_mgr.conf file is triggered when the queue starts discarding traps. If and when a device is identified as
the source of a trap storm, information about it is logged in the sm_trapd log file.


The VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide provides details
on the parameters in the trapd.conf file.


Planning for notifications checklist
Before discovering the network, the requirements mentioned in Planning for notifications checklist must
be completed. Each chapter in this guide includes a checklist. Chapter 12 Design and Deployment
Checklists contains all available checklists.
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Table 6‑1.  Planning for notifications checklist


Complete Task Description
Related
documentation


Determine which notifications
are important for
VMware Smart Assurance
operators.


Ensure that only the notifications that are useful to
Global Console operators reach the Global Manager.


“Overview of
notification
processing” on
page 60


Configure notification lists. Notification lists are the mechanism that clients use to
subscribe to and receive notifications from a
Global Manager.


Configuring
notifications for
clients


Design trap processing. Any VMware Smart Assurance deployment should
include a plan to handle trap processing.


Recommended trap
processing design
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Designing for
VMware Smart Assurance Users 7
This chapter describes how best to use VMware Smart Assurance clients to satisfy the needs of
operators, including providing appropriate access rights to monitoring and administration functions.


This chapter includes the following topics:
n Determining the Global Manager users


n Choose a console for types of users


n Designing user profiles


n VMware Smart Assurance user design checklist


Determining the Global Manager users
When designing your deployment, you must determine who will use the Global Consoles and for what
purposes. Initially, it is not necessary to define individual users — consider, instead, broad functional
categories of users with similar needs and characteristics.


Name these categories of users, and list their requirements in the deployment build guide. Using specific
position names as categories can make the process easier. For example, you might create one or more
of these categories: application engineer, application administrator, application support specialist, network
engineer, network administrator, network support specialist, NOC manager, NOC operator, LAN
administrator, and IT management. After you choose categories, determine the typical
VMware Smart Assurance-related duties that are performed by the individuals in these categories. You
may find that as you list the duties, you have to expand or combine certain categories. After the
categories are completely defined, list them and their specific needs in the deployment build guide.


For example, Examples of VMware Smart Assurance user categories defines two typical user categories.
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Table 7‑1.  Examples of VMware Smart Assurance user categories


User category Description of needs or duties


Network engineer Administers and maintains local and wide area networks and related hardware.
Monitors daily activity, enforces licensing agreements, and provides front line support,
including both software and hardware support.
n Needs monitoring access to all VMware Smart Assurance domains.
n Needs to see all important traps, notifications, and network outages.


Local area network administrator
supporting a customer of a Service
Provider


Directs the daily operational availability of the hardware and software systems required
to support facility operations. Directs and oversees scheduled testing and review of
hardware and software to ensure that potential problems are identified as soon as
possible. Analyzes, evaluates, and builds cost effective LAN solutions that leverage
resources and technology to meet business requirements. Designs, creates, and
distributes user documentation relating to installation of software:
n Needs monitoring access to the VMware Smart Assurance domain that supports


the customer, but not access to any other domains.
n Needs to see all important traps, notifications, and network outages for the


customer’s VMware Smart Assurance domain.


Choose a console for types of users
VMware Smart Assurance consoles have different capabilities. For each type of user and their equipment,
determine which console is most appropriate:


n Global Console can provide all functions and all views to operators. Administrators can restrict
console operations so that operators have only the specific functionality that they require.


n Web Console can also provide all functions and all views that are available from the Global Console,
except for the Topology Browser Console. As with the Global Console, most console operations can
be restricted.


n Business Dashboard provides access to the results of VMware Smart Assurance analysis through
one or more Dashboard viewlets implemented as Java applets. A Dashboard viewlet is a Java
application that shows a particular aspect of Service Assurance information such as notifications,
containment, or maps. Dashboard viewlets provide operational functions, but no administrative
functions.


A Global Console, a Web Console, and a Business Dashboard (on a single browser using one Java
Virtual Machine) showing similar content, all use the same resources. This is regardless of the
number of viewlets displayed by the Business Dashboard.


Deployment considerations for client consoles
Each of the available Client Consoles has different deployment considerations.


Typically, the Global Console is deployed by installing VMware Smart Assurance software on the user’s
system, but the Global Console can also be accessed by using the server software on the user’s system
when the Global Console runs on a remote UNIX server. the client that displays the application does not
require Java.
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The Web Console can be deployed in two ways:


n As a typical Java applet where the HTML and JAR files are located on the host where the Business
Dashboard is installed. When a user opens the Web Console, the JAR files are loaded over the
network to the user’s Web browser.


n By using Java Web Start, which integrates the Web Console with the user’s desktop. This enables
users to start the Web Console directly from their desktop without using a Web browser.


With both methods, the JAR files are loaded over the network during the initial connection but then
saved to the user’s local system. Subsequent connections use the cached files to optimize the use of
network resources.


An installation of the Business Dashboard includes the Tomcat Servlet Engine, which is necessary to
serve the JAR files and map layout servlet. The servlet engine is installed as the
VMware Smart Assurance Servlet Engine service on the system where you install the
Business Dashboard. If you wish to serve Dashboard viewlets from a different Web server, you must
install the Business Dashboard to obtain the necessary files.


Users and security
When defining the functional categories for users, consider the VMware Smart Assurance security
implementation. For each user category, determine the following:


n List the specific VMware Smart Assurance managers that must be accessed by the users in the
category. If necessary, divide a category. For example, in a category of network administrators, some
users require access to managers in Asia, other users require access to managers in Europe, and
still other users require access to all managers. In this case, the network administrators category
could be divided into three categories to match these user needs while maintaining tighter security.


n Determine what functionality must be accessed by users in this category. VMware Smart Assurance
software is designed so that users can be classified into levels that define access:


n All - A level where users can access all Global Console functionality available for one or more
VMware Smart Assurance Managers, if their user profile permits it.


n Monitor - A level where users can access only Global Console monitoring functionality, not
administrative functionality, at one or more VMware Smart Assurance Managers, if their user
profile permits it.


n Ping - A level normally reserved for VMware Smart Assurance processes, where processes will
ping hosts where other VMware Smart Assurance processes are installed to determine if the
hosts are running.


n None - A level that specifically excludes access to the Global Console.


These types of security access are defined in the serverConnect.conf file located in the
BASEDIR/smarts/local/conf directory on the servers where VMware Smart Assurance software is
installed.
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Password configurations
Determine how you will configure VMware Smart Assurance passwords. You can do any or all of the
following:


n Allow the host operating system to validate users. This method provides the highest level of security
and is easy to manage because it relies on the security implementation that is already in place. There
are two variations: Any valid user can access one of the VMware Smart Assurance levels (All,
Monitor, Ping), or specific users can access a specific VMware Smart Assurance security level.
Defining specific access requires more maintenance because you must list the user names in the
configuration files (serverConnect.conf and clientConnect.conf). The
VMware Smart Assurance System Administration Guide defines methods to configure and to secure
access for these files.


n Specify unique passwords for individual users. Consider this method only when there are very few
users because it requires a high level of maintenance.


Note   This is less secure than permitting the host to validate users. Plan on using the
VMware Smart Assurance password encryption mechanism. The
VMware Smart Assurance System Administration Guide provides information on using this encryption
mechanism.


n Specify a common user name with a common password. This method is the least secure, but very
easy to maintain. The VMware Smart Assurance System Administration Guide provides information
on using this.


Note   You can combine these methods, for example, you could restrict administration (All)
capabilities to specific users validated by the operating system. In addition, you could provide Monitor
level abilities to a general VMware Smart Assurance user named, Monitor.


Designing user profiles
The functional grouping of users and their requirements form the basis of VMware Smart Assurance user
profiles. These profiles combine access to notification lists, console operations, custom console layouts,
and specific tools.


Create a profile for each category of user that you must support. Groups of users with similar needs can
then be assigned the same user profile.


If needed, you can further customize a generic user profile by copying it and then modifying it for more
specific needs. For example, an administration user profile could be customized for less experienced
administrators by restricting access to some administrative console operations and tools. Other possible
user profiles could include regional or customer-specific consoles.
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Designing notification lists
A notification list determines the events that are forwarded to a user. Essentially, the list filters the
notifications that are sent from the Global Manager and can be assigned to one or more users. The lists
can be organized by:


n Business units


n Geographical regions


n Groups of resources


For example, a notification list can be defined to allow only notifications from the subnetworks
devoted to a specific ISP customer to reach the Global Console of the customer’s network
administrator. Configuring notifications for clients provides additional information.


Restricting console operations
Most operations that can be performed at the Global Console can be individually enabled or disabled in
the user profiles. When used with the security levels, restricting console operations can fine tune user
access to functionality and further protect the deployment.


For example, consider two users who have the Monitor security level that allows access to Global
Console monitoring functionality, but not administrative functionality, for an VMware Smart Assurance
Manager. You can further restrict one of the viewers to see only the Summary view and the IP Network
Map while restricting the other user to the Notification Log and the Topology Browser.


Designing consoles
Specific console layouts can be saved and then automatically provided to match user needs at the
Global Console, Web Console, and Business Dashboard. Layouts including the Notification Log view,
Map view, Summary view, Status Table view, Notification Properties view, and Containment view can be
used to create a custom console layout for Global Console and Web Console users. These same views
can be provided to Business Dashboard users as Dashboard viewlets. Another view, the Topology
Browser view, can be used only in layouts for Global Console and Web Console users.


Filtering the Notification Log view at the Global Console or Web Console does not affect Global Manager
performance, but it can be used to create a simpler, more useful Notification Log view for groups of users.
Properly configured filters can be used to customize notification consoles for groups of users. In addition,
specific views can be automatically provided to match user needs.


Topology Browser views (not Map views) are more resource intensive than others. Carefully consider the
information that operators require before including the Topology Browser view in a console layout.


All console layouts are created by using the Global Console and then deployed by copying them to
appropriate directories on the Global Manager.
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Planning for tools and tool deployment
Many types of client and server tools can be designed and developed for users. Typically, creating tools
will require different levels of programming skills based on their complexity. Plan to have individuals with
the appropriate skills available to create the tools. In addition, determine which tools should be available
to which users through their user profiles.


VMware Smart Assurance user design checklist
Each chapter in this guide includes a checklist. Chapter 12 Design and Deployment Checklists contains
all available checklists.


Table 7‑2.  Client and user design checklist


Complete Task Description
Related
documentation


Define functional
groups for users.


List the broad functional groups that users will belong to and
then define the needs and duties of each group. Add this
information to the deployment build guide.


“Determining the Global
Manager users” on
page 68


Choose
appropriate
VMware Smart
Assurance clients
for users.


VMware Smart Assurance consoles have different capabilities.
For each type of user and their equipment, you must determine
which console is most appropriate. Document your choices in
the deployment build guide.


“Choose a console for
types of users” on
page 68


Define how you will
implement security
for user groups.


When defining the functional categories for users, consider
VMware Smart Assurance’s security implementation. Document
the implementation in the deployment build guide.


Users and security


Define the
notification lists in
VMware Smart
Assurance user
profiles.


The Notification List determines which notifications are sent
from the Global Manager to the VMware Smart Assurance
client. Carefully define the Notification Lists, as they can affect
Global Manager performance. Document the notification list
provided for each user profile in the deployment build guide.


Designing notification
lists


Design console
operations access.


Most operations that can be performed at the
VMware Smart Assurance clients can be individually enabled or
disabled in the user profiles. Document the access provided for
each user profile in the deployment build guide.


Designing consoles


Design console
layouts.


Specific console layouts can be saved and automatically
provided to match user needs at the Global Console, Web
Console, and Business Dashboard. Document the console
layout used in each user profile in the deployment build guide.


Designing consoles


Design client and
server tools.


Define the necessary tools that users must access and the
levels of programming skills required to create the tools.
Document this information and tools provided by each user
profile in the deployment build guide.


Planning for tools and
tool deployment
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Deploying Business Impact
Processing 8
The VMware Smart Assurance Business Impact Manager calculates the impact of infrastructure and
application events on business services. This chapter describes the choices that must be made when
designing business impact processing.


This chapter includes the following topics:


n Designing business impact processing


n Importing information


n Business Impact Manager design checklist


Designing business impact processing
Business Impact Manager uses information from a Global Manager in conjunction with user-defined
criteria to calculate the business impacts of infrastructure and application events.


To design business impact processing, you must consider at least these things:


n Business processes to model


n Topology of the business processes and the underlying infrastructure


n Impact (weight) caused by issues in the topology


Business processes
When designing a Business Impact Manager implementation, consider the company’s business
processes. Try to answer the following questions:


n Which business processes exist?


n Which business processes depend on applications or network devices?


A business process represents functions and operations that support the internal business activities
of an enterprise. In the manufacturing sector, for example, business processes include order
processing, production planning, accounting, fulfillment and so on. Each of these may depend on
different applications in order to operate as well as on network devices to pass information among
and between applications and processes.
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In a hypothetical situation, an order comes into a company and is processed. The processing involves
entering the order into a Customer Relationship Management (CRM) application and simultaneously
sending it to accounting for approval and fulfillment for shipping. Underlying accounting is a financials
application and underlying fulfillment is a logistics application. Fulfillment begins preparing the order
for shipping but cannot release the order until it receives approval from accounting. After accounting
approves the order, it notifies both fulfillment and ordering through a financials application that
updates both the logistics and CRM applications. If a network device that supports the financials
application exhibits problems, the fulfillment and CRM applications will not receive necessary
updates, which has an impact on the business.


Try to map these dependencies in preparation for creating business topologies and weighing the
impacts of problems on these processes. In the hypothetical situation, updating the logistics
application, after accounting approves the order, may be a higher priority than updating the CRM
application.


Business topology
After you have established the business processes, create a business topology to model them. The
Business Impact Manager has special elements to describe business processes, including
ServiceOffering, BusinessProcess, ServiceSubscriber, Customer, and others. The
Business Impact Manager provides flexibility in classifying elements, but be consistent in your choices.


The names of these business elements or entities must be unique. The Global Manager assigns prefixes
to the names of business elements to identify elements, but their display names do not include this prefix.
When importing topology, remember to specify these names. When using a custom adapter to import
topology, the element names must include the prefix.


The relationship between elements in the business topology is defined as part of an element’s definition.
The next step in designing the business topology is to define relationships between business elements
and other elements. As you do this, consider the following:


n How do infrastructure and other events affect business elements?


n What are the critical elements upon which the business elements rely?


In the case of an internet service provider (ISP), ServiceOffering represents the connections between
a customer and the ISP. ServiceSubscriber represents a customer. You can make other choices. In
this example, a ServiceOffering is a specific contract to provide a connection to a ServiceSubscriber.
The business topology gets linked to infrastructure elements through more definitions. The critical
elements associated with a ServiceOffering are the customer routers. While the ISP edge routers are
important, a ServiceOffering does not necessarily have to be associated with a particular router.
When events affect customer routers, the ServiceOffering is directly affected. These routers are
associated as members of the ServiceOffering.


Note   As the ISP does not manage the customer routers, the ISP has only ICMP access to those
routers. The ISP could choose to represent those routers as hosts.
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Weights: Impacts of issues in the topology
Weight values are optionally set to indicate the magnitude of a problem but are not necessary to a
Business Impact Manager installation. When a root-cause event occurs, the Business Impact Manager
sums the weight of the affected elements for a total impact, which is displayed with the root-cause: the
greater the impact number, the greater the problem. You can assign weights by class, instance name, and
instance. Wildcards can be used when you assign weights by instance.


There is no particular method to use to assign weights. Weights measure the relative importance of
aspects such as revenue, contractual requirements, reputation, cost and so on.


One strategy to follow when assigning weights is to develop weights from parent classes, through
subclasses, down to particular instances. If there is any overlap, the instance weight is used before the
class weight, which is used before the parent class weight.


Importing information
There are two methods of importing Business Impact Manager information: import files and manually
through a Global Console:


n For small Business Impact Manager configurations, such as demonstrations and test installations,
manual configuration using the Topology Builder Console is a reasonable choice. Objects created
through this console are stored only in the topology. You cannot modify elements not created with the
Topology Builder or that are discovered by the underlying Domain Manager. Before you can use this
console, you must set correct user privileges and permissions.


n For larger deployments, creating import files can ease the process. Import files provide an additional
benefit in that they act as backup to the business topology.


Do not use both methods to modify business topology. Elements added through one method are not
modifiable by the other.


The structure of import files
When creating import files, consider the structure of the files. Especially when defining relationships,
multiple files may be used to define one-to- many relationships. Business elements can be comprised of
members and subscribers. Separate files may exist for these files or may exist for all of the different
business elements.


The import files define business elements and service data, related infrastructure, and lists of related
elements. The lists of related elements can be very useful when constructing relationships among large
groups of elements, subscribers, or applications.


The VMware Smart Assurance Business Impact Manager User Guide provides additional information.
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Business Impact Manager design checklist
Each chapter in this guide includes a checklist. Chapter 12 Design and Deployment Checklists contains
all available checklists.


Table 8‑1.  Business Impact Manager design checklist


Complete Task Description
Related
documentation


Define relevant
business processes.


Determine the business processes to model. Record
your choices in the deployment build guide.


“Designing business
impact processing” on
page 76


Create a business
topology.


Create business elements to model the business
processes. Define the expectations of the model and
the events it should analyze. Document your topology
in the deployment build guide.


Business topology


Assign weights to
the elements of the
topology.


This step is optional but allows you to assign a value to
measure the impact of events that occur in the
topology. The weights of impacted elements are
summed in the root-cause event. Record your choices
in the deployment build guide.


Weights: Impacts of
issues in the topology


Choose a method
for importing
information.


If the topology is small, use the Topology Builder
Console. For larger topologies, use one or more
topology files. Record your choice in the deployment
build guide.


“Importing information”
on page 77
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Deploying Service Assurance 9
This chapter describes important design considerations when installing VMware Smart Assurance
software. This chapter should be considered as a supplement, not a replacement, for the installation
guides included with the VMware Smart Assurance Service Assurance Manager software and for the
VMware Smart Assurance System Administration Guide.


This chapter includes the following topics:


n General installation/deployment guidelines


n Configuring the Java clients to use a proxy server


General installation/deployment guidelines
Many organizations have strict rules for deploying enterprise-level software which may include
deployment of staging areas whenever possible. A staging area is a copy of the installation.


Never install a deployment during a normal production shift; instead, choose a period of low utilization for
installation. If a test environment is not available, create a staging area (an environment that mirrors
production) and make and test all changes in the staging area.


If possible, install the deployment in stages to reduce the size and complexity of each step in the overall
process. Doing so makes debugging easier. Chapter 10 Validating Your Deployment (Acceptance Testing)
provides information on verifying each stage of the deployment.


VMware Smart Assurance Service Assurance installation and
configuration
As you install VMware Smart Assurance applications, configure each application before installing the next
application. The following installation order is recommended:


1 Broker (normally installed and configured when the first VMware Smart Assurance components are
installed)


2 A Global Console to use to verify the installation of other applications


3 Underlying domains (IP Availability Manager, IP Performance Manager, Network Protocol Manager
and so on) with associated adapters


4 Global Manager which includes Business Impact Manager, if licensed
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5 Adapter Platform


6 VMware Smart Assurance Adapters (that use Adapter Platform as a server)


7 Global Consoles for end users


To ease troubleshooting of the initial deployment, install limited segments of the deployment first.
Always configure and validate a segment before installing the next segment.


By default, all VMware Smart Assurance applications are installed as services and are started
immediately after installation. During deployment, you should set the services to start manually until
your installation, configuration, and validation are complete.


Setting environment variables
Setting inappropriate values for environment variables is a common cause of post-installation problems.
The VMware Smart Assurance System Administration Guide provides detailed descriptions of the
VMware Smart Assurance environment variables, including methods for setting them.


Configure security


Usernames and passwords
For initial validation, use the default administration user name and password (admin and changeme).
Once you have validated your installation, change the default administration user name and password.


Security configuration files and a Secure Broker
A Secure Broker is a broker that requires authentication for VMware Smart Assurance applications to use
it. By default, the Broker is not secure. Universal access is provided to all VMware Smart Assurance
applications. By changing the password associated with the Broker, you configure a Secure Broker.
VMware Smart Assurance applications need to use the username and password to register with the
Broker and also to connect to the Broker to determine the location of server applications.


Use and guard your VMware Smart Assurance secret phrase
VMware Smart Assurance components are installed using a default secret phrase. This phrase is used to
encrypt passwords used in authentication and to encrypt communications between
VMware Smart Assurance components.


It is recommended that you take advantage of the added level of security provided through the secret
phrase and its related security mechanisms. To do this, you must change the secret phrase using
sm_rebond and make it consistent at all your VMware Smart Assurance installation sites. Due to the
sensitive and vital nature of this secret phrase, store and guard the phrase as you would do with the root
passwords of the most sensitive servers in your network.


Under certain circumstances, the loss of the secret phrase can force extensive reconfigurations and
require reinstallations of all VMware Smart Assurance components.
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Propagating the secret phrase
The recommended method to change the secret phrase for an VMware Smart Assurance deployment is
to run the sm_rebond utility in each installation area. Under certain circumstances, you can use one
machine to create and encrypt the different configuration files as well as the imk.dat file.


It is best to do the propagation before the other applications are started. If you want to propagate the files
and the server has started but there are no SNMP V3 passwords in use, replace the connection
configuration files. If you are using SNMP V3 passwords, you will need to replace the connection
configuration files, delete the existing repository files (*.rps), and restart the server.


An alternative to propagating all of the files is to propagate imk.dat, then run it for each file requiring
security on each installation:


sm_edit --noedit <filename>


      


Deploy Business Impact Manager
Deploying the Business Impact Manager consists of the following tasks:


n Modify weights by changing weights.conf and applying the change using the ASL script,
ICS_RemoteConfig.asl. Unless the weights are modified, each element will have the same value.


n Import business data by using the Topology Builder Console.


Deploy user configurations
Deploying the user configurations consists of these tasks:


n Configure access to the software by adding user names and passwords to the security files
(clientConnect.conf and serverConnect.conf). The
VMware Smart Assurance System Administration Guide provides additional information. These files
define the security level for each user, including user capabilities, servers that can be accessed, and
passwords.


n Configure users:


n Deploy and configure tools. Server tools must be copied to the server where the Service
Assurance Manager is installed and client tools must be copied to all systems where Global
Consoles are installed.


n Create console configurations and then save them on the server where the Global Manager is
installed. Create each console configuration by opening the Global Console and then arranging
the layout and customizing preferences. Save the customized console.


n Define customized Notification Lists.
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n Create user profiles that associate individual users with access to specific tools, consoles, and a
Notification List.


The VMware Smart Assurance Service Assurance Manager Configuration Guide provides
configuration information.


Configuring the Java clients to use a proxy server
You can configure the Web Console, Business Dashboard, Dashboard viewlets, and Global Console to
use a proxy server to communicate with VMware Smart Assurance applications (for example, Availability
Manager and Global Manager) that reside behind a firewall. Using a proxy server reduces the number of
firewall ports that need to be opened to one firewall port.


For example, Example of a deployment with a proxy server illustrates a typical deployment where a web
server acts as the proxy server.


Figure 9‑1.  Example of a deployment with a proxy server


Before you configure these Java clients, ensure that the web server that will act as the proxy satisfies the
requirement. Requirement for proxy server provides additional information.


To configure the Java clients to use a proxy server, perform the following steps:


1 Your firewall administrator needs to open Port 80 on the firewall to enable communications between
the client and a web server.


Through a series of requests, the client communicates with a web server and that web server acts as
the proxy to the VMware Smart Assurance applications.
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2 Use the sm_edit utility to add the Proxy properties described in Parameters for Properties files to the
appropriate properties file:


n If you are using the Web Console (or Java Web Start), modify the webconsole.properties file in
the BASEDIR/smarts/tomcat/webapps/webconsole directory.


n If you are using the Business Dashboard and viewlets, modify the dashboard.properties file in
the BASEDIR/smarts/tomcat/webapps/templates directory.


n If you are using the Global Console, modify the
BASEDIR/smarts/conf/console/properties.conf file on the machine where the Global Console
is running.


Table 9‑1.  Parameters for Properties files


Parameter Value


com.smarts.proxyHost= "<Host name where the web server is running>"


com.smarts.proxyPort= <Port number of the web server>


com.smarts.proxyAuthString= “<Authentication string if authentication is required>"


com.smarts.proxyAdditionalHeaders = "<Additional HTTP Requests if any >"


The parameters, com.smarts.proxyAuthString and com.smarts.proxyAdditionalHeaders, are optional.


For com.smarts.proxyAuthString, the value would depend upon the type of authentication scheme the
web server supports. For example, if it supports Basic Access Authentication Scheme, and if the
Username is “User” and Password is “Password”, the value would be:


"Proxy-Authorization: basic VXNlcjpQYXNzd29yZAo=\r\n"


Then, string “VXNlcjpQYXNzd29yZAo=” would be the base64 encoding of, “User:Password”.


For com.smarts.proxyAdditionalHeaders, the value could be any valid HTTP request like this, for
example:


t"GET http://www.example.com HTTP/1.1 \r\nHost: example.domain.com \r\n"s 


Requirement for proxy server
The connection time-out mechanism implemented in the
VMware Smart Assurance Service Assurance Manager makes use of a standard TCP feature known as
urgent data or out-of-band data.


The HTTP proxy used with this code must pass the out-of-band data as is.


The RFCs that define the correct operation of HTTP proxies require that the proxies provide a transparent
network connection. However, they do not explicitly mention support of out-of-band data.


Because of the large number of HTTP proxy implementations in use, VMware, Inc. is not in a position to
indicate which, if any, fail to correctly pass out-of-band data.
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Please check if the proxy server you are considering passes out-of-band data. Contact VMware Global
Services if the proxy server does not pass TCP urgent data.


If the proxy server fails to pass out-of-band data, connections will time out within about three minutes.
The Global Manager or Domain Manager log will contain a message of the following form:


CI-E-EFLOWKEEPALIVESEND-Flow closing due to missed keepalive
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Validating Your Deployment
(Acceptance Testing) 10
This chapter describes how to ensure that your deployment operates as intended.


Validation techniques
When validating, begin by dividing the deployment into manageable, logical segments. Ensure that each
of the segments function properly and then perform end-to-end testing. Check data flow and then check
the accuracy of the data itself. Validate as much as possible before discovering the topology so that you
reduce complexity.


Initial validation
To start validation, ensure that the Broker has access to all the VMware Smart Assurance Managers and
that the VMware Smart Assurance Manager processes are registered and running. Use brcontrol to list
the processes registered with the Broker and their status. The
VMware Smart Assurance System Administration Guide provides additional information.


Validating topology operations
After the topology of the network is discovered, it must be provided to the Global Manager from
underlying domains or third-party software and then from the Global Manager to the Global Consoles.
You must validate the topology before and after each exchange.


If the deployment includes an IP Availability Manager, ensure that you verify the topology at the
Domain Manager. The VMware Smart Assurance IP Manager Deployment Guide provides additional
information.


Validating trap processing
Use sm_snmp to generate traps to the SNMP Trap Adapter (Receiver) functioning as the trap exploder.


Ensure that you send traps that cause notifications from the underlying analysis servers as well as from
the SAM Adapter configuration. Create a trap for each trap processing statement in the trap_mgr.conf file.
If ASL scripting is included in the trap processing, ensure that the scripts function as intended.
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Validating users and capabilities
To validate users and their capabilities, test each user profile. Create a temporary user for each of your
user profiles. Log onto the Global Console as each user in turn and review the associated console
capabilities including access to console operations, access to tools, configuration of the notification list,
and layout of the console. Ensure that the capabilities match your expectations for each user profile.
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Monitoring the Performance of
Your Deployment 11
This chapter includes the following topics:


n Assessing performance


n Improving performance


Assessing performance
For the Global Manager, assess performance by checking the resources required by
VMware Smart Assurance processes against the operating system limits and by reviewing
VMware Smart Assurance performance metrics. The following methods helps you access performance:


n Monitoring Global Manager memory usage


n Monitoring Global Manager queues


n Monitoring VMware Smart Assurance software with heartbeat notifications


n Monitoring topology synchronization performance


n Monitoring clients and threads


n Monitoring tool execution


n Monitoring escalation


Monitor Global Manager memory usage
Monitor memory usage by the Global Manager to ensure that it does not exceed the operating system’s
memory limit and as a way to detect possible performance issues.


Although monitoring memory usage should be part of a routine, these symptoms require immediate
investigation:


n Fast memory growth after the Global Manager has reached a steady state, such as hundreds of
megabytes of memory growth in a few hours. The steady state is typically reached sometime after
startup: Be conservative and allow a few hours after startup before assuming that the Global Manager
is in the steady state.


n Consistent memory growth over time, never reaching a plateau. This is relevant only if the overall
growth of the Global Manager process is also hundreds of megabytes of memory, after reaching
steady state.
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Establish and monitor a baseline for process memory size
Under normal conditions with the Global Manager process memory size well within the operating system
limit, monitor memory size to establish a baseline that can be used to detect performance issues early.


For UNIX systems, this can be automated by creating a script that periodically executes ps -l -p proclist
and writes the output to a file.


Investigating the values from the file helps to understand the memory growth pattern over time. Once the
pattern is understood, it can be used to establish a baseline value for the memory usage of a running
Global Manager.


The baseline value is then used to establish a memory usage threshold. Using a monitoring script, an
alert can be generated if the memory used by the Global Manager ever exceeds the threshold.


Once the alert is received, investigate the queue growth before attempting to remedy the condition.


Monitoring Global Manager queues
Global Manager queue growth is often a cause of the Global Manager memory growth. Memory growth
and queue growth are expected occasionally, due to large bursts of information processed. However,
consistent growth of queues may indicate a problem.


The dump queues command
To monitor queues, VMware Smart Assurance software provides a dump queues command that uses this
syntax:


tdmctl -s <server_name> exec dmdebug --queues 


-output=<file_name>s


where:


n <server_name> is the name of the Global Manager.


n <file_name> is the name of the file where the output is written, such as queues-010105-0100.out
(where 010105 is January 1, 2005, and 0100 is 1 AM). The file is written to the smarts/local/logs
directory.


a Average over


b 3 minutes


c Average over


d 30 minutes


e Average over


f 300 minutes


g Average over


h 3000 minutes
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Figure 11‑1.  Global Manager queues information example


Analyzing queue size
The queues output lists many queues. Monitor these queues closely:


n SM_PropertyPoller: This queue contains client requests for property subscriptions and data to be sent
to clients as responses to property subscriptions. For example, in the Global Manager, notifications
are sent to clients through property subscriptions. So, the property poller queue contains notifications
to be sent to clients.


n SubscriberFE: This queue represents a connection the Global Manager server makes to another
server, where the Global Manager server subscribes to information in another server. For example,
there is a SubscriberFE queue for each underlying Domain Manager. For each queue, the first line
provides name of the queue and the number of workers.


Note   Subscriber Front Ends like this one never have any workers, since they are not used as
normal server queues.


The second line provides the current size, and an exact maximum size. Also included is the total
number of entries “processed.” To be exact, this is the total number of entries that were pulled from
the queue.


The next three rows provide averages. Each column reports values averaged over a different time
interval: The last 3 minutes, 30 minutes, 300 minutes, and 3000 minutes. Each row reports a different
value:


n Size is the queue size, that is, the average of what “Current size” reports for this moment.


n Flow is the number of queue entries processed, that is, the average of what “Current processed
entries” reports.


n Late is the delay between when an entry in a timer queue was scheduled to run and when it actually
ran. The Late row is always all 0's for a server queue.


Each of the averages listed in the Size, Flow, and Late rows have two fields separated by a sign (+ or
-):


n The first field is the average value of the variable over the appropriate period. The queue in Analyzing
queue size has processed many entries -- almost 22,000 -- and once, even held 369 entries; but that
was apparently an isolated peak some time in the past, since its average Size over all the reported
intervals is 0: Most of the time, the queue is empty. On the other hand, the Flow value over the last 3
minutes is very close to the value for processed entries (21,843). If we look at this value averaged
over longer and longer periods, we see that the longer the period, the smaller the value. This is what
we would expect if the rate at which elements are flowing through this queue is roughly constant.
Always keep in mind that Size grows and shrinks, while Flow can only grow.
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n The second field is the average rate of change in the first value, per second. In the example above,
the Size is shrinking slowly: -0.0 indicates fewer than 0.01 entries per second. On the other hand, the
Flow is increasing at a steady rate: between 0.05 and 0.06 entries per second (3.0 and 3.6 entries per
minute) are flowing through this queue. Again, because Flow can only increase, the second field is
always non- negative. Note that the rates are virtually the same across all time periods, which is
consistent with the analysis in the previous paragraph that entries are flowing through at a slow,
steady rate.


Guidelines for monitoring queues
Follow these guidelines:


n The queues output lists many queues. Queues that should be monitored more closely are
SubscriberFE and SM_PropertyPoller.


n Current size information is the most important to monitor. For most queues, this value is often 0.
Some queues, such as ICS_ActionScheduler, almost always have non-zero values for current size. If
the current size is not zero and grows over several successive dump queues commands, it should be
further analyzed.


Establish and monitor a baseline for queue size
Under normal conditions, monitor queue size to establish a baseline that can be used to detect
performance issues early.


To set up automatic monitoring of queues, a script may be written to parse the output of the dump
queues. The script could specifically parse the current size for each queue. For example, if the current
size exceeds a specified threshold, then alert someone to investigate this further. Some queues would
need to be exempt from the threshold, such as ICS_ActionScheduler.


A possible threshold for queues would be 10,000. However, this setting would depend on your specific
needs. It would also be possible to set the threshold lower. If you set a lower threshold, you should do
more monitoring to determine whether or not there is a consistent queue growth.


If queue growth happens consistently over time, further investigation is recommended.


Monitoring with heartbeat notifications
To monitor the throughput of notifications by a Global Manager, you can implement a mechanism to
create heartbeat notifications. These notifications are generated in Domain Managers or
Adapter Platforms on a periodic basis. The notifications are propagated from the lower level domains to
the Global Manager or through multiple levels of Global Manager.


A custom adapter listens for these notifications at the Global Manager. The custom adapter monitors the
rate of receipt of the notifications from each of the underlying domains.
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If a notification is not received within a predetermined period after it is generated, appropriate personnel
are alerted automatically for further investigation. This investigation would entail determining if there is a
consistent delay from either of the following:


n One particular VMware Smart Assurance domain: If the delay is from one domain, analyze the
domain. Consult the appropriate deployment guide for the domain.


n All VMware Smart Assurance domains: If the delay is from all domains, analyze the Global Manager.
Analyze the Global Manager memory usage, queues, and topology synchronizations as described in
this chapter.


The heartbeat notifications must be filtered so that they are not displayed in the Global Consoles.
This would add an unnecessary burden to the Global Console users. Configure the notifications lists
to eliminate the heartbeat notifications.


VMware Smart Assurance Global Services or Professional Services can aid in deploying heartbeat
notifications for monitoring.


Monitoring topology synchronization
Topology synchronization information is written to the Global Manager log file. This information indicates
when the Global Manager starts and ends a topology synchronization with an underlying domain.
Topology synchronization is one of the more resource intensive aspects of processing in the
Global Manager. Therefore, it is important when analyzing Global Manager performance to determine the
following information about topology synchronizations:


n How many topology synchronizations occur over a period?


n How frequently are individual domains synchronizing topology?


n How long did each topology synchronization take?


The log file contains a significant amount of information. To extract only the topology synchronization
information, use grep. The gnu version of grep provides an option to return lines above and below
the matching line, which is very helpful in this case.


For example, using /opt/gnu/bin/grep -C1 “Topology Synch” will return an output similar to the
sample in the Global Manager Topology Synchronization Information Example. Note that the “-C1”
option returns one line above and one line below the matched line.
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Figure 11‑2.  Global Manager Topology Synchronization Information Example


Global Manager Topology Synchronization Information Example shows two topology synchronizations
from IC-AM1, an IP Availability Manager, during the log file monitoring period:


n Started on July 6 at 13:57 and then ended at 14:01.


n started on July 6 at 14:42 and then ended at 14:42.


Another topology synchronization was in progress from IC-AM2 which ended at 14:13. The start time
is not included in the log file.


A slow topology synchronization may not be an issue. Since topology synchronization occurs in the
background, its duration does not necessarily impact general processing of the Global Manager. If
there is a long latency in the connection from Global Manager to the underlying domain that it is
synchronizing with, the topology synchronization may take longer and yet not affect Global Manager.
Also, topology synchronization will take longer for larger topologies than smaller topologies.


However, it may be a symptom that the Global Manager is overloaded and is trying to process more
than it can handle. If the Global Manager is overloaded, you may see long topology synchronization
times, slow performance when viewing information in the console, and possibly even delays in
processing notifications.


Since topology synchronization is one of the Global Manager processing tasks, improving control of
topology synchronization may be a way to improve performance.


For example, it is possible to make small topology changes on an underlying domain at a high
frequency or larger topology changes at a low frequency on an underlying domain. Global Manager
performance will be better if a low frequency of larger topology changes are made. The frequency of
topology changes can be controlled partially in underlying domains by adjusting the periodic and full
discovery intervals. Also, an VMware Smart Assurance administrator can initiate discoveries. The
frequency of these on-demand discoveries may affect Global Manager performance; minimize them
when possible.
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Another topology synchronization consideration is the number of underlying domains communicating
with Global Manager and the concurrency of the topology synchronization of these. If there are a
large number of domains, there is an increased likelihood of concurrent topology synchronizations of
underlying domains. Since topology synchronization is one of the more intensive processes done by
Global Manager, having multiple topology synchronizations concurrently may cause console
performance and notification throughput to slow down.


Periodic dump threads and dump clients
VMware Smart Assurance provides a number of different monitoring utilities, including:


n Listing thread information from a running VMware Smart Assurance server


n Listing attached clients for a running VMware Smart Assurance server


Listing thread information
These can be executed using the command:


tdmctl -s <server_name> exec dmdebug dumpThreads 


-output=<file_name>s


The output of threads is shown in Global Manager threads information example.


Figure 11‑3.  Global Manager threads information example


Global Manager threads information example lists running threads in the server. This gives an idea of the
type of processing done in the server. This is often used in conjunction with a pstack output. This
information is not typically monitored, but often used in investigating issues.
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Listing client information
This command displays a list of all clients attached to an VMware Smart Assurance server, including
adapters.


tdmctl -s <server_name> exec dmdebug dumpClients 


-output=<file_name>s


Global Manager client information example shows an example of dump clients output.


Figure 11‑4.  Global Manager client information example


The example in Global Manager client information example shows one console client, “IC Console”, and
one ASL client, “ASL”. The output gives the time the connection was initiated, the privileges associated
with the connection, and the host the client runs on.


Monitoring tools
Tools are programs that can be invoked automatically by the Global Manager or through the Global
Console by an operator. The tools should be monitored using the following VMware Smart Assurance
utility to ensure that they do not adversely affect performance:


tdmctl -s <server_name> invoke ICS_ActionManager::ICS-ActionManager dumpStatistics <string> filenames


Output of the Dumpstatistics option for tools illustrates the output of the Dumpstatistics option for tools.


VMware Smart Assurance Service Assurance Manager Deployment Guide


VMware, Inc.  79







Figure 11‑5.  Output of the Dumpstatistics option for tools


The tools monitored by the utility include all synchronous tools (server and automatic). Asynchronous
tools (client tools), which are client tools invoked by users from the Global Console, are not monitored
using this utility.


Monitoring escalation
VMware Smart Assurance software provides a utility that can monitor escalation, including statistics for
each escalation level in every escalation path configured in the Global Manager. The syntax is as follows:


tdmctl -s <server_name> invoke ICS_AutoActionManager::ICS-AutoActionManager dumpStatistics 


<string>fileNames


Figure 16 on page 102 shows the sample output for the Dumpstatistics option for escalation. The
following values are included as a total for all escalation paths and for each level in each path:


n Number of executed jobs. A job is a scheduled notification that matched a policy-path and that
repeats for each level in that path. The number of executed jobs is indicated for all levels in all paths
(overall) and for each level.


VMware Smart Assurance Service Assurance Manager Deployment Guide


VMware, Inc.  80







n Total, maximum, and average execution times. Execution time indicates how long the tool actions
defined for a job took in seconds. If the maximum execution time at a level far exceeds the average, it
may indicate an issue for a particular tool.


n Total, maximum, and average queue delays for all the escalation paths is also displayed. These
delays are not related to execution time. Delay is difference between when a job was scheduled to
execute and when the job was actually executed. A positive value for the delay indicates that the
system is not keeping up with scheduled escalation. Delay may be caused by the overall load on the
server, number of notifications, policies, paths, or levels. When a burst of notifications make it into a
path, all jobs are scheduled to execute at the same time in a future time, so delay may increase due
to these bursts.


Increase worker threads for escalation provides information on improving escalation performance.


Improving performance
If the performance metrics indicate a performance degradation, do the following to improve performance:


n Refine notification lists for users


n Reassess the topology synchronization configuration


n Refine sets of trap, syslog notifications sent to SAM


n Increase worker threads used for escalation


n Redesign your deployment to deploy additional Global Managers in a hierarchical Service Assurance
configuration


Refine notification lists for users
A Notification List determines the events that are forwarded to a user. Essentially, the list filters the
notifications that are sent from the Global Manager and can be assigned to one or more users.


In large Service Assurance deployments, significant numbers of notifications are active at any given time.
Displaying all of these notifications to all users may adversely affect the performance of the system.
Instead, create notification lists that are focused on providing groups of users with only the notifications
that are specifically useful to them. This approach will improve performance and may also simplify users’
tasks by allowing them to focusing their efforts on appropriate notifications.


Reassess configuration of topology synchronization
Chapter 5 Designing for Topology Operations describes the frequency of topology changes that can be
controlled partially in underlying domains by adjusting the periodic and full discovery intervals. If the pace
of change in your network and application infrastructure can be supported with longer discovery intervals,
increasing the interval may also improve Global Manager performance.
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Because discovery can also initiated manually, another method to improve performance may be to reduce
the frequency of manual discoveries. Reassess access to unplanned discovery and remove it from the
user profiles of administrators who do not require it. For administrators who retain access to manual
discovery, educate them on the effect of initiating an unscheduled discovery.


Refine set of trap and syslog notifications sent to Global Manager
The notifications that result from analysis by VMware Smart Assurance Managers typically contribute very
little to the notification load on Global Manager. During analysis, VMware Smart Assurance Managers
reduce the load by analyzing numerous traps and polling results to produce a notification for each root
cause rather than the symptoms.


Do not forward traps to the Global Manager when they are already sent to a Domain Manager for
analysis. Use the first match in trap forwarding configuration file, if possible. If you have not implemented
batching at the VMware Smart Assurance SNMP Trap Adapter, do so.


Designing trap processing on page 62 provides additional information.


Increase worker threads for escalation
If the performance metrics indicate a performance degradation in Escalation, add worker threads to
improve performance. Increasing threads to 10 worker threads is acceptable, but keep in mind that more
threads may require additional or more capable CPUs. Be conservative when increasing threads, since
this action may reduce the overall resources that are available and affect performance. Increase the value
in the ics-default.xml file. The
VMware Smart Assurance Service Assurance Manager Configuration Guide provides information on
reconfiguring the Global Manager.


Note   Once increased, the number of worker threads cannot be reduced unless the server is restarted.


Upgrade server hardware
Improve the capabilities of the equipment where the VMware Smart Assurance process is installed by
using a faster CPU or reinstall VMware Smart Assurance software on a more capable equipment. Before
resorting to this hardware upgrade, consider the previous options.


Redesign the Service Assurance deployment
If, after attempting the other methods to improve performance, there are still issues, then determine if
your actual deployment has exceeded the original deployment design.


If this is the case, you may have to deploy additional Global Managers in a hierarchical
Service Assurance configuration. To start redesigning a deployment, return to Chapter 4 Designing the
Service AssuranceDeployment.
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Design and Deployment
Checklists 12
This chapter includes the following topics:


n Before you begin checklist


n Basic information checklist


n VMware Smart Assurancedesign checklist


n Designing topology operations checklist


n Planning for notifications checklist


n VMware Smart Assurance client and user design checklist


n Business Impact Manager design checklist


Before you begin checklist
Table 12‑1.  Before you begin checklist


Complete Requirement Description


Possess an
understanding of the
VMware Smart
Assurance architecture
and capabilities.


At a minimum, you must understand the concepts and VMware Smart Assurance
architecture described in the following documents:
n VMware Smart Assurance Service Assurance Manager Introduction
n VMware Smart Assurance Service Assurance Manager Configuration Guide
n VMware Smart Assurance Service Assurance Manager Adapter Platform User


Guide
n VMware Smart Assurance System Administration Guide
n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM


Managers that accompanied your software product
n VMware Smart Assurance user guides related to the underlying


VMware Smart Assurance domains in your deployment


To improve your understanding, attend VMware Smart Assurance training courses
offered by VMware ®® Education Services and Development. Typically, deployment
requires the knowledge equivalent to what is provided in the training courses on:
n VMware Smart Assurance Global Manager
n VMware Smart Assurance Service Assurance Manager Adapter Platform
n Any underlying VMware Smart Assurance domain that will be part of your


deployment.


VMware, Inc.  83







Table 12‑1.  Before you begin checklist (Continued)


Complete Requirement Description


Obtain contact
information for the
deployment team.


The contact list should include titles, responsibilities, and contact methods for all team
members.


Get nondisclosure
requirements and
negotiate an agreement.


Be aware of the requirements of the non-disclosure agreements that are in place for
the VMware Smart Assurance deployment.


Develop schedules and
set milestones for early
deliverable.


Scheduling a software deployment varies based on the size and scope of the
deployment and the organization’s requirements. Typical milestones might include:
n Initial project meeting to define the deployment scope
n Purchase of VMware Smart Assurance software
n Project development begins
n Installation in test environment complete
n Testing complete
n Installation in production environment complete
n VMware Smart Assurance goes live


Additional information on scheduling is beyond the scope of this guide.


Basic information checklist
Table 12‑2.  Basic Service Assurance information checklist


Complete Task Description
Related
documentation


o Determine the number of
managed devices and
applications in the
environment.


Document all quantities in the deployment build guide. Determine how many
devices and
applications will be
managed


o Estimate potential growth in
quantity of managed
devices.


The VMware Smart Assurance deployment must support
potential network growth. Estimate the growth over a
specific time period. Document the calculations in the
deployment build guide.


Determine how many
devices and
applications will be
managed


o Get the organization’s
testing/acceptance
requirements.


Your design may be required to meet test and acceptance
requirements. Obtain any specifications that cover
integration testing, user acceptance testing, and
operational acceptance testing. You may be required to
write an installation or deployment report that follows an
organization’s particular standards.


“Determine
requirements for
installing software” on
page 30


o Describe the organization’s
requirements for installing
new software.


Document these requirements and how the design meets
them in the deployment build guide.


“Determine
requirements for
installing software” on
page 30


o List the products that
currently monitor the
network.


Document the products (including version) in deployment
build guide.


Define requirements
for integrating existing
software with VMware
Smart Assurance
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Table 12‑2.  Basic Service Assurance information checklist (Continued)


Complete Task Description
Related
documentation


o Describe the network
security.


Describe security features that will affect the deployment.


Document the security features in the deployment build
guide.


“Gather network
security information”
on page 31


o List any other network
requirements or features
that may affect the
deployment.


Document the features in the deployment build guide. “Other network
features affecting
VMware Smart
Assurance” on
page 32


VMware Smart Assurance design checklist
Table 12‑3.  Initial design checklist


Complete Task Description
Related
documentation


o Determine the configuration
of the
Service
AssuranceDeployment.


Determine Service Assuranceconfiguration, including the
numbers of Global Managers and how they are organized
in the VMware Smart Assurancedeployment.


“Determine the
Service Assurance
configuration” on
page 36


o Determine the hardware
required to support the
Service Assurance
Deployment.


For each Global Managerin the
Service Assuranceconfiguration, determine the type of
equipment required to support it.


Hardware for Service
Assurance platform
equipment tiers


o Determine the location of the
VMware Smart
AssuranceBroker


Choose a location for the
VMware Smart AssuranceBroker that will support the
VMware Smart Assurancedeployment.


Locating VMware
Smart Assurance
Brokers


o Determine the location of the
License Server


Choose a location for the
VMware Smart AssuranceLicense Server that will support
the VMware Smart Assurancedeployment.


Locating license
servers


o Determine the location of the
VMware Smart Assurance
Global Manager(s)


Choose locations for the one or more
VMware Smart Assurance Global Manager(s) that will
support the VMware Smart Assurancedeployment.


“Locating the Global
Managers in the
network” on page 50


o Determine if Service
Assurance Manager must be
configured with failover.


Determine if a high availability configuration is required. “Considering failover
(high availability)
configurations” on
page 51


o Determine if acceptance
tests are required.


Acceptance tests may be required for different portions of
VMware Smart Assurancefunctionality. Be aware of the
requirements and develop acceptance criteria.


“Designing
acceptance tests” on
page 52
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Designing topology operations checklist
Table 12‑4.  Designing topology operations checklist


Complete Task Description
Related
documentation


o Review topology
synchronization issues.


Ensure that you understand how topology
synchronization affects Global Manager performance.


Understanding
topology
synchronization


o Plan topology
synchronizations.


To optimize Global Manager performance, it is best to
reduce the number of topology synchronizations where
possible.


Planning for topology
synchronization


o Plan topology groups. Topology grouping is a visual tool that does not affect
Global Manager performance. Groups help organize
topology elements.


“Designing topology
groupings” on
page 58


Planning for notifications checklist
Table 12‑5.  Planning for notifications checklist


Complete Task Description
Related
documentation


o Determine which
notifications are
important for
VMware Smart
Assurance operators.


Ensure only the notifications that are useful to Global Console
operators reach the Global Manager.


“Overview of
notification
processing” on
page 60


o Configure Notification
Lists.


Notification lists are the mechanism that clients use to subscribe to
and receive notifications from a Global Manager.


Configuring
notifications for
clients


o Design Trap
Processing.


Any VMware Smart Assurance deployment should include a plan
to handle trap processing.


Recommended trap
processing design


VMware Smart Assurance client and user design checklist
Table 12‑6.  VMware Smart Assurance client and user design checklist


Complete Task Description
Related
documentation


o Define functional
groups for users.


List the broad functional groups that users will belong to and then
define the needs and duties of each group. Add this information
to the deployment build guide.


“Determining the
Global Manager
users” on page 68


o Choose appropriate
VMware Smart
Assurance clients for
users.


VMware Smart Assurance consoles have different capabilities.
For each type of user and their equipment, you must determine
which console is most appropriate. Document your choices in the
deployment build guide.


“Choose a console for
types of users” on
page 68
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Table 12‑6.  VMware Smart Assurance client and user design checklist (Continued)


Complete Task Description
Related
documentation


o Define how you will
implement security
for user groups.


When defining the functional categories for users, consider
VMware Smart Assurance’s security implementation. Document
the implementation in the deployment build guide.


Users and security


o Define the
notification lists in
VMware Smart
Assurance user
profiles.


The Notification List determines which notifications are sent from
the Global Manager to the VMware Smart Assurance client.
Carefully define the notification lists as they can affect
Global Manager performance. Document the notification list
provided for each user profile in the deployment build guide.


Designing notification
lists


o Design console
operations access.


Most operations that can be performed at the
VMware Smart Assurance clients can be individually enabled or
disabled in the user profiles. Document the access provided for
each user profile in the deployment build guide.


Designing consoles


o Design console
layouts.


Specific console layouts can be saved and then automatically
provided to match user needs at the Global Console, Web
Console, and Business Dashboard. Document the console layout
used in each user profile in the deployment build guide.


Designing consoles


o Design client and
server tools.


Define the necessary tools that users must access and the levels
of programming skills required to create the tools. Document this
information and tools provided by each user profile in the
deployment build guide.


Planning for tools and
tool deployment


o Define functional
groups for users.


List the broad functional groups that users will belong to and then
define the needs and duties of each group. Add this information
to the deployment build guide.


“Determining the
Global Manager
users” on page 68


Business Impact Manager design checklist
Table 12‑7.  Business Impact Manager design checklist


Complete Task Description
Related
documentation


o Define relevant
business processes.


Determine the business processes to model. “Designing business
impact processing”
on page 76


o Create a business
topology.


Create business elements to model the business processes.
Define the expectations of the model and the events it should
analyze.


Business topology


o Assign weights to
the elements of the
topology.


This step is optional but allows you to assign a value to measure
the impact of events that occur in the topology. The weights of
impacted elements are summed in the root-cause event.


Weights: Impacts of
issues in the topology


o Choose a method
for importing
information.


If the topology is small, use the Topology Builder Console. For
larger topologies, use one or more topology files.


“Importing
information” on
page 77
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Service Assurance Manager
Benchmarks 13
This chapter includes the following topics:


n Service Assurance Manager benchmarking deployment


n Number of syslog messages a given Smarts syslog parser can successfully handle per second


n Number of escalation policies that can successfully be processed using multiple threads


n Service Assurance Manager 8.0 performance benchmarking


n Time to log in to the SAM 8.0 server


n Default Global Console heap size allocation


n SAM 8.1 latency performance benchmark testing


n Amount of memory SAM 8.1 requires to process notifications


Service Assurance Manager benchmarking deployment
The following software and hardware configuration was used in conducting the SAM 9.1 benchmarking:


n Software


n Service Assurance Manager 9.1


n Availability Manager-Performance Manager 9.1


n Hardware


Service Assurance Manager benchmarking hardware defines the hardware used:


Table 13‑1.  Service Assurance Manager benchmarking hardware


Hardware Operating system CPU quantity CPU Model Memory


PowerEdge R310 -
Dell


Red Hat Enterprise Linux Server
release 5.8


4 Intel(R) Xeon(R) CPU
X3450 @ 2.67GHz


16 GB


The following three setups were used to deploy the Service Assurance Manager components and domain
manager.


n Service Assurance Manager deployment with one trap adapter and no trap exploder shows
Service Assurance Manager deployment with one trap adapter and no trap exploder
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n Service Assurance Manager deployment with one trap adapter and one trap exploder shows
Service Assurance Manager deployment with one trap adapter and one trap exploder


n Service Assurance Manager deployment with two trap adapters and one trap explodershows
Service Assurance Manager deployment with two trap adapters and one trap exploder


Figure 13‑1.  Service Assurance Manager deployment with one trap adapter and no trap
exploder
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Figure 13‑2.  Service Assurance Manager deployment with one trap adapter and one trap
exploder
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Figure 13‑3.  Service Assurance Manager deployment with two trap adapters and one trap
exploder


Number of traps Service Assurance Manager can successfully
process
This benchmark defines how many traps per second the Service Assurance Manager can successfully
process. The following points were considered when setting up the benchmark environment:


n The benchmark is based on receiving a mix of new notifications from multiple traps


n The trap adapter will be tested with, and without ASL scripts in use


n The trap adapter is flooded using a trap generator with traps ranging from 2000 to 10000 TPM to
reach it’s optimum limit


n SAM servers, Trap Exploder, Trap Adapter are running on the same machine.


The following configurations were tested:


n One trap adapter, no trap exploder, ASL script disabled


n One trap adapter, with trap exploder, ASL script disabled
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n One trap adapter, with trap exploder, ASL script enabled


n One trap adapter, with trap exploder, ASL script enabled, with Queue limits settings


n Two trap adapters, with trap exploder, ASL script enabled


One trap adapter, no trap exploder, ASL script disabled
The procedure for benchmarking one trap adapter with ASL script disabled included:


n Generating consistent inflow of traps each minute directly to Trap Adapter.


n Without Queue Limits set


n Match=ALL


One trap adapter, no trap exploder, ASL script disabled defines the results for a one trap adapter, no
trap exploder, ASL script disabled, with 10 threads configuration.


Table 13‑2.  One trap adapter, no trap exploder, ASL script disabled


Trap exploder Trap adapter Threads ASL script


Trap rate NA 100 T/s 10 NA


Legend


T/s – Traps per second


One trap adapter, with trap exploder, ASL script disabled
The procedure for benchmarking one trap adapter with a ASL script disabled included:


n Generating consistent inflow of traps each minute directly to Trap Exploder.


n Trap Exploder forwards traps to Trap Adapter.


n Without Queue Limits set


n Match=ALL


One trap adapter, with trap exploder, ASL script disabled defines the results for a one trap adapter,
with trap exploder, ASL script disabled, with 10 threads configuration.


Table 13‑3.  One trap adapter, with trap exploder, ASL script disabled


Trap exploder Trap adapter Threads ASL script


Trap rate 133.33T/s 100 T/s 10 NA


Legend


T/s – Traps per second


One trap adapter, with trap exploder, ASL script enabled
The procedure for benchmarking one trap adapter with a ASL script enabled included:


n Generating consistent inflow of traps each minute directly to Trap Exploder.
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n Trap Exploder forwards traps to Trap Adapter.


n Without Queue Limits set


n Match=ALL


One trap adapter, with trap exploder, ASL script enabled defines the results for a one trap adapter, no
trap exploder, ASL script disabled, with 10 threads configuration.


Table 13‑4.  One trap adapter, with trap exploder, ASL script enabled


Trap exploder Trap adapter Threads ASL script


Trap rate 133.33 T/s  33.33 T/s 10 Yes


Legend


T/s – Traps per second


One trap adapter, with trap exploder, ASL script enabled, with Queue Limit
settings
The procedure for benchmarking one trap adapter with a ASL script enabled included:


n Generating consistent inflow of traps each minute directly to Trap Exploder.


n Trap Exploder forwards traps to Trap Adapter.


n With Queue Limits set to 200 MB


n Match=ALL


One trap adapter, with trap exploder, ASL script enabled defines the results for a one trap adapter, no
trap exploder, ASL script disabled, with 10 threads configuration.


Table 13‑5.  One trap adapter, with trap exploder, ASL script enabled


Trap exploder Trap adapter Threads ASL script


Trap rate 133.33 T/s  50 T/s 10 Yes


Legend


T/s – Traps per second


Two trap adapters, with trap exploder, ASL script enabled
The procedure for benchmarking one trap adapter with a ASL script enabled included:


n Generating consistent inflow of traps each minute directly to Trap Exploder and Trap Adapter.


n Trap Generator forwards traps to Trap Exploder.


n Trap Exploder forwards traps to first Trap Adapter.


n Another instance of Trap Generator forwards traps directly to second Trap Adapter.


n Without Queue Limits set
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n Match=ALL


Table 27 on page 122 defines the results for a two trap adapters, with trap exploder, ASL script
enabled, with 10 threads configuration.


Table 13‑6.  Two trap adapters, with trap exploder, ASL script enabled


Trap exploder Trap adapter 1 Trap adapter 2 Threads ASL script


Trap rate 133.33 T/s 33.33 T/s  33.33 T/s 10 Yes


Legend


T/s – Traps per second


Number of syslog messages a given Smarts syslog parser
can successfully handle per second
The following configurations were benchmarked:


n Syslog adapter using the --file option


n Syslog adapter using the -- tail option


Syslog adapter using --file option
When a file containing all syslog entries was processed, both the SAM aggregate server and the SAM
presentation server approximately 55 notifications per second in a SAM 8.0 environment.


SAM 8.0 Syslog adapter using the --file option benchmarking results defines the results for a syslog
adapter using the --file option configuration.


Table 13‑7.  SAM 8.0 Syslog adapter using the --file option benchmarking results


Syslog Adapter Adapter Platform (OI)
SAM 8.0aggregate
server


SAM 8.0
presentation server


Syslog Rate 57.18 S/s 57.18 S/s 56.88 N/s 55.59 N/s


Legend


S/s – Syslogs per second


N/s – Notifications per second


Syslog adapter using --tail option
When a file was appended with 33,333 syslog entries a second, both the SAM aggregate server and the
SAM presentation server processed 58.65 notifications per second in a SAM 8.0 environment.


SAM 8.0 Syslog adapter using the --tail option benchmarking results defines the results for a syslog
adapter using the --tail option configuration.


VMware Smart Assurance Service Assurance Manager Deployment Guide


VMware, Inc.  94







Table 13‑8.  SAM 8.0 Syslog adapter using the --tail option benchmarking results


Syslog Adapter Adapter Platform (OI)
SAM 8.0aggregate
server


SAM 8.0
presentation server


Syslog Rate 58.69 S/s 58.69 N/s 58.65 N/s 58.65 N/s


Legend


S/s – Syslogs per second


N/s – Notifications per second


Number of escalation policies that can successfully be
processed using multiple threads
When 50,000 traps were sent to the trap adapters, the rate to compute the escalation of notifications at
the Service Assurance Manager presentation server was measured for 5, 10, 20, and 50 escalation
policies. For each escalation policy:


n The following path and levels were used: 1 path and 1 level, 5 paths and 3 levels, and 10 paths and 6
levels


n Each notification matches exactly one policy per path


Note   Each escalation, path, and level action consisted of running a unique shell script that created
an empty file in the local file system.


Escalation policy benchmark results defines the escalation policy benchmarking results for SAM 8.0.


Table 13‑9.  Escalation policy benchmark results


Configurat
ionpolic
y/path/
level


Adapter
Platfor
m
(OI)N/s


SAM-
Aggrega
te N/s


SAM-
Present
ation
N/s


Elapsed
time in
seconds


Queue
growt
h


Memory
start in
KB


Memor
y end in
KB


Delay
in
compl
etion
in
secon
ds


Notificatio
n average
escalation
time in
seconds


Time
to load
XML
file


5/1/1 37.48 35.41 13.94 3587 2 264448 419432 0 0.1987 3.6


10/1/1 41.91 40.23 13.14 3805 6 283944 438064 0 0.2016 3.6


20/1/1 42.37 40.52 12.42 4025 5 283376 433032 0 0.2108 3.8


50/1/1 40.00 37.94 12.53 3990 2 268864 422168 0 0.207 4.3


5/5/3 38.70 37.06 5.48 9131 896 274960 516096 2 min. 121.0753 5.3


10/5/3 32.98 30.40 5.87 8642 1022 230984 472424 2 min. 121.2158 6.8


20/5/3 37.97 36.34 5.21 9721 836 283760 514104 2 min. 121.1235 19.7


50/5/3 35.46 32.81 5.47 9269 885 238376 478216 2 min.
1 sec.


121.0869 69.3
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Table 13‑9.  Escalation policy benchmark results (Continued)


Configurat
ionpolic
y/path/
level


Adapter
Platfor
m
(OI)N/s


SAM-
Aggrega
te N/s


SAM-
Present
ation
N/s


Elapsed
time in
seconds


Queue
growt
h


Memory
start in
KB


Memor
y end in
KB


Delay
in
compl
etion
in
secon
ds


Notificatio
n average
escalation
time in
seconds


Time
to load
XML
file


5/10/6 32.24 28.97 2.93 17359 1857 219896 588280 5 min.
2 sec.


325.505 15.2


10/10/6 37.12 32.94 2.38 21350 1686 269768 625400 5 min.
1 sec.


311.5431 47.6


20/10/6 37.12 35.04 2.60 19567 1013 283224 628792 5 min.
13
sec.


305.2938 253


50/10/6 33.94 31.87 2.56 19808 1082 288608 402664 5 min.
2 sec.


305.0976 1146.8


Legend


* Queue name is ICS Auto Action Time. If no value, the queue file was not created.


N/s – Notifications per second.


NG – No queue growth.


Elapsed Time in Seconds is the time to execute all escalations.


min. – minutes.


sec. – seconds.


Delay in Completion in Seconds is the excess time to complete the execution of the escalations This is
measured as the difference between the time the last notification was received by the Service Assurance
Manager server and the time the last escalation was completed.


Time to load XML file defines the time it took to load the escalation policies configuration file into the
Service Assurance Manager server. This file is in XML format and is loaded into the server using the
sm_config command.


Service Assurance Manager 8.0 performance
benchmarking
Service Assurance Manager 8.0 performance benchmarking focused on the following functionality:


n Displaying containment views


n Displaying maps


n Processing notifications


n Performing topology synchronization
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Environment
The Service Assurance Manager 8.0 performance benchmarking environment consisted of multiple:


n Hierarchical Service Assurance Manager servers


n Underlying domains (at a minimum four underlying domains, including IP and NPM)


n Trap adapters


Performance benchmarking hardware configuration defines the hardware configuration used for the
performance benchmarking.


Table 13‑10.  Performance benchmarking hardware configuration


Type Model Platform Memory size


Server System Sun SPARC Enterprise T5220 sun4v/1.1GHz 16256 MB


Scenario
The performance benchmarking scenario included 100 concurrent clients responsible for the same
number of notifications, performing different operations, such as taking ownership of an event, releasing
ownership of an event, getting properties of an event, getting a map, and getting containment views.


Results
During a typical scenario with 100 concurrent users logged in and with the SAM server receiving 20 event
notifications a minute and the console displaying 1,200 event notifications when logged in, a containment
view displays in approximately 5 seconds.


Time to log in to the SAM 8.0 server
This section describes the performance benchmark for logging in to the SAM 8.0 server.


Environment
Time to log in to the SAM 8.0 server benchmarking hardware configuration defines the hardware
configuration used in benchmarking the time to log in to the SAM 8.0 server.


Table 13‑11.  Time to log in to the SAM 8.0 server benchmarking hardware configuration


Type Model Platform Memory size


Server Sun Fire V240 sun4v / 1.5 GHz 4 GB


Note   The environment for this benchmark did not include any network latency.
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Scenario
This benchmark included the following scenarios:


n 40,000 total notifications with 21 concurrent clients logging in to the SAM server at the same time.


n 40,000 total notifications with 20 concurrent clients logged in and performing operations and 1 client
logging in to the SAM server.


n 20,000 total notifications with 21 concurrent clients logging in at the same time.


n 20,000 total notifications with 20 concurrent clients logged in and performing operations and 1 client
logging in to the SAM server.


n 40,000 total notifications with 1 client logging into the SAM server.


Results
Logging into the SAM 8.0 server benchmark defines the benchmarks for logging into the SAM 8.0 server.


Table 13‑12.  Logging into the SAM 8.0 server benchmark


Scenario Benchmark


40,000 total notifications with 21 concurrent clients logging in to the SAM server at
the same time.


1 minute and 51 seconds


40,000 total notifications with 20 concurrent clients logged in and performing
operations and 1 client logging in to the SAM server.


1 minute and 44 seconds


20,000 total notifications with 21 concurrent clients logging in at the same time. 51 seconds


20,000 total notifications with 20 concurrent clients logged in and performing
operations and 1 client logging in to the SAM server.


46 seconds


40,000 total notifications with 1 client logging into the SAM server. 1 minute and 46 seconds


Default Global Console heap size allocation
This section describes the default heap size allocation for the SAM 8.0 Global Console.


Environment
This section defines the hardware configuration used to determine the default Global Console heap size
allocation.


Recommendations
The SAM 8.0 default heap size allocation for the Global Console is 350 MB. A heap size of 350 MB is
sufficient for deployments having 50,000 notifications.


Note   The default heap size allocation for previous versions of SAM was 256 MB.
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For the Web Console, the default heap size is 64 MB. A heap size of 64 MB is sufficient for SAM
deployments with 15,000 notifications. For deployments with more than 50,000 notifications the heap size
should be increased to 350 MB. The
VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide provides detailed
heap size considerations for the Web Console and Business Dashboard applets.


SAM 8.1 latency performance benchmark testing
SAM 8.1 latency performance benchmark testing consisted of introducing latency in a wide area network
environment and testing the:


n Notification processing time between the presentation SAM server and the underlying aggregate SAM
domain managers


n Topology synchronization time between the SAM server and the underlying servers


Environment
Router connections governing communication between two hosts were adapted to cause network latency
delays of less than 1 millisecond (ms), 100 milliseconds, and 300 milliseconds. Transactions between
domain managers were then monitored at each latency level over the router connection.


The specific environment specifications include:


n Host specifications include:


n 4 GB of RAM


n 2 CPUs


n 60 GB of storage


n Static notification set:


All notifications used in the notification synchronization were included in the aggregate SAM
repository. Additional notifications were not added during the test.


n Topology synchronization repository specifications include:


n 1,200 systems


n Instances — 17,862 (17,859 added 0 deleted)


n Relationships — 35,306 (79,398 connections)


n 2,600 systems


n Instances — 21,841 (21,838 added 0 deleted)


n Relationships — 43,528 (99,066 connections)


n 3,600 systems


n Instances — 26,951 (26,948 added 0 deleted)


n Relationships — 53,204 (121,016 connections)
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Scenarios


Scenario 1
Latency results for SAM-to-SAM notification processing defines the time required to process notifications
between two SAM domain managers, an underlying aggregate SAM server and a top-level presentation
SAM server.


Table 13‑13.  Latency results for SAM-to-SAM notification processing


Latency 1 ms 100 ms 300 ms


~14500 notifications 1:45 2:37 3:32


~32500 notifications 3:10 4:07 5:00


~35100 notifications 3:46 4:20 5:53


Note   The format for the time measurement is minutes:seconds.


Scenario 2
Latency results to complete an initial topology synchronization between an IP domain manager and a
SAM domain manager defines the time required to complete initial topology synchronization between an
IP domain manager (for example, AM and AMPM) and a SAM domain manager.


Table 13‑14.  Latency results to complete an initial topology synchronization between an IP
domain manager and a SAM domain manager


Latency 1 ms 100 ms 300 ms


~1200 systems 2:35:735 2:39:962 2:51:916


~2600 systems 4:20:484 4:21:969 4:55:593


~3600 systems 4:41:862 4:53:813 5:40:516


Note   The format for the time measurement is minutes:seconds:milliseconds.


Results
Latency did have an effect on processing time. However, the number of objects being monitored and the
complexity of the repository structure did greatly influence the processing time.


Amount of memory SAM 8.1 requires to process
notifications
This benchmark determines the amount of memory SAM 8.1 requires to process notifications.


VMware Smart Assurance Service Assurance Manager Deployment Guide


VMware, Inc.  100







Environment
The benchmark environment consisted of:


n SAM server version 8.1 running on:


n LinuxAS5 physical machine


n Red Hat Enterprise Linux Server release 5, Kernel 2.6.18-8.el5 on an x86_64, with 4 GB of
memory


n 4 Intel® Xeon™ CPU 3.60GHz  


n IP servers version 7.0.3 started on:


n Sun T5220 Solaris 10, with 16 GB of memory, 40 1167 MHz SUNW,UltraSPARC-T2 Virtual
CPUs  


Test scenarios
Test scenarios included the following four cases:


n Case 1 — Configured an AM/PM server with approximately 2000 devices as an underlying Service
Assurance Manager domain. Generated 40,000 notifications as rapidly as possible. Measured the
memory of the SAM server from initialization until all notifications were processed.


n Case 2 — Repeated Case-1 with 30 simulated consoles attached.


n Case 3 — Configured 2 AM/PM servers with approximately 2000 devices, configured 2 AM servers
with approximately 1000 devices as underlying Service Assurance Manager domains. Generated
90,000 notifications as rapidly as possible. Measured the memory of the SAM server from
initialization until all notifications were processed.


n Case 4 — Repeated Case 3 with 30 simulated consoles attached.


Results on a Linux AS5 platform
SAM 8.1 Memory benchmarking results defines the results on a Linux AS5 platform.


Initialization: 477580 KB


Topology synchronization (27,000 instances, 30,000 relationships) from
Case 1 and Case 2:


202240 KB


Topology synchronization (50,000 instances, 59,000 relationships) from
Case 3 and Case 4:


315704 KB


43,000 notifications from Case 1: 159084 KB


3.69 KB per notification.


43,000 notifications with 30 consoles from Case 2: 414136 KB


Amount of overhead per console for 43,000
notifications equals 8501.73 KB, or 197.7 bytes per
notification.
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96,000 notifications from Case 3: 343044 KB


3.57 KB per notification.


96,000 notifications with 30 Consoles from Case 4: 598388 KB


Amount of overhead per console for 96,000
notifications equals 8511.47KB, or 88.66 bytes per
notification.
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Preface 1
As part of an effort to improve its product lines, VMware periodically releases revisions of its software and
hardware. Therefore, some functions described in this document might not be supported by all versions of
the software or hardware currently in use. The product release notes provide the most up-to-date
information on product features.


Contact your VMware technical support professional if a product does not function properly or does not
function as described in this document.


Note   This document was accurate at publication time. Go to VMware Online Support docs.vmware.com
to ensure that you are using the latest version of this document.


This chapter includes the following topics:


n Purpose


n Audience


n VMware Smart Assurance Service Assurance Manager installation directory


n VMware Smart Assurance Service Assurance Manager


n Related documentation


n Suggestions for searching PDF files


n Conventions used in this document


n Pathname conventions


n Graphical conventions


n Manager


n Where to get help


n Your comments


Purpose
This document contains troubleshooting instructions and frequently asked questions and troubleshooting
tips on the VMware Smarts Service Assurance Manager.
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Audience
This guide is intended for administrators who are responsible for deploying, installing, and configuring the
Global Manager. IT managers who seek to understand the role of the Global Manager in the context of an
VMware Smart Assurance solution may also find this guide useful.


In addition to the configuration guides for specific components, administrators should also read the
VMware Smart Assurance Service Assurance Manager Deployment Guide and the
VMware Smart Assurance System Administration Guide Guide.


VMware Smart Assurance Service Assurance Manager
installation directory
In this document, the term BASEDIR represents the location where VMware Smart Assurance software is
installed:


n For UNIX, this location is: /opt/InCharge/<productsuite>.


For example, on UNIX operating systems, VMware Smart Assurance Service Assurance Manager is,
by default, installed to /opt/InCharge/SAM/smarts.


Optionally, you can specify the root of BASEDIR to be something other than /opt/InCharge (on UNIX),
but you cannot change the <product> location under the root directory.


The VMware Smart Assurance System Administration Guide provides more information about the
directory structure of VMware Smart Assurance software.


VMware Smart Assurance Service Assurance Manager
The VMware Smart Assurance Service Assurance Manager includes the following products:


n Service Assurance Manager (Global Manager), includes Business Impact Manager (BIM) and
Failover System


n Global Console


n Business Dashboard


n Companion UI


n SAM Native Adapters:


n Service Assurance Manager Notification Adapters (E-Mail Notifier Adapter,
Script Notifier Adapter, SNMP Trap Notifier Adapter, Log File Notifier Adapter)


n Adapter Platform (Adapter Platform server, Syslog Adapter, SNMP Trap Adapter, sm_ems
command-line interface)


n VMware Smart Assurance Adapter for UIM/O


n XML Adapter
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Related documentation
In addition to this document, VMware Corporation provides a help system for command line programs as
well as product documentation.


Help for command line programs
Descriptions of command line programs are available as HTML pages. The index.html file, which provides
an index to the various commands, is located in the BASEDIR/smarts/doc/html/usage directory.


VMware Smart Assurance documentation
Readers of this guide may find the following related documentation helpful:


n Smarts Foundation EMC Data Access API (EDAA) Programmer Guide


n VMware Smart Assurance Common Information Model (ICIM) 1.11 Reference for Non-Service
Assurance Manager Products


n VMware Smart Assurance Common Information Model (ICIM) Reference for Service Assurance
Manager


n VMware Smart Assurance Foundation Documentation Portfolio


n VMware Smart Assurance System Administration Guide


n VMware Smart Assurance ASL Reference Guide


n VMware Smart Assurance Perl Reference Guide


n VMware Smart Assurance Dynamic Modeling Tutorial


n VMware Smart Assurance MODEL Reference Guide


VMware Smart Assurance Service Assurance Manager
documentation
The following documents are relevant to users of the
VMware Smart Assurance Service Assurance Manager:


n VMware Smart Assurance Service Assurance Manager Release Notes


n VMware Smart Assurance Open Source License and Copyright Information


n VMware Smart Assurance Service Assurance Manager Introduction


n VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers


n VMware Smart Assurance Service Assurance Manager Deployment Guide


n VMware Smart Assurance Service Assurance Manager Configuration Guide


n VMware Smart Assurance Service Assurance Manager Operator Guide
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n VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide


n VMware Smart Assurance Business Impact Manager User Guide


n VMware Smart Assurance Failover System User Guide


n VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide


n VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide


n VMware Smart Assurance Adapter for Unified Infrastructure Manager/Operations Configuration Guide


n VMware Smart Assurance XML Adapter User Guide


n VMware Smart Assurance Notification Module User Guide


n VMware Smart Assurance Service Assurance Manager Troubleshooting Guide


n VMware Smart Assurance Companion UI Online Help


n VMware Smart Assurance Companion UI Open Source License and Copyright Information for GPLv3
as Included with a Distribution of SLES 11


n VMware Smart Assurance Service Assurance Manager Documentation Portfolio


The VMware Smart Assurance Documentation Catalog provides documentation resources for other
VMware Smart Assurance products.


Suggestions for searching PDF files
You can search across multiple PDF files by using the Adobe Acrobat Reader software:


1 If the documentation is not accessible to all users of the VMware Smart Assurance product, copy the
contents of the BASEDIR/smarts/doc/pdf directory to a central location, such as a shared drive on
your LAN, so that operators and others can view the documentation.


2 To search throughout the documentation library, open the Acrobat Reader software:


3 Select Edit > Search, and type a word or phrase.


4 Select All PDF Documents in, in the Where would you like to search option, and type the
pathname of the location where the PDF documents reside.


If you have more than one VMware Smart Assurance product installed, you can set up cross-product
document searches by copying files from the BASEDIR/smarts/doc/pdf directory for each product into
this common documentation directory path.


Conventions used in this document
VMware uses the following convention for special notices:


Note   NOTICE is used to address practices not related to personal injury.
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Typographical conventions
VMware uses the following type style conventions in this document:


Bold Use for names of interface elements


Italic Use for full titles of publications referenced in text


Monospace
Use for:
n System output, such as an error message or script
n System code
n Pathnames, filenames, prompts, and syntax
n Commands and options


                      
  Monospace italic
                     


Use for variables.


                      
  Monospace bold
                     


Use for user input.


[ ] Square brackets enclose optional values


| Vertical bar indicates alternate selections — the bar means “or”


{ } Braces enclose content that the user must specify, such as x or y or z


... Ellipses indicate nonessential information omitted from the example


Pathname conventions
Directory pathnames are shown with forward slashes (/).


Graphical conventions
Under UNIX, the consoles appear with slight differences. For example, in views that display items in a
tree hierarchy such as the Topology Browser, an open circle appears for UNIX.


Manager
Unless otherwise specified, the term Manager is used to refer to VMware Smart Assurance programs
such as Domain Managers, Global Managers, and adapters.


Where to get help
VMware Smart Assurance support, product, and licensing information can be obtained as follows:


Product information
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For documentation, release notes, software updates, or information about VMware products, go to
VMware Online Support at:


docs.vmware.com


Technical support


Go to VMware Online Support. You will see several options for contacting VMware Technical Support.
Note that to open a service request, you must have a valid support agreement. Contact your VMware
sales representative for details about obtaining a valid support agreement or with questions about your
account.


Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the
user publications. Provide your feedback of this document to:docs.vmware.com
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Troubleshooting 2
This chapter includes the following topics:


n Configuration issues


n Adapter issues


n NOTIF issues


n Notification and event processing issues


Configuration issues
This section provides troubleshooting help for the following issues:


n Synchronizing Service Assurance Manager with other Domain Managers


n Out-of-memory issue


n Checking status of underlying domain managers


n Identifying a port number


n Refreshing the console


n Reattaching to a Manager


n Responding to disconnected Managers


n Support is absent for IPv6 literal addresses in URLs


n Web Console or viewlets running out-of-memory


n SelectiveGroup and HierarchicalGroup instances lost when HierarchicalGroupManager is deleted or
purged


n Inability to load dynamic library causes ASL errors


n Unable to build hierarchical groups while running group driver


n Containment view missing from Presentation SAM


Synchronizing Service Assurance Manager with other
Domain Manager s
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Symptom
Unable to synchronize Service Assurance Manager with IP Availability Manager.


Recommended action
Run the following command to synchronize Service Assurance Manager with IP Availability Manager:


<basedir>/smarts/bin/dmctl -s <sam_server> invoke GA_DaemonDriver::<am_server>_Topo-Driver start


dmctl -s INCHARGE-SA invoke GA_DaemonDriver::INCHARGE-AM-PM_Topo-Driver start


Out-of-memory issue


Symptom
Subscriber queue keeps growing in the server for a client that has become inactive. The queue
processing thread in the server gets blocked in the socket during a write-operation, when the client stops
reading data off the socket. However, keepAlives continue to be sent, thus keeping the connection active.


Possible cause
The out-of-memory issue may be occurring because there is a finite amount of memory process that can
be used. Hence, if you have a very large topology or lot of notifications in the SAM repository, then it
would result in hitting the limit. Memory usage increases to the maximum during topology synchronization
because new topology objects are created during synchronization.


Recommended action
The solutions recommended include:


n Refactoring of domains (short term solution): Redesign your deployment to deploy additional Global
Managers in a hierarchical Service Assurance configuration. Instead of using one SAM, split them
into two. For instance, if one SAM is configured with 20 underlying domains, then start two SAMs with
10 each. This reduces the topology size and notification flow. Additionally, you can choose to reduce
the archive interval from 4 hours (default) to a shorter interval. Also, topology can be trimmed by
avoiding import of unnecessary classes.


n Refine notification lists for users.


n Re-assess the topology synchronization configuration.


n Refine sets of trap and syslog notifications sent to SAM.


n Increase worker threads used for escalation.


n If you are on a lower version of SAM, migrate to a higher version. This is a good long term solution.


The VMware Smart Assurance Service Assurance Manager Deployment Guide provides detailed
guidelines and procedures for assessing and improving performance of your deployment.
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Logs or information to collect
n Run <BASEDIR>/smarts/bin/sm_monitor against the domain for collecting data every few hours.


n Use the <BASEDIR>/smarts/bin/sm_getinfo utility to collect logs and configuration settings if you
intend to raise an issue with support.


The VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers
provides details on using the sm_getinfo utility to collect data to help in troubleshooting problems.


Checking status of underlying domain managers


Symptom
Unable to figure out the operational status of the underlying domain manager.


Recommended action
If you do not know the operational status of your underlying domain manager, use the brcontrol command
or the Browse button in the Attach Manager dialog box to list the Managers and their status. The status
listed for your Manager should be ‘Running.’ If your Manager is not running state, contact your
administrator, consult the VMware Smart Assurance System Administration Guide, or refer to your
specific product installation guide for instructions on starting the Manager.


For the brcontrolcommand, type one of the command lines shown in The brcontrol command.


Table 2‑1.  The brcontrol command


Operating system Example


UNIX <BASEDIR>/smarts/bin/brcontrol


Identifying a port number


Symptom
Unable to find the port number of a domain manager.


Recommended action
If you do not know the port number of a domain manager, use the brcontrolcommand or the Browse
button in the Attach Manager dialog box to display the port number.


Refreshing the console


Symptom
Console display is distorted.
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Recommended action
If your console does not display properly, you can force the console to redisplay. For example, if
fragments of menus or fields from dialog boxes linger after the menus or dialog boxes close, you can
redisplay the console.


To refresh a console, select View > Refresh.


Reattaching to a Manager


Symptom
Machine running Service Assurance Manager becomes unavailable.


Recommended action
Initially, when you log in to start a session, you specify the Manager to which you want to attach.
Ordinarily, you do not have to attach again during your session.


If the machine running the Service Assurance Manager becomes unavailable, the Global Console polls
the broker every 30 seconds and reattaches when the Manager is operational.
VMware Smart Assurance Service Assurance Manager Operator Guide includes instructions on manually
attaching or reattaching to an VMware Smart Assurance Manager.


Note   If a VMware Smart Assurance Manager disconnects, a Domain Disconnected message appears
informing you that the Manager disconnected and that the console will reconnect when the domain
becomes available.


Responding to disconnected Manager s


Symptom
Underlying Managers get disconnected from the Global Manager.


Recommended action
When underlying Managers disconnect from the Global Manager (for example, due to a network outage),
the notifications from the unavailable sources are not updated in the console. The affected notifications,
maps, and summaries no longer reflect the current conditions.


If a disconnect situation occurs, a Session Disconnected notification informs you that a specific Manager
is disconnected and a similar entry is added to the audit log.


When the Manager reconnects, the Session Disconnected notification clears, and it is recorded in the
audit log.


If you receive a Session Disconnected notification, your administrator should investigate it for a network
connection failure or an operational problem. The Manager may need to be restarted.
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Support is absent for IPv6 literal addresses in URLs


Symptom
Firefox and Mozilla web browsers support IPv6 literal addresses in URLs.


Recommended action
Use Firefox or Mozilla web browsers instead of Microsoft IE if you need to use an IPv6 literal address to
access the Web Console or Business Dashboard.


Web Console or viewlets running out-of-memory


Symptom
Depending on the heap space configured for the web browser in which the Web Console or Business
Dashboard runs, the Web Console or the viewlets in the Business Dashboard may run out-of-memory. By
default, the Web Console and viewlets allocate less heap space than the Global Console. Less heap
space may result in out-of-memory errors in the Web Console or viewlets. For example, an out-of-
memory error may occur in a Web Console that heavily uses large map background images.


Recommended action
If the Web Console or viewlets run out-of-memory, adjust the maximum amount of heap space that the
Java Plug-in uses for dynamic memory allocation. For example, by specifying -Xmx256M as a runtime
parameter you can increase the heap space allocation to 256 MB. The number can be set larger or
smaller than 256 MB, depending on the resources available on the client machine running the web
browser. To increase the heap space for the Java Plug-in:


1 Launch the Java Plugin Control Panel. For instructions, see:


http://java.sun.com/j2se/1.5.0/docs/guide/deployment/deployment-guide/jcp.html.


2 In the Java Plug-in Control Panel, click the Java tab.


3 In the Java tab page, click View in the Java Applet Runtime Settings box.


4 The Java Runtime Settings dialog box appears.


5 In the Java Runtime Settings dialog box, in the J ava Runtime Parameters text entry field for your
JRE, type the maximum heap-space runtime parameter (-Xmx) and a value for the parameter. For
example:


-Xmx256M
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6 Save your entry. Click OK to close the Java Runtime Settings dialog box. Then click OK to close the
Java Control Panel.


Close and restart any web browser running on the host machine.


SelectiveGroup and HierarchicalGroup instances lost when
HierarchicalGroupManager is deleted or purged


Symptom
If the HierarchicalGroupManager instance is deleted or purged due to some reason, the group instances
are not visible.


Recommended action
The HierarchicalGroupManager instance maintains relationships with HierarchicalGroups and
SelectiveGroups. SelectiveGroups are created using SAM console and HierarchicalGroups are created
from configuration files. Once HierarchicalGroupManager instance is purged, the group instances are not
visible since the relationship information is lost even though group instances are present in the repository.


In case of HierarchicalGroup instances, use the following steps to recreate them:


1 In the Global Manager Administration Console, expand INCHARGE-SA > ICS Configuration and
click Business Templates.


2 Click Modify List on the Configure “Business Templates” screen.


3 On the Edit Business Template dialog-box, select a template from Selected Template Files and
remove it.


4 From Available Template Files, add the template you just removed.


5 Click OK on the Edit Business Template dialog-box.


6 Click Apply on the Configure “Business Templates” screen.


7 Start the group driver by running the following command:


    dmctl -s INCHARGE-SA invoke GA_DaemonDriver::ICS-Group-Driver start


For recreating SelectiveGroup instances, run the following command:


./sm_adapter -s INCHARGE-linux ics/ics-restore-selectivegroup.asl


Inability to load dynamic library causes ASL errors
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Symptom
In a typical SAM configuration, when the server is started it does not contain the dynamic library to load
all custom classes, for example, UIM_O_AdapterManager. In a custom hierarchical SAM configuration,
this may result in generating ASL errors.


Recommended action
The following configuration must be made in the hierarchical SAM area to avoid the generation of ASL
errors:


1 Copy dyn_uii.ldm and dyn_uii.mdl files from the Service Assurance Manager
<BASEDIR>/smarts/model/ics files to the <BASEDIR>/smarts/local/model/top-sam folder. Here, top-
sam is the custom folder created for the top-level SAM.


2 Restart the server.


Unable to build hierarchical groups while running group driver


Symptom
No map console groups are created running the GA_DaemonDriver using the dmctl -s INCHARGE-SA
invoke GA_DaemonDriver::ICS-Group-Driver start command.


Recommended action
If there are multiple hosts configured across groups, there may be an issue while creating hierarchical
groups in SAM. Delete the disjointed hosts from the topology and the current map console structure, and
run the script.


Containment view missing from Presentation SAM


Symptom
Containment view is missing from Presentation SAM, but is available in Aggregation SAM. The problem
occurs because the Presentation SAM topology driver is hanging.


Recommended action
To resolve this issue:


1 Run the following command to determine the state of the topology driver:


               <BASEDIR>/smarts/bin/dmctl -s <Pres SAM> get GA_DaemonDriver::<AGG SAM>_Topo-Driver
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2 Compare the state of the topology driver with that of the SAM domain. If the topology driver state is
GA_DRIVER_RUNNING, but the SAM domain topology does not indicate that topology sync is
occurring, then the topology driver is hanging. The topology driver must only be running during a SAM
domain topology sync. When no topology sync is occurring, the topology driver must display the
status as GA_DRIVER_STOPPED.


3 If the topology driver is hung, restart the Presentation SAM domain to resolve the issue.


The ‘TimeOutTopo’ flag in the dxa-sam.conf file helps detect if a a driver hanging and will stop the
driver so that the next topology sync will proceed normally. By default the TimeOutTopo flag is
disabled. To enable the flag:


4 Open the dxa-sam.conf configuration file for editing in sm_edit as follows:


               <BASEDIR>/sm_edit conf/ics/dxa-sam.conf


            


5 Find the ‘TimeOutTopo’ line. Remove the comment hash character (#) from the start of the line to
enable the functionality, and increase the timeout value (in seconds). For instance change the line
#TimeOutTopo 60 to TimeOutTopo 600.


Note   The increased value (600) specified in the example and can be configured to a different value.
From SAM 8.1 Service Pack 1 (SP1) release, the TimeOutTopo value is set to 600 seconds by default
and the dxa-sam.conf configuration file still contains the option of changing the time out value. For
more information on the TimeOutTopo flag, see the
VMware Smart Assurance Service Assurance Manager Configuration Guide. Earlier versions of SAM
will not have a default value.


6 Run a reconfigure operation in Presentation SAM or restart the Presentation SAM domain for the
changes to take effect in the active environment.


Adapter issues
This section provides troubleshooting help for the following issues:


n Notification adapter fails to start


n Notification adapter starts, but fails to connect to VMware Smart Assurance Manager


n Email not received from Email Notifier


n Email received from Email Notifier, but not for all events


n File notifier does not create a log file containing notifications


n Not all events are recorded in the file notifier output


n No traps delivered to destination by trap notifier


n Not all traps delivered to destination by SNMP Trap Notifier


n Script is not invoked for Script Notifier Adapter
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Notification adapter fails to start


Symptom
Notification adapter appears not to start. The issue may be seen across Email Notifier Adapter, the Log
File Notifier Adapter, the SNMP Trap Notifier Adapter, and the Script Notifier Adapter.


Recommended action
When a notification adapter appears not to start, check the status of its process or service.


For an adapter started with the sm_notify command


For an adapter started as a service


For UNIX


Type the command from the <BASEDIR>/smarts/bin directory:


         ./sm_service start <service_name> [<service_name> ...]


where <service_name> is the service you need to start.


Additionally, you can check the sm_notify_en_US_UTF-8.log present in the <BASEDIR>/local/logs folder
or use the sm_getinfo utility to collect data to help troubleshoot the problem.


The VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers provides
details for using the sm_getinfo utility.


Notification adapter starts, but fails to connect to
VMware Smart Assurance Manager


Symptom
Adapter starts successfully without any error, but cannot connect to an VMware Smart Assurance
Manager. The issue may be seen across Email Notifier Adapter, the Log File Notifier Adapter, the SNMP
Trap Notifier Adapter, and the Script Notifier Adapter.


Recommended action
When an adapter cannot connect to VMware Smarts Assurance Manager, it is usually for one of the
following reasons:


n VMware Smart Assurance Manager is not running.


n Name of the VMware Smart Assurance Manager is not the same as the name specified in the
adapter’s configuration file.


n VMware Smart Assurance Manager cannot be reached from the host running the adapter.


VMware Smart Service Assurance Manager Troubleshooting Guide


VMware, Inc.  18







Check the status of the VMware Smart Assurance Manager


Use the brcontrol command to check the status of the VMware Smart Assurance Manager. The syntax is:


<BASEDIR>/smarts/bin/brcontrol


By default, this command returns a list of VMware Smart Assurance Managers registered with the broker
and their current state. The list indicates whether an VMware Smart Assurance Manager’s state is
RUNNING or DEAD. If the VMware Smart Assurance Manager is not running or included in the list,
restart the VMware Smart Assurance Manager.


Check the name of the VMware Smart Assurance Manager in the configuration file


The configuration file of each adapter contains the name of the VMware Smart Assurance Manager to
which it connects. This value in the configuration file can be overridden by using the --server option with
the sm_notify command.


In cases where an adapter cannot connect, check that the --server option, if used, points to a valid
VMware Smart Assurance Manager. If that is not the issue, check that the appropriate
VMware Smart Assurance Manager is specified in the adapter’s configuration file.


Adapters andVMware Smart Assurance Manager parameters lists the configuration file and parameter to
check for each adapter.


Table 2‑2.  Adapters and VMware Smart Assurance Manager parameters


Adapter
Location and name (relative to
<BASEDIR>/smarts/conf)


VMware Smart Assurance Manager
parameter


Email Notifier Adapter /notifier/mail-notify.conf serverName


Log File Notifier Adapter /notifier/file-notify.conf serverName


SNMP Trap Notifier Adapter /notifier/trap-notify.conf serverName


Script Notifier Adapter /notifier/script-notify.conf serverName


Check communication to the VMware Smart Assurance Manager’s host


If the adapter and the VMware Smart Assurance Manager run on different hosts, the adapter’s host might
not be able to communicate with the VMware Smart Assurance Manager’s host. From the adapter’s host,
run the following command:


         dmctl


         --server=<InCharge_Manager> ping


      


The results of this command show whether the VMware Smart Assurance Manager is alive or
unavailable.


Email not received from Email Notifier
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Symptom
When the Email Notifier Adapter starts and connects to the Domain Manager, the intended recipient
receives no email.


Recommended action
The issue is usually caused due to an incorrect configuration. The configuration file for the Email Notifier
Adapter is mail-notify.conf. This file resides in the <BASEDIR>/smarts/notifier directory.


There are three parameters that specify where the Email Notifier Adapter delivers information. 
Parameters needed to receive email lists these parameters.


Table 2‑3.  Parameters needed to receive email


Parameter Description


MailServer Name for the mail server. For example:


MailServer = "localhost"


SenderId Email address associated with the adapter. Users can reply to this address. This address
must be recognized by the mail server. For example:


SenderId = "daemon@localhost"


Recipients A comma-separated list of the recipients of the emails. The


recipients in the list must be recognized by the mail server. For


example:


Recipients = "root@localhost,recipient@your_company.com"


Check the parameters in the configuration file and verify them with your email administrator. All three
must have a valid value for the Email Notifier Adapter to work. For the changes to the configuration file to
take effect, the adapter must be restarted.


Email received from Email Notifier, but not for all events


Symptom
Email Notifier Adapter does not seem to be sending messages for all of the correct events.


Recommended action
The issue could be that the subscription profile is incorrect or that you expect the adapter to be sending
messages when notifications clear. To resolve the issue you can:


Modify the subscription profile


When the Email Notifier Adapter sends email, but does not send them for all expected events, the issue
usually is improper subscriptions. “Specifying subscriptions in the configuration file” in the
VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide contains
instructions on modifying the subscription profile for this adapter.


VMware Smart Service Assurance Manager Troubleshooting Guide


VMware, Inc.  20







Change the Email Notifier Adapter to send notifications of cleared events


By default, the Email Notifier Adapter does not send messages when a notification clears. It only sends
messages for new notifications or when the certainty of the notification changes.


To enable the Email Notifier Adapter to send CLEAR notifications, change the following in the file,
<BASEDIR>/rules/notifier/mail/mail-filter.asl:


START () {


OMIT_CLEAR_EVENTS


}


to


START () {


// OMIT_CLEAR_EVENTS


}


After making changes to the file, restart the adapter for the changes to take effect.


File notifier does not create a log file containing notifications


Symptom
The Log File Notifier Adapter starts and connects to the VMware Smart Assurance Manager, but it does
not appear to create the notification file.


Recommended action
Check to ensure the filename is the one you expect. The Log File Notifier Adapter’s configuration file, file-
notify.conf, contains the name of the notification file. The file-notify.conf file resides in the
<BASEDIR>/smarts/conf/notifier directory. The parameter, fileName, defines the name of the notification
file that the adapter creates for its output. The adapter always creates the notification file in the
<BASEDIR>/smarts/local/logs directory. If you do not specify a value, the adapter creates a default file
named <InCharge_Manager>-alarms.log.


Note   Do not confuse this adapter’s output file with its log file. The log file also appears in the
<BASEDIR>/smarts/local/logs directory. You determine the log file’s name when the adapter starts using
the --output command option. The default name of the log file is sm_notify.log. Never use the same name
for both the notification file and the Log File Notifier Adapter’s log file.


Not all events are recorded in the file notifier output


Symptom
The Log File Notifier Adapter sends information to the notification file, but does not send it for all of the
correct events.
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Recommended action
The issue usually is caused due to improper subscriptions. “Specifying subscriptions in the configuration
file” in the VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide
contains instructions on modifying the subscription profile for this adapter.


No traps delivered to destination by trap notifier


Symptom
The SNMP Trap Notifier Adapter starts and connects to the VMware Smart Assurance Manager and does
not send the SNMP Traps.


Recommended action
The issue is usually the format of the parameter Destinations. The parameter, Destinations, is a table that
contains the SNMP trap destinations. Each row in the table is surrounded by curly braces and consists of
three different values: hostname or IP address, port number, and SNMP version. The values are
separated by commas. There are two valid values for SNMP version: V1 and V2C. These values and the
values for host name or IP address must be surrounded by quotation marks. The port number is an
integer value with no quotation marks.


Each row in the table is separated from the next by a comma. Place a comma after the curly brace that
marks the end of each row in the table except for the last. An outer set of curly braces defines the entire
table.


For example, the Destinations parameter could appear as follows:


Destinations = {


{"localhost", 162, "V1"},


{"other-host", 30162, "V2C"},


{"195.67.23.103",21539, "V2C"}


}


Not all traps delivered to destination by SNMP Trap Notifier


Symptom
The SNMP Trap Notifier Adapter sends traps, but does not send them for the correct events.


Recommended action
The issue is usually improper subscriptions. “Specifying subscriptions in the configuration file” in the
VMware Smart Assurance Service Assurance Manager Notification Adapters User Guide contains
instructions on modifying the subscription profile for this adapter.
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Script is not invoked for Script Notifier Adapter


Symptom
This issue applies to the Script Notifier Adapter, where scripts are not invoked for the adapter.


Recommended action
To ensure that the script is invoked for the Script Notifier Adapter:


1 Ensure your script is located in <BASEDIR>/smarts/local/actions, and that it is readable and
executable.


2 Check the configuration file to see that you have altered the file to include the correct name for the
script you want to invoke.


NOTIF issues
This section provides troubleshooting help for the following issues:


n Unable to startup NOTIF


n NOTIF Java errors in server log


Unable to startup NOTIF


Symptom
SAM or OI server logs indicate that NOTIF is active, but also indicate that NOTIF did not start. The
following error message is generated:


Checking NOTIF settings for start flag...


Loading JVM interface...


Initializing JVM interface...


*** Notif start thread created; returning.


Program initialization call returned.


......<few more lines>.....


*** NOTIF DID NOT START!


com.vmware.smarts.notif.entryPoints.notifIcEntryPoint$notifNotEnable


Exception: com.smarts.remote.SmRemoteException


Started: Specified property not found in class


MR-PROPERTY_NOT_FOUND-Specified property not found in class


SAM will continue to run without Notif


Recommended action
Check for the following:


n If the value for SM_JAVA_ENABLED parameter is set to YES in the runcmd_env.sh file. The The
runcmd_env.sh file is located in the <BASEDIR>/smarts/local/conf directory.
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n All libraries and jars are present in the lib and classes folder, respectively.


n SM_LIB_PATH contains the entry for the <BASEDIR>/smarts/lib and <BASEDIR>/smarts/local/lib.


Logs or information to collect
n <server_name>.log


n Notif.<server_name>.audit.* files


n *.ncf files in server configuration directories in all the sitemod locations


n Use <BASEDIR>/smarts/bin/sm_getinfo utility to collect logs and configuration settings if you intend
to raise an issue with support.


The VMware Smart Assurance Installation Guide for SAM, IP, ESM, MPLS, and NPM Managers
provides details on using the sm_getinfo utility to collect data to help in troubleshooting problems.


NOTIF Java errors in server log


Symptom
‘ClassNotFound’ errors observed in SAM or OI server log depending on where NOTIF is configured.


Recommended action
Check if jars in notif-init.asl are available in the <BASEDIR>/smarts/classes or
<BASEDIR>/smarts/local/classes folder.


Logs or information to collect
n <server_name>.log


n Notif.<server_name>.audit.0 files


n Individual trap logs (if applicable)


n *.ncf files in server config directories in all the sitemod locations


Notification and event processing issues
This section provides troubleshooting help for the following issues:


n Viewing subscriptions for an event


n Unsubscribing from disabled events


Viewing subscriptions for an event


Symptom
Unable to identify subscriptions for a given event, but able to view the bootstrap subscriptions.
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Recommended action
Use the following command to view subscriptions associated with an event:


dmctl> exec dmdebug subscriptions[=all] [output=]


Unsubscribing from disabled events


Symptom
Unable to unsubscribe from Disabled events using the Service Assurance Manager.


Recommended action
To allow the Service Assurance Manager to subscribe to all problem events except for Disabled events,
modify the DXA file which is used by the Service Assurance Manager to communicate with underlying
domains. This file is available under:


<BASEDIR>/SAM/smarts/bin/sm_edit conf/ics/dxa-conn.conf


In this file change:


sub .*::.*::.*/p 


to:


sub *::*::~Disabled/pg 


Add, the ChoiceSubscription->glob = glob("*g*", Modifiers) line to the
<BASEDIR>/SAM/smarts/bin/sm_edit rules/ics/ics-event-driver.asl file for the Service Assurance Manager
not to filter the current Disabled events, for example:


ChoiceSubscription->symptoms = glob("*s*|*e*", Modifiers)


ChoiceSubscription->glob = glob("*g*", Modifiers)


ChoiceSubscription->quiet = TRUE
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Frequently Asked Questions 3
This chapter includes the following topics:


n Configuration queries


n Trap processing queries


n NOTIF queries


n Notification and Event processing queries


n Business Dashboard queries


Configuration queries
This section answers the following frequently asked questions on SAM configuration:


n Editing .conf files


n Enabling SAM scheduling maintenance


n Obtaining information on users logged to domains


n Using ASL to create file outside of logs directory


n Accessing console message logs


Editing .conf files


Query
When do I edit the trapd.conf and trap_mgr.conf files?


Answer
Edit the trapd.conf file when you want to forward traps; use this file to specify where to forward what set of
traps. Edit the trap_mgr.conf if you are configuring the Adapter Platform to send notifications on to the
Global Manager.


Enabling SAM scheduling maintenance
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Query
I am unable to turn on the SAM Scheduling maintenance feature as the interface is grayed out. The
necessary script files under the actions directory are also unavailable. The user does not have a BIM
license. Is a BIM license required for the maintenance feature?


Answer
A BIM license is not a prerequisite for running the maintenance feature. However, the MBIM server needs
to be running, with SAM domain configured as its source. Also, SAM should be subscribed to the MBIM
domain.


Obtaining information on users logged to domains


Query
I need details on the SAM-Presentation login information. Is there a flag or setting that we can set to
obtain details of whose logged into the domains?


Answer
The SM_OKLOGIN_LOGLEVEL environment variable enables the logging of successful logins at FATAL
severity, rather than INFORMATIONAL. SM_OKLOGIN_LOGLEVEL is a Boolean. Set
SM_OKLOGIN_LOGLEVEL=1 in the runcmd_env.sh file, located in the <BASEDIR>/smarts/local/conf
folder. You must restart the domain for the change to take affect. 


Using ASL to create file outside of logs directory


Query
Can we use ASL to create or write a file (ACT_FILE) outside of the logs directory?


Answer
No, you cannot create or write a file (ACT_FILE) outside of the logs directory using ASL.


Accessing console message logs
The Global Console has two logs which are useful for troubleshooting:


n The Java console is the first tool to use for console debugging. It shows store exceptions, errors
reading attributes, and stack traces.


To collect the most information about potential console problems, specify the -
Dcom.smarts.log.level=TRACE property.
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Java console information can automatically be saved to a file on your local workstation by specifying
the -Dcom.smarts.java.log=<filename> property. When specifying this property, the file is written to
the <BASEDIR>/smarts/local/logs directory.


SM_WRITEABLE is an environment variable whose default value can be changed in the
runcmd_env.sh. Use this console information to assist with debugging issues.


Note   Before starting the console with the -Dcom.smarts.java.log=<filename> property , verify that
the <SM_WRITEABLE>/logs directory exists under the <BASEDIR>/smarts/local folder.


n The message log shows everything the Manager sends to the console while the log window is
activated (opened or minimized).


This information can automatically be saved to a file on your local workstation by specifying the -
Dcom.smarts.server.logMessages=true property. When specifying this property, the file is written to
the <SM_WRITEABLE>/logs directory. Use this information to assist with debugging issues when the
console stops responding.


Note   Before starting the console with the -Dcom.smarts.server.logMessages=true


property, verify that the <SM_WRITEABLE>/logs directory exists under the <BASEDIR>/smarts/local
folder.


To access the log views, select View > Java Console or View > Message Log.


In the Java console, the following warning is benign:


Warning: Could not get the full set of system properties.


Trap processing queries
This section answers the following frequently asked questions on trap processing:


n Difference between Notification Adapter and Adapter Platform


n Traps sent not reflected in Adapter Platform Server


n Check for agent sending traps


n Forwarding traps to servers


n Ensuring traps reach Adapter Platform


n Verifying trap forwarding


n Debugging SNMP Trap Notifier


n Debugging SNMP Trap Notifier


n Defining two SNMP traps in trap_mgr.conf file


n Number of traps adapter or exploder can process


n Improving performance of trap adapter and trap exploder
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n Defining sm_adapter parameters


n Log levels defined


Difference between Notification Adapter and Adapter Platform


Query
Are SAM Notification Adapter and the Adapter Platform the same?


Answer
No. The VMware Smart Assurance Service Assurance Manager Notification Adapters convert SAM
Notifications and log them either by writing to a file, emailing them, sending the notifications as traps, and
so on. The Adapter Platform receives traps and processes them into notifications.


Traps sent not reflected in Adapter Platform Server


Query
When I send a trap, why don't I see it in the Adapter Platform server?


Answer
Check the following:


n Ensure that your trap OID, both generic and specific is configured within the trap_mgr.conf file. The
file located under the <BASEDIR>/smarts/conf/icoi folder.


n Ensure that the agent sending the trap is in the Adapter Platform server topology.


n Ensure that you are giving the correct hostname and port to where your trap receiver is running.


Check for agent sending traps


Query
How do I check if the agent sending the trap is in the Adapter Platform server?


Answer
The IP address of the device sending the trap must be in the Adapter Platform server, and must be
hosted by (with a HostedBy relationship) some unified computing system (UCS) for the trap notification to
be created.


To check the HostedBy relationship, use your topology browser or use the following dmctl command:


dmctl -s <OI-Server> get IP::IP-<AgentIPAddress>::HostedBy
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To use the topology browser, check under IP section, expand it, select your IP and see if that it has a
HostedBy relationship.


The UnknownAgent is set to IGNORE by default. To create a trap notification in the Adapter Platform, the
value for UnknownAgent must be set to CREATE in the trap configuration definition, else traps will be
dropped.


Forwarding traps to servers


Query
How can I forward the Adapter Platform processed traps to the IP Availability Manager server?


Answer
Edit the trapd.conf file located under the <BASEDIR>/smarts/conf/icoi folder to include the IP address and
Receiving Trap Port where the IP Availability Manager server is running in the FORWARD section. An
example is provided below:


#           All generic traps (0 to 5) from network devices whose address 


#           matches 193.20.*.* will be sent to obelix port 7000, surya port 162 


#           and host 194.56.78.23 port 9000.


#


#     FORWARD: 193.20.*.* .* <0-5> * obelix:7000 surya 194.56.78.23:9000


Ensuring traps reach Adapter Platform


Query
How do I make sure that the traps are reaching the Adapter Platform?


Answer
Use one of the following methods:


n Shut down your the Adapter Platform.


n Start the default trap adapter with the same port as the Adapter Platform.


n Send your trap and check if the default trap adapter generates any output.


The VMware Smart Assurance Service Assurance Manager Adapter Platform User Guide provides
details on the procedures.


Verifying trap forwarding


Query
How do I verify that the traps are getting forwarded by the forwarder?
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Answer
Use one of the following methods:


n Check the < BASEDIR>/conf/trapd/trapd.conf to see which HostName:Port the traps are forwarded.


n Start the default trap adapter on HostName with the specified Port. For example, sm_snmp -p 9987
trapd.


n Send a trap to the forwarder (default port: 9000) and check if you see any output of the trap sent to
the HostName.


Debugging SNMP Trap Notifier


Query
How do I debug the SNMP Trap Notifier?


Answer
In the <BASEDIR>/smarts/local/rules/notifier folder, look up the notify.asl file. This is the main rule set.
Additionally, you can also see the trap-notify.asl in the trap directory. If you set debug=TRUE in these files
you will be able to get sufficient debugging information.


Trap exploder function


Query
Can I have the Trap Exploder send traps to both BGP and the Receiver?


Answer
Yes you can. Infact, you can send traps to any destination you like.


Defining two SNMP traps in trap_mgr.conf file


Query
Is it possible to define two SNMP traps in the trap_mgr.conf file - one to generate a notification and a
second one to clear it?
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Answer
Yes, it is possible to define two SNMP traps in the trap_mgr.conf file. As the trap is defined by the OID
generic and specific, you can only have one definition for a particular combination. At times, the notify and
clear are determined by the specific number, with one being notify and one being clear. If the status is
contained in a varbind, you will need to use a single trap definition and then use the ASL option to set the
action to notify or clear. An example is provided below:


----------------------------------------------------


BEGIN_TRAP .1.3.6.1.4.1.9.5.* 6 1


        ClassName:        Host


        InstanceName:     $SYS$


        EventName:        lerAlarmOn


        Severity:         2


        EventText:        Fddi PORT Ler Flag set to TRUE for : fddi PORT SMT Index = $V1$ And fddi 


PORT Index = $V2$


        Expiration:       600 


        State:            NOTIFY


        EventType:        DURABLE


END_TRAP


BEGIN_TRAP .1.3.6.1.4.1.9.5.* 6 2


        ClassName:        Host


        InstanceName:     $SYS$


        EventName:        lerAlarmOn


        State:            CLEAR


END_TRAP


-----------------------------------------------------


Number of traps adapter or exploder can process


Query
What is the maximum number of traps per second that the trap adapter or exploder can process?


Answer
The number of traps that can be processed depends on the trap configuration, mainly hook scripts and
the execution of the findComputerSystem call. The ideal rate without any kind of delay should be about
30-40 traps per second, with 4 threads. But on an average, the trap processing rate is around 15 traps
per second. Again, these numbers are very subjective to the environment and the configuration.


Improving performance of trap adapter and trap exploder


Query
What is the best way to increase the performance of the trap adapter and trap exploder to better handle
the traps hitting the exploder with more threads.
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Answer
You can increase the performance of the trap adapter and trap exploder by:


n Keeping the number of threads for the Trap Exploder as default (1)


n Increasing the number of threads processing the traps for Trap Adapter


You can specify these values in the trapd.conf and the trap_mgr.conf files for the Trap Exploder and
Trap Adapter, respectively. The trapd.conf and trap_mgr.conf files files are available under the
<BASEDIR>/smarts/conf/icoi/ folder.


Find the line, #THREADS: 1 in the configuration files. The default value specified is 1. Retain the
default entry for the trap exploder. For the trap adapter you can change the value for the threads to
five.


Defining sm_adapter parameters


Query
Can you define the sm_adapter parameters: --loglevel and --errlevel? What are the allowed levels and
what is expected to be seen when they are set.


Answer
Most messages printed by VMware Smart Assurance code use the exception logging mechanism with
something like CI_ExException(...).log(), or SM_System logXXX() calls from ASL. The exception logging
mechanism can send messages to one of two receivers, which could be the:


n Log file


n System error logger, which is the syslog mechanism on UNIX systems


The second mechanism has the potential to cause problems. On UNIX systems, the syslog files are
typically on small partitions, for example, /var/tmp. There have been cases where attempts to start VI
failed because it uses /var/tmp for temporary files, and /var/tmp is filled with a huge log of messages
from the VMware Smart Assurance server. Deleting the log file would temporarily solve the problem,
but the system logger re-creates it and it will promptly start growing again. The exception logging
mechanism is controlled by the severity level assigned to the message being logged. In the order
from most to least severe, a message can have one of the following severity levels:


Fatal, Error, Warning, Notice, Informational or Debug


You can individually assign, to each of the two receivers, the minimum severity level for messages to
be sent to that receiver. By default, the log file receives messages of severity Warning or above, and
the system error logger receives messages of severity Error or above. Two standard options available
with all VMware Smart Assurance main programs control these two levels:


n --errlevel: controls the minimum level for writing to the log file
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n --loglevel: controls the minimum level for sending to the system logging facility


If you use --help, you will see that there you can specify any of the listed severity levels as a value for
either of these options, as well as a couple of additional levels that make sense to syslog, but which
are synonyms for Fatal for the VMware Smart Assurance code. In addition, you can specify None to
completely disable a particular receiver.


If it is inconvenient to change your startup scripts, you can use the SM_MAIN_OPTIONS environment
variable. Any standard option that appears in this variable becomes the default. You can override
these default values on the command line. Thus, after setting:


n SM_MAIN_OPTIONS=--loglevel=None


n export SM_MAIN_OPTIONS


any VMware Smart Assurance program you start will, by default will not send anything to the system
error logging facility. To avoid having to actually look at the system log files always, you can set this in
your .profile.


Log levels defined


Query
What do the log levels mean?


Answer
The log levels are defined below:


n \begin\item[FATAL]: Indicates a serious internal error. A FATAL error is raised only in circumstances
where continued execution of the entire application is in question. Unless otherwise handled by an
application code, a FATAL exception in any thread will cause the entire program to exit.


n \item[ERROR]: A serious error that indicates that a requested function cannot be accomplished.
However, the application itself will normally be expected to continue. Unless otherwise handled by the
application code, an ERROR exception in any thread causes that thread, but not the program as a
whole, to exit.


n \item[WARNING]: Indicates that something unexpected happened. While the requested function was
completed, it may not have been completed exactly as expected. Unhandled exceptions of this and
lesser priority are logged but do not necessarily cause a thread to exit.


n \item[NOTICE]: Indicates that something unexpected happened that should be logged, but is not
expected to interfere with normal functioning.


n \item[DEBUG]: A catch-all for debugging code.
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n \end: Despite these intended meanings, an application may catch even a FATAL exception that it
knows how to recover from and continue operation.


There are a few exceptions to these definitions. For example, login failures are logged at FATAL level
since they are considered important, even though they are completely recoverable as far as the
application itself is concerned. There is an additional standard option, --tracelevel. An exception at
this level or above causes a stack trace to be printed to the log file. This log tells you exactly where
the exception was thrown, which may be more important that where it was caught and logged. By
default, --tracelevel is set to Fatal.


NOTIF queries
This section answers the following frequently asked questions on NOTIF:


n Error messages in Adapter Platform log file


Error messages in Adapter Platform log file


Query
After enabling NOTIF, the following messages appear in the Adapter Platform log file:


n discardUnknownAgent.java. Got unknownAgentSetting: IGNORE


n discardUnknownAgent.java. Got ignoreUnknowns: true


Answer
Set the value for the environment variable, SM_JAVA_ENABLED to YES in the runcmd_env.sh file,
available under the <BASEDIR>/smarts/local/conf/ directory.


Notification and Event processing queries
This section answers the following frequently asked questions on notification and event processing:


n Handling notification flooding


n Scenarios triggering NL_Delete


n Command to get queues


n Getting each notification to invoke the tool


n Identifying all subscriptions and subscribers to events


n Creating notifications using the Java API


Handling notification flooding
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Query
For an ASL notification adapter subscribing to NL_Notify, NL_Change, NL_Clear, NL_Delete events, what
happens if there is a flood of notifications? Is SAM able to queue them internally and make sure it passes
all of them to the subscribing modules? Does it make sense to implement a queue-like data structure in
the ASL adapter to first buffer the notifications before processing them.


Answer
There is no need to create your own queue. The SAM server creates the queues internally, and then
feeds the alarms one at a time into the ASL script. Once the START rule is complete, then the next
notification will be processed. So, if you do not write an efficient ASL script then it becomes a bottleneck
and the queues in SAM build up, using up memory, and subsequent crash.


The only way that you can speed up the processing is by having multiple notification lists feeding multiple
ASL scripts.


Scenarios triggering NL_Delete


Query
What are the scenarios in which NL_Delete will be triggered?


Answer
NL_Delete occurs when the event is archived or removed from the NL because of certain filtering actions.


Command to get queues


Query
What is the dmdebug command to get queues?


Answer
Run the following command to get queues:


dmctl> execute dmdebug --queues 


This prints information about all server queues in the system into the server log file. An example for the
queue output is provided below:


SubscriberFE                                         [0 worker(s)]


Current size 0, max 369; processed entries 21843


Size           0-0.00            0-0.00            0-0.00             0-0.00


Flow       21839+0.06        21803+0.05        21446+0.05         17895+0.06


Late      0.0000+0.00       0.0000+0.00       0.0000+0.00        0.0000+0.00
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In the example, the first line gives you the name of the queue and the number of workers.


Note   Subscriber Front Ends like the one cited here never have any workers, since they are not used as
normal server queues.


The second line gives you the current size, and an exact maximum size. The total number of ‘processed
entries’ indicates the total number of entries that have ever been pulled off the queue.


Getting each notification to invoke the tool


Query
We have escalation policies set to run automatic server tools which text, page or email various recipients.
We noticed that sometimes we do not get paged or emailed. I did some testing and it seems that only the
first notification of an event invokes the tool, until the notification is archived. Is anyone familiar with how
to get each notification to invoke the tool with each notification?


Answer
You can do it with two escalation policies, and using a tag value in a user defined field.


n The first escalation policy triggers on the following conditions and executes the automatic tool:


n STATUS == ACTIVE


n USERDEFINED != TAG


n The second escalation policy triggers on the following conditions and clears out the tagged field:


n STATUS == INACTIVE


n USERDEFINED == TAG


Then if the notification becomes active again, the criteria for the first escalation policy are met
again and the automatic tool will be invoked again.


Identifying all subscriptions and subscribers to events


Query
Is it possible to identify if there is somebody who is subscribed for a given event or see all subscriptions,
not just the bootstrap subscriptions?


Answer
Use the following command to see if anybody is associated with an event:


dmctl> exec dmdebug subscriptions[=all] [output=]
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Creating notifications using the Java API


Query
We would like to create notifications in SAM directly from the Java API. Using the sm_ems command line
interpreter is not an option. The device already exists within the IP/AM topology, but this is a Non-SNMP
device. Messages are received through XML containing information on the notification details. It has to be
through the Java API, and not use the ASL open adapter either as everything will run from a single
adapter framework.


Answer
Use the dynamic model to define the new events that you want created. Then, you can use the Java API
to toggle boolean flags. The VMware Smart Assurance MODEL Reference Guide and the
VMware Smart Assurance Dynamic Modeling Tutorial provide examples of exporting new events.


If are using external instrumentation sources, you must use the "External" polling settings in AM/PM. To
enable these, log into domain using the GUI, select the Domain Manager Administration Console >
Polling and Thresholds. Once this is done, your instrumentation logic can set attributes in the
instrumentation objects (follow the InstrumentedBy relationship in the Interface and IP objects).


Business Dashboard queries
This chapter includes information for troubleshooting the VMware Smart Assurance Business Dashboard
and contains the following information:


n Business dashboard troubleshooting overview


n Debugging the Web Console


n Configuring the log file directories


n Configuring the log files


n Sun Java Console (Plug-in message log)


n Log file location


n Increasing the heap space


Note   The information contained in this chapter should be checked against your installation before
problems arise. Contact VMware Online support if it becomes necessary to clarify or resolve any
questions or issues.
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Business dashboard troubleshooting overview
When troubleshooting reasons why the Web Console stops responding, the following files and
parameters are reviewed:


n Required files


When troubleshooting issues, VMware always asks for the following files:


n RPS files


n Service Assurance Manager server log files


n tomcat log files


n sm_monitor log files


n Console log files


n ics.conf files


The console log files include the VMware Smart Assurance Java Message log file, the Sun Java
Plug-in Console log file, and the VMware Smart Assurance VMware Smart Assurance server
messages received log file. By reviewing the console log files, VMware Smart Assurance can
clearly determine if the console stopped responding because the system ran out of memory, or if
the issue was the result of some other error. Using the server log file, VMware can review what
occurred at the time the console stopped responding; for example, was the server busy or was
there some other exception.


From prior experience, a Web Console or Global Console stops responding as a result of the
machine running out of memory.


n Debugging parameters


To have debugging information entered in the log files, you must have the console debugging
parameters set by default, before you use the console and the console stops responding. You need to
verify that the debugging information is being entered into the log files before there is a problem.
Having the debugging parameters set ensures that no critical information is lost.


n Primary Java log file


The primary Java log file is the key tool used in diagnosing issues. This file gets overwritten at each
startup time and is the file that saves the contents of the Console Java Log. Enable this file by typing
the following command:


               -Dcom.smarts.java.log=<


               filename


               >
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n Asynchronous message log file


This log file is controlled by versioning. This file can get very large if the server is processing
numerous notifications. Enable the asynchronous message log file by typing the following command:


               Dcom.smarts.server.logMessages=true


            


Debugging the Web Console


Query
How do I go about debugging the Web Console?


Answer
Web Console debugging parameters defines the parameters used to capture information when a Web
Console stops responding.


Table 3‑1.  Web Console debugging parameters


Parameter Description


-Xmx350m -Dsun.net.inetaddr.ttl=0 This parameter gets around the broker failover cache problem.


-Dcom.smarts.server.logMessages=true This parameter logs all the asynchronous messages that the server
sends to the console, primarily, notification adds/changes/deletes.


-Dcom.smarts.java.log=<name>-webconsole.log This parameter saves the VMware Smart Assurance Java Message
Log content. This content is lost when the console stops responding.
This log file must be copied and saved before restarting the Web
Console. Content included in this log file could provide information on
why the console stopped responding.


Restarting the Web Console overwrites this file.


-Dcom.smarts.log.level=TRACE This parameter results in maximum information being entered in the
Java Message Log.


Heap size VMware has tested a heap size of 350 M


Note   The parameters are configured in the Java Plug-in Control Panel.


Configuring the log file directories


Query
How do I set up the log file directories when the VMware Smart Assurance GUI is running as a Web
Console in Internet Explorer?
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Answer
You can set up the log file directories for the com.smarts.server.logMessages and com.smarts.java.log
files when the GUI is running as a Web Console in Internet Explorer. The parameters can be enabled if
they are set in the Java Control Panel in the workstations. To display the Java Control Panel, click
Settings > Control Panel > Java.


Internet Explorer defaults the console’s com.smarts.writeable parameter to the desktop location where log
files are written. You can verify this in the Sun Java Console window (not the Smarts Java Log file).


To verify that the com.smarts.writeable parameter is configured correctly:


From Internet Explorer, click Tools > Sun Java Console.


The Java Console appears. An example of the type of information available from the Sun Java Console
is:


Java Plug-in 1.4.2_06


Using JRE version 1.4.2_06 Java HotSpot(TM) Client VM


User home directory = C:\Documents and Settings\bm1.SMARTS 


----------------------------------------------------


c: clear console window


f: finalize objects on finalization queue


g: garbage collect


h: display this help message


l: dump classloader list


m: print memory usage


o: trigger logging


p: reload proxy configuration


q: hide console


r: reload policy configuration


s: dump system and deployment properties


t: dump thread list


v: dump thread stack


x: clear classloader cache


0-5: set trace level to <n>


---------------------------------------------------- 


Properties: com.smarts.fixed, com.smarts.sitemod, com.smarts.writeable not found.


Defaulting com.smarts.fixed, com.smarts.sitemod, com.smarts.writeable paths to: C:\Documents and 


Settings\bm1.SMARTS\Desktop 


The Properties line defines the location of the com.smarts.writable path. In this example, the path has
been defaulted to the desktop and the user ID has been defined by default as the user ID for the specific
workstation (in the example, the user ID is: bm1.SMARTS).


Configuring the log files


Query
How do I retrieve the log files when running the Web Console?
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Answer
To retrieve the log files when running the Web Console:


1 Verify that the log files have been configured.


VMware Smart Assurance Service Assurance Manager Dashboard Configuration Guide provides
additional information on configuring log file directories.


2 Create a new folder labeled “logs” on the workstation's desktop.


3 Click Settings > Control Panel > Java.


The Java Control Panel appears.


4 Click Advanced and add a new Java Runtime Parameter. (For Java 1.5, click the Java tab and then
click the View button to display the Java Runtime Settings window.) An example of the settings is:


-Dcom.smarts.server.logMessages=true


-Dcom.smarts.java.log=ZZZZ


-Dcom.smarts.log.level=TRACE


5 Edit the -Dcom.smarts.java.log=ZZZZ to the name of your java log file.


Note   This log file does not get appended with versions. It needs to be saved before restarting the
console. If the file is not saved before starting the console, the contents of the file are overwritten.


After configuring the java log file location, when you run Internet Explorer, the log of server message
log file and the java log file are written into the desktop's logs directory. The java log file lists trace
level messages.


Because the parameter was updated in the client’s Java Plug-in, you do not need to restart the
tomcat application.


You need to configure the log files location before a console stops responding so that information
about the console not responding can be retrieved. Verify that the two debugging files
(webconsole.log and server_Mesg_<userid>.log) get written to the logs directory.


Sun Java Console (Plug-in message log)


Query
How do I enable the Sun Java Plug-in and capture its content?


Answer
When the VMware Smart Assurance GUI is run as a Web Console, important debugging information is
written to the Sun Java Plug-in Console. When the GUI stops responding but Internet Explorer continues
to run (for example, if the web browser window goes blank), it is helpful to capture the contents of the Sun
Java Plug-in console.
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To enable the Sun Java Plug-in Console
To enable the Sun Java Plug-in Console:


1 From Settings, click Control Panel.


The Control Panel appears.


2 Double-click Java.


The Java Control Panel appears.


3 Click Basic (for Java 1.4.2) or click Advanced for Java 1.5.


4 Expand the Java console option.


5 Click the Show Console option.


By default, the Sun Java Plug-in Console displays as a window (typically in the upper-left corner of
the screen) in Internet Explorer. You can also display the Sun Java Console by clicking the Internet
Explorer’s Tools menu and selecting the Sun Java Console.


Capturing the Sun Java Plug-in Console content
To capture the Sun Java Plug-in Console content:


1 From the Java Console, click Copy.


The content displayed in the Sun Java Console is copied to the clipboard.


2 Open a new file in a text editor and paste the clipboard contents into the new file.


3 Save the file and send the file to VMware along with other debugging information.


Note   If you are reporting Web Console problems that did not cause the Web Console to stop
responding, you should also copy, save, and send this log file.


Log file location


Query
Where do I find the log files for debugging issues related to the Web Console?


Answer
Log file location defines the log file locations.
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Table 3‑2.  Log file location


File/ or log name Location


rps file <BASEDIR>/smarts/local/repos/icf directory.


Run dmctl -s NA-SAM-PRES and invoke the ICF_PersistenceManager::ICF-PersistenceManager.
Save this information before sending the rps file to ensure all notifications are saved to the rps.


SAM server log <BASEDIR>/smarts/local/logs directory.


sm_monitor logs <BASEDIR>/smarts/local/logs/SM_Monitor directory.


Tomcat logs <BASEDIR>/smarts/jakarta-tomcat-5.0.16/logs directory from where tomcat started.


ics.conf file <BASEDIR>/smarts/local/conf/ics directory.


Console logs C:\Documents and Settings\<username>.SMARTS\Desktop\logs directory.


Increasing the heap space


Query
How do I increase the heap size for the Java Plug-in and for Java Web Start.


Answer
If the Web Console or viewlets run out of memory, adjust the maximum amount of heap space that the
Java Plug-in uses for dynamic memory allocation. By specifying -Xmx256m as a runtime parameter, for
example, you can increase the heap space allocation to 256 MB. The number can be set larger or smaller
than 256 MB, depending on the resources available on the client machine running the web browser.


To increase the heap space for the Java Plug-in:


1 Launch the Java Control Panel. The Sun website provides instructions (http://java.sun.com).


2 In the Java Control Panel, click the Java tab.


3 In the Java Runtime Environment Settings section, click the View button. The Java Runtime
Environment Settings dialog box appears.


4 In the Runtime Parameters field, type the maximum heap-space runtime parameter (-Xmx) and a
value for the parameter. For example: -Xmx330m.


5 Click OK.


6 Click the Java Control Panel Apply button.


7 Terminate and restart any web browser running on the host machine.


For the Java Web Start, the heap space defaults to 350 megabytes.


Increasing Java Web Start heap space
To increase the heap space for the Java Web Start:


1 Using a text editor, open the <BASEDIR>/smarts/tomcat/webapps/webconsole/globalConsoleApp.jnlp
file.
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2 Locate the following line:


<j2se version="1.6.0+" max-heap-size="350M"/>


3 Change the max-heap-size variable value.


4 Save and close the file.
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